# Contents

## Chapter 1. Introduction
- Using the Carlson Software Manual ................................................................. 2
- Product Overview ................................................................................................. 2
- System Requirements ............................................................................................ 4
- Installing Carlson Software .................................................................................. 4
- Authorizing Carlson Software .............................................................................. 10
- Carlson Registration .............................................................................................. 12
- Setting Up a Project .............................................................................................. 13
- Startup Wizard ...................................................................................................... 13
- Command Entry .................................................................................................... 16
- Layer and Style Defaults ....................................................................................... 16
- What is New ........................................................................................................... 17
- Standard Report Viewer ....................................................................................... 18
- Report Formatter .................................................................................................... 20
- Instruction Manual and Program Conventions ...................................................... 23
- Carlson File Types ............................................................................................... 23
- Quick Keys ............................................................................................................. 27
- Obtaining Technical Support ................................................................................ 28
- License Agreement ............................................................................................... 28

## Chapter 2. Tutorials
- Lesson 1: Entering a Deed .................................................................................... 32
- Lesson 2: Making a Plat ....................................................................................... 41
- Lesson 3: SurvNET ............................................................................................... 78
- Lesson 4: Field to Finish for Faster Drafting ......................................................... 101
- Lesson 5: Intersections and Subdivisions ............................................................. 120
- Lesson 6: Contouring, Break Lines and Stockpiles .............................................. 143
- Basic Road Design with Volumes ........................................................................ 156

## Chapter 3. AutoCAD Overview
- Issuing Commands .............................................................................................. 176
- General Commands .............................................................................................. 177
- Selection of Items ................................................................................................. 178
- Properties and Layers .......................................................................................... 179
- Properties Toolbar ............................................................................................... 180
<table>
<thead>
<tr>
<th>Chapter 4. File Menu</th>
<th>181</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>182</td>
</tr>
<tr>
<td>Open</td>
<td>183</td>
</tr>
<tr>
<td>Close</td>
<td>183</td>
</tr>
<tr>
<td>Save</td>
<td>183</td>
</tr>
<tr>
<td>Save As</td>
<td>184</td>
</tr>
<tr>
<td>Get Project from Data Depot</td>
<td>184</td>
</tr>
<tr>
<td>Plot</td>
<td>186</td>
</tr>
<tr>
<td>Layout Manager</td>
<td>186</td>
</tr>
<tr>
<td>Page Setup</td>
<td>189</td>
</tr>
<tr>
<td>Plot Preview</td>
<td>189</td>
</tr>
<tr>
<td>Plot</td>
<td>189</td>
</tr>
<tr>
<td>PDF</td>
<td>193</td>
</tr>
<tr>
<td>Output Layouts to PDF</td>
<td>193</td>
</tr>
<tr>
<td>Merge PDF Files</td>
<td>194</td>
</tr>
<tr>
<td>Xref Manager</td>
<td>195</td>
</tr>
<tr>
<td>Carlson Community</td>
<td>197</td>
</tr>
<tr>
<td>Import</td>
<td>200</td>
</tr>
<tr>
<td>Import 3D Viewer File</td>
<td>200</td>
</tr>
<tr>
<td>Import 3D Model File</td>
<td>200</td>
</tr>
<tr>
<td>Import Xref to Current Drawing</td>
<td>200</td>
</tr>
<tr>
<td>Import RoadXML File</td>
<td>200</td>
</tr>
<tr>
<td>LandXML</td>
<td>201</td>
</tr>
<tr>
<td>Import LandXML File</td>
<td>202</td>
</tr>
<tr>
<td>Import 12D File</td>
<td>205</td>
</tr>
<tr>
<td>Import ePlan File</td>
<td>205</td>
</tr>
<tr>
<td>Civil 3D All</td>
<td>205</td>
</tr>
<tr>
<td>Civil 3D Pipes</td>
<td>205</td>
</tr>
<tr>
<td>Civil 3D Labels</td>
<td>206</td>
</tr>
<tr>
<td>Import MxRoad GENIO</td>
<td>206</td>
</tr>
<tr>
<td>Import Google Earth File</td>
<td>206</td>
</tr>
<tr>
<td>Export</td>
<td>207</td>
</tr>
<tr>
<td>Export LandXML File</td>
<td>207</td>
</tr>
<tr>
<td>Export RoadXML File</td>
<td>210</td>
</tr>
<tr>
<td>Export 12D File</td>
<td>212</td>
</tr>
<tr>
<td>Export ePlan File</td>
<td>212</td>
</tr>
<tr>
<td>Export Civil 3D Drawing</td>
<td>212</td>
</tr>
<tr>
<td>Export Civil 3D Points</td>
<td>214</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Export Civil 3D Surface</td>
<td>214</td>
</tr>
<tr>
<td>Export Drawing to AutoCAD 14</td>
<td>214</td>
</tr>
<tr>
<td>Export Google Earth File</td>
<td>215</td>
</tr>
<tr>
<td>Set Google Tags</td>
<td>218</td>
</tr>
<tr>
<td>Polyline File</td>
<td>220</td>
</tr>
<tr>
<td>Draw Polyline File</td>
<td>220</td>
</tr>
<tr>
<td>Write Polyline File</td>
<td>220</td>
</tr>
<tr>
<td>Drawing Cleanup</td>
<td>221</td>
</tr>
<tr>
<td>Drawing Utilities</td>
<td>225</td>
</tr>
<tr>
<td>Geolocate DWG Files</td>
<td>225</td>
</tr>
<tr>
<td>Translate Layers</td>
<td>226</td>
</tr>
<tr>
<td>Audit</td>
<td>226</td>
</tr>
<tr>
<td>Recover</td>
<td>226</td>
</tr>
<tr>
<td>Drawing Save Log</td>
<td>227</td>
</tr>
<tr>
<td>Remove XData</td>
<td>227</td>
</tr>
<tr>
<td>Remove Civil 3D Custom Objects</td>
<td>228</td>
</tr>
<tr>
<td>Remove Reactors</td>
<td>228</td>
</tr>
<tr>
<td>Remove Groups</td>
<td>228</td>
</tr>
<tr>
<td>Unlock Attributes</td>
<td>229</td>
</tr>
<tr>
<td>Purge</td>
<td>229</td>
</tr>
<tr>
<td>Chapter 5. Edit Menu</td>
<td>231</td>
</tr>
<tr>
<td>Undo</td>
<td>232</td>
</tr>
<tr>
<td>Redo</td>
<td>232</td>
</tr>
<tr>
<td>Erase</td>
<td>232</td>
</tr>
<tr>
<td>Erase Select</td>
<td>232</td>
</tr>
<tr>
<td>Erase by Layer</td>
<td>232</td>
</tr>
<tr>
<td>Erase by Closed Polyline</td>
<td>233</td>
</tr>
<tr>
<td>Erase Outside</td>
<td>234</td>
</tr>
<tr>
<td>Temporary Erase</td>
<td>234</td>
</tr>
<tr>
<td>Move</td>
<td>234</td>
</tr>
<tr>
<td>Copy</td>
<td>234</td>
</tr>
<tr>
<td>Standard Copy</td>
<td>234</td>
</tr>
<tr>
<td>Copy To Layer</td>
<td>235</td>
</tr>
<tr>
<td>Copy Polyline Section</td>
<td>235</td>
</tr>
<tr>
<td>Offset</td>
<td>236</td>
</tr>
<tr>
<td>Standard Offset</td>
<td>236</td>
</tr>
<tr>
<td>Offset To Layer</td>
<td>236</td>
</tr>
<tr>
<td>Offset to Area</td>
<td>236</td>
</tr>
<tr>
<td>Command</td>
<td>Page</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Multiple Offsets</td>
<td>237</td>
</tr>
<tr>
<td>Median Offset</td>
<td>237</td>
</tr>
<tr>
<td>Variable Offset</td>
<td>238</td>
</tr>
<tr>
<td>Buffer Offset</td>
<td>238</td>
</tr>
<tr>
<td>Explode</td>
<td>239</td>
</tr>
<tr>
<td>Standard Explode</td>
<td>239</td>
</tr>
<tr>
<td>Block Explode</td>
<td>240</td>
</tr>
<tr>
<td>Trim</td>
<td>240</td>
</tr>
<tr>
<td>Extend</td>
<td>240</td>
</tr>
<tr>
<td>Extend To Edge</td>
<td>240</td>
</tr>
<tr>
<td>Extend to Intersection</td>
<td>241</td>
</tr>
<tr>
<td>Extend Arc</td>
<td>241</td>
</tr>
<tr>
<td>Extend by Distance</td>
<td>242</td>
</tr>
<tr>
<td>Break</td>
<td>244</td>
</tr>
<tr>
<td>Break by Crossing Polyline</td>
<td>244</td>
</tr>
<tr>
<td>Break Polyline at Specified Distances</td>
<td>245</td>
</tr>
<tr>
<td>Break at Intersection</td>
<td>245</td>
</tr>
<tr>
<td>Break, Select Object, 2nd Point</td>
<td>246</td>
</tr>
<tr>
<td>Break, Select Object, Two Points</td>
<td>246</td>
</tr>
<tr>
<td>Break, At Selected Point</td>
<td>246</td>
</tr>
<tr>
<td>Chamfer By Chord Length</td>
<td>246</td>
</tr>
<tr>
<td>Change</td>
<td>247</td>
</tr>
<tr>
<td>Change Elevations</td>
<td>247</td>
</tr>
<tr>
<td>Change Attribute Style</td>
<td>247</td>
</tr>
<tr>
<td>Change Style</td>
<td>248</td>
</tr>
<tr>
<td>Change Colors</td>
<td>249</td>
</tr>
<tr>
<td>Change Lineweight</td>
<td>249</td>
</tr>
<tr>
<td>Change Block/Inserts Rotate</td>
<td>250</td>
</tr>
<tr>
<td>Change Block/Inserts Substitute</td>
<td>250</td>
</tr>
<tr>
<td>Change Block/Inserts Resize</td>
<td>251</td>
</tr>
<tr>
<td>Rotate</td>
<td>251</td>
</tr>
<tr>
<td>Pivot Point Rotate by Bearing</td>
<td>251</td>
</tr>
<tr>
<td>Entity Insertion Point Rotate</td>
<td>252</td>
</tr>
<tr>
<td>Rotate by Pick</td>
<td>252</td>
</tr>
<tr>
<td>Scale</td>
<td>252</td>
</tr>
<tr>
<td>Scale Wizard</td>
<td>252</td>
</tr>
<tr>
<td>Standard Scale</td>
<td>254</td>
</tr>
</tbody>
</table>
Join Two Polylines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 273
Merge Closed Polylines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 274
Draw Polyline Start/End . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 274
Edit Polyline . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 275
Add Intersection Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 275
Add Polyline Vertex . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 276
Add Polyline Arcs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 276
Edit Polyline Vertex . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 277
Edit Polyline Section . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 278
Change Polyline Elevation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 278
Change Polyline Width . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 279
Set Polyline Origin . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 279
Make Arcs Tangential . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 279
Close Polylines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 280
Open Polylines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 280
Remove Polyline . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 280
Remove Duplicate Polylines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 280
Remove Polyline Arcs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 280
Remove Polyline Segment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 281
Remove Polyline Vertex . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 281
Polyline Blips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 282
Draw Polyline Blips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 282
Remove Polyline Blips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 283
Check Polylines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 283
Check Elevation Range . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 283
Highlight Non-Perpendicular Intersections . . . . . . . . . . . . . . . . . . . . . . . . . . 283
Highlight Non-Tangent Polylines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 284
Highlight Crossing Plines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 285
3D Polyline Utilities . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 286
Offset 3D Polyline . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 286
Fillet 3D Polyline . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 288
Join 3D Polyline . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 288
Add Point by Two Slopes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 288
Add Points At Elevation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 289
3D Polyline by Slope on Surface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 289
Join Nearest . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 290
3D Entity to 2D . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 291
Selection Sets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 292
Chapter 6. View Menu

Redraw
Regen
Zoom - Window
Zoom - Previous
Zoom - Extents
Zoom
Zoom - Dynamic
Zoom - Center
Zoom IN
Zoom OUT
Zoom Selection
Zoom Most
Zoom Extents on All Layouts
Zoom Points
Pan
Align Paper With Model Space

3D Views
3D Viewer Window
Surface 3D Viewer
Surface 3D FlyOver
3DX Model File
Viewpoint 3D

Viewports
Draw Model View
Twist Screen

Standard
Chapter 7. Draw Menu

Line
2D Line
3D Line
2D Polyline
3D Polyline ................................................................. 334
Circle ........................................................................ 339
Arc ............................................................................ 340
  3 Point ..................................................................... 340
  PC, PT, Center .......................................................... 340
  PC, PT, Radius .......................................................... 340
  PC, PT, Tangent ........................................................ 341
  PC, Radius, Chord ...................................................... 341
  PC, Radius, Arc Length .............................................. 341
  2 Tangents, Radius ..................................................... 342
  2 Tangents, Arc Length .............................................. 342
  2 Tangents, Chord Length .......................................... 342
  2 Tangents, Mid-Ordinate .......................................... 343
  2 Tangents, External .................................................. 343
  2 Tangents, Tangent Length ....................................... 344
  2 Tangents, Degree of Curve ..................................... 344
  2 Tangents, Through Point ........................................ 344
  Tangent, PC, Radius, Arc Length ............................... 345
  Tangent, PC, Radius, Tangent Length ......................... 345
  Tang, PC, Radius, Chord Length ............................... 346
  Tang, PC, Radius, Delta Angle .................................... 346
  Arc From Last Point .................................................. 346
  Compound or Reverse .............................................. 347
  3D Arc ..................................................................... 347
  2-Radius Curve Series .............................................. 348
  3-Radius Curve Series .............................................. 348
  Best Fit Curve ........................................................ 349
  Curve Calc ................................................................ 350
  Spiral Curve ............................................................ 351

Text ............................................................................ 352
  Text Wizard ............................................................. 353
  Text Import ................................................................ 354
  Text Export ............................................................. 354
  Field Text ............................................................... 354
  Text on Line ............................................................ 356
  Text on Polyline ....................................................... 357
  Text Mask ................................................................ 357
  Draw Barscale ........................................................ 358
Draw North Arrow .................................................. 358
Draw Box Around Text ........................................... 359
Draw Table .......................................................... 360
Text UnMask .......................................................... 360
White Solid Behind Text .......................................... 361
Trim Linework Through Text .................................... 361
Symbols ............................................................... 361
Insert Symbols ...................................................... 363
Insert Multi-Point Symbols ....................................... 366
Hatch ................................................................. 369
Standard Hatch ...................................................... 372
Hatch Wizard ......................................................... 376
Image ................................................................. 377
Raster Image ........................................................ 377
Leaders ............................................................... 379
Arrowhead ........................................................... 379
Curve - Arrow ......................................................... 379
Leader With Text .................................................... 380
Multileader with Text .............................................. 381
Special Leader ....................................................... 382
Callout Leader ........................................................ 383
Bold Curve Leader ................................................... 383
Flow Leader .......................................................... 384
Draw Standard Item ................................................ 384
Item Standards Manager ......................................... 387
Draw By Example .................................................... 389
Sequential Numbers ............................................... 389
Boundary Polyline .................................................. 391
Shrink-Wrap Entities ............................................... 392
Section Line .......................................................... 394
Polyline by Nearest Found ........................................ 395
Drawing Block ....................................................... 396
Write Block .......................................................... 397
Insert ................................................................. 398
Chapter 8. Inquiry Menu

- List ................................................................. 401
- Point ID ........................................................... 402
- Layer ID ........................................................... 402
- Layer Inspector .................................................. 403
- Drawing Inspector On/Off ..................................... 403
- List Elevation ...................................................... 405
- Bearing & 3D Distance ......................................... 405
- Find Point .......................................................... 405
- Calculator .......................................................... 406
- Curve Info .......................................................... 408
- Angle Info .......................................................... 409
- Polyline Info ....................................................... 410
- Layer Report ....................................................... 410
- Style Report ....................................................... 411
- Block Data Report ............................................... 411
- Display-Edit File .................................................. 412
- Text File To Report Formatter .................................. 412
- Load Saved Report ................................................ 413
- Load Last Report Formatter ..................................... 413
- Display Last Report ............................................... 413

Chapter 9. Settings Menu

- Drawing Setup .................................................... 415
- Set Project/Data Folders ........................................ 419
- Carlson Configure ............................................... 425
- Settings Explorer ............................................... 442
- Settings File Manager .......................................... 443
- Toolbars ............................................................. 445
- Symbol Library ..................................................... 446
- Layer Library ....................................................... 447
- 2D Linewor Library ............................................... 450
- 3D Viewer/Model Library ....................................... 450
- Title Block .......................................................... 453
- Mortgage Block ................................................... 455
- Rescale Drawing ................................................... 456
- Set/Reset X-Hairs .................................................. 457
- Tablet Calibrate .................................................... 457
- Save/Load Tablet Calibration .................................... 459
<p>| Contents |
|-----------------------------|-----------------------------|
| Set UCS to World .          | 459                         |
| Units Control               | 459                         |
| Point Object Snap On/Off    | 461                         |
| Object Snap                 | 462                         |
| System Variable Editor      | 464                         |
| Chapter 10. Points Menu     | 467                         |
| Point Defaults              | 468                         |
| Draw-Locate Points          | 470                         |
| List Points                 | 474                         |
| Import Text/ASCII File      | 476                         |
| Export Text/ASCII File      | 478                         |
| Set Coordinate File         | 480                         |
| CoorDinate File Utilities  | 481                         |
| Point Group Manager         | 491                         |
| Edit Points                 | 497                         |
| Erase Points                | 499                         |
| Freeze Points               | 499                         |
| Thaw Points                 | 500                         |
| Lock Points                 | 500                         |
| Adjust Coordinates          | 501                         |
| Translate Points            | 501                         |
| Rotate Points               | 503                         |
| Scale Points                | 505                         |
| Align Points                | 507                         |
| Move Points                 | 508                         |
| Coordinate Transformation   | 509                         |
| Edit Point Attributes       | 512                         |
| Edit Multiple Pt Attributes | 515                         |
| Move Point Attributes Single| 519                         |
| Move Point Attributes with Leader | 519          |
| Resize Point Attributes     | 520                         |
| Erase Point Attributes      | 521                         |
| Twist Point Attributes      | 521                         |
| Fix Point Attribute Overlaps| 522                         |
| Point Utilities             | 525                         |</p>
<table>
<thead>
<tr>
<th>Coordinate Cloud</th>
<th>.................................................................</th>
<th>525</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Point Files</td>
<td>........................................................................</td>
<td>527</td>
</tr>
<tr>
<td>Geoid Utilities</td>
<td>........................................................................</td>
<td>528</td>
</tr>
<tr>
<td>Trim by Point Symbol</td>
<td>......................................................................</td>
<td>528</td>
</tr>
<tr>
<td>Change Point LayerColor</td>
<td>..................................................................</td>
<td>529</td>
</tr>
<tr>
<td>Link Linework With Points</td>
<td>...................................................................</td>
<td>530</td>
</tr>
<tr>
<td>Renumber Points</td>
<td>.........................................................................</td>
<td>530</td>
</tr>
<tr>
<td>Convert Point Format</td>
<td>........................................................................</td>
<td>531</td>
</tr>
<tr>
<td>Explode Carlson Points</td>
<td>.......................................................................</td>
<td>531</td>
</tr>
<tr>
<td>Convert Surveyor1 to CRD</td>
<td>.......................................................................</td>
<td>532</td>
</tr>
<tr>
<td>Convert CRD to TDS CR5/Convert TDS CR5 to CRD</td>
<td>.................................................</td>
<td>532</td>
</tr>
<tr>
<td>Convert CRD to Land Desktop MDB</td>
<td>....................................................................</td>
<td>532</td>
</tr>
<tr>
<td>Convert Land Desktop MDB to Carlson Points</td>
<td>.........................................................</td>
<td>533</td>
</tr>
<tr>
<td>Convert Civil 3D to Carlson Points</td>
<td>.................................................................</td>
<td>533</td>
</tr>
<tr>
<td>Convert Carlson Points to Land Desktop</td>
<td>....................................................................</td>
<td>533</td>
</tr>
<tr>
<td>Convert Land Desktop to Carlson Points</td>
<td>....................................................................</td>
<td>534</td>
</tr>
<tr>
<td>Convert Softdesk to Carlson Points</td>
<td>......................................................................</td>
<td>534</td>
</tr>
<tr>
<td>Convert Carlson Points to C&amp;G</td>
<td>......................................................................</td>
<td>534</td>
</tr>
<tr>
<td>Convert C&amp;G to Carlson Points</td>
<td>.......................................................................</td>
<td>535</td>
</tr>
<tr>
<td>Convert Carlson Points to Simplicity</td>
<td>.....................................................................</td>
<td>535</td>
</tr>
<tr>
<td>Convert Simplicity to Carlson Points</td>
<td>.....................................................................</td>
<td>536</td>
</tr>
<tr>
<td>Convert Leica to Carlson Points</td>
<td>........................................................................</td>
<td>536</td>
</tr>
<tr>
<td>Convert Geodimeter to Carlson Points</td>
<td>.....................................................................</td>
<td>536</td>
</tr>
<tr>
<td>Convert Carlson Points to Ashtech GIS</td>
<td>.....................................................................</td>
<td>536</td>
</tr>
<tr>
<td>Convert Carlson Points to Softdesk</td>
<td>.......................................................................</td>
<td>537</td>
</tr>
<tr>
<td>Convert CAICE KCM to Carlson CRD</td>
<td>.......................................................................</td>
<td>537</td>
</tr>
<tr>
<td>Convert PacSoft CRD to Carlson CRD</td>
<td>.......................................................................</td>
<td>537</td>
</tr>
<tr>
<td>Convert Carlson Points to Eagle Point</td>
<td>.....................................................................</td>
<td>537</td>
</tr>
<tr>
<td>Convert Eagle Point to Carlson Points</td>
<td>.....................................................................</td>
<td>538</td>
</tr>
</tbody>
</table>

**Chapter 11. Survey Menu**

<table>
<thead>
<tr>
<th>Carlson Cloud</th>
<th>........................................................................</th>
<th>540</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Collectors</td>
<td>...........................................................................</td>
<td>545</td>
</tr>
<tr>
<td>Edit-Process Raw Data File</td>
<td>........................................................................</td>
<td>569</td>
</tr>
<tr>
<td>Edit-Process Level Data</td>
<td>..........................................................................</td>
<td>617</td>
</tr>
<tr>
<td>Edit Process SDMS File</td>
<td>........................................................................</td>
<td>624</td>
</tr>
<tr>
<td>Draw Field to Finish</td>
<td>..........................................................................</td>
<td>624</td>
</tr>
<tr>
<td>Field to Finish Inspector</td>
<td>...........................................................................</td>
<td>672</td>
</tr>
<tr>
<td>Edit Field to Finish Codes</td>
<td>...............................................................................</td>
<td>675</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
<td></td>
</tr>
<tr>
<td>------------------------------------------------------------</td>
<td>-------</td>
<td></td>
</tr>
<tr>
<td>Enter Deed Description</td>
<td>675</td>
<td></td>
</tr>
<tr>
<td>Deed Reader</td>
<td>678</td>
<td></td>
</tr>
<tr>
<td>Process Deed File</td>
<td>680</td>
<td></td>
</tr>
<tr>
<td>Deed Tools</td>
<td>684</td>
<td></td>
</tr>
<tr>
<td>Import Angle/Distance File</td>
<td>684</td>
<td></td>
</tr>
<tr>
<td>Deed Linework ID</td>
<td>685</td>
<td></td>
</tr>
<tr>
<td>Deed Correlation</td>
<td>685</td>
<td></td>
</tr>
<tr>
<td>Legal Description Writer</td>
<td>688</td>
<td></td>
</tr>
<tr>
<td>Closure by Point Numbers</td>
<td>697</td>
<td></td>
</tr>
<tr>
<td>Map check</td>
<td>699</td>
<td></td>
</tr>
<tr>
<td>By Points</td>
<td>699</td>
<td></td>
</tr>
<tr>
<td>By Screen Entities</td>
<td>700</td>
<td></td>
</tr>
<tr>
<td>Cut Sheet</td>
<td>702</td>
<td></td>
</tr>
<tr>
<td>Set Point Elevations</td>
<td>716</td>
<td></td>
</tr>
<tr>
<td>By Surface Model</td>
<td>716</td>
<td></td>
</tr>
<tr>
<td>By 3D Polylines</td>
<td>716</td>
<td></td>
</tr>
<tr>
<td>Polyline Tools</td>
<td>717</td>
<td></td>
</tr>
<tr>
<td>Polyline Report</td>
<td>717</td>
<td></td>
</tr>
<tr>
<td>Polyline to RW5 File</td>
<td>719</td>
<td></td>
</tr>
<tr>
<td>Crandall Polyline Adjustment</td>
<td>719</td>
<td></td>
</tr>
<tr>
<td>Compass Polyline Adjustment</td>
<td>720</td>
<td></td>
</tr>
<tr>
<td>Grant Boundary Adjustment</td>
<td>721</td>
<td></td>
</tr>
<tr>
<td>Deed File By Interior Text</td>
<td>722</td>
<td></td>
</tr>
<tr>
<td>Polyline to Deed File</td>
<td>723</td>
<td></td>
</tr>
<tr>
<td>4 Sided Building</td>
<td>723</td>
<td></td>
</tr>
</tbody>
</table>

**Chapter 12. COGO Menu**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inverse</td>
<td>725</td>
</tr>
<tr>
<td>Occupy Point</td>
<td>727</td>
</tr>
<tr>
<td>Traverse</td>
<td>727</td>
</tr>
<tr>
<td>Side Shots</td>
<td>729</td>
</tr>
<tr>
<td>Enter-Assign Point</td>
<td>729</td>
</tr>
<tr>
<td>Raw File On/Off</td>
<td>730</td>
</tr>
<tr>
<td>Line On/Off</td>
<td>730</td>
</tr>
<tr>
<td>Visual COGO</td>
<td>731</td>
</tr>
<tr>
<td>Locate by Line Bearing-Ang</td>
<td>735</td>
</tr>
<tr>
<td>Locate by Line Bearing</td>
<td>735</td>
</tr>
<tr>
<td>Locate by Azimuth</td>
<td>735</td>
</tr>
<tr>
<td>Locate by Turned Angle</td>
<td>736</td>
</tr>
</tbody>
</table>
Locate by Bearing ................................................................. 736
Locate by Delta ................................................................. 736
Locate at Intersect ............................................................ 737
Pick Intersection Points ..................................................... 737
Linework Intersection Points .............................................. 738
Bearing-Bearing Intersect .................................................. 738
Bearing-Distance Intersect .................................................. 739
Distance-Distance Intersect ................................................ 740
Perpendicular Intersect ...................................................... 741
Tangent Intersect ............................................................. 742
2 Point - 2 Point Intersect .................................................. 743
Resection ........................................................................... 743
Benchmark ........................................................................ 745
Numeric Pad COGO ............................................................. 746
Line by Angle-Distance ....................................................... 747
Tangent Line from Circles .................................................... 747
Getodetic ........................................................................... 748
Traverse .............................................................................. 748
Single Proportion Line Division .......................................... 748
Double Proportion Line Division ........................................ 749
Double Break ..................................................................... 750
Middle Break ..................................................................... 750
Irregular Boundary Adjustment .......................................... 750
Section Corners .................................................................. 752
Section Subdivision ............................................................ 752
GLO Corner Proportioning ................................................ 753
One Way Control .............................................................. 753
Two Way Control .............................................................. 754
Three Way Control ........................................................... 755
Four Way Control ............................................................. 757
Solar Observations .............................................................. 758
Triangle Solutions .............................................................. 761
Best Fit ............................................................................. 762
Best Fit Point ..................................................................... 762
Best Fit Circle .................................................................... 763
Best Fit Centerline ............................................................. 765
Best Fit Line by Average ..................................................... 767
Best Fit Line by Least Squares ........................................... 768

Contents
Set Active Area Table ......................................................... 831
Edit Area Table Properties .............................................. 832
Remove Area Table Rows .................................................. 834
Area Table Defaults ........................................................ 835
Consolidate Area Table ..................................................... 838
Area Description ............................................................ 839
Tag Area Descriptions ...................................................... 839
Identify Area Descriptions ................................................ 839
Untag Area Descriptions ................................................... 839
Adjust Areas .................................................................. 840
Hinged Area .................................................................. 840
Sliding Side Area ............................................................. 840
Area Radial from Curve ..................................................... 841
Bearing Area Cutoff .......................................................... 843
Layout Utilities .................................................................. 845
Lot Layout .................................................................. 845
Cleanup Lot Linework ......................................................... 846
Set Linework Angles To Nearest Second ......................... 848
Set Linework Intersections To Perpendicular .................. 848
Offsets & Intersections ....................................................... 848
Cul-de-Sacs ................................................................ 850
Elevate 2D Polylines ........................................................ 850
Parking .................................................................. 852
Draw Lot Setback ................................................................ 853
Footprint Creator ............................................................ 855
Set Back Measure-Move .................................................... 864
Fit Structure ................................................................ 865
Lot Network Settings .......................................................... 876
Lot Network Boundary ....................................................... 878
Lot Networks Sub-Areas ..................................................... 879
Tag Sub-Area ................................................................ 879
Untag Sub-Area ............................................................... 879
Identify Sub-Area .............................................................. 879
Report Sub-Area ............................................................... 880
Hatch Sub-Areas .............................................................. 880
Erase Sub-Areas Hatch ...................................................... 881
Label Sub-Areas ............................................................... 881
Lot Networks Roads ............................................................ 881
Contents
Lot File Utilities .......................................................... 907
Lot File Inspector .......................................................... 907
Right-of-Way Crossing Table ............................................. 908
Define Lot Attributes ..................................................... 911
Import Lot File From MDB Database ................................. 912
Export Lot File to MDB Database ...................................... 912
Export Lot File To Old SurvCADD ...................................... 913
Set CRD File for Lot Files ............................................... 913
Lot File to Centerline .................................................... 913

Chapter 15. Annotate Menu ............................................. 915
Annotation Defaults ..................................................... 916
Auto Annotate ............................................................. 924
Angle/Distance ............................................................ 933
  Custom Label Formatter AD .......................................... 935
Draw End Point Leaders ................................................. 936
Dynamic Annotation Note .............................................. 937
Flips Labels ................................................................. 937
  Switch Bearing/Azimuth Quadrant .................................. 937
  Mirror Selected Labels ............................................... 938
  Mirror and Flip Selected Labels ................................... 938
  Flip ON/OFF .......................................................... 939
  Flip Last Label ....................................................... 939
  Flip Selected Labels ................................................ 939
Annotate with Leader .................................................... 940
  Move Label with Leader ............................................ 940
  Bearing with Leader ................................................ 942
  Distance with Leader .............................................. 942
  Distance-Bearing with Leader .................................... 943
  Bearing-Distance with Leader .................................... 943
  Azimuth-Distance with Leader .................................... 944
Fix Label Overlaps ..................................................... 945
Global Reannotate ....................................................... 947
Survey Text ............................................................... 948
  Survey Text Defaults .............................................. 948
  Offset Dimensions .................................................. 949
  Building Dimensions ............................................... 950
  Adjoiner Text ........................................................ 951
Draw Grid ................................................................. 951
Special Line/Entity ................................................................. 990
Guard Rail ........................................................................ 991
Label Angle ...................................................................... 991
Label Coordinates/Elevation .................................................. 992
Label LatLong ..................................................................... 994
Label Curb Flow Elevations .................................................. 995
Replot Descriptions ............................................................... 996
Label Offset Distances ........................................................ 997
Label Elevations Along Pline .................................................. 998

Chapter 16. Surface Menu .................................................. 1001
Triangulate & Contour ........................................................... 1002
Contour from TIN File .......................................................... 1016
Draw Triangular Mesh ........................................................... 1017
Contour Utilities .................................................................. 1018
Smooth Contours ................................................................. 1018
Reduce Contour Vertices ....................................................... 1020
Edit Contours .................................................................... 1021
Contour ID ......................................................................... 1022
Color Contours by Elevation .................................................. 1022
Color Contours by Interval ..................................................... 1024
Highlight Index Contours ....................................................... 1025
Highlight Depression Contours ............................................. 1025
Change Contour-Plines Width ................................................ 1026
Contour Elevation Label ....................................................... 1026
Move Label Along Contour .................................................... 1028
Flip Contour Labels-Text ....................................................... 1029
Volumes By Triangulation ...................................................... 1029
One Triangulation Surface Volumes ........................................ 1032
Triangulation File Utilities ..................................................... 1033
Triangulation Surface Manager ............................................. 1041
Surface Manager ................................................................. 1041
Surface_Report ................................................................. 1049
Make 3D Grid File ............................................................... 1050
Draw 3D Grid File ............................................................... 1054
Two Grid Surface Volumes ..................................................... 1056
Volumes By Layers ............................................................... 1060
Spot Elevations ................................................................. 1062
Draw Spot Elevations ........................................................... 1062

Contents  ................................................................. xxii
Chapter 18. CGSurvey Module

CGFile

Current Information
Coordinate Files
Opening Closing and Saving
New
Open
Close
Save As
Export Coordinates to ASCII
Import ASCII File into Coordinates
Close Raw File
Close Map Check File
CGDos Drawings
Open Dos Drawing
Setup DOS Dwg
Convert Old CG Dos Level File to New Format
Convert Old CG Dos Raw File to New format
Convert Old CG Dos Cross Section File to New Format
Convert Old CG Dos Template File to New Format
Empty Print File
Print View Print File

CGTrav

Contents
Quick Traverse ........................................... 1189
Edit Raw File ........................................... 1192
Data Collector Transfer ................................. 1193
Reduce Traverse ......................................... 1246
Edit Map Check File .................................... 1261
Reduce Map Check File .................................. 1261
Visual Map Check ......................................... 1263
Create StarNet File ....................................... 1265
CGCogo ....................................................... 1268
General Information ...................................... 1268
Inverse ...................................................... 1269
Intersects ................................................... 1271
Station Offset ............................................. 1278
Station Offset ............................................. 1278
Coords From Station Offset ............................. 1279
Create Point Group From Station Offset ............ 1281
Display Centerline Stations ............................ 1281
Station Offset From Coords ............................ 1282
Points on Line ............................................ 1283
Curves ....................................................... 1286
Calculate Horizontal ...................................... 1286
Curve Between Tangents .................................. 1287
Middle Ordinate Solution ............................... 1288
Points on Arc ............................................. 1289
Spiral Curve Design ....................................... 1291
Spiral Curve Stakeout .................................... 1292
Stakeout Horizontal ...................................... 1293
Tangent Between Curves ................................ 1294
Vertical Curve Design .................................... 1295
Area Summary ............................................. 1296
Roadways ................................................... 1297
Right-of-Way Easements ................................. 1297
Intersections/Cul-de-sacs ............................... 1297
T Intersections ............................................ 1297
X Intersections ............................................ 1298
Y Intersections ............................................ 1299
Bubble Cul-de-Sac ......................................... 1300
Standard Cul-de-Sac ....................................... 1300
Introduction

- Website: http://www.carlsonsw.com
- Phone: 1-606-564-5028
- Email: support@carlsonsw.com
Products Overview

Carlson Software offers a full suite of commands for downloading, entering, and processing field survey data and for generating final plats and drawings. Carlson Software can function as a total and complete software solution for the land surveying firm, or as an affordable downloading, calculation, and preparatory solution used in conjunction with the more full-featured Carlson Software. Built around the Autodesk 2018 OEM graphics engine, Carlson Software reads and writes standard AutoCAD drawings and assures familiarity to AutoCAD trained staff.

Data Collection

The power of Carlson Survey begins with data collection. Carlson Survey downloads all major collectors ranging from Geodimeter and TDS to Leica, Nikon, Sokkia, and SMI. The raw data is stored in &acirc;&euro;&aelig;RW5&acirc;&euro; format and can be viewed, edited and processed. The processing, or calculation of coordinates, recognizes &acirc;&euro;&aelig;direct and reverse&acirc;&euro; and other forms of multiple measurement, and processes sets of field measurements. Surveys can be balanced and closed by selective use of angle balance, compass, transit, Crandall, and least squares methods&acirc;&euro; "or simply by direct calculation with no adjustment. Commands exist for finding bad angles and for plotting the traverse and sideshot legs of the survey in distinct colors as a means of searching for &acirc;&euro;&aelig;busts&acirc;&euro; or errors. In addition to downloading of data from electronic data collectors, the program accepts manual entry of field notes directly into a spreadsheet format, permitting review, storage, and editing. Alternatively, field notes can be entered for immediate calculation and screen plotting of points, with the &acirc;&euro;&aelig;raw notes&acirc;&euro; stored simultaneously, permitting re-processing and re-calculation as needed. For data that was not field-surveyed, but was provided in the form of an ASCII or binary point file, Carlson Software offers the &acirc;&euro;&aelig;Import Text/ASCII File&acirc;&euro; command, unrivaled in its flexibility to read foreign data sources.

Field to Finish

The survey world is recognizing the power of coding field shots with descriptions that lead to automatic layering, linework, and symbol work. Office drafting time can be reduced by 50% or more with intelligent use of descriptions, leading to &acirc;&euro;&aelig;field to finish&acirc;&euro; plotting. For example, breaklines, which act as barriers to triangulation, should be placed on streams, ridges, toe-of-slopes and top-of-banks for more accurate contouring. With the field to finish command, breaklines can be created by field coding, with descriptions such as DL, for creating 3D polyline ditch lines, or TB for creating top-of-bank polylines, etc. and this coordinate data can be simply plotted to the screen as undifferentiated points. However, with the field to finish command, the data can be plotted in one step, creating 3D polyline break lines, building lines, light poles, manholes, edge-of-pavements, that are all distinctly layered and fully annotated. The field to finish command within Carlson Survey is extremely robust, so much so that it can adapt to a coding system made up on-the-fly, or a coding system that has been received from an outsourced survey. Field crew coding and office processing using the field to finish command can save valuable hours of drafting and eliminate misinterpretations, paving the way for quick plat generation or supporting supplemental engineering work.

Deed Work

Carlson Survey allows you to enter old deeds and plot the linework, then add bearing and distance annotation optionally. Distances can be entered in meters and feet, and even in the old measurement forms of chains, poles, links, and varas. Both tangent and non-tangent arcs can be entered. Closures, distances traversed, and
areas are automatically reported. Working in reverse, the command Legal Description creates a property description suitable for deed recording directly from a closed polyline on the screen. If that polyline has point numbers with descriptions at any of the property corners, these descriptions will appear in the deed report, as in &acirc;&euro;,&aelig;&acirc;&euro;&brvbar;thence N 45 degrees, 25 minutes, 10 seconds E to a fence post &acirc;&euro;&brvbar;&acirc;&euro;. Deed files can be saved, re-loaded, edited, re-drawn and printed or plotted to the screen in a report form.

Drafting and Design

Carlson Software offers approximately 150 different symbols and north arrows, broken down by categories (for example, points, trees, map symbols). You can create new categories or supplement or change the available point symbols within any category. The program is designed to receive entire sets of new, customized point symbols in a single command. Attributes of points, such as elevation and point number, can be selectively &acirc;&euro;&aelig;&acirc;&euro; allowing the creation of final plats with symbols and optional descriptions remaining on points, as desired. Linework, typically in the form of polylines, can be drawn by any combination of point number and &acirc;&euro;&aelig;&acirc;&euro; selection, to create property lines, street lines, easements and right-of-ways, building lines and borders. In addition to Carlson Software &acirc;&euro;™s standard line types, dozens of special line types are available, including tree lines, fence lines, all manner of utility lines, stonewalls, and customizable line types. Design features include automatic street intersections and cul-de-sacs, and automatic lot layout. For lots, you can pick your right-of-way and back property polylines, specify desired acreages and frontage/rear lot parameters, and the lots are automatically calculated and drawn. Hinged Area, Sliding Side Area, and Area Radial from Curve are excellent design tools, with an easy, graphic interface. All design polylines can be converted to point numbers at vertices and radius points for purposes of field stakeout.

Annotation

With a full slate of annotation commands, Carlson Survey is all you need to finalize your boundary surveys and plats. There is a wide range of bearing and distance annotation options, including the Auto-annotate command, which allows you to annotate an entire selection set of polylines in one step. Station and offset annotating, as for right-of-way lines, is provided. Use commands such as Special Leader, Station Polyline, Draw North Arrow, and Draw Bar Scale to dress up the drawing and give it a hand-drafted look. Commands such as Title Block and Draw Legend, as well as sequential lot numbering and the area labeling commands, help you complete the finished drawing quickly.

Powerful Utilities

Carlson Software contains many strong utilities, particularly polyline utilities. You can Join Nearest disconnected polylines, turn 2-sided figures into closed, 4-sided figures, offset, trim, and extend 3D polylines, create building &acirc;&euro;&aelig;&acirc;&euro; with left and right entries using Extend by Distance, even reverse polyline directions. There are over 20 significant polyline utilities available, including Reduce Vertices, which weeds out duplicate or unnecessary vertices and cuts down on drawing size. Boundary Polyline is a simplified version of the AutoCAD command Boundary, and its opposite, Shrinkwrap Entity. Other categories of utilities include point attribute editing, scaling, twisting and re-sizing, text editing, font alteration and re-sizing, and advanced layer manipulation. Raster images such as aerial photos and scanned images can be placed on drawings.

Contouring and Terrain Modeling

There are many higher order features in Carlson Survey. Full contouring is provided, with options for smoothing and labeling contours, highlighting index contours and clipping contours to selected perimeters. Carlson Survey can be used to create both grid files and TIN files (.flt format). Volumes can be computed between grid files, inside any selected polyline perimeter. Profiles can be extracted from contour maps or hand-entered, as generic &acirc;&euro;&aelig;&acirc;&euro; profiles or as road profiles with vertical curves. The Design Pad Template command carves in building pads, pits, parking lots, roads, and other 3D features into any existing terrain. Land forms created by contouring and Design Pad Template can be viewed in 3D and rotated in real time, using the 3D Viewer Window command. In addition to all the commands needed to create final drawings, Carlson Survey
also contains commands to perform many engineering tasks typically encountered by survey firms.

Carlson Software is the ideal stand-alone solution for the survey and drafting organization, but it is also the perfect go-between product for the large civil engineering firm with in-house or outsourced survey operations. It complements Carlson Roads. Carlson Survey enables Carlson Software to serve the full spectrum of the surveying and civil engineering design world.

**System Requirements**

**Operating System**

- Microsoft® Windows® 7, Vista or Windows XP Professional or Home Edition (SP1 or SP2)

**Notes**

- It is recommended that you install and run Carlson Software on an English version of the operating system.
- Carlson OEM 2018 based products do not support Windows 95, 98, 2000, NT and ME (all editions).

**Processor**

Intel® Pentium® V processor or better recommended

**RAM**

4 GB

**Video**

1024 x 768 VGA display with true color

**Hard disk**

750 MB free disk space

**Pointing device**

Mouse

**Optional hardware**

Printer or plotter

Digitizer

Open GL-compatible 3D video card

The OpenGL driver that comes with the 3D graphics card must have the following: Full support of OpenGL or later. An OpenGL Installable Client Driver (ICD). The graphics card must have an ICD in its OpenGL driver software. The "miniGL" driver provided with some cards is not sufficient for use with this Autodesk CAD engine.

**Installing Carlson Software**

Before you install Carlson Software, close all running applications. Make sure you disable any virus-checking software. Please refer to your virus software documentation for instructions.
Note: If you are upgrading from an older version of Carlson Software, you must uninstall the older version before installing Carlson Software. This is required for successful software installation and to meet the guidelines of the EULA (End User License Agreement).

1 Insert the CD into the CD-ROM drive.

If Autorun is enabled, it begins the setup process when you insert the CD.

To stop Autorun from starting the installation process automatically, hold down the SHIFT key when you insert the CD.

To start the installation process without using Autorun, from the Start menu (Windows), choose Run. Enter the CD-ROM drive letter, and setup. For example, enter d:\setup.

2 The Windows Installer dialog box is displayed briefly, followed by a dialog box for entering in your serial number.

In the Enter Carlson Software 2008 Serial Number dialog box, you must enter the serial number provided with your copy of Carlson Software. Then click OK.

3 The Setup dialog box appears briefly, followed automatically by the Carlson Software 2008 Setup dialog. If this is the initial installation, you will see the dialogs shown below.
After reading this second dialog box, press Next. If this version of Carlson Software has already been installed, you will see a different Add/Remove dialog instead. In this case, it is recommended that you Cancel the current install and go to Windows > Control Panel > Add/Remove Programs and remove Carlson Software 2008. After the old installation is removed, you may start the install process once more to continue.

4 Review the End-user License Agreement, accept it with the correct click choice, and then click Next. You can optionally print it out.
On the Select Installation Type dialog box, select the type of installation you want: Typical or Custom. Choose Next.

Typical installs the following features:

- Program files: Executables, menus, toolbars, Help templates, TrueType® fonts, and additional support files
- Internet tools: Support files
- Fonts: SHX fonts
- Samples: Sample drawings
- Help files: Online documentation

Custom installs only the files you select. By default, the Custom installation option installs all Carlson Software features. To install only the features you want, choose a feature, and then select one of the following options from the list:
the list:
- Will be installed on local hard drive: Installs a feature or component of a feature on your hard drive.
- Entire feature will be installed on local hard drive: Installs a feature and its components on your hard drive.
- Feature will be installed when required only: Installs a feature on demand.
- Entire feature will be unavailable: Makes the feature unavailable.

6 On the Destination Folder dialog box, do one of the following:

Choose Next to accept the default destination folder/directory.

Choose Browse to specify a different drive and folder where you want Carlson Software to be installed. Choose any directory that is mapped to your computer (including network directories), or enter a new path. Choose OK and then Next.

Setup installs some files required by Carlson Software in your system folder (for example, c:\Windows\System, or c:\Winnt\System32). This folder may be on a different drive than the folder you specify as the installation folder (for example, d:\Program Files\Carlson Software). You may need up to 60 MB of space in your system folder, depending on the components you select to install. Setup alerts you if there is insufficient free space on the drive that contains your system folder.

On the Start Installation page, choose Next to start the installation.
The Updating System dialog box is displayed while Carlson Software is installed.

When the installation is complete, the Setup Complete dialog box is displayed. Choose Finish to exit the installation program.
It is strongly recommended that you restart your computer at this point in order for the new configuration settings to take effect.

Congratulations! You have successfully installed Carlson Software. You are now ready to register your product and start using the program. To register the product, double-click the Carlson Software icon on your desktop and follow the instructions.

**Authorizing Carlson Software**

The first time you start Carlson Software, the Registration Wizard is displayed.

Carlson Software has installed an automated procedure for registering your software license. Change keys are no longer given over the telephone. Please choose one of the following registration methods.

**Form:** This method allows you to fill out a form that you can print out and fax or mail to Carlson Software for registration.

**Internet:** If your computer is online, you may register automatically over the Internet. Your information is sent to a Carlson Software server, validated and returned in just a few seconds. If you are using a dial-up connection, please...
establish this connection before attempting to register.

**Enter change key:** Choose this method after you have received your change key from Carlson Software (if you previously used the Form method above).

**Register Later:** Choose this method if you want to register later. You may run Carlson Software for 30 days before you are required to register.

After you choose the registration method, press Next

Choose the reason for installation. The very first time you install Carlson Software is the only time you will choose the first reason. All subsequent installations require a choice from the remaining options.

**New install or maintenance upgrade of Carlson Software:** If you are installing Carlson Software for the first time, choose this reason.

**Home use. See License Agreement:** Choose this reason if you are installing on your home computer. See your license agreement for more details!

**Re-Installation of Carlson Software:** Choose this reason if you are reinstalling on the same computer with no modifications.

**Windows or AutoCAD upgrade:** Choose this reason if you have reinstalled Carlson Software after installing a new version of Microsoft Windows.

**New Hardware:** Choose this reason if you are installing Carlson Software on a new computer or if your existing computer has had some of its hardware replaced such as the hard disk, network adapter, etc.

After you choose the reason for installation, press Next, and then enter the required information into the dialog.
If you are using the Form method, press the Print Fax Sheet button, to print out the form. You may fax this form to the number printed on the form, or mail it to Carlson Software, 102 W. Second St., Suite 200, Maysville, KY 41056-1003.

If you are using the Internet method, press Next. After a few seconds, your registration will complete. If your registration is successful, you will receive a message such as the one below. If your registration is unsuccessful, please note the reason why and try again. Keep in mind that each serial number may be registered to a single computer only.

If you do not have access to the Internet, and do not have a printer, you must write down the information from the User Info tab (shown above) and fax it to 606-564-9525, or mail it to Carlson Software, 102 W. Second St., Suite 200, Maysville, KY 41056-1003.

**Carlson Registration**

Each Carlson program is licensed for use on one workstation which must be registered. The registration records your company name, Carlson serial number and AutoCAD serial number. To register your copy of Carlson, start Carlson and choose "Register Now". The following dialog will appear.

Note: Carlson Software will no longer issue change keys over the telephone. There are four registration options.

- **Fax**: This method allows you to print out the required information on a form which you then fax to Carlson Software. The fax number is printed on the form. The change key will be faxed back to you within 72 hours.

- **Internet**: Register automatically over the Internet. Your information is sent to a Carlson Software server, validated and returned in just a few seconds. If you are using a dial-up connection, please establish this connection before attempting to register.

- **Enter pre-authorized change key**: If you originally chose the Fax method above, you will need to choose this method now to enter the change key that is faxed back to you.

- **Register Later**: If you wish, you may defer registration up to 30 days. After this time, Carlson will enter demo mode which displays a message each time a Carlson command is run.
After you select the registration method, choose Next and select the type of installation you are performing, choose Next again to review the copyright information and to fill out the required information. At this point, if you are using the Fax method, press the Print Fax Sheet button. If you are registering using the Internet method, press Next and the process will start.

If you have any problems with Internet registration, please repeat this process and use the Fax method. The registration form is available on the Carlson Software website at http://www.carlsonsw.com/registration.html.

Tip: If Carlson is running, you may access the registration dialog by choosing About Carlson from the Help menu, then pick the Change Registration button.

**Setting Up a Project**

Over 200 Carlson Software settings can be specified in the *Configure* command on the Settings menu. These values are used to initialize Carlson Software options when opening a new or existing drawing. Among these settings is the coordinate point number format, object linking options, and settings for the COGO portion of Carlson Software. The template drawing is the default drawing that opens up each time Carlson Software is started. To customize the template drawing, run the OPEN command under the File pulldown menu, change the files of type setting to Drawing Template and choose the template drawing, "survey.dwt". Then make your changes and SAVE the drawing as survey.dwt in the Template folder.

When starting a new drawing, one of the first steps is to run *Drawing Setup* in the Settings menu. Drawing Setup sets the drawing scale, the units mode as either english or metric, and the text, symbol and linetype size scalers. The initial values for these Drawing Setup variables are set in Configure > General Settings. When a drawing is saved, the Drawing Setup variables are saved with the drawing. Carlson Software will set the text height according to the drawing scale and text size scaler set in Drawing Setup. For example, if the horizontal scale is set to 50 and the text size scaler is 0.1, Carlson Software will draw the text with a height of 5 \( (50 \times 0.1) \). Then, when the drawing is plotted at 1"=50', the text will be 0.1 inches.

Every drawing remembers the data files that are being used for the drawing. When the drawing (.DWG) file is saved with the SAVE or SAVEAS command, Carlson Software writes a settings file that contains all the active data file names. Then, when the drawing is reopened, the data files default to their previous settings. For example, you won't have to choose which coordinate file to use unless you want to change it. The settings file is stored in the same folder as the drawing file, and has the same name as the drawing, with an .INI extension. For example, a drawing called survey.dwg would have a settings file called survey.ini.

The Drawing Explorer command, in the Settings menu within the *Project* command, tracks and stores project files associated with each saved drawing. You may use this command to generate a report of all files used in a particular drawing. Project Explorer takes this concept one level further and allows you to group drawing files and their associated project files. Reports can also be generated using this tool.

**Startup Wizard**

For creating a new drawing in Carlson Software, the Startup Wizard can guide you through starting and setting up the drawing. This wizard is optional, and it can be turned on or off in the Settings menu by clicking *Configure*, then General Settings. You can also exit out of the Startup Wizard at any time. When the Startup Wizard is turned on and the New drawing command is executed, you will see the Select template dialog box.
Typically, you want to choose the drawing template SURVEY.DWT when you are using Carlson Survey, and then click Open. Remember that for Carlson Roads you will use ROADS.DWT. For Carlson Field you will use ROADS.DWT. The drawing template will set some of the basic drawing parameters, such as the default layer names. The Startup Drawing Wizard dialog appears.

Here, you need to set the new drawing name and scale. Set the drawing (.dwg) name by picking the Set button. The Drawing to Create dialog box opens. Change to the directory/folder ("Save in" field) where you want to store the drawing. You can either select an existing folder or create a new folder. Type in the drawing name in the File name field and click the Save button.
Then you can set the drawing horizontal scale, symbol size, text size and unit mode (English or Metric). Clicking the Next button brings up the Startup Wizard Data Files dialog box. This is for setting the Data Path and CRD File. The Set button for the Data Path is for setting the folder where Carlson Software will store the data files, such as raw (.RW5) files and profile (.PRO) files. The Set button for the Data Path allows you to select an existing folder or create a new folder. See the Set Data Directory command for more information.

The Coordinate (.CRD) File is the coordinate file for storing the point data. There is an option to create a new or existing coordinate file. The New option will erase any point data that is found in the specified CRD file. The Existing option will retain any point data in the specified coordinate (.CRD) file. If the specified coordinate (.CRD) file does not exist, the wizard will create a new file.

The next wizard step depends on the Import Points option. The Data Collector option will start the data collection routines to download data from a collector. The Text/ASCII option will import point data from a text/ASCII file. See the Data Collection and Import Text/ASCII File commands for more information on running these routines. If the None option is set, then the Startup Wizard is finished.

Once point data has been imported from the data collector or text/ASCII file, the wizard guides you through drawing the points. There are options to run Draw/Locate Points, Field To Finish or None. If None is selected, then the Startup Wizard is finished. Draw/Locate Points will import the points into the drawing using the same symbol and layer for all the points. From the Draw/Locate Points dialog, set the symbol, layer and point attributes to draw (description, elevation) and then pick the Draw All button. The Field To Finish command will import the points into the drawing using different layers and symbols depending on the point descriptions that refer to the code table defined in Field to Finish. Also Field to Finish can draw linework. See the Draw/Locate Point and Field To Finish
commands for more information on running these routines. After drawing the points, the wizard will zoom the display around the points. Then the wizard is finished.

**Command Entry**

Commands may be issued by selecting a pulldown menu, screen menu, digitizer tablet item, or by typing a command at the command prompt. Pressing Enter at the command prompt repeats the last command. Pulldown menus have a row of header names across the top of the screen. Selecting one of these header names displays the possible commands under that name. The pulldown menus are the primary method for command selection. This manual is organized by the contents of each pull-down menu.

Each section of this manual shows the pulldown menus which contain the commands that are explained in that section. Pulldown menus are sometimes also referred to as dropdown menus.

Quick Keys are explained in more detail in another section of this manual.

**Layer and Style Defaults**

Many Carlson Software commands have default layers such as AREATXT for area labels and BRGTXT for bearing and distance annotations. These layers can be specified in dialogs for the corresponding commands, and several can be set in the *Configure* command under the Settings menu. Sometimes you may want to use the current layer, and it can be an extra step to have to open the dialog to set the layer. In this case, instead of using the default layer that is set in the dialog, the default layer can be set as "CLAYER", which will use the current layer.

For example, if the annotation layer is set to CLAYER, then annotation will be drawn in the current layer instead of BRGTXT or whatever the annotation layer used to be. This same concept applies for text styles. Several commands have specific text styles and if you want to use the current style instead of the command style, use the name "CSTYLE" for the style name.
What is New

General
- Ultra High Resolution Displays - Improved font and image scaling for dialogs.
- Enterprise Licensing - Added support for multiple seats per serial number.
- 3D Viewers - Major performance improvements for handling large models. Added method to use different textures for surfaces based on slope. Added method to color the surface by the normals of the 3D faces. Added display of x,y,z coordinates for position of the cursor on the surface. Added control for thickness of linework. Added keyboard controls for panning and zooming the scene.
- Surface File Viewer - Added function to reload the surface. Added method to load multiple surfaces or solids.
- 3D Model Library - New command to define how to render CAD entities for 3D viewer for points, lines and areas.
- 3D Entity to 2D - Added support to flatten 3D Solids.
- Transparent Snap - Added a PI snap method.
- Drawing Save Log - New command to report the date, time and user for when the dwg has been saved.
- Select By Filter - Added filter for open/close status of polylines.
- Make Arrows Tangential - New command to adjust polylines to make arcs tangential.
- Chamfer By Chord Length - Added method for multiple chords.
- Remove Polyline Arcs - Added method to replace arcs with a set number of chords.
- Change Lineweight - New command to set the lineweight for the selected entities.
- Centroid Point - Added options to draw symbol and report elevation.
- Leader With Text - Added option to underline the text with the leader.
- Style Report - New command to list font files used in the drawing and the style properties.
- Output Layouts to PDF - Added option to optimize geometry.
- Drawing Setup - Added optional field for project location to include in reports and use for geolocating.
- Report Formatter - Improved Import/Export to process selected reports and avoid name conflicts.

Survey Commands
- Edit Points - Added a toolbar to the dialog for quicker access to common functions.
- Point Group Manager - Added functions to sort the groups by name or number of points.
- Edit/Process Raw Data - Added method to track any edits such as changing a rod height. Added function to scale values such as from meters to feet. Added processing for SurvCE tilt records.
- Edit/Process Level Data - Added report summary of elevations changes to the coordinate file.
- Field To Finish - For multi-point symbols, added option to center the symbol instead of using the first control point when only one point is survey, and added detection for points surveyed in the wrong order. For split multiple codes, added option to only draw symbol from the second code. Color setting now used for main, point and 3D polyline layers. Added option to keep trailing digits when creating a code table from CRD file. Added method to store GIS data to the CRDB.
- Draw Building Envelope Polyline - Added option to draw cross lines between corners.
- Distance Between Two Entities - Added option to dimension the minimum distance.
- Best Fit Centerline - Added settings for the minimum points on an arc and settings to make arcs tangential.
- Label Station Offset - Added option to label the lat/lon.
- Offset Point Entry - Added option whether to draw the new points.
- Elevation Along Entity - New command to create points at an elevation interval along a 3D polyline.
- Import Angle/Distance File - New command to draw a polyline using angles and distances in a text file.
- Annotation Defaults - Added setting for bearing leader offset and option to round angles to nearest 15 seconds.
- Arc Annotation - Added option to strip degrees leading zero for delta angles.
- Arc Dimensions - New command to label arc values along the chord or radial lines.
- Label Angle - Added option to draw dimension leaders for interior angles.
- Line Table - Added option to include the total distance.
- Curve Table - Added fields for the PC, PT and PI stations.
- Set Lot Edge Angles to Nearest Second - Added setting for how many seconds to round to.

Surface Commands
• Design Pad Template - Added option for no tie slope when the cut/fill is less than a minimum.
• Draw Triangular Mesh - Added option to draw the TIN surface as a surface object.
• Draw 3D Grid File - Added option to draw the grid surface as a surface object.
• Draw Spot Elevations - Added option to use MText. Added option for prefix or suffix on a separate row. Added leader style with horizontal underscore and option to draw a symbol with a leader.
• Label Pad Elevation - Added option to create labels at real Z.
• Cut/Fill Labels - Added option to only label cut or fill.
• Extend 3D Polyline To Surface - New command to extend a 3D polyline to the intersection with a surface model.
• Profile From 3D Points - Added method to process a selection set of points.
• Draw Profile - Added a description table to translate profile descriptions into labels and set symbols by description. Added option to skip the profile grid range dialog. Added method to draw a waterline profile based on a profile point description. Added method to create slope labels at an interval. Added option to label the sump depth on sewer profiles. Added option to label the pipe capacity on sewer profiles.

Data Conversions
• Projections - Added projection for Hotine Oblique Mercator Azimuth Center.
• SDMS - Added import of CTL files in Points > Import Text/ASCII File. Added import of EFB into Carlson Field to Finish code table.
• Civil 3D - Added export drawing method to convert Carlson TIN to Civil 3D Surface custom objects and Carlson centerlines to Civil 3D alignment custom objects. For import objects, added support for converting surface labels, note labels and grading objects to regular CAD entities. Also added import of Civil 3D Profile Styles from the drawing into Carlson Draw Profile PFS style settings.

Standard Report Viewer

Many Carlson routines display output in the Standard Report Viewer as shown below. A project name and job number can be added to the report header by filling out values for them in the Settings- >Drawing Setup command. The format for the date in the upper right of the report is controlled by the Date Format setting in Settings- >Configure- >General Settings. The report can be edited directly in the report viewer. Report Viewer commands are described below.

Open: This allows you to open an ASCII file and display the contents in the report viewer.

Save: Save the contents of the report viewer to a text file.

SaveAs: This allows you to save the contents of the report viewer to a file.

Append To: This allows you to append the contents of the report viewer to another file.

Print: Print the contents of the report viewer. This will open the standard windows Print dialog where you can choose the printer and modify any of the printer settings before you actually print.

Screen: Draws the report in the current drawing. The program will prompt you for a starting point, text height, rotation, layer and whether you want it inserted as Mtext or Text.

Undo: Reverses the effect of your last action. If you mistakenly deleted some text, stop and choose the Undo command to restore it. The key combination Ctrl+Z also performs this action.
Select All: Selects all the text in the report viewer.

Cut: Deletes the selected text and places it on the Windows® clipboard.

Copy: Copies the selected text to the Windows® clipboard.

Paste: Inserts ASCII text from the Windows® Clipboard into the report viewer at the cursor.

Search: Opens the Find Text dialog. Allows you to search for text in the report viewer.
**Replace**: Opens the Find and Replace Text dialog. Allows you to search for text and replace it.

**Options**: Opens the Report Viewer Options dialog. In this dialog, you can specify print settings, such as lines per page and margins. You can also specify the font used in the report viewer. This font is used for both the display and for printing.

**Hide**: This button allows you to minimize the report viewer window and give focus back to the Carlson CAD screen. This allows you to return to working on the Carlson CAD screen without closing the report. You can re-activate the report by picking on the minimized report viewer icon.

---

**Report Formatter**

A number of Carlson routines use a dialog box called Report Formatter Options to allow you to specify how and which results of calculations should be presented in the report. This report routine lets you select a set of data to report and the format of the selected data. The report can be displayed in either the standard report viewer as described in the previous section, Microsoft® Excel or Microsoft® Access.

The data set in the Report Formatter may be thought of as a spreadsheet, where columns are various fields related to a single item such as time period, drillhole, area and etc. Each new row represents a new item. Descriptions of these field names are displayed in the Available list of the Report Formatter. To include a data field in the report, highlight the field name in the Available list on the left and pick the Add button. This moves the field name to the Used list on the right. The order of items in the right list defines the order in which they will be displayed. In addition, the items may be sorted as specified by the user in the right column. Items are first sorted by the first column, then items with the same value in the first column are sorted as specified for the second column, and so on.

![Report Formatter Options](image)

These subsequent sortings do not modify sortings of previous columns. If you specify no sorting for some column (even the first one) then no sorting will happen in subsequent columns either. For example, you may want to sort production by mining panel name but not by month.

To generate the report after selecting columns and other preferences, click on Display button. It will bring up a standard report viewer showing the report data. Upon exiting the viewer, you come back into the Report Formatter for further data manipulation if needed. The other data output and destination options include saving the specified...
data into a comma-delimited text or CSV file, creating a spreadsheet preview whereby the data may be exported using several methods, and direct export to Microsoft® Excel. Due to the popularity of the Excel output choice, you can also customize certain Excel options, including setting mirror output, just prior to export. Data can also be merged to combine current and old reports, and it be exported to XML format files. There is an option for output to other database formats as well.

You may define new columns as equations based on existing columns. Click on the Edit User Attributes button to add a new field name. A list of the existing attributes is available for reference.

User attributes may have one of the several summation options just like program-generated ones (except that for them these options are set by program). The summation level is defined by the "Total" pop-up list in the middle of the dialog. By default only grand total will be displayed at the bottom of the list. By picking the next item in that box, you will get subtotals added each time the value in first column is changed. It makes most sense to use this kind to summation if the corresponding column is sorted. For example if the first column is "Area Name" and it is sorted, and "Total" is set to "Grand, Area Name" the report will have a sub-total for each distinct Area Name. This feature makes the Report Formatter a very flexible tool for results exploration, even before or without using a spreadsheet.

Various forms of reports may be saved and recalled using controls in the top line of the dialog.
To save a new version of the format, type in a new name (or use default to overwrite old one) and click on the Save button. The next time that you come to the Report Formatter from the same Carlson routine it will recall this last format. To pick another format just pull down on list of formats in the left top corner and pick which format to use. To Delete an unwanted format, pick it from the list first and then click on Delete button.

There are several Microsoft® Excel export options provided. You may specify a spreadsheet file to load before export, as well as a left upper cell to start with and sheet number to use. Totals which are reported when using built-in viewer may be skipped when using Microsoft® Excel export.

For commands that process reports using perimeter polylines, the Report Formatter has an option to create GIS links between the polylines and the database records when the Export to MS Access function is used. When the polyline data is available for the GIS Links, there will be a report field called Handle. This Handle field is the AutoCAD entity name for the polyline and serves as the hook for the GIS link. The Handle field does not need to be put into the report Used list in order to create the links. When the Export function is called with the MS Access method, there is a pop-up window prompt for whether to create the GIS links. When these links are created, you can then use the GIS menu commands to manage and report the data.
Instruction Manual and Program Conventions

*Westwood*

Italic text represent responses by the user that should be typed in and followed by the Enter key.

**Number/<Pick point>:**

Bold text represents prompts or questions that the computer program will ask the user.

<90.0000>

Values enclosed in corner brackets represent default values obtained by pressing Enter with a blank response.

[end on]

Lower case text enclosed in brackets in Command prompts denotes an *OSNAP* mode that is turned on by the command.

**Carlson File Types**

.AAN Auto-annotate settings
.ADF Annotation Default settings
.ARX AutoCAD Runtime Extension For Carlson Program
.ATR Strata attribute definitions
.AVG Mining Composite Quality Analysis
.BLK Mining Block Model
.CAL Mining equipment calendar
.CAP Capacity file for hydrology (stage-storage)
.CDF Geology Channel Sample File Format
.CDS MDL Laser Raw Data
.CDT Mining custom date table
.CFG Configure Configuration Settings
_CFZ Cut/Fill Color Map Zones
Chapter 1. Introduction
Chapter 1. Introduction
Quick Keys

"Quick Keys" allows you to enter in the coding shown here on the left, and by doing so run the commands shown on the right.

2DP = 2D Polyline
3DP = 3D Polyline
A = Arc
AL = Align
B = Block
BB = Bearing-Bearing Intersect
BD = Bearing-Distance Intersect
BH = Boundary Hatch
C = Circle
CH = Change Properties
CO = Color
CP = Copy
DD = Distance-Distance Intersect
DI = Distance
DT = Draw Text
E = Erase
EA = Enter-Assign Point
EX = Extend
F = Fillet
H = Hatch
I = Inverse
L = Line
LI = List
LP = Draw-Locate Point
LS = List
M = Move
MI = Mirror
O = Osnap
OF = Offset
OP = Occupy Point
P = Pan
PL = Polyline
PR = Properties
PREF = Preferences
R = Redraw
RE = Redo
RG = Regen
RO = Rotate
SC = Scale
SET = Set Environment Variable
SS = SideShot
ST = Style
T = Traverse
TR = Trim
UN = Undo
UT = Units
VP = Viewpoint
W = Write Block
Obtaining Technical Support

via Discussion Groups

- Carlson Software operates user discussion groups located at news://news.carlsonsw.com. You can participate in user-to-user discussions on tips, tricks and problems. Our staff monitors these groups to ensure that all the issues are addressed. Visit our website at http://www.carlsonsw.com for information on how to access these groups.
- You may also access the Carlson Software Knowledge Base. Visit it directly at http://update.carlsonsw.com/kbase_main.php.

via Electronic Mail

- The Technical Support e-mail address is support@carlsonsw.com.

via Phone/Fax

- Phone: (606) 564-5028
- Fax: (606) 564-6422

via Web Site

Check the Carlson Software web site at http://www.carlsonsw.com for:

- Knowledge Base, discussion groups, technical support documents and newsletters
- Carlson Software manuals (PDF) and training movies
- Training and seminar schedules
- Step by step procedures on popular called-in topics
- Carlson Software and Autodesk downloads and updates (Feel free to register for automatic update notification of updates when you come to that area.)

via Training

- Basic, advanced and update training is available from Carlson College. Enroll on our webpage or call 606-564-5028 and ask for Carlson College.

License Agreement

Copyright 1992-2019 Carlson Software All Rights Reserved

CAUTION! READ THIS NOTICE BEFORE USING SOFTWARE

Please read the following Software License Agreement before using this software package. Using this software indicates that you have accepted its terms and conditions.
END-USER LICENSE AGREEMENT FOR CARLSON SOFTWARE

IMPORTANT-READ CAREFULLY: This Carlson Software End-User License Agreement ("EULA") is a legal agreement between you (either an individual or a single entity) and Carlson Software, Inc for the Carlson Survey 2009 software accompanying this EULA, which includes computer software and may include associated media, printed materials, and "online" or electronic documentation ("SOFTWARE PRODUCT" or "SOFTWARE"). By exercising your rights to make and use copies of the SOFTWARE PRODUCT, you agree to be bound by the terms of this EULA. If you do not agree to the terms of this EULA, you may not use the SOFTWARE PRODUCT.

SOFTWARE PRODUCT LICENSE

The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold.

1 GRANT OF LICENSE This EULA grants you the following rights: Applications Software. You may install and use one copy of the SOFTWARE PRODUCT, or any prior version for the same operating system, on a single computer. The primary user of the computer on which the SOFTWARE PRODUCT is installed may make a second copy for his or her exclusive use on a portable computer. Storage/Network Use. You may also store or install a copy of the SOFTWARE PRODUCT on a storage device, such as a network server, used only to install or run the SOFTWARE PRODUCT on your other computers over an internal network; however, you must acquire and dedicate a license for each separate computer on which the SOFTWARE PRODUCT is installed or run from the storage device. A license for the SOFTWARE PRODUCT may not be shared or used concurrently on different computers.

2 DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS Limitations on Reverse Engineering, Decompilation, and Disassembly. You may not reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that such activity is expressly permitted by applicable law notwithstanding this limitation. Separation of Components. The SOFTWARE PRODUCT is licensed as a single product. Its component parts may not be separated for use on more than one computer. Software Transfer. You may permanently transfer all of your rights under this EULA, provided the recipient agrees to the terms of this EULA. Termination. Without prejudice to any other rights, Carlson Software may terminate this EULA and disable the software if you fail to comply with the terms and conditions of this EULA. In such event, you must destroy all copies of the SOFTWARE PRODUCT and all of its component parts. In cases of installation of software obtained by illegal means Carlson Software may collect end-user information.

3 COPYRIGHT All title and copyrights in and to the SOFTWARE PRODUCT (including but not limited to any images, photographs, animations, video, audio, music, text, and "applets" incorporated into the SOFTWARE PRODUCT), the accompanying printed materials, and any copies of the SOFTWARE PRODUCT are owned by Carlson Software or its suppliers. The SOFTWARE PRODUCT is protected by copyright laws and international treaty provisions. Therefore, you must treat the SOFTWARE PRODUCT like any other copyrighted material.

4 U.S. GOVERNMENT RESTRICTED RIGHTS The SOFTWARE PRODUCT and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 CFR 52.227-19, as applicable. Manufacturer is Carlson Software, 102 West Second Street, Maysville, KY 41056

LIMITED WARRANTY NO WARRANTIES. Carlson Software expressly disclaims any warranty for the
SOFTWARE PRODUCT. The SOFTWARE PRODUCT and any related documentation is provided "as is" without warranty of any kind, either express or implied, including, without limitation, the implied warranties or merchantability, fitness for a particular purpose, or noninfringement. The entire risk arising out of use or performance of the SOFTWARE PRODUCT remains with you. NO LIABILITY FOR CONSEQUENTIAL DAMAGES. In no event shall Carlson Software or its suppliers be liable for any damages whatsoever (including, without limitation, damages for loss of business profits, business interruption, loss of business information, or any other pecuniary loss) arising out of the use of or inability to use this Carlson Software product, even if Carlson Software has been advised of the possibility of such damages. Because some states/jurisdictions do not allow the exclusion or limitation of liability for consequential or incidental damages, the above limitation may not apply to you. MISCELLANEOUS If you acquired this product in the United States, this EULA is governed by the laws of the State of Kentucky. If this product was acquired outside the United States, then local laws may apply.
Tutorials

This section contains tutorials designed to assist you in learning this Carlson Software product. It is recommended that you try some of these out when you are first starting to learn the software, or when you need some pointers later on.

You will see how to enter a deed, make a plat and use Field to Finish for faster drafting. There are also lessons on intersections and subdivisions, SurvNET, contouring, DTM and design. Using break lines and surfaces are also covered.

Some of the tutorials will ask you to open drawing and data files that are provided to you at purchase. Good luck!
Lesson 1: Entering a Deed

In this short lesson you will create a simple drawing. You will enter a 6-sided deed, add a title block, bar scale, and north arrow, add a title and certification text, and plot the deed area.

Note that the Esc key will cancel most commands, so if you choose the wrong command or enter something incorrectly and want to start over, just press Esc.

1 Click the icon for Carlson. You may be presented with a "Startup Wizard" dialog box. If so, click Exit.

2 Under the Settings menu, click Drawing Setup. Set the unit setting to English and the Horizontal Scale to 50. Click OK.

![Drawing Setup dialog box]

3 Choose Point Defaults from the Points menu, and, in the dialog box, click Elevations off to eliminate the Elevation prompt. Click Descriptions on and also set the point symbol name to symbol 4 (SPT4), which is the round, open circle. Click Automatic Point Numbering on. Click OK.

4 Under the Survey menu, select Enter Deed Description. Use the default settings as shown in this dialog box image.
Set the To Table Scaler option to 0.00. This places all of the deed calls in the drawing. The To Table Scaler determines which deed calls appear in the drawing and which deed calls appear in a table. Deed calls less than the To Table Scaler value multiplied by the Drawing Scale will be placed in a table of calls. Set the dialog box options to match those shown above. Click OK.

The command line is the area below the graphics and to the left. When prompted to "Pick point or point number" at the command line, pick a point in the lower left quadrant of your screen to start the deed plotting. If you are prompted for elevation, you failed to turn off the elevation prompt in Point Defaults. Press Esc and return to the Point Defaults command.

The following dialog box will appear so you can specify where to store the coordinates:

Select the New tab. Then, for the File Name, type in Deed. This creates a file called Deed.crd. All Carlson points are stored in files with the "crd" extension, which stands for "coordinates." Click Open. Now respond to the
When you are prompted for a description, enter "Fence Post".

**Exit/Curve/<Bearing (Qdd.mmss)>**: 125.3500

The quadrant (Q) is 1 for Northeast (2 is Southeast, 3 is Southwest and 4 is Northwest). The bearing is 25 degrees, 35 minutes, and 00 seconds. If all digits for the minutes and seconds are entered as shown above, then the deed call will be fully plotted, including the seconds. If only the degrees and minutes were entered, as in 125.35, then the plot would appear as "N 25° 35' E".

**Varas/Meters/Poles/Chains/<Distance(ft)>**: 200.51

Note that you can enter old deeds in the forms of Poles and Links, Chains and Links and even Varas (a unit of measurement formerly used in the southwestern states of the U.S.).

**Enter Point Description <Fence Post>**: Iron Pin

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>**: 189.4321

**Varas/Meters/Poles/Chains/<Distance>**: 225.00

**Enter Point Description <Iron Pin>**: press Enter

Pressing Enter selects the default, which is Iron Pin.

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>**: C

**Radius**: 75

**Curve direction [Left/<Right>]?** press Enter for right

**Non-tangent/Reverse-tangent/Bearing/Chord/DeltaAng/Tangent/<Arc Len>**: 118.17

If you don't know the arc length, but you know the tangent, you would choose "T" for tangent.

**Enter Point Description <Iron Pin>**: press Enter

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>**: 200.0000 (due south)

If you were to enter just 2 (no degrees, minutes, or seconds), then the deed call would be plotted "S 000 E".

**Varas/Meters/Poles/Chains/<Distance>**: 178.00

**Enter Point Description <Iron Pin>**: Concrete Monument

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>**: 488.2300

This entry specifies Northwest 88 degrees, 23 minutes.

**Varas/Meters/Poles/Chains/<Distance>**: 300.34

**Enter Point Description <Concrete Monument>**: Fence Post

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>**: 454.1109

**Varas/Meters/Poles/Chains/<Distance>**: 106.93

**Enter Point Description <Fence Post>**: press Spacebar, then press Enter

Simply pressing Enter uses the default text (Fence Post) again. To avoid drawing the text "Fence Post" twice on the end point, press the spacebar, skip a blank character, and press Enter.

You have now completed the 6-sided figure (including one curve).

**Undo/Exit/Curve/<Bearing (Qdd.mmss)>**: E

The following results are reported:

SQ. FEET: 83921.8  SQ. YARDS: 9324.6  SQ. MILES: 0.0

ACRES: 1.93

Closure error distance> 0.01708540  Error

Bearing> S 52d5'26'' E

Closure Precision> 1 in 66076.89  Total Distance Traversed>

1128.95

SQ. FEET: 82302.9  SQ. YARDS: 9144.8  SQ. MILES: 0.0

ACRES: 1.89

The resulting deed, has a closure of 1:66077. In the initial prozmpt "Undo/Exit/Curve...", U for Undo would allow you to reenter the previous deed call.
Use the Extents command on the View menu to see the entire area. Then choose Zoom Out under the View menu giving you adequate room for the next step.

5 Under the Settings menu, select Title Block. The first dialog you will see is shown here:

Select Paper Size B2 (11 x 17), and enter the layer name of BORDER, then choose OK. You will be prompted for the border location, pick a point in the lower left of the survey.

The following dialog appears, allowing you to enter the attributes for the Title Block. After you have completed the title block entries, as shown below, select OK.
Note that the title line is plotted in large text on the title block. Its length, therefore, should not exceed 15 characters.

Your drawing should look like the example below at this point.

Use the *Extents* command, found in the View menu, to see the entire working area. If you want to move the border, use the *Move* command on the Edit menu. Pick the border lines and the title block objects (up to 3 picks total), press Enter (to end object selection), then pick two points representing the vector of the move.

If you want to see a margin around the working area after you use the Extents command, use the Zoom Out command on the View menu. Then use the Window command on the View menu to capture the view and margin you prefer.
If you make a mistake, enter U for undo, or select the back arrow icon that appears at the top of the screen.

6 On the Annotate menu, select *Draw North Arrow*.

![Draw North Arrow dialog box]

Accept the default north arrow that is shown at the right side of the dialog, click OK, and place it in the upper right of your drawing. Choose *Move* on the Edit menu (or Enter M for move at the command line) and move it.

7 On the Annotate menu, select *Draw Bar Scale*. Accept the defaults, and then pick an insertion point below the north arrow and directly above the "a" in Farmer, and approximately the same distance from both. You can move the bar scale using the *Move* command on the Edit menu, if you need to.

8 On the Draw menu, select *Dynamic* within the *Text* command. Respond to the prompts as shown below:

Specify start point of text or [Justify/Style]: J
Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]: C for center justified
Specify center point of text: Choose a point near the top-center of the drawing.
Specify height <4.00>: 10 Entering 10 make the title text bigger than the default.
Specify rotation angle of text <E>: E
Text: Farmer Survey
Text: Ashland, KY
Text: press Enter

To enter a certification in the lower-right of the drawing, again select Text > Dynamic from the Draw menu, or type "dtext" at the command line. If you haven't done anything else, such as Zoom or Pan, you can simply press Enter to repeat the last command. If pressing Enter does not repeat the Text command, press Esc to cancel. Enter Dtext at the command prompt, and respond to the resulting prompts as shown below.

Pick a point above and to the left of the title block for the certification. You don't have to enter L for left-justification. The Dtext command defaults to left-justification every time.

Height <10.00>: 4
Rotation angle <E>: press Enter
Text: Surveyor's Certification
Text: Press spacebar, then press Enter
I do hereby certify that the survey shown hereon is a true and correct representation.

Press spacebar, then press Enter

Arnold James, PLS #2534

Press Enter twice to end

The following is a closeup of the certification that we just entered:

Surveyor's Certification
I do hereby certify that the survey shown hereon is a true and correct representation...

Arnold James, PLS #2534

The degree symbol is represented as %. (If you had typed N 15%%d25'35" E in the Dtext command, Carlson

Chapter 2. Tutorials 38
would draw that entry as N15°25'35"E.) Click in the text to the immediate right of the quotation mark and press the Backspace key until the text reads as shown here.

Click OK. Press Enter to exit the command.

12 In the enlargement in Step 8 showing the title block and also showing point 5, notice how the linework travels into the circle that represents the point. To clip off the linework at the edge of the corner symbols, use the Trim by Point Symbol command on the Points menu. This command requires that all points be in view, so if you cannot see your entire drawing, use the Extents command on the View menu (sometimes referred to as Zoom Extents). Respond to the following prompts:

Select point symbols to trim against. Select objects: ALL
Entering "all" at the command line selects everything on the screen. Only the linework crossing into the corner symbols will be trimmed.

Select objects: press Enter
You can continue to select objects until you press Enter.
The trimming is completed.

13 Prepare for area labeling by selecting the Area Defaults command on the Area menu. The dialog box shown below appears. Change the Other Area Labels and Inverse with Area decimal precision to 4 decimal places. Also, make the Area Text Size Scaler 0.2 (doubled from the default of 0.1).

You are going to compute the area by point number. You could have chosen the Area by Lines & Arcs command. In that command, you would pick the lines and arcs that make up the figure. But since the closure was 0.017 off (the
distance from point 7 to point 1), you would exceed the default Max gap tolerance. Unless you change that tolerance in this dialog box to something larger than 0.017, you would get no result using the Area by Lines & Arcs command. So do not change it for this exercise because you might forget to change it back. Instead, you will compute the area by inverting from 1 through 7 and back to 1. Click OK to exit the Area Defaults dialog box.

14 Select Inverse with Area on the Area menu. Respond to the prompts as shown below:

Station/<Pick Starting point or point number>: 1
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 2
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 3
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): R
Radius point number or pick point: CEN for center "snap"
Now move the cursor, without picking, to the arc and see how the center snap becomes active. When the radius point is found, pick on the arc.

Curve direction [Left/<Right>]? press Enter for the Right option
Pick End of Arc or point number (U-Undo, Enter to end): 4
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 5
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 6
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 7
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): 1
Pick point or point numbers (R-RadiusPt, U-Undo, Enter to end): press Enter to end

A Standard Report Viewer dialog box showing the Inverse with Area results will appear. Select Exit at the top of the dialog box and respond to the prompts as shown below:

SQ. FEET: 83921.8 SQ. YARDS: 9324.6 SQ. MILES: 0.0
ACRES: 1.9266 PERIMETER: 1128.9671

Pick area label centering point (Enter for none): pick a point near the center of the figure, in its interior. The area units you chose in Area Defaults are labeled on the screen.

Erase Polyline [<Yes>/No]: Y
This erases a polyline that has been drawn over the original lines and arcs. The Inverse with Area command draws this polyline because often you are solving the area from points and want the new linework drawn.

You snapped to the radius point using the "cen" snap. Additional object snaps appear under Aperture-Object Snap command on the Settings menu. Since all plotted points have a node, you could have inverted around this figure by using the "nod" snap for points 1 through 7, and the "cen" snap to capture the radius point. Snaps are typically entered at the keyboard as 3 characters (for example, "int" for intersect and "end" for endpoint).

15 Freeze the point numbers to finish the drawing by choosing Layer Control on the View menu. In the PNTNO row, click the sun icon to change it to a snowflake icon, which freezes the PNTNO layer. Click OK. The point numbers remain in the drawing, waiting to be "thawed", but they are not displayed.

The final drawing is shown here:
This completes the Lesson 1 tutorial: Entering a Deed.

Lesson 2: Making a Plat

In this lesson you will draw out a plat of a single lot, using Carlson drafting techniques. You will make the plat from an ASCII file of points named Plat.txt.

1 Click the icon for Carlson. You may be presented with a Startup Wizard dialog box, as shown below:

You will use the Wizard in Lesson 3 to quickly perform a series of commands. In this lesson, however, you will enter the commands individually, so that you can see what each one does.
If you see the Startup Wizard dialog box, and you don't want to see it again, click the Skip Startup Wizard Next Time option in the dialog box above. Make sure the other settings are as shown above and click Exit.

Another way to turn off the Wizard is to click it off within the Configure > General Settings command, found under the Settings menu. You will open this General Settings dialog box now.

2 On the Settings menu, click Configure to display the following menu:

Click General Settings to display the dialog box shown here.

The settings in this dialog box, along with the settings in other Configure sub-options, determine default working conditions for Carlson. Turn on Group Point Entities, which groups point elevations, numbers, and descriptions (all aspects of the points) into a single entity for moving, erasing and other commands.

Choose Numeric Only to store points in numeric form. This produces point numbers such as 1, 2, 3, 10 and 11. If you selected Alphanumeric, then you could have point numbers like 1A, 1B, 1C, HUB5, CTRL, SS10, etc. There is
a slight speed advantage to working with purely numeric point numbers. The highest numeric point number allowed is 32000. Regardless of format, point numbers are stored in a file that has a .crd extension. There is no limit to the number of points in an alphanumeric coordinate file. In anticipation of Lesson 3, click on the Use Startup Wizard option. Click OK at the bottom of this dialog box.

Now we want to set the data path. Another of the Configure sub-options is Project/Data Folders. Click this option and you will see this dialog box.

For this lesson, you will keep it simple. Click on Fixed Folder at the top. Notice the Current Data Folder section at the bottom. This specifies where data files, such as .crd files in this case, are to be stored. Set the folder to C:\Carlson2008\DATA. Click OK. You are now back to the Configure main dialog.

3 Select Drawing Setup from the Configure main dialog box.
The scale acts as a multiplier on all text annotation. For example, $100 \times \text{Text Plot Size (0.08)} = 8$ (text height of 8 units). The Text Plot Size is the effective height, in inches, that the text will appear when plotted at the Horizontal Scale (here 100).

Bearings and Distances, Legends, Title Blocks, and Point Symbols will size up or down on the basis of the Horizontal Scale set within Drawing Setup. Set the Horizontal Scale to 100. Then click OK to exit Drawing Setup. Then click Exit to close the Configure dialog box.

Next, you will import the ASCII file called Plat.txt and store the points in a Coordinate file called Plat.crd. However, since you are in a new drawing, you have not yet set a coordinate file to store the points in. You must have a Carlson coordinate file (.crd) open and established as the container for your points.

So, under the Points menu, select the command Set Coordinate File to display a dialog box. Click the New tab, as shown here. To the right of File name enter Plat and click Open. You have now created the required .crd file.
You are now ready to import the points. This time, under the Points menu, select *Import Text/ASCII File* to display the Text/ASCII File Format dialog box, as shown below. Click the Select Text/ASCII Files button and then choose Plat.txt listed on the right. It is found in the default data folder (C:\Carlson2008\Data). Click Open.

Plat.txt is an ASCII file containing 54 points in the form of Point Number, Northing, Easting, Elevation and Description. The format of the points appears in the Preview Window. The format is: Point (P), Northing (Y), Easting (X), Elevation (Z), Description (D), or, in short, P,Y,X,Z,D. You must match this format in the Coordinate Order. If you don't see P,Y,X,Z,D in the Coordinate Order box, then select that format from the Common Formats option. Or, you can type the list directly into the Coordinate Order box. Make sure that Draw Points is set to Off.

Click OK. The points will be saved and stored in Plat.crd. A confirming dialog appears as follows:

Click OK.

5 Choose the *List Points* command under the Points menu.
The *List Points* dialog box will typically default to the full range of points, which is 1 through 54 in this exercise. You can control the decimal places for the Northing/Easting and the Elevation of the points in the lower portion of the dialog box. Click OK and the settings shown above result in the report exhibited below in the Standard Report Viewer:

Exit the report by selecting the Exit icon at the top of this report viewer box, or by clicking the X in the upper right of the window.

6 Select the *Draw-Locate Points* command on the Points menu to draw the points on the screen.
In this figure shown above, the current Symbol Name is showing as SPT10, which stands for Survey Point symbol 10. SPT10 is an X, shown in the symbol display window. You can select a different default symbol using the Point Defaults command on the Points menu.

In this exercise you will change the Symbol Name to null, or symbol 0, listed as SPT0 (in effect, no symbol). Later, you will add official property corner and utility symbols. Although you are working without a default symbol, there will always be a “dot” or a node at the correct insertion point of each point number.

At the top click Select. You will see the following dialog box:

Note that the scroll bar at the right of this Select Symbol dialog box leads to more pages of symbols. Click the blank SPT0 point symbol option.

When you select a symbol, you automatically return to the Draw-Locate Point dialog box. Click Draw All to display the rather busy drawing shown below:
You will now be using the *Scale Point Attributes* command on the Points menu. Notice how the lower-right corner of the drawing is very congested, with many point attributes overlapping. You can specify a window containing these points and scale them down by a factor of 0.4. For Scaling Multiplier, you will enter 0.4. When you are prompted to Select Carlson Software points, you will enter WP for Window Polygon and make a polygon around the congested area. Press Enter when you have surrounded the points with the polygon as shown below. Here is the command line sequence, along with the responses you will enter, after clicking *Scale Point Attributes*:

**Scaling Multiplier** <0.500>: .4  
Scale symbols only, point labels only or both [Symbols/Labels/<Both>]? press Enter  
Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter  
Select Carlson Software points.  
Select objects: wp  
First polygon point: start creating your polygon
Once this polygon is complete, you are again prompted to select points. Press Enter. The following shows the scaled points.

Next, you will prepare for drawing linework by setting the current layer. You should draft linework and symbol work in designated layers. In this example, you will put linework and symbol work in a layer named Final. (You could put property linework in the Final layer and utility linework in the Utility layer, but, for now, you will put all linework and symbols in the layer Final.) To pick the current working layer, select the Layer Control command from the View menu.
Click Final. Click Current. Click OK.

9 The 2D Polyline command allows you to enter point numbers to draw a line. First, connect portions of the property line. Select the 2D Polyline command on the Draw menu. A dialog box might appear. If it does, accept the defaults and click OK.

[Continue/Extend/Follow/Offset/OPtions/<Pick point or point numbers>]: 1
[Arc/CLOSE/Distance/Offset/Undo/<Pick point or point numbers>]: 8
[Arc/CLOSE/Distance/Extend/Follow/Line/Offset/Undo/<Pick point or point numbers>]: press Enter

This creates a polyline. Keep this as a separate polyline because later you will turn this back lot line into a fence line.

Now, connect some of the other property lines. Repeat the 2D Polyline command. You can press Enter to repeat the command, or you can select it from the Draw menu. Connect points 8 through 10, and start an arc, by entering as follows:
[Continue/Extend/Follow/Offset/Options/<Pick point or point numbers>]: 8-10
[Arc/Close/Distance/Extend/Follow/Line/Offset/Undo/<Pick point or point numbers>]: a
[Radius pt/radius Length/Arc length/Chord/Second pt/Undo/<Endpoint or point number>]: 15
[Arc/Close/Distance/Extend/Follow/Line/Offset/Undo/<Pick point or point numbers>]: 1
[Arc/Close/Distance/Extend/Follow/Line/Offset/Undo/<Pick point or point numbers>]: press Enter to end the command

This creates the full lot, with the arc coming off point 10 on a tangent. The line from 15 to 1 is not guaranteed to be tangent to the previous arc.

You should have the following linework at this point:

![Diagram of lot layout with linework and coordinates]

10 You will now create a fence line on the polyline you drew from points 1 to 8. Go back to Drawing Setup from the Settings menu and set the Horizontal Scale to 50. Click OK to exit Drawing Setup.

Now, choose the Line Types command on the Annotate menu and select the Change Polyline Linetype command. The Line Types command creates polylines that respond as one entity when selected. When the dialog box appears, click Next twice to display the dialog box shown below.
Choose the Fence S option (the solid fence line).

When prompted to Select Objects, pick the polyline you created from points 1 to 8. Press Enter to end selection. Notice in the dialog box above that the current Line Type Scaler, governing spacing, should be 0.5 (inches) and the Text (height) Scaler is 0.1. If your settings are different, you may want to Undo (by entering U for undo) the fence line and select the Annotate Defaults command on the Annotate menu, and set these items to match the example.

On the View menu, select the Isolate Layers command, pick the property line, and press Enter twice. Here is the result:
Next, you will connect up the edge of pavement. On the View menu, select the *Restore Layers* command to restore your points. Then select the *2D Polyline* command under the Draw menu. Again, a dialog box might appear as shown below. If it does, make sure that the options selected are the same. In the future you can choose not to see this box.

![Polyline 2D Options dialog box](image)

Click OK. Proceed as follows to connect up the edge of pavement:

**[Continue/Extend/Follow/Options/][Pick point or point numbers]>**: 45-47, 49-51
Press Enter at the next prompt to exit the command and create the road. Press Enter one more time. Note how you can separate range entries using a comma.

12 To smooth the edge of the road, select the *Polyline Utilities* command on the Edit menu, and select *Smooth Polylines*.

**Enter the looping factor (1-10) <5>:** press Enter
**Enter the offset cutoff <0.05>:** press Enter
**Select objects:** pick the edge of road polyline
**Select objects:** press Enter

13 To offset the smoothed edge-of-road polyline by 24 feet to make the opposite edge of the road, Select the *Standard Offset* command on the Edit menu.

**Specify offset distance or [Through/Erase/Layer] <Through>:** 24
**Select object to offset or [Exit/Undo] <Exit>:** pick the edge-of-road polyline
**Specify point on side to offset or [Exit/Multiple/Undo] <Exit>:** pick to the right of the polyline
**Select object to offset or [Exit/Undo] <Exit>:** press Enter to end the command

Now, select the *Isolate Layers* command again from the View menu, pick on any of your linework, and only the entities on the picked layers are displayed.

Select the *Restore Layers* command from the View menu to recover your points. Experiment with the "cadence" of Isolate and Restore Layers. Select Isolate Layers, pick the layers to isolate, then press Enter twice. Then select Restore Layers.
Next, you will draw the shed. Select the 2D Polyline command on the Draw menu. To draw a two-sided shed, connect points 5 through 7 as follows:

\[\text{Continue/Extend/Follow/Options/}\langle\text{Pick point or point numbers}\rangle: 5-7, \text{ press Enter twice}\]

This produces the 2-sided building shown here:

Select the 4 Sided Building command on the Survey menu. Turn the 2-sided shed into a 4-sided shed as follows:

\[\text{Options/}\langle\text{Pick a line or polyline}\rangle: \text{Pick the shed}\]

Now your 2-sided building looks like this:

---

Focus your attention on the area of tightly spaced points with point numbers ranging from 27 to 44. This is the driveway and paving area. In the case of the driveway, assume that the surveyor who collected the points shot in 3-point arcs. They came up to a PC, shot a point on the arc, and finished up at the PT.

On the View menu, select the Window option, and pick a lower left and upper right point that windows the driveway area. (If you wish to use the View>Previous command to zoom out, then use View>Window to zoom in again.)

Select the 2D Polyline command under the Draw menu, and walk the polyline through the two arcs as follows:

\[\text{Continue/Extend/Follow/Options/}\langle\text{Pick point or point numbers}\rangle: 27\]
\[\text{Arc/Close/Distance/Extend/Undo/}\langle\text{Pick point or point numbers}\rangle: 28\]
\[\text{Arc/Close/Distance/Extend/Follow/Line/Undo/}\langle\text{Pick point or point numbers}\rangle: \text{A}\]
\[\text{Radius pt/radius Length/Arc length/Chord/Second pt/Undo/}\langle\text{Endpoint or point number}\rangle: \text{S}\]

Use S for 3-pt arcs.

Second point or point number: 29

Endpoint or point number: 30

\[\text{Arc/Close/Distance/Extend/Follow/Line/Undo/}\langle\text{Pick point or point numbers}\rangle: 31\]
In the above exercise you started at point 27, went to the PC at point 28 and inserted a 3-point arc through points 29 and 30. You proceeded tangent to point 31, which was another PC, then completed a 3-point arc through points 32 and 33, and ended.

Now, connect up the basketball court area. Select the 2D Polyline command under Draw, or press Enter to repeat the previous command.

Shown below is your drawing to this point.
Next you will make a building footprint. Points 18 and 19 are two shot corners of a building. Assume that the surveyors taped the main house, going clockwise from point 18, as follows: 10'L, 20'R, 40'L, 20'R, 20'L, 83'L, 60'L, 23'L, 10'R.

You can easily enter these “jogs” in the building using the Extend by Distance command. If you are zoomed in on the driveway, use View > Zoom > Zoom Out, then View > Pan to focus on the building north of the driveway. Now use the 2D Polyline command on the Draw menu to draw a line from 18 to 19.

Pick point or point numbers: 18
Undo/Arc/Length/<Pick point of point numbers>: 19, then press Enter twice to end

Select the By Distance option from the Edit menu, Extend command.

Pick line or pline to extend: pick the building line closer to point 18

This makes the arrow point toward 18 rather than 19. Now you can go clockwise:

Enter or pick distance to Draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help): L10 (lower case "l" and "r" work also)

Next, you will complete the linework for the sewer line and the electric utility line. Use the View > Extents command so you can see all your points.

The sewer line runs from points 52 to 53 to 54. Select the 2D Polyline command from the Draw menu. To create the sewer line, enter the following:

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 52-54, press Enter twice to end

You will next annotate the sewer polyline using the Change Polyline Linetype command, but first you must set the default spacing for the annotation. Select the Annotate Defaults command on the Annotate menu. The following dialog box appears.
Change the Line Type Spacing to 1.5. This will label "S" on the sewer line every 1.5" at the current scale (1"=50').

To annotate the sewer line with an S, select the Line Types command on the Annotate menu, then choose Change Polyline Linetype. Within the dialog box, click Next four times, select the Sewer linetype from the list, and then select the sewer polyline that runs next to the road. The polyline will be annotated.

Next, create the electric utility line, which runs from point 3 to point 4 to point 17. Select the 2D Polyline command on the Draw menu.

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 3
[Arc/Close/Distance/Follow/Undo/<Pick point or point numbers>]: 4
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: 17
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: press Enter twice to end

No points were taken beyond point 17, due to obstructions from the various setups in the field. So you must extend the polyline from point 17 to beyond the property. Under the Edit menu, choose Extend, then By Distance. Pick on the electric utility polyline near point 17. Then pick beyond the property. Press Enter to end.

Before you annotate the electric utility line, you must offset it 25' on both sides, for a 50' total right-of-way. You will do this using Standard Offset. Select the Offset>Standard Offset command under the Edit menu. Enter the offset distance of 25. Pick the electric utility polyline and then pick to one side for the first offset. Repeat for the other side, by first picking the electric utility polyline, then picking the other side for the offset. Press Enter to end.

Now annotate the central electric line with an E by selecting the Line Types command on the Annotate menu, then choose Change Polyline Linetype. Choose the Electric linetype, which appears on the second page of linetypes. Then select the electric utility polyline to annotate it, and press Enter.

Next, make the Property lines bold. Under the Edit menu, select Polyline Utilities, then Edit Polyline and then select Change Polyline Width.

New Width <0.0>: 1.5
Select objects: pick the property polylines while holding down the Shift key Pick once for the fence line portion and once for the remaining property lines.
Select objects: press Enter to end
To add color and improve layer management, make a layer for your road and driveway. Select the Layer Control command on the View menu.

Click the New Layer button, and enter the name "Road" for the new layer. Choose the color cyan by clicking the color square to the right of the layer name. Click OK.

On the View menu, select the Change Layer command.
Select entities to be changed.
Select objects: with Shift key held down, pick all driveway and road entities and press Enter

This brings up the dialog box shown below. Select ROAD and click OK.

Your linework is now complete and is shown below:
If you have not already saved your drawing, now is a good time to do it. Use the Save command on the File menu, and call the file Lesson2.dwg.

20 You will add symbols for trees, property corners, manholes and a light pole.

Start with the trees. Points 11, 12, and 20 are oak trees of different sizes, and point 14 is a pine tree. Use symbol 61 for the deciduous oak trees and symbol 53 for the pine tree. On the Draw menu select Symbols. Then select the Insert Symbols command. The following dialog box appears.

Click the Select button, and within the Select Symbol dialog box, use the down arrow at the right to scroll forward to the tree symbols, which are several pages deep. Choose symbol SPT61. You can also choose Trees under the Symbol category field in this dialog. You are returned to the Insert Symbols dialog box.
Click the Select Layer button, and type in TREES in the Layer Name field. This creates a Trees layer if one does not exist. Click OK. For the Symbol Size use 18. A symbol size equal to the diameter of the tree is often effective. Click OK.

Options/Select entities/Enter Coords/<Pick point or point numbers>: 11
Options/Select entities/Enter Coords/<Pick point or point numbers>: 20

Place symbol 61 on the larger point 12 at size 24. Press Enter to repeat the last command, or once again select the Insert Symbols command from the Draw menu. Symbol 61 will now be the default. Change the Symbol Size to 24 and click OK.

Options/Select entities/Enter Coords/<Pick point or point numbers>: 12
Options/Select entities/Enter Coords/<Pick point or point numbers>: press Enter

Place symbol 53 on the larger point 14 at size 8. To do this, press Enter to repeat the last command, or select Insert Symbols from the Draw menu. Select symbol 53 and a Symbol Size of 8. Click OK.

Options/Select entities/Enter Coords/<Pick point or point numbers>: 14
Options/Select entities/Enter Coords/<Pick point or point numbers>: press Enter

Place symbol 5 (representing an iron pin) on points 8-10 and point 15. Repeat Insert Symbols by pressing Enter to repeat the last command, or again select the Insert Symbols command from the Draw menu. Select symbol 5 (first page) and leave the Symbol Size of 8. Change the layer to FINAL. Click OK.

Options/Select entities/Enter Coords/<Pick point or point numbers>: 8-10,15
Wildcard match of point description <*>: press Enter
This puts symbols on points 8 through 10, as well as point 15.

Options/Select entities/Enter Coords/<Pick point or point numbers>: press Enter

Place a concrete monument (symbol 13) on point 13 on layer FINAL. Keep the Symbol Size of 8. Press Enter to repeat the last command, or select the Insert Symbols command from the Draw menu. Select symbol 13.

Options/Select entities/Enter Coords/<Pick point or point numbers>: 13

Place a manhole (symbol 34) on the vertices (endpoints) of the sewer line, at points 52 through 54. You could use the above method, but you can also use S for Select entities, and place the symbol automatically at the vertices of the selected entity.

Select the Insert Symbols command from the Draw menu. Select symbol 34 from the list. Keep with layer FINAL and Symbol Size 8. Click OK.

Options/Select entities/Enter Coords/<Pick point of point numbers>: S
The following dialog box appears. Click OK.
Select arcs, circles, faces, points, text, lines and polylines.

Select objects: pick the sewer polyline

The symbols are inserted at the three polyline endpoints.

21 You can reduce clutter by selecting the Freeze Layer command under the View menu, and picking a point number. The points freeze, leaving only linework and symbols. To bring the points back, use the Thaw Layer command under the View menu. The Freeze Layer and Thaw Layer commands go together, just like the Isolate and Restore Layers commands.

22 Next, you will create (in reduced size) your building dimensions. You can set the building dimension text size for the current work session using the Survey Text Defaults option of the Survey Text command on the Annotate menu. However, you can set the text size permanently using the Configure command on the Settings menu, then selecting the Configure command. Use this last method. This dialog box appears:

Select Survey Settings and the following dialog box appears:
Choose Survey Text Defaults. The following dialog box appears:

The changes you will make are in the upper-left section "Building Dimensions." Change the Text Size Scaler to 0.04, change Offset From Line to 0.02, and select Drop Trailing Zeros.

The Drop Trailing Zeros option will label 17.0' as 17'. To save more space, you could blank the Characters to Append box, but not this time. Enter the name of a new layer for the building text called BTXT, so that building dimensions can be frozen to reduce the clutter even more. It is generally a good strategy to use layers for selective freezing and thawing.

Click OK on the above dialog box, then click Exit until you return to the command prompt. On the Annotate menu, choose the Survey Text command, Building Dimensions option. Click on the middle of the bottom segment of the
building and then drag the alignment to the right, along the same bottom segment being dimensioned. The resulting label is shown below.

If you had dragged the cursor to the left rather than to the right, with the same near-parallel angle to the line, the 83' would be drawn below the building rather than above.

Another example is shown below. Select Annotate > Survey Text > Building Dimensions, and click on the left-most segment of the building. Then click roughly perpendicular to the left. This creates a perpendicular, rather than parallel, label as shown below.

Label the rest of the building. Notice that the sides of the building that you are dimensioning are measured in even feet. Because you had selected the Drop Trailing Zeros option when you set your Survey Text Defaults, and you set the Decimal Places default at 0.0, the ".0" is not reflected in the labels,
If you choose the wrong direction while you are labeling, you can exit the command, or you can erase the incorrect dimension by typing E for erase at the command line, or you can enter U for undo to back out your last work. Once the labels are in place, you can type M for the Move command, and move the text to the desired position.

23 Next, you will label the offset dimension from property lines to two building corners, the SE corner as offset from the south property line, and the SW corner as offset from the west property line. Because of the options you set in the Survey Text Defaults dialog box above, Offset Dimensions will be created on layer DTXT, and they will be horizontal, with arrowheads.

On the Annotate menu select Survey Text, Survey Text Defaults. The dialog previously shown will reappear. Change the Text Size and Arrow Size Scalers to 0.040. Then select Dual Arrows Line and click OK. On the Annotate menu, select Survey Text, Offset Dimensions option.

[**end on**] Pick Bldg/Object Corner: pick on the SE building corner

[**perp**] Pick Line To Offset From: pick on the South property line (before the arc, near the end of the driveway)

The setback is labeled 43.5 ft. Why "ft" and not " ' " for distance? If you review the Survey Text Defaults dialog box again, you will see that you set the Characters to Append option to "ft".

On the Annotate menu, select Survey Text > Survey Text Defaults. Under Offset Dimension Text, change the characters to Append to an apostrophe, " ' ". Also, change the Text Alignment to Parallel instead of Horizontal. Click OK. Select Annotate > Survey Text > Offset Dimensions.

[**end on**] Pick Bldg/Object Corner: pick on the SW building corner

[**perp**] Pick Line To Offset From: pick on the West property line (avoid the electric right-of-way line)

Use the Move command to move the 20' text label to the right, so that it is not overwritten by the offset dimension. The result is shown below:
Notice the display, within the above prompts, of the [end on] and [perp] snaps. When Carlson sets a snap for temporary use, it displays the snap within the brackets as shown. A building corner is always an endpoint, so the end snap always applies to the first pick. The offset is the perpendicular distance to the property lines, so the [perp] snap always applies to the second pick. The per, or perpendicular, snap applies to offsets from arcs as well. In the case of arcs, the per snap finds the shortest, radial distance to the arc.

When you enter a snap at the keyboard in response to a "Pick object" request, type only the first 3 letters of the snap, such as "per" or "end". You could use the Offset Dimension command to label the Electric utility right-of-way distance of 50' total by entering "nea" (for nearest snap) for the first pick, then entering the default "per" snap for the second pick on the other side of the right-of-way.

24 Next, you will add adjoiner ownership text to the property lines. Select the Survey Text Defaults command, under the Annotate menu, and set the Adjoiner Text Justification option to C for centered, and the Text Size Scaler to 0.06. Click OK and then select the Adjoiner Text option on the Annotate > Survey Text command.

**Pick Line Or Polyline:** pick the west property line
**Pick Starting Point:** pick a centering point west of the property for the adjoiner text
**Text:** Brian W. and Mary T. Jones
**Text:** D.B. 101, P. 37
**Text:** press Enter twice

This produces parallel, center-justified text on the west side of the property. Repeat the command for the north side. Press Enter to repeat the Adjoiner Text command or select it from the menus.

**Pick Line Or Polyline:** pick the north property line
**Pick Starting Point:** pick a centering point north of the north property line
**Text:** Stan W. Bosworth
**Text:** D.B. 94, P. 272
**Text:** press Enter twice

The results are shown here:
Next, you will add bearing annotation. Select the Annotate menu, choose Angle/Distance, select the BearingDistance option to place Bearing and Distance above the line.

**Define bearing by, Points/<select line or polyline>:** *pick the northern property line to the east, or right side* The bearing direction will be labeled towards the picked end, which is northeast.

**Define bearing by, Points/<select line or polyline>:** *pick the eastern property line* Pick closest to the southern endpoint of the line

To label the western property line on the lower (western) side of the line, select the _BearingDistance option of the Angle/Distance command.

**Define bearing by, Points/<select line or polyline>:** *pick the western property line* on the northern portion of the line

To label the southern line segment with a leader, on the Annotate menu select the Annotate w/Leader command, *Brg-Dist w/Leader* option.

**Options/Points/<Select line or polyline>:** *pick the southern property line segment* on the southwest side

**Pick point to start leader:** *pick a point* to start and locate the pointed end of the arrowhead

**Pick next leader point:** *pick a point* Pick a point off to the right for the left-justified bearing and distance

**Pick next leader point (Enter to end):** *press Enter*

**Options/Points/<Select line or polyline>:** *press Enterto end*

Next, you will want to annotate the arc in the drawing. The label will consist of four entries: arc length, radius, chord bearing (angle) and chord distance.

Select the *Annotate Arc* command, on the Annotate menu, and choose the *Stack Label Arc* option. The Stack Label Arc dialog box appears.
Set the sequence column to 1, 2, 3 and 4 as shown. Remember that changes to this box apply only to this work session. To set these options permanently, go to the Settings menu, choose Configure > Survey Settings > and choose the Stack Label Arc command. When you are done with the dialog box, click OK.

**Define arc by, Points/<select arc or polyline>:** *pick the arc*

**Pick point for labels:** *pick a point to the right to place the label*

As the cursor moves, the text "ghosts", allowing you to make the best possible placement decision

**Pick point to start leader at ([Enter] for none):** *pick a point on or near the arc for the arrowhead*

**Define arc by, Points/<select arc or polyline>:** *press Enter to end*

Sometimes Carlson displays an arc as a series of chords. Type Regen at the command prompt to "regenerate" the arc. Even if an arc shows up on the screen as a group of jagged chords, it will plot as a smooth arc to a printer or plotter.

27 Next, you will label the trees, the shed, and the building using a special leader, for a hand-drafted appearance. Under the Annotate menu, select the Special Leader command.

**Options/Pick Arrow Location:** *pick near the southern most corner of the shed*

**Text location:** *pick slightly down and to the right*

**Text:** Shed

*Text: press Enter twice to end*

Repeat the process for all the special leader text items shown in the drawing below. In the case of the 18" Oak trees, create just one leader with text, and on the second oak tree, create only the leader, and then press Enter when asked for Text. For the best appearance, enter 18’Oak and 24’Oak with no spaces between the characters.

Your drawing should be similar to this one:
28 You can add a North Arrow and Bar Scale by selecting these options under the Annotate menu. When you place the North Arrow, pick your North Arrow symbol, maybe change the scale, and click OK. Then pick an insertion point. You place the Bar Scale by answering the prompts and picking a location. Both the North Arrow and the Bar Scale can be moved to desired locations with the Move command on the Edit menu.

29 Next, you will insert a title block with a border. Select the Title Block command from the Settings menu.

Choose paper size A1 (portrait view, 8-1/2 by 11). Click OK. Pick a point below and to the left of the survey in
order to locate the lower-left corner of the border outer line. Remember that the title block will be at the bottom, so leave extra room at the bottom.

The following dialog appears, prompting you for the attributes of the title block. Be sure to also click Next in order to enter in more attributes.

Your drawing should resemble the one shown below.
Next, you will add a legend. On the Annotate menu, select the Draw Legend command. Choose the New tab, then Open the default legend name. When the dialog box appears, select Add from Drawing. You will make one pick for each symbol you want to appear in the legend. So, with the Shift key held down, select one of the sewer manholes, one of the iron pins, the concrete monument, one oak tree and the pine tree. Press enter. You will then see the symbols that you picked listed.

If you want to change the order of the items in the list, use the Move Up and Move Down buttons, after first selecting and highlighting the item to be moved. After the list is ordered correctly, highlight one item on the list and click the Edit button to edit the symbol definition.

Edit each symbol definition individually, typing the following descriptions in the description box:

SPT5 = "Iron Pin"
SPT34 = "Manhole"
SPT13 = "Concrete Monument"
SPT 61 = "Oak Tree"
SPT53 = "Pine Tree"

Below is the symbol definition, with Description, for SPT13.

After you have entered the descriptions for the symbols, choose the Add option from the Legend Definition dialog box, and add the Fence Line type to the list by picking the Select Linetype command, as shown below:
Save the completed legend, which is shown below.

Select the Draw option from the Legend Definitions dialog box. Set the defaults as shown below.
Click OK. Pick a point for the legend, at roughly 5260,4380. Then click Exit.

You may need to move the fence line portion of the legend to fit in the tight space. You also may need to move the previously drawn bar scale. Use the Move command to do this. The following shows the drawing to this point:

If you wish to reset the spacing of the sewer and electric utility annotation, use the LTSCALE box in the Drawing Setup dialog box, under the Settings menu, to set it. (The setting is 50, in this example).

Next, you will use Dtext to label the road and Mtext to create a certification block. Zoom in on the area shown below. At the command line, type Dtext.
Specify start point of text or [Justify/Style]: R (for right-justified)
Specify right endpoint of text baseline: pick a point as shown below, just to the left of the leader annotation
Specify height <8.00>: 10
Specify rotation angle of text <E>: pick a point as shown below by the location of the crosshair

Text: Meadow Lane
Text: press Enter

This right-justifies the label Meadow Lane, ending it before it contacts the leader line.

Now you will enter a certification using Mtext. The Mtext command stretches an entire block of text. This command breaks up the lines in the block of text, depending on how you edit and adjust the Mtext window. First, use the View > Extents command to view the entire drawing. Then, at the command line, type in Mtext.

Specify first corner: pick a point in the 5660,4980 range
Specify opposite corner or [Height/Justify/Line spacing/Rotation/Style/Width]: pick a point below and to the right of the first, but inside the inside border line.

You now see a dialog box that displays all the text heights that you have used in the drawing. Choose the text height of 8. Then type the following into the dialog box:

Surveyor’s Certification
I do hereby certify that the survey shown heron was performed under my direction by method of random traverse, and that the error of closure was 1:52544.

B. Brod Smith
PLS No. 11952

The command adds carriage returns to the text when it runs out of space in the Mtext window. Click OK at the upper right to place this text into the drawing.

After the Mtext is plotted, you can click on the text to activate the grips. All 4 corners highlight as grips. Pick on a grip, and then you can expand or change the shape of the Mtext rectangle. When you do this, the text adjusts automatically, adding more lines and carriage returns, or condensing many lines into fewer, but longer, lines of text. You can also move the entire text block to a new location.

Next, you will define a text style, then add text using that style. On the Draw Menu, under Text, choose select
the Set Style option. The Text Style dialog box appears. Click New, enter Bold in the New Text Style dialog, and click OK.

Create a Bold Style consisting of the Arial Black font tilted at a 10 degree oblique angle, by entering the settings as show below.

Then click Apply and Close. Now, run the Dtext command by typing Dtext at the command line, and place the text at the top of the drawing as follows:

Specify start point of text or [Justify/Style]: pick a point near the northwest corner of the drawing
Specify height <10.00>: 20
Specify rotation angle of text <N 54d40'16'' E>: E for due East
Text: William T. Farmer
Text: press Enter twice

33 Next, you will create an area label for the drawing. Select the Area Defaults command, under the Area/Layout menu, and change the Precision for Other Area Labels to 2 decimal places.

Select the Areas by Lines & Arcs command, under the Area menu. When prompted to Select objects, pick the 2 polylines that, taken together, completely enclose the property.

Pick an area labeling centering point for the area label under the William T. Farmer title at the top of the drawing.

34 Next, bring the points back and draw a contour map. To draw the points, use the Thaw Layer command under the View menu. If you did not complete this lesson in one sitting, then Carlson won't "remember" what layer to thaw. In that case, select the Layer Control command on the View menu, and thaw the PNTS layer by turning the snowflake to a sun symbol.
Go to the Surface menu and select the *Triangulate & Contour* command. Click the Contour tab.

In this Contour tab section, change the contour interval to 1.0. Now click on the Triangulate tab, then click on Use Inclusion/Exclusion Areas. Press OK and then answer as follows:

**Select the Inclusion perimeter polylines or ENTER for none.**

**Select objects: press Enter**

We have no "inclusion" perimeter.

**Select the Exclusion perimeter polylines or ENTER for none.**

**Select objects: select the building and the shed while holding down the Shift key, then press Enter**

Since the building and shed are closed polygons acting as exclusion perimeters, the contours will not pass through them when they are created.

**Select the points and barrier lines to Triangulate: select a window around the points by picking from the lower left to the upper right**

The contour map is created. Freeze the points again by using View > *Freeze Layer* and picking one of the points.

Next, label the contours. Select the *Contour Elevation Label* command from the Surface menu > Contour Labels. Select OK after matching the settings in the dialog box shown here:
Now pick two points that cross through one or more contours. The contours are automatically labeled using the current text style. You can use the Change Text Font command, part of the Text command in the Edit menu, to change the font to Romans, or to another font, if you wish to.

The Completed Plat is shown here:

If you have not saved your drawing for awhile, now is a good time to do it. Use the Save command on the File menu.

36 Now we are ready to plot the drawing.
Before plotting it's a good idea to do a *Zoom Extents*, then a *Zoom Out* (both on the View Menu) before executing the plot command.

To get started, choose Plot from the File menu. There are many variables that can affect how the dialog box will look, such as what version of AutoCAD you are using. Here is a common Plot dialog box:

With this layout, you have two tabs on the dialog labeled "Plot Device" and "Plot settings". We will start with "Plot device". The first thing to select is your plotting device (see arrow #1). Here DWF6 ePlot.pc3 is already selected, and that is what we want to use. Next, arrow #2 points to the "What to Plot" section. In this version of AutoCAD, you are either working in the model tab or one of the layout tabs. Our example is drawn in the model tab, so the option labeled "Current Tab" should be selected. If you want more than one copy of your plot, this is where you would change that number. Arrow #3 points to the plot settings tab. Click on here next. Now the dialog should look like this:
Now we are on the "Plot settings" tab. Arrow #4 points to where you can change the paper size and units. Here we chose 8.5 X 11 for our size and inches for our units. The next thing to select is the drawing orientation, arrow #5 shows you where this is. We will choose portrait.

Now looking at arrow #6, we want to choose the window button in order to select the area we want to plot. After you select this button, the dialog will disappear and you can select the upper left and the lower right corners of the drawing border. When you finish, the dialog will reappear.

The next thing to do (arrow #7) is choose the correct plotting scale, our drawing is 1"=100' or 1:100. Choose this from the dropdown list. Now we are ready to preview the plot. Press the Full Preview button in the lower left corner of the main dialog. Press ESC to return to the main dialog. One new feature starting in AutoCAD 2000 is the ability to save all the information you have just entered in a "Page Setup". In the upper part of the dialog, check on the box labeled "Save changes to layout", then to the right of that, click the button labeled "Add". A new dialog will appear, at the top of this dialog, enter a name to save your page setup as and click OK. I chose 8.5 X 11 STD. You can see this in the dialog shown above. If your plot preview looked OK, choose OK from the bottom of the dialog and your plot is on its way. The advantage to saving the page setup is that you can open this drawing tomorrow or 3 weeks later and choose 8.5 X 11 STD as your page setup, and then choose OK to plot the drawing exactly like you did today, without having to remember all the settings yourself.

This completes the Lesson 2 tutorial: Making a Plat.

**Lesson 3: SurvNET**

This tutorial is divided into two lessons covering the process of reducing and adjusting raw survey data into final adjusted coordinates, using the SurvNET program. The tutorial will describe the reviewing and editing of the raw data prior to the processing of the raw data. Next, the least squares project settings will be described, and then the final report generated from the least squares processing will be reviewed. This tutorial will review both a total station only project, and a project that combines both total station and GPS vectors.

The raw data files associated with this tutorial is located in the Carlson2008\Data folder, under the installation folder on your computer (example: \Carlson2008\DATA).
Lesson One - Processing an Assumed Coordinate System 2D Total Station Network

1 The easiest way to start the program is to select SurvNET from the Survey menu. This opens the SurvNET window and program.

2 The first step is to open an existing project or create a new project. We will open an existing project. Choose Open Project from the File menu. Navigate to the \Carlson2008\DATA\ folder and open the SurvNetTut01 project.

3 Learning the meaning and implications of the different project settings is the most critical initial step in learning how to use SurvNET. Let's review the different project screens. Choose Project from the Settings menu.
Least Squares Settings

4 The Network Least-Squares Settings dialog box is displayed. In this dialog, the different settings required for the Least Squares reduction are available in the different tabbed dialog boxes. When all of the settings are set as desired, press OK to save the changes to the project settings, or press Cancel to return to the raw data editor without saving any project settings. For the purpose of this tutorial, the Coordinate System settings tab should look as follows before proceeding to the next step. To use an assumed coordinate system, the 'Local' Coord. System needs to be checked, and the 2D,1D Adjustment Model must be chosen. When using a local coordinate system, the distance units are not important other than for display purposes in the report. Computing elevation factors and performing Geoid modeling is not applicable to assumed datums. Notice that in this example we are not performing a vertical adjustment.
For more information on the content of this dialog box section, please review the SurvNET chapter of this manual.

5 Choose the 'Input Files' tab. This is the section of the Settings dialog box where you define the data files that make up the project. You can have multiple raw files in a single project. The ability for multiple raw files allows flexibility in collecting the data and processing large projects. It is typically easier in a large project to analyze and edit subsets of the total project, before combining all the data for a final adjustment. Notice that since we are working in a local coordinate system and using the 2D,1D Adjustment Model, GPS vectors cannot be incorporated into this project.

Note: The sample tutorial project has the input raw file in the default data folder of C:\Carlson2008\DATA. If you have a different data directory, then set the correct data file by highlighting the default file, pick Delete and then pick Add and select SurvNetTut01.rw5 from your data folder.
Choose the Preprocessing tab to review the least squares preprocessing settings. For the purpose of this tutorial, the Preprocessing settings should look as follows before proceeding to the next step. Preprocessing consists of reducing and averaging all the multiple measurements, applying curvature and refraction correction, reducing the measurements to grid if appropriate, and computing unadjusted traverse closures if appropriate. Much of the data validation is performed during the preprocessing step.

For more information on the content of this dialog box section, please review the SurvNET chapter of this manual.
Choose the Standard Errors tab to review the standard error settings. The standard error settings should look as follows before proceeding to the next step. Standard errors are an estimate of the different errors you would expect to obtain based on the type equipment and field procedures you used to collect the raw data. For example, if you are using a 5 second theodolite, you could expect the angles to be measured within +/- 5 seconds (Reading error).

For more information on the content of this dialog box, please review the SurvNET chapter of this manual.

Choose the Adjustment tab to review the Adjustment settings. The Adjustment settings should look as follows before proceeding to the next step. The Adjustment settings affect how the actual least squares portion of the processing is performed. Additionally, from the screen the user can set whether ALTA reporting is performed.
9 Choose the Output Options tab to review the output settings. For the purpose of this tutorial, the Output Options settings should look as follows before proceeding to the next step. These settings apply only to the output of data to the report files. These settings do not affect computational precision. Press OK to return to the main SurvNET screen.

General Rules For Collecting Data for Use in Least Squares Adjustments
Least squares is very flexible in terms of how the survey data needs to be collected. Generally speaking, any combination of angles and distances, combined with a minimal amount of control points and azimuths, are needed. This data can be collected in any order. But there needs to be at least some redundancy in the measurements.

Redundant measurements are measurements that are in excess of the minimum number needed to determine the unknown coordinates. Redundancy can be created by including multiple GPS, and other control points, within a network or traverse. Measuring angles and distances to points in the network that have already been located create redundancy. Running additional cut-off traverses, or additional traverses to existing control points, creates redundancy. Following are some general rules and tips in collecting data for least squares reduction.

- Backsights should be to point numbers. Some data collectors allow the user to backsight an azimuth not associated with a point number. SurvNET requires that all backsights be associated with a point number.
- There has to be at least a minimum amount of control. There has to be at least one control point. Additionally, there needs to be either one additional control point or a reference azimuth. Control points can be entered in either the raw data file, or there can be a supplemental control point file containing the control point. Reference azimuths are entered in the raw data file. The control points and azimuths do not need to be for the first points in the raw file. The control points and azimuths can be associated with any point in the network or traverse. The control does not need to be adjacent to each other. It is permissible to have one control point on one side of the project, and a reference azimuth on the other side of the project.
- At least one of the control points needs to be occupied. There may be situations where no control point is ever occupied in the network, but only backsighted. In these situations, a preliminary value for one of the occupied points needs to be computed and entered as a floating point control point.
- Some data collectors do not allow the surveyor to shoot the same point twice using the same point number. SurvNET requires that all measurements to the same point use a single point number. The raw data may need to be edited after it has been downloaded to the office computer to insure that points are numbered correctly.
- The majority of all problems in processing raw data are related to point number problems. Using the same point number twice to different points, not using the same point number when shooting the same point, misnumbering backsights or foresights, and misnumbering control points are all common problems.
- It is always best to explicitly define the control for the project. A good method is to put all the control for a project into a separate raw file. A big source of problems with new users is a misunderstanding in defining their control for a project.
- Some data collectors may have preliminary unadjusted coordinates included with the raw data. These coordinate records should be removed from the raw file. The only coordinate values that should be in the raw file are the control points.
- When a large project is not processing correctly, it is often useful to divide the project into several raw data files and debug and process each file separately as it is easier to debug small projects. Once the smaller projects are processing separately, they can be combined for a final combined adjustment.

**Reviewing and Editing the Raw data**

10 To review or edit the raw data, choose the *Edit Raw Files* command from the Tools menu.
If there are problems with the raw data, such as point numbering problems or incorrect rod heights, the raw data can be edited from this dialog. See the section on the raw data editor in the Carlson documentation to learn the details of the editor. Review the following Standard Errors and Control Points section before exiting the raw data editor.

### Standard Errors and Control Points

The default standard errors for points are defined in the Standard Errors sheet of the Settings dialog box. There are times when the default values may need to be overridden. For example, the control may be from GPS and the user has differing standard errors for his various GPS points. Or maybe some of the control points were collected with RTK methods, and other GPS points collected with more accurate static GPS methods. Standard error for individual points can be inserted into the raw data file. The following is the menu option used to insert standard errors into the raw file. Notice in the above raw data file that points TR1 and TR100 are the control points for this project. Also, notice there is a standard error record, CSE, preceding the control points.
The CSE record has the character '!' in the N,E,& Z field. The character '!' designates that all following control points will be fixed. Points that are fixed will not be adjusted during the adjustment. Placing a very small standard error on a control point is almost equivalent to fixing the point. Points can also be designated to be floating points by using the '#' character. The only practical use of creating a floating point is if SurvNET cannot compute preliminary coordinates because no control point is occupied. The surveyor can compute a preliminary value for one of the occupied points, and insert that point as a floating point. The floating point will be adjusted, and no weight will be given to the floating coordinate values.

Standard error records effect all the records that follow the standard error record. To revert the standard errors back to the default values, a CSE record can be inserted containing the '*' character. In the following example, point TR1 has been designated as a fixed point. TR100 has a north standard error of .02 and east standard error of .01. Following the TR100 point record there is a CSE record containing the '*' character. So, if there were any control points further down in the raw data file they would use the default standard errors as set in the project settings dialog box.
There may be times when non-control standard errors need to be overridden for certain measurements. For example, if fixed tripods were used for backsights and foresights for part of the traverse, and hand-held rods were used for another portion of the traverse, it would be appropriate to have differing 'Rod Ctr' standard errors for the different sections of the raw data.

Standard errors for angles and distances can also be inserted into the raw data file using the Add menu options Setup Standard Error and Measurement Standard Error. The standard errors set by these inserted records override the default standard errors. In the following example, a setup standard record, SSE record, has been inserted in record 12. The SSE record effects all setup data that follow until another SSE record is inserted. In the following example, the foresight rod centering error is set to .005, the total station centering error is set to .005, the total station meaure-up error is set to .005 and the foresight measure-up error is set to .005.

The following is another example where it would be appropriate to insert a measurement standard error record, MSE, into the raw data. If two different total stations with different accuracy specifications were used to collect the data, it would be appropriate to have different standard errors for the different sections of the raw file, depending on which total station was used to collect the data. In the following example, a MSE record has been inserted for record 27. The horizontal pointing and reading error has been changed to 5 seconds, and the vertical pointing and reading error has been changed to 10 seconds. The inserted MSE record will effect all following raw data until another MSE is inserted.
Least Squares Processing

12 After exiting the raw data editor, we are ready to perform the least squares adjustment. From the Process menu, choose the Network Adjustment option.

The least squares adjustment is performed, and the results from the adjustment are displayed. If the solution converged correctly, the report should look similar to the following window. If there were errors or the solution did not converge, an error message dialog will be generated.

If there are errors, you will need to return to the raw data editor to review and edit the raw data. Since the tutorial example should have converged, we will next review the reports generated by the least squares adjustment. There are four windows created by the least squares program during processing. These files include the .err file, which contains any errors or warnings that were generated during processing. The .rpt file is the primary least squares report file summarizing the data and the results from the adjustment. An .out file is created containing a listing of the final coordinates. There is also a Graphics window that is displayed. The graphic window is temporary and useful only for seeing the results of the survey. To bring up the Graphics window, choose under the Window menu the Graphics command, or click the View Graphics icon on the toolbar.
Relative Error Ellipses

Relative error ellipses are a statistical measure of the expected error between two points. Regular error ellipses are a measure of the absolute error of a single point. Some survey accuracy standards such as the ALTA standards state the maximum allowable error between any two points in a survey. Relative error ellipses can give you this information. There is a more detailed ALTA reporting feature in SurvNET. See the manual for additional information on creating an ALTA report.

13 Press the Relative Error Ellipse toolbar icon button, or choose, off of the Tools menu, Relative Error Ellipse. Enter TR3 and TR7 in the From Pt. and To Pt. fields. Press OK to calculate. The dialog box should look as follows.

At the 95% confidence level there should only be around .02 feet of error between points TR3 and TR7. If you need to compute relative error ellipses for sideshots make sure the "Enable sideshots for error ellipse" toggle is set in the Adjustment tab of the Settings/Project dialog box.

Review of the Least Squares Report
In this section, the different sections of the least squares report are explained. If the Least Squares Report is not already showing, choose the Window menu and select the Least Square Report item. The report viewer has tabs to quickly access different sections of the report.

Preprocessing and Header Information

The following excerpt from the report shows the header information and the preprocessing results. The header information consists of the date and time, the input and output file names, the coordinate system, the curvature/refraction setting, maximum iterations, and distance units.

During the preprocessing process, multiple angles are reduced to a single angle and multiple slope distances, vertical angles, HI’s, and rod heights are reduced to a single horizontal distance and vertical difference. During this process the horizontal angle, horizontal distance, and vertical difference spreads are computed. If the spreads exceed the tolerance settings from the Settings dialog box, then a warning message is displayed showing the high and low measurement and the difference between the high and low measurement.

Unadjusted Measurements

The following excerpt from the report shows the unadjusted measurements. Measurements consist of some combination of control X, and Y, horizontal distances, horizontal angles, and azimuth measurements. These measurements consist of a single averaged measurement. For example, if multiple distances were collected between two points during data collection, only the single averaged measurement is used in the least squares adjustment.

Also, standard errors for the measurements are displayed in this section of the report. The standard errors are computed from the standard error setting in the Settings dialog box using error propagation formulas. The standard error of an angle that was measured several times would typically be lower than an angle that was measured only once.

If the data had been adjusted into NAD 83 coordinates both the ground distances and the grid distances would be displayed. The grid, elevation, and combined factor would also be displayed in this section of the report.
Adjusted Observations

Control Coordinates: 0 Observed Points, 2 Fixed Points, 0 Approx. Points

<table>
<thead>
<tr>
<th>Sta.</th>
<th>N:</th>
<th>E:</th>
<th>StErr N:</th>
<th>StErr E:</th>
</tr>
</thead>
<tbody>
<tr>
<td>TR1</td>
<td>5000.000</td>
<td>5000.000</td>
<td>FIXED</td>
<td>FIXED</td>
</tr>
<tr>
<td>TR100</td>
<td>5820.9805</td>
<td>5820.9805</td>
<td>FIXED</td>
<td>FIXED</td>
</tr>
</tbody>
</table>

Distances: 104 Observations

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>To Sta.</th>
<th>Dist.</th>
<th>StErr</th>
</tr>
</thead>
<tbody>
<tr>
<td>TR1</td>
<td>TR100</td>
<td>820.99</td>
<td>0.01</td>
</tr>
<tr>
<td>TR1</td>
<td>TR2</td>
<td>867.49</td>
<td>0.01</td>
</tr>
</tbody>
</table>

Angles: 238 Observations

<table>
<thead>
<tr>
<th>BS Sta. Occt. Sta. FS Sta.</th>
<th>Angle (Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>TR100 TR1 TR2</td>
<td>180-13'02''</td>
</tr>
<tr>
<td>TR100 TR1 TR2</td>
<td>180-13'10''</td>
</tr>
</tbody>
</table>

Adjusted Coordinates

The next section of the report shows the final adjusted coordinates. Additionally, the computed standard errors of the coordinates are displayed. If this project was reduced to NAD 83, the final latitude and longitudes are also displayed. Error ellipses computed to the 95 percent confidence interval are also displayed.

Adjusted Measurements

The following section from the report shows the final adjusted measurements. This section is one of the most important sections to review when analyzing the results of the adjustment. In addition to the adjusted measurement, the residual is displayed. The residual is the amount of adjustment applied to the measurement. The residual is computed by subtracting the unadjusted measurement from the adjusted measurement.

The standard deviation of the measurement is also displayed. Ideally, the computed standard deviation and residual and the standard error displayed in the unadjusted measurement would all be of similar magnitude. The standard residual is a measure of the similarity of the residual to the a-priori standard error. The standard residual is the measurements residual divided by the standard error displayed in the unadjusted measurement section. A standard residual greater than 2 is marked with an "*". A high standard residual may be an indication of a blunder. If there are consistently a lot of high standard residuals it may indicate that the original standard errors set in the Settings dialog box were not realistic.
Statistics

The next section displays some statistical measures of the adjustment including the number of iterations needed for the solution to converge, the degrees of freedom of the network, the reference variance, the standard error of unit weight, and the results of a Chi-square test.

The degree of freedom is an indication of how many redundant measurements are in the survey. Degree of freedom is defined as the number of measurements in excess of the number of measurements necessary to solve the network. The standard error of unit weight relates to the overall adjustment and not to an individual measurement. A value of one indicates that the results of the adjustment are consistent with the a priori standard errors. The reference variance is the standard error of unit weight squared.

The chi-square test is a test of the "goodness" of fit of the adjustment. It is not an absolute test of the accuracy of the survey. The a-priori standard errors which are defined in the project settings dialog box or with the SE record in the raw data file are used to determine the weights of the measurements. These standard errors can also be looked at as an estimate of how accurately the measurements were made. The chi-square test merely tests whether the results of the adjusted measurements are consistent with the a priori standard errors. Notice that if you change the project standard errors and then reprocess the survey the results of the chi-square test change, even though the measurements themselves did not change.

In our example the chi-square test failed at the 95% significant level. Our example failed the chi-square test on the low end, 52.6 is less than 60.5. Failing on the low end indicates that our data is actually better than expected compared to our a-priori standard errors. If we were to decrease the pointing and reading standard error in the Settings screen by 5-10 seconds we would probably pass the chi-square. Also notice that if you change the standard errors by only 5-10 seconds and reprocess the data the final coordinates will not change significantly.

Statistics

The next section displays some statistical measures of the adjustment including the number of iterations needed for the solution to converge, the degrees of freedom of the network, the reference variance, the standard error of unit weight, and the results of a Chi-square test.

The degree of freedom is an indication of how many redundant measurements are in the survey. Degree of freedom is defined as the number of measurements in excess of the number of measurements necessary to solve the network. The standard error of unit weight relates to the overall adjustment and not to an individual measurement. A value of one indicates that the results of the adjustment are consistent with the a priori standard errors. The reference variance is the standard error of unit weight squared.

The chi-square test is a test of the "goodness" of fit of the adjustment. It is not an absolute test of the accuracy of the survey. The a-priori standard errors which are defined in the project settings dialog box or with the SE record in the raw data file are used to determine the weights of the measurements. These standard errors can also be looked at as an estimate of how accurately the measurements were made. The chi-square test merely tests whether the results of the adjusted measurements are consistent with the a priori standard errors. Notice that if you change the project standard errors and then reprocess the survey the results of the chi-square test change, even though the measurements themselves did not change.

In our example the chi-square test failed at the 95% significant level. Our example failed the chi-square test on the low end, 52.6 is less than 60.5. Failing on the low end indicates that our data is actually better than expected compared to our a-priori standard errors. If we were to decrease the pointing and reading standard error in the Settings screen by 5-10 seconds we would probably pass the chi-square. Also notice that if you change the standard errors by only 5-10 seconds and reprocess the data the final coordinates will not change significantly.

Statistics

Solution converged in 2 iterations
Degrees of freedom: 84
Reference variance: 0.63
Standard error unit weight: +/-0.79
Failed the Chi-Square test at the 95.00 significance level
60.540 <= 52.627 <= 111.242

Sideshow
If the "Enable sideshots for relative error ellipses" is not set in in the Adjustment screen of the project settings screen, sideshots are computed separately after the adjustment is completed.

<table>
<thead>
<tr>
<th>From</th>
<th>To</th>
<th>Bearing</th>
<th>Dist.</th>
<th>N</th>
<th>E</th>
<th>StDev. N</th>
<th>StDev. E</th>
</tr>
</thead>
<tbody>
<tr>
<td>TR1</td>
<td>1.00</td>
<td>S 72-32'23&quot;E</td>
<td>20.66</td>
<td>4695.7449</td>
<td>5019.6065</td>
<td>0.0026</td>
<td>0.0083</td>
</tr>
<tr>
<td>TR1</td>
<td>1.01</td>
<td>S 74-30'42&quot;E</td>
<td>22.26</td>
<td>4695.7833</td>
<td>5022.4226</td>
<td>0.0033</td>
<td>0.0084</td>
</tr>
<tr>
<td>TR1</td>
<td>1.02</td>
<td>N 04-45'59&quot;E</td>
<td>124.11</td>
<td>5123.6541</td>
<td>5016.6728</td>
<td>0.0068</td>
<td>0.0008</td>
</tr>
<tr>
<td>TR1</td>
<td>1.03</td>
<td>N 09-40'36&quot;E</td>
<td>64.60</td>
<td>5063.7459</td>
<td>5016.4693</td>
<td>0.0086</td>
<td>0.0014</td>
</tr>
<tr>
<td>TR1</td>
<td>1.04</td>
<td>N 57-42'41&quot;E</td>
<td>118.78</td>
<td>5063.4480</td>
<td>5016.4090</td>
<td>0.0067</td>
<td>0.0074</td>
</tr>
<tr>
<td>TR1</td>
<td>1.05</td>
<td>N 65-59'21&quot;W</td>
<td>152.17</td>
<td>5062.9719</td>
<td>4882.6010</td>
<td>0.0050</td>
<td>0.0092</td>
</tr>
<tr>
<td>TR1</td>
<td>1.06</td>
<td>N 69-32'48&quot;W</td>
<td>166.16</td>
<td>5062.8099</td>
<td>4842.5590</td>
<td>0.0051</td>
<td>0.0084</td>
</tr>
</tbody>
</table>

If the project had valid elevation benchmarks and measured HI's and rod heights the project could have been defined to adjust elevations. When using the 2D/1D least squares model the horizontal and the vertical adjustments are separate least squares adjustment processes. As long as there are redundant vertical measurements the vertical component of the network can also be reduced and adjusted using least squares. In the vertical adjustment, benchmarks are held fixed.

This is the final step in the adjustment. The final adjusted coordinates are now stored in the current project point database and can now be used for mapping and design.

Lesson Two - Processing a 3D Network With Both Total Station Data and GPS Vectors

In this lesson we will process a project that contains both GPS vectors and total station measurements.

1. Following is the opening SurvNET window. The first step is to open the project for lesson two. Choose the File/Open Project.. option. Navigate to the \Carlson2008\Data\ subdirectory and open the SurvNetTut02 project.

2. Let's review the project settings. Go to Settings/Project.
In order process GPS vectors, the coordinate system must be set to 'SPC 1983' with the appropriate state plane zone. The 'Coordinate System Adjustment Model' must be set to the 3D Model. With the 3D model, horizontal units and vertical units must be the same in regards to output and total station raw data. Geoid modeling may or may not be important depending on the extent of the project and the accuracies required. The most accurate results are typically obtained by using a 'Geoid File' set to GEOID03.

The project raw data is defined from the 'Input Files' settings screen. Notice that the units need to be specified for both the GPS vector data and the total station raw data. Typically, but not always, GPS vectors are in meters while...
the total station and the final output may need to be in feet. Also make sure that the correct GPS vector format is correct. Some GPS formats are binary and cannot be edited easily. Sometimes it is needed to edit the GPS vectors usually in terms of point numbers.

Note: The sample tutorial project has the input raw file in the default data folder of C:\Carlson2008\Data. If you have a different data directory, then set the correct data file by highlighting the default file, pick Delete and then pick Add and select GPSAndTS.cgr (C&G format raw file) from your data folder. Do the same for the GPS Vector files of GPSAndTS1.gps and GPSAndTS2.gps.

Though this tutorial does not cover the topic, it is from this screen that you would define the traverse file needed to compute either GPS loop closures or totals station traverse closure. See the manual for further details.
Notice the standard error settings related to GPS. The GPS instrument centering error can be defined. The vector standard error is a factor that can be used to increase the standard errors as defined in the GPS vector files.

None of the settings in this screen are specific to processing GPS vectors. See the manual for details on the settings in the 'Adjustment' dialog box.
None of the settings in this screen are specific to processing GPS vectors. See the manual for details on the settings in the 'Output' dialog box. Press the OK to return to the main SurvNET dialog box.

Following is the main SurvNET window. To process the data chose the Process/Network Adjustment option.

The project should process and converge and the following windows should be displayed.
Let's review sections of the report that are unique to the processing of GPS vectors and the 3D model.

Unadjusted observations

Control Coordinates: 1 Observed Points, 0 Fixed Points, 0 Approx. Points

<table>
<thead>
<tr>
<th>Sta.</th>
<th>Latitude</th>
<th>Longitude</th>
<th>Z (Ellip.)</th>
<th>STErr N</th>
<th>STErr E</th>
<th>STErr Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>40°18.58' N 75°12.63' W</td>
<td>858.21</td>
<td>0.0036</td>
<td>0.0030</td>
<td>0.0043</td>
<td></td>
</tr>
</tbody>
</table>

Grid XYZ

<table>
<thead>
<tr>
<th>Sta.</th>
<th>X:</th>
<th>Y:</th>
<th>Z (Geoid):</th>
<th>STErr X</th>
<th>STErr Y</th>
<th>STErr Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>359799.1900</td>
<td>2396585.1700</td>
<td>858.21</td>
<td>0.0030</td>
<td>0.0030</td>
<td>0.0043</td>
</tr>
</tbody>
</table>

Geocentric XYZ

<table>
<thead>
<tr>
<th>Sta.</th>
<th>X:</th>
<th>Y:</th>
<th>Z:</th>
<th>STErr X</th>
<th>STErr Y</th>
<th>STErr Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>1160584.9395</td>
<td>-4730365.2299</td>
<td>4104524.27</td>
<td>0.0009</td>
<td>0.0009</td>
<td>0.0013</td>
</tr>
</tbody>
</table>

Notice that now that we are working with a specific datum instead of an assumed coordinate system that latitude/longitude, state plane coordinates and geocentric coordinates are all displayed.
Mark to Mark Slope Distances: 192 Observations

<table>
<thead>
<tr>
<th>Sta.</th>
<th>To Sta.</th>
<th>Dist.</th>
<th>StErr</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>201</td>
<td>325.78</td>
<td>0.03</td>
</tr>
<tr>
<td>200</td>
<td>202</td>
<td>546.09</td>
<td>0.03</td>
</tr>
<tr>
<td>200</td>
<td>203</td>
<td>170.86</td>
<td>0.03</td>
</tr>
<tr>
<td>200</td>
<td>204</td>
<td>149.60</td>
<td>0.03</td>
</tr>
</tbody>
</table>

Mark to Mark Vertical Angles: 192 Observations

<table>
<thead>
<tr>
<th>Sta.</th>
<th>To Sta.</th>
<th>Vertical Ang.</th>
<th>StErr (Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>201</td>
<td>097° 58' 35&quot;</td>
<td>4</td>
</tr>
<tr>
<td>200</td>
<td>202</td>
<td>077° 10' 57&quot;</td>
<td>4</td>
</tr>
<tr>
<td>200</td>
<td>203</td>
<td>056° 54' 34&quot;</td>
<td>4</td>
</tr>
<tr>
<td>200</td>
<td>204</td>
<td>079° 22' 30&quot;</td>
<td>4</td>
</tr>
</tbody>
</table>

Horizontal Angles: 191 Observations

<table>
<thead>
<tr>
<th>BS Sta.</th>
<th>OCC Sta.</th>
<th>FS Sta.</th>
<th>Angle</th>
<th>StErr (Sec.)</th>
</tr>
</thead>
<tbody>
<tr>
<td>201</td>
<td>202</td>
<td>203</td>
<td>131° 40' 05&quot;</td>
<td>8</td>
</tr>
<tr>
<td>201</td>
<td>202</td>
<td>203</td>
<td>143° 45' 37&quot;</td>
<td>11</td>
</tr>
<tr>
<td>201</td>
<td>202</td>
<td>203</td>
<td>176° 40' 38&quot;</td>
<td>12</td>
</tr>
<tr>
<td>201</td>
<td>202</td>
<td>203</td>
<td>168° 43' 47&quot;</td>
<td>14</td>
</tr>
</tbody>
</table>

GPS Vectors: 17 Observations

<table>
<thead>
<tr>
<th>From Sta.</th>
<th>Delta X</th>
<th>Variance Delta X</th>
<th>Covariance XY</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In the above unadjusted observations section of the report, notice that distances have been converted to mark to mark distances. Note that vertical angles are now treated as measurements in the 3D model. And lastly, notice that the GPS vectors are also displayed. The GPS vectors are displayed as delta X,Y,&Z in the geocentric coordinate system.

Adjusted Geographic Coordinates

<table>
<thead>
<tr>
<th>Sta.</th>
<th>Latitude</th>
<th>Longitude</th>
<th>Z (Ellip.)</th>
<th>Conv. Ang.</th>
<th>Grid Factor</th>
<th>Z Factor</th>
<th>Combined Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>40° 28' 39.1600&quot; N 76° 22' 53.4000&quot; W</td>
<td>839.21</td>
<td>600-59.437</td>
<td>0.99998245</td>
<td>0.99998293</td>
<td>0.99998245</td>
<td></td>
</tr>
<tr>
<td>201</td>
<td>40° 28' 59.1240&quot; N 76° 22' 56.0939&quot; W</td>
<td>809.26</td>
<td>600-59.437</td>
<td>0.99998246</td>
<td>0.99998293</td>
<td>0.99998245</td>
<td></td>
</tr>
</tbody>
</table>

Adjusted Grid coordinates, (in Feet)

<table>
<thead>
<tr>
<th>Sta.</th>
<th>N (ft)</th>
<th>E (ft)</th>
<th>Z (ft)</th>
<th>Z (GeoEl)</th>
<th>StErr N</th>
<th>StErr E</th>
<th>StErr Z</th>
</tr>
</thead>
<tbody>
<tr>
<td>200</td>
<td>759875.1889</td>
<td>1294293.6172</td>
<td>838.21</td>
<td>0.0029</td>
<td>0.0029</td>
<td>0.0042</td>
<td></td>
</tr>
<tr>
<td>201</td>
<td>759972.1761</td>
<td>1296209.3441</td>
<td>809.26</td>
<td>0.0026</td>
<td>0.0023</td>
<td>0.0087</td>
<td></td>
</tr>
<tr>
<td>202</td>
<td>759962.4753</td>
<td>1296642.2690</td>
<td>939.08</td>
<td>0.0024</td>
<td>0.0024</td>
<td>0.0096</td>
<td></td>
</tr>
</tbody>
</table>

In the above adjusted coordinate section of the report, notice that the grid, elevation, and combined factor are displayed with the adjusted geographic coordinates.
In the above adjusted measurements section the adjusted measurements are shown along with their residuals, standard residuals and standard deviation.

This completes the Lesson 3 tutorial title SurvNET.

**Lesson 4: Field to Finish for Faster Drafting**

In this lesson, you will make a plat using field to finish techniques, with the help of the Startup Drawing Wizard.

1. Launch Carlson, or, if you are already in the program, select the File menu, and select New to start a new drawing. Save your existing drawing first, if you'd prefer. If you are asked to use a template, choose carlsonxx.dwt, where xx is the last two digits of the AutoCAD release that you are working with. For example, for AutoCAD 2006, you will select carlson06.dwt.

The first of several Startup Wizard dialog boxes appears. If the Startup Wizard does not appear, then go to the Settings menu, choose *Configure* and then select General Settings. In the General Settings dialog, click Use Startup Wizard in the upper-left and click OK. Then open a new drawing again.
Once in the Startup Drawing Wizard, click Set at the top of the dialog box, and enter in a new Drawing Name. Since this is Lesson 3, call the new drawing Plat3.

Verify that the other settings match the settings shown above, and click Next. You will see the Startup Wizard Data Files dialog. This dialog box is used to specify where to store data, and the existing point information source. Set Plat3.crd as the new CRD file name.

Our source is the same file as in Lesson 2, Plat.txt. This is an ASCII file, so click Next, and in the new dialog box click the option to Select Text/ASCII Files. In the next dialog box, titled Text File to Read, choose plat.txt from the \DATA folder, and then click Open.
The Text/ASCII File Format dialog appears again, and the format of the points appears in the Preview Window, for verification, as shown below. Be sure that to the right of Draw Point, that Draw-Locate Pts is selected. Set the other options as shown. Click OK.

The points are then copied into the file Plat3.crd. If you repeat this exercise, and again use the file name Plat3.crd, you will be asked:

\[ \text{[O]verwrite w/new coordinates, overwrite [A]ll, or use number <55>: A (for all)} \]

In either case, when you correctly complete the process, the following dialog box appears:
Then this Drawing Import Wizard dialog box appears:

Choose the Field to Finish option, and click Next. If you receive a file selection dialog titled Specify Field Code Definition File, choose the file called "Carlson.fld". A dialog box now appears with a warning that some codes have two descriptions.

The command is asking whether these codes are to be treated as two separate descriptions, or as one description that has a space in it. Choose the default (Split all multiple codes), to tell the command that codes with spaces are really two separate descriptions, and click OK.

The Draw Field to Finish dialog box appears. Choose the options as shown here. Then click Additional Draw Options.
This displays a dialog box that provide many additional options, as shown below.

You want to draw all 1 through 54. Make sure the other options are set as shown above. Click OK twice.

*Draw Field to Finish* now draws the points and linework. Got to View, and then *Extents* to show the points, as well as the linework and point symbols. *Draw Field to Finish* saves you many manual steps. Your plat is shown below:
To understand how the above drawing was created, select Draw Field to Finish again from the Survey menu, and then select the Edit Codes/Points button from the dialog box. This takes you to the Field to Finish dialog box.

The display window shows a list of point codes, such as IP for iron pin and FL for fence line, that are converted to special symbols and linetypes by Draw Field to Finish. For an example of how the codes are used, look at the sewer line running from point 52 to 53 to 54 (the southernmost point), which is based on a field code of MH. Select MH for Manhole, as shown above, and then click Edit. The following dialog box is displayed.
MH has several attributes that are used by Draw Field to Finish, based on the settings shown above. Draw Field to Finish draws a manhole using the symbol SPT34. It draws a sewer line with the letter S for sewer. It places the manhole on layer SEWER, and plots a text description of "MANHOLE" underneath the symbol. (Descriptions can be upper or lower case.) When you are done looking at the MH field code definition dialog, click OK.

Other codes have fewer attributes. LP is set only to draw a symbol and text (Light Pole), but not to draw linework. FL, for fence line, is set to draw linework but not corner symbols or points descriptions. A code's attributes depend on the entries in the Set Linetype, Set Symbol, Description and Entity Type options.

The "Carlson.fld" Field to Finish code table is provided with the Carlson software. This table shows one possible system, but with far too many codes for a field crew to remember. You can make your own table by choosing the Code Table Settings option from the Field to Finish dialog box, then choose the Set button at the top right. Then select the New or the Existing tab from the top of the Specify the Code Definition File dialog box, in order to create or select a different code table (.FLD) file.

3 Use the Layer ID command, located under Inquiry, to verify the layers of the various plotted entities. Select Layer ID. Pick on the fence line, the road and the utility line, and notice the different layers (FENCE, EOP, UTILITY). You should study the layers in a drawing before deciding what to freeze and thaw. To reduce clutter on the screen, select the Layer Control command from the View menu. (The appearance of this dialog box might differ from what you see. It varies, depending upon what AutoCAD version is in use.)
Freeze the PNTS layer, the SPOT layer, and the PNTELEV layer by turning the sun into a snowflake. Then click OK.

4 Now you will do some drawing cleanup. Note that a single property line is drawn from point 8 to 9 to 10 and to 15. The chord from point 10 to 15 should be an arc. You will erase the segment from 9 to 10 and from 10 to 15, so that you can re-draw it, establish the tangent, then draw the arc and finish back at point 1.

To eliminate part of a polyline, select the Edit menu, then select the Polyline Utilities command, then Remove Polyline, and then click Remove Polyline Segment.

**Break polyline at removal or keep continuous [Break/Continuous]:** press Enter for Break

**Select polyline segment to remove:** Pick the segment from 9 to 10, then the segment from 10 to 15, then press Enter to end

To draw the correct polyline, use the 2D Polyline command under the Draw menu. If you prefer to type in the command, enter 2dp, which stands for 2D Polyline.

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: 9
[Arc/Closedistance/Extend/Follow/Line/<Pick point or point numbers>]: 10
[Radius point/radius Length/Arc length/Chord/Second point/<endpoint or point number>]: A
[Radius point/radius Length/Arc length/Chord/Second point/<endpoint or point number>]: 15
[Radius point/radius Length/Arc length/Chord/Second point/<endpoint or point number>]: 1
[Radius point/radius Length/Arc length/Chord/Second point/<endpoint or point number>]: press Enter

Now erase the plotted traverse line that makes a "V" near the left side of the drawing. Then use the 4-Sided Building command you learned in Lesson 2 to create the other two sides of the shed, located in the upper middle of the screen, near point 17. The end result, except the house, is shown below:
Much of the text in the above drawing, such as tree sizes and types, the manhole text, and the light pole text, can be used in the final drawing. But some of the text, such as the text plotted for iron pins and poles, can be fully described in the Legend without the redundancy of plotting to the screen. If you use the Erase command to remove the iron pin and pole text, the entire point will be erased because the attributes are grouped with the point. Instead, use the Erase Point Attributes command under the Points menu.

**Select Point No., Elev, or Desc to Erase:** Pick the 3 poles and the 4 iron pins

Next, you will use Extend by Distance command to create a building. The building will be less complex than the building you created in Lesson 2, but you will learn the "t" and "c" options, in addition to "l" for left and "r" for right. Under Edit, choose the Extend command. Select the By Distance option. Pick the western side of the small line segment west of the 12" pine and north of the driveway. Follow the prompts:

**Pick line or polyline to extend:**


"T" or "t" means "total" distance or "to" the distance - so extend "to" 50 feet total.


The Extend by Distance "T" option for total distance solves the dilemma of making an existing line, of unknown length, extend to an exact known length.

Use the Twist Screen command to position the plat on the sheet. Not every drawing can be plotted "due North." Sometimes North needs to be rotated so that property lines and important features run nearly left-to-right or top-to-bottom on the plotted page, for a better fit. In this drawing, you want the western line from point 8 to point 9 to run left-to-right on a sheet that will be plotted in landscape style (longer left-to-right than top-to-bottom). Under the View menu, select Twist Screen, then Line, Polyline or Text.
Pick a line, polyline or text to make horizontal: Pick the western line from point 8 to point 9, closer to point 9.

Now the drawing appears as shown below:

Notice that the north indicator (referred to as the USCICON), at the lower left, displays the rotation.

8 Now select Twist Point Attributes, under the Points menu, to twist the point descriptions and point numbers back to a left-to-right rotation.

 Twist by [<Twist screen>/Azimuth/Entity segment/Follow polyline]? press Enter
 Enter angle relative to current twist screen <0.0>: press Enter
 Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter
 Select Carlson Software points.
 Select objects: ALL press Enter

The points then twist back orthogonal to the screen, reading once again left-to-right.

9 The remaining descriptions associated with the points can be used in the final drawing, but they should be moved slightly for a better appearance. For example, the tree descriptions would look better if they were not inside the tree canopies.

Under the Points menu, select Move Point Attributes - Single. The steps of the command are: pick text, pick the new text position, press Enter, press Enter. Then the command repeats. Notice how the text "ghosts" as it moves, which helps you place it in the best position. Try to duplicate this result:
10 Because of the earlier *Twist Screen* command, the E's in the electric utility polyline are upside down. Choose the *Text* command, from the Edit menu, and select the *Flip Text* option. Select the text to flip.

**Select objects:** *pick the upside down E's* individually while holding down the Shift key

11 To label the dimensions of the building automatically, you must first activate the Auto Label Closed Polyline Exterior function. To make this a permanent setting, under the Settings menu, select *Configure*, then Survey Settings, and then Survey Text Defaults. Change the dialog box as shown below:

Click OK, and Exit back out. Select *Building Dimensions* from the Annotate menu, which is under the *Survey Text* command. Pick on the house. If the text overwrites the inside corner of the house, use the *Move* command (under the Edit menu, or type M for Move at the command prompt) and move the 30' dimension beneath the line.

12 To automatically annotate bearings and distance, as well as arcs, select the *Auto Annotate* command from the Annotate menu. When the dialog box appears, under the Lines tab, select the options you would like to use so that the bearings and distance labels appear as you would like. Then pick the three polylines that fully define the perimeter: the fence line, the polyline containing the arc, and the lower polyline, which is still the western polyline although you have twisted the screen so that it runs along the lower portion of the drawing. Use the *Move* command to move the bearing and distance labels to avoid overwriting other features.

When you move the lower distance label, 404.90' to the left, you want to move perfectly level to the screen, since this was the line you used to twist the screen, and it runs perfectly left-to-right. To do this, press the function key F8 to activate Ortho. Then pick 404.90' and move it to the left, picking its final position. Repeat this for the S 17°05'38" E bearing. After you move these items, press F8 again to turn off Ortho. Sometimes you will load a drawing from another client or source, and the Ortho setting has been left on. This may initially confuse you during the *Move* commands. Press F8 to deactivate Ortho. Notice that F8 works even with Twist Screen active.

13 *Auto Annotate* typically centers the arc annotation above and below the arc, which causes the arc data to overwrite the surveyed edge-of-pavement (EOP) polyline. You want to erase both the arc annotations, and use the *Label Arc* option of the *Annotate Arc* command to force both the arc length and radius to be drawn beneath the arc.

At the command line, enter E for Erase.

**Select objects:** *enter WP*, then pick as shown below
Press Enter when the selection set is complete. There is no "close" option for window polygon and crossing polygon selections.

For the new annotation, under the Annotate menu, select the Annotate Arc command, then the Label Arc option. Then select the arc from the screen. The Label Arc Settings dialog box appears:

You want to locate the arc text inside the arc, on positions 1 and 2. Position (Row) 1 is just under the arc, and 2 is under 1. Be sure they are both Inside. Fill out the dialog box as shown above, and click OK.

The new arc text might overwrite the 8" Pine, so, if it does, use the command Move Point Attributes - Single, in the Points menu, to relocate the 8" Pine description.

With the annotations placed in new positions, your drawing should be similar to the one shown below. Move your
14 To label the area of the lot, first select the *Area Defaults* command from the Area/Layout menu. Set the Square Units (s.f.) to the nearest whole unit (no decimals) and the Other Area Labels to 2 decimal places. Then click OK to exit the dialog box. Select the *Area by Lines & Arcs* command from the Area/Layout menu, and pick the three polylines individually, while holding down the Shift key, that define the property perimeter. Press enter, and locate the text to the left of the 12” Pine.

15 Before completing the final formatting of your drawing, you need to do some minor cleanup, using procedures you learned in Lesson 2.

You don’t want point 16, the PL point, to show in the final drawing. Use the *Layer ID* command, under the Inquiry menu, to verify the layer of point 16, which should be MISC. Freeze MISC using the *Freeze Layer* command on the View menu, and pick point 16. Freeze the point numbers using the *Layer Control* command on the View menu, and freeze the layer PNTNO.

16 To insert an A1, 8-1/2 x 11 border and title block, with the orientation landscape (not portrait), select the *Title Block* command from the Settings menu. You will see this dialog box.
Be sure these above selections match your own. Click OK. For the insertion point, select a point at the very lower-left of the screen, so that your drawing plan entities fit inside the border and somewhat nearer to the top. Pick your screen location. You will then be prompted for the attributes of the title block. Fill them in and click OK.

If you prefer, you can use the *Move* command, pick the title block and two border perimeters, and move them. Never move the drawing, because you will change the coordinates if you do. Move the drawing only if changing the coordinate locations does not matter.

17 Select the *Draw Legend* command, under the Annotate menu, select the Existing tab, choose the .lgd file that you saved in Lesson 2, and click Open. Then select Draw and OK, to close out the dialog boxes that follow, and then click Exit.

Pick an upper-left location point in the available space to the lower-left of the plat. If you did not save a legend in
Lesson 2 (or you skipped Lesson 2), follow the steps in that lesson. Use the *Scale Point Attributes* command, under the Points menu, and scale up the oak tree symbol in the Legend by a factor of 1.5.

Select the *Survey Text* command from the Annotate menu, then select *Survey Text Defaults*. Change the Offset Dimension Text alignment to Horizontal. (It may have been set to Parallel in Lesson 2.) Click OK. Now select the *Offset Dimensions* command from the Annotate menu, under the *Survey Text* command, and pick the lower right corner of the building, then the lower-most property line (in the current twist screen position). This labels the offset dimension horizontal to the current twist screen.

Pick the *Draw North Arrow* command, under the Annotate menu, and select and find the north arrow symbol that is shown in the figure below. Change the Symbol Size Scaler, if necessary, and click Specify Rotation On-Screen. Click OK. Then pick an appropriate location and press Enter. Note how the arrow draws due north, respecting the twist screen.

Choose the *Draw Barscale* command, under the Annotate menu, and pick a location near the lower-left portion of the drawing.

Your drawing should now look similar to this:

![Diagram of a drawing with a north arrow and barscale](image)

18 Select the *Hatch* command from the Draw menu.
Select the SOLID pattern from the pulldown list, then click the Select Objects button. Pick the house and the shed, and press Enter twice.

19 To offset the EOP Polyline, first try using the Standard Offset command under the Edit menu, and try offsetting the edge-of-pavement polyline that runs roughly parallel to the sewer line. You will see an error message because that object is a 3D Polyline, created by the Draw Field to Finish command.

To offset a 3D Polyline, you must use a command specifically designed to offset 3D Polylines. Under the Edit menu, select 3D Polyline Utilities, and slide over to Offset 3D Polyline.

Enter the offset method [<Interval>/Constant/Variable]: press Enter
Vertical/<Horizontal offset amount>: 30
Percent/Ratio/Vertical offset amount <0>: press Enter
Select a polyline to offset (Enter for none): pick the EOP polyline
Select side to offset: pick out and away from parcel, for the other side of the road

20 Before you add a title to the drawing, create a text style for the title. Choose Set Style in the Draw menu, found under Text.
Click New, and name the style Title. Choose the font named romant.shx, and then change the oblique angle to 10 degrees as shown. Click Apply, then click Close. Now, to create the title, type Dtext at the command line. Make sure that TITLE is the current text style.

Specify start point of text or [Justify/Style]: C
Specify center point of text: pick a point near the top-right of the screen
Specify height <8.00>: 20
Specify rotation angle of text <E>: pick a point to right of first point with <Ortho on>, dynamically stretch right
Text: Farmer Survey
Text: August 15, 2006
Text: press Enter

Select the Text Enlarge/Reduce option of the Text command under the Edit menu. Enter a Scaling Multiplier of .8 and pick the date you just entered.

21 Verify your drawing scale using the Drawing Setup command under Settings. Your drawing should have a scale of 100 with a Text Plot Size of 0.08. Change the Text Plot Size to 0.06 to shrink the building dimensions. Then label the house "2-Story", "Farm House" (2 lines of labeling), select the Leader with Text command under the Annotate menu.

Options/Pick Arrow Location: pick near or on the left side of the house
To point: pick off to the left
Next point (Enter to end): press Enter
Text: 2-Story
Text: Farm House
Text: press Enter

Pick anywhere on the leader. You see two grip squares (usually yellow), one on the left side and one of the right side. Pick on the right grip nearest the house. Move your cursor. Note how the arrow moves. Pick again for the new location, and note how the arrowhead and leader are now located and angled to your specifications.

22 Select the Triangulate & Contour command from the Surface menu. The Contour tab of dialog box should be filled out as shown below:
Click on the Selection tab and fill out to match the following:

Click on the Labels tab and match the following dialog:
Click OK.

**Select the Inclusion perimeter polylines or ENTER for none.**

Select objects: press Enter

**Select the Exclusion perimeter polylines or ENTER for none.**

Select objects: *Pick the house and the shed.* Since these objects have now been filled, the selection may be a little more tricky. We could (actually should) have placed the solids on their own layer and froze the layer before beginning the contour command. But we can use the fact that Carlson is filtering the objects to get around the problem. When prompted to select the objects, issue the C (for crossing) option, then pick a box that crosses the edge of the filled polylines. Carlson will accept the polyline but reject the fill.

**Select the points and breaklines to Triangulate.** Select a right-to-left window of the property. A right-to-left selection behaves as a crossing, which means that any object that is touched by the window or included inside the window is selected. (A left-to-right selection is a window selection, which means that only objects that are fully enclosed by the window are selected.)

Select objects: *pick Window location*  
Other corner: *pick other location*  
Select objects: press Enter to end

Pick the coordinate file that contains the points, plat3.crd, and click Open.

Reading points ...

Range of Point Numbers to use [<All>/Group]: press Enter  
Wildcard match of point description:<*>: press Enter

If the triangulation lines and faces were drawn, freeze them now. Next, pick the lower-left elevation “502” contour near the end. The grips are displayed. The grips near the contour end can be used for stretching. Straighten out the end of this contour line.

**STRETCH **

Specify stretch point or [Base point/Copy/Undo/eXit]: *pick a grib and pick a point*

**STRETCH **

Specify stretch point or [Base point/Copy/Undo/eXit]: *prck another grib and pick a point*
Press Enter. Clicking the right button on your mouse is the equivalent to pressing enter.

The final drawing will look similar to this:

![Diagram](image_url)

This completes this Lesson 4 tutorial titled Field to Finish for Faster Drafting.

**Lesson 5: Intersections and Subdivisions**

1. Click the icon for Carlson and start up Carlson Software from Windows. Once in the program, exit the Startup Wizard if it appears.

2. Once in Carlson, click **Open** under the File pulldown menu. Look for the file Plat4.dwg and click on it. When it lights up blue, as shown below, it will appear in the Preview Window at right. It should look like the open-sided property shown here. Plat4.dwg is found within the WORK folder of Carlson. You search for the file as you typically would in Windows, clicking the yellow "Up one level" button to go to the parent folder of the current folder, or by clicking the adjacent down arrow to find the desired path in the full tree of folder locations.
Now click Open to select and open the file Plat4.dwg.

3 Enter & Assign a Starting point for the Street Centerline. Select Draw-Locate Points, found under the Points pulldown, and obtain the dialog shown below:

Click off the prompting and labeling for Descriptions, Elevations and Locate on Real Z Axis (make them blank as shown). Up top, change the symbol to SPT10 by picking Select at the very top of the dialog, and choosing symbol SPT10 from the dialog of symbol choices (not shown here). Also, verify that Automatic Point Numbering is clicked on, that the Starting Point Number is 1, that the layer is PNTS. Match these entries (which are mostly the default
conditions) and click Enter and Assign at the lower left.

Prompting will appear at the bottom of the screen. We will enter the starting point as follows:

**Enter North(y):** 4809.17  
**Enter East (x):** 4391.28

The program will recognize that you have not yet started a coordinate file, so click the New tab and enter the File Name as Plat4.crd (which should be the default). If you enter Plat4, you do not need to enter the extension .crd. The program will add extensions automatically. You will see this:

![Coordinate file to process](image)

Click Open. You will be prompted again:

**Enter North(y):** press Enter (for no more points; we are done)

4 Traverse from PI to PI (to the two endpoints of our centerline). Select Traverse under the COGO menu, or alternately just enter T at the command line. (T is a hot key. Other hot keys are I for Inverse and SS for Sideshot). Reply to the prompts as follows:

**Traverse, Line OFF, RAW FILE OFF**  
**Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <7>:** 1  
**Enter Bearing Angle (dd.mmss) <90.0000>:** 58.1848  
**Points/<Distance>:** 736.73  
**N: 5196.15 E: 5018.19 Z: 0.00**  
**Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <1>:** E (to exit)

You could keep on traversing, but we will stop here to review. You have created point 2, traversing NE from point 1. To review, code 1 is for NE, 2 for SE, 3 for SW, 4 for NW, 5 for Azimuth, 6 for Angle Left, 7 for Angle Right, 8 for Deflection Left and 9 for Deflection Right. This is the standard way that traverses and sideshots are entered in Carlson with a code entry (followed by Enter), then the angle or bearing entry (followed by Enter). Lesson 1, the Entering a Deed lesson, presented another method, where the angle and bearing are together in the form of 158.1848. That is a rare form, designed to save keystrokes, and used primarily only in Enter Deed Description. Now you have been exposed to both!

5 Line On/Off. Click Line On/Off, under the COGO menu, to turn on simultaneous linework with traversing. This command toggles on and off each time you click it, with the On status indicated by a check mark. Now repeat the
 Traverse, Line ON, RAW FILE OFF
Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <1>: 2
Enter Bearing Angle (dd.mmss) <58.1848>: 75.0627
Points/<Distance>: 553.69
N: 5053.85 E: 5553.28 Z: 0.00
Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <2>: E (to exit)

6 Draw a Polyline from Point 1 to Point 2, and connect the segments with Join Nearest. We could have turned linework with traverse on before we got started, but now we will do it after-the-fact. So choose 2D Polyline under Draw. Some users like to simply type in 2DP at the command line that starts the Polyline command, also.

[Continue/Extend/Follow/Options/<Pick point or point numbers>:] 1
[Arc/Close/Distance/Follow/Undo/<Pick point or point numbers>:] 2
[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>:] press Enter (to end)

Now we have two line objects. The first, from point 2 to point 3 is a pure Line. The second, from point 1 to point 2, is a true Polyline (even though it is only one segment long). It is officially a LWPOLYLINE, a lightweight polyline. This can be verified by picking it using the List command under Inquiry. Polylines are linked combinations of one or more line segments that behave as one unit. We encourage use of polylines versus lines because they offset as a unit, will take on a thickness or width, are easier to select and have superior editing capabilities. A line can be turned into a polyline by picking Polyedit under Edit, picking the line, and answering Y to the question "Do you want to turn it into one? <Y>". To join the polyline and line objects into a single polyline, choose the very useful command Join Nearest, found under Edit.

The defaults are good. Just click OK. Now pick the polyline from 1 to 2 and the line from 2 to 3, and then hit Enter for no more.

Now, see the grips on the new polyline by picking it with the cursor. See how the whole thing highlights? That is proof that it is joined up as a polyline.

7 Design a Curve with a 500' Radius. Under Draw, pick Arc and slide over to 2 Tangents,Radius.

Radius of Arc <0.00>: 500
[nea] Pick Point on 1st Tangent Line: Pick on the 1st polyline segment closer to point 2
[nea] Pick Point on 2nd Tangent Line: Pick on the 2nd polyline segment close to point 2

The arc draws in, and the centerline remains a polyline, now with 3 segments.

8 I for Inverse. Entering I for Inverse, at the command line, is a handy way to get on a point to begin another traverse. Practice inversing. Enter I. Inverse from point 1, then to point 2, then to point 3 then back to 1. But you can also
inverse (go to) a snapped position on a line or polyline, such as the midpoint of an arc. Let's do that, because we want to traverse south from the midpoint of the arc. Enter I, for Inverse.

**Calculate Bearing & Distance from starting point?**

Traverse/SideShot/Options/Arc/Pick point or point number: MID (for midpoint snap) of Select the arc
Traverse/SideShot/Options/Arc/Pick point or point number: T (for traverse)

Traverse, Line ON, RAW FILE OFF

Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <2>: press Enter

Enter Bearing Angle (dd.mmss) <75.0627>: 10.11

Calculated Bearing (Qdd.mmss): 210.1100

Points/Distance: 400

Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <2>: E (to exit traverse)

Notice that you can transition from inverse, to traverse, to sideshot, etc. with these COGO options. We were in inverse, but we did T for traverse, and could have done I for inverse to return to inverse. This cuts down on keystrokes, and adds to the sense of fluidity of the software.

9 Turn a Line into a Polyline with Polyedit. The command *Offsets & Intersections* requires pure polylines, not lines, to execute. So, since we had Line On with the last traverse, we have created a line. To use this in street design, we need to convert it into a polyline. Select Polyedit under the Edit pulldown menu.

**Select polyline or [Multiple]:** Pick the side road line

Object selected is not a polyline

Do you want to turn it into one? <Y> press Enter

Enter an option [Close/Join/Width/Edit vertex/Fit/Spline/Decurve/Ltype gen/Undo]: press Enter

10 Offsets & Intersections. Under the Area/Layout menu, select *Offsets & Intersections.*

**Select all PRIMARY road polylines.**

Select objects: Enter (we will consider both these subdivision streets secondary)

**Select all SECONDARY road polylines.**

Select objects: Hold down the Shift key and pick the main centerline

Select objects: With shift key still down, pick the side road

Select objects: Enter (for no more)
The street intersections are presented in a dynamic dialog as shown above. Try experimenting with different radii under the Secondary Roads column, then clicking Calculate. The streets will re-draw in the upper graphical area. But after experimenting, change the four values under Secondary Roads to those shown (ignore Primary Roads – those don't apply here), and click Calculate. Then click Finish 2D. Note the drawn-out street intersection.

Now select **Layer ID** under the Inquiry menu. Pick on the outside polyline (it is layer ROW). Pick on the next polyline in from the outside (it is layer EOP). For example, if you had clicked off EOP under the Draw column in the above dialog, the edge-of-pavement polyline would not have drawn.

**11 Standard Cul-de-Sac.** Under Area/Layout, select Cul-de-Sacs. You may want to zoom into the area of the bottom center, near point 4. When finished with the procedure below, zoom back out.

Prompting:

**Select all offset polylines to end with cul-de-sac.**

**Select objects:** Do a crossing selection from right to left across the lower side road, selecting all 5 polylines (ROW-L, EOP-L, CL, EOP-R, ROW-R)

**Select objects:** press Enter (for no more)

**Pick cul-de-sac center projection onto centerline:** END (type end for endpoint snap)

Pick near the endpoint of the centerline of the lower side road near point 4. However make sure the pick is on the centerline polyline, or the routine will say the centerline not found.

This brings up the following dialog:
Again, you can change the Fillet Radius and the Outside Radius on the EOP or ROW, hit Calculate, and check out its effect. (Don't make the Outside radii too small or it will fail Calculate if there is no workable solution). Set values as shown above. Then click on Finish 2D.

12 Teardrop Cul-de-Sac. Now select the *Cul-de-Sacs* routine again, under Area/Layout.

**Select all offset polylines to end with cul-de-sac.**

**Select objects:** *Do a crossing selection* pick from right to left across the right main road, selecting all 5 polylines (ROW-L, EOP-L, CL, EOP-R, ROW-R)

**Select objects:** *Enter*(for no more)

**Pick cul-de-sac center projection onto centerline:** END for endpoint snap *Pick endpoint of the centerline* of the lower side road near point 3

For a teardrop cul-de-sac, fill out the dialog as follows, then click on Calculate and Finish 2D.

Teardrop cul-de-sacs allow moving vans and other large vehicles more turning room, and have been popular in the
Cincinnati area, for instance. Our drawing now appears as shown below, with the exception of the filled reference dots.

13 Let's make a layer called LOTS using Layer Control found under View. It's a good idea to create a layer and set it current before beginning the design process. Select Layer Control and obtain the following dialog:

![Layer Properties Manager dialog box]

Click on for New layer. When Layer1 highlights, as shown at bottom of list, type over it with LOTS, then click under the Color column and change the color to Magenta. Then click the (Set) Current button up top to make this layer current. Then click OK to exit the dialog.

Next, we will use Break at Selected Point, found in the Edit menu.

The Lot Layout routine under Area/Layout works nicely with reasonable polylines that run roughly parallel. Our goal is to make 1-acre lots. Lots of zigs, zags, and jogs in the polylines cause the perpendicular offset logic to fail to
find a solution (lots will radiate perpendicular from the front polyline in Lot Layout). Not only should the front and back lines run opposite each other, but they should end at some point before the calculation runs into difficulty with impossible math.

The outer R-O-W polyline currently runs left-to-right, goes around both cul-de-sacs and returns right-to-left in one, connected polyline. We need to break it near where the filled dot is pointing. It should be easy to lay out lots along the upper portion of the subdivision, as long as we stop to break the R-O-W polyline before it turns and runs back through the lower, more complex frontage and back property portions.

Under Edit, select Break, and slide over to At Selected Point. You will select using the filled dots, shown on the plan above, as references.

**Select Line, Arc, or Polyline at break point:** Pick near the filled dot on the outer boundary polyline. Repeat the command for the ROW polyline.

**Select Line, Arc, or Polyline at break point:** Pick the far right end of the Teardrop cul-de-sac R-O-W polyline.

To prove you have broken the polylines in two, click on the R-O-W polyline on the south side (only the south portion should highlight), then click on the north R-O-W polyline (which we will use as our frontage polyline in the command Lot Layout). Then press the ESC key twice, which gets rid of the grips, as does zooming or panning.

14 Select Lot Layout under Area/Layout. A dialog appears:

![Lot Layout dialog](image)

Fill out as shown. In particular, click off Apply Remainder Equally to All Lots (if it is on) so that we force 1.000 acres lots and don't just get equal lots of some size such as 1.0017 (because the remainder lot that would not fit was added onto all lots).

Making Closed Polylines means that our side lines will be doubled up, each lot sharing a side line. Click OK.

**Select front polyline:** Pick north R-O-W

**Select back polyline:** Pick northernmost polyline the back property line.

The 1.00 acres lots are laid out as far as is possible. You may get a small lot at the end of the row, which you would erase.

15 Applications of Reverse Polyline. We can get one more lots from Lot Layout, by doing the lower R-O-W at the left side of the drawing, and picking the southern back polyline. Let's try. Select Lot Layout under Area/Layout. Use same dialog entries. Select the front polyline as the southern edge of the road R-O-W, near the left side of the drawing. Select the back polyline as the southern property line. Oops! Nothing drew. It was unable to calculate. It turns out that the direction of the polyline is important. The southern R-O-W polyline starts way off to the right,
so the program was not even considering where we were looking! We need to reverse the direction of the southern R-O-W polyline so it starts on the left side. Select **Reverse Polyline**, found under the Edit pulldown, sliding over from **Polyline Utilities**. It prompts:

**Select polyline or line to reverse:** *Pick the southern R-O-W polyline.*

The polyline now reverses direction, goes left-to-right, and shows phantom direction lines (which are automatically removed when the command ends). Now repeat the Lot Layout command as outlined in the beginning of Step 15, and we get one new lot out of the exercise, as shown below. If you get a second wedge shaped lot, erase it.

![Diagram of the reversed polyline](image)

**16** Break at Intersection. The lower back property line is still continuous. We can work with it in small pieces rather than as one big polyline. Say we want to break it as the inside corner identified by the arrow above. To do this, select Edit pulldown, Break, sliding over to At Intersection. Prompting:

**Select Line, Arc, or Polyline to Break:** *Pick the south property line*

[app on] **Pick Intersection to break at:** Move the cursor to the intersection point indicated above, look for the INT snap to appear as you approach the exact corner (which is an intersect), then click there.

**17** Draw a Polyline from the corner indicated by the filled dot to the beginning of the R-O-W arc, also indicated by a filled dot in the previous graphic. Select 2D Polyline under Draw.

**Pick point or point numbers:** End (type in end for the endpoint snap)

of **Pick the inner back property corner**

**Undo/Arc/Length/**<**Pick point or point numbers**>: End (type in end for the endpoint snap)

of **Pick the beginning of the Arc (it will show endpt when you get close to the true start of arc)**

**Undo/+/-/Arc/Close/Length/**<**Pick point or point numbers**>: Enter (to end)

**18** Area by Interior Point. We have just created a new lot, but the lot is not defined by one, single, closed polyline. If we want to verify its area, however, we can still use the command Area by Interior Point. Select Area by Interior Point under Area.

**Pick point inside area perimeter:** *Pick inside our new lot*

**SQ. FEET:** 40997.2 **SQ. YARDS:** 4555.2 **SQ. MILES:** 0.0

**ACRES:** 0.9412 **PERIMETER:** 830.5026

**Pick area label centering point:** *Press Enter here to avoid labeling.*
The lot is less than one acres. We will set as a goal to extend its lower boundary to the right to obtain one acre. That is accomplished by using the command Hinged Area. But Hinged Area works best if we have a nice, closed polyline for the new lot. We can get one using the command Boundary Polyline.

19 Boundary Polyline. At the command line, type in BPOLY (or BOUNDARY). When the dialog appears, pick New.

Then pick all the polylines that surround our new lot. Then after you hit Enter to Select objects, this same dialog returns. Then you select Pick Points and pick inside the lot. This creates a new closed polyline, in the current, LOTS layer (magenta).

20 Select Hinged Area under the Area/Layout pulldown.

Define area by points or closed polyline [Points/<Linework>]? press Enter (for linework)
Select polyline segment to adjust: Pick on the right-side line
Select hinge point [endp]: Pick on the upper right hinge point (see arrow)
Keep existing polyline [Yes/<No>]? N
Area: 40997.20 S.F, 0.9412 Acres
Remainder/Acres/<Enter target area (s.f.)>: A (for acres)
Remainder/SF/<Enter target area (acres)>: 1.0

The new lot draws, as shown below:
21 Next, use the Erase command to remove the segment that is pointed to above with the text Click on This Side.

22 Make 2 More Lots with Polyline command. Instead of using Draw, 2D Polyline, we will use the straight AutoCAD polyline command. At the command line, enter PL.

**Specify start point:** END (type in the endpoint snap) of Pick the endpoint (which is the lower right corner of the new lot).

**Current line-width is 0.00**

**Specify next point or [Arc/Halfwidth/Length/Undo/Width]:** PER(type in the perpendicular snap) to Pick on the R-O-W polyline to the right.

**Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]:** press Enter(to end)

Now for the second lot. Referring to the drawing below, repeat the PL command, and answer as follows:

**Specify start point:** NEA (enter the nearest snap) of Pick on the property line anywhere near the circled point 1(no need to be exact)

**Current line-width is 0.00**

**Specify next point or [Arc/Halfwidth/Length/Undo/Width]:** PER (type in the perpendicular snap, which when intersecting arcs means radial to the arc) to Pick on the R-O-W polyline near circled point 2.

**Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]:** ENTER (to end)

The drawing appears below:
23 Issue the *Break at Intersect* command, and break the back property polyline and the cul-de-sac R-O-W polyline at the intersections with our newly drawn polyline from step 22. Repeat this command, and break the back property polyline at the filled dot to the right of the "Sliding Side Area" label below.

24 Repeat *Lot Layout* with the same entries as before. The front and back polylines to select are shown below, along with the results. This gives us 2 more usable lots.

Next, use the *2D Polyline* command to generate a segment (above the "Sliding Side Area" label below) that runs from the ENDpoint of the corner to a point PERpendicular to the R-O-W line. Then use *BPOLY* to create a closed boundary inside it.

Erasing the original segment you placed is a little tricky since the newly formed polyline is on top. When two pieces of geometry lie on top of each other, Carlson will take the one created last. Issue the *Erase* command, then hold down the control key while picking the segment above the "Sliding Side Area" label. When the single segment highlights, press enter to erase it, leaving the boundary polyline.

25 Sliding Side Area. Because we have a small closed polyline, we can investigate another area command, the
Sliding Side Area. As shown in the graphic above, we want to slide the north side of the last, smaller lot parallel to its current bearing such that the lot will contain 1.00 acres. Select *Sliding Side Area* under the Area/Layout pulldown.

**Define area by points or closed polyline [Points/Linework]?** press ENTER

**Select polyline segment to adjust:** Pick the north side of the lot above (shown here containing the words Sliding Side Area)

**Keep existing polyline [Yes/No]?** press ENTER

**Area:** 20375.30 S.F, 0.4678 Acres

**Remainder/Acres/<Enter target area (s.f.)>:** A (a for acres)

**Remainder/SF/<Enter target area (acres)>:** 1.0

---

26 Complete the remaining Lots. Using the 2D Polyline command, under Draw, use endpoint snaps and perpendicular snaps (end and per) to draw the final 3 polylines, shown below marked 1, 2 and 3 for reference.

It may not be the most aesthetic subdivision, but we applied a lot of tools making it. But we're not done. There's some real automation ahead.

27 Create Points from Entities. We have designed a subdivision, in effect, without point numbers. This is the beauty of CAD. But we need to make point numbers in order to stakeout the subdivision. To do this, select *Create Points from Entities*, under COGO. The following dialog appears:
Set the starting point number to 5, verify the dialog as shown, and click OK. A second dialog, covering what entities to capture, appears next. Stick with the default settings and click OK.

When it asks, Select objects, type in All. Press Enter for no more selections, and Enter again. All the point numbers for stakeout are created.

28 Number the lots, clockwise from the upper left, using the command *Sequential Numbers*. Under Draw, select *Sequential Numbers*. This dialog appears:
Choose the circled text and click OK.

Set the text size (height) to 16 and the starting text value to 10, as shown. Then click OK.

**Pick point at center of label or type Polylines to label:** Pick near the center of the first upper left lot.

**Pick point for label alignment:** Press F8 for <Ortho on> Pick to the right.

Now pick near the center of all of the lots, going clockwise.

When done, and back to the command line, press F8 again to set Ortho off.

The resulting drawing, with point numbers, is shown below:
Lot File by Interior Text. Official lot files can be created whenever a lot number or name exists within a lot as the sole text (other text may be present but could be frozen). So we will play it safe and first freeze the point number layer. Before we do, take note of the point number assigned to the NW corner of Lot 10. In our case, it is point 64 (it may be different in your case, depending on how you selected the objects in the command Convert Entities to Points).

Under View, select Freeze Layer and pick on one of the point numbers. Now go to the Area/Layout pulldown, select Create Lots and slide over to select Lot File by Interior Text.

A dialog box will appear. Be sure that is says Block Name 1. Click OK.

Select lot lines, polylines and text.

Select objects: Pick the lots and the lot numbers

The Lot Files will be created. Before we look at the Lot Files, let's finish up and do area annotation on the upper lots, by the command Area by Interior Point.

Note: If we had not made points at all lot corners, using Convert Entities to Points, the Lot File by Interior Text would make point numbers. This is the reason for the prompt: Starting point number. If points are found, no new ones are created. Lot files must have points at all the corners.

Area by Interior Point. Select Area Defaults, under Area/Layout, and cancel the square feet plot, leaving only the area plot to 3 decimal places. Set as shown below:
Now choose *Area by Interior Point*, under the Area/Layout pulldown menu, and pick inside Lots 10 through 16, as shown below:

31 Select *Lot Manager*, under Area/Layout, and the following Lot Editor dialog appears:
Pick on Lot 10 and click Report. This will lead to the Lot Report dialog box.

Be sure that your setting are as shown above, and then click Lot Report.
This dialog is typical of the many Carlson Standard Report Viewer dialogs, first introduced in Carlson CES. You can click on 1 or more lines, highlight them and hit the delete key on the keyboard, and these lines will delete. You can edit lines directly in the dialog. You can also save the report to disk with the Save icon shown above. To exit, click the Exit icon.

32 The Edit Current (lot) option within the Lot Editor dialog box can be used to describe a lot by different point numbers, or to assign a lot to a different block. This is explained here and shown below for reference purposes only.

Click Lot Manager under the Area/Layout pulldown menu. You will see the Lot Editor dialog as shown in Step 31. First, make sure that a .lot file is open. If it is not, open one. Then, under Selection, select a lot to edit. Click Edit Current. You will get this dialog. Note the graphic display in the lower half, which map the Points listed above.
Re-Drawing Lots after Editing Points. Let's assume you actually changed the point numbers that define Lot 10. That would cause the lot to draw differently. Also, you could simply alter the coordinate values of a point in the current lot file. That would also cause the lot to draw differently. Let's take the latter approach. Remember point 64? It is the NW corner of lot 10 (in our case your's may be different as stated above). So select Edit Points under the Points pulldown menu. A spreadsheet appears. Scroll down to point 64 (or whatever point is your NW corner of Lot 10).

Click on the Northing and edit it to 5050. This is for illustration purposes. In reality, you might be fine-tuning your
subdivision design points. As long as the same points define the lots, you are, in effect, making a ready-made new
drawing. Now select at the top of the dialog File, then Save and Exit.

34 Draw the Lot File. Before we draw the lot file, save your drawing by selecting Save under the File pulldown
menu. Then choose New, exit the Startup Wizard (if it appears), and go straight to Lot Manager, found under the
Area/Layout pulldown menu. Lot Manager provides the tools for drawing lot files to the screen.

Click the Existing tab. Select the plat4 lot file and click Open. Now select your existing crd file that you created
earlier. In the next dialog, called Lot Editor, shown below, choose all lots by clicking Select All. Then click Draw.
Accept the defaults and click OK to the Draw Lots dialog box. This leads to the Auto-Annotate dialog, shown below. Use the settings shown here. Click OK.

Next comes the Area Defaults dialog, as seen in Step 30. Fill out exactly as shown in Step 30.
Click OK and then Exit. This leads to the plot shown below, created entirely from stored Lot Files, and showing our revision of Lot 10.

This completes this Lesson 5 tutorial titled Intersections and Subdivisions.

**Lesson 6: Contouring, Break Lines and Stockpiles**

1 Click the icon for Carlson and start-up AutoCAD/Carlson from Windows.

2 Once in Carlson, exit out of the Startup Wizard (if it appears) and click *Open* under the File pulldown menu. Look for the file Mantopo.dwg and click on it.

3 Select *Triangulate & Contour* from the Surface pulldown menu (within the Survey module). Click the Contour tab. Let's target contours at a 1-unit interval, and contour the area of points. You will see this dialog.
Make all settings as shown (most of them are the default). We want to make sure that the Contour Interval (top right) is set to 1. Also, be sure to set the Index Interval to 5. Click OK.

**Select the points and breaklines to Triangulate.**

**Select objects:** Do a bottom right to upper left crossing selection by picking just to the left of the small, stockpile contour map, near the bottom of the screen, and then picking the upper left of the screen (capturing all points).

**Select objects:** Enter(for no more)

A dialog box appears. Select Mantopo.crd as your crd file. Click Open and the points will be read from the crd file.

**Range of Point Numbers to use [All]/Group:** Enter (to accept All)

**Wildcard match of point description <#>:** Enter

Contours are drawn, but notice the unacceptable wavy look around the perimeter an area which is meant to be a ditch.
Type in U for Undo and press Enter until the new contours (at left) disappear and you are back at the command prompt.

4 Field-to-Finish: From within the Survey module, under the Survey pulldown menu, select *Draw Field-to-Finish*.

You will be prompted for the CRD file to process. Choose the Existing tab, then select MANTOPO.CRD, which resides in Carlson's data folder, and click Open. The Draw Field to Finish dialog appears.

![Field-to-Finish dialog](image)

At the lower left of the Draw Field to Finish dialog, click Edit Codes/Points. The Field to Finish dialog appears.
On the left side of the Field to Finish dialog, under the heading Code Table, there is an option called Code Table Settings. Click on it. You will see this dialog:

As you can see at the top of the Code Table Settings dialog, the default Field to Finish code definition (.FLD) file is Carlson.fld. We want to make a new code table because the coordinate file for the field survey includes special coding (17 and 18) for ditch lines and top of banks.

You can react and adjust to whatever a field crew uses by making a new field-to-finish table that can load up the codes right from whatever descriptions were used in the field. To do this, click Set at the upper-right of the Code Table Settings dialog, then choose the New tab (for new file) and you might name it Mantopo, as shown below:

On the left side of the Field to Finish dialog, under the heading Code Table, there is an option called Code Table Settings. Click on it. You will see this dialog:
Click Open. You will be taken to the previous dialog.

Notice how `\DATA\Mantopo.fld` is now listed at the top. Click OK. You will return to the main Field to Finish table, completely empty, as shown below:
Now, jump start the table by choosing the option Code Table by CRD (located in the lower left of the dialog). Choose Append.

In this lesson, we only care about code 17 and 18, so highlight all of the others (by holding the CTRL key down and picking them), then choose Cut. Now highlight both 17 and 18 as shown below.
Pick the middle Edit button. Another dialog appears.

Click the Entity button for yet another dialog, shown below. Make all settings as shown in this box. We will turn them both into 3D polylines (which will act as break lines or barrier lines for contouring). Accept the 3D Polyline choice by clicking OK, then hit Exit, which will take you back to the Field to Finish dialog.
The last steps are to first to save the Field-to-Finish (.FLD) file Mantopo by clicking the Save button. Then click Draw (lower right) to draw the 3D polylines. You will see the following dialog which allows you to control the details of what to draw. Make sure lines is the only entity to be drawn, not points or symbols. Take a quick look at Additional Draw Options by clicking that button. Make sure that the Point Label Settings are set so that you can see the points properly. Click OK to both dialog boxes.
The following drawing is created. All the ditch lines and top of bank lines, because they were coded 17 and 18, are drawn in one quick procedure.

5 Because the field crew did not use start and stop logic (e.g. appending 7 or some agreed upon code to a description could end a polyline and start another), some polylines connect that should not. In particular, the line pointed to near the NW corner is clearly crossing the ditch line. It must be removed. Choose the Edit pulldown, then Polyline Utilities, Remove Polyline, then Remove Polyline Segment.

**Break polyline at removal or keep continuous [<Break>/Continuous]?: Enter**
Select polyline segment to remove: Select the polyline segment to the right of point 127. You will recognize this as a long segment running from point 127 to point 50.

Select polyline segment to remove: Enter (for no more)

6 Return back up to the Surface Menu, pick Triangulate & Contour, and set the standard contour interval to 1 (as before), but specify Draw Index Contours. Set the index interval to 5. Then do a right-to-left crossing selection as before (avoiding the stockpile at the lower right). Select the Mantopo.crd file again.

Now we get excellent contours, with a sharply defined ditch. Under View, do Freeze Layer and pick on a point. The points will freeze.

Here is the improved drawing, helped out by 3D polylines, which, if selected, act as break lines, which were produced by Draw Field-to-Finish.

7 Delete Layer. Let's say that now you don't want the break lines on there. You don't want to even freeze them, you want to fully delete them. There is a command for that under Edit. Pick Erase, sliding over to Erase by Layer. This dialog appears.

![Erase by Layer/Type dialog box](image)
If you know the layer names, you can just type them in. If you know where they are but not their names, then click on Select Layers from Screen. If you'd recognize the layer name if you saw it in a list, click Select Layers by Name. Click on Select Layers by Name and pick 17 and 18, then OK twice. Notice the change in the drawing.

8 Explode. Inserted Drawings need to be exploded. Do a View pulldown, option Window and window in on the stockpile at the lower right of the drawing. If you type E to Erase, and try to erase any aspect of the stockpile, the whole stockpile will erase all features. That is because the Stockpile was another drawing inserted into this drawing. Sometimes other drawings that are inserted are referred to as Blocks. In any case, this stockpile block, or inserted drawing, needs to be exploded. Explode just breaks it up into its unit objects which then start to behave normally. Select Explode under Edit and slide over to Standard Explode. Then pick the stockpile. It is now a set of normal objects.

It's also worth noting that while the block has been exploded, it still exists in the drawing as a block definition. This means that now that it's exploded it is taking up twice the amount of storage space in the drawing. As such, you should purge the drawing of the unused block, or turn on the explode toggle when inserting one drawing into another. As a basic rule, if it's a symbol, don't turn on the explode toggle; if it's a complete dialog, turn it on.

9 Change Elevations. Let's assume our stockpile drawing is too high and should be lowered in elevations by 540 units. To best see the effect of this command, bring back the points by selecting Thaw Layer, under View. Now select the Edit pulldown, then Change, then Elevations.

Ignore zero elevations [<Yes>/No]? Enter
Type of elevation change [Absolute/<Differential>]: D
Change Layer for changed entities [Yes/<No>]: Enter
Positive number increases, negative number decreases elevation.
Scale/Elevation difference <0.00>: -540
Hit Enter twice.
Select objects: Do a lower right pick to upper left pick (automatic crossing) selection.
Select objects: Enter (for no more)

Notice in the drawing below how everything has change elevation, including the points, but with the exception of the contour text.
Do the command List Elevation under the Inquiry pulldown, pick on an index contour, and notice how the elevation has indeed changed. Repeat step 7 and delete the layer Ctext, so as to remove the 5 index contour elevations, which are no longer accurate.

10 Volumes by Layer. One of the signature commands of Carlson, Volumes by Layer will produce accurate volumes without making any files. The only prerequisite is that the existing and final surfaces exist on the drawing in separate, distinct layers. It is also very important to have a drawn inclusion perimeter to pick and define where the volumes are being calculated. In our example, the original ground will be the 3D polyline connecting points 1 through 15, and everything else above will be the final ground (including the 3D perimeter itself).

Select Volumes by Layers. This command is found under the Grading menu, within Volumes by Grid Surface.

**Pick Lower Left limit of surface area:** Pick below and to the left of the stockpile, but as close as possible to the stockpile without clipping it in the window. You want to totally include it, but with little wasted margin.

**Pick Upper Right limit of surface area:** Pick above and to the right of the stockpile.

A dialog appears:

![Make 3D Grid File dialog]

We will stick with the defaults, as shown. Notice that we are using 50 grid cells within our window, and since our window was not a perfect square, the cell sizes are not whole numbers. (In this example it is 6.88 x 5.77. You may have slightly different sizes). Seeing this, if we wanted 5 x 5 cell size, we could click the Dimensions of a Cell option and set the size to 5 x 5. Hundreds or thousands of cells in both directions will increase calculation time. You can experiment with more cells, or if you prefer, smaller cells (which makes more cells), and see when you get diminishing returns in terms of accuracy changes. After a while, tighter, smaller cell sizes don't add any value to the precision of the calculation. Click OK.

Then pick the layers that define the existing ground (Perimeter) and the layers that define the final ground (Perimeter, Barrier, Ctr, Ctrindex).

![Volumes by Layer dialog]

Then click OK. Notice how the Perimeter layer is common to both. If you want to be a master of volumes, remember this as a mantra: The perimeter should be a 3D polyline in a distinct layer, common to both surfaces. A stockpile is just a special case in that sometimes the 3D perimeter is all you know about the base surface.
When asked to Select objects, do a right-to-left (crossing) selection of the entire stockpile area. Lastly, you will be asked for the inclusion perimeter (pick the white perimeter polyline) and the exclusion perimeter (none). This leads to a flexible reporting and output dialog:

![Volume Report Options](image)

Elevation Zone Volumes, for example, would produce volumes in any desired increment from the base of the stockpile going up. If the stockpile consists of coal (80 lbs/c.f.), then Report Tons can be clicked on and a Density value entered.

Click OK, and the basic report is produced, as seen below. We did not include the points in the final layer. Since there is a high point, for example, the top of the stockpile, the points would lift the volumes up slightly.

![Volume Report](image)

Click the Exit icon to return to the command prompt.

**Stockpile Volumes**. Our Stockpile is naturally well-suited for applying the simplest volume command of all Stockpile Volumes. It requires that the 3D perimeter polyline for the stockpile be placed in a layer called Perimeter which ours is. So let's try it.

Select *Calculate Stockpile Volume* found under the Grading pulldown menu.

**Material density lbs/ft\(^3\) (Enter for none):** 80

**Ignore zero elevations [<Yes>/No]? Enter**

**Reading points ...**

**Select Stockpile perimeter polyline:** Crossing select (right-to-left picks) the entire stockpile area.

The grid resolution dialog (note that it is still at 50x50) appears again. Click OK. Done. A report is generated.
This completes the Lesson 6 tutorial: Contouring, Break Lines and Stockpiles.

**Basic Road Design with Volumes**

1 First we need to open an example drawing supplied with Carlson. Issue the File Open command and choose EXAMPLE2.DWG. It should be in the Carlson work folder, and will look like the example (without the curved road).

2 Draw Road Centerline. Issue the Draw > 2D Polyline command and generate the road centerline as shown below. In this case it was drawn from the left, down and toward the right. Include a curve segment with the Arc option of the command.

3 Profile from Surface Entities. Now we will make a profile file, *.pro. This will be from the centerline shown in the drawing as the lines with the curve. Under the Profiles menu choose Create Profile From ..., then Profile from Surface Entities. This will create a new file. Type in a file name in the dialog and click Save. On the next dialog, we will use the default values and click OK. Pick the centerline, and without hitting enter, select all of the contours. The data is written to file.

4 Draw Profile. This will give us a profile view of the contours at our centerline. Under Profiles, go down to Draw Profile and open our new file. The window will appear as shown. With the horizontal scale set to 50 and the vertical
scale set to 5, there will be a 10X vertical exaggeration of the profile. Fill this dialog box it out as shown below and click OK.

Next, there is the Profile Grid Elevation Range dialog. Accept the top and bottom elevations it gives by hitting OK. Pick a spot in the drawing to draw the profile, then view the profile on the grid by zooming as required. Your profile should look similar to this.

5 Design Road Profile. Now we will design how the road centerline profile will be, in relation to the existing ground (which is the first profile we have made). This routine will create another Profile file. Under Profiles, go to Design Road Profile, and then Design Road On Profile Grid (this method is suggested for this tutorial).

The following dialog box will appear. Since we followed up the Draw Profile command with this one, it was able to determine proper startup values for the dialog.
Choose OK on this dialog. A new file creation dialog box will appear, asking for an output file name. Enter a name such as DESIGN, and click Save.

**Pick Lower Left Grid Corner <0.00,0.00>[endp on]:** *Pick Lower Left Grid Corner* of the profile grid (Carlson has endpoint osnap active to make the pick accurate).

At this point another dialog will appear in the upper left corner. Initially, it will display only station and elevation. Once a beginning point has been designated, it will also display the relative difference from the last point to the cursor position. This can be an aid in determining acceptable slopes for your design.

**Enter a station or pick a point (Enter to End):** *ENDof* (pick the left-most endpoint of the existing ground profile as a tie in point). The following dialog will appear, choose OK to accept the defaults.
Station of second PVI or pick a point (U,E,D,Help): 1111.01
Percent grade entry/<Elevation of PVI>: 1999.37
Station of next PVI or pick a point (U,E,D,Help): 1911.64
Percent grade entry/<Elevation of PVI>: 2002.66
View table/Unequal/Through pt/Sight dist/K-value/<Vert Curve Length>: 500.00
For Sag with Sight Distance>VC and Vertical Curve => 500.00
Sight Distance => 2334.40, K-value => 243.2
Use these values (<Y>/N)? Y
Station of next PVI or pick a point (U,E,D,Help): END of (pick the far-right endpoint of the existing road as a tie in point).

The following dialog appears. Choose OK to accept the defaults.

View table/Unequal/Through pt/Sight dist/K-value/<Vert Curve Length>: 500.00
For Sag with Sight Distance>VC and Vertical Curve => 500.00
Sight Distance => 1000.00, K-value => 697.0
Use these values (<Y>/N)? Y
Station of next PVI or pick a point (U,E,D,Help): press Enter

At this point the following dialog appears. Change settings to match, and choose OK.
Carlson will now finish the road design, and your drawing should look like the following:

![Diagram of road design](image)

6 Polyline to Centerline File. This step will create a centerline file necessary for the final road design routine. We will do the simplest variation, which is simply picking a polyline. There are other methods to design a centerline. They are documented in the manual.

First (if necessary), zoom back to the plan view area, as we will be working with the polyline first created in this exercise. Go to Polyline to Centerline File command, under Centerline, and name a *.cl file to create.

**Beginning Station <0+00>: press Enter**

**Polyline should have been drawn in direction of increasing stations.**

**Select polyline that represents centerline: pick the plan-view polyline**

<table>
<thead>
<tr>
<th>Station</th>
<th>North (y)</th>
<th>East (x)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0000</td>
<td>159460.9658</td>
<td>1857580.2082</td>
<td>LI</td>
</tr>
<tr>
<td>446.2825</td>
<td>159541.3445</td>
<td>1858019.1926</td>
<td>PC</td>
</tr>
<tr>
<td>1178.1130</td>
<td>159254.1689</td>
<td>1858643.2229</td>
<td>LI</td>
</tr>
<tr>
<td>2707.2962</td>
<td>157932.5436</td>
<td>1859412.4483</td>
<td>LI</td>
</tr>
</tbody>
</table>

**Press ENTER to continue, press Enter**

7 Input-Edit Section Alignment. Now we will layout the alignment for our cross-section file. This step gives the section interval, and the offset left and right from our centerline. Under Sections, go to Input-Edit Section Alignment. Choose the New tab, which brings up the dialog to make a new MXS file (multi-xsection file). Type in a new name and click Open. Notice how all files can have the same name in this road design portion, as they all have a unique file extension. So for the organization of various jobs, it is sometimes helpful to have all of the files with the same name.
Polyline should have been drawn in direction of increasing stations.
CL File/: Select polyline that represents centerline>: pick the centerline polyline
Enter Beginning Station of Alignment <0.00>: press Enter

The dialog will appear as shown, enter in the stations and offsets exactly as they appear here. This will give the needed detail for the road design routine.

Choose OK, and another window appears that allows for any station editing or changes. It all looks good here, so hit Save.

The Alignment file is now written. There is now a preview of the section alignment lines shown on the centerline. These are just images, if the drawing is regenerated, they will disappear. (They can be drawn permanently if desired.)

8 Sections from Surface Entities. Next, we will create the actual section file (*.SCT) from the contours, in combination with the alignment file (*.MXS). Under Sections, go to Sections from Surface Entities. We will use the contours and breaklines for surface elevations, as we did with generating the profile. Specify the MXS file that we just created to read for the alignment. Click Open to select it. Then choose a new file name for the section file, and click Open.
We’ll enter in a distance of 1000 feet to add to our MXS limit of 70. This will search farther for contour elevations, then choose OK. Now, select the surface entities which are the contours and the breaklines. Once you are back to the command prompt, you are done with the making of sections.

9 Design Template. Let’s design a wide boulevard, 30’ of drivable pavement, with curb and gutter on the outside. Whenever a cut is within rock, the cut slope will go from a typical 2:1 to 0.5:1. At the top of rock, the cut will continue on at 2:1. In fill, the condition will be 3:1 in all fill under 6’ and 2:1 in all fill over 6’ in depth. Pavement depths will be 8 of stone and 4 of asphalt.

First, Select Design Template, found under Roads, within the Civil Design module of Carlson. Click on the New tab.
We'll give it the same name as the drawing. Choose Open. A large dialog box appears as shown below. In it, you enter segments of the template, which work outwards from the middle as you add more lanes, curbs and shoulders. We will enter a symmetrical template, with 13.5' pavement sections either side of centerline, connecting to a 2' curb and gutter, with 18'' of gutter and 6'' of curb. Then we will add a 6' shoulder.

For the lanes, click the Grades icon. This leads to a child dialog as shown next:
Fill out as shown. It's important to note that a downhill pavement from a crown in the middle is entered as a negative slope. That is, it is 2% heading from centerline outward, regardless of which side of centerline we are speaking of. Slope is in reference to the centerline of the template, and it is independent of the profile grade point. It is also important to enter an ID whenever requested. IDs can be referenced later.

A break point in a shoulder in superelevation could be defined as occurring at EP+3, as opposed to the exact offset distance from centerline. The advantage of EP+3 is that if the road lane width expands (e.g., for a passing lane), but the shoulder always breaks 3 feet beyond edge of pavement, then EP+3 is the only effective way to reference the break point. Now click OK. You'll note that the lanes show up in the preview window at the top.

Next, we will add a curb. Click the Curb icon. Fill out as shown:

It is especially a good idea to match crown – to make the curb match the slope of the last pavement lane (2% above). But if your curb tilts downward more (like 3%), then use a Special Base Slope Type. If it is flat, by all means click on Flat Base. Now click OK. Here's what our screen looks like so far:
Next, we will add a shoulder, going uphill at 4% for 8’. Notice what is happening. You are lit up on the Curb line, so if you add another Grade, it will append after the curb, and add to the back of curb. If you were to click on the GRADE: 13.500, -2.000%, EP line, highlight it, then click on GRADES, you would add a second lane before the curb. Now click on GRADES. Fill out the dialog as shown:

That's it for the surface! Here's what our screen looks like now:
Now we have subgrades and outslopes still to consider. Let's turn our attention to subgrades. Let's think about this: if our pavement is a total of 12 deep (8 stone, 4 asphalt) and our concrete gutter is 6 deep, then the stone will run 6 deep under the gutter. Do we want this stone to come back up at the back of the gutter, behind the gutter, or even wrap around back into the gutter, like a layer of bedding that is covered by dirt. The most complex concept is the wrap around, so let's go for it.

Select the Subgrade icon, second from the right (yellow color). We'll do two subgrades: first asphalt, which will run straight out and hit the curb, and then stone, which will run out, go under the curb, and wrap back.

For any sub-grade, we still do the vertical offset as a negative distance (negative meaning down). But follow this concept: we start it out 13 feet from offset 0, and keep going at "Continue Slope" until it hits something (the curb). This won't work if there is nothing to hit. But it will run into the curb. Or if there is a fill slope, downhill 6:1 recovery zone lane, or something to intersect, it will also. This Continue Slope concept works perfectly for shallow asphalts and concretes that will bump into a curb, when extended.
Complete as shown above, and click OK.

Now for the other subgrade: the stone beneath the asphalt. Follow this: if the stone can't Match Surface (note this option under Slope Type), it will start uphill with the shoulder as it passes beyond the curb (it goes out 17'). So it must have a Special Slope Type, the same 2% all the way. The Wrap Height is the vertical rise at the end of the 17', before it wraps back and hits the curb. Select the Subgrade icon again (second from the right).

Fill out the Sub-Grad Dimensions dialog, as shown above, and click OK. Note the preview screen:
We still need to enter the outslope conditions. They are done with the Cut and Fill icons. Fill is easy in our example. Click on Fill.

Just 3 entries total: 3 (for 3:1), 6 (up to 6'), then 2 (for 2:1 over 6'). Click OK. Next, click the icon for Cut.
This is actually easier (in terms of total entries). Just 2 entries do it: 2 (for 2:1 normal cut) and down below, 0.5 (for 0.5:1 cut when in rock). Click OK.

The template is complete, so click Save. Now let's prove we have a good template by doing the command Draw Typical Template.

10 Draw Typical Template. The file extension for templates will be tpl. Select Draw Typical Template under the Roads pulldown menu, select Example2.tpl (or as named above), choose Open and the following dialog shown here
We have doubled the text scaler to 0.5 for better appearance in this tutorial. Click on Draw, and pick a starting position point. Here is the look of the plotted template.

11 Drawing Explorer. As more files are created, edited, loaded and reviewed within a work session, the drawing ini file takes note. You can review your active files as you work, or days later, because they save to the ini file that shares the same name as the drawing file. To see the files associated with this tutorial drawing file, select Drawing Explorer by sliding over from Project, under the Settings menu.
12 Input-Edit Section File. *Input-Edit Section File* has many uses. One of them is to translate or lower the elevations of a file and re-save. If we lower the elevations of our ground sections 8 feet, we can call that the rock line. Rock lines react with templates and profiles to create rock cuts and rock quantities, within the final step, which is called Process Road Design (Step 13). Select *Input-Edit Section File* under the Section pulldown menu. Under the Existing tab section, select the SCT file you created earlier and click Open.

The next dialog that appears is shown below:
Click the Translate button. The Translate Selections dialog appears. The Ending Station might differ from what is showing here, but it should be close to this value. Make sure the rest of the dialog looks that same as shown below, and click OK.

Now back at the Input-Edit Section File dialog, click Save As, and enter a different name, such as Rock, and save the file. Then click Exit.

Input-Edit Section can do much more through the Edit option. In the case of Edit, you would first highlight one station, then click Edit to review and revise it.

13 Process Road Design. This is the routine that weaves everything together. Select Process Road Design, as the lower command under the Roads pulldown in the Civil Design module. Fill out the dialog as shown below. Be sure to select, under Specify Output Files, the Section File option and click New. Enter a new file name and Save. Then click OK.
On the next dialog, be sure to click on Triangulate & Contour at the lower left of the dialog.

Now click OK. Here is a partial view of the final report, with itemized quantities:
Click Exit when finished reviewing the report. You will get this command prompt:

**Trim existing contours inside disturbed area [Yes/<No>]? press Enter**

Here is the resulting graphic, in 3D, obtainable by using *3D View Window*, found under the View pulldown:

![Graphic Image](image_url)

This completes this tutorial: Basic Road Design with Volumes.
AutoCAD Overview

This chapter explains the essentials of using AutoCAD including command entry, selection sets and layers. Since Carlson Software is built on the AutoCAD OEM engine, it is helpful to know the AutoCAD basics. Several of the Carlson Software commands are native AutoCAD commands and many others have an AutoCAD style user-interface.
Issuing Commands

Virtually all commands in Carlson Software have three or more ways they can be initiated. The two most common are the menu and the toolbar, but the command line can many times be a very easy method of working through commands. Using the menu and toolbar should be second nature to Windows users, so this section will mainly focus on the command line usage in Carlson Software.

Command Line Prompt-Command:

Carlson Software has a command line prompt where commands are "issued" and the status of a command is reported. When you select a command from the menu or toolbar, that command name is sent to the command line and is executed. Before most commands can begin, all other commands must be terminated. The exceptions are referred to as transparent commands. The easiest way to see if no commands are running is to look at the command line. If it displays Command: no commands are currently in progress.

Enter

When you are required to press the Enter key in Carlson Software, you can use the Enter key on the keyboard or you can press the spacebar or click the right mouse button.

Pressing the Enter key will perform different operations depending on your location within Carlson Software. If you are in the process of running a command, the Enter key will end the command (if there are no available options) or it will select one of the options available (see below). If you are at the command line Command: prompt, pressing the Enter key will repeat the last command.

Right Mouse Button

As mentioned above, the right mouse button can be used as enter. However, you can set the right mouse button to perform different functions. The control for the Right Mouse Button behavior is in the Mouse Click Settings command. When you click the right mouse button, you will get a drop down list of the options and can select the desired one. Move the cursor the desired option and click on it with the left mouse button.

Getting Out of a Command-Esc

For commands that provide no options, the Enter key (or spacebar or right mouse button) will end the command you are using. Also, when a command is issued in Carlson Software, this action will also automatically end the previous command. However, there are exceptions to these two rules.

To avoid any problems with using the above methods to end a command, you can press the Escape (Esc) key. For example, if the command line displays something other than Command: or if a command you want to run does not start because you are using another command, you will want to end the command and return to the command prompt. Using the Escape (Esc) key will accomplish this every time.

Note: Some commands have several optional levels which will require the escape key to be pressed more than once.

If you accidentally select a location on the screen and start a selection window, the command prompt will prompt for another corner. Either select another point on the screen to finish the selection (not advised) or press the Esc key to return to the Command: prompt.

Commands Option

When any command is issued, the command line acts as a status bar that will show the available options and "ask" for input from you.
When there are options for the command you are currently running, these options will be shown on the command line with capital letters in the option name. To use one of the options, type the capital letter(s) at the prompt. For example, if you issue the Zoom command, the command prompt will show All/Center/Dynamic/Extents/...<Realtime>: To select the Dynamic option, type D at the command line, then press the Enter key. If you do not input an option and just hit enter, you will be selecting the option that appears in the <> brackets. For the example shown, that is the Realtime Zoom option.

**Transparent Commands**

Several commands in Carlson Software can be run transparently. This means that they can be performed while another command is running. For example, if you are in a command and are trying to select something in the drawing but it is too small to see, you can use the zoom command transparently. Zoom to the area where the object is, then select the object without ending the initial command. The most commonly used commands are the View commands of Zoom and Pan, and the Properties commands including the Layer dialog box.

To issue a transparent command, type an ' (apostrophe) before the command name. For example, 'Z would be transparent zoom. Note that many commands will automatically be assumed to be transparent if they are issued from the toolbar while another command is running.

When you are in a command that is running transparently, this will be indicated with a >> at the far left of the command line preceding any options or other text. When a transparent command is complete, you will return to the command you were previously running. If you are in a transparent command and want to end the command to get back to the command prompt, you will need to press the Esc key twice.

**Note:** If you select a View command while running another command, the other command will not end. You will be running the View command transparently. This is one of the exceptions to the rules for ending a command. If you do not want to run the View command transparently, you need to complete the other command or end it by pressing the Esc key.

**General Commands**

**Enter**

When you are required to press the Enter key in Carlson Software, you can use the Enter key, the spacebar on the keyboard or click on the right mouse button.

**Repeating Commands**

When you press the Enter key at the command line Command: prompt, you will repeat the last command.

**Cancel**

The Escape key (Esc)key can be used to cancel any command. Some commands may require pressing the Escape key more than once.

**Command Options**

The command line changes as a command is running. When there are options available for the command you are running, they will display at the command line. To select one of the options, type the capital letter(s) in the name of the option and press the Enter key.
Selection of Items

Most commands in Carlson Software require the selection of objects. When you need to select objects, the command line will prompt Select objects:. When you are at this prompt, your next step will be to create a selection set. While creating the selection set, the prompt Select Objects: repeats and you can continue to select objects until you press the Enter key, at which time the command you are using will continue and use the objects selected. If you are selecting object for an Eagle Point Software command, the objects selected will be then used for that command.

Selection Sets

There are several ways to create a selection set from the Select objects: prompt. With all selection methods, the number of objects selected will be displayed in the command line along with any objects that were duplicated. Following are the most commonly used methods for creating a selection set:

Single

A single selection is made when you move the object selection target to an object on the screen and click on it. The selected object will highlight and the select objects prompt will return. The cursor changes to a small square when the command line displays Select objects:.

Window

A Window will select all objects completely inside of the rectangle drawn. Create a window by selecting a point on the view screen and then moving the cursor right. The window will display as a solid rectangle. You can also create a window by typing \texttt{W} at the select object prompt. In this case you can move the cursor to the left to create the window.

Crossing

A crossing will select all objects within the rectangle as well as those touched by the rectangle. If you select a point on the view screen and move the cursor to the left, you are creating a crossing. The crossing will display as a dashed rectangle. You can force a crossing by typing \texttt{C} at the select objects prompt, allowing you to move the cursor to the right and create the crossing.

Previous

After you select several objects, they will be temporarily stored as a selection set. Should you want to re-use the same objects that were selected by the last command, you can type \texttt{P} at the Select objects: prompt.

Remove

If you select incorrect objects, you can type \texttt{R} to remove objects from the selection set. When you are in Remove mode, the prompt will be Remove objects:. Click on the objects that you do not want to include in your selection. To return to select or add mode, type \texttt{A} at the command line.

Grips

Objects may also be selected before issuing the command and receiving the Select objects: prompt. This selection will turn on Carlson Software "grips." Grips appear as small blue squares in the drawing. All objects with grips will be used when a command is issued. Grips are turned on similar to selecting objects as described in the previous section, but with the command line at the Command: prompt, not the Select Objects: prompt. You can select
single objects by clicking on an object with the standard cursor or you can select multiple objects by clicking in the view where there are no objects, then creating the window (right) or crossing (left). To remove grips, press the Esc key twice.

**Using Grips**

Grips can also be used to edit or change the location of objects in the drawing. Move your cursor to a grip and click. You should notice the cursor “snap” to the grip. The grip will turn from blue to red. The object grip is now attached to the cursor so you can move the object to the desired location and release it by clicking again.

**Properties and Layers**

Properties define how an object in Carlson Software is stored. One of the most common properties is the Layer. Layers can be turned off or frozen so the objects on that layer are hidden from the view of the drawing. Layers that are turned off can still be selected while frozen layers are essentially removed from the working set of the drawing. After layers are turned off or on, a redraw (which is done automatically) will update the view. A redraw of a file is a rather quick process. After a frozen layer is thawed, a regeneration may be required to update the view. Regenerations on large files may take a considerable amount of time depending on your hardware.

**Layer Dialog Box**

The Layer dialog box provides control of the drawing layers. You can turn layers on, off, freeze or thaw them, change the layer color and linetype, set the current layer, add new layers, delete layers, etc. To perform any of these functions, click on the **Layers** button.

In the Layer dialog box, you can highlight several individual layers to perform actions on at once by holding down the Control key and clicking on the desired layers. You can also highlight a continuous range of layers by highlighting one layer, holding down the Shift key, and clicking on another layer. All layers between the two will be selected. To select all of the layers, hold down the CTRL key and press A on the keyboard.

**Layer Drop List**

To turn layers on/off or freeze/thaw, you can also use the drop list on the toolbars. When you click on the symbols in the list, the layer's status will be changed appropriately.

**Setting Current Layer**

The current layer will be the one shown in the Layer drop list box. You can change the current layer by selecting the desired current layer from the drop list. You can also use the Set Current Layer button and select an object on the layer. The layer the object is on will become the current layer. Finally, you can highlight a layer in the Layer dialog box and click on the **Current** button to make the highlighted layer current.

You cannot freeze the current layer, but you can turn that layer off (not recommended).

**Changing Properties**

To change the properties of an object in the drawing, use the Properties button on the toolbar or the Change command from the command line. This command will allow you to change the layer an object is on, the color or linetype of the object. The color and linetype can be set to bylayer or to a specific setting. Bylayer means that when the property for a layer is changed, so does the property for the object. For example, the specific setting of an object may be the color blue. No matter what color you set for the layer the object is on, that object will be blue.
Properties Toolbar

If this toolbar (or any toolbar) is not displayed, you can open it using the Toolbars dialog box. Type `toolbars` at the command line.

Layer

The Layer dialog box is used to modify layers properties (color or linetype) or status (on/off, freeze/thaw).

Key-in: `LA` or `ddlmodes`

Toolbar:

Current Layer

The Current Layer is the layer that you are on and will be working with. The Current Layer is the one shown in the Layer drop list. For example, in the above toolbar illustration, the Current Layer is `Water`.

Toolbar:

Change

The Change command allows you to modify the properties of an object, such as layer and color.

Key-in: `CH`

Toolbar:
File Menu

The Carlson Software programs share some of the same pull-down menus, such as File, Edit, View, Draw, Settings and Points. Within each program, the other pull-down menus, typically, are specific to the that program. The common pull-down menus contain general commands that are applicable within all programs. Many of these commands are AutoCAD commands which are described in your AutoCAD Reference manual. The Carlson commands located in the more common pull-down menus are explained in the next sections.

All the options on the File menu not described here are AutoCAD commands, which are discussed in the AutoCAD Reference Manual.
New

This command allows you to create a new drawing file. This routine defines the settings for a new drawing. You can start a new drawing file by selecting New, and then picking a template file. SURV.DWT is the default template file for use in Carlson Survey. After choosing the template, click the Open button at the lower-right. Next, you will either see the New Drawing Wizard dialog box or you will be taken to a blank screen. Should you use the wizard, a new drawing name will need to be chosen in order to get to the next step.

There are two methods that you can use to create a new drawing. One is this New command. The other is Open, also under the File pulldown menu. If you need to open an existing drawing, use the OPEN command, under File, then choose an existing file name.

The opening dialog, Select Template, lists all template files that currently exist in the drawing template file location. Choose a file to use as a starting point for your new drawing. A preview image of the selected file is displayed to the right. If the wizard is in use, the following options will be available to you in the New Drawing Wizard dialog. The New command starts a new drawing using default settings defined in either the surv.dwt or surviso.dwt template, depending on the measurement system you've chosen. You cannot modify the surv.dwt or surviso.dwt templates. To start a new drawing based on a customized template, see Use a Template.
**English:** This option starts a new drawing based on the Imperial measurement system. The drawing is based on the surv.dwt template, and the default drawing boundary (the drawing limits) is $12 \times 9$ inches.

**Metric:** This option starts a new drawing based on the metric measurement system. The drawing is based on the surviso.dwt template, and the default drawing boundary (the drawing limits) is $429 \times 297$ millimeters.

The New command creates a new drawing using the settings defined in a template drawing you select. Template drawings store all the settings for a drawing and may also include predefined layers, dimension styles, and views. Template drawings are distinguished from other drawing files by the .DWT file extension. They are normally kept in the template directory. Several template drawings are included with Carlson Survey. You can make additional template drawings by changing the extensions of drawing file names to .DWT.

**Pulldown Menu Location:** File

**Keyboard Command:** new

**Prerequisite:** None

---

**Open**

This command allows you to open an existing drawing file. Carlson TakeOff displays the Select File dialog box (a standard file selection dialog box). Select a file and click Open.

**Prerequisite:** None

**Keyboard Command:** OPEN

---

**Close**

This command allows you to close the current drawing. Carlson TakeOff closes the current drawing if there have been no changes since the drawing was last saved. If you have modified the drawing, the program prompts you to save or discard the changes. You can close a file that has been opened in Read-only mode if you have made no changes or if you are willing to discard changes. To save changes to a read-only file, you must use the SAVEAS command.

**Prerequisite:** None

**Keyboard Command:** CLOSE

---

**Save**

If the drawing is named, Carlson TakeOff saves the drawing without requesting a file name. If the drawing is unnamed, the program displays the Save Drawing As dialog box (see SAVEAS) and saves the drawing with the file name you specify. If the drawing is read-only, use the SAVEAS command to save the changed file under a different name. This command allows you to save the drawing under the current file name or a specified name.
Save As

This command allows you to save the current drawing and assign the file name which allows you to give an unnamed drawing a file name or rename the current drawing. You can also use this command to save the current drawing to a different file format. You can save a drawing to an earlier version of the drawing format (DWG) or drawing interchange format (DXF), or save a drawing as a template file. Choose the format from Files of Type in the Save Drawing As dialog box.

If you save the file as a drawing template, the program displays the Template Description dialog box, where you can provide a description for the template and set the units of measurement.

Get Project from Data Depot

The Carlson Data Depot is a document management system to allow tracking of the changing states of files and projects over time and manage the contributions from multiple users providing data integrity, productivity and accountability for the managed products. Once a project has been successfully registered with the Data Depot using the Project Explorer, it can be retrieved through the Data Depot for subsequent editing.

Subversion Example:

![Project To Link To dialog box]

Continue below to the "Select the Project" section.

ProjectWise Example:
For ProjectWise the "Select Included Data Type Categories" dialog will appear. Here the user can select which types of files to download from the repository. A special category "Non Carlson" is used to determine whether files not associated with Carlson Software should be downloaded or not (e.g. Word .DOC documents or Microstation .DGN files). If the user wants even more control over what files are downloaded, say at the drawing level, he/she can use the "Clear All" button to deselect all categories. In this case, only the directory structure plus the Project File (.PRJ) will be downloaded. This allows the user to select which drawings they want to download from the repository directly from the Carlson Project Explorer.

Selecting the Project:

Select the project you would like to open and click OK. Unless you have selected "Use Automatic Project Folder Name" (see Set Project/Data Folder for more information), you will be prompted to identify a "working" folder where the checked-out copies of your project files will reside:
Identify the destination folder location and click OK. The checked-out copies of the project files will be placed into the specified folder at which point further editing can begin.

**Pulldown Menu Location:** File > Project  
**Keyboard Command:** get_prj_from_depot  
**Prerequisite:** A properly installed, configured and support content management system

## Plot

### Layout Manager

The Layout Manager is a docked dialog that displays the contents of a Layout Set. Layout Sets (.set files) contain information on layouts that come from a single or multiple drawings. Once you build a layout set, the Layout Manager facilitates printing via AutoCAD's PUBLISH functionality.
The Layout Manager contains two sections. A Treeview, which displays the items of the Layout Set. Items are the root node, which is the topmost node representing the Layout Set. Subsets, which act as folders and can contain Layouts and additional Subsets.

The bottom section contains a grid view, which will display built-in and custom properties of the selected Layout Set, Subset or Layout item. The first column shows the property name, and the second column displays its value. Some properties are read-only and are calculated by the Layout Manager.

**New:** Use the New button to create a new empty Layout Set. You can also specify an existing layout set to use as a Template. If a Template is specified, only the Subsets (folders) structure will be copied to your new Layout Set. This is convenient if you have a standardized Subset structure to use for all Layout Sets.

**Open:** Use the Open button to open an existing Layout Set. Only one Layout Set is allowed open per session. If a Layout Set is currently open in the Layout Manager, you will be prompted to save any changes if necessary.

**Save:** Use the Save button to save your current Layout Set file. Layout Sets are saved as .set files.

**Save As:** Use the Save As button to save a copy of an existing Layout Set file with a new name.

**Print:** Use the Print button print all checked layouts using AutoCAD's Publish functionality. All Subsets and Layouts in the Layout Manager contain a checkbox. If the Subset or Layout is checked, it will be included when the print command is run. When a user checks a Subset, all the child items of that Subset are checked. Similarly, when a Subset is unchecked, all the child items of that Subset are unchecked.

**Insert Table:** Use the Insert Table button to insert a Table of Contents. This feature allows you to draw a Table containing all the layouts of the Layout Set, including their file name, drawing name, page number, etc.

Use the Set Table Columns button to define which columns are to be displayed in the Layout Set table. Toggle the Use Table Entity to insert the table as a block, or leave it unchecked to draw each row as an individual block.
You can edit the Label column, which will be displayed as the column header in your table. The Width and Text Alignment can also be set for each column.

**Exit**: Use the Exit button to exit and close the Layout Manager.

**Add Subset**: Use the Add Subset button to create a new Subset folder under the selected Layout Manager item.

**Add Layout**: Use the Add Layout button to add a Layout to the current Layout Set file in the selected Subset or root of the Layout Set. Layouts may be selected from the current drawing, or from another drawing on your computer or network.

**Move Up**: Use the Save As button to move the selected Layout (or Subset and child Layouts) above the previous sibling item.

**Move Down**: Use the Save As button to move the selected Layout (or Subset and child Layouts) below the next sibling Subset or Layout.

**Move In**: Use the Move In button to move the selected Layout (or Subset and child Layouts) under the next sibling Subset.

**Move Out**: Use the Move Out button to move the selected Layout (or Subset and child Layouts) above the selected parent Subset.

**Remove Item**: Use the Remove Item button to remove the selected Layout (or Subset and child Layouts).

**Custom Properties**: Use the Custom Properties button to Add, Edit or Remove custom properties to a Layout, Subset or Layout Set.
Select the appropriate tab to add a custom property. Then use the Add, Edit or Remover buttons to edit properties for the selected item type.

**Pulldown Menu Location:** File > Plot  
**Keyboard Command:** layoutmgr  
**Prerequisite:** None

---

**Page Setup**

This command allows you to configure your drawing for plotting. The Page Setup dialog box has the same options as the Plot dialog box. See the PLOT command below for a detailed description of options.

**Menu Location:** File  
**Prerequisite:** None  
**Keyboard Command:** PAGESETUP

---

**Plot Preview**

This option displays the drawing as it will appear when plotted on paper. To exit the print preview, right-click and choose Exit. This command is the same as the Full Preview option under Plot.

**Menu Location:** File  
**Prerequisite:** None  
**Keyboard Command:** PREVIEW

---

**Plot**

This command allows you to plot a drawing to a plotting device or file.

Carlson TakeOff displays the Plot dialog box. Choose OK to begin plotting with the current settings and display the Plot Progress dialog box.

1. The Plot dialog box includes the tabs, Plot Device and Plot Settings, and several options to customize the plot.

   - **Layout Name:** This option displays the current layout name or displays "Selected layouts" if multiple tabs are selected. If the Model tab is current when you choose Plot, the Layout Name shows "Model."
• Save Changes to Layout: This option saves the changes you make in the Plot dialog box in the layout. This option is unavailable if multiple layouts are selected.

• Page Setup Name: This option displays a list of any named and saved page setups. You can choose to base the current page setup on a named page setup, or you can add a new named page setup by choosing Add.

• Add: This option displays the User Defined Page Setups dialog box. You can create, delete, or rename named page setups.

2 Under the Plot Device Tab you can specify the plotter to use, a plot style table, the layout or layouts to plot, and information about plotting to a file.

• Plotter Configuration: This field displays the currently configured plotting device, the port to which it's connected or its network location, and any additional user-defined comments about the plotter. A list of the available system printers and PC3 file names is displayed in the Name list. An icon is displayed in front of the plotting device name to identify it as a PC3 file name or a system printer.

• Properties: The option displays the Plotter Configuration Editor (PC3 Editor), where you can modify or view the current plotter configuration, ports, device, and media settings.

• Hints: This option displays information about the specific plotting device.

• Plot Style Table (Pen Assignments): This option sets the plot style table, edits the plot style table, or creates a new plot style table.

• Name: This option displays the plot style table assigned to the current Model tab or layout tab and a list of the currently available plot style tables. If more than one layout tab is selected and the selected layout tabs have different plot style tables assigned, the list displays "Varies."

• Edit: This option displays the Plot Style Table Editor, where you can edit the selected plot style table.

• New: This option displays the Add-a-Plot-Style-Table wizard, which you can use to create a new plot style table.

• Plot Stamp: This option places a plot stamp on a specified corner of each drawing and/or logs it to a file.

• On: This option turns on plot stamping.
• Settings: This option displays the Plot Stamp dialog box, where you can specify the information you want applied to the plot stamp, such as drawing name, date and time, and plot scale.

• What to Plot: This field defines the tabs to be plotted.

• Current Tab: This option plots the current Model or layout tab. If multiple tabs are selected, the tab that shows its viewing area is plotted.

• Selected Tabs: This option plots multiple preselected Model or layout tabs. To select multiple tabs, hold down CTRL while selecting the tabs. If only one tab is selected, this option is unavailable.

• All Layout Tabs: This option plots all layout tabs, regardless of which tab is selected.

• Number of Copies: This option denotes the number of copies that are plotted. If multiple layouts and copies are selected, any layouts that are set to plot to a file or AutoSpool produce a single plot.

• Plot to File: This option plots output to a file rather than to the plotter.

• File Name: This option specifies the plot file name. The default plot file name is the drawing name and the tab name, separated by a hyphen, with a .plt file extension.

• Location: This option displays the directory location where the plot file is stored. The default location is the directory where the drawing file resides.

• […]: This option displays a standard Browse for Folder dialog box, where you can choose the directory location to store a plot file.

3 Under the Plot Settings Tab you specify paper size, orientation, plot area and scale, offset, and other options.

• Paper Size and Paper Units: This field displays standard paper sizes available for the selected plotting device. Actual paper sizes are indicated by the width (X axis direction) and height (Y axis direction). If no plotter is selected, the full standard paper size list is displayed and available for selection. A default paper size is set for the plotting device when you create a PC3 file with the Add-a-Plotter wizard. The paper size you select is saved with a layout and overrides the PC3 file settings. If you are plotting a raster image, such as a BMP or TIFF file, the size of the plot is specified in pixels, not in inches or millimeters.

• Plot Device: This field displays the name of the currently selected plot device.
• Paper Size: This field displays a list of the available paper sizes.
• Printable Area: This field displays the actual area on the paper that is used for the plot based on the current paper size.
• Inches: This option allows you to specify inches for the plotting units.
• MM: This option allows you to specify millimeters for the plotting units.
• Drawing Orientation: This option specifies the orientation of the drawing on the paper for plotters that support landscape or portrait orientation. You can change the drawing orientation to achieve a 0-, 90-, 180-, or 270-degree plot rotation by selecting Portrait, Landscape, or Plot Upside-Down. The paper icon represents the media orientation of the selected paper. The letter icon represents the orientation of the drawing on the page.
  • Portrait: This option orients and plots the drawing so that the short edge of the paper represents the top of the page.
  • Landscape: This option orients and plots the drawing so that the long edge of the paper represents the top of the page.
  • Plot Upside-Down: This option orients and plots the drawing upside down.
• Plot Area: This option specifies the portion of the drawing to be plotted.
• Layout: This option plots everything within the margins of the specified paper size, with the origin calculated from 0,0 in the layout. Available only when a layout is selected. If you choose to turn off the paper image and layout background on the Display tab of the Options dialog box, the Layouts selection becomes Limits.
  • Limits: This option plots the entire drawing area defined by the drawing limits. If the current viewport does not display a plan view, this option has the same effect as the Extents option. Available only when the Model tab is selected.
  • Extents: This option plots the portion of the current space of the drawing that contains objects. All geometry in the current space is plotted. TakeOff may regenerate the drawing to recalculate the extents before plotting.
• Display: This option plots the view in the current viewport in the selected Model tab or the current paper space view in the layout.
• View: This option plots a previously saved view. You can select a named view from the list provided. If there are no saved views in the drawing, this option is unavailable.
• Window: This option plots any portion of the drawing you specify. If you select Window, the Window button becomes available. Choose the Window button to use the pointing device to specify the two corners of the area to be plotted or enter coordinate values.
• Plot Scale: This option controls the plot area. The default scale setting is 1:1 when plotting a layout. The default setting is Scaled to Fit when plotting a Model tab. When you select a standard scale, the scale is displayed in Custom.
• Scale: This option defines the exact scale for the plot. The four most recently used standard scales are displayed at the top of the list.
• Custom: This option creates a custom scale. You can create a custom scale by entering the number of inches or millimeters equal to the number of drawing units.
• Scale Lineweights: This option scales lineweights in proportion to the plot scale. Lineweights normally specify the linewidth of printed objects and are plotted with the linewidth size regardless of the plot scale.
• Plot Offset: This field specifies an offset of the plotting area from the lower-left corner of the paper. In a layout, the lower-left corner of a specified plot area is positioned at the lower-left margin of the paper. You can offset the origin by entering a positive or negative value. The plotter unit values are in inches or millimeters on the paper.
• Center the Plot: This option automatically calculates the X and Y offset values to center the plot on the paper.
• X: This field specifies the plot origin in the X direction.
• Y: This field specifies the plot origin in the Y direction.
- Plot Options: This field specifies options for lineweights, plot styles, and the current plot style table. You can select whether lineweights are plotted. By selecting Plot with Plot Styles, you plot using the object plot styles that are assigned to the geometry, as defined by the plot style table.

- Plot object lineweights: This option plots lineweights.

- Plot with Plot Styles: This option plots using the plot styles applied to objects and defined in the plot style table. All style definitions with different property characteristics are stored in the plot style tables and can be easily attached to the geometry. This setting can replace pen mapping in earlier versions of AutoCAD.

- Plot Paperspace Last: This option plots model space geometry first. Paper space geometry is usually plotted before model space geometry.

- Hide Objects: This option plots layouts with hidden lines removed for objects in the layout environment (paper space). Hidden line removal for model space objects in viewports is controlled by the Viewports Hide property in the Object Property Manager. This is displayed in the plot preview, but not in the layout.

- Full Preview: This option displays the drawing as it will appear when plotted on paper. To exit the print preview, right-click and choose Exit.

- Partial Preview: This option quickly shows an accurate representation of the effective plot area relative to the paper size and printable area. Partial preview also gives advance notice of any warnings that you might encounter when plotting. The final location of the plot depends on the plotter. Changes that modify the effective plot area include those made to the plot origin, which you define under Plot Offset on the Plot Settings tab. If you offset the origin so much that the effective area extends outside the preview area, the program displays a warning.

**Prerequisite:** None

**Keyboard Command:** PLOT

---

**PDF**

**Output Layouts to PDF**

This command creates a PDF from layouts in the current drawing. The command starts by prompting for the output PDF file to create. In the dialog, the **Title, Subject, Keywords** and **Author** are optional properties for the PDF file.

The **Print Area** controls whether to use the page size defined in the Page Setup Manager for each layout, or set the print area by zoom extents on the entities for each layout.

The **Store Layers in PDF** creates a PDF with the CAD layers.

The **Include Off Layers** outputs all layers to the PDF.

The **Encoded (small size)** option creates a PDF with encoding which should be used unless working with an old Adobe Reader.

Each layout can store the layer state for printing for which layers to thaw and which to freeze. The **Restore Layout Layer States** will set the layer state for the PDF on each layout. This option works together with the Save and Restore Layout Layer commands in the File > PDF menu.

The **Open PDF Upon Completion** option opens the PDF in the viewer for PDFs assigned in Windows which is typically the Adobe Reader.

For **Layouts to Export**, choosing Active will output the current layout to the PDF. The All option outputs all the layouts to the PDF. The Selected option lets you control which layouts to output. When in Selected mode, you can
use the Remove button to remove a layout from the output. Use the Up and Down button to change the order of the layouts. The Reset button puts the list of layout back to the default.

Pick the **Export** button to create the PDF.

### Pulldown Menu Location: File > PDF

**Keyboard Command:** `pdfexport`  
**Prerequisite:** Layouts

## Merge PDF Files

This command combines separate PDF files into a single PDF file. The dialog has a list of available PDF files on the left and there are functions to add or remove PDF files from this list. The list of PDF files on the right and the PDFs to output to the single PDF. Use the Add and Remove buttons to move PDF files between these Available and Used lists. Use the Move Up and Down to change the order of the PDF files for the output PDF. When a PDF is highlighted in the list, a graphic preview is shown.

The **Open PDF Upon Completion** option opens the PDF in the viewer for PDFs assigned in Windows which is typically the Adobe Reader.

The **Rotate PDF CW** setting controls how much to rotate the source PDF files for the output PDF.

The **Load and Save** functions are for storing and recalling a set of PDF files in a `.PDQ` file.
Pulldown Menu Location: File > PDF
Keyboard Command: pdfmerge
Prerequisite: .pdf files

**Xref Manager**

Attaches, overlays, lists, binds, detaches, reloads, unloads, renames, and modifies paths to external references (Xrefs) in the current (or host) drawing. Displays the Xrefs in the drawing in a tree view or a list view. You can use the F3 and F4 keys to switch between list view and tree view.
**List View:** Displays a flat listing of the attached Xrefs and their associated data. You can sort the list of references by name, status, type, file date, file size, or the saved path and file name.

**Reference Name:** Lists the names of the Xrefs as stored in the definition table for the drawing. Status: Shows whether the Xref is loaded, unloaded, unreferenced, not found, unresolved, orphaned, or marked for unloading or reloading.

- **Loaded:** Currently attached to the drawing.
- **Unloaded:** Marked to be unloaded from the drawing once the Xref Manager is closed.
- **Unreferenced:** Attached to the drawing but erased.
- **Not Found:** No longer exists in the valid search paths.
- **Unresolved:** Cannot be read by AutoCAD.
- **Orphaned:** Attached to another Xref that is unreferenced, unresolved, or not found.

**Size:** Shows the file size of the corresponding reference drawing. The size is not displayed if the Xref is unloaded, not found, or unresolved.

**Type:** Indicates whether the Xref is an attachment or an overlay.

**Date:** Displays the last date the associated drawing was modified. This date is not displayed if the Xref is unloaded, not found, or unresolved.

**Saved Path:** Shows the saved path of the associated Xref (this is not necessarily where the Xref is found).

**Tree View:** Displays a hierarchical representation of the Xrefs, displaying the relationships between Xref definitions. Tree view shows the level of nesting relationship of the attached Xrefs, whether they are attached or overlaid, and whether they are loaded, unloaded, marked for reload or unload, or not found, unresolved, or unreferenced.

**Attach:** Displays the External Reference dialog box if an external reference is selected or displays the Select Reference File dialog box if no external reference is selected.

**Detach:** Detaches one or more Xrefs from your drawing, erasing all instances of a specified Xref and marking the Xref definition for deletion from the symbol table. Only the Xrefs attached or overlaid directly to the current drawing can be detached; nested Xrefs cannot be detached. Carlson TakeOff cannot detach an Xref referenced by another Xref or block.

**Reload:** Marks one or more Xrefs for reloading. This option rereads and displays the most recently saved version of the drawing.

**Unload:** Unloads one or more Xrefs. Unloaded Xrefs can be easily reloaded. Unlike detaching, unloading does not remove the Xref permanently. It merely suppresses the display and regeneration of the Xref definition to improve performance.

**Bind:** Displays the Bind Xrefs dialog box Xref. The Bind option makes the selected Xref and its dependent symbols (such as blocks, Xref styles, dimension styles, layers, and linetypes) a part of the current drawing.

**Found At:** Displays the full path of the currently selected Xref. This is where the Xref is actually found and is not necessarily the same as the saved path.

**Browse:** Displays the Select New Path dialog box (a standard file selection dialog box), in which you can select a different path or file name.

**Save Path:** Saves the path, as it appears in Xref Found At, to the currently selected Xref.

**Prompts**

Command: _Xref
Overlay Xref "example1": ..\..\..\..\..\Program Files\Carlson TakeOff
Carlson Community

This command displays files from Carlson Community where Carlson Software customers can post files to share. This file warehouse is hosted on a Carlson Software server. Types of files on Carlson Community include 3D models for visualization (mdl), point symbol files (dwg), Field-to-Finish code tables for standards in different regions (fld), and road design templates (tpl). To view and download files, you don't need an account log in.

To find a file, first choose the File Type to search for. The files are organized by category and you can browse by category using the category tree on the left. The Include Sub-Categories option shows the files in the current category as well as any sub-categories. The results can be filtered by User, Tag and Text.

There are two views for displaying the file results. The List view shows a spreadsheet. Under the Settings button, you can control the columns to show for the List view. The Icons view shows a series of buttons with images for each file.

To see details about a file, highlight the file and pick the View button, or double-click on the file. The View file dialog shows the file name, title, image, description, tags, category, number of downloads, average rating by users, file size, user name who uploaded the file, date/time of the upload and user comments.
To download the file to your computer, pick the Download button on the View dialog or highlight the file on the main dialog and pick the main dialog Download button. The download routine will then prompt where to save the file on your computer.

To do more on Carlson Community, you need to have an account and log in. To log in, pick the Log In button and then enter either your User Name for Carlson Community or your email and then your password.

To create a new account, pick the Log In button and then the Account Sign Up button. You need to create a unique User Name for Carlson Community and a password. Your email is also required and needs to be in the Carlson Software records to create a Carlson Community account. If your email is not in the records, then you will receive an email that needs to be confirmed before your Carlson Community account is activated.

Also on the sign up, you must agree to the Terms of Use to create an account. The rest of the information is optional. The Company Key is a way to group users by company which is used by the Carlson Cloud routine for data exchange with SurvCE.
After logging in, you can upload files by picking the Upload button. On the Upload dialog, pick the Select File button and choose the file to upload. Currently the file size limit is 10mb. To upload several files at once, turn on the Enable Multiple Upload toggle before picking Select File. The Select Preview File allows you to pick an image file to use as the preview for your file. Without selecting a preview file, the program will automatically make a preview. The Title, Description and Tags are all optional but helpful ways for users to search for your file. Select a Category for the file from the list or create a new category by entering the category name in the edit box.

Under Account Options, you can update your email, image and other account settings. The List Users shows users by the Company/Group Key name. The Delete Account removes your account from Carlson Community.

The Members routine shows a list of Carlson Community accounts along with activity on uploading.

Files available on Carlson Community include:
MUTCD symbol drawings (dwg): Manual on Uniform Traffic Control Devices from FHWA.

**Pulldown Menu Location:** File  
**Keyboard Command:** community  
**Prerequisite:** None
Import

Import 3D Viewer File
This command selects a 3DX file and draws the objects from the scene including points, lines and 3D faces. The 3DX file can be created in 3D viewer commands including Surface 3D Flyover and 3D Viewer Drawing.

Pulldown Menu Location: File > Import
Keyboard Command: import3dx
Prerequisite: 3DX file

Import 3D Model File
This command draws 3D faces for geometry in a 3D model file in .mdl or .obj file format. These graphic files are used in 3D viewing commands like 3D Drive Simulation. The Settings > 3D Model Library manages these graphics files. The .mdl file is also used for Solids in the Underground Mining module.

Pulldown Menu Location: File > Import
Keyboard Command: mdl2dwg
Prerequisite: MDL or OBJ file

Import Xref to Current Drawing
This command allows you to import external reference files (Xrefs) into the current drawing. Before Xrefs are imported, the drawing data from the Xrefs can be viewed but not modified. This import routine has a simpler method for importing than the Xref Manager command. A list is shown of the Xrefs that are attached to the current drawing. If the Xref file is not found, you can pick the Set Path button to locate the drawing file. To import an Xref, highlight the file name and Pick Import.

Prerequisite: files to import

Keyboard Command: import_xref

Import RoadXML File
The Import RoadXML File routine provides a mechanism where road-based data from other software applications (including Carlson Software) can be brought into a project and used for analysis and/or design purposes. The program supports centerline and profile data in Trimble style RoadXML format. To import a RoadXML file, a series of dialog boxes are presented:
Select RoadXML File: The standard File Selector dialog box prompts you identify an existing RoadXML (*.RXL) file you wish to import. The following dialog box is then displayed:

RoadXML Units: Indicates the Units of Measure associated with the incoming RoadXML file (see the Unit Differences item below).

Destination File Method: This option allows you to indicate how the incoming data file(s) are named as they are imported.

Change Directory: This option allows you to adjust the folder location where the new data files will be written.

Import from RoadXML: Enable or disable various entries that should used to produce the data files found within the RoadXML file.

RoadXML Units: RoadXML files are always in metric units. If the current drawing units as set in Drawing Setup are not metric, then you will be prompted whether to apply a scale factor. Note: Visit http://www.road-xml.org for additional information on the RoadXML initiative.

Pulldown Menu Location: File > Import
Keyboard Command: roadxml_import
Prerequisite: A RoadXML file to import

LandXML

What is LandXML?
LandXML, initiated by Autodesk in December 1999, is an industry-driven, open XML data exchange standard that addresses the needs of private and public land development professionals, software/hardware producers, and service vendors. The first draft LandXML schema was derived from the earlier ASCII-based EAS-E (Engineering and Surveying - Exchange) data interchange standard initiative.

LandXML specifies a design data structure that:

- Transfers civil engineering / survey design data between producers and consumers.
- Provide a data format suitable for long-term data archival.
- Provide a standard format for official electronic design submission.

LandXML data may also be used as:

- Source data for quantity take-off, cost estimation.
- Source data for custom calculations and reports.
- Accessible design data from remote/field devices.
- Data extraction and submittal format for GIS databases.
- Engineering design data transport layer for collaborative applications.

In the past year, many software programs adopted native XML support features. Desktop applications such as Microsoft Office, AutoCAD as well as database programs such as Microsoft SQL 2000, IBM DMBS and Oracle support XML data nearly seamless. LandXML provides a specialized XML format for land development professionals that suits their needs and provides data that can be used in new ways with business, technical and database software that supports XML.

For the latest in LandXML developments, visit http://www.landxml.org/

**Import LandXML File**

This command imports project data from the industry standard LandXML file format version 2.0 and earlier. Land development software applications including Carlson Software can exchange project data using LandXML. The project data in LandXML includes survey measurements, coordinates, centerlines, profiles, cross sections, surfaces, lots, plan view linework and pipe networks.

To import a LandXML file, the program first prompts to select a LandXML file to import. Then there is a dialog with import options along with a view of the contents of the LandXML file. You can toggle on which data from the file that you want to import.
LandXML Units: Indicates the Units of Measure associated with the incoming LandXML file (see the Unit Differences item below).

Point Protection: When enabled, you are prompted for a course of action if an existing LandXML file you've selected contains COGO points that have the same number(s) as those that already exist in the drawing. When disabled, existing point data in the project is updated with the values from the LandXML file.

Destination File Method: This option allows you to indicate how the incoming data file(s) are named as they are imported.

Load Surfaces into Surface Manager: When enabled, this option will automatically add surface model (TIN) data into the Surface Manager and graphically represents (draws) the surface model/contours according to the current settings found in the Triangulate & Contour command.

Skip Invisible Triangles: This option skips triangles flagged as invisible when importing a triangulation surface.

Use Old FLT Triangulation File Format to Import Surface Data: When enabled, the older ASCII-based Carlson *.FLT file format will be used in place of the newer and more efficient *.TIN file format.

Save All Existing Ground Profiles from One Centerline to the Same File: When enabled, collections of existing ground profiles associated with a particular centerline are combined into a single *.PRO file.

Draw PlanFeatures to current drawing: When the LandXML contains PlanFeatures, this option will automatically draw this linework. Otherwise, the program stores a .pln file which can be drawn using the File > Import > Polyline File routine.

Save Point Descriptions: For coordinate records, this option controls whether to use the LandXML description or code record for the coordinate file point descriptions.

Add F2F Codes to Points from PlanFeatures: When the LandXML file contains both coordinates and plan features, this option adds Field-to-Finish linework codes to the descriptions of the coordinates. For example, if a
plan feature line ends at point 25, then the Field-to-Finish end linework code of END is appended to the description of point 25.

**Change Directory:** This option allows you to adjust the folder location where the new data files will be written.

**Import from LandXML:** Enable or disable various entries that should used to produce the data files found within the LandXML file.

![Warning](image)

**Unit Differences:** If the Units of Measure specified in the LandXML file are different than those found in Drawing Setup, you will be prompted for a course of action.

![Sewer Network](image)

**Manning's "n":** If you are importing sewer data from a LandXML file and if the LandXML file does not carry Manning's "n" values, you will be prompted to specify a default Manning's "n" value for all incoming sewer entities that don't already have a Mannings "n" value.

![Sewer Network](image)

**Import Structures:** If you are importing sewer data from a LandXML file and structure values specified in the LandXML file do not exist in the Structure Library, you will be prompted to indicate the structure(s) that should be imported into the Structure Library. Use standard Windows click, shift+click and/or ctrl+click functionality to select multiple structures at the same time.

**Skip Invisible Triangles:** This option applies to importing TIN surfaces from Civil 3D. When this option is active, triangles marked by Civil 3D as invisible or excluded are not imported.

**Note:**
• The LandXML initiative is being driven by the land development industry as an acceptable means to share and transfer land data rather than the traditional graphical representation of that data. It also provides an effective means for transferring a variety data (points, centerlines, profiles, surface models, sewer data, etc). Another advantage of LandXML is that the LandXML data structure is CAD and software vendor neutral (meaning you don’t have to own or use the CAD or software product used by your data provider).
• Visit http://www.landxml.org for additional information on the uses and acceptance of the LandXML project.

Pulldown Menu Location(s): File > LandXML
Keyboard Command: landxml_import
Prerequisite: A LandXML file to import

Import 12D File
This function imports project data from the 12D modeling program into Carlson format. Linework geometry from the 12D file is drawn as polylines. The routine also draws any text, symbols and points. Project data for centerlines, profiles, sections, pipe networks and surfaces are saved into Carlson project files.

Pulldown Menu Location: File > Import
Keyboard Command: 12d_import
Prerequisite: A 12DA file to import

Import ePlan File
This command reads an ePlan project file and creates Carlson project files. Point data is stored to a Carlson coordinate file. There is an option to store measurements to a Carlson RW5 file. There is an option to import lot data to a Carlson LOT file and to draw the lots as polylines.

Pulldown Menu Location: File > Import
Keyboard Command: eplan_import
Prerequisite: ePlan XML file

Civil 3D All
This command converts custom AEC objects from Civil 3D into standard CAD entities. The supported objects include points, surfaces, centerlines, pipe networks, feature lines and labels.

Pulldown Menu Location: File > Import
Keyboard Command: c3d_all
Prerequisite: AEC objects

Civil 3D Pipes
This command converts custom AEC pipe and structure objects from Civil 3D pipe networks into standard CAD entities.
Civil 3D Labels
This command converts custom AEC label objects from Civil 3D into standard CAD text entities.

---

Import MxRoad GENIO
This command draws the linework and entities from an MxRoad GENIO file (.inp) into the current drawing. The File > Export > Polyline File command can be used to create an .inp file from the drawing.

---

Import Google Earth File
The Import Google Earth File command allows you to insert a KML (Keyhole Markup Language or alternatively a KMZ) file of points (KML Placemark), polylines (KML Path) and closed polylines (KML Polygon) into your drawing. Throughout this discussion, KML will be used to also describe KMZ files unless explicitly noted.

---

**Import Lines and Polygons:** When this option is selected, KML Path and Polygon entries will be placed into the drawing as open or closed polylines, respectively.

**Import Points:** When this option is selected, KML Placemark entries will be placed into the drawing and active coordinate file.

**Point Protect:** When enabled, existing points in the active coordinate file will not be over-written.

**Use Name as Number:** When enabled, the names of KML Placemark entries will be utilized as Carlson point numbers.

**Attach Image To Points:** This option applies to KML files created by Carlson SurvCE when the points are stored together with an image. Use this option to attach the image to the point symbol. The images can be viewed using the Image/Document Inspector command. The image files are extracted from the KML and stored in the Image Storage Path folder.

**Import Overlay Images:** When enabled, any Overlay Image placemarks in the KML file will be inserted into the CAD drawing.
Use Folders as Layers: When enabled, KML Folder entries will be used to create layer names in CAD and the supported KML options described above will be placed onto the layer that conforms the the Folder to which they belong.

Default Layer: The supported KML options described above that are not contained in a KML folder will be placed into the specified layer.

Import GIS Data: When enabled, this routine will populate GIS data into the drawing such as that written from the drawing with the Export Google Earth File command.

Note:

- Placemarks, paths or polygon entries that have an altitude value specified will be imported at the proper "Z" elevation in the CAD drawing.
- KML or KMZ files can be specified for the import process.

Prompts

Google Earth File to Read: Select a previously saved KML or KMZ file.

- To import a Google Earth image into your drawing, use the Place Google Earth Image command.
- To import a Google Earth terrain data into a Carlson TIN (surface model), use the Place Google Earth Image command.
- To export content from your drawing to a KML file, use the Export Google Earth File command.

Pull-down Menu Location: File > LandXML/RoadXML/Google Earth

Keyboard Command: kmlread

Prerequisite: A KML or KMZ file with Placemark, Path and/or Polygon information, an active coordinate file with an established projection zone through Drawing Setup.

Export

Export LandXML File

The Export LandXML File routine provides a mechanism where data can be sent from Carlson Software into a LandXML file for use in other applications that support the LandXML data specification. LandXML version 2.0 is used which includes the ability to output triangulation surfaces with colors and materials defined for the triangles.

To generate a LandXML file, a series of dialog boxes are presented:

![Import/Export LandXML](image)

Export to LandXML: This option allows you to individually select the desired Carlson Software data file(s) that should be included in the LandXML file.

Project Data Files: This option allows you to quickly select the various data files associated with, and defined by a Carlson Project (*.prj) file.

Select LandXML File: Specify the name of a LandXML file you wish to create.
Include Files Referenced in Select Files: When enabled, this option will automatically add other files that are referenced by the selected file. As an example, the file produced by the Carlson Road Network command references TINs, Centerlines, Profiles, etc, and adding the single Road Network file will also add the referenced file(s) into the Export to LandXML File dialog box.

Export to LandXML File: Add, remove (using standard Windows click, shift+click and/or ctrl+click functionality) or otherwise organize the data file(s) that is to be incorporated into the LandXML file.

Change Directory: This option allows you to adjust the folder location from where selected data files should be referenced (often used for project revision purposes).

Report: Create a report (suitable for file transmission or archival purposes) of the file(s) selected to be incorporated into the LandXML file.
LandXML Units: Specify the desired Units of Measure that reflect the outgoing data.

Point Protection: When enabled, you are prompted for a course of action if an existing LandXML file you've selected contains COGO points that have the same number(s) as those being selected for the LandXML file. When disabled, point data you've selected for the LandXML file are automatically written to (or updated into) the existing LandXML file.

Exported Element Protection: When enabled, you are prompted if existing data (such as a centerline) in a LandXML file should be updated with data of the same name that you have selected for the LandXML file.

Precision: Set the desired level of precision for each of the various measurement categories.

Profiles:

There are two major different types of profiles in LandXML: ProfSurf and ProfAlign. ProfSurf is typically an existing surface that is usually created using existing surface data. The data for this type of profile is stored in a series of station-elevation values as a representation of a PntList2D list. ProfAlign is for a design profile. The data for this type of profile is stored in LandXML elements starting from the simplest one: PVI element, CircCurve element, ParaCurve element, etc.

Carlson differentiates the two types mentioned above by using the profile type in the Carlson .pro file: Generic = ProSurf, Road = ProAlign.

Note:

- The LandXML initiative is being driven by the land development industry as an acceptable means to share and transfer land data rather than the traditional graphical representation of that data. It also provides an effective means for transferring a variety data (points, centerlines, profiles, surface models, sewer data, etc). Another advantage of LandXML is that the LandXML data structure is CAD and software vendor neutral (meaning you don't have to own or use the CAD or software product used by your data provider).

Pulldown Menu Location(s): File > LandXML
Keyboard Command: landxml_export
Prerequisite: Carlson project data files to convert

Export RoadXML File

The Export RoadXML File routine creates a RoadXML RXL file using Carlson format centerline and profile files. This RoadXML file can be used for data exchange with other applications that support the RoadXML data specification such as Trimble. To generate a RoadXML file, a series of dialog boxes are presented:

**Current Drawing Data Files:** This option selects the various data files associated with, and defined by the Drawing Explorer command.

**Project Data Files:** This option allows you to quickly select the various data files associated with, and defined by a Carlson Project (*.prj) file.

**Selected Data Files:** This option allows you to individually select the desired Carlson Software data file(s) that should be included in the RoadXML file. This is followed by:

**Select RoadXML File:** Use the standard File Selector dialog box to specify a new or append to an existing RoadXML file. This is followed by:
Include Files Referenced in Select Files: When enabled, this option will automatically add other files that are referenced by the selected file. As an example, the file produced by the Carlson Road Network command references TINs, Centerlines, Profiles, etc, and adding the single Road Network file will also add the referenced file(s) into the Export to RoadXML File dialog box.

Export to RoadXML File: Add, remove (using standard Windows click, shift+click and/or ctrl+click functionality) or otherwise organize the data file(s) that is to be incorporated into the RoadXML file.

Change Directory: This option allows you to adjust the folder location from where selected data files should be referenced (often used for project revision purposes).

Report: Create a report (suitable for file transmission or archival purposes) of the file(s) selected to be incorporated into the RoadXML file.

RoadXML Units: The Units of Measure are displayed for the RoadXML file about to be created.

Exported Element Protection: When enabled, you are prompted if existing data (such as a centerline) in a RoadXML file should be updated with data of the same name that you have selected for the RoadXML file.

Precision: Set the desired level of precision for each of the various measurement categories.

Pick the Export button to complete the creation of the RoadXML RXL file.

RoadXML Units: RoadXML files are always in metric units. If the current drawing units as set in Drawing Setup are not metric, then you will be prompted whether to apply a scale factor.
Indicate the desired action of what should occur if the units of the RoadXML do not match those of the current drawing.

Note: Visit http://www.road-xml.org for additional information on the RoadXML initiative.

**Pulldown Menu Location(s):** File > LandXML/RoadXML  
**Keyboard Command:** roadxml_export  
**Prerequisite:** Carlson project data files to convert

**Export 12D File**
This command creates a 12DA project file for the 12D modeling program. You can export drawing entities and Carlson project files. For the drawing entities, the program supports linework, text and point entities. For Carlson project files, the export handles triangulation surfaces (TIN), centerlines (CL), pipe networks (SEW), profiles (PRO) and cross sections (SCT).

**Pulldown Menu Location:** File > Export  
**Keyboard Command:** 12d_export  
**Prerequisite:** None

**Export ePlan File**
This command creates an ePlan project file from Carlson lot and coordinate files. The program prompts for the Carlson .LOT and coordinate files to read and then the ePlan .XML file to create.

**Pulldown Menu Location:** File > Export  
**Keyboard Command:** eplan_export  
**Prerequisite:** Carlson lot and coordinate files

**Export Civil 3D Drawing**
This command saves the current drawing to a dwg file and converts the optional Carlson points, Carlson centerlines and selected Carlson TIN files into Civil 3D objects.
**Convert Points:** When enabled, the Carlson points in the drawing will be converted into Civil 3D point objects.

**Convert Centerlines:** When enabled, the Carlson centerlines in the drawing will be converted into Civil 3D alignment objects.

Clicking the **Add** button yields the Choose Surface File to Read dialog box.

![Choose Surface File to Read](image)

Clicking the **Remove** button removes the selected surface file from the list of Surface Files to convert.

**Output Drawing** *select a .DWG file* to create Civil 3D objects within.

**Pull-down Menu Location:** File > Export

**Keyboard Command:** convert_c3d

**Prerequisite:** None
Export Civil 3D Points
This command saves the current drawing to a dwg file and converts the Carlson points into Civil 3D point objects.

Pulldown Menu Location: File > Export
Keyboard Command: crd_c3d
Prerequisite: None

Export Civil 3D Surface
This command saves the selected TIN file to a dwg file and converts the Carlson TIN into Civil 3D surface object.

Pulldown Menu Location: File > Export
Keyboard Command: tin_c3d
Prerequisite: None

Export Drawing to AutoCAD 14
This command will save an existing Carlson drawing to AutoCAD R14 format. This command is for Carlson in AutoCAD 2004 and Carlson working in AutoCAD 2005.

Prompts
Source Drawing To Load dialog select a .DWG file
AutoCAD R14 Format Drawing To Save dialog select name for a new .DWG file
Files saves to R14.
Pulldown Menu Location: File
Keyboard Command: dwg2r14
Prerequisite: An existing Carlson .DWG file, using Carlson in AutoCAD 2004 or Carlson in AutoCAD 2005

Export Google Earth File

The Export Google Earth File allows you to produce a KML (Keyhole Markup Language or alternatively a KMZ) file of points, polylines, text, solids, images, lines and arcs for rendering in other mapping and GIS applications such as Google Earth and Google Maps. Throughout this discussion, KML will be used to also describe KMZ files unless explicitly noted.
**Drape on Google Terrain (2D):** When this option is selected, entities written to the KML file will have an Altitude setting of "Clamped to ground."

**Use Elevation from the Drawing (3D):** When this option is selected, entities written to the KML file will have an Altitude setting of "Absolute."

**Line Width (pixels):** Indicate how wide selected linework should be when viewed in Google Earth. The higher the value, the thicker the line.

**Include Selected Points:** When enabled, this option exports selected Carlson point information to the KML `<Placemark><Point>... </Point></Placemark>` tag structure. For the Google placemark, you can choose between using the point number, elevation or description.

**Include Selected Text:** When enabled, this option exports selected Text and MText entities to the KML `<Placemark><Point>... </Point></Placemark>` tag structure.

**Include Layer Information:** When enabled, this option organizes exported information based on the layer of each entity, with each CAD layer becoming a KML `<Folder>... </Folder>` entry with the color of the group taking the general color of the CAD layer.

**Shade Closed Regions:** When enabled, all closed polyline regions (e.g. building pads, ponds, etc) will be fill-shaded.

**Include Solids and Images:** When enabled, Solid entities and Images are included in the KML as `<Placemark><Polygon>... </Polygon></Placemark>` and/or `<GroundOverlay>... </GroundOverlay>` tags, respectively.

**Export to KMZ Format:** When enabled, the KML file is written to the more compact (zipped) KMZ version of the standard KML file format.

**Display Results in Google Earth:** When enabled, the results of the KML are passed to and automatically opened with Google Earth. To setup for running Google Earth Pro, go to Windows Start > Default Programs > Associate File Type With Program and assign KML and KMZ file types to Google Earth Pro.

**Share Results through Dropbox:** When enabled, the results of the KML are passed to a personal DropBox account.

**Include GIS Data:** When enabled, GIS attribute data associated with selected entities will be populated into the
KML file. GIS attribute data can be imported via the Import SHP File command (see the Sample Esri Data note below) or manually assigned with the Input-Edit GIS Data command or the Set Google Tags command. Upon specifying the KML file to output, the **Quick View Settings** dialog box of the GIS Inspector command may display:

1. Select a desired GIS Feature from the upper-left of the dialog box.
2. Add the desired Attributes to the display list using a double-click action or clicking the **Add Attribute** button.
3. Indicate a desired Attribute to serve as the **Placemark Name** and use the **Use as Placemark Name** button to set it.

Upon exiting from the dialog box, available GIS Data on a per-entity basis will be populated into the KML file:
Linework Opacity: Use the horizontal slider control to indicate the desired level of opaqueness that should be applied to linework entities. A lower opacity results in increased entity transparency and is helpful for viewing underlying map data found in applications such as Google Earth.

Solids and Images Opacity: Use the horizontal slider control to indicate the desired level of opaqueness that should be applied to Solids and Image entities. A lower opacity results in increased entity transparency and is helpful for viewing underlying map data found in applications such as Google Earth.

Note:

- When the Use Elevations from the Drawing (3D) option is selected, be aware that elevation values lower than the Google Earth terrain may be obstructed in the Google Earth display.
- Attribute information (e.g. Number, Elevation, Description) of selected Carlson points are also written to the KML and will display in the "balloon" when a point is picked in the Google Earth display or data hierarchy.
- The formatting of any selected MText entities is not propagated into the KML/KMZ file.
- When the Shade Closed Regions toggle is enabled, note that all closed polyline regions will become fill shaded and may lead to undesired results for items such as closed contours.
- When Image entities are included, the size of the image itself is incorporated into the KMZ file and may significantly swell the size of the KMZ file which may result in lengthy load times into other applications.
- To have results posted to Dropbox, the Dropbox Application for Windows must be first installed to your PC using its default folder specification for the location of shared/synchronized folders/files.
- When prompted for the name of the KML/KMZ file to write, the appropriate KML or KMZ file extension based on the Export to KMZ Format toggle will be added to the file if the file extension is not specified.
- Arrows and polylines with arcs are converted into chord segments that closely approximate the arc(s).
- Other entities not supported for direct export to a KML file (e.g. circles, ellipses, splines, multilines, etc), can be first turned into polylines with the Entities to Polylines command.
- Sample Esri data of the United States in Shape File form can be freely downloaded and explored.
- The graphical symbology of any/all items sent to the KML file can be manually modified via the Google Earth interface.

Prompts

Select points, polylines, text, solids, images, lines and arcs to write.

FIL[ter]/<Select entities>: Select the desired entities and press Enter when complete.

- To import a Google Earth image into your drawing, use the Place Google Earth Image command.
- To import a Google Earth terrain data into a Carlson TIN (surface model), use the Place Google Earth Image command.
- To import KML content into your drawing, use the Import Google Earth File command.

Pulldown Menu Location(s): File > Export
Keyboard Command: kmlwrite
Prerequisite: Points, lines or polylines in the drawing with an established projection zone through Drawing Setup.

Set Google Tags

This command adds labels to drawing entities that are shown as "balloon" labels in Google Earth when the Include GIS Data option of the Export Google Earth File command is enabled.
After selecting the entity to tag, the dialog box above displays that permits various forms of tag data to be associated with the entity. An example result is shown below for reference purposes (the first “tag” being the layer upon which the entity resides):

Prompts

**Select entity:** Select a point, symbol, text or linework

**Pulldown Menu Location:** File > Export

**Keyboard Command:** tagkml

**Prerequisite:** Entities to attach tags
Polyline File

Draw Polyline File

This command draws polylines from the selected polyline file. This command supports the following formats: Carlson (.PLN), Agtek (.WRL), CAICE (.SRV), Digital Line Graph from USGS (.DLG, .OPT), Idan (.DIS), MicroStation (.TXT), MOSS (.INP, .PRN), Peabody (.PLY) and Topcon (.LN3 and .TXT). For formats that contain only geometry without layer names, the polylines are drawn in the current layer.

Prompts

Polyline file format [Carlson]/Agtek/CAICE/DLG/DTM/Idan/MicroStation/MOSS/Peabody/Topcon]? press Enter for Carlson default
Polyline File to Read Dialog select existing .PLN file
Pulldown Menu Location: File->Import
Keyboard Command: polydraw
Prerequisite: A polyline file

Write Polyline File

This command creates a polyline file that contains the point data of the select polylines. The objects supported by this tool include polylines, arcs and lines. If you want to include text, you must use the Text Explode To Polylines command found in the Edit menu to convert the text to polylines before running this command. Several different output formats are supported.

The Carlson format (.PLN) is a text file format that is used by some Carlson commands and by machine control (Carlson Grade, Dozer 2000, GradeStar) for the plan view. Each polyline begins with a line of "POLYLINE, Color number, etc". Then the points for the polyline are listed on separate lines in X,Y,Z format.

The DTM and Idan formats create linework files for the DTM and Idan programs.

The KOF method creates a .KOF format file.

The MicroStation format (.txt) can be imported into MicroStation. This format has the coordinates as space delimited for each polyline point. There is an extra column with a 1 or 0 where 1 specifies the start of a new polyline.

The Moss format creates a INP file for the MXROAD/MOSS Genio program.

The Peabody format is a company specific format for Peabody Energy.

The Topcon format creates a Topcon LN3 file.

Note:

- The former Google (KML) output option has been moved to the dedicated Export Google Earth File command.

Prompts

Polyline file format [Carlson]/DTM/Idan/MicroStation/MOSS/Peabody/Topcon]? Specify the desired output option by specifying the CAPITALIZED option or press Enter for the <default> option.
Polyline File to Write dialog: Create a new file or Append to Existing. If the Carlson option was selected, the following dialog then appears:
Use Polyline File for Grid File Utilities macro: When enabled, the option will write a polyline file that can be used with Grid File Utilities for inclusion/exclusion perimeters.

Specify Exclusion/Warning Polylines: When enabled, this option applies to machine control for warning areas.

Specify WorkZone Polylines: When enabled, this option applies to machine control for working areas.

Reduce Polyline Vertices: When enabled, this option applies the Reduce Polyline Vertices to the polyline vertices before writing the file.

Offset Cutoff: Indicate the allowable offset distance (essentially the middle ordinate distance of a 3-point arc) that would allow the middle vertex between two other vertex locations to be removed.

Include Z coordinate in polyline file: When enabled, this option controls whether the elevation(s) (or "Z" value) of the selected polyline vertices are written to the polyline file.

Decimals: Indicate the desired amount of precision for the coordinate values that should be written to the file.

Select polylines, lines and arcs to write.
FILTER/SELselect entities>: Pick the entities to process press Enter when complete.

Sample Polyline File:

```
POLYLINE,51,0,0.0,CONT|V-STRM-PIPE
5375168.9320,3932304.7050,0.0000
5375193.3310,3932211.6150,0.0000
POLYLINE,150,0,0.0,CONT|V-BRKL
5375026.8800,3932090.0480,962.8334
5375062.3960,3932105.7540,961.5399
5375075.5640,3932115.7940,961.1595
5375079.0150,3932128.0920,961.1532
5375081.6860,3932159.7840,961.6147
5375086.6920,3932195.6480,962.6206
etc.
```

Pulldown Menu Location: File > Export
Keyboard Command: polywrite
Prerequisite: Polylines in the drawing

**Drawing Cleanup**

The Drawing Cleanup dialog box allows you to perform many functions that fix common errors, and it removes unnecessary data found in many drawing files. It also converts incompatible data into useful entities. This command offers many filters that audit the drawing file and allows you to select which options and settings you want to use. A report of the cleanup results will be displayed upon completion. Always save your file when the drawing cleanup routine is complete.
Set UCS to World Coordinates
This sets the UCS (user coordinate system) to the world coordinate system (WCS). Carlson works exclusively in the world coordinate system and there is no way to change this setting. In CAD, it is possible to change the coordinate system from WCS. If you receive a drawing in which the coordinate system is not set to world, click this on to restore the UCS.

Convert Architectural Inches Units To Decimal Feet
Drawings are sometimes in architectural units, i.e. inches, when the unit of measurement was intended to be in feet. This routine will change the units from inches into feet and then scale the drawing by 1/12.

Import Xrefs To Current Drawing
This routine allows you to import any 'found' external reference files (Xrefs) into the current drawing. If the path is not found, the Xref file will not be brought into the drawing. To set the Path for any unfound Xrefs, run Import Xref to Current Drawing under File.

Remove Layers With No Entities
Drawings work with a "BYLAYER" concept meaning that layer definitions define the drawing. For example, the layer named EOP might be used to display polylines at the Edge Of Pavement in the drawing. Many times extra layers get defined by a user but not used to display any objects. This function removes any layers defined in the drawing that are not being used.

Rename Layers With Wildcards
Layers with wildcard characters such as "*" can interfere with Carlson layer matching functions. This routine renames layers by replacing any wildcard characters with an underscore "_".

Remove Unused Blocks, Linetypes and Styles
This function removes this unused information from the drawing.

Remove Zero Length Linework
This function seeks out and removes any linework definition that have zero length. Point nodes are not removed.
Remove Duplicate Linework
This function finds any duplicate linework in the drawing and removes all but one set.

Remove Duplicate Points
This function searches the drawing (but not the .CRD file) for points with the same northing, easting and elevation. The tolerances for considering points to have the same coordinate are set to the right. To be counted the same coordinate, both the northing/easting and elevation must be within the tolerance distance.

Remove Overlapping Polyline Loops
Polylines that completely overlap themselves are broken into two different polylines.

Join Linework With Same Endpoint
This function finds common endpoints on linework on common layers with common elevations and joins the linework into a continuous polylines. This is very helpful for future selection sets.

Convert Splines, Multilines and Regions Into Polylines
Some CAD applications utilize Spline Object Definitions and Regions, Carlson utilizes basic polyline/polygon definitions. This function finds any Splines and/or Regions defined in the drawing and re-defines them as simple polylines or polygons.

Convert Lines, Arcs, Circles, Ellipses, 3DFaces and Solids Into Polylines
By converting Lines, Arcs, Circles, Ellipses, 3D Faces, and Solids into Polylines, you can use the variety of Polyline commands available in Carlson.

Convert LDD-AEC Contours and Points Into Carlson Format
Drawings created in the Land Development Desktop CAD program can contain special objects known as LDD-AEC contours that define their topographic contour display. This function locates those special objects and re-defines them as simple 2D polylines retaining their elevation values.

Convert Entities With Extrusion To World Coordinates
Drawings created in the Land Development Desktop CAD program can contain special objects known as LDD-AEC contours that define their topographic contour display. This function locates those special objects and re-defines them as simple 2D polylines retaining their elevation values.

Erase Blank Text Entities
This function removes any text boxes defined in the drawing that are not being used.

Erase Hatch Entities
Carlson offers many hatch display options, however hatch entities have no 3D value. This function removes all hatch entities in the original drawing to help reduce the size and clutter of the drawing file.

Remove Arcs From Polylines - Offset Cutoff
This function replaces arcs in polylines with a series of short chord segments. The purpose is to prepare the polylines for modeling since arcs need to be converted into segments to be part of the triangulation model. The density of chord segments is controlled by the offset cutoff. This cutoff represents how much the polyline can move horizontally. A smaller cutoff will result in more chord segments. The option for 3D Only controls whether only polylines at zero elevation or both zero and elevated polylines get processed. Sometimes you may want to leave the arcs in zero elevation polylines when these polylines represent road alignments and are not part of the surface model.

Reduce Polyline Vertices - Offset Cutoff
This function utilizes a pre determined offset amount and removes unnecessary polyline vertices that fall within the offset amount.
Set Negative Polyline Thickness to Zero
This function sets the thickness property of polylines to zero for polylines with negative thickness.

Set Elevations Outside Range to Zero and Elevation Range
This function comes with a "Scan DWG" option that audits the elevation range in the drawing file. Once the minimum and maximum elevation range has been set, manually or by a scan, all objects that fall outside the set range are moved to elevation zero. All objects at zero elevation do not contribute to the 3D model.

Entities To Process...
This allows you to run the command for the entire drawing or for a selected set.

Default
This allows you to return to the Carlson Drawing Cleanup default settings.

Final Report
This example report displays the results of drawing cleanup. Like all reports in Carlson, this report can be saved to a text file, sent directly to your printer, or pasted onto the screen as text entities.
Drawing Utilities

Geolocate DWG Files
This command displays placemarks in Google Earth for DWG files. The command starts by prompting for a folder. Then all the DWG files in this folder and the sub-folders are used to make the map for Google Earth. In order to use a DWG file, the coordinate system must be set in the DWG using the Drawing Setup command. The command creates a Google Earth file called kmldwgs.kmz in the %appdata%\Carlson Software\version\platform\USER folder.

In Google Earth, the location of each DWG file is shown with a circle marker. When you on a marker, the DWG properties are shown including the folder location, date, file size and graphic preview.

To load a DWG file from Google Earth, go to Tools > Options in Google Earth. In the Options dialog, go to the General tab and turn on Allow Access To Local Files and Personal Data. Then when you pick on a placemark to open it up, you can double-click on the properties window to load that DWG file into CAD.

Pulldown Menu Location(s): File > Drawing Utilities
Keyboard Command: dwg2kml
Prerequisite: DWG files with defined coordinate systems
Translate Layers

This command renames layers using a lookup table with pairs of original and renamed layer names. This command can be used to convert the layers for a drawing from another source to match your layer standards. The layer names are entered in a spreadsheet. The Add, Insert, Delete and Sort buttons work on the spreadsheet rows. The Report button makes a report for the layer assignments. The SaveAs and Load functions store and recall the layer assignments to a .LTF file for sharing the settings or keeping different sets of layer assignments.

If you use Layer Library and define your target layers with their properties, then the Translate Layers command will use these layer properties. For the example below, if the X-U-TE layer is defined in the Layer Library, then X-U-TE is created using the color, line type, transparency and plot style from the Layer Library.

![Layer Translation Table Editor](image)

Pulldown Menu Location: File > Drawing Utilities

Keyboard Command: translayers

Prerequisite: None

Audit

This command scans your current drawing and looks for any corruption and has the option to fix any errors.

Prerequisite: none

Keyboard Command: audit

Recover

This command opens a drawing file and scans it for errors. Use this command if Carlson TakeOff crashes while using the regular Open command.
Prerequisite: none

Keyboard Command: recover

**Drawing Save Log**

The command reports the save history for the current drawing including the date, time, user and computer name for each save. This save history is only recorded when the Generate Drawing Save Log option is turned on in the Carlson Configure > Getting Settings.

![Drawing Save Log](image)

**Pull-down Menu Location:** File > Drawing Utilities  
**Keyboard Command:** dwg_save_log  
**Prerequisite:** Turn on Generate Drawing Save Log in Carlson Configure

**Remove XData**

This command removes the xdata (Extended Entity Data) from the selected entities. Many Carlson routines add xdata to entities in order to add extra program specific information to them. Carlson programs use the xdata to make entities more intelligent. For example, when you draw a centerline (.cl) as a polyline, xdata is attached to the polyline that stores the reference of the .cl file name. Then if you double-click the polyline, then the program can read the xdata to know the polyline is a centerline and launch the centerline editor. By removing the xdata, the entities revert to regular CAD entities which is useful if you want to detach these entities from the program links.

**Prompts**

Select entities to remove extended entity data from.  
Select objects: pick the entities  

**Pull-down Menu Location:** File > Drawing Utilities  
**Keyboard Command:** xdata  
**Prerequisite:** Entities with xdata
Remove Civil 3D Custom Objects

This command removes all Civil 3D custom objects (AEC objects) from the current drawing so that the next time the drawing is opened, AutoCAD will not load the AEC functions. The AEC objects can be either erased or exploded into standard AutoCAD entities. The cleaned drawing is saved to a new dwg file.

Prompts

Erase or Explode AEC entities during conversion [Erase]/Explode? press Enter

Save dwg selection dialog

Pulldown Menu Location: File > Drawing Utilities
Keyboard Command: aeccleaner
Prerequisite: Drawing with AEC data

Remove Reactors

This command removes the reactor links from the selected points, text, polylines and lines. This disables the links for points to the coordinate (.CRD) file, annotation with linework and linework with points. Note that in General Settings there is a section called Object Linking. This is the specific section that contains the options for creating these reactors to the drawing entities. Reactors can be turned off for entities created later by clicking off the four link options in General Settings. To get to this dialog go to Settings > Configure > General Settings.

Prompts

Select entities to remove reactors from:
Select objects: pick the entities

Pulldown Menu Location: File > Drawing Utilities
Keyboard Command: delreact
Prerequisite: Entities with reactors

Remove Groups

This command is used to “ungroup” selected entities that, prior to using this command, were part of a group. For our purposes, we might more specifically be referring to Carlson's Point Entity Grouping feature. A group is a named selection set of objects. This routine removes selected entities from groups. It is especially useful when dealing with our Carlson points.

More on Point Entity Grouping: As mentioned in the Points chapter, remember that for each point, the point attribute block, node, and symbol can be bound together. This means that if you choose to use the Move command (or other CAD tools) the entire collection moves together. This is done using the grouping functionality in AutoCAD or IntelliCAD. To disable this system altogether, go to Configure, choose General Settings, and turn off the toggle for Group Point Entities. If you need to temporarily disable grouping in a drawing, you can use the AutoCAD toggle for grouping, which is Ctrl-A. Holding down the Ctrl key, and pressing the letter A on the keyboard, activates this two-way toggle, with the current status echoed to the command prompt area.

Prompts

Select entities to remove from groups.
Select objects: select entities
Unlock Attributes

This command turns off the lock flag for attributes of the selected block entities.

Prompts

Select attributes to unlock.
Select objects: pick the entities

Purge

Displays a tree view summary of all named objects that can and can't be purged in the current drawing. The View Items You Can Purge and View Items You Cannot Purge options toggle the dialog box display, showing different options and tree view summaries.

Items Not Used in Drawing: Displays a tree view of all named object categories (blocks, layers, and so on) in the current drawing. A plus sign appears next to the object category names that you can purge. Clicking the plus sign or double-clicking an object category expands the tree view, displaying all unused named objects that exist for the category. To purge all unused named objects, select All Items in the tree view, and choose Purge All. To purge a specific named object category, select the category in the tree view, and choose Purge.
Confirm Each Item to Be Purged: Displays the Verify Purge dialog box when you purge an item.

Purge Nested Items: Removes all unused named objects from the drawing even if they are contained within or referenced by other unused named objects. The Verify Purge dialog box is displayed, and you can cancel or confirm the items to be purged.

Prerequisite: None

Keyboard Command: purge
Shown here is the Edit menu of Carlson Field. There are useful commands available here for making your drawing more accurate and for manipulating existing entities.
**Undo**
This command allows you to reverse the effect of previously issued commands.

**Prerequisite:** None

**Keyboard Command:** U

---

**Redo**
This command allows you to reverse the effects of the previous UNDO command.

**Prerequisite:** None

**Keyboard Command:** REDO

---

**Erase**

**Erase Select**
This command allows you to remove objects from a drawing.

**Prerequisite:** None

**Keyboard Command:** ERASE, E

**Erase by Layer**
This command will ERASE all the entities on the specified layers but will not delete these layers from the drawing. The command prompts for the layer name to erase and then erases all entities on that layer. In addition to typing in the layer name, you can also specify a layer to delete by picking an entity on that layer. To select layers by picking, first click the Select Layers from Screen button and then select the entities on the layers to be deleted. The Select Layers by Name button allows you to choose a layer name from a list of layers in the drawing. You can also specify which types of entities to erase. For instance, if you have both linework and points on the same layer and you want to erase only the linework, you can click off All and check Line and Polyline. The Save and Load buttons save and recall the layer names.

![Erase by Layer/Type dialog box](image)
Pulldown Menu Location: Edit > Erase
Keyboard Command: I dell
Prerequisite: Something to erase

Erase by Closed Polyline

This tool is used to clean up drawing geometry at the extents of a polyline boundary. It provides options to erase adjacent geometry as well as trim geometry crossing the fence of the polyline.

First, select the boundary polyline. Only one can be selected. Designate the desired options in the following dialog. The top section of the dialog allows you to toggle which object types should be affected by the operation. Note that some of the objects, such as text and inserts, cannot be trimmed.

In the middle of the dialog is a toggle that determines whether to prompt for objects to process. If you want to isolate the drawings contents to that of the selected polyline, turn this toggle on. Note that all geometry in the drawing is effected, even geometry that is outside of the current viewport. Many users will prefer to turn this toggle off, so that they can be prompted to manipulate the geometry.

The bottom row allows you to choose whether to erase all the entities on the inside or outside of the polyline.

Pulldown Menu Location: Edit > Erase
Keyboard Command: erasepline
Prerequisite: Entities and a closed polyline
Erase Outside

This command erases all the entities outside of a user specified window. This can be useful if you somehow place entities way outside your drawing limits and want to easily erase them.

Prompts

Pick 1st corner of window to erase outside of: Pick point location
Pick 2nd corner: Pick second point location
Pulldown Menu Location: Edit > Erase
Keyboard Command: eraseout
Prerequisite: Entities to erase

Temporary Erase

This command erases the selected entities while keeping track of their data to allow restoring them. To unerase the entities, simply run the command again. The program keeps track of the erased data only during the current drawing session. If you exit the drawing, the entities cannot be restored when the drawing is opened again.

Prompts

Select entities for temporary erase.
Select objects: pick entities to erase

Pulldown Menu Location: Edit > Erase
Keyboard Command: terase
Prerequisite: Entities to erase

Move

This command allows you to displace objects a specified distance in a specified direction.

Prerequisite: None

Keyboard Command: MOVE, M

Copy

Standard Copy

This command copies all objects you select to the Clipboard. You can paste the contents of the Clipboard into a document or drawing as an OLE object.

You can also use CTRL+C to run this command. If the cursor is in the drawing area, Carlson TakeOff copies the selected objects to the Clipboard. If the cursor is on the command line or in the text window, the program copies the selected text to the Clipboard.

Prerequisite: None

Keyboard Command: COPY
Copy To Layer

This command is used to copy a selected entity or entities and put the copy in a specified layer. Once copied to the chosen layer the entity or entities will take on the characteristics of that layer (color, linetype, etc.).

Prompts

Select entities to copy.
Select objects: select entities
Select Layer dialog select a layer from list and click OK
Pulldown Menu Location: Edit > Copy
Keyboard Command: copy2layer
Prerequisite: Entities to be copied

Copy Polyline Section

This command is used to copy a portion of a polyline, at specified points, and put the copied portion onto another layer. The portion of existing polyline that is being copied still remains as part of the original entity (with no break), while the new portion, with its chosen layer designation, is a new polyline.

Prompts

Select polyline to copy: Pick a polyline
Select first break point along polyline: Pick location on the polyline
Select second break point along polyline: Pick the second location on the same polyline
Layer name <CTR>: wall

Pulldown Menu Location: Edit > Copy
Keyboard Command: copy_pl
Prerequisite: Polyline to be copied
Offset

Standard Offset
This command creates a new object at a specified distance from an existing object or through a specified point. Offset does not support 3D polylines. Use Offset 3D Polyline to offset these entities.

Prompts
1 Specify offset distance or [Through] <Through>: **Press Enter**

The Through option allows you to screen pick the location of the offset. You can also enter a value for the interval of the offset.

2 Select object to offset or <exit>: **select entity**

3 Specify through point: **pick point**

Menu Location: Edit
Prerequisite: None
Keyboard Command: OFFSET

Offset To Layer
This is a command to offset a polyline and put the offset polyline into a separate layer from the original polyline. The Offset Both Sides For Open Polylines option can be used to create easement perimeters. For example, you can pick a pipe polyline and this option will offset to both sides to create an easement around the pipeline.

Prompts
**Offset To Layer dialog**
Select object to offset: **pick a polyline to offset**
Specify point on side to offset: **pick a point**
Select a polyline to offset (Enter to end): **press Enter**

Pulldown Menu Location: Edit > Offset
Keyboard Command: offset_layer
Prerequisite: Linework to offset

Offset to Area
This command offsets a polyline by a distance that results in creating the specified target area. The source polyline should represent the frontage on the area. There is an option to connect the sides between the source and offset polylines to make a closed polyline.
Before and after Offset to Area

Prompts

Pick line or polyline to offset: pick a polyline
Select side to offset: pick a point on the offset side
Keep existing polyline [Yes/<No>]? press Enter
Create closed polyline [<Yes>/No]? press Enter
Acres/<Enter target area (s.f.)>: 90000

Pulldown Menu Location: Edit > Offset
Keyboard Command: offset_area
Prerequisite: polyline to offset

Multiple Offsets

This command applies the same offset multiple times in series from the original polyline.

Prompts

Specify offset distance <20.0000>: 25
Enter Number of Repetitions <1>: 3
Select object to offset or <exit>: pick a polyline to offset
Specify point on side to offset: pick a point

Pulldown Menu Location: Edit > Offset
Keyboard Command: offset_mult
Prerequisite: Linework to offset

Median Offset

This command creates a median polyline that is offset halfway between two existing polylines. For example, this command can be used to get the center of a river given polylines for the left and right river banks. The intersection method finds where the offsets from the two reference polylines intersect. The Salient and Normal methods come from the CAPD program originally developed by the BLM.
Prompts

Select the First Polyline: pick a polyline
Select the Second Polyline: pick a polyline
Draw Chords of Parabolas [Yes/<No>]? press Enter
Draw Perpendiculars for Check [<Yes>/No]? press Enter

Pulldown Menu Location: Edit > Offset
Keyboard Command: medoff
Prerequisite: two polylines to offset

Variable Offset
This is a command to offset a polyline, with different offset amounts for each polyline segment of the same polyline. The offset distances can be variable, and you choose between a Line or a Point method at the command line.

Prompts

Vary offsets by line segments or at points [<Line>/Point]? press Enter
Select a polyline to offset (Enter for none): pick polyline
Select side to offset: pick a point on the side to offset to
As you go from segment to segment, you can enter in different offset values for each line segment.
Enter the segment horizontal offset <0.000>: 56
Enter the segment horizontal offset <56.000>: 33
Enter the segment horizontal offset <33.000>: 12
Select a polyline to offset (Enter for none): press Enter

Pulldown Menu Location: Edit > Offset
Keyboard Command: VOFFSET
Prerequisite: A polyline to offset

Buffer Offset
This command offsets a polyline, and maintains a fixed distance from the original polyline by placing an arc on convex corners. The standard Offset command can actually have a distance greater than the offset at corners. In the example shown, the distance between the corners of the original and offset polylines is 70.01, while the offset distance is 50.0. Buffer Offset makes an offset polyline that doesn't exceed the offset distance. This is useful when you want an offset that goes no further than the offset distance, such as wetland offsets. Later versions of AutoCAD can achieve the same effect using the standard Offset command by changing the system variable OFFSETGAPTYPE to 1.

Prompts
Enter the offset amount: 50
Select object to offset: pick the original polyline
Specify point on side to offset: pick a point on the side to offset to

Regular Offset
Buffer Offset

Pulldown Menu Location: Edit > Offset
Keyboard Command: boffset
Prerequisite: A polyline to offset

Explode

Standard Explode
This command allows you to break a compound object into its component objects.
Results differ depending on the type of compound object you're exploding. The following is a list of objects that can be exploded and the results for each.

- **All Explodable Objects**: Produces object geometry that may look the same, but the color, linetype, and lineweight of the object may change.
- **Block**: Removes one grouping level at a time. If a block contains a polyline or a nested block, exploding the block exposes the polyline or nested block object, which must then be exploded to expose its individual objects.

Blocks with equal X, Y, and Z scales explode into their component objects. Blocks with unequal X, Y, and Z scales (nonuniformly scaled blocks) might explode into unexpected objects.

When nonuniformly scaled blocks contain objects that cannot be exploded, they are collected into an anonymous block (named with a "*E" prefix) and referenced with the nonuniform scaling. If all the objects in such a block cannot be exploded, the selected block reference will not be exploded. Body, 3D Solid, and Region entities in a nonuniformly scaled block cannot be exploded.

Exploding a block that contains attributes deletes the attribute values and redisplays the attribute definitions.

- **2D and Lightweight Polyline**: Discards any associated width or tangent information.
- **Wide Polyline**: Places the resulting lines and arcs along the center of the polyline. TakeOff discards any associated width or tangent information.
- **3D Polyline**: Explodes into line segments. Any linetype assigned to the 3D polyline is applied to each resulting line segment.

- **Text Explode to Polylines**: Explodes polylines depending on the font used for various annotations, this can make the resulting polylines more efficient in terms of vertex count.

- **Leaders**: Explodes into lines, splines, solids (arrow heads), block inserts (arrow heads, annotation blocks), Mtext, or tolerance objects, depending on the leader.

- **Mtext**: Explodes into text entities
• **Multiline**: Explodes into lines and arcs.
• **3D Solid**: Explodes planar surfaces into regions. Nonplanar surfaces explode into bodies.
• **Region**: Explodes into lines, arcs, or splines.
• **Body**: Explodes into a single-surface body (nonplanar surfaces), regions, or curves.
• **Polyface Mesh**: Explodes one-vertex meshes into a point object. Two-vertex meshes explode into a line. Three-vertex meshes explode into 3D faces.
• **Circle Within a Nonuniformly Scaled Block**: Explodes a circle within a nonuniformly scaled block into ellipses.
• **Arc Within a Nonuniformly Scaled Block**: Explodes an arc within a nonuniformly scaled block into elliptical arcs.

**Prerequisite**: None

**Keyboard Command**: EXPLODE, X

### Block Explode

This command retains the values of attributes when a block is exploded. The standard *Explode* command changes the attribute values back to the attribute type. For example, using *Explode*, a Carlson point block would become PNTNO, PNTELEV, PNTDESC. *Block Explode* would keep the point attribute values, such as 10, 1000.0, EP. The layer names of the exploded block attributes can be either the insert layer of the parent block or the original attribute layers from the block definition.

**Pulldown Menu Location**: Edit

**Keyboard Command**: explode2

**Prerequisite**: A block to be exploded

### Trim

This command allows you to trim objects at a cutting edge defined by other objects.

**Prompts**

1 Select cutting edges ...

Select objects: **pick entity**

2 Select object to trim or shift-select to extend or [Project/Edge/Undo]: **select entity to be trimmed**

• **Project**: You can project the object to be trimmed in order to trim objects that do not intersect.
• **Edge**: You can project the trimming edge in order to trim objects that do not intersect.
• **Undo**: This option allows you to undo the above projections.

**Prerequisite**: None

**Keyboard Command**: TRIM, TR

### Extend

#### Extend To Edge

This command allows you to extend an object to meet another object.

**Prompts**
1 Select boundary edges ...
Select objects: **pick entity**

2 Select object to extend or shift-select to trim or [Project/Edge/Undo]: **pick entity**
You have the option of trimming or projecting objects and edges.

**Prerequisite:** None

**Keyboard Command:** EXTEND

---

**Extend to Intersection**
This command extends the end points of two lines and/or polylines, at the same time, to their intersection point.

**Prompts**

**Select first line or polyline to extend:** pick a line or polyline
**Select second line or polyline to extend:** pick another line or polyline

---

![Diagram](Before Extend to Intersection)

After Extend to Intersection

**Pulldown Menu Location:** Edit > Extend

**Keyboard Command:** extint

**Prerequisite:** Two lines or polylines

---

**Extend Arc**
This command extends an arc entity.

**Prompts**

**Pick arc to extend:** select an arc entity
**Break Arc at Extension [Yes/<No>]?** N Answering Yes will create a new arc starting at the end of the existing arc.
**Enter or pick the distance to extend:** 5 This extends the arc 5 units
**Enter or pick the distance to extend ('U' to Undo):** press Enter to end

**Pulldown Menu Location:** Edit > Extend

**Keyboard Command:** extarc
**Extend by Distance**

This command extends a line or polyline, or creates new lines or polylines off of an existing one. By specifying a distance, a new segment of the line or polyline can be drawn from the current position. The current position and direction along the line or polyline is indicated by an arrowhead. Extend by Distance starts by selecting an existing line or polyline. Initially, the current position will be the closest vertex to where the line or polyline was selected. Extending from the endpoint of a polyline will add a new point to that polyline, while extending from any other point will create a new polyline.

There are two modes of operation: draw mode (D) and move mode (M). When in draw mode, extending will draw line or polyline segments. In move mode, the current position arrowhead can be moved without drawing segments. The orientation of the current position arrowhead can be changed with the Right, Left, and Angle commands.

The second prompt for this command offers numerous options in the form of key letters. These key letters are listed below along with their full names and actions. The list of the Extend by Distance commands are:

- **# - Number**: Distance to draw or extend
- **A# - Angle change**: Rotates pointer by specified number of degrees
- **A - Align**: Rotates pointer to align with segment
- **B - Bearing**: Sets pointer direction by bearing in format: Qdd.mmss with Q- quadrant, d-degrees, m-minutes, s-seconds (e.g. 130.1005 is NE 30 degrees, 10 minutes, and 5 seconds)
- **C - Close**: Closes the polyline
- **D - Draw Mode**: Actions draw or extend the line or polyline
- **E - Extend to Edge**: Extends to intersection with a selected line or polyline
- **I - Input mode**: Toggles distance input between decimal feet and feet-inches
- **L - Left rotate**: Rotates counterclockwise 90 degrees
- **M - Move Mode**: Actions only move the pointer
- **N - Next**: Moves pointer forward to next point
- **O - Open**: Opens the polyline
- **P - Previous**: Moves pointer backward to previous point
- **R - Right rotate**: Rotates clockwise 90 degrees
- **S - Switch**: Reverses pointer direction
- **T# - Total distance**: Sets current segment to specified distance
- **U - Undo**: Undo the last Extend by Distance command
- **Z - Zoom mode**: Toggles auto-zoom between on/off
- **? - Info**: Displays lengths of current polyline

**H - Help**: The Help option also displays this Extend by Distance Commands list.

**Press <Enter>**: Ends the routine
Prompts

Select line or polyline to extend: select line or polyline near the place to extend
Enter or pick distance to draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help): 50 The line is extended by 50 units.
Use the Pick option to pick a distance.

Pick/Horizontal Distance to Extend ([Enter] for new line): R Rotate right 90 degrees.

Enter or pick distance to draw (A,B,C,E,I,L,M,N,O,P,R,S,T,U,Z,?,Help): 50 The line is extended by 50 units.
Use the Pick option to pick a distance.


Extend another (<Yes>/No)? No

Note: R50 and L10 can be used to go right 50, left 10, etc.
The result of using the Help (H) option

Pulldown Menu Location: Edit > Extend
Keyboard Command: extender
Prerequisite: An existing line or polyline with at least one segment from which to start.

Break

Break by Crossing Polyline

This tool is used to break drawing geometry at the edge of a polyline boundary. It provides options to change the layers of the interior and exterior geometry after it is broken.

First, select the boundary polyline. Only one can be selected. Then select the polylines and lines to be clipped. You will be prompted for options on specifying the layers for the newly broken geometry. Respond with a "Y" if you want to specify a new layer, then enter the new layer name. If the layer name does not exist, it will be created.

Prompts

Select the clip edge polyline: pick a closed polyline
Select the polylines and lines to be clipped.
Select Objects: pick the entities to break
Specify layer names for Inside segments (Yes/<No>)? Yes
Enter a layer name for the Inside segments <0>: press Enter
Specify layer names for Outside segments (Yes/<No>)? Yes
Enter a layer name for the Outside segments <0>: Final
Break Polyline at Specified Distances

This command allows you to pick a polyline and break it at a specified distances along the polyline. Following the prompts below, the beginning of the polyline in the illustration was broken into three 55-foot segments.

Prompts

Select polyline to break: select polyline
Total Distance: 779.429 This is the length of the polyline reported.
Distance Along Polyline For Break: 55.0
Distance Along Polyline For Break (Enter to end): 110
Distance Along Polyline For Break (Enter to end): 165
Distance Along Polyline For Break (Enter to end): press Enter
3 polyline breaks created.

Break at Intersection

This command will break a line, arc or polyline at the intersection of another line, arc or polyline. In many cases this command is used in conjunction with the Area by Lines & Arcs command. In order to get the correct area of a figure, it is often necessary to break it from adjoining lines.

Prompts

Select Line, Arc, or Polyline to Break
Select object: select object to break
[int on] Pick Intersection to break at: pick intersection point
Break, Select Object, 2nd Point

This command allows you to break an object by selecting the object, then the second break point. The first break point is the point where you select the object.

Prompts
1 Select object: select entity to break
2 Specify second break point or [First point]: select second break point

Break, Select Object, Two Points

This command allows you to break an object by selecting the object, then two points. First select the object, then the program will prompt you to select two points that define where the object will be broken.

Prompts
1 Select object: select entity to break
2 Specify second break point or [First point]: First
3 Specify first break point: pick first point
4 Specify second break point: pick second point

Break, At Selected Point

This command allows you to break an object by selecting the object. Only one pick is necessary since TakeOff both selects the object and treats the selection point as the break point.

Prompts
1 Select object: select entity to break

Select an object to break

Prerequisite: None

Keyboard Command: BREAK

Chamfer By Chord Length

This command chamfers by a specified chord length. You can have a single chord or fit in a number of chords.
Before and after Chamfer By Chord Length of 25

Prompts

Select Polyline to Chamfer: pick 1st line segment
Select Adjoining Polyline Segment: pick adjoining line segment
Chord Length: 25
Number of chords <1>: press Enter

Pulldown Menu Location: Edit > Chamfer
Keyboard Command: chord_chamfer
Prerequisite: Two connected line segments

Change

Change Elevations
This command will change the elevation of selected entities. It can move the entity to a specified elevation from its current elevation (absolute) or do a differential change by adding or subtracting a value from its current elevation. If Carlson points are selected, their attribute text and z axis coordinate are changed.

Prompts

Ignore zero elevations (<Yes>/No)? press Enter If you answer No, then entities with elevation 0 will be changed.
[A]bsolute or [D]ifferential Change <A>: A
Elevation to change to: 125 By using the Absolute option all entities selected are changed to the elevation 125.
Select Entities for elevation change.
Select objects: C
First corner: pick a point
Other corner: pick a point
Select objects: press Enter

If Carlson points are selected, the command warns:
This command DOES NOT change the elevations in the Coordinate file!
Use Coordinate File Utilities menu option F to update the file.

Pulldown Menu Location: Edit > Change
Keyboard Command: chgelev
Prerequisite: Something to change

Change Attribute Style
This command will globally change the text style of attributes on the drawing. This can be very useful if all the label styles (such as the point symbol attribute labels) on a drawing must be changed to accommodate a different plotting specification. The default STYLE used for the point symbol attributes is PTXT.

Under Existing Style, select the style that is currently applied to the attributes you want to change. If you are unsure of the existing text style, select the Pick Attr button, then pick an existing attribute on the screen. When the dialog returns, the text style applied to that attribute will be selected in the list.

Select the New Style that you want to apply to the attributes.

Enter a New Height for the attributes. An entry of zero (0) will not modify the existing height.
Pulldown Menu Location: Edit > Change  
Keyboard Command: chgattr
Prerequisite: You may want to use the LIST command to check the current Text size.

**Change Style**

This command will globally change the style and height of text on the drawing. This can be very useful if all the text sizes on a drawing must be changed to accommodate a different plotting scale.

Under Existing Style, select the style that is currently applied to the text you want to change. If you are unsure of the existing text style, select the Pick TEXT button, then pick an existing text entity on the screen. When the dialog returns, the text style applied to that text entity will be selected in the list.

Select the New Style that you want to apply to the text.

Enter a New Height for the text. An entry of zero (0) will not modify the existing height.

---

**Pulldown Menu Location:** Edit > Change  
**Keyboard Command:** chgstyl
**Prerequisite:** Text entities
Change Colors

This command is designed to change the original color of existing entities in the drawing to a different color. This is done using the Change Colors dialog. You must match up the original colors of original entities to the preferred colors that they will change to. These "destination colors" are directly to the right of the original colors in the dialog (on the same row). You then click OK and select the specific entities on-screen that you want changed. This routine changes all entities in the drawing that you have chosen and that have an original color that has been changed. Do your dialog box color selections and matching up first, followed by OK. Then select the entities.

Prompts

Change Colors dialog Create your color change schemes and click OK.
Select entities to change colors.
Select objects: select entities

Pulldown Menu Location: Edit > Colors
Keyboard Command: chgcolor
Prerequisite: Entities whose colors are to be changed

Change Lineweight

This command sets the lineweight for the selected entities.

Pulldown Menu Location: Edit > Change
Keyboard Command: chglwt
Prerequisite: Entities
Change Block/Inserts Rotate

This is a command to set the angle of blocks by various methods. This command optionally can change the rotation of a block by twist screen angle, azimuth, entity segment or by follow polyline. It will work with Carlson point symbol blocks, or any block. For example, you may receive a drawing from another firm, insert it in, and then want to change the rotation.

Prompts

Twist by [Twist screen>/Azimuth/Entity segment/Follow polyline]? press Enter
Enter angle relative to current twist screen <0.0>: 30
Select Symbols to Rotate. pick symbol
Select objects: 1 found

Pulldown Menu Location: Edit > Change > Block/Inserts
Keyboard Command: TWISTSYM
Prerequisite: None

Change Block/Inserts Substitute

This command is used to replace selected block(s) with a different block. The command optionally can change the size and rotation angle. This command will work with Carlson point symbol blocks, or any block. For example, you may receive a drawing from another firm and want to replace certain inserts with inserts of your own specification. In the dialog shown, we are replacing the block named NASTAR with a block named COHNORTH, which will be inserted at 50 scale and zero rotation.

**Existing Block:** Select the block name to be replaced. If the block name is unknown, choose the Select from Screen button, then select the block from the current drawing.

**Replace With:** Select the block that will replace the existing block. You may choose from the list of defined blocks, select an existing block from the current drawing, choose a point symbol from the standard Carlson point library, or select a drawing file.

**Retain Size and Rotation:** When checked, the new block will retain the size and rotation values from the old block.

**New Size:** Available if Retain Size and Rotation is not checked. Enter the size for the new block.
New Rotation Angle: Available if Retain Size and Rotation is not checked. Enter the rotation angle for the new block.

Pull Down Menu Location: Edit > Change > Block/Inserts
Keyboard Command: chgblk
Prerequisite: None

Change Block/Inserts Resize
This command resizes blocks inserts while maintaining their insertion position. When prompted to select objects, choose the inserts to resize. Note that this routine does not rescale attributes that may be associated with the selected inserts.

Prompts

Scaling Multiplier <0.5>: Enter the size scale factor.
Select symbols and blocks to scale.
Select objects: select entities

Pull Down Menu Location: Edit > Change > Block/Inserts
Keyboard Command: sizeblk
Prerequisite: block/inserts in drawing

Rotate

Pivot Point Rotate by Bearing
This command allows you to rotate the selected entities from the drawing. The rotation angle is defined by the difference between a reference line and an entered bearing or azimuth. The reference line is defined by two points that can be picked on the screen or entered by point number.

Prompts

Select entities to rotate.
Select objects: select the entities
Base pivot point ?
Pick point or point number: 2 The program then reads the coordinate value for pt#2 from the current CRD file.
Reference Bearing point ?
Pick point or point number: pick a point
Reference Bearing N 44d31'1" E The program then displays the reference bearing defined by the two points selected.
Azimuth/<Bearing (Qdd.mmss)>; 245.3030 Enter an A to input an Azimuth or enter the bearing. The above response is a bearing of South 45 degrees, 30 minutes, and 30 seconds East. The program then rotates the database to the new bearing.
Update viewports [Yes/<No>]? press Enter. This option rotates all the viewports in all the layouts of the drawing.

If Carlson Points are selected the program warns:
This command DOES NOT change the coordinates in the CooRDinate file!
Use CooRDinate File Utilities menu, Update CRD from Drawing.
This warning applies if the points entities are not linked to the CRD file. This link option is set in the Configure command.
Entity Insertion Point Rotate

This command allows you to rotate the selected entities where the rotation pivot point for each entity is the insertion point of the entity. The rotation angle will follow one of the following alignments: Twist screen, Azimuth, Entity Segment, Follow or Pick. This routine processes TEXT, MTEXT and INSERT entities only.

Prompts

Rotate by [<Twist screen>/Azimuth/Entity segment/Follow/Pick]? F
Select polyline to follow: pick a polyline
Select Entities to Rotate.
Select objects: pick entities to rotate
Flip text for twist screen [Yes/<No>]? Y
Rotating ....

Rotate by Pick

This command allows you to move objects about a base point using a point as a rotation reference.

Prompts

1 Select objects: pick entities
2 Specify base point: pick point on screen as reference
3 Specify rotation angle or [Reference]: rotate to desired location
Prerequisite: None
Keyboard Command: ROTATE

Scale

Scale Wizard

This command will scale selected entities using a specified scale factor and base point. This 2D Scale method differs from the 3D Scale method in that it only scales the entities in the x,y coordinates and does not change the elevations of the entities. A case for using 2D Scale is when the x,y coordinates are in architectural units of inches and the elevation is in feet and you want to convert the x,y coordinates to feet. When the entities are at zero elevation, then 2D Scale makes no difference and it is better to use 3D Scale because it is faster.
In the dialog shown here, you have the ability to determine what is scaled: the entire drawing or a selection set. If you choose Select Objects, you will be prompted to select the entities to scale after clicking the OK button. The Base Point acts as the center of the scaling operation and remains stationary. The base point you specify identifies the point that remains in the same location as the selected objects change size.

There are two methods for scaling entities: by Units Conversion or by a Customized Scale Factor. The dialog above shows one application of this routine, converting a drawing from architectural (Inches) to decimal units (US Feet) when the architectural units have the drawing x,y coordinates in inches and the elevations in feet. In this case, 2D Scale can be used to apply a 1/12 scale factor (0.08333333) to convert the inches to feet for the x,y coordinates and leave the elevations unchanged.

If the scale you want to apply is not a standard conversion, a manual scale can be entered by checking on the Use Customized Scale Factor checkbox. A scale factor greater than 1 enlarges the object. A scale factor between 0 and 1 shrinks the object.

To scale a drawing by a known distance on the plan (which is often the case when working with PDF imports) select the Screen Pick button. This will prompt you to pick the beginning and ending points along a known distance (like the bar scale above). The program will then report the current distance of the segment (in this example 40.073) and allow you to enter in the desired distance (which is 40 in this case).

The program will then calculate the proper Scale Factor to apply to the selection set.
Select entities to scale.
FILter/<Select entities>: Select the entities whose size should change and press Enter to complete the selection process.

Pulldown Menu Location(s): Edit > Scale
Keyboard Command: sscscale
Prerequisite: None

**Standard Scale**
This command allows you to enlarge or reduce selected objects equally in the X, Y, and Z directions.

**Prompts**
1 Select objects: pick entities
2 Specify base point: pick point on screen as reference
3 Specify scale factor or [Reference]: scale to desired size
Prerequisite: None
Keyboard Command: SC

**Text**

**Edit Text**
This command allows you to edit text and attribute labels.
1 Select Text to Edit: select the text
You can modify text in provided text field.
Prerequisite: Text
Keyboard Command: EDITXT

**Text Enlarge/Reduce**
This command will scale text entities up or down in size. The routine prompts for a scale multiplier and a selection set of text objects. If you want to enlarge the text enter a value greater than one. If you want to reduce text enter a decimal fraction such as .5. This would reduce the text size by 50%. This command is very useful if you have set up
your drawing for one plotting scale and decide to change to a new plotting scale. The Change Text Size command can alternatively be used to set the text size to a specific value.

**Pulldown Menu Location:** Edit > Text  
**Prerequisite:** Text entities to be changed  
**Keyboard Command:** txtenl

---

**Rotate Text**

This command sets the rotation of the selected text to the current twist screen, an entered azimuth, or to align with a line or polyline. The text keeps the same insertion point and justification. The Twist Screen option sets the text rotation to align horizontal with the current twist screen. With the Azimuth option you can enter the angle or pick two points to define the text rotation. The Entity segment aligns the text with a selected line or polyline segment. The Follow option aligns the text with the closest polyline segment.

**Prompts**

Rotate by (<Twist Screen>/Azimuth/Entity segment/Follow/Pick)? press Enter  
Enter angle relative to current twist screen <0.0>: 23  
Select Text to rotate.  
Select objects: *select the text*

---

**Move Text**

This command moves existing text entities by sliding at the text angle or perpendicular. This sliding method is equivalent to setting the crosshairs to the text angle and then moving with ORTHO on.

**Prompts**

Select Text to slide:  
Select objects: *pick text entities*  
Pick starting point for slide: *pick a point to begin sliding and then pick a second point for the new location*

---

**Move Text with Leader**

This command moves an existing text entity and creates a leader from a picked point to the new text location. The routine keeps track of the original text location and has an option to restore the text to the original without the leader. To use the Restore function, type R at the Command prompt. Also, to access the options for this command, type O for Options at the Command prompt.

**Prompts**

Select Label to Move (O for Options,R for Restore): *pick any text entity*  
Pick start point for leader: *pick the point where to draw the leader arrowhead*
Pick end point for move: pick the end of the leader where to move the text
Select Label to Move (O for Options, R for Restore): O

![Move Text With Leader Options dialog]

When Options is chosen the "Move Text With Leader Options" dialog allows the user to customize the leader and label drawing settings:

**Use MLeader:** This option uses an MLeader for a combined label and leader. Otherwise a standard Leader entity is drawn with separate label.

**Minimum Leader Length Scaler:** If the distance of the move is less than this value, a leader will not be drawn.

**Draw Horizontal Leader Tick:** When checked, a horizontal leader tick will be drawn from the end of the leader towards the annotation.

**Draw Arrowhead:** Controls whether to draw an arrowhead at the end of the leader.

**Curved Leader:** Chooses between making a straight line or curved leader.

**Draw Box Around Text:** Creates a box around the text.

**Minimum Length for Arrow Scaler:** When the leader length is more than this amount, the arrowhead is drawn.

**Arrow Size Scaler:** Sets the size for the arrowhead.

**Leader Offset Scaler:** This is used to set the distance from the end of the leader and the annotation.

**Leader Layer:** The Use Separate Layer method places the leader on the specified layer from the dialog. The Use Current Layer method places the leader on the current drawing layer. The Use Text Layer method uses the label layer for the leader layer.

**Keep Label Alignment:** This option keeps the original text angle. Otherwise the leadered text is orientated horizontally to the current twist screen.

**Move Multiple Labels:** Use this option to select multiple text entities as a group for moving.

**NOTE:** The leader scaler units (Arrow Size Scaler, Minimum Length for Arrow Scaler, Minimum Leader Length Scaler and Leader Offset Scaler) are multiplied by the current horizontal scale value which is set under Drawings Setup.

Select Label to Move (O for Options, R for Restore): R

Select Label to Restore: pick a text that had been moved with the "Move with Leader" command previously. The selected label will be restored to its previous state.

Pulldown Menu Location: Edit > Text
Keyboard Command: movetext
Prerequisite: Text entity to move.
Move Attributes with Leader

This command allows you to move block attributes and to draw a dynamic leader to block insertion point. Leaders and arrowheads may be customized by selecting Options at the command line. The attributes are always justified left or right depending on which side the leader starts. The Restore option prompts to select a moved attribute label and then puts that block attribute back to the default position.

The Options dialog has these settings.

Minimum Leader Length Scaler: Specifies the minimum length, in terms of multiples of the attribute block's height, that the leader must be.

Prompt for Curved Leader Points: This option prompts for additional leader points and creates a smooth leader that goes through all the leader points.

Draw Horizontal Leader Tick: Specifies whether or not to draw a terminating tick (a short horizontal line segment sometimes referred to as a "hook line").

Draw Arrowhead: Specifies whether or not to draw an arrowhead at the end of the leader that points to the point entity.

Minimum Leader for Arrow Scaler: Specifies the minimum length of the leader, in terms of multiples of the attribute block's height, that the leader must be before an arrowhead is placed on it.

Arrow Size Scaler: A scale factor to apply to resize the arrowhead symbol.

Leader Offset Scaler: A distance indicating the desired offset from the point node to the tip of the leader.

Use Separate Leader Layer: Specifies whether or not to use a layer other than that of the identified point for the leader. Use the Select button to choose an alternative layer for the leader.

Prompts

Select Label to Move [Options/Restore]: select block attribute
Pick label position: pick point
Select Label to Move [Options/Restore]: press Enter to end

Pulldown Menu Location: Edit > Text
Keyboard Command: moveattrleader
Prerequisite: Block with attributes

Change Text Font

This command can change multiple text entities to a user specified style. The routine prompts for a selection set of TEXT and/or MTEXT objects. Once the selection is made, the Select Style dialog appears. You can then select a text Style Name, such as MONO or ROMANS, that you would like to change to. Click OK. To the right on Style Name, you can enter a style name that does not exist. If you do, it will be created for you using the font with the same name.
Change Text Size

This command will change the size of the selected text objects to the user specified size. The Text Enlarge/Reduce command also changes text size. The difference is that this routine sets the text to an absolute size whereas Text Enlarge/Reduce scales, or relatively changes, the text size.

Prompts

Select the text to size.
Select objects: select the text
Enter new text size: enter value

Change Text Width

This command changes the width of the selected text entities, after a new width factor is entered. The insertion point of each text entity is maintained as the routine lengthens or shortens the text.

Iron Pin
Iron Pin
Iron Pin

Text width = 1

Iron Pin
Iron Pin

Text width = 0.75

Iron Pin
Iron Pin

Text width = 1.5

Effect of different width factors on the same text line
Prompts

Select the text to change.
Select objects: select text entities
Enter new width factor <1.0>: enter new width factor

Pulldown Menu Location: Edit > Text
Keyboard Command: chgtxtwidth
Prerequisite: Text entities to be changed

Change Text Oblique Angle

This command allows you to change the text oblique angle on existing text in the drawing. The oblique angle for a specific text style is defined during the creation of the style. The default value for the oblique angle for text styles is 0 until defined to another value by the user. When changing the oblique angle, a minus (-) sign in front of the angle indicates a backward slant and a positive value results in a forward slant. Remember that the reference base point for the oblique change is always 0 degree. This means that if an existing text string has an oblique angle of 20, changing the oblique angle to 25 will not add 25 degrees to the existing 20 degree oblique resulting in a text oblique angle of 45 degrees, but rather a 25 degree oblique will be established by referencing 0 oblique as the base, and then slanting the text to 25 degrees. This works the same for slanting text backward as well as forward. Below is an example showing original text created with the default oblique angle of zero, then changed to a backward slant of 20 and a forward slant of 25 degrees.

Prompts

Select the text to change.
Select objects: Select text to change oblique angle on. Note that one or more text strings can be selected. When all desired text has been selected, press Enter.
Enter new oblique angle <0.0>: Enter the desired oblique angle.

Convert Text To MText

This command converts regular text entities (DTEXT) into multi-line text entities (MTEXT). There are two processing methods. The Individual method converts each selected text entity into a separate MText entity. The Group method combines all the selected text entities into a single MText entity. The Group method applies to text entities that belong together such as text lines for a paragraph of text.

Prompts
Fix Text Overlaps

This command allows you to fix text overlaps for where different text overlap each other or where text crosses linework entities. You can either have the program automatically fix overlaps by using rules or just find the overlaps and step-through them to review and fix with CAD edits as needed.

In the options dialog, you can choose which rules to try for fixing the overlaps. The rules are applied in the order of the Used Methods list. If using a rule doesn't clear the text from overlaps, then the program tries the next rule.

The Slide rule moves the text parallel to text angle. The labels will not move past the Max Slide amount.

The Offset rule moves the text perpendicular to text angle. The labels will not move past the Max Offset amount.

The Avoid Linework Conflicts option checks for text overlaps with linework entities. Otherwise only overlaps with other text entities are checked.

The Overlap Manager can be used to manually check and change label overlaps that aren't solved by the automatic rules. With the View Remaining Overlaps After Applying Rules option, any remaining overlaps will show in the Overlap Manager. Use the Back and Next buttons to step through each text conflict. The Auto-Zoom option zooms the dwg to show the current overlap. The Skip Resolved option shows only the unresolved conflicts. The Status option shows whether a conflict is resolved and lets you change the status. The Slide function moves text along the text angle. The Move function does an unrestricted move of the text. The Move With Leader function moves the text and creates a leader between the original and new locations. The Offset functions move the text perpendicular to the text angle.
When **View Last Overlap File** is checked, the Overlap Manager will return to the previous labels that were under review.

When **Skip Resolved Overlaps** is unchecked, the Overlap Manager will display all the labels that were moved by the command as a final check for you.

**Restore Original Zoom** will restore the zoom you were previously at before running the command.

![Overlap Manager](image)

**Prompts**

**Avoid Label Overlap dialog**
Select Labels for which to resolve annotation conflicts:
Select objects: *select entities*

**Pulldown Menu Location:** Edit > Text  
**Keyboard Command:** textconf  
**Prerequisite:** Text entities

**Flip Text**
This command will change the alignment of text entities by 180 degrees.

**Pulldown Menu Location:** Edit > Text  
**Keyboard Command:** fliptext  
**Prerequisite:** Text entities to be changed

**Flip Text By Twist Screen**
This command will change the alignment of text entities by 180 degrees for any selected text that are upside-down relative to the current drawing twist screen (dview twist).

**Prompts**
Split Text into Two Lines

This tool allows you to break a single line of TEXT into two separate lines. First, select the text string you would like to break. The Text Break dialog then appears. Initially, the slider is all the way to the right. Begin dragging it toward the left until it reaches the point where the split is at the desired position. Then choose OK to complete the break operation.

![Text Break dialog]

Text Explode To Polylines

This command converts the selected text into polylines. This function is generally used when preparing a plan view file for machine control, before using the Write Polyline File command.

Prompts

Select text to be EXPLODED.
Select objects: select the text
Substitute With Simple Font [<Yes>/No]? Y
1 text object(s) have been exploded to lines.
The line objects have been placed on layer 0.
Reading the selection set ...
Joining ...
Converting ...

Text Capitalization

This command sets the capitalization for the selected text. There are three options. The Proper method capitalizes the first character. The Upper method makes all the characters upper case. The Lower method makes all the
Prompts

Set capitalization to [<Proper>/Upper/Lower]? press Enter
Select text to process.
Select objects: pick text to set

Pulldown Menu Location: Edit > Text
Keyboard Command: txtcaps
Prerequisite: Text Entities

Text Math
This command updates number labels by a math operation. After selecting the text to update, choose to add, subtract, multiply or divide, and then enter the amount.

Prompts

Select text entities.
Select objects: pick the number labels
Enter the operator (+ - * /): +
Enter a real number: 100
Enter number of decimals: 1

Pulldown Menu Location: Edit > Text
Keyboard Command: txtmath
Prerequisite: Text with numbers

Add Prefix/Suffix To Text
This command simply adds a prefix and/or suffix to the selected text entities. The strings to add are specified in a dialog. Then you select the text entities to update.

Prompts

Add Prefix/Suffix To Text dialog
Select text to process.
Select objects: pick the text entities
Pulldown Menu Location: Edit > Text
Prerequisite: Text entities to be changed
Keyboard Command: txtwrap

Remove Spaces From Text
This command removes leading and/or trailing spaces from the selected text entities.

Prompts

Trim all spaces from text on [Right/Left/<Both>]: press Enter
Select text to process.
Select objects: pick the text entities to process
Trimmed spaces from 1 text entities.

Pulldown Menu Location: Edit > Text
Keyboard Command: txtrmspace
Prerequisite: Text entities

Line Up Text
This command lines up the selected text entities along either a horizontal or vertical line position, or following a polyline.

Before and after Line Up Text

Prompts

Line up text on [Horizontal/<Vertical>/Polyline]: press Enter for Vertical
Pick vertical position: pick a point
Select text to process.
Select objects: select the text to process

Pulldown Menu Location: Edit > Text
Keyboard Command: txtlineup
Prerequisite: Text

Join Text Entities
This command combines two text entities by appending the second text to the first. The Words join method puts a space between each text. The Letter join method appends without a space.

Prompts

Select first text line: pick a text entity
Select text to add to first text line: pick a text entity
Join type as [Words/<Letters>]: press Enter
Replace Text

This command will replace one text string with another. For example, if the text LEGEL is on a drawing, you could use this command to replace it with LEGAL. This command has a couple method. The Copy method prompts to select an existing text label to copy and then select the text entities to replace with this copy. The Type method prompts for the old string to replace and the new string.

There is also the CAD command Find and Replace Text (FIND) includes more options, including replacing partial strings and searching attributes and MTEXT.

Prompts

Type in replacement string or copy another text label [<Type>/Copy]? press Enter
Select Text to Change
Select objects: pick text
Old string: LEGEL
New string: LEGAL
Replace all or prompt [All/<Prompt>]? All

Table

Consolidate Table

This command renumbers the first column of a table to remove any gaps in the numbering. For example, a table with rows labeled 1,3,4 would get renumbered to 1,2,3.

Prompts

Select Table to consolidate: pick table entity
Align

2D Align

This command will align (translate, rotate and scale) the selected objects using two pairs of source and destination control points. The difference between the first source point and first destination point determines the translation amount. The difference between the angle and distance from the first and second source points compared to the angle and distance from the first and second destination points determines the rotation and scale. The scale part of the alignment is optional. This 2D Align function is the same as the standard Align function except that this 2D Align function does not use elevations so that the alignment is always in 2D. The control points can be screen picked or entered by point numbers.

Prompts

Select entities to align.
Select objects: pick entities to process
First Source Point?
Pick point or point number: pick point 84
First Destination Point?
Pick point or point number: pick point 18
Second Source Point?
Pick point or point number: pick point 85
Second Destination Point?
**Pick point or point number:** pick point 19  
**Scale factor:** 1.00434258  
**Scale objects based on alignment points [Yes/No]?** Y  
This command DOES NOT change the coordinates in the CooRDinate file!  
Use Coordinate File Utilities menu, Update CRD File from Drawing.

**Pulldown Menu Location:** Edit > Align  
**Keyboard Command:** scalign  
**Prerequisite:** None

### Standard Align

Aligns objects with other objects in 2D and 3D

You use ALIGN to move, rotate, or scale objects into alignment with other objects. Add source points to the objects you want to align, and add destination points to the objects to which you want the source objects to align. You can add up to three pairs of source and destination points to align an object.

The first set of source and destination points defines the base point for the alignment. The second set of points defines the angle of rotation.

When you select three point pairs, you can move and rotate the selected objects in 3D to align with other objects.

If you use two source and destination points to perform a 3D alignment on nonperpendicular working planes, you get unpredictable results.

After you enter the points, Takeoff prompts you to scale the object. The program uses the distance between the first and second destination points as the reference length to which the object is scaled. Scaling is available only when you are aligning objects using two point pairs.

**Prompts**

1. Specify first source point: **pick point**
2. Specify first destination point: **pick point**
3. Specify second source point: **pick point**
4. Specify second destination point: **pick point**
5. Specify third source point or <continue>: **Press Enter**
6. Scale objects based on alignment points? [Yes/No] <N>: **Press Enter**

**Prerequisite:** None  
**Keyboard Command:** ALIGN

### Mirror

This command allows you to create a mirror image copy of objects. The two specified points become the endpoints of a line about which the selected objects are reflected. In 3D, this line orients a mirroring plane perpendicular to the XY plane of the user coordinate system (UCS) containing the mirror line.

**Prompts**

1. Select Objects: select objects to be mirrored  
2. Specify first point of mirror line: **pick point**  
3. Specify second point of mirror line: **pick point**  
4. Delete source objects? [Yes/No] <N>: **Press Enter**
Fillet

This command allows you to round and fillet the edges of objects. You can enter a radius for rounding (default radius is 0). You can also trim an object that extends beyond the intersection.

FILLET rounds or fillets the edges of two arcs, circles, elliptical arcs, lines, polylines, rays, splines, or xlines with an arc of a specified radius. FILLET trims the intersecting lines to the endpoints of the fillet arc. If the selected lines do not intersect, Carlson Survey extends or trims them so that they do. FILLET also rounds or fillets the edges of 3D solids.

If both objects you want to fillet are on the same layer, the program creates the fillet line on that layer. Otherwise, the program creates the fillet line on the current layer. The same is true for the fillet color, lineweight, and linetype.

You can fillet line segments of a polyline that are adjacent, nonadjacent, intersecting, or separated by one segment. If they are nonadjacent, the polyline segments are extended to accommodate the fillet. If they are intersecting, the polyline segments are trimmed to accommodate the fillet. To create a fillet, the polyline segments must converge within the drawing limits when limits checking is on.

The result is a single polyline that includes the fillet as an arc segment. All the properties of this new polyline, such as its layer, color, and linetype, are inherited from the first polyline selected.

Filleting an associative hatch whose boundary is defined by lines removes hatch associativity. Carlson Survey maintains associativity when the boundary is a polyline.

Prompts
1 Select first object or [Polyline/Radius/Trim]: select entity
2 Select second object: select entity

Properties Manager

Carlson Survey displays the Properties window. The Properties window is the main method for viewing and modifying properties of AutoCAD objects.

There are some general properties common to all objects. These include Color, Layer, Linetype, Linetype Scale, Plot Style, Plot Style Table, Lineweight, and Thickness. All other object properties are specific to the type of entity. In the example below, a line has been selected. In addition to the properties mentioned above, you may modify the X, Y, and Z coordinate for each endpoint. Notice that you may not directly modify the delta, length or angle. These are read-only properties. Obviously, modifying either end point will cause these values to change.
The Properties window can be docked in the drawing area. Right-click the Properties window and choose Allow Docking or Hide to undock or hide it.

You can enter commands and work in Carlson Survey while the Properties window is open.

When you select an object in the drawing area, the Properties window displays the properties of that object. If you select multiple objects, the Properties window displays all the properties they have in common.

Object properties are displayed either alphabetically or by category, depending on the tab you choose. To modify properties using the Properties window select the object whose properties you want to change and use one of the following methods:

- Enter a new value
- Select a value from a list
- Change the property value in a dialog box
- Use the Pick Point button to change a coordinate value

The Select Objects button in the Properties window provides access to the full complement of selection methods, such as Fence and Crossing Polygon, from the Command prompt. You choose Select Objects, select the desired objects using any selection method, and press ENTER. The properties common to the selected objects are displayed in the Properties window. You can then modify the properties of the selected objects in the Properties window or you can make other changes to the selected objects by entering an editing command.

In the next example, 3 circles have been selected. Each circle has a different radius, color and linetype. Notice that these three fields do not show a default value. Remember, when multiple objects are selected, only their common properties are shown.
This last illustration shows how the properties window can be docked inside the main application window.

Menu Location: None
Prerequisite: None
Keyboard Command: Properties
Polyline Utilities

Entities to Polylines
This command converts selected lines, arcs, circles, 3DFaces, ellipses, splines, multilines, regions and solids into individual polylines. Use Join Nearest to convert adjoining lines and arcs into continuous polylines.

Prompts

Select lines, arcs, circles, 3DFaces, ellipses, splines, multilines, regions and solids to convert.
Select objects: select entities
Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: topline
Prerequisite: lines, arcs or other entities to convert

Reverse Polyline
This command reverses the order of the line and/or arc segments of a POLYLINE. This can be useful in conjunction with the commands Station Polyline, MXS by Polyline, Profile from Surface Model or CL File from Polyline, since the polyline must be plotted in the direction of increasing stations. If it is more convenient to draft a polyline in one direction do so and then use the Reverse Polyline command to change its order. Temporary arrows along the polyline are drawn to graphically show the new polyline direction.

Prompts

Select the Polyline to Reverse: pick a point on polyline
Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: revpline
Prerequisite: A polyline

Reduce Polyline Vertices
This command removes points from a polyline, without significantly changing the polyline. The offset cutoff is the maximum amount that the polyline can move horizontally and vertically when removing a point. For example, in a polyline with three points in a straight line, the middle point can be removed without changing the polyline.

Prompts

Enter the offset cutoff <0.1>: .5
Select polylines to reduce.
Select objects: pick polylines
Processed polylines: 1
Total number of vertices: 10
Number of vertices removed: 1
Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: reduce
Prerequisite: A polyline
Densify Polyline Vertices
This command adds vertices to the selected polylines at the specified interval. These points are interpolated between existing points in the polyline. This command is the opposite of Reduce Polyline Vertices.

Prompts
Select polylines to densify.
Select objects: select polylines
Point interval <10.0>: press Enter
Testing Entity> 1
Added 17 points to 1 polyline.
Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: densepl
Prerequisite: A polyline

Smooth Polyline
This command smooths the selected polylines using a modified Bezier method that makes the smooth polyline pass through all the original points and only smooths between the original points. Either the entire polyline can be smoothed or only a section of the polyline. When using Polyline Section, the program will prompt for points along the polyline to start and end the smoothing. The Looping Level controls smoothing amount. A higher factor gives more looping. The Offset Cutoff (After Smooth) is used to reduce the number of vertices in the final polylines. To not reduce vertices, set this Offset Cutoff to zero. The Offset Cutoff is the maximum amount that the polyline can move horizontally when removing a point. The Reduce Polylines Before Smoothing option removes extra vertices from the contours before smoothing. Removing points before smoothing gives the Bezier smoothing more freedom to make the polylines curvy.
Prompts

Smooth Polylines dialog
Select polylines to smooth.
Select objects: pick polylines
Smoothed 1 PolyLines
Total original vertices: 9 Total final vertices: 50

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: smoothpl
Prerequisite: A polyline

Join Polyline By Trace
This command combines linework entities to create a polyline. This command is similar to Join Nearest. The difference is that this command processes a single polyline at a time instead of a selection set of polylines. This command prompts for a linework entity to start joining from. Then the program looks in the drawing at other linework to join to this polyline using the filter options from the dialog. All the options in the dialog are the same as Join Nearest except the Prompt For Linework To Join option which prompts for other linework to join to the polyline once the program has finished tracing. See the Join Nearest section of the manual for descriptions of the other options.

Prompts

Join Polyline By Trace dialog
Select line, arc or polyline to join: pick an entity
Select entity to join to start (Enter for none): press Enter
Select entity to join to end (Enter for none): press Enter

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: joinpoly
Prerequisite: Linework to join

Join Two Polylines
This command combines two linework entities to create a polyline. This command is simple variation of the Join Nearest command. The difference is that there is no options dialog and only two linework entities are processed. The linework entities can be polylines, lines or arcs. At the first entity prompt, you can enter Options to set the connection method for how to bridge a gap between the linework. The Direct method creates a segment across the gap. The Average method averages the endpoints into a single vertex. The Fillet method does a fillet with radius of zero.

Prompts

Select 1st entity to join [Options]: pick polyline
Select 2nd entity to join: pick polyline

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: join2
Prerequisite: Linework to join
Merge Closed Polylines

This command combines two closed polylines that share a common boundary to create a single closed polyline. For example, this command can be used to merge a polyline for a lot that is too small with a polyline for a neighboring lot. There are two methods for merging. One method is to pick the two polylines to merge. The other method takes an area size and selection set of polylines and merges all the polylines with an area smaller than the specified amount.

Before and after Merge Closed Polylines

Prompts

Select polylines by individual pick or size filter [Pick>/Size]? press Enter
Pick 1st closed polyline to merge: pick a polyline
Pick 2nd closed polyline to merge: pick a polyline
Done.
Pick 1st closed polyline to merge (Enter to end): press Enter

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: mergepl
Prerequisite: two polylines to offset

Draw Polyline Start/End

This command simply draws symbols at the start and end vertices of a polyline to give a visual indication of the polyline direction. The routine starts with a dialog to select the different symbols for the start and end, and to select the layer and size for the symbols. Then you select the polylines and the program draws the symbols.

Prompts
Polyline Start/End Settings dialog
Select polylines.
Select objects: select polyline(s)

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: plends
Prerequisite: A polyline

Edit Polyline

Add Intersection Points
This command adds points into lines or polylines where there are intersections. This can be useful for other commands such as Auto-Annotate. For example in the drawing shown, Add Intersection Points adds points to the boundary polyline where the lot lines intersect. Then Auto Annotate for the boundary polyline will label the boundary distance along each lot. This routine does not add intersection points on arcs.

Prompts

Select lines and polylines to check.
Select objects: pick lines or polylines
Reading the selection set ...
Adding intersection points ...
Added 3 intersection points.

Pulldown Menu Location: Edit > Polyline Utilities > Edit Polyline
Keyboard Command: addint
Prerequisite: Polylines or lines
Add Polyline Vertex

This command adds points into a polyline. First you select the polyline to modify. The existing polyline vertices are marked and then you can pick or enter the coordinates for the new point(s). A new point is inserted into the polyline at the nearest polyline segment. On a 3D polyline, the elevation of the new vertex will be calculated for you. You can continue to pick points to add. Press Enter when you are done.

Prompts

Select polyline to add to: pick a polyline
Pick or enter point to add: pick a point
Select polyline to add to: press Enter to end

Pulldown Menu Location: Edit > Polyline Utilities > Edit Polyline
Keyboard Command: addpl
Prerequisite: A polyline

Add Polyline Arcs

This command replaces a series of short chord line segments in a polyline with an arc segment. This applies where you want to have a true arc instead of a series of line segments. In some cases, the CAD drafting has the arcs drawn as a series of short chords. Another application is to create an arc out of a series of connected survey points along the curve. The routine works by searching for a series of polyline vertices that fit within the specified tolerance with a best fit curve.

The options dialog allows you to set the layer for the new polylines. Otherwise the original polyline layer is used. There is an option whether to keep or erase the original polylines. The Snap Tolerance is the maximum offset allowed between the original points and the arc.

Prompts

Add Arcs to Polylines dialog
Select polylines to process.
Select entities: pick the polylines

Pulldown Menu Location: Edit > Polyline Utilities > Edit Polyline
Keyboard Command: addplarc
Prerequisite: polyline
**Edit Polyline Vertex**

This tool allows you to make changes in the coordinates of vertices on all polyline types. Upon execution, you will be asked to select a polyline to edit. Upon selection, a temporary marker will be placed at all of the vertices of the polyline, making them easy to distinguish. You must then pick near the vertex you wish to edit. The following dialog appears.

At the top of the dialog it identifies the type of polyline as being 2D or 3D. In the case of 2D polylines, it allows you convert the polyline. You have the ability to type in new northing, easting or elevation values. You can also determine the 3D coordinate position by using distances and slope to/from adjacent points. As you change the values in the dialog, new values for derivatives are being calculated. For example, if you change the horizontal distances, the coordinates will change.

![Edit Polyline Vertex dialog](image)

**Prompts**

Select polyline to edit: *pick a polyline*
Pick point on polyline to edit: *pick a point to be modified*
Edit Polyline Vertex dialog click "Pick Position"
Pick vertex position: *pick a new location for the vertex*
Edit Polyline Vertex dialog click OK

Make changes as needed. You will see the polyline vertices relocated based upon the new picked positions and coordinate changes. Use Previous and Next to move along the polyline. Note the dialog values changing.

Select polyline to edit (Enter to end): *press Enter to end*

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: editpl
Prerequisite: A polyline
**Edit Polyline Section**

This command revises a segment of a polyline. Begin by picking a point on the polyline where you want to start editing. Then pick new points for the polyline. When finished picking new points press Enter, and then pick a point on the polyline to connect with the new points. The polyline segment between the start and end points is then replaced with the new points.

**Prompts**

*Select polyline to edit:* pick the polyline at the place to start editing
*Pick intermediate point (Enter to End):* pick a point
*Pick intermediate point ('U' to Undo, Enter to End):* pick a point
*Pick intermediate point ('U' to Undo, Enter to End):* press Enter
*Pick reconnection point on polyline:* pick the polyline at the place to join

![Edit this contour by picking new points](image1)

![Contour with segment replaced with new points](image2)

**Pulldown Menu Location:** Edit > Polyline Utilities > Edit Polyline
**Keyboard Command:** editpl2
**Prerequisite:** Polylines

---

**Change Polyline Elevation**

This command changes the elevations of polylines and can be used to set the elevations of contour polylines. The routine begins at a specified elevation and prompts for a selection set of polylines to set to the elevation. Then the routine repeats using the last elevation plus the elevation increment. Enter an empty selection set to exit the routine.

**Prompts**

*Starting elevation* <0.0>: 500.0
*Contour interval (negative for down)* <1.0>: 5.0
*Select polylines to set to elevation* 500.0.
Select objects: *pick the polylines*
Select polylines to set to elevation 505.0.
Select objects: *pick the polylines*
Select polylines to set to elevation 510.0.
Select objects: Press Enter

**Keyboard Command:** setcelev

**Prerequisite:** polylines

---

**Change Polyline Width**

This command sets the width of the selected polylines. In later versions of AutoCAD, the command `PEDIT` can also modify the width of multiple polylines.

**Prompts**

New width `<1.0>`: 2
Select Polylines/Contours to change width of:
Select objects: *pick polylines*

**Pulldown Menu Location:** Edit > Polyline Utilities > Edit Polyline
**Keyboard Command:** cwidth

**Prerequisite:** A polyline

---

**Set Polyline Origin**

This command sets the starting vertex of a closed polyline. Simply pick the polyline and then pick near the point to set as the starting point.

**Prompts**

Select Polyline: *pick a polyline*
Pick Near New Origin Point: *pick a point on the polyline to be the starting point*
Processing ...
Select Polyline: Press Enter

**Pulldown Menu Location:** Edit > Polyline Utilities > Edit Polyline
**Keyboard Command:** plchgorg

**Prerequisite:** A closed polyline

---

**Make Arcs Tangential**

This command adjusts polylines to make arcs tangential. The program holds the tangents and adjusts the radius as needed.

**Prompts**

Select polylines to process.
Select objects: *pick polylines*

**Pulldown Menu Location:** Edit > Polyline Utilities
**Keyboard Command:** tang.pl
**Prerequisite:** Polylines with arcs
Close Polylines
This command allows you to close a selection set of open polylines.
**Prerequisite:** Open polyline(s).
**Keyboard Command:** CLOSEPL

Open Polylines
This command allows you to open a selection set of closed polylines.
**Prerequisite:** Closed polyline(s).
**Keyboard Command:** OPENPL

Remove Polyline

Remove Duplicate Polylines
This command analyzes the selected polylines and erases any duplicate polylines found. They must be exactly the same for one to be deleted.

**Prompts**

*Select lines, arcs and polylines to process.*
*Select objects: select linework to process*
*Reading the selection set ...*
*Removed 1 duplicate linework entities.*

**Pulldown Menu Location:** Edit > Polyline Utilities > Remove Polyline
**Keyboard Command:** rmduplwork
**Prerequisite:** Polylines that have duplicates

Remove Polyline Arcs
This command replaces arc segments in polylines with a series of chords. Removing arcs is a prerequisite to some Carlson commands that don't handle arcs, such as *Break by Closed Polyline* and *Make 3D Grid File*. This process can add many vertices to the polyline. There are three methods to control the size of the chords and how many vertices are created. The Offset cutoff sets the maximum distance any point on the arc will be allowed to shift from the true arc to the chord position. The Length method sets the chord length. With the Length method, you can choose to create the chords entirely on the left or right side. Without setting the side, the program puts the chords on the inside of the arcs. The Count method sets how many chords to replace each arc with.

Original polyline with reverse curve and polyline with arcs removed using Length method with chords put on top side

**Prompts**
Select polylines to remove arcs from.
Select objects: pick polylines
Use max offset or chord length method [<Offset>/Length]? press Enter for Offset method
Offset cutoff <0.5>: press Enter

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: rmarc
Prerequisite: polyline with arcs

Remove Polyline Segment
This command removes the user specified segment from a polyline. A polyline segment is the section between two vertices of the polyline. There are two options for removing the segment. Either the two vertices of the removed segments are averaged together to keep polyline continuous, or the segment is left missing in the polyline, which creates two separate polylines. The keywords Continuous and Break respectively identify these two options. The first image is of the Original Polyline. The second is with the Continuous Removal option. The third is using the Break Removal option.

Prompts
Break polyline at removal or keep continuous (Break/<Continuous>)? press Enter
Select polyline segment to remove: pick point on polyline
Select polyline segment to remove: press Enter to end

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: removepl
Prerequisite: A polyline

Remove Polyline Vertex
This command removes vertices from a polyline. First you select the polyline to modify. The existing polyline vertices are marked and then you pick near the vertex you wish to delete. You can continue to pick vertices to delete,
Press Enter when you are done.

Prompts

Select polyline to remove from: pick point on polyline
Pick point to remove: pick point
Pick point to remove (Enter to end): press Enter to end

Pulldown Menu Location: Edit > Polyline Utilities > Remove Polyline
Keyboard Command: rmvertex
Prerequisite: A polyline

Polyline Blips

Draw Polyline Blips

This command will draw temporary markers, "blips", at each polyline vertex. This allows you to identify the actual location of each vertex. The Blips can be drawn as temporary marks or lines. The lines method creates line entities that can be cleared from the drawing using Remove Polyline Blips. For temporary marks, any change to the viewport (pan, zoom, regen) will make the blips disappear. In later versions of AutoCAD, you can also click on the polyline to activate the grips which will remain visible during and after viewport changes.

Prompts

Draw as temporary marks or lines [<Temporary>/Lines]? press Enter
Select polylines to draw blips.
Select objects: select polyline(s)

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: plblip
**Remove Polyline Blips**

This command erases polyline blip lines created by Draw Polyline Blips.

**Pulldown Menu Location:** Edit > Polyline Utilities  
**Keyboard Command:** rmblip  
**Prerequisite:** Polyline blips

---

**Check Polylines**

**Check Elevation Range**

This command analyzes a selection set of polylines, and highlights the ones that fall outside of a specified elevation range. There is an option to set the polylines that are outside of the range to zero. Every polyline vertex that is outside of the range will be highlighted with an X.

**Prompts**

Enter elevation range minimum: 0  
Enter elevation range maximum: 4900  
Select polylines to check.  
**Select objects:** pick polylines to process  
**Found 1 polylines outside of elevation range.**  
**Set polylines outside elevation range to zero elevation [Yes/<No>]? N

**Pulldown Menu Location:** Edit > Polyline Utilities  
**Keyboard Command:** checkpl  
**Prerequisite:** Polylines with elevations

---

**Highlight Non-Perpendicular Intersections**

This command highlights selected polylines that have T-intersections with other polylines that are non-perpendicular. For example, this command can be used to check that side lines for lots are perpendicular to the frontage polyline.
For every non-perpendicular intersection, a temporary graphic arrow is drawn and the angle and the coordinates of the point are reported at the command line.

**Prompts**

**Select the polylines to check.**
Select objects: *pick polylines to check*
Warning: Polyline non-perpendicular by 0°00'47'' at 5477.08,5047.53

Pulldown Menu Location: Edit > Polyline Utilities > Check Polylines
Keyboard Command: highlight_nonperp
Prerequisite: Polylines

**Highlight Non-Tangent Polylines**
This command highlights selected polylines that have non-tangent lineworks. For every non-tangent polyline, an arrow is pointed to the first non-tangent point, and the non-tangent angle and the coordinates of the point are reported at the command line.

Select polylines to check.
Select objects: 1 found
Select objects: 1 found, 1 total
Select objects: *press Enter to end*
Polyline non-tangent by 32°15'26'' at 1540.41,-182.05
Highlighted 1 non-tangent polylines.

Pulldown Menu Location: Edit > Polyline Utilities > Check Polylines
Keyboard Command: highlight_nontangent
**Highlight Crossing Plines**

This command highlights selected polylines that are crossing in the drawing and have different elevations at the crossing. Every intersection point where the polylines cross are marked with a temporary X. A report is provided at the end where the X and Y of the intersection points are displayed with the two Z values and the Z difference. The command has the ability to repair crossing polylines by inserting a vertex in each polyline at the intersection and assigning a common elevation at this intersection.

**Prompts**

- **Select polylines to check.**
- **Select objects:** *pick polylines to process*
- **Ignore zero elevations [Yes/No]?** press Enter for Yes to filter out polylines at zero elevation
Reading points ... 1677
Finding points on breaklines ...
19 crossing polylines are highlighted.

Use Report Formatter [Yes/<No>]? press Enter for No. Use the Report Formatter to customize the report layout
or export to Excel.

Minimum delta Z to report <0.0>: 2

Add polyline vertices at intersections [Yes/<No>]? Y

Set 3D polyline to crossing contour elev or average elevs [Set/<Average>]? press Enter for Average. The
Set option applies to crossing polylines where one polyline is a 3D polyline with varying elevations and the other
polyline is a contour polyline with a fixed elevation. For this case, the Set method will hold the elevation of the
contour polyline and set the 3D polyline elevation to match the contour. The Average method sets the elevation of
the intersection point as the average of the crossing polyline elevations at that point.

Maximum delta Z to average <1.0>: press Enter. This option will only add the intersection point with the
averaged elevation if the elevation difference is less than this tolerance.

Pulldown Menu Location: Edit > Polyline Utilities
Keyboard Command: xing_plines
Prerequisite: Polylines with elevations

3D Polyline Utilities

Offset 3D Polyline

This command offsets a 3D polyline entity in both the horizontal and vertical directions. There are six offset
methods.

The Interval method applies one horizontal and one vertical offset to all the vertices of the polyline.

The Constant method has a horizontal offset and sets the elevation of the polyline to one constant elevation.

The Variable method allows you to specify each horizontal and vertical offset individually either by polyline
segment or for each point. The vertical offset can be specified by actual vertical distance, percent slope or slope ratio.

The Surface method allows to offset/project a 3D polyline entity on to a surface (tin;flt;grd) based on cut and fill
slope ratios.

The Multiple method allows multiple offsets of a 3D polyline with separate layers. User can add, insert and delete
offsets rows and set individual layers. The option Progressive Offsets draws offsets progressively, i.e. successive offsets uses last drawn offset as base.

The Intersection method creates a 3D polyline at the intersection of two slopes from two reference 3D polylines.

The Slope Projection Perpendicular To option applies to sloping 3D polylines. The Polyline method creates the user-specified slope perpendicular to the polyline. The Slope Direction method accounts for the slope of the 3D polyline and makes the surface between the original and offset polylines to match the user-specified slope. For example, if the 3D polyline is at a 10% slope and the offset slope is at 2:1, then the Polyline method would create surface slopes that are 2:1 perpendicular to the polyline while slightly steeper (1.96:1) for the actual slope that goes in the slope direction with the effect of the sloping 3D polyline. For the same case except with the Slope Direction method, the resulting slope perpendicular to the polyline is less steep (2.04:1) while the actual slope in the slope direction is exactly 2:1.

The Change Layer option sets the layer for the offset polyline. Otherwise the offset polyline will use the layer of the original polyline.

Prompts

Enter the offset method [<Interval>/Constant/Variable/Surface/Multiple]: press Enter
Vertical/<Horizontal offset amount>: 15
Percent/Ratio/Vertical offset amount <0>: 10
Select a polyline to offset (Enter for none): select a 3D poly
Select side to offset: pick a point
Select a polyline to offset (Enter for none): press Enter
Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: offset3d
Prerequisite: 3D polyline

Fillet 3D Polyline
This command fillets two segments of a 3D polyline with the given radius. The standard FILLET command does not support 3D Polyline entities. Since 3D polylines cannot have arcs, this command draws the fillet arc as a series of short chords. The elevations along the curve are interpolated from the 3D polyline.

Prompts
Fillet corner of a polyline or intersection of two polylines [Corner]/Intersection]? press Enter
Enter fillet radius <10.00>: press Enter
Select a corner point on polyline: pick 3D polyline near meeting point of two segments
Select a corner point on polyline: pick 3D polyline near meeting point of two segments
Select a corner point on polyline: press Enter (to end command)

Join 3D Polyline
This command joins 3DPOLY entities into a single 3D polyline entity.

Prompts
Select the 3D polyline to join: pick a 3D polyline
Select the other 3D polyline to join: pick a 3D polyline that has a common endpoint with the first 3 segments added to the polyline.

Add Point by Two Slopes
This command inserts a vertex into a 3D Polyline between two points based on the slopes specified for these two points on polyline.

Prompts
Select polyline to process: select a polyline
Select first point on polyline: select a point on polyline
Enter percent slope from first point: -1.0
Select second point on polyline: select a second point on polyline
Enter percent slope from second point: -1.0

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: plzslopes
Prerequisite: 3D Polylines

Add Points At Elevation
This command inserts vertices into a 3D Polyline at a specific elevation, or elevation interval, by interpolating between existing elevations in the polyline.

Prompts

Add single elevation or elevation interval [Single/<Interval>]? press Enter
Enter Elevation Interval: 50
Select 3D polylines to process. pick 3D polyline(s)
Select objects: 1 found
Select objects:
Processing polylines ...
Added 10 points to polylines.

Pulldown Menu Location: Edit > 3D Polyline Utilities
Keyboard Command: addplz
Prerequisite: 3D Polylines

3D Polyline by Slope on Surface
This command creates a 3D polyline at a user-specified slope. The user picks the starting point and then the polyline continues along the surface at the slope until it reaches a point where the maximum slope at the point is less than the design slope. The surface is defined by a grid or TIN file which must be created before running this routine. Applications for this command include designing haul roads or ditches.

Prompts

Enter the polyline layer <SLOPE ROAD>: press Enter
Select the Grid File dialog
Reading row > 51
Extrapolate grid to full grid size (Yes/<No>)? Y
Limiting length for polyline (Enter for none):
Pick origin point of 3D polyline: pick a starting point
Direction of 3D Polyline (<Up>/<Down>)? press Enter
The slope must go either uphill or downhill.
Direction of 3D Polyline facing up slope (<Left>/<Right>)? R Imagine facing uphill. Do you want the polyline to go to the left or right?
Enter the design slope: 10 This value is in percent slope.
**Pulldown Menu Location:** 3D Data  
**Keyboard Command:** surfpl  
**Prerequisite:** Existing surface file

**Join Nearest**

This command joins lines, arcs and/or polylines together. While the *PEDIT-Join* command requires the endpoints to match, Join Nearest will allow you to join entities whose endpoints do not exactly meet. You specify the maximum separation distance to join, along with other options, in the dialog box shown below. Also you can join many entities at once.
Max Separation to Join: Entities whose endpoints are spaced apart greater than this value will not be joined. You may use the pick button to specify this value by picking two points on the screen.

Max Deflection Angle (degrees): This option will not join any lines if the angle between them is greater than this angle in degrees.

Connection Method: Determines how to connect the endpoints. See the illustration below.

1. **Average Endpoints Together**: New vertex will be located at midpoint between two original endpoints (see illustration below on left).
2. **Directly Connect Endpoints**: Original endpoints are connected with new segment (see the middle illustration below).
3. **Fillet with Radius Zero**: Same as the FILLET command using zero radius (see the illustration on right).

Convert Lines and Arcs Into Polylines: When checked, automatically converts lines and arcs into polylines. If not checked, lines and arcs are joined but remain separate entities.

Join Across Intersections: This option applies to cases where more than two linework endpoints come together such as a Y intersection. In these cases, there are multiple possible connections. When this option is on, the program will automatically choose one of the possible connections. Otherwise, the program will not connect any of them.

Join Only Identical Widths: When checked, only polylines with the same width will be joined.

Join Only Identical Layers: When checked, only entities on the same layer will be joined.

Join Only Identical Colors: When checked, only entities with the same color will be joined.

Join Only Identical Linetypes: When checked, only polylines with the same linetype will be joined.

Join Only Common Elevations: When checked, only endpoints located on the same elevation will be joined.

Different Layer Prompt: When Join Only Identical Layers is off, then this option will prompt for which layer to use when it finds a connection between two different layer names.

Different Elevation Prompt: When Join Only Common Elevations is off, then this option will prompt for which elevation to use when it finds a connection between two different elevations.

Elevate Zero Elevations When Joined To Elevated: This option applies when joining a combination of linework at elevation and linework at zero elevation. When checked, zero elevation vertices will get assigned the elevations from connected neighboring vertices.

Pulldown Menu Location: Edit

Keyboard Command: nearjoin

Prerequisite: Lines or polylines to be joined

3D Entity to 2D

This command changes a 3D Line, Arc, Circle, Polyline, Hatch, Leader, Solid, 3D Face, Insert or Point to 2D. In 2D, the entity has the same Z coordinate for all vertices. When the program detects a 3D polyline with all vertices with the same elevation, there is an option to convert to a 2D polyline with this elevation. Otherwise, the entered elevation is used.
Prompts

Select/<Enter Elevation <0.00>: press Enter
Select entities for elevation change.
Select objects: pick a 3D polyline
3DPOLY to 2DPOLYLINE
Number of entities changed > 1

Pulldown Menu Location: Edit
Keyboard Command: 3dto2d
Prerequisite: None

Selection Sets

Select Similar
This command creates a selection set of all entities in the drawing with properties that match the selected entity. The properties filter uses the entity type and layer name. To use this selection set in other commands, enter "P" for previous at the "Select objects:" prompt.

Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: selectsim
Prerequisite: None

Select by Filter
This command can be used to build a selection set of objects inside a drawing based on properties of layer, level, entity type, style, linetype, size and color. The open/closed filter applies to polylines. There is a dialog to define the filter of which properties to include and exclude. The Entities To Process option chooses between checking the entire drawing or prompting for a selection to process with the filter. The program then builds a selection set of those objects that resides on those layers. Then to use this selection set in other commands, enter "P" for previous at the "Select objects:" prompt.

Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: fsel
Prerequisite: None
**Select by Elevation**

This command builds a selection set of entities that are greater than, less than or in between a specified elevation that you enter in on the command line. Entities selected, based upon this elevation criteria, go into a selection set. With the Window selection method, the entities must be entirely inside of the inclusion area to be included in the selection set. With the Crossing selection method, an entity is added to the selection set if any part of the entity is inside the inclusion area.

**Prompts**

Select by greater, less or between elevations [Greater/Less/Between]? press Enter
Enter elevation for greater than: 19
Ignore zero elevations [Yes/No]? press Enter
Select objects to build selection set. pick objects
Processing selection set ...
Built selection of 120 objects for elev more than 19.00.
To use type 'P' at Select objects: prompt.

**Select by Length**

This command builds a selection set of linework objects in the drawing based on linework length. The length filter can be setup to get linework greater than or less than the specified value, or between two length values. After specifying the length criteria, the program prompts for selecting the linework to check. The program then builds a selection set of those objects that pass the length filter. Then to use this selection set in other commands, enter "P" for previous at the "Select objects:" prompt.

**Prompts**

Select by greater, less or between lengths [Greater/Less/Between]? press Enter
Enter length for greater than: 1000
Select objects to build selection set.
Select objects: pick linework to filter

**Select by Block**

This command builds a selection set of blocks by using a block name filter. The block name to match is specified in a dialog with a list of all the block names in the drawing. Either pick from the list or use the Select From Screen button to get the block name by picking a block in the drawing. After selecting the block name, pick OK and the program will report how many of those blocks were found in the drawing and put into the selection set. This selection set is then ready to use at the next command with a select objects prompt. To use the selection set, type 'P' at the select objects prompt.
Select by Area

This command builds a selection set using inclusion and/or exclusion closed polylines. Entities within the inclusion polylines are selected and entities within the exclusion polylines are not selected. With the Window selection method, the entity must be entirely inside the inclusion area and entirely outside the exclusion area to be included in the selection set. With the Crossing selection method, an entity is added to the selection set if any part of the entity is inside the inclusion area.

Prompts

Select the Inclusion perimeter polylines or ENTER for none:
Select objects: pick the closed polyline
Select objects: press Enter
Select the Exclusion perimeter polylines or ENTER for none.
Select objects: press Enter
Type of selection (Window/<Crossing>)? press Enter
Select objects to build selection set.
Select objects: All These selected objects are checked with the inclusion/exclusion polylines.
Select objects: press Enter
Built selection set with 43 objects.
Command: Erase
Select objects: P To use previous selection set created by Select by Area.
43 found
Select objects: press Enter

Pulldown Menu Location: Edit > Selection Sets
Keyboard Command: ssetarea
Prerequisite: Closed perimeter polylines

Image

Image Frame

This command controls whether TakeOff displays the image frame or hides it from view.
Because you select an image by clicking its frame, setting the image frame to off prevents you from selecting an image.

**Prompts**

1. Enter image frame setting [ON/OFF] <current>: enter an option or Press Enter
   - **On**: Displays image frames so you can select images.
   - **Off**: Hides image frames so you cannot select images.

**Prerequisite**: None

**Keyboard Command**: IMAGEFRAME

---

**Image Clip**

This command allows you to create new clipping boundaries for an image object.

**Prompts**

1. Select image to clip: select the edge of an image
2. Enter image clipping option [ON/OFF/Delete/New boundary] <New>: enter an option or Press Enter

   The boundary you specify must be in a plane parallel to the image object.
   - **On**: Turns on clipping and displays the image clipped to the previously defined boundary.
   - **Off**: Turns off clipping and displays the entire image and frame. If you recclip the image while clipping is turned off, the program automatically turns clipping back on. The program prompts you to delete the old boundary even when clipping is turned off and the clipping boundary is not visible.
   - **Delete**: Removes a predefined clipping boundary and redisplays the full original image.
   - **New Boundary**: Specifies a new clipping boundary. The boundary can be rectangular or polygonal, and consists only of straight line segments. When defining a clipping boundary, specify vertices within the image boundary. Self-intersecting vertices are valid. Rectangular is the default option. If you use the pointing device to specify a point at the Enter Clipping Type prompt, the program interprets the point as the first corner of a rectangle.
3. Enter clipping type [Polygonal/Rectangular] <Rectangular>: enter P or Press Enter
   - **Polygonal**: Uses specified points to define a polygonal boundary.

   Specify first point: Specify a point
   Specify next point or [Undo]: specify a point or enter u
   Specify next point or [Undo]: specify a point or enter u
   Specify next point or [Close/Undo]: specify a point, or enter c or u

   You must specify at least three points to define a polygon.

   If the image already has a clipping boundary defined, TakeOff displays the following prompt:

   Delete old boundary? [No/Yes] <Yes>: enter N or Press Enter

   If you choose Yes, the program redraws the entire image and the command continues; if you choose No, the command ends.
   - **Rectangular**: Specifies a rectangular boundary by its opposite corners. TakeOff always draws the rectangle parallel to the edges of the image.

   Specify first corner point: specify a point
   Specify opposite corner point: specify a point

**Prerequisite**: None
Image Adjust

This command controls the display of the brightness, contrast, and fade values of images.

The Image Adjust dialog box controls how the image is displayed by adjusting the brightness, contrast, and fade settings of the selected image. Adjusting these values changes the display of the image but does not change the image file itself.

- **Brightness**: Controls the brightness, and indirectly the contrast, of the image. Values range from 0 through 100. The greater the value, the brighter the image and the more pixels that become white when you increase contrast. Moving the slider to the left decreases the value; moving the slider to the right increases the value.

- **Contrast**: Controls the contrast, and indirectly the fading effect, of the image. Values range from 0 through 100. The greater the value, the more each pixel is forced to its primary or secondary color. Moving the slider to the left decreases the value; moving the slider to the right increases the value.

- **Fade**: Controls the fading effect of the image. Values range from 0 through 100. The greater the value, the more the image blends with the current background color. A value of 100 blends the image completely into the background. Changing the screen background color causes the image to fade to the new color. In plotting, the background color for fade is white. Moving the slider to the left decreases the value; moving the slider to the right increases the value.

- **Image Preview**: Displays a preview of the selected image. The preview image updates dynamically to reflect changes to the brightness, contrast, and fade settings.

- **Reset**: Resets values for brightness, contrast, and fade to default settings (50, 50, and 0, respectively).

**Prerequisite**: None

**Keyboard Command**: IMAGEADJUST
Shown here is the View menu of Carlson Field. There are many commands listed here for your viewing and display needs.
Redraw
This command refreshes the display in the current viewport.
**Prerequisite:** None
**Keyboard Command:** R

Regen
This command regenerates the drawing and refreshes the current viewport.
**Prerequisite:** None
**Keyboard Command:** REGEN

Zoom - Window
This command zooms to display an area you specify by two opposite corners of a rectangular window.
**Prerequisite:** None
**Keyboard Command:** ZOOM, W

Zoom - Previous
This command zooms to display a previous view. You can restore up to 10 previous views.
**Prerequisite:** None
**Keyboard Command:** ZOOM, P

Zoom - Extents
This command zooms to display the drawing extents. You can use Zoom Extents transparently, but it always regenerates the drawing.
**Prerequisite:** None
**Keyboard Command:** ZOOM, E

Zoom
Zoom - Dynamic
This command zooms to display the generated portion of the drawing using a view box. The view box represents your viewport, which you can shrink or enlarge and move around the drawing. Positioning and sizing the view box pans or zooms the viewport, filling it with the image inside the view box.
**Prerequisite:** None
**Keyboard Command:** ZOOM, D
**Zoom - Center**
This command zooms to display a window you define by picking a center point and a magnification value or height. A smaller value for the height increases the magnification. A larger value decreases the magnification.

**Prompts**

1. Specify center point: **pick a point**
2. Enter magnification or height <226.66>: **enter a value**

**Prerequisite:** None

**Keyboard Command:** ZOOM, C

---

**Zoom IN**
This command increases the zoom factor of the current viewport by a factor of 2.0.

**Prerequisite:** None

**Keyboard Command:** ZOOM, 2.0x

---

**Zoom OUT**
This command decreases the zoom factor of the current viewport by a factor of 0.5.

**Prerequisite:** None

**Keyboard Command:** ZOOM, 0.5x

---

**Zoom Selection**
This command zooms the display to fit the selected entities. For example, if you run Viewpoint 3D and your viewport only shows two small dots of entities that are far apart, then you can use Zoom Selection to select the entities of one of these dots and quickly zoom the display to these entities.

**Prompts**

Select objects to zoom onto:
Select objects: **select entities**

**Pulldown Menu Location:** View
**Keyboard Command:** zoom_on

**Prerequisite:** Entities

---

**Zoom Most**
This command zooms to show the bulk of the entities in the drawing and avoid outliers. This zoom method is helpful when the drawing has a few entities far off and regular zoom extents results in showing small dots because it zooms out so far. When outliers are detected, there is a choice to either zoom to the bulk of the entities so you can see your main drawing, or to zoom to the outliers so you can see the entities that are far away. When no outliers are found, this command reports that none are found and does a regular zoom extents.

**Prompts**

**Zoom to [Most]/Outliers?** press Enter for Most
**Zoom Extents on All Layouts**

This command does a zoom extents for all the layouts in the drawing.

**Pulldown Menu Location:** View > Zoom  
**Keyboard Command:** zoommost  
**Prerequisite:** Entities

**Zoom Points**

This command centers the screen to a user-specified point. The point can be specified by either the point number or description. The command searches the current coordinate (.CRD) file. Besides centering the screen, the magnification can also be changed. The default value is the current magnification. To zoom in, enter a smaller value and to zoom out, enter a greater value.

**Prompts**

Find by point number or description [<Number>/Desc]? N  
Point number or range of point numbers to find <1>: 2079  
We want to find point number 2079  
Magnification or Height <179.50>: press Enter  
Accept the default zoom magnification

**Pulldown Menu Location:** View  
**Keyboard Command:** zoompnt  
**Prerequisite:** A .CRD file

**Pan**

This command moves the drawing display in the current viewport. The cursor changes to a hand cursor. By holding down the pick button on the pointing device, you lock the cursor to its current location relative to the viewport coordinate system. The drawing display is moved in the same direction as the cursor.

When you reach a logical extent (the edge of the drawing space), a bar is displayed on the hand cursor on the side where the extent has been reached. Depending on whether the logical extent is at the top, bottom, or side of the drawing, the bar is either horizontal (top or bottom) or vertical (left or right side).

When you release the pick button, panning stops. You can release the pick button, move the cursor to another location in the drawing, and then press the pick button again to pan the display from that location.

**Prerequisite:** None
Keyboard Command: P

**Align Paper With Model Space**
This command works in paper space for a layout that has a viewport. The command aligns a point from the model view in the viewport to a point in paper space. The command prompts for the point in model space and the point in paper space. Then the command pans the model view to align with the picked point in paper space.

**Prompts**

Pick point in model space: *pick a point*
Pick point in paper space: *pick a point*

Pulldown Menu Location: View > Pan
Keyboard Command: alignps
Prerequisite: None

**3D Views**

**3D Viewer Window**
This command loads the selected 3D faces, blocks, polylines, lines and points into a separate 3D Viewer window. Some of the features of this viewer include the ability to zoom in and out, pan, rotate around the X-Y-Z axes, and shade entities with user-positioned lighting.
The 3D Viewer Window has several mouse and keyboard controls that can assist with navigating the scene. These are listed below:

- Hold left-mouse button: Rotates/pans/zooms the scene based on the current mode. You can change the mode by clicking one of the control icons.
- Hold right-mouse button: Zooms in/out.
- Hold middle-mouse button: Pans around the scene.

- W key: Zooms in.
- S key: Zooms out.
- A key: Pans left.
- D key: Pans right.
- Q key: Pans up.
- Z key: Pans down.
- E key: Rotates down.
- C key: Rotates up.
- X key: Rotates left.
- V key: Rotates right.

**Ignore Zero Elevations:** When enabled, the 3D viewer will not display entities at zero elevation.

**Color By Elevation:** This will color the entities by elevation. The *None* option will not modify the color of entities in the viewer. The *All* option will color all entities by elevation. The elevation color legend will be displayed on the left of the window and can be adjusted via the Color By Elevation Scale controls. The *Surface Only* option will only color surface files by elevation. Other entities such as polylines and 3D faces will not be colored by elevation.

**Sky:** This option controls the background image for the 3D viewer. By default, no background image will be displayed. When a background image is displayed, you can toggle the *Background Color Below Horizon* checkbox to hide the bottom half of the background image.

**Vertical Scale:** This option sets the vertical scale factor for the 3D viewer.

**Lighting by Location/Time:** This button will display the below dialog, which allows you to set the lighting as it would appear at a specific location at a specific time.
Date/Time: These values set the date and time for the lighting. The Select button will allow you to pick the date from a calendar. The horizontal slider below the time will allow you to set the time of day.

Latitude/Longitude: These values set the location of the viewpoint.

Time Zone: This value adjusts for the various time zones. Values should be integers representing GMT adjustments. For example, the Eastern Standard Time (EST) in the USA will use a value of -5.

Control Action

This control represents the position of the sun in plan view. If the yellow square is in the center of the blue circle, the sun is in a zenith. If the yellow square is near the edge of the circle, the sun is near the horizon. To move the yellow square, simply drag it to a new location, or click on the new location. The slider bars on the sides control the intensity and brightness of the display.

Switch to Pan mode. Click and drag to pan.

Switch to Rotation mode. When the cursor is placed near the outer edge of the view, a “Z” cursor is presented that permits rotation around the Z-axis. When the cursor is placed further into the interior of the view, an “X,Y” cursor is presented that permits the tilt angle of the view to be adjusted.

Switch to Dynamic Zoom mode. Click and drag to zoom in and out.

Zoom Previous.

Toggle shading of 3D Faces and Surfaces. The shading of these entities is controlled by the Shading Mode control.
Switch to Pick mode. In this mode, hovering over an entity will display data such as the layer, entity type, elevation, and length. Double-clicking an entity permits additional actions to be performed on the entity including the ability to change the layer of the entity and/or setting the entity to an elevation of zero (0). When hovering over a surface, the coordinates and slope of the surface at the cursor location will be displayed. Clicking a point on the surface will set a new reference point from which the distance and slope to the cursor will be displayed (click a point, move the mouse to measure the distance/slope).

Resets the 3D view to plan.

**Rotation Axis:** Permits the use of "slider" controls to orient the view in the X, Y and/or Z axis direction(s). Axes may be locked to prevent rotation about that axis.

**Fixed Views:** Permits the view to be displayed from one of six different directions:

1. Custom - This option will be displayed after manually rotating the view. Selecting this option will not return to a predefined view.
2. Plan View - Sets the view directly over the site, looking straight down. This is the same as the Reset to Plan button.
3. NE - Sets the view as shown from the Northeast looking to the Southwest in a downward direction.
4. SE - Sets the view as shown from the Southeast looking to the Northwest in a downward direction.
5. SW - Sets the view as shown from the Southwest looking to the Northeast in a downward direction.
6. NW - Sets the view as shown from the Northwest looking to the Southeast in a downward direction.

**TIN Edit:** This option is only available when using the Surface 3D Viewer Command and when using the Pick Mode. This allows you to modify TIN files by picking points on the surface.

*Swap Tin Edge* will rotate the edge of two adjacent triangles, but this is not possible for all triangles on the surface. *Add Breakline* will add a breakline to the surface after selecting the starting and ending points on the surface. *Remove Point* will remove a point on the surface and retriangulate the affected area. *Remove Triangle* will remove a triangle from the surface, leaving a gap. *Set Point Elevation* will allow you double-click a point on the surface and enter a new elevation for that point.

**XRay Cursor:** This option is only available when using the Surface 3D Viewer Command and when using the Pick Mode. This will hide the surface file near the cursor, allowing you to see objects beneath it.
Display Axis Icon: This option toggles the display of the X-Y-Z axes icon in the lower left corner of the window.

Bounding Box: This dropdown menu controls the display of a 3D box around the limits of the data.

The *None* option will not display the bounding box.
The *Box Only* option will display simple bounding box around the objects in the 3D view.
The *Box with Labels* option will display a bounding box with labels to indicate the range of X, Y, and Z values in the scene.

Display Orbit: This option toggles the display of a graphic guide for controlling the view angle and position using the mouse movements similar to the AutoCAD Orbit routine.

Smooth Surface: This option shades 3D faces in a way that appears to remove sharp transitions from one entity to another. This option affects both surfaces and solids.

Display Triangle Edges: This option toggles the edge lines of triangles that make up surfaces. The triangle edge color can be set with the *Set Colors* button.

Display Surface Names: This option toggles the display of the file names for the surfaces currently being viewed.

Display Vertical Scale: This options toggles the display of the vertical scale.

Display Non-Surface Entities: This option toggles the display of entities that have been tagged as "non-surface" by the Tag Non-Surface Entities/Points commands.

Use Dynamic Text: This option automatically resizes and rotates text entities so that they are always readable. When the option is first enabled, you will need to restart the viewer for the changes to take effect.

Hide Backs of Triangles: This option toggles the display of the backs of 3D Faces. When enabled, even the edges
of the triangles will be hidden.

**Linework Pixel Thickness:** This value sets the display thickness for polylines.

**Point Pixel Size:** This value sets the display thickness for points.

**Set Colors:** This button opens the dialog shown below.

![Set Colors Dialog](image)

**Color By Elevation Scale:** These three colors are used for the Color By Elevation option. The program will interpolate between these colors for the color scale.

**Contour/Edge color:** These colors control the coloring for contours and triangle edges. Note that this does not affect the coloring of contour polylines that are loaded into the viewer, but only contours that are generated within the viewer.

**Use CAD Background Color:** When enabled, the background color of the 3D viewer will match the CAD background color. If this option is disabled, you can set a different background color.

**Default Surface Colors:** These colors set the default colors for new surfaces (Grid or TIN files) that are loaded into the 3D viewer. The colors of the surfaces may changed after they have been loaded.

<table>
<thead>
<tr>
<th>Control</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Control Icon" /></td>
<td>Sets the drawing view to match the view shown in the 3D viewer window.</td>
</tr>
<tr>
<td><img src="image" alt="Control Icon" /></td>
<td>Sets the view position and target position by coordinates according to the below dialog.</td>
</tr>
</tbody>
</table>

**Settings Controls**
The positions can be entered in the edit boxes or you can use the respective Pick button to pick a point in the drawing. The program will pick up the elevation of the surface for picked points and then the Height above the position can be entered. For example, to check sight distance the view position could be a point on a road at the driver's eye height and the target position could be the distance to check.

**Saved Views:** This option allows for naming and saving a 3D view for easy recall later. Named views can be selected from the pull-down and the active view can be deleted from the list.

**Block Model Objects:** This option has three choices when loading block model entities:

1. Leave as Points - this option will display blocks as points. In this mode, vertical stacks of blocks will be composited by color. For example, if 5 blocks of the same color are on top of one another, only one point will be displayed for those 5 blocks. This greatly reduces the number of points to be displayed in the viewer, but this viewing mode can be difficult to interpret for relatively homogeneous block models.

2. Render - this option will display each block as a solid.

3. Prompt Each Time - this option will prompt you to select the viewing mode each time a block model is loaded into the viewer.

**Shading Mode:** When the Shading control is enabled, the rendering of the shaded 3DFACE entities (usually used to represent a surface model) will vary based on:

1. Shade Front - Shades only the "positive" normal direction.
2. Shade Back - Shades only the "negative" normal direction.
3. Shade Both - Shades both the "positive" and "negative" normal directions.
Control

Action

Adds a single surface file to the 3D Viewer. You may also add one or multiple surfaces to the viewer by right clicking on “Surfaces” in the tree view.

Allows you to select more entities from the drawing to add to the 3D Viewer.

 Allows you to edit properties of the currently selected entity.

Loads a 3DX file into the viewer. This file contains all entities within a saved 3D View.

Save the entities in the 3D Viewer to a 3DX file.

Model Controls

Within the "model" tab is a "tree-view" of the various entities that comprise the view along with the listing of layers upon which the entities are found. Each "branch" in the tree view may be expanded by clicking the "+" symbol to the left of the branch. Entities may be displayed (thawed), hidden (frozen), or edited by right clicking the entity name and selecting the appropriate option. The below dialog shows the properties of a surface that may be edited.
Visibility: This option toggles the visibility of the entity.

Opacity (Surfaces/Solids): This option controls the opacity of the entity. A lower opacity results in increased surface transparency and is helpful for viewing sub-surface utilities such as Storm Sewer pipes and manholes.

Color By Normal (Surfaces/Solids): When enabled, this option will color the surface/solid by the direction perpendicular to each face. This view can be useful for identifying particularly steep areas of the surface. The Color By Elevation option must be disabled to show the designated color.

Override color from file: When enabled, this option will override any color assignments and display the entity as a single color. The Set Color button below this option sets the color for the entity. The Color By Elevation option must be disabled to show the designated color.

Texture Mode (Surfaces/Solids): This dropdown controls how texture images are applied to surfaces and solids.

None will not apply a texture to the surface/solid
Single Texture will apply a single texture image to the surface/solid. The texture image and the Scale of the texture may be set by clicking the Edit button.
By Color will set different texture images for each colored area of the surface. For example, surfaces output from RoadNet, may have a different color for the asphalt compared to ditches. This option will then allow you to apply one texture to the asphalt and another to the ditch. When enabled you can add a row to the Texture by Color table, first selecting a color and then specifying the texture to use in place of that color.
By Color, Single as Default is the same as the By Color option, but you are allowed to set a default texture for any colors not included in the list.
By Slope sets the texture of the surface according to the slope of the surface. When enabled, you will be able to set a texture, scale, and max slope for each zone.
Shading Mode (Solids): This option controls which side of the 3D faces of the solid should be shaded.

These controls are always displayed at the bottom of the window.

Control

Action

The Clip Plane slider bars hide a portion of the view. Sliding the bar to the right will clip more of the view. This is helpful for producing quick "section" views of the data.

The Near slider bar will clip objects closer to the camera, while the Far slider bar will clip objects further away from the camera. Similarly, the Top and Bottom slider bars will clip higher and lower objects, respectively. Specific elevations for the Top and Bottom clipping plans may also be set by entering values in the Top Elev and Bottom Elev text boxes.

Clicking the cyan button to the left of each slider bar will allow you to pick a point in the 3D view to set the clip position.

The Sync Front/Back toggle will move both the Near and Far slider bars by the same amount when enabled. This can be used to hold a specific viewing width while. The Sync Top/Bottom toggle has a similar effect on the Top and Bottom slider bars.

This button takes a screenshot of the 3D Viewer. Several different image file formats are supported including bmp, png, jpg, xpm and gif. The image resolution and color depth may be set with this option.

This button exports the 3D Viewer to a PDF report with project information. The default project information is set under Carlson Configure > General Settings. The dialog that appears for this command is shown below.

This button exports the 3D Viewer to a 3D PDF. This function is further described in the to the 3D Viewer to 3D PDF help article. Note that you must have access to the CADNET module in order to use this command.

This button opens the help documentation you are currently reading.

Exit the 3D viewer window.

Common Controls
Scale Type: This option controls how the image and the paper will be scaled to match one another. When the *Fit Paper to Image* option is selected, you will be able to manually set the **Image Size**.

Paper Size: This option sets the size of the PDF.

Draw Border: This option toggles the addition of a border around the PDF.

Draw Title Block: This option toggles the addition of a title block in the PDF. Information such as the **Company Name**, **Project**, **Date**, and **Logo** will be included in the title block. The logo may be selected by clicking the **Select** button and the dimensions may be specified in pixel dimensions.

Top/Side/Bottom Margin: These values set the margins around the PDF in inches.

- To quickly view just a surface file, use the Surface 3D Viewer command.
- To visualize a site with animated vehicle controls, use the Surface 3D Fly-Over command.

Pulldown Menu Location: View > 3D View
Keyboard Command: cube
Prerequisite: Entities to display

**Surface 3D Viewer**
This command is identical to the 3D Viewer Window, except that this one loads a Carlson Grid GRD, TIN or FLT file. After the file is selected, the same viewer documented in *3D Viewer Window* appears. For more information or this command, and a detailed explanation of the buttons and tabs, see this same command listed in the Surface section of this manual.
Pulldown Menu Location: View
Keyboard Command: cube
Prerequisite: Entities to display

Surface 3D FlyOver
This command allows you to view a self guided animation of following a path through a 3D surface model. There are two variations to this command. When the command is started, you must specify whether you want to use a surface model from file or screen entities.

Surface model from file: Using this method, you can select either a triangulation (.TIN) file or a grid (.GRD) file, then you have the option of following a polyline or following a "free" path. If you choose the polyline method, then the animation is limited to following the polyline. If you choose the "free" path method, you first specify two points to obtain a starting direction, the while inside the viewer you can point the animation in any direction.

Screen entities: Using this method, you must select a 3D polyline to follow. The animation is limited to following the polyline.

After making the above selections, the 3D graphics window is opened. The main window is for the animation, the smaller upper right window shows you the overall plan view, and the smaller window located at middle right shows you the current elevation, slope and azimuth. While following a "free" path, you will have a 3rd small window located at lower right which shows you the amount of roll at your current position.
This button raises the elevation of your viewing position. This button lowers the elevation of your viewing position. This button turns your viewing position to the left. This button turns your viewing position to the right. This button allows you to zoom in and out. This button allows you to rotate the main animation window in any X, Y or Z direction. This button allows you to pan. This button toggles shading on and off. This button starts the animation in the main window. This button stops the animation. This button exits the 3D Surface FlyOver command Control for position of the light source, viewed from above.

**Prerequisite:** Surface Model and optionally a 3D Polyline  
**Keyboard Command:** flyby

### 3DX Model File

This command selects a 3DX file to view in the 3D Viewer Window. The 3DX file contains all the elements for the scene. Use the 3D Viewer Drawing, 3D Viewer Surface File or Surface 3D FlyOver routines to create a 3DX file.

**Pulldown Menu Location:** View  
**Keyboard Command:** cube_3dx  
**Prerequisite:** .3DX file
Viewpoint 3D

This command allows you to define 3D view settings.

1 Under Set Viewing Angles, you must set the direction of the view relative to either the world coordinate system (WCS) or a user coordinate system (UCS).

- **Absolute to WCS**: This option sets the view direction relative to the WCS.
- **Relative to UCS**: This option sets the view direction relative to the current UCS.

2 You must specify the viewing angles.

- **X Axis**: This field specifies the angle from the X axis.
- **XY Plane**: This field specifies the angle from the XY plane. You can also use the sample image to specify viewing angles. The black arm indicates the new angle. The red arm indicates the current angle. Specify an angle by selecting the inner region of the circle or half-circle. Selecting the bounded outer regions rounds off the angle to the value displayed in that region.
- **Set to Plan View**: This option sets the viewing angles to display the plan view relative to the selected coordinate system.

**Prerequisite**: None.

**Keyboard Command**: DDVPOINT

### Viewports

**Draw Model View**

This command draws a rectangular polyline in Model space for the outline of a selected viewport in Paper space. Before running this command, switch to a Layout that has the viewport to draw. The polyline is drawn in the drawing current layer. After drawing the polyline, the program switches to Model space.

**Prompts**

**Pick viewport to draw::** pick a viewport
Twist Screen

Standard
This command will twist the screen orientation to where something other than the north direction is toward the top of the screen/drawing. It does not do a coordinate rotation, the drawing coordinates remain unchanged. Use commands on the *Points* menu, such as Rotate Points and Translate Points, if you want to do a coordinate rotation or translation.

Prompts
This routine prompts for the twist angle then adjusts the screen and cross-hairs to that angle. This is a modification of the DVIEW command. The twist angle is always measured counterclockwise with 0 degrees being to the east/right.

Pulldown Menu Location: View > Twist Screen
Keyboard Command: twist1
Prerequisite: None

Line Pline or Text
This is a variation of the previous command that allows you to select a line, polyline, or text in your drawing that you want to be aligned parallel to the east-west direction of the graphics screen. Think of the entity you select as a pointer or arrow that will point in the east direction of the screen after you select it. Select the line, polyline, or text closest to the end point which you want to be the horizontal or east direction of the screen.

Prompts
Pick a line, polyline or text to make horizontal: *pick a line or polyline*
Surveyor

This command is another variation of twisting the screen that allows you to input an angle/azimuth that you want to be aligned parallel to the east-west direction of the graphics screen. Entering zero would align due north with respect to real world coordinates to the east or horizontal direction of the graphics screen. The Grid Projection Angle button prompts for a base point and sets the angle to the grid mapping angle. To use this option, the grid projection must be assigned in the Drawing Setup command.

**Pulldown Menu Location:** View > Twist Screen

**Prerequisite:** None

**Keyboard Command:** twist3

---

**Restore Due North**

This command twists the screen to make due north vertical. When the grid projection is specified under the Drawing Setup command, this command will prompt for whether to use grid north or geodetic north. When the grid projection is not set, this routine automatically twists to grid north.

**Prompts**

Twist to Grid North or True Geodetic North [<Grid>/True]? press Enter

**Pulldown Menu Location:** View > Twist Screen

**Keyboard Command:** twist4

**Prerequisite:** None

---

**Twist 3D Entities**

**Twist To 3D View**

This command orients selected text, symbols and point attributes to face the current viewpoint. Typically, text and points are drawn to face up to plan view. When viewed in 3D from the side, this text can be hard to read. This command makes this text readable for the current view. Before running this command, the 3D view should be set by commands like Viewpoint 3D or Orbit. The entities are oriented to the current view by setting the extrusion values for the entities.

**Prompts**

Select points, symbols and text to twist.

Select objects:  pick entities

**Pulldown Menu Location:** View > Twist 3D Entities

**Keyboard Command:** twist3d

**Prerequisite:** Entities to view
**Restore World View**

This command is the companion to the Twist To 3D View command. This command resets entities so that they face up in plan view.

**Prompts**

*Select points, symbols and text to restore.*  
*Select objects:* pick entities

**Pulldown Menu Location:** View  
**Keyboard Command:** untwist3d  
**Prerequisite:** 3D Entities

**Display Order**

This command allows you to change the display order of objects by repositioning an entity from either the background to the forefront of the drawing view or from the forefront to the background of the drawing view.

**Prerequisite:** None  
**Keyboard Command:** draworder

**Show/Hide By Selection**

This set of commands to select entities to hide, isolate or make visible.

**Hide By Selection**

This command prompts to select entities and then makes these entities invisible in the drawing.

**Isolate By Selection**

This command prompts to select entities and then makes all other entities in the drawing invisible so that only the selected entities are shown.

**Show All**

This command makes all the entities visible that were hidden by the Hide By Selection or Isolate By Selection commands.

**Pulldown Menu Location:** View  
**Prerequisite:** None  
**Keyboard Command:** hidess, isolatess, showss
Levels

Set Level
This command assigns a level name to the selected entities. The level is an optional, additional name that can be assigned to entities and used to filter entities for making selection sets.

Pulldown Menu Location: View > Levels
Keyboard Command: levelset
Prerequisite: None

Level Manager
This command lists, creates and renames level names. The dialog shows the level names defined in the drawing. Use the New button to add a level name. Use the Rename button to change a level name.

Pulldown Menu Location: View > Levels
Keyboard Command: levelmgr
Prerequisite: None

Layer Control
This command allows you to manage layers and layer properties.
This Layer Properties Manager dialog box makes a layer current, adds new layers to the layer name list, and renames an existing layer. You can assign properties to layers, turn layers on and off, freeze and thaw layers globally or by viewport, lock and unlock layers, set plot styles for layers, and turn plotting on and off for layers. You can filter the layer names displayed in the Layer Properties Manager, and you can save and restore layer states and properties settings.

1 Under Named Layer Filters, you determine which layers to display in the list of layers. You can filter layers based on whether they're xref-dependent, or whether they contain objects. You can also filter layers based on name, visibility, color, linetype, lineweight, plot style name, whether they are plotted, or whether they are frozen in the current viewport or in new viewports.

- [...] This button displays the Named Layer Filters dialog box.
- Invert Filter: This option displays layers based on the opposites of the criteria you select when you are using a named layer filter. Layers that fit the inverse criteria are displayed in the layer name list.
- Apply to Object Properties Toolbar: This option displays in the Object Properties toolbar only layers that match the current filter. The layer list tooltip on the Object Properties toolbar displays the filter status of layers in the drawing. (To display the layer list tooltip, position the pointing device over the layer list on the Object Properties toolbar.)

- New: This option creates a new layer. After you choose New, the list displays a layer named LAYER1. You can edit this layer immediately. To create multiple layers quickly, you can select a layer name for editing and enter multiple layer names separated by commas. If you create a new layer, the new layer inherits the properties of the currently selected layer in the layer list (such as Color, and On/Off state). To create layers with default settings, make sure that there are no selected layers in the list or that you select a layer with default settings before beginning layer creation.

- Current: This option sets the selected layer as the current layer. The CLAYER system variable stores the layer name.

- Delete: This option deletes selected layers from the drawing file definition. You can delete only unreferenced layers. Referenced layers include layers 0 and DEFPOINTS, layers containing objects (including objects in block definitions), the current layer, and xref-dependent layers. Layers that don't contain objects (including objects in block definitions), are not current, and are not xref-dependent can be deleted by using the PURGE command.
careful about deleting layers if you are working on a drawing in a shared project or one based on a set of layering standards.

- **Show/Hide Details**: This option controls whether the Details section is displayed in the Layer Properties Manager.

- **Save State**: This option displays the Save Layer States dialog box, in which you save layer state and layer properties settings of all layers in a drawing. You can choose which layer states and properties you want to preserve. You save a layer state by assigning it a name.

- **Restore State**: This option displays the Layer States Manager, in which you can manage named layer states.

2 The Layer Properties Manager dialog box displays all layers and their properties. To modify a property, click its icon. To quickly select all layers, right-click your pointing device and use the shortcut menu. The following are the layer properties you can modify:

- **Name**: This field displays the names of the layers. You can select a name, and then click and enter a new name.

- **On/Off**: This field turns layers on and off. When a layer is on, it is visible and available for plotting. When a layer is off, it is invisible and not plotted, even if Plot is on.

- **Freeze/Thaw in All Viewports**: This field freezes and thaws layers in all floating viewports. A frozen layer is invisible and excluded from regeneration, hiding objects, rendering, and plotting. A thawed layer is visible and available for regeneration, hiding objects, rendering, and plotting.

You can freeze layers to speed up ZOOM, PAN, and many other operations, improve object selection performance, and reduce regeneration time for complex drawings. TakeOff does not display, plot, or regenerate objects on frozen layers. Objects on frozen layers do not hide objects and are not rendered.

You can freeze layers in all viewports, in the current viewport, or in new viewports.

Freeze layers that you want to be invisible for long periods. When you thaw a frozen layer, the program regenerates and displays the objects on that layer. If you switch between visible and invisible states frequently, use the On/Off setting.

- **Lock/Unlock**: This field locks and unlocks the layers. You cannot select or edit objects on a locked layer. Locking a layer is useful if you want to view information on a layer for reference but do not want to edit objects on that layer.

- **Color**: This field changes the color associated with the selected layers. Clicking the color name displays the Select Color dialog box.

- **Linetype**: This field changes the linetype associated with the selected layers. Clicking any linetype name displays the Select Linetype dialog box.

- **Lineweight**: This field changes the lineweight associated with the selected layers. Clicking any lineweight name displays the Lineweight dialog box.

- **Plot Style**: This field changes the plot style associated with the selected layers. If you are working with color-dependent plot styles (the PSTYLEPOLICY system variable is set to 1), you cannot change the plot style associated with a layer. Clicking any plot style displays the Select Plot Style dialog box.

- **Plot/Don't Plot**: This field controls whether the selected layers are plotted. If you turn off plotting for a layer, the objects on that layer are still displayed. Turning off plotting for a layer affects only visible layers in the drawing (layers that are on and thawed). If a layer is set to plot, but is currently frozen or off in the drawing, TakeOff does not plot the layer. Turning off plotting for layers containing reference information such as construction lines can be useful.

**Prerequisite**: None

**Keyboard Command**: LAYER
Set Current Layer

This command allows the user to change the current layer to a different layer by picking an entity on that layer.

Pulldown Menu Location: View
Keyboard Command: lset
Prerequisite: None

Layer Utilities

Change Layer

This command allows you to change the layer of a group of entities by selecting the group of entities. The layer name to assign can be either typed it or read from an existing entity by picking an entity that is on the layer that you want to change the group to.

Prompts

Select entities to be changed.
Select objects: pick entities
The Select Layer dialog appears select a layer from the list, or select Screen Pick
If Screen Pick is chosen,
Pick entity with layer to change to: pick another entity This assigns the selected entities to the layer of this entity.
or
Enter new layer name or pick entity with layer (Enter/<Pick>)? E
Enter new layer name: FINAL This assigns the selected entities to the FINAL layer.

Pulldown Menu Location: View
Keyboard Command: lchg
Prerequisite: None

Change Layer Color

This command changes the color of a layer. The layer is selected by picking an entity on the layer. Then the program prompts for the color to set.
Prompts

Select entity on layer: *pick an entity*
Color dialog

Pulldown Menu Location: View
Keyboard Command: lcolor
Prerequisite: A drawing entity

Add/Replace Layer Prefix

The Add Layer Prefix command adds a string to the beginning of all the layers in the drawing. The Replace Layer Prefix looks for a string at the beginning of layers and replaces this string with a new string.

Add Layer Prefix

Prompts

Layer prefix to add: *PRE_*

Replace Layer Prefix

Prompts

Old layer prefix to replace: *PRE_*
New layer prefix to add: *POST_*
Pulldown Menu Location: View > Layer Utilities
Keyboard Command: addLayerPrefix, replaceLayerPrefix
Prerequisite: None

Freeze Layer By Pick

This command will freeze layers by picking entities on that layer. The entity selection is done one at a time. As entities are selected, the layers are frozen.

Prompts

Pick entity on layer to be frozen: *pick an entity*
Freezing layer
Pick entity on layer to be frozen (U-Undo,Enter to end): *press Enter*
Pulldown Menu Location: View
Keyboard Command: pickoff
Prerequisite: None
Freeze Layer By Selection

This command will freeze layers by picking entities on that layer. The entity selection is done by selection set for selecting one or more entities.

Prompts

Select entities on layers to be frozen.
Select objects:  pick entities
Pulldown Menu Location: View
Keyboard Command: loff
Prerequisite: None

Thaw Layer

This command thaws the layers frozen by the Freeze Layer command.

Pulldown Menu Location: View
Keyboard Command: lon
Prerequisite: None

Isolate Layer

This command freezes all the layers except the ones you select an entity on. The program prompts to see if you would like to retain the POINT layers which keeps the Carlson point layers from freezing. By default, these layers include PNTNO, PNTMARK, PNTDESC, and PNTELEV.

Prompts

Select objects on layers to isolate.
Select objects: pick entities
Retain POINT layers [Yes/No]? Press Enter

Isolate the wall layer by picking one wall line

Pulldown Menu Location: View
Keyboard Command: isolate
Prerequisite: None
**Restore Layer**
This command thaws the layers that were frozen by the *Isolate Layer* command.

*Pulldown Menu Location:* View  
*Keyboard Command:* restore  
*Prerequisite:* None

**Thaw/On All Layers**
This command turns on and thaws all layers in the drawing.

*Pulldown Menu Location:* View  
*Keyboard Command:* laa  
*Prerequisite:* None

**Layer Control By Name**

**Freeze Layer By Name**
This command will freeze layers by entering the layer names in a dialog. Multiple layers can be frozen at the same time.

*Pulldown Menu Location:* View > Layer Control By Name  
*Keyboard Command:* laz  
*Prerequisite:* None

**Thaw Layer By Name**
This command will thaw layers by entering the layer names in a dialog. Multiple layers can be thawed at the same time.

*Pulldown Menu Location:* View > Layer Control By Name  
*Keyboard Command:* lat  
*Prerequisite:* Frozen layers

**Isolate Layer By Name**
This command will isolate layers by entering the layer names in a dialog. Multiple layers can be isolated at the same time. The layers are isolated by freezing all the other layers. Use the Restore Layers command to thaw the layers frozen by Isolate.

*Pulldown Menu Location:* View > Layer Control By Name  
*Keyboard Command:* lai  
*Prerequisite:* None
Turn Layers On/Off

Turn Off By Pick
This command will turn off layers by picking entities on that layer. The entity selection is done one at a time. As entities are selected, the layers are turned off.

Prompts

Pick entity on layer to turn off: pick an entity
Turning off layer
Pick entity on layer to turn off (U-Undo, Enter to end): press Enter

Pulldown Menu Location: View
Keyboard Command: layeroffp
Prerequisite: None

Turn Off By Selection
This command will turn off layers by picking entities on that layer. The entity selection is done by selection set for selecting one or more entities.

Prompts

Select entities on layers to turn off.
Select objects: pick entities

Pulldown Menu Location: View
Keyboard Command: layeroffs
Prerequisite: None

Turn On Layers
This command turns on the layers turned off by the Turn Off commands.

Pulldown Menu Location: View
Keyboard Command: layeron
Prerequisite: None

Lock Layers/Unlock Layers
The Lock Layers command will lock the layers for the layers of the selected entities.

The Unlock Layers command will unlock the layers for the layers of the selected entities.

Pulldown Menu Location: View
Keyboard Command: laylock, layunlock
Prerequisite: None
Save/Restore Layer State

The *Save Layer State* command stores to a file all the layers in the drawing and their current status of color, freeze/thaw, on/off, and linetype. The layer state file has a .LAY extension. Later versions of AutoCAD include the ability to save and restore layer states, found in the layer dialog box.

The *Restore Layer State* command sets the drawing layers and their status from the layer information in a layer state file (.LAY file). If a layer from the layer state file does not exist in the drawing, the program will create the layer. Besides the Carlson format, the Land Desktop layer state format, which is also uses a .LAY extension, is supported by this command.

**Pulldown Menu Location:** View  
**Keyboard Command:** savelay, restlay  
**Prerequisite:** None
Shown here is the Draw menu of Carlson Field. There are many commands listed here for your drawing and image creation needs.
Line
This command allows you to draw a line entity by picking points on the screen or by supplying the coordinate values using the point number and associated coordinates stored in the current coordinate file. The Line command links the line with the points when the line is drawn using point numbers if the Link Linework with Points option is turned on. This option is set under General Settings in the Configure command in the Settings menu. With links active, changing a point with a command like Move Points automatically updates the line. This command always draws 2D lines with a zero elevation.

Prompts
1 Pick point or point numbers: 1-3
You may enter a single point number or a range of point numbers
2 Undo/Distance/<Pick point or point numbers>: 16
3 Undo/+/-/Close/Distance/<Pick point or point numbers>: 35
4 Undo/+/-/Close/Distance/<Pick point or point numbers>: +
The + or - activates an additional prompt option that allows you to plot line segments at a 90 degree deflection angle from the last line.
5 Perpendicular Distance Right: 80
6 Undo/+/-/Close/Distance/<Pick point or point numbers>: -
The + or - activates an additional prompt option that allows you to plot line segments at a 90 degree deflection angle from the last line.
7 Perpendicular Distance Left: 105.12
8 Undo/+/-/Close/Distance/<Pick point or point numbers>: D
The distance option allows you to input a distance for the next line segment. The position of the cursor determines the angle.
9 Enter distance: 174.32
10 Undo/+/-/Close/Distance/<Pick point or point numbers>: C
The close option draws a line segment back to the original starting point

Prerequisite: None

Keyboard Command: 2DLINE

2D Line
This command allows you to draw a line entity by picking points on the screen or by using the point number and associated coordinates stored in the current coordinate file. This command always draws 2D lines with a zero elevation. The line can also be drawn by entering distances and angles. See the 2D Polyline command for information on using the Distance and Extend input modes.

When the line is drawn using point numbers, the line is linked with the points if the Link Linework with Points option is turned on. This option is set under General Settings in the Configure command in the Settings menu. With links active, changing a point with a command like Move Points automatically updates the line.
Show Options on Startup: When this option is enabled, the dialog box will display automatically upon starting the command. If disabled, you can still get to this dialog by typing O for Options at the command prompt.

Prompt To Draw Another: This option stays in the command after completing the polyline and prompts whether you want to draw another polyline.

Auto-Zoom Mode: This setting provides 3 options for Auto-Zoom: Never, Proximity or Always. The "Never" setting requires you to manually Zoom or Pan to keep the current polyline vertex centered in the drawing screen. The "Proximity" setting will activate the "Proximity Level" setting and will automatically re-center the view only if the current polyline vertex is within a certain distance of the limits of the drawing area. The "Always" option will automatically re-center the view after each new polyline vertex is added.

Auto-Correct For 90 Degree Corners: This option will adjust two line segments to make an exact 90 degree corner when the original lines are nearly 90 degrees.

Use Current Drawing Properties: Select this option if you want the layer, color and linetype of the newly created polyline to match those currently set in the drawing.

Layer: Use this setting to manually assign the layer for the newly created polyline. You can type in the new layer name, use the "Select" button to choose an existing layer from the drawing's layer list or use the "Pick" button to select an entity in the drawing and match its layer.

Set Color: Use this button to manually specify a color for the newly created polyline.

Linetype: Use the "Select" button to manually specify a linetype for the newly created polyline.

Select Code: This option allows you to set the layer, color and linetype of a new polyline by using the properties assigned to a Field to Finish field code. The field code is selected from an existing Field Code table (.FLD) file that has been previously specified in the Point Defaults dialog box.

Prompts

Options/<Pick point or point numbers>: 1-3
You may enter a single point number or a range of point numbers
Distance/Undo/<Pick point or point numbers>: 16
Distance/Extend/Undo/Pick point or point numbers: 35
Distance/Extend/Undo/Pick point or point numbers: press Enter

Pulldown Menu Location: Draw
Keyboard Command: 2DLINE
Prerequisite: None

3D Line
This command draws line entities and is the same as Draw > 2D Line except that this command uses the elevations of the points to make 3D lines.

Pulldown Menu Location: Draw
Keyboard Command: 3DLine
Prerequisite: None

2D Polyline
This command creates a 2D polyline. A Polyline is a complex CAD entity comprised of one or more line or arc segments. While a 2D polyline elevation isn't necessarily zero, a 2D polyline is flat with all vertices at the same elevation.

This command is available from the Draw pulldown menu, from the Draw toolbar or at the Command: line (2DPL) and provides many more options than the standard CAD version of the command. Unless disabled, the Polyline 2D Options dialog box will appear after starting Carlson's 2D Polyline command.

Show Options on Startup: When this option is enabled, the Polyline 2D Options dialog box will display automatically upon starting the 2D Polyline command. If disabled, you can still get to this dialog by typing O for Options at the command prompt.
Elevation: Set the elevation of the polyline to be drawn. The Set Elevation By 1st Point option will use the elevation from the first specified point for the whole polyline.

Offset from Centerline: If this option is enabled, an additional option, Offset, is available from the Command: line. Issuing the "Offset" option allows you to draw a new polyline using Station and Offset entry from an existing polyline or existing Centerline (.CL) file.

Skip Inline Vertices for Extend: This setting applies to the "Extend" option with the Total Distance Sub-Menu option. If enabled, an existing vertex will dissolve when lengthening a 2D Polyline segment.

Prompt To Draw Another: This option stays in the command after completing the polyline and prompts whether you want to draw another polyline.

Auto-Zoom Mode: This setting provides 3 options for Auto-Zoom: Never, Proximity or Always. The "Never" setting requires you to manually Zoom or Pan to keep the current polyline vertex centered in the drawing screen. The "Proximity" setting will activate the "Proximity Level" setting and will automatically re-center the view only if the current polyline vertex is within a certain distance of the limits of the drawing area. The "Always" option will automatically re-center the view after each new polyline vertex is added.

Annotate Closed Pads: Enabling this option will activate the "Settings" button. The "Settings" button displays the Label Pad Elevations dialog box where you can specify label settings for the pad and other vertical offset elevations. For instance, you can label both the Finished Floor Elevation and the SubGrade elevation of a building pad at the same time using this command. See additional information on the Label Pad Elevation command.

In the "Polyline Properties" section of the dialog box you have several alternatives for specifying the layer, color and linetype of the newly created polyline.

Auto-Correct For 90 Degree Corners: This option will adjust two line segments to make an exact 90 degree corner when the original lines are nearly 90 degrees.

Smooth Polyline: This option applies for drawing smooth polylines such as a path for a stream. The Bezier smoothing method is used which passes through all the points and smooths only between the points.
Use Current Drawing Properties: Select this option if you want the layer, color and linetype of the newly created polyline to match those currently set in the drawing.

Layer: Use this setting to manually assign the layer for the newly created polyline. You can type in the new layer name, use the "Select" button to choose an existing layer from the drawing's layer list or use the "Pick" button to select an entity in the drawing and match its layer.

Set Color: Use this button to manually specify a color for the newly created polyline.

Width: Specify the width of the newly created polyline.

Linetype: Use the "Select" button to manually specify a linetype for the newly created polyline.

Select Code: This option allows you to set the layer, color and linetype of a new polyline by using the properties assigned to a Field to Finish field code. The field code is selected from an existing Field Code table (.FLD) file that has been previously specified in the Point Defaults dialog box.

Prompts

Command: 2dp
[Continue/Extend/Follow/Offset/OPtions/<Pick point or point numbers>]: screen pick a point
[Arc/Closed/Distance/Follow/Offset/Undo/<Pick point or point numbers>]: screen pick a point
Segment length: 202.55, Total length: 202.55
[Arc/Closed/Extend/Follow/Line/Offset/Undo/<Pick point or point numbers>]: screen pick a point
Segment length: 179.73, Total length: 382.28
[Arc/Closed/Extend/Follow/Line/Offset/Undo/<Pick point or point numbers>]: screen pick a point
Segment length: 127.45, Total length: 509.73
[Arc/Closed/Extend/Follow/Line/Offset/Undo/<Pick point or point numbers>]: press Enter
Command:

Options and SubMenu Options

Once all settings have been specified and the "OK" button is picked, the options shown below are available from the Command: line. To issue any of these options, simply type in the capitalized portion of the Option at the Command: line and press Enter. The default option is always shown between angle brackets <Default>.

Continue: This option allows you to select an existing polyline to which you'd like to add more line or arc segments. When prompted to "Select a polyline to continue or extend:", you may pick anywhere on the existing polyline and the new segment will begin at the ending vertex nearest your cursor. New line or arc segments can be added by screen-picking or using the options at the Command: line. Once finished adding segments, they are automatically joined to the original polyline.

Extend: This option gives you many ways to lengthen or shorten an existing polyline using the abbreviated SubMenu options shown below. Some of these options create additional segments at the end of the existing polyline and some allow you to change the length of the ending segment of the polyline. When prompted to "Select a polyline to continue or extend:", you may pick anywhere on the existing polyline and the "Extend" will occur at the ending vertex nearest your cursor. Once finished Extending, the new segments are automatically joined to the original polyline.

[I / R / L / S / T / A / B / E / U / X / Help / <Enter or Pick Distance>]
then prompt again for inches) and decimal feet.

**R - Right rotate** - From the ending vertex, turns the pointer 90-degrees to the right and then prompts for a distance.

**L - Left rotate** - From the ending vertex, turns the pointer 90-degrees to the left and then prompts for a distance.

**S - Switch direction** - From the ending vertex, turns the pointer 180-degrees and then prompts for a distance.

**T - Total distance** - Prompts you to "Enter total distance (100.00)" and displays the current length of the segment in parentheses. If a number smaller than the current distance is entered, this option will shorten the existing segment. If a number larger than the current distance is entered, this option will lengthen the existing segment. This option is also affected by the Skip Inline Vertices for Extend setting in the Polyline 2D Options dialog box. If "Skip Inline Vertices for Extend" is enabled, then the existing vertex will be dissolved when lengthening a segment. If the setting is not enabled, then the existing vertex will be left intact and an additional segment will be created inline.

**A - Angle change** - From the ending vertex, prompts you to "Enter Angle (ddd.mmss):" to turn the pointer by a specified angle and then prompts for a distance.

**B - Bearing/Azimuth/Turned/Deflection** - From the ending vertex, this option allows you to set the pointer direction by specifying an Angle. The Angle format is Qdd.mmss and there are a variety of ways to use the "Q" value to specify the Angle. See here for more.

**E - Extend to edge** - Extends current segment to another line or entity

**U - Undo** - Undo last action

**X - Quit extend mode** - Returns to normal 2D Polyline Draw mode

**Help** - Displays the descriptions of the Extend options

**Enter or Pick Distance** - Distance to extend the current segment

Follow: This option allows you to trace all or a portion of an existing polyline. After issuing the "Follow" option, you are prompted to "Select the polyline to Follow:" and then to "Specify the first follow point:". After snapping to a starting point on the polyline, you are asked whether you want to "Interpolate follow vertices elevations?". With this being a 2D Polyline, the answer to this is most likely "NO". You will then be prompted to specify the "Last follow point or follow distance:" where you can snap to another point on the polyline or type in a distance to trace the existing polyline.

Offset: With the "Offset" option, you will first be prompted to select an existing polyline or select an existing Centerline (.CL) file. Next, you will be asked to "Specify starting station:" where you will enter the station number of the first polyline vertex. Then, you will be prompted to "Enter Station" and "Enter Offset" for each vertex of the new polyline. Note: To have this option available, you must place a check next to Offset From Centerline in the Polyline 2D Options dialog box.

Pick Point or Point Numbers: This is the default prompt for the command. From here you can set a new polyline vertex by screen picking, entering coordinates in X,Y format or entering a point number from the associated Coordinate (.CRD) file.

Arc/Line: New polyline segments can be either an Arc or a Line segment. If the last polyline segment drawn was a LINE, then the "Arc" option will be shown as an available option; however, if the last polyline segment drawn was an ARC, then the "Line" option will be available.

When in the "Arc" mode, there are many additional SubMenu options available to you for creating an arc segment within the new polyline. The options are generated directly from the standard CAD version of the PLINE command and include Radius Point, Radius Length, Arc Length, Chord and Second Point (Point on Curve).

Close: This option will create a new Line or Arc segment back to the starting vertex of the polyline and results in a closed polyline.

Distance: This option allows you to first enter a distance for the new Line segment and then to specify the direction using one of three methods: Cursor, Line or Angle.

**Cursor** - This method will draw the polyline segment in the direction of your cursor position.

**Line** - This method prompts you to select a line or polyline segment to which it will draw a parallel segment.

**Angle** - This method prompts you for an Angle to determine the direction of your new polyline segment. The Angle
format is Qdd.mmss and there are a variety of ways to use the "Q" value to specify the Angle. See here for more.

**Undo:** Undo the last drawn polyline segment.

**Angle Entry Methods**
The Angle format is Qdd.mmss where: Q=quadrant/angle, d=degrees, m=minutes and s=seconds.
The Quadrant/Angle can be specified as:
1=NE (NorthEast)
2=SE (SouthEast)
3=SW (SouthWest)
4=NW (NorthWest)
5=AZ (AZimuth)
6=AL (turned Angle-Left)
7=AR (turned Angle-Right)
8=DL (Deflection angle-Left)
9=DR (Deflection angle-Right)

**Pulldown Menu Location:** Draw
**Keyboard Command:** 2DP
**Prerequisite:** None

---

**3D Polyline**

This command creates a 3D Polyline. A 3D Polyline is a version of a polyline that can have different elevation at every vertex. 3D Polylines can not have arcs and the program will instead draw a series of short chords to closely follow an arc.

The **3D Polyline** command is available from the Draw pulldown menu, from the Draw toolbar or at the Command: line (3DP). Unless disabled, the **Polyline 3D Options** dialog box will appear after starting Carlson's **3D Polyline** command.
**Show Options on Startup**: When this option is enabled, the Polyline 3D Options dialog box will display automatically upon starting the 3D Polyline command. If disabled, you can still get to this dialog by typing O for Options at the command prompt.

**Prompt for Elevation/Slope**: When this option is enabled, the elevation for each new vertex will be displayed as a prompt, giving you an opportunity to override that value by typing in a new elevation. When disabled, the elevation to be assigned to each new vertex is displayed but you are not given a chance to assign a different elevation.

**Prompt for Coordinate Point Elevations**: This option only applies if you specify a point number from an associated Coordinate (.CRD) file to establish the X,Y,Z values for a new 3D Polyline vertex. When this option is enabled, the elevation for each new vertex will be displayed as a prompt, giving you an opportunity to override that value by typing in a new elevation. When disabled, the elevation to be assigned to each new vertex is displayed but you are not given a chance to assign a different elevation.

**Elevation Adder**: Use this setting to add a constant elevation value to all default elevation values.

**Check Elevation Range**: Enabling this option allows you to monitor elevations assigned to 3D Polyline vertices and issue a warning (with options to correct) if the elevation falls outside the specified range. If the proposed elevation of a 3D Polyline vertex falls outside the range specified, the Warning: Elevation Range dialog box is displayed. The Warning: Elevation Range dialog box allows you to assign a new elevation to the vertex, adjust the acceptable range of elevations or turn OFF monitoring of elevations.

**Use Surface Model From File**: Selecting this option allows you to use a Surface Model (.TIN, .GRD, .FLT) file to
determine the elevation for each new 3D Polyline vertex.

**Skip Inline Vertices for Extend:** This setting applies to the "Extend" option with the Total Distance Sub-Menu option. If enabled, an existing vertex will dissolve when lengthening a 3D Polyline segment.

**Prompt To Draw Another:** This option stays in the command after completing the polyline and prompts whether you want to draw another polyline.

**Auto-Zoom Mode:** This setting provides 3 options for Auto-Zoom: Never, Proximity or Always. The "Never" setting requires you to manually Zoom or Pan to keep the current polyline vertex centered in the drawing screen. The "Proximity" setting will activate the "Proximity Level" setting and will automatically re-center the view only if the current polyline vertex is within a certain distance of the limits of the drawing area. The "Always" option will automatically re-center the view after each new polyline vertex is added.

In the "Polyline Properties" section of the dialog box you have several alternatives for specifying the layer, color and linetype of the newly created polyline.

**Auto-Correct For 90 Degree Corners:** This option will adjust two line segments to make an exact 90 degree corner when the original lines are nearly 90 degrees.

**Smooth Polyline:** This option applies for drawing smooth polylines such as a path for a stream. The Bezier smoothing method is used which passes through all the points and smooths only between the points.

**Use Current Drawing Properties:** Select this option if you want the layer, color and linetype of the newly created polyline to match those currently set in the drawing.

**Layer:** Use this setting to manually assign the layer for the newly created polyline. You can type in the new layer name, use the "Select" button to choose an existing layer from the drawing's layer list or use the "Pick" button to select an entity in the drawing and match its layer.

**Set Color:** Use this button to manually specify a color for the newly created polyline.

**Width:** Specify the width of the newly created polyline.

**Linetype:** Use the "Select" button to manually specify a linetype for the newly created polyline.

**Select Code:** This option allows you to set the layer, color and linetype of a new polyline by using the properties assigned to a Field to Finish field code. The field code is selected from an existing Field Code table (.FLD) file that has been previously specified in the Point Defaults dialog box.

**Prompts**

For A 3D Polyline With A Specified Elevation At Each Vertex:

Command: 3dp

[Continue/Extend/Follow/Options/<Pick point or point numbers>]: screen pick a point
Interpolate/Object/<Elevation> <0.00>: 150.50
Z: 150.50

[Arc/Close/Distance/Follow/Undo/<Pick point or point numbers>]: screen pick a point
Percent/Ratio/Elevation/Degree/Object/OSnap[.]/Next point or elevation<Interpolate>: 155.25
Z: 155.25, Hz dist: 324.63, Slope dist: 324.66, Slope: 1.5% Ratio: 68.3:1

[Arc/Close/Distance/Extend/Follow/Line/Undo/<Pick point or point numbers>]: screen pick a point
Percent/Ratio/Elevation/Degree/Object/OSnap[.]/Next point or elevation<Interpolate>: 148.12
Z: 148.12, Hz dist: 272.88, Slope dist: 272.98, Slope: -2.6% Ratio: -38.3:1
For a 3D Polyline with interpolated elevations at one or more vertices:

**Command:** 3dp

**Command:**

For a 3D Polyline with interpolated elevations at one or more vertices:

**Command:**

Note that the difference between this and the previous example is that, instead of entering an elevation for each vertex, we are screen picking another new vertex. Each time we neglect to enter an elevation we are notified that, "This point elevation will be interpolated upon completion." After we specify "94.44" as the elevation of the last vertex, the slope of the interpolated segments is calculated using the total elevation change and the total length of all interpolated segments. Now, the elevations of all vertices can be determined and set based on the resulting slope.

### Options and SubMenu Options

Once all settings have been specified and the "OK" button is picked, the options shown below are available from the Command line. To issue any of these options, simply type in the capitalized portion of the Option at the Command line and press Enter. The default option is always shown between angle brackets <Default>.

When starting a new 3D Polyline, the initial set of options assist you in setting the X,Y location of the first vertex:

**Continue:** This option allows you to select an existing polyline to which you'd like to add more line or arc segments. When prompted to "Select a polyline to continue or extend:.", you may pick anywhere on the existing polyline and the new segment will begin at the ending vertex nearest your cursor. New line or arc segments can be added by screen-picking or using the options at the Command line. Once finished adding segments, they are automatically joined to the original polyline.

**Extend:** This option gives you many ways to lengthen or shorten an existing polyline using the abbreviated SubMenu options shown below. Some of these options create additional segments at the end of the existing polyline and some allow you to change the length of the ending segment of the polyline. When prompted to "Select a polyline to continue or extend:.", you may pick anywhere on the existing polyline and the "Extend" will occur at the ending vertex nearest your cursor. Once finished Extending, the new segments are automatically joined to the original polyline.

**I / R / L / S / T / A / B / E / U / X / Help / <Enter or Pick Distance>**

**I - Input mode** - This option toggles the distance input between feet & inches (will prompt first for feet, then prompt again for inches) and decimal feet.
\textbf{R - Right rotate} - From the ending vertex, turns the pointer 90-degrees to the right and then prompts for a distance.

\textbf{L - Left rotate} - From the ending vertex, turns the pointer 90-degrees to the left and then prompts for a distance.

\textbf{S - Switch direction} - From the ending vertex, turns the pointer 180-degrees and then prompts for a distance.

\textbf{T - Total distance} - Prompts you to "Enter total distance (100.00)" and displays the current length of the segment in parentheses. If a number smaller than the current distance is entered, this option will shorten the existing segment. If a number larger than the current distance is entered, this option will lengthen the existing segment. This option is also affected by the Skip Inline Vertices for Extend setting in the \textbf{Polyline 3D Options} dialog box. If "Skip Inline Vertices for Extend" is enabled, then the existing vertex will be dissolved when lengthening a segment. If the setting is not enabled, then the existing vertex will be left intact and an additional segment will be created inline.

\textbf{A - Angle change} - From the ending vertex, prompts you to "Enter Angle (ddd.mmss):" to turn the pointer by a specified angle and then prompts for a distance.

\textbf{B - Bearing/Azimuth/Turned/Deflection} - From the ending vertex, this option allows you to set the pointer direction by specifying an Angle. The Angle format is Qdd.mmss and there are a variety of ways to use the "Q" value to specify the Angle. See here for more.

\textbf{E - Extend to edge} - Extends current segment to another line or entity

\textbf{U - Undo} - Undo last action

\textbf{X - Quit extend mode} - Returns to normal 3D Polyline Draw mode

\textbf{Help} - Displays the descriptions of the Extend options

\textbf{Enter or Pick Distance} - Distance to extend the current segment

\textbf{Follow}: This option allows you to trace all or a portion of an existing polyline. After issuing the "Follow" option, you are prompted to "Select the polyline to Follow:" and then to "Specify the first follow point:". After snapping to a starting point on the polyline, you are asked whether you want to "Interpolate follow vertices elevations?". After answering Yes or No, you will then be prompted to specify the "Last follow point or follow distance:" where you can snap to another point on the polyline or type in a distance to trace the existing polyline.

\textbf{Options}: This will display the \textbf{Polyline 3D Options} dialog box.

\textbf{Pick Point or Point Numbers}: This is the default prompt for the command. From here you can set a new polyline vertex by screen picking, entering coordinates in X,Y format or entering a point number from the associated Coordinate (.CRD) file.

After setting its location, the next set of options help you calculate the elevation of the initial vertex:

\textbf{Interpolate}: This option will set the elevation of the vertex by calculating the slope between other vertices of known elevation.

\textbf{Object}: This option allows you to "Select an elevation label or a point on a polyline:" to set the elevation of the vertex. Elevation labels such as "FFE: 124.85" or "Z: 124.85" can be selected.

\textbf{Adjust}: This option allows you to add or subtract an amount from the elevation like for a curb offset.

\textbf{Elevation}: This is the default option and prompts you to type in the elevation for the vertex.

For subsequent 3D Polyline vertices, several options are added to assist you in setting the X,Y location of each new vertex:

\textbf{Arc/Line}: New polyline segments can be either an Arc or a Line segment. If the last polyline segment drawn was a LINE, then the "Arc" option will be shown as an available option; however, if the last polyline segment drawn was an ARC, then the "Line" option will be available.

When in the "Arc" mode, there are many additional SubMenu options available to you for creating an arc segment within the new polyline. The options are generated directly from the standard CAD version of the PLINE command and include Radius Point, Radius Length, Arc Length, Chord and Second Point (Point on Curve).

\textbf{Close}: This option will create a new Line or Arc segment back to the starting vertex of the polyline and results in a closed polyline.
Distance: This option allows you to first enter a distance for the new Line segment and then to specify the
direction using one of three methods: Cursor, Line or Angle.

**Cursor** - This method will draw the polyline segment in the direction of your cursor position.

**Line** - This method prompts you to select a line or polyline segment to which it will draw a parallel segment.

**Angle** - This method prompts you for an Angle to determine the direction of your new polyline segment. The Angle format is Qdd.mmss and there are a variety of ways to use the "Q" value to specify the Angle. See here for more.

**Undo**: Undo the last drawn polyline segment.

After setting subsequent vertices, several more options are added to help you calculate the elevation of each
new vertex:

**Percent**: This option allows you to specify the slope in Percent format (3%) from the previous vertex.

**Ratio**: This option allows you to specify the slope in Ratio format (for 3:1, enter 3) from the previous vertex.

**Degree**: This option allows you to specify the slope angle in decimal degree format (dd.dddd) from the previous
vertex.

**Osnap[.]**: Using the [.] will toggle Running OSNAP settings ON or OFF.

**Angle Entry Methods**
The Angle format is Qdd.mmss where: Q=quadrant/angle, d=degrees, m=minutes and s=seconds.
The Quadrant/Angle can be specified as:
1=NE (NorthEast)
2=SE (SouthEast)
3=SW (SouthWest)
4=NW (NorthWest)
5=AZ (AZimuth)
6=AL (turned Angle-Left)
7=AR (turned Angle-Right)
8=DL (Deflection angle-Left)
9=DR (Deflection angle-Right)

**Pull down Menu Location**: Draw

**Keyboard Command**: 3DP

**Prerequisite**: None

---

**Circle**

This command allows you to draw a circle.

**Prompts**

1 Pick center point or point number or [3P/2P/TTR]: pick point or specify option
   - 3P: This option draws a circle based on three points on the circumference.
   - 2P: This option draws a circle based on two endpoints of the diameter.
   - TTR-Tangent, Tangent, Radius: This option draws a circle with a specified radius tangent to two objects.
2 Specify radius of circle or [Diameter]: enter a value

Sometimes more than one circle matches the criteria specified in the command. The circle whose tangent points are
closest to the selected points is drawn.

**Prerequisite**: None
Arc

3 Point
This command draws an arc between three points. The first point is the PC, the second is a point on the arc and the third is the PT. The points can either by picked on-screen or specified by point number.

Prompts

Pick PC point or point numbers: 101 (For point number 101.)
Pick Second point or point number: 102
Pick PT point or point number: 103

Pulldown Menu Location: Draw > Arc
Keyboard Command: 3PA
Prerequisite: None

PC, PT, Center
This command draws an arc between the PC point, radius point and PT point. The points can either by picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counterclockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.

Prompts

Pick PC point or point number: 101
Pick Radius point or point number: 102
Pick PT point or point number: 103
Is the direction of this arc correct ? No/<Yes>: N

Pulldown Menu Location: Draw > Arc
Keyboard Command: pca
Prerequisite: None

PC, PT, Radius
This command draws an arc that is defined by the specified PC point, PT point and radius length. The points can either by picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counterclockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.

Prompts

Pick PC point or point number: pick a point
Radius length: 300
Pick PT point or point number: pick a point
Is the direction of this arc correct [<Yes>/<No]]? press Enter for Yes

Pulldown Menu Location: Draw > Arc
Keyboard Command: pcptr
Prerequisite: None
PC, PT, Tangent

This command fits a curve between beginning and end points (PC, PT) given a tangent-in. The tangent-in is specified by selecting a line entity. The PC and PT points are screen picked.

Prompts
- Pick tangent-in: *pick a line entity*
- Pick point PC: *pick a point*
- Pick point PT: *pick a point*

Pulldown Menu Location: Draw > Arc
Keyboard Command: tangpcpt
Prerequisite: Tangent line

PC, Radius, Chord

This command draws an arc, given the PC point, radius length, chord length and chord bearing. The PC point can either by picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counter-clockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.

Prompts
- Radius of Arc <40.00>: 500
- PC Start Point ?
- Pick point or point number: *pick a point*
- Chord bearing or chord endpoint (<Bearing>/Point)? Press Enter
- Enter Bearing (Qdd.mmss) <90.0000>: 145.1041 (for NE 45d10'41'')
- Chord Length <200.46>: 200
- Is this arc in the correct direction (<Yes>/No)? Press Enter

Pulldown Menu Location: Draw > Arc
Keyboard Command: srcb
Prerequisite: None

PC, Radius, Arc Length

This command draws an arc given the PC point, radius length, and arc length. The PC point can either by picked on-screen or specified by point number. Given these points, the arc can be drawn clockwise or counterclockwise. The program shows one direction and asks if it is correct. If you need the arc to go the other direction, enter No.

Prompts
Pick PC Point or point number: pick a point
Pick Radius point or point number: pick a point
Arc length <5.00>: 150
Is this arc in the correct direction (<Yes>/No)? press Enter

Pulldown Menu Location: Draw > Arc
Keyboard Command: pra
Prerequisite: None

2 Tangents, Radius
This command fits a curve between two tangent lines by entering a known radius. It prompts for the radius and then prompts to pick points on the two tangent lines.

Prompts
Radius of Arc <300.00>: press Enter
[nea] Pick Point on 1st Tangent Line: pick a point
[nea] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlin
Prerequisite: Tangent lines should be drawn before execution

2 Tangents, Arc Length
This command fits a curve between two tangent lines and a known arc length. It prompts for the arc length then pick the P.I. (intersection of tangent lines) and points on the two tangent lines.

Prompts
Arc Length <100.00>: press Enter or enter distance
[int on] Pick P.I. of curve: pick intersection of tangent lines
[nea on] Pick pnt on 1st Tangent Line: pick a point
[nea on] Pick pnt on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlal
Prerequisite: Tangent lines should be drawn before execution

2 Tangents, Chord Length
This command fits a curve between two tangent lines and a known chord length. It prompts for the chord length, the P.I. and points on the two tangent lines.

Prompts
Chord Length <100.00>: press Enter
[int on] Pick P.I. of curve: pick a point
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlcl
Prerequisite: Tangent lines should be drawn before execution

2 Tangents, Mid-Ordinate
This command fits a curve between two tangent lines and a known middle ordinate. It prompts for the middle ordinate length, the Point of Intersection and points on the two tangent lines.

Prompts
Middle Ordinate <50.00>: press Enter
[int on] Pick P.I. of curve: pick a point
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlmo
Prerequisite: Tangent lines should be drawn before execution

2 Tangents, External
This command fits a curve between two tangent lines and a known external secant distance. It prompts for the P.I. and points on the two tangent lines then the external distance.

Prompts

[int on] Pick P.I. of curve: pick a point
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point
External Distance <50.00>: press Enter

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanlex
Prerequisite: Tangent lines should be drawn before execution
2 Tangents, Tangent Length

This command fits a curve between two tangent lines and a known curve tangent length. It prompts for the tangent length, P.I. and points on the two tangent lines.

Prompts

Tangent Length <50.00>: press Enter
[int on] Pick P.I. of curve: pick a point
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanltl
Prerequisite: Tangent lines should be drawn before execution

2 Tangents, Degree of Curve

This command fits a curve between two tangent lines by entering a known degree of curve. It prompts for the degree of curve and then prompts to pick points on the two tangent lines.

Prompts

Degree of Curve (ddd.mmss) <5.0000>: press Enter
Define by [C]hord or [A]rc length <A>: press Enter
[nea on] Pick Point on 1st Tangent Line: pick a point
[nea on] Pick Point on 2nd Tangent Line: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanldo
Prerequisite: Tangent lines should be drawn before execution

2 Tangents, Through Point

This command creates an arc by tangents in/out plus a pass through point on the arc.

Prompts

Pick tangent-in: pick a line entity
Pick tangent-out: pick another line entity
Pick point on the arc: pick a point

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2tanpt
Prerequisite: 2 tangent lines

Tangent, PC, Radius, Arc Length
This command draws a curve from a perpendicular tangent line with a known radius and arc length. It prompts for the radius, the arc length and then to pick the P.C. start point of the curve (endpoint of previously drawn tangent line) and a point along the tangent line.

Prompts
Precede radius with - sign for curve to the left.
Radius of Arc <15.00>: 55
Arc Length <25.00>: 30
PC Start Point?
Pick point/<point Number>: 14
PtNo. North(y) East(x) Elev(z) Desc
14 4869.06 4390.3 10.00
[nea on] Pick point along perpendicular tangent line: pick a point on tangent line
Radius Point Coordinates: (4355.2 4911.4 0.0)
Pulldown Menu Location: Draw > Arc
Keyboard Command: sral
Prerequisite: Tangent lines should be drawn before execution

Tangent, PC, Radius, Tangent Length
This command draws a curve from a perpendicular tangent line with a known radius and tangent length. It prompts for the radius, the tangent length and then to pick the P.C. start point of the curve and a point along the tangent line.

Prompts
Precede radius with - sign for curve to the left.
Radius of Arc <300.000>: press Enter
Tangent Length <236.000>: press Enter
PC Start Point?
Pick point or point number: pick a point
[nea on] Pick point along perpendicular tangent line: pick a point
(5270.39 4840.36 0.0)
Radius Point Coordinates: (5251.37 4534.71 0.0)
Tang, PC, Radius, Chord Length
This command draws a curve from a perpendicular tangent line with a known radius and chord length. It prompts for the radius, the chord length and then to pick the P.C. start point of the curve and a point along the tangent line.

Prompts
Precede radius with - sign for curve to the left.
Radius of Arc <300.000>: press Enter
Chord Length <25.000>: press Enter
PC Start Point ?
Pick point or point number: pick a point
[nea on] Pick point along perpendicular tangent line: pick a point
(5142.38 4911.57 0.0)
Radius Point Coordinates: (5221.51 5209.63 0.0)

Tang, PC, Radius, Delta Angle
This command draws a curve from a perpendicular tangent line with a known radius and delta angle. It prompts for the radius, the delta angle and then to pick the P.C. start point of the curve and a point along the tangent line.

Prompts
Precede radius with - sign for curve to the left.
Radius of Arc <300.00>: press Enter
Enter Delta Angle <90.00>: press Enter
PC Start Point ?
Number/<Pick point>: pick a point
[nea on] Pick point along perpendicular tangent line: pick a point

Arc From Last Point
This command draws an arc that is tangent from the last point of the most recent linework or arc entity. The PC point of the arc is automatically set from this last point. This command only prompts for the PT point to create the arc.

Prompts
**Compound or Reverse**

This command draws a compound or reverse off an existing curve. It prompts whether the curve is reverse or compound, for the P.C. start point (endpoint of an existing arc) and the known radius. Then the user selects the other known from the choices of tangent length, arc length, chord length or delta angle and enters that value. This command can be confused and malfunction if there is another entity such as a point symbol at the P.C. (If this happens, freeze the PNTMARK layer or temporarily erase the point symbol.)

**Prompts**

-end on- Select ARC at PC Start point of the curve: pick a point  
Type of curve [Compound/Reverse]: press Enter  
Enter the Radius: 300  
Define arc method [Tangent/Chord/Delta/Length]: press Enter  
Enter the arc length: 236

**3D Arc**

This command draws an arc in 3D using three points for input. The points are the beginning of the arc (PC), a point along the arc, and the end of the arc (PT).

**Prompts**

Pick PC point or point numbers: pick a point  
Point on arc.  
Pick point or point number: pick a point  
PT point.  
Pick point or point number: pick a point  

Chapter 7. Draw Menu
2-Radius Curve Series

This command draws a series of two curves with different radii between 2 tangents. In the dialog, set the layer to draw, the radius for each curve and the arc length of the first curve. The program calculates the length of the second curve to fit with the tangents. After the dialog, the program prompts to pick 2 lines to define the tangents in and out.

Prompts

Pick first tangent: *pick a line*
Pick second tangent: *pick a line*

Pulldown Menu Location: Draw > Arc
Keyboard Command: 2curves
Prerequisite: Two tangents

3-Radius Curve Series

This command is used to fit a series of three curves with different radii between 2 tangents. The "Offsets from the Tangents" is the distance perpendicular to the tangent from both ends of the second curve.
Offset from the tangents is the x value

Prompts

Please pick two tangents...
Pick first tangent: pick a line
Pick second tangent: pick a line

Pulldown Menu Location: Draw > Arc
Keyboard Command: 3curves
Prerequisite: Two tangents

Best Fit Curve
This command draws an arc between two endpoints with a radius that is derived from sampling points. Least-squares is used to find the radius for the closest arc that passes through these points. The Hold End Points option applies additional weight to the end points by the specified weight factor. After specifying the points, the program calculates the best-fit arc and shows the results in the dialog show here. You can toggle each point for whether to include in the calculations. When a point is toggled off for processing, it is not used to calculate the best-fit arc but the residual is still reported. Use the Remove button to remove a point both from calculation and reporting. You can also modify the radius. After picking OK, the arc is drawn in the current layer and there is a report.

Prompts

Starting Point?
Pick point or point number: 46
Ending point?
Pick point or point number: 50
Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter
Select Carlson Software Points.
Select objects: pick points
Hold end points [Yes/<No>]? press Enter

Best Fit Curve

Best Fit Arc
Coordinate File: C:\sample\PLAT.CRD

Source Coordinates
Point# Northing Easting Residual
46 4573.478 5647.688 -0.059
47 4618.130 5667.428 0.177
48 4669.960 5671.494 -0.211
50 4707.039 5664.138 0.093
Point# Northing Easting Residual
46 4573.478 5647.688 -0.059
47 4618.130 5667.428 0.177
48 4669.960 5671.494 -0.211
50 4707.039 5664.138 0.093

Residuals Standard Deviation: 0.148
Average Residual: 0.135

Circle Center: 4657.233, 5516.647
Radius: 155.580

Pulldown Menu Location: Draw > Arc
Keyboard Command: bfitcrv
Prerequisite: Points for sampling should be drawn before execution.

Curve Calc
This Curve Calculator command displays a dialog box with a series of edit boxes that are filled in with the values of a curve. You can input two known values and the program calculates the other values. One of the known values must be the radius or the delta angle. The 3 Points option allows you to simply select three on-screen point locations. All of the fields will immediately be filled in after the picking of the third point. Optionally, you can also input point numbers from a coordinate file.
**Roadway or Railroad:** Allows you to choose which type of curve you would like information on. Toggling between the two, after data is entered, will reveal different values.

**Select:** Allows you to select an arc from the drawing. The information for the selected arc is displayed in the dialog box.

**3 Points:** Allows you to specify three points on the screen to define an arc. The information for this defined arc is displayed in the dialog box.

**Plot:** Allows you to plot the currently defined arc in the drawing.

**Clear:** Clears all edit boxes in the dialog.

**Prompts**

**Curve Calculator dialog** *Enter at least two values, as described above*

The dialog box first pops up without any data in the fields. The above dialog graphic is a result of entering in the radius and the arc length values of a known curve, then the *Enter* or *Tab* key.

**Pulldown Menu Location:** Draw > Arc

**Keyboard Command:** curvecalc

**Prerequisite:** None

**Spiral Curve**

This command plots a spiral curve. The user must provide the P.I. (point of intersection), the length of spiral and the radius length of the simple curve. The command will plot a symmetrical spiral or a spiral in or spiral out (choose the S option for the first prompt if you only want to plot a spiral out). If you have an unsymmetrical spiral then plot a spiral in using the T or P option then use the S option to plot the spiral out. The command plots a polyline to represent the spiral as line segments at the resolution specified by the user. You can use the *Calculate Offsets, Station Polyline/Centerline* or *Offset Point Entry* commands, found in the Centerline menu, to calculate points and/or stations and offsets from the spiral.

**Prompts**

**Spiral method [TS/ST/<PI>] press Enter**

**PI Point ?**
Pick point or point number: pick intersection of tangent lines
TS Direction point (tangent in) ?
Pick point or point number: pick point along tangent in line
ST Direction point (tangent out) ?
Pick point or point number: pick point along tangent out line
Tangent in direction= N 56d24'9" E Azimuth= 56d24'9"
Tangent out direction= S 65d9'1" E Azimuth= 114d50'59"
Overall Delta= 58d26'50"
Point calculating distance resolution <10.0>: press Enter
Length of Spiral <350.0>: press Enter
Radius of simple curve (precede with - sign if curve to left) <954.93>: 954.93
Degree of curve: 6d0'0"
Theta of Spiral= 0.18325951 (radians) 10d30'0" (dd.mmss)
Distance along tangent line from TS to SC= 348.82
Distance offset from tangent line to SC= 21.33
(k) Shift along tangent line of PC= 174.80
(p) Shift offset from tangent line of PC= 5.34
Distance from PI to TS= 712.00
North(Y) of TS= 4583.08 East(X) of TS= 4244.46
North(Y) of SC= 4758.34 East(X) of SC= 4546.82
North(Y) of Offset PC= 4675.36 East(X) of Offset PC= 4393.02
[P]lot spiral or
[I]ntermediate distances for staking (deflection angle calc) <P>: press Enter
Point calculating distance resolution <10.0>: 5 Enter the resolution at which you would like the line segments of the representative polyline plotted.
North(Y) of Radius Pt= 3879.96 East(X) of Radius Pt= 4921.44
<press [Enter] for symmetrical spiral out> /[D]elta of simple curve: press Enter If you want a spiral in only enter D then input the delta angle of the curve.
Simple Curve Delta= 37d26'50" Length of Arc= 624.12
North(Y) of CS= 4805.10 East(X) of CS= 5158.11
Pulldown Menu Location: Draw > Arc
Keyboard Command: spiral
Prerequisite: For a symmetrical spiral, draw the tangent in and tangent out lines. For spiral in or out only, draw the tangent line in or out.

Text

Creates a single-line text object.

You can use the TEXT to enter several lines of text that you can rotate, justify, and resize. As you type at the Enter Text prompt, the text you are typing is displayed on the screen. Each line of text is a separate object. To end a line and begin another, press Enter after entering characters at the Enter Text prompt. To end the TEXT command, press Enter without entering any characters at the Enter Text prompt.

By applying a style to the text, you can use a variety of character patterns or fonts that you can stretch, compress, make oblique, mirror, or align in a vertical column.

If TEXT was the last command entered, pressing ENTER at the Specify Start Point of Text prompt skips the prompts for height and rotation angle and immediately displays the Enter Text prompt. The text is placed directly beneath the previous line of text. The point specified at the prompt is also stored as the Insertion Point object snap.

Prompts

1 Current text style: "MONO" Text height: 4.00
2 Specify start point of text or [Justify/Style]: S
The style option lets you change the text style on the fly
3 Enter style name or [?] <MONO>: STANDARD
4 Current text style: "STANDARD" Text height: 4.00
5 Specify start point of text or [Justify/Style]: J
The justify option lets you specify the justification for the text.
6 Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]: BC
In this case BC = Bottom Center
7 Specify bottom-center point of text: pick point or enter coordinates
8 Specify height <4.00>: press enter to select default or enter text height
9 Specify rotation angle of text <0d0'0'0'0'>: press enter to select default or enter angle
10 Enter text: Found Iron Pin
11 Enter text: press enter to end
Prerequisite: None
Keyboard Command: DTEXT, TEXT

Text Wizard
This command creates text using a dialog to set the text properties. In the dialog, you set the text string to create, height, justification, layer, style and color. Text Rotation chooses between having the label horizontal to the current view, prompting for the label angle or at a fixed angle specified in the dialog. The Use MText setting controls whether to create the text as a regular Text entity type or as MText. The Use Current Drawing Properties option will use the current layer, style and color from the drawing instead of the dialog.

Prompts

Draw Text dialog
Text location: pick a point

Pulldown Menu Location: Draw > Text
Keyboard Command: drawtext
Prerequisite: None

Text Import
This command reads a text file and draws the contents as text entities. The file to import and the options are set in the dialog shown here.

When using a Microsoft Word .doc or .docx file, the document is drawn as MText using the formatting from the document. There is an option to link the MText to the document so that the MText is updated when the document in changed. This update is done when the drawing is opened or running a REGEN.

Pulldown Menu Location: Draw
Keyboard Command: textin
Prerequisite: text file

Text Export
This command writes a text file from the selected Text and MText entities. The text is sorted to output in top to bottom order based on the entity locations.

Pulldown Menu Location: Draw
Keyboard Command: textout
Prerequisite: text entities

Field Text
This command adds predefined and custom text objects to your drawing that are updated when a drawing is Regenerated or Saved. Custom fields refresh their data from the Custom Properties defined in the Layout Manager. For
example, one of the available fields is Layout Page Number which can be placed as a text entity on a layout. Then if the layout page number changes, the text is updated.

**Category**: The Category list is used to filter the Available Fields. Selecting All will show all Categories. Some Categories, such as Current Layout Set, Current Layout Subset and Current Layout will only be displayed if the current drawing is attached to a Layout Set file (.set).

**Add**: Use the Add button to add an Available Field to the Selected Fields list. As you add fields sequentially to the Selected Fields list, the name and row number will be displayed. You can change the row number if you would like the field to appear on a new line. See the Setup button description for more information.

**Remove**: Use the Remove button to remove a field from the Selected Fields list.

**Setup**: Use the Setup button to edit the Prefix, Suffix and other contextual properties of the field. For example, Date fields will show a Date Format option, and numeric fields may show a precision format option. Toggle the "Place on new row" checkbox to place the field on a new line. The Field Setup dialog can also be invoked by double clicking a Selected Field list item.

**Move Up**: Use the Move Up button to move the selected field above the previous field.

**Move Down**: Use the Move Down button to move the selected field below the next field.
**Draw Field As:** This setting controls whether the Field is drawn as Text, MText or block attribute objects. The block attribute method can be used to fill out attributes in your title block.

**Pulldown Menu Location:** Draw > Text  
**Keyboard Command:** drawfield  
**Prerequisite:** None

---

**Text on Line**

This command creates text aligned by the selected linework. In the options dialog, you set the text string to create, height, layer, style, color, justification and text entity type. The Text Offset controls the distance between the linework and the text. The Slide option allows you to graphically place the text. The User Current Drawing Properties option will use the current layer, style and color from the drawing instead of the dialog. The Hide Drawing Under Labels creates a Wipeout entity under the text label. The Selection method by Individual prompts for a line or polyline segment to place a single text label at a time. The Crossing Line method prompts to pick two points in the drawing and places the text label at every linework intersection along the line between the two points.

![Create Text on Line dialog]

**Prompts**

Create Text on Line dialog  
**Pick line or polyline segment:** select linework entity  
**Pick point for slide:** pick a point

**Pulldown Menu Location:** Draw > Text  
**Keyboard Command:** textline  
**Prerequisite:** polyline or line
Text on Polyline

This command creates text with each character aligned by the selected polyline. In the options dialog, you set the text string to create, height and offset. The Text Offset controls the distance between the polyline and the text. The Slide option allows you to graphically place the text. The Hide Drawing Under Labels creates a Wipeout entity under the text label. The Selection method by Individual prompts for a line or polyline segment to place a single text label at a time. The Crossing Line method prompts to pick two points in the drawing and places the text label at every linework intersection along the line between the two points.

Prompts

Create Text on Polyline dialog
Pick polyline: select polyline entity
Pick point for slide: pick a point

Pull Down Menu Location: Draw > Text
Keyboard Command: textpline
Prerequisite: polyline

Text Mask

This command hides drawing entities under text by creating a wipeout entity around the text. The Offset is a distance in drawing units to create a buffer around the text.
Select text to mask.
Select entities: pick text
Offset <0.100>: press Enter

Pulldown Menu Location: Draw > Text
Keyboard Command: textmask
Prerequisite: text

Draw Barscale
This command draws a barscale. You will be prompted for the horizontal scale. The default value is set in the Drawing Setup command in the Settings menu.

```
0'  50'  100'  150'
```

Prompts
1 Insertion Point: pick a point
2 Horizontal scale <50.0>: Press Enter
Prerequisite: None
Keyboard Command: BARSCALE

Draw North Arrow
This command inserts a north arrow symbol. You can select from several styles of arrows, and you can add your own by using the Edit Symbol Library command on the Settings menu.

Prompt

Draw North Arrow Dialog choose an arrow symbol, layer and other variables
Specify insertion point: pick a point
**Keyboard Command:** narrow  
**Prerequisite:** None

**Draw Box Around Text**

This command draws a rectangle to enclose the selected text. This rectangle is drawn as a polyline in the current layer. The options dialog has Gap Factor which controls the offset from the text to the polyline. The factor is relative to the text size. The Round Corners option fillets the corners of the box.

![Draw Box Around Text](image)

**Prompts**

[Options/<Select text>]: pick the text to box or type O for the options dialog.

**Pulldown Menu Location:** Draw > Text  
**Keyboard Command:** textbox  
**Prerequisite:** Text entity
Draw Table
This command creates a table entity by reading a delimited text file such as a comma separated file (CSV). In the options dialog, set the Delimiter for the character that separates the values in the text file. Also there is an option for whether to create a totals line at the end of the table. The Link Table option will update the table in the drawing when the text file is updated. This update is done when the drawing is opened or running a REGEN.

After picking the location to draw the table, there is a dialog for formatting the table. You can control the header names, width, size, alignment and style. There are settings for the table layer, color and title.

<table>
<thead>
<tr>
<th>DRILLHOLE</th>
<th>NORTH</th>
<th>EAST</th>
<th>SURFACE</th>
<th>STRATA</th>
<th>BOTDEPTH</th>
<th>MOISTURE</th>
<th>PLASTICITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>B-1</td>
<td>219064.77</td>
<td>6134999.45</td>
<td>618.500</td>
<td>CLAY</td>
<td>5.000</td>
<td>62.000</td>
<td>59.000</td>
</tr>
<tr>
<td>B-2</td>
<td>219064.77</td>
<td>6134999.45</td>
<td>618.500</td>
<td>LIMESTONE</td>
<td>12.000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B-3</td>
<td>219068.24</td>
<td>6135073.06</td>
<td>618.400</td>
<td>CLAY</td>
<td>4.400</td>
<td>60.000</td>
<td>57.000</td>
</tr>
<tr>
<td>B-4</td>
<td>219068.24</td>
<td>6135073.06</td>
<td>618.400</td>
<td>LIMESTONE</td>
<td>12.500</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B-5</td>
<td>219078.64</td>
<td>6135102.68</td>
<td>617.600</td>
<td>CLAY</td>
<td>3.000</td>
<td>34.000</td>
<td>55.000</td>
</tr>
<tr>
<td>B-6</td>
<td>219078.64</td>
<td>6135102.68</td>
<td>617.600</td>
<td>LIMESTONE</td>
<td>11.000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B-7</td>
<td>219054.60</td>
<td>6135198.22</td>
<td>618.560</td>
<td>CLAY</td>
<td>2.500</td>
<td>59.000</td>
<td>61.000</td>
</tr>
<tr>
<td>B-8</td>
<td>219054.60</td>
<td>6135198.22</td>
<td>618.560</td>
<td>LIMESTONE</td>
<td>10.500</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B-9</td>
<td>219093.22</td>
<td>6135182.05</td>
<td>615.100</td>
<td>CLAY</td>
<td>4.250</td>
<td>50.000</td>
<td>58.000</td>
</tr>
<tr>
<td>B-10</td>
<td>219093.22</td>
<td>6135182.05</td>
<td>615.100</td>
<td>LIMESTONE</td>
<td>12.750</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B-11</td>
<td>219996.06</td>
<td>6135103.44</td>
<td>616.560</td>
<td>CLAY</td>
<td>3.000</td>
<td>59.000</td>
<td>59.000</td>
</tr>
<tr>
<td>B-12</td>
<td>219996.06</td>
<td>6135103.44</td>
<td>616.560</td>
<td>LIMESTONE</td>
<td>12.000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B-13</td>
<td>219996.06</td>
<td>6135103.44</td>
<td>616.560</td>
<td>LIMESTONE</td>
<td>12.000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>B-14</td>
<td>219994.83</td>
<td>6134946.24</td>
<td>617.760</td>
<td>CLAY</td>
<td>5.000</td>
<td>40.000</td>
<td>54.000</td>
</tr>
<tr>
<td>B-15</td>
<td>219994.83</td>
<td>6134946.24</td>
<td>617.760</td>
<td>LIMESTONE</td>
<td>12.500</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Prompts
Select Input Data File
Draw Table options dialog
Pick location for report table: pick a point
Table Options dialog

Pulldown Menu Location: Draw
Keyboard Command: csv2tbl
Prerequisite: delimited text file to import

Text UnMask
This command removes text masks from the selected text entities.

Prompts
Select text to unmask.
Select entities: pick text
White Solid Behind Text

This command draws a white solid rectangle to highlight the selected text. The display order for the solid is set behind the text and the solid is drawn on the current layer. This command is only useful when the text itself is not white. At the command prompt, type O for Options to bring up the settings dialog for how to set the layer for the solid.

![White Solid Behind Text dialog]

Prompts

[Options/<Select text>]: pick the text to highlights

Trim Linework Through Text

This command trims linework that crosses text. After selecting the text to trim with and entering a buffer offset around the text, the program automatically finds any crossing linework and trims.

Prompts

Select text: pick the text to trim with
Enter gap <0.5>: press Enter

Symbols

This command inserts symbols from the symbol library into the drawing. The symbol library may be edited using the Edit Symbol Library command. The locations for the symbols can be specified by picking points, specifying point numbers in the current coordinate (.CRD) file or by entering the northing and easting. If you specify a point number, and that point number already has a symbol on it, you will be prompted whether or not to replace the existing symbol. Selecting the Enter coords option allows you to insert the symbol by entering a northing, easting and elevation. Using the Select entities option, symbols can also be placed on arcs, faces, points, text, lines and
polyline. Under the Options command, you can turn prompting for rotation on or off. With rotation off, the symbol will be inserted horizontal to the current twist screen. Choose a symbol from the Select Symbol dialog by clicking on it. The Symbol Category choices are Points, Trees and Map Symbols. You may select a category by choosing the Symbol Category dropdown list. Within each category, use the scroll bar to view all of the symbols.

Appears at start of command

Appears when Select (symbol) is chosen
Prompts

**Insert Symbols dialog** choose variables and click **OK**

**Options/Select entities/Enter coords/\(<\text{Pick point or point numbers}\)>**: *pick a point*

**Options/Select entities/Enter coords/\(<\text{Pick point or point numbers}\)>**: 5-10 Inserts symbols at points 5-10 from the current coordinate file.

**Options/Select entities/Enter coords/\(<\text{Pick point or point numbers}\)>**: S

**Insert Symbols dialog**

Select arcs, faces, points, text, lines and polylines. select objects

**Options/Select entities/Enter coords/\(<\text{Pick point or point numbers}\)>**: press Enter to end

**Keyboard Command**: ptsym

**Prerequisite**: None

---

**Insert Symbols**

This command inserts symbols from the symbol library into the drawing. The symbol library may be edited using the *Edit Symbol Library* command.

In the Insert Symbols options dialog, choose a symbol by entering the Symbol Name or by picking the Select button which brings up the Select Symbol dialog. The default Symbol Category choices are Points, Trees and Map Symbols. You may select a category by choosing the Symbol Category dropdown list. Within each category, use the scroll bar to view all of the symbols. The Prompt For Rotation option will add a prompt for each symbol rotation. The Rotate By Centerline option will prompt to select linework and then rotate the symbols to make them parallel to the nearest linework. The Symbol Rotation Angle is applied relative to horizontal of the current twist screen or to the nearest linework angle when Rotate By Centerline is active. The Erase Existing Symbols options apply if you specify a symbol location that already has a symbol on it. There are also settings for the symbol layer name and size. The Prompt For Attributes option applies to symbols that have attribute definitions. When active, this option will prompt for the attribute values in a dialog.

The Select Code option is an alternate way of selecting the symbol by Field-to-Finish code name. The Field-to-Finish code table to use is set with the Points->Point Defaults command. Besides setting the symbol name, the code lookup method also sets the layer. For example, instead of picking a symbol like SPT5 and setting the layer name to "TRAVERSE" for an iron pin symbol, the select code method would set the symbol name and layer by picking the code name/description of "IPS"/"Iron Pin Set" from the code list. So the code method is a way to handle drawing standards.
After the options dialog, the program prompts at the Command line for the symbol locations. The locations can be specified by picking points, specifying point numbers in the current coordinate (.CRD) file or by entering the northing and easting. Using the Select entities option, symbols can also be placed on arcs, faces, points, text, lines and polylines. Selecting the Enter coords option allows you to insert the symbol by entering a easting, northing and elevation in x,y,z order.
Chapter 7. Draw Menu
Insert Multi-Point Symbols

This command allows you to locate symbols using multiple insertion points. Up to three insertion points can be defined for an individual symbol. When defining only two insertion points for a particular symbol, the symbol will be scaled and rotated. With three insertion points defined, the symbol is rotated and scaled in both the X and Y directions. The two point insertion definition will aid in the drawing of tree symbols with a specific drip line width. For instance, a surveyor could locate the tree and then locate the drip line, two shots for each tree, and allow the program to size the tree symbol accordingly so that the map will have various tree symbol sizes that reflect the actual field conditions.

The multiple insertion points are defined in the Field to Finish codes. The Insert Multi-Point Symbols command reads the Field to Finish code table and finds all of the codes with multi-point symbol definitions. Then you can select from these codes for the symbol to draw. Both the two and three point insertion definitions can aid with the insertion of concretes and buildings symbols during final drawing preparations and design phases of a project.

Here are the various steps to define two point and three point insertion point symbols. First, you must decide on the symbol to use for the desired code, as well as the specific placement points for the symbol. Once a symbol has been chosen, open the desired symbol drawing. To do this, identify the symbol name and then locate the symbol by its drawing name under the SUP sub-directory found under the Carlson installation directory. Next, determine the placement points for the symbol. As shown below, the placement points for the BLD code symbol, which will be explored later in this section, were determined by identifying X and Y values of the desired placement points by using the id command and specifying the end points of the lines.

Next, the symbol insertion points must be defined in the Field to Finish code table (.FLD) file. To do this, open your FLD file by choosing Draw Field to Finish under the Survey pulldown. Then select a particular code from the list of codes displayed in the Field to Finish dialog box. Edit it by highlighting the code and picking the Edit button, or define a new code with the Add button. Either choice will display the Edit Field Code Definition dialog. In the Edit Code Definition dialog, choose the desired symbol for the code by pressing the Set Symbol button and selecting the desired symbol. Next, select the Symbol Pts button. This brings up a dialog called Define Symbol Placement Points. Here is where you define the symbol by three points. You do this by entering an X and Y coordinate and a description for the symbol. Enter the X and Y values for each placement point into the appropriate fields. The description fields are used as the prompts when placing the symbol in the drawing. A two insertion point symbol is defined in the same way. An example is the Symbol Pnts definition for the code TREE. The placement points for the Tree code symbol were determined by opening the symbol drawing and finding the X and Y values at the insertion points. The center of the large circle was chosen for Point 1 and the East Quadrant was chosen for point 2. In both cases osnaps were used in picking the points.

Now that we have the codes defined, let's go through the Insert Multi-Point Symbol command and see the results. The command starts with a dialog that lists all the codes with Multi-Point Symbols defined. At this point you can select the symbol to draw. The symbol size applies only to using one point to place the symbol. When two or more points are used, the symbol is scaled to fit the points. Let's look at the BLD code three point insertion definition.
Shown below are three points that represent a building pad. We want the building to be exactly the same dimensions defined by the point locations.

The three point PAD and the tree with drip line examples follow. We start by specifying the building pad codes.

**Prompts**

**Insert Multi-Point Symbol Dialog**
Choose a symbol to draw. In this example, the Pad symbol is a 3 point multi-symbol.

**Specify LTFNT PAD point.**
Pick Point or Point Number (Enter to End): 15

**Specify LT REAR PAD point.**
Pick Point or Point Number (Enter to End): 16

**Specify RT REAR PAD point.**
Pick Point or Point Number (Enter to End): 17

Insert another BLD symbol [Yes]/No? N

**Insert Multi-Point Symbol Dialog**
Choose a symbol to draw. In this next example, the Tree symbol is a 2 point multi-symbol. Now specify the location of the trunk and the drip line by point number.

**Specify Trunk Location point.**
Pick Point or Point Number (Enter to End): 1

**Specify Drip Line Point.**
Pick Point or Point Number (Enter to End): 13

Insert another TREE symbol [Yes]/No? N

From the Field to Finish routine

*Chapter 7. Draw Menu*
Chapter 7. Draw Menu

Two points symbol placement for TREE

Three points for building PAD
Hatch

This command allows you to fill an enclosed area or selected objects with a hatch pattern.

The Hatch command first defines the boundaries of the area you want to hatch, either by computing a region or polyline boundary from a specified point within an enclosed area, or by using selected objects as boundaries. It then fills the boundaries with a hatch pattern or a solid color. You can create an associative hatch, which updates when its boundaries are modified, or a nonassociative hatch, which is independent of its boundaries. You can preview any hatch and adjust the definition.

Due to the large number of combinations of geometry that you can hatch, editing hatched geometry can produce unexpected results. In this event, delete the hatch object and rehatch.

The Boundary Hatch dialog box defines the boundary, pattern type, pattern properties, and attributes for hatch objects. Use the Quick Tab to work with hatch patterns and quickly create a hatch. Use the Advanced Tab to customize how TakeOff creates and hatches boundaries.

1 Under the Quick Tab you define the appearance of the hatch pattern to be applied.
- Type: This field sets the pattern type.
- Pattern: This field lists the available predefined patterns. The six most recently used predefined patterns appear at the top of the list. The Pattern option is available only if you set Type to Predefined.
• Islands Style: This button displays the Hatch Pattern Palette dialog box, in which you can view preview images for all predefined patterns at once to help you make a selection.

• Swatch: This field displays a preview of the selected pattern. You can click the swatch to display the Hatch Pattern Palette dialog box.

• Custom Pattern: This field lists the available custom patterns. The six most-recently used custom patterns appear at the top of the list. The Custom Pattern option is available only if you set Type to Custom.

• Angle: This field specifies an angle for the hatch pattern relative to the X axis of the current UCS.

• Scale: This option expands or contracts a predefined or custom pattern. This option is available only if you set Type to Predefined or Custom.

• Relative to Paper Space: This option scales the hatch pattern relative to paper space units. Using this option, you can easily display hatch patterns at a scale that is appropriate for your layout. This option is available only from a layout.

• Spacing: This option specifies the spacing of lines in a user-defined pattern. This option is available only if you set Type to User Defined.

• ISO Pen Width: This option scales an ISO predefined pattern based on the pen width you choose. This option is available only if you set Type to Predefined and set Pattern to one of the available ISO patterns.

2. Under the Advanced Tab you define how TakeOff creates and hatches boundaries.

- Island Detection Style: This option allows you to specify the method for hatching objects within the outermost hatch boundary. If no internal boundaries exist, specifying an Island Detection style has no effect. Because you can define a precise set of boundaries, it's often best to use the Normal style.

The illustrations that accompany each style show how the program hatches a group of three nested boundary objects in each case.

Normal
Hatches inward from the outer boundary. If the program encounters an internal intersection, it turns off hatching until it encounters another intersection. Thus, areas separated from the outside of the hatched area by an odd number of intersections are hatched, and areas separated by an even number of intersections are not.

**Outer**

Hatches inward from the outer boundary. The program turns hatching off if it encounters an internal intersection. Because this process starts from both ends of each hatch line, the program hatches only the outermost level of the structure and leaves the internal structure blank.

**Ignore**

Ignores all internal objects and hatches through them.

Hatching concave curves with the Outer and Ignore styles can cause hatching discrepancies.

The Normal, Outer, and Ignore options are also available from a shortcut menu by right-clicking in the drawing area while you specify points or select objects to define your boundaries.

- **Object Type:** This option allows you to specify whether to retain boundaries as objects, and specifies the object type TakeOff applies to those boundary objects. Object Type controls the type of the new boundary object. TakeOff creates the boundary as a region or a polyline. This option is available only if you select Retain Boundaries.
- **Retain Boundaries:** This option adds the temporary boundary objects to the drawing.
- **Boundary Set:** This field defines the set of objects TakeOff analyzes when defining a boundary from a specified point. The selected boundary set has no effect when you use Select Objects to define a boundary. By default, when you use Pick Points to define a boundary, the program analyzes all objects visible in the current viewport. By redefining the boundary set, you can disregard certain objects when defining boundaries without having to hide or remove those objects. For large drawings, redefining the boundary set can also produce the boundary faster because the program examines fewer objects.
  - **New:** This option prompts you to select the objects that define the boundary set. When you choose this option, the dialog box temporarily closes, prompting you to select objects. TakeOff includes only the hatchable objects you select when it constructs the new boundary set. TakeOff discards any existing boundary set, replacing it with the new boundary set defined by the objects you select. If you don't select any hatchable objects, the program retains any current set. Until you exit the Hatch command or create a new boundary set, TakeOff ignores objects that do not exist in the boundary set when you define your boundaries using Pick Points.
  - **Island Detection Method:** This option allows you to specify whether to include objects within the outermost boundary as boundary objects. These internal objects are known as islands.
    - **Flood:** This option includes islands as boundary objects.
    - **Ray Casting:** This option runs a line from the point you specify to the nearest object and then traces the boundary in a counterclockwise direction, thus excluding islands as boundary objects.

3 In the Boundary Hatch dialog box, you set the options the define the selection set.

- **Pick Points:** This option determines a boundary from existing objects that form an enclosed area. How TakeOff detects objects using this option depends on the selected Island Detection Method on the Advanced tab. For example, if the Island Detection Method is Flood, the program detects objects within the outermost boundary as islands and includes them in the boundary definition. The Island Detection Style (which you also set on the Advanced tab) then determines how to hatch the detected islands. When you choose Pick Points, the dialog box closes temporarily, and the program prompts for point specification.
• Select Objects: This option allows you to select specific objects for hatching. The dialog box closes temporarily, and the program prompts you for object selection. When you define your boundaries using Select Objects, the program does not detect interior objects automatically. You must select the objects within the selected boundary to hatch those objects according to the current Island Detection Style (which you set on the Advanced tab). Each time you choose Select Objects, the program clears the previous selection set. While selecting objects, you can right-click at any time in the drawing area to display a shortcut menu. You can undo the last or all selections, change the selection method, change the island detection style, or preview the hatch.

• Remove Islands: This option removes from the boundary definition any of the objects that the program detects as islands when you use Pick Points. You cannot remove the outer boundary.

• View Selections: This option temporarily dismisses the dialog box and displays the currently defined boundaries with the hatch settings that you last previewed. This option is unavailable when you have not yet specified points or selected objects.

• Inherit Properties: This option hatches specified boundaries using the hatch properties of one object. After selecting the associative hatch object whose properties you want the hatch to inherit, you can right-click in the drawing area and use the shortcut menu to toggle between the Select Objects and Pick Internal Point options to create boundaries.

• Double: For user-defined patterns, this option draws a second set of lines positioned at 90 degrees to the original lines, creating a crosshatch. This option is available only if you set Type to User Defined on the Quick tab.

• Associative: This option creates an associative hatch, meaning that the hatch is updated when you modify its boundaries.

• Nonassociative: This option creates a nonassociative hatch, meaning that it is independent of its boundaries.

• Preview: This option temporarily dismisses the dialog box and displays the currently defined boundaries with the current hatch settings. This option is not available when you have not yet specified points or selected objects to define your boundaries.

Prerequisite: None

Keyboard Command: BHATCH

Hatch

Standard Hatch

This command allows you to fill an enclosed area or selected objects with a hatch pattern.

The Hatch command first defines the boundaries of the area you want to hatch, either by computing a region or polyline boundary from a specified point within an enclosed area, or by using selected objects as boundaries. It then fills the boundaries with a hatch pattern or a solid color. You can create an associative hatch, which updates when its boundaries are modified, or a nonassociative hatch, which is independent of its boundaries. You can preview any hatch and adjust the definition.

Due to the large number of combinations of geometry that you can hatch, editing hatched geometry can produce unexpected results. In this event, delete the hatch object and rehatch.
The Boundary Hatch dialog box defines the boundary, pattern type, pattern properties, and attributes for hatch objects. Use the Quick Tab to work with hatch patterns and quickly create a hatch. Use the Advanced Tab to customize how TakeOff creates and hatches boundaries.

1 Under the Quick Tab you define the appearance of the hatch pattern to be applied.
   - **Type**: This field sets the pattern type.
   - **Pattern**: This field lists the available predefined patterns. The six most recently used predefined patterns appear at the top of the list. The Pattern option is available only if you set Type to Predefined.
   - **…**: This button displays the Hatch Pattern Palette dialog box, in which you can view preview images for all predefined patterns at once to help you make a selection.
   - **Swatch**: This field displays a preview of the selected pattern. You can click the swatch to display the Hatch Pattern Palette dialog box.
   - **Custom Pattern**: This field lists the available custom patterns. The six most-recently used custom patterns appear at the top of the list. The Custom Pattern option is available only if you set Type to Custom.
   - **Angle**: This field specifies an angle for the hatch pattern relative to the X axis of the current UCS.
   - **Scale**: This option expands or contracts a predefined or custom pattern. This option is available only if you set Type to Predefined or Custom.
   - **Relative to Paper Space**: This option scales the hatch pattern relative to paper space units. Using this option, you can easily display hatch patterns at a scale that is appropriate for your layout. This option is available only from a layout.
   - **Spacing**: This option specifies the spacing of lines in a user-defined pattern. This option is available only if you set Type to User Defined.
   - **ISO Pen Width**: This option scales an ISO predefined pattern based on the pen width you choose. This option is available only if you set Type to Predefined and set Pattern to one of the available ISO patterns.

2 Under the Advanced Tab you define how TakeOff creates and hatches boundaries.
• Island Detection Style: This option allows you to specify the method for hatching objects within the outermost hatch boundary. If no internal boundaries exist, specifying an Island Detection style has no effect. Because you can define a precise set of boundaries, it's often best to use the Normal style.

The illustrations that accompany each style show how the program hatches a group of three nested boundary objects in each case.

Normal

Hatches inward from the outer boundary. If the program encounters an internal intersection, it turns off hatching until it encounters another intersection. Thus, areas separated from the outside of the hatched area by an odd number of intersections are hatched, and areas separated by an even number of intersections are not.

Outer

Hatches inward from the outer boundary. The program turns hatching off if it encounters an internal intersection. Because this process starts from both ends of each hatch line, the program hatches only the outermost level of the structure and leaves the internal structure blank.

Ignore

Ignores all internal objects and hatches through them.

Hatching concave curves with the Outer and Ignore styles can cause hatching discrepancies.

The Normal, Outer, and Ignore options are also available from a shortcut menu by right-clicking in the drawing area while you specify points or select objects to define your boundaries.
• **Object Type:** This option allows you to specify whether to retain boundaries as objects, and specifies the object type TakeOff applies to those boundary objects. Object Type controls the type of the new boundary object. TakeOff creates the boundary as a region or a polyline. This option is available only if you select Retain Boundaries.

• **Retain Boundaries:** This option adds the temporary boundary objects to the drawing.

• **Boundary Set:** This field defines the set of objects TakeOff analyzes when defining a boundary from a specified point. The selected boundary set has no effect when you use Select Objects to define a boundary. By default, when you use Pick Points to define a boundary, the program analyzes all objects visible in the current viewport. By redefining the boundary set, you can disregard certain objects when defining boundaries without having to hide or remove those objects. For large drawings, redefining the boundary set can also produce the boundary faster because the program examines fewer objects.

• **New:** This option prompts you to select the objects that define the boundary set. When you choose this option, the dialog box temporarily closes, prompting you to select objects. TakeOff includes only the hatchable objects you select when it constructs the new boundary set. TakeOff discards any existing boundary set, replacing it with the new boundary set defined by the objects you select. If you don't select any hatchable objects, the program retains any current set. Until you exit the Hatch command or create a new boundary set, TakeOff ignores objects that do not exist in the boundary set when you define your boundaries using Pick Points.

• **Island Detection Method:** This option allows you to specify whether to include objects within the outermost boundary as boundary objects. These internal objects are known as islands.

• **Flood:** This option includes islands as boundary objects.

• **Ray Casting:** This option runs a line from the point you specify to the nearest object and then traces the boundary in a counterclockwise direction, thus excluding islands as boundary objects.

3 In the Boundary Hatch dialog box, you set the options the define the selection set.

• **Pick Points:** This option determines a boundary from existing objects that form an enclosed area. How TakeOff detects objects using this option depends on the selected Island Detection Method on the Advanced tab. For example, if the Island Detection Method is Flood, the program detects objects within the outermost boundary as islands and includes them in the boundary definition. The Island Detection Style (which you also set on the Advanced tab) then determines how to hatch the detected islands. When you choose Pick Points, the dialog box closes temporarily, and the program prompts for point specification.

• **Select Objects:** This option allows you to select specific objects for hatching. The dialog box closes temporarily, and the program prompts you for object selection. When you define your boundaries using Select Objects, the program does not detect interior objects automatically. You must select the objects within the selected boundary to hatch those objects according to the current Island Detection Style (which you set on the Advanced tab). Each time you choose Select Objects, the program clears the previous selection set. While selecting objects, you can right-click at any time in the drawing area to display a shortcut menu. You can undo the last or all selections, change the selection method, change the island detection style, or preview the hatch.

• **Remove Islands:** This option removes from the boundary definition any of the objects that the program detects as islands when you use Pick Points. You cannot remove the outer boundary.

• **View Selections:** This option temporarily dismisses the dialog box and displays the currently defined boundaries with the hatch settings that you last previewed. This option is unavailable when you have not yet specified points or selected objects.

• **Inherit Properties:** This option hatches specified boundaries using the hatch properties of one object. After selecting the associative hatch object whose properties you want the hatch to inherit, you can right-click in the drawing area and use the shortcut menu to toggle between the Select Objects and Pick Internal Point options to create boundaries.

• **Double:** For user-defined patterns, this option draws a second set of lines positioned at 90 degrees to the original lines, creating a crosshatch. This option is available only if you set Type to User Defined on the Quick tab.

• **Associative:** This option creates an associative hatch, meaning that the hatch is updated when you modify its boundaries.
• Nonassociative: This option creates a nonassociative hatch, meaning that it is independent of its boundaries.
• Preview: This option temporarily dismisses the dialog box and displays the currently defined boundaries with the current hatch settings. This option is not available when you have not yet specified points or selected objects to define your boundaries.

Prerequisite: None

Keyboard Command: BHATCH

**Hatch Wizard**

This command draws a hatch. The dialog has settings for the Color, Layer, Transparency and Scale for the hatch. The *Use Layer/Color of Perimeter Polyline* option sets these properties for the hatch from the polyline used for the hatch perimeter instead of from the dialog. The *Pick Interior Point to Make Perimeter* method defines the hatch area by picking a point in the drawing and having the program find the bounding linework. Otherwise the program prompts to select the inclusion and exclusion perimeter polylines. The *Prompt For Exclusions* controls whether the program prompts to select closed polylines for areas to exclude from the hatch. The *Create Hatch Boundary by Auto-Connecting* method creates a closed area for hatching from unclosed linework by joining the selected linework at their endpoints.

After dialog and selecting the hatch area, the program prompts for the hatch pattern. Then the hatch is created.

![Hatch Wizard dialog box](image)

**Prompts**

Pick interior point method:
*Pick interior point: pick a point*

Pick interior point (Enter to end): *press Enter*

Pick polylines method:
*Select the Inclusion perimeter polylines.*
*Select objects: pick closed polylines to hatch*
*Select the Exclusion perimeter polylines or ENTER for none.*
*Select objects: press Enter*

*Select Text to Exclude from fill or ENTER for none.*
*Select objects: press Enter*

For selected text, the program automatically creates an exclusion box around the text to keep the hatch pattern from covering the text.
Image

Raster Image

This command allows you to manage raster images.

The Image Manager dialog box lists all the image files attached to the current drawing. You can view the parameters and details for selected images. You can attach new image files and detach, locate, reload, and unload existing images.

- **List View:** This button lists the image definitions attached to the drawing. Each image name appears only once regardless of how many times you attach (insert) the image. You can sort the list of images by name, status (loaded, unloaded, or not found), size, type (TIFF, for example), date, or the saved path and file name. By default, TakeOff displays the list alphabetically by image name.

  To select multiple images, hold down SHIFT or CTRL while selecting items.

  To sort the list alphabetically or numerically by a specific column, click that column's heading.

  To change the width of the column, drag the line between the column headings to the right or left. The program saves and restores the settings when you reopen the dialog box.

  To change an image name, select it and then click it again, or select it and then press F2. You cannot edit names of images that reside in external references (xrefs). Image names can include up to 255 characters and can contain letters, digits, spaces, and any special characters not used by Microsoft® Windows® or TakeOff. The image name can be identical to the file name, but changing the image name does not change the file name.

- **Tree View:** This button displays all the image definitions and the levels of nesting of images within xrefs. The top level of the tree view shows images that you attached directly to the drawing, images nested in block references, and the names of externally referenced drawings containing images. The names of the images attached to the externally referenced drawings appear nested within the drawing at the next tree level. To insert a copy of an already attached image, select it, and then choose Attach.

  Tree view lists the image names only (not file names) and lists the image name just once, regardless of how many times you attach (insert) the image.

  You can edit an image name by selecting it and then clicking it again, or by selecting it and then pressing F2. However, you cannot select more than one image at a time.
• Attach: This option displays the Select Image File dialog box. When you unload and then reload an image, the program draws that image on top. Images remain loaded or unloaded from one drawing session to the next.

• Detach: This option removes the selected image definitions from the drawing database and erases all the associated image objects from the drawing and from the display.

• Reload: This option loads the most recent version of an image or reloads an image that was previously unloaded. Reloading does not control whether the image is displayed, but it ensures display of the most current image.

• Unload: This option unloads image data from working memory without erasing the image objects from the drawing. It is recommended that you unload images no longer needed for editing to improve performance. An unloaded image cannot be displayed or plotted. You can selectively load and unload individual images from a working list of images associated with the drawing file.

• Details: This option opens the Image File Details dialog box, which displays the image name, saved path, active path, file creation date and time, file size and type, color system, color depth, width and height in pixels, resolution, default size in units, and a preview image.

• Image Found At: This field shows the path of the selected image. If you select multiple images, this field remains blank. The path shown is the actual path where the image resides.

• Browse: This option opens the Select Image File dialog box (a standard file selection dialog box). The path you select appears under Image Found At.

• Save Path: This option stores the new path information. Press ESC while editing the path to restore the old path. If the program cannot find the referenced image in the new path, the image's status changes to Not Found. If you do not choose Save Path after editing the path, the program uses the original image path the next time you load the drawing.

2 Under the Image dialog box, you can attach an image.

3 In the Image dialog box, you must first identify the image and the path.

• Name: This field identifies the image you have selected to attach, either from the Select Image File dialog box (an unattached image) or from the list of previously attached images. To add another instance of an image file that is already attached, select the image name from the list and choose OK.

• Browse: This option opens the Select Image File dialog box (a standard file selection dialog box). If Show Preview is selected, the program displays a preview of the selected file.

• Retain Path: This option saves the path of the image file with the image definition. If Retain Path is not selected, only the image name is saved and TakeOff searches the Support File Search Path.

4 Under Insertion Point, you must specify the insertion point for the selected image. Specify On-Screen is the default. The default insertion point is 0,0.
• Specify On-Screen: This option directs input to the command line or the pointing device. If Specify On-Screen is cleared, enter the insertion point in X, Y, and Z.
• X: This field sets the X coordinate value.
• Y: This field sets the Y coordinate value.
• Z: This field sets the Z coordinate value.

5 Under Scale, you must specify the scale factor of the selected image. Specify On-Screen directs input to the command line or the pointing device. If Specify On-Screen is cleared, enter a value for the scale factor. The default scale factor is 1.

6 Under Rotation, you must specify the rotation angle of the selected image. If Specify On-Screen is selected, you may wait until you exit the dialog box to rotate the object with your pointing device or enter a rotation angle value on the command line. If Specify On-Screen is cleared, enter the rotation angle value in the dialog box. The default rotation angle is 0.

Prerequisite: Raster image

Keyboard Command: IMAGE

Leaders

Arrowhead
This command draws an arrowhead at the end of the selected line or polyline.

Prompts

Enter the arrow size <5.00>: press Enter
Pick a line or pline to add arrow: pick a line or polyline
Pick a line or pline to add arrow (Enter to End): press Enter

Pulldown Menu Location: Draw
Keyboard Command: arrowhd
Prerequisite: None

Curve - Arrow
Curve - Arrow can be used to draw a section of contour line or create leader pointer lines. Curve - Arrow draws a Bezier curve through user specified points. After choosing endpoints, each time an intermediate points is picked the curve will be redrawn through all the points. There is an option to draw an arrowhead at the starting point. This routine also has a Zorro option which creates a Z leader curve. The Draw Text option will make the program prompt after the leader points for a text label to place at the end of the leader.

Prompts
**Pick a starting point:** pick a point
**Pick an ending point:** pick a point
**Pick an intermediate point (U to Undo):** pick a point
**Pick an intermediate point (U to Undo):** press Enter

![Examples of Curve - Arrow](image)

**Pulldown Menu Location:** Draw
**Keyboard Command:** carrow
**Prerequisite:** None

---

**Leader With Text**

This command will draw a straight or curved leader between two points, with an arrow at one end and optional text at the other. The options dialog is displayed at the start. To skip this dialog, turn off the Show Options On Startup toggle. Then on the command line, entering O for Options will show the options dialog. To quickly change the label size, enter S for Size at the command line.

In the options dialog, Text Position chooses between automatically placing the label next to the leader end point or picking the label position. For Text Justification, you can set a specific justification or use the Automatic option which uses either Left or Right justification depending on whether the leader end is left or right of the leader start. Text Rotation chooses between having the label horizontal to the current view, prompting for the label angle or at a fixed angle specified in the dialog. The Hide Drawing Under Labels option uses a wipeout to hide drawing entities behind the leader labels. The Curved Leader option curves the leader between the start and end points. Otherwise a straight leader line is created. The Use MText option chooses between creates MText or regular Text entities. The Landing Style of Horizontal Tick draws a short horizontal line segment at the end of the leader. The Landing Style of Underline draws the leader line under the text like an underscore. The Text Size Scaler and Arrow Size Scaler are multiplied by the Horizontal Scale from Drawing Setup to set the drawing size for the label and arrowhead. There are settings for the layer and style for the label. When the User Current Drawing Properties is on, then the current layer and current style from the drawing will be used.

The Text Input can either be entered with prompts after the leader points at the command line or selected from a prepared list. The prepared list is a way to quickly create leaders for common labels. To prepare the label list, use the Add, Edit and Remove buttons. Use the Save and Load buttons to save the preset labels to a .CALL file.
Prompts

Options/Size/Pick Arrow Location: pick a point
Text location: pick a point
Text: Leader With Text
Text: press Enter

Leader With Text

Pulldown Menu Location: Draw > Leader
Keyboard Command: LDR
Prerequisite: None

Multileader with Text
This command draws multiple leaders to a label. The style of the leaders is controlled by the current Dimension Style.
Prompts

**Beginning point of leader:** *Pick point at arrowhead*
**End point for leaders:** *Pick point at label*
**Text:** *Multileader*
**Text (Enter to end):** *press Enter*
**Beginning point of leader (Enter to end):** *pick a point*
**Beginning point of leader (Enter to end):** *press Enter*

**Pulldown Menu Location:** Draw > Leader
**Keyboard Command:** mldr
**Prerequisite:** None

Special Leader

This command draws a curved leader line like the one shown. With this routine you can also choose to enter in multiple lines of text, not just a single line. The arrow size is determined by the Symbol Plot Size setting, found in the **Drawing Setup** command. On the command line, selecting *O* for Options will provide you with more customizing choices to make.

**Prompts**

**Options/Pick Arrow Location:** *pick a point* Pick point where leader arrow will start.
**Text location:** *pick a point*
**Text:** *Monument*
**Text:** *press Enter*
**Callout Leader**

This command draws a triangle shaped leader and a label inside a box. There is a dialog to enter the label string, style, size and colors. The leader is drawn in the current layer.

![Callout Leader Example](image)

**Prompts**

**Callout Leader Settings dialog**

- **Pick callout point**: pick a point for point of leader
- **Pick textbox corner**: pick a point for position of label

**Pulldown Menu Location**: Draw > Leader

**Keyboard Command**: callout, ldr

**Prerequisite**: None

---

**Bold Curve Leader**

This command draws a thick curved leader with an arrowhead. This leader is created by picking three points.

![Bold Curve Leader Example](image)
Prompts

Starting point: pick a point
End of arrowhead: pick a point
Pick end point of leader: pick a point

Pulldown Menu Location: Draw > Leader
Keyboard Command: site_leader
Prerequisite: None

Flow Leader
This command draws a wavy leader line with an arrowhead. The size of the arrowhead is set by the symbol size scaler in Drawing Setup.

![Flow Leader Diagram](image)

Prompts

Starting point: pick a point for arrow end of leader
Ending point: pick a point for tail end of leader

Pulldown Menu Location: Draw > Leader
Keyboard Command: flowline
Prerequisite: None

Draw Standard Item

Draw Standard Item
The Draw Standard Item command activates the Standards Draw palette:
This palette is essentially the same as the **Standards Draw Manager** palette except that it does not have the Standards management commands available in the right-click short-cut menu.

**Draw Quick Key Item:** When a valid Standard Item key-in (essentially the layer designation of an item until changed to something more meaningful) has been keyed into the *Quick Key* edit box, you can draw the item without having to navigate for it in the list of Standard Items.

**Draw Item:** This option will permit you to browse for a Standard Item from the list of items (within their respective Categories, if present) and place the Standard Item into the drawing.

**Load:** This command will load the content of an XML-structured *.CAD* file.

Carlson includes a Standards Database file (.cad) with the installation (**NCS_SurveyCivil.cad**) which is a fully populated database based on the **US National CAD Standard**.

The **Draw Standard Item** command permits you to browse through you list of Standard items or draw one based on its "quick key" (essentially its layer name) designation and can be quickly accessed through the toolbar short-cut on the left shown below.

![Standards Draw Manager](image)

Items in the **Standards Draw** palette are organized into Categories and given commonly referred-to, descriptive names. Defining these Items and other management tasks are done through the Items Standards Manager.

A Standard Item can include any one or a combination of three types of entities:

1. Symbol
2. Linework
3. Annotation (with or without a Leader)

Next to each item in the palette is a graphic icon which indicates the type of entity(ies) defined for that Standard Item.

This icon, **symbol** is shown for a Standard Symbol Item.

This icon, **line** is shown for a Standard Linework Item.

This icon, **annotation** is shown for a Standard Annotation Item.
Because many Standard Items will be sized based on the scale of the drawing, it is important to set the "Horizontal Scale" in the Carlson Drawing Setup dialog box before drawing Standard Items into your drawing. If Standard Items are drawn and scaled according to the "Horizontal Scale", the "Horizontal Scale" setting is saved with the entity. In other words, changes to the "Horizontal Scale" of the drawing will not affect existing entities. This is true of Symbols, Annotation and Leader components.

To Draw a Standard Item using the Item menu in the palette, navigate through and left-click the Standard Item to be drawn. Assuming the Standard Item has a Symbol, Linework and Annotation component, you will see, generally, the following series of prompts. Note that, depending on the various options that have been set for each Item, the prompts may vary.

Start Point: Using the left-mouse button, select the location for the first Symbol component. This point will also be the first endpoint of the Linework for this Item. If you do not wish to have a Symbol inserted at this point and only wish to draw the associated Linework, hold the ALT key when specifying the Start Point to proceed on to the next Endpoint.

Rotation Angle: If you have placed a Symbol, specify its Rotation Angle. If you have set the Symbol Rotation option to "Fixed", you will not be prompted for this Rotation Angle.
If you insert a Symbol having non-Constant attribute values, you will be prompted through a dialog box to define the attribute values:

Halfwidth/Width/Close/Length/Open/Undo/Arc Endpoint of line: Select the next Endpoint of the line segment or specify one of the other Polyline command options before picking the Endpoint. If you do not want to draw a Linework segment at this time, press Enter to skip this step and continue on to place Annotation.

Rotation Angle: Specify the Rotation Angle for the next Symbol. Again, depending on the Symbol Rotation options you have set, you may or may not receive this prompt.

The prompts will continue to alternate between "Rotation Angle" and "Endpoint of Line" until you have reached the end of your Linework. When you have specified your final Endpoint and the Rotation Angle of your final Symbol, right-click to continue on to place Annotation.

Displacement/Identify or <P>key in alternative text: This is the prompt for your first Annotation entity. The Item's Label is used for default Text content. To override the default Text, simply type in the alternative Text at the Command: Line. If you need a 2nd line of Text, use "$P$" to designate the 2nd line of text. For instance, entering "TWO STORY\PWOOD FRAME" would result in the following Text string in the drawing:
Also, left-clicking on any other Text entity will update your current Text value to match the Text that was selected. And, holding the ALT key while left-clicking on any other Text entity will add the value of that Text entity as a 2nd line of Text to your current Text value.

Once you have finished entering the Text, press Enter to finish Text entry. Left-click in the drawing to place the Text.

**Rotation angle/Identify or </P>-key in alternative text <0.0000>:** Type in a Rotation Angle for the text or left-click to specify the desired angle.

**Leader Start Point:** Left-click to specify the location of the arrowhead part of the Leader. If you do not want a Leader, you can right-click to skip the Leader and proceed on to place the next Text entity.

**Next Leader Point:** Left-click to specify the next Endpoint of the Leader. You will continue being prompted for "Next Leader Point:" until you right-click or Enter to finish drawing the Leader. After you have finished drawing the first Annotation entity (with or without a Leader), you will continue to be prompted to place additional Annotation and Leaders. Right-click or press Enter to finish the command.

**Pulldown Menu Location(s):** Draw > Draw To Standard

**Keyboard Command:** drawitem

**Prerequisite:** Standards Database file (.cad)

## Item Standards Manager

The **Item Standards Manager** command launches the **Standards Draw Manager** palette.

This palette has a right-click shortcut menu allowing you to Insert, Modify, Delete and otherwise manage Items stored in the Standards Database file (.cad):

![Standards Draw Manager](image)

Once displayed, right-clicking inside the **Standards Draw Manager** displays a menu containing the Standards Database management commands. Other than the shortcut menu, this palette is essentially identical to the Draw
Standard Item command.

The **Item Standards Manager** command permits you to browse through your list of Standard Items and manage the list of Items you can quickly place into a drawing. The command can be quickly accessed through the toolbar shortcut on the right shown below.

### Add Item

When a Category has been selected/highlighted, you can add an Item into it.

![Add Item dialog box](image)

**Name:** Provide a common name for Item in the selected Category.

**Quick Key:** Indicate a desired short-cut key-stroke (for example, a survey field code might be useful) that would be used to designate the Item. This value is not used or set for Categories.

**Category:** Select/identify the Category to which the item should belong.

**Entities:** Indicate the entity(ies) (and the order thereof) that comprise the Standard Item you are creating.

**NOTE:** The **Add from Drawing** option permits you to select a previously drawn Text, Symbol or Line/Polylne entity and add it to the Standard Item. Each item will have specific properties you can set that will permit you to control its insertion and composition into the Standard Item.

### Add Category

When a Category has been selected/highlighted, you can add a sub-Category into it.

### Draw Item

With an Item selected from the list, you can draw the item into the drawing. Refer to the Drawing Standard Items discussion for additional details.

### Edit
This command allows you to make changes to the composition of the actively selected/highlighted Item or Category.

**Remove**

This command allows you to delete the the actively selected/highlighted Item or Category.

**NOTE:** Removing (deleting) a Category will also remove/delete the Items/Sub-Categories which are "housed" within the Category! You will be prompted for confirmation prior to deletion.

**Load**

This command allows you to replace the content of the current Drawing Standard library content with that of a different *.cad file.

**Save**

This command allows you to commit the values of the current Drawing Standard library content to a named *.cad file

**Pulldown Menu Location(s):** Draw – Draw to Standard  
**Keyboard Command:** configItem  
**Prerequisite:** None

**Draw By Example**

This command prompts you to pick an entity and then starts the appropriate draw command to begin creating another one of the selected type of entity. The properties such as layer and color of the original entity are used for creating the new one. For example, if you pick a polyline, this command will start the `Pline` command. Likewise if you pick text, this command will begin the `Text` command using the layer and style of the selected text.

**Prompts**

**Pick Object for Command:** *pick an entity*  
The remaining prompts depend on the type of the selected entity.

**Pulldown Menu Location:** Draw  
**Keyboard Command:** drawbyex  
**Prerequisite:** Entities

**Sequential Numbers**

This command draws a text label and then increments to the next value for additional labels. The label can optionally be placed inside a circle, square or other symbol. The size of the symbol adjusts to fit the label size.

In the dialog, specify the **Text** label. The text **Prefix** and **Suffix** are optional. The **Text Size Scaler** is the text size in paper units that gets multiplied by the horizontal scale from Drawing Setup to set the text drawing size or **Text Size Dwg Units**. The **Justification** setting controls the text justification mode. The **Size By Symbol** method uses a fixed symbol size and sizes the label to fit within the symbol. When **Auto Increment Labels** is checked, the value entered in the Text field will be incremented by the value in the **Increment** field. The **Group Label With Symbol** option will make a group of the label text and symbol. When **Prompt for Alignment Every Time** is checked, you will be prompted for the alignment angle for each label, otherwise the alignment from the first label is automatically used for the other labels. The **Draw Leader** option creates a leader from the label to a picked point.
The label is drawn by combining the Prefix, Text and then Suffix into one text label. When placing multiple labels, the text portion of the label will increment by the value in the Increment field. For example, this command could be used to quickly label a series of boundaries by setting the Prefix to "Perimeter" and the Text field to the starting number. Then pick points inside the boundaries to label as "Perimeter 1", "Perimeter 2", etc.

![Sequential Numbers dialog box](image)

![Select Symbol for Numbers dialog box](image)
Prompts

Select Symbol for Numbers dialog select your symbol
Sequential Numbering Options dialog make your choices
Pick point at beginning of label: pick a point
Pick point for label alignment: pick a point to the right of the first point
Pick point at beginning of label: press Enter to end the routine

Pulldown Menu Location: Draw
Keyboard Command: numbers
Prerequisite: None

Boundary Polyline

This is a streamlined analog of the AutoCAD command Boundary. The Carlson version is faster and works in many cases where Boundary fails. Boundary Polyline supports a Snap Tolerance, which means that you may specify a maximum gap to close when creating a closed polyline.

To create closed polylines from any existing linework, simply select all entities you would like to use and specify desired snap tolerance. There are two methods to create boundary polylines. The Pick Inside method creates boundary polylines one at a time. For this method, click inside openings you would like to trace and the routine will generate the corresponding closed polyline. Duplicate polylines are detected and not created, so that clicking more than once in the same area does not change anything. For the All Areas method, the program finds all the closed areas from the input linework and creates a boundary polyline for each area.

These new polylines are created in the layer set in the options dialog. Layers of the original linework do not matter.
Prompts

Boundary Polyline dialog
Select polylines: pick an entities to be used
Pick an internal point: pick the points to enclose

These three polylines are created from original linework by clicking at shown locations

Pulldown Menu Location: Draw
Keyboard Command: boundpl
Prerequisite: Entities

Shrink-Wrap Entities

This command creates a closed polyline which encloses a given set of entities. The resulting polyline is created in the current layer. The program works on either point entities or polylines. For points, the program creates a closed polyline through the points around the perimeter of the area defined by the points. For polylines, the shrink-wrap polyline follows the outside border of the selected polylines. The polylines that are processed have to be connected to be shrink-wrapped. The snap tolerance is the maximum gap that will be joined to make the closed polyline. For open polylines, as in the bottom figure, the Gap method works better, as it jumps across the gaps and connects the end points. The Interior Void method creates a closed boundary polyline for an empty area that is surrounded by points such as a pond.
Example of Interior Void method

Prompts

Shrink-wrap across gaps or bounded linework only [<Gap>/Bound]? G
Shrink-wrap layer <FINAL>:
Select points and linework to shrink-wrap.
Select objects: select entities to process
Section Line

This command creates a plan view section line with labels such as for showing the alignment for a cross section. Choose the section line properties in the options dialog. Then the program prompts for the two end points for the line and draws the section line with labels.

Three different styles of section lines

Prompts

Section Line dialog
Polyline by Nearest Found

This command draws a polyline by connecting points using a nearest found method. The points to connect can be specified either by entering point numbers or picking POINT entities on the screen. The nearest found method draws a polyline by starting at one of the points and then connecting to the closest of the remaining points. Then a remaining point that is closest to one of the polyline end points is added until all points are part of the polyline.

Prompts

Polyline By Nearest Found dialog
Select point from screen or by point number (<Screen>/Number)? press Enter
Select points.
Select objects: pick points
Drawing Block

This command allows you to create a block definition from objects you select.

1 In the Block Definition dialog box, you must first name the block. The Name field, names the block. The name can have up to 255 characters and can include letters, numbers, blank spaces, and any special character not used by Microsoft® Windows® and Carlson Survey for other purposes. The block name and definition are saved in the current drawing. You cannot use DIRECT, LIGHT, AVE_RENDER, RM_SDB, SH_SPOT, and OVERHEAD as valid block names.

2 Under Base Point, you must specify a base point for the block. The default value is 0,0,0.
   • X: This field specifies the X coordinate value.
   • Y: This field specifies the Y coordinate value.
   • Z: This field specifies the Z coordinate value.
   • Pick Point: This option allows you to temporarily close the dialog box so that you can specify an insertion base point in the current drawing.

3 Under Objects, you specify the objects to include in the new block and whether to retain or delete the selected objects or convert them to a block instance after you create the block.
   • Retain: This option retains the selected objects as distinct objects in the drawing after you create the block.
   • Convert to Block: This option converts the selected objects to a block instance in the drawing after you create the block.
   • Delete: This option deletes the selected objects from the drawing after you create the block.
   • Select Objects: This option dismisses the Block Definition dialog box temporarily while you select the objects for the block. When you finish selecting objects, press Enter to redisplay the Block Definition dialog box.
   • Quick Select: This option displays the Quick Select dialog box, which defines a selection set.
   • Objects Selected: This option displays the number of selected objects.

4 Under Preview Icon, you determine whether to save a preview icon with the block definition and specify the source of the icon.
• **Do Not Include an Icon**: This option specifies that no icon is created.

• **Create Icon from Block Geometry**: This option creates a preview icon to be saved with the block definition from the geometry of the objects in the block.

5 In the Block Definition dialog box, you must describe and link the block.

• **Insert Units**: This field specifies the units to which the block is scaled when it is inserted.

• **Description**: This field specifies the text description associated with the block definition.

• **Hyperlink**: This button opens the Insert Hyperlink dialog box, which you can use to associate a hyperlink with the block definition.

**Menu Location**: Draw

**Prerequisite**: Drawing entities.

**Keyboard Command**: BLOCK

### Write Block

This command allows you to write objects or a block to a new drawing file.

![Write Block dialog box](image)

The Write Block dialog box displays different default settings depending on whether nothing is selected, a single block is selected, or objects other than blocks are selected. For example, if you have a single block selected when you open the Write Block dialog box, the Source radio button is set to Block.

1 Under **Source**, you write selected blocks and objects out as a file, and specify insertion points.

• **Block**: This option specifies an existing block to save as a file. Select a name from the list.

• **Entire Drawing**: This option selects the current drawing as a block.

• **Objects**: This option specifies objects to be saved as a file.

2 Under **Base Point**, you must specify a base point for the block. The default value is 0,0,0.

• **X**: This field specifies the X coordinate value.

The Write Block dialog box displays different default settings depending on whether nothing is selected, a single block is selected, or objects other than blocks are selected. For example, if you have a single block selected when you open the Write Block dialog box, the Source radio button is set to Block.
• Y: This field specifies the Y coordinate value.
• Z: This field specifies the Z coordinate value.
• Pick Point: This option allows you to temporarily close the dialog box so that you can specify an insertion base point in the current drawing.

3 Under Objects, you specify the objects to include in the new block and whether to retain or delete the selected objects or convert them to a block instance after you create the block.
• Retain: This option retains the selected objects as distinct objects in the drawing after you create the block.
• Convert to block: This option converts the selected objects to a block instance in the drawing after you create the block.
• Delete from drawing: This option deletes the selected objects from the drawing after you create the block.
• Select objects: This option dismisses the Block Definition dialog box temporarily while you select the objects for the block. When you finish selecting objects, press Enter to redisplay the Block Definition dialog box.
• Quick Select: This option displays the Quick Select dialog box, which defines a selection set.
• Objects Selected: This option displays the number of selected objects.

4 Under Destination, specify the name, location, and unit value used for the objects in the file.
• File Name: This field specifies a file name that the block or objects will be saved to.
• Location: This field specifies the drive and directory path for the file.
• Insert Units: This field specifies the unit value to be used when the new file is inserted as a block. Enter 0 (zero) if you do not want to scale the drawing to a specific value as you insert it.

**Prerequisite:** Drawing entities

**Keyboard Command:** WBLOCK

**Insert**

This command allows you to place a named block or drawing into the current drawing.

1 In the Insert dialog box, you specify the block to insert and define the position for the inserted block. The last block you insert during the current editing session becomes the default block for subsequent uses of this command.
• Name: This field specifies the name of a block to insert or the name of a file to insert as a block.
• Browse: This button opens the Select Drawing File dialog box (a standard file selection dialog box) where you can select a block or a file to insert.
2 Under Insertion Point, you specify the insertion point for the block.
   • Specify On-Screen: This option specifies the insertion point of the block using the pointing device.
   • X: This field sets the X coordinate value.
   • Y: This field sets the Y coordinate value.
   • Z: This field sets the Z coordinate value.

3 Under Scale, you specify the scale for the inserted block. Specifying negative values for the X, Y, and Z scale factors inserts a mirror image of a block.
   • Specify On-Screen: This option specifies the insertion point of the block using the pointing device.
   • X: This field sets the X coordinate value.
   • Y: This field sets the Y coordinate value.
   • Z: This field sets the Z coordinate value.
   • Uniform Scale: This option specifies a single scale value for X, Y, and Z coordinates. A value specified for X is also reflected in the Y and Z values.

4 Under Rotation, you specify the rotation angle for the inserted block.
   • Specify On-Screen: This option specifies the rotation angle of the block using the pointing device.
   • Angle: This field sets a rotation angle for the inserted block.

5 You can explode the block and inserts to the individual parts of the block. When you select Explode, you specify only an X scale factor.

**Prerequisite:** None

**Keyboard Command:** DDINSERT
Inquiry Menu

Shown here is the Carlson Inquiry menu. The top section contains detailed inquiry commands. The lower section of the menu includes report and file editing commands.
List

This command lists the object type, object layer, and X,Y,Z position relative to the current user coordinate system (UCS) and whether the object is in model space or paper space.

The List command reports color, linetype, and lineweight information if these items are not set to BYLAYER. The thickness of an object is displayed if it is nonzero. Z coordinate information defines the elevation. If the extrusion direction of the entry differs from the Z axis (0,0,1) of the current UCS, the List command also reports the extrusion direction in UCS coordinates. The List reports additional information related to the specific object selected.

Prompts

Command:
LIST
Select objects: 3 found, 1 group

Select objects:

BLOCK REFERENCE Layer: "PNTS"
Space: Model space
Handle = 1F3D
Group = *A1
"SPT4"
at point, X=6135023.7190 Y=2190074.2098 Z= 800.0000
X scale factor 5.0000
Y scale factor 5.0000
rotation angle 0d0'0"
Z scale factor 5.0000

BLOCK REFERENCE Layer: "PNTS"
Space: Model space
Handle = 1F4D
Group = *A1
"SRVPNO1"
at point, X=6135023.7190 Y=2190074.2098 Z= 800.0000
X scale factor 5.0000
Y scale factor 5.0000
rotation angle 0d0'0"
Z scale factor 5.0000

ATTRIBUTE Layer: "PNTNO"
Space: Model space
Handle = 1F4E
Style = "PTXT"
Font file = TXT
center point, X=6135023.7190 Y=2190077.9598 Z= 800.0000
height 5.0000
value 1
tag PT#
rotation angle 0d0'0"
width scale factor 1.0000
obliquing angle 0d0'0"
flags normal

Chapter 8. Inquiry Menu
ATTRIBUTE Layer: "PNTELEV"
Space: Model space
Handle = 1F4F
Style = "PTXT"
Font file = TXT
start point, X=6135031.2190 Y=2190071.7098 Z= 800.0000
height 5.0000
value 800

Prerequisite: an entity

Keyboard Command: LIST

Point ID
This command reports complete information pertaining to a Carlson point. Although similar in function to the AutoCAD ID command, this routine is much more detailed. With this command, you are given the point number, as well as the northing, easting and elevation coordinates. You also are given the point description, and you are shown the name and the location of the coordinate file for the point.

Prompts
Pick point or point number: 255

PointNo. Northing(Y) Easting(X) Elev(Z) Description
255 4379.83 4265.48 19.01 GROUND/SHOT
N: 4379.83 E: 4265.48 Z: 19.01
PT#: 255 CRD File: c:\Carlson2008\data\mantopo.crd

Pulldown Menu Location: Inquiry
Keyboard Command: PT_ID
Prerequisite: None

Layer ID
This command reports the layer name of the selected entity.

Prompts
Pick entity to read layer: pick an entity
Layer: FINAL
Pick entity to read layer: press Enter to end

Pulldown Menu Location: Inquiry
Keyboard Command: layerid
Prerequisite: None
Layer Inspector

This command is used to inspect and work with layers in the drawing. This command is ideal when you are working on a very dense and complex drawing which has many layers and you want to review the entities on different layers. In some cases, there will be layers that you would want to erase. Another scenario might be that you’d like to highlight a layer that is hard to find and see.

The Layer Inspector command has a dialog that docks to the bottom of the drawing window which keeps the drawing window visible while running the command. On the left of the dialog is a list of all the layers in the drawing. To inspect a layer, highlight the layer name from this list. You can inspect multiple layers at a time by selecting multiple layers in the list using the Shift and Ctrl keys while picking in the list. When a layer is selected, the Entity Count reports how many entities in the drawing are set to that layer. The Zoom toggle will zoom the drawing window to the extents of the entities on the layer. The Isolate toggle will freeze all other layers. The Highlight toggle will highlight all the entities on the layer. The Restore View On Exit will set the drawing window to the original position when Layer Inspector was started. The magnify and arrow buttons are used to zoom in/out and pan the drawing window. The Rename button allows you to rename the layer. The Erase Entities button will erase all the entities on the layer. The Purge button will purge the layer from the drawing which is only available when there are no entities on the layer. The Current button sets the layer as the current layer for the drawing.

Pulldown Menu Location: Inquiry
Keyboard Command: layer_inspect
Prerequisite: None

Drawing Inspector On/Off

This command reports object properties to you as you move the cursor over an entity. You can simply move the pointer over an entity and the selected property will be displayed either in a pop-up window next to the pointer and/or on the status bar, depending on the selected option. Drawing Inspector is a transparent command that can run while other commands are running. Once Drawing Inspector is started, it will stay active even while running other commands until you turn it off. To turn off Drawing Inspector, run the command again to toggle it off by pick Drawing Inspector from the Inquiry pull-down menu or from the toolbar or by typing the command name, or right-click and choose Turn off Drawing Inspector. The options for this command are set in the menu that pops up by clicking the right mouse button. The available properties are: Layer Name, Elevation, Azimuth-Distance, Bearing-Distance, Point Data, Text Data, Curve Data, 3D Face Data, Polyline Data and Polyline Blips.
In the *Drawing Inspector* menu, you can choose one or more properties to display.

<table>
<thead>
<tr>
<th>Property</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display Layer Name:</strong></td>
</tr>
<tr>
<td>displays the layer name of the entity.</td>
</tr>
<tr>
<td><strong>Display Entity Type:</strong></td>
</tr>
<tr>
<td>displays the type of the entity (ie. TEXT or POLYLINE).</td>
</tr>
<tr>
<td><strong>Display Elevation:</strong></td>
</tr>
<tr>
<td>displays the elevation of the entity.</td>
</tr>
<tr>
<td><strong>Display Azimuth-Distance:</strong></td>
</tr>
<tr>
<td>displays the azimuth and distance of a line.</td>
</tr>
<tr>
<td><strong>Display Bearing-Distance:</strong></td>
</tr>
<tr>
<td>displays the bearing and distance of a line.</td>
</tr>
<tr>
<td><strong>Display Point Data:</strong></td>
</tr>
<tr>
<td>displays the coordinate data of point.</td>
</tr>
<tr>
<td><strong>Display Text Data:</strong></td>
</tr>
<tr>
<td>displays the contents of text.</td>
</tr>
<tr>
<td><strong>Display Curve Data:</strong></td>
</tr>
<tr>
<td>displays the radius, arc length, chord length and delta angle of a curve.</td>
</tr>
<tr>
<td><strong>Display Polyline Data:</strong></td>
</tr>
<tr>
<td>displays the end point elevations, horizontal distance, slope distance and slope ratios.</td>
</tr>
<tr>
<td><strong>Display 3D Face Data:</strong></td>
</tr>
<tr>
<td>displays the Z elevations at the face corners.</td>
</tr>
<tr>
<td><strong>Display Polyline Blips:</strong></td>
</tr>
<tr>
<td>displays temporary blip plus marks at the vertex locations of polylines.</td>
</tr>
<tr>
<td><strong>Display Polyline Direction:</strong></td>
</tr>
<tr>
<td>displays temporary arrows to show the direction of polylines.</td>
</tr>
<tr>
<td><strong>Display Surface Elevation:</strong></td>
</tr>
<tr>
<td>prompts for a TIN or grid surface file to load and displays the surface elevation at the current cursor location.</td>
</tr>
</tbody>
</table>

In the *Drawing Inspector* menu, you can also choose how the property information is reported.

**Enable Highlighting:** Allows you to highlight the object that the *Drawing Inspector* is reporting.

**Enable Tag Display:** Enables you to view the information next to the cursor on the screen.

**Show Data On Status Bar:** Enables you to view the information on the status bar, in the lower corner of the screen.

**Use Default Cursor:** When enabled, only the drawing cursor shows. When disabled, the mouse pointer is also shown.

**Report In High Precision:** When enabled, displays 8 decimals on distance and 4 decimal seconds on angles.
Example of Drawing Inspector reporting Bearing-Distance using the Tag Display

**Pulldown Menu Location:** Inquiry
**Keyboard Command:** inspector
**Prerequisite:** None

### List Elevation

This command displays the elevation of a polyline or line. With a 3D polyline, the elevation of the 3D polyline at the pick point is reported along with the elevation of each vertex. See also, the *Drawing Inspector* command on the *Inq-Set* menu.

**Prerequisite:** an entity

**Keyboard Command:** LSTELV

### Bearing & 3D Distance

This command reports the slope distance, slope ratio, bearing, azimuth and vertical angle between two 3D points. Pick or enter the coordinates of two points or select a line or polyline segment to calculate between the segment endpoints.

**Prompts**

Specify bearing-distance from (Line/PLine/<Points>)? press Enter
Pick point or enter point number: pick a point
Pick second point or enter point number: pick a point
Horiz Dist: 233.4 Slope Dist: 233.4 Elev Diff: 0.0 Vert Ang: 0d0'0"
Slope: 0.0% 0.0:1 Bearing: S 71d15'37'' W Azimuth: 198d44'23''

**Pulldown Menu Location:** Inquiry
**Keyboard Command:** 3DIST
**Prerequisite:** None

### Find Point

This command can be used to find a point in the current CRD file with a certain point number or description. For example, if you entered RAD* the command would plot a preview arrow at all the points that have the letters RAD...
as part of the description. i.e. RADPT1, RADPT2, RADPT3, etc. This command is not case sensitive (test is considered the same as TEST). Matching points are highlighted on the graphics screen with the preview arrow and listed on the text screen.

**Prompts**

Find by point [N]umber or [D]escription <N>: press Enter
Point number or range of point numbers to find <1>: 8-10
8 4856.75 4747.20 0.00
9 4909.25 4648.37 0.00
10 4223.30 4545.46 0.00 RADPT

If you respond with D for the first prompt the program prompts:

Conforms to AutoCAD's wild card matching.

Point Description(s) text to search for <>: rad*
Searching file C:\Carlson\DATA\LOT.CRD for point descriptions matching RAD* ...
7 4817.02 4662.73 0.00 RADPT
10 4223.30 4545.46 0.00 RADPT
Point(s) found 2

Pulldown Menu Location: Inquiry
Keyboard Command: fpnt
Prerequisite: None

**Calculator**

The Carlson Calculator command uses a convenient pop-up calculator with three tabs for a standard calculator, scientific calculator and conversion calculator. The standard calculator does basic math calculations using expressions such as +, -, / and *. The scientific calculator has angle and other functions. The conversion calculator has feet-metric and angle conversions including radians. The standard and scientific calculators support RPN. Here is how RPN works:

1+2 = 3
- type value 1 + Enter
- type value 2 + Enter
- type +
X = 3.

**Standard Calculator**

Most basic calculations can be performed using this tab in the calculator. Memory functions are also available.
Scientific Calculator
Values can be entered on the X register. The values can be rolled up and down with the up and down arrow keys and the Roll and RollD buttons on the dialog. The Enter key finishes the entry of a number and pushes the stack. The C on the touch screen clears an entry. Additional functions on the screen can be obtained through touching the scroll [<] and [>] area of the screen.

Conversion Calculator
This mode provides for conversion between many units. Enter a value in any field and press Enter to find the conversion value. The following units are available in Feet, Meters and International Feet Degrees, Minutes, Seconds and Gons/Grads and Decimal Degrees.
Pulldown Menu Location: Inquiry
Keyboard Command: cscalc
Prerequisite: None

Curve Info

This command displays information about a curve/arc. The curve can be defined by an arc entity or polyline arc segment or by selecting three points on the arc. The three points can be defined by point number or picked on the screen. The curve data is displayed in the text window with an option to be displayed in the Standard Report Viewer. Click Exit to return to the graphics window.

Prompts

Define arc by, Points/<select arc or polyline>: select the arc entities
Endpoint: (4923.81 5193.15 0.0)
Other Endpoint: (5168.27 5274.03 0.0)
Radius Point Coords: (5126.6 4990.09 0.0)
Chord Bearing: N 71d41'33'' E
Chord Azimuth: 71d41'33''
Delta angle in radians: 0.9304628295
RoadWay Degree of Curve: 19d57'56''
RailRoad Degree of Curve: 20d4'4'' Chord Crv Length: 265.66 Excess: 1.36
External: 34.13 Mid Ord: 30.50 Tangent: 144.06
Delta: 53d18'42''
Chord: 257.49
Length: 267.02
Radius: 286.97
Display curve data in report viewer [Yes/<No>]? Y
Angle Info

This command reports the interior and exterior angles defined by two joining line segments or by three points. The coordinates, angles and distances of the line segments are also reported. The report is displayed in the standard report viewer.

<table>
<thead>
<tr>
<th>Point#</th>
<th>Northing</th>
<th>Easting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>11</td>
<td>4728.73</td>
</tr>
<tr>
<td>Corner</td>
<td>12</td>
<td>4684.89</td>
</tr>
<tr>
<td>End</td>
<td>13</td>
<td>4664.02</td>
</tr>
</tbody>
</table>

Bearing Distance

First Side: S 38°40'56'' W 56.16
Second Side: S 72°21'16'' E 68.85

Interior: 68°57'48''
Exterior: 291°02'12''
Prompts

Define angle by, Points/<select line or polyline>: P for points

1st Point?
Pick point or point number: 11

2nd (Corner) Point ?
Pick point or point number: 12

3rd Point?
Pick point or point number: 13
Interior: 68°57'18'' Exterior: 291°02'42''

Angle Info Report Viewer

1st Point (Enter to end)?
Pick point or point number: press Enter

Pulldown Menu Location: Inquiry
Keyboard Command: ainfo
Prerequisite: None

Polyline Info

This command reports the length and elevation of the selected polyline or line.

Prompts

Pick Polyline or Line: pick a polyline or line

Polyline length: 7702.75 Slope distance: 7702.75 Avg elev: 1700.00 Avg slope: 0.00%

Pulldown Menu Location: Inquiry
Keyboard Command: polylen
Prerequisite: None

Layer Report

This command generates a report containing all the layers defined in the drawing. Along with the layer names, the report includes the number of entities on each layer, and the color, linetype and lineweight for each layer.

Layer Report
Drawing: C:\sample\example1

<table>
<thead>
<tr>
<th>Layer Name</th>
<th>Entity Count</th>
<th>Color</th>
<th>Linetype</th>
<th>Lineweight</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>5</td>
<td>White</td>
<td>CONTINUOUS</td>
<td></td>
</tr>
<tr>
<td>AREAPERIM</td>
<td>0</td>
<td>White</td>
<td>CONTINUOUS</td>
<td></td>
</tr>
<tr>
<td>AREATXT</td>
<td>0</td>
<td>Magenta</td>
<td>CONTINUOUS</td>
<td></td>
</tr>
<tr>
<td>BL</td>
<td>8</td>
<td>White</td>
<td>DASHED</td>
<td></td>
</tr>
<tr>
<td>BL-LAB</td>
<td>76</td>
<td>Red</td>
<td>CONTINUOUS</td>
<td></td>
</tr>
</tbody>
</table>

Pulldown Menu Location: Inquiry
Keyboard Command: reportlayer
Prerequisite: None
Style Report

This command generates a report containing all the styles defined in the drawing. Along with the style names, the report includes the number of entities on each style and the style properties.

**Style Report**

**Drawing:** C:\files\user\Project.dwg

<table>
<thead>
<tr>
<th>Style</th>
<th>Font</th>
<th>Text Count</th>
<th>Fixed Height</th>
<th>Width Factor</th>
<th>Oblique Angle</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROMAND</td>
<td>romand.shx</td>
<td>1198</td>
<td>0.0</td>
<td>1.0</td>
<td>0°00'00''</td>
</tr>
<tr>
<td>ROMANS</td>
<td>romans.shx</td>
<td>3981</td>
<td>0.0</td>
<td>1.0</td>
<td>0°00'00''</td>
</tr>
<tr>
<td>ROMANT</td>
<td>romant.shx</td>
<td>104</td>
<td>0.0</td>
<td>1.0</td>
<td>0°00'00''</td>
</tr>
</tbody>
</table>

**Pulldown Menu Location:** Inquiry

**Keyboard Command:** style_layer

**Prerequisite:** None

Block Data Report

This command reports the number of different types of blocks in the drawing along with the block attributes. After selecting the blocks to report, the program has a dialog with all the block attributes. You can select which attributes to report. The Details option for the Report Format includes the properties for each block including the northing and easting. The Summary Report reports the number of each type of block with matching reported attributes. The Only Report Blocks With Attributes chooses whether to report blocks with no attributes.

**Prompts**

Select blocks to report.

Select objects: select blocks

Block Data Report dialog

Report Formatter
Summary Report
COND Count
POOR 1
GOOD 3
FAIR 2
Total 6

Details Report
ID Northing Easting COND
100 2190229.6 6135223.9 GOOD
101 2190224.1 6135171.4 GOOD
102 2190200.4 6135103.4 GOOD
103 2190227.0 6135117.4 FAIR
104 2190198.9 6135164.8 POOR
105 2190198.9 6135239.4 FAIR

Pulldown Menu Location: Inquiry
Keyboard Command: blk_report
Prerequisite: Blocks with attributes

Display-Edit File
This command allows you to edit or review an ASCII/text file. Files are displayed in the Standard Report Viewer section of this manual.

Pulldown Menu Location: Inquiry
Keyboard Command: scedit
Prerequisite: A file to edit

Text File To Report Formatter
This command loads data from a comma separated text file into the Report Formatter. The first line in the text file is used for the header names for the report. The rest of the lines in the text file has the field data for the report. Here's an example text file:

Point,Northing,Easting,Elevation,Description
11,4684.34317,5652.95193,501.47000,IP
12,4792.02100,5436.00000,505.90000,UP
13,4651.52246,5516.53607,504.03000,BLD
14,4656.32969,5535.94973,504.72000,BLD
Load Saved Report
This brings up the Report Formatter for the report data file saved previously by the Report Formatter.

Pulldown Menu Location: Inquiry
Keyboard Command: load_report
Prerequisite: A saved report

Load Last Report Formatter
This command brings up the last report generated by any Carlson command that used the Report Formatter.

Pulldown Menu Location: Inquiry
Keyboard Command: prev_report
Prerequisite: A previously run command that used the Report Formatter

Display Last Report
This brings up the last report generated by any Carlson command that uses the standard report viewer.

Pulldown Menu Location: Inquiry
Keyboard Command: report_up
Prerequisite: A previously viewed report
Settings Menu

Shown here is the Carlson Software Settings menu. The top section contains the commands most important for setting up the drawing. You should run Drawing Setup prior to beginning your drawing. Additional setup and settings features are found in the middle section. The last section of the menu includes AutoCAD settings commands, including the System Variable Editor.
**Drawing Setup**

This command allows you to specify drawing parameters, including the plotting scale, size of symbols, label annotation size, and the angle mode.

- Specify **English 1in=?ft or Metric 1m=?m** as the unit mode to use. This affects the prompting and reports. When you are working on a drawing in English units, one unit equals one foot. In metric, one unit equals one meter.
- Specify the **Horizontal Scale** of the drawing. For example, if the horizontal scale is set to 50, then 1" = 50' is your drawing scale.
- The **Symbol Plot Size** value is a scaler that represents the size on the plot. The Drawing Units are determined by multiplying the scaler by the horizontal scale. In English mode the scaler represents the plotted size in inches. In Metric mode, this value is the plotted size in centimeters. The Drawing Units field shows the result of the Symbol Plot Size value (the scaler) multiplied by the horizontal scale.
- The **Text Plot Size** value is a scaler that represents the size on the plot. The Drawing Units are determined by multiplying the scaler by the horizontal scale. In English mode the scaler represents the plotted size in inches. In Metric mode, this value is the plotted size in centimeters. The Text Plot Size is not entered in Drawing Units. The Drawing Units field shows the result of the Text Plot Size value (the scaler) multiplied by the horizontal scale.
- The **Line Type Scaler** option sets the linetype scale by multiplying this scaler by the horizontal scale.
- **Angle Mode-Bearing** sets reporting to bearing mode for any of the inquiry commands. (Modifies the settings in the AutoCAD UNITS command.)
- **Angle Mode-Azimuth** sets reporting to north based azimuth mode for any of the inquiry commands. (Modifies the settings in the AutoCAD UNITS command.)
- **Angle Mode-Gon** sets reporting to gon mode for any of the inquiry commands. (Modifies the settings in the AutoCAD UNITS command.)
- **Angle Mode-Other** lets the user determine angle mode by using the AutoCAD UNITS command.
- **Coordinate System** is an optional setting to define the drawing coordinate system. The coordinate system settings are used in commands like List Points and Label Lat/Lon to report geodetic coordinates from the drawing coordinates. The Grid System setting applies to drawing coordinates that are in a grid projection.
system such as state plane coordinates. The Projection list selects the grid projection from the list of supported projections. Along with the Projection, there are selections for the zone and datum to use with the projection. When the drawing setup is in English mode, there is a projection setting for whether the feet are in US Feet or International Feet units. The Local System setting applies to all other coordinate system beside grid projections. The Define Localization button has settings to define the transformation from local coordinates to grid coordinates. With a localization defined, you can work in a drawing in local coordinates and still report lat/lon. The localization definition contains pairs of local and grid coordinates that define the transformation. See the Align To Local Coordinates command in the Field Module for more information.

- **Project Scale Factor** is multiplied by the x,y coordinates when converting between drawing and geodetic coordinates.
- **Base Z** is used for calculating the combined scale factor for calculating geodetic areas.

- **Projection:** There are several built-in projection including State Plane 83, State Plane 27 and UTM. Also on the Projection list is an item for More Pre-Defined as well as User-Defined projections. This expanded Pre-Defined selection includes the projections used in SurvCE which has hundreds of projections including the US County projections for Indiana INDOT INGCS, Iowa Regional Coordinate System, Minnesota, Oregon and Wisconsin (WCCS and WISCRS) as well as from around the world. When you pick Pre-Defined, a dialog shows a list of recently selected Pre-Defined projections.

You can pick from this recently used list, or pick the Add Pre-Defined to select from the built-in list.
The Add From File button reads in a projection saved to a file by this routine or by SurvCE CSL or ESRI PRJ. The Edit button allows you to change the name or parameters of a projection. The Remove function removes a projection from the list of recently used projections. The Add User-Defined routine defines a projection by setting the ellipsoid, choosing the method and entering the parameters. There are over 25 built-in ellipsoids to choose from such as Clarke 1880. You can also manually enter the ellipsoid values. The projection definition includes the 7 parameter Helmert transformation to go from WGS-84 to the user datum. There are over 20 projection types to choose from such as Transverse Mercator. After selecting the projection type, there are edit fields for each of the parameters for the selected projection. The Test button brings up a calculator to enter a lat/lon and report the projection coordinates as a way to test that the projection parameters are entered correctly and are working.

Besides Drawing Setup, these projection functions are also used in the Coordinate Transformation function in Coordinate File Utilities.

- **Project Name and Job Number** are optional fields that are used in the header for reports.
- **Project Location** is used in the header for reports and used to roughly geolocate the drawing when the Projection isn't set.

- **Report Distance Scale Factor** is used to show distances in a second system besides the drawing units. For example, this factor can be used to report distances in meters when the drawing is in feet, or it can be used to report grid distances when the drawings is in a ground coordinate system. This factor is applied in commands that have an option to label/report a second scaled distance such as the Inverse command and Annotate Defaults that applies to the angle/distance label routines. The scale factor can be set to a single fixed value or set to go from ground to grid or from grid to ground on-the-fly. The fixed scale factor can be entered directly into the edit box or calculated using the Set button which has feet-meters conversions as well as combined scale factor calculations for grid-ground factors. See the Scale Points command for more information on calculating the combined scale factor. For the on-the-fly factor between grid and ground, the program calculates the combined scale factor for each distance using the two end points for the distance line.

- **Rotation** is used to adjust the bearings and azimuths for labels and reports such as in the Inverse and Auto-Annotate routines.
- The **Set Text Styles** button creates text styles in the drawing for the current drawing Horizontal Scale with the specified Font Name and list of Style Names and Text Size Scalers. For example, when the Horizontal Scale is set to 50 and there is a Style Name of L80 with Text Size Scaler of 0.08 in the list, then this function will create a text style in the drawing called L80 with the text height of 4 (50 * 0.08). Besides the font and size, you can also set the width factor and oblique angle for each style. Use the Save and Load buttons to store and recall these style settings to a .FNT file for sharing with co-workers or your own use.
• The Set Paper button allows you to draw a rectangle on the screen that represents the edge of your paper. After you have set the horizontal scale, press the Set Paper button and the Set Paper dialog appears.

– The Layout option lets you specify landscape or portrait paper orientation. Landscape layout is where the width of the page is greater than the height of the page. Portrait layout is the opposite.
– The Paper Size option allows you to specify the paper size. The numbers in parenthesis represent drawing units and will be multiplied by the horizontal scale to determine the rectangle to be drawn. If you select the Other option, you will be prompted on the command line for the horizontal and vertical sizes of the paper.

Prompts (for Set Paper)

Pick or Type lower left corner point for border <(5000.00 5000.00 0.0)>: pick a point
Erase existing Set Paper boundary [<Yes>/No]? Y This prompt only appears if there is an existing paper boundary in this drawing.
Set Limits [Yes/<No>]?

If you answer Yes to Set Limits, drawing limits are enabled, and AutoCAD restricts the coordinates you can enter to within the paper boundary. Drawing limits also determines the area of the drawing that can display grid dots, and the minimum area displayed by the Zoom All command on the View menu. To turn drawing limits off, type in LIMITS on the command line and set to Off.

Drawing Setup also sets the AutoCAD dimension scale (DIMSCALE) and linetype scale (LTSCALE) to the Horizontal Scale.

Pulldown Menu Location: Settings
Keyboard Command: setup
Prerequisite: None

Set Project/Data Folders

This command sets the project work folder, the data folder and the settings folder to use as the default folders for your Carlson drawing and data files. The PROJECT folder is the top-level folder for all the data sub-folders with all the files for the project. The DATA folder contains project specific data files such as coordinate (.CRD), profile (.PRO) and centerline (.CL) files. The SETTINGS folder contains program settings files that can apply to multiple projects such as Field-To-Finish Code Tables (.FLD) and Draw Profile Settings (.PFS). These folders are the defaults where the file selection dialogs will start in. When selecting files, you can change to another folder at any time.

Data Folder Setup: This grouping of controls provides varying levels of sophistication towards how data files associated with a given project are stored and organized on your computer system. Three options are provided:

- **Project Folder** - Data files are organized and stored (by default) into a user-definable sub-folder structure and this option is often used by larger organizations that have teams of employees working on a project. Selecting this option enables the Project Sub-Folders Setup and Data Type Sub-Folders buttons.
- **Drawing Folder** - Data files are stored (by default) into the same folder where the current project drawing has been directed and this option is often used by mid-sized or smaller organizations who seek only basic data organization.
• **Fixed Folder** - Data files are stored (by default) into a single folder and might be used by smaller organizations who do not require any type of data organization.

**Project Sub-Folders Setup:** Click this button to create a folder structure (see the sample below) that is created when a new project is created. The list of project folders can be customized at any time but modifications to the folder structure will only occur on projects that are created after the modification(s) to the Project Folder list.

![Project Folders](image)

**Data Type Sub-Folders:** Clicking this button allows the various types of data files produced by Carlson to be assigned to a folder identified with the Project Sub-Folders Setup command, as illustrated below. File types that are not assigned to a sub-folder are stored (by default) in the current project folder.

![Data Type Sub-Folders](image)

The following controls allow you to organize your data file types:

<table>
<thead>
<tr>
<th>Control</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Create" /></td>
<td>Creates a new data type sub-category.</td>
</tr>
<tr>
<td><img src="image" alt="Remove" /></td>
<td>Removes the selected data type sub-category. Any data types that have been assigned to the sub-category are subsequently migrated into the Misc Data-Types category.</td>
</tr>
<tr>
<td><img src="image" alt="Rename" /></td>
<td>Allows the selected data type sub-category to be renamed.</td>
</tr>
</tbody>
</table>

Category Controls
Move To: Associates the selected data type(s) with a data type sub-category. Use standard Windows click, shift+click and/or ctrl+click functionality to select multiple data types at the same time.

Assign Folder: Assigns the selected data type(s) to a project sub-folder. Use standard Windows click, shift+click and/or ctrl+click functionality to select multiple data types at the same time.

Load: Loads a previously saved Data Type Sub-Folder (.DSF) file.

Save As: Saves the current Data Type Sub-folder configuration to a Data Type Sub-Folder (.DSF) file.

Report: Allows the contents of the current Data Type Sub-folder configuration to be sent to a report.

Edit Sub-Folders: Initiates the Project Sub-Folders Setup command.

Startup Project/Data Folder: Indicate or use Set button to assign the start-up (or default) Project Folder location (when using the Project Folder option) or the start-up Data Folder location when using either the Drawing Folder or Fixed Folder option.

Current Project Folder: This setting is the top-level project folder for the current drawing.

Current Data Folder: This setting is the default data folder for the current drawing.

Reassign Data Folder: This function shows a list of all the folders used for data files associated with the current drawing. You can select a folder from this list and switch to another folder location which re-associates the data files. This function applies to projects that have been moved in the file system.

Clear Data Folder History: This function removes the association of all data files with the current drawing. The effect is to go back to defaults for data file selections.

File Selection Check for Project Folder: This option applies to the standard File Selection dialog for whenever a project data file is selected:

- Off: No folder checking is performed.
- Warn Non-Project: The program will display a warning if a project file is selected from a folder that is outside the Current Data Folder.
- Prevent Non-Project: The File Selection will not accept selecting a data file that is outside the Current Data Folder.

Use Data Folder For Settings: When enabled, this option sets the Settings folder to match the Data folder which, in effect, combines the Settings and Data folders into one folder.

Startup Settings Folder: This folder is the default Settings folder for new drawings.

Current Settings Folder: This folder is the Settings folder for the current drawing.

Use Settings Server: The Settings Server is a system for distributing program settings and files to workstations in the office.

Report: Reports the date and time that files have been copied to your computer.

Setup: Provides an interface to configure the Settings Server as illustrated below:

Server Location: Indicate the path to a shared folder on your office network. This folder is where the settings and files to distribute are stored.

Automatically Check Settings Server On Startup: When enabled, the settings are checked each time the program is started.
Check For Updates: This button copies any new files and settings from the Settings Server to your computer. When files are copied from the Settings Server to your computer, your existing files are backed up.

Restore Backup: This option allows you to bring back your original files.

Manage Settings Server: Use this button to setup the files and settings to distribute:

The Manage Settings Server dialog shows a list of the files to distribute. To control access to these settings and files, use Windows permissions to set the folder to *read-only* to all except the Server Manager.

Use Base Settings: Base Settings are copied to each workstation only once. After this initial setup, the workstation settings can be changed by that user. Use the **Setup** button to show the settings in the Settings Explorer command where you can review and edit the settings for each file.

Use Update Settings: Update Settings are copied to each workstation each time the workstation checks the Settings Server. These Update Settings can be used to make sure certain settings are kept set on workstations. Use the **Setup** button to show the settings in the Settings Explorer command where you can review and edit the settings for each file.

Compare Settings: This function reports the difference between the Base Settings and the Update Settings.

Report File Log: This button reports the date and time each file is distributed per user.

Report User Log: This command reports the date and time that users have checked into the Settings Server and it reports the version and build date of Carlson that they are running.

Add: This button permits you to add a file. The Add function prompts for the target folder for the file:

- **Settings Folder**: For Carlson command settings files such as Field-To-Finish code table (.fld), Draw Profile settings (.pfs) or Triangulate and Contour settings (.tri). The target Settings Folder is defined in the Project Setup dialog shown above. The default Settings folder is C:\Carlson Projects\Settings.

- **Support Folder**: For CAD support files such as symbol drawings, hatch patterns (.pat) and linetypes (.lin). The target Support Folder is under the Windows AppData folder in this format: \Users\<user name>\AppData\Roaming\Carlson Software\<program version>\<CAD version>\SUP.

- **User Folder**: For Carlson program files such as Symbol Library (symbols.dta), Quick Keys (quickrun.lsp) and Report Formatter (formats.dta). The target Support Folder is under the Windows AppData folder in this format: \Users\<user name>\AppData\Roaming\Carlson Software\<program version>\<CAD version>\USER.

- **Other Folder**: For files in a user-specified folder.
When adding files, there is an option to assign a comment to the file which is used in reporting.

**Remove:** This button removes the selected file from the list.

**Project File:** Indicate or use **Set** button to specify the Project Settings (.PRJ) file associated with the current drawing. The Project Settings file is a collection of drawing names (e.g. BaseMap.dwg, Roads.dwg, Parcels.dwg, Sewers.dwg, etc) that belong to the same project. This collection of drawings is used by Project Explorer to manage the drawings and data files for the current project and must be specified if the Carlson Data Depot service is to be used. If the current drawing is not associated with a project, then this setting will be blank.

**Data Depot Type:** The Carlson Data Depot is a document management system to allow tracking of the changing states of files and projects over time and merge the contributions from multiple users providing data integrity, productivity and accountability for the managed products. Carlson Software supports the following version control systems:

1. Subversion - a free, open-source version control system.
2. ProjectWise - software developed and produced by Bentley Systems.

**Setup:** Before proceeding, refer to the Carlson Data Depot section for information on how to install and properly prepare your preferred document management system. Once this has been completed, click this button to complete the Data Depot Settings.

**Server Location (Subversion local):** Indicate the path for the appropriate location (often a shared server drive) where the file edits and updates are tracked (e.g. file:///C:/svnrepo). For Windows users, note the triple-slash convention:

**Server Location (Subversion VPN):** Indicate the server (proper login name and password may be required) where the file edits and updates are tracked:

![Data Depot Settings](image)
For a more extensive write-up on available options, refer to Subversion in Action - Chapter 1. Fundamental Concepts.

**Server Location (ProjectWise):** Indicate the ProjectWise server and datasource where the file edits and updates are tracked (format is server-name followed by a colon ":", followed by the datasource name, e.g. esri:pwtest). See your ProjectWise Administrator for the name of your ProjectWise servers and datasources.

![Data Depot Settings](image)

**Automatic Check-Out on Startup:** This option will check for any updates for the project and associated file on the server while opening the drawing. If there is a new version of a file is found it is automatically updated to match the current version on the server. User will be prompted if an older version or conflicting versions of file are found.

**Use Automatic Project Folder Name:** When a project is updated or initially accessed with the get_prj_from_depot command, this option will automatically map the project to a folder with the same name as the repository project name under your Startup Project Folder. For example, if your Startup Project Folder is named "C:\Carlson Projects\" and the repository project is named "My Test Project" the get_prj_from_depot will use "C:\Carlson Projects\My Test Project\" as the local Current Project Folder.

**Include User Name in Project Folder Name:** When "User Automatic Project Folder Name" is enabled this option will also be enabled. When a project is updated or initially accessed with the get_prj_from_depot command, this option will automatically map the project to a folder with the same name as the repository project name, plus your user name under your Startup Project folder. For example, if your Startup Project Folder is named "C:\Carlson Projects\", your user name is "Engr1" and the repository project is named "My Test Project" the get_prj_from_depot will use "C:\Carlson Projects\Engr1\My Test Project" as the local Current Project Folder.

**Set Read-Only File Attribute for Drawings Not Locked by the Current User:** This option will prevent the user from being able to save drawings for which he/she is not the lock owner. This prevents the user from getting into situations that may cause potential loss of data at check-in time.

**Automatic Check-In Changes:** If any file under project is updated or edited, it will be automatically checked-in to the repository.

**Automatic Upgrade Read-Only to Edit:** If a file is checked-in by the current user, the file is upgraded to Edit Mode (locked) for that user for further editing opportunity.

**Revert to Read-Only After Upgrade from Edit:** If a file is checked-in by the current user, the file is reverted to Read-only Mode (unlocked) so that other users can further edit the file.

Once the Data Depot has been configured, you can assign a project to the Data Depot via the Project Explorer command.

**Pulldown Menu Location:** Settings

**Keyboard Command:** settmpdir

**Prerequisite:** None
Carlson Configure

This command allows you to set up the default settings that are used each time you start a new drawing, or load an existing drawing.

![Configuration dialog box]

**NOTE:** When using Carlson products with an "embedded AutoCAD OEM engine" (*e.g.* Carlson Survey with Embedded AutoCAD or Carlson Takeoff with Embedded AutoCAD), only a subset of the various configuration commands will be available.

**Load:** This command permits a previously saved configuration (CFG) file to be loaded into the software and is useful for propagating corporate standards to groups or individuals within an organization.

**SaveAs:** This command "packages" up all current configuration settings and permits them to be saved to a named configuration (CFG) file that can be shared with users of Carlson Software.

<table>
<thead>
<tr>
<th>General Settings</th>
<th>Drawing Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project/Data Folders</td>
<td>Startup Settings</td>
</tr>
<tr>
<td>Survey Settings</td>
<td>Surface Settings</td>
</tr>
<tr>
<td>Section-Profile Settings</td>
<td>Hydrology Settings</td>
</tr>
<tr>
<td>Mine Note Settings</td>
<td>Mining Settings</td>
</tr>
<tr>
<td>Takeoff/SiteNet Settings</td>
<td>Localization Settings</td>
</tr>
</tbody>
</table>

Table of Contents
Use Startup Wizard: When enabled, a dialog-based "wizard" interface is used for the creation of a new project.

Generate Report Log: When enabled, output from several commands will be accumulated in a report buffer. Commands that output to the report log include Inverse, Traverse, Curve Info, etc. Also, any report that is displayed in the standard report viewer is also added to the report log. While activated, the report log resides in the lower left corner of the desktop as a minimized title bar that shows how many lines are in the report buffer. To view the report log, pick on the maximize icon on this title bar. You can also view the report log by running the Display Report Log function in the Inquiry menu. The report log can be edited, saved to a file or printed. To quickly turn the report log on and off, you can type REPORT at the command prompt.

Generate Drawing Save Log: This option stores the time stamp and user name in the DWG each time the drawing is saved. This save log can be viewed using the Drawing Save Log command.

Save Drawing INI Files: This option stores the file names of data files used with the current drawing. When enabled, an .INI with the same name as the DWG file will be created to store the data file names. These file names are used for the list of recent files when selecting data files and the Drawing Explorer command manages the list of these data files.

Save Settings To Drawing Dictionary: This option saves the settings for commands within the drawing. Commands always store settings at the program level for recall the next time the commands are run. By storing settings with the drawing, each drawing will recall the command settings used in the drawing. For example, if you run Triangulate & Contour at an interval of 5 in Drawing_A, then use interval 1 in Drawing_B, then the next time you contour in Drawing_A it will recall interval 5 instead of using the last interval of 1.

Ignore Zero Elevs: This option will ignore any entities with a zero elevation. It is used for many commands, such as Triangulate and Contour or Make Grid File.

Use South Azimuth: Turning on this option will use a South Azimuth instead of a North Azimuth as the basis for
0 degree.

**Use Dview Twist Angle:** This option makes the program create text entities at an angle to match the current VIEWTWIST system variable so that the labels are horizontal to the screen twist angle. This twist angle can be set with the DVIEW command or the View > Twist Screen commands. In IntelliCAD, this option also controls the USEVIEWTWIST system variable for making MLEADER and MTEXT default rotation to be horizontal to the current screen twist angle.

**Set DIMSCALE to Drawing Scale:** This will set the dimension scale to match the drawing scale.

**Set AUNITS to Drawing Angle Mode:** This will set the DWG angular units to match the angle mode established under Drawing Setup.

**Set PDSIZE to Symbol Size:** This will set the PDSIZE scale to match the symbol size defined in Drawing Setup.

**Set INSUNITS to Unitless:** This will set the INSUNITS (Insertion Units) CAD system variable to Unitless (INSUNITS=0) when the drawing is opened.

**Set MENUBAR on Startup:** When enabled, the Carlson Menu associated with the Carlson icon (usually on the PC Desktop) will be loaded. Otherwise, use the Carlson Menus command to select the desired menu.

**Set UCS to World on Startup:** When enabled, drawings with a User Coordinate System (UCS) other than World will have the UCS set to World.

**Set LTSCALE on Startup to Drawing Setup:** When enabled, the linetype scale (LTSCALE) variable will be set to the Horizontal Scale defined under Drawing Setup.

**Use Software Rendering:** When enabled, commands that use OpenGL functionality (such as 3D Viewer Window) on computers with older video cards that don't offer extensive hardware acceleration will attempt to render the information with any available random-access memory (RAM).

**Use Dialog For Selection Set Filter:** For IntelliCAD, this option chooses whether to prompt for selection set filters in a dialog or command prompt at the "Select objects" prompt.

**Use Annotative Scale:** When enabled, text created by Carlson routines such as Annotation will use scale-able annotative properties. This setting also applies to symbols created by Draw > Insert Symbols. Carlson Points have a separate setting for annotative under the Point Defaults command.

**Support All Drawing Scales:** When enabled, text placed as annotative entities will make use of all annotation scales currently defined within the drawing.

**Set Annotative to Drawing Scale:** This option sets the annotative scale to match the Horizontal Scale set in the Drawing Setup command.

**Annotative Scale Prefix/Suffix:** These strings are used for naming annotative scales when the program creates new annotative scales. For example, when the program creates an annotative scale for a horizontal scale of 50, you can name the annotative scale as 1:50 or 1"=50' depending on these string settings.

**Coordinate Report Order:** You can choose the traditional North-East format, or reverse these in reports with an East-North format.

**Date Format:** You can control the display of dates in Carlson reports with this drop-down menu. The default is "Windows Setting" which allows you to control it with Windows Control Panel. Several other common formats are available.

**Formatted Document Type:** (AutoCAD-based platforms, only) Use this option (for commands such as 3D Viewer Window to establish the type of document produced by the command.

**Report Viewer:** This option chooses between the Carlson Report Viewer, Windows Notepad and Microsoft Word for the viewer to use for reports that the Carlson commands generate.

**AutoCAD Menu:** (AutoCAD-based platforms, only) This option chooses which AutoCAD menu to load when picking the AutoCAD menu from the Carlson Menus toolbar or from the Settings > Carlson Menus pull-down
menu. When AutoCAD Map is installed, there are different layouts of the Map menu to choose from. When Autodesk LandDesktop is installed, those menus are available.

**Object Linking:** The Object Linking section contains options for creating additional "intelligence" on Carlson-placed entities:

- **Link Points with CRD File** - (AutoCAD-based platforms, only) When enabled, points placed into the drawing will be given a "reactor" so that any change to the entities such as MOVE or ROTATE will update the coordinates in the CRD file.
- **Link Linework with Points** - (AutoCAD-based platforms, only) Line and polyline entities that are drawn by point number (including those placed via Draw Field-to-Finish such that a positional change to a linked point will automatically update the linework.
- **Link Labels with Linework** - (AutoCAD-based platforms, only) When enabled, direction and/or distance labels assigned to physical linework entities will get updated if the underlying line is changed.
- **Link Linework with Centerlines** - (AutoCAD-based platforms, only) For linework that has been used to create a Carlson Centerline, changes to the linework will update the corresponding centerline (CL) file.
- **Group Point Entities** - When enabled, the three entities of a Carlson point (attribute block, symbol and node) become linked as a single entity. For each point, selecting any one of these entities selects all three entities for the point. **NOTE:** This setting is not the same as the "Point Group" functionality as found under the Point Group Manager command.
- **Maintain CRD History File** - When enabled, changes to a point are tracked into a "history" file. These changes can be accessed via the **History** button found under the Edit Point Attributes command.

**Coordinate File Format:** Carlson can be configured to utilize a variety of coordinate file formats:

- **Carlson Numeric Only** - Point numbers cannot contain letters and must be in the range from 1 to 99999.
- **Carlson Alphanumeric** - This format allows letters in the point numbers and the point "number" can be up to 9 characters in length. Any combination of letters and numbers is acceptable.
- **Carlson SQLite** - Based on the Structured Query Language (SQL) database format, this CRDB format allows alphanumeric combinations of point number and descriptions up to 255 characters in length.
- **C&G Numeric** - This format of the C&G division supports up to 5 digits, with a 65000 point limit.
- **C&G Alphanumeric** - This format of the C&G division supports up to 10 characters, with no limit to the number of points.
- **Simplicity ZAK:** - This is the Simplicity Systems "Sight Survey" coordinate file format.
- **MS Access Database (LDT)** - This is a Microsoft Access database used by Autodesk Land Desktop. The file is typically named "points.mdb" and is typically found in a Land Desktop project \COGO subdirectory. The point identifier limitation is established by the database structure, which has a default of 255 characters.

**Remove Arcs:** Since 3D polylines do not allow true arcs, the program represents arcs in 3D polylines as a series of short chords. The Remove Arcs settings control the spacing of these arcs:

- **Max Offset** - Sets the maximum difference between the chords and the original arcs as shown in the image above. This method is similar to the Reduce Polyline Vertices command.
- **Chord Len** - Sets the length of the chord segments that replace the original arc.

**Digitizer Puck Layout & View:** There are two main formats for the digitizer puck. They are numbered 1 and 2. Selecting the View button brings up the window showing the two formats.
Use Mouse: This option allows you to use the mouse instead of the digitizer puck for the digitize commands.

Auto Tablet On for Digitize Commands: This option will activate the tablet when using the digitize commands.

Auto Tablet Off for Digitize Commands: This option will de-activate the tablet when using the digitize commands.

Several settings under Drawing Setup are used to establish the default values provided in the Startup Wizard and are identical to those discussed in Drawing Setup. There are a few additions, such as Vertical Scale, Point Prompt-Label Settings, Point Number Settings and Vertical Angle Mode.

There is also the ability to maintain two different sets of defaults (English and Metric). The user can maintain a comfortable set of settings for either unit system, especially if they constantly switch back and forth. Also added was support for meters/metres, tons/tonnes and various date representation which can be accessed via the Localization Settings button.

Please refer to the Set Project/Data Folder command for complete information.

These options are used for starting Carlson. Defaults are set here, and will be used at the beginning of each session.
**Template Name:** This is the drawing template file that will be used when starting a new drawing. The Browse button allows for selecting a new file.

**Carlson Launch Folder:** This is the folder where Carlson projects would be stored by default. The Browse button allows for selecting a new folder location.

**Profile Name:** This is the AutoCAD/IntelliCAD Profile that will be used when working in Carlson. If you use a custom profile, be sure that the profile contains the Carlson support folder in the Support File Search path (ie. %appdata%\Carlson Software\Carlson version\CAD version\SUP), and the Carlson main menu must be loaded.

If the custom profile doesn't have these requirements, then the program switches to the default Carlson profile.

**AutoCAD command switches:** This turns off the AutoCAD "splash" screen upon launching the program. The /nologo takes the splash screen out of the start-up procedure. See AutoCAD documentation for other switches that are available for use.

**AutoCAD product to run:** (AutoCAD Only) This is the AutoCAD version and flavor (Map or LDT, etc.) that Carlson is installed for, and will run with.

**No menu resetting:** (AutoCAD Only) This controls whether to set the Carlson menu as the main customization file on startup or to keep the current main customization unchanged.

**CG Survey Menu:** Indicate whether to add-on the C&G Survey pull-down menus to the standard Carlson Survey menus. The Compact mode has all the C&G commands in a single pull-down menu. The Expanded mode has all eight C&G pull-down menus that C&G "stand-alone" used to have.

**Initial Traverse/Sideshot Angle Mode:** This sets the default angle mode for these COGO commands.

**Show Occupy and Backsight Points on Status Bar:** This is an option for the COGO Inverse command.

**Automatic Raw File On:** This is equivalent to toggling on the COGO > Raw File On/Off automatically when the drawing is opened.

**Automatic Line On:** This is equivalent to toggling on the COGO > Line On/Off automatically when the drawing is opened.
Automatic Point Object Snap On: This is equivalent to toggling on the Settings > Point Object Snap On/Off automatically when the drawing is opened.

Automatic Compare DWG points with Coordinate File on Startup: This option runs the Coordinate File Utilities > Compare Points routine when the DWG file is opened to report any differences between the point entities in the drawing and point coordinates in the coordinate file.

Most of the Surface/Triangulate & Contour commands will remember the settings and parameters used from drawing to drawing. There are some in this screen that will be used for gridding and modeling.

Inverse Distance/LeastSquares Modeling Parameters: The modeling methods of Inverse Distance and Least Squares are similar ways to create a grid from datapoints or drillholes. It is not recommended to use these methods for gridding contour or breaklines. Triangulation is better for that. These methods need a search radius defined. Anything past this distance from one data point to the next will be ignored for influence. The Max Samples are the number of data points that will be used to influence each data point. The area is broken into 4 quadrants. The Min and Max Quadrant are the numbers of data points that will be used in each quadrant.

Specify Grid Resolution As: There are two ways to create a grid file. Once the boundary has been selected, the cells need to be determined. Number of Cells in X and Y will divide the boundary up into the specified number of cells. These will then be odd shaped rectangles, with the size calculated by the boundary dimensions and the number of cells. The Dimensions of Cells is the more commonly used method. This will allow for a set cell size for the X and Y directions. Most of the time the grid cells should be square, where you set the size.

Grid Precision: This is the number of decimals that are stored in the grid file.

Draw Contours Max Number of Rechecks for Crossings: Routines that generate contours check for any crossings that can occur from smoothing or reduction options. When a crossing is found, the smoothing or reduction factors are reduced and then the contours are rechecked in case that adjustment causes a new crossing. This option can be used to decrease the number of rechecks in case your dataset is large and you don't want to take the time for these checks.

Save Grids Using Binary Format: This options chooses between saving .grd files as either text or binary files. This setting applies to all routines that save grid files. The advantage of the text format is the ability to view the grids using any text editor like Notepad and the ability for non-Carlson programs to easily read the grids. The advantage of the binary format is the speed of saving and loading the grids which is several times faster than the text format. Only Carlson 2015 and later versions can read the binary format. When the range of min/max grid values is small enough relative to the grid precision, the program will automatically switch to an indexed binary format which uses half the file size and loads twice as fast.

Eye Height and Object Height are used for calculating sight distance on vertical curves.
**Vertical Curve Drawing Resolution** applies to Draw Profile for the segment length for drawing vertical curves.

**Use Crest Sight Distance Formula for Sag**: When this option is on, the Crest Vertical Curve formula is used to calculate the sight distance for sag vertical curves. Otherwise, the Sag Vertical Curve formula is used.

**Parabolic Template Grade Subdivisions** applies to Process Road Design and Road Network for how many 3D polylines to draw for grades defined as parabolic in the template.

**Station Type** controls the format of station labels. For the NO.0 type, there is a setting for the label prefix, and the Use Partial Labels for Intermediate Stations option will skip the label prefix for odd stations.

**Stage-Storage File Format**: Indicate the format of the Stage-Storage File to be used in Carlson Hydrology.

These options will toggle various prompts when entering Mine Notes in the Underground Mining module. You can also set the layers for various linework needed for geologic modeling and mine planning. These options are further described in the documentation of the Mine Note Defaults command.
This is the configuration screen for default settings used with the Mining Modules. Each item is detailed below.

**InverseDist/LeastSq Max Samples:** This value sets the maximum number of data points to use to estimate the value at a grid node. If this value is set to 20, only the 20 data points nearest the grid node being calculated will be used. This option only affects the Inverse Distance and Linear Least Squares modeling methods.

**Min/Max Quadrant:** When the program calculates the value of a grid node, the area around the grid node
is divided into four quadrants, as shown below by the blue dashed line. These Min/Max Quadrant values set the minimum/maximum number of data points to use from each quadrant. If the Min Quadrant value is set to 5, a value will only be assigned to the grid node if at least 5 data points are found within all four quadrants. If the Max Quadrant value is set to 20, only the nearest 20 data points in each quadrant will be used for estimation.

Search Radius: This value sets the maximum search radius for data points. For example, if this value is set to 10,000, any data points beyond 10,000 ft/meters from a given grid node will not be used to estimate the value of that grid node. This concept is shown in the below image.

![Diagram showing search radius](image)

Fill in Missing Strata Above/Below Existing Strata ( Seam Stacking/Conformance): This option determines how the program handles drillholes with missing strata. An example of a data set modeled with and without the conformance option is shown below. Notice that when conformance is applied, the red and blue strata will more closely mimic the green strata, even though the red and blue strata do not occur in all three drillholes. The program does this by artificially adding data points to the drillhole with missing strata.

In the below example, consider drillhole #3. This drillhole does not contain the blue strata. To make the blue strata conform to the green strata, the program will search for the nearest drillhole that contains the blue strata (in this case, Drillhole #1). The program will then measure the elevation difference between the blue and green strata and apply that same elevation difference in drillhole #3. In this example, the bottom of the blue strata and the top of the green strata in Drillhole #1 are 800' and 705', respectively (a difference of 95'). The top elevation of the green strata in Drillhole #3 is 655'. So, when the program models the blue strata, an artificial elevation of 750' (that is, 655' + 95') will be used in Drillhole #3. In this case, the green strata is considered to be the "marker" and the blue strata is considered to be the "target".

In drillhole #2, the red strata is not present. In this case, either the blue or the green strata could serve as the "marker" strata. When the "All" option is used, the program will automatically select one of these strata to be the "marker". The program will set the "marker" strata as the strata closest to the "target" strata. In this example, the red strata is closer to the blue strata, so the blue strata will be used as the "marker". If the "Seam-Specific" option is used, you will have to manually define which strata are "markers" and which strata are "targets".

Although this example shows the result of seam stacking/conformance applied to an area with sufficient drilling depth in an area with varying topography, the same effect can be applied to drillholes that are not simply drilled deep enough to intersect all strata.
None: This option will not apply seam stacking/conformance. In this scenario, each strata layer will be modeled independently of other strata layers. Only strata data that is actually included in the drillhole will be used to make the strata grid file.

All: This option will apply conformance in any way possible. This can be a useful option when the structure of all strata are similar. However this option does not give you the option to specify which strata layers are "markers" and which strata are "targets".

Seam Specific: This option also applies conformance, but requires that you specify which strata are "markers" and which strata are "targets". The strata are tagged as "markers" and "targets" in the Define Strata/Bed command. It is important to note that when using this option, you can define the "Marker Level", which sets the priority of the marker strata. this is an optional field, but it can have a significant impact on the model when multiple marker strata are available for use.

Use Conformance for Channel Samples: This option controls whether to use channel samples as source data points for conformance of other strata.

Calculate Strata Pinchout: This option determines if the thickness of a seam is pinched out when it does not occur in a drillhole, as shown in the below image.
When pinchout is disabled, as shown in the first cross section in the above image, the middle drillhole is completely ignored when making the grids for the blue and green strata. This results in the blue and green strata suggesting a significant thickness at the location of drillhole 2. In the second cross section, pinchout has been enabled, but the results are misleading because no thickness grids were incorporated into the model. In the third cross section, pinchout has been enabled and the thickness grids have been incorporated into the model to accurately model the pinchout.

It is important to note that elevation grids will not be automatically modified to show the pinchout, although the elevation grids may in fact be adjusted somewhat. It is therefore recommended to only enable this option when making thickness grids to avoid misleading results. When the program creates a thickness grid with this option enabled, the missing strata will be modeled as having a negative thickness at the drillhole without the strata. The thickness value will be equal but opposite to the thickness of the nearest thickness data point for that strata. In the above example, the blue strata has a thickness of 10' in drillhole 1, so the program will use a value of -10' in drillhole 2 when making the blue thickness grid. By incorporating a negative thickness value, the thickness will approach a value of zero approximately halfway between the drillholes 1 and 2. The Pinchout Slider bar to the right of this toggle in the dialog controls where the strata will actually pinchout. Before the thickness grid is written, it will be modified so that all negative values are reset to zero. This results in a thickness grid that begins to decrease in value as it nears the drillhole with the missing strata, but never shows a negative thickness.

Since this option is only intended to be used when making thickness grids, you will need to create modified elevation grids before adding them to the Geologic Model. This can be done quite easily with Grid File Utilities. In the above image, notice that the blue and green strata layers only pinch out properly when the elevation grids have been modified. In this case, the top of the blue strata was created by adding the bottom elevation grid of the blue strata to the thickness grid of the blue strata. Notice that in the second diagram in which only bottom elevation grids were used, the blue strata does not pinchout between the drillholes.

Finally, it is important to note that pinchout will only affect thickness grids when two "sandwiching" strata are detected above and below the missing strata. In the above image, the blue strata is "sandwiched" between the red
and yellow strata. If drillhole 2 did not contain the red strata, then the blue strata would not pinchout. This means that the top and bottom strata in any given model will not be able to pinchout.

**Pinchout Zero Thickness:** This option determines if a strata with a thickness of zero will be modeled as a pinchout. Pinchout is normally only applied for strata layers that are absent in a hole.

**Pinchout Key Only:** This option will only apply the pinchout to the Key strata while the Non-Key strata will be modeled as if the pinchout were not applied.

**Adjust Non-Key for Estimated Key Strata:** This setting controls whether to adjust non-key strata to fit in key strata for pinchout or conformance.

**Restrict Pinchout to Drillhole Elevation Range:** This option controls where the seam will pinchout. If there is a shallow hole, and a seam is running beneath it, this setting will pinchout the seam if it is off. If it is on, then the seams will only pinchout if they pass through the elevation range of the drillhole. This is useful if it is desired to pinch out a seam that passes above or below the elevation range of the drillholes.

**Include Strata Name in Bed Composite:** This option will add the strata name to the bed name when running the bed compositing commands, such as Split Bed by Parameters.

**Composite Bed Qualities by Density:** When creating grids of bed qualities from drillholes with multiple samples of the bed quality, the quality will be composited to a single data point before the grid file is made. By default, the quality will be averaged by the thickness of the sample. When this option is enabled, the qualities will instead be averaged by weight (thickness * density). The **Density Attribute Name** sets the name of the density attribute to be used for weighting. Density is always expressed as lbs/ft³ or kg/m³.

**Use Strata Limit Lines:** This option determines if Strata Limit Polylines will be used for modeling. If this option is disabled, you will not be prompted to select Strata Limit Lines when modeling.

**Auto Select All Strata Limit Lines:** This option will automatically select all Strata Limit Polylines when modeling. You will not be prompted to select the lines when this option is enabled.

**Process Only Strata with Beds:** This option will ignore all strata layers without a bed name when modeling. This can be useful when overburden/interburden layers are not marked with unique strata names and have not been tagged with a bed name.

**Process Only Strata with Definition:** This option will ignore all strata that are not listed in the current Strata Definition file when modeling. However, strata layers that are not included in the Strata Definition file will still be used to calculate conformance and pinchout.

**Store Source Data in Grids:** This option will include the source data used to make strata grid files within the grid itself. This includes the X-Y coordinates of the data point, the value used for modeling, and the type of data source (drillhole, channel sample, etc.). This can be useful for understanding how the grid file was generated when the original source data is not available.

**Hole Dip Angle Direction:** This option determines how drillhole dip values are interpreted. The default option of 0 = Down— 90 = Horizontal— 180 = Up will treat dip values of 0 degrees as vertical in the downward direction, dip values of 90 degrees in the horizontal plane, and dip values of 180 degrees as vertical in the upward direction. The other options may be used to accommodate other dip value schemes.
**StrataCalc Drillhole Selection Method:** This option determines how the program will prompt for geologic data when modeling. The On-Screen Drillholes option will prompt you to select drillholes, channel samples, etc. when making the geologic model. The StrataCalc File option will instead prompt you for a .stc file, which can be saved from the StrataCalc Data Sheet command. The .stc file can be useful when you need to be certain that the same information is being used to create model between iterations.

**Underground Room/Pillar Settings:** These options apply to the series of commands for placing coal sections (used for calculating end of month volumes).

**Use 0 Values for Blank Entries in Coal Sections:** This option will replace treat blank values in coal sections as 0 rather than considering it to be null.

**Draw Coal Sections Z at Thickness:** This option will draw coal section symbols at the Z value of the actual thickness. For example, a coal section with a thickness of 5 feet will be drawn at an elevation of 5. This is useful for contouring or gridding the coal sections with standard commands from the Civil module.

**Prompt for Advancement Pline for Quantities:** This option will prompt you to select an additional advancement polyline when running the Quantities by Average / Grid / Centerline commands. This polyline represents the direction of mining in a particular area. The length of the polyline will be included in the quantity report.

**Report Format for Quantities by Avg/Grid Methods:** This option determines the default report format for the Quantities by Average / Grid / Centerline commands. However, each of these commands will also let you set the report format when the command is executed. The Standard option will use a simple text editor for the report. The Columns option will still use a standard text editor, but with the values aligned into columns. The Formatter option will send the report to the Report Formatter for user-defined formats.

**General Settings:**

**Key Material Name:** This is the name of the Key material you are mining. This name will be used in several reports to identify Key material, such as the outputs from Surface Mine Reserves and Surface Production Timing. If you have more than one type of key material, you may want to give this a more generic name such as "Key Material" to avoid confusion in the reports.

**Bed Name Suffixes: KEY, OB, PARTING, BOTTOM:** These suffixes are used to identify the four portions of a bed. An example is shown in the below image. When Bed names are applied to a group of strata layers, all strata layers with matching bed names are treated as a single group. This allows the program to properly correlate groups between drillholes even when the number of samples for each bed is not consistent between drillholes. Although the strata will be treated as one group, there are four portions of the bed available for modeling. Note that not all four portions of the bed may not be present in a data set.

**OB:** This is the non-key portion of the bed above the first occurrence of Key strata.

**Parting:** This is the Non-Key portion of the bed bound between Key strata.

**Key:** This is the Key portion of the bed.

**Bottom:** This is the non-key portion of the bed below the last occurrence of Key strata.
**SDPS Directory:** This field sets the installation directory for the Subsidence Deformation Prediction System (SDPS) program. The SDPS commands are found under the Subsidence Pulldown Menu of the Underground Mining Module.

**Use Map Object Data as Properties:** This option will use the AutoCAD Map data to set the Property and Owner names for reserve estimates. When this option is disabled, the program will use the Owner and Property names assigned to polylines from the Assign Property Names command.

These options are used for the Construction module and SiteNet commands in the Civil module.
Extrapolate Surface To Boundary Perimeter: When this is check ON surfaces are extended and volumes are calculated out to your boundary perimeter. When this is checked OFF surfaces and calculations end at the extents of your design data.

Use Existing Surface To Extrapolate Design: When this is checked ON surfaces and volumes are calculated to the extents of your existing data.

Use Binary Triangulation File Format: This option sets the format for the surface model files as either binary or ASCII. The binary format has a .tin file name extension and loads about twice as fast and has about 50% less file size than ASCII. The ASCII format has a .flt extension and is the legacy format used by other Carlson products and Softdesk.

Minimize Flat Triangles: This option reduces the occurrence of "flat" (or more precisely, horizontal) triangles. Flat triangles often occur when creating surface models from contour data. The Minimize Flat Triangle option will swap triangulation edges when possible to switch flat triangles to sloped triangles.

Densify Breaklines: This option automatically add vertices on breakline segments for triangulation at the specified Interval.

Draw Triangulation Surfaces: This option sets how the Takeoff surfaces are drawn in the drawing. The 3D Faces option creates 3D Face entities for each triangle in the surface. The Surface Object option creates a single Carlson Surface Object for the surface which is more efficient on memory and drawing size.

Reduce Triangulation Surfaces: This causes edges within the selected surface TIN mesh to be collapsed to reduce the number of triangles, edges, and points within the mesh while having a minimal impact on the overall shape of the mesh.

Reduce Offset Distance: This setting is used by the Reduce Triangulation Surfaces command to set the reduction tolerance. Specify the maximum average distance that any point can be moved outside of the plane of any triangle that connects to that point. Values might range from .01 to .1 for most purposes.
Surface File Suffixes: These settings allow you to change the file names for the surfaces generated by the program:

- **-og** - This is the default name for the original ground surface before adjustments.
- **-ze** - This is the default name for the original ground surface after subgrade zone adjustments.
- **-ex** - This is the default name for the original ground surface after subgrade zone and topsoil adjustments.
- **-bs** - This is the default name for the initial design surface before adjustments.
- **-zn** - This is the default name for the design surface after subgrade zone adjustments.
- **-fn** - This is the default name for the design surface after subgrade zone and topsoil adjustments.
- **-ox** - This is the default name for the over-excavate surface after subgrade zone and topsoil adjustments.

**Automatic Update Colors:** This refreshes colors in your drawing as they change (i.e. elevating entities, setting layers for different Targets, etc.). If your drawing is very large and is slow to automatically refresh you may want to toggle this off and use the Update Colors For Set Elevations command under View when you want/need to see the color changes.

**Assign Colors By Target:** This option allows you to set the Existing, Design, and Other layers to any color you define.

**Assign Colors By Elevation:** This option allows you to set the color for entities needing elevations.

**No Elevation Entities Color:** Indicate the color entities with no elevation (Z=0) should be assigned to when their layer is classified as "Original" or "Design".

There are literally hundreds of default settings that can be set with this dialog. The categories that can be selected from are:

The Settings for each Category will display all of the items that can be setup for default values. The Default value is set in the Configuration Default Value box. The corresponding Metric or English default values are set here, allowing for easy switching between the two systems.

**Pulldown Menu Location(s):** Settings

**Keyboard Command:** config_scad

**Prerequisite:** None
Settings Explorer

The Carlson Settings Explorer dialog box allows you to view, manage and report the values for all settings in all commands in all Carlson Software programs.

The tree-view on the left of the window shows the four levels of the command structure of Carlson Software, Program, Menu and Function. Selecting (highlighting) any one or many of these levels will show associated settings. The programs level also includes General, that includes the first six menus available in all Carlson programs.

The right-side is a spreadsheet view and is populated depending on the item(s) selected and highlighted in the tree-view. Selecting and placing a checkmark next to an item at one of the upper levels of the tree structure will select that item and all its sub-items.

The spreadsheet view shows the following columns for a command:

- **Setting** - Prompt for the settings in the dialog or at Command: line
- **Value** - Current value
- **Default** - Default value for the setting
- **Ini Name** - Carlson internal file name for the command
- **Data Type** - Description of the value for this setting

**Select/Unselect:** Using the square tick boxes you can click this toggle to select or unselect a unique item or all items under the hierarchical list. All ticked items will appear in the spreadsheet view to the right.

**Select All:** Use this button to place a checkmark next to all items and sub-items in the tree-view.

**Clear All:** Use this button to clear checkmarks from all items and sub-items in the tree-view.

**Show Selected Only:** Select this option to display, in spreadsheet view, the tree-view settings that have checkmarks on.

**Filter:** Using a Filter will display the settings containing the text string specified as the Filter. For instance, filtering with the word "elevation", returns the following results:
Find: Use this option to search for a string of text. First, enter the text to be found and then pick the button to the right to execute the search.

Show Modified Only: Select this option to display the settings whose current value, as shown in the "Value" column, is different from the default value shown in the "Default" column.

Show Layers Only: Select this option to display the settings whose value in the "Data Type" column is specified as "Layer".

Report: Use this button to prepare a report of all selected settings using Carlson's Report Formatter.

Load: Use this button to Load settings from a Carlson Configuration File (.cfg).

Save: Use this button to Save settings to a Carlson Configuration File (.cfg).

Restore: Use this button to Restore selected settings to their Default value.

Pulldown Menu Location: Settings

Keyboard Command: setxplore

Prerequisite: None

Settings File Manager

The Settings File Manager provides an organized view of all Carlson Software Settings files that have been saved in a specified "Settings" folder. By default, the initial folder displayed is the "Startup Settings Folder" as specified in the Project Setup dialog box.

The various Settings files are displayed in a tree structure based on their corresponding Carlson Software program. If the current Settings for any command match the Settings found in a Settings file, the file name will show up in a Bold font. Because Configuration Files (.cfg) are collections of many Settings files, they cannot be set Current and will not show up in Bold font.
Set Current: After selecting one of the various Settings files, use this button to set that file current. Files that have been set "Current" will show up in a Bold font. Only one file of any Setting type can be set Current at one time. And, because Configuration Files (.cfg) are collections of many Settings files, they cannot be set Current and will not show up in Bold.

Change Settings Folder: Use this button to browse to and select a folder in which Carlson Software settings have been stored.

Compare: This function compares two settings files and reports differences in a spreadsheet. To run this function, select the first settings file to compare from the Settings File Manager dialog. Then pick the Compare button and the program will prompt for the second file of that type to compare with. In the Compare dialog, you can make changes to the settings and use the save buttons to save the edits.
Pulldown Menu Location: Settings
Keyboard Command: setmanager
Prerequisite: None

Toolbars

This command allows you to display and hide toolbars. Click on a toolbar name and press the Show or Hide button.

- **Show**: Turns on the selected toolbar. If the toolbar is already visible, then this does nothing.
- **Hide**: Turns off the selected toolbar. If the toolbars is already hidden, then this does nothing. If the toolbar is floating, you can also turn it off by clicking the x in the upper right corner.
- **Exit**: Exits this command

Pulldown Menu Location: Settings
Symbol Library

This command allows you to customize the symbol library. For a printout of the default symbols, get the symbols.pdf in the Carlson Projects folder. The default library has hundreds of 2D and 3D symbols including National CAD Standard (NCS) symbols, MassDOT standard symbols and a set of symbols with wipeouts built-in to hide linework under the symbols.

Categories are a way for grouping symbols by type for your own convenience in symbol selection. There are two levels of categories: top-level and sub-category. Within each top-level category, you can have any number of sub-categories. A new category is added by clicking on the "Add Category" button. An edit field then appears in the tree view on the left and waits for you to enter the category name. The input is finished by pressing the Enter key.

The category may be populated by creating a new symbol from selected entities in the drawing, by specifying drawing (.DWG) files, or by moving existing symbols from one category to another.

Each symbol has an optional description which is shown with the symbol to help choosing in symbol selection like in Draw > Insert Symbols. To change a description, highlight the symbol in the list and then pick Edit Description.

To create a new symbol, open a drawing which has the entities to be used in the symbol. The symbol should be drawn at unit size (scale 1:1) because Carlson will scale the symbol by the current drawing scale when the symbol is used. Highlight the category for the symbol and click on the "Create Symbol" button. A dialog appears for entering the new symbol name. Next, specify the file name for the symbol. The file name has a .DWG extension and would usually reside in the Carlson SUP directory, but you may use another path. Then the program will prompt you to select the entities from the drawing for the symbol. An insertion point for the symbol must also be picked.

The "Import Symbols" button brings up a file selection dialog which allows you to select multiple files to be added to the current category (to select multiple files use Shift or Control keys along with the mouse). If the files you select are not in the Carlson SUP directory, the program will offer an option of copying them there. There are also Import Library and Export Library buttons.

By default, the symbol description is the same as file name. The description for the symbol or category name may be changed by highlighting that name and clicking on "Rename" button, the name being edited is then placed into edit mode. To move a symbol into a different category, select the symbol to be moved on the tree and click an "Up"
or "Down" button as many times a needed to reach the desired category. The symbols are sorted alphabetically within each category, while categories are remaining in the order placed to allow the more frequently accessed categories be on top.

The Reset button adds symbols from the default symbol library into the current library.

Note: The symbol library is stored in an ASCII file named symbols.dta in the Carlson \USER directory.

**Pulldown Menu Location:** Settings
**Keyboard Command:** editptsym
**Prerequisite:** None

---

**Layer Library**

This feature serves as an expanded version of the Layer Manager and also as a layer standards manager. In addition to allowing you to sort layers into easily recognizable groups called **Layer Categories**, this feature can also be used to import layers from a text file and to compare and match layers in the library to the current drawing.

Once populated, layers from the Library can be called from commands such as **2D Polyline** and **3D Polyline** for layer and property assignment.

The **Layer Library** has two areas of the dialog box: the **Layer Category** List on the left and the **Layer** List on the right.

**Layer Categories**: Layer Categories are shown as a list in a tree view in the left-hand pane of the dialog box.

Categories can be re-ordered by dragging and dropping to a different position in the list or by using the **Move Up**, **Move Down**, **Move Left** and **Move Right** arrow buttons. Other buttons above the Layer Category list also enable you to **Add**, **Remove** and **Rename** Categories.

Also, right-clicking on a Category in the list displays a shortcut menu allowing you to access many of the same commands as the buttons along the top and bottom of the dialog box.
Layers: Layers in a selected Category are shown as a list in spreadsheet view in the right-hand pane of the dialog box.

Layer Properties: Except for Non-Surface, all the layer properties in Layer Library correspond to the layer properties in CAD. The Non-Surface property is a specific flag used by the Triangulate & Contour routine to filter out entities. You can set a layer as Non-Surface when you want to exclude all entities on that layer from surface modeling.

The default column-headings for the Layer List are Name, Description, Color, Line Type, Line Weight, Non-Surface, Transparency, Plot Style and Plot/No Plot. Additional column-headings may be added using the Extra Fields button at the bottom of the dialog. Using the Add Layer (plus) and Delete Layer (minus) buttons, layers can be easily added and removed from a particular Category. The Move To button can also be used to change a layer to a different Category.

Clear All: This button removes all the Layer Category and Layer definitions.

Save As and Load: These buttons can be used to create and restore Layer Library settings using a Layer Library Settings (.LA) file. There are a few default .LA files in the Carlson Projects\Settings folder that you can load for National CAD Standard (NCS) layers and MassDOT standard layers. The current layer library definitions are stored in the USER folder in a file named layerstd.dta.

Extra Fields: This button allows you to define up to ten extra text fields (column headings) for a layer. These fields can then be used as import fields or displayed in a report.

Report: This button uses the Report Formatter to allow you to compile and display a report containing all Layer Categories and Layers in the Library. The Report Formatter can also be used to export the data to a Microsoft Excel (.XLS or .XLSX) file.

Import: This button gives you two options for Importing layers into the Layer Library.

The Drawing Layers option simply copies all layer definitions from the current drawing into the Library after prompting you to select the destination Category.

The Text File option allows you to select an existing Text (.TXT, .DAT, or .CSV) file containing standard layer definitions to populate the Library. Note that Microsoft Excel provides an option to save an Excel (.XLS or .XLSX) file as a Text file. Follow the steps below to Import layers from a text file.

1. Pick the Import button.
2. Pick the Text File (txt;dat;csv) button. This opens the Text File Import Options dialog box.
3. At the top of the **Import Options** box, select the file format type such as "Comma-Separated" or "Tab Separated".

4. If the top-line of the Text file contains column headings, pick the option to "Use first row for column headers".

5. If the Text file contains one or more lines of text above the layer and property data, use the text box next to "Skip" to specify the number of rows at the top of the text file to be "Skipped" before importing the list of layers.

6. If headers are not included in the Text file, use the drop-down at the top of each column heading in the spreadsheet view to specify the column's data type such as "Name", "Color" or "Linetype".

7. **Pick the Continue button** and specify the Category into which the new layers are to be Imported.

**Create**: After selecting a Layer Category, you can pick this button to create all the layers for that Category in the Drawing. When creating the layers, there is an option to create a layer group filter for the CAD Layer command.

**Compare DWG**: This button is used to Compare drawing layers and their associated properties such as color, linetype, lineweight and plot style to the standard Library definition for those layers. This feature will report how many layers matched exactly, how many had a different set of properties and how many non-Standard layers were found. It will also list the non-standard layers which are those defined in the drawing but not in the Library.

**Match DWG**: This button is used to alter the properties of drawing layers to match the properties of layers defined in the library, or vice versa. After picking the **Match DWG** button, this dialog box displays:
Pick the **Library to DWG** button to alter the drawing layers to conform to the Library definitions.

Pick the **DWG to Library** button to alter the Library definitions of the layers to conform to those set in the drawing.

**Pulldown Menu Location:** Settings → Layer Library  
**Keyboard Command:** layerlib  
**Prerequisite:** None

### 2D Linewor Library

This command sets lines and polylines on specified layers to zero elevation which helps solve the common drafting problem of linework getting moved to elevation such as with a grip edit snapping to a 3D point. In the dialog, you select which layers to check. When you pick OK, the program checks all linework on those layers and sets their elevations to zero. The Track Linework Edits option checks when the linework is modified to make sure the elevations are zero. When this routine prints a message to the command line whenever it moves the linework elevation to zero.

![Zero Elevation Linework Layers](image)

**Pulldown Menu Location:** Settings  
**Keyboard Commands:** 2dlworklib  
**Prerequisite:** None

### 3D Viewer/Model Library

This command manages a collection of 3D graphic files and defines how to render CAD entities in the 3D Viewer. The CAD to 3D Viewer settings define how to translate different types of selected CAD entities into the 3D Viewer. The **Points** tab associates a CAD block name with a 3D model. This way you can have a simple symbol when working in CAD that is rendered as a complex 3D model with viewing in the 3D Viewer. The **Lines** tab defines a 3D model to use for linework on a specified layer. For example, a polyline on a layer of FENCE in CAD can be assigned to render using a fence 3D model. Besides defining the layer and 3D model, there is also a setting for **Gap** which is the distance between the 3D models along the linework. The **Area** tab defines textures to apply to the surface model by closed CAD polylines on specified layers. You can have different textures using nested closed polylines on different layers and the texture for the inner polyline is used for that inner area. For example, you can
have an outer polyline on a Parking layer for a texture of asphalt and inner polylines for parking lot islands on an
Island layer for a texture of grass. The Colors tab applies to TIN surfaces that have colors assigned to the 3D faces.
This settings map TIN colors to textures for rendering the TIN.

The Model Library button has the collection of 3D model files which can be assigned to CAD symbols in the Points
tab of CAD to 3D Viewer. Also, these 3D Models can be added to the scene by using the Add Model function in
commands such as 3D Drive Simulation.

The files are grouped by user-defined categories. The graphic files can be either .dfx, .mdl or .obj format. SketchUp
.skp files can also be selected to add to the library. The program will convert these .skp files into .obj format. The
SaveAs and Load functions allow you to save the model library to .mlib files for sharing or backup. The current
model library data is stored in the Carlson USER folder in models.dta.
The Edit Symbol function brings up another dialog with edit functions. In the edit dialog, the program shows the dimensions of the model and the number of data points.

The Properties tab has controls for the lighting of the object and whether to smooth the 3D faces of the object.

The Rotation function sets the default rotation for when the object is inserted. The Random Rotate option makes the rotation random for each time the object is inserted which applies to objects like trees that are inserted multiple times and look better with different rotations.

The Scale function sets the initial insertion scale. Often a scale factor of 0.08333 is needed to convert a model in inches units into feet for inserting into a scene in feet units. The X/Y/Z axis can be scaled independently or uniformly. The scale can be set directly by factors or by entering the model dimensions which is handy for vehicle models when the dimensions of the vehicle are known.

The Translation settings control the insertion point of the model.

The Orientation setting for Force Vertical Orientation makes the model level when inserted into the scene which applies to objects like trees and buildings. Otherwise the models get inserted at the slope of the surface at their position which is good for objects like vehicles.
**Title Block**

This command draws a border and title block for the selected sheet size. At the top of the dialog, choose your horizontal scale and sheet size. The "other" choice at the bottom of each list will allow you to add your own scale or size if yours is not listed. Anything added to these lists will be retained for future use. Next, choose either "landscape" or "portrait" format. A blue rectangle next to this choice shows you the difference. Below this, you can choose what layer to draw the border and title block on. The margins to use are specified next at the bottom of the dialog. On the right hand side of the dialog, you can choose from several title blocks. As you choose each one, a preview will be shown below this list. This routine looks for all drawings named "tblock" in the \SUP directory. If you want to add your own title block, simply create a new drawing (or copy an existing one) in the \SUP directory and give it a name that starts with tblock. Example: tblock22.dwg and tblock-Jones.dwg are both valid names for this routine, but "MyTitleblk.dwg" is not. After you have made all your decisions in the dialog box, press OK. Depending on your current zoom level, your drawing may be zoomed out to allow you to see the entire area that will be covered by the drawing border. At this point, you have the border attached to your cursor and it is waiting for you to pick a point for insertion. As soon as you do this, a secondary dialog will appear for you to fill out the attributes associated with the particular title block you selected.
Chapter 9. Settings Menu
Pulldown Menu Location: Settings
Keyboard Command: tblock
Prerequisite: Set horizontal scale in Drawing Setup

**Mortgage Block**

This command draws a personalized title block for a mortgage survey. You may select an 8½" x 11" sheet, an 8½" x 14" sheet, or define your own sheet size. The dialog box allows the user to edit all block information and input unique data for every layout. The mortgage block drawing is called from the mortgage.dwg file located in the \sup directory and can be easily opened and edited within AutoCAD, allowing for the user to alter the size, text, or any other aspect of the drawing to fit the user's particular needs. However, this is usually unnecessary since the original .dwg file places this block for a standard 8 ½ x 11 ratio drawing. In addition to the block, the user can include the inputs and prescribed text for a Flood Note, which is placed in the bottom left hand corner of the drawing. You may also select a custom drawing file for your flood note. All inputs are saved and recalled from a mortgage.ini file located in the \User directory.

The LIMITS of the drawing can be set to the lower left and upper right corners of the border. After the title block is drawn, the contents can be edited using the Attribute Edit command under the Edit menu.
Pulldown Menu Location: Settings
Keyboard Command: mortgage
Prerequisite: Set horizontal scale in Drawing Setup

**Rescale Drawing**

This command globally resizes selected text, symbol and block entities within the drawing by comparing the existing drawing scale factor to a new scale factor. Entities are scaled from their individual insertion points. Lines and polylines are not scaled.

**Prompts**

Old Horizontal Scale: 20
New Horizontal Scale: 30
Select text, symbols, dimensions and blocks to scale.
Select objects: select objects by window, crossing or by typing "all" at the command prompt, and press Enter
41 found
Select objects: press Enter
Number of symbols and blocks changed > 7
Testing Entity > 41
Number of text entities changed > 20
Pulldown Menu Location: Settings
Keyboard Command: scaledwg
Prerequisite: Drawing entities to be scaled

Set/Reset X-Hairs

*Set X-Hairs* sets the crosshairs either to align with the selected line or polyline or to a user-specified slope. *Reset X-Hairs* restores the crosshairs alignment to horizontal.

Pulldown Menu Location: Settings > Crosshairs
Keyboard Commands: setxhairs, resetxhairs
Prerequisite: Line entity

Tablet Calibrate

This command executes the routine to perform calibration of the digitizer tablet to the drawing. There are two methods of calibration: Known Reference Points, and Drawing Scale with New Reference Points, which are explained in detail below. The Calibrate routine must be used prior to using the Digitize Contours command.

Before proceeding, please refer to the Settings menu, then go to Configure and General Settings. Then look at the Digitizer Puck Layout section for the selection of the correct puck layout.

Tablet Calibration

**Known Reference Points** uses two known coordinates for reference points on the drawing. When this option is selected, the fields for coordinate info activate. Enter the known northing and easting values for the reference points from the info on the drawings in the appropriate fields and pick the Pick button. Pick the points from the drawing on the tablet. Furthermore, Carlson saves the coordinates of the two reference points for future calibrations and displays them on the *Tablet Calibration Dialog* the next time it is accessed, so if you are working in the same drawing, you can use the Known Reference Points method with the saved coordinates to digitize back to your previous coordinates. For greater calibration accuracy, choose two points that are farther apart rather than closer together.
Drawing Scale with New Reference Points is very convenient when you don't know the precise coordinates of the entities on your drawing. The user must specify the drawing scale from the plan. This method establishes a coordinate system relative to the position of the plan on the digitizer board. In addition to the drawing scale, you are required to enter a random coordinate for the first reference point, the default coordinate is (1000,1000). You then pick the Pick button and pick the point on the drawing to assign the specified coordinate to. The program will compute the coordinate of the second reference point that you pick based on the first point. The coordinates of these two reference points would be saved and will be display in the Tablet Calibration Dialog as Known Reference Points the next time you calibrate the tablet, so you can digitize back to the previous coordinates if you are working on the same drawing, even though you may have moved or rotated your drawing on the digitize board.

Prompts
Tablet Calibration Dialog
Specify the Calibration Methods. If you select Drawing Scale method, enter the drawing scale and the coordinate of the first reference point. Otherwise enter the exact coordinates of the first and second reference points.

Pick first reference point: pick a point
Pick second reference point: pick another point

Pulldown Menu Locations: Settings > Tablet Calibration
Keyboard Command: digsetup

Prerequisite: Affix a drawing to your digitizer tablet. Have a digitizer board and a puck connected to your computer, and have Wintab driver installed. The digitizer has been correctly set up. Select the puck layout in Configure.

Save/Load Tablet Calibration
A common problem with calibrating maps on a large format digitizer is that if you leave the current drawing session, AutoCAD forgets the tablet calibration. Tablet save can be used to save the calibration when a drawing is taped down properly. This calibration file can be restored at any time later and be accurate so long as the drawing did not move on the tablet.

Save Configuration Procedure:
1) Command: TABSAVE
2) Designate filename (*.TCF) to save configuration into.

Restore Configuration Procedure:
1) Command: TABREST
2) Select filename (*.TCF) to restore configuration from.

Pulldown Menu Location: Settings > Tablet Calibration
Keyboard Commands: tablet1, tablet2
Prerequisite: None

Set UCS to World
This command sets the UCS (user coordinate system) to the world coordinate system (WCS). Carlson TakeOff works exclusively in the world coordinate system and there is no way to change this setting. In AutoCAD, it is possible to change the coordinate system from WCS. If you receive a drawing in which the coordinate system is not set to world, use this command to restore the UCS.

Prerequisite: None

Keyboard Command: UCS_WORLD

Units Control
The Drawing Units dialog box controls coordinate and angle display formats and determines precision.
1 Under Length, you specify the current unit of measurement and the precision for the current units.

- **Type**: This field sets the current format for units of measure. The values include Architectural, Decimal, Engineering, Fractional, and Scientific. The Engineering and Architectural formats produce feet-and-inches displays and assume that each drawing unit represents one inch. The other formats can represent any real-world unit.

- **Precision**: This field sets the number of decimal places for the current units display.

2 Under Angle you specify the current angle format and the precision for the current angle display.

- **Type**: This field sets the current angle format.

- **Precision**: This field sets the precision for the current angle display.

TakeOff uses the following conventions for the various angle measures: decimal degrees appear as decimal numbers, grads appear with a lowercase g suffix, and radians appear with a lowercase r suffix. The degrees/minutes/seconds format uses d for degrees, ' for minutes, and " for seconds, for example:

123d45'56.7"

Surveyor's units show angles as bearings, using N or S for north or south, degrees/minutes/seconds for how far east or west the angle is from direct north or south, and E or W for east or west, for example:

N 45d00'0" E

The angle is always less than 90 degrees and is displayed in the degrees/minutes/seconds format. If the angle is precisely north, south, east, or west, only the single letter representing the compass point is displayed.

- **Clockwise**: This option calculates positive angles in the clockwise direction. The default direction for positive angles is counterclockwise.

When the program prompts for an angle, you can point in the desired direction or enter an angle regardless of the setting specified for Clockwise.

3 Under Drawing Units for TakeOff DesignCenter blocks, you can control the unit of measurement used for block insertions. A block created in units that differ from the units specified in this option is scaled and inserted in the specified units. Select Unitless to insert the block as is and not scale the block to match the specified units. Source content units and Target drawing units settings in the User Preferences tab of the Options dialog box under the Settings menu are used when Insert Units are not defined.

4 Sample Output displays an example of the current settings for units and angles.

Direction displays the Direction Control dialog box described below.
A The Base Angle determines where 0 degrees is located when the program calculates angles. The base angle sets the direction of the base angle. These options affect the entry of angles, object rotation angles, the display format, and the entry of polar, cylindrical, and spherical coordinates. Choose East, North, West, or South, or choose Other to indicate an alternative direction. The default direction for the zero angle is East. In TakeOff, the base angle is relative to the orientation of the user coordinate system.

- **East**: Sets the base angle to east (default is zero degrees).
- **North**: Sets the base angle to 90 degrees north.
- **West**: Sets the base angle to 180 degrees west.
- **South**: Sets the base angle to 270 degrees south.
- **Other**: Sets a direction different from the points of the compass.
- **Angle**: Sets the angle. Available only when Other is selected.
- **Pick an Angle**: Uses the pointing device to define the angle based on the angle of an imaginary line connecting any two points you specify. Available only when Other is selected.

**Prerequisite**: None

**Keyboard Command**: UNITS

### Point Object Snap On/Off

When this toggle is turned on, you can move your cursor near a Carlson point and snap to the actual coordinates of the point without having to use the AutoCAD NODE snap. Point Object Snap can be used alone to display the point information or it can be turned on and used during other commands. In the example illustration, the 2DP command (2D polyline) has been started and the first point picked was point number 2074. As the cursor nears point number 2067, the point snap marker appears and the point information is displayed, click the mouse and the next polyline vertex will snap to the coordinates of point 2067.
Object Snap

The Drafting Settings dialog box sets object snap modes.

1 Under Object Snap, you set object snaps.

- **Object Snap On**: This option turns running object snaps on and off. The object snaps selected under Object Snap Modes are active while object snap is on. This setting is also controlled by the OSMODE system variable.

- **Object Snap Tracking On**: This option turns object snap tracking on and off. With object snap tracking the cursor can track along alignment paths based on other object snap points when specifying points in a command. To use object snap tracking, you must turn on one or more object snaps.

2 Under Object Snap Modes, you turn on running object snaps.

- **Endpoint**: Snaps to the closest endpoint of an arc, elliptical arc, line, multil ine, polyline segment, spline, region, or ray or to the closest corner of a trace, solid, or 3D face.

- **Midpoint**: Snaps to the midpoint of an arc, ellipse, elliptical arc, line, multil ine, polyline segment, solid, spline, or xline.

- **Center**: Snaps to the center of an arc, circle, ellipse, or elliptical arc.

- **Node**: Snaps to a point object.
• **Quadrant**: Snaps to a quadrant point of an arc, circle, ellipse, or elliptical arc.

![Quadrant Snap](image)

• **Intersection**: Snaps to the intersection of an arc, circle, ellipse, elliptical arc, line, multiline, polyline, ray, spline, or xline. Intersection snaps to the edges of regions and curves, but does not snap to the edges or corners of 3D solids. Extended Intersection snaps to the imaginary intersection of two objects that would intersect if the objects were extended along their natural paths. Carlson Survey automatically turns on Extended Intersection when you select the Intersection object snap mode. You might get varying results if you have both the Intersection and Apparent Intersection running object snaps turned on at the same time. Intersection and Extended Intersection work with edges of regions and curves, but not with edges or corners of 3D solids.

![Intersection Snap](image)

• **Extension**: Causes a temporary extension line to display when you pass the cursor over the endpoint of objects, so you can draw objects to and from points on the extension line.

• **Insertion**: Snaps to the insertion point of an attribute, a block, a shape, or text.

• **Perpendicular**: Snaps to a point perpendicular to an arc, circle, ellipse, elliptical arc, line, multiline, polyline, ray, solid, spline, or xline. Carlson Survey automatically turns on Deferred Perpendicular snap mode when the object you are drawing requires you to complete more than one perpendicular snap. You can use a line, arc, circle, polyline, ray, xline, multiline, or 3D solid edge as an object from which to draw a perpendicular line. You can use Deferred Perpendicular to draw perpendicular lines between such objects. When the aperture box passes over a Deferred Perpendicular snap point, the program displays a Snaptip and marker.

![Perpendicular Snap](image)

• **Tangent**: Snaps to the tangent of an arc, circle, ellipse, or elliptical arc. Carlson Survey automatically turns on Deferred Tangent snap mode when the object you are drawing requires you to complete more than one tangent snap. For example, you can use Deferred Tangent to draw a line that is tangent to two arcs, polyline arcs, or circles. When the aperture box passes over a Deferred Tangent snap point, the program displays a marker and Snaptip. If you use the From option in conjunction with the Tangent snap mode to draw objects other than lines from arcs or circles, the first point drawn is tangent to the arc or circle in relation to the last point selected in the drawing area.

![Tangent Snap](image)

• **Nearest**: Snaps to the nearest point on an arc, circle, ellipse, elliptical arc, line, multiline, point, polyline, spline, or xline.

• **Apparent Intersection**: Apparent Intersection includes two separate snap modes: Apparent Intersection and Extended Apparent Intersection. You can also locate Intersection and Extended Intersection snap points while running Apparent Intersection object snap mode is on. Apparent Intersection snaps to the apparent intersection of two objects (arc, circle, ellipse, elliptical arc, line, multiline, polyline, ray, spline, or xline) that do not intersect in 3D space but may appear to intersect in the drawing display. Extended Apparent Intersection snaps to the imaginary intersection of two objects that would appear to intersect if the objects were extended along their natural paths. You might get varying results if you have both the Intersection and Apparent Intersection running object snaps turned on.
at the same time. Apparent and Extended Apparent Intersection work with edges of regions and curves but not with edges or corners of 3D solids.

- **Parallel**: Draws a vector parallel to another object whenever Carlson Survey prompts you for the second point of a vector. After specifying the first point of a vector, if you move the cursor over a straight line segment of another object, the program acquires the point. When the path of the object you create is parallel to the line segment, the program displays an alignment path, which you can use to create the parallel object.

- **Clear All**: This option turns off all object snap modes.

- **Select All**: This option turns on all object snap modes.

**Menu Location**: Settings  
**Keyboard Command**: OSNAP  
**Prerequisite**: None

### System Variable Editor

The AutoCAD/IntelliCAD engine stores the values for its operating environment and some of its commands in system variables. Each system variable has an associated type: integer, real, point, switch, or text string. This command allows you to list or change the values of system variables.

#### Variable Editor

- **List Box**: Contains a list of the variables associated with the currently running version of AutoCAD. There are more items than will display on the list box, use the scroll bar to move up and down through the list. Picking on an item in the list box makes it the current item, causing the information about the item to be displayed, and can be affected by most of the edit commands explained below.

- **Edit Field**: When an item on the list box is picked, its current setting is displayed in the edit field. If you intend to make changes in an item, use standard editing procedures including the use of arrow keys and/or pointer movements to make changes. Once changes have been made, you must use the CHANGE options explained below to effect changes. Pressing enter at the edit field will have no effect on the item in the list. If the item selected is a read-only variable, the edit field will be grayed-out and will not allow input.
• **Description**: When an item on the list box is picked, its definition is referenced and displayed in this field. This can be a benefit in learning the uses of the assorted system variables. This is a display only field, so you can't change the description given.

Under Type Group, the type of variable will be displayed indicated by one of the radio buttons. Each of these types are explained below for your benefit. For additional information on variable types used by AutoCAD, obtain and consult a source of AutoCAD documentation.

• **Integer**: Defined as a whole number in the range from -32767 to +32768, no decimal value accepted.

• **Real**: Defined as a real number in the range from -1.797E+308 to +1.797E+308, with extreme decimal accuracy maintained. Some real variables have a smaller range than previously stated.

• **String**: Defined as a sequential array of characters in the range from 0 to 65535 characters, with a range of ASCII (0-255). Numbers can be included in strings, even though they have no mathematical significance.

• **2D Point**: Defined as a list of two real numbers in the range from -1.797E+308 to +1.797E+308 separated by a comma, having extreme decimal accuracy maintained. Always maintain the X,Y format, one (and only one) comma must be used, separating the X and Y.

• **3D Point**: Defined as a list of three real numbers in the range from -1.797E+308 to +1.797E+308 separated by commas. While editing a 3D point, you must always maintain the X,Y,Z format, two (no less or no more), commas must be used, separating the X and Y and Z values.

Under Range Group, the variable displayed will usually have a range displayed. The FROM value indicating the minimum, and the TO value being the maximum value accepted.

Under the Store Group, depending on the type of variable, AutoCAD may store the value in the drawing or the configuration file, or it may not be stored. Each of these types are explained below for your benefit.

• **Not Stored**: Some variables, such as PLATFORM and CDATE, are not stored because they are system interdependent.

• **In Drawing**: Most variables are stored in the drawing, making the drawing format more personal than just a database of objects. This allows you to open a drawing and have it behave just as though you had never left it.

• **In Config**: These are variables that remain the same regardless of the drawing opened. APERTURE and PICK-BOX are just two examples of variables stored in the configuration file.

Under Access Group, depending on the type of variable, AutoCAD may not allow you to make changes to it. Each of these types are explained below.

• **Read Only**: Some variables, such as PLATFORM and CDATE, are read-only and therefore cannot be changed. Read-Only variables are marked and the edit field will be grayed indicating that you can't change the variable.

• **Read/Write**: Most variables are read/write and can be changed. These variables are marked and the edit field will be active so you can change the variable.

Under Binary Group, depending on the type of variable, the value may be off or on, yes or no. If the variable type is not binary, this group will be grayed out entirely.

• **Off (0)**: Indicate an off condition. Some variables, such as ATTREQ, are simply on or off toggles. You may change a binary item by clicking in this group to change the variable, or changing the value in the edit field.

• **On (1)**: Indicate an on condition. Binary variables are simply on or off toggles. Their range is from 0 to 1. You may change a binary item by clicking to change the variable, or changing the value in the edit field.

Control Buttons - These buttons are the main controls in the use of the Variable Editor. Each buttons purpose is explained below.

• **OK**: Used to accept the changes made during the variable editing process, returning you to the command prompt with changes in effect.

• **Cancel**: Used to cancel the changes made during the variable editing process, returning you to the command prompt without the changes in effect.
• **Load**: Used to load a saved set of system variables. This allows you to create a drawing, save the system variables, open a second drawing, and load those variables into that drawing. Read-only variables are skipped.

• **Save**: Used to save the current system variables to a disk file. All system variables are stored to the file, even those that are marked as read-only.

• **Print**: Used to print the current system variables. After choosing this option, you will be prompted for an output filename, then the program will proceed to write the system variables to the file. This file can be loaded into any editor or word processor, edited, and printed.

Variable Buttons - These buttons are used to control the changes in variables, while using the Variable Editor. Each button's purpose is explained below.

• **Change**: Used to execute the changes typed into the edit field. You must use this button; simply pressing enter will not make the change.

• **Restore**: Used to cancel the changes typed into the edit field. If you make a mistake or change your mind while making changes in the edit field, press this button to restore the edit field to the value before editing.

• **Status**: Used to determine if the program will echo the status of changes being made to the command area. If this toggle is on, any changes made from the dialog will echo the change. Also, if a stream of change commands is being read from a file, and the toggle is on, the changes taking place will be displayed.

Note: This command displays many more system variables than are found in the Systems Variable Chapter, which contains a list of **supported** system variables. Modification of any system variable other than the supported ones found in the Systems Variable Chapter is done at your own risk, and may result in program errors requiring a re-installation of Carlson.

**Pulldown Menu Location**: Settings
**Keyboard Command**: VARED
**Prerequisite**: None
Points Menu

Shown here is the Points menu of Carlson Field.
Point Defaults

This command sets Carlson point options for drawing point entities.

**Descriptions:** Specify whether you are prompted for a point description when creating points and whether the point descriptions are labeled in the point block.

**Label Limit:** Sets the maximum length for description attribute labels.

**Dialog Prompt:** When creating new points, this option controls whether to prompt for descriptions and elevations in a dialog or at the command line.

**Elevations:** Specify whether you are prompted for a point elevation when creating points and whether or not the point elevation is labeled with the point.

**Prefix/Suffix:** Indicate a desired prefix or suffix that should be included with the elevation label.

**Locate on Real Z Axis:** When checked, points are drawn at their actual elevation, otherwise, points will be drawn at Z=0.

The following tables illustrate the effects of Elevation vs. Real Z settings:

<table>
<thead>
<tr>
<th></th>
<th>Elevations Yes</th>
<th>Real Z Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Picked Point</td>
<td>Labels point, Prompts for elevation</td>
<td>Uses elevation for z coordinate</td>
</tr>
<tr>
<td>Point Number</td>
<td>Labels point, No Prompt</td>
<td>Uses z coordinate from file</td>
</tr>
</tbody>
</table>

Effects of Elevation Settings - Scenario 1
Picked Point | Labels point, Prompts for elevation | Uses z coordinate of picked point
Point Number | Labels point, No Prompt | Uses z coordinate from file

Effects of Elevation Settings - Scenario 2
Picked Point | No Label, No Prompt | Uses 0 for z coordinate
Point Number | No Label, No Prompt | Uses 0 for z coordinate

Effects of Elevation Settings - Scenario 4

Attribute Layout ID: Controls the location of the point number, elevation and description. Up to 10 attribute layouts (0 through 9) are available. See Carlson Knowledgebase Article 779 (Customized Carlson Point Attribute Layouts) for examples and steps of different attribute layout configurations.

Symbol Name: Enter the default symbol name to use. You may also pick the Select Symbol button to select a symbol from the Symbol Library.

Prompt for Symbol Names: When checked, you will be prompted for each symbol name instead of using the default symbol.

Point Numbers: When this toggle is OFF, no point number will be created and no points will be stored in the active coordinate file.

Automatic Point Numbers: When enabled, point numbers are numbered sequentially from the Start Point Number. If the Start Point Number field is set to 0, no point will be plotted. An exception to this is when you use the Draw-Locate Points command and use the Range option, then a point entity is plotted. When disabled, commands that locate new points will prompt for the point number.

Start Point Number: Specify the starting point number to use.

Layer for Points: Specify the default layer name for Carlson points.

Vertical Angle Mode: Specify how Carlson should prompt you for vertical angles. None means "Do not prompt." This applies to creating points with commands such as Traverse. The vertical angle is used to calculate the point elevation.

Separate Layers: Specify settings for point attribute layers:

- **None** - The point number, elevation and description use the layer names PNTNO, PNTELEV and PNTDESC, respectively.
- **Points** - The point number, elevation and description layers are composed by concatenating the point layer and the string NO, ELEV, and DESC. For example, if the point layer is UTIL then the attribute layers will be UTILNO, UTILELEV and UTILDESC, respectively.
- **Symbols** - The point symbol layer is composed by concatenating the point layer and the string MARK. For example, if the point layer is UTIL then the symbol layer will be UTILMARK.
- **Both** - The point symbol, point number, elevation and description layers are composed by concatenating the point layer and the string MARK, NO, ELEV, and DESC respectively. For example, if the point layer is UTIL then the symbol/attribute layers will be UTILMARK, UTILNO, UTILELEV and UTILDESC.

Auto Zoom Center for New Points: When checked, the drawing will perform a "Zoom Center" around new points to keep the display centered around the current working area during the new point creation process.
**Draw Point Nodes:** This option controls whether to create a CAD point entity. A full Carlson point consists of the CAD point entity, point symbol and point attribute block that has the point number, elevation and description labels. Normally the CAD point entity is part of this group but is not required.

**Use Annotative Points:** When enabled, points (usually placed through the Draw Field-to-Finish or Draw-Locate Points commands) will use scale-able annotative properties.

**Support All Drawing Scales:** When enabled, points placed as annotative entities will make use of all annotation scales currently defined within the drawing.

**Mask Point Attributes:** This option hides the drawing behind the point attributes when the points are drawn. The Mask Offset controls the buffer area around the point attribute. This offset value is scaled by the drawing horizontal scale. You can also leave this option off and apply the mask later by using the Mask Point Attributes command under the Points > Point Utilities menu.

**Use Field to Finish for Point Styles:** Allows you to use the code definitions from the designated Feature Library Definition (FLD) table specified below. For example, when creating a point with description of "FH" (for Fire Hydrant), Carlson would look up "FH" in the Field to Finish table and will use the field code definitions to establish the parameters of the point being created instead of the definitions defined in within *Point Defaults*. The Field To Finish settings under **Additional Draw Options** are described in the Field To Finish topic in the manual.

**Code Table:** This option lets you specify the Feature Library Definition file (FLD) used by the Use Field to Finish controls specified above.

**GIS File:** This option lets you specify a GIS file to be used when creating new points. The GIS file contains a list of fields to prompt for. For each point that is created, the program will prompt for these fields and store the results to the note file (.not) associated with the current coordinate file.

**Pulldown Menu Location(s):** Points

**Keyboard Command:** ptsetup

**Prerequisite:** None

---

**Draw-Locate Points**

The Draw-Locate Points dialog box allows you to insert either new or existing points into the drawing. You can create new points either by picking points on the screen, or by entering northing and easting coordinates. You can also place existing points by entering point numbers which reference the current coordinate file. You are prompted to choose a coordinate file if no coordinate file is current.
The Coordinate File at the top of the dialog shows the current file which can be changed with the Set button.

The name of the symbol file is displayed in Symbol Name. You can choose a different symbol by clicking Select. The selected point symbol is displayed on the right.

Symbol Rotation Azimuth is the rotation angle that is used for the point symbols. This angle is used in a counterclockwise direction relative to the current twist screen.

Layer by Description inserts the points in the layer named by the point description. Using Layer by Description organizes the points by description and allows for layer management. For example, you can use the Isolate Layers command to show only points on a certain layer. If you include an invalid layer character in the description, the layer name stops at the bad character. A point description of "UP / 105" would use layer "UP", for example. The Layer Prefix is added to the beginning of the layer name. For example, a Layer Prefix of "PT." and a point with the description "EP" would use the layer "PT_EP". Layer Prefix is optional. It allows all the point layers to be grouped.

Draw Nodes Only inserts only a point entity (the node) and not the point block and symbol. This option is most useful when you have a lot of points to insert, because inserting only the nodes is faster than inserting nodes with the point block and symbol. Commands such as Triangulate & Contour and Make 3D Grid File can use these points, and do not need the point block and symbol.

Selecting Elev Text Only draws text of the point elevation without the point block, symbol, or node. The decimal place of elevation text is placed at the northing and easting point location.

Locate within Polyline inserts only the points that are inside a closed inclusion polyline. The command prompts you to select a closed inclusion polyline and as well as an optional exclusion polyline. All the points in the current coordinate file are checked. Any points that are located within the inclusion polyline and outside the exclusion polyline are drawn.

Locate within Distance inserts only the points that are within a specified distance from a reference point. The command asks you for the reference point and the search distance. All the points in the current coordinate file are checked. Any points that are located within the search distance of the reference point are drawn.

Locate within Window/Coord Range inserts only the points that are within the specified window or range of northing, easting, and elevation. The command prompts for the minimum and maximum northing, easting, and elevations. These values default to the actual minimum and maximum in the coordinate file. Then the command
prompts for the point number range of points to check. The points that fall in both the point number range and the coordinate range are drawn.

Under **Point Prompt-Label Settings**, you determine attributes for which you will be prompted. **Descriptions** determines whether you are prompted for descriptions for each point when creating new points. When you are placing both new and existing points, Descriptions determine whether this attribute is labeled with the point inserts.

**Notes** works with the note file (.not) associated with the current coordinate file. The note file contains unlimited point descriptions in addition to the fixed 32-character point descriptions in the coordinate file. When you create points with Notes on, the command will prompt for point notes to be stored with the point. When you draw existing points with Notes on, any notes for the points are drawn as text entities below the point description.

**Elevations** determines whether you are prompted for elevations for each point when creating new points. When you are placing both new and existing points, Elevations determine whether this attribute is labeled with the point inserts.

Use `+` labels the positive elevations with a leading `+`. For example, `+159.43`.

Use `-` labels the negative elevations with a leading `-`.

**Locate on Real Z Axis** determines if the points are placed at their elevations or at zero elevation.

**Label Zeros** will label points with zero elevation when the Elevations option is on. Otherwise only points with nonzero elevation will be labeled.

**Elevation Prefix/Suffix** set the prefix and suffix labels to apply for the elevation labels.

**Elevation Integers** controls the number of digits to display to the left of the decimal point for the elevation label. The All setting will show the full elevation digits. The other settings allow you to limit the number of digits to display for the purpose of reducing the amount of space the elevation labels take up in the drawing. For example, if a site is in the 4000 foot elevation range, then this setting could be set to three digits (000) and an elevation of 4321 would be labeled as 321.

**Elevation Decimals** sets the number of decimals to the right of the decimal places for the elevation labels.

Under **Point Number Settings**, you determine how points will be numbered. **Point Numbers** determines whether the complete point block is drawn or just the symbol and node. When you create new points with Point Numbers off, no points are stored in the current coordinate file, and only the point symbol and node are drawn. When you draw existing points with Point Numbers off, the point attribute block is not drawn and only the point symbol and node are drawn.

**Automatic Point Numbering** applies to creating new points. With this option active, the command will use the **Starting Point Number** for the first new point. The next point number is automatically incremented. Before storing the point, the command checks whether the point number is used. If the point number is used and point protect is on (set in the Coordinate File Utilities command), then the command will prompt for another point number or to overwrite the point. With Automatic Point Numbering off, the command will prompt for the point numbers.

Determine how the points are to be displayed and in what layer.

With **Wildcard match of pt description**, you can display only points with specific descriptions. This can be thought of as a filter. For example, entering IP would display only points that are labeled with the description IP, or Iron Pin. The default is the asterisk (*). This will display all points regardless of description.

**Layer Name** allows you to designate a layer for the points to be displayed. You can enter a new name, CLAYER, or choose an existing layer by clicking **Select Layer**. Entry of CLAYER selects the current layer. A Carlson Survey point consists of a block insert with attributes, a point symbol, and a point entity. The point entity is used for picking the point by OSNAP Node in other commands. The block insert includes a point number, elevation, and description. These attributes are in the PNTMARK, PNTNO, PNTELEV, and PNTDESC layers. The points are also in an overall layer as specified in this dialog box. This layer setup allows you to freeze a group of points by
the main layer name or freeze point attributes for all the points in the drawing. For example, freezing layer "PNTS" would freeze all the points in this layer. Freezing layer "PNTELEV" would freeze the point elevation attribute for all the points.

The **Duplicates** option for **Erase and Redraw** will erase existing point entities that match the point numbers currently being drawn. The **Allow Duplicates** option will leave any existing point entities as the specified points are drawn. The **Draw Only New** option will only draw points that don't already exist in the drawing.

**Fix Overlapping Point Attributes** will detect point number, elevation and description attributes that overlap with other points. Rules can be applied to rearrange the point attributes to avoid the overlaps. A point overlap manager then steps through each overlap for review or manually moving the attributes.

**Symbol Size Scaler** controls the size of the point symbol and **Text Size Scaler** controls the size of the point attribute labels. The scalers are multiplied by the Horizontal Scale from Drawing Setup to set the size in drawing units.

**Match Properties** prompts to select an existing point entity and then the program sets the settings in the dialog such as layer and symbol to match the selected point.

**Draw Range** will draw existing points from the current coordinate file. The Draw Range button will prompt for the point numbers to draw.

**Draw All** will draw all the points in the coordinate file, and then zoom the extents of the display to show the points.

**Draw Point Group** will draw a point group with settings that are established in the Point Group Manager.

**Enter and Assign** can be used to create new points using the point northing and easting. When a grid projection is defined in Drawing Setup, then there is an option to enter the points using latitude/longitude.

**Screen Pick** allows you to create points by picking the point coordinate on the screen. For example, you could set the Object Snap to EndPoint and pick the end point of a building polyline to create a point at the building corner.

**Prompts**

To create a new point:

**Draw-Locate dialog** *choose Screen Pick*

**Pick point to create:** pick a point

Select/<\Enter Point Elevation <0.00>: Enter elevation Press S to select text to set elevation.

**Enter Point Description <>: Enter**

**N: 5106.57 E: 4901.96 Z: 0.00**

**Enter/<<Select text of elevation>: Select text entity that defines elevation of point.**

To locate a point in the coordinate file (point number 3 in this example):

**Draw-Locate Point dialog** *choose Draw Range*

**Point numbers to draw:** 3

**Points Drawn> 1**

Locates point 3.

**Point numbers to draw:** 1-2

**Points Drawn> 2**

Locates a range of points. From 1 to 2.

**Point numbers to draw:** Enter

**Keyboard Command:** lpoint

**Prerequisite:** A CRD file and you may want to execute *Drawing Setup* (see the Setting menu) to set the scale and
List Points

This command generates a report of point numbers, northings, eastings, elevations and descriptions.

Selection Method-Range allows you to specify the points to list by point number range

Selection Method-Area allows you to select a closed polyline to list all of the points inside of that polyline.

Selection Method-Selection Set allows you to specify the points to list by selecting them from the drawing.

Range of Points: If you are using the Range method, specify the range of points to list here. To quickly specify all points, click the All button.

Point Group allows for the selection of a specified group or multiple groups for listing. Standard windows selection tools, ctrl and shift keys, can be utilized for selecting groups.
Description Match: Can be used to filter the point list. For example, entering "EP" for the Description Match would only list those points with a description of "EP". An asterisk (*) is the default setting, it matches any character sequence, meaning no filtering occurs.

Report Coordinate Range: When checked, the point list will include the minimum and maximum northing, easting and elevation.

List Point Notes: When checked, any additional point notes assigned to the points will be included in the point list. Point notes can be entered using the Input-Edit Point command found in Coordinate File Utilities.

Use Report Formatter: When checked, you may customize the fields and layout of the point report using the Report Formatter. The Report Formatter can also be used to export the point report to Excel or Access.

Double Space Between Points: When checked, the report will be double spaced.

The point list report is displayed in the Standard Report Viewer which can print, draw and save the report file. This report viewer cannot be used to edit the coordinate file. Instead use the Edit Points command in the Points menu.

Example of List Points Report:

List Points Report
File> C:\Carlson2008\DATA\POINTS.CRD
Job Description>
Job Number> 0.000 Job Date> 06/01/2002
PointNo. Northing(Y) Easting(X) Elev(Z) Description
1 5355.240 5000.000 91.8 CP2
2 5000.000 5000.000 90.0 CP2
1000 5355.236 5000.000 91.8 CK
1001 4941.911 4622.029 91.4 FPC
1002 4952.629 4642.818 90.6 FH
1003 4959.931 4634.440 89.8 TOE1

Pulldown Menu Location: Points
Keyboard Command: listpt
Prerequisite: Points in a coordinate file or on the screen
Import Text/ASCII File

This command converts point data from an ASCII text file into a Carlson coordinate (.CRD) file. Each line of the text file can contain any combination of point number, northing, easting, elevation and description. All point information should be on one line with the values separated by a comma, space or other delimiter.

Under the Source File Format setting you can choose from some specific formats or User-Defined. For User-Defined, the format of the text file is specified in the Coordinate Order field where the value identifiers are listed with the appropriate delimiters. For example:

For a text file with northing, easting, elevation and comma delimiters:

5100.0,5150.5,485.1
5127.1,5190.3,487.3

The Coordinate Order would be:

Y,X,Z

For a text file with point number, easting, northing, elevation, description and space delimiters:

1 5000.0 5000.0 490.3 TRAV
2 5030.4 4930.5 495.5 TRAV

The Coordinate Order would be:

P X Y Z D

Common formats can be selected from the Common Format List. All the lines in the text file should contain only point data and any header lines should be removed. To read the text file, pick the Select Text/ASCII File button and choose the file to read. Then the selected file is displayed in the Preview Window to help with filling out the Coordinate Order. When the Coordinate Order is set, click OK to read the text file.

The Use Import Formatter is an alternative way to define the format of the input file. This method has a heads up interface for selecting the fields for each column of data. This method also supports fixed width, user-defined delimiter and semi-colon delimited files that the Coordinate Order method doesn't handle.
The Wild Card Descriptions Match allows for only point with matching descriptions to be imported. The Value to Add to Point Numbers allows you to renumber the points as they are imported. The Header Lines to Skip value is the number of lines not to be processed at the start of the text file. The Point Group To Assign option will create a point group with the specified name for the coordinate file containing the point numbers imported with Import Text/ASCII File. The Use Inclusion/Exclusion Areas option prompts for selecting closed polylines to control where to import points.

With Point Protect active, the program will check if a point number already exists in the CRD before importing the point. If a point conflict is found, you can either assign a new point number or overwrite the old point.

Multiple files can be imported at once. To do this, toggle on the Enable Process Multiple Files option. After selecting the Text/ASCII Files button, you can select multiple files by using the Shift or Ctrl keys while picking files. You can also run Select Text/ASCII Files multiple times allowing for selection of files located in different locations. The files to import are listed in the top scroll display window. The point data from all the import files can be stored to the current CRD file or to separate files for each import file. The separate file option will name the
resulting CRD files with the same name as the import file with a .CRD file extension. For example, the import file job125.txt would create job125.crd. The CRD file will be created in the same location as that of the selected text file to import.

Under Process Options, there are choices for selecting the coordinate file to store the imported points. The Current option uses the current coordinate file that is active in the drawing. This coordinate file name is shown at the bottom of the dialog. The Prompt For Another option uses the standard file selection dialog to select the file. The Name Another By Input File uses a coordinate file name with the same name as the input file except for a file extension of .CRD.

The Process Space Separated DMS Latitude/Longitude handles a text file with the degrees, minutes and seconds separated by spaces. The latitude and longitude values get stored to the coordinate file in decimal degrees. Here is an example text file line with the point number (1100), latitude degrees (42), latitude minutes (6), latitude seconds (3.200), longitude degrees (70), longitude minutes (2), longitude seconds (2.090) and elevation (85.245). The Coordinate Order for this example should be set to P Y X Z.

1100 42 06 03.200 70 40 02.090 85.245

The special formats of SDMS .ctl, Leica .d45/.gsi/.raw files, MicroStation .TA2 files, WinCMM .cor and .lev files, TDS .cr5 files, Topobase .ro files, Geodimeter .obs/.raw/.are files, Laser Atlanta .txt files, Trimble .pos files, Zeiss .txt files, Traverse PC .trv files, Maptech, Benchmark .dat files, CAICE/Caltrans .tss files, NLS MMH360 .360 files, EMXS .xng files, and Cadvantage .cog files can be directly imported by choosing that File Format at the top of the dialog.

Pulldown Menu Location: Points
Keyboard Command: readpt
Prerequisite: A text file to read

Export Text/ASCII File

This command outputs point data from the current Carlson coordinate file to an ASCII text file formatted according to a variety of options presented in the form of a general dialog.

![Export Text/ASCII File dialog](image)
Format. Specify the type of file to write from the drop down list. There are several variations on point number, northing, easting, elevation and descriptions as well as specific formats for Leica, Geodimeter, Zeiss, Maptech, Idan REG, NLS MMH360, D45, Cadavantage, Multiplane and SDMS CTL formats. In addition there is a User-Defined Format option to define the order of the fields output. When using the User-Defined format, after selecting OK, the User-Define Export Format dialog will appear. On this dialog, specify the order of the fields by defining a number sequence in each field. You can skip fields and omit data in the output file by leaving None in the sequence field for this data:

![User Define Export Format](image)

Selection. There are four Selection Methods provided for the data to export. Specify either Range, Screen Points, Screen Entities or Pick Points in the Selection Field. A Range selection is a user specified range such as 1-10,30-50. A Screen Points selection is made by selecting points from the screen area. The Pick Points method prompts to select the points to export from the drawing. The Screen Entities option allows for selection of polylines, lines, arcs, points, faces, inserts and text to export point data from. When the Screen Entities option is selected, the following dialog box will display allowing for the specification of the type of entity to export data from:

![Entities To Process](image)

Delimiter. Select the desired field delimiter of the export file as either Comma or Space from the drop down list. If a header line is to be included, enable the check box.

Number of Decimal Places. Select the desired number of digits to be included in the mantissa of all output ordinates.

Location Filter. Choose from filter methods of within inclusion perimeter polyline, by coordinate window or center within radius from a center point.

Wild Card Descriptions Match. A description filter is also available for exporting only points from the range or
selection set with certain descriptions.

**Export Point Notes and Attributes.** Notes associated with the points may be included in the export by enabling the check box.

**Export Multiple Coordinate Files.** Enable this check box to specify multiple CRD files to apply the selection criteria against. If enabled, an additional dialog will be presented from which you can browse, select, and remove as many CRD files as desired. In this mode, you can use the Write To Single ASCII File to output the multiple coordinate files into one combined text file.

**Point Group.** Displays the Point Group manager dialog from which you may define, modify, and select one or more Point Groups to define the points to be included in the export.

After selecting the OK button, a final dialog appears that allows you to specify a new file or to append data into an existing file. The standard file selection dialog allows you to specify the export file name.

**Pulldown Menu Location:** Points  
**Keyboard Command:** writept  
**Prerequisite:** A Coordinate File (.CRD)

### Set Coordinate File

This command allows the user to set the name of the active coordinate file. This file is used by different commands that compute, store and recall point coordinates. Carlson coordinate (.CRD) files are binary files that contain point numbers, northings, eastings, elevations and descriptions. Alternately, C&G CRD & CGC files, LandDesktop MDB files or Simplicity Systems ZAK files can be used in place of the Carlson CRD file. These files are stored by default in the configured data subdirectory. When prompted for the name, if you type in a path name the file will be stored in the specified path. If you don't specify a path then the default path that is configured in the `Configure` command, found under Settings, will be used.

When executed, the command defaults to the Existing tab for selection of an existing file. You may select a file from the list of Recent Folders, or choose the Browse button to go to a specific location on your computer. To create a new file, select the New tab and enter the name of the file in the file name field provided. Use the Browse button to specify the desired location to save the file.
Pulldown Menu Location: Points
Keyboard Command: setcrd
Prerequisite: None

CooRDinate File Utilities

This command organizes a wide variety of coordinate file and point manipulation routines into one central location. The type of coordinate file format is displayed within the dialog box. Another increasingly popular coordinate format is the Carlson coordinate database (.CRDB) which is based on SQLite and supports point numbers and descriptions up to 255 characters in length.
In addition to running the routines through the dialog, many routines have command names that you can enter at the Command prompt, create a Quick Key, or put into a toolbar. The table below shows the command names and their corresponding key-in command equivalents:

<table>
<thead>
<tr>
<th>File Utilities</th>
<th>Point Utilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open CRD File</td>
<td>listpt</td>
</tr>
<tr>
<td>Copy/Merge CRD File</td>
<td>delpt</td>
</tr>
<tr>
<td>Convert CRD File Format</td>
<td></td>
</tr>
<tr>
<td>Map Points from 2nd File</td>
<td></td>
</tr>
<tr>
<td>Import Text/ASCII File</td>
<td></td>
</tr>
<tr>
<td>Export Text/ASCII File</td>
<td></td>
</tr>
<tr>
<td>Edit Header</td>
<td></td>
</tr>
<tr>
<td>Compress CRD File</td>
<td></td>
</tr>
<tr>
<td>Coordinate Transformation</td>
<td></td>
</tr>
<tr>
<td>Draw Entities by Point ID</td>
<td></td>
</tr>
<tr>
<td>New Last Point Number</td>
<td></td>
</tr>
<tr>
<td>Swap Northing-Easting</td>
<td></td>
</tr>
<tr>
<td>Point Entity CRD File Links</td>
<td></td>
</tr>
<tr>
<td>Manager</td>
<td></td>
</tr>
<tr>
<td>Update Drawing from CRD File</td>
<td></td>
</tr>
<tr>
<td>Update CRD File from cfuupdatecrd Drawing</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Open CRD File:** Allows the user to switch to another file. See Set Coordinate File for additional information. When you exit Coordinate File Utilities this will be the current file that you work with in Carlson.

**List Points:** List the points stored in the active coordinate file. See List Points for additional information.

**Copy/Merge CRD File:** This command allows for the copying of entire CRD files, or parts of CRD files, to a new or existing files. This can be used to make a backup of your coordinate file, and it can also be very valuable in coordinate file manipulation. For example, if a certain range of points from one CRD file was also required in the active CRD file, this command would be used to simply copy the required range into the active CRD file. There are two options when first executing the command. These options are whether to import points from another file to the current (active) CRD file, or to export the current (active) coordinate file to another file.

Once this option has been decided, a prompt for the file to copy From or TO, will be displayed. Here simply specify the correct file.

Next there's a dialog to specify the range of points to transfer and some options. Here specify the points to copy. Point numbers and ranges can be entered together. For example, **1-3,10,15** would result in points 1 through 3 and points 10 and 15 being copied. The Description Match can be used to filter the points to transfer only the points with matching description. The default of * will transfer all the points in the range. The Store Non-Conflicting Point Automatically will set the transfer action as Store for all transfer points that don't have a point protect conflict. The Skip Merge Dialog If No Conflicts will skip the next dialog when there are no point protect conflicts.
The Import dialog has a few more options than the Export dialog. The Add Prefix/Suffix To Point Names will change the point names as they are imported. The Create Point Group will make a new point group with the imported point names.

Next there's the Merge Points Manager dialog that shows the Source Coordinate File on the left (where the point data is being copied from) and the Target Coordinate File on the right (where the point data is being written to). Conflict cases are when the same point number exists in both files with different coordinates. The action choices for conflicts are to Overwrite, Skip or Renumber. For renumber, you can either renumber with the next available point number in the target file or to the highest point number in the target file plus one. Non-conflict cases are when the source point number does not exist in the target file. The action choices for non-conflicts are to Store or Skip. You can assign actions by picking on the Action field in the spreadsheet or by entering in a Point Range to apply and picking an action button. The Show Matching Points toggle will show points with matching point data in both files. Otherwise only point with differences are shown. The Next Conflict button will highlight the spreadsheet and set the Point Range to the next point that needs an action assigned. Similarly, the Previous Conflict sets focus to a lower point number that needs an action. The History button shows the point history for the selected point. The Report button creates a list points report. The Current Merge Status reports the number of unresolved and resolved points. When all the unresolved points are resolved by assigning actions, you can pick OK.
Delete Points: Deletes points from the active coordinate file. See Erase Points for additional information.

Convert CRD File Format: This allows you to convert the current coordinate file from one format (e.g., numeric only) to another (e.g., alphanumeric). This routine will also change coordinate files to and from other software formats. These formats include Carlson SQLite (.CRDB), C&G, Microsoft Access (.MDB) in same format as AutoDesk Land Desktop, and Simplicity (.ZAK). The current format of the active coordinate file will be displayed as well as the options for the new file format. This command only changes the format of the active coordinate file.

Screen Pick Point: Pick a point on the graphics screen and its coordinate value is added to the coordinate file. This command does not plot a point, point attributes or point symbol. Use Draw Field-to-Finish or Draw-Locate Points or Update Drawing from CRD File to graphically draw the point(s).

Map Points from 2nd File: This routine adds point to the current coordinate file from points stored in a second coordinate file. The points to copy are specified by numbers one at a time. Prompts for the destination point number (number to create in current coordinate file) and source point number (point number to be copied from second coordinate file) will be displayed.

Scale Points: This option multiplies the point northing, easting, and elevation by the scale conversion factor. You can use this routine for Metric-Imperial unit conversion. See Scale Points for additional information.

Import Text/ASCII File: This routine converts point data from a text file into the current coordinate file. See Import Text/ASCII File for additional information.

Translate Points: This option translates a range of points based on entered delta x and delta y, entered coordinates or translation point numbers. See Translate Points for additional information.

Export Text/ASCII Text File: This routine outputs point data from the current coordinate (.CRD) file to a ASCII Text file. See Export Text/ASCII File for additional information.

Rotate Points: This option rotates a range of points based on entered degrees or rotation, entered azimuths, entered bearings or rotation point numbers. See Rotate Points for additional information.

Edit Header: Enter or edit the job information associated with the coordinate file. The fields include Job Description, Job Number and Job Date. This information will appear on the List Point report. Non-digit characters are not allowed in the Job Number field.

Align Points: This option does a translate based on a source point and destination point and then rotates to align the
first source point and a second source point with the first destination point and a second destination point. See Align Points for additional information.

**Compress CRD File:** Removes unused point numbers by renumbering high point numbers into the unused spaces. For example, for an original file with points 1,2,105,107,108,109 would be compressed to 1,2,3,4,5,6.

**Description for Points:** This routine modifies the point description field with the user-specified text for a range of point numbers. There is an option to update the description attributes of the points in the drawing in addition to updating the coordinate file.

**Coordinate Transformation:** Transforms coordinates between local, State Plane 27, State Plane 83, Latitude/Longitude, Universal Transverse Mercator (UTM) and many other projections, including regional and user-defined projections. This works on individually entered coordinates, by range of point numbers and with on-screen entities. See Coordinate Transformation for additional information.

**Elevation for Points:** This routine modifies the elevation of the specified points. The Absolute method sets the elevations to the specified value. The Differential method adds the value to the current elevations. The Scale method multiplies the current elevations by the value.

**Draw Entities by Point ID:** Draw Lines, Arcs, 3DLines, Polylines or 3DPolys by defining a range of point numbers.
Prompts

Plot Entities by Point Number

**Type of entity, Arc/Polyline/3dpoly/2dline/Exit/Line:** Indicate the type of entity to draw.

**Undo/Enter point numbers or ranges:** Indicate the point numbers through which to draw.

Example: 1-4,7,10-12,5,8 would draw the entity from point numbers 1 through 4 then to 7, to 10 through 12, then to 5 to 8 (limit 132 characters)

Example: 1-10,20-30 would draw the entity from point number 1 through 10 then to point number 20 through 30.

**Point Number Report:** This routine lists the used and the unused point numbers in the coordinate file.

**New Last Point Number:** This option sets the highest point number in the coordinate file. **NOTE:** All points above this number are erased!

![Set New Last Point Number](image)

**Duplicate Points:** This function searches the coordinate file for points with the same northing, easting and elevation. The tolerances for considering points to have the same coordinate are set in the dialog separately for northing/easting and elevation. To be counted the same coordinate, both the northing/easting and elevation must be within the tolerance distance. The duplicate points can be reported, deleted or averaged. For the erase and average options, the first point number is kept and any higher point numbers with duplicate coordinates are processed from the coordinate file.

![Duplicate Point Check](image)

**Swap Northing-Easting:** This option allows you to swap northing and easting coordinates for any selected range of points. What was the northing of an existing coordinate point, or range of points, becomes the easting. And the easting(s) become the northing(s).

![Swap Northing-Easting Values](image)

**Compare Points:** This function compares the coordinates in the coordinate file with either the coordinates for the matching point numbers in the drawing file, with matching point numbers from another coordinate file or with different point numbers from the same coordinate file. A report is created for any differences that shows the point numbers and the differences. The difference can be reported as a bearing and distance between the two points, as distance North/South and East/West or as the delta-X and delta-Y. There is an option whether to include the point coordinates in the report. The Create Point Groups option creates point groups of "Missing From Drawing" and "Changed Points" for any points that have this status. Use the Point Group Manager routine to check on these point groups.
Example Bearing-Distance format Compare Points Report:

Point Entry CRD File Links Manager: When points are created in the drawing, the program records the source coordinate file for the points. The coordinate file names assigned to the point entities links the point entities back to the coordinate file. These links are used by routines that process the point entities and then need to reference the changes (e.g. those generated from the Rotate Points routine) back to the coordinate file. This routine checks all the point entities in the drawing and lists all the linked coordinate files. You can use the Assign button to set the coordinate file assigned to point entities which is useful when the coordinate file has been moved or manually renamed after the points were drawn. Use the Unlink button to remove the link.
**Renumber Points:** This option renumbers points in the user-specified range starting from a new point number. See Renumber Points for additional information.

**Update Drawing from CRD File:** This function updates the position of Carlson points in the drawing to match the position stored in the coordinate file. This command also has options to erase and draw points. For the erase option, points are erased from the drawing if the point number does not exist in the coordinate file. For the draw option, if a point number in the CRD file does not exist in the drawing, then this point is drawn using the settings from the dialog. The number of points modified, erased and drawn is reported at the end of the command.

![Update Drawing from CRD File](image)

**Input-Edit Point:** Enter or edit the coordinate values or the description of a point. The Notes section is for adding optional point notes which are additional point descriptions. Under notes, any number of lines of text can be assigned to the point. A list box shows the lines of notes. To add a note line, pick a blank line in the list box and then type in the note in the edit box belong the list box and press **Enter**. To edit a note, highlight the line in the list box and edit the text in the edit box.

![Input-Edit Point](image)

**Update CRD File from Drawing:** This function allows you to select all or some of the points in the drawing and add or update them to the coordinate file. The points can be filtered using standard CAD entity selection and/or
wild-card matching of the point descriptions. The Update Point Descriptions option determines whether the point
descriptions from the drawing will be stored to the coordinate file. Use this command to manually update the file
after a general CAD edit such as Move, Rotate, Erase, etc. This routine directly reads Leica (Wildsoft), Softdesk,
Geodimeter, InRoads, Land Development Desktop, and Eagle Point point blocks.

**Point History:** All changes to the coordinate file will record the commands performed on this coordinate file and
the status of the points themselves. This makes up the coordinate file history. The history can then be reported by
point number or by command. All of the changes can be rolled back.

The **Disable History Feature** button at the top of the dialog shown above is a toggle device. It should be clicked
if you prefer not to build the point history file. Clicking it a second time changes it back to saying **Enable History
Feature**. You can also choose **Delete History File** to delete the file altogether. By clicking any point from the
list, as shown in the Points tab example above, and then selecting **History**, you will be given the history for that
specific point. Double-clicking on any command shows the details. Clicking on **Details** also shows the selected
command details. Undo thru Selected will undo the effect of all of the commands up through and including the
selected command. The changes from the undo command are themselves then added to the command list and can
be undone in the future.

**NOTE:** It is important to note that if maintaining such a history file is your objective, make sure that **Maintain CRD
History File** option is enabled within the (Carlson) Configure – General Settings command:

**Point Protect:** When enabled, attempting to store a point with a point identifier (point number) that already exists
in the current coordinate file will display the following alert:
**Overwrite with new coordinates** will update the existing point number with the new location of the point.

The **Renumber Point** field displays the point number that will be used if the Renumber Point From – Next Available option is selected (the routine will attempt to fill in any point number gaps. To leave any existing point number gaps in the file, specify the **End of File** option.

The **Overwrite All** and **Renumber All** options apply when more than one point with the same number exists in the coordinate file. These options are helpful when importing points into existing coordinate files.

**Pulldown Menu Location(s):** Points  
**Keyboard Command:** cfu  
**Prerequisite:** None

**Point Group Manager**

This command is used to create point groups based on inclusion and exclusion filters. The manager can perform various functions on these point groups. Also point groups can be referenced by group name in other commands such as Field to Finish and Data Collection.

**Groups Pulldown**

**Create Point Group:** This routine creates point groups. When selected, the New Point Group dialog box is displayed.
Group Name is the name of Point Group to create.

Description is the description of Point Group to create.

Use the Include Tab to define the filters to be applied when creating the point group. Inclusion rules are applied before the exclusion rules.

When Include All is toggled on, all points in the coordinate file will be included in the selection.

When Point List is toggled on, an option of defining the point list can be selected or the point numbers can be manually entered in the edit box. The points retain the order entered in the edit box which can be used in other point functions that process points where the order matters such as Legal Description. The Edit button brings up a spreadsheet editor for the point list and there is a flag for each point for whether the point is a radius point. This radius point flag is used in routines that process points for a polyline or perimeter such as Legal Description. The radius point is used to define an arc in the polyline. The sequence of points for the arc are PC, radius point and PT.
**DWG: Select** allows for manual selection of the points to include from the drawing. The points must be drawn on the screen prior to using this option. All standard AutoCAD selection tools are available for selection of the points.

**DWG: Inside Circle** allows for selection of the points to include by a user defined circle. The circle is defined by specifying the center and radius of the circle. The radius can be defined by entering in a numeric value or by picking on the screen. Points must be drawn to the screen prior to using this option.

**DWG: Inside Polyline** allows for the selection of points to include by referencing a closed polyline. All points located within the closed polyline will be included in the selection. Prompts for the inclusion polyline and the exclusion polyline will display. The inclusion polyline limits of the selection area. The exclusion polyline defines the area to exclude within the inclusion polyline. Points must be drawn to the screen prior to using this option.

**DWG: Along Polyline** allows for the selection of points to include by offset from an alignment polyline. All points located within the specified offset tolerance from the polyline will be included in the selection.

**CRD: Select** allows for manual selection of the points to include from a point list. Standard window selection tools are available for selecting the points to include.
CRD: Inside Circle allows for selection of the points to include by a user defined circle. The circle is defined by specifying the center and radius of the circle. The radius can be defined by entering in a numeric value or by picking on the screen. The points do NOT have to be drawn to the screen prior to selection.

CRD: Inside Polyline allows for the selection of points to include by referencing a closed polyline. All points located within the closed polyline will be included in the selection. Prompts for the inclusion polyline and the exclusion polyline will display. The inclusion polyline limits the selection area. The exclusion polyline defines the area to exclude within the inclusion polyline. The points do NOT have to be drawn to the screen prior to selection.

CRD: Along Polyline allows for the selection of points to include by offset from an alignment polyline. All points located within the specified offset tolerance from the polyline will be included in the selection.

RW5 File: creates a list of points from all the point numbers used in the selected RW5 raw data file.

History Select: creates a point group by date range using the log stored in the CRD history. See Coordinate File Utility > Point History to review this information.

Point Name Prefix: creates a point group by a specified number of digits from the start of point names. This method applies when your point numbering method uses a fixed beginning string for point names. For example, if point names begin with a code for the crew, then this method can make point groups per crew.

Elevation Range allows for the selection of points within a specified elevation range to be included in the group. The minimum and maximum elevations can be entered manually in their respective data fields. The minimum and maximum values can also be specified by the Set By Selection and Set From List options.

Set By Selection allows for selection of points to include in the group from the drawing. The points must be drawn to the screen prior to using this selection method. Standard AutoCAD selection methods are available.

Set From List allows for selection of points to include in the group from a point list. Standard Windows selection tools are available with this option.

The Description option allows for a selection of points to include based upon the description of the point. The description to filter for can be entered in the data field or by using the Set By Selection and/or the Set From List options described above.

The Exclude Tab allows for defining rules that pertain to the points to be excluded from the Inclusion selection. After defining the inclusion rules for the group, the options on the Exclude tab can be used to filter for points to exclude from the group. For example, if the inclusion rules call for all points within the elevation range of 8 to 12,
an exclusion rule can be set to exclude the points on elevation 9 or with the description tree. The options on this tab work exactly like the options on the Include tab. Please refer to the Include tab definitions for further instruction.

**Save Changes** saves the point group to the group name specified based upon the Inclusion and Exclusion rules specified.

**Cancel Changes** discards specified rules and changes and goes back to the Point Group Manager dialog.

**Edit Point Group:** This function allows for editing of existing point groups. From the list of available groups, highlight the group or groups to edit. When complete with the first group, if more than one is selected, selecting the Save Changes option will save the changes to the active group and switch to the next group in the selection set.

From the Groups pulldown, select Edit Groups, the Edit Group dialog box will now appear.

See Create Point Groups for further definitions of the available options.

**Delete Point Group:** This deletes specified groups for the existing group list. One or more groups can be deleted at one time.

**Copy Point Group:** This routine creates a new point group by copying the currently highlighted group. This allows you to modify an existing group definition and create a new group.

**Import Point Groups:** This allows for importing filters from point group manager settings of other coordinate files. This is a useful option when coordinate files are going to contain same point group names with the same filters. This option only brings in the filters into the point group manager, it does not import actual points into the coordinate file by group name. Existing points in the active coordinate file that meet the filter definitions of the imported point groups will automatically be added to the corresponding group.

## Points Pulldown

**Insert into Drawing:** This routine draws the points in the group in the drawing. Individual points or point ranges can be selected from the group to be erased from the drawing. For example points 264-275 and point 298 contained in group Wet Lands are tagged to be erased from the drawing in the following figure.

The symbol to be used and the attribute layout are determined by the Point Default Settings. The symbol size and the point attribute size are determined by the settings in the Drawing Setup routine.

**Erase from Drawing:** This erases specified point group/groups or specified points from within the group from the
Erase from Coordinate File and Drawing: This erases the points in the specified group/groups or specified points from within the group from the drawing and will also permanently delete the points from the CRD file. You will be prompted with a warning as follows:

Selecting **Yes** will complete the command and erase the points from the screen and also the coordinate file. Selecting **No** will cancel the command leaving the drawing and the coordinate file unchanged.

Report: The routine will generate a point list of the points contained in the selected group/groups or specified points from within the group.

Highlight: This routine highlights the specified objects in the drawing. This makes them distinguishable from the other points on the screen.

Isolate: This routine freezes all the points except for the current group.

Freeze: This routine freezes the points of the highlighted point group like the Points->Freeze Points command.

Thaw: This routine thaws the points of the highlighted point group like the Points->Thaw Points command.

Thaw All: This routine thaws all the points like the Points->Thaw Points command.

Draw 2D Line: This routine draws a 2d polyline between the points contained in the group/groups or between specified points in a group.

Re-number: Renumbers points in the current group.

Edit Attributes: Edits the point attributes for the points entities in the drawing.

Edit Descriptions: Sets the description for the points in the current group.

Edit Elevations: Sets the elevation for the points in the current group.

Export: This command exports the selected group/groups or the specified point(s) or range of points from within the group to various formats. The available formats are ASCII/Text, Carlson Software CRD and C&G CRD files. When **ASCII/Text** is selected, the Export Text/ASCII File dialog box will be displayed. Please refer to the Export Text/ASCII File section of the manual for more information.
The **CRD-Carlson software** command writes the selected group/groups or the specified point(s) or range of points within the group to a new Carlson formatted CRD file.

Specify the file name of the CRD file to create and press save.

**CRD-C&G** writes the selected group/groups or the specified point(s) or range of points within the group to a new C&G formatted CRD file.

Specify the file name of the CRD file to create and press save.

**Button Functions**

The series of buttons at the bottom of the main dialog do the same functions as the routines in the Groups pull-down menu except the Move Up and Move Down which are only available as these buttons. The Move **Up/Down** simply change the display order of the groups in the list. The **Import** function brings in group definitions from either another coordinate file or from a C&G Points List File. The **Sort** function sorts the groups by name or by number of points. The **Merge** function combines the definitions from two or more existing groups to create a new group. To run Merge, highlight the groups to merge in the Groups list by clicking on them while holding the Ctrl key, and then pick the Merge button.

**Pulldown Menu Location:** Points

**Keyboard Command:** pgm

**Prerequisite:** A coordinate file

**Edit Points**

This command edits point data in the current coordinate file or within a point range. The current coordinate file can be set with the Set Coordinate File command. **Edit Points** shows all the points in the coordinate file. New points
can be added and points can be deleted by using the Insert and Delete keys.

In the Edit pull-down menu, there are functions to add and remove rows from the spreadsheet. Also there are clipboard functions to copy and paste spreadsheet cell values. The **Delete Range** function allows you to delete a range of points or all the points by entering "ALL" for the range. The **Hide** function hides the selected range of spreadsheet rows and the **Show** function brings these rows back. The **Settings** function has a dialog to control the decimals to show in the spreadsheet and an option to use a large font in the spreadsheet to make it easier on the eyes to see.

In the Search pull-down menu, the **Find** function searches the spreadsheet. The **Replace** function has settings to limit the replace by point number range or by field type.

The **Group > Point Group Filter** function allows you to edit subset collection of points as defined by Point Group Manager. This Group method is a way to filter the points by point range, elevation range or description.

This tool also lets you edit notes associated with each point. While the standard point description is limited to 32 characters, the drawing notes are not. When you click on a given point, you can add numerous lines of notes about that point in the bottom of the dialog. Keep in mind that these notes are stored in a separate file with the extension ".not" having the same name as the CRD and residing in the same folder.
Erase Points

This command erases Carlson points inserts from the drawing. The points to erase can either be selected from the screen or specified by point number, point number range or by point group. Erasing a Carlson point will erase the three entities that make up a Carlson point: the point symbol, point attributes, and point node. There is an option to skip erasing the point symbol in case you want to leave the symbols in the drawing. The points may optionally be erased from the coordinate file. As long as the points are not deleted from the coordinate file, they can be redrawn with Draw-Locate Points or Field-to-Finish.

When the program detects linework associated with the points, there is a prompt for whether to erase this linework too. For example, when Field-to-Finish is used to draw both points and linework, then this linework can be erased along with the points.

Prompts

Select points from screen, group or by point number [Screen/Group/<Number>]? press Enter
Point numbers to erase: 1-5
Delete points from coordinate file [Yes/<No>]? press Enter
Delete point symbols [<Yes>/No]? press Enter
Erasing Carlson Points ....
Number of points erased > 5

Freeze Points

This command freezes Carlson points to hide them from view without erasing them. Use the Thaw Points command to show the points again. This command works similar on points as Freeze Layers works on layers. The points to freeze can be selected by point number range, point group, inclusion/exclusion perimeter polyline areas, or screen selection. There is a dialog to choose the method and specify a description match filter.
When the program detects linework associated with the points, there is a prompt for whether to freeze this linework too. For example, when Field-to-Finish is used to draw both points and linework, then this linework can be frozen along with the points.

Pulldown Menu Location: Points
Keyboard Command: freezept
Prerequisite: Carlson points to freeze

**Thaw Points**

This command thaws Carlson points that were frozen with the Freeze Points command to show the points in the drawing again. This command works similar on points as Thaw Layers works on layers.

Pulldown Menu Location: Points
Keyboard Command: thawpt
Prerequisite: Frozen Carlson points

**Lock Points**

This command locks points in the coordinate file so that their names, coordinates and descriptions cannot be modified. There are several types of coordinate files. Lock points only works with the CRDB format because this format in an SQLite database which has a point attribute for lock status. To check on the format of the current coordinate file, run Coordinate File Utilities (CFU) which shows the format type at the top of the dialog. To change the current coordinate file format to CRDB, run CFU and choose the Convert CRD File Format function.

The only way to modify locked points is to first run the Unlock Points command and then run one of the point edit functions.

The points to lock can be selected by point number range, point group, inclusion/exclusion perimeter polyline areas, or screen selection. There is a dialog to choose the method and specify a description match filter.
Unlock Points
This command unlocks points from the current coordinate file that are locked. There is a dialog to choose the method to select which points from the coordinate file to unlock.

Pulldown Menu Location: Points
Keyboard Command: unlockpts
Prerequisite: CRDB coordinate file

Report Locked Points
This command reports points from the current coordinate file that are locked. There is a dialog to choose the method to select which points from the coordinate file to check for the locked status.

Pulldown Menu Location: Points
Keyboard Command: reportlocks
Prerequisite: CRDB coordinate file

Adjust Coordinates
Translate Points
This command translates points in a coordinate file from one coordinate position to another. The delta X, Y, and Z can be entered directly or calculated from original and destination coordinates. The original and destination coordinates can be entered directly, specified by point number, selecting the point number from a point list by selecting the list icon, or selected from the screen by selecting the pick icon. Once these points have been specified, the Delta X,Y,Z, if Process Elevations is checked ON, fields will be filled in with their calculated values. Any points in the drawing will be updated automatically in addition to updating the coordinate file.
Define Translation By Angle/Distance requires a specified direction, Northeast (NE), Southeast (SE), Southwest (SW), Northwest (NW) or Azimuth (AZ) along with a specified distance in order to perform a translation. Once the direction and distance are entered, the Delta X,Y,Z will be calculated. This is a useful command when you know that the job needs to shift, for example, to the Northeast 25 degrees for a distance of 100 feet. Here you would simply type in 25 in the Angle (dd.mmss) field, choose NE in the Type field and then enter the distance of 100 in the Distance field.

With Process Elevations checked, all elevations will be translated by the specified or calculated Delta Z value. This option is very useful in correcting point elevations after performing a survey with assumed elevations and then later surveying into a benchmark with known true elevation. In this case only the Delta Z value, use (-) to indicate a lower correction, and the range of points to translate would be required for a translation. For example if the entire job needed to be lowered by 5', the Delta Z would be defined as -5 and the Range of Points defined as ALL.

Ignore Zero Elevations is only available when Process Elevations has been chosen. With this option checked ON, all points with an elevation of 0 will be ignored resulting in no translation taking place on these points.

With Translate Screen Entities checked ON, after specifying the point range or group to translate and selecting OK on the dialog box the following command line prompt is displayed:
Select objects to rotate (points excluded):
At this prompt select the objects on the screen, polylines, lines, arc, etc., to also translate and press enter. The translation of the points and screen entities will be completed.

Various Output Options for the translated points are available.

Overwrite Existing Coordinates will overwrite the existing coordinate points with the new translation coordinates thus changing the coordinate values in the existing crd file.

New Point Numbers will assign new point numbers to the translated coordinate points and leave the original co-
ordinate points unchanged and present in the coordinate file. When using this option, on the Range of Points to Translate dialog, there is a Value to add to point numbers field. In this field, enter the value to add to the point numbers. For example if the existing point numbers are 1-20, and the value to add is 100, the resulting new point numbers will begin at 101 and end at 120.

**New CRD File** will place the translated coordinates in a new crd file. After selecting OK to the range of points to translate dialog, the Coordinate File to Create dialog will appear. On this dialog enter the name of the new crd file and select save. The original crd file will remain unchanged and the new file will contain the points with the translated coordinates.

Specifying the points to be translated is accomplished either by specifying a **Range of Points** (1-20,33,36-40...) or by **Point Groups**. If using the Point Group option, the Select Point Group(s) dialog box will be displayed allowing for the selection of the Group(s) to rotate.

The **Description Match** option only translates points with the description(s) specified in this field.

**Undo Last Translation** restores the points to their previous location before translation. It is important to note that if Translate Screen Entities has been checked to restore the translated objects to their previous location will require the use of the undo command located in the Edit pulldown.

The AutoCAD command MOVE can be used to translate points on the screen but this does not update the coordinate file unless you have the option Link Points with CRD File turned ON in Configure. (Note: This toggle must have been turned ON prior to locating the points). If you do use the MOVE command and the CRD file needs updating, run the command Update CRD file From Drawing found in Coordinate File Utilities.

**Pulldown Menu Location:** Points

**Keyboard Command:** transpt

**Prerequisite:** points in a coordinate file

---

**Rotate Points**

This command rotates points in a coordinate file. The degrees of rotation can be entered directly or calculated from original and destination bearings or azimuths.

---

![Rotate Points dialog box](image-url)
The **Rotation Point** will remain unchanged while the points specified for rotation rotate around it. This point can be specified by using the **List** button to pick from a list of points contained in the coordinate file, or from the screen by using the **Pick** button. The rotation point can also be defined by a coordinate value by manually entering in the X and Y values of the point. This point must be defined before the rotation will take place.

The **Original Bearings/Azimuths** and **Destination Bearings/Azimuths** can be entered directly or specified by point numbers. If using a pair of points to define the original bearing and then specifying the destination bearing by entering in the desired Bearing/Azimuth, the From and To Pt# fields should be left blank in the destination bearing/azimuth settings. Use the From and To Pt# fields in the Destination Bearing/Azimuth when you want to make a direction or Bearing/Azimuth between two existing points match the Bearing/Azimuth between two other existing points within the file. For example, to make the bearing between points 25-26, the Original Bearing/Azimuth could be defined as From Pt#10 To Pt#12 with the Destination Bearing/Azimuth defined as From Pt#25 To Pt#26.

With **Rotate Screen Entities** checked ON, after specifying the point range or group to rotate and selecting OK on the dialog box the following command line prompt is displayed:

Select objects to rotate (points excluded).:

At this prompt select the objects on the screen, polylines, lines, arc, etc., to also rotate and press enter. The rotation of the points and screen entities will be completed.

Various **Output** options for the rotated points are available.

**Overwrite Existing Coordinates** will overwrite the existing coordinate points with the new translation coordinates thus changing the coordinate values in the existing crd file.

**New Point Numbers** will assign new point numbers to the translated coordinate points and leave the original coordinate points unchanged and present in the coordinate file. When using this option, on the Range of Points to Translate dialog, there is a Value to add to point numbers field. In this field, enter the value to add to the point numbers. For example if the existing point numbers are 1-20, and the value to add is 100, the resulting new point numbers will begin at 101 and end at 120.

Specifying the points to be rotated is accomplished either by specifying a Range of Points (1-20,33,36-40,...) or by Point Groups. If using the Point Group option, the Select Point Group(s) dialog box will be displayed allowing for the selection of the Group(s) to rotate.

The **Description Match** option only rotates points with the description(s) specified in this field.
The points that have been specified for rotation that are present in the drawing will be graphically updated to their new location in addition to an automatic update of the coordinate file.

**Undo Last Rotate** restores the points to their previous location before rotation. It is important to note that if Rotate Screen Entities has been checked to restore the rotated objects to their previous location will require the use of the undo command located in the Edit pulldown.

**Pulldown Menu Location:** Points  
**Keyboard Command:** rotatept  
**Prerequisite:** points in a coordinate file

---

**Scale Points**

This command scales points in a coordinate file. The northing, easting and optionally the elevation are multiplied by the specified scale factor. You can use this routine for Metric-English conversion or a specific conversion by choosing the Use Customized Scale Factor option and specifying the desired Scale Factor in the edit box.

![Scale Points Dialog](image)

Specify the **Range of Points** to scale by entering in a range or group to scale. You can access the group dialog box by typing "group" in the range of points field.

The **Description Match** option only scales points with the description(s) specified in this field.

The **Scale Factor** is to be entered in manually when using a customized scale factor. If converting from standard measurement units, feet to meters, meters to feet, US Feet to International Feet, etc., the scale factor will be calculated and entered automatically. If a combined scale factor is required for converting from ground to grid and grid to ground coordinates, this value can be calculated by using the **Calculate Combined Factor** option. The Combined Factor is the Elevation Factor times the Grid Factor. This calculation process begins with the Calculate Scale Factor dialog shown below.
The Projection Type must be specified as either State Plane 83 or State Plane 27 as well as what state plane Zone is required.

The available Coordinate Units are Metric, US Feet and International (Intl) Feet. The correct unit must be specified before calculating the combined scale factor.

The Range of Numbers to Process should be used to select the points to be used in order to calculate the combined scale factor. This does not specify what points are going to be scaled by the resulting scale factor. These points can be selected from a list by selecting the List button.

Scale Direction determines which way the scale factor will be calculated. A scale for Ground to Grid or Grid to Ground can be calculated and applied.

Pressing the Calculate button will calculate and then display the combined scale factor on the dialog box. To accept this value as the customized scale factor to use to scale the points in the coordinate file, press the OK button.

The Report option displays a report showing specified information. This information is specified by using the report formatter found throughout the program. Simply choose the information you wish to display and the order to be displayed. For further instruction and information on the Report Formatter please refer to the Report Formatter section of this manual.
With **Align Scale Entities** checked ON, after specifying the point range or group to scale and selecting OK on the dialog box the following command line prompt is displayed:

Select objects to scale (points excluded):

At this prompt select the objects on the screen, polylines, lines, arc, etc., to also scale and press enter. The points and screen entities will be now be scaled and updated graphically and in the active coordinate file.

With **Use Customized Scale Factor** Off, various conversions can be performed by specifying the Source Coordinate units and the Destination Coordinate units. This is a quick and easy way to perform Metric/English conversions.

**Pulldown Menu Location:** Points  
**Keyboard Command:** scalept  
**Prerequisite:** points in a coordinate file

### Align Points

This command translates a specified Range of Points or Points Group(s) based on a source point and destination point and then rotates to align the first source point and a second source point with the first destination point and a second destination point. The command basically combines the Translate and Rotate Point commands. To specify a Range of Points to align, enter the range to align or select a point group(s) by selecting the Point Group button. Each of the Translation and Rotation points, both Source and Destination points, can be entered manually or picked from the point list by selecting the List button.
When **Align Screen Entities** is checked, after specifying the point range or group to align and selecting OK on the dialog box the following command line prompt is displayed:

**Select objects to rotate (points excluded):** At this prompt select the objects on the screen, polylines, lines, arc etc., to also align and press Enter. The alignment of the points and screen entities will be completed.

When **Ignore Zero Elevations** is checked, all points with an elevation of 0 will be ignored in the alignment.

**Undo Last Align** restores the points to their previous location before alignment. It is important to note that if **Align Screen Entities** has been checked to restore the aligned objects to their previous location will require the use of the **undo** command located in the **Edit** pulldown.

**Pulldown Menu Location:** Points  
**Keyboard Command:** alignpt  
**Prerequisite:** Points in a coordinate file

---

### Move Points

This command allows you to move Carlson points, one at a time by selecting any part of the point. Each Carlson point is made of three entities: a POINT entity, a symbol, and a point attribute block with the point number, elevation and description. This routine updates the X,Y of the point and not the Z. To update the elevation, use commands such as **Edit Point Attributes** or **Translate Points**. All these parts of the point are moved together with this routine. Any point moved using this command will result with the original source coordinate file (which is not necessarily the current coordinate file) updated with the new position of the point. Setting the **Link Points** with **CRD File** from Carlson Configure->>General Settings is not necessary because the coordinate file is always updated since the Move Points command has built-in smarts to lookup the coordinate file for the selected point entity. The **Link Points** settings applies to generic CAD commands like the regular Move command.

**Pulldown Menu Location:** Points  
**Keyboard Command:** mpnt
Coordinate Transformation

Transforms coordinates between local, State Plane 27, State Plane 83, Latitude/Longitude, Universal Transverse Mercator (UTM) and many other projections, including regional and user-defined projections. This works on individually entered coordinates, by range of point numbers and with on-screen entities. For converting between State Plane 27 and 83 within the USA, Carlson calls upon NADCON from the National Geodetic Survey to apply the Latitude/Longitude adjustment. Converting between NAD27 and NAD83 for Canada is supported using NTv2 grids.

The Transformation Type is used to define the Source Coordinate and Destination Coordinate formats. Settings for Lat/Long Datum, Lat/Long formats (dd.mmss or dd.dddd), Projections, State Plane Zones and coordinate units are defined in the Transformation Type dialog. The format of this dialog will change depending upon the type of transformation requested.

For Grid to Grid transformations, the program converts between state plane projections as well as other pre-defined and user-defined. When converting between pre-defined/user-defined projections, the program automatically converts the source grid coordinate to latitude/longitude and then to the destination grid coordinate. This method of using latitude/longitude works for converting between projections that share the same datum.

Example Lat/Long to Grid dialog

For all Transformation types, there are three options for inputting the data to be transformed. Data can be selected from the screen by using the Screen Entities. If a range of points or a particular point is desired, the Point Numbers option would be used. Manual entry of coordinates to transform one at a time is accomplished with the Enter Coordinates option. The coordinates can be typed in or use the Input Point Number option. Output Point Number is an option to store the results in the coordinate file.
For all transformations there are two output options when using point numbers as the input data. Overwrite Existing Coords replaces the original coordinate values with the new coordinate values after transformation. **New Point Numbers** will retain the original coordinate data and point numbers and create new point numbers with the revised coordinate data after transformation.

When transforming a **Local Coordinate System**, there are three options for defining the transformation as shown in the next dialog.

The Enter Transformation Parameters method prompts for the translate, rotate and scale parameters. The Base X and Y are used for the rotation and scale. The Load and Save functions store and recall the parameters to a .DXY file.

The **Align by Two Pairs of Points** option uses two pairs of source and destination coordinates. The first pair defines the translation as the difference between the source and destination northing and easting.
This destination point is also the pivot point for rotation. Rotation can be entered directly or defined by a second pair of points where the bearing between the first and second source points is rotated to align with the bearing from the first and second destination points. There is an option to also apply scaling. The scaling holds the angle between points and adjusts the distances by the scale factor. The scale factor is calculated for each point as the elevation factor at the first source point times the grid factor at the first destination point averaged with the elevation factor at the transform point times the grid factor at the transform point.

The **Least-Squares Best-Fit** option is used when there are more than two pairs for translation points. Since two pairs of points are sufficient to define the translation and rotation, more than two pairs of points provides more than enough information.

Over **Determination by Plane Similarity** is used to find the least squares best fit transformation for all the given source and destination points. Besides doing a translation and rotation, this option will also scales the points during the transformation. The **Rigid Body Transformation** also does a best fit least squares transformation, but applies
The **Helmert 7-Parameter** method can also be used for local transformations. The 7-Parameter Values can be calculated from control points or entered by the user. The program uses the Helmert Transformation, Strict formula:

\[
[X_t \ Y_t \ Z_t] = [dX \ dY \ dZ] + M * R * [X_s \ Y_s \ Z_s]
\]

where \( R \) is the rotation matrix.

The Transformation Type chooses between doing a 2D transformation and 3D transformation. For the 3D transformation, the program transforms the x/y using the same method as the 2D transformation, and the z is transformed using an elevation difference model that is modeled by either a best-fit level plane or tilted plane as set by the **Vertical Transformation** setting.

The **Add** button is used to define the source and destination coordinates for the points that define the transformation. Pressing this button brings up the following dialog box.

![Add Alignment Point dialog box](image)

The **Edit** button is used to edit existing data.

The **Delete** button removes the source and destination pairing from the transformation setup.

The **Process On/Off** button allows source and destination pairings to be turned on and off. This is useful when wanting to inspect different results using different pairings.

The **Optimize** option chooses which point pairings would yield the best transformation results by turning off the processing of pairings with higher residuals. This minimizes the average residual for the control points.

The **Report** option displays a report of the transformation point pairings, their residuals, processing status, transformation scale and avg. residual.

The **Load** and **Save** options allow for saving and recalling local coordinate transformation pairings and settings.

Pulldown Menu Location(s): Points

Keyboard Command: cfutransform

**Prerequisite:** Drawing entities or coordinate points

**Edit Point Attributes**

This command will edit the attributes of a Carlson point, such as the symbol type, point number, elevation and description. When this command is invoked, the command line will prompt the user: **Select point to edit (Enter to end)**. At this point, you can select any part of the point including the symbol, elevation, point number or the...
The dialog has several tabs. On the General tab, the name of the coordinate file for the point is displayed at the top along with any point groups that contain this point. The Elevation Decimals setting for the point elevation label. Both Drawing Description and CRD File Descriptions are displayed. When a change to the Drawing description is made, this change will not be reflected in the coordinate file. This allows the change of a description that is defined in the Field to Finish (fld) table for a particular code. If a change is made in the CRD File description, it will be reflected in the coordinate file. Take note that if the CRD file description is changed, running Field to Finish will change the definitions for the point changed. If you change the point number to a number that already exists in the current CRD file, and point protect is ON, you will be prompted whether to overwrite or renumber. The Non-Surface toggle controls whether this point is filtered out in surface modeling with Triangulate & Contour. This Non-Surface setting is the same that the Non-Surface Points routines use in the 3D Data menu. The properties that you modify, with the exception of Drawing Description, will update the current CRD file. All modifications will update the point screen entities. Edits to the elevation and Non-Surface setting will update any triangulation surface created by Triangulate & Contour that used the point for input.

To change the symbol, go to the Symbol tab and either type in a new symbol name in the edit box, or choose the
Symbol or Set button where you can choose from a list of symbols from the Symbol Library.

On the Notes tab, you can edit notes for the point. These notes are free-form additional descriptions for the point.

On the GIS tab, you can edit GIS attributes for the point. These GIS attributes are only available for CRDB format coordinate files. See the GIS Data section of the manual for more information on the CRDB GIS data.
The Image tab shows any images assigned to the point. The Open function will open the image in the image program set in Windows for the image file type. The Add and Remove functions are to add and remove images assigned to the point. The Next and Previous buttons are for selecting different images when the point has multiple images.

The Settings tab has a control for the number of decimals to use in the dialog.

Selecting the Point History button will bring up another dialog box that displays the point history of the point chosen. A history of the point will be listed, but only if, under General Setting, the Maintain CRD History File had been set to ON (selected) for the coordinate file that you are working with. With the CRD History feature of Carlson, all point changes can be rolled back.

You may also choose to use the CAD DDATTE command to change the attributes of a point. If you do this, then the CRD file will not be updated and if you change the elevation attribute, the point will not change its current Z location.

**Pulldown Menu Location:** Points  
**Keyboard Command:** editpnt  
**Prerequisite:** Carlson points

### Edit Multiple Pt Attributes

This function allows you to modify the properties of multiple point attributes at the same time. This command gives you complete control over the Carlson point attributes that are present in the drawing. Changes can be made to each attribute – the point number, elevation, description or symbol – all in one motion. For example, you could rotate the elevation text of some points to 45 degrees, change the height of the description text for all the points in the drawing, or change the layer for a particular attribute. Once this command is chosen, the entry Edit Multiple Points dialog, a smaller box, appears. Here you can determine your point selection method. There is also an option for description matching.
After the selection of the points to change, click OK, and the subsequent, larger Edit Multiple Points dialog boxes will appear. The number of points selected will be shown at the top of the dialog boxes.

**Edit Multiple Points dialog**

For each attribute, you can change any number of the properties, including the layer, height and rotation. These dialogs will reflect the current status of each attributes properties. If, for example, you select 10 points, and 5 of them have the elevation rotation set at 45 degrees, and the other 5 are set at 0 (zero) degrees, then the rotation edit field will say *varies* to let you know that the properties of the points you selected are not the same. Here is an example of the dialog box.

The **X location** refers to the distance in the X direction from the center (or insertion point) of the point symbol. The **Y location** refers to the distance in the Y direction from the center (or insertion point) of the point symbol.

The **Layer** refers to the layer of the individual attribute, not the entire attribute block. To change the layer of the entire attribute block, use the **Attribute Block Layer** option. The **Height** is expressed in real units (generally feet or meters), not plotted size. The **Rotation angle** is expressed in absolute decimal degrees. The **Color** can be set ByLayer or to a specific color. The **Point Entity Layer** refers to the layer that the node of the point resides. The required layers can either be typed in manually, or the Select button can be used to pick from the existing layers in the drawing. If a new layer is desired, simply type in the name of the new layer and it will be created automatically. Use the layer property manager to edit the properties of this new layer, if required. The **Visibility** setting allows for attributes to be shown or hidden in the drawing.
To change a point symbol, check on the **Symbol** tab and use the select button to choose the desired symbol. On the Point Entity tab, the **Attribute Layout ID** refers to the attribute layout style defined in Point Defaults or Field to Finish code definitions. This option allows you to change the particular layout with one of the other available styles or to a customized style if defined. The Pick buttons allow you to pick two points to define a distance (or angle in the case of Rotation). If you want to select a line to define a distance or angle, select two points on the line with the appropriate OSNAP.

Select the attribute to edit, make the necessary changes to this attribute and then move on to the next attribute if required. Changes made to the attributes are remember individually, which allows for switching back and forth though the attributes until the command is completed. After completion the new settings for the point attributes will be retained until changed or redrawn on the screen.

The **Sync Layer/Height** function sets the layer or height for some or all the attributes. The layer and height can be entered manually or pick an existing attribute to get the value. The **Save** and **Load** functions are a way to store and recall all the point display settings to a .PT file for having different point styles to reuse or share.

**Example sequential use of Edit Multiple Points dialog**

Again, the number of points selected will be shown in the dialog title. Let's now define the changes for each attribute individually. In the following example, suppose we want to rotate the elevation text to a 45 degree angle, move the description to the right and change the symbol. First, click on the Elevation for the Attribute to Edit. Now, select the Rotation option and type in 45. The dialog box should be as below.

Now, select the Description option for the Attribute to Edit. Select the X location from the Items to Change. Enter 1.50 in the box. This value makes the description line up better with the rotated elevation. The dialog should be as below:
Now, for the final change, select the Symbol for the Attribute to Edit. We want to actually change the point symbol. To do this, toggle on the option to change the symbol by clicking in the box beside the word Symbol. Next, press the Select button and select symbol SPT5. The dialog should be as below:

![Edit Multiple Points Dialog]

At this point we are ready to select the OK button to perform the changes. The following image shows the points before and after the changes.
Before and After Changes

**Move Point Attributes Single**

This command allows the user to move Carlson point attributes (including the point number, elevation or description) one at a time.

**Prompts**

Select Point Number, Elevation, or Description to Move: *select point attribute*

Pick new location: *pick point*

Pick new angle: *pick new angle or press Enter*

**Move Point Attributes with Leader**

This command allows you to move Carlson point attributes (including the point number, elevation or description), and to draw a dynamic leader to the point node. Leaders and arrowheads may be customized by selecting Options at the command line. The attributes are always justified left or right depending on which side the leader starts. If you redraw a point with Draw-Locate Points or Field-To-Finish, the program will recall the moved attribute location to redraw the attributes in the same location as long as the point coordinate is the same.

**Prompts**

Select Point Label to Move (O for Options, R for Restore): *select point attribute*

Pick label position: *pick point*

Select another Point Label to Move (O for Options, R for Restore, Enter to End): *O*
**Minimum Leader Length Scaler**: Specifies the minimum length, in terms of multiples of the attribute block's height, that the leader must be.

**Prompt for Curved Leader Points**: This option prompts for additional leader points and creates a smooth leader that goes through all the leader points.

**Draw Horizontal Leader Tick**: Specifies whether or not to draw a terminating tick (a short horizontal line segment sometimes referred to as a "hook line").

**Draw Arrowhead**: Specifies whether or not to draw an arrowhead at the end of the leader that points to the point entity.

**Minimum Leader for Arrow Scaler**: Specifies the minimum length of the leader, in terms of multiples of the attribute block's height, that the leader must be before an arrowhead is placed on it.

**Arrow Size Scaler**: A scale factor to apply to resize the arrowhead symbol.

**Leader Offset Scaler**: A distance indicating the desired offset from the point node to the tip of the leader.

**Use Separate Leader Layer**: Specifies whether or not to use a layer other than that of the identified point for the leader. Use the `Select` button to choose an alternative layer for the leader.

**Point Name Order, Elevation Order and Description Order**: These settings control the sequence of the attributes for the leader.

**Select another Point Label to Move (O for Options, R for Restore, Enter to End)**: R

**Select Point Label to Restore**: `pick label`

**Pulldown Menu Location**: Points

**Keyboard Command**: `movepntleader`

**Prerequisite**: Carlson points

---

**Resize Point Attributes**

This command sets the size of the selected point attributes (point number, elevation, description) and point symbols. This command is similar to Scale Point Attributes, but instead of scaling the size by a factor, all the select points are set to the same specified size. Points can also be chosen based upon Point Groups.

**Prompts**
Enter point attribute and symbol size <4.0>: press Enter
Scale symbols only, point labels only or both [Symbols/Labels/<Both>]? press Enter
Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter
Select Carlson Software points.
Select objects: pick the point entities
Finding Carlson Software Point Attributes ....
Number of entities changed > 10

Pulldown Menu Location: Points
Keyboard Command: sizepnt
Prerequisite: Carlson points

**Erase Point Attributes**

This command allows you to erase point attributes like the number, elevation or description individually by picking on the attribute to erase.

**Prompts**

Select Point No., Elev, or Desc to Erase: select point attribute

Pulldown Menu Location: Points
Keyboard Command: erasepnt
Prerequisite: Carlson points

**Twist Point Attributes**

This command will rotate the orientation of the text of Carlson point attributes (point #, elevation, description) and/or point symbols. The Twist Screen option aligns the point attributes to appear horizontal in the current twist screen. The Azimuth option allows you to enter an azimuth or pick two points to align the point attributes. The Entity Segment option aligns the point attributes by the selected line or polyline segment in the direction the entity is drawn. The Follow Polyline option aligns the point attributes by the polyline segment that is closest to the point.

**Prompts**

Twist by [<Twist screen>/Azimuth/Entity segment/Follow polyline]? F for follow
Attributes to twist [<All>/Symbol/Name/Elevation/Description]? press Enter
Select reference polylines to follow.
Select objects: pick a polyline
Select points from screen, group or by point number [<Screen>/Group/Number]? select Enter
Select Carlson Software points.
Select objects: pick the Carlson point inserts
Fix Point Attribute Overlaps

This command is to be used to adjust point attribute labels to avoid overlapping labels. It applies adjustment methods based upon user-specified ordering and tolerances. The command steps you through any remaining overlaps in an Overlap Manager, which includes the capability to manually move labels. This point overlap feature is also available within the Draw-Locate Point and Field To Finish commands.

Methods: There are different methods of automatically solving a point attribute overlap. The methods will be applied in order from top to bottom on the Used Methods list. Unused methods appear on the Available Methods list. The methods are:

Alternate Layout ID 0-9
These methods will simply apply the specified attribute layout ID and then check to see if the attributes of the point in question still overlap. The different attribute layout IDs can be seen in the Point Defaults command on the Points menu.

Flip Individual Attributes
This method tests each attribute (point #, description, and elevation) by flipping it or mirroring it the other side of the point. The mirror is the vertical axis of the text that goes through the point entity. This method is not applied to points that have a leader.

Slide Individual Attributes
This method tests each attribute (point #, description, and elevation) by sliding it back and forth. The maximum distance the attribute will be moved is the horizontal length of the text. This method is not applied to points that have a leader.

Rotate (If Only One Attribute)
This method is applied if there is only one point attribute, either point #, description, or elevation. The one attribute is rotated around the point entity to see if the point overlap can be fixed.

Offset Attribute Block
This method is arguably the most powerful method and can solve any overlap by moving the attribute block far enough. See Offset Options below for a description of the options that can be used with this method.

**Offset Options:** These are the options that apply to the Offset Attribute Block method of automatically solving point attribute overlaps.
- Maximum Offset Scaler: This specifies the maximum distance, in terms of multiples of the whole attribute block's height, that the attribute block may be offset from the point entity.
- Use Leader: Specifies whether or not a leader should be drawn when offsetting the attribute block.
- Minimum Leader Length Scaler: Specifies the minimum length, in terms of multiples of the height of an attribute's text, that the leader must be.
- Draw Arrowhead: Specifies whether or not to draw an arrowhead at the end of the leader that points to the point entity.
- Minimum Leader for Arrow Scaler: Specifies the minimum length of the leader, in terms of multiples of the height of an attribute's text, that an arrowhead can be placed on it.
- Arrow Size Scaler: Specifies a scale factor to be applied to control the size of the arrowhead if drawn.
- Leader Offset Scaler: Specifies the length, in terms of multiples of the height of an attribute's text, that the leader arrowhead should be offset from the point.
- Use Separate Leader Layer: If enabled, allows the user to define a different layer on which to place the resultant leader.

**Use Selection Set for Points:** Check this checkbox to be given the option of selecting which points in drawing to fix overlaps with. If not checked, all points in the drawing are used.

**Avoid Linework Conflicts:** Check this checkbox to prevent point attributes from overlapping linework in addition to other point attributes.

**Review Remaining Overlaps:** Check this checkbox to have the Overlap Reviewer dockable dialog come up after the automated process finishes. The Overlap Reviewer allows for reviewing the automated fixes as well as tools for manually fixing any remaining overlaps. See Overlap Reviewer below for more information.

**Skip Resolved Overlaps:** Check this checkbox to skip overlaps that were automatically resolved and to only review unresolved overlaps. If not checked, both resolved overlaps and unresolved overlaps will be available for review. This option only applies if Review Remaining Overlaps is on.

**Overlap Reviewer**
The Overlap Reviewer will come up after automatic overlap fixing if the Review Remaining Overlaps checkbox was checked. This tool displays how many points were found, how many overlaps were fixed, which overlap is
currently being viewed, how many overlaps there were total, and the point # of the current overlap. Use the First, Last, Back, and Next buttons to navigate forwards and backwards through the list of overlaps. Use the Move Block and Move Attrs buttons to manually move either the entire attribute block or individual attributes.

**Pan and Zoom Controls:** Use the buttons on the top to help zoom in and out and pan the drawing around. You can also use the standard mouse controls for panning and zooming.

**First, Last, Back, and Next:** These buttons allow you to step through each overlap or to jump to the first or the last.

**Status:** This drop-down list indicates the status of the current overlap. *open* means that the overlap has not been fixed yet. *resolved* means that the overlap has been fixed. *ignore* can be chosen by you to remove the overlap from the list.

**Restore:** Restores the attributes of the current point to their original location and rotation from before the Fix Point Attribute Overlaps command was run.

**Move Block:** Allows you to move one or more attribute blocks in the drawing. See the documentation for *Move Point Attributes with Leader* command in the Points menu.

**Erase Attrs:** Allows you to erase selected point attributes.

**Move Attrs:** Allows you to move and rotate one or more individual attributes in the drawing. See the documentation for *Move Point Attributes* command in the Points menu.

**Auto-Zoom:** Check this checkbox to automatically zoom and pan the view as each overlap is viewed.

**Prompts**

The following prompt will be displayed if the Use Selection Set for Points checkbox is on and OK is pressed. **Select the points to fix overlaps with:** *pick the Carlson point inserts*
Point Utilities

Coordinate Cloud

The Coordinate Cloud command (not to be confused with the Carlson Point Cloud module) is an Internet/cloud-based routine designed to easily facilitate storing and sharing coordinate point information either publicly or privately.

Prior to using the coordinate cloud command, the user must have created a Carlson Cloud account.

Upon launching Coordinate Cloud, the user is challenged to provide login credentials as shown below:

- **Account Sign Up**
- **Account Options**

**Username:** Supply the user name (Case Sensitive) that you used when creating your Carlson Cloud account.

**Password:** Supply the password (Case Sensitive) that you used when creating your Carlson Cloud account.

**Remember Me:** When enabled, the last used *Username* and *Password* values are recalled for the next Carlson Cloud login session.

**Forgot Password:** Use if you have forgotten your password and need it emailed to you or reset.

Once logged in, refer to the Carlson Cloud - Logged In discussion.

The *Account Sign Up* command provides the ability to create a new user account and associate the user account with a "company key" (essentially, a group of people with whom you wish to network within Carlson Cloud). *See the Carlson Cloud command for more information*
**Username:** Supply the user name (this will be Case Sensitive) that you will want to use for your Carlson Cloud account.

**Password:** Supply the password (this will be Case Sensitive) that you will want to use for your Carlson Cloud account.

**Email:** Supply an Email address where password recovery instructions can be sent.

**Optional Information:** Supply your name, company, location, phone and additional description

**Create Company Key:** When enabled, this toggle permits you to create a new company "profile" (or communication group).

**Existing Company Key:** Indicate the name (Case Sensitive) of an existing company "profile" to which the new member should belong.

Read and agree to the **Terms of Use**

**Sign Up:** Click this button when complete

**Show Public Points:** When enabled, all points designated as public will be shown.

**Search by Distance:** Will control the search area by zip code, or distance in miles.

**Select CRD File:** Use this to select a coordinate file from which to upload point data.

**View:** Highlight a point from the display list and view the detailed information
Download: Download the point data into the current coordinate (CRD) file.

Upload: Upload point data from the current coordinate (CRD) file.

Export to Google Earth: Export the point data to Google Earth

Pulldown Menu Location: Points->Point Utilities
Keyboard Command: crdcloud
Prerequisite: Internet connection, Carlson Cloud account

Search Point Files
This command searches for a point number or description in coordinate and raw files in a folder. The program also searches in all sub-folders of the selected folder. The command reports all files that found a match.
**Pulldown Menu Location:** Points > Point Utilities  
**Keyboard Command:** ptsearch  
**Prerequisite:** None

### Geoid Utilities

This command has functions for using a geoid with points in the current coordinate file.  
**Report:** Reports the geoid heights at the points.  
**Add Geoid:** Adds the geoid heights to the point elevations.  
**Subtract Geoid:** Subtracts the geoid heights from the point elevations.  
**Switch To Target Geoid:** Allows you to adjust the point elevations to switch from one geoid to another. The geoid used with the original point elevations is specified as the Source Geoid, and the geoid to switch to is set by the Target Geoid.

**Pulldown Menu Location:** Points > Point Utilities  
**Keyboard Command:** geoid_util  
**Prerequisite:** Points in coordinate file

### Trim by Point Symbol

This command will trim lines and polylines that pass through the selected point symbols such that the lines do not appear within the symbol. This should be a last step because this routine explodes the points and modifies the lines and polylines by trimming which makes these entities unusable by some of the other COGO routines.

**Prompts**

*Select Carlson Software point symbols to trim against.*  
**Select objects:** select the point symbols
Before Trim by Point Symbol

After Trim by Point Symbol

**Pulldown Menu Location:** Points  
**Keyboard Command:** trimpts  
**Prerequisite:** Carlson point symbols

---

### Change Point Layer Color

This command changes the layer and optionally the color of Carlson points. The points are initially put in the layer set in Point Defaults. The symbol, point number, elevation and description are in the layers PNTMARK, PNTNO, PNTELEV, and PNTDESC. To change the point attribute colors, this routine creates new attribute layers based on the new layer name. For example if the new layer name was TRAV, then the resulting layers would be TRAVMARK, TRAVNO, TRAVELEV and TRAVDESC. These new layers can be given different colors. To select an attribute color, pick on the color button. To permanently change attribute colors, edit the drawing SRVPN01.DWG in the Carlson SUP directory. To permanently change a symbol color, edit the symbol drawing itself.
The selection of the points to change can be accomplished in three ways. A number range selection would require the input of the range of points to change. An example would be 1-20,25,30, 32-36. Points groups can also be used as a selection method. Simply specify the point group name to change, when prompted, and all the points included in that group will be changed. The final selection method is that of Pick Points. Using this method a prompt to select objects is displayed. When prompted select the points to change from the screen.

**Pulldown Menu Location:** Points  
**Keyboard Command:** pntchg  
**Prerequisite:** Carlson points displayed in the graphic drawing window

### Link Linework With Points

This command links lines and polylines with points so that the linework updates if the points are updated. This link is the same as option under Carlson Configure > General Settings. The option in Configure is applied when the linework is created. This separate link command allows you to add links on selected linework in case the Configure link option was off when the linework was created.

In order to link points to the linework, the program matches points from the current coordinate file to the linework vertices. The Vertex Tolerance is how close the coordinate point needs to be to the linework vertex to create a link.

To remove point links, run File > Drawing Utilities > Remove Reactors.

### Prompts

**Enter Point to Vertex Tolerance \(<0.001>\):** press Enter  
**Select Lines and Polylines to Create reactors for.**  
**Select objects:** pick the linework

**Pulldown Menu Location:** Points > Point Utilities  
**Keyboard Command:** linkline  
**Prerequisite:** Points and linework

### Renumber Points

This command edits point numbers. This function is also in Coordinate File Utilities. The points to renumber can be selected by point number range, point group, the area inside a closed polyline or by selecting points from the drawing. The Description Match is a way to filter which points to renumber. The Condense Points option removes any gaps in the point numbers to make the renumbered points sequential. There are five renumbering methods:

- **Begin Renumbering From:** Points are numbered starting from the specified point number.  
- **Increment Point Number By:** Adds this number to the existing point numbers.  
- **Add Point Number Prefix:** Adds this string to the start of the existing point numbers.  
- **Add Point Number Suffix:** Adds this string to the end of the existing point numbers.  
- **Along Alignment:** Sequences the point numbers in station order along a centerline.
Pulldown Menu Location: Points > Point Utilities
Keyboard Command: renumpnt
Prerequisite: Coordinate file

Convert Point Format

Explode Carlson Points

This command can be useful if you need to send your drawing to another firm who does not have AutoCAD/Carlson. Drawing transfer problems occur when the recipient does not have the same block/inserts defined or available. This command explodes all blocks and replaces the Carlson point attributes with TEXT entities of the same value. After the points have been selected, a prompt for the layer name for each point attribute will be displayed. Point Numbers, Point Elevations and Point Descriptions can be put on user specified layers, or the default for each prompt can be selected. Caution: After using this command, the link between the points and the coordinate file are destroyed and you can no longer extract the attributes from the drawing. If you want to use this command but retain your point information, follow these steps:

1. Save your drawing
2. Run this command to explode the points
3. Execute the SAVEAS command and save the drawing as a different name (you can also choose DXF format if you wish).
4. Exit the drawing without saving.

Prompts

This command will explode selected Carlson Software point blocks and replot the attributes as Text entities! The resulting points will NOT be useable by most Carlson Software commands!!!!
Select Carlson Software Points to Explode. select points
Layer Name for Point Numbers <PNTNO>: press Enter
Layer Name for Point Elevations <PNTELEV>: press Enter
Layer Name for Point Descriptions <PNTDESC>: press Enter
Number of entities changed > 345

Pulldown Menu Location: Points
Keyboard Command: explode, scad
Prerequisite: Carlson points

---

**Convert Surveyor1 to CRD**

This command will convert a Surveyor1 coordinate file to the current Carlson format.

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: SURVEYOR2CRD
Prerequisite: A Surveyor1 coordinate file

---

**Convert CRD to TDS CR5/Convert TDS CR5 to CRD**

These commands convert coordinate file formats between a Carlson CRD file and a TDS CR5 file. Both of these file formats are binary which require these special routines. These commands will prompt for the file names to process.

Pulldown Menu Location: Points
Keyboard Commands: crd_crd, cr5_crd
Prerequisite: A CRD or CR5 file

---

**Convert CRD to Land Desktop MDB**

This command converts a Carlson CRD file into an Autodesk Land Development Desktop (LDD) point database file in Access MDB format. The LDD point database always has the file name of POINTS.MDB. So, to specify the LDD file to create, you only need to specify the directory/path and not the file name. This path corresponds to the LDD project directory. The conversion program has point protect, so that if a point number from the CRD file already exists in the LDD file, you then will be prompted to skip or replace the point. Once the command is executed, the following dialog is displayed. On this dialog, specify the Carlson CRD file to convert as well as the LDD (MDB) file to append, if existing, or create if creating a new LDD (MDB) file.

---

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: crd, ldd
Prerequisite: A .CRD file
Convert Land Desktop MDB to Carlson Points

This command converts an Autodesk Land Development Desktop (LDD, also referred to as LDT) point database file into a Carlson CRD file. The LDD point database always has the file name of POINTS.MDB and is stored in the LDD project directory. Once the command is executed, the following dialog is displayed. On this dialog, specify the LDD file to convert as well as the Carlson CRD file to append, if existing, or create if creating a new CRD file.

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: LDD_crd
Prerequisite: An LDD point database file

Convert Civil 3D to Carlson Points

This command converts Civil 3D point entities into Carlson format point entities. When running in AutoCAD, the Civil 3D Object Enabler from Autodesk is used to read the Civil 3D point entities. This object enabler must be installed before running this routine. The installation for the object enabler is located under Support at www.autodesk.com. When running in IntelliCAD, this routine uses a conversion program from the Open Design Alliance to read the Civil 3D point entities.

If you have Civil 3D, another way to make a drawing with standard AutoCAD entities is to use the aectoacad command in Civil 3D which converts the custom objects into standard entities.

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: c3d_crd
Prerequisite: Civil 3D points in the drawing

Convert Carlson Points to Land Desktop

This command converts a Carlson CRD file into a Land Desktop point file. To do this, you must specify the existing Carlson CRD points to convert. You have the option of selecting all points, or selecting on-screen the specific points you'd like to convert.

Prompts

Convert all or selected points [All/<Selected>]? press Enter
Select Carlson Software Points to convert:
Select objects: pick first point for window selection method
Select objects: pick second point
Processing Carlson Software point...

Chapter 10. Points Menu  533
Convert Land Desktop to Carlson Points

This command converts Land Desktop point entities into Carlson format point entities. The Land Desktop Object Enabler from Autodesk is used to read the Land Desktop point entities. This object enabler must be installed before running this routine. The installation for the object enabler is located under Support at www.autodesk.com. Be sure to match the version of the object enabler with the Land Desktop version used to create the drawing.

Prompts

Convert all or selected points [All/<Selected>]? all. Choose which points to convert.
Point position method [Insertion/<Database>]? press Enter. Choose between the drawing insertion points or the point database for the point locations.
Locate points on Real-Z Axis [Yes/<No>]? press Enter. Choose between creating the points at their elevation or at zero.
Convert point markers to symbols [<Yes>/No]? press Enter. Choose between using a point symbol or the PDMODE.

Convert Softdesk to Carlson Points

This command converts Softdesk point blocks in the drawing to Carlson point blocks. These point block formats are similar and converting only requires reordering and renaming the attributes. Softdesk points can also be read into the current CRD file by using the command Update CRD File from Drawing in Coordinate File Utilities, this updates the CRD file without modifying the screen entities.

Convert Carlson Points to C&G

This command converts a Carlson CRD file into a C&G Point file.
Specify the existing Carlson CRD to convert by selecting the Open Carlson CRD File button. Specify the existing C&G CRD file to write to, or the new C&G CRD file to create, by selecting either Open C&G CRD file or Create C&G CRD file. Press OK and the conversion is completed.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** crd2cg  
**Prerequisite:** A Carlson CRD file

### Convert C&G to Carlson Points
This command converts C&G Points into a Carlson CRD file.

Specify the existing C&G File to convert by selecting the Open C&G CRD File button. Specify the existing Carlson CRD file to write to, or the new Carlson CRD file to create, by selecting either Open Carlson CRD file or Create Carlson CRD file. Press OK and the conversion is completed.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** cg2crd  
**Prerequisite:** A C&G point file

### Convert Carlson Points to Simplicity
This command will convert Carlson points to Simplicity.

Select Carlson CRD file to convert by selecting the Open CRD file button. Specify the existing Simplicity file to write to, or the new Simplicity file to create, by selecting either Open Simplicity File or Create Simplicity File. Press Export and the conversion is completed.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** crd_zak
Prerequisite: A Simplicity point file

Convert Simplicity to Carlson Points
This command converts Simplicity Points into a Carlson CRD file.

Specify the existing Simplicity File to convert by selecting the Open Simplicity File button. Specify the existing Carlson CRD file to write to, or the new Carlson CRD file to create, by selecting either Open CRD File or Create CRD File. Press OK and the conversion is completed.

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: zak_crd
Prerequisite: A Simplicity point file

Convert Leica to Carlson Points
This command converts LisCad or Leica point blocks in the drawing to Carlson point blocks. These point block formats are similar and converting only requires reordering and renaming the attributes. Leica points can also be read into the current CRD file by using the command Update CRD File from Drawing in Coordinate File Utilities. This updates the CRD file without modifying the screen entities.

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: 2surv3
Prerequisite: Leica points

Convert Geodimeter to Carlson Points
This command converts Geodimeter point blocks in the drawing to Carlson point blocks. These point block formats are similar, and converting only requires reordering and renaming the attributes. Geodimeter points can also be read into the current CRD file by using the command Update CRD File from Drawing in Coordinate File Utilities. This updates the CRD file without modifying the screen entities.

Pulldown Menu Location: Points > Convert Point Format
Keyboard Command: 2surv4
Prerequisite: Geodimeter points

Convert Carlson Points to Ashtech GIS
This command converts Carlson point blocks in the drawing to Ashtech GIS point blocks. After executing the command, you will be prompted to select the points to convert. When using this command, the setting "Group Point Entities", found under General Settings of the Configure command (Settings menu) should be unchecked (turned
**Convert Carlson Points to Softdesk**

This command converts Carlson point blocks in the drawing to Softdesk point blocks. These point block formats are similar, and converting only requires reordering and renaming the attributes.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** 2soft  
**Prerequisite:** Carlson points

---

**Convert CAICE KCM to Carlson CRD**

This command converts a CAICE .KCM point database file to a Carlson CRD file.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** kcm2crd  
**Prerequisite:** CAICE KCM file

---

**Convert PacSoft CRD to Carlson CRD**

This command converts a PacSoft CRD file to a Carlson CRD file. PacSoft stores the point descriptions to a separate coordinate descriptor file having an extension of PTD. This file should be present in the same directory as the CRD file to convert. Prompts for the PacSoft CRD file to convert, and the Carlson CRD file to create, will be displayed. Once both files have been specified, the following dialog box will be displayed.

The **No Coordinate Conversion** option converts the file format while leaving the coordinate values unchanged.  
**Convert From Meters to Feet** will assume the coordinates in the selected PacSoft crd file are metric, and will convert the coordinate values to US Feet.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** pacsoft2crd  
**Prerequisite:** PacSoft crd file

---

**Convert Carlson Points to Eagle Point**

This command converts Carlson point blocks in the drawing to Eagle Point point blocks. A prompt for the Eagle Point version to convert to will be displayed.
Specify the appropriate version and then select the OK button. You will then be prompted to select the Carlson points to convert. These point block formats are similar, and converting only requires reordering and renaming the attributes.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** 2eds  
**Prerequisite:** Carlson points

### Convert Eagle Point to Carlson Points

This command converts Eagle Point point blocks in the drawing to Carlson point blocks. These point block formats are similar, and converting only requires reordering and renaming the attributes. Eagle Point points can also be read into the current CRD file by using the command *Update CRD File from Drawing*, found in *Coordinate File Utilities*. This updates the CRD file without modifying the screen entities.

**Pulldown Menu Location:** Points > Convert Point Format  
**Keyboard Command:** 2surv2  
**Prerequisite:** Eagle Point points
This chapter provides information on using the commands from the Survey pulldown menu, in order to download data from data collectors, process raw data and prepare plats. The first sections of the pulldown provide information on working with data collectors, editing and processing raw data and drawing Field to Finish. Carlson SurvNET is Carlson’s Network Least Squares Reduction (NLSA) program. Below that there are complex deed creation and linework commands. The bottom portion of this menu provides features for creating cut sheets, polyline data and other survey important requirements.
The Carlson Cloud command (not to be confused with the Carlson Point Cloud module) is an Internet/cloud-based routine designed to easily facilitate sending messages, data files and crew locations between the office and Internet-connected field devices running Carlson SurvCE or Carlson SurvPC.

Upon launching Carlson Cloud, the user is challenged to provide login credentials as shown below:

- **Account Sign Up**
- **Account Options**

**Username**: Supply the user name (Case Sensitive) that you used when creating your Carlson Cloud account.

**Password**: Supply the password (Case Sensitive) that you used when creating your Carlson Cloud account.

**Remember Me**: When enabled, the last used Username and Password values are recalled for the next Carlson Cloud login session.

Once logged in, refer to the Carlson Cloud - Logged In discussion.

The Account Sign Up command provides the ability to create a new user account and associate the user account with a "company key" (essentially, a group of people with whom you wish to network within Carlson Cloud).
Username: Supply the user name (this will be Case Sensitive) that you will want to use for your Carlson Cloud account.

Password: Supply the password (this will be Case Sensitive) that you will want to use for your Carlson Cloud account.

Phone: Supply your phone number.

Email: Supply an Email address where password recovery instructions can be sent.

Create Company Key: When enabled, this toggle permits you to create a new company "profile" (or communication group).

Existing Company Key: Indicate the name (Case Sensitive) of an existing company "profile" to which the new member should belong.

The Account Options of Carlson Cloud permits you to investigate and manage certain aspects of your Carlson Cloud account(s).

List Users Tab

Carlson Cloud can display the listing of users assigned to a specified Company Key.

Company Key: Supply the name of the unique Company Key established for your communication group.

Search: The list of users associated with the Company Key is returned.

Delete User Tab

Carlson Cloud accounts that are no longer needed can be removed from the Carlson Cloud service.
Username: Supply the user name (Case Sensitive) of the user that you will want to remove.

Password: Supply the password (Case Sensitive) of the user that you will want to remove.

Delete User: Clicking this button will remove Carlson Cloud account associated with the unique Username/Password combination.

Forgot Password Tab

Passwords that have been forgotten can be reset.

Email: Supply the Email address associated with the account whose password has been forgotten.

Forgot Password: Password recovery instructions are sent to the specified Email address.

Upon successful login to Carlson Cloud, the user is presented with the communication aspects of Carlson Cloud.

Chat Tab

While logged in to Carlson Cloud, it is possible to communicate with other Carlson Cloud accounts that belong to the same "Company Key" as that of the active logged in user.
Username Drop-list: Select the individual with whom you would like to chat.

Broadcast All: When enabled, all members listed in the Username Drop-list will receive your chat (and optional attachment) at their next login.

Message Area: The listing of communication chats (both current and received since the last successful login) will appear.

Chat Line: Supply a brief chat question or statement for the intended person or audience.

Send: Delivers the Chat Line content (and optional attachment) to the intended person or audience.

Attach: Specify a Carlson SurvCE, SurvPC or CSI Mobile compatible file (e.g. CRD, RW5, NOT, LOC, etc) that should be delivered to the intended person or audience.

Logout: Logs the active account out of the Carlson Cloud service.

**Crew View Tab**

Carlson Cloud permits the viewing of other crew members that can be helpful for site logistics and planning.
Crew to Show Drop-list: Indicate the crew members (if any) that should be shown:

- **Off** - No crew members will be shown.
- **Show All Users** - All crew members will be shown.
- **Show Users by Radius** - Crew members within a prescribed radius of a central Latitude/Longitude position will be shown.

**Latitude:** Indicate the central latitude.

**Longitude:** Indicate the central longitude.

**Radius:** Indicate the radius value in miles from the central Latitude/Longitude position to display crew members.

### Job Share Tab

Carlson Cloud permits the sharing of job data (*e.g.* field readings) with other Carlson Cloud members associated with the Company Key.

![Carlson Cloud Link](image)

**Job Name:** Specify the name as it appears (Case Sensitive) from the sending device (such as Carlson SurvCE).

![JobShare](image)

**CRD File Name:** Indicate the name of the Carlson Coordinate File that is to receive the job information. **Note:** This CRD does not need to be the same name as that used on the sending device.

**Accept New Data:** When enabled, incoming data will be permitted into the specified CRD File Name.

**Draw Points:** When enabled, incoming data will be placed into the drawing via the Draw-Locate Points command.
Note:

- When creating a "Company Key," consider a unique combination of your organization name with a portion of your phone number or postal code to help establish "uniqueness."
- When resetting a password, the "From" Email address will be from no-reply@parseapps.com. Please make sure you add this address to your "Safe Senders" list.
- The positions of crew members will only appear if the crew has enabled their "Allow others to view my position" toggle.
- The positions of crew members update about once every 5 minutes.
- While logged out of Carlson Cloud, any "chats" or data files sent to you are held in-transit until you next log into Carlson Cloud.

Pulldown Menu Location: Survey
Keyboard Command: ccloud
Prerequisite: Internet connection

Data Collectors

This command does two main functions for a variety of popular data collectors. First, this command transfers (uploads and downloads) data between the data collector and Carlson. Second, this command converts data formats between the data collector format and the Carlson format. So, if you already have the data file on the computer, you can skip the transfer function and just perform the conversion function.

The transfer function does the conversion at the same time. In most cases, the download from the data collector produces a raw (.RW5) file (field notes) and/or a coordinate (.CRD) file (coordinate points). Several of the download programs have an option to automatically run the Edit-Process Raw Data File command after downloading raw data. You can also send, or upload, a coordinate (.CRD) file. The dialog shown here appears when the menu command is selected.

Carlson SurvCE: For Carlson Software data collection programs SurvCE and SurvStar. This button produces the SurvCOM dialog and program.
Prepare Geoid for SurvCE: Creates a subset of a geoid as a .GSF file to load into SurvCE.
CG Field: For CG Field programs.
Surveyors Assistant: For data collectors running Surveyors Assistant software (Corvallis MC2, MC5 and Pentax SC5).
Sokkia SDR: For SDR2 through SDR 33 and other collectors that have a SDR format like the Trimble.
Sokkia G2: Specifically for the SDR2.
TDS: For data collectors that use TDS software (Ranger, HP48, HP95, Husky FS-2 & FS-3, Corvallis MC-V and TOPCON FS2, FC95 and FC48).
SMI: For SMI data collectors on the HP48.
Leica: For Leica GIF-10 module, GeoCOM for older Leica and DBX for newer Leica instruments.
Nikon: For Nikon DTM and DR-48 total stations.
Geodimeter: For the Geodimeter Geodat collector.
Topcon 210/310/220/GPT2000: Supports these Topcon models.
MDL Laser: For MDL Laser instruments.
General Kermit Transfer: For general transferring using Kermit.

Carlson SurvCE

Note: In the following text, the term SurvCE will apply to SurvCE, SurvStar, and Sokkia G2

Connect the serial cable. Select Data Transfer from the on the handheld. Choose Carlson/Carlson Survey Download. This leads to a File Transfer screen on SurvCE, which says "Awaiting Connection". All the action is on the PC side. There is no time delay in this handshake. It will wait for the PC program to catch up. When you connect the cable from SurvCE to the PC, Microsoft ActiveSync may interfere and say "Connect to PC?" If you get this question, say No or otherwise terminate the Microsoft ActiveSync linkage. Start the Carlson portion of this link by choosing Survey, Data Collectors, then the SurvCE option. If connection is automatically established, SurvCE will display, "Connected to PC".

If only the left side of the screen displays data, then you do not yet have a connection. Press the Connect button located at the bottom left of the file transfer dialog. The transfer program will respond with Retrieving File List. Once the file list has been retrieved, the left side of the dialog box will show files located in the specified path on the PC and the right side of the dialog displays the files located in the designated path on the remote. You can change directories by scrolling to the top of the file list and choosing Up One Level (just like in Windows).

To transfer one or more files, simply select or highlight the desired files and select the transfer button. More than one file can be transferred from the remote to the PC or from the PC to the remote during the transfer process. Standard Windows selection options apply. For example, selecting one file and then while pressing the shift key on the PC, selecting another file deeper on the list will select all the files in between the first and last selected. You can also select the first file to transfer and press and hold down the shift key and use the down arrow to specify the range of files to transfer. Pressing and holding the control key on the keyboard allows for the selection of multiple files in any selection order, by picking the files with the left mouse button.

After the files have been selected, press the transfer button. When the transfer is complete, the program will return a "Transfer Complete" message, and will then proceed to update the file lists on the PC and the Remote.
The following information describes the buttons on the bottom row of the SurvCOM dialog box. The button name is on the left in bold:

**Connect:** After selecting Data Transfer in SurvCE, press this button to start the connection. Once connection is made, the status line on the file transfer utility dialog box will show Connected to the remote machine.

**Transfer:** Pressing this button transfers selected files from either the Remote to the PC, or the PC to the Remote.

**Set Path:** This option allows for the specification of the desired source and destination drives and folders for both the PC and the Remote device. For example, if you were downloading, or copying files from the Remote device to the PC, to specify a source path on the remote device, select the Remote Machine toggle and then type in the desired path in the path field. To specify a destination path on the PC, select the Local PC toggle and type in the desired path in the path field. When a change to either path is made, the transfer utility will retrieve a new file list from the specified paths.

**Make dir:** This option allows for creation of directories on both the PC and the Remote device. Specify the hardware on which to create the directory and then enter the directory name.
Delete: This option allows you to delete the tagged files. To delete a file, select the file to delete by clicking on the file, press the delete button at the bottom of the dialog. Confirm deletion by selecting the appropriate response on the Delete File dialog.

```
Delete File

This file has not been downloaded since it was last modified. OK to delete? [Y/N]
```

Yes All | No All | Yes | No

Rename: To rename a file, click on the file to rename and select the rename button at the button of the dialog. On the dialog that displays type in the new name and press the OK button.

```
File Name to Rename to

Name: __________
```

OK | Cancel

Options: This command allows you to set various options for data transfer. The dialog shown below will appear.
Transfer Type: Choose USB for transferring over a USB cable. Choose 9-Pin for transferring over a 9-pin serial cable. Choose Ext Drive for transferring to another folder on your computer or a drive connected to your computer such as a USB storage drive or memory card.

Com Port: You must select which com port on the PC to use when using the 9-Pin transfer type.

If you are transferring data via a USB port, set the com port to ActiveSync, see the Options section below for procedures to change com ports. To transfer data using an USB port a connection between the Remote and PC using ActiveSync is required. In ActiveSync verify that the "Connect Settings" have been set to "Allow serial cable or infrared connection to this Com port" and Allow USB connection with this desktop computer. This will allow for connection using an USB port or a COM port connection. Both will use ActiveSync to transfer data between devices.
**File Mask:** You must select a file filtering syntax. This filter allows for the setting of specific file types to display. For example, if you only wanted to see CRD files, the filter would be *.CRD.

**Directory Sort:** You must select how to sort the list of files.

![Directory Sort](image)

**Display Special Files:** Toggle whether or not you should see special files.

**Confirm Overwrite:** Check this to confirm before overwriting files.

**Baud Rate:** You must choose the baud rate for transferring data.

**Protect Remote Files:** Check this to protect files on the mobile device.

**Archive RW5 Files:** With this option set to YES, when downloading rw5 files, a second copy of the file will be made with a .SC5 extension to serve as an archive of the original rw5 file.

**Geoid:** This command will carve out a portion of the Geoid 99, EGM96, Canadian CGC2000, Canadian HT2.0, Canadian HT 1.01, Australian GDA94, Great Britain OSG-MO2 and Geoid 2003 grid files, and send it to SurvCE. Since these geoid grids are very large, this carves out a precise portion of it and avoids overloading the memory on the remote device running SurvCE. You will be prompted for the directory on the PC of the source Geoid grid file, the approximate latitude and longitude of the job, and the size of the area desired in miles, kilometers or degrees of latitude and longitude. To define a Geoid area, make sure that this criteria is met:

1. Specify the location of the geoid grid files.
2. Specify the geoid type.
3. Enter the latitude and longitude near the center of the job area.
4. Specify the Grid size either in miles, km (kilometers), or deg (degrees).
5. Name the grid file.

The file will be transferred to the data collector and placed in the appropriate place for use.
**F2F conv:** This converts the more thorough and detailed Carlson field code file (for field-to-finish work, *.FLD) to the more simplified Feature Code List that runs in SurvCE (*.FCL). The Feature Code List in SurvCE (not SurvStar or Field) handles Linework (on or off), Line Type (2D or 3D), Layer (= Code) and Full Text (Description). Select the Carlson field code (*.FLD) to convert, the conversion takes place and the file is transferred and located in the correct location for use in the data collector.

**Send Pnts:** This option allows for the uploading of a user specified point number range out of the selected crd file to unload. Use the Select button to specify the crd file to upload. The Remote File Name will default to the name of the crd file selected to upload. You can change this name if needed. Specify the Point Range to Send and select the OK button.
Exit: This command will exit the File Transfer Utility

The following information describes the buttons on the Data Collection Programs dialog box that come after the Carlson SurvCE button, moving from left to right and then from top to bottom. The command/button name is on the far left margin, in bold:

**Prepare Geoid for SurvCE**

This function creates a .GSF (Geoid Separation File) for SurvCE from a built-in geoid. Most geoids are very large and this routine carves out a subset of the geoid by specifying a center position and area size. The geoid data files are not included in the regular install since they are so large. Instead, the program automatically downloads them as needed from the Carlson server. You can also install them separately by running the CarlsonGeoidGrids.exe from the Support->Other Downloads on www.carlsonsw.com.

**CG Field**

To transfer data to and from data collectors using CGField software, first make sure that the Baud Rate is set to 9600 and the Parity is set to NONE then follow the steps outlined below.

**Receiving a Coordinate File from CGField**

CGField:
1) Go to the UTILS menu and select Option 1, C&G Transfer.
2) Select Option 4, "Send Coords"
3) Select the Coordinate file to send.
Stop here in CGField and go to Carlson.

Carlson:
Leave the FILE fields blank.
Press the "Download Coordinates" button to ready Carlson to receive the file. Stop here in Carlson and go back to CGField to complete the transfer process.

CGField:

Select the points to send

1) For All points
2) To select Blocks of points.
3) From .PTS file (the set of points in a Batch Point File).

The coordinates will be transferred. After the transfer is complete, you will be asked for the CRD file name. The C&G CRD file will automatically be converted to a Carlson CRD file. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

Receiving a Raw Data File from CGField

CGField:

1) Go to the UTILS menu and select Option 1, C&G Transfer.
2) Select Option 2, "Send Raw Data". Stop here in CGField and go to Carlson.

Carlson:

Leave the FILE fields blank.

Press the "Download Raw" button to ready Carlson to receive the file. Stop here in Carlson and go back to CGField.

CGField:

Select the raw data file to be sent. The transfer will begin.
The C&G .RAW file will be transferred and saved in the data folder. After the transfer is complete, you will be asked for the RW5 file name. The RAW file will be automatically converted to a Carlson RW5 file.

**Receiving an ASCII file from CGField**

This will allow you to transfer a C&G report file (RPT) or an ASCII NEZ file to Carlson.

**CGField:**

1) Go to the UTILS menu and select Option 1, C&G Transfer.
2) Select Option 6, "Send ASCII". Stop here in CGField and go to Carlson.

**Carlson:**

Leave the FILE fields blank.

Press the "Download ASCII" button to ready Carlson to receive the file. Stop here in Carlson and go back to CGField.

**CGField:**

Select the ASCII file to send.

After the transfer is complete, you will see the file in the Carlson editor. You can then select FILE and SAVE (or SAVEAS) to save the ASCII file.

**Sending a Coordinate File to CGField**

**CGField:**

1) Go to the UTILS menu and select Option 1, C&G Transfer.
2) Select Option 3, "Receive Coords" to ready the data collector. Stop here in CGField and go to Carlson.

**Carlson:**

Leave the FILE fields blank.

1) Press the "Upload (Send Carlson File)" button.
2) Select the Coordinate file.
3) Select the points to send.
4) Press the "Start Transfer" button.

**CGField:**

Carlson will send the file name to CGField and a coordinate file with the same name will be automatically created or opened in CGField.

If the file exists you will be asked how you want to handle duplicate points:

1) Overwrite
2) Don't Overwrite
3) Ask for each Point

The point transfer will begin.

**Convert CG .RAW to Carlson .RW5**

This utility allows you to convert a C&G raw data file to a Carlson raw data file. Select the C&G .RAW file to convert. Then enter the file name of the destination Carlson RW5 file.

**Thales/FastSurvey** You will be taken directly to the SurvCOM dialog, similar to the Carlson SurvCE process.

**Surveyor's Assistant**
Download
From the Surveyor's Assistant data collector, go to the Transfer routine from the main menu. Fill out the transfer screen as follows:

Direction: OUTPUT  
Format: LIETZ  
Data: Coordinate or All Data  
Port: COM1 or COM2  
Chk Hold: NO  
Protocol: NONE

You should also check the settings under the PORT menu. Typical port settings are baud=9600, parity=none, data=8, stop=1 and handshake=XON/XOFF. Now in Carlson, run Data Collection in the Survey menu and choose Surveyor's Assistant. Check that the COM port and baud rate are set correctly. Then click the Download button and within 10 seconds go back to Surveyor's Assistant and press GO. The file transfer should now go. If the All Data option is used, then the Leitz format will contain both coordinate and raw data. The coordinate data is converted to a Carlson coordinate (.CRD) file and the raw data is converted to a Carlson raw data (.RW5) file. When the transfer is complete, the program will ask you for the Carlson coordinate (.CRD) file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

Upload
Point data from the Carlson coordinate (.CRD) file can be uploaded into the Surveyor's Assistant. First go to the Transfer routine on the main menu. Fill out the screen as follows:

Direction: INPUT  
Format: LEITZ  
Port: COM1 or COM2  
Protocol: NONE

Go back to Carlson and choose Surveyor's Assistant from the Data Collection command in the Survey menu. Check that the COM port and baud rate are set correctly. In the Carlson dialog, pick the Select File button next to the Carlson coordinate (.CRD) File edit box and choose the coordinate (.CRD) file to send. Then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Before clicking the OK button for range of points, go to the Surveyor's Assistant and hit the GO function key. The Surveyor's Assistant is now waiting to receive so return to Carlson and click OK on the range of point dialog. The file transfer should now go.
Sokkia SDR

This routine applies to the Sokkia SDR-20, SDR-22, SDR-31 and SDR-33 as well as other collectors that have SDR format transfer such as the Trimble and C & G.

Download

From the SDR data collector, go to the Communications routine from the main menu. Choose Data Format SDR. Next hit the Send function key. Then choose Select Jobs. From the list of jobs, highlight the job to transfer and set it to Yes with the arrow keys. Now in Carlson, run Data Collection in the Survey menu and choose Sokkia/SDR. Check that the COM port and baud rate are set correctly. Then click the Download button and within 10 seconds go back to SDR and press OK. The file transfer should now go. The SDR format contains both coordinate and raw data. The coordinate data is converted to a Carlson coordinate (.CRD) file and the raw data is converted to a Carlson raw data (.RW5) file. The original SDR transfer file is stored on the computer as a RAW file. When the transfer is complete, the program will ask you for the Carlson coordinate (.CRD) file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

The SDR-33 has different modes for storing and transferring data. In coordinate mode, the download will create points in the coordinate (.CRD) file and the raw data (.RW5) file will only contain some basic header lines. In the raw data mode, the download will create all the measurement data in the raw file and no points will be created in the coordinate (.CRD) file. For this raw data mode, you will need to run Edit-Process Raw Data File in the Survey menu to calculate the points from the raw data. The third mode in the SDR-33 creates both raw data in the raw data (.RW5) file and points in the coordinate (.CRD) file. The Include Time Stamps in Notes option sets whether all the date-time records for each point are put in the raw data (.RW5) file as description records. The Include Point Attributes in Notes option will store SDR code 13(AT) codes to the point note (.NOT) for the coordinate (.CRD) file.
Upload
Point data from the Carlson coordinate (.CRD) file can be uploaded into the SDR. First go to the Communications routine on the SDR main menu. Choose Data Format SDR. Go back to Carlson and choose Sokkia/SDR from the Data Collection command in the Survey menu. Check that the COM port and baud rate are set correctly. In the Carlson dialog, pick the Select File button next to the Carlson CRD File edit box and choose the coordinate (.CRD) file to send. Then click the Upload button. Then a Sokkia Options dialog appears for setting the job parameters for the file to be created on the collector. Be sure to choose the Distance Unit that matches your coordinate (.CRD) file (meters, US feet or international feet). Click OK and the next dialog now allows you to specify the range of point numbers to upload. Before clicking the Start Transfer button for range of points, go to the SDR and hit the Receive function key. The SDR is now waiting to receive so return to Carlson and click Start Transfer on the range of point dialog. The file transfer should now go.

Communication Settings
Besides matching the baud rate between Carlson and the collector, make sure that the collector is set to word length of 8 and 1 stop bit under the communication settings.

Print File
The Receive Sokkia Print File downloads a print report from the SDR33 data collector. This file is only used for printing report purposes in Carlson. This file is not used by Carlson to generate coordinate (.CRD) files or raw files. The first step is to choose Data format=Printed in the Communications menu of the SDR33. Next pick the Receive Print File button in Carlson. Then on the SDR33 choose the Send function and select a job to send. At this point the file is transferred. After downloading, the job report is displayed in the Carlson standard report viewer.

Example of Sokkia Printed Format:

SDR33 V04-04.25 (C) Copyright 1998 Sokkia May-29-80 23:39 01/29/1999
Angle Degrees  Dist Feet  
Temp Farenht  Coord N-E-Elev  
JOB TRAV  Point Id Alpha (14)  
Atmos crn No  C and R crn No  
Record elev Yes  Sea level crn No  
POS TP 1  North 10050.000  East 10000.000  Elev 0.000

Chapter 11. Survey Menu 557
Sokkia G2 This routine takes you directly to the SurvCOM dialog, similar to the Carlson SurvCE process.

TDS

Download [HP-48 and Husky]
In the TDS program, go to the File Transfer routine. Choose the type of data to transfer (CRD or RAW). Next pick the Send function key. Stop here on the TDS and go to Carlson to run Data Collection in the Survey menu and pick TDS. Make sure that the COM port and baud rate are set correctly. Then pick the Download button. The Carlson program will now wait to receive the TDS file. Within 10 seconds select the file to send on the TDS. The file should be transferred now. When the transfer is complete, the program will ask you for the Carlson file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

Download [Ranger and Windows CE]
In the TDS program, go to the Transfer routine and pick the Send File function. Set the "Connecting To" field to HP-48. Make sure that the COM port, baud rate and parity are set correctly and then pick OK. In the Type field of the file selection dialog, choose Coordinate Files or Raw Files. Stop here on the TDS and go to Carlson to run Data Collection in the Survey menu and pick TDS. Make sure that the COM port and baud rate are set correctly. Then pick the Download button. The Carlson program will now wait to receive the TDS file. Within 10 seconds select the file to send on the TDS and pick OK in the TDS dialog. The file should be transferred now. When the transfer is complete, the program will ask you for the Carlson file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.
Upload [HP-48 and Husky]
A Carlson coordinate (.CRD) file can be converted to a CR5 file and uploaded into TDS. Start in the TDS program, by going to the File Transfer routine. Then move back to Carlson and run Data Collection in the Survey menu and pick TDS. In the Carlson dialog, enter a TDS File name. This name should not include the drive and directory path or file extension. For example, if the coordinate (.CRD) file is \c:\scadxml\data\simo2.crd then the TDS File name could be just SIMO2. Next pick the Select File button next to the Carlson coordinate (.CRD) File edit box and choose the coordinate (.CRD) file to send. Check that the COM port and baud rate are set correctly. Now pick the Carlson Upload button. A dialog now allows you to specify the range of point numbers to upload. Enter the range of points but before clicking the Start Transfer button go to TDS and hit the Receive function key. Within 10 seconds go back and click the OK button on the range of points. The file should then transfer.

Upload [Ranger and Windows CE]
A Carlson coordinate (.CRD) file can be converted to a CR5 file and uploaded into TDS. Start in the TDS program, by going to the Transfer routine and pick the Receive File function. Set the "Connecting To" field to HP-48. Make sure that the COM port, baud rate and parity are set correctly and then pick OK. Then move back to Carlson and run Data Collection in the Survey menu and pick TDS. In the Carlson dialog, enter a TDS File name. This name should not include the drive and directory path or file extension. For example, if the coordinate (.CRD) file is \c:\scadxml\data\simo2.crd then the TDS File name could be just SIMO2. Next pick the Select File button next to the Carlson coordinate (.CRD) file edit box and choose the coordinate (.CRD) file to send. Check that the COM port and baud rate are set correctly. Now pick the Carlson Upload button. A dialog now allows you to specify the range of point numbers to upload. Enter the range of points and click the Start Transfer button.

SMI

Download
To send point data from the SMI data collector, go to the file transfer routine by typing [More] [NXT] [TOPC] [COMM]. In SMI version 6 or later, type [Job][KERM][SEND]. Also in version 6, make sure that the first function key reads [NE] and not [XY] in the [Job][KERM] screen. Otherwise the coordinate northing and easting will be reversed. The [NE] stands for North-East coordinate order which is the format that Carlson expects. Also in the [Job][KERM] screen, make sure that the second function key reads [COMM] and not [SPACE]. The [COMM] stands for comma separators. Then enter the first point to send followed by the last point to send but before pressing Enter for the last point go to Carlson. Run Data Collection in the Survey menu and choose SMI. Check that the COM port and baud rate are set correctly. Then click the Download button and within 10 seconds go back to SMI and press Enter for the last point to send. The file transfer should now go. When the transfer is complete, the program will ask you for the Carlson coordinate (.CRD) file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector. To send raw data, use the [Print][Raw] routine in SMI along with the same Carlson procedure used for point data.

Upload
From the SMI data collector, go to the file transfer routine by typing [More] [NXT] [TO48] [COMM]. In SMI version 6 or later, type [Job][KERM][RECV]. Also in version 6, make sure that first function key reads [NE] and not [XY] in the [Job][KERM] screen. Otherwise the coordinate northing and easting will be reversed. Then enter the first point to send followed by the last point to send. Next enter the job name but before pressing Enter go to Carlson and run SMI under Data Collection in the Survey menu. In the Carlson dialog, specify the same job name as entered in SMI. Next pick the Select File button next to the Carlson CRD File edit box and choose the coordinate (.CRD) file to send. Check that the COM port and baud rate are set correctly. Then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Enter the same range of points as entered on the SMI. Go back to SMI and hit Enter for job name followed by clicking the OK button for range of points in Carlson. The file transfer should now go.
Leica

There are three types of Leica transfers: GIF-10, GeoCom and DBX.

Choose newer Leica instruments, choose Leica DBX on first dialog. Then there is a choice between Import and Export.

For Import, select the folder that contains the Leica DBX data. Typically the Leica DBX data is on a memory card that is inserted into the computer and gets assigned a drive name by Windows. Use the Set button to browse to this Leica DBX drive or folder. Then the program shows a list of the Leica projects in that folder. The Import Measurements With Points function reads the Leica data into Carlson CRD and RW5 files. The Import Points Only reads the Leica data into a Carlson CRD file and brings in attribute data to the Carlson NOT file. The Import GPS Points function imports the Leica data into a Carlson RW5 file for GPS measurements.
For Export, select the folder to store the Leica DBX data to using the Set button. Enter in a job name for the new job in the Leica Job Name edit box. There are three types of project data that can be exported. The Points export converts a Carlson coordinate file to Leica format. The Road export converts Carlson profiles and centerlines to Leica format. The Surface export converts a Carlson TIN file to Leica format.

For GIF-10 and GeoCom, choose All Others on the first dialog. Then the choice for GIF-10 or GeoCom is set in the Equipment Type field on the main dialog. For transferring with the Leica instruments, the GeoCom program shows a dialog of the available COM ports on your computer. On the first time that you transfer to an instrument, you will need to pick the Instruments button and register the instrument from the list. Pick the Port Settings button to make sure that the communication settings match the instrument.
To download a file with GeoCom, make sure that the instrument is ON and connected to the computer by serial cable. The instrument also needs to be in GeoCom mode. Then pick the Download in the Carlson dialog. In the GeoCom program, open the computer COM port that the instrument is connected to by picking the ‘+’. Then open the Memory Card and GSI folders. Next select the file to transfer and click the OK button. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

To upload a file with GeoCom, specify the file name to be created on the instrument in the Leica File field and pick the Upload button in the Carlson dialog. Then the program will prompt for the range of points to transfer. Fill out the range and pick the Start Transfer button. Then the GeoCom program will start. Open the computer COM port by picking the ‘+’. Then open the Memory Card folder and highlight the GSI folder and click OK.

The upload and download file transfer works with the GIF-10 data collector. The GIF-10 communication settings should be the following:

- **Baud**: 9600
- **Parity**: NONE
- **Protocol**: NONE
- **Stop Bit**: 1
- **End Mark**: CR/LF
- **Connected As**: Some computers use DCE and others use DTE

### Download

From the GIF-10, go to the file transfer routine. Then go to Carlson and run *Data Collection* in the Survey menu and choose Leica. Check that the COM port and baud rate are set correctly. Then click the Download button and within 10 seconds go back to GIF-10 and select the file to send. The file transfer should now go. When the transfer is complete, the program will ask you for the Carlson coordinate (.CRD) file to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

### Upload

From the GIF-10 data collector, go to the file transfer routine. Then go to Carlson and run Leica under *Data Collection* in the Survey menu. In the Carlson dialog, specify the job name in the Leica File field. Next pick the Select File button next to the Carlson coordinate (.CRD) File edit box and choose the coordinate (.CRD) file to send. Check that the COM port and baud rate are set correctly. Then click the Upload button. A dialog now allows you
to specify the range of point numbers to upload. Before clicking the OK button for range of points, go to GIF-10 and start the receive by highlighting Receive and pressing the Run button. The GIF-10 now shows the available job numbers. Choose a job to receive the transfer using the arrow buttons and then press the Run button.

Converting
Carlson supports raw and coordinate data collected using three different Leica Operation Codes: Wildsoft and 10-20-30-40 as well as the newer LISCAD. Moreover, data could be in the GSI8 format or the newer GSI16 format. Some example files are shown here.

**GSI8 format data file using LISCAD Operation codes:**

WILD GIF-12

410149+00000001 42....+00005003 43....+00005.42 44....+00005.25 45....+00005000 110150+00005000 21.324+35959480 22.324+09238590 31..01+00228271 410151+00000005 42....+00010100 110152+00005001 21.324+35156390 22.324+09303500 31..01+00133532 410153+00000005 42....+00000002 410154+00000014 42....+00000000 110155+00007082 21.324+34739450 22.324+09322050 31..01+00137685 410156+00000005 42....+00000000

**GSI16 format data file using LISCAD Operation codes:**

410001+0000000000000001 84..8+0000100000000000 85..8+0000000000000000 86..8+0000000000000000 410002+0000000000000000 84..8+0000100000000000 85..8+0000000000000000 86..8+0000000000000000 410003+0000000000000000 84..8+0000100000000000 85..8+0000000000000000 86..8+0000000000000000 410004+0000000000000000 84..8+0000100000000000 85..8+0000000000000000 86..8+0000000000000000 410005+0000000000000000 84..8+0000100000000000 85..8+0000000000000000 86..8+0000000000000000 410006+0000000000000000 84..8+0000100000000000 85..8+0000000000000000 86..8+0000000000000000 410007+0000000000000000 84..8+0000100000000000 85..8+0000000000000000 86..8+0000000000000000 410008+0000000000000000 84..8+0000100000000000 85..8+0000000000000000 86..8+0000000000000000

**GSI8 format data file using Wildsoft Operation codes:**

410001+00000001 42....+00000013 43....+00000000 44....+00000012 45....+00981101 410002+00000002 42....+00000013 43....+00005.42 44....+00000012 45....+00000000 410003+00000032 42....+00000050 43....+00004.26 44....+00000012 45....+00000000 410004+000000TP 42....+00000000 43....+00000000 44....+00000000 45....+00000000 110005+00000001 21.324+00000000 22.324+09322050 31..01+00137685 110006+00000002 21.324+03473945 22.324+09322050 31..01+00137685 110007+00000003 21.324+03915180 22.324+09322050 31..01+00137685 110008+00000004 21.324+06530420 22.324+09832920 31..01+00137685

Leica raw files usually have a .RAW or .GSI extension. The primary difference in the GSI8 and GSI16 formats is that information is contained in data blocks of 16 characters in the GSI16 format, while it is contained in blocks of 8 characters in the GSI8 format. Leica instruments make it possible to have both the GSI8 as well as GSI16 data formats in the same raw file. However, lines with the GSI16 format data will always start with an asterisk (*) character, to distinguish them from the GSI8 format. There is no distinction between Leica raw files collected in the Wildsoft and LISCAD operation codes.
Supported Wildsoft codes:
1: Start Job
11: Assign Coords
12: Coord Offset
13: Target Height
14: Add to Tgt Ht
15: Add to Meas Dist
2: Occupy Point
21: Occupy Saved Point
3: FS to Trav Pt
31: FS to Single Pt
32: Radial Sideshots
33: Sets of Angles
4: Closing Pt
41: Closing Angle
50: BS to Benchmark
51: FS to Turn Pt
52: BS to Turn Pt
53: FS to Benchmark
60: Save Point
61: Recall Point
62: Compare Point
63: Remark

Supported LISCAD codes:
1: New instrument setup
2: New target height
3: Sets of directions
4: Fixed azimuth
5: Feature code
6: Measured offset
8: Line creation for sub-codes 1 (straight string), 2 (curved string) and 6 (arc by 3 points)
9: Fixed coordinates
11: Close string
14: Additional description
20: Start of job
27: Feature code
90: Split feature code
100+: Descriptions

The Convert button can be used to convert any Leica format file into a Carlson format file. For example, if you have a Leica PCMCIA card then there is no serial cable transfer to do. Instead use the Convert routine to make the Carlson raw data (.RW5) and coordinate (.CRD) files. Since there is no distinction between Wildsoft and LISCAD files, the user must know in advance which format has been used in the file. Then, select that particular option (Wildsoft, 10-20-30-40 or LISCAD) under the "Coding System" option at the bottom of the dialog box, as shown in the previous page. Another option that the user needs to choose is the order in which foresight-backsight readings have been recorded in the raw file, BFFB or BFBF, as explained in the dialog box. Then, the user can simply pick the "Convert" button and the program prompts for the input" Wild/Leica File" (raw file), and the output" Carlson RW5 file" and "Carlson CRD file", if they are not already filled.

Nikon

Download
First choose the equipment and data type under the Transfer Type list. Also check that the communication and data format settings match your collector. Then click the Download button and follow the on-screen directions. When the transfer is complete, the program will ask you for the Carlson coordinate file (.CRD) and raw file (.RW5) to create if you haven't already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector. The original data from the collector is stored in a file name with the same name as the coordinate file except with a .TRN extension. For example, job5.crd would have job5.trn.

**Upload**

Pick the Select File button next to the Carlson CRD File edit box and choose the CRD file to send. Check that the COM port and baud rate are set correctly and then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Set the points and then click the Start Transfer button. The file transfer should now go.

Convert Nikon to Carlson

The Convert button will translate the Nikon raw file format (.TRN or .RAW) into Carlson coordinate (.CRD) and raw (.RW5) files.

**Portion of typical Nikon file format:**

```
MP,1,,5000.0000,5000.0000,0.0000,T/1
ST,1,,2,,0.0000,0.00000,0.00000
SS,3,0.0000,152.1510,359.59590,90.44100,11:43:38,T/2
SS,4,0.0000,127.5560,0.06040,90.40110,11:44:45,CON
SS,5,0.0000,97.1820,2.19580,90.52460,11:45:43,CON
```

Geodimeter

**Download**

From the Geodimeter data collector, go to the file transfer routine by pressing the PRG (Program) key and entering
program 54. Then choose Imem (option 1) as the source. Next choose the file type to send as either Job (measurement data) or Area (point data). The Geodimeter will then prompt for the job name. Next enter Serial (option 3) as the destination. A confirmation screen appears showing the serial port settings. Here are some typical settings:

COM=1,8,0,9600

Before pressing enter (ENT key), go to Carlson and run Data Collection in the Survey menu and choose Geodimeter. Then click the Download button and within 15 seconds, go back to the Geodimeter and press Enter. The file transfer should now go. When the transfer is complete, the program will ask you for the Carlson coordinate file and raw file to create if you haven’t already specified a file name in the dialog. With Point Protect on, the routine will check the coordinate file for existing point data before downloading the point from the data collector.

**Upload**

In Carlson, run Geodimeter under Data Collection in the Survey menu. Pick the Select File button next to the Carlson CRD File edit box and choose the CRD file to send. Check that the COM port and baud rate are set correctly and then click the Upload button. A dialog now allows you to specify the range of point numbers to upload. Enter the points to send but before clicking OK, go to the Geodimeter data collector. Start the file transfer routine by pressing the PRG key and entering program 54. Then choose Serial (option 3) as the source. The Geodimeter will display the serial port settings. Check these values and press enter. Next choose Area (option 2) as the destination. Then enter the job name. The Geodimeter is now listening for data. Quickly go back to Carlson and click OK on the points to send dialog. The file transfer should now go.

**Convert**

The Convert button will translate the Geodimeter raw file format (.OBS) into Carlson coordinate (.CRD) and raw (.RW5) files.

**Communication Settings**

If the Geodimeter is not communicating with Carlson, run function 79 on the Geodimeter and make sure that it is set to 4. This setting is for the transfer message end of sequence format.

**Supported Geodimeter Codes**

The following Geodimeter codes are processed when converting the Geodimeter raw file. All other codes are...
recorded as descriptions in the Carlson rw5 file.
0=Info
1=Data
2=Station No
3=Instrument Height
4=Point Code
5=Point Number
6=Signal Height
7=Horizontal Angle
8=Vertical Angle
9=Slope Distance
11=Horizontal Distance
17=Horizontal Angle
18=Vertical Angle
21=Horizontal Reference Angle
30=Atmospheric Correction
37=Northing
38=Easting
39=Elevation
40=Delta North
41=Delta East
42=Delta Elevation
45=Correction To Bearing
46=Standard Deviation
50=Job Number
51=Date
52=Time
53=Operator
54=Project Id
55=Instrument Id
56=Temperature
60=Shot Id
61=Activity Code
62=Reference Object
70=Entered Radial Offset
71=Entered Angle Offset
72=Calculated Radial Offset
73=Calculated Angle Offset
74=Air Pressure

Portion of typical Geodimeter file format
5=108
4=13POC
6=5.000
7=238.0708
8=89.2236
9=440.39
37=767.42
38=4626.07
39=699.795

Topcon 210/310/220/GPT2000
This command supports these above Topcon models.
MDL Laser

The MDL Laser outputs a raw file of angles, distances and codes as one long string of data which can be converted into a Carlson raw data (.RW5) file. There is no coordinate data in the MDL raw file. So you need to run Edit-Process Raw File to calculate coordinates from the raw data. The Download button will transfer the MDL raw data from a BDI logger.
Kermit

Kermit can be also used for transferring files with accuracy. The dialog looks like this:

![Kermit Transfer](image)

**Pulldown Menu Location:** Survey

**Keyboard Command:** datacolt

**Prerequisite:** None

## Edit-Process Raw Data File

This program reads or creates a raw data (.RW5) file that contains various lines of data (records) that could be likened to a surveyor's field book. You can specify point coordinates, job information, notes, and the angles and distances that make up traverse or sideshots records. Once the raw data is created or read it can be processed/reduced to coordinates that are stored in the current coordinate (.crd; .cgc; .mdb; .zak) file.

The raw file can also be created or appended using the Locate Point, Traverse, Sideshot, and Inverse commands on the COGO menu. To store the data inputs from these commands into a raw file, first toggle on the Raw File ON/OFF command on the COGO menu. It is possible to always have the raw data file open to store data inputs. To enable this option, choose Configure from the Settings menu, then choose Survey Module, then choose General Settings. Turn on the Automatic Raw File toggle in this dialog.

The raw files created by TDS data collector programs are also compatible without conversion. The command Data Collectors on the Tools menu has options for reading other data collectors native file formats and converting them to raw data (.RW5) format. Within the raw data editor, the File menu includes an import menu for converting raw data from other formats.

When you select the Edit-Process Raw Data File command you are prompted to specify the name of the raw data (.RW5) file. The current coordinate file is used automatically. To change the current coordinate file, use the Set Coordinate File command in the Points menu before starting this command. If no coordinate file is current, the program will prompt you to set the current coordinate (.CRD) file.

*Edit-Process Raw Data File* uses a spreadsheet for editing the raw data as shown. Each row of the spreadsheet is represented by a number located at the far left side of the editor. Various messages and reports often reference possible problems with the data by this row number. Each row of the spreadsheet represents one record of data. There are 14 types of data records. The type of data record is shown in the first column. Different record types use...
different numbers of columns. Whenever the data record type changes between rows, a record header is added to the spreadsheet that describes each column of data in the following row. To edit the raw data, simply highlight the cell and type in the new value. To change the type of record, pick on the down arrow in the first column and choose a new data type from the list. To delete a row, highlight any cell in the row and hit the Delete key or choose Delete Row from the Edit menu. Records can be added pressing the Insert key, pressing the down arrow key from the last line in the spreadsheet, or by choosing one of the add records from the Add menu.

The different record types are described below.

**TR (Traverse)**
The traverse record contains the occupied point number, foresight point number, angle mode, horizontal angle, distance, vertical angle and description. When processed, this record will calculate and store the coordinates for the foresight point. Traversing also moves the setup by making the traverse foresight point the next occupied point and the traverse occupied point becomes the next backsight point. The different angle codes are NE for northeast bearing, SE for southeast, SW for southwest, NW for northwest, AZ for azimuth, AL for angle left, AR for angle right, DL for deflection angle left and DR for deflection angle right. To set the angle code, pick on the Code down arrow and choose from the list. The horizontal and vertical angles should be entered as dd.mmss. For example, 45.2305 is 45 degrees, 23 minutes and 5 seconds. The vertical angle can be shown as vertical angle (0 degrees level), zenith angle (90 degrees level) or elevation difference. The vertical angle mode is set in the Display menu. The distance mode is also set in the Display menu as either slope or horizontal distance. The description field is used as the foresight point description.

**SS (SideShot)**
The sideshot record is the same as the traverse record except that sideshot does not move the setup.

**HI (Instrument and Rod Height)**
This record sets the instrument and rod heights used in elevation calculations. This record should precede any traverse and sideshot records that you want the heights applied to.

**BK (BackSight)**
The backsight record contains the occupied point number, backsight point number, backsight azimuth and the set azimuth. This record should precede any traverse and sideshot records that use this setup. If no backsight point is
entered, the program uses the backsight azimuth to turn angles from. The Set Azimuth is the circle reading of the instrument when sighting the backsight. A Set Azimuth of zero is the default.

**PT (Store Point)**
The store point record consists of a point number, northing, easting, elevation and description. When processing, this data will be stored as a point in the coordinate file. If the first Occupied point and/or the initial Backsight point are not defined in the coordinate file set for processing to, both points will need to be added to the rw5 file as PT (Store Point) records.

**DS (Description)**
The description record is an additional note that appears in the spreadsheet editor and printouts. This record can contain various information that is recorded in data collectors during field operations. This data can vary from user, temperature and general data to each line of data associated with "Set Collection". When "Sets" of data collected using various brands of data collection software is converted/imported into the raw editor, the actual measurements made during the spinning of the angles and distances are recorded as DS records and the mean value of the angle and distance is recorded as a SS record. DS records are not used in processing except for description records containing the offset code OF. The OF codes are recorded by SurvCE for offset left/right, in/out and depth. These offset amounts are applied to the points when the program processes the raw data.

**CL (Closing Shot)**
The closing shot record is the traverse record where the foresight point is the closing point for the traverse. This record is used by the adjustment commands in the Process menu. There should be only one CL record in each Traverse loop (Name Record) in the raw file. If there is no CL record, the process adjustment routines will prompt for which shot is the closing shot. The closing shot can also be define in the field by using special codes defined in the Open Settings found under the File pulldown within the editor. Please refer to the "Open Settings" documentation below for more information on these codes.

**AB (Angle Balance)**
The Angle Balance record is the measurement data observed that closes the angles of the traverse. Typically this record is the measurement data recorded from the closing shot to the initial backsight point. The backsight could be either external or internal to the traverse. Angle Balance routine in the Process menu uses this record and compares the angle between the occupied point and foresight point of this record with a user-specified reference angle. There should be only one AB record in the raw file. If there is no AB record, then the Angle Balance routine will prompt for which shot to use as the angle balance.

**CL + AB (Closing Shot and Angle Balance)**
This record is used as both the closing shot and angle balance records.

**FD (Foresight Direct)**
The foresight direct is a traverse record used in a direct and reverse set. When the program finds one of direct-reverse measurement records, it will look for the other three records to complete the set.

**FR (Foresight Reverse)**
The foresight reverse is a traverse record used in a direct and reverse set.

**BD (Backsight Direct)**
The backsight direct is a traverse record used in a direct and reverse set.

**BR (Backsight Reverse)**
The backsight reverse is a traverse record used in a direct and reverse set.

**EL (Elevation Only)**
This record sets the elevation in the CRD file for the specified point number. Often used when an existing point with good vertical control is being traversed through. Using this record type for the point would keep the elevation from changing on the existing point regardless of the measurement data.

**AZ (Azimuth Only)**
Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**CSE (Control Standard Error)**
Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**SSE (Set-up Standard Error)**
Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**MSE (Measurement Standard Error)**
Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**NAME (Traverse Name)**
This record acts as an identifier for the group of records that make up a traverse. All the records after the NAME record belong to that traverse up to the next NAME record or the end of the file. This record allows you to have multiple traverses in one raw file. When running one of the Process commands, the program will bring up a list of all the traverse names. Simply choose which traverse to process. If you have only one traverse in the raw file, then you don't need the NAME record.

**GPS**
This record contains the Latitude and Longitude of a point as measured by GPS surveying equipment using Carlson SurvCE data collection software. This record has additional information tied to it such as localization files, geoid files, coordinate projection systems etc. This record has its own processing routine in the Process pulldown within the editor. Processing procedures are discussed in the Process (Compute Pts) pulldown documentation.

**Raw Data Editor Pulldown Menus**

**File Menu**

- **Open RW5 File**
  This command prompts for a rw5 file to load into the editor.

- **New RW5 File**
  This command clears the editor spreadsheet.

- **Save RW5 File**
This saves the rw5 file. If the file hasn't been named you will be prompted for the file name and the location to save the file. After you perform the first save, this command acts as a quick save and saves the file to the name and location specified during the initial saving of the file.

**Save RW5 As**
This command saves the raw editor data in the spreadsheet to a rw5 file and always prompts for file name and location to save.

**Open CRD File**
This command prompts for an existing coordinate file to set as the active coordinate file for the raw editor.

**New CRD File**
This command prompts for a new coordinate file to set as the active coordinate file for the raw editor. The coordinate data will be initialized as empty.

**Save CRD File**
This command saves the current coordinate data in the raw editor to the current coordinate file.

**Save CRD As**
This command saves the current coordinate data to a specified coordinate file name.

**Report/Print**
There are three types of reports: Raw Data, Coordinates and Summary. A sample of the raw data report is shown below. This report shows the data from the raw editor spreadsheet. The Coordinates report lists the point data (point number, northing, easting, elevation, description) from the current coordinate file. The summary report groups the traverse, sideshot and store point numbers along with a list of the setups and the shots from each setup.

Note: Survey Example

<table>
<thead>
<tr>
<th>PntNo</th>
<th>Northing</th>
<th>Easting</th>
<th>Elevation</th>
<th>Desc</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>5000</td>
<td>5000</td>
<td>100</td>
<td>START</td>
</tr>
</tbody>
</table>

OcPt BsPt SetAzi

1
InstHgt RodHgt

5.32 6.0

OcPt FsPt HorzAngle SlopeDist ZenithAng Desc

TR 1 2 AR 268.5330 711.420 89.4050 P2

InstHgt RodHgt

5.43 6.0

OcPt FsPt HorzAngle SlopeDist ZenithAng Desc

TR 2 3 AR 262.5448 457.760 89.3236 P3

InstHgt RodHgt

5.4 6.0

OcPt FsPt HorzAngle SlopeDist ZenithAng Desc

TR 3 4 AR 208.5710 201.310 89.1803 P4

TR 4 5 AR 247.1657 497.120 88.5235 P5

TR 5 6 AR 277.4835 223.980 90.2926 P6

TR 6 7 AR 247.1657 497.120 88.5235 P7

InstHgt RodHgt

5.42 6.0

OcPt FsPt HorzAngle SlopeDist ZenithAng Desc

TR 7 8 AR 261.2756 387.250 91.4405 CLOSE

SS 7 19 AR 289.3456 112.450 91.3423 SS1

**Report/Print Settings**
This dialog has settings for the report functions. The Use Report Formatter option allows for customized reports and exporting to Excel. The Use Distance Scaler allows for reporting distances in different units. For example, the
survey distances could be in US Feet and then use a scale factor to report the distances in chains.

Import
These routines convert raw data from other formats into the current Carlson RW5 format. The converted raw data will be added to the end of any existing data in the editor. In many cases, the raw data file to import can be downloaded directly from the data collector or instrument using the Data Collectors command. The following supported formats (along with their standard file extension) are listed here. Some Sample File Formats are listed at the end of this section.

C&G (.CGR;.RAW;.TXT;*)
CalTrans (.DMP)
Carlson (.RW5)
EFB (.RAW;.OBS) Electronic Field Book
Fieldbook (.FBK): From Softdesk, Land Development Desktop or Civil 3D. The import handles the following record types:
  AD
  AZ / AZM / AZIMUTH
  B / BRG / BEARING
  BEG / BEGIN
  BS / BACKSITE / BACKSIGHT
  C3
  END
  F1
  FC1
  NE / NEZ
  PRISM
  STN / STA / STATION
  ZD

Geodimeter (.OBS; .RAW; job;*)
Horizon (.RAW)
LandXML (.XML): LandXML is the industry standard data format for exchanging project data. It can contain any number of different data types including surfaces besides raw measurements.
Leica (.GSI; .RAW; GRE): This reads the Leica raw file in Wildsoft, Liscad, 10-20-30-40, C&G, or GeoComp format. There are options to specify direct-reverse shot order if any and to convert from International Feet to Leica US Feet.
Maptech (.FLD)
MDL Laser (.CDS)
Nikon (.TRN; .RAW)
PC Cogo (.BAT)
SDMS (.prj;*)
SMI (.RAW)
Sokkia SDR (.SDR; .RAW;*)
StarNET (.DAT) The import handles the following StarNET record types: E - Elevation record
C - Coordinate record
B - Bearing / Azimuth record
M - Measurement record
SS - SideShot record
TB - Begin Traverse record
T - Traverse record
TE - End Traverse record
DV - 3D Distance Record (creates a slope distance/zenith angle record)
D - 2D Distance Record (creates a horizontal distance)
A - Horizontal Angle Record (creates an angle-only record)
V - Zenith Angle record (creates a zenith angle-only record)

When parsing these records, if a measurement, coordinate or azimuth has standard errors assigned to it, then standard error records are created in the RW5 file so none of that information is lost. The import also handles the following DOT commands:
.ORDER - Specifies point order (AtFromTo or FromAtTo) in the measurement record, and/or the order of NORTH/EAST or EAST/NORTH in control records.
.DELTA - Specifies whether the data is SlopeDist/Zenith or HDist/VDist. The default is SD/ZE.
.2D / .3D - Specifies the data format. Without this information the fields can be confused while parsing.
SurvCOGO (.RAW or .TXT)
SurvCE Archive (.SC5) When downloading a rw5 file from SurvCE using SurvCOM, there's an option to copy the rw5 file to a sc5 file as a read-only backup.
Survis (.RAW)
TDS (.RW5; RAW)
Topcon (raw;*)
Trimble (.dc)
3TA5 (.TXT)
Zeiss (.DAT)
Export
These routines convert the Carlson raw data (.RW5) file to other formats. The following file formats are supported.

CalTrans (DMP)
dgDialog (.DGD)
Fieldbook (.FBK): This export routine provides an option to "Setup Fieldbook Codes". This allows the user to substitute the raw description contained in the rw5 file with the fieldbook code used in AutoDesk Land Desktop or Civil 3D.

FL DOT (.OBS)
GPS Data (.TXT; *)
LandXML (.XML)
Leica (.GSI)
MOSS (.MOS)
RMGeo (.txt)
SDMS (.PRJ) This export routine provides an option to "Setup SDMS Codes". This allows the user to substitute the raw description contained in the rw5 file with the SDMS codes used in SDMS program.

SFN: This format is used in the Netherlands.
Open/Save Settings
This option allows for defining codes that represent the closing shot and angle balance shot of a traverse. These codes can be entered in the description of a point while in the field. When the rw5 is opened in the raw file editor, the measurement data containing the closing shot code will be set to a CL record and the measurement data containing the angle balance code will be set to an AB record. This allows for quick processing of the survey data and saves the time spent setting up the file for processing.

Exit
Exits the raw file editor.

Edit Menu

Undo: This command undoes the last data entry or the last copy, cut or delete command performed on keyboard entered data only. This will not undo a change to the Type or Code columns, nor a cut or copy command to a row.

Cut: Standard windows cut command. Removes data from editor and places it in the windows clipboard.
Copy: Standard windows copy command. Copies selected data to windows clipboard.

Delete: Deletes selected data or row of data. Will not delete headers if data is present below the header.

Find: Tool to search and find a particular word, letter, numeric value or a combination of all. Provides options to Match whole word only and/or case. Allows for a up or down directional search from the active cell in the editor. The Point Number Search allows you to search for occupy or foresight point numbers.

Replace: Tool to search and replace a particular word, letter, numeric value of a combination of all. Options to Match whole word only and/or case is provided for the search criteria. Provides further options to Replace individual items one at a time or to Replace All. The Point Number Search allows you to replace only point numbers.

Go To: Tool to advance the focus of the active cell to a specified line number.

Delete Row: This command deletes the row containing the active cursor or cell. You can delete a row by placing the cursor in any of the cells in the row that you wish to delete, or by picking on the row number at the far left of the editor.

Scale Values: This function scales values which can be used to convert data between feet and meters. Besides feet and meters scaling, you can also enter a custom scale factor. There are controls for which types of data values to scale. Also, there are filters to scale within a point number range or line number range.
Modify Measurements: This option allows for a change in distance, horizontal angle, vertical angle or lat/lon by a specified amount for the entire file or for a specified point number or line number range. To modify a measurement, choose which field to modify, enter the change in either distance or angle in dd.mmss format. The Distance Factor method multiplies the distances by the specified value which can be used to convert distance units between feet and meters or to apply a scale factor. The Lat/Lon/Z Delta can be used to adjust GPS records in case of a shift due to adjusting the base position. Next choose how to apply the modification. If all is selected, the change will be applied to all records in the specified field. If By Point Number is chosen, enter the point number or range of numbers in the Range of Points field. If by Line Number is chosen, then define the area for the change by specifying the Starting and Ending line.

Convert Points To Notes Records: This function converts point (PT) records to note (DS) records. This leaves the information of the point coordinates in the rw5 file as display only and without having the point coordinates stored to the coordinate file when the file is processed. The point data in the DS records can be converted back to PT records by picking the Code field in the spreadsheet and switching DS to PT.
**Edit Coordinate File:** This option allows for editing and/or listing of the coordinate data in the active coordinate file. The active coordinate file is displayed in the Header of the raw data editor. This routine brings up the edit point dialog and allows editing of the points one at a time.

![Edit-Assign Point Dialog](image)

**Display Menu**

**Angles:** This option chooses the angle format between degrees/minutes/seconds (dd.mmss) and Gons-400 decimal degree circle (dd.dddd). This setting applies to the angles in the spreadsheet editor as well as the angle format for reports. There is also a separate setting to Show Decimal Seconds which use edit and process angles to the nearest tenth of a second (dd.mmss).

**Vertical:** The options contained in this menu allow for specifying the type of vertical measurement information you will input or is contained in the rw5 file. The Vertical Angle selection assumes the barrel or scope of the instrument is level when reading 0 (zero). With this setting, the vertical component of a measurement record will have a header of VertAng. The Zenith Angle selection, most commonly used, assumes the barrel/scope to be level when reading 90. Using this setting results in a header of ZenithAng. Elevation difference displays the elevation difference between
the occupied and foresight points. If the Distance option is specified as Slope, this elevation difference will be used to calculate the horizontal distance of the measurement. The header for this record is ElevDiff. The None selection assumes all distances are horizontal distances and removes the vertical component for a measurement from the editor. Switching modes can be performed at any time.

**Distance:** This option controls the display of either Slope or Horizontal Distances. Changing the display results in the distance data adjusting to reflect the correct value for the selection made. The Vertical data, VertAng, ZenithAng or VertDiff, is used to convert the distance value when changing this display option.

**Graphics:** The Raw Data Editor uses an optional graphics window to display the points and traverse lines in real time. As data is entered or edited, the graphics window will be updated to show the configuration or new configuration of the traverse. The option of whether to show sideshots is also available. When a cell is selected, the traverse or sideshot line in the display window will change to the color yellow for a graphical reference. The graphics window is toggled on or off from the Display — Graphics Window menu inside the raw file editor.

**Graphics>On:** Turns the graphics window on.

**Graphics>Off:** Turns the graphics window off.

**Graphics>Show Sideshots:** Controls the display of the sideshot data in the graphics window. Figure 1 shows the graphics window with sideshots on. Figure 1A shows the graphics window with sideshots off.
**Figure 1 Sideshots On**

**Figure 1A Sideshots Off**

**Graphics > Zoom Mode:** Within the graphics window, real time zoom is available. To zoom in press and hold the left mouse button and drag in the direction of the + symbol. To zoom out, press and hold the left button and drag in the direction of the - symbol.

**Graphics > Pan Mode:** Real time pan is available within the graphics window. To pan, set the graphics window to
pan mode, then press and hold the left mouse button and then drag to desired position.

**Graphics > Resize Text:** With this option on the text becomes smaller/larger in the view when you zoom in/out.

**Graphics > Fixed Text Size:** With this option on, the text stays a fixed size while zooming in and out.

**Spreadsheet Colors:** This option allows for the assignment of colors to record types. To change/define the color for a particular record, select Spreadsheet Colors from the Display pulldown within the raw editor. From the Color Settings dialog select the record to edit by clicking on the select button next to the desired record.

The color slide beside the select button shows the current setting for the record. After selecting the record, the Select Color dialog box will be display. Select the Set button next to the desired color for the record.

**Display > Hide Row:** This option allows for hiding single or multiple rows. This could be used to prevent crucial information from being accidentally altered during editing of data or data entry. Hiding a record does not exclude it...
from processing. To hide a record click on the row number at the far left of the editor. The entire row of data will highlight, now select the Hide Row option. Multiple rows or data can be selected by selecting the first row of data to hide then while holding down the shift key on the keyboard, select the last row to hide. All rows in between these two selections will be highlighted, now select Hide Row. When a row or rows of data are hidden, the row numbers will reflect the hidden rows. For example, Figure 2 below shows a multiple selection of rows 10-17 to hide. Figure 2A shows the editor with the rows hidden. Notice that the row numbers indicate hidden rows by showing a gap from rows 9-18.

Figure 2
**Show Row:** This option shows rows that have been hidden. To show hidden rows, the row above the first hidden row and the row below the last hidden row must be selected by using the shift key selection method described in Hide Row above. After selecting the appropriate rows, select the Show Row option. Figure 2B shows the selection of rows 9 & 18 in order to show the hidden rows 10-17. Figure 2C shows the editor after the Show Row option has been selected.
Hide By Point Numbers: This function prompts for a range of point numbers and then isolates records containing those point numbers by hiding all other records. This feature is useful to focus on certain point numbers in a large file.

Hide Selected Rows: This function hides the rows that are currently highlighted. To highlight multiple rows, pick in a cell with the mouse and then hold the Shift key while picking a cell on another row.

Show Selected Rows: This function unhides rows previously hidden by the Hide Selected Rows function.

Show All Rows: This function unhides rows previously hidden by the Hide Selected Rows or Hide By Point Numbers functions.

Hide Description Records: This option controls the visibility of the Description records contained in a rw5 file. The description record is an additional note used to store useful information in addition to typical point data. Sometimes these records clutter the raw file and make it hard to review actual survey data. The ability to control the description record visibility is a useful tool when reviewing survey data.

Show Sideshot Records: This option shows (unhides) sideshot records contained in the rw5 file.

Hide Sideshot Records: This option hides the sideshot records contained in a rw5 file to make it easier to see the traverse records.

Show Description Records: This option shows (unhides) description records contained in the rw5 file.

Hide Record Headers: This option hides the in-line headers such as the PntNo, OcPt, FsPt, etc. The editor contains "Smart Headers" that changes with the type of data that is in the active row. These headers are not in-line and are always displayed at the top of the editor. Figure 2D shows the editor with the record headers hidden and the Smart Header active. Row #21 contains the active cell, the automatic header at the top of the editor shows traverse (TR) record headers.

Track Changes: This option tracks any changes in the spreadsheet such as changing a rod height. The original values are automatically recorded in a Description record in the spreadsheet next to the edited row.
Add Menu

**Traverse:** Adds a traverse record (TR) to the spreadsheet editor. The new record will be inserted above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

**SideShot:** Adds a sideshot record (SS) to the spreadsheet editor. The new record will be inserted above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

**Backsight:** Adds a backsight (BK) to the spreadsheet editor. The new record will be inserted above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

**Instrument Height:** Adds an instrument height (HI) record to the editor. This record contains both the instrument and rod height setting.
**Point:** Adds a point (PT) record to the editor. Provides options to either add a Blank Point Record or Import From Coordinate File.

Inserting a blank record allows for manual input to define the coordinates for the point. Import From Coordinate File imports the coordinate values from an existing point or range of points contained in the coordinate file. Enter the point number or range of points and select OK. The points will be read into the rw5 file at the top of the file.

![Add Point From Coordinate File](image)

**COGO Command:** Adds COGO Command (CC) record with a field to specify the command (Translate, Rotate, Scale or Align) and a field for entering the parameters. The COGO commands are executed in sequence as the rw5 file is processed from top to bottom by any of the process methods in the Process menu. The COGO commands are all transformation commands that are applied to the points in the current coordinate file. The following list is the syntax of the COGO commands:

- **Translate:** Range Dx Dy Dz Process_Zero_Z
- **Rotate:** Range Angle Base_Y Base_X
- **Scale:** Range Scale Base_Y Base_X Use_Z
- **Align:** Range From1 To1 From2 To2

All the parameters are entered into one spreadsheet cell next to the COGO function. The parameters use space separators. The following list is the parameter definitions:

- **Range:** point numbers
- **Dx:** delta easting (X)
- **Dy:** delta northing (Y)
- **Dz:** delta elevation (Z)
- **Process_Zero_Z:** toggle for whether to process points with elevation of zero (0=No, 1=Yes)
- **Angle:** rotation angle in dd.mmss format
- **Base_Y:** base point northing
- **Base_X:** base point easting
- **Scale:** scale factor
- **Use_Z:** toggle for whether to scale the elevations (0=No, 1=Yes)
- **From1:** point number of first source point
- **To1:** point number of first destination point
- **From2:** point number of second source point
- **To2:** point number of second destination point

For example, to translate points 1-10 by a delta Z of 6.0 while filtering out zero elevation points, set the parameters for the COGO Translate record as "1-10 0 0 6.0 0".
**Elevation:** Adds an elevation (EL) record to the editor. The new record will be insert above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

**Note:** Adds a note (DS) record to the editor. Note records are for information display and do not affect processing except for two special notes which are:

- Elevation: 2D
- Elevation: 3D

These special notes set the elevation mode for processing for the records that follow the note. The raw editor starts in 3D mode. The "Elevation: 2D" note will switch processing to 2D mode and the "Elevation: 3D" note will switch the mode back to 3D. In 2D mode, the processing will not set the elevations in the coordinate file.

**Data On/Off:** Adds a data on/off (DO) record to the editor. This record toggles the raw data between processing on and off modes. The raw data starts in processing on mode. Working from top to down, when a DO record is reached, the processing mode is turned off. Then next DO record will turn processing back on, and so on. Data records that are in processing off mode and skipped when running the routines in the Process menu.

**Traverse Name:** Adds a traverse name (Name) to the editor. The new record will be insert above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

**GPS:** Adds a GPS record to the editor. The new record will be insert above the row that contains the active cell unless this row is the last row in the file. If so, you will be prompted to insert above or below the current row.

**Reference Azimuth:** Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**Control Standard Error:** Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**Setup Standard Error:** Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**Measurement Standard Error:** Applies to SurvNET, the optional Network Least Squares analysis and adjustment routine.

**Process (Compute Pts) Menu**

This menu contains tools to process raw data by various methods. The calculated coordinates, and notes if specified, are stored to the active specified coordinate file. The coordinate file can be specified using Set Coordinate File, under the Points pulldown within the drawing screen, or from the Tools menu of the editor, discussed later in this section. The options for processing are specified within either the Process Options dialog box or the Closure Options dialog box, depending upon . This dialog box is displayed before processing data, using any of the available methods, with the exception being the Least Squares method.
Multiple Measurements To Same Point: This option sets the method of how to handle multiple measurements to the same point. There are three available options, Use Last, Average or Use First. Use last uses the last measurement to calculate the position of the point. Average uses the average of all the measurements for the position calculation and Use Last takes the last measurement to the point as the data to use.

Use Backsight Reciprocals: This setting applies to backsight measurements that are not part of a complete direct/reverse set. Backsight measurements that are part of a direct/reverse set use the direct/reverse settings under Process Settings to reduce the measurements.

A foresight to point 15 from a setup on 14, followed by a backsight from 15 to 14, makes a pair of "reciprocal" measurements. The backsight "reciprocal" measurement can be ignored for its impact on recalculating the occupied point (None Option), or the elevation of component of the reciprocal measurements can be averaged (Average Elevation option), or both the elevation and distance can be averaged (Average Elev & Dist) to recalculate the setup (occupied point) coordinates.

Calculate Elevations: This option determines whether the elevations of the points will be calculated and written to the coordinate file. Options of whether to calculate All elevations or just the Sideshots Only are provided.

Direct-Reverse Vertical Angles: Specify whether to balance all or process the direct-reverse shots and use only the foresight direct shot.

Report Angle Format: Specifies the angle format for the report. The By File option makes the report use the angle format in the raw data (.RW5) file.

Calculate Elevations: This option controls which point elevations will be calculated. For example, if the traverse point elevations have already been adjusted and you need to recalculate the sideshot elevations, then use the SideShots Only option.

Report SideShots: Specify whether to include the sideshot data in the process results report.

Point Protect: This option will check the coordinate (.CRD) file for existing point data before processing. If the foresight point number for any traverse or sideshot record already is a stored coordinate in the coordinate (.CRD)
file, then the program shows a list of conflicting point numbers. You can either continue processing and overwrite the coordinate (.CRD) file coordinates with the calculated raw file coordinates or cancel the processing to go back to the editor to change foresight numbers.

A report of the conflicting point numbers can be generated to the standard report viewer in Carlson by selecting the Report option on the Point Protect dialog box. From the report viewer, the report can then be printed, sent to the screen or saved to a file.

**Create Point Notes:** This option will generate a note (.NOT) file named after the coordinate file. The note file contains additional descriptions for points. With this option active, the text from all note records (DS records) will be stored to the note file for the foresight point number preceding the note records. When this option is active, the Note Setup button brings up a dialog to set a Wildcard Match which filters the notes in the raw file and only stores the notes that match to the note file. The Prefix To Remove option removes the specified string from the start of the
Calculate Grid Scale Factor at Each Setup: This option will calculate a scale factor for each TR and SS record. This scale factor is calculated as the average of the scale factors at the occupied and foresights points. At these points the scale factor is calculated as the projection grid factor multiplied by the elevation factor which is the earth radius divided by the elevation plus the earth radius \[SF = \text{Grid Factor} \times \left(\frac{\text{Earth Radius}}{\text{Elevation} + \text{Earth Radius}}\right)\]. In order to calculate these projection grid factors, the traverse coordinates must be in grid coordinates. When this option is selected, the program will prompt for the projection and zone to use. The elevation for the scale factor can be adjusted by the geoid height using the geoid specified in the Geoid To Apply list. The geoid height is added to the point elevation to adjust the elevation value used in the scale factor equation. The geoid surface files are not installed by default due to the large size of these files. To install the geoids to use with this option, go to the Carlson Software webpage and download the Geoid Grid Files from the Support Downloads section.

Report Each State Plane Scale: This option becomes available if the Calculate State Plane Factor at Each Setup has been selected. With this option on, the scale factor at each point will be shown in the process results report.

Scale Factor: This value is multiplied by the horizontal distance for the traverse and sideshot records. This factor can be use to transform from ground to grid coordinates. This factor does not affect elevations.

Correct for Earth Curvature: This option adjusts the calculated points for the effect of the Earth's curvature. Typically this adjustment is small and adjusts the elevation more than the horizontal.

Report Angle Format: This option controls the angle format displayed on the process result report. The option of By Raw File will display the angles in the format that is contained in the raw file. The Bearing option will display the angle in a bearing format. The Azimuth option will display the azimuth of the measurement and the Angle Right option will display the angle right measurement of the observation.

Decimal Places for Report: This option controls the number of decimal places for the reported data.

Report Closure: This option determines whether the closure report will be displayed after processing. If processing a topo survey where the traverse has not been closed, then turn this toggle off for quick processing.

Report Sideshots: Controls whether the sideshot data is shown on the process report.

Reference Closing Point: This is an optional field for entering the coordinates to compare the ending traverse point with. This reference closing point is used to calculate the closure. Without using this option the program will by default use the starting coordinate as the reference closing point.

Report Output: There are three report output options contained in the raw editor, the Standard Report Viewer, the Custom Report Formatter and the Tabular Report Viewer. Each is documented below.
The **Standard Report Viewer** is the default report viewer throughout the program. Any routine that generates a report has this option and the data contained in the report depends upon the routine executed. The report viewer is also a text editor. It allows for addition and deletion of text in order to customize the report for printing or for saving to a particular format for a file. Options to print, send to the screen in the drawing window as text or save to a file are available.

The **Custom Report Formatter** allows for customization of the process results by selecting the fields and the layout of the fields to display. The settings can be saved to a format name and recalled when needed. Options to Delete, Export and Import saved Formats are also available.
To create a report, select data from the Available list and then select the Add button. This will populate the Used field with the selected data. Standard window selection methods can be used when selecting the data to report. Holding the ctrl key while selecting data allows for making random selections. Holding the shift key while selecting data will select the first item picked, last item picked and all items between.

The **Tabular Report Viewer** displays a report viewer consisting of tabs. Each tab organizes and displays different data depending upon the process option chosen. The process results using the No Adjust method results in three tabs the Report Header, Unadjusted Data and the Store Points tabs. Each of these tabs display different information which corresponds to the tab title. Using an adjustment method results in five tabs. In addition to the three listed above, an Angle Balance and Compass Closure tab is added. From the Tabular Report Viewer, the Standard Report Viewer can be switched to by pressing the Report option at the bottom of the dialog. This is useful when wanting to combine all tabs into one report for printing or saving to a file. An example of a Tabular Report for a compass rule adjustment is shown below.
**Processing Methods**

**No Adjust:** No Adjust means that no angle balance or traverse adjustment will be applied. Options are specified in the Process Options dialog. After picking OK for the process options dialog, a Traverse Points dialog appears for entering the starting and ending point numbers.

The program reads the raw file to set the defaults for these point numbers which are used to calculate the closure. The difference between the ending point and the reference closing point is the closure error and the sum of the traverse distances from the starting to the ending point is used as the total distance traversed. After picking OK for the second dialog, the program starts processing the raw file from the top record down. The result is displayed in the Standard Report Viewer which can save, print or draw the report.

**Angle Balance:** This process method applies an angle balance to the traverse lines when calculating the coordinates. The angle balance takes the angular error divided by the number of traverse lines and adjusts the angle of each traverse line by this amount. The angular error is the difference between the angle balance shot and a reference angle. The angle balance shot is specified as a type AB or CL+AB record in the raw file. If no AB record is found in the raw file, then the program will prompt for which traverse shot to use as the angle balance shot. The angle from the angle balance shot is calculated as the angle from the occupied point to the foresight point. The reference angle can be specified as a bearing, azimuth or by two point numbers in the dialog shown.
The angle balance report shows the unadjusted points, the unadjusted closure, the angular error, the adjusted points and then the adjusted closure. Typically but not always, applying the angle balance correction will improve the traverse closure.

**Compass, Crandall, Transit:** These process methods apply the selected rule to the traverse lines when calculating the coordinates. After adjusting the traverse, the sideshots are also recalculated. The closure error is calculated as the difference between the closing shot and a reference point. The closing shot is specified as a type CL or CL+AB record in the raw file. If no CL record is found in the raw file, then the program will prompt for which traverse shot to use as the closing shot. The foresight point is used as the closing coordinate. The reference point can be specified by point number or by entering the northing, easting and elevation. The process results report shows the unadjusted points, closure error, adjustments to each traverse point and adjusted point.

**Prepare Least Squares Data:** From the raw file data, this routine makes initial calculations for the coordinate points in the traverse.

This data, along with the control point coordinates and the angle and distance measurements, is stored to a data file with the same name as the current RW5 file except with a .LSQ extension (ie: survey.lsq goes with survey.rw5). The constraints of the routine are:

- All angle readings must be in angle right mode.
- The coordinates of the starting and the ending points must be known.

The routine begins with a dialog for specifying the reference closing coordinates and any scale factors to apply to the distance measurements. The Reference Closing Point is the last point in the traverse, whose coordinates must be
known. If an angle balance shot is used in the traverse, the Reference Angle Balance Angle must also be specified, either as a value or as the angle between known points.

Since angles and distances have errors of different magnitudes, they are normalized using weights, based on the accuracy and confidence with which these quantities have been measured. There is a dialog for specifying the estimated measurement errors. The Reading Error is the horizontal angular error in the instrument. For example, for a "5-second" instrument this error would be 5. The Pointing Error accounts for several factors in the horizontal angle reading including accuracy lining up the crosshairs on the target, the target size and the optical quality of the instrument. The Target and Instrument Centering Errors are the distance off the point due to faulty centering. The EDM Constant Error is the accuracy of the instrument distance measurements. The EDM Scaler Error is entered in parts per million for the increased error in longer measurements. These settings can be saved and loaded as a way to store settings for different equipment.

The program will calculate the weights for each distance and angle measurement using these measurement errors. The control points, points to adjust, distance and angle measurements with weights are reported. You can edit these measurements and weights using the Edit Least-Squares Data routine or go directly to the Process Least-Squares Data routine.

**Edit Least Squares Data:** This routine edits the points, measurements and weights stored in the .LSQ file associated with the current RW5 file. The editor works through the dialog shown. You can edit, add or remove the control points, adjust points, angle measurements or distance measurements. The program does not check that the editing is valid. So you need to make sure that your changes keep a good set of least-squares data (i.e. don't delete a needed control point). The Distance Error button allows you to set the distance standard error weights for all the distance measurements to the same value. Likewise the Angle Error button sets the standard error weights for all the angle measurements.
Least-Squares Input Data:

Control Points
Point# Northing Easting
1 5000.000 5000.000
8 5000.000 5000.000

Distance Observations
Occupy FSight Distance StdErr
1 2 711.409 0.018
2 3 457.745 0.017
3 4 201.295 0.017
4 5 497.024 0.018
5 6 223.972 0.017
6 7 233.872 0.017
7 8 387.073 0.017

Angle Observations
BSight Occupy FSight Angle StdErr
7 1 2 268d53'30'' 15.1843''
1 2 3 262d54'48'' 13.68268''
2 3 4 208d57'10'' 15.36335''
3 4 5 277d48'35'' 12.262''
4 5 6 92d41'13'' 15.818''
5 6 7 261d27'56'' 12.991''
7 S 01d59'18'' E 0.001''

Process Least Squares Data
This routine applies a least-squares adjustment to the data stored in the .LSQ associated with the current raw data (.RW5) file. The closing errors are distributed among the other points, using the "Method of Least Squares" (Ref: Wolf, P.R. and Ghilani, C.D., 1996, "Adjustment Computations", John Wiley and Sons, NY, Third Edition). After the adjustment, the rest of the raw file is processed to recalculate the sideshots. There is an option to draw standard error ellipses around the adjusted points. The ellipse axes are multiplied by Ellipse Scale Factor to make the ellipse larger for easier viewing.
The least-squares process report shows the input data and the results. For each point, the amount adjusted and the standard error in X and Y are reported. The Reference Standard Deviation is based on the sum of the residuals and the initial estimated standard errors. The Chi-Squares test is a goodness-of-fit test that checks the reference standard deviation with the least-squares model. If this test fails, there may be a blunder in the measurement data or the initial estimated standard errors were too low or too high.

**Stadia Processing Method:** Provides functionality to process Stadia surveying notes. Stadia sighting depends on two horizontal cross-hairs, known as stadia hairs, within the telescope. These hairs are parallel to the horizontal cross-hair and are equally spaced above and below it. The distance between the two stadia hairs is known as the intercept. The distance from the instrument to the rod is 100 times the intercept. For example, an intercept of 3.10 would represent a distance of 310 (3.10 X 100). For entering in stadia notes, you would enter the horizontal angle, the distance (entered as the intercept X 100) and the vertical angle.

**GPS:** The process GPS routine allows for reduction of GPS records that reside in a raw (*.RW5) file from latitude, longitude and WGS84 Ellipsoid Height to State Plane or local coordinates. When a DZ (Depth) record follows a GPS record, the depth value is used to adjust the GPS point elevation. When a GSAL record follows a GPS record, the position is adjusted by the record delta tilt values for the rod tilt.

The Process GPS settings dialog is shown below.
**GPS Settings**

**Projection Type:**
Defines the datum coordinate system to be used for converting the latitude, longitude and WGS84 ellipsoid height collected from the GPS receiver into Cartesian coordinates. The supported projection types are State Plane 83, State Plane 27, UTM, Lat/Long, Great Britain-OSGB36, Australia, New Zealand-NZGD2000, New Zealand-NZGD49, and France NTF-GR3DF97A. A User-Defined option is also available for defining a user projection.

The supported geoids include: Geoid99 (USA), Geoid03 (USA), EGM96 (World), GDA94 (Australia), CGG2000, HT 2.0, HT HT 1.01 (Canada) and SGM02 (Britain). GeoUser-Defined projections are supported. To define a new projection select the Define Projection option. This will bring up the following dialog.

Enter a name for your system (e.g. PRVI for Puerto Rico/Virgin Islands), then select a Projection type and enter the appropriate parameters. Note that all latitude and longitude values are in Degrees Minutes and Seconds (dd.mmss) and False Northing and False Eastings are always presented in meters. Define a Datum shift by selecting the Select Datum radial button. You may select a predefined Ellipsoid or set your own parameters by typing in a new
ellipsoid name in the Ellipsoid field and entering values for a and 1/f. When you enter in a new Ellipsoid name, the Datum name field will be blank. The values for Dx, Dy, Dz, Rx, Ry, and Rz and scale are "to WGS84". If the values you have are "from WGS84", simply reverse the sign of each value (positive becomes negative and vice versa).

You may save your system to a "udp" file. To Load a user defined coordinate system from a file, select the Load radial button. A list of user defined systems will be displayed. Select the desired system and press OK.

**GPS>Zone:** for State Plane projections, you must select the correct state zone that you are working in. For UTM, the Automatic Zone option will have the program automatically use the program automatically use the correct UTM zone for your location. Otherwise for UTM, you can manually set a specific UTM zone. This manual option applies to working on the border between zones and you want to force the program to always use one of those zones.

**GPS>Use Alignment File For Localization:** With this option toggle on, a prompt for the Alignment File to Process will be displayed. This file is typically created by SurvCE (Carlson's Data Collection System) using the Localization routine or by Carlson Field Using the Align to Local Coordinates routine. This file (*.DAT) contains the parameters to transform the derived State Plane coordinates to the defined local coordinates.

At the end of the process, the coordinates will be written to the current coordinate (*.crd) file and a report will be presented in the Carlson editor for saving or printing purposes.

**GPS>Transformation:** The transformation in the align Local Coordinates command can either be by plane similarity or rigid body methods. The difference is that the rigid body method does a transformation with a translation and rotation and without a scale. The plane similarity does a rotation, translation and scale. This option only applies when two or more points are used in Align Local Coordinates or the Localization routine in SurvCE.

**GPS>One Point Alignment Azimuth:** This option applies to the rotation when using one point in Align Local Coordinates or the Localization routine in SurvCE. For this alignment method, the state plane coordinate is translated to the local coordinate. Then the rotation can use either the state plane grid or the geodetic as north. No scale is applied in this transformation. The state plane and geodetic true north diverge slightly in the east and west edges of the state plane zone. This option allows you to choose which north to use.

**GPS>Two Point Alignment Method:** There are two option when using this method, Fit & Rotate and Rotate Only. Fit & Rotate will use the second point in the localization file for direction and scaling. The Rotate Only option allows you to use the second point in the localization file for direction but not for scaling. When using the Rotate Only option, any scale factor entered in the Project Scale Factor will be used.

**GPS>Project Scale Factor:** For most applications, the Scale Factor should be set to 1.0. The scale factor represents the "combined" grid/elevation factor that reduces ground distances to grid. After converting the LAT/LONG from the GPS records to state plane coordinates and applying the coordinate alignment (Localization) file, the Project Scale Factor is applied as the final adjustment to the coordinates. This adjustment is used on the X, Y, and not the Z. The Project Scale Factor is applied by dividing the distance between the coordinate and a base point by the Project Scale Factor. The coordinate is then set by starting from the base point and moving in the direction to the coordinate for the adjusted distance. The base point is the first point in the alignment (Localization) file. If there are no points specified in the alignment file, then 0.0 is used as the base point. If using an alignment file (Localization File) this value will be automatically calculated and displayed. Manual entry of a scale factor is also permitted and is often used with the Two Point Alignment Method when a scale factor is known.

**GPS>Geoid to Apply:** The supported geoids include: Geoid99 (USA), Geoid03 (USA), EGM96 (World), GDA94 (Australia), CGG2000, HT 2.0, HT HT 1.01 (Canada) and SGM02 (Britain).
This option will account for the geoid undulation in determining the orthometric elevation of the measurement. The definition of the geoid model as currently adopted by the national Geodetic survey is the equipotential surface of the Earth's gravity field which best fits, in a least squares sense, global mean sea level. Orthometric elevation measurements are used in survey calculations. In order to convert ellipsoid heights (He) as measured by GPS into orthometric elevations (E0), you must provide for a correction between the GPS-measured ellipsoid (reference ellipsoid) and a constant level gravitational surface, the geoid. This corrections is the geoid undulation (Ug). The formula is He=E0 + Ug.

Carlson applies the Geoid model by subtracting the Geoid undulation from the GPS elevation. The resulting elevation is then used and displayed. In practice, the Geoid model is most applicable to two types of alignment scenarios. One of these types is when setting up the base over a known point and having no alignment control points. The other is when there is one alignment control point. When using multiple alignment control points, the Geoid model is not as important because Carlson can model the elevation difference which can generally pick up the local Geoid undulation.

GPS>Units: Coordinates can be reduced into one of three available units, Metric, US Feet or International Feet.

Process>Process Settings: This option allows for the setting of user preferences and tolerances to be used during processing and generation of reports.

Multiple Measurement Settings: These options provide control for managing how multiple measurements to the same point are handled and reported.

Distance Tolerance Horizontal and Vertical: Allows for user input of desired tolerance values for multiple measurements. Exceeded tolerances will be displayed on the process results report. With the Report Residuals option ON, the residual values of the measurements will be shown on the process results report. The data to be averaged can be either the Distance Measurements or the Coordinates.

Backsight Orientation Settings: The Override Backsight Azimuth When Have Backsight Coordinate File applies to BK records that have both a backsight point number and backsight azimuth. When this option is on and the backsight point is found in the coordinate file, then the backsight orientation is set to the angle from the occupy point to the backsight point. Otherwise the backsight azimuth is used. The Use Multiple References option...
will take multiple backsight measurements for an occupation and computes a least squares orientation for the instrument. There is also an option to compute and correct for the instrumental collimation error from the available measurements if both direct and reverse readings to one or more stations in the same set have been recorded. The program uses the BD (backsight direct) and BR (backsight reverse) records to identify the measurements to process. You can backsight different targets. The targets do need to have known coordinates either as points in the current coordinate file or as SP records in the raw file. The measurements can be complete with angles and distance, and they can be partial with only angles or only distance. When this option is active, the calculated backsight orientation will override the SetAzi field in the BK (backsight) record for the setup. The process report will include all the measurements used, the residuals and the resulting backsight orientation. The least-squares routine will also calculate the occupied station coordinate by resection if possible from the measurements and the report includes this calculated position along with the reference position and residuals. This calculation of the occupy point is used only for a check for the report and does not affect the occupy coordinate for processing. Note that if the occupied station position is unknown, there must be sufficient measurements to at least three known reference stations to support the resection and orientation solution. Here is an example of the raw data and the report.

### Raw Data

<table>
<thead>
<tr>
<th>PntNo</th>
<th>Northing</th>
<th>Easting</th>
<th>Elevation</th>
<th>Desc</th>
</tr>
</thead>
<tbody>
<tr>
<td>71</td>
<td>4998.1900</td>
<td>5199.8200</td>
<td>125.0000</td>
<td>PK</td>
</tr>
<tr>
<td>22</td>
<td>4770.1200</td>
<td>5192.5000</td>
<td>90.0000</td>
<td>PK</td>
</tr>
<tr>
<td>2</td>
<td>4900.2700</td>
<td>5007.3100</td>
<td>75.0000</td>
<td>PK</td>
</tr>
<tr>
<td>53</td>
<td>5345.8600</td>
<td>4799.0400</td>
<td>150.0000</td>
<td>PK</td>
</tr>
<tr>
<td>1</td>
<td>5000.0000</td>
<td>5000.0000</td>
<td>100.0000</td>
<td>PK</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>InstHt</th>
<th>RodHt</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.000</td>
<td>1.000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OcPt</th>
<th>BsPt</th>
<th>Azi</th>
<th>SetAzi</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>0°00'00''</td>
<td>0°00'00''</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OcPt</th>
<th>FsPt</th>
<th>HorzAngle</th>
<th>SlopeDist</th>
<th>ZenithAng</th>
<th>Desc</th>
</tr>
</thead>
<tbody>
<tr>
<td>BD</td>
<td>1</td>
<td>AR 0°31'09''</td>
<td>200.930</td>
<td>84°00'06''</td>
<td>PK</td>
</tr>
<tr>
<td>InstHt</td>
<td>RodHt</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.000</td>
<td>2.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OcPt</th>
<th>FsPt</th>
<th>HorzAngle</th>
<th>SlopeDist</th>
<th>ZenithAng</th>
<th>Desc</th>
</tr>
</thead>
<tbody>
<tr>
<td>BD</td>
<td>1</td>
<td>AR 50°03'22''</td>
<td>300.120</td>
<td>92°29'02''</td>
<td>PK</td>
</tr>
<tr>
<td>InstHt</td>
<td>RodHt</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.000</td>
<td>3.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OcPt</th>
<th>FsPt</th>
<th>HorzAngle</th>
<th>SlopeDist</th>
<th>ZenithAng</th>
<th>Desc</th>
</tr>
</thead>
<tbody>
<tr>
<td>BD</td>
<td>1</td>
<td>AR 85°48'25''</td>
<td>103.580</td>
<td>105°06'37''</td>
<td>PK</td>
</tr>
<tr>
<td>InstHt</td>
<td>RodHt</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.000</td>
<td>4.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OcPt</th>
<th>FsPt</th>
<th>HorzAngle</th>
<th>SlopeDist</th>
<th>ZenithAng</th>
<th>Desc</th>
</tr>
</thead>
<tbody>
<tr>
<td>BD</td>
<td>1</td>
<td>AR 239°50'24''</td>
<td>403.000</td>
<td>83°01'04''</td>
<td>PK</td>
</tr>
<tr>
<td>BR</td>
<td>1</td>
<td>AR 59°50'31''</td>
<td>403.001</td>
<td>276°58'56''</td>
<td>PK</td>
</tr>
<tr>
<td>InstHt</td>
<td>RodHt</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.000</td>
<td>3.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OcPt</th>
<th>FsPt</th>
<th>HorzAngle</th>
<th>SlopeDist</th>
<th>ZenithAng</th>
<th>Desc</th>
</tr>
</thead>
<tbody>
<tr>
<td>BR</td>
<td>1</td>
<td>AR 265°48'38''</td>
<td>103.581</td>
<td>254°53'23''</td>
<td>PK</td>
</tr>
<tr>
<td>InstHt</td>
<td>RodHt</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.000</td>
<td>2.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OcPt</th>
<th>FsPt</th>
<th>HorzAngle</th>
<th>SlopeDist</th>
<th>ZenithAng</th>
<th>Desc</th>
</tr>
</thead>
<tbody>
<tr>
<td>BR</td>
<td>1</td>
<td>AR 230°03'39''</td>
<td>300.121</td>
<td>267°30'58''</td>
<td>PK</td>
</tr>
<tr>
<td>InstHt</td>
<td>RodHt</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5.000</td>
<td>1.000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ZenithAng</th>
<th>Desc</th>
</tr>
</thead>
<tbody>
<tr>
<td>BR 1</td>
<td></td>
</tr>
</tbody>
</table>

| BR 1       |      |

| AR 180°31'16'' | 200.931   | 275°59'54'' | PK   |

### Multiple Backsight Orientation

<table>
<thead>
<tr>
<th>OcPt</th>
<th>BsPt</th>
<th>Azimuth</th>
<th>SetAzi</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>00°00'00''</td>
<td>269°59'57''</td>
</tr>
</tbody>
</table>

### Orientation Standard Deviation: 0.000

### Instrument Height: 5.000

### Occupy Point Northing Easting Elevation

---

**Chapter 11. Survey Menu**
### Check Point Settings:
These options provide user controls for survey check points. With Report Check Points ON, any point coded as a check point in the raw data file, will be reported. When selected the Check Point Code and Distance Tolerance fields become active and allow for editing. The Check Point Code is a user specified code entered in during the survey that tells the program to check the coordinates of a particular point with the coordinates of another point. This code is configurable by the user. An example of a point description coded as a Check Point would be as such, "trav =8". This description tells the program that the description of the point is "trav" and to check the coordinates of the this point with that of point #8. The Distance Tolerance Horizontal and Vertical are user specified tolerances for the check point. If either of these tolerances is exceeded it will be reported on the process results report.

### Instrument/Rod Height Ranges:
These settings are used to check the instrument and rod heights when the raw file is processed. The program will report warnings if there are any heights that exceed the specified min/max ranges.

### Angle Only Measurements:
The Combine Elevations Method applies to points calculated from Angle Only measurements. Angle Only points are calculated as part of the processing for the No Adjust, Compass, Crandall, Transit and Angle Balance process methods. To calculate points from Angle Only measurements, there needs to be multiple SS records with horizontal and vertical angles and no distance with the same target foresight point number from setups at different occupy points. The elevations can be set as the average from the multiple measurements, using the highest measured elevation, or using the lowest measured elevation. For example, to survey the top of a tree, you could have a SS to foresight point 99 from occupy point 1 with a horizontal and vertical angle and another SS to foresight point 99 from occupy point 2 with a horizontal and vertical angle. Then point 99 can be calculated by angle-angle intersect which determines the horizontal distances from 99 back to occupy points 1 and 2. These distances are then used with the vertical angles and occupy point elevation to calculate the elevation at point 99.

### Store Point Records:
These options control how any store point (PT) record is handled during processing of the raw data file. There are three options for storing Store Point (PT) records, Never, Always, and When CRD Empty. Never prevents any Store Point (PT) Record Report in the raw file from being written to the crd file. With this option on no existing point in the crd file would be overwritten. Always will write to the coordinate file and will overwrite any existing point with the same number of the Store Point (PT) records. The When CRD Empty option will only write Store Point (PT) records to the coordinate file when it is empty. Report Store Points displays all store points in the process results report. The Hold Store Points option will hold the coordinate values for the store point record when measurements are taken to the store points. This will prevent the coordinates of the point from changing if measurements to the point dictate a change in coordinate position. The Convert OC to PT Records option will convert description (DS) records to store point (PT) records when the description record contains contains an OC tag with an occupy point number and coordinates for a point number that isn't already used in another PT or SS
Direct-Reverse Settings:

Direct-Reverse Vertical Angles: This option determines how to handle direct-reverse vertical angle measurements when processing. Balance Direct-Reverse will take the mean of the direct-reverse measurements and use this value when processing the file. Direct Only will only use the direct measurement to the point for processing.

Foresight-Backsight Measurements: Balance Foresight-Backsight allows for averaging in the Foresight and backsight measurements when using direct-reverse sets. The Foresight Only option will average the foresight measurements only of a direct-reverse set.

Horizontal Angle Tolerance (Seconds): This is the tolerance that the angle measured by the direct measurements and the angle measured by the reverse measurements in a direct-reverse set must fall within.

Flip Angle Tolerance (Seconds): User specified value for the acceptable difference in measured horizontal angles determined from the direct (BD-FD) and reverse (BR-FR) observations.

Distance Tolerance: User specified tolerance for the difference in distance measurements to the same points. When this value is exceeded on a measurement, it will be displayed on the process results report.

Measurements To Control Points: The Store To Current Coordinate File option applies when a control coordinate file is used in addition to the active coordinate file. When processing the raw file, measurements to point numbers that are in the control coordinate file will not be stored into the active coordinate file when this option is on.

Drawing Points and Linework: This option controls the drawing of points and linework using Field to Finish. It differs from the draw traverse and sideshot lines under the Tools Menu of the Raw Editor by using a field to finish code table (*.fld) to define how the points and linework are to be drawn and layerized. There are three settings for this option, Manual, Auto and Prompt. Manual means that the file will not be processed using the field to finish codes and no points or linework with be drawn upon existing the raw editor. The Auto option will use the current or last used field to finish file (*.fld) to draw the points and lines on the drawing screen when the raw editor is existed. The option of Prompt will give the option to draw the points and lines to the screen. With this setting specified, the following prompt will be displayed when existing the editor.

Tools Menu
**Direct-Reverse Report:** This routine creates a report of direct and reverse shots along with the resulting averaged shots. Any tolerance specified in the Process Settings>Direct-Reverse Settings section, that is exceeded will be displayed in this report. The residuals are the difference between the measurement and the final average. If the current spreadsheet display mode for distances is set to horizontal, then the report will show horizontal distances. Otherwise, the report uses slope distances.

**Reduce Direct-Reverse:** This routine processes the direct and reverse shots and simplifies the raw file by replacing the sets of direct and reverse shots with the resulting average traverse record.

**Update Raw from Points:** This routine is used to update the raw data based upon the coordinates of the points contained in the coordinate (*.crd) file. For example if the raw data has been processed using the compass rule adjustment method, the points in the crd file are now adjusted. However the raw data remains unchanged. If a record of the rw5 file reflecting the angles and distances between the points after an adjustment has been ran is desired, this routine can be run thus updating the raw data to reflect the adjusted angles and distances. Another application for this routine is that of building a rw5 file for future processing and adjustment. For example if a point file or text file has been received from another engineering firm or fellow surveyor and you would like to build a rw5 file for future reference and processing this option can also be used to accomplish this. The rw5 file would be set up with the occupied points, foresight points and the desired angle type to use specified for the traverse. This would be all the manual entry of the data necessary. After creating the "shell" of the traverse then run the update raw from points routine and the raw data, as contained in the coordinate file, will be imported into the rw5 file thus filling out the horizontal angle, distance and vertical components specified.

**Find Bad Angle:** This routine applies the angular error to each traverse record one at a time. The adjusted traverse record that improves the closure the most is reported as the Bad Angle. The angular error is the difference between the angle balance shot and a reference angle.

**Append Another Raw File:** This routine prompts for another raw data (.RW5) file which is read and the data added to the end of the existing raw data (.RW5) file. For example, if you are editing the raw file from the first days work and have a separate raw file with a second days work, you can use this routine to add the second raw data to the first raw file.

**Draw Traverse-Sideshot Lines:** This routine draws lines for all the traverse and sideshot records. Sideshot Traverses are traverses that do not lead to the closing or ending point. There are different layers so that the lines can be drawn with different colors. This command does not process the raw file. Instead it reads the raw file and for each traverse and sideshot record, the program looks up the coordinates for the occupied and foresight points in the CRD file. So it may be necessary to run Process>No Adjust before running this routine. With the Erase Previous Traverse-Sideshot Lines toggled on, any previous linework drawn using this method will be erased from the drawing screen before drawing the lines again.
**Renumber Points:** This routine renumbers points in the raw file. This applies to all point numbers including: TR, SS, and PT records. The points can be renumbered by either incrementing the number or by adding a suffix. The Renumber Duplicates Only option only renumbers points that are duplicated in the raw file.

**Range of Points to Renumber:** Enter in the range of points to change, ie 1-4.

**Line Number to Begin Renumbering:** This corresponds to the line number located at the far left or the raw data editor. Enter the line number to begin the renumbering.

**Line Number To End Renumbering:** This also corresponds to the line number located at the far left on the raw data editor. Enter the line number to end the renumbering. If the range of numbers specified does not occur between the beginning line number and the ending line number, no changes will be made.

**Numbers to Add to Point Numbers:** Enter in the value to add. This number will be added to the existing point number to create the new point number. For example, if the number to add is 10 and the existing point numbers 1 and 6, the new renumber points will be 11 and 16.

**Point Groups:** This option can be used to organize the survey data into point groups. There are three options for the creation of point groups, **Create All Point Group**, **Create Traverse Point Group** and **Create Sideshot Point Group**. The **Create All Point Group** option, creates a user specified group containing all of the points defined in the rw5 file. **Create Traverse Point Group** creates a user specified group containing only the points defined in the traverse records (TR) of the rw5 file. The **Create Sideshot Point Group** creates a user specified group that contains only the points defined in the sideshot records (SS) of the rw5 file.

**Format of the raw data (.RW5) file**

The Carlson raw data format is a comma delimited ASCII file containing record types, headers, recorded data and comments. The format is based on the RW5 raw data specification, with the exception of angle sets. Angle sets are recorded as BD, BR, FD and FR records to allow reduction of all possible combinations. Essentially, these records are identical to a sideshot record.

**Backsight Record**
Record type: BK
Field headers:
OP Occupy Point
BP Back Point
BS Backsight
BC Back Circle
Sample:
BK,OP1,BP2,BS315.0000,BC0.0044

Line of Sight Record
Record type: LS
Field headers:
HI Height of Instrument
HR Height of Rod*
*GPS heights may be recorded to phase center or ARP depending on GPS make.
Samples:
LS,HI5.000000,HR6.000000
LS,HR4.000000

Occupy Record
Record type: OC
Field headers:
OP Point Name
N Northing (the header is N space)
E Easting (the header is E space)
EL Elevation
– Note
Sample:
OC,OP1,N 5000.00000,E 5000.00000,EL100.000,–CP

Store Point Record
Record type: SP
Field headers:
PN Point Name
N Northing
E Easting
EL Elevation
– Note
Sample:
SP,PN100,N 5002.0000,E 5000.0000,EL100.0000,–PP

Traverse / Sideshot Record / Backsight Direct / Backsight Reverse / Foresight Direct / Foresight Reverse
Record type: TR / SS / BD / BR / FD / FR
Field headers:
OP Occupy Point
FP Foresight Point
(one of the following)
AZ Azimuth
BR Bearing
AR Angle-Right
AL Angle-Left
DR Deflection-Right
DL Deflection-Left
ZE Zenith
VA Vertical angle
CE Change Elevation
SD Slope Distance
HD Horizontal Distance
– Note
Samples:
TR,OP1,FP4,AR90.3333,ZE90.3333,SD25.550000,–CP
SS,OP1,FP2,AR0.0044,ZE86.0133,SD10.313750,–CP
BD,OP1,FP2,AR0.0055,ZE86.0126,SD10.320000,–CP
BR,OP1,FP2,AR180.0037,ZE273.5826,SD10.315000,–CP
FD,OP1,FP3,AR57.1630,ZE89.4305,SD7.393000,–CP
FR,OP1,FP3,AR37.1612,ZE270.1548,SD7.395000,–CP

GPS
Record type: GPS
Field headers:
PN Point Name
LA Latitude (WGS84)
LN Longitude (WGS84, negative for West)
EL Ellipsoid elevation in meters*
– Note
*GPS heights may be recorded to phase center or ARP depending on GPS make.
Sample:
GPS,PN701,LA42.214630920,LN-71.081409184,EL-21.8459,–C

DZ
Record type: Depth
PN Point Name
DZ Depth
Sample:
DZ,PN10002,DZ0.3962

Alphabetical listing of Field Headers
AD Azimuth Direction ( 0 for North, 1 for South)
AL Angle-Left
AR Angle-Right
AZ Azimuth
BC Back Circle
BP Back Point
BR Bearing (this field will be recorded as N123.4500W)
BS Backsight (when back point is not defined)
CE Change Elevation
DL Deflection-Left
DR Deflection-Right
DT Local Date (MM-DD-YYYY)
DZ Depth
E Easting (the header is E space)
EC Earth Curvature (0 for off, 1 for on)
EL Elevation (GPS value is ellipsoid elevation in meters)
EO EDM Offset
FE Foresight Elevation
Traverse Examples

This first example is a closed traverse with an internal backsight of azimuth 178d0'42"

Use the functions under the Add menu to create and fill out the raw file as shown here.
Notice that the record from point 7 to 8 is set as a CL+AB record. This tells the program that point 8 is the closing point and that the angle from 7 to 8 is the closing angle. For traverse adjustment, the closing reference point is 1 and the closure error is the difference between point 1 and point 8. For angle balance, the reference closing angle is 358d0'42'' (178d0'42'' + 180). The angle balance error is the difference between this reference angle and the angle from points 7 to 8.

Now let's process using Compass adjustment with Angle Balance. Choose Compass under the Process menu and fill out the dialogs as shown.

<table>
<thead>
<tr>
<th>Point</th>
<th>North (ft)</th>
<th>East (ft)</th>
<th>Elevation (ft)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PT</td>
<td>1</td>
<td>5000.0000</td>
<td>5000.0000</td>
<td>START</td>
</tr>
<tr>
<td>OCP</td>
<td>2</td>
<td>900.0000</td>
<td>108.0000</td>
<td></td>
</tr>
<tr>
<td>H1</td>
<td>3</td>
<td>178.0000</td>
<td>0.0000</td>
<td></td>
</tr>
<tr>
<td>OCP</td>
<td>4</td>
<td>269.5290</td>
<td>711.3200</td>
<td>P2</td>
</tr>
<tr>
<td>H2</td>
<td>5</td>
<td>5.430</td>
<td>6.0000</td>
<td></td>
</tr>
<tr>
<td>OCP</td>
<td>6</td>
<td>262.5448</td>
<td>457.7600</td>
<td>P3</td>
</tr>
<tr>
<td>H3</td>
<td>7</td>
<td>5.420</td>
<td>6.0000</td>
<td></td>
</tr>
<tr>
<td>OCP</td>
<td>8</td>
<td>261.2756</td>
<td>987.2500</td>
<td>P4</td>
</tr>
<tr>
<td>CL+AB</td>
<td>9</td>
<td></td>
<td></td>
<td>P5</td>
</tr>
</tbody>
</table>

![Image of Compass adjustment with Angle Balance dialog box]

Chapter 11. Survey Menu
**First half of process report:**

Process Results 05/23/2002 10:06  
Raw file> c:/scadxml/data/example.rw5  
CRD file> C:/scadxml/DATA/example.crd

Scale Factor: 1.00000000  
Correct for Earth Curvature: OFF  
Starting Point 1: N 5000.00 E 5000.00 Z 100.00  
BackSight Azimuth: 178°00'42''

<table>
<thead>
<tr>
<th>No.</th>
<th>Description</th>
<th>Angle (Northing)</th>
<th>Arrow</th>
<th>Zenith Angle (Easting)</th>
<th>Slope Dist</th>
<th>Inst Rod</th>
<th>Northing</th>
<th>Easting</th>
<th>Elev</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>AR268.5330</td>
<td>89.4050</td>
<td>711.32</td>
<td>5.32</td>
<td>6.00</td>
<td>5038.43</td>
<td>5710.27</td>
<td>103.29</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>AR262.5448</td>
<td>89.3236</td>
<td>457.76</td>
<td>5.43</td>
<td>6.00</td>
<td>4587.89</td>
<td>5791.20</td>
<td>106.36</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>AR208.5710</td>
<td>89.1803</td>
<td>201.31</td>
<td>5.40</td>
<td>6.00</td>
<td>4397.30</td>
<td>5726.43</td>
<td>108.22</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>AR247.1657</td>
<td>88.5235</td>
<td>497.12</td>
<td>5.40</td>
<td>6.00</td>
<td>4363.08</td>
<td>5230.59</td>
<td>117.37</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>AR289.3456</td>
<td>91.4405</td>
<td>112.45</td>
<td>5.40</td>
<td>6.00</td>
<td>4471.32</td>
<td>5260.88</td>
<td>113.36</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SS1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>AR277.4835</td>
<td>90.2926</td>
<td>223.98</td>
<td>5.40</td>
<td>6.00</td>
<td>4586.54</td>
<td>5245.67</td>
<td>114.85</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>AR92.4143</td>
<td>90.2746</td>
<td>233.88</td>
<td>5.40</td>
<td>6.00</td>
<td>4613.25</td>
<td>5013.33</td>
<td>112.36</td>
<td></td>
</tr>
<tr>
<td></td>
<td>P7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>AR261.2756</td>
<td>91.4405</td>
<td>387.25</td>
<td>5.42</td>
<td>6.00</td>
<td>5000.09</td>
<td>4999.97</td>
<td>100.06</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CLOSE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Closure Results (Before Angle Balance)

Starting Point 1: N 5000.00 E 5000.00 Z 100.00  
Closing Reference Point 1: N 5000.00 E 5000.00 Z 100.00  
Ending Point 8: N 5000.09 E 4999.97 Z 100.06  
Azimuth Error : 341°38'22''  
North Error : 0.09061  
East Error : -0.03007  
Vertical Error: 0.05953  
Hz Dist Error : 0.09547  
Sl Dist Error : 0.11251  
Traverse Lines> 7  
SideShots> 1  
Horiz Dist Traversed: 2712.29  
Slope Dist Traversed: 2712.62  
Closure Precision: 1 in 28409

**Remainder of process report:**

Compass Closure
Adjusted Point Comparison

<table>
<thead>
<tr>
<th>Original</th>
<th>Adjusted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point#</td>
<td>Northing</td>
</tr>
<tr>
<td></td>
<td>Northing</td>
</tr>
<tr>
<td>2</td>
<td>5038.445</td>
</tr>
<tr>
<td>3</td>
<td>4587.914</td>
</tr>
<tr>
<td>4</td>
<td>4397.319</td>
</tr>
<tr>
<td>5</td>
<td>4363.044</td>
</tr>
<tr>
<td>6</td>
<td>4586.509</td>
</tr>
<tr>
<td>7</td>
<td>4613.178</td>
</tr>
<tr>
<td>8</td>
<td>5000.017</td>
</tr>
</tbody>
</table>

Max adjustment: 0.097
Starting Point 1: N 5000.00 E 5000.00 Z 100.00
BackSight Azimuth: 178°00'42''

<table>
<thead>
<tr>
<th>Point</th>
<th>Horizontal</th>
<th>Zenith</th>
<th>Slope</th>
<th>Inst</th>
<th>Rod</th>
<th>Northing</th>
<th>Easting</th>
<th>Elev</th>
</tr>
</thead>
<tbody>
<tr>
<td>No.</td>
<td>Angle</td>
<td>Angle</td>
<td>Dist</td>
<td>HT</td>
<td>HT</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>AR268.5326</td>
<td>89.4050</td>
<td>711.34</td>
<td>5.32</td>
<td>6.00</td>
<td>5038.44</td>
<td>5710.29</td>
<td>103.29</td>
</tr>
<tr>
<td>P2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>AR262.5434</td>
<td>89.3236</td>
<td>457.76</td>
<td>5.43</td>
<td>6.00</td>
<td>4587.91</td>
<td>5791.26</td>
<td>106.36</td>
</tr>
<tr>
<td>P3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>AR208.5704</td>
<td>89.1803</td>
<td>201.30</td>
<td>5.40</td>
<td>6.00</td>
<td>4397.31</td>
<td>5726.52</td>
<td>108.22</td>
</tr>
<tr>
<td>P4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>AR247.1657</td>
<td>88.5235</td>
<td>497.09</td>
<td>5.40</td>
<td>6.00</td>
<td>4363.03</td>
<td>5230.69</td>
<td>117.37</td>
</tr>
<tr>
<td>P5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>AR289.3456</td>
<td>91.4405</td>
<td>112.47</td>
<td>5.40</td>
<td>6.00</td>
<td>4471.28</td>
<td>5260.97</td>
<td>113.36</td>
</tr>
<tr>
<td>SS1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>AR277.4839</td>
<td>90.2926</td>
<td>223.99</td>
<td>5.40</td>
<td>6.00</td>
<td>4586.50</td>
<td>5245.75</td>
<td>114.85</td>
</tr>
<tr>
<td>P6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>AR92.4130</td>
<td>90.2746</td>
<td>233.88</td>
<td>5.40</td>
<td>6.00</td>
<td>4613.16</td>
<td>5013.42</td>
<td>112.36</td>
</tr>
<tr>
<td>P7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>AR261.2758</td>
<td>91.4405</td>
<td>387.27</td>
<td>5.42</td>
<td>6.00</td>
<td>5000.00</td>
<td>5000.00</td>
<td>100.06</td>
</tr>
<tr>
<td>CLOSE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Shown above is the resulting process report. The angle balance had an error of 39 seconds which was divided among the 7 traverse sides. The Compass Closure shows how each traverse point was adjusted and then the resulting adjusted angles and distances.

Here is another layout of the last example that shows an external backsight setup. In this case there are two known points. Point 1 is the starting point and point 21 is the initial backsight. The setup could also use a backsight azimuth (ie north azimuth for example) instead of a backsight point number.
The closing record setup has changed from the last example. In this example, the shot from 7 to 8 is the closing shot with point 8 as the closing point. The closing reference point is still point 1. The angle balance shot is from 8 to 9 and the reference angle is from 1 to 21.

The traverse starts from the known point 1 and ends at the known point 14. In this case there is no angle balance shot. The closing shot is from 3 to 4 with point 4 being the closing point. Point 14 is the closing reference point.

The closing record setup has changed from the last example. In this example, the shot from 7 to 8 is the closing shot...
with point 8 as the closing point. The closing reference point is still point 1. The angle balance shot is from 8 to 9 and the reference angle is from 1 to 21.

Here is an example of an open traverse.

**Compass Report from Open Traverse example:**

**Process Results**

Raw file: d:/scdev/data/tsurvey.rw5
CRD file: d:/scdev/data/tsurvey.crd

**Compass Closure**

**Adjusted Point Comparison**

<table>
<thead>
<tr>
<th>Original</th>
<th>Adjusted</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point#</td>
<td>Northing</td>
</tr>
<tr>
<td>2</td>
<td>5013.76</td>
</tr>
<tr>
<td>3</td>
<td>4560.69</td>
</tr>
<tr>
<td>4</td>
<td>4372.46</td>
</tr>
</tbody>
</table>

Point Horizontal Vertical Slope Inst Rod Northing Easting Elev

<table>
<thead>
<tr>
<th>No.</th>
<th>Angle</th>
<th>Angle</th>
<th>Dist</th>
<th>HT</th>
<th>HT</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>AR133.5324</td>
<td>89.4050</td>
<td>711.27</td>
<td>5.32</td>
<td>6.00</td>
</tr>
<tr>
<td>3</td>
<td>AR262.5506</td>
<td>89.3236</td>
<td>457.74</td>
<td>5.43</td>
<td>6.00</td>
</tr>
<tr>
<td>4</td>
<td>AR208.5712</td>
<td>89.1803</td>
<td>201.30</td>
<td>5.40</td>
<td>6.00</td>
</tr>
</tbody>
</table>

The traverse starts from the known point 1 and ends at the known point 14. In this case there is no angle balance shot. The closing shot is from 3 to 4 with point 4 being the closing point. Point 14 is the closing reference point.

*Portion of typical Sokkia/SDR raw data file:*

00NMSDR20 V03-05 Jan-22-98 19:14 122211
10NMW970709A
13CPSlevel crn: N
02TP00015000.000005000.0000085.6350005.2200000PK-FD
08KI00035000.000005192.9200081.7450000MN-SET
Chapter 11. Survey Menu

Portion of typical Wild/Leica raw data file:
410001+000000SB 42....+00000000 43....+00000000 44....+00000000 45....+00000000 110002+00000002
21.124+35959590 22.104+08748240 31...1+00000000 51..0.+0012+000 110003+00000003
21.124+00000000 22.104+08748240 31...1+00267075 51..0.+0012+000 110004+00000004
21.124+00420390 22.104+08702570 31...1+00168234 51..0.+0012+000 110005+00000005
21.124+26029130 22.104+09311370 31...1+00206133 51..0.+0012+000 410006+000000IP 42....+00000000
43....+00000000 44....+00000000 45....+00000000 110007+00000000 21.124+25827090 22.104+09504550
31...1+00106228 51..0.+0012+000 110008+00000007 21.124+27151500 22.104+09312240 31...1+00106066
51..0.+0012+000

Portion of typical SMI raw data file:
CM Definitions: SS: Side Shot; TR: Traverse; OC: Occupied Coordinates;
PC: Point Coordinates; CM: Comment; OS: Occupied Station;
TS = time stamp; e = electronic; m = manual; CM TS TUE 04/09/91 09:41:25PM
PC 1 5000.00000 5000.00000 0.00000
SS e HI:4.000 HR:5.000 PIPE/F
0 1 2 BAZ:0.00000 AR:0.00040 ZA:91.24330 SD:92.020
SS e HI:0.000 HR:0.000 BC/BR FRAME 1ST
0 1 3 BAZ:0.00000 AR:28.47220 ZA:91.20250 SD:65.240

Portion of typical PC COGO raw data file:
* NEW SET UP INST. AT 1 359 59 59 ON 4
L ANG 1000 4 1 77 18 52 4.44 * 1000 WALL# 283.22
L ANG 1001 4 1 55 44 28 9.8 * 1001 WALL# 283.28
L ANG 1002 4 1 38 37 8 15.89 * 1002 WALL# 283.48
L ANG 1008 4 1 27 18 34 123.82 * 1008 WALL# 287.75

Portion of typical Nikon raw data file:
MP,NOR,,5000.0000,5000.0000,100.0000,1
ST,NOR,,1,,5.0000,0.0000,0.0000
SS,1.5.0000,131.0605,91.3744,88.4935,10:36:15,CL1
SS,2.5.0000,137.6770,90.2923,88.5236,10:36:50,CL1

Portion of typical MDL/Laser raw data file:
D052097F04P52I494P01P02
H32473V-0639R016202P03
H06687V-0706R014936P91
H03840V-0483R017380

Portion of typical Geodimeter raw data file:
50=HAWTHORN
54=19398
23=3222
2=1
37=1000.00
38=5000.00
39=700.00

Portion of typical Survis raw data file:
_OCCUPY_PNT_
621 616 5.140
148.36076
Edit-Process Level Data

This command is for entering and calculating level data. It has a spreadsheet editor for entering the level measurements, and the level calculations are updated as the data is entered. There is also a processing and reporting feature.

Carlson Software supports two level file formats:

**LEV Files:** The .LEV file is the old format. You can still edit and process files in this format. The LEV format only supports differential levels, single and three-wire. The LEV file has 5 record types:

1) **SR** - Start Record. Contains the starting benchmark measurement.
2) **TP** - Turning point record, contains the backsight and foresight to the turning point.
3) **LV** - Side Shot (or level) record. Contains the foresight measurement to the point.
4) **ER** - End Record, contains the measurement to the ending benchmark.
5) **Note/Comment** - starts with two dashes

**TLV Files:** The TLV file format can contain Differential and/or Trig-Level data. This is Carlson's new format and is supported by SurvCE (Carlson data collection program). The TLV file has the following record types:

1) **H1** - First header record contains project information
2) **H2** - Second header record contains date, time, temperature and pressure information
3) **BM** - Benchmark record, contains the point number, elevation and description of the benchmark.
4) LS - Rod height, only used with TRIG-LEVEL data.
5) BS- Backsight measurement. This record contains the backsight point number and measurement:
   a) Differential data: VD and HD - Vertical Difference (rod reading) and Horizontal Distance
   b) Trig data: SD/ZE - Slope Distance and Zenith Angle
6) FS - Foresight measurement. This record contains the foresight point number and measurement.
   a) Differential data: VD and HD - Vertical Difference (rod reading) and Horizontal Distance
   b) Trig data: SD/ZE - Slope Distance and Zenith Angle
7) Note/Comment - starts with two dashes

This routine runs the *.TLV / *.LEV file editor and file report functions.

**LEV File Editor:**
If you are creating a new .LEV file, you must choose either single-wire or three-wire for your level format data entry preference.

Three Wire leveling, or precise leveling, is a process of direct leveling wherein three cross hairs, or threads, are read and recorded rather than the single horizontal cross hair. Note below, in the sample three-wire editor graphic, the additional columns representing top and bottom readings.

The commands starts by asking you, with a dialog box, to select an existing level file (.LEV) to process or to select a name for a new level file. The below examples are using existing files. Once this choice is made the small, Level Format dialog appears.

Regardless of whether you choose Single or Three Wire, the Level Editor appears in its own window. Below we see the editor displaying the contents of two existing files of level information. One is single wire and the other is three wire. The pulldown menus are the same for both, as described below in detail.

In the spreadsheet, the background color of the cells indicate the data type. White cells are for user-specified values. Blue cells are program calculated values. Black cells are data fields that aren't used by the level record for that row.
**Level File Editor - sample Single Wire data**

**Level File Editor - sample Three Wire data**

**File->Settings**

**File**: Standard File routines - Open, Save, Save As, Settings, Print and Exit. Settings brings up a dialog where you can adjust the 3-wire tolerance and distance values. Open will allow you to open up another existing .LEV file.

**File->Import**: This routine imports Carlson .LEV format, Leica level data in .GSI or .XML format, TDS .RAW format, Topcon or Trimble .DAT format into the level editor.

**File->Settings**: This function has a setting for whether to use the Report Formatter for the Print function. The Report Formatter allows for customized reports and output to Excel. Without the Report Formatter, the Print function creates an automatic report.
Edit: Cut, Copy, Paste and Go To. Go To will take you to the row of your choosing.
Add: These options provide the standard level run routines. Details on each and a graphic of the pulldown follow.
Tools: This pulldown is for adjusting and storing elevations.

The Add and Tools pulldowns at the top of the editor provide the following features:

![Add Menu](image)

**Level Editor - Add pulldown menu**

**Level Start (SR):** Starts the level run, usually with a know starting elevation or benchmark.

**Level Turning Point (TP):** Turning point procedure for leveling.

**Level Side Shot (LV):** For entering leveling side shots.

**Level End (ER):** Enter your value.

**Note:** You can add a note, or comments, into the editor as you move through the level run.

![Tools Menu](image)

**Level Editor - Tools pulldown menu**

**Adjust Elevations:** This function will do a simple adjustment of your level data and place the adjusted elevations in the Adjusted Elevation column. If you are running 3 wire level loop the corrections will be inversely proportionate to the distance between the measurements. If you are running a single wire level loop, the corrections will be averaged by the number of turns.

**Store Elevations to Coordinate File:** If you have an active coordinate file passed to the level editor, this function will be available to store the elevations calculated in the level file to the active coordinate file by matching point numbers. The point number in the level file must match the point number in the coordinate file for an elevation to be stored. If adjusted elevations have been calculated, they will be stored. If not, the unadjusted elevations will be stored. This function shows a report of the original elevations from the coordinate file and the level elevations and reports matching or missing points numbers. After the report, there is a prompt to confirm whether to store the elevations to the coordinate file.
Selecting Print (editor File menu) provided this Level File Report sample

**Editor Columns:**

**Type:** These are small pulldown menus with two-letter level procedure choices. The two letters are abbreviations as indicated in the next dialog. These steps may be made with the Add pulldown or with this method. The options are SR, TP, ER, LV and DS. DS stands for description shot.

**Point #** - Point number of measurement.

**BS** - Backsight rod reading

**HI** - Calculated height of instrument

**FS** - Foresight rod reading

**Elevation** - Elevation of point

**Code:** The code is used by SurvNet for network least-squares processing of networked level loops. The code can be either EL or FE where EL is for calculated elevations and FE is for fixed elevations. FE should only be assigned to a START or END record (where you can enter the value for the adjusted elevation). If FE is assigned to an intermediate record it is ignored. Here is how the FE records are used. Say you run from one benchmark to another (point 1 to point 10). Point 1 and point 10 are the START and END records of the first loop and both are FE records. Then you start another loop at point 5 (halfway between 1 and 10). This is not a benchmark and can be adjusted so it should be assigned an EL code. Point 5 is the START record for the second loop. You run from point 5 to point 20 which is a benchmark. Point 20 is the END record and is assigned an FE code. When SurvNET processes the file, it will hold points 1, 10 and 20, allowing all others to be adjusted, including point 5 (even though it is a START record).

**Adjusted Elevation** - Adjusted elevation of point

**Description** - description of point

**TLV File Editor:**

TLV files can contain trig-level and/or differential level data. The editor will allow both type records in the same file.

Below is a sample Trig-Level TLV file:
Below is a sample Differential-Level TLV file:

<table>
<thead>
<tr>
<th>No</th>
<th>Edt</th>
<th>Add</th>
<th>Tools</th>
<th>Geo</th>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>BM</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Below is a sample Differential-Level TLV file:

<table>
<thead>
<tr>
<th>No</th>
<th>Edt</th>
<th>Add</th>
<th>Tools</th>
<th>Geo</th>
<th>ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>BM</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Menu Options:

**File Menu:**

*Open* - Open an existing .TLV file.

*New* - Creates a new TLV level file.

*Save* - Save changes

*Save As* - Save as different file name

*Settings* - Not used with TLV files.

**Import** - You can import the following level file formats: Leica GSI format, Leica XML format, and Trimble DAT format.

**Print** - get hard copy printout of data.

*Exit* - Exit Level Editor Program

**Edit Menu:**

*Clipboard: Cut, Copy, Paste*

*Go To* - "Go To" will take you to the row of your choosing. Enter the row number.
Add Menu:
Add: These options allow you to add or insert a new record into the level editor.
Benchmark Record (BM): Point with known elevation.
Backsight Record (BS): Differential-level measurement to the backsight point.
Foresight Record (FS): Differential-level measurement to foresight point.
Backsight Record (BT): Trig-level measurement to the backsight point.
Foresight Record (FT): Trig-level measurement to foresight point.
Note: You can add a note, or comments, into the editor as you move through the level run.

Tools Menu:

Adjust Elevations: This function will do a simple adjustment of your level data and place the adjusted elevations in the Adjusted Elevation column. If you have distances, either HD or SD for all your measurements, the corrections will be inversely proportionate to the distance between the measurements. If you are running a single wire level loop (VD but no HD), the corrections will be averaged by the number of turns.

Store Elevations to Coordinate File: It is important that the point numbers in the level file match the point numbers in the coordinate file. If you have an active coordinate file passed to the level editor, this option will be available to you. The elevations calculated in the level file will be stored in the active coordinate file by matching point numbers. The point must exist in the coordinate file before an elevation will be stored. After the elevations have been stored, a report will show which points were stored and which ones were not. If adjusted elevations have been calculated, they will be stored. If not, the unadjusted elevations will be stored.

Editor columns

Measurement records will have the following columns:
Trig Level Record:
Type - Two character abbreviation that shows the record type:
BM - Benchmark
BS - Differential-level backsight record
BT - Trig-Level backsight record
FS - Differential-level foresight record
FT - Trig-Level foresight record
DS - Note or Comment
Point # - Point number of measurement.
RodHt - Rod reading
Zenith - Zenith angle
S.Dist - Slope Distance
HI/Elev - Elevation of HI if a backsight record, or the foresight point if a foresight record
Adjusted Elevation - Adjusted elevation of foresight point
Description - description of point

Differential Level Record:
Type - Two character abbreviation that shows the record type, same as above.
Point # - Point number of measurement.
V.Diff- Rod Reading
H.Dist - Horizontal Distance
HI/Elev - Elevation of HI if a backsight record, or the foresight point if a foresight record
Adjusted Elevation - Adjusted elevation of foresight point
Description - description of point

Pulldown Menu Location: Survey
Keyboard Command: diglevel
Prerequisite: .LEV (level) file to process

**Edit Process SDMS File**

This command processes SDMS format raw data from PRJ files. There is a spreadsheet editor with the data tag, value and description for each of the records. The processing functions are the same as the Edit Process Raw Data command. See that section of the manual for a description of the processing functions. The Edit Process SDMS command allows you to work with the SDMS raw data in its native format. Alternatively, you can run Edit Process Raw Data and convert the SDMS PRJ file into a Carlson RW5 file.

![SDMS Editor Screenshot](image)

**Pulldown Menu Location:** Survey

**Keyboard Command:** sdmsedit

**Prerequisite:** None

**Draw Field to Finish**

This command turns data collector field notes into a final drawing by matching the descriptions of the field points with user-defined codes. The points are brought into the drawing with attributes defined by the code, including the layer, symbol, size and linetype. Draw Field to Finish also uses an improved coding method.
Example drawing results using the example points and example code definitions
Two files are used in Draw Field to Finish - a coordinate file and a field code definition file. The coordinate file
consists of point#, x,y,z points with text description fields. The description fields contain codes for the Draw Field
to Finish processing. An ASCII data file can be converted into a coordinate file using the Import Text/ASCII File
command. The field code definition file defines the layer, symbol, size and other actions to apply with each code.
These file names are displayed at the top line of the Draw Field to Finish dialog box.
Draw Field to Finish can translate the field points into Carlson points (also called coordinate geometry points
or cogo points) with a symbol, layer, and size defined by the code. The point settings of whether to label the
description, point number, and elevation and whether to locate the point at zero or at the real Z can be found in
the Additional Draw Options of the Draw Field to Finish dialog box. The Draw-Locate Points command has these
point settings stored separately in the Point Defaults menu. Draw-Locate Points provides a simpler method for
drawing points compared with Draw Field to Finish.
Field-to-Finish will layerize the points and linework according to the code definitions. If the layers to use are not
already defined, Field-to-Finish will create the necessary layers and assign different colors. To have the same colors
for these layers in all your drawings, define the layers in the prototype drawing. The prototype drawing is the
default drawing that is loaded whenever a new drawing is created. To define layers in the prototype drawing, save
your current drawing and then start a new drawing with the New command. Don't give the new drawing a name,
just click OK. Then define the layers as desired with the Layer command. When you are done creating layers, use
the Save As command and change to Drawing Template (.DWT) under Save as Type. The default drawing template
that is used is named Carlson12.DWT. This template name will correspond to the version of AutoCAD that is being
used. You can overwrite this default template or make a new drawing template. If you make a new one, you may
want to edit the Carlson icon to use the new one. To edit the icon, highlight the icon with one click and then click
the right mouse button. Choose Properties and then Shortcut and change the drawing template name.
There are two different methods for connecting linework. One method creates line work by connecting points with
the same code. The linetype is defined by the code as either points only (no line work), lines, 2D polylines, both
2D and 3D polylines, or 3D polylines (breaklines). Distinct lines with the same code are defined by adding a group
number to the end of the code name in the data file. With this method, all points with the description CODE1 will

Chapter 11. Survey Menu

625


be one line while points with CODE2 will be another line. Both CODE1 and CODE2 use the definition for CODE. For example, the code EP could be a code for edge of pavement that is to be connected as 3D polylines. If there are two separate edge of pavement lines on the left and right sides of a road, all the points for the left side could have the description EP1 and the points on the right side could be EP2.

The second method is the PointCAD format. This method also connects points with the same code. The difference is that instead of using a number after the code for distinct lines, you use the same code with an additional code for starting and ending the line. For example, +0 is used to start a line and -0 to end. So the coding for a segment of edge of pavement could be EP+0, EP, EP, EP-0. Another special code that has been added to Field to Finish is +7, -7. This 7 code will use the linetype definition of line, 2D polyline or 3D polyline defined by the Draw Field to Finish code. For example, if EP is defined as a 3D polyline, then the coding EP+7, EP, EP, EP-7 will create a 3D polyline. Otherwise codes like +0, -0, which is defined as start and end line, will draw EP as a line. Other PointCAD special codes are: +4 starts a curved 2D polyline, +4 starts a closed curved 2D polyline, +1 begins a 3-point arc, +5 starts a 3D polyline, +5 starts a closed 3D polyline, +6 starts a 2D polyline, +6 starts a closed 2D polyline, +7 starts a line whose type is specified by the field code definition, -05 starts a curved 3D polyline section, -50 ends that section, +8 starts a 2D and 3D polyline combination, +8 starts a closed 2D and 3D polyline combination, -08 starts a 2D and 3D polyline combination curved section, -80 ends that section. //, followed by a field code, concatenates that field code's description on to the point's description. For example, OAK//04 might become LIVE OAK TREE 4" if the field code OAK translates to LIVE OAK TREE and the field code 04 translates to 4".

The advantage to the PointCAD method is that you don't have to keep track of line numbers. For example, if you are surveying 50 curb lines, the first method would require you to use 50 distinct curb numbers. The advantage to the first method is that you don't have to use the start and end codes. Also the Nearest Found connection option applies to the first method.

**Draw**

![Draw Field to Finish](image)

**Range of Points:** Specify the range of points to draw.

**Point Group:** Specify the point group(s) to process.

**Entities To Draw:** The Points option draws only the points and point attributes. The Lines option draws only the
linework and the Symbols draws only the symbols. Any combination of these options can be processed as well as individual processing of each entity.

**Draw Within:** These options are methods to filter the points to draw. The Polyline method prompts for a closed polyline and only draws points inside this polyline. The Distance method uses a specified center point and distance to only draw points within this circle. The Window/Coordinate Range prompts for lower left and upper right points to define the rectangular area to draw points.

**Layer Prefix:** Optional layer prefix added to all entities drawn with Draw Field to Finish.

**Erase Existing Draw Field to Finish Entities:** When checked, this option will erase from the drawing any old entities created by previous Field-To-Finish runs before drawing the new entities.

**Erase In Range:** This option only erases and redraws those Draw Field to Finish entities that are within the specified range of points to process.

**Preview Only:** When checked, this option will temporarily draw the points and linework and allow you to review it with zoom and pan.

**Fix Overlaps:** This option checks the points drawn by Field-to-Finish for any point labels that overlap with other points or linework. For any overlaps, the point labels can be automatically moved or you can step through each overlap to decide how to handle it. See the command called Fix Point Attribute Overlaps in the Points chapter for more information on this feature.

**Code Table:** Sets the FLD file to process which contains the code definitions.

**Coordinate File:** Sets the CRD file to process which contains the point numbers, coordinates and descriptions.

**GIS Table:** Sets the GIS file which defines the GIS feature and attribute names. This file is optional and is used in GIS processing.
**Additional Draw Options**

**Point Label Settings:** Specify whether you want Draw Field to Finish to label the Point Numbers, Descriptions, and/or Points Notes which are contained in the note (.NOT) file that is associated with the coordinate (.CRD) file.

**Elevation Label Settings:** Specify the elevation labeling options. The Elevations toggle controls whether to draw the elevation attribute label for the points. The Label Zeros option will label the elevations of points with z=0. The Prefix and Suffix By Code sets whether to use the general Prefix and Suffix for all point elevation labels from this dialog or use the Prefix and Suffix defined in each code definition. Use ‘+’ and Use ‘-’ will place the appropriate symbol in front of the elevation. The Label In Inches option allows for elevation label in feet and inches instead of in decimals.

**Locate Points on Real Z Axis:** Choose between locating all the points at real Z elevation, all at zero elevation or to use the real Z setting as defined in the individual codes.

**Locate Linework on Real Z Axis:** Choose between drawing all the linework at real Z elevation, all at zero elevation or to use the 2D/3D polyline setting as defined in the individual codes.

**PC-PT Curve Type:** Sets the method for drawing curves with more than 3 points. The Bezier option draws a smooth polyline through all the curve points. The Sequential Arcs method draws multiple arcs with arc end points at each of the curve points. These arcs are tangent to the preceding line segment. The Best Fit method creates a single best-fit curve for all the curve points between the PC and PT.

**Adjust PC/PT for Arcs to be Tangential:** This option will adjust the PC and PT polyline vertices to make the curve tangential. The program will only adjust these points is the adjustment distance is less than the specified tolerance. This option applies to cases where the tangents are well defined and the PC/PT are harder to survey exactly.

**Creating Point Groups:** Point Groups can be created in one or two different ways. Each field code definition can specify Point Group(s) that all point numbers that use that code will be added to. Multiple field codes can use the same Point Group name. Check the By Code Definition checkbox for that option. The second method is to automatically create Point Groups for each code that is processed. Check the Automatically By Code checkbox for that option. Ignore Code Suffix, if checked, will cause the codes to be considered after removing the numeric suffix. For example, points with the EP10 and EP11 codes will both be automatically added to the Point Group named EP. No matter how the Point Group is created, the Group Name Prefix can be used to add a prefix to the group name. Note: if the Point Group already exists, it will be erased first before being created again by either of these two methods.

**Creating Point Notes:** These options append point notes to the coordinate file data for some of the data fields processed by Field-to-Finish. These notes can then be used by other commands like List Points to report these fields. For example, this enables List Points to report both the point coordinate file description as well as the point drawing description as generated by Field-to-Finish.

**Keep Layers Frozen:** This option will not thaw layers that Field-to-Finish uses for drawing entities. So when you have this option on and some layers are frozen, then you won’t see the entities that Field-to-Finish creates until you thaw those layers.

**Output Caice TSS File:** This option creates a TSS file from the processing results.

**Allow 3D Arcs:** When creating polyline arcs with the PC special code, this option checks whether to create the arc in 3D for tilted or vertical arcs such as a doorway or bridge arch. Otherwise, only the 2D coordinates are used to define the curvature.
**Flip Text for Twist Screen:** This option will rotate the point labels and symbol by 180 degrees when needed to make them right-side up readable relative to the current twist screen drawing view. This option applies to the Rotate To Line and Rotate special code (ROT).

**Set Levels By Codes:** This option assigns the optional Level Names for use by selection filters.

**Auto Zoom Extents:** When checked, this will force a zoom extents after Draw Field to Finish is done.

**Pause on Undefined Codes:** When checked, Draw Field to Finish will pause if it encounters a description that is not defined in the code table.

![Screenshot of the 'Undefined code found prior to drawing' window](image)

**Abort without drawing anything:** This stops the command. Run Draw Field to Finish again to correct the code table.

**Use the default settings for this point:** This option draws a point in the "MISC" layer with no linework. To set your own default, define a code called "SC_DFLT".

**Use default settings for all undefined codes:** This option will draw all undefined codes in the "MISC" layer by default or a user specified layer as defined in the "SC_DFLT" code. A good way to check the data file for unmatched descriptions is to use the Print Table command and choose the Data Points and Distinct Code options. This command will print the different codes in the data file and identify any undefined codes.

**Report Codes/Points**

This routine prints the code table or the data file to the screen, file, or printer. A useful option here is to print the data file (CRD Points) and choose Sort by Codes which will group the data points by distinct codes.

![Screenshot of the 'Report Codes/Points' window](image)

**Edit Codes**
The Field to Finish dialog box allows you to load the coordinate and field code definition files, view and edit the code definitions, view and edit the coordinate file, view reports, and then return to the Draw Field to Finish dialog box to process the files. The top section displays the code definitions. The bottom section has three columns of functions each pertaining to controls for different elements of the command. The Code Table section provides controls for settings, sorting and reporting of codes. The Code Definitions section provides tools for the creation and editing of codes. The Feature Settings section provides controls for the special tree and pipe feature types.

The code table editor has a list of categories and a spreadsheet of codes. The spreadsheet shows the codes for the currently highlighted category. The category toolbar buttons allow you to add, remove, edit the names and change the order of the categories. There are two fixed categories. The Unassigned category shows any codes with blank categories. The All category shows all the codes. You can control which fields are visible in the spreadsheet by using the Column Options button. You can make edits to the fields in the spreadsheet or highlight a row and pick the Edit button to bring up a dialog to edit the code.

**Code Table**

**Code Table Settings:** These options provide tools for defining the coding method to be used for processing of the point data. Various import tools allow for the importing of codes from different software packages. Controls for handling multiple codes are located on this dialog. All special codes can be replaced to other characters defined by the user. The special codes are listed and edited on this dialog.
Set: Choose this button to specify a new code table. The name of the current table is shown in the field to the right of this button.

Coding Method

Carlson Coding: When checked, this option interprets and processes coordinate files based upon the Carlson Coding method and data collection method.

Eagle Point Coding: When checked, coordinate files are processed based on the Eagle Point Data Collection method. When selected the Eagle Point Codes button becomes available for selection and displays the following dialog. This dialog allows for customization of the eagle point special designators.

Currently the supported designators include, "Field Code", "Point-On-Curve", "Close Line", "Line End", "Insert Description" and "Bearing Close". Also supported is the ability to recognize overwriting of descriptions just as Eagle Point does by using the space separator instead of the "Insert Description" designator. Examples of supported coding are as follows:

.\TC Places a node and or line per the field code library.
\TC Places a node and or line per the field code library.
\TC- Specifies a point on a curve.
\TC- Specifies a point on a curve.
..\TC Stops the line.
TC! Stops the line.
\TC+ Closes the line back to the starting point.
\TC+ Closes the line back to the starting point.
\TC# Typically coded on the third corner of a rectangle to close the figure with having to locate the fourth corner.
\TC# Typically coded on the third corner of a rectangle to close the figure with having to locate the fourth corner.
Places a node as specified by the code "WV" in the field code library and then begins a line as specified by code "W" in the field code library.

\texttt{.TC.EP.FL} Results in three lines coming together.

\texttt{TC1.TC2.TC3} Results in three lines coming together. All three lines are specified by the definition of the single code "TC" in the field code library.

\texttt{TC.TC1} When used in conjunction with the "Draw Field Codes Without a Suffix as Points Only" toggle, "TC" will be recognized as the node and "TC1" will be recognized as the line so that if the code "TC" in the field code library is defined as a polyline, line or 3D polyline, duplicate lines will not be unintentionally placed when this shot only pertains to a single element. Keep in mind that all line work must have a numeric suffix when using this toggle.

\texttt{TREE * OAK} Result on screen would be: TREE OAK

\texttt{TREE OAK *} Result on screen would be: OAK TREE

\texttt{TREE OAK} Result on screen would be: OAK

\texttt{TC1!.TC2-.VLT6#} Stops "TC1", continues "TC2" as a point on a curve and closes VLT6 as a rectangle using the "Bearing Close" code.

\texttt{Note: The use of the "Use Multiple Codes for Linework Only" toggle is recommended when using Eagle Point Coding.}

\texttt{CAiCE Coding:} When checked, coordinate files are processed based on the CAiCE Data Collection method. Examples of supported coding are as follows:

\texttt{169} is just the code 169.

\texttt{145C10} is the code 145 and line #10.

\texttt{169C25C} is the code 169, line #25, and the point is on a curve.

\texttt{172C12B} is the code 172, line #12, and this point closes the line.

\texttt{SDMS Coding:} This option processes coordinate files based upon SDMS coding method. When active, the program will prompt for an SDMS .PRJ file to process.

\texttt{LandXML Coding:} This method prompts for a LandXML or Leica/Hexagon HeXML file to use with the processing. This method applies when the point descriptions do not have linework coding and the LandXML file has PlanFeatures that define how points are connected to create linework. This method reads the LandXML file to find the points that begin and end lines and curves.

\texttt{Split Multiple Codes:} Multiple codes are defined by including each code in the point description field separated by a space. A single data point can be used in different lines by assigning it multiple codes. For instance, a point might be part of both a curb line and a driveway line with a description of "CURB DRW". Field-to-Finish uses spaces as the delimiter for multiple codes. You should avoid spaces in the descriptions except for where multiple codes are intended or after the "/" character. For example, a code for light post should not be "LGT POST" but instead should be "LGTPOST".

There are three options for the handling of multiple codes when encountered. The \texttt{All} option will split all multiple codes and process each code based upon their code definition. When \texttt{None} is select both codes will be processed based upon their code definition. If the \texttt{Prompt} option is checked on, when Field-to-Finish detects multiple codes on a point the following dialog will be displayed with options for handling the codes.
**Import Land Desktop Desc Key:** This option imports and converts a Land Desktop Description Key into a Carlson Draw Field to Finish (fld) code definition file. The Land Desktop Description Key file is a mdb file and is found in the Land Desktop Project file path. It is located in the under the COGO/DescKey directory.

**Import TDS Codes:** This option imports TDS codes into the Carlson Field to Finish (fld) code definition file.

**Import Topcon Codes:** This function imports Topcon codes and layers from an XML file.

**Import Trimble Codes:** This option imports Trimble .FXL file codes into the Carlson Field to Finish (fld) code definition file.

**Import Civil 3D Codes:** This option imports Civil 3D .fdb_xdef file codes into the Carlson Field to Finish (fld) code definition file.

**Import Eagle Point Codes:** This option imports Eagle Point codes into the Carlson Field to Finish (fld) code definition file.

**Import EFB:** This option imports the SDMS Electronic Field Book codes (.xml) into the Carlson Field to Finish (fld) code definition file.

**Import C&G Description Table:** This option imports C&G code tables (tbl) into the Carlson Field to Finish (fld) code definition file.

**Import Text/ASCII Codes:** This option imports code definitions from a user-defined format. Each row in the text file should represent one code. The program will prompt for the delimiter (ie. comma separated) that is used in the text file and then for the field type for each of the columns (ie. "Layer" or "Description").

**Import GIS Feature Codes:** This option imports features in a .GIS file from Define GIS Features into F2F codes.

**Import SurvCE Codes:** This option imports a SurvCE Feature Code List (fcl) into a Carlson Field to Finish (fld) code definition file.

**Export SurvCE Codes:** This option creates a SurvCE Feature Code List (fcl) from the current a Carlson Field to Finish (fld) code definition file.

**Merge Code File:** This function adds code definitions from another (fld) code definition file into the current code table. The program shows a list of the codes from the other file that are different than the current code table. You can choose which codes to import. Any codes that conflict with an existing code definition are defaulted to not import.

**Spreadsheet Editor:** This function lets you edit all the codes with all their settings in a single large spreadsheet. This method can be a handy way to use copy and paste to edit the codes. This method can also be quicker to make many changes than navigating the Edit Code dialog. This method is for expert users and you need to take care make
valid inputs.

**Draw Field Codes Without a Suffix as Points Only:** This option is useful for when wanting to use a field code sometimes for linework and sometimes for just points but it is preferred to number the lines rather than using start and stop codes. For example, if the field code EP is defined to use the Line Entity type, then EP25 will be drawn as a Line, however if just EP is used, no linework will connect to that COGO point.

**Use Multiple Codes:** When multiple codes are detected for a point, this setting controls how to draw the additional codes. The Linework and Points setting fully draws the multiple codes. The Linework Only method uses the multiple codes for drawing linework and only draws a point based on the primary code. If you want symbols for all multiple codes, then choose the Linework and Symbols option.

**Max Delta-Height for Linework:** Use this option to specify the maximum elevation difference that Draw Field to Finish should draw any section of linework. This option is for use with 3d polylines and lines.

**Max Length for Linework:** Specify the maximum length that Draw Field to Finish should draw any section of linework.

**Skip 1st/2nd Symbol Control When Missing 3rd Control:** For multi-point symbols when the 3rd control point is missing, this option centers the symbol on the 1st point instead of using the 1st point as a control point.

**Use MText for Linework Descriptions:** Controls whether to create MText or regular Text entities for linework description labels.

**Skip Multiple Z Labels For Linework At Same Z:** This option labels only the first point elevation for points on polyline or rectangle from the RECT code when the elevation difference between the points is less than the specified Z Tolerance and the horizontal distance is less than the Distance Tolerance. For example, for points on the corners of a level utility pad, this option will label the pad elevation just once.

**Stop Linework At Gap In Point Numbers:** This option is a method for controlling the start and stop of drawing linework. This method will automatically stop linework where there is a gap in the point numbers for the linework code. For example, if there are points with code EP then points with code CL then more points with code EP, the EP linework for the first set of EP points will stop at the last EP before the CL points and then new EP linework will begin.
Stop Linework For Different Point Groups: This option applies to when you have points for the same job collected at different times or with different crews and you want to prevent linework connecting points between them. For example, this applies when you survey a job with two crews and combine their points into a single CRD and both crews used "EP1". In this case, to keep each set of "EP1" separate, you can put each set of points into a separate point group with Point Group Manager and use this Field-to-Finish option. The Point Group Filter is optional and is used to make the program only check groups that match the filter. A point can be in multiple groups such as "CONTROL" and "DAY1". Some groups could be used for different days such as "CONTROL". So the Point Group Filter could be set to "DAY" to filter out the common groups and only process the time related groups.

Default Distinct Point Layer: These settings control the default layer for when the Distinct Point Layer option is turned on for each code definition.

Use Preceding Special Codes: This setting tells the program to expect the special codes before the main code. For example, if "BEG" is the special code for begin linework and "EP" is a main code, then the program looks for "BEG EP". The default sequence is for the special code to come after the main code as in "EP BEG".

Interpolate No Elevation Points for 3D Polyline: For points tagged as "No Elevation" that are part of a 3D polyline, this option will interpolate an elevation for this point from the other points in the 3D polyline. Otherwise, this point will be skipped in the 3D polyline.

GIS Special Codes: This option allows you to use GIS attribute for Field-to-Finish special coding. For a select group of special codes, a GIS attribute can be assigned. When processing the points, if a point has GIS data for the specified attribute, then that attribute value is used for the special coding. For example, you can have a GIS attribute of COMMENT set to the Append Description special code. Then if a point has a GIS attribute for COMMENT, the value of that COMMENT will be added to the description label for that point.

The Append Code option adds the GIS code to the description code to make the code for processing. For example, for a point with description "ROAD" and a GIS attribute named "TYPE" with a value of "DIRT", then set the GIS Special Code for Append Code to "TYPE" and the program will process this point using the combined code of "ROADDIRT".

Substitution Codes: This option defines a lookup table for translations of the raw point descriptions. This translation is done as a pre-processing step before the regular Field-to-Finish processing. For example, if you had a substitution setup for "25" = "EOP", then a point description of "25" would get translated to "EOP" and then this "EOP" would be processed with Field-to-Finish. Use the Import and Export functions to load and save
substitution codes to a comma separated text file. The Match With Number Suffix option will match with a number following the string. For example, "CL" will match with "CL2". Otherwise, the strings have to be an exact match.

**Special Codes:** This section allows you to substitute the existing predefined special codes and characters with your own. Draw Field to Finish recognizes several special codes. A special code is placed before or after the regular code with a space separating the code and special code. The Append Desc Auto Space option applies to the special codes that control the point description label. This option sets whether to insert a space in the description label when appending to the description.

Here is a listing of the default special codes and characters.

**Special Characters**
The characters (*, -, +, /, and _) can be used and substituted in Draw Field to Finish. The way these characters are used is that when the file is processed the description field is searched for these characters. If the "+" symbol was changed to "-" then the program would look for "-" and change it to "+". This is useful when a particular data collector may not have all the symbols available. With these substitutions you can make a character that is provided on the data collector generate the symbol needed. Multiple characters can also be used. For example "-" can be used to in order to produce a "/" character or any of the characters listed above.

Special Codes

"/": Append Description

Carlson points in the drawing have point attributes including a description. When Field-to-Finish draws the points, the point description from the coordinate file is processed to match a code. The code then defines the description that is drawn with the point. For example, consider a code of "UP" with a description of "POLE" and a data point with the description "UP". The data point description "UP" would be matched with the code "UP" and the point would end up being drawn with the description "POLE". A special character "/" (the forward slash or divide key) can be used for an unprocessed description to append. Everything after the "/" is added directly to the point description and is not considered a code and no further substitution is done on it. For example, a data point with the description "UP / 150" with the same code "UP" definition above would be drawn with the description "POLE 150".

"///": Replace Description
This special code takes the part of the description after the "///" and uses it as the point description label.

"\": Prefix Description
This special code takes the part of the description after the "\" and puts it as the prefix before the point description. For example, a data point with the description "TR 24ft" and a "TR" code definition with a description of "Tree" would be drawn with a description of "24ft Tree".

"//": Append Field Code Description
This special code causes text after the "/" to be interpreted as a field code. That field code's description is then appended to the first field code's description. For example, if the field code 02 has the description 2" and the field code OAK has the description oak tree, then 02//OAK will result in the point having the description of 2" oak tree. If the "/" character has been replaced with a different character, for example with a & character, then the "/" code would become "&&".

"\\": Prefix Field Code Description
This special code is the same as "/" except that field code's description is then prefixed instead of appended to the first field code's description.

"—": End Coding
The bar separator indicates the end of coding. Everything after the bar is ignored for Field-to-Finish processing.

MULT: Multiple Field Code
This code applies when the Split Multiple Codes under Code Table Settings is set to None and you want to override this setting and explicitly split selected codes. Multiple codes apply to points with dual code definitions for drawing two different style points or for connecting different linework to the same point. For example, if a point is both a sidewalk and driveway corner, then the point description could be "SW MULTDR".

PC: Start Curve
This code begins a three point arc or a curved line when used with the "PT" code (see below). The point with this special code is the first point on the arc. The next point with the code is considered a point on the arc, and third point with the code is the arc endpoint. For example (in point number, X, Y, Z, description format), 10, 500, 500, 0, EP PC - start curve
PT: End Curve

This code can be used with "PC" to define a curve with more than three points or a tangent two-point curve. Starting at the point with the "PC", the program will look for a "PT". If the "PT" is found, all the points between the "PC" and "PT" are used for the curve which is drawn as a smoothed polyline that passes through all points and only curves the polyline between points. If no "PT" is found, then the regular three point arc is applied as explained above. If no points are found between the "PC" and "PT", then the point prior to the "PC" and the point after the "PT" are used to create tangents for the resulting curve.

AFIT: Fit Arc

This special code adjusts the PC/PT points for the current arc to make the arc tangential. This special code is a way to individually control this tangential arc adjustment. To adjust all arcs within a specified adjustment tolerance, use the Adjust PC/PT setting under the Additional Draw Options from the first Field-To-Finish dialog.

BFIT: Best-Fit Line

This code creates a best-fit line using the points for the linework. This feature can be used when you have multiple points on a feature that you know is a straight line such as a sidewalk and you want a single line to be drawn. Each of the points that you want to include in the best-fit need to have the BFIT code.

CTOG: Curve Toggle

This special code toggles curve mode on and off. Instead of using PC to start a curve, you can use CTOG. Likewise, instead of using PT to end a curve, you can use CTOG.

CLO: Close

This code forces the lines drawn between a series of points with the same code to close back to the first point with the same code. For example, shots 1-4 all have the BLD description with the exception of point 4. Its description is BLD CLO. This will force the linework drawn for the BLD code to close back to point 1 which is the first point with the description of BLD.

GAP

This special code makes a single segment break in the current linework. For example, if you have a curb polyline that you want to break to skip over a driveway, then you could add the GAP code at the start of the driveway and continue the curb as normal on the other side.

NE: No Elevation

This code represents no elevation. A point with this special code is located at zero elevation.

YZ: Yes Elevation

This special code locates at the point entities at the coordinate elevation and overrides any other setting for locating the point at zero elevation.

NOS: Non-Surface

This code indicates that the point should be "non-surface"; that is, that it should be ignored when contouring or creating surfaces. This can also be controlled per-field code by turning on the Non-Surface toggle in the Edit Field Code Definition dialog box.

ZO: Elevation Only
This code represents elevation only (Z-Only). A point with this special code is used at part of a 3D polyline for elevating the 3D polyline without effecting the horizontal position of the polyline. For example, this code could be used on a grade break point along a cube where only the elevation should change and not the horizontal alignment.

**PHOTO**

This code attaches a photo file to the point. The name of the photo file should be right after the PHOTO code. The PHOTO Link setting controls whether the photo is attached using a Carlson-format link or a CAD Hyperlink. Use the Image Inspector command to view photos attached to points by either link method. To use the Hyperlink, you can Ctrl-click or right-click on the point entity.

In addition to the PHOTO code, Field-to-Finish will also automatically create the photo links for SurvCE photos. The program looks for the photo database from SurvCE which should have the same name as the coordinate file with an extension of .phdb. This photo database file should be in a sub-folder of the coordinate file folder and called Pictures_{X} where X is the name of the coordinate file. For example, if your coordinate file is C:\Projects\Job1\Job1.crd, then the program looks for C:\Projects\Job1\Pictures_Job1\Job1.phdb.

When SurvCE stores photos, it creates this photo database using this naming. So to process with Field-to-Finish, copy the coordinate file and photo files from the data collector to your computer.

**LABEL**

This code controls the point attribute format using a number after the code. This number uses 0=attribute block, 1=text, 2=both, 3=none. For example, LABEL1 means draw that point using text attributes.

**Offsets: OH, OV, OFL, OFB**

The codes "OH" and "OV" stand for offset horizontal and offset vertical. These offset codes apply to 2D and 3D polylines. A single set of offset codes can be used to offset the polyline a set amount. For example,

10, 500, 500, 100, EP OH2.5 OV-.5
11, 525, 527, 101, EP
12, 531, 533, 103, EP

This would create a polyline connecting points 10,11 and 12 and an offset polyline with a 2.5 horizontal and -0.5 vertical offset. The direction of the horizontal offset is determined by the direction of the polyline. A positive horizontal offset goes right from the polyline direction and a negative goes left. The horizontal and vertical offset amounts apply starting at the point with the offset codes until a new offset code or the end of the polyline. Only one horizontal and vertical offset can be applied to 2D polylines. For 3D polylines, multiple offset codes can be used to make a variable offset. For example,

10, 500, 500, 100, EP OH2.5 OV-.5
11, 525, 527, 101, EP OH5.5 OV-.75
12, 531, 533, 103, EP OH7.5

This would offset the first point horizontal 2.5 and vertical -0.5, the second point horizontal 5.5 and vertical -0.75 and the third point horizontal 7.5 and vertical -0.75.

When there are multiple "OH" codes for the same point, the polyline is offset multiple times.

The "OFL" code stands for offset left horizontal. The only difference with the "OH" code is that you don't have to enter the ".-" to go left.

The "OFB" code stands for offset both left and right horizontal. For example, if the points follow the center of a ROW, the OFB code can be used to create the left and right edges of the ROW. There is a setting for Offset
Both for whether the offset value if for the full or half width between the two offset lines.

**SZ: Symbol Size**

This code is used to set a different symbol size. There are several ways to use this code. It can take multiple scale factors for different dimensions by putting an ID character after the factor.

SZ: If nothing follows the SZ code, then the next point with the same field code as the current point will be used to determine the size.

SZ#: The value of the new symbol size is specified after the SZ. This value is the actual size in drawing units. For example, SZ2.

SZ#X: The value after the SZ is used to scale the symbol in the X dimension. For example, SZ2X.

SZ#Y: The value after the SZ is used to scale the symbol in the Y dimension. For example, SZ2Y.

SZ#Z or SZ#V: The value after the SZ is used to scale the symbol in the Z (Vertical) dimension. For example, SZ2Z.

SZ#H: The value after the SZ is used to scale the symbol in the X,Y (Horizontal) dimensions. For example, SZ2H.

SZ#S: The value after the SZ is a symbol size scaler that get multiplied by the drawing horizontal scale to determine the actual drawing units. For example, SZ0.2S.

The X, Y, Z, V and H can be combined. For example, to scale a symbol by 10 horizontally and 25 vertically, use SZ10H25Z. Or to scale a symbol by 2 in the X direction and 4 in the Y direction, use SZ2X4Y.

When multiple SZ codes are used in the same point description, the symbol is drawn multiple times at the different sizes. For example, a point description of "TREE SZ5 SZ10" will draw the tree symbol twice. One symbol will be size 5 and the other size 10.

**ROT: Rotate**

This code is used to set the rotation of the point symbol. If a point number follows the ROT code, then angle from the current point to this point number is used for the rotation. For example, "ROT45" would rotate the symbol towards point number 45. If there is no point number after the ROT code, then the rotation point is the next point number with the same code as the current point or a companion code for the current code. ROT can also be used to rotate towards an angle clockwise from north by using ‘+’ or ‘-’ in front of the number. For example ROT+45 rotates the point symbol to the northeast and ROT-90 rotates the point symbol to the west.

**SMO: Smooth**

This code is used to smooth the polyline.

**AZI & DIST**

The AZI and DIST codes are used together to offset the point. The AZI sets the offset azimuth and DIST sets the distance. The values should directly follow the code. For example, AZI25 DIST4.2 would draw the point offset 4.2 at an azimuth of 25 degrees.

**JOG: Extend By Distance**

The "JOG" special code allows for additional points to be inserted into the line work at perpendicular or straight offsets. Only offsets should follow the JOG code. Positive numbers indicate a jog to the right and negative numbers indicate a jog to the left. Alternatively, "R#" and "L#" can be used where # is the distance to either the right or the left. Finally, "S#" can be used to make an offset straight ahead by using a positive # or behind by using a negative #. For example, "BLDG JOG S10.1 R5 L12.2 L5 L12.2" or equivalently "BLDG JOG S10.1 5 -12.2 -5 -12.2" advances 10.1 units and then draws a closed rectangle on the right hand side of an existing line. The offsets are always done in the X-Y plane. If the current line is vertical, an offset to the right is along the positive X-axis.

**JPN: Join to Point Name**

The "JPN" (Join to Point Name) special code joins to the point named immediately after the code. For example, "JPN205" causes a line to be drawn from the current point to the point "205". JPN is designed to work for adding a
segment at the start of linework. So the point with the JPN code should be at first segment of the linework.

**XSCT: Template**
This special code defines a template from a series of points with this special code. This template is then applied like a template defined under Linetype for a code. This XSCT code is a way to define a template in the field instead of having a template with fixed dimensions defined in the code table. For example, you could have a code for BC for back-of-curb. Then store three points with a description of "BC XSCT" for three points to cross section the curb: back-of-curb, top-of-curb and flow line. After these three "BC XSCT" points, you could have single "BC" points along the curb and the program will apply the template along these curb points and draw three parallel lines.

**NEAR: Nearest Found**
This special code sets the current polyline to Nearest Found connection order. This applies to codes that have the Connection Order set to Sequential and you want to override this setting to Nearest Found for the current polyline.

**RECT: Close Rectangular**
The "RECT" special code creates a rectangle as a 2D or 3D polyline using one of two different methods. If a number follows "RECT" (e.g., "RECT10"), a rectangle will be drawn 10 units to the right of the last two points ending on the point with the "RECT" code. Use a negative offset to place the rectangle on the left side (e.g., "RECT-2.5"). For example if locating the left side of a 10' rectangular concrete pad using the code conc for concrete, the description of the two left points would be (conc) for the first point and (conc rect10) for the second. If no number follows "RECT", then the polyline will be closed by shooting right angles from the first point of the polyline and the current point and creating a new point where those two lines cross. This method requires three points be established on the rectangle. In this method, the "RECT" code can be on any of the polyline points.

**LTF: Linetype Flip**
This special code switches the side for the linetype. This option applies to non-symmetrical linetypes like the treeline or guard rail for when you want the linetype to face the other way.

**LTW: Line Width**
This special code sets the line width. The width value is entered after the LTW code. This width is applied to lines and 2D polylines.

**PARKING: Parking**
This special code draws parking stall lines using three points. Points one and two are used to draw the first parking line and define the length and angle of the lines. The third point defines that position of the last parking line. A number needs to follow the PARKING code for the number of parking lines to draw. For example, PARKING8.
RAMP: Curb Ramp
This special code adjusts the 3D polylines to create a curb ramp. The routine looks for parallel 3D polylines for the bottom of curb, top of curb and back of curb. These 3D polylines can be created in Field-To-Finish by using a Template under the Code > Linetype definition, or using the offset special codes, or by having three separate 3D polylines. The ramp is centered at the point with the RAMP code. The dimensions of the ramp follow the code in order of width, depth and taper. For example, a description of "BC RAMP 3 2 1" uses "BC" for a bottom of curb code then "RAMP" for the special code and 3 for the width, 2 for the depth and 1 for the side taper.

CIR: Circle
The "CIR" special code causes the point to create a circle in one of three different ways. The first way uses just the current point as the center with the CIR special code followed immediately by the radius. For example "CIR7.5" will create a circle centered on this point with radius 7.5 and at the elevation of the current point. The second method uses two points, the first point specifying the center and the elevation, and the second point specifying the radius. Only the first point has the "CIR" special code and the second point is the next point with a matching field code. Another variation of method 2 is using 2 points that are on the perimeter and define the diameter. For the
2 point method, whether the points define the radius or diameter is defined on the Code Table Settings > Special Codes dialog. The third method uses 3 or more points that specify the perimeter of the circle in 2D with the first point specifying the elevation. For this method, the "CIR" special code is only on the first point and the rest of the points are the next points with matching field codes.

The "CIR" code can be used with all of the linetypes including "points only". The circles are always parallel to the X-Y plane unless the code linetype is set to "3D Polyline”. Then the circle is drawn as a 3D polyline. Any active linework for the code is ended before processing the “CIR” special code.

PointNo. Description
Method 1 (Single point at center with radius value)
82 PP CIR7.5
Method 2a (Point at center plus point at perimeter)
83 PP CIR
84 PP
Method 2b (2 Points on perimeter that define the diameter)
83 PP CIR
84 PP
Method 3 (Points on perimeter)
85 PP CIR
86 PP
87 PP
88 PP
89 PP

Methods 1, 2a, 3

Method 2b

2ND: Multi-Point Code
When used on the first point of a multi-point symbol, the "2ND" code indicates that the second point of the sequence (i.e., the next point after the current one) should be used as the second symbol insertion point for a multi-point symbol. Please refer to Symbol Pts in the Edit Field Code Definition section below.
3RD: Multi-Point Code
When used on the first point of a multi-point symbol, the "3RD" code indicates that the third point of the sequence should be used as the third symbol insertion point. The "3RD" code should be used with the "2ND" code. Please refer to Symbol Pts in the Edit Field Code Definition section below.

3D Special Codes
Below are the special codes that can be used for the easy creation of 3D surfaces. The resulting 3D face entities can be viewed in the Carlson 3D viewer by entering "cube" on the command line.

FACE3D
Makes a triangle mesh of 3D face entities by triangulating points starting with the current point and continuing until the line ends or another 3D special code is found. The points must be ordered along the perimeter. Although the mesh will be built if the points are clockwise or counterclockwise along the perimeter, the visible side in the Carlson 3D viewer, "cube", is the clockwise side by default. On the Advanced tab, the shading mode may be set to Shade both or Shade back if you would prefer to see both sides or just the counter-clockwise side.

HOLE3D
Makes an exclusion area within the triangle mesh identified by the point number following this code (e.g., "HOLE3D101" will start a hole in point # 101). If no point number is given ("HOLE3D"), the exclusion area is applied to the last mesh or if there is a mesh in the process of being constructed by the current sequence of points, it is ended and the hole is applied to it. Note that a hole can only be applied to a mesh that was created by FACE3D (not BLOCK3D or WALL3D). Note also that it can be difficult to predict what the "last mesh" was if it used a different field code since the points of the coordinate file are processed by order of field code first and then point number. There is no limit to how many holes can be applied to a FACE3D mesh. The points of the hole itself are not added to the FACE3D mesh; they are projected on to the best plane that contains the FACE3D mesh and then the hole is cut-out.

Example 1:
2500 HOUSE1 FACE3D/front of house
2501 HOUSE1
2502 HOUSE1
2503 HOUSE1
2504 HOUSE1
2505 VENT1 HOLE3D2500/applies 2505-2508 as a hole to last mesh that uses point #2500. So any point in the range 2500-2504 would have the same effect.
2506 VENT1
2507 VENT1
2508 VENT1

Example 2:
2500 HOUSE1 FACE3D/front of house
2501 HOUSE1
2502 HOUSE1
2503 HOUSE1
2504 HOUSE1
2505 HOUSE1 HOLE3D/stops the above mesh and applies 2505-2508 as a hole
2506 HOUSE1
2507 HOUSE1
2508 HOUSE1

Example 3:
2500 HOUSE1 FACE3D/front of house
2501 HOUSE1
2502 HOUSE1
2503 HOUSE1
2504 HOUSE1
2505 WINDOW1 FACE3D HOLE3D2503/applies 2505-2508 as a hole to above mesh 2500-2504 and starts a new mesh using the WINDOW field code.
2506 WINDOW1
2507 WINDOW1
2508 WINDOW1

Example 4 (same result as Example 3):
2500 HOUSE1 FACE3D/front of house
2501 HOUSE1
2502 HOUSE1
2503 HOUSE1
2504 HOUSE1
2505 WINDOW1 FACE3D,starts a new mesh using the WINDOW field code.
2506 WINDOW1
2507 WINDOW1
2508 WINDOW1 HOLE3D2504/makes the mesh 2505-2508 also be a hole in the mesh 2500-2504.

**BLOCK3D**

Makes a set of 3D faces to make a 3d block using the height value entered after the code (e.g., "BLOCK3D2.3" with height 2.3). Heights can be positive or negative. With 3 points, makes a parallelogram base that is extruded up (or down if height is negative) to form a 6-sided block, including top and bottom. With 4 or more points, makes a closed polygon for the base that is then extruded by the height. The points can be laid out in clockwise or counterclockwise order around the perimeter. The perimeter or base does not have to be a convex polygon.

**WALL3D**

Makes a set of 3D faces above the polyline using a height value entered after the code (e.g., "WALL3D2.3" with height 2.3). This height is a signed value so you can shoot either the top of the wall or the bottom of the wall. The height can be negative if the points on the top of the wall have been shot. If no height parameter exists, then the height is determined by the distance from the current point to the next point.
After the height value, you can have a width/thickness value. If no width value is entered, then a width of zero is used. When the width value starts with a minus "-", then the width is put on the left side of the points. When the width value starts with a plus "+", then the width is put on the right side of the points. When the width value has no plus or minus, then the points go through the center of the wall width.

Both sides of the wall will have triangles and so both sides will always be visible in the Carlson 3D viewer.

Example – 6' high wall shot along the bottom:
2000 1000.000 1060.000 100.000 WALL1 WALL3D6.0 /wall 6'
2001 1100.000 1060.000 100.000 WALL1
2002 1100.000 1160.000 100.000 WALL1

Example – 6' high and 1.5' wide wall shot along the bottom:
2000 1000.000 1060.000 100.000 WALL1 WALL3D6.0 1.5 /wall 6' high and 1.5' thick
2001 1100.000 1060.000 100.000 WALL1
2002 1100.000 1160.000 100.000 WALL1

Example – 6' high wall, height specified by 1st to 2nd point, shot along the bottom:
2020 1100.000 1160.000 100.000 WALL2 WALL3D /height by 2nd pt
2021 1100.000 1160.000 106.000 WALL2
2022 1000.000 1160.000 106.000 WALL2

**Load Default**
This button sets the special codes to Carlson, Eagle Point, Geopak, InRoads or TMOSS defaults.

![Select Default](image)

**Code Table (continued)**

**Sort Table** - This sorts the code table by either code name or layer.

**Report Codes/Points** - This routine prints the code table or the data file to the screen, file, or printer. A useful option here is to print the data file (CRD Points) and choose Sort by Codes which will group the data points by distinct codes.
**Code Table by CRD** - This command will create code table definitions based on the coordinate file field descriptions. This is useful when creating a code table from scratch.

**Save:** Saves the Draw Field to Finish field code definition (.FLD) file.

**Save As:** Reacts the same as Save but allows for specification of file name and location to save to.

**Code Definitions**

**Edit:** If only one field code is selected, then this command opens the Edit Field Code Definition dialog box. If multiple field codes are selected (by holding down the control key or shift key and clicking on the rows), then the Multiple Set dialog box will open.
The code definition dialog has three tabs: General, Symbol and Linetype. Here are the settings under General:

**Processing ON:** This toggle controls whether this code will be processed.

**Code:** This is the key name that identifies the code and is matched with the field data descriptions. It is important to note that the * character, used in this field, is regarded as a wildcard or "match anything" code. For example, a field code definition with the code defined as TREE* will be used for any raw description of TREE. Raw descriptions of TREEA, TREE12, TREE, etc. will match the TREE code definition. This will always be the case unless there is a more specific code is found. For example is there was a code TREEA in the code definition file, then that code would be used instead of the TREE code.

**Use Code Sequence:** This specifies a sequence type code. Sequences are a way to simplify field entry of a sequence of codes. For example, a road cross-section could be SHD1 EP1 CL EP2 SHD2. Instead of entering these different descriptions, one sequence definition can store these descriptions in order. Then just the sequence code (such as RD) is used in the field. The cross-section can be shot in left to right then left right order, right to left then right to left order, or alternating left to right then right to left order. The alternating method is known as the Zorro style. The one restriction is that the shots always start from a right or left edge. To set up a sequence, choose the Sequence toggle in the Edit Code dialog. Then pick the Define Code Sequence button. This brings up a dialog for entering the sequence codes in order. These sequence codes should be defined as normal codes somewhere else in the Draw Field to Finish code table (ie SHD as a 3D polyline). In the field, the one template code is used for all the cross-sections shots (ie RD for all the points). Then Draw Field to Finish will substitute this template code with the sequence codes (ie substitute RD with SHD).
Resulting points and linework showing Zorro style template

**Define Code Sequence:** This sets the code names that make up the sequence.

**Full Name:** This is an optional field that describes the code for viewing.

**Description:** This value is assigned to the point description attribute when the point is drawn. This description can be different than the field description. An additional description can be added to a point by entering it after a forward slash in the data description field.

**Use Raw Description:** This option turns off the Description field described above. Instead the points will be drawn with their original unprocessed descriptions. The Attribute Block option applies to the point block with
point #, elevation and description fields. The Text Attribute applies to drawing the description as text. The format of the description is controlled by the Attribute Format setting.

**Main Layer:** The point and line work for the code will be created in this layer.

**Distinct Point Layer:** When this toggle is selected, the line work is created in the layer defined in the Layer field and the points are created in the specified distinct point layer. For example, you could have DRIVEWAY for linework and DRIVEWAY_PNT for the points.

**Dual 3D Polyline Layer:** Displays the layer that the 3d polyline will be drawn on when using an Entity Type of 3D and 2D. The layer name can be typed in this field.

**Set 3D Layer:** Sets the layer that the 3d polyline will be drawn on when using an Entity Type of 3D and 2D. The layer can be selected from the list or typed in at the bottom of the dialog box.

**Attribute Format:** This chooses the type of point entities to create. The Attribute Block format creates the Carlson point entity which is block with attributes for point#, elevation and description. The Text Attribute format creates text entities for each of the point attributes. When the Text Attribute format is selected, the Set button is available where you can control which attributes to draw as text and the position, order, size, rotation, decimals, style, prefix, suffix and layer for each attribute. The Offset Scalers control the distance for the text from the point for the different positions. These offset distances are calculated by multiplying the scaler by the horizontal scale for the drawing. The Elevation Label Decimal On Point option will place the elevation label so that the decimal point of the label is on top of the point location. The Use Commas In Labels option will add commas for the thousandths place for the northing, easting and elevation labels. The Avoid Overlap With Block Attributes option expands the offset distance starting point from the point to the bounding box that encloses the point block attributes. The Draw On Real Z Axis option controls whether the text entities at the point elevation or at zero elevation. The Group Text option creates a CAD Group for all the point labels. The Text Size Scaler is multiplied by the current Horizontal Scale to set the text height.

![Point Attributes as Text Settings](image)

Also, for points notes and SurvCE GIS attributes, you can choose to all or selected fields. For selected, use the Add, Edit and Remove buttons to build the list of fields to label. To specify the field to label, the Sequence# method sets the field by its order position. For example, a sequence of 3 would use the third attribute for the point. The Name method sets the field to label by field name such as HRMS. The Equation method sets the value by the specified
equation of attribute names and numbers. Besides the attribute names, there are keywords of "X", "Y" and "Z" for
the values of the current point coordinates. For example, if there is an attribute named DEPTH, then you could
define a label for the invert as an equation of "Z - DEPTH". Another example is to make a label that is 1.5 higher
than the point elevation using an equation of "Z + 1.5". Besides attribute names, you can make an equation by
attribute sequence using "NOTE" plus the sequence number. For example, if the depth value is the 3rd attribute,
then to define a label for the invert elevation, use the equation "Z - NOTE3".

For each attribute, there are settings for the rotation, prefix, suffix, position, decimals, layer and style. The
decimals setting applies to GIS fields that are real numbers. Besides labeling attributes as text with this method, the
Symbol > Custom Attributes feature is a way to label attributes as block attributes.

Separate Attribute Layers: This controls the layers of the point and symbol attributes and the parent layer
for the point attribute block. With "None" the point attribute layers are the standard layers, "PNTNO", "PNTELEV"
and "PNTDESC", the parent layer for the point attribute block is the Main Layer and the symbol layer is "PNT-
MARK". With "Points" or "Both" the point attribute layers begin with the layer for the code followed by the attribute
type. For example, the "DWL" code shown in this dialog has a layer name "DRIVEWAY". The point attributes
would then be "DRIVEWAYNO", "DRIVEWAYELEV" and "DRIVEWAYDESC". With "Symbols" or "Both" the
symbol attribute layer begins with the layer for the code followed by "MARK".

Attribute Layout ID: Controls the location of the point number, elevation and description. These attribute
layouts are defined in the drawings that are stored in the Carlson SUP directory with the file name of SRVPNO plus
the ID number (i.e. SRVPNO1.DWG, SRVPNO2.DWG, etc.). If you want to change the attribute positions for a
layout ID, then open and edit the associated SRVPNO drawing.

Point Groups: This field is for the name of the point group that all points with this code will be added to.
If the points for this code belong to multiple point groups, you can specify multiple point group names in this field
separated by commas. Under Draw in Additional Draw Options, there is an option whether to automatically use the
code name as the point group name or to use the name defined in the code definition.

Text Size Scaler: This is a scaler value that is multiplied by the horizontal scale to obtain the actual size.

Set Color: The line work will be drawn in this color. The default is BYLAYER. The color can be an index
or true color.

Entity Type: This defines the line entity to be created. Points only does not create any line work. 3D
Polyline can be used for breaklines. 3D and 2D entity type selection creates a 3d polyline in the layer specified in the Dual 3d polyline layer setting and a 2d polyline in the layer identified in the Layer setting. Since 3d polylines do not display linetypes, this is useful when needing linework in 3d for design work while also needing to display linetypes for final plotting of the drawing. This provides an easy and quick way to turn off all 2d polylines or all 3d polylines by using the layer control dialog or the appropriate toggles in the Draw Points dialog.

**Elevation Integers:** This controls the number of digits to display to the left of the decimal point for the elevation label. The All setting will show the full elevation digits. The other settings allow you to limit the number of digits to display for the purpose of reducing the amount of space the elevation labels take up in the drawing. For example, if a site is in the 4000 foot elevation range, then this setting could be set to three digits (000) and an elevation of 4321 would be labeled as 321.

**Elevation Decimals:** This controls the display precision for the elevation label.

**Elevation Prefix/Suffix:** These set the prefix and suffix for the elevation label per code. In the Draw function under Additional Draw Settings, there is an override to set the elevation prefix/suffix for all the codes.

**Locate Pts on Real Z Axis:** This option will draw the points at the actual point elevation. Otherwise the points are drawn at zero elevation. For example, you could turn this option off for the FH for fire hydrant code to drawn them at zero. Then the GND code could have this option on to draw the ground shots at their elevations.

**Non-Surface:** Entities created with this flag are ignored when contouring or creating surfaces regardless of their elevation.

**Feature Type:** Controls how to process this code. The Tree and Pipe types are used for the special tree and pipe processing. All other codes should be set to type Topo.

**Companion Codes:** This option allows different codes to connect when defined as line, polyline or 3d polyline. For example, a main line power pole code may be defined as PP while a service utility pole may be defined as UP. When processing Draw Field to Finish, it may be desired to connect all PP and UP codes together. This could be accomplished by defining a companion for UP as PP and a companion code for PP as UP. Each code needs to reference the other as a companion code.

**Fixed Parameters:** This option is a coding method where you specify a sequence of parameters that follow the main code. There can be up to three parameters and these parameters can be an additional description or special codes Description, GIS Attribute, Size, Rotate, Azimuth, Distance or Offsets. The purpose for Fixed Parameters is to save keystrokes by not having to enter the special code prefix. For example, for a code TR for Tree along with a size 12 feet and description of Oak, the special code description would be "TR SZ12 // OAK". With Fixed Parameters of Size and Description, the description would be "TR 12 OAK".

GIS attributes can be creating using the point description by choosing the GIS Attribute parameter. This way the GIS attributes can follow the main code in the description. For example, you can have a main code of MH for manhole followed by the depth to store as a GIS attribute. In this case, the description would be "MH 4.4".
Data Collection Codes: These settings apply to Carlson Field for turning on the Offset mode and Rotate mode automatically by F2F code.

Here are the settings on the Symbol tab:

Set Symbol: This is the point symbol for the code. The dialog allows you to select from the symbols defined in the Symbol Library which is setup with the Settings->Symbol Library command. Besides the symbols from the symbol library, you can also use any symbols that are defined as blocks in the current drawing by entering the block name in the symbol edit box. To have a point without a symbol, use the Carlson symbol named SPT0 which represents "no symbol". If you set a custom symbol and you want to process Field-To-Finish on other computers, then be sure to put this symbol in the Settings > Symbol Library and copy this symbol onto the other computer. Or you can upload the symbol onto Carlson Community for the other computer to find. Field-To-Finish automatically checks the Carlson Community for any symbols that aren't found on the computer.
Random Rotate: This option will randomly rotate the symbol. For example, this option could be used for tree symbols to have the trees drawn in various orientations.

Rotate To Line: This option applies to points that are part of Field-to-Finish linework. This option will align the point attributes and symbol to the associated linework. The Middle mode uses the average angle for the line segments coming to and from the point. The Forward mode uses the line angle going from the point. The Backward mode uses the line angle coming into the point. The Ends mode uses the perpendicular angle for the line end segment and applies for culverts.

Rotate Entities: This setting controls whether to apply rotation to the symbol, the point attribute block or both.

Symbol Size Scaler: This is a scaler value that is multiplied by the horizontal scale to obtain the actual size in the drawing. The horizontal scale can be set in Drawing Setup.

Unit Symbol: This option will draw the point symbol at unit (1:1) scale. For example, this option could be used for a symbol that is already drawn to actual dimensions such as a car symbol.

Custom Attributes: This feature allows you to use customized blocks that have customized attributes (the tag/value pairs). This feature works for both point attribute blocks and symbols. For attribute blocks, Field-to-Finish looks for attributes with the tags "PT#", "ELEV2", and "DESC2". The custom attributes feature allows you to define additional attributes in their custom blocks on a per-field code basis. The dialog shows five attributes at a time. The number of attributes is unlimited. Use the Next and Back buttons to show more attributes.

For an example, the custom block could have an attribute with the tag "TREE_SPECIES" and there is a separate field code for each species of tree. Each of those field codes can specify the value that should be assigned to the attribute that has the TREE_SPECIES tag. Then when the points are drawn, the tree species is shown. Note that the custom attributes must have their Constant and Preset properties set to "no". The custom attributes settings in F2F should not use those tags that the software already handles (PT#, ELEV2, and DESC2), or the setting will be ignored.
The Values for the attributes can be fixed strings that you enter in the dialog shown here. They can also be dynamic parameters including point number, northing, easting, elevation or description for the current point as well as a point note, GIS attribute or equation. The Equation type sets the value by the specified equation of attribute names and numbers. Besides the attribute names, there are keywords of "X", "Y" and "Z" for the values of the current point coordinates. For example, if there is an attribute named DEPTH, then you could define a value for the invert as an equation of "Z - DEPTH". To setup a parameter value, pick the Set button and then select the attribute. The Decimals setting applies to fields that are real values. The Prefix and Suffix fields are added to the Value for the attribute string.

Besides labeling as block attributes, the Attribute Format method of Text mode is a way to label the attributes as text entities.

**Symbol Points:** For each code definition, the symbol insertion points can be defined with up to three points. To define the symbol insertion points, choose the Symbol Pts button in the Edit Code Definition dialog box. By default, the symbol insertion is defined by one point at the symbol center (0,0). A one point insertion definition can be used to insert a symbol offset from the center. With a two insertion point definitions, the program will rotate and scale the symbol. For example, two insertion points can be used to insert a tree symbol to size the tree, where the first point is for the tree center and the second is for the drip line. With three insertion point definitions, the program will rotate and scale the symbol in both X and Y. For example, three points can be used to insert a car symbol with the first point being the front drivers side, the second point as the back driver side (to rotate and scale the length) and the third as the back passenger side (to scale the width). Besides the insertion point coordinates, you can define a description for each point which is used for the drawn point description and is used for prompting in the Insert Multi-Point Symbol command and in Carlson Field data collection.

![Define Symbol Placement Points](image-url)
Three Point Symbol Drawing

The coordinates for the insertion point definitions are for the symbol at unit size. To figure these coordinates, you will need to open the symbol drawing (.DWG) file. By default, the symbols are located in the Carlson SUP directory. For example to make an insertion point for the tree drip line, open the tree symbol drawing and find the coordinate at the edge of the tree symbol (in this case 0.5,0.0).

Two Point Symbol Drawing

Not all of the symbol insertion points need to be used when drawing the points. If a code definition has a three insertion points, it is possible to use just the first two or first one. There are special codes to associate multiple points to the same symbol. The first code point is used as the first symbol insertion point. The "2ND" code is used to specify the second symbol insertion point. A point number can follow the "2ND" to identify a specific point. Otherwise without the point number, the program will use the next point with the current code. The "3RD" code is
used to specify the third symbol insertion point and similar to the "2ND" code, a point number after the "3RD" is optional. The "2ND" and "3RD" codes should be assigned to the first point. For example, consider a code of "CAR" with a three point symbol insertion definition. If point #1 has a description of "CAR 2ND 3RD", then point #1 will be used as the first symbol insertion point and the next two points with the "CAR" description will be used as the second and third symbol insertion points.

Multi Point Symbol Drawing

The **Point Layer Suffix for 2nd/3rd Points** option allows for having different layers for the 2nd and 3rd points used with the multi-point symbol.

The **Automatic Multi-Point Special Code** option saves from having to enter the 2ND or 3RD special codes. This option applies when the code is always used from multi-point symbols.

The **Use Single Average Elevation** option averages the elevations of the symbol points for the point elevation label.

The **Rotate Only** option uses the symbol points only to rotate the symbol and does not scale.

The **Draw Additional** has options for drawing a 4th point or rectangle. The **Create 4th Corner Point** option draws another point when using a three multi-point symbol. This option applies when the symbol is rectangular and you shoot three corner points and want the program to draw a point at the 4th corner. The **Rectangle** option creates a rectangle to fit the 3 symbol points and applies to creating a breakline for surface modeling around the symbol.

The **Fit Point Description Instead Of Symbol** option is a method to drawing labels that are positioned by these points such as road markings. To set a custom text to label, you can use the /// (Replace Description) special code. For example with a code called MARK, the description could be "MARK 3RD ///BUS LANE". Or turn on the Automatic Multi-Point Special Code and then the "3RD" isn't needed and the description could be "MARK///BUS LANE". For the text control points, lower-left = 0,0, upper-right = 1,1, upper-left=0,1, and lower-right = 1,0.

**Draw 2nd Symbol**: This option creates a second symbol on each point. This additional symbol can be
used to add a 3D symbol to a 2D symbol used as the first symbol. Besides selecting the symbol name, there are settings for the symbol size and layer.

Here are the settings on the Linetype tab:

![Linetype Settings](image)

**Set Linetype:** Line work can be drawn in any of the special linetypes or with the linetype for the layer ("BYLAYER"). There are three types of pre-defined linetypes: CAD, Entity and Continuous. The type is shown as part of the linetype names in the list. The CAD linetypes are the default linetypes available in AutoCAD and IntelliCAD. The Entity linetypes insert text or symbol entities at the linetype interval. These linetypes are the same as used with the Annotate->Polyline To Special Line command. The Continuous linetypes define a special linetype in CAD and create continuous polylines with that special linetype. These linetypes are the same as with the Annotate->Change Polyline Linetype command. Besides these pre-defined linetypes within Field-to-Finish, you can also use any linetype that is defined in the drawing by entering that linetype name in the linetype edit box or by picking the Select From Drawing button within the Set Linetype dialog. The spacing and size of the special linetypes is determined by the CAD LTSCALE system variable and by the field code settings *Line Type Spacing Scalser* and *Line Type Text Scalser*. The special linetype "hedge" is drawn with a width set by Line Width. The special linetype "userdash" is drawn with user specified distances for the length of the dash and the length of the gap between dashes.

**Line Width:** This controls the width for the linework. Only applies to 2D polylines. The LTW special code can also be used to set the line width for a specific line.

**Linetype Text:** This is the text that is used for the user-defined linetype. First use Set Linetype to either Other_E or UserDef_C. Then this text will be used for the linetype. For example, if you have a code for a 8" PVC pipeline, then you could set this text to 8" PVC.

**Linetype Spacing Scalser:** This is a scaler value that is multiplied by the CAD LTSCALE system variable to give the distance between symbols in the line.
**Linetype Text Scaler:** This is a scaler value that is multiplied by the CAD LTSCALE system variable to give the size of the text in a line.

**Flip Linetype:** This option switches the side for the linetype which applies to non-symmetrical linetypes like the treeline or guard rail.

**Smooth Polyline:** This option applies a modified Bezier smoothing to the polyline. The smoothed polyline will pass through all the original points.

**Hard Breakline:** This option will tag the 3D polylines created with this code as hard breaklines. In *Triangulate & Contour*, contours are not smoothed as they cross hard barriers.

**Separate Offset Layer:** This setting uses another layer name for polylines created using an offset special code.

**Label 3D Offset Elevations:** This option labels the elevations and symbols of the vertices for polylines created using an offset special code.

**Connection Order:** The points of a distinct code can be connected in their point number order or by nearest found which makes the line by adding the next closest point.

**Tie:** When checked the linework drawn with this code will always close. For example if you have points 1, 2, 3, and 4 with the code BLDG and Tie is checked on for the code BLDG, then the linework will be drawn from point 1 to 2 to 3 to 4 and then back to point 1, closing the figure.

**Linework Description:** This description is labeled along linework created by this code. The Set button displays a dialog to control the layer, style and size for these labels. You can also set the label interval. The Flip Text For Twist Screen option orients the linework labels to be right side up for the drawing current twist view. The Add Point Special Descriptions adds any point special code descriptions to the Linework Description.

![Linework Description Setup](image)

**Edit and Set Template:** For 3D polyline codes, this option allows you to assign a template (.TPL) file to the code. The code points act as the centerline for the template and the program will draw parallel 3D polylines for each break point (grade ID) in the template. The template file is defined in the Civil Design module or by using the Edit button. In the Edit Template dialog, there's a special setting for Field-to-Finish for the Offset Target Grade. This Offset Target Grade controls which grade in the template to use as the centerline for the code points. If this field is blank, then the start of the template is used.
The templates are dynamic and can be adjusted along the 3D polyline by using the OH (offset horizontal) and OV (offset vertical) special codes. For example, when there is a curb template that flattens when it comes to a driveway, then an OVO code could be used at the driveway start point and then use OV.5 at the driveway end point to restore the curb to 0.5 feet high.

The **Use Template IDs** as Layer option will use the grade IDs from the template for the layers of the 3D polylines.

**Hatch Closed Areas:** This option applies for codes used to draw closed linework. This linework can be used as the perimeter for a hatch area. The hatch settings include the hatch pattern name, scale and layer.

**Code Definitions (continued)**

**Select All:** This option selects all the codes. This can be used when only wanting to process a couple of codes. For example, use the select all option to select all the codes and then turn them off. Now select the codes for processing and turn them on. Also it can be used to make a global change to all the codes.

**Add:** The new code definition is inserted in the list in the position after the currently selected one. If none are selected for positioning, the new code is placed at the top. Only one code definition may be highlighted before running this routine.

**Copy:** This option copies the definition of a selected code. It opens the Edit Field Code Definition dialog and copies the definition of the selected code to the appropriate settings. It does not copy the name of the code. It is a time saving tool to use when creating codes that are similar with only a couple of differences.

**Cut:** This command will remove the highlighted code definitions from the list and puts them in a buffer for retrieval with Paste.

**Paste:** This command will insert the code definitions put in the buffer by the Cut command. These codes will be inserted after the row of the currently highlighted code or at the top.

**Search:** Allows you to search for a specific code in the list.

**Coordinate File**

**Set CRD File:** This command allows you to specify a coordinate (.CRD,.CGC,.MDB,.ZAK) file to process.

**Edit Points:** This command opens the *Edit Points* spreadsheet editor. See *Edit Points* for more details.

**Draw:** This command returns to the Draw Field to Finish dialog box.

**Coding Examples**

Under the Carlson Projects folder, there is an example that shows the different ways for linework coding along with examples for many of the special codes. The examples are in f2f_example.crd and f2f_example.fld. Here is a breakdown of the features that the points illustrate.

**Point 1:** Point Entity by itself

**Points 2-3:** Using Begin code to start a line; end line using Begin code for next line

**Points 4-5:** Using Begin and End to start and stop linework

**Point 6:** Point Entity by itself after End code

**Points 7-11:** Linework by code defined as Polyline entity type; using End as break between linework

**Points 12-15:** Linework by code defined as Polyline entity type; using Begin as break between linework

**Points 16-19:** Linework by code defined as Polyline entity type; using # after code instead of Begin/End to separate linework

**Points 20-22:** Linework by code defined as Polyline entity type without using Begin/End to start/stop linework
Points 24-26: 3 point curve using on PC code
Points 27-30: 3+ point curve using PC/Point codes
Points 32-33: 2 point tangent curve using PC/Point codes
Points 35-39: reverse curve using PC/Point codes
Point 40: Regular point without extra description
Point 41: Using // to use a code description as a suffix
Point 42: Using \ to use a code description as a prefix
Point 43: Using / to append a description
Point 44: Using \ to add a description as a prefix
Point 45: Using ROT and a Point# to rotate to that Point#
Point 46: Using ROT and a value to set the rotation
Point 47: Using ROT by itself to rotate to the next Point#
Point 48: Regular point without rotation
Point 49: Using AZI and DIST codes to offset the point
Point 50: Using SZ with value to set size of symbol
Points 51-52: Using SZ by itself to size symbol by the distance to the next point
Point 53: Using SZ with 2 values to draw multiple symbols at those sizes
Points 54-55: Using 2ND code to size the symbol
Points 56-58: Using 2ND and 3RD codes to size the symbol in 2 dimensions
Points 59-62: Using CLO to close the linework
Points 63-64: Using RECT with two points and a value to create a rectangle
Points 65-67: Using RECT with three points to create a rectangle
Points 68-69: Using OH to offset right a fixed amount
Points 70-73: Using OH on multiple points to offset various amounts
Points 74-75: Using multiple OH on the same point to offset polyline multiple times
Points 76-77: Using OH with negative value for offset to left
Points 78-79: Using OFL with value for offset left a fixed amount
Points 80-81: Using OFB with value to offset both left and right a fixed amount
Point 82: Using CIR to draw circle at specified radius
Points 83-84: Using CIR to draw circle using two points for center and perimeter
Points 85-89: Using CIR to draw best-fit circle through points on perimeter
Points 90-91: Using JPN to join linework to another Point#
Points 92-95: Using SMO to create smoothed linework
Points 96-97: Using JOG to create additional linework segment extensions
Points 98-102: Using GAP to create a break in the linework
Points 103-106: Using LFT to switch linetype to left side
Points 107-109: Using WALL3D with specified height value
Points 110-112: Using WALL3D with height from 2nd point
Points 113-115: Using BLOCK3D with height and three points to define parallelogram
Points 116-123: Using BLOCK3D with height and multiple points to define perimeter
Points 124-128: Using FACE3D with multiple points to make a surface
Points 129-132: Using HOLE3D with multiple points to define the perimeter of a hole in the FACE3D surface
Point 133: Using code definition with Attribute Format set to Text and only Elevation turned on with Label Decimal On Point
**PointCAD Coding**

Field-to-Finish supports an early Carlson style of linework coding called PointCAD. The PointCAD codes use numbers with +,-,* symbols as follows:

+0 Starts a regular 2D line (not a polyline) that is open.
*0 Starts a regular 2D line that is closed.
+4 Starts a curved 2D polyline that is open.
*4 Starts a curved 2D polyline that is closed.
+1 Begins a 3-point arc.
-0 or -1 or -3 or -4 or -5 or -6 or -7 Ends a line.
+5 Starts a 3D polyline that is open.
*5 Starts a 3D polyline that is closed.
+6 Starts a 2D polyline that is open.
*6 Starts a 2D polyline that is closed.
+7 starts line whose type (2D line, 2D polyline, 3D polyline) is specified by the point's field code definition. If the field code definition is to use points, then a 2D line is started.
+2 Middle point of 3 point arc
-05 starts a curved 3D polyline section.
-50 ends a curved 3D polyline section.
+8 starts a 2D and 3D polyline combination that is open.
*8 starts a 2D and 3D polyline combination that is closed.
-8 ends a 2D and 3D polyline combination.
-08 starts a 2D and 3D polyline combination curve that is open.
-80 reverts back to a straight 2D and 3D polyline combination.

**GIS Processing**

With GIS processing activated, the entities created by Field-to-Finish are linked to a GIS feature name and attributes. These GIS links can be used by the routines in the GIS module such as Input-Edit GIS Data.
GIS processing in Field-to-Finish starts with the GIS Table setting in the initial Draw Field To Finish dialog. The GIS Table is the .GIS file created by the Define GIS Features command which defines the GIS feature names and attributes. Setting the GIS Table is optional but useful. The GIS Table is used as the reference in the Set functions for selecting a GIS feature name to assign to Field-to-Finish codes. Additionally, when processing the Field-to-Finish codes, any associated attributes from the GIS Table will be attached to the entities. Also, attributes generated from Field-to-Finish are added to the GIS Table. So using the GIS Table links the GIS module commands with Field-to-Finish.

Each Field-to-Finish code has settings to assign GIS feature names. In the Edit Field Code Definition dialog, the GIS Setup button brings up a dialog for setting the GIS feature names and attribute options for the current code. Since Field-to-Finish codes are capable of drawing both points and linework and GIS can have different features for points and linework, there are separate settings for the GIS feature names for points and linework. For example, a Field-to-Finish code UP for utility pole could be setup to draw both points with symbols at the poles and polylines between these points. Then you could have different GIS feature names for the pole points and linework with separate GIS attributes for each.

For Attributes to Create, these options create GIS attribute data which is stored in the database setup by the GIS Settings command and linked to the entities created by Field-to-Finish.

SurvCE GIS Fields: This option uses the attribute data generated by SurvCE which is stored in a .vtt file with the same file name as the current coordinate file except with the .vtt extension.
Field-to-Finish Code: This option creates an attribute named CODE with a value of the Field-to-Finish code name (ie. UP).
Field-to-Finish Full Name: This option creates an attribute named FULL_NAME with a value of the Field-to-Finish Full Name (ie. Utility Pole).
Special Codes: This option creates attributes for Field-to-Finish special codes including OH (Offset Horizontal), OV (Offset Vertical), SZ (Size), ROT (Rotation), AZI (Azimuth) and DIST (Distance).
Point Number: This option creates an attribute named POINT_NAME with a value of the point number from the coordinate file.
Drawing Description: This option creates an attribute named POINT_DWG_DESC with a value of the point description for the point block created in the drawing.
Coordinate File Description: This option creates an attribute named POINT_RAW_DESC with a value of the point description from the coordinate file.

The Point Properties By GIS Parameters lets you control the layer, symbol, color or size of the points based on GIS attributes. A classic example is drawing cities on a map with different symbols and sizes based on the population. The properties are defined in order of priority so that the first to match the parameters is used. Use the Up and Down buttons to change the order of the...
Default Code Tables

Default code tables are installed under Carlson Projects\Settings including Carlson.fld and the following DOT's: CA, CO, FL, IA, IL, IN, LA, MA, MD, MN, MO, MS, NC, ND, NE, NY, OH, SD, SK, TX, WA and WI.

Pipe Surveys

The Pipe Feature adds additional properties to the pipe of size, material and name. Also the Pipe Feature allows for more labeling of the pipe parameters and ability to draw the pipe in 3D.

Important:

The Pipe Settings apply to codes that are set to a Feature Type of Pipe. To set the Feature Type, go to Edit Codes and then the General tab of the Edit Field Code Definition dialog.

When a code is tagged as a Pipe Feature, the program looks for additional parameters after the code. The parameters are separated by spaces in the point description and in the order specified in the Description Sequence in the settings dialog. For example, if code 'P' is defined as a Pipe Feature and the order of size, material and name, then a description of 'P 8 PVC 31' would define a pipe point for an 8 inch pipe of material PVC and name of 31. These pipe parameters are optional. The program will use the provided parameters and leave the rest blank. Besides using the point description, the pipe attributes can be set from GIS attributes using the attribute names setup in the dialog.

For a structure with multiple inverts, the invert values should be in the description separated by commas. For example, for a structure with two incoming PVC pipes with sizes of 15" and 24", and inverts at depths 5.9 and 5.5, the description would be 'P 15,24 PVC 5.9,5.5'.

The Create Pipe Network option will generate a .sew data file that is used by the Hydrology > Network commands. The Connection Distance Tolerance is the max distance between pipe points to be counted as connecting to the same structure. The Use Point Elevation setting controls whether to use the point elevation for the pipe invert elevation or the structure rim elevation.

The Invert Measurement sets whether the inverts are measured to the top or bottom of the pipe. When measuring to the top of pipe, use the Pipe Thickness Lookup to define the default pipe thickness and pipe thickness for different pipe sizes and materials. The program will use the pipe thickness plus the pipe size to calculate the invert for the bottom of the pipe.
To setup the label and draw options, pick the Pipe Setup on the main edit codes dialog and pick the Pipe Label Settings tab. There are options to label the pipe length, size, material, name and slope. Under Draw Pipe Type, there are different styles for drawing the pipe line. The 3D Faces option draws the pipe in 3D at the pipe size. The Field-To-Finish option uses the polyline type (2D or 3D) as defined by the Field-to-Finish code. The Use Field-to-Finish Code Layer option uses the layer from the code definition instead of the pipe settings layers.
The Structure Label Settings tab has settings for labeling the structures in plan view. See the Plan View Label Settings topic in the Hydrology chapter for information on these settings.

Tree Surveys

Tree surveys can be coded simply by using general Field-to-Finish coding methods such as defining a code for a tree ("OAK") with a tree symbol and using the SZ special code for sizing the symbol. For tree survey specific features, go to the Tree Survey button on the main edit codes dialog. This function brings up a dialog with tree survey settings. The tree survey works with three attributes for each tree: trunk, drip and tag. Trunk is the diameter of the tree trunk. Drip is the radius of the tree canopy. Tag is an id for the tree for reporting.

Important: The Tree Survey Settings apply to codes that are set to a Feature Type of Tree. To set the Feature Type, go to Edit Codes and then the General tab of the Edit Field Code Definition dialog.
On the **Tree Entry Options** dialog tab:

**Draw Point Attribute Block**: controls whether to draw the point block with the point #, elevation and description attributes.

**Draw Tree Table**: This option makes the program prompt for whether to draw a tree table when the program finds a couple points with tree codes. Otherwise, there must be many tree codes to have the program prompt for creating a tree table. The **Use Table Entity** option draws the table as a Carlson Table Entity. Otherwise the table is drawn with regular CAD lines and text.

**Draw Trunk Diameter**: Sets whether to create a circle or solid with the trunk diameter. The **Group With Symbol** option creates a CAD group to combine the tree and trunk symbols.

**Draw Treeline by Drip Radius in Scale**: shrinks the tree driplines to get the overall treeline perimeter. The perimeter polyline can be drawn either as Bubbles or Smooth. The Bubbles creates a treeline style polyline with a series of arcs. The Smooth creates a regular polyline.

**Draw Tree Symbol for Drip Radius in Scale**: draws individual symbols for each tree using the symbols defined in the code table and scaled by the drip size attribute.

**Draw Tree Symbol for Drip Radius by Factor**: draws individual symbols for each tree using the symbols defined in the code table and scaled by the drip size attribute and the **Size Factor** from this dialog.

**Draw Tree Symbol with Code Symbol Size**: draws individual symbols for each tree using the symbol name and size defined in the code table.

**Draw Tree Symbol by Factor of Trunk Diameter**: draws individual symbols for each tree using the symbols defined in the code table and scaled by the trunk size attribute multiplied by 12. For example, a 10” trunk size is drawn as a 10ft symbol.

**Draw Same Size Tree Symbol**: draws individual symbols for each tree using the symbols defined in the code table and at size of 6.

**None**: simply does not draw a tree symbol.
On the **Input Values Options** dialog tab:

**Default Tree ID to Point ID:** This option uses the point number for the tree tag unless the point description contains a tree tag.

**Begin Tree ID From:** This is the number to start incrementing tree tags from in case the tree coding is missing tags and you want to assign tags for reporting.

**Input Trunk Value:** controls whether the trunk size is entered as a radius or diameter.

**Input Drip Value:** controls whether the canopy drip size is entered as a radius or diameter.

On the **Layer** dialog tab, there are optional layer names for different types of tree entities to append either as a prefix or suffix to the layer from the code table.
On the **Description Codes** tab, there are settings to help identify the tree attributes in the point description. The program looks for the trunk size, drip size, tag ID and height in the point description after the tree code. By default, the program expects the attributes to be in the order of trunk size, drip size, tag ID and height. Here's an example default order:

OAK 16 12 100 28

where OAK is the tree code from the code table, 16 is the trunk diameter, 12 is the drip radius, 100 is the tag ID and height is 28.

If the attributes are in a different order, then the suffix/prefix settings can be used to identify the attributes. When the program finds a specified prefix or suffix, that tells the program which attribute to use. For example, if the Trunk Suffix is "in" and the Drip Suffix is "ft" and the Tag Prefix is "T", then

OAK T100 16in 12ft

means tag ID of 100, trunk diameter 16 and drip radius 12 feet.
In addition to looking for the tree attributes in the point description, the program can also read these attributes from GIS fields. On the **GIS Attributes** dialog tab, you can set the GIS field names for the tree attributes.

On the **Label** tab, there are settings for the tree text labels for the size, offset from trunk center, style and location. When creating a tree table, only the tag text is labeled. Otherwise, the label is drawn. **Offset By Tree Symbol Size** moves the labels beyond the tree symbol to avoid overlap between the labels and the symbol. **Output Trunk Value** sets whether to label the trunk size as a radius or diameter. **Output Drip Value** sets whether to label the canopy size as a radius or diameter.

The **Label Description Setup** dialog sets which fields to include in the label or table. For each field, there are settings for the field order, prefix, suffix and decimals. The New Row option allows for drawing labels on separate rows. The Header and Width settings are for the tree table. The **Only Label Tag ID With Table** option controls whether to draw the tree tag when not creating a tree table.
When Field-to-Finish draws entities, the program checks for codes set as tree features and applies the settings from the Tree Survey dialog. When tree features are found, the number of trees are reported along with a prompt for whether to draw a tree table. The tree table has the tag ID, code description and trunk diameter.

Here is an example with the following three points:
Point# Northing Easting Description  
1 4994.73 4923.15 OAK 24 38 301  
2 5034.59 4881.40 PINE 18 24 302  
3 4987.32 4975.79 PINE 12 20 303

Dripline drawn as Treeline method along with a tree table.

Another feature of Tree Survey is the Tree Report under the Report Codes/Points function. The Report Formatter option can be used to make a custom report and output to Excel or create a custom table in the drawing.
Pulldown Menu Location: Survey
Keyboard Command: fld2fin
Prerequisite: A data file of points with descriptions

Field to Finish Inspector

This command reviews entities in the drawing created by Field To Finish. Point descriptions can be edited and the drawing is updated for both the point symbols and linework, using the Field To Finish coding.

Field to Finish Inspector docks a control panel dialog at the bottom of the screen which leaves the drawing view at the top.

Code: Lists the field codes that were found in the drawing. Clicking on a code causes the Instance list to show all of the linework and points that use the selected code.

Instance: Lists the linework and points of the currently selected code.
Point: Lists the points that make up the currently selected linework or point in the Instance list.
Go to Point#: Type in the point # to see in the drawing and then press this button to bring the point # into view. If the point # is not in the drawing, then a message will be printed at the top of the dialog box. If the Zoom toggle is on, then the point # will be brought to the center of the screen even if it was already visible on the screen. Likewise, if Isolate or Highlight are on, then those options will be applied, too.

Zoom: Check this checkbox to make the Field to Finish Inspector automatically zoom and pan the drawing so that the selected items in the above lists are viewable. Zoom is used on the Code and Instance lists. Pan is used for all three lists.

Isolate: Check this checkbox to make the Field to Finish Inspector only display the selected items in the above lists.

Highlight: Check this checkbox to make the Field to Finish Inspector highlight the selected items in the above lists.

Restore View On Exit: Check this checkbox to make the Field to Finish Inspector restore the zoom and pan values when you exit.

Desc: This edit box will display the description field from the coordinate file used on the given point(s). If the points do not all have the same description in the coordinate file, *varies* is displayed instead. If you type in a new description and then click on Apply, the new description will be applied to the coordinate file and Field-to-Finish will be used to process the coordinate file and update the drawing, including linework. Press the Code button to place an existing field code into this Desc edit box.

Code: Press this button to select a field code from the current field code definition (FLD) file. The following dialog box is an example of what you will see. The Categories on the left are the categories that are defined in the current field code definition file. The list on the right is all of the field codes in the selected category. Select (all categories) to see all of the codes in all of the categories. The selected field code will be placed in the Desc edit box.

Apply: Press this button to apply the modified description that is in the Desc edit box to the currently selected points. The below dialog box will come up that lists exactly what will be changed. Optionally, the raw file that was used to create the coordinate file will be updated as well. Press OK to continue. The description will be updated in the coordinate file and then Field-to-Finish will be used to process that coordinate file and finally the drawing will
be updated to reflect the changes.

Code: This button generates a user-defined report with fields for the point number, coordinate, feature name and code. This report uses the Report Formatter to select which fields to include.

SAMPLE REPORT

<table>
<thead>
<tr>
<th>Point#</th>
<th>Code</th>
<th>Full Name</th>
<th>Northing</th>
<th>Easting</th>
<th>Elevation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CM</td>
<td>CONCRETE MONUMENT POINT</td>
<td>4922.730</td>
<td>5570.695</td>
<td>502.510</td>
<td>CM/(4’’ DIAM)</td>
</tr>
</tbody>
</table>
Edit Field to Finish Codes

This command edits a Field to Finish code table. The program prompts for the .fld file to edit and then runs the code table editor. See the Field-to-Finish section of the manual for a description of the code table.

Enter Deed Description

This command lets you enter line and curve data which is drawn and annotated as entered. When entering in data, the bearing quadrant and bearing value is input on the same line. For example, a bearing of N45-10-30E would be entered as 145.1030, where (1) represents the NE quadrant. The numeric codes for the quadrants are 1-4 beginning with NE as (1) and continuing sequentially in a clockwise direction to the NW quadrant (4). Distance data can be entered in Varas, Meters, Poles, Chains or US Feet. In addition to typing in the angle and distance numbers, there is a Select option at the command line which prompts to select an existing text label that the program will read to get the angle or distance.

Curve data can be entered for Non-Tangent, Reverse-Tangent and Tangent curves. Data used to define curves includes but is not limited to Tangent Out Bearing, Radius data, Chord Bearing, DeltaAng and Tangent Length. Prompting for curve data it determined by what curve definition data is used. When you are finished, the closure and area of the figure is reported.

The program has the option to Undo the previous data entry in case you need to re-enter values. Also, the program auto-saves the data entered during the command so that if the command is canceled and restarted, there's an option to resume entering data. The command starts with the dialog shown here.
Line and Curve Layer: Specify the layer name for lines and arcs.

Points Layer: Specify the layer name for the points.

Traverse by: Select between entering bearings, azimuth, gons or point numbers. The points option recalls points from the current coordinate (.CRD) file. The prompt option adds a prompt for each angle to specify the angle format.

Point Format: Choose between creating Carlson points in the coordinate (.CRD) file at each point in the figure, drawing descriptions only or having no point labels.

Apply Rotation: This option adjusts the entered bearings by the specified rotation.

Label Lines and Arcs: Specify whether the annotation should be drawn on the lines and arcs or should be added to line and curve tables. The settings for the label styles are defined by the Annotate Defaults and Auto Annotate commands. Please see those commands in the manual for a description of those settings. You can either specify specific settings files from those commands or use the current settings which is the default.

Deed Name: Specify the beginning deed name. Only available when Store to Deed File is checked on.

Draw Linework: Specify whether or not to draw linework, if this is disabled then all annotation options are disabled also.

Create Polyline: This option creates a polyline of the deed perimeter instead of individual line and curve entities.

Prompt for Descriptions: Specify whether or not the program should prompt you for point descriptions. If this is not checked, then point descriptions are blank.

Prompt for Elevations: Specify whether or not the program should prompt you for point elevations. If this is not checked, then point elevations are set to zero.

Prompt for True Point of Beginning: With this option, the traverse begins before the TPOB. When the traverse reaching the TPOB, enter the POB option at the command prompt to indicate the true point of beginning and start.
Plot Point Symbols: If the Point Format is set to Descriptions Only or None, this option is available. It will place point symbols without creating points in the coordinate (.CRD) file.

Create Radius Points: When checked, radius points will be created for arcs. Radius points are given the description RADPT.

Store to Raw Data (.RW5) File: When checked, data entered will also be written to a raw data (.RW5) file that can be opened using the Edit-Process Raw Data File command. This file can be used to perform coordinate adjustments. The Compass rule, Crandall rule, Transit rule, Angle balance adjustment and Least-square adjustment routines are all available. See Edit-Process Raw Data File for more information.

Store to Deed File: When checked, data entered will be written to a deed (.PDD) file. This file can be processed later to correct errors, create deed reports or to redraw the deed. To use this option, set the deed file name by picking the Specify File Name button. Also set the Deed Name field.

Prompts

Pick point or point number: 1

PtNo. North(y) East(x) Elev(z) Description
1 8000.00 12000.00 0.00

In this example the coordinate for point number one has already been stored in the current coordinate (.CRD) file with the Draw-Locate Points command.

Undo/Exit/Curve/Select/<Bearing (Qdd.mmss)>: 145.3035
Varas/Meters/Poles/Chains/Select/<Distance(ft)>: 210.5 Enter P to input a distance in Pole format or C for Chains format.

Undo/Exit/Curve/Select/<Bearing (Qdd.mmss)>: C Enter C to traverse through a curve.

Tangent-out/Radius: R
Radius: 1103.5

Curve direction (Left/<Right?>) press Enter for right
Non-tangent/Reverse-tangent/Chord/Delta angle/Tangent/<Arc length>: N If the curve is non-tangent to the previous leg then enter the arc length, enter C for a chord length, D to enter the delta angle or T to enter the tangent distance. In this example we have a non-tangent curve so we entered N.

Non-tangent/Reverse-tangent/Chord/Delta angle/Tangent/<Arc length>: C Enter C to traverse through a curve.
Chord Bearing (Qdd.mmss): 245.2341
Length of Chord: 201.22
Undo/Exit/Curve/Select/<Bearing (Qdd.mmss)>: 345.3218
Varas/Meters/Poles/Chains/Select/<Distance(ft)>: 209.28
Undo/Exit/Curve/Select/<Bearing (Qdd.mmss)>: 445.2348
Varas/Meters/Poles/Chains/Select/<Distance(ft)>: 200.54
Undo/Exit/Curve/Select/<Bearing (Qdd.mmss)>: E Enter E to end the prompting and calculate the closure error.

Closure error distance> 1.35251089 Error Bearing> N 70d41'35'' E
Closure Precision> 1 in 607.63 Total Distance Traversed> 821.82

Pulldown Menu Location: Survey
Keyboard Command: PDD
Prerequisite: None
Deed Reader

This command is used to extract deed line and curve data from the text of a deed. It shows the deed data in a spreadsheet and also graphically. The deed data can be saved to a deed file, drawn and reported. A blank Deed Reader dialog box appears as soon as the command is chosen.

The Text section is for entering in ASCII/TXT data for the deed. This can be accomplished by using the Paste button at the bottom of the dialog, or loading a filing using the Load button. You can also type information directly into this screen. Reader Warnings indicates irregularities in the deed text. The Result section is below that. This section will give you a detailed, editable spreadsheet of the deed, which can be saved. At the very bottom of the dialog is a section called Summary. Here is where you will see the mathematical and closure data for this deed displayed.

Paste: This is for pasting in copied information.
Load: This option will load an existing deed text (.TXT) file. Here is an example.
Quick Settings: This option allows you to set up, in a speedy fashion, the detailed criteria for this Deed Reader command.

Settings: A more formal settings feature, which is more methodical and dialog box driven.

Draw: This option will provide you choices as to how the data will be translated to the drawing screen.
It is in the Draw Options dialog that you can make decisions as to how detailed and involved your drawing will be. The Points section is key if you desire to have points created to a new coordinate file, or if you want to append an existing one. In the Annotations section, if Label Lines and Arcs is clicked on, the next dialog that you see, after choosing a point of origin, will be Auto-Annotate. Finally, click OK.

Prompts

**Deed Reader dialog:** *enter in or load the deed text*

**Pulldown Menu Location:** Survey

**Keyboard Command:** read_legal

**Prerequisite:** Deed text

**Process Deed File**

This command contains several functions for deed (.PDD) files. A deed file consists of one or more deed descriptions. Each deed description includes a deed name, starting coordinate and line/curve data. This deed data can be created with the *Enter Deed Description* command. This command begins with the Process Deed File dialog.
Edit Opens the Edit Deed dialog where you can view or modify the deed name, starting coordinates, or line/curve data. Within this dialog the following commands are available.

Add Opens the Edit Deed dialog where you can add a new deed.

Remove Removes the currently highlighted deed.

Draw Draws the currently highlighted deed in the drawing and returns to the main dialog. The actual geometry will not appear in the drawing until you exit Process Deed File. There is an option to label the deed using the settings from the Annotate Defaults and Auto-Annotate commands.

Report Generates a report for the currently highlighted deed. The report is displayed in the Standard Report Viewer unless Use Report Formatter is active which allows for customized reports and Excel output using the Report Formatter. For the Report Closure, the Start-End Coordinates option uses the difference between the POB (point of beginning) and the coordinates of the last call to calculate the closure error. The Angle-Distance Precision option determines the closure error by starting with the POB and calculating each point in the deed using the angle and distance values entered. Distance values are further affected by the precision in the report settings.

Copy Creates a new deed by copying the geometry of the highlighted deed.

Export Saves the selected deed data (.PDD) in raw file format (.RW5) that can be used with Edit-Process Raw File.

Save Saves the currently loaded deed (.PDD) file.

SaveAs Allows you to save the currently loaded deed (.PDD) file to another file name.
**List** Selects the starting coordinate from a point selection list from the current coordinate file.

**Pick** Allows you to screen pick the starting coordinate.

**Order** Allows you to set the sequence of the columns in the spreadsheet editor.

**Add** Allows you to add a new deed call (line or curve).

**Remove** Removes the highlighted deed call.

**Move Up/Down** Change the list order of the data records for the currently highlighted row.

**Angle Mode** Choose between Azimuth or Bearing inputs.

**Angle Format** Choose between using one spreadsheet cell for the angle in dd.mmss format or using three cells with dd, mm and ss in separate cells for easier editing.
The POB location is variable on the deed. This means when entering or editing a deed, you may select any call in the deed to be the POB (Point of Beginning). The total perimeter, closure error and precision are determined from this point to the last call of the deed. Other calls leading up to the POB may be included in the deed as reference or commencement calls but not used in the closure calculations.
Deed Tools

Import Angle/Distance File

This command creates a Deed File (PDD) using the angles and distances from a text file. The text file must have one set of angle and distance on each row with the values separated by a delimiter such as a comma. After selecting the data file to import and the deed file to output, the program has a dialog to define the format of the input file. Choose the file delimiter and select the columns for the Azimuth and Distance.
Deed Linework ID
This command is used to report the deed name associated with selected linework. Since the Carlson deed commands that draw deeds attach the deed name to the linework, this command will extract that information and list it out. You can choose to select more than one deed linework entity before ending out of the command.

Prompts

Select deed linework to identify: select deed linework
Deed Name: Out Lot3 - Carlson Property
Select deed linework to identify (Enter to end): select Enter

Deed Correlation
This command takes a set of field and design/deed points and creates an inverse report, such as radial stakeout, for each pair of points. The Align functions combine a translation and rotation. The Alignment Direction settings controls whether to go from the survey points to the deed points, or vice versa. The command includes a routine to find the best point to hold and the best point to rotate to. This command provides tools for the correlation of surveyed points with that of deed input points. Different points can be specified as hold points, or rotation points, and provide a report showing the bearing and distance of all sides of the traverse/deed, based upon the hold and rotation points. This allows for the review of different scenarios based upon hold and rotation points. Perhaps two points in the field are in good shape, and seem to meet all the descriptions thereof. You decide to hold these two points as good, but you would like to see what holding these points will do to each side/call of the tract/description. This is what this routine is designed to do. In addition to allowing user specified trials of different hold and rotation points, the routine also provides a Find Minimum Rotation option that will report which points specified as the hold and rotation points will result in the minimum rotation of all sides of the tract/description. All points must be contained in the same coordinate file, and the points to be used in the correlation must be specified as either Survey points or Deed points. The Use Report Formatter option chooses between a fixed, automatic report, or a user-defined report format.
Edit: Edits the highlighted Survey and Deed point. Once selected the dialog above is displayed allowing for changes to be made.

Add Point: Click this button to specify the points as either Survey or Deed points. Then fill out the Edit Points dialog as desired.

Add Polyline: This function prompts to select polylines for the survey and deed perimeters and uses the polyline vertices for the survey and deed points.

Remove: Removes the highlighted Survey and Deed points from the correlation setup. This does not delete the points from the coordinate file.

Inverse Report: This generates a report showing the inverse data from each point, both survey and deed, to every other point specified in the correlation set up. For example if there were four points in the survey points (1-4) then the report would show inverse data from 1 to 2, 3, 4; from 2 to 1, 3, 4; from 3 to 1, 2, 4 and from 4 to 1, 2, 3. This would be the same for the corresponding deed points.

Compare Before Align: This option compares the survey information to the deed information.

Check Align: This option that allows for user specified hold and rotation points, and then reports the inverse data of each side of the tract/description. The hold point and rotation point must be points from the specified survey point group.

Find Min Align: Determines the hold and rotation points that would result in the minimum rotation to each side of the tract/description. When selected the Minimum Deed Rotation Report is displayed.

Apply Alignment: This option can be issued after the Min Align criteria is set.

Save: Saves the point list to the current dcf file.

Save As: This option prompts for a user specified file name and allows for a user specified location to save the file. The file extension for the deed correlation file is dcf. When executing the program you have the option of using an existing file or creating a new file for the deed correlation.
After specifying the hold and rotation points, the deed correlation report will display again, showing the bearing and distance of each side of the tract/description.
Pulldown Menu Location: Survey
Keyboard Command: deed_align
Prerequisite: A coordinate file (.CRD)

**Legal Description Writer**

The *Legal Description Writer* gives you the ability to create a detailed legal description from a polyline. This description consists of calculated calls, point descriptions from Carlson points, and numerous user defined terms. The program's values for these terms are easily replaced, and are stored as defaults with each use. When a scale factor is specified under Drawing Setup, the Legal Description distances will apply the scale factor which is a way to report grid distances from ground drawing coordinates or vice versa.

In addition to this command, you can also generate legal descriptions by point numbers with the Report function within the Lot File Manager command.
Legal Description Writer Dialog
This initial and primary dialog box is shown above, and described below.

**Pick Boundary Polyline:** This button is used to designate the polyline boundary used. The boundary should be a closed polyline. Tools are provided in the Edit menu if you need to reverse the polyline or change its origin point. You can also select multiple polylines to process at the same time by entering M for Multiple at the Select Boundary Polyline prompt in this routine.

**Pick Inside Boundary:** This button is another way to designate the polyline boundary. With this method, the boundary can be defined by multiple linework entities. You pick inside the boundary area and the program will figure the boundary perimeter from the surrounding linework. This method uses the same technique as the Draw->Boundary Polyline command. The boundary perimeter that the program finds is highlighted for visual confirmation.

**Deed File:** This method selects the deed to report from a deed file (.pdd).

**Pick Reference Lines:** Used to select lines that tie into the polyline boundary used for the legal description. These should be LINE objects that have one endpoint exactly the same as the beginning point of the boundary polyline. If a Carlson point exists at the end of the line away from the boundary, the routine will pick up its description, otherwise you will be prompted for the description. You can choose any number of reference lines, simply press enter to conclude the selection of reference lines.

**Point Group:** This method defines the perimeter by a series of points from a group defined by the Point Group Manager command. In Point Group Manager, a group can be defined as a point list including the ability to have radius points.

**Header File:** This button and edit field are used to designate the optional header text file. If a valid file is selected
it will be written into the top of the output.

**Footer File:** This button and edit field are used to designate the optional footer text file. If a file is selected it will be written at the end of the output.

**Centerline File:** This allows you to set an optional reference centerline for reporting station/offset for each point in the boundary.

**Output Options** allows you to select where Legal Description Writer should send the output.

**Report Viewer:** The output is sent to the report viewer specified under Configure Carlson->General settings: Carlson Standard Report Viewer, Windows Notepad or Microsoft Word.

---

**Text File:** The output is sent to an external text file as designated in the output file section described below.

**Mtext Object:** This creates a mtext object in the current drawing. Upon choosing OK you will be prompted for a starting point (which is the upper left corner) and well as a second point that determines the width and angle. By default ortho is turned on for this second point. Press the F8 key to toggle its status.

**Output File:** This button and edit field are used to designate the necessary output text file. This file can then be brought into your word processor and finalized. Note that the appearance of the output file can be affected by the status of the 'Use Paragraph Format' toggle in the Legal Description's General settings.

**Angle Specifications**
This section is used to establish the appearance of the bearings that are output with the description, and allows detailed control over each aspect.
**Angle Format:** The Format chooses between Bearing, Azimuth, Decimal and Fraction. Designate the character or word used in each bearing direction. Standard values are the letters N, S, E, or W. One possible option is the entire words NORTH, SOUTH, EAST, and WEST. It is important to keep in mind that spaces are literal, meaning that if you don't have a literal space after N/S, and before E/W, a space will not be formatted into the bearing. To use Azimuth, place a check in the Use Azimuth box and the General Prefix will be set to AZ.

**Cardinal Angles:** For example bearings that are due NORTH, the default is to generate N 00° 00' 00 E. If the Label Cardinal Angles toggle is turned on, the program will substitute the single word (which you can change) for the direction, these usually being NORTH, or DUE NORTH.

**Quad Directions:** These names are used for the Concave Direction for curves and for the direction when using the Report Interior Angle option.

**Symbols:** This section allows you to designate the precision for bearings, as well as the symbols used. Turn on/off the toggles for degrees, minutes, and seconds to control the precision. For example, if you wish to round to the nearest minute, simply clear the toggle from the second field. For each field (degrees, minutes, seconds), you can supply the character or word to be used. You can quickly fill in these fields with the two buttons to the right.

**Line Segment Specifications**
This section is used to establish the terms used when the course of a call is a line segment, as is often the case. Simply supply the beginning and ending terms for these line calls.
**Curve Segment Specifications**

This large dialog is used to establish the terms and options used when creating the course of a curve. Basic options include beginning and ending terms, as well as the words for left and right if chosen. In the large table of curve options, you can choose the items you wish to report, in the order you want them to appear. Simply place a number in the sequence field indicating the items you wish to report, making sure that there are no duplicate numbers. In the example below, the program would output the curve direction, arc length, radius length, chord bearing, and chord length, radius length, chord bearing, and chord length, and in that order. Each field can also have a unique prefix/suffix. There are four different possible phrases for the start of the curve description for whether the curve is tangential, non-tangential, compound or reverse. The Radial In/Out for Non-tangent Only option applies to the Radial In/Out fields and tell the program to only use these fields when the curve is non-tangent. Otherwise, these fields are always used when the Radial In/Out fields are in the sequence.

![Curve Settings](image.png)

**Spiral Specifications**

This dialog has the setting for reporting spiral portions of the boundary. In order to pick up the spiral, a centerline (.CL) containing the spiral must be drawn using the Draw Centerline File command. Then the program will pick up the spiral definition for any portion of the legal description boundary that follows the spiral on the centerline.
Distance Specifications
This dialog is used to establish the terms and precision used when creating a distance for the course of a call. The precision and suffix apply to curves as well. Simply choose the desired distance precision from the popdown, and supply the beginning and ending terms for the line calls.

Note the availability of dual distance reporting. If you would like to report dual distances such as feet/metric, turn on the toggle in the lower left corner of the dialog. Note that the primary units are the units set in the Settings menu, Drawing Setup. If you have English set as your units in Drawing Setup, then the alternate units will be metric. The opposite also applies. If your units in Drawing Setup is set to metric, then the alternate units will be English.

Point Specifications
In the process of following the polyline definition for a boundary, the legal description writer can look for descriptions of the points at the endpoints of the polyline. These can be extracted by setting the data source to the corresponding point from the coordinate (.CRD) file, meaning the points do not have to be plotted on the screen. A second option is point block, in which the program will read the information from the drawing, and not require the presence of a coordinate (.CRD) file.
Besides point descriptions, you can also report the point coordinates.

Prefix: General term applied before the actual description.
Suffix: General term applied after the actual description.
Unknown: The text designated here will be placed in the description if the program does not find a valid description at that coordinate location. The words ‘Unknown Point’ may be used.
Tolerance: The point must be within this distance of the polyline vertex to use the description.
Report Coordinates: Choose whether to report coordinates and the order for the northing and easting.
Northing Prefix/Suffix: Strings to report before and after each northing value.
Easting Prefix/Suffix: Strings to report before and after each easting value.
Precision: Number of decimals for the northing and easting values.

Station/Offset Specifications
When using a reference centerline file, the report will include the station and offset for each of the points in the boundary. The settings in this dialog control the format of these values. The program will skip reporting the station/offset for points with an offset more than the specified Max Offset.
General Specifications
This dialog controls general specifications which can affect the entire description. Each group of items are explained in detail below.

Body of Description: Enter the beginning and ending terms for the description.
**String Case:** Choose the button corresponding to the string case conversion desired. If you want no changes made, choose none. Choosing upper, lower, or proper case conversion will affect the case of all text throughout the description, except bearing letters.

**Report Sequence:** This option controls the sequence to report the boundary segments either in the direction of the polyline, clockwise or counter-clockwise.

**Spell Out Numbers:** This option writes numbers as words instead of digits. For example, a distance of 123 would be written as one hundred twenty three.

**Append Lines Output Format:** If this toggle is on, the program will output the description without carriage returns after each line. This approach makes a nice paragraph style when brought into a word processor with word wrap. If the toggle is cleared, the program will place carriage returns at the end of each call.

**Geodetic Options:** In order to use these options, the grid projection for the drawing must be set using the Settings > Drawing Setup command. The **Report Geodetic Mean Angle** option reports the geodetic mean angle which is the average of the geodetic bearings at the two point instead of reporting the direct coordinate bearing between two points. **Distance Type** controls whether to report grid distances or geodetic distances at zero or mean elevation.

**Area Specifications**
The legal description writer can output several types of areas. Basic options include beginning and ending terms. In the large table of area options, you can choose the items you wish to report, in the order you want them to appear. Simply place a number in the sequence field indicating the items you wish to report, making sure that there are no duplicate numbers. You can edit the prefix/suffix for each and control decimal precision of each field output. For geodetic areas, the grid projection needs to be defined in the Settings > Drawing Setup command.

**Reset:** This option will reset all settings to their original default values.

**Save:** This option saves the legal description settings to a file. The file will be saved with an extension of (.LGL).

**Load:** This option loads previously saved legal description (*.LGL) files.
Closure by Point Numbers

This command allows for traverse entry by point numbers, reports the closure and supports traverse adjustments. Using an existing coordinate file, the traverse is defined by a series of point numbers. The angle and distance for each traverse segment is calculated using the coordinates of the points. The traverse can be processed using all adjustment routines. Refer to the Edit-Process Raw Data File command for more detail on adjustment procedures. After selecting Closure By Point Numbers from the Survey menu, the Closure By Point Numbers dialog will appear.

In this dialog shown above, add the point numbers that make up the traverse. This can be done by entering the point number, a range of points, or a point group into the Point Number(s) field. You can also choose points from a list by clicking the List button. Once each point, or group of points, is entered, click the Add button. Continue in this fashion until all of the point numbers are entered in. Clicking the Process button will display the Choose Process
Method dialog. Choose the desired process method.

After selecting the process method for any of the adjustment methods, the dialogs and prompts will follow. They all start out with an "options" dialog box. These dialogs are titled either Process Options or Closure Options, depending on which process method you chose. The prompts that follow for any of the methods are subset of, and are very similar to, the prompting found in the Edit-Process Raw Data File command. After you have made your selections within these dialog boxes, click OK.

When you choose No Adjust of Angle Balance

When you choose Transit, Compass or Crandall
Each of the process methods will display a report that details the closure before the adjustment, and after the adjustment. Options to save and print this report are available. After a review of the report, pressing Exit will remove the report from the screen. At this point a Process Results dialog, prompting whether to Update points in CRD file with adjusted coordinates, will appear. If you choose Yes, the active coordinate (.CRD) file will be updated with the adjusted coordinates. Choosing No will leave the active coordinate (.CRD) file in its existing state, with the coordinates unchanged. It is important to remember that the starting and ending point in this routine must be a different point number. For example, if the traverse starts at point 1 and ends at point 1, then another point number should be used for the tie in shot to point 1. This logic is different in Edit-Process Raw Data File, where the starting and ending point can be the same point number.

Pulldown Menu Location: Survey
Keyboard Command: ptrawedit
Prerequisite: Coordinate (.CRD) file

Map check
By Points
This command allows you to check the closure of a figure and produce a report. The points used for the map check should already be stored in a coordinate (.CRD) file, by using commands such as Traverse, Locate by Bearing, Curves menu, Locate by Angle – or perhaps a file from an electronic data collector.

Prompts
Table Description: Description
Beginning Point Number: 903
PointNo. Northing(Y) Easting(X) Elev(Z) Description
903 4940.73 2490.40 0.00
eXit/Curve/<point number>: 904

PointNo. Northing(Y) Easting(X) Elev(Z) Description
904 4850.89 2388.01 0.00
BEARING> S 48d43'58'' W Hz DIST> 136.21
eXit/Curve/<point number>: 905

PointNo. Northing(Y) Easting(X) Elev(Z) Description
905 4699.39 2423.32 0.00
BEARING> S 13d07'04'' E Hz DIST> 155.56
eXit/Curve/<point number>: 906

PointNo. Northing(Y) Easting(X) Elev(Z) Description
906 4653.59 2582.19 0.00
BEARING> S 73d55'04'' E Hz DIST> 165.34
eXit/Curve/<point number>: 910
<table>
<thead>
<tr>
<th>PointNo.</th>
<th>Northing(Y)</th>
<th>Easting(X)</th>
<th>Elev(Z)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>910</td>
<td>4941.88</td>
<td>2492.50</td>
<td>0.00</td>
<td></td>
</tr>
</tbody>
</table>

**BEARING**: $N$ 17d16'54'' W Hz **DIST**: 301.93

**Closure error distance**: 2.39476609 **Error Bearing**: $N$ 61°10'45'' E

**Closure Precision**: 1 in 316.96 **Total Distance Traversed**: 759.04

**SQ. METERS**: 30403.0 **SQ. KILOMETERS**: 0.03

**HECTARES**: 3.04 **CUERDAS**: 7.74 **PERIMETER**: 759.04

**Pick area label centering point**: *pick point on screen for label text*

**Erase Polyline Yes/No**: *Yes*

**Typical Map Check Report:**

<table>
<thead>
<tr>
<th>Course</th>
<th>Bearing</th>
<th>Distance</th>
<th>PT#</th>
<th>Northing</th>
<th>Easting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>903</td>
<td>S 48°43'58'' W</td>
<td>136.21</td>
<td>904</td>
<td>4850.89</td>
<td>2388.01</td>
<td></td>
</tr>
<tr>
<td>904-905</td>
<td>S 13°07'04'' E</td>
<td>155.56</td>
<td>905</td>
<td>4699.39</td>
<td>2423.32</td>
<td></td>
</tr>
<tr>
<td>905-906</td>
<td>S 73°55'04'' E</td>
<td>165.34</td>
<td>906</td>
<td>4653.59</td>
<td>2582.19</td>
<td></td>
</tr>
<tr>
<td>906-910</td>
<td>N 17°16'54'' W</td>
<td>301.93</td>
<td>910</td>
<td>4941.88</td>
<td>2492.50</td>
<td></td>
</tr>
</tbody>
</table>

**Closure error distance**: 2.39476609 **Error Bearing**: $N$ 61°10'45'' E

**Closure Precision**: 1 in 316.96 **Total Distance Traversed**: 759.04

327253.1 SQ. FT. 7.51 ACRES

---

**Pulldown Menu Location**: Survey

**Keyboard Command**: mc

**Prerequisite**: Current coordinate (.CRD) file

---

**By Screen Entities**

This command allows you to check the closure of a figure, and produce a report from the Distance and Bearing labels in the drawing. The command works by prompting for a polyline and a sample of the text labels. Then the program looks for text on the sample layer and matches the text labels to the polyline segments. The text to process can be selected manually or automatically using an offset factor from the polyline. In addition to labels along the polyline, line or curve tables can also be used when the table are created using the Table Entity method in Table Defaults. The Deed Reader command is used here also, for extracting the deed line and curve data from the text of the deed. This polyline can be an open polyline in which case it's like doing an open traverse. The closure is based on the length of the polyline compared to the difference between the ending coordinate of the polyline and
the ending coordinate from the label angles and distances. The deed data can then optionally be saved to deed file.

The report includes the line and curve data for every segment along with the starting and ending coordinates, the area and the closure. The format for the area values is set by the Area Defaults command.
Prompts

Select linework to process: select polyline for the figure
Select sample text: select a label
Pulldown Menu Location: Survey
Keyboard Command: txtdeed
Prerequisite: Distance and Bearing labels

Cut Sheet

This command creates a report of the horizontal distance and elevation difference between points and a design. The design elevation can be defined by a grid file, triangulation file, 3D polyline, section file, note file, road template file, runway airway clearance or design points. The station and offset of the points can also be reported when a centerline is applied.

The data for the cut sheet is shown in a spreadsheet. You can edit or enter data in all the fields except for the Cut/Fill and Hz Error fields which are calculated. The cut sheet data can be saved and loaded with a .CUT file. The functions for processing the data are in the pull-down menus. Here’s an outline of a typical workflow:

1. Import the survey data using Import > Points, or Import > SurvCE.
2. Assign the target design elevation using a method from the Grade menu.
3. If station-offset are needed, use a method from the Centerline menu.
5. Run File > SaveAs to save the cut sheet data.

File > New: Clears the spreadsheet.
File > Save: Saves the spreadsheet data and report format settings to the current .CUT file.
File > SaveAs: Prompts for a .CUT file and saves the data.
File > Exit: Quits the program.

Edit > Undo: To undo the last edit in the spreadsheet.
Edit > Delete Row: Deletes the currently highlighted spreadsheet row. You can also use the Delete key to delete the current row.
Edit > Insert Row: Inserts a new row above the current row. You can also use the down arrow key from the last row to add rows to the bottom of the spreadsheet, and use the Insert key to add a row above the current row.
Edit > Modify Values: Changes values in the spreadsheet for the elevation, station or offset. In the dialog, set the amount to add or subtract (use negative value to subtract) and set which field to modify. There are controls for whether to update all the values or by point number range or by line number range. The Description Match is a way to filter which values to update.

Edit > Set Values: Sets values in the spreadsheet for the description, comment or offset field. In the dialog, choose the field to set, the value and which rows to set.
**Edit > Set Pipe Command:** This function fills in a Comment record of length and slope (ie "81.00ft - 15" RCP @ 2.4%") using the distance and slope between two points. The two points to use and the formatting options are set in this dialog.

**Edit > Cut:** Blanks out the data for the currently highlighted cells and puts this data into the Windows clipboard.

**Edit > Copy:**Copies the data for the currently highlighted cells into the Windows clipboard.

**Edit > Paste:** Puts data from the Windows clipboard into the spreadsheet starting at the currently highlighted cell.

**Import > Coordinate File:** Imports survey data from a coordinate file for the Point#, Northing, Easting, Survey Z and Description fields of the spreadsheet. This function first prompts for the coordinate file to import. Then there is a dialog to choose whether to select the points by point number range, by selecting point entities from the drawing, or by screen picking points. The Description Match and Ignore Zero Elevations are options for filtering out points.

Besides reading the coordinate data, this import function can also read station/offset data from the point descriptions by looking for values after the prefixes defined in this dialog.
Import Point Text File: This method is similar to Import by Coordinate File except a text file is used instead of a CRD file. The text file should have one point per row with fields for the northing, easting, elevation, description and point number.

Import Note File: This method reads the survey data along with the grade elevation from the note (.NOT) file that is associated with a coordinate file. For example, if the coordinate (.CRD) file is job3.crd then the note file name is job3.not. In Carlson Software's data collection programs (SurvCE and Field), there is an option to store stakeout data to the note file under the Stakeout options. When storing a point in the stakeout routines (using SurvCE or Field), the target point number, coordinates and elevation can be stored to the note file. This results with the as-staked coordinate stored in the coordinate (.CRD) file and the target coordinate stored in the associated note file. The Cut Sheet report can display this stakeout data using the Stakeout Point Comparison report option. The horizontal difference between the staked point and the target point can be reported in Bearing-Distance, Delta X-Y or North-South-East-West format. Also, in SurvCE and Field, the elevation difference routines can record the design grade elevation and station-offset to the note file when a point is stored to the coordinate (.CRD) file. This grade data can be reported using the Grade Elevation Report option. The note file records that the Cut Sheet report uses are TARGET\_X, TARGET\_Y, TARGET\_Z, TARGET\_DESC, TARGET\_PT, STATION, OFFSET, VOFF1 and VOFF2.

Import RW5 File: This method imports cut sheet data from a RW5 file of measurement data created by SurvCE. The stakeout functions in SurvCE store all the data needed to fill out the whole cut sheet including the survey data, design data and station-offset.

Import SurvCE Cut Sheet: Imports data from a SurvCE Cut Sheet file (.CSV or .TXT). The setup for these cut sheet files in SurvCE is under File > Job Settings > Stake > Cut Sheets.

Import TDS Raw: Imports data from a TDS RAW or RW5 file by reading the TDS stakeout records.

Grade Points: The reference points to compare can be in the same coordinate file or a separate file. The reference/design points need to be matched with the survey points. The Match By Distance Tolerance method matches the design point that is closest to the survey point and within the specified Match Tolerance. The Point# Within Description method looks for the specified Point# Description Code in the descriptions of the design points and gets the survey point number from the suffix of the description code. When the Point# Description Code is found, the number after this code is used as the point# to match from the other file. For example, if description code is "PT" and the description for point# 101 in the first coordinate file is "CURB PT303", then point# 303 from the second coordinate file is used for the match. For the separate file option, there is a third method to match points between the files which is to use point numbers to match points between the files. The Match By Manually method has a dialog for picking pairs of point numbers for the survey and design to add. The list of available survey points to match with comes from points in the spreadsheet that have Point#, Survey Northing and Survey Easting but not the design data.
Grade > Triangulation File: the design elevation is determined by the elevation of the triangulation surface at each point.

Grade > Grid File: the design elevation is determined by the elevation of the grid surface at each point.

Grade > 3D Polyline: When using a 3D Polyline for the grade elevation, the program calculates the elevation along the 3D polyline at the position perpendicular from the point selected. This calculated elevation is then compared to the point(s) selected to determine the cut/fill values.

Grade > Cross Sections: With Section Files, the grade elevation is interpolated from the offset-elevation data in the section file based on the station-offset of the point along the centerline. When using this method, a centerline file (*.cl) must be specified for station-offset data.

Grade > Runway Clearance: This option defines the target surface as the airway clearance around a runway. This method is for clearance reports for tree and building tops by comparing points to this runway clearance surface. The runway surface is built from a 3D perimeter polyline of the runway along with slopes for the approach lanes and runway sides. The runway sides are offset level from the runway perimeter for the specified distances before starting the slopes. The parameters for the runway are defined in the dialog and illustrated in the graphic shown here. The Write Runway Clearance Surface File creates a triangulation surface file that you can draw or inspect for verification of a correct target surface.
Grade > Road Design: This option defines the grade elevation using road design files. For each point, the program finds the station-offset for the point along the centerline and then applies the road design at that station to determine the grade elevation. Grade to Process is used to define the surface to use for the cut sheet comparison. These grades are defined as Top Surface, usually final grade, or subgrades and correspond to the defined grades and subgrades within a template file. The required design files include a centerline (.CL) file, a template (.TPL) file, and a profile (.PRO) file. There are also several optional design files such as Superelevation, Template Point Profile and Template Point Centerline. The design files are created in the Civil Design module. Using the design files in Cut Sheet is similar to the Process Road Design command.

![Cut Sheet Template](image)

Centerline > Centerline File: This function assigns the Station and Offset fields in the spreadsheet by prompting for a centerline file (.CL) and locating each point along the alignment.

Centerline > Polyline: This function assigns the Station and Offset fields in the spreadsheet by picking a polyline, entering the starting station, and locating each point along the alignment.

Centerline > Points: This method defines the alignment by entering two points to define a line.

Report > Create Report: This function display a report of the cut sheet data using the current report settings. When Use Report Formatter is off, the report is shown directly in the standard viewer. Otherwise, the Report Formatter dialog is shown for customizing the report and outputting to different formats such as Excel.

Report > Report Settings: There are several settings for the report including decimal precision, prefix for cut and fill and distance units. For the Horizontal and Vertical Tolerance, the report highlights any points that exceed these tolerances. The Distance Format chooses between Angle-Distance, Delta X/Y, and North-South-East-West deltas. The Cut/Fill Direction chooses whether to report cut/fill as Survey relative to Design or vice versa.
The **Report Zero Elevations** option controls whether to skip or report points with zero elevation.

The **Report Statistics** option reports the min, max, average and standard deviations of the deltas at the bottom of the report.

The **Design/Survey Data on Separate Rows** option creates two rows in the report for each record with the Design coordinate on one row and the deltas on the second row as shown here.

Point# Northing Easting Elevation Description Comment
229 499.997 1000.001 3.027
201 -0.005 -0.002 0.004 A

230 507.120 1000.158 2.929
202 -0.006 -0.003 0.001 B

231 515.694 1000.304 2.875
203 -0.005 -0.006 0.002

There are options for up to three **User-Defined Columns** which add extra fields to the spreadsheet and report.

![Report Options](image)

**Draw > Draw Labels**: This function uses the cut sheet data and draw settings to create labels in the drawing. **Draw > Label Settings**: There are three types of labels to draw. The Mark Points Outside Tolerance draws a symbol at each point that exceeds the tolerances setup in Report Settings. The Colors Labels Outside Tolerance sets the color for points outside the tolerance. Otherwise these points are labeled using BYLAYER for the color.

The Draw Delta Symbol has three styles. The DX/DY style draws a symbol to show the direction of the delta X and delta Y along with the values. The deltas are due north-south and due east-west. The Rotate Deltas By
Centerline style draws the same DX/DY symbol but this style prompts for a centerline to align the deltas. The Delta Distance style draws an arrow from the design towards the survey point.

**DX/DY symbol style**

![DX/DY symbol style](image)

**Delta Distance symbol style with Hz Error text label**

The Text Labels creates text labels for cut/fill, delta-x, delta-y, horizontal distance error or description. There are settings for the sequence order, prefix, suffix, layer, style, color, size and position.

**View > Zoom Plan View**: This function zoom centers the drawing on the currently highlighted point.

**View > Profile**: Creates profiles connecting the survey and design points. The profiles are shown in a graphic preview dialog which has functions to save the profiles to .PRO files.

![Draw Options](image)
**View > Hide By Point Numbers**: This function is a way to filter the spreadsheet by point numbers. The function prompts for a range of point numbers and then only displays those points in the spreadsheet.

**View > Hide By Description**: This function is a way to filter the spreadsheet by description. Wildcard matching applies to the user-defined description filter.

**View > Show All Rows**: This function shows all the spreadsheet rows including those hidden by the above functions.

**Examples of Cut Sheet reports comparing points are shown next.**

**Example 1: Cut Sheet comparing points to surface and using Report Viewer for report**

1) Run Import > Points and select sample_cusheet.crd from Carlson Projects. Select the points to import by range as shown.

   ![Import Points]

   ![Profile]

   ![View > Hide By Point Numbers]

   ![View > Hide By Description]

2) Run Grade > Triangulation File and choose sample_cutsheet.tin from Carlson Projects.
3) Run Centerline > Centerline File and choose sample_cutsheet.cl from Carlson Projects. Now all the data is ready for reporting.
4) Run Report > Report Settings and make sure the settings match the dialog shown here.

![Report Options Dialog]

5) The next steps will format the report. Run Report > Create Report which brings up the Report Formatter. Move the Available fields over to the Used fields list as shown. Also, be sure that Widths by Field is toggled on.
6) On the Report Formatter dialog, pick the Settings tab and then the Attrab Options button which controls how the values are formatted in the report. Then on the Attribute Options dialog, highlight Description and pick the Edit button. On the Attribute Display Options dialog for Description, turn off Auto Width and set the Fixed Width to 18. Then pick OK. Next highlight Comment in the list and pick Edit. Set the Fixed Width to 21 for Comment. Then pick OK on the Attribute Options to finish the attribute edits.

7) On the Settings tab for Report Formatter, pick the Field Options button which setups up the report header and footer. On the Field Options dialog, pick Import and select sample_cutsheet.fds from the Carlson Projects\Settings folder. Then pick OK.
8) On the Report tab for Report Formatter, pick the Report Viewer button. There is a dialog for setting the report page size. Pick OK.

Next is a dialog for entering report fields for the report header as setup in the previous step with the Field Options. Fill in the report fields and then pick OK.

Now the report is displayed in the Report Viewer which can be printed or saved to PDF, MS Word or Excel.
Example 2: Cut Sheet Report comparing points from the Current Coordinate File and with the Use Feet-Inches For Cut/Fill options on.
Example 3: Cut Sheet Report comparing points from Another Coordinate file, reporting coordinates for the points.

Example 4: Steps for Comparing Points in Current Coordinate file and using Report Formatter Option to customize report output to user preference.

2) Specify points to compare by one of the four methods described above for comparing points within the current coordinate file.
3) Select report content by highlighting the desired data from the Available list on the left side of the dialog box and then pressing the Add button to place the selected data in the Used list. Standard window selection methods using the Ctrl and Shift keys can be used to select more than one item at a time. After moving the selected data to the Used window it may be necessary to move data up or down to obtain the desired order of your report. To do this use the up and down arrows located on the left of the Used window.

4) When the desired data has been specified in the Used window press the Display button at the bottom left of the dialog. For more detailed information on using the report formatter see the Report Formatter section of this manual.
Set Point Elevations

By Surface Model

This command assigns elevations to points by a triangulation or grid surface model. For each of the points, the routine looks up the elevation from the surface model at the point x,y location. The option to Link Elevations To Surface Model will update the point elevations when the reference surface model is changed.

Prompts

Choose Grid or Tmesh file to process dialog choose existing GRD, TIN or FLT file
Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter
Select points to elevate.
Select objects: pick the points to elevate
Elevating points...
Elevated 10 points.

By 3D Polylines

This command assigns elevations to points by referencing 3D polylines. The station-offset is calculated for each point to the nearest reference 3D polyline. The point must be within the specified Max Offset Tolerance in order to be elevated. The elevation is calculated from the elevation of the reference 3D polyline at the station combined with the specified percent slope times the offset plus the vertical offset. The Decimals setting is for the elevation...
label of the point. The elevation for the coordinate file always uses full precision. The option to Link Elevations To Polylines will update the point elevations when the reference polyline is changed.

![Set Point Elevations By 3D Polylines](image)

**Prompts**

**Options Dialog**
Select points from screen, group or by point number [Screen]/[Group]/[Number]? press Enter
Select points to elevate.
Select objects: *pick the points to elevate*
Select reference 3D polylines.
Select objects: *pick the reference 3D polylines*
Elevating points...
Elevated 10 points.

**Pulldown Menu Location:** Survey and 3D Data in Civil
**Keyboard Command:** 3dpts, 3dp
**Prerequisite:** 3D polylines

**Polyline Tools**

**Polyline Report**
This command generates a report of data in the selected polylines. After starting the command, press O for Options to set various report options. When the Report Points option is active, the report includes the coordinates, angle-distance and curve data for all the points. With Report Points turn off, the report includes just the perimeter, area and layer names of the polylines. The closure can be reported between the starting and ending points of the polyline. The polyline area can also be reported. With the Multiple Polylines option, you can report a selection set of polylines with their total length at the end of the report.
Polyline Report

<table>
<thead>
<tr>
<th>Northing</th>
<th>Easting</th>
<th>Bearing</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>4657.495</td>
<td>5452.844</td>
<td>N 40d45'51'' E 84.323</td>
<td></td>
</tr>
<tr>
<td>4721.362</td>
<td>5507.902</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Radius: 175.795 Chord: 249.282 Degree: 32d35'33'' Dir: Right</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Length: 277.088 Delta: 90d18'35'' Tangent: 176.747</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Chord BRG: N 85d55'08'' E Rad-In: S 49d14'09'' E Rad-Out: S 41d04'26'' W</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Radius Point: 4606.577,5641.050</td>
<td></td>
</tr>
<tr>
<td>4739.102</td>
<td>5756.552</td>
<td>S 24d29'28'' E 122.817</td>
<td></td>
</tr>
<tr>
<td>4627.336</td>
<td>5807.466</td>
<td>S 74d29'33'' W 199.062</td>
<td></td>
</tr>
<tr>
<td>4574.114</td>
<td>5615.650</td>
<td>N 62d53'05'' W 182.885</td>
<td></td>
</tr>
<tr>
<td>4657.470</td>
<td>5452.866</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Closure Error Distance > 0.03419 Error Bearing > N 41d22'21'' W
Closure Precision > 1 in 25333.8 Total Distance > 866.174
Polyline Area: 47735.6 sq ft, 1.1 acres

Prompts

Options/Select polyline to report: pick a polyline
Standard Report Viewer Displays the report for the selected polyline.
Options/Select polyline to report (Enter to End): press Enter

Pulldown Menu Location: Survey > Polyline Tools
Keyboard Command: plreport
Polyline to RW5 File
This command generates a raw data (.RW5) file for the selected polyline. This file can be opened using Edit Process Raw Data File, which allows you to process the raw data (.RW5) file to generate coordinate points, calculate closure and perform coordinate adjustments by the compass, crandall, transit and least squares adjustment routines.

Prompts

RW5 File to Write (Standard Windows File Selection Dialog): choose file location and name
Select Polyline To Process: select polyline
Done.

Pulldown Menu Location: Survey > Polyline Tools
Keyboard Command: pl2rw5
Prerequisite: A polyline

Crandall Polyline Adjustment
This command applies a crandall adjustment to a perimeter defined by a polyline. This is a way to distribute rounding errors on perimeters without altering the record dimensions. The command draws a new polyline of the adjusted perimeter and creates a report. The closure error is the difference between the end point of the polyline and the specified closing point that the program prompts for. For a closed loop adjustment, the closing point is the starting point of the polyline.

Here is an example report for a closed loop.

Crandall Polyline Adjustment

Closure Results
Starting Point : N 5212.097 E 4476.155
Ending Point : N 5209.953 E 4491.172
New Point : N 5212.097 E 4476.155
Azimuth Of Error : N 81°52'24'' W
North Error : -2.144
East Error : 15.017
Distance Error : 15.169
Distance Traverse: 4093.830
Closure Precision: 1 in 269.9

Original Data
Angle Distance
S 01°56'05'' E 826.057
S 84°59'27'' E 1154.279
N 02°17'10'' E 914.234
N 89°29'16'' W 1199.260

Adjusted Point Comparison
Original Adjusted
Northing Easting Northing Easting Dist Angle
5212.097 4476.155 5212.097 4476.155 0.000 N 90°00'00'' E
Adjusted Data
Angle Distance
S 01°56'05" E 825.175
S 84°59'27" E 1146.879
N 02°17'10" E 914.782
N 89°29'16" W 1206.897

Prompts

Pick polyline for Crandall Adjustment: *pick polyline*
Reverse polyline [Yes/<No>]? *press Enter*
Close polyline to start point or pick new closing point [<Close>/Pick]? *press Enter*

Pulldown Menu Location: Survey > Polyline Tools
Keyboard Command: crandalladj
Prerequisite: A polyline

Compass Polyline Adjustment
This command applies a compass adjustment to a perimeter defined by a polyline. After selecting the polyline, the program displays arrows to show the polyline direction and you have an option to reverse the polyline. The command draws a new polyline of the adjusted perimeter and creates a report. The closure error is the difference between the end point of the polyline and the specified closing point that the program prompts for. In the dialog, you can set the Traverse Type as Open or Closed. For a closed loop adjustment, the closing point is the starting point of the polyline. For an open traverse, the program will prompt for the closing point.

For the Geodetic Report option, the program reports the geodetic distances and angles. To use this option, the grid projection must be define in Settings > Drawing Setup.

Here is an example report for a closed loop.

Compass Polyline Adjustment

Closure Results
Starting Point: N 4854.766 E 5357.221
Ending Point: N 4854.636 E 5357.533
New Point: N 4854.766 E 5357.221
Azimuth Of Error: N 67°22'29" W
North Error: 0.130
East Error: -0.312
Distance Error: 0.338
Distance Traverse: 1029.503
Closure Precision: 1 in 3050

Original Data
From To Angle Distance
4 5 S 13°1'45" E 392.218
5 11 N 44°23'59" E 296.297
11 N 60°2'20" W 340.987

Adjusted Point Comparison
Original Adjusted
Point# Northing Easting Northing Easting Dist Angle
4 4854.766 5357.221 4854.766 5357.221 0.000 N 90°00'00" E
5 4472.645 5445.645 4472.695 5445.526 0.129 N 67°22'29" W
11 4684.343 5652.952 4684.430 5652.744 0.226 N 67°22'29" W
4854.636 5357.533 4854.766 5357.221 0.338 N 67°22'29" W

Adjusted Data
From To Angle Distance
4 5 S 13°00'50" E 392.143
5 11 N 44°22'56" E 296.261
11 N 60°2'29" W 341.098

Prompts

Pick polyline for Compass Adjustment: pick polyline
Reverse polyline [Yes/<No>]? press Enter
Pick new closing point: pick point

Pulldown Menu Location: Survey > Polyline Tools
Keyboard Command: compassadj
Prerequisite: A polyline

Grant Boundary Adjustment

This command applies a Grant Boundary Adjustment by rotating and scaling a polyline. Before running this command, the grid projection must be set in Drawing Setup and a polyline must be drawn.
The Grant Boundary method is used to set lost corners on perimeters within public lands. Distances between the record and measured are compared to define a ratio for adjustments. A rotation is defined by the difference between the record and measured bearings to preserve the angular relationship at the lost corners and to adjust the distance at the same ratio through each lost corner.

Rotation: 8'42” Scale: 1.004612115

**Prompts**

Pick polyline for Grant Boundary Adjustment: *pick polyline*
Layer name for adjusted polyline <GRANT>: *press Enter*
Reverse polyline [Yes/<No>]?: *press Enter*
Pick new closing point: *pick point*

Pulldown Menu Location: Survey > Polyline Tools
Keyboard Command: grantadj
Prerequisite: A polyline

**Deed File By Interior Text**

This command stores deed data to a deed file (.pdf) using linework boundaries around selected text of the deed names. You can create a single deed or process multiple deeds at once. From the selected linework, the program finds all the closed areas and then looks in the closed areas for text to use as the deed name. The deed boundaries can be defined by any combo of lines, arcs and polylines.

In the options dialog, the Clockwise Point Order option chooses between creating the deed points in clockwise or counter. The Combine Common Angles option will join sequential boundary line segments together that have the same angle.

**Prompts**

Deed File to Process dialog: choose .pdd file to save deed data
Deed File By Interior Text options dialog
Select deed linework and text.
Select objects: pick the deed labels and surrounding linework

Pulldown Menu Location: Survey > Deed Tools
Keyboard Command: txt2pdd
Prerequisite: Deed labels surrounded by linework

Polyline to Deed File
This command generates a deed (.PDD) file from the geometry of a selected polyline. This file can be opened using Process Deed File which allows you to edit the deed data and generate reports.

Prompts
Deed File To Write: choose file location and name
Select Polyline To Process: select polyline
Done.

Pulldown Menu Location: Survey > Polyline Tools
Keyboard Command: pl2pdd
Prerequisite: a polyline

4 Sided Building
Often only one or two sides of a building are surveyed in the field. This routine completes the building by drawing the other sides. 4 Sided Building creates a parallelogram given two connecting lines, or given a polyline with two segments. With two lines, there is an option to make the parallelogram as a polyline or as four lines. When only one side is defined, the program will prompt for the building width. Besides using linework to define the sides, you can use points by entering P at the prompt to switch to points mode.

Prompts
Options/Points/<Pick a line or polyline>: pick a line
Pick another side (Enter for none): pick a line
Convert the lines into a polyline [<Yes>/No]? press Enter
Options/Points/<Pick a line or polyline>: press Enter
Entering O for options lets you choose whether or not to be prompted to set the new polyline width, and for whether to default the width to make a square building with one sided input.

Pulldown Menu Location: Survey
Keyboard Command: 4sided
Prerequisite: A polyline with two segments or two adjoining lines
Shown here is the COGO menu of Carlson Field.
Inverse

This command reports the bearing/azimuth and horizontal distance between two points. The command prompts for a series of points. Use the appropriate object snap mode to select the points from the screen, or use the point numbers to reference coordinates stored in the current coordinate (.CRD) file. The results are then displayed. This command is also used in conjunction with the Traverse and Sideshot commands to occupy and backsight two points. The last two points you inverse to are the Backsight and the Occupied point for the Traverse and Sideshot commands. An attractive feature of Inverse is that you can enter T or SS within the command and go directly to Traverse or Sideshot. Even a single S will transmit to Sideshot. Hotkeys are not case sensitive. Press [Enter] at the point prompt to end the command.

You can also inverse around an arc by inversing to the Point of Curvature (PC), and then entering an A for Arc option. The program will ask for the radius point, the curve direction left or right and the PT point. The curve data is then reported. There is an unequal PC-Radius and PT-Radius distance check. The tolerance for this is set in the Area Label Defaults command.

After picking the first point, there is a keyboard option for Multiple which will prompt for a range of point numbers to report as a sideshot inverse.

There are several input options for Inverse that are set by entering O for Options on the command line. Sideshot inverse holds the current occupied point and calculates the bearing/distance to each entered point. The Pairs option reports the bearing/distance between pairs of points and not for every entered point. For example, if points 1,2,11,12 were entered, the bearing/distance would be reported for 1,2 and 11,12 but not 2,11. The Auto Increment option uses the next point number by just pressing Enter. To exit the routine with Auto Increment active, End must be entered.

The Auto Zoom settings under Inverse Options will zoom the display as needed to have the occupied point or both the occupied and backsight points visible. The Report Total Distance option displays a running total of all inversed distances during the current run of the routine.

The Report Geodetic Mean Bearing option reports the geodetic bearing at the to point (forward), at the from point (back) and the mean bearing. The geodetic distance is also report for the geodetic distance at zero elevation and at ground elevation. The coordinates are converted to lat/lon using the projection setup under the Drawing Setup command. The program reports that lat/lon, convergence angle and grid scale factor at the from and to points. Here's an example for SP83 VT,

Northing(Y) Easting(X) Elev(Z) 218623.2996 485210.2502 0.0000
Northing(Y) Easting(X) Elev(Z) 218439.0529 487144.1875 0.0000
Bearing: S 84°33'28'' E Horizontal Distance: 1942.6941325
Lat: 43°01'05.81806'' Long: -76°49'09.53807''
Convergence: N 02°56'59'' E Scale: 1.0014892493
Lat: 43°01'04.98404'' Long: -76°48'43.45145''
Convergence: N 02°56'41'' E Scale: 1.0014841465
Geodetic Forward Bearing: S 87°30'28'' E
Geodetic Back Bearing: S 87°30'09'' E
Geodetic Mean Bearing: S 87°30'18'' E
Geodetic Distance: 1942.984 Zero Elev, 1942.984 Ground Elev

There are also several angle output options that are set at the second prompt in Options. The angle can be reported as either Bearing, Azimuth, Gon or Angle Right. You can also specify to report angles with decimal seconds. The distance settings include the number of decimals for distances, whether to report slope or horizontal distance and
whether to report distances in feet and inches format. The Report Total Distance option will report the cumulative
distance for all the inverses. The Report Delta X/Y will distances as delta north-south-east-west instead of angle
and distance. For Report Latitude/Longitude, the grid projection must be set in Drawing Setup. The Report Point
After Angle/Distance controls whether the point coordinates are reported before or after the angle and distance.
The Report Header controls whether to have a header label line for the point data. The Report Coordinates option
choose whether to report the northing, easting and elevation of the points. The Report Elevation Difference option
will report the delta Z between the pairs of points. The Report Second Scaled Distance option will report a second
distance value that is scaled from the first distance value using the scale factor defined in Drawing Setup. When the
Second Scaled Distance option is on, there are settings for the suffix to use for both the first and second distance to
help identify them separately in the report.

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points
Commands section of the General Commands chapter.

Prompts

Calculate Bearing & Distance from starting point?
Traverse/SideShot/Options/Arc/Multiple/Pick point or point number: pick a point
Traverse/SideShot/Options/Arc/Multiple/Pick point or point number: 9
PtNo. Northing(Y) Easting(X) Elev(Z) Description
9 4909.25 4648.37 0.00
Bearing: N 81d8'54'' E Azimuth: 81d8'54''
Horizontal Distance: 261.17407461
Pulldown Menu Location: COGO
Keyboard Commands: inverse, i
Prerequisite: None
Occupy Point

This command sets the occupied point and backsight angle for other COGO commands such as Traverse. For setting the occupied point, you have the option of picking a point on the screen, entering coordinates at the command line or typing in a point number that will be read from the current coordinate (.CRD) file. Four options are available for determining the backsight direction: Azimuth, Bearing, None and Point. For the default Point option, you may pick a point on the screen, input coordinates, or type a point number that will be read from the current coordinate file. For the Azimuth and Bearing option, you enter the backsight angle in the selected format. The None option sets the backsight to an azimuth of 0 (zero) or North. You can also set the occupied point by using the Inverse command. If you inverse from point 3 to point 1, you have set point 1 as the occupied point and point 3 as the backsight. For more information, see the Inverse command.

The current occupied point and backsight are shown in the lower right hand corner of the AutoCAD status bar just below the command line.

Prompts

Set Occupied Point
Pick point or point number: pick a point (5000 5000 0.0)
Set backsight method [Azimuth/Bearing/None/<Point>]? press Enter
Set Backsight Point
Pick point or point number: pick a point (5184.76 5381.3 0.0)

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter. This feature can be found in the Points pulldown of all menus.

Pulldown Menu Location: COGO
Keyboard Commands: occpoint, op
Prerequisite: None

Traverse

This command allows the user to input any combination of turned angles, azimuths or bearings to define a traverse or figure. The command prompts for an Angle-Bearing Code which defines the angle or bearing type. This command always occupies the last point it calculated and backsights the point before that.

Codes 1 through 4 define the bearing quadrants:
1 = Northeast
2 = Southeast
3 = Southwest
4 = Northwest

The remaining codes define as follows:
5 = Azimuth
6 = Angle turned to the left
7 = Angle turned to the right
8 = Deflection angle left
9 = Deflection angle right
For both the Angle-Bearing Code and the Distance prompt, the user can enter point-defined responses: two points separated by an asterisk, as in 2*3 for the bearing (or distance) defined by 2 to 3. You can also add math expressions. For angles, 2*3+90 would deflect 90 degrees right from 2 to 3. For distances, 2*3/2 would mean half the distance of 2 to 3. You do not need to enter N before entering a number-defined distance. Just bring up the number inverse prompt. For distances, the # symbol can also be used to indicate point numbers like in SurvCE. So 2#3 means the distance between points 2 and 3.

The command draws lines between located points (if the Line On/Off in the COGO menu is set to on) and plots the points calculated and stores them in the current coordinate (.CRD) file if point numbering is On. The point settings are defined in the Point Defaults command. If Point Protect is turned on, Traverse checks if the point numbers are already stored in the file. Point Protect is set in the Coordinate File Utilities command.

There are Angle-Bearing code input options for Traverse that are set by entering O for Options. The Angle Right option prompts for the angle right and skips the angle-bearing code prompt. The Azimuth option prompts for the azimuth and skips the angle-bearing code prompt.

**Prompts**

**Occupied Point ?**

**Pick point or point number:** pick a point

You will only be prompted for the occupied point the first time you use the command. Use the Inverse command to set the occupied and backsight points.

**Exit/Options/SideShot/Inverse/Enter Azimuth (ddd.mmss) < >: o**

Angle prompt angle right or azimuth only [Right/Azimuth/Prompt]? p

**Exit/Options/Arc/Points/Line/SideShot/Inverse/Angle-Bearing Code <5>: press Enter** Pressing Enter uses the default angle right code.

**Enter Angle (dd.mmss) <90.0000>: 88.1324** You can also enter L or R to define an angle 90 degrees Left or Right.

**Backsight Point ?**

**Pick point or point number:** pick a point

**Number inverse/<Distance>: 100**

[Diagram of codes used for Bearings, Azimuths, Left & Right angles, and Deflection angles]

**Select Coordinate (.CRD) File** This dialog only appears if there is not a current coordinate (.CRD) file.

**Exit/Options/Line/Side Shot/Inverse/<Angle-Bearing Code <7>: 14*9-45.2045** Uses the bearing defined by point numbers 14 & 9 and subtracts the angle 45 degrees, 20 minutes, and 45 seconds. You can use a + or - in this type of entry.

**Number inverse/<Distance>: N (note: you can enter 14*9/2 here, as well)**

**Point number inverse (i.e. 10*20): 14*9/2** This causes the command to recall the distance from point number 14 to 9 and divide it by 2.

**Exit/Options/Line/Side Shot/Inverse/<Angle-Bearing Code <7>: L**

**Select Line or Polyline that defines Bearing:** select line that defines bearing

**Number inverse/<Distance>: 100**

**Exit/Options/Line/Side Shot/Inverse/<Angle-Bearing Code <7>: E** Enter E to end the command. Enter S or SS to execute the Side Shots command or I to execute the Inverse command.

---

Chapter 12. COGO Menu 728
For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter. This feature can be found in the Points pulldown of all menus.

**Pulldown Menu Location:** COGO  
**Keyboard Commands:** T, Traverse  
**Prerequisite:** None

### Side Shots

This command allows the user to input any combination of turned angles, azimuths or bearings while remaining on an occupied point. The command prompts for an Angle-Bearing Code which defines the angle or bearing type. Codes 1 through 4 define the bearing quadrants; 1 being North-East, 2 South-East, 3 South-West, and 4 North-West. Code 5 is a north-based azimuth, 6 an angle turned to the left, 7 an angled turned to the right, 8 a deflection angle left and 9 a deflection angle right. The command plots the points calculated and stores them in the current coordinate (.CRD) file if point numbering is On. If Point Protect is turned On, Side Shots checks if the point numbers are already stored in the file. All points calculated radiate from the occupied point. Use the Traverse, Inverse, or Occupied Point commands explained previously to define the occupied and backsight points. Options allows you to select your angle entry method.

#### Prompts

**Occupied Point ?**  
Pick point or point number: screen pick a point or enter a point number  
Exit/Options/Traverse/Inverse/Enter Azimuth (ddd.mmss) <A>: O for options  
Angle prompt angle right or azimuth only [Right/Azimuth/Prompt]? P for prompt  
Exit/Options/Points/Line/Traverse/Inverse/<Angle-Bearing Code <7>: 6 Code 6 for angle turned to left.  
Pick point or point number: pick a point  
Enter Angle (dd.mmss) <6>: 22.3524 Angle of 22 degrees, 35 minutes, 24 seconds.  
Points/<Distance>: 120.91  
Enter Vertical Angle (ddd.mmss) <0.0000>: 88.2548

These prompts only come up if you have Instrument and Rod height prompting turned on.  
**Instrument Height** <5.000>: 5.12  
**Rod-Target Height** <5.120>: press Enter  
Enter Point Description <>: Topo Shot  
Exit/Options/Points/Line/Traverse/Inverse/<Angle-Bearing Code <6> E

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter. This feature can be found in the Points pulldown of all menus.

**Pulldown Menu Location:** COGO  
**Keyboard Commands:** sideshot, ss  
**Prerequisite:** None

### Enter-Assign Point

This command creates a point at the user-entered coordinates. The point is both stored to the current coordinate (.CRD) file and drawn on the screen. The program will prompt for the northing and easting. This routine will prompt for point number, elevation and description, depending on the settings in the Point Defaults command. Point Defaults also allows you to set the point symbol and layer. Point Defaults is found under the Points pulldown.
Prompts

Enter North(y): 5000
Enter East(x): 5000
Select/<Enter Point Elevation <0.00>: Enter 100 for elevation, or press S and enter to select text to set elevation.
Enter Point Description <>: START
N: 5000.00 E: 5000.00 Z: 0.00
Enter North(y): press Enter to end

For instruction on how to insert either new or existing points into the drawing, see Draw-Locate Points in the Points Commands section of the General Commands chapter. This feature can be found in the Points pulldown of all menus.

Pulldown Menu Location: COGO
Keyboard Commands: capoint, ea
Prerequisite: None

Raw File On/Off

This menu selection toggles raw file (.RW5) creation. When this option is active, commands such as Traverse create entries in the current raw data (.RW5) file. If Raw File is turned on, the pulldown menu option will have a check mark character in the menu. A dialog will appear, allowing you to create a New, Append an existing, or Close the .RW5 file.

To begin this routine, select the COGO pulldown and observe the Raw File (On or Off) toggle for check. Click the command and the dialog appears.

New: Allows you to create a new raw traverse file (.RW5).
Append: Allows you to append an existing raw traverse file.

Pulldown Menu Location: COGO
Keyboard Command: openraw
Prerequisite: None

Line On/Off

This menu selection toggles line plotting on and off for the commands such as Traverse, Locate by Line Bearing, etc. If line drawing is turned on, the pulldown menu option will have a check mark character to the left of the command.
Visual COGO

This command contains COGO routines for Inverse, Occupy Point, Traverse, Side Shots, Bearing-Bearing Intersect, Bearing-Distance Intersect, Distance-Distance Intersect and Enter-Assign Point. Choosing Visual COGO from the COGO pull-down menu provides you with quick access to any of the Visual COGO routines.

A dialog for command input docks on the side of the graphic window when any of the five options from the pulldown menu are selected. Points are drawn to the screen as they are created. Linework can also be drawn. CAD and Carlson commands can be activated with the Visual COGO dialog active. This allows for quick switching between Visual COGO commands and any other command. You can also switch between Visual COGO commands within the dialog by entering the 2 character function name in any edit box. For example, from Visual COGO Inverse, you can enter SS in the point number field to switch to Side Shots.

The function names OC, EA, IN, BB, BD, DD, TR and SS are also available as function buttons across the top of the dialog. The second row of buttons are functions for zooming in/out and panning. The final button brings up Visual Cogo options. The Use Sound option is for whether to have sounds cues. The Prompt for Bearing/Azimuth Rotation adds an additional angle input in the Sideshot and Traverse functions. This angle is added to the bearing or azimuth angle input and is a way to handle North rotation where the orientation of the angles that your entering is different than the target coordinate system.

Prompts

When in Visual COGO, you will have a very different user interface from other areas of Carlson. This user-friendly screen will guide you through various COGO data entry procedures such as Inverse, Occupy Point, Traverse, Side Shots and Enter-Assign Point. You will still be able to follow the command on the command line at the bottom of your Carlson screen. Using Visual COGO is an alternative and easy method to entering in such information. The top half of the COGO pulldown menu offers you the more traditional Carlson data entry method. Your results will be the same.
IN (Inverse): This command reports the bearing/azimuth and horizontal distance between two points. The points can be entered manually or by picking from a point list by picking on the list button. The resulting report of bearing/azimuth is dependent upon the Angle Mode setting in the drawing setup options.

OC (Occupy Point): Used to specify the point number of the instrument setup point. The point can be specified by manually entering in the point number in the Occupied Point data field, or by selecting the List button and choosing from the list of points contained in the coordinate file.

Backsight Method can be either by Point Number or by Azimuth. If angle right/left or deflection right/left is being used for traverse or sideshot entry, a backsight method must be specified. If using Bearing or Azimuth entry, no backsight method is required. The Backsight Point can be specified by manually entering in the point number in the Backsight Point data field, or by selecting the List button and choosing from the list of points contained in the coordinate file.

Instrument Height: Use this field to set the height of the instrument.

Accept (F2): Selecting this button or pressing the F2 function key accepts the data entered in the fields above. After accepting the data, until changed, the points specified will remain the occupied and backsight points. If the dialog is exited without Accepting the settings the Occupied and Backsight points will have to be specified when the OC dialog is revisited.

Exit: Cancels the command

TR (Traverse): This command allows data entry using any combination of turned angles, deflections, azimuths or bearings to define a traverse or figure. This command always occupies, moves up to, the last point it calculated and backsights the point before, or the previous occupied point.

Point Number: This is the number of the point to be created.

Rod Height: Height of target to be located.

The horizontal angle component can be input in various formats. The format label will change with the option chosen. Choose the format by selecting the down arrow and picking from the list.

NE=Northeast
SE=Southeast
SW=Southwest
NW=Northwest
AZ=Azimuth
AL=Angle Left
AR=Angle Right
DL=Deflection Left
DR=Deflection Right

The vertical angle component can be input in various ways (the format label will change with the option chosen). Choose the format by selecting the down arrow and picking from the list.

VA=Vertical Angle. Zero (0) degrees is level.
ZE=Zenith Angle. Ninety (90) degrees is level.
DZ=Elevation Difference. The difference in elevation either plus or minus from the instrument setup to the target.

The distance component can be entered as either Slope or Horizontal Distance. Choose the format by selecting the down arrow and picking from the list.

SD=Slope Distance
HD=Horizontal Distance

Distance can be defined by Point Numbers by selecting the calculator button to the far right of Angle Right and Slope Distance.
Additional mathematical calculations of addition, subtraction, multiplication and division can be performed on the input distance by selecting the appropriate button and filling out the function dialog.

For example to add 25 to the Slope distance value on the traverse dialog, select the + button, enter 25 and then select Done. The same steps apply to any of the other mathematical functions.

**Side Shots:** This command works in the same way as the traverse command. All the available options contained in the traverse command are available in this command. The only difference in the commands is that the side shot command does not move the setup point to last shot input. Refer to the traverse command for further details.
Desc: Defines the description for the point to be created.
Create Point: Option whether to store the point to the CRD file and draw a point.
Draw Line: Option to draw line to the traverse point.
Preview (F2): Previews the traverse point location, without storing the point to the coordinate file.
Store (F3): Stores the traverse point based upon the entered data to the coordinate file.
Undo: After storing the point, the point can be deleted from the screen and coordinate file by selecting the undo button.
Exit: Exits the Visual COGO command and closes the dialog box.

EA (Enter Assign): Use this function to enter and assign coordinate values for new and existing points.

BB (Bearing-Bearing Intersect): Enter two base points along with the angles from each and the routine calculates the bearing-bearing intersection point. The dialog has fields for the output point number and description.
BD (Bearing-Distance Intersect): Enter two base points along with the angle from the first and distance from the second and the routine calculates the bearing-distance intersection point. The dialog has fields for the output point number and description.
DD (Distance-Distance Intersect): Enter two base points along with the distances from each and the routine calculates the distance-distance intersection point. For the two possible solutions of the intersecting circles, the intersection clockwise from the first point is used. The dialog has fields for the output point number and description.

Zooming and panning functions are also available from the Visual COGO dialog box:
Plus (+) magnifier: Zooms the display window in. Use to view an area up close.
Minus (-) magnifier: Zooms the display window out. This shows more of the drawing.
Left arrow: Pans the display window to the left.
Right arrow: Pans the display window to the right.
Up arrow: Pans the display window up.
Down arrow: Pans the display window down.

Pulldown Menu Location: COGO
Keyboard Commands: vcogo_inverse, vcogo_setup, vcogo_traverse, vcogo_sideshot, vcogo_store
Prerequisite: Coordinate file to process
Locate by Line Bearing-Ang

Locate by Line Bearing

This command calculates and plots a line (if the Line On/Off is set to Line On) and point from an occupied point. The bearing can be defined by picking two points, selecting a line, inputting two point numbers, or typing in a bearing or azimuth. The command always occupies the last point calculated.

Prompts

Press [Enter] to use preview point/or select occupied point.
Pick point or point number: 14

PointNo. North(Y) East(X) Elev(Z) Description
14 4869.06 4390.31 0.00

Pick points that define bearing.
Define Bearing by, Line/Bearing/Numbers/<pick 1st point>: B

At this prompt the default is to pick the first point that defines the bearing. If you pick a point, you are then prompted for a second point. You can input B to type in a bearing or azimuth or L to select a line or polyline that defines the bearing, or N to input two point numbers that define the bearing.

[A]zimuth/<Bearing (Qdd.mmss)>: A
Azimuth (ddd.mmss): 45.2349
Number inverse/<Distance>: 188.27
Enter Vertical Angle (dd.mmss) <0.0000>: press Enter
The horizontal distance is given.
Enter Point Description <stk>: press Enter
The coordinates are given.

Pulldown Menu Location: COGO > Locate by Bearing-Ang
Keyboard Command: locbrg, lb
Prerequisite: None

Locate by Azimuth

This command locates points by azimuth and distance. The AutoCAD text screen provides the horizontal distance and coordinates.

Prompts

[Enter] to use preview point/ or Select occupied point ?
Pick point/<point Number>: _endp of (pick a point)
Enter Azimuth (ddd.mmss) <22.5632>: 277.1259
Enter or pick Distance <40.32>: 104.39
Enter Vertical Angle (dd.mmss) <0.0000>: Enter

Pulldown Menu Location: COGO > Locate by Bearing-Ang
Keyboard Commands: locazi2, az
Prerequisite: None
Locate by Turned Angle

This command locates a point by turned angle and distance.

Prompts

Define occupied & backsight points by [L]ine or [P]oints <P>: L
Select Line or Polyline near end point that defines occupied point: select line
Occupied point: (4078.44 4610.89 0.0)
Backsight point: (4390.31 4869.06 0.0)
Enter Angle (ddd.mmss) <45.2349>: 22.5632
Pick or Type Distance <188.27>: 40.32
Enter Vertical Angle (dd.mmss) <0.0000>: hit Enter

Pulldown Menu Location: COGO > Locate by Bearing-Ang
Keyboard Commands: turnang2, ta
Prerequisite: None

Locate by Bearing

This command locates points by bearing and distance. Additionally, the AutoCAD text screen provides the horizontal distance and coordinates.

Prompts

[Enter] to use preview point or Select occupied point ?
Pick point/<point Number>: 24

PointNo. Northing(Y) Easting(X) Elev(Z) Description
24 4922.37 4544.81 0.00

Enter Bearing (Qdd.mmss) <277.1259>: 435.2317
Enter or pick Distance <104.39>: 200
Enter Vertical Angle (dd.mmss) <0.0000>: Enter

Pulldown Menu Location: COGO > Locate by Bearing-Ang
Keyboard Command: locbrg2, lg
Prerequisite: None

Locate by Delta

This command locates points by specified delta x, y, z from a reference point. The point style and whether to prompt for a description is set in Point Defaults.

Prompts

[Enter] to use preview point/ or Select occupied point ?
Pick point/<point Number>: pick a point
Delta Northing (dy): 23.45
Delta Easting (dx): 12.34
Delta Elevation (dz) <0.0>: press Enter
Enter Point Description <>: press Enter
N: 11687.04 E: 10095.31 Z: 0.00
Delta Northing (Enter to end): press Enter

Pulldown Menu Location: COGO > Locate by Angle-Distance
Keyboard Commands: locdelta
Prerequisite: None

Locate at Intersect

Pick Intersection Points
This command locates points at screen picked intersections. The object snap mode is set to intersection. This routine is similar to the Locate Point command, with an additional check that makes sure there is an intersection at the picked point. If there is not an intersection at the picked point, then no point is created.

Prompts

Pick Intersections Points dialog
APParent intersection on [<Yes>/No]: Y
This first prompt is very important. Apparent Intersection snaps to the apparent intersection of two objects (arc, circle, ellipse, elliptical arc, line, multiline, polyline, ray, spline, or xline) that do not intersect in 3D space, but may appear to intersect in the current view. This allows you to locate a point at the theoretical intersection of two 3D entities. You should answer No to this prompt if you want to ignore theoretical 3D intersections.

[app on] Pick intersection Point: pick a point
[app on] Pick intersection Point: press Enter to end

Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: pickint
Prerequisite: Intersection of two entities
Linework Intersection Points
This command is used to create points at all of the intersections between selected linework entities.

Prompts
Select lines and polylines to process.
Select objects: Specify opposite corner: pick objects
Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: ADDINTPTS
Prerequisite: None

Bearing-Bearing Intersect
This command locates a point at the intersection of two lines. The lines can be defined by picking two points, selecting a line or typing in a bearing. After the lines are defined a point symbol is located at the point of intersection. When a grid projection is defined in Drawing Setup, there is a prompt for whether to use the mean, forward or back geodetic bearing.

Prompts
[Enter] to use preview point or select 1st Base point ?
Options/<Pick point or point number>: press Enter
Define 1st angle by (Line/Points?Right/Azimuth/Bearing) <Bearing>: L
Select Line or Polyline that Defines 1st Bearing: select
Enter 1st Offset Distance <0.0>: press Enter
2nd Base point?
Pick point or point number: pick a point
Define 2nd angle by (Line/Points/Right/Azimuth/Bearing) <Line>: P
[Enter] to use preview point/or pick 1st point that defines 2nd bearing.

Pick point or Point number: pick point

2nd point that defines 2nd bearing?

Pick point or Point number: pick a point

Enter 2nd Offset Distance <0.0>: press Enter

Enter/<Select text of elevation>: select

The point is then located at the computed point of intersection.

---

**Bearing-Distance Intersect**

The Bearing-Distance Intersect command prompts the user for a base point from which the known bearing intersects. It then defines the bearing by one of three methods. The bearing can be defined by picking two points, selecting a line with the same bearing or by typing in the bearing in the form of Qdd.mmss (similar to the Locate by Bearing command). Next the user is prompted for a base point from which the known distance radiates. After entering the known distance a circle is drawn radiating from the selected base point, and a line defined by the bearing is extended to intersect the circle. The user then picks the correct point for the solution desired and a point symbol is located at the selected intersection. The command then erases the temporary circle and line. The Options choice allows you to be prompted for angle method or for offsets, or both.

When a grid projection for the drawing is defined under Drawing Setup, this command will prompt for whether to use the grid bearing or geodetic mean, forward or back bearing. Also, the program will prompt for whether to use the grid or geodetic distance.

**Prompts**

[Enter] to use preview point or select known Bearing base point

Options/Pick point or point number: pick point

Define 1st bearing by (Line/Points/Azimuth/Bearing)<Bearings>: l
Distance-Distance Intersect

This command creates a point at the distance-distance intersection from two base points. The program prompts for two distances and two base points. The two possible intersections (A,B) are shown on the screen. You can either pick near the desired intersection or type in the letter A or B. The A intersection is clockwise from the first point. The Options choice brings up a small dialog that allows you to be prompted for angle method or for offsets, or both. When a grid projection for the drawing is defined under Drawing Setup, the program will prompt for whether to use the grid or geodetic distances.

Prompts

Select 1st base point
Options/ <Pick point or point number>: 1
Points/ <1st distance>: 46.72
Enter 1st Offset Distance <0.0>
Select 2nd base point
Pick point or point number: 2
Points/ <2nd distance>: 38.96
Enter 2nd Offset Distance <0.0>: press Enter
Pick near solution or Enter [A] or [B]: pick a point

Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: DD
Prerequisite: None

Perpendicular Intersect
This command creates a point at the perpendicular intersection from an offset point to a line. This command prompts for a base point from which the known bearing intersects. Then the bearing is defined by typing in the bearing in the form of Qdd.mmss (similar to the Locate by Bearing command). Next the user is prompted for an offset point.

Prompts
[Enter] to use preview point or select known Bearing base point
Pick point or point number: 1
Bearing (Qdd.mmss): 145.0000
Offset point.
Pick point or point number: 51
Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: perpint
Prerequisite: None

Tangent Intersect
This command creates a point at the tangential intersection from a point to another point and distance. This command prompts for a base point and then the distance. Next there is a prompt for the second point. Since there are two possible tangential solutions on the circle from the base point, the program displays the two possible solutions and prompts for which one to use. To choose the solution, pick close to the solution point.

Prompts
[Enter] to use preview point or select known base point
Pick point or point number: 1
Points/<Enter Distance>: 25
Second point.
Pick point or point number: 51
Pick tangent point solution: pick a point

Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: tangint
Prerequisite: None

2 Point - 2 Point Intersect

This command is similar to Bearing-Bearing Intersect except that in this command bearings are defined by specifying two point numbers. In the example shown below, the first two points specified are 3838 and 3839, the second pair are 3841 and 3840. Point 3842 is located at the intersection.

Prompts

Specify 1st base point.
Pick point or point number: 3838
Specify 2nd point that defines 1st direction.
Pick point or point number: 3839
Specify 2nd base point.
Pick point or point number: 3841
Specify 2nd point that defines 2nd direction.
Pick point or point number: 3840
Select/<Enter Point Elevation>: Enter value

Pulldown Menu Location: COGO > Locate at Intersect
Keyboard Command: bbint2
Prerequisite: None

Resection

This command calculates point coordinates given the angle and distance from two or three reference points. The Z coordinate can also be calculated in addition to the X, Y. If you only need the 2D solution, then enter the instrument and rod heights as 0.0, the zenith angle as 90 and the distance as the horizontal distance. The reference points are specified by point number. These reference points need to be stored in the current coordinate (.CRD) file before running this command.

After entering the reference point, there is a dialog to enter the horizontal angle, zenith angle and slope distance. The horizontal angle is the horizontal azimuth or angle right from the unknown point to the reference point. In the example, the backsight azimuth is 0 (due north), but this is not a requirement since the backsight can be any angle. The program calculates the coordinate by averaging the distance-distance and angle-angle solutions. Since there is redundant data, the final calculated coordinate will differ slightly from the individual measurements. For example, in a 3-point resection, there are two different distance-distance solutions (between the first-second point and between the second-third points). The program reports the difference between the final coordinate and the
individual solutions as the residuals which act as an indicator whether the data is good. High residuals suggest a problem with the input data. In the dialog that displays the final coordinates and residuals, there is a button to store the coordinates to the current coordinate (.CRD) file with a specified point number.

In the first Resection dialog box, you can choose to use two or three reference points.

In the second Resection dialog box, you assign the reference point.

Point: You must enter the point number of your reference point. These reference points need to be stored in the current coordinate file before you run this command.  
Inst. Height: You must enter the instrument height.  
Target Height: You must enter the target height.  
If you need only the 2D solution, then enter the instrument and target heights as 0.0.

In the Manual Read dialog box, you must specify parameters for the calculation.

Horizontal Angle: You must enter a horizontal angle from the resection to the reference points. The horizontal angle is the horizontal azimuth, or angle right, from the unknown point to the reference point.  
Zenith Angle: You must enter a zenith angle. For a 2D solution, set the zenith angle to 90 degrees.  
Slope Distance: You must enter a slope distance from the reference points to the resection.
You are prompted for additional reference points and parameters.

The Resection Calculation dialog box that displays the final coordinates and residuals. You can select the option to store the coordinates in the current coordinate file with a specified point number.

**Pulldown Menu Location:** COGO > Locate at Intersect  
**Keyboard Command:** cression  
**Prerequisite:** Two or three reference points

---

**Benchmark**

This command is similar to the data collector routine, where a measurement with a total station is taken from an unknown elevation to a known elevation foresight. The unknown elevation of the occupied point is then calculated based on the measurement. Either the Occupied Elevation or the Instrument Height can be calculated. Note that a check box is located at the bottom of the dialog box to "Store Elev To Occupied Pt". This will automatically change the elevation of the occupied point.
**Prompts**

**Coordinate File to Process dialog** If required, this dialog will appear and you must select a file.

**Benchmark dialog** Fill in variables, click Calculate

**Pulldown Menu Location:** COGO  
**Keyboard Command:** benchmark  
**Prerequisite:** None

---

**Numeric Pad COGO**

Using only the keys on the numeric pad, this command does several COGO commands. The program cycles through six prompts. Only respond to the prompts that apply and the program will perform the correct action. The prompts are: First point? First angle? First distance? Second point? Second angle? Second distance?

To *inverse*, give a first point and second point.

To *traverse*, give a first point, first angle and first distance.

To do *bearing-bearing intersect*, give a first point, first angle, second point and second angle.

To do *bearing-distance intersect*, give a first point, first angle, second point, and second distance. Or give a first point, first distance, second point, and second angle. The point is calculated at the closer intersection.

To do *distance-distance intersect*, give a first point, first distance, second point, and second distance. The point is calculated at the first intersection going clockwise from the first point's distance circle.

Points can be screen picked or entered as point numbers that reference the current coordinate file. The last point is used as a default when you press Enter at the prompt for the first point. Which point is being used is indicated by a ghost arrow pointer.

Angles can be specified by picking two points or entering an angle code which begins with a single digit code followed by the degrees and the minutes and seconds after a decimal point. The digits codes are (1 - Northeast, 2 - Southeast, 3 - Southwest, 4 - Northwest, 5 - Azimuth). For example, Northwest 50d10'2'' would be `450.102`.

Distances can be specified by picking two points or entering the distance value.

**Prompts**

Enter coords/Quit/<Pick 1st point or point number>: 5
Pick or Type 1st Direction by 2 Points: 145.0135 (Northeast 45d1'35'')
Pick or Type 1st Distance by 2 Points: 50.0
A point is created from the values for this traverse. The prompts for the second point don’t appear because all the information for this action is entered.

Enter coords/Quit/<Pick 1st point or point number>: press Enter to use the point created by the traverse.
Pick or Type 1st Direction by 2 Points: 50.0
Enter coords/Quit/<Pick 1st point or point number>: 4
Enter/Pick 2nd Direction by 2 Points: press Enter
Enter/Pick 2nd Distance by 2 Points: 75.0
This creates a point by distance-distance intersect.

Enter coords/Quit/<Pick 1st point or point number>: Q
Line by Angle-Distance

This command draws a line from an occupied point at a given angle and distance, where the angle format supports the standard 1-9 angle-bearing codes. It holds the current occupied point and calculates a line by angle-distance to each entered point. As for the angle formats, the Options choice allows for angle right, azimuth only or prompt entry (Right/Azimuth/Prompt) methods. The Prompt method allows you to enter the 1-9 angle-bearing codes.

Prompts

Occupied Point ?
Pick point or point number: pick point
Exit/Options/SideShot/Inverse/Enter Azimuth (ddd.mmss) <90.0000>: 112.3024
Points/<Distance>: 290
Exit/Options/SideShot/Inverse/Enter Azimuth (ddd.mmss) <112.3024>: O
Angle prompt angle right or azimuth only [Right/Azimuth/Prompt]? R
Exit/Options/SideShot/Inverse/Enter Angle (dd.mmss) <112.3024>: 88
Points/<Distance>: 300
Exit/Options/SideShot/Inverse/Enter Angle (dd.mmss) <88>: O
Angle prompt angle right or azimuth only [Right/Azimuth/Prompt]? P
Exit/Options/Points/Angle-Bearing Code <7>: Enter
Enter Angle (dd.mmss) <88>: 31.4340
Points/<Distance>: 419
Exit/Options/Points/Angle-Bearing Code <7>: E

Tangent Line from Circles

This command draws a line that is tangent to two circles or arcs. The circles can be defined either by picking the radius point and entering the radius, or by selecting circle or arc entities. The tangent line can be drawn to either outside on the left or right side, or across the middle between the circles from left to right or from right to left. The line and the circles are drawn in the current layer. There is also an option to create two points at the ends of the tangent line.

Prompts
Tangent Line From Circles dialog
Pick center point of first circle: pick a point
Pick first radius: 25
Pick center point of second circle: pick a point
Pick second radius: 35
Pulldown Menu Location: COGO
Keyboard Command: linecircle
Prerequisite: None

Getodetic

Traverse
This command creates points by traversing by bearing and distance. The program starts by prompting for a starting point. Then the bearing is entered as either grid bearing or geodetic bearing for mean, forward or backward. Then the distance is entered either as grid distance or geodetic distance at mean elevation or zero elevation, and the distance units can be either feet, meters or chains. The resulting point is then drawn using the point settings from the Point Defaults command. Before running this command, the grid projection for the drawing must be defined in the Drawing Setup command.

Prompts

Select 1st line to split: pick a line
Select 2nd line to split: pick a line
Pulldown Menu Location: COGO > Geodetic
Prerequisite: None
Keyboard Command: geotrav

Single Proportion Line Division
This command breaks a line into two lines that have the same mean geodetic angle. The length of the first new line is proportional to the specified part distance relative to the total distance. Before running this command, the grid projection must be set under Drawing Setup.

Prompts

Select a line near beginning point: pick a line
Enter Record Part Distance [Meters/<Feet>/Chains]: 500
Enter Record Total Distance [Meters/<Feet>/Chains]: 2000
Double Proportion Line Division

This command is used to restore a lost corner from new measurements between four known corners with two measurements each on intersecting meridional and latitudinal lines. The program prompts for the four known corner points to establish the retracement. Plus the program prompts for the four sets of record bearings and distances from the known points to the lost corner. The report then shows the calculated point along with the input data.

Double Proportion

<table>
<thead>
<tr>
<th>Retrace Point</th>
<th>Northing</th>
<th>Easting</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st North-South</td>
<td>243758.936</td>
<td>471259.132</td>
</tr>
<tr>
<td>2nd North-South</td>
<td>252622.467</td>
<td>471144.220</td>
</tr>
<tr>
<td>1st East-West</td>
<td>248221.216</td>
<td>477033.581</td>
</tr>
<tr>
<td>2nd East-West</td>
<td>248208.591</td>
<td>464242.295</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Record</th>
<th>Bearing</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1st North-South</td>
<td>N 00°05'03'' W</td>
<td>4529.100</td>
</tr>
<tr>
<td>2nd North-South</td>
<td>N 01°09'48'' W</td>
<td>4335.400</td>
</tr>
<tr>
<td>1st East-West</td>
<td>N 89°34'32'' W</td>
<td>5821.300</td>
</tr>
<tr>
<td>2nd East-West</td>
<td>S 89°03'47'' W</td>
<td>6971.200</td>
</tr>
</tbody>
</table>

New Point: 248287.938 471213.134

Prompts

Pick First point for North-South line: pick a point
Pick Second point for North-South line: pick a point
Mean Bearing from Record (Qdd.mmss): 40.5027
Enter Record Distance [<Meters>/Feet/Chains]: 4529.1
Mean Bearing from Record (Qdd.mmss): 41.0948
Enter Record Distance [<Meters>/Feet/Chains]: 4335.4
Pick First point for East-West line: pick a point
Pick Second point for East-West line: pick a point
Mean Bearing from Record (Qdd.mmss): 489.3432
Enter Record Distance [<Meters>/Feet/Chains]: 5821.3
Mean Bearing from Record (Qdd.mmss): 389.0347
Enter Record Distance [<Meters>/Feet/Chains]: 6971.2

Pulldown Menu Location: COGO > Geodetic
Prerequisite: Grid projection under Drawing Setup
Keyboard Command: geodprop

Double Break
This command breaks two crossing lines at their intersection such that the two segments of the first line have the same geodetic mean bearing and the two segments of the second line have the same geodetic mean bearing. Before running this command, the grid projection must be set under Drawing Setup.

Prompts
Select 1st line to split: pick a line
Select 2nd line to split: pick a line

Pulldown Menu Location: COGO > Geodetic
Prerequisite: Two crossing lines
Keyboard Command: geodbk

Middle Break
This command breaks a line into two lines that have the same mean geodetic angle and same geodetic length. Before running this command, the grid projection must be set under Drawing Setup.

Prompts
Select line to split at geodetic midpoint: pick a line

Pulldown Menu Location: COGO > Geodetic
Prerequisite: A line
Keyboard Command: geomid

Irregular Boundary Adjustment
This command adjusts angle/distance courses between two control points. This adjustment applies to boundaries that are not established as straight lines and are termed "irregular". A modified form of single proportionate measurement is used by this method to restore the lost corners. To apply the geodetic lengths and angles with this adjustment, the grid projection must be set under Drawing Setup before running this command.

For input, this command takes reference coordinates for the starting and ending points either by screen pick or by point number. Then the record angles and distances between these two reference points are entered. The program reports the input data, the recalculated points and the adjusted angles and distances.
Prompts

Pick Starting point or point number: pick point
Pick Ending point or point number: pick point
Mean Bearing from Record (Qdd.mmss): 40.2200
Enter Record Distance [<Meters>/Feet/Chains]: 5314.46
Mean Bearing from Record (Qdd.mmss): 41.0220
Enter Record Distance [<Meters>/Feet/Chains]: 2846.75
Enter another record [Yes/<No>]? press Enter
Draw adjusted lines [<Yes>/No]? press Enter

Irregular Boundary Report

Retrace Point
Northing Easting
222637.518 477292.438
230796.636 477202.638

Record
Bearing Distance
N 00°22'00" W 5314.460
N 01°02'20" W 2846.750

New Point
Northing Easting
227950.882 477255.709

Adjusted
Section Corners

Section Subdivision

This command calculates and stores unknown Section corners that can be calculated given the data specified. The calculated points will be plotted on the screen and saved to the coordinate file.

**Section Location Group:** Input the required Section number, Township and Range.

**Specify Field Located Corners Group:** Indicate whether Section & Quarter Corners were located in the field or if 1/16th corners were located in the field.

**Section Linework Group:** Indicate whether the calculated Section lines should be drawn and indicate the desired layer(s) for the Section Lines, Quarter Section Lines and Sixteenth Section Lines.

**Inputs A - H:** Specify the point IDs of corners that have been located in the field.

**Government Chainages Group:** Specify the government chainages as documented/required.

**Note:**

- The choices in the **Specify Field Located Corners** section of the dialog merely make it more convenient to enter the Section & Quarter corners and the 1/16th corners. This choice allows you to enter the corners in order by just typing the point ID of a corner then just press Enter to move to the next corner. You may enter any type of corner located in the field by changing the types of corners selection in the **Specify Field Located Corners** section.
For each calculated corner, the Saving Point dialog box will be displayed. Depending on the Point Default settings, this dialog may allow you to accept or change the default point ID. Also, depending on the Point Default settings, the description and elevation may also be changed or accepted.

**Pulldown Menu Location(s):** COGO > Section Corners  
**Keyboard Command:** cg_section_subd  
**Prerequisite:** Coordinate File with at least eight points

### GLO Corner Proportioning

The GLO Corner Proportioning commands calculate section and 1/4 section corners by one, two, three or four way control. GLO plats are the official plats of the U.S. Government Land Office (GLO) executed after July 1946. The Department of the Interior, Bureau of Land Management (BLM) is the successor agency to the GLO.

### One Way Control

This routine calculates section and 1/4 section corners by one way control. First, enter the point number for Point A. This number can be entered in manually or picked from the screen by selecting the Pick radial button at bottom right. In a like manner, the Bearing from A to B can be entered manually or by using the Pick radial button to pick from the screen. The distance from A to X can be specified in the same manner as above. After selecting OK, a dialog box will display where the Point number, description and elevation can be edited. The point default settings determine the available data for editing. For example, if the option for Automatic Point Numbering is turned off in the Point Defaults, then the field for the point number will be grayed out. If elevations are turned off in the point defaults, then the elevation field will be grayed out. This also applies to the description of the point as well.

### Prompts

**GLO Proportioning One Way Control dialog**

![GLO Proportioning One Way Control dialog](image)
Pulldown Menu Location: COGO > Section Corners > GLO Corner Proportioning
Keyboard Command: cg_glo_one_way
Prerequisite: A coordinate file

Two Way Control
This routine calculates section and 1/4 section corners by two way control. Enter the point numbers for Point A and B. These numbers can be entered in manually or picked from the screen by selecting the Pick radial button at bottom right. In a like manner, the Record Chainages from A to X and from A to B can be entered manually or by using the Pick radial button to pick from the screen. After selecting OK, a dialog box will display where the Point number, description and elevation can be edited. The point default settings determine the available data for editing. For example, if the option for Automatic Point Numbering is turned off in the Point Defaults, then the field for the point number will be grayed out. If elevations are turned off in the point defaults, then the elevation field with be grayed out. This also applies to the description of the point as well. GLO is an acronym for Government Land Office.

Prompts
GLO Proportioning Two Way Control dialog
Pulldown Menu Location: COGO > Section Corners > GLO Corner Proportioning
Keyboard Command: cg_glo_two_way
Prerequisite: A coordinate file

Three Way Control
This routine works as the previous GLO Proportioning methods described. Fill out the required data fields on the dialog box and select OK. After selecting OK, a dialog box will display where the Point number, description and elevation can be edited. The point default settings determine the available data for editing. For example, if the option for Automatic Point Numbering is turned off in the Point Defaults, then the field for the point number will be grayed out. If elevations are turned off in the point defaults, then the elevation field will be grayed out. This also applies to the description of the point as well. GLO is an acronym for Government Land Office.

Prompts
GLO Proportioning Three Way Control dialog

Pulldown Menu Location: COGO > Section Corners > GLO Corner Proportioning
Keyboard Command: cg_glo_three_way
Prerequisite: A coordinate file
Four Way Control

This routine works as the previous GLO Proportioning methods described. Fill out the required data fields on the dialog box and select OK. After selecting OK, a dialog box will display where the Point number, description and elevation can be edited. The point default settings determine the available data for editing. For example, if the option for Automatic Point Numbering is turned off in the Point Defaults, then the field for the point number will be grayed out. If elevations are turned off in the point defaults, then the elevation field will be grayed out. This also applies to the description of the point as well. GLO is an acronym for Government Land Office.

Prompts

GLO Proportioning Four Way Control dialog

Saving Point dialog:
Pulldown Menu Location: COGO > Section Corners > GLO Corner Proportioning  
Prerequisite: A coordinate (CRD) file  
Keyboard Command: cg_glo_four_way

Solar Observations

This feature calculates true north and/or grid north bearings by solar observation. It uses the Local Hour Angle (LHA) method. The routine calculates Ephemeris data, thus alleviating the necessity of obtaining a Solar Ephemeris. The True North option calculates the true north bearing to mark. This option requires no zone/ellipsoid information. The True North & Grid North option calculates both true north and grid north bearings to north. The convergence angle is also shown.

Note: There is a description of solar observation field procedures at the end of this section.

True North Prompts

Calculate true north, or true north and grid bearing (<True north>/Grid Bearing: type T, press Enter  
Choose field method (Leading edge/Trailing edge/<Center>): choose method, press Enter  
If a Roelofs prism is being used, the Center Method should be selected. If not, select one of the other options. The Trailing Edge Method is the more popular of the two remaining methods.  
Date of observation as MM/DD/YY or MM-DD-YYYY: For example 04/08/03.  
Enter latitude of instrument point as DD.MMSS: For example 36.0545  
Enter longitude of instrument point as DD.MMSS: 

The following input loop will begin:  
Obs. #1 - Time of observation as HH.MMSS: For example 15.3030  
Enter angle to mark as DD.MMSS: Angle in the instrument when backsighting the mark.  
Enter angle to sun as DD.MMSS: Clockwise angle from mark to sun.  
The angle to the mark always has a default value of the last entered Angle to Mark. Each observation is numbered and the true bearing to the mark will be calculated. There is not limit as to the number of observations that can be made from a setup. After data entry is complete, press Enter.
The following options appear:

[Edit/Ok/Quit] <O>:

If you choose Edit, you will have the following options:

**ADD/Change/Delete/eXit:**
- **Add:** Allows for addition observation data entry.
- **Change:** Allows editing of existing data. When selected a prompt for Enter observation to change will be displayed. Choose which observation number to edit. You will then be prompted with the initial input prompts for the observation again. The original input values will be the default values for each prompt. To change the value, simply enter new data.
- **Once Delete:** This will delete the specified observation data. Choose the observation number to delete.
- **eXit:** This exits the change routine.

If you type 0 and Enter or just enter for **OK**, the bearings from all the observations will be averaged and shown as well as the True Bearing. For example:

**No. Time Angle@-Mark Angle-to-Sun True-Brg-to-Mark**

1 12.3030 0°00'00'' 20°00'00'' N 73°05'43''E
2 12.4456 0°00'00'' 21°00'00'' N 74°17'15''E
**Average True Bearing: N 73°41'29''E**

**True North & Grid Bearing Prompts**

*Type of calculation [True-north/true-north-and-Grid-bearing] <T>: G*

The following dialog will be displayed.

![Solar Observations - State](image)

Select the state in which the observations were made. All fifty states are available, as well as PR for Puerto Rico and UTM for Universal Transverse Mercator.
If the state is divided into zones, you will be prompted for the zone you are working in.

**Enter zone (N,S):** Enter the zone.

If you are using a UTM, you will see the following prompt:

**Enter ellipsoid to use [GRS-1980/Other] <G>:**
Type "R" and Enter or just Enter for Reciprocal flattening, "S" and Enter for Semi-minor axis, or "E" and Enter for ellipsoid ECC squared.
if you typed O and Enter for **Other**, you will see the following prompt:
Ellipsoid constant [Reciprocal flattening/Semi-minor axis/ellipsoid ECC squared] <R>:

Depending on what was entered at the last prompt you will see one of the following prompts: Enter reciprocal flattening constant: Type the constant.
Enter semi-minor axis: Enter the axis.
Enter ellipsoid ECC squared constant: Enter the constant.

After entering the zone and ellipsoid information (if applicable) the date, latitude, longitude and time input loop will begin (as described above for the True North calculation).

After data entry is completed the [Edit/Ok/Quit] <O>: prompt will be displayed (see the True North section for more details on this prompt).

If you type 0 and Enter of just Enter for Ok, the information for all the observations is displayed along with the Average True Bearing, Average Grid Bearing and the Convergence Angle as follows:

No. Time Angle-@-Mark Angle-to-Sun True-Brg-to-Mark
1 12.2222 0°00'00'' 20°00'00'' N 72°57'31''E
2 12.4444 0°00'00'' 22°00'00'' N 74°20'51''E
Average True Bearing: N 73°39'11''E
Average Grid Bearing: N 72°15'12''E
Convergency Angle: 1°23'59''

Field Procedures for the Local Hour Angle (LHA) method

This section explains Universal Time and then explains two ways of pointing, Trailing Edge Tangency and Roelofs Prism.

Universal Time
The Universal Time can be obtained on certain radio bands. On the radio channel there will be a signal beep every minute. Set a watch to the Universal Time or, when in the field, start a stopwatch at the beep (for a known Universal Time).

In order for the solar observation method to produce accurate results, it is essential that you record the precise Universal Time for an observation. Thus, when making the field observations, record the stopwatch elapsed time in order to calculate the Universal Time or, if you set your watch to Universal Time, record the time directly.

Trailing Edge Tangency
While pointing at the ground mark, set the horizontal circle to read about 00-00-30, perfect pointing. With the scope direct, record the horizontal circle reading to the mark.

Attach the eyepiece filter and sight the sun. After locating the sun, do the following:
Set the horizontal reticle line near the center of the sun's image with the vertical reticle line leading the trailing edge of the sun (slightly right for a direct image).
Clamp the horizontal motion and watch the image of the sun as the trailing edge approaches tangency with the vertical reticle line.
Stop the timer at the time of tangency.
Record the time and the horizontal circle reading.
Repeat the pointing for a total of four pointings in the direct position.
Unclamp the horizontal motion, rotate the instrument 180 degrees, plunge the scope, and then obtain data for four reverse readings.

Unclamp the horizontal motion, point at the ground mark with the instrument reverse and record the horizontal circle.
The timer must be checked-in on a radio signal. Some quartz regulated electronic watches are accurate for extended periods of time, allowing several hours of check-in to check-out on the radio. Otherwise, most timers should be started and stopped on a radio signal at the beginning and ending of the observation set.

Roelofs Prism
Attach Roelofs prism and sight the sun (you can center the shadow of the telescope between the standards as an aid in locating the sun). Be sure that the hinged tube is closed when pointing at the sun. After locating the sun through the scope, do the following:

- Rotate the prism until the four overlapping images of the sun are symmetrical with the instrument's reticle lines.
- Point on the ground mark with the instrument direct and the Roelofs prism tube swung open, perfect pointing on the ground mark. Record the horizontal circle reading to the mark.
- Point at the sun with the prism closed. After locating the sun, do the following:
- Set the horizontal reticle line near the center of the sun's pattern with the vertical reticle line leading the center of the moving pattern (slightly to right of the sun for direct optics).

Clamp the horizontal motion and watch the pattern move to the point of coincidence. This is the intersection of the vertical reticle line with the apex of the small dark square formed in the center of the pattern by the overlapping parts of the four images formed of the sun.

Stop the timer at the moment of coincidence.
- Record the time and the horizontal circle reading.
- Repeat the pointing for a total of four readings in the direct position.
- Unclamp the horizontal motion, rotate the instrument 180 degrees, plunge the scope, and then obtain data for four reverse readings.
- Unclamp the horizontal motion, point on the ground mark with the instrument reversed and record the angle on the horizontal circle.

The timer must be checked-in on a radio signal. Some quartz regulated electronic watches are accurate for extended periods of time, allowing several hours of check-in to check-out on the radio. Otherwise, most timers should be started and stopped on a radio signal at the beginning and ending of the observation set.

**Pulldown Menu Location:** COGO

**Keyboard Command:** cg_solar_obs

**Prerequisite:** None

---

**Triangle Solutions**

Triangle Solutions solves for the remaining sides and angles of a triangle given the known side and angles. The upper case letters A, B and C represent the distances. The lower case letters a, b and c represent the angles. Distance A is the leg of the triangle opposite the angle 'a'. Likewise, distance B and C are the legs opposite the angles of 'b' and 'c', respectively. Enter any three known values of the six possible parameters and the three unknowns will be calculated and displayed. If you enter three angles, you will be shown proportional distances since there is an infinite number of distances that would solve a three angle triangle.
In this example, The sides A & B are known as is angle ‘a’. After entering the three parameters, press the Solve button and the remaining three will be calculated and shown. The area in acres or hectares and feet or meters will also be calculated and shown. Press clear to enter data on a new triangle after the triangle has been solved. The solution for each triangle area is then displayed at the command line. You may press F2 to display the command line window and view the results.

Side A Side B Side C Angle a Angle b Angle c
45.00 85.00 88.40 30°00'00'' 70°48'43'' 79°11'17''
Area = 1878.550 sq. ft. (0.043 acres)

_Pulldown Menu Location:_ COGO  
_Keyboard Command:_ trianglesolutions  
_Prerequisite:_ None

**Best Fit**

**Best Fit Point**
This command calculates the average point from a selection of input points and reports the residual statistics. The input points can be specified by point number, by point group or by screen selection. The program displays the input points with residuals in a dialog where you can toggle on/off whether to include points in the point average using the Process On/Off button. The Remove button removes a point from the average and the residual report. There is an option whether to output the average point to the current coordinate file. The option to delete all the input points applies when there are several points that are meant to be the same point and you want to replace them with a single averaged point. The command shows a report of the input points, residuals and average point.
Prompts

Select points from screen, group or by point number [<Screen>/Group/Number]? press Enter
Select Carlson Software Points.
Select objects: pick points
Best Fit Dialog

Sample Report:

<table>
<thead>
<tr>
<th>Source Coordinates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point# Northing Easting Elevation Residual</td>
</tr>
<tr>
<td>1  4024.912   5205.108   542.200   131.567</td>
</tr>
<tr>
<td>2  4062.104   5173.570   543.100   147.733</td>
</tr>
<tr>
<td>3  4126.711   5180.822   543.700   142.100</td>
</tr>
<tr>
<td>...</td>
</tr>
</tbody>
</table>

Residuals Standard Deviation: 37.128
Average Residual: 107.188
Average Point: 4091.142,5317.562,558.855

Pulldown Menu Location: COGO
Keyboard Command: bfitpt
Prerequisite: Two or more points

Best Fit Circle

This command draws a least-squares best-fit circle based on points on the perimeter. The program handles four or more perimeter points. A design point for the circle center can optionally be specified as a reference to compare with the best-fit center in the report. The report shows the residuals for each point, the residuals standard deviation, the difference between the design point and the circle center, and the circle parameters. The residuals are calculated as the perpendicular distance from the point to the circle. The best-fit circle can be calculated in 2D or 3D. In 2D mode, the elevation of the points is not used. In 3D mode, a best-fit plane is calculated for the points. Then the points are projected onto the plane and the best-fit circle is calculated on this plane. Then the resulting circle
is projected back into world coordinates and drawn as a 3D polyline with short chords to represent the 3D circle since CAD doesn't support a 3D circle entity. Applications for 3D circles are tunnel sections and architectural arches.

After specifying the points, the program calculates the best-fit circle and shows the results in the dialog show here. You can toggle each point for whether to include in the calculations. You can also modify the radius.

**Prompts**

Create 2D or 3D circle [<2D>/3D]? press Enter
Select points from screen or by point number [<Screen>/Number]? N
Point numbers: 2-6
Point numbers (Enter to continue): press Enter
Enter design center point# (Enter for None):

![Best-Fit Circle](image)

Sample Report:

Source Coordinates

<table>
<thead>
<tr>
<th>Point#</th>
<th>Northing</th>
<th>Easting</th>
<th>Residual</th>
<th>Process</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>5253.198</td>
<td>5070.233</td>
<td>0.126</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>5246.623</td>
<td>5084.077</td>
<td>0.045</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>5232.963</td>
<td>5078.608</td>
<td>-0.131</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>5235.610</td>
<td>5065.105</td>
<td>0.217</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>5247.392</td>
<td>5064.165</td>
<td>-0.264</td>
<td></td>
</tr>
</tbody>
</table>

Residuals Standard Deviation: 0.174

Circle Center: 5242.678, 5073.785 Radius: 10.977
Design Center Point#: 1
Design Center: 5242.718, 5073.688
Center Distance Difference: 0.105
**Best Fit Circle**

Pulldown Menu Location: COGO  
Keyboard Command: bfitcir  
Prerequisite: Four or more points

**Best Fit Centerline**

This command processes a group of points to compute the best fitting centerline by least squares. The points can be input from Carlson points or from vertices of a polyline. For points input, the points can be selected by screen selection or point number range. Each line segment in the centerline is calculated by the best-fit line method and each arc segment is calculated by the best-fit arc method.

In the process options dialog, the Snap Tolerance is the max offset from the point to the line or arc segment in order to be counted as part of that segment. The Polyline Layer is used for the output polyline. The Max Radius controls the maximum radius for arc segments that the program will fit to the data. The Create Tangents Only option skips the step of calculating the best-fit arcs and outputs only the lines. Arcs can be added later using routines like Fit Curve in the Input-Edit Centerline command. The Make Curves Tangential option fits the line and arc segments to be tangential. The Min Points For Arc setting controls how many points are required to calculate an arc. If this number is low that makes it more likely to create an arc where some points vary from linear but there really isn't meant to be an arc. If this number is high that makes it more possible to miss creating an arc in case the arc only has a few points on it.
The residual for each point is the perpendicular distance from the point to the best-fit centerline. The results are shown in a dialog and you can toggle each point for whether to include in the calculations. Points that are toggled off are not used for calculating the centerline but are still used in the residual report. The Remove function removes the point from both calculation and residual reporting.

Prompts

Input existing data from points or polyline [<Points>/Line]? press Enter
Select points from screen or by point number [<Screen>/Number]? S
Select Carlson Software Points.
Select objects: pick the centerline points

Pulldown Menu Location: COGO
Keyboard Command: bestcl
Prerequisite: Group of points or a polyline to sample

**Best Fit Line by Average**

This command will fit a line from a starting point by sampling a group of points. The routine averages the coordinates of the sampling group then draws the best-fit line. The program generates a report of the residuals, standard deviation, line bearing and line distance. The perpendicular distance from each point to the line is reported as the residual.

![Diagram of lines and points](image)

**Prompts**

Starting point ?
Pick point or point number: *pick starting point*
Select points from screen, group or by point number [<Screen>/Group/Number]? *press Enter*
Select points.
Select objects: *select group of points* Select points using Window or Crossing. The line is then drawn to the computed point.

**Pulldown Menu Location:** COGO
**Keyboard Command:** bfitlin
**Prerequisite:** points to sample
Best Fit Line by Least Squares

This command will process a group of points to compute the best fitting line by least squares. The points can be selected by screen selection, point number, point group name or polyline vertices. The program can calculate either a 2D or 3D line. There are options to best fit with nothing held (None), to best fit by holding a point, and to best fit by holding a bearing. All three options are shown below in the graphic. When holding a point, you are prompted to enter the weight for the point. In this example, a weight of 1000 caused the line to pass to within 0.025 of point 111. With a weight of 5000, the line passed to within 0.005 of point 111. Increase the weight accordingly to obtain the desired precision. When holding a bearing such as N45E, you are prompted to enter the bearing in the form QDD.MMSS (e.g. 145.0000 or just 145). The program generates a standard report. The residual for each point is the perpendicular distance from the point to the best-fit line.

After specifying the points, the program calculates the best-fit line and shows the results in the dialog show here. You can toggle each point for whether to include in the calculations. Points with Process set to No and not used for calculating the line but are still included in the report of residuals. Use the Remove button to remove a point both from calculation and reporting.

The Create Two Parallel Lines option applies when the points are for two line that are meant to be parallel such as a right-of-way. The program takes input for the distance between these two lines and then automatically sorts the points between the two lines, reports the residuals for the two lines and draws the two lines.

Prompts
Select points from screen, group or by point number [<Screen>/Group/Number/Polyline]? S>
Create 2D or 3D line [<2d>/3d]? 2d
Select Carlson Software Points.
Select objects: pick the five points
Point numbers (Enter to continue): press Enter
Parameter to hold [<None>/Point/Bearing]: P
Enter point number to hold: 111
Enter weight for point: 5000

Sample Report:

**Best Fit Line By Least Squares**
Holding point 111: (5227.721,5149.482)

**Coordinate File**
c:\data\interval.crd

**Source Coordinates**

<table>
<thead>
<tr>
<th>Point#</th>
<th>Northing</th>
<th>Easting</th>
<th>Residual</th>
</tr>
</thead>
<tbody>
<tr>
<td>109</td>
<td>5103.542</td>
<td>5182.098</td>
<td>10.050</td>
</tr>
<tr>
<td>110</td>
<td>5114.634</td>
<td>5191.928</td>
<td>6.921</td>
</tr>
<tr>
<td>111</td>
<td>5149.482</td>
<td>5227.721</td>
<td>0.005</td>
</tr>
<tr>
<td>112</td>
<td>5178.703</td>
<td>5268.237</td>
<td>0.400</td>
</tr>
<tr>
<td>113</td>
<td>5201.666</td>
<td>5312.602</td>
<td>8.129</td>
</tr>
</tbody>
</table>

Residuals Standard Deviation: 6.559

Bearing: N 53d44'07'' E
Distance: 163.266

**Pulldown Menu Location:** COGO
**Keyboard Command:** bfitlinelq
**Prerequisite:** Group of points to sample

---

**Interpolate Points**

**Point on Arc**

This command locates a point on an arc. You can select an arc entity, an arc polyline segment or enter three points to define an arc. After the arc is defined, the screen preview arrow shows the occupied point and the distance to solve for is entered. The command then displays the curve information and locates/inserts a point symbol at the computed point. When prompted for the distance, use a positive value if the distance is from the 1st endpoint (PC the one highlighted by the screen preview arrow) and a negative value if from the 2nd endpoint (PT).

**Prompts**

**Define arc by, Points/<select arc or polyline>:** pick arc or polyline arc segment Pick a point on the arc somewhere near it’s midpoint. The preview arrow points to the 1st endpoint.
**Precede distance with minus sign if distance from 2nd endpoint.**
**Distance along arc from 1st point:** 100
The command then plots a point at the computed distance.
Pulldown Menu Location: COGO > Interpolate Points  
Keyboard Command: ptarc  
Prerequisite: None

**Divide Between Points**

This command divides the distance between two points and inserts one of the point symbols at the specified distances. It can also interpolate elevations (to interpolate the elevations, the points picked must be at their real Z axis elevation).

**Prompts**

Interpolate elevations [Yes/<No>]? hit Enter
Point to divide-interpolate from?
Pick point or point number: 1

<table>
<thead>
<tr>
<th>PointNo.</th>
<th>Northing(Y)</th>
<th>Easting(X)</th>
<th>Elev(Z)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4252.76</td>
<td>4158.32</td>
<td>0.00</td>
<td></td>
</tr>
</tbody>
</table>

Point to divide-interpolate to?
Pick point or point number: pick a point
Number of Segments-Divisions: 3
Enter Point Description <>: hit Enter
The command then locates two points.

**Divide Along Entity**

This command locates points along an entity such as a line, polyline, spline or arc. You must specify the number of divisions.

**Prompts**

Interpolate Elevations [Yes/<No>]: press Enter
Select Entity to Divide: pick point on entity

Chapter 12. COGO Menu
Number of Divisions/Segments: 15
The command then locates 14 points.

Pulldown Menu Location: COGO > Interpolate Points
Keyboard Command: divent
Prerequisite: 2 points if you want to interpolate elevations

Elevation Between Points
This command interpolates new points between two reference points at a single elevation or elevation interval. The routine uses the elevations of the two reference points together with the target elevation to figure the interpolation distance. For example, with one reference point at 100, the other reference at 104 and the target at 101, then the new point will be created 1/4th the distance from the first reference point towards the second reference. The target elevations are used as elevations for the new points.

Prompts

Point to interpolate from.
Pick point or point number: pick a point

Point to interpolate to.
Pick point or point number: pick a point

Add single elevation or elevation interval [Single/<Interval>]? press Enter
Enter elevation interval: 1

Pulldown Menu Location: 3D Data > 3D Points
Keyboard Command: addptz
Prerequisite: None

Elevation Along Entity
This command creates points at a specified elevations along 3D polylines. The points are stored in the current coordinate file and drawn on the screen. A single elevation can be entered or use an elevation interval.

Prompts

Select entities to process
Select objects: pick a 3D polyline
Elevation Range: 547.200 to 587.300
Add single elevation or elevation interval [Single/<Interval>]? press Enter
Enter elevation interval: \( I \)
Point Description: \( EP \)

Pulldown Menu Location: COGO > Interpolate Points
Keyboard Command: entptz
Prerequisite: 3D polyline

**Interval Between Points**
This command creates points by interpolating at a horizontal distance interval between two control points. There is an option for whether to interpolate the elevation or use zero for elevation. The point style and whether to prompt for a description is set in *Point Defaults*.

**Prompts**

Interpolate elevations [Yes/<No>]? press Enter
Point to interpolate from?
Pick point or point number: pick a point
Point to interpolate to?
Pick point or point number: pick a point
Interval Distance: 50

Pulldown Menu Location: COGO > Interpolate Points
Keyboard Commands: ptintpt
Prerequisite: None

**Interval Along Entity**
This command creates points at a specified distance along an entity such as a line, arc, spline or polyline. The points are listed out on the text screen, stored in the current coordinate (.CRD) file and drawn on the screen. For example, you might use this command to locate lot corner points along a frontage line. When Break Entity at Points is checked, the selected entity will be broken at every located point. The Create Points At Endpoints option locates points at the starting and ending points of the entity. When Create Point at Vertices is checked, points will also be located at each vertex of the selected entity. Horizontal Distance Between Points allow you to specify the distance between located points. There is also an option to create points on curved portions of the centerline at a different interval than on tangent portions (to reduce chord lengths, a shorter interval may be suitable for curves).

There is an option in this dialog allowing you to determine whether or not to label elevations on the new points. And for the purposes of describing the points, there is an option that allows you to set the same description to all of the points. For more options related to points, see *Point Defaults* under the Points pulldown.
Create Points at Endpoints turned on

Prompts

Select entity near endpoint which defines first station.
[nea on] Select Entity to Interpolate Points: select entity
[nea on] Select Entity to Interpolate Points: Locating 13 Points

The command locates points along the selected entity.

Pulldown Menu Location: COGO > Interpolate Points
Keyboard Command: ptint
Prerequisite: An entity

Create Points from Entities

This command will create Carlson Survey points on selected entities. The points are stored in the current coordinate (.CRD) file and drawn on the screen. For arcs and polylines with arc segments, points are created at the radius
points of the arcs as well as the PC and PT.

In the first options dialog, there are settings for the point attributes. To have points obtain their elevation from the selected entities, unselect the Prompt for Elevations toggle and select the Locate on Real Z Axis toggle. After you have specified the point options, a secondary dialog appears which allows you to specify the entity types to process. Under the Description Settings, Prompt for Description At Each Point will prompt you at the command line for a description for each individual point. Prompt Per Entity will ask you for a description per each highlighted entity. Use Entity Layer for Description will assign the layer name to the description. Same Description For All Points will prompt you for a single description for all points.

The second options dialog has processing settings. When Entity Layer for Description is checked, the layer name of the entity will be used as the description for the created point. When Avoid Duplicates with Existing Pts is checked, this routine will not create a point if a point with the same coordinates already exists in the current coordinate (.CRD) file.

![Convert Entities To Points Dialog](image.png)

**Prompts**

Create Points From Entities Dialogs Choose settings
Select arcs, faces, points, text, lines and polylines.
Select objects: pick entities
Before and after using Create Points from Entities. Points are created at each endpoint and radius point.

**Pull down Menu Location:** COGO  
**Keyboard Command:** autopnts  
**Prerequisite:** drawing entities

### Offset Points By Interval

This command creates offset points along an alignment which can be used for creating curb stakeout points. The alignment can be defined by either a 2D polyline or a centerline file (.cl). The options dialog has three tabs for the General, Description and Draw settings.
Offset Distance: Sets the offset distance from the alignment to the points. Use a positive value for offset right and negative for offset left.

Reference Elevation: This setting controls the point elevations. The 3D Polyline method prompts to select a 3D polyline. The offset points get the elevations from the position of the nearest perpendicular offset on the 3D polyline. The Profile method prompts to select a profile file. The stations of the profile must match the alignment stations. The Constant method sets the point elevations to a fixed elevation. The Surface Model method uses a triangulation (.tin) or grid (.grd) surface model file.

Delta Z: Adjusts the point elevations from the reference elevations.

Create Interval Points: Creates points along the alignment at the specified interval. There are separate intervals for line and curve segments.

Space Points Evenly: For each segment, this option figures how many points fit at the interval and then adjusts the interval to make that number of points evenly spaced. For example, if the interval is 10 and the segment length is 48, then 4 points fit and this option will space them at an interval of 12.

Create Vertex Points: Creates points offset from the points in the alignment.

Create Radius Points: Creates radius points for curve segments in the alignment.

Offset Side Only: Applies to radius points and only creates the radius point when it is on the same side of the alignment as the offset direction.

Max Radius: Applies to radius points to only create the radius point when the radius of the curve is less than this amount.

Create Only Radius Points on Small Curves: When the curve radius is less than the Min Radius, only the radius point is created and not the PC, PT or mid points.

Create Curve Midpoints: Creates a point midway along the curve when the curve length is greater than the specified Min Curve Length.

Minimum Deflection Angle: At an alignment vertex between two line segments, when the deflection between the line in and line out is greater than this value, only a single offset point is created. Otherwise two offset points are created, one for the line in and one for the line out. Set this value to 0 to always have only a single offset point. Set this value to 180 to always have two offset points.

Deflection Distance Tolerance: Sets how close together two offset points should be set on vertex deflection points. When the vertex point is set to get two offset points, but the offset points are within this tolerance of each other, then only a single offset point is created instead of two.

Starting Point Number: The new point numbers will increment starting from this number.
**Point Group to Assign:** Creates a point group for the new points created by this command.

**Create 2nd Offsets:** Creates a second set of points at the 2nd Offset Distance.

The Description settings control the point descriptions for the various types of new points. The **Append Offset To Description** option adds the offset amount to the description of each point.

The Draw settings have the symbol and layer for the points. The **Draw Lines** option is for drawing lines between
the alignment and the points.

Prompts

CL File/<Select alignment polyline>: pick a polyline
Offset Points dialog

Pull-down Menu Location: COGO
Keyboard Command: curb_pnts
Prerequisite: Alignment polyline or centerline

Building Offset Extensions

This command is used to calculate building corner offset points that are extensions of the building faces. This command uses building perimeters that are drawn as closed polylines. The point are stored to the current coordinate file and draw on the screen. There is a dialog for setting the parameters. The Offset Amount is the distance that the offsets are extended past the end of the building line. The Starting Point Number is the point number to begin storing from. The Point Description and Elevation are assigned to all the new points and the Point Layer is used for all the drawn points. The Create Extension Points controls whether offset points are created as extensions of the building lines at the corners. The Create Perpendicular Points applies to the extension points for creating a pair of perpendicular points at the corners. The Create Diagonal Points method creates points at the diagonals of corners. The Create Across Building Points creates points across to the other side of the building for inside corners. The Create Envelope Points calculates a rectangle that encloses the building and creates points at the four rectangle corners. The Create Polyline Vertex Points creates points at each vertex in the building perimeter. The Create 2nd Offset option makes a second point for each point at another offset and with another description.
In the first example shown here, Create Perpendicular Points is on. Points 101, 103, 104, 106, 107, 109, 110, 112, 115, 117, 118 and 120 are corner extension offset points. Points 102, 105, 108, 111, 116 and 119 are diagonal points. Points 113 and 114 are across building points.

In the second example, Create Perpendicular Points is off and the program only creates points on one side. Also on this example, the Create 2nd Offsets option is on.
Prompts

Building Offset Extensions dialog
Select building perimeter linework.
Select objects: make selection

Pulldown Menu Location: COGO
Keyboard Command: bldg.pnts
Prerequisite: A polyline perimeter that represents a building

Draw Building Envelope Polyline

This command creates a rectangular polyline around selected linework. This can be used to give a building all one elevation.

Select the entities that make up the building. Next you will be prompted to name the layer and in the dialog, you can set the layer name for the rectangle and other settings.
Offset: This is the amount the building envelope will be offset out from the source linework.
Prompt For Each Side Offset: This option allows you have different offsets for each side of the rectangle.
Length Snap Resolution: Will round the dimensions of the created Building Envelope by a certain tolerance. For example, if you select None you may get a Building Envelope of 37.4 x 25.2. However, if you set the Length Snap Resolution to 0.5, you will get a Building Envelope of 37.5 x 25.0.
Prompt For Elevation: This option allows you to set the elevation for the rectangle. Otherwise the rectangle is drawn at zero.
Trim Crossing Linework: This option trims any linework that crosses the building envelope which applies to linework like contours to ensure that you have a flat pad when building the surface model.
Draw Corner Cross Lines: This option draws two lines between the corners of the rectangle.

**Prompts**

Select building lines.
Select objects: pick the linework that makes up the perimeter of the building
Enter the segment horizontal offset <0.000>: 10
Enter the segment horizontal offset <10.000>: Enter
Enter the segment horizontal offset <10.000>: 5
Enter the segment horizontal offset <5.000>: Enter
Select/Enter Elevation <0.0000>: 400
Draw another building envelope [<Yes>/No]? No

Pulldown Menu Location: Civil > 3D Data, Survey > COGO, Takeoff > Elevate
Keyboard Command: bldg_perim
Prerequisite: Building linework

**Radial Stakeout**

This command creates a radial stakeout report using the current coordinate (.CRD) file. The program calculates the azimuth, angle right, horizontal distance and/or slope distance for a range of points relative to an occupied point and a backsight point.
**Occupied Point Number:** Specify the occupied point number X and Y values will fill in automatically.

**Backsight Point Number:** Specify the backsight point number X and Y values will fill in automatically.

**Maximum Hz Distance:** This is the maximum horizontal distance from the occupied point that the program will include in the report.

**Range of points to Compute:** Enter the range of points to be included in the stakeout report. If you check Select Points from Screen, this option is unavailable.

**Select Points from Screen:** This option allows you to select from the screen the points to be included in the stakeout report.

**Number of Decimal Places:** Specify the display precision for the report.

**Report Options:** Specify the direction format that the report should use.

**Report Slope Distance:** When checked, the slope distance is included in the report in addition to the horizontal distance.

**Use Cut Sheet Format:** When checked, adds columns to the report for Description, Hub Elev, and Elevation.

---

Results from clicking the List (point) button.
Sample radial stakeout report:

Radial Stakeout
Occupied Point
2  7137.7248  9016.1417  500.000
Backsight Point
1  7075.7408  8875.7884  500.000
Backsight Azimuth= 246.1021
PtNo. Azimuth AngRight HzDist North(y) East(x) Elev(z)
3  261.0258  14.5237  74.061  7126.2022  8942.9830  500.000
4  262.4347  16.3327  113.032  7123.4208  8904.0181  500.000
5  281.1809  35.0748  137.858  7164.7435  8880.9572  500.000
6  301.4512  55.3452  82.296  7181.0342  8946.1639  500.000

Pulldown Menu Location: COGO
Keyboard Commands: radstake, rs
Prerequisite: A coordinate file (.CRD file) with points
Centerline Menu

The Centerline menu provides commands for designing and editing centerlines and centerline files. Tools for stationing, labeling and offsetting centerlines, along with Right of Way features, are also provided in this menu. Additionally, there are many import and export conversion options to select from when you pick Centerline Conversion.
Design Centerline

This command draws a centerline polyline and writes the centerline data in a centerline file. The first step is to specify a centerline (.CL) file name. Next in the Design Centerline dialog you can specify several options. Centerline Layer is the layer name for the polyline. Tangents Layer is the layer name for the tangent lines drawn from the centerline to the curve center. Max superelevation is used for determining the minimum recommended radius. Setting the Prompting mode to Existing skips design questions such as design speed.

After the Design Centerline dialog, the program cycles through curve prompting until End is selected. There are PC and PI modes for curve entry. In PC mode the arc's PC points are entered followed by the curve data. The PC points can be specified by either picking the point, entering a distance or entering a station. In PI mode, the arc's PI points are entered. Once the PI points determine two tangents, the program prompts for curve data for the previous PI. Spirals can only be entered in PI mode. You can switch between arc and PI mode between curves on the polyline. The arc curvature can be specified by degree of curve or radius. The minimum recommend radius is based on AASHTO. The arc length can be specified by PT station, tangent length or arc length.

The Store Points in CRD File will create points in the current coordinate file for each design point on the centerline. This option is also used for creating the SMI chain file within Centerline Utilities, since the SMI chain file requires point numbers. To specify the coordinate file, choose Set Coordinate File in the Points menu.

Prompts

Centerline file to design Enter the .CL file name to create.
Design Centerline Dialog Choose your options and click OK.
Pick Point or Point number: pick a starting point or enter the starting point coordinates
For PC mode design:
Bearing/PI/End/Undo/<Pick Point or Point number>: pick the PC point
Bearing/PC/PI/End/Undo/<Pick Point or Point number>: PC
Enter Design Speed for curve <55.00>: 40
Minimum Recommended Radius = 426.67
View/Point/Degree of Curve/<Radius>: 500
Curve direction (Left/<Right>)? press Enter for right
Length to use (Station/Tangent/<Arc>)? press Enter for arc
Point/Station/Tangent/<Arc Length>: 200
Reverse/Compound Curve (Yes/<No>)? press Enter
PI/Distance/Station/<Pick PC or Point number>: D for distance
Point/Enter Distance: 180
Bearing/Line/Undo/End/<Continue PC>: press Enter
Enter Design Speed for curve <40.00>: press Enter
Minimum Recommended Radius = 426.67

Example of PC mode centerline design

View/Point/Degree of Curve/<Radius>: 500
Curve direction (Left/<Right>)? press Enter
Point/Station/Tangent/<Arc length>? 300
Reverse/Compound Curve (Yes/<No>)? press Enter
PI/Distance/Station/<Pick point or Point number>: D for distance
Point/Enter Distance: 140

For PI mode design:
Bearing/PI/End/Undo/<Pick Point or Point number>: pi
Pick Point or Point number (PI)<5098.50,3509.11>: pick the first PI point
Type of curve [Spiral/<Circular>]? S for spiral
Enter Design Speed for curve <55.00>: 40
Minimum Recommended Radius = 426.67
View/Point/Degree of Curve/<Radius>: 500
Enter Number of Lanes <2>: 2
View/Enter Spiral Length In <204.800>: 210
View/Enter Spiral Length Out <210.000>: press Enter
Bearing/Pick next Point or Point number (PI): pick the next PI point
TS: 1+33.280
SC: 3+43.280
CS: 6+39.364
ST: 8+49.364
Bearing/Line/PC/Undo/End/<Continue PI>: press Enter
Type of curve [Spiral/<Circular>]: press Enter for circular
Enter Design Speed for curve <40.00>: press Enter
Example of PI mode centerline design

Minimum Recommended Radius = 426.67
View/Point/Degree of Curve/<Radius>: 500
Bearing/Pick next Point or Point number (PI): pick the last PI
PC: 9+35.900
PT: 16+34.283
Reverse/Compound Curve [Yes/<No>? press Enter
Bearing/Line/PC/Undo/End/<Continue PI>: E to end
EndPoint: 18+37.121
Stations are printed for every PC, PT and end point in the design process.

Pulldown Menu Location: Centerline
Keyboard Command: centerln
Prerequisite: None

Input-Edit Centerline File

This command can be used to input a new centerline or edit an existing centerline (.CL) file. It is a dialog-based alternative to Design Centerline and has the advantage of accepting whatever information you have on your centerlines (coordinates, stationing, length of tangents and arcs, etc). For creating a new centerline, it is ideal for entering data straight from highway design plans. For editing, this command allows you to change any of the geometric properties of any of the elements of the centerline (lines, curves, spiral-only and symmetrical spiral-curve-spiral elements), including the starting coordinates and station.

Starting this command launches the Centerline Input-Edit main dialog box. To edit an existing Centerline, you can either pick the Load button and pick the .CL file, or pick the Screen Pick button and pick the polyline in the drawing that represents the Centerline. The Centerline is then displayed in the graphics window of the dialog box. The highlighted segment in the text window is also highlighted in the graphics window.
Drag Action (Zoom and Pan): In the graphics window, hold the left mouse button down and move mouse to Pan, roll the wheel to Zoom.

Zoom Drawing To Current Segment: This option zooms the drawing graphics to center on the centerline segment currently highlighted in the dialog.

Hold Other PI Points When Change Starting Point: With this option active, all the existing PI's are held when the starting coordinate is moved. Otherwise, all the PI's are moved by the same amount that the starting point is moved.

Show Right of Way: This option shows any ROW's defined in the centerline in the graphic preview window.

Type of Curves: This setting chooses between roadway and railroad definitions for curve lengths.

Add: Adds a new element after the highlighted element. Prompts you for the type of the element to be added, Line, Curve, Spiral-Only or Spiral-Curve-Spiral.

Edit: Allows you to edit the highlighted segment.

Remove: Removes the highlighted element from the centerline.

Up/Down: Moves elements in the table Up and Down in the list. For example, if this centerline ended with a tangential line from the last curve, then was followed by a non-tangential line at 45d NE, moving the last element up would create a line at 45d after the curve (non-tangential), and the formerly tangential line will remain tangential and therefore continue at NE 45d.

Load: Loads an existing centerline (.CL) file for review or editing. After loading a centerline, the listbox in the dialog shows a list of all the elements in the centerline, identifying them as either a line, curve, spiral only or full spiral-curve-spiral element and reporting the ending station, northing and easting of the element.

Screen Pick: Allows user to pick a CL off the screen in the drawing to load into the editor.

Tools > Reverse: Reverses direction of Centerline.

Tools > Rotate: Rotates the centerline by the specified rotation angle and around the specified pivot point.

Tools > Scale: Scales the centerline which can be used for changing units between metric and English.
**Draw:** This button draws the centerline in the drawing on the specified layer.

**Save:** Saves the currently loaded centerline to a file, or will prompt you for a name if no name has been set.

**Save As:** Prompts you for a file name for the saved file.

**Fit Curve:** Fits a circular curve element into the centerline after the line element that is currently selected. When all the elements are lines, the program allows you to fit curve for all PIs. The program checks if the radius fits all PIs and will prompt the maximum radius that works for all PIs if the current radius is too big. The Horizontal Speed Tables allows you to pick a speed and a super elevation rate to the minimum radius.
Fit Spiral: Fits a spiral curve element into the centerline after the line element that is currently selected.

Point Numbers: This will create Carlson points along the elements of the centerline and store them to the current CRD file. The new points will be numbered in sequence beginning with the first available point number in the CRD file.

Station Equations: At any number of locations on a centerline, you can set the back station and forward station for the re-stationing of the centerline. The station equation dialog appears below:
If the Station Back is lower than the Station Ahead, then a "gap" is inserted in the centerline, where the stations jump forward. If the Station Ahead is less than the Station Back, then an overlap occurs, where the common station range is repeated.

**ROW:** This function edits the right-of-way definitions associated with the centerline. There can be multiple ROW’s assigned to the centerline for left and right sides as well as multiple on the same side. The function first shows a list of ROW’s for the centerline where you can add, edit or delete.

When you add or edit a ROW, there is a second dialog for entering the stations and offsets that define the ROW relative to the centerline. Use negative offsets for left and positive for right.

Alternatively, the **Enter Right of Way** and **Polyline to Right of Way** commands are other ways to define the ROW’s for a centerline.

**Exit:** Exits this routine, prompting to save changes if necessary.

The dialog for every type of element shows the point ID, the northing, easting and station of the start point of the
element. It then allows the user to modify or define the parameters specific to the type of element. The following are some of the things to remember about data entry in the centerline editor. These are valid for lines, curves and spirals.

- Wherever length of the element is to be entered, entering an expression of the type 123.5 - 93.7 would evaluate the difference of the values. This is particularly convenient where only the stations of the start and end points of the element are known.
- When the station is specified, the program takes the length of the element as the difference between the station of the start point of the element and the station specified.
- All bearings should be specified by entering the angle between 0 and 90 degrees (in dd.mmss format) and selecting the quadrant.
- When entering the delta angle of a curve, only the absolute value (between 0 and 360 degrees) is to be entered. The direction of the curve is to be explicitly set as right or left, the default being left. All angles are entered in (dd.mmss) format.
- Point numbers, when used, access their coordinates in the current .CRD file. If the point number specified has no coordinates stored in the coordinate file, the point number is remembered for that particular location (say the radius point of a curve or the SC point of a spiral). Then, when the .CL file is saved, the program creates points for that location and stores them to the .CRD file with the specified point number.

The dialog for a Line allows the user to specify the line primarily by its length or station and its bearing. The line can also be defined by its end point number or its coordinates. The bearing of a line can be changed if the Tangential to the Previous Element toggle is not checked. By default, any line which follows a curve element is defaulted to be tangential to it. To use a bearing different than that of the previous element, uncheck this toggle and enter the bearing.

The dialog for the Curve allows the user to define the curve primarily by its radius and delta angle or arc length. The other parameters of the curve that can be edited are the bearing of tangent-out and the “Station to”, which also defines the arc length. The curve can also be specified by entering the coordinates or point numbers of its end point (PT) and the radius point. Another way to specify the curve would be to enter the chord length or PT point station and chord bearing. If the central PI point and a point on the forward tangent are known, then the curve can be defined by entering both of these points and at least one other property of the curve (like radius, arc length, delta angle). The point on the forward tangent can be any point that defines the tangent out direction including the next PI point. If only the central PI point is known, then the tangent-out can be entered by bearing instead of by forward tangent point. Central PI and forward tangent points are not displayed from the .CL file. They have to be entered by the user and are valid only for that particular edit session; that is, they are not remembered the next time the file is loaded. Curves are assumed to be tangent to the last element unless the Tangential to the Previous Element checkbox is cleared.

The Curve Edit Mode option defines how the curve is accepted in the centerline. If the Hold PC point is checked on, the radius is taken as fixed and the delta angle of the curve is calculated based on some additional parameter. Hence, the extent of the curve is unlimited. However, if the Hold PI points option is checked on, the bearing of tangent-out of the curve is taken as fixed and the radius is calculated based on some other parameter. In this case, the curve is completely restricted within the central PI point and the bearing of tangent out. Hence, when the Hold PI points option is checked on, the above parameters should also be defined to carry out the calculations.

The dialog for the Spiral-Curve-Spiral element allows the user to define the spiral by entering either the various parameters of the spiral (like the angles and lengths) or the coordinates or point numbers of its defining points: the TS (Tangent-to-Spiral), SC (Spiral-to-Curve), Radius point, CS (Curve-to-Spiral), ST (Spiral-to-Tangent) and end point (optional). While defining the spiral by its geometric properties, the program will accept the data even if the information for the simple curve is given with zero spiral lengths. In this method, however, the central PI point of the spiral MUST be specified (that is, it is always in Hold PI Points mode). The tangent out can be defined by entering bearing or by specifying a point on the forward tangent. This forward tangent point can be the next PI coordinates. The direction of the spiral-in and spiral-out elements would be the same as the direction of the simple curve (left or right). The Spiral Definition setting chooses between Arc definition for clothoid spirals and Chord for 10-chord spirals.

The spiral can be defined by several different parameters and the order that you enter data into the spiral dialog can
be important. There are two main sequences for entering data. The method to use depends on the spiral data that you have. The first method is to enter the radius of the simple curve, the spiral in and out lengths, the tangent bearing out and the PI station. The second method is to make a Line segment coming up to the TS (tangent to spiral) point. This Line segment should be added before creating the Spiral element. Then with the Spiral In point set to the TS point, enter the radius of the simple curve, the spiral in and out lengths, the curve direction (left or right) and the arc length of the simple curve. Then the rest of the spiral points will be calculated.

The Spiral Only element allows for flexible transitions from curve to spiral to curve or line to spiral to curve or between any combination of curve and line elements. The Spiral-Curve-Spiral element, for example, can be entered as Line, Spiral Only, Curve, Spiral Only and Line, producing the same results. You can spiral from tangent to curve, curve to tangent and curve of one radius to curve of another radius. You can also spiral from one endpoint to another endpoint. To define the spiral by sweep angle, use the Delta Angle field. To define the spiral by length, use the Spiral Length field. To define the spiral by end point, fill in the min and max radius fields and then enter either the End Point Pnt# or coordinates and the program will calculate the radius and spiral length to fit that point.

Once all the elements of the centerline are defined, the file can be saved and then plotted using the Draw Centerline File command.

Here is an example of a highway interchange ramp that involves a starting tangent and a spiral curve that goes abruptly into a simple curve and then a final tangent. Start by entering a starting Northing and Easting and starting Station. The Start Point# is optional. Then the concept is that you click Add to add each subsequent element (line, curve, spiral-curve-spiral or spiral only):
Line (Tangent) Segment: We want to enter the tangent segment length up to the TS (tangent to spiral). Enter in the length (200.0), bearing (88.0732) and then the bearing quadrant (NW). Since the next spiral-curve-spiral element can be based on a PI station, it is not necessary for this line segment to go up to the TS point. The purpose of this line segment is to establish the tangent-in direction.

When OK is clicked, the routine will add the Line element as the first in the list of complete centerline elements. Next up is Curve-Spiral-Curve. Click Add.
**Spiral Segment:** Though the dialog is complex (for total flexibility), the key on a typical symmetrical spiral curve is to enter four things: (1) the radius of the simple curve, (2) the spiral in and out lengths, and (3) the tangent-out bearing. Everything else will calculate when you press Enter for the PI station.

**Curve Segment:** Add the next element and select curve. The Curve dialog appears. The key is to enter the Radius Length (255), the Arc Length (150) and the Curve Direction. Everything else will calculate.

**Final Line Segment:** All you need to enter in the final dialog for the line (tangent) segment is its length. All other items will calculate when you press Enter.
The completed centerline will appear as shown in the dialog and each element can be edited. Pick the Save button to store this centerline data to a .CL file.
**Polyline to Centerline File**

This command writes a centerline (.CL) file from a polyline in the direction the polyline was drawn. The Northing and Easting for each vertex of the polyline is written to the centerline file and each arc in the polyline becomes a circular curve. After selecting the polyline, the program shows the direction by drawing temporary arrows along the polyline. To reverse the direction of the polyline, there is a keyword option R for Reverse at the Command line. Also, the Reverse Polyline command can be used to switch the direction of a polyline.

For stationing the centerline, there is a Command line prompt for entering the station at the beginning of the polyline and then using the polyline segment lengths for the rest of the centerline stations. Alternatively, there is a keyword option E for Ending to specify the station at the end of the polyline and then back calculating the centerline stations to the beginning using the polyline lengths.

In addition to being used as roadway/corridor "baselines," a .CL file can also be used as the horizontal control for a Template Point Centerline.

Note: To convert lines and/or arcs into a polyline, use the Entities to Polylines command or the Join Nearest command.

**Prompts**

- **Centerline file to Write dialog** Enter the .CL file name to create
- **Centerline station [Reverse/Ending/<Beginning: 0+00>]:** Press Enter to accept the default station value specified or Type in the beginning station then press Enter
- **Select polyline that represents centerline:** Pick the polyline that represents your centerline

**Draw Centerline File**

This command reads a centerline (.CL) file and plots it as a 2D polyline in the drawing at the proper coordinates. First you are prompted for the layer name for the polyline to be created. There is also an option to specify whether to draw PI lines and specify their length. The Label Centerline option draws station labels using a .STA settings file.
Next you are prompted for the file name of the centerline to plot.

The .CL file can be made with the following commands on the Design menu: **Polyline to CL File, Input-Edit Centerline or Design Centerline**. Drawing the centerline file is a way to check the .CL file data graphically for correctness. If a spiral exists in the .CL file, the spiral will be represented by polyline segments.

**Prompts**

- **Draw Centerline Options dialog**
- **Centerline File to Draw file selection dialog** Select the .CL file name to read and plot.

**Pulldown Menu Location:** Centerline  
**Keyboard Command:** cl2pline  
**Prerequisite:** a centerline file

**Centerline Report**

This command reads a centerline file and creates a report in the standard report viewer which can be written to a file, a printer, or to your drawing. If the centerline file contains point numbers, then the report will include these point numbers. If station equations are found, they are noted at the top of the report. The options dialog has settings for the report format and type of the centerline. The Use Profile for Elevations Report option will prompt you for a profile (.pro) file to add elevations to the report. The Report At Interval option will report stations, northing and easting at the specified station interval. The Use Report Formatter option lets you choose the report format and has output options for Excel. Also, the Report Formatter enables an expanded report with options for Report 2nd Centerline and Include Geodetic Report. The Report 2nd Centerline uses the second centerline for reporting offsets. The Geodetic Report adds geodetic distances and bearings to the report. It requires the grid projection to be defined in Drawing Setup.
Here is an example report:

Centerline Report
Centerline File:  C:\sample\setback_3.cl

Station Northing Easting Bearing Distance
0+00.000 4033.165 4379.271
N 13°07'20'' W 92.076'
0+92.076 4122.836 4358.367 PC
Radius:  4196.621 4674.880 Radius Length:  325.000'
PI: 4159.044 4349.926 1+29.254 Tangent:  37.178'
Arc Len: 74.035' Delta: 13°03'07'' Right Degree: 17°37'46''
Chord Len: 73.875' Chord Brg: N 06°35'47'' W
Radial-In: N 76°52'40'' E Radial-Out: N 89°55'47'' E
Tangential-In Tangential-Out
1+66.110 4196.222 4349.881 PT

Pulldown Menu Location: Centerline
Keyboard Command: clreport
Prerequisite: A centerline (.CL) file

Centerline ID

Centerline ID reports the centerline file name and location that is associated with an alignment polyline. The subject polyline must have been created with either Design Centerline, Input/Edit Centerline, or Polyline to Centerline File. When the routine is initiated and an alignment polyline is selected, the file associated with that polyline is reported at the command line. Additional alignment polylines may be selected without re-entering the command, or Enter may be pressed to exit the command.

Prompts

Select centerline polyline to identify: pick the polyline
Centerline Name: D:\SAMPLE.CL
Select centerline polyline to identify (Enter to end): press Enter
Station Polyline/Centerline

This command will station a polyline or centerline file at a given interval distance. The options for this command are set in the dialog shown below. After setting the options, click OK on the dialog and then pick the polyline or select the centerline file. All settings can be saved as (.STA) files and loaded for reuse, and for storing multiple stationing schemes. Polyline/Centerline station labels are also dynamic, and so will update when changes are made in the geometry.

- **Distance for Stations** is the primary interval for stationing. On Curve allows for a different interval for curve segments verses line segments.

- **Distance for Intermediate Stations** is the intermediate interval for stationing. On Curve allows for a different interval for curve segments verses line segments.

- **Beginning Station** is the beginning station of the centerline for stationing.

- **Locate Even Stations** labels the stations at the distance interval (i.e. 2+00, 3+00, etc.).

- **Locate Odd Stations** labels the non-interval stations at the polyline/centerline end points and PC and PT points.

- **Locate User-Entered** prompts you for individual stations to label.

- **Locate Start/End Stations** labels the Start and End Station as specified when the option Specify Start/End Stations is enabled.
Without the **Increment Station Labels from Beginning** Station option, the program increments the station labels from zero. For example, if the station interval is 100 and the polyline starting station is 145, then the program will label 2+00, 3+00, etc. With this option active, the station labels are incremented from the starting station. In this example, the program would then label 2+45, 3+45, etc.

**Label Deflection Angles** adds deflection angles to centerlines without arcs. Settings for this are specified in the **Label Deflections Setup**, accessed by the Deflections Setup button.

![Label Deflections Setup](image)

**Include Station** sets the station name as None, Prefix or Suffix to the deflection angle. **Station Prefix** and Suffix are added to the Station Label. **Use MText** option will create the deflection angle and associated text as Mtext. **Fields on separate rows** will place each line of text on a separate layer. **Label North/East** option adds a Northing and Easting coordinate to the PI location. **Use Symbol for Delta Angle Label** adds a triangular shaped symbol as a prefix to the deflection angle. **Deflection Label Position** controls the position of the label as Perpendicular, Horizontal or Parallel.

When **Specify Start/End Stations** is checked, only the stations between and including the specified starting and ending stations will be labeled. If locate centerline points and offset points are toggled on, only points within the specified stations will be located.

When **Erase Previous Station Labels** is checked, previous station labels are erased when new ones are generated.

The **PC/Spiral Setup PC** button accesses the **PC/Spiral Setup** dialog, where settings are controlled for lines and/or symbols and/or labels at the starting and ending (PC and PT) stations of an arc of the centerline as well as for the spiral special stations (TS, SC, CS, ST).
Label on Radial Lines controls whether to draw a perpendicular line and label the station.
Label On Centerline when checked, the station of the PC and PT will be labeled on the centerline as well as the PC and PT lines. When not checked only the PC and PT lines will be labeled.
Draw PC Symbols controls whether symbols are placed at these locations. If checked, the desired symbol is selected by picking on the symbol box.
Label PC Radius controls whether this point is labeled.
Max PC Length controls the maximum length for the PC lines to be drawn described above.
Position controls the placement of the PC and PT labels as either the midpoint of the PC line or at a user defined offset from the centerline.
Prefix/Suffix: Each special station has a prefix/suffix string that can be added to the station label.
Curve Table Settings controls which elements will be labeled or placed in a data table for both arcs and spirals as shown in the Curve Table Setup dialog box.
**Draw Arc Table** when enabled, creates and draws a table containing the arc information selected. **Delta Angle, Radius, Length and Total Tangent**.

When **Label PI Stations** is checked, the PI station is labeled at the PI point.

When **Locate PI Points** is checked a point will be created at the PI of a horizontal curve graphically and written to the active coordinate file.

When **Label Station Text** is checked, this command places station text along the polyline at the angle of the corresponding segment. After toggling this option on, the Label Setup button will become available for selection.

The **Label Setup** controls the placement, precision, font and size of station labels along the centerline.

The **Label Setup** dialog box shown below allows the user to set various options for labeling station text along the centerline.

- **Text Layer** is the user-specified layer for text labels to be drawn on.
- **Text Style** is the user-specified text style for labels.
- **Text Size Scaler** determines the size of the station labels. This value multiplied by the horizontal scale setting in Drawing Setup results in the size of the label. For example, if the horizontal scale is set to 100 and the text size scaler is set to 0.10, the station labels will be 10 units.
- **Text Offset Scaler** works like text size scaler above controlling the distance the text labels will be offset from the centerline.
- **Station + at Tick Mark** labels the station text along the polyline with the ‘+’ of the station text at the station’s location on the polyline. See Marker Set up for marker size manipulation settings.
- **Horizontal Offset** shifts the station label along the centerline.
- **Use MText** controls whether to create the labels as MText or regular Text entities.
- **Draw on Real Z Axis** creates the labels and tick marks at elevation when using a 3D Polyline for the centerline.

**Label Intermediate Stations**: If the intermediate distance is the same as the station distance then no intermediate station ticks or labels will be drawn. For example, with the above entries and 0+00 for the first station the stations will be labeled with descriptions as follows: 0+00 0+50 1+00 1+50, etc.

If the **Flip Text For Twist Screen** setting is checked and the drawing has been twisted using the twist screen command, the label text will be flipped to read in the proper direction of the stationing.

**Station Units** when set to Miles divides the station values by 5280 for creating the station labels. When set to
Kilometers, it divides the station values by 1000 for the labels.  
**Station Prefix** adds to the front of the station labels.  
**Remove Zeros** removes the specified number of least significant digits from the station label if these digits are all zero.  
**Label Northing/Easting of Starting Point** adds this label information, including prefixes and/or suffixes as specified.  
**Decimals** determines the number of decimal places of the stationing labels to be drawn for the odd stations and user entered stations only.

Use **Label Stations** to specify whether to label the stations perpendicular or parallel to the centerline.

Specify the **Position** of the station labels, either above or below the centerline. This is only available when labeling stations using the parallel option is enabled.

**Align** determines the alignment of the station label, either left or centerline, centered along the centerline or to the right of the centerline. This option is only available when using the perpendicular option for station labels.

The **Marker Setup** options control the size of markers for different station types as well as the layer the markers will be drawn on.

The **Marker Layer** specifies which layer the station marks will be placed.

**Use Label Layer** option sets the label for the markers to be the same as that of the labels as set above.  
The **Half Size Main Marker**, **Half Size Intermediate Marker** and **Half Size Odd Marker** options draw a perpendicular tick mark on only one side of the centerline. Otherwise a full marker is drawn that goes on both sides of the centerline.  
**Draw PI Lines** option will draw a line in the direction of both tangents, in and out of the PI at the size designated in the **PI Lines Size**.

Specify whether to define the **Centerline By** picking a 2D polyline or 3D polyline in the drawing or selecting a centerline (.CL) file.

- Using a **2D Polyline** will result in horizontal distance stationing along the polyline.
- Using a **3D Polyline** will result in the slope distance stationing along the polyline.
- Using a **CL File** will result in horizontal distance stations as with the 2D Polyline option only a prompt for the centerline to use will display.
Use **Station Type** to specify the stationing format to use.

Use **Type of Curves** to specify whether you are labeling a roadway curve (arc definition) or railroad curve (chord definition).

**Locate Centerline Points** will locate points and store them in the current CooRDinate file.

**Locate Radius Points** will locate the radius points of any arc segments.

**Starting Point Number** determines the starting point number for the points to be located.

**Vertical Exaggeration** applies to Profile Polyline mode. This factor is the ratio between the horizontal and vertical scales on the profile grid.

There are two ways to **Set Elevations** for the centerline points and offset points to be created.

- The **3D Polyline** option gets the elevation of the point from a specified 3D Polyline within the drawing.
- The **Profile** option will determine the elevation of the point based upon the same station in the profile file. You will be prompted for the profile file to read for the elevation reference.
- With the **None** option selected, no elevations will be determined for the points.

When **Include Station in Description** is checked, the station along the centerline will be included in the resulting offset point description field.

- **Left Prefix** or Suffix is added to the left offset label
- **Right Prefix** or Suffix is added to the left offset label
- **Decimals** controls the label precision
- **Description Prefix** is an optional user-specified prefix to be added to the point description.
- **Description Suffix** is an optional user-specified suffix to be added to the point description.
When **Label Sta Equations** is checked on any station equation, contained in a centerline (*.cl) file will be labeled. This option is only available when stationing a centerline file (*.cl).

**Locate Offset Points** will create points at the specified left and right offset distances from the centerline. Options for setting the elevations and descriptions of the points are available from the Offset Setup dialog.

![Offset Setup Dialog](image)

**Use Polylines** allows you to select an offset reference polyline  
**Left** and **Right** offsets allow a user defined offset amount  
**Percent Slopes** allows you to project an offset grade based on a slope from the corresponding centerline points.  
**Vertical Offset** allows you to define a separate vertical offset for the left and right horizontal offsets.  
**Bisect Deflection Angles** controls how the offsets are located at angle points. When enabled, two offset points both 90 degrees from their respect centerlines are located.

**Label Super Elevation:** This option labels the super elevation transition stations as defined in the specified .SUP file. You can choose which types of the transition stations to label and set the prefix for each type.

![Super Elevation Label Setup](image)

Use **Select** to select a super elevation file (.SUP). This file is created as part of the Roads Menu contained in the Civil Module.

**Prompts**

**Station Polyline Dialog**  
Polyline should have been drawn in direction of increasing stations.
Select polyline that represents centerline: select a polyline

Closeup of Station + at Tick Mark option

Labels with Label PC on Centerline checked on

Labels set to perpendicular and Max Length of PC lines set to 75.0
Labels with Draw PI Lines, Label PI Stations and Locate PI Points all checked on

Labels using Centerline By 2D Polyline (Horizontal Station)

Labels using Centerline By 3D Polyline (Slope Station)

Pulldown Menu Location: Centerline
Keyboard Command: stapl
Prerequisite: A polyline or CL file

**Label Station-Offset**

This command will compute and label the stations, offsets and elevations of selected points or entities. Additional labels for the names of the reference alignments and point data (point name, northing, easting, latitude, longitude, description) can also be specified and placed.

A common usage for using dual alignments and profiles typically involves the alignment and profile of a road coupled with the alignment and profile of a pipe/utility.
1st/2nd Alignment: Specify the criteria for either one or two alignments that will be used for the label(s) that will be placed into the drawing.

Use 2nd Alignment: Enable this toggle if multiple alignments are to be used for the label(s) that will be placed into the drawing.

Name: Supply a label-friendly value for the name of the alignment (e.g. "King Street" or "Water Main"). The value(s) specified get assigned to the Alignment Label Field.

Centerline: Indicate the source (Polyline or Centerline File) for the reference alignment. If the Polyline option is selected, you will be prompted to select the polyline(s) after the OK button is pressed. If CL File option is selected, supply a valid path and file name for the centerline file or navigate to the file using the "File Picker" button. The Beginning Station will be determined from the selected Centerline File.

Beginning Station: Specify the beginning station of the centerline. The polyline should be drawn in the order of increasing stations. This control is not used when you use a centerline (.CL) file to define the centerline as the starting station of the centerline is stored in the .CL file.

Vertical Reference: Indicate the source (3D Polyline, Profile File, Road Network or Surface File) for the reference elevation. With a Vertical Reference, there are label fields to label the Elevation Reference and Cut/Fill. With 3D Polylines, there will be an additional Slope Station available under the Label Fields in addition to the regular horizontal distance station. If the Profile option is selected, supply a valid path and filename for the profile file or navigate to the file using the "File Picker" button shown above. For the Road Network, specify the road network (.rdn) file with the "File Picker". With the Road Network method, the program will find the road design surface elevation for the specified points using all the road network design files including profiles, templates and transitions. For Surface File, the program will prompt for selecting a triangulation or grid surface model.

Cross Slope (%): Indicate the slope as a percentage to "travel" from the Vertical Reference. A value of 0 (zero) will not apply any cross slope from the reference elevation. Positive values will decrease the calculated elevation(s) and negative values will increase the calculated elevation(s).

Vertical Adjustment: Indicate the desired amount of vertical displacement that should applied to the calculated elevation. This is useful when deriving elevations for back or face of curb.
**Label Alignment:** Specify whether the labels should be Horizontal on the screen, Vertical on the screen, Parallel to the Centerline, Perpendicular to the Centerline, or user-specified by Picking.

**Label Brackets:** Options to draw brackets around the labels with different styles including Square, Parenthesis, Arrow and Curly. The Single, Double and Triple options are for how many brackets to draw.

![Bracket Example](image)

**Text Placement Options:** Controls how the leader is drawn with the label. The Above/Below Leader method draws the leader along the label. The After Leader draws the leader up to the label.

![Text Placement Options](image)

**Text Size Scaler:** Determines the size of the labels. This value multiplied by the horizontal scale setting in Drawing Setup results in the size of the label. For example, if the horizontal scale is set to 100 and the text size scalar is set to 0.10, the labels will be 10 units.

**Text Offset Scaler:** Controls the distance between the leader and the label.

**Text Offset Scalar:** Determines the scalar to offset top, and or bottom label(s) from the label line base point (i.e. the end of the leader line). This value is multiplied by the horizontal scale setting in Drawing Setup to determine the on screen label(s)’ text offset up/down. (NOTE: Only available when top, and or bottom label(s) text is offset up, and or down. Not available when drawing labels as MLeader objects)

**Text Style:** Specify the desired text style for the label.

**Use MLeader:** Creates an MLeader which combines the leader with the label.

**Leader Segments:** Specify the desired number of leader segments that should be allowed when constructing the label.

**Use Relative Leader:** Indicate whether successive labels placed into the drawing should re-use the geometry of the initial leader placed with the command.
**Draw Leader Arrow:** Indicate whether to draw an arrowhead on the leaders.

**Draw Line From Centerline:** This option draws a perpendicular line between the point and the centerline. The Setback Offset option shortens the line and makes gaps at the centerline and point ends. The Set Label Adjacent option places the label along this line instead of at the leader endpoint.

**Draw At Fixed Position:** After you pick the first label position, the rest of the labels will be placed at this same level. This option applies to the Vertical and Horizontal Label Alignment methods.

**Label Fields:** Use the green arrow buttons to specify the items that are to appear in the labels. As labels are "moved" from Available to Used, a Label Format dialog box particular to the label will appear that will allow for more precise display control. To subsequently edit each item, use the Format Editor button as shown below.

![Label Format dialog box](image)

**Note:**

- The Row Number value is specified as the row starting closest to the leader with subsequent rows moving further from the leader as shown in the figure below. Row 2 below the leader has been illustrated with the Draw Box option enabled.

\[
\text{Row 4} \\
\text{Row 3} \\
\text{Row 2} \\
\text{Row 1} \\
\text{Row 1} \\
\text{Row 2} \\
\text{Row 3} \\
\text{Row 4}
\]

**Layers:** Specify the layer of each item that comprises the label.

**Max Offset to Calc:** Specify the maximum offset to calculate.

**Truncate Station at +:** Removes the digits before the + in the station labels.
Station Type: Specify the stationing format to use.

Station Units: When set to Miles divides the station values by 5280 for creating the station labels. When set to Kilometers, it divides the station values by 1000 for the labels.

Add to Existing Point Description: When picking points to label by point #, this option appends the label to point description instead of creating a text label. The description is updated both in the coordinate file and for the point description attribute in the drawing.

Flip Text for Twist Screen: When this option is enabled, the label(s) text will be flipped as necessary to adjust for the use of Twist Screen. When this option is disabled the normal, and forward direction of the Centerline will be used to determine an up direction for drawing the label(s) text. Applicable to Perpendicular, Parallel, and Pick Label Alignment.

Offset Tolerance: For points with an offset greater than the specified tolerance, this option puts the labels in a separate layer. This option is a way to highlight points with offsets more than the tolerance. The separate Offset Tolerance layer can be setup to use a different color.

Type of Curve: Specify whether the centerline is for a roadway or railroad. Stationing for Roadway Curves is measured along the curve length itself whereas stationing for Railroad Curves is measured along chord segments.

Save: Allows the current settings to be saved to a Station-Offset Settings (*.sos) file.

Load: Allows settings from a previously saved Station-Offset Settings (*.sos) file to be recalled for use.

Prompts

Polyline should have been drawn in direction of increasing stations.
Select Polyline Centerline (Alignment-1): Pick the polyline centerline This prompt will not appear if the Centerline File option was specified.
Select 3D Polyline Profile (Alignment-2): Pick the polyline profile This prompt will not appear if the Profile File option was specified.
Pick point or point numbers (SS for Selection Set,G for Group,Enter to End): Pick a point
Pick point to label: Pick a leader vertex point
Pick label alignment: Pick angle for the label This prompt will only appear if the Pick option was specified.
Pick point or point numbers (SS for Selection Set,G for Group,Enter to End): Press Enter

Real-time display of Station and Offset as you move the cursor.
A sample label with a 2-segment leader.

**Pulldown Menu Location:** Centerline  
**Keyboard Command:** offsta  
**Prerequisite:** A polyline or centerline file

---

**Offset Point Entry**

This command creates points along a centerline at specified stations and left and right offsets. The centerline can be defined by a polyline, centerline (.CL) file or two points.
The Output option to Coordinate File will store any points the current coordinate (.CRD) file. This includes centerline points and offset points. The option to Draw will draw the new points using the settings from Points > Point Defaults.

When Locate Points on Centerline is checked, the program will locate points along the centerline, otherwise just the offset points will be created.

When Label Stations & Offsets is checked, the program will label the station-offset as the point description attribute.

The Include Station-Offset In Description option will add the station and offset of the point into the point description.

**Beginning Station:** Enter the Beginning Station of the Centerline.

Use Centerline from to specify whether to define the centerline by picking a polyline in the drawing, selecting a centerline (.CL) file, or using 2 points.

Use Reference Elevation to assign elevations to the points created when locating points on the centerline of offset points. When using a 3D Polyline for the elevation reference, points will be created at the station entered and the offsets specified with the elevation of the same station along the 3D polyline. The Profile option will do the same as the 3D Polyline option only it will use a profile file for the elevation reference. You will be prompted for the profile to use for the elevation reference. None simply creates 2d point data on elevation zero. The Reference Elevation option is good for creating points along the centerline for final grade elevation points. Profile to 3D polyline can be used to transfer the profile data to the polyline before calculating the final grade points.

**Cross Slope %:** This option is used to alter the elevations of the new points by applying either a Cross Slope calculation or a Delta Z variable.

The Manual Entry option in Input Station-Offset from will prompt for the station and offset distances. The Read File option will read the stations and offsets from a text file. The text file format with point number, station, offset, elevation and description. The program handles station formats with or without the '+' (i.e. either 250 or 2+50). The elevation and description are optional. The Read File option is a quick routine to convert a station-offset data file into coordinates. The delimiter for the text file and the order of the fields are set in the dialog shown here.
When Offset Prompt is set to Both Left-Right, the program will prompt for left and right offsets. If you respond to an offset prompt with zero (0), no offset point is created. The Single Offset option will prompt for one offset per station. Enter a right offset with a positive value and a left offset as a negative value. The Multiple option keeps prompting for offsets at the current station until you enter a blank offset. This option applies when you have more than one offset to create on the left or right side.

Use Station Type to specify the stationing format to use.

Use Type of Curve to specify whether the curves are for a roadway or railroad.

Prompts

Offset Point Settings Dialog
Polyline should have been drawn in direction of increasing stations.
Select Polyline near endpoint which defines first station.
[nea on] Select Polyline to Station-Measure: select a polyline
(5309.0 4845.0) Station: 0.00
(5526.0 4917.0) Station: 228.63
Distance from beginning station along centerline (Enter to end): 110
Starting Segment Station: 0.0 Ending Segment Station: 228.633
Working Line segment...(5413.4 4879.64 0.0)
Left offset distance <10.0>: 15
Right offset distance <15.0>: 20
Distance from beginning station along centerline (Enter to end): press Enter

Keyboard Command: offpts
Prerequisite: A centerline (.CL) file, polyline, or two points

Calculate Offsets

This command calculates the station and offsets of point coordinates relative to a centerline. The points to calculate can be stored in a coordinate (.CRD) file or picked on the screen. As the crosshairs are moved, the station and offset of the current position are displayed in real-time in a small window (see example). After entering the points
to calculate, the program prompts for selecting another centerline which is optional in case you want a report for multiple centerlines.

**Beginning Station:** Specify the beginning station of the centerline. The polyline should be drawn in the order of increasing stations. Not available when you use a centerline (.CL) file to define the centerline.

**Maximum Offset to Calc:** This is the maximum distance from the Centerline for which offsets are calculated.

**Report Offsets Ahead/Behind Centerline:** When checked, this option shows offsets for points or picked points located before the beginning station and after the ending station of the centerline.

**Label Station and Offsets:** When checked, the station offsets will be labeled in the drawing.

**Label Cut/Fill:** When using a reference elevation from the Report Grade Elevation setting, this option labels the cut/fill between the reference elevation and the points.

**Cut/Fill In Inches:** Sets the precision for reporting cut/fill when using inches or whether to report in decimals.

**Sort Report by Stations:** When checked, this option will report the station-offsets in station order no matter what order the points were calculated.

**Report Point Coordinates:** When checked, this option will include the point northing and easting in the report.

**Report Point Notes:** When checked point notes will be included on the calculate offset report.

**Create Point Notes:** When checked, the station and offset of the offset point will be created as notes and written to a note file (*.not). This note file will have the same name as the crd file.

**Use Report Formatter:** When checked, the output of this command is directed to the Report Formatter which allows you to customize the layout of the report fields and can be used to output the data to Microsoft Excel or Microsoft Access. You must check this option on in order to use the Report Grade Elevation From option.

**Round Stations:** When checked, this option will round the stations for the selected points on the report to the Rounding Interval specified. For example if an offset point is located at station 1+01, and the rounding interval is set to 10, then the report will show the offset point at station 1+00.
Store Station Text to CRD File: When checked, the station offset text is appended to point numbers that are selected.

Report Grade Elevation From: When checked, this option will calculate an elevation for each point from a 3D polyline, grid file (.grd) or triangulation (.flt) file. To Use this option, the Report Formatter must be toggled on. The grade elevation is reported and compared with the point elevation to report the cut/fill. For the 3D polyline option, the grade elevation is calculated by finding the elevation at the point on the 3D polyline that is the nearest perpendicular position from the offset point. The 3D polyline that is used for elevations does not need to be the same polyline that is used as the centerline for the station-offset calculations.

Define Centerline by: Specify whether to define the centerline by picking a polyline in the drawing, selecting a centerline (.CL) file, by a point and direction angle, or using 2 points. The polyline mode can be either 2D or 3D for horizontal or slope distance stationing.

Station Type: Specify the stationing format to use.

Decimals: Specify the display precision for the stations and offsets.

Type of Curve: Specify whether the curves are for a roadway or railroad.

Prompts

Calculate Offset Settings Dialog
Polyline should have been drawn in direction of increasing stations.
Select Polyline near endpoint which defines first station.
[nea on] Select Polyline Centerline: select polyline centerline
(5309.0 4845.0) Station: 0.00
(5526.0 4917.0) Station: 228.63
PtNo. North(y) East(x) Elev(z) Description
140 4889.13 5410.25 0.00 1+10.00L10.00
Station on Line > 1+10.00 Offset > 10.00 Left
PtNo. North(y) East(x) Elev(z) Description
141 4870.15 5416.55 0.00 1+10.00R10.00
Station on Line > 1+10.00 Offset > 10.00 Right
+ before station denotes point is ahead of line segment, - denotes beyond.
Pick point or point numbers (Enter to End): 22-28

Pick point or point numbers (Enter to End): press Enter

Pulldown Menu Location: Centerline
Keyboard Command: calcoff
Prerequisite: A centerline (.CL) file, polyline or two points

Distance Between Two Entities

This command reports the average, minimum and maximum distances between two entities. For example, this command can be used to find the minimum distance between a right-of-way polyline and a property perimeter.
polyline. The supported entities include polylines, lines and arcs. The reports the coordinates along the two entities at the minimum and maximum distances. There is an option to dimension the minimum or maximum distances.

![Image of polylines and distances](image)

**Prompts**

Select first polyline, line or arc: pick a polyline  
Select second polyline, line or arc: pick a polyline  
Distance Between Two Entities results dialog

**Pulldown Menu Location:** Centerline  
**Keyboard Command:** minmax2  
**Prerequisite:** Two entities

**Centerline Conversions**

There are twelve Import options available in Carlson Software to convert other applications' centerline files to Carlson centerline files (.CL), and five Export options to convert Carlson centerline files (.CL) to other applications' formats. Each Import option prompts for the file to convert and the name of the new .CL file to create. Each Export option prompts for .CL file to convert and a file name for the new file.
Keyboard Commands: geod2cl, geopak2cl, geopak2rd, wildcl2, moss2cl, sdms2cl, dcac12, sdr2cl, ali_to_cl, pla_to_cl, importrd5, tm2cl, wildcl1, smic11, dcac11, cl2sdr, tdscl1

Chapter 13. Centerline Menu
Area/Layout Menu

This chapter provides information on using the commands from the Area/Layout menu to calculate and label areas, and also to set and define lots. Commands for designing and drawing more complex configurations, such as cul-de-sacs and intersections, are available here as well.

- Area Defaults...
- Inverse with Area (IA)
- Area by Lines & Arcs
- Area by Interior Point
- Area by Closed Polylines
- Area Utilities
- Area Tables
- Area Descriptions

- Adjust Areas
- Layout Utilities

- Lot Network Settings
- Lot Network Boundary
- Lot Network Sub-Areas
- Lot Network Roads
- Lot Network Linework
- Lot Network Areas
- Lot Network Labels
- Lot Network Utilities

- Set Lot File
- Create Lots
- Lot File Manager
- Lot File Utilities
Area Defaults

This command allows you to specify default settings for area labeling. The Area Defaults dialog is divided into 3 tabs. The first is the Label Fields and Settings tab. The top portion of the Label Fields and Settings tab contains two listboxes which are used to control which of the possible ten area fields will be used for area labeling. You use the Add and Remove buttons to control which fields will be included in area labels. You can also add to the Used Fields list by doubleclicking on items in the Available Fields list. The area label will include the values in the order as specified in the Used Fields listbox. To change the order you use the Move Up and Move Down buttons.

When a grid projection is defined in Drawing Setup, the Available Fields with include geodetic areas where the areas are adjusted by the projection. The Base Z from Drawing Setup is used for the elevation factor for this adjustment.

Field Settings Dialog: To control the appearance of the fields in the drawing, use the Edit button to edit the highlighted item in the Used Fields list, or double click on a field in the same list. This will call up the Field Settings Dialog.

User Defined: The Field "User Defined" can be added to place a custom fixed label in all areas. To control the value and appearance of the custom label in the drawing, use the Edit button to edit the "User Defined" item in the Used Fields list, or double click on a field in the same list. This will call up the Field Settings Dialog. In this case the "Value" setting becomes the custom label.
Scaled labels: The "Scaled Sq. Feet", "Scaled Sq. Meters", "Scaled Acres" and "Scaled Perimeter" fields can be used to include area labels that are scaled based on Drawing Setup "Report Scale Factor".

Text Style: This allows you to set a text style for the area labels. You can enter the name manually or use the Select Style button to call up a dialog which presents a list of known text styles.

Text Size: This value is multiplied by the horizontal scale to obtain the actual text size.

Text Layer: This allows you to assign a layer for the area text. You can enter the name manually or use the Select Layer button to call up a dialog which presents a list of known layers.

Text Color: This allows you to assign a color for the area text. Use the Select Color button to call up the standard color picker dialog. To use the default for the Text Layer, select ByLayer.

Prefix and Suffix: Although most area labeling uses the suffix, as in 1.25 Acres or 3.515 Hectares. But for those who prefer a prefix, as in Ac: 1.25, this routine can create that area labeling style automatically (see below for example of results of using a prefix with square feet and acres).

Justification: Use this to control whether the label field is left, centered or right justified.

+/-: This allows you to display + or - in the Prefix or Suffix of the area labels, or choose None.

Precision: Choose precision level for the currently selected field.

Below the Available and Used Fields lists the following items for further controlling area label generation:

Use Commas in Labels: This allows you to use commas in the area labels.

Use MText: Check this box to turn on the use of MText for area labels. If this is checked all area labels will be grouped into as few MText entities as possible. Area labels with different text styles, justification or layers will not be combined into the same MText entity.

Erase Previous Labels: When checked, previous area labels for the area being relabeled will be erased.

Label Placement: When auto placement of area labels is used, the labels can be placed either at the centroid of area or at the rear side. This is accomplished by selecting either the Center or Rear Side radio button, respectively. When Center is selected the user can choose to have the labels oriented according to the side lines of the area by checking the Align By Sides checkbox. When either Align By Sides or Rear Side is selected, the checkbox Flip Text for Twist Screen can be selected to have the label rotated 180 degrees to present it in the best reading orientation relative to the current Twist Screen rotation setting.

Draw Symbol Around Lot Description: When the Lot Description field is included in the Used Fields list, the user can check this checkbox to have a symbol drawn around the Lot Description field. When this box is checked, you specify the symbol name in the Symbol Name field or click on the current symbol (drawn to the right) to graphically choose the desired symbol. You specify the layer by entering the name in the Layer box or by clicking on the Select button to choose from a dialog that presents all known layers.

Symbol Buffer Offset: By default, the symbol will be automatically scaled according to the text length and size of the Lot Description value for the area. For additional control of symbol scaling, the user can enter a number in text size units in the Symbol Buffer Offset box. This value will be added to the automatically generated default scaling value.

Avoid Label Overlap: If this box is checked the area labels will be checked for overlaps after they are generated. Please see the Overlap Manager documentation for more information.

Overlap Settings: Click this button to go to the Avoid Label Overlaps dialog where you can review or modify the Overlap Manager settings. Please see the Overlap Manager documentation for more information.
Table Process Settings Tab:

**Use Area Tables:** Use this control to determine whether area labels are sent to a table or not. Options are "Never", "Always" or "By Scaler".

**To Table Area:** When the user has selected "By Scaler" in the "Use Area Tables" list this item is enabled. When "By Scaler" is selected and the area is less than this minimum, the area label is sent to a table.

**Area Reference Numbering:** There are three different methods for setting the reference number: *Next Available* will automatically use the lowest available number. *Specified With Prompt* will prompt you for a number for each area. *Specified with Auto Numbering* will automatically use the lowest available number starting with the specified number.

**Auto Place Table References:** When checked, will automatically place the area reference label according to the settings for the area labels as specified in the Label Field and Settings tab (see above). Otherwise you will be prompted to pick each label location manually.
Area Commands Tab:

Max gap to join: You use this option during Area by Lines & Arcs command. When connecting lines and arcs that define the perimeter, the program will join endpoints if the distance between the two points is less than the specified gap. Otherwise the program will report an error and will not report an area.

Prompt whether to retain polylines created by Area by Interior Point: When checked the user will be asked whether to retain the polylines created by the "Area by Interior Point" command.

Polyline Layer: Will be enabled when "Prompt whether to retain polylines created by Area by Interior Point" is checked to allow the user to select the layer that any such created polylines will be placed in.

Load/Save: These buttons save and recall all the Area Default settings to a .ARS settings file.

Tip: Keep in mind that changes in Area Defaults, if changed from the Area/Layout pulldown menu, only apply to that work session. If changed within the Configure command, the changes apply to all new work sessions as well.
The results of using a prefix with square feet and acres

Pull-down Menu Location: Area/Layout

Keyboard Command: defarea

Prerequisite: None

**Inverse with Area**

This command generates a report of the angle and horizontal distance between a series of points and calculates the area of the closed figure defined by the points. The points can be entered individually or by selecting a point group or linework entities. To use a point group, type G for Group at the first prompt. To use a linework, type L for Line at the first prompt. For linework, a single closed polyline can be used or a series of connected lines, arcs and polylines that are selected one at a time.

Curve data can also be entered and reported. The points can be either picked on the screen, or entered by point number. You can also enter a range of point numbers (i.e. 1-9). The closure is reported using the total distance inversed, and the difference between the starting and ending points, as the closure error.

At the first command prompt, you can enter O for Options to bring up the command options. The **Input Method** determines the default input mode for the first command prompt. The **Different Radius Tolerance** checks that the distance between the PC and radius point and the PT and radius point match for curves. The **Linework Snap Tolerance** applies to the linework input mode and is used to check the distance between end points when connecting two linework entities. The Report Closed By choosing between using the difference between the starting and ending coordinates to calculate the closure error or angle and distance values in the report. The **Apply Compass Rule Adjustment** will adjust the perimeter as a closed loop for the closure error. The **Label Both Feet And Meters** is an option to report the distances in both feet and meters. The **Report Stations** option adds stations for each point into the report. The **Use Report Formatter** chooses between the standard report or customizing the report. You can also set the decimal precisions for the report and whether to report stations for the distances along the perimeter. This command creates a polyline of the figure which can be erased or kept in the drawing. The **Prompt To Draw Perimeter Polyline** and **Polyline Layer** settings apply to this polyline.
The area can be labeled in the drawing using the settings from the *Area Defaults* command. If you don't want to label the area, press Enter at the pick label point prompt.

**Prompts**

Options/Line/Group/ *<Pick Starting point or point number>*: *pick a point*
Pick point or point numbers (R-RadiusPt,U-Undo,Enter to end): *pick a point*
Pick point or point numbers (R-RadiusPt,U-Undo,Enter to end): *R* for radius
Radius point number or pick point: *pick a point*
Curve direction [Left/<Right>]? *press Enter*
Pick End of Arc or point number (U-Undo,Enter to end): *pick a point*
Pick point or point numbers (R-RadiusPt,U-Undo,Enter to end): *pick a point*
Point number (R-RadiusPt,U-Undo,Enter to end): *pick a point*
Point number (R-RadiusPt,U-Undo,Enter to end): *press Enter*

SQ. FEET: 27247.4 SQ. YARDS: 3027.5 SQ. MILES: 0.0
ACRES: 0.63 PERIMETER: 668.35
Pick area label centering point: *pick a point*
Erase Polyline Yes/No *<Yes>*: *press Enter* The command plots a polyline that represents the figure you defined if you want to keep the polyline respond with No.
Inverse with Area
CRD File> c:\data\newplat.crd
PNTNO BEARING DISTANCE NORTING EASTING STATION DESC
903 4940.73 2490.40 0.00 StartPt S 48°43'58'' W 136.21 904
Closure Error Distance> 0.0000
Total Distance Inversed> 1008.07
AREA: 74664.6 SQ METERS

Pulldown Menu Location: Area/Layout
Keyboard Command: ia
Prerequisite: None

Area by Lines & Arcs

This command allows you to calculate the area of a perimeter or lot defined by lines, arcs, or polylines. Default settings for this command are set in Area Defaults. One of these settings is Max gap to join. If there is a gap greater than this value, the area is not reported, and the program will show where the gap is with a temporary X symbol. The area data shows up on the text screen. You can then choose to plot the area information to the drawing, or, by hitting Enter, just read it from the text screen.

Prompts

Select lines & arcs or polylines of perimeter for area calculation.
Select Objects: select lines and arcs or polylines
Lines and arcs are then joined together and the area calculated.
Pick area label centering point (Enter for none): pick a point
The area is then plotted at the point selected.
Area by Interior Point

This command calculates and labels the area of the perimeter surrounding a picked interior point. The *Boundary Polyline* command is used to find the perimeter. Generally, this command will only work on closed or overlapping objects. Use *Area by Lines & Arcs* for other applications. The settings for the area label and for whether to prompt to create a closed polyline for the area are under the *Area Defaults* command.

**Prompts**

- **Pick point inside area perimeter:** *pick a point*
- **Pick area label centering point (Enter for none):** *pick a point*

The area is then plotted at the point selected.

**Pulldown Menu Location:** Area/Layout
**Keyboard Command:** ptarea
**Prerequisite:** Set Area Defaults

Area by Closed Polylines

This command will calculate and report the area of single area and multiple area closed polylines. In the case of multiple areas, the user can choose to have the areas totaled (*Total Multiple Areas*) into a single result or to generate data for each area separately. *Area by Closed Polyline* will also automatically find special Carlson attributes attached to the polyline, in addition to capturing the area itself. These attributes will appear in the report, which can be the standard report or which can be presented in the Report Formatter, which itself links to Excel and Access. For example, property names and owner names, as applied to a polyline using the Mine modules, will report out automatically using Area by Closed Polyline. The command "Draw Lots from File..." will apply "extended entity data" to the lot polylines, which includes the lot name, and this will also report out when using Area by Closed Polyline. In addition, lot names, or any interior text whatsoever, can be captured and included in the report. The plot of the area on-screen can be canceled if only the report is desired.
Prompts

Select Area Polyline: *select the area polyline*

SQ. FEET: 64862.9 SQ. YARDS: 7207.0 SQ. MILES: 0.0
ACRES: 1.5 PERIMETER: 1018.7
Pick area label centering point (Enter for none): *pick a location*

When auto-placing labels at the rear of lots or when aligning labels by the sides of the lot the user will also be prompted to pick one or more centerlines (*Select the Centerline Polylines*). The routine will find the closest centerline and use this to determine the location of the front and back corners of the area.

When additional interior text is selected, the standard report will include that text:

**Polyline Area 11/17/2004 12:49**
Polyline Area: 43560.0 sq ft, 1.00 acres
Polyline Perimeter: 838.35 ft
Text: 16 Sf: 43560.0; Ac: 1.00

In this case, the "16" refers to Lot 16, and appears in the report because the lot number and existing area labeling were selected along with the polyline for the lot.
Pulldown Menu Location: Area/Layout
Keyboard Command: plarea
Prerequisite: Set Area Label Defaults

Area Utilities

Digitize Areas

This command allows for digitizing areas. This routine includes an option for drawing perimeter polylines.

![Digitize Areas dialog box]

Pulldown Menu Location: Area/Layout
Keyboard Command: dig_area
Prerequisite: A digitizer

Label Last Area

This command will label the last area calculated with one of the Area commands in the manner defined in the Area Defaults dialog. The command prompts for a point where the label will be centered.
Prompts

SQ. FEET: 50265.3 SQ. YARDS: 5585.0 SQ. MILES: 0.0
ACRES: 1.2 PERIMETER: 889.4
Lot Description <2>: 1
Pick area label centering point (Enter for none): pick a point

Pulldown Menu Location: Area/Layout
Keyboard Command: lastarea
Prerequisite: Set Area Defaults, and use one of the Area commands to calculate an area.

Area Tables
New Area Table
This command draws the column header labels for the Area Table commands. When prompted for the starting point, the user may enter a coordinate or pick a point on the screen. This table becomes the active area table. Any new area table entries will be added to this table until another table is created or the active table is changed with the atabset command (menu item Area/Layout > Area Tables > Set Active Table).

| Area   | Perimeter | Sq. Feet | Acres | Lot Description |

Prompts
Starting point of area table: pick point
Pulldown Menu Location: Area/Layout > Area Tables > Create New Table
Keyboard Command: atabnew Prerequisite: None

Set Active Area Table
This command allows the user to change the active area table. The table selected becomes the active area table. Any new area table entries will be added to this table until another table is created or the active table is changed with another invocation of this command.

Prompts
Select active Table: *pick area table*

Pulldown Menu Location: Area/Layout > Area Tables > Set Active Table

Keyboard Command: atabset

Prerequisite: None

**Edit Area Table Properties**

This command allows the user to edit the properties of an area table.

**Prompts**

**Select an area table to modify: *pick an area table***

After picking an area table the Area Defaults dialog will be displayed. Here you can change the settings of the selected table. The changes will be reflected once the user selects the OK button.

![Area Defaults dialog](image)

The Table Fields tab contains the Available Fields and Used Fields listboxes which are used to control which of the possible ten area fields will be used in the area table. You use the Add and Remove buttons to control which fields will be included in the table. You can also add to the Used Fields list by double-clicking on items in the Available Fields list. The area label will include the values in the order as specified in the Used Fields listbox. To change the order you use the Move Up and Move Down buttons.

**Field Settings Dialog:** To control the appearance of the fields in the table, use the Edit button to edit the highlighted item in the Used Fields list, or double click on a field in the same list. This will call up the Field Settings Dialog.
**Column Title:** This will be the tile name used for the field's column in the area table.

**Text Style:** This allows you to set a text style for the area labels. You can enter the name manually or use the Select Style button to call up a dialog which presents a list of known text styles.

**Text Size:** This value is multiplied by the horizontal scale to obtain the actual text size.

**Text Layer:** This allows you to assign a layer for the area text. You can enter the name manually or use the Select Layer button to call up a dialog which presents a list of known layers.

**Text Color:** This allows you to assign a color for the area text. Use the Select Color button to call up the standard color picker dialog. To use the default for the Text Layer, select ByLayer.

**Prefix and Suffix:** Although most area labeling uses the suffix, as in 1.25 Acres or 3.515 Hectares. But for those who prefer a prefix, as in Ac: 1.25, this routine can create that area labeling style automatically.

**Justification:** Use this to control whether the label field is left, centered or right justified.

**+/-:** This allows you to display + or - in the Prefix or Suffix of the area labels, or choose None.

**Precision:** Choose precision level for the currently selected field.

**Column Width/Auto:** The default behavior is that the column width is automatically set for best fit. The user can override this value by unchecking the Auto checkbox and setting the column width in text size units.

The **Table Settings** tab brings up the Table Settings panel shown below.

---

**Total Area on Last Row:** Select this to have a total row placed at the bottom of the table which will contain the sum of all relevant table fields.

**Label Layer:** Use this to control the layer that the area table reference will be placed in. Use the Select button to pick from a list of all known layers.

**Label Color:** Use this to control the color of the area table reference. Use the Select button to pick from a color picker dialog. Select ByLayer to use the default color of the label layer.

**Area Label Prefix:** Use this to control the prefix of the area table references. Add a space after the prefix to have
the prefix and the reference number separated by a space if desired.

**Label Text Style:** Use this to set the text style of the area table reference. Use the Select button to pick from a list of all known text styles.

**Table Layer:** This allows the user to set the layer that the table will be placed in. Use the Select button to pick from a list of all known layers.

**Table Color:** This allows the user to set the color of the grid lines of the table. Use the Select button to pick from a color picker dialog. Select ByLayer to use the default color of the table layer.

**Area Table Title:** To add a title row as the first row of the area table, enter a table title here.

**Title Text Color:** This allows the user to set the color of the table title. Use the Select button to pick from a color picker dialog. Select ByLayer to use the default color of the table layer.

**Title Text Style:** Use this to set the text style of the table title. Use the Select button to pick from a list of all known text styles.

**Title Text Size:** Use this to control the size of the table title text.

**Background Colors:** The area table is broken into 5 zones in respect to background color. Each zone can have its own unique background color. The zones are Title, Header, Contents1, Contents2 and Total. To set a background color for each zone, first the respective "Use Table...Background Color" box must be checked. This enables the Select button, which is used to pick the respective background color from a color picker dialog. For the Contents zone all contents rows can either have the same background color, or by setting up an "Alternating Background Color", rows will have alternating colors.

**Load/Save:** These buttons save and recall all the Area Default settings to a .ARS settings file.

**Tip:** Keep in mind that changes made here only apply to the selected table. If properties are changed within the Configure command, the changes apply to all new work sessions as well.

---

**Pulldown Menu Location:** Area/Layout > Area Tables > Edit Properties

**Keyboard Command:** atabedit

**Prerequisite:** An area table

---

**Remove Area Table Rows**

This command allows the user to remove rows from an area table. The routine will remove both the table row and the table reference label from the drawing.

---

**Prompts**

Select a table row to delete: *pick area table row*

Consolidate table [<Yes>/No]? If consolidation is chosen, row numbers will be renumbered to close up the gap created by this deletion. Consolidation will also update all relevant area table references in the drawing. If the user chooses not to consolidate the table at this time, the atabfix command (menu item Area/Layout > Area Tables > Consolidate Table) can be used at any time to perform consolidation.

<table>
<thead>
<tr>
<th>Area</th>
<th>Perimeter</th>
<th>Sq. Feet</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>470.70</td>
<td>9157.63</td>
</tr>
<tr>
<td>A2</td>
<td>629.20</td>
<td>15572.47</td>
</tr>
<tr>
<td>A3</td>
<td>542.18</td>
<td>16810.50</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>41540.60</td>
</tr>
</tbody>
</table>

The drawing above shows the table before row removal. In the drawing below, row 2 has been deleted without table consolidation.
The drawing below shows the results of deleting the same row 2, only this time the user has chosen to perform table consolidation.

<table>
<thead>
<tr>
<th>Area</th>
<th>Perimeter</th>
<th>Sq. Feet</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>470.70</td>
<td>9157.63</td>
</tr>
<tr>
<td>A2</td>
<td>542.18</td>
<td>16810.50</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>25968.13</td>
</tr>
</tbody>
</table>

**Pulldown Menu Location:** Area/Layout> Area Tables> Remove Row

**Keyboard Command:** atabel

**Prerequisite:** None

## Area Table Defaults

This command allows you to specify table fields and format settings for area tables. Whether the Area Commands create an area table or label within the area is controlled by the Area Defaults command by the Use Area Tables setting. With the Area Defaults and Area Table Settings prepared, the various Area Commands will create tables according to the settings. When the Area By Closed Polylines routine is used to create the area table and the Link Linework With Labels option is on under Configure Carlson->General Settings, then the area table values are automatically updated when the polyline geometry is modified. Also, when using the Area By Closed Polylines command with the Lot Description field active for the table, the program prompts for an area description for each polyline. The rest of the area table fields are calculated from the polyline geometry.
The Area Table Defaults dialog is divided into 2 tabs. The Table Fields tab brings up the Table Settings panel shown below. The area table option puts the area data in a table that is typically drawn outside the area and contains area data for multiple areas. Each row in the table has the data for one area and includes a reference number. The reference number is also labeled inside the area.

![Area Table Defaults dialog](image)

The Table Fields tab contains two listboxes which are used to control which of the area fields will appear in any table rows that are generated for areas. You use the Add and Remove buttons to control which fields will be included in area tables. You can also add to the Used Fields list by double-clicking on items in the Available Fields list. The area table will include the values in the order as specified in the Used Fields listbox. To change the order you use the Move Up and Move Down buttons.

**Field Settings Dialog:** To control the appearance of the fields in the table, use the Edit button to edit the highlighted item in the Used Fields list, or double click on a field in the same list. This will call up the Field Settings Dialog.

![Field Settings dialog](image)

**Column Title:** This will be the tile name used for the field's column in the area table.

**Text Style:** This allows you to set a text style for the area labels. You can enter the name manually or use the Select Style button to call up a dialog which presents a list of known text styles.

**Text Size:** This value is multiplied by the horizontal scale to obtain the actual text size.

**Text Layer:** This allows you to assign a layer for the area text. You can enter the name manually or use the Select Layer button to call up a dialog which presents a list of known layers.

**Text Color:** This allows you to assign a color for the area text. Use the Select Color button to call up the standard
color picker dialog. To use the default for the Text Layer, select ByLayer.

**Prefix and Suffix:** Although most area labeling uses the suffix, as in 1.25 Acres or 3.515 Hectares. But for those who prefer a prefix, as in Ac: 1.25, this routine can create that area labeling style automatically.

**Justification:** Use this to control whether the label field is left, centered or right justified.

**+/-:** This allows you to display + or - in the Prefix or Suffix of the area labels, or choose None.

**Precision:** Choose precision level for the currently selected field.

**Column Width/Auto:** The default behavior is that the column width is automatically set for best fit. The user can override this value by unchecking the Auto checkbox and setting the column with in text size units.

The **Table Settings** tab brings up the Table Settings panel shown above. The area table option puts the area data in a table that is typically drawn outside the area and contains area data for multiple areas. Each row in the table has the data for one area and includes a reference number. The reference number is also labeled inside the area.

**Table Parameters:**

**Total Area on Last Row:** Select this to have a total row placed at the bottom of the table which will contain the sum of all relevant table fields.

**Label Layer:** Use this to control the layer that the area table reference will be placed in. Use the Select button to pick from a list of all known layers.

**Label Color:** Use this to control the color of the area table reference. Use the Select button to pick from a color picker dialog. Select ByLayer to use the default color of the label layer.

**Area Label Prefix:** Use this to control the prefix of the area table references. Add a space after the prefix to have the prefix and the reference number separated by a space if desired.

**Label Text Style:** Use this to set the text style of the area table reference. Use the Select button to pick from a list of all known text styles.

**Table Layer:** This allows the user to set the layer that the table will be placed in. Use the Select button to pick from a list of all known layers.

**Table Color:** This allow the user to set the color of the grid lines of the table. Use the Select button to pick from a color picker dialog. Select ByLayer to use the default color of the table layer.

**Area Table Title:** To add a title row as the first row of the area table, enter a table title here.
Title Text Color: This allow the user to set the color of the table title. Use the Select button to pick from a color picker dialog. Select ByLayer to use the default color of the table layer.

Title Text Style: Use this to set the text style of the table title. Use the Select button to pick from a list of all known text styles.

Title Text Size: Use this to control the size of the table title text.

Background Colors: The area table is broken into 5 zones in respect to background color. Each zone can have its own unique background color. The zones are Title, Header, Contents1, Contents2 and Total. To set a background color for each zone, first the respective "Use Table...Background Color" box must be checked. This enables the Select button, which is used to pick the respective background color from a color picker dialog. For the Contents zone all contents rows can either have the same background color, or by setting up an "Alternating Background Color", rows will have alternating colors.

Pulldown Menu Location: Area/Layout->Area Tables
Keyboard Command: defatab
Prerequisite: None

Consolidate Area Table
This command allows the user to renumber area tables to eliminate numbering gaps left as the result of row deletions or other means.

Prompts

Select a table to consolidate:: pick area table
Row numbers will be renumbered to close up the gaps in the selected area table. Consolidation will also update all relevant area table references in the drawing.

<table>
<thead>
<tr>
<th>Area</th>
<th>Perimeter</th>
<th>Sq. Feet</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>470.70</td>
<td>9157.63</td>
</tr>
<tr>
<td>A3</td>
<td>542.18</td>
<td>16810.50</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>25968.13</td>
</tr>
</tbody>
</table>

The drawing above shows the table before row removal. The drawing below shows the results of consolidating this table.

<table>
<thead>
<tr>
<th>Area</th>
<th>Perimeter</th>
<th>Sq. Feet</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>470.70</td>
<td>9157.63</td>
</tr>
<tr>
<td>A2</td>
<td>542.18</td>
<td>16810.50</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>25968.13</td>
</tr>
</tbody>
</table>

Pulldown Menu Location: Area/Layout-> Area Tables-> Consolidate Table
Keyboard Command: atabfix
Prerequisite: None
Area Description

Tag Area Descriptions
This command is used to assign a description to a closed polyline. The description is stored with the polyline in the drawing. This description is used for reports in routines like Area By Closed Polylines.

Prompts

Select polyline for area description: pick a polyline
Area description <AREA1>: West Pond

Pulldown Menu Location: Area/Layout > Area Descriptions
Keyboard Command: tag_area_desc
Prerequisite: A closed polyline.

Identify Area Descriptions
This command reports area descriptions for the selected polylines. There are two methods. The Pick method reports the area description for one selected polyline at a time. The Search method scans the whole drawing and highlights polylines with area descriptions.

Prompts

Pick polylines to check or search drawing [<Pick>/Search]: press Enter
Select area description polyline: pick a polyline
Description: West Pond
Select area description polyline (Enter to end): press Enter

Pulldown Menu Location: Area/Layout > Area Descriptions
Keyboard Command: id_area_desc
Prerequisite: A polyline with a tagged area description.

Untag Area Descriptions
This command removes an area description that has been assigned to a polyline.

Prompts

Select polylines to remove area description from.
Select entities: pick area polylines
Cleared 10 area descriptions.

Pulldown Menu Location: Area/Layout > Area Descriptions
Keyboard Command: untag_area_desc
Prerequisite: A polyline with a tagged description.
Adjust Areas

Hinged Area

This command can be used to determine the dimensions of a figure when the area is fixed and three or more sides are known. The figure can be defined by a closed polyline or by picking the known points and curves. The command then prompts for the area to be solved for (in square units and acres).

Prompts

**Define area by points or closed polyline [Points/<Linework>]?**  
**press Enter**

**Select polyline segment to adjust:**  
**select a polyline segment**

**Select hinge point [endp]:**  
Move the cursor around to find a hinge point.

**Keep existing polyline [Yes/<No>]?**  
**N**

**Area:**  
47104.31 S.F, 1.0814 Acres

**Remainder/Acres/<Enter target area (s.f.)>:**  
48000

Sliding Side Area

This command adjusts one side of a polyline to meet a specified area. The existing area can be defined by a closed polyline or by picking each point in the perimeter. The desired area can be entered in either square feet or acres. The area to adjust must be represented by a closed polyline. The program moves the selected segment of the polyline in or out. There are a few methods for defining the direction of the adjusted segment. With the Selected method, the original direction of the segment is maintained. The Line method prompts to pick another line segment to define the direction. The Angle method uses an entered angle for the direction. The Points method prompts for two points to define the direction.

Prompts

**Define area by points or closed polyline [Points/<Linework>]?**  
**press Enter**

**Select polyline segment to adjust:**  
**pick a point on a closed polyline**

**Keep existing polyline [Yes/<No>]?**  
**press Enter**

**Define new line by selected line, another line, angle or points [<Selected>/Line/Angle/Points]?**  
**press Enter**

**Area:**  
176044.14 S.F, 4.0414 Acres
Define area by points or closed polyline [Points/<Linework>]? press Enter

**Prompts**

**Area Radial from Curve**

This command swings a line radial from a curve to reach a predetermined area. The existing area can be defined by polylines or by picking each point on the perimeter. For the point method, the curve to radiate from should be the last entity selected when defining the figure. For the polyline method, front and back polylines are used. The computed line goes perpendicular from the front polyline and intersects the back polyline. This line is moved to find the target area. Both ends of the front and back polylines are connected to close the area. The options for the polyline method are set in the dialog shown.

**Pulldown Menu Location:** Area/Layout

**Keyboard Command:** ssarea

**Prerequisite:** A closed perimeter polyline

Lot Area: 9000.00 S.F., 0.2066 Acres
**Point Method**

**Polyline Method**

**Pulldown Menu Location:** Area/Layout

**Keyboard Command:** arearc

---

*Chapter 14. Area/Layout Menu*
Bearing Area Cutoff

Prerequisite: An existing area defined by points or polylines

This feature allows you to cut a predetermined area from a closed figure using a cut-off line having a specified bearing. The boundary intersected by the cut-off bearing line can be either a straight line or arc.

Enter area in ACRES [Sq. Feet/Done] <0.000000>: Enter the number of acres contained within the cut-off area.

To change from acres to square feet, type S and <Enter>.

Note: if units are set to meters, the prompt will be:

Enter area in HECTORS [Square meters/Done].

Enter bearing of cutoff line <100.000000>: Enter the bearing of the cut-off line through the property using Qdd.mmsss format.

where:
Q = quadrant (1 = NE, 2 = SE, 3 = SW, 4 = NW)
dd = degrees
mm = minutes
sss = seconds (The third s indicates that, if desired, you can optionally specify seconds to the nearest 0.1 second)

Note: Trailing zeros need not be entered.

Place area to right or left of bearing line [Right/Left] <R>: "Looking" in the direction of the cut-off bearing allows you to determine which side is left or right. Type R and <Enter> or just <Enter> for right. Type L and <Enter> for left.

Method of defining the overall area to be divided [C&G Point-group/Manual-entry] <M>: Type "P" and Enter if you wish to use a point group to specify the overall area or type "M" and Enter (or just press Enter) to specify the overall area interactively.

Defining the overall area using a C&G Point Group:

If you have a C&G Point Group that defines the area to be divided and you choose to use the point group option, you will then be asked to use a file dialog to browse to the point group file and select it.

Defining the overall area manually:

If you choose to type or pick the points defining the overall area individually, you will see the prompt:

Enter point ID or pick graphically [cLockwise/ccW/Polyline]: Specify a point ID or begin a curve by typing L or W. Type P and enter to pick a polyline.

Note: if you choose to pick a polyline, it must be a closed polyline and all its vertices must have coordinates matching points found in the coordinate file.

When specifying individual points, move around the parcel and pick or type in the points, in order, to define the overall area involved.

After all points have been entered, press Enter to end point input.

Calculate the Cut-off Line

Chapter 14. Area/Layout Menu
No matter which method you use to specify the property being divided, once the overall tract is specified, the cut-off line is calculated and the points at which the cut-off line intersects the tract boundaries are saved.

The **Saving Point** dialog (below) will be shown for each intersection point.

![Saving Point Dialog](image)

Click the **OK** button to save the intersection point.

Depending on your settings for **Auto Line Plot** and **Auto Point Plot** on the **Graphics** tab of the **C&G Options** dialog box, you may see both the points and the cut-off line drawn on the screen.

This process can be repeated as many times as is necessary to further divide the overall area or to divide another area. Press <Esc> or "D" at the Enter area... prompt to end the command.

**Prompts**

**Enter area in ACRES [Sq. Feet/Done] <0.000000> :**
Enter the number of acres contained within the cutoff area or type "S" and Enter to use square feet or "D" and Enter when done.

**Enter bearing of cutoff line <100.000000> :** Enter the bearing of the cut-off line through the property.

**Place area to right or left of bearing line [Right/Left] <R> :**
Type "R" and Enter or just Enter for right of line. Type "L" and Enter for left. The direction of the cut-off bearing determines which side is left or right.

**Method of defining the overall area to be divided [C&G Point-group/Manual-entry] <M> :**
Type "P" and Enter if you wish to use a point group to specify the overall area or type "M" and Enter (or just press Enter) to specify the overall area interactively.
for Manual entry:
**Enter point ID or pick graphically [c]lockwise/[ccW]/Polyline**: Specify the point ID or begin a curve by typing L or W. Type P and enter to pick a polyline.

**Pulldown Menu Location**: Area/Layout

**Keyboard Command**: baco

**Prerequisite**: Coordinate file.

## Layout Utilities

### Lot Layout

This command draws lots based on a front and back polyline. Starting from the front polyline, the program calculates two lot side lines perpendicular from the front polyline that intersect the back polyline and create the specified lot size. Lots are created along the front polyline in the order that the front polyline is drawn. If the front polyline needs to be reversed, use the *Reverse Polyline* command found on the Edit menu. The direction of the back polyline does not matter. The lots can be drawn as closed polylines or just the lot sides can be drawn. There is also an option to automatically create all the possible lots at the specified area between the front and back polylines or to prompt for each 0.4 acre lot.

In prompt mode, the program reports the remaining area between the front and back polylines and then asks for the lot size. The lot size can be specified either by area or frontage along the front polyline.

The lots are sized to meet the specified area and also meet the minimum frontage and backlot distances. The program starts by checking the lot area at the minimum distances. If this area is greater than the target, then the lot is drawn at the minimum distance and the resulting lot area will be greater than the target area. Otherwise the program will increase the frontage until the lot reaches the exact target area. The *Use Frontage Setback Polyline* option allows you to use another polyline besides the actual frontage polyline for the minimum frontage indicator. Typically, this Frontage Setback Polyline would be offset a set amount from the actual frontage polyline.

![Lot Layout dialog](image)

### Prompts

**Lot Layout dialog**

**Select front polyline**: *pick a polyline*
Select back polyline: pick a polyline
With prompt for each lot active:
Area remaining: 160326.88 S.F, 3.6806 Acres
Quit/Frontage/Enter lot area (Acres) <1.2269>: 1
Area remaining: 116766.88 S.F, 2.6806 Acres
Quit/Frontage/Enter lot area (Acres) <1.0000>: F
Enter Frontage <50.00>: 75
Lot Area: 37807.50 S.F, 0.8679 Acres
Area remaining: 78959.38 S.F, 1.8127 Acres
Quit/Area/Enter frontage <50.00>: A
Quit/Frontage/Enter lot area (Acres) <1.0000>: press Enter
Area remaining: 35399.38 S.F, 0.8127 Acres
Quit/Frontage/Enter lot area (Acres) <1.0000>: Q

Polylines for Lot Layout
The Front Polyline goes from right to left

Resulting lots numbered using Sequential Numbers

Pulldown Menu Location: Area/Layout
Keyboard Command: lotlay
Prerequisite: A frontage polyline and a backlot polyline.

Cleanup Lot Linework
This command finds any overshoots or undershoots in the lot linework. The Report Errors mode will report the location of the errors in the standard report viewer. The Circle Errors mode will draw circles on the specified layer around the errors. The you can use CAD functions to review these errors and make edits. The Adjust Linework mode makes the program automatically adjust the linework coordinates to remove the errors as long as the coordinates move less than the specified Tolerance.
Example of overshoot where lot line goes past intersection

Example of undershoot where lot line falls short of intersection

**Prompts**

Cleanup Lot Linework dialog
Select polylines to process.
Select objects: pick polylines

Pulldown Menu Location: Area/Layout > Lot Layout Utilities
Keyboard Command: lotclean
Prerequisite: Linework
Set Linework Angles To Nearest Second

This command adjusts the coordinates of lines and polylines to set their bearings to the nearest second. This routine eliminates decimal seconds for the linework. Here's an example inverse showing decimal seconds on a line before running this routine.

Northing(Y) Easting(X) Elev(Z)
7054276.3676 11519401.0186 0.0000
7054104.6344 11519556.5360 0.0000
Bearing: S 42d09'47.5207'' E Horizontal Distance: 231.6850115

Here's the inverse showing the bearing to the nearest second on the line after running this routine:

Northing(Y) Easting(X) Elev(Z)
7054276.3673 11519401.0182 0.0000
7054104.6344 11519556.5360 0.0000
Bearing: S 42d09'48.0000'' E Horizontal Distance: 231.6850115

Prompts

Select lines and polylines to process.
Select objects: pick lines and polylines
Adjusted 1 polylines.
Maximum distance shift 0.000538

Pulldown Menu Location: Area/Layout > Lot Layout Utilities
Keyboard Command: pl2sec
Prerequisite: Linework

Set Linework Intersections To Perpendicular

This command processes a set of polylines to find any T-intersections and adjusts the polyline coordinates for any polylines that are not exactly perpendicular. A use for this routine is to select a right-of-way polyline and connected lot polylines that are meant to be perpendicular. To check polylines without adjusting, use the Edit > Polyline Utilities > Check Polylines > Highlight Non-Perpendicular Intersections command.

Prompts

Select polylines to check.
Select objects: pick polylines
Adjusted 1 polylines to make perpendicular.

Pulldown Menu Location: Area/Layout > Lot Layout Utilities
Keyboard Command: pl2perp
Prerequisite: Polylines

Offsets & Intersections

This command takes a set of centerline polylines and calculates the series of offset polylines using the user defined offset and fillet radius values. The function recognizes primary and secondary roadways which allows for different
offsets and fillet radii to be specified for each. Up to seven sets of offsets and radii can be defined for different features such as edge of pavement, right-of-way, sidewalk, etc. Each set also has a layer name and description. The Pick button lets you set the layer name by picking an entity with that layer in the drawing. The description is for your own information and is not used by the program.

Multiple centerline polylines can be processed together which allows for the creation of an entire set of roadway offset polylines in one step. Intersections are calculated based on the centerlines selected and the fillet radii are applied at the intersections. The Smooth Interior and Exterior Corner options will fillet bends in the offset polylines. Otherwise turns without an arc in the original centerline will become straight corners in the offset polylines. The results of the calculations for the given parameters may be previewed in the dialog. Zoom and pan are available by clicking and dragging mouse on the preview image (zoom or pan mode is selected by a toggle). Once the satisfactory offsets are calculated, they are inserted into the drawing by clicking on Finish2D button. The Finish 3D button opens the *Elevate 2D Polylines* command, described in this chapter.

If it is preferable to handle intersections manually, you may run the command multiple times on non-intersecting centerlines. Another alternative is to use the *Offset* command in the Draw menu and the *Fillet* command in the Edit menu.

![Offsets and Intersections dialog]

**Prompts**

Select all PRIMARY road polylines.  
Select objects: *select polylines*  
Select objects: *Enter*  
Select all SECONDARY road polylines.  
Select objects: *select polylines*  
Select objects: *Enter*  
Calculating offsets for layer EOP...  
Calculating offsets for layer ROW...

**Pull-down Menu Location:** Area/Layout  
**Keyboard Command:** `wayint`
Prerequisite: Centerline polylines

Cul-de-Sacs
This command uses a polyline centerline and the offset polylines to create a cul-de-sac. These offset polylines can be generated by the Offsets & Intersections command, or with the standard Offset command. The layer names of the offset polylines must match the layer names set in the dialog.

To run this command, pick a set of polylines and point on roadway centerline where the cul-de-sac center is. For cul-de-sacs with an offset center, pick a projection of that center onto the centerline and specify an offset distance (positive value is offset to the right, negative - to the left). Like the Offsets and Intersections command, a preview is shown of the cul-de-sac being designed. Any of the cul-de-sac parameters may be modified and reviewed before the cul-de-sac is applied and the drawing is modified with the Finish 2D button. The Finish 3D button opens the Elevate 2D Polylines command described in this chapter.

Bend cul-de-sacs are created by selecting offset entities on one side of the centerline.

Prompts

Select all offset polylines to end with cul-de-sac.
Select objects: make selections

Pulldown Menu Location: Area/Layout
Keyboard Command: stdcul
Prerequisite: A set of offset polylines and roadway centerlines.

Elevate 2D Polylines
This command allows to assign elevations to a selection of polylines based on elevations along supplied 3d centerline and user-defined slopes. This routine calculates a distance from each vertex of 2D polyline to a specified 3D reference polyline and uses that distance and slope to calculate a 3D offset to a corresponding point on 3D polyline.

You can specify either the original centerline to be a reference 3D polyline or use another set of offset polylines. For example, you could specify the edge of pavement elevation to be relative to the curb elevation, while curb elevation is calculated based on the centerline elevation. You can view the resulting road/intersection design in 3D,
making changes and updating picture on-the-fly. Local sink points can be reported instantly by evaluating a resulting triangulation to predict low points in the design leading to water retention.

Prompts

Select all offset polylines for the intersection.
Select objects: select entities
Select all 3D profile polylines.
Select objects: select entities

Pulldown Menu Location: Area/Layout
Keyboard Command: 3dintersect
**Prerequisite:** A set of offset polylines and roadway centerlines

### Parking

This command draws a series of parking stalls. The command prompts for stall width and length, stall parking angle, and side for stalls. Stalls can be located by the number of stalls in a direction, as many as fit between two points, or along a polyline.

#### Stall Layout Method:

- **The Number of Stalls method** creates the specified number of stalls at a fixed stall width along an alignment. The Fit By Width creates as many stalls as can be fit on an alignment between the specified Min and Max Stall Width. The Fit By Number is the same as Number of Stalls except the stall width is adjusted to span the full alignment with the stalls.

- **Min Stall Width:** Indicate the minimum width a stall can be when the Fit on Alignment option is specified.

- **Max Stall Width:** Indicate the maximum width a stall can be when the Fit on Alignment option is specified.

- **Stall Width:** Indicate the stall width when the Number of Stalls option is specified.

- **Number of Stalls:** Indicate the desired number of stalls when the Number of Stalls option is specified.

- **Stall Length:** Indicate the desired length of each stall.

- **Angle of Parking:** Controls the angle of the stalls from the alignment.

- **Line Width:** Sets the line width property of the parking lines. Using a Line Width helps with viewing the parking lines in the 3D Viewer.

- **Adjust Length for Angle Method:** When the stalls are not perpendicular, this setting controls whether the stall length is measured along the stall line or as the perpendicular offset from the curb alignment.
Side for Stalls: Indicate the side to which the stall lines should be placed. The Left and Right sides are relative to the direction of the baseline. Use the Pick option to screen pick the side for the stalls.

Stall Placement Method: Indicate the method by which the stall direction should be determined whether it be between two picked points or along an existing graphical alignment.

Draw Baseline: This option draws a baseline in addition to the stall side lines.

Draw Handicap Marker: This option draws a handicap symbol.

Draw Baseline

Locate on Real Z Axis: Controls whether the stall lines are created at zero elevation or the elevation of the alignment.

Draw Label: This option labels the number of stalls using the Text Size Scaler, Label Prefix and Suffix settings.

Layer: Specify the layer on which parking lines should be placed or click the Set button to choose an existing layer.

Prompts

Starting Point?
Pick point or point number: Pick a point

Ending Point?
Pick point or point number: Pick a point

Created 10 stalls.

Pulldown Menu Location: Area/Layout > Layout Utilities

Keyboard Command: parking

Prerequisite: None

Draw Lot Setback

This command draws closed polylines inside lots to represent the building setback offsets. Before running this command, the lots need to be draw as closed polylines. The command starts with a dialog for entering the setback offsets and the layer for the new setback polylines.

There are two methods for the program to define the edges of the lot as front, side, back or corner. For the Use Reference Centerline method, the Front to CL Max Offset is used to determine which lot edges are frontage. The program will prompt to select CL reference polylines and lot edges that are within this offset from these CL polylines are considered frontage edges. For the By Pick method, the program prompts to select the setback type for each lot edge. Only the By Pick method has the option for the Corner Setback type.
The Round Corners option will round the setback polyline using a radius of the setback offset amount for corners with an interior angle over 180 degrees.

The Front Setback is applied to the lot frontage edges. The Side Setback offset is applied to lot edges that have only one of their ends within the frontage offset. The Back Setback offset is applied to all other lot edges.

Prompts

Lot Setback Polyline dialog
Select reference centerline polylines.
Select objects: pick the polylines
Select lot polylines to setback.
Select objects: pick the polylines

Pulldown Menu Location: Area/Layout
Keyboard Command: lot_setback
Prerequisite: Lot and CL polylines
Footprint Creator

*Footprint Creator* is a command that allows for the creation of a library and placement of building footprints. The command is run from the Area/Layout menu and found in the Layout Utilities sub menu. The command inserts footprint drawings and uses the layering scheme in them to place the footprints with options. *Footprint Creator* allows the person producing plans to include optional aspects of designs such as; locating the garage left or right and including details such as driveways. Labeling tools are provided should it be desired that elements of the footprints are called out in the plans.

**Command Operation**

![Footprint Creator dialog](image.png)

The command starts with a dialog that allows for the selection of a footprint by a number of characteristics. These are region, model and elevation. Placement of the garage is able to be left or right. Labeling of model and elevation can be enabled or disabled. There is also a message board function that allows for team members to share information with each other about use and updates to footprints. For operation of the command select Next.
Footprint drawings may contain optional elements to be included upon placement. In this case an option is a master suite. This is read from the source drawings layering convention, layers containing "-OPT" display as options. To place an option select it by single clicking and choose the Add button. To remove it select it from the Selected Options pane and then select the Remove button. The Remove All button does just that and allows you to restart the selection of options.

Additionally, Iterate All Options if toggled along with the final creation method of Place on Building Pads will place and all options and combinations of all options. This option only has an effect if Place on Building pads is chosen.

The Label Options toggles will annotate the options either by leader, create table or both.

Use the Back button should you realize a different footprint is needed.

Select the Next button to select further options.
Porches and Bay Windows

The source drawing's layering scheme is used to allow for the placement of porches and bay windows. The command reads the drawing and displays any porches or bay windows available. The layer schemes for porches and bay windows are any of the following; "##-OPT-000-COVERED LANAI", "##-OPT-000-PORCH" "##-OPT-155" or "##-OPT-156". If none are included this pull down will be blank.

Excavation Lines

Excavation lines are also read from the source drawing. The layer scheme for excavation lines is "##-EXC". If none are included this pull down will be blank.

Driveways and Sidewalks

The source drawing can also include driveways. The layer scheme for driveways is "##-DW" and for sidewalks is "##-SW". Again, if none are present in the drawing this pull down will be blank.

Add Special, Remove Special, Remove All

The Add Special, Remove Special and Remove All buttons will add the option selected for the corresponding list. Remove them individually or remove them all.

Create Footprint

When ready to place the footprint select Create Footprint. You will be prompted to select the method for creation.
Create

Choose the option for placement. The footprint will include an enclosure line "Plot Plan" or simply place the footprint as drawn in the source drawing "Site Plan". The Group Footprint if selected will group the Footprint entities together.

Save to File

Enter Output Drawing Name
Screen Pick Insertion Point

Pick an insertion point and the rotation for the footprint. The command will continue to prompt for insertion points until canceled allowing for multiple placements of the same model, elevation and options within the same command execution.

Place on Building Pads

For the Place on Building Pads to work properly, the footprint source drawing must be laid out properly. The insertion point of the footprint should be the front most point of the footprint with the garage on the left side. This option will prompt for the selection of Building Pads, these should be closed polylines. After selecting the building pads, the selection of Centerlines or Targets for Building Alignment will be prompted. Multiple targets may be selected and the tool will use these targets for determining the footprint front orientation.
Footprints will be placed in each building pad selected and rotated toward the selected alignment option. The footprints will be placed by edge (driveway side) or centered on the building pad. When the alignment is by centerline, the footprint will be placed perpendicular to the centerline. When alignment is by building pad it will rotated the footprint along the edge of the building pad.

![Footprint Placement Options]

<table>
<thead>
<tr>
<th>Placement Center</th>
<th>Placement Edge</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align to Centerline</td>
<td>Align to Building Pad</td>
</tr>
</tbody>
</table>

**Optional Toggles**

If no option is selected, all Models and Elevations selected on the initial Select Region, Model, Elevation and Garage page will be placed within every Building Pad.

**Best Fit Models**

This option will adjust the footprint forward and back as well as side to side until the footprint fits within the building pad. If multiple models are selected on the initial Select Region, Model, Elevation and Garage page this will attempt to fit the highest priority model/elevation on each Building Pad. Once a footprint has placed on a building pad the building pad will no longer be processed. This is used to place the highest priority models in the selected building pads.

**Place on Building Pads that fit**

Like the Best Fit Models, this will only place footprints that fit within each building pads. This option will continue to process building pads that footprint have been placed in resulting with multiple footprints within any building pad that the footprint fits within.

**Extend Driveways**

This option will prompt for Edge of Pavements for Driveway Extensions. Multiple targets may be selected, and the tool will use these targets while extending closed polylines representing the driveway. The layer scheme for the driveway extension must contain "DRIVEWAY" or "-DW". This includes the Special Optional Selections of driveways and sidewalks.

**Configure**

To configure *Footprint Creator*, select the Configure button on the first dialog. This must be coordinated with the drawings and directory structure for them for the command to work properly.
The Footprint Folder is the folder where all the sub folders for footprints will be located. The Model Data and Elevation Data Files by default will be in your Settings folder. Each footprint is stored in a folder with a name that corresponds to elements of the footprint. A footprint is included with the Carlson installation. It is 0999-Edgemont KY.dwg and is in a folder named 0999-Edgemont KY under the settings folder.

An additional model 0998-Remington KY.dwg is also included in the Carlson installation and is in a folder named 0998-Remington KY. This model has multiple elevations defined and can be accessed by choosing the Add_Model.ftm and Add_Elevation.fte files. The additional model and elevation files also include the Edgemont model and elevations.

Layers are included that are read by the command to determine which elements of the drawing are placed when the command is run.
Other layers that can be used are those related to excavation. Layers with OPT are standard Options, they must be preceded by 00- as shown "##-OPT". Layers that include the Elevation name can be selected during command operation.

**Model Data**

To create or edit Models select the Model Data button.

The Model Code is a four-digit code that will be the first four characters of the folder and drawing file name. This is followed by a dash and then the Model Name which is followed by a space and then the Region Code. The command matches the Region Code to the Region Name for display in the dialog box for Region. The Notes are purely descriptive.
Add Model Data

To add a model select the Add button.

The Model Code is four numeric characters. The Model name can be alpha or numeric. The Region Code is a two-character designation. The Region Name matches up with the Region Code and can be alpha or numeric. The notes are descriptive and are there purely to help understand information about the Model. To edit an existing model, select the Model and then select the Edit button. To save a model for modification, select the model and then select the Save As button. Should the list of models become extensive, use the Search button to locate the model desired.

Elevation Data Manager

To create or edit Elevation Data select the Elevation Data button.
The operation of this dialog is nearly identical to the Model Data Manager dialog. The Code and Name relate to layers in the source drawing.

**Pulldown Menu Location:** Area/Layout - Layout Utilities  
**Keyboard Command:** createfp  
**Prerequisite:** Footprint drawings in properly named folders with layering convention matching the command configuration.

### Set Back Measure-Move

This command can be used to measure the perpendicular distance of 1 or 2 points to 1 or 2 lines. This can be helpful in placing buildings for proper setback from lot lines. After selecting the lot lines and the building, the command allows you to drag the building while a real time display on the side-bar menu shows the perpendicular distances to the lot lines. After experimenting you can press T to type in the values to move to. The second line and point are optional.

**Prompts**

Select 1st Lot line to measure perpendicular from.  
Select object: select line  
Select 2nd Lot line to measure perpendicular from ([Enter] for none).  
Select object: select line  
Select entity to move at 1st point to measure from:  
Select object: ENDPOINT of (Pick a point on polyline.)  
Pick a 2nd point on entity to measure from ([Enter] for none). END of (Pick a point.) Pick another endpoint of the polyline representing the building.  
Drag-Pick new Location or [T]ype in Move distance(s) [C] to Cancel: T Either drag the building to a location and press the pick button on your pointing device or press T to enter the distances.  
You may have to use a negative distance to move to the proper side of lot line!  
Distance from 1st line: 10  
Distance from 2nd line: 20  
The building is then moved to your specification.
Fit Structure

The purpose of the Fit Structure feature is to place a structure (or the footprint) within a bounding polygon. For example, a house foundation - the footprint - within the limits of the setback lines of a lot - the bounding polygon.

The user can easily insert a structure footprint within a lot or bounding polygon near its final location. The footprint then it can then be conveniently rotated and/or translated, in user definable increments, to the exact position desired.

Footprint Templates

The template, a full scale definition of a structure's footprint, must be defined prior to placing it within the bounding polygon.

Templates are not AutoCAD drawings but they can be imported from AutoCAD drawings.

The data specifying the dimensions of a template is stored in a binary format and cannot be manipulated without using the Template Manager. Once a template is placed in the drawing, it becomes a C&G footprint polyline. Since it is a C&G polyline, it can be queried and manipulated using ordinary AutoCAD and CGSurvey commands.

Template Manager

The Template Manager is used to manage the templates for the various projects you work on. For example, the various house footprints used in a given subdivision can be defined as templates. The templates can then be placed in a lot in an "as" or "reverse" orientation and reused as many times as necessary. You can use the Template Manager to define templates directly or import the templates from existing AutoCAD drawings.

The Template Manager allows you to organize your templates within projects. You can name the projects in a meaningful way then import the templates into the project "folder".

When you choose the Fit Structure feature from the Cogo menu for the first time, a dialog warns you that you have no templates defined then brings up the Template Manager.

In the dialog below you will notice that there is nothing listed under the Projects item. This means that you will have to either create a template or import one from an existing drawing.
Creating a Template:

To create a new template, click the Create button. This brings up a dialog that allows you to configure the simple drawing in which you will create a template. This dialog allows you to specify the name of the project, the name of the template and asks about the approximate overall size of the template. If the structure template is made up of right angle segments you may want to specify a snap grid to aid you in laying out the template. You should be aware that the create template method should only be used for very simple templates and that it does not allow you to edit the structure once it is added to the Template Manager.
When you are done configuring the create template drawing interface, click OK and you will be see an empty AutoCAD screen upon which you can draw the template. The template is merely a closed polyline. The C&G Polyline by Points interface is used but in this case there will only be normal AutoCAD points picked (also known as graphic points designated as GR-PT). The polyline must be closed - so use the C for Close command line option for the last line segment in the template. Once you enter the Close option keyword for the polyline you are working on, the drawing window closes and the template is imported into the Template manager as shown below.
**Note:** You must click on the template name in order to see its shape in the window on the right and to choose it as the current template.

**Importing a Template**

The Create template method is only useful for very simple templates. For more complicated templates and projects with multiple structures, it is recommended that you use the Import method. To import a template you must create a separate drawing, then draw all of your templates at full scale on the layer specified for templates (see **Fit Structure Setup**).

**Create a separate template drawing**

Begin the importing of a template by creating a new drawing file as a repository for all the structure template drawings used in a specific project. For this example we will create a new drawing named Mitchell Estates bldgs.dwg. This file will only contain the structure template drawings for this project.

Select the CAD File menu then select the menu **New** item.

![Open dialog box](image)

You may be asked to choose a drawing template (not to be confused with the structural template polylines you are about to create). It is generally easiest to use the default acad.dwt drawing template but you may also specify one of your own choosing.

In this new drawing create a layer having the name specified in **Fit Structure Settings** and make this layer current. You can accomplish this by using the CAD Layer Manager. To open the Layer Manager, from the Format menu choose the Layer menu item.

In the new drawing, draw the templates (house footprints for example) you will be using in your project. A structure template must be a closed polyline and may contain arc segments.
Draw the individual house footprints. It is recommended that you use either the C&G Polyline by Points feature or use the standard CAD PLINE command - on the Draw menu choose 2D Polyline.

You could also use the C&G Quick Traverse feature to traverse around the building. However, if you use Quick Traverse to create the footprint you must then convert the C&G lines created by Quick Traverse to polyline. To do this you can use a utility on the CGTools menu, Join Nearest.

Once you have created the templates needed, close and save the template drawing file. You can come back to this drawing at anytime and add or modify templates as needed.

Note: If you change a template in the original template drawing, you must be re-imported using the Template Manager. First, use the Template Manager's Delete feature to delete the old template, then re-import the changed template from your template drawing file.

**Placing a Footprint:**

Return to the original drawing into which you wish to insert the footprint. In this example Mitchell Estates.dwg will be used to place structure footprints within lot setbacks.

Select the Fit Structure menu item.

If this is the first time you have run the command and no templates have been specified, you will be informed of this by a warning dialog. Click OK in the warning dialog and the Template Manager will come up.

If you have inserted a template prior to running this command, the following prompt will be seen at the command line:

Choose a structure template
[Set template/Current-template (Wilson)/Mirror-current/Done] <C> :

Select "S" for Set template to bring up the Template Manager.

**The Template Manager**
As mentioned earlier, the **Template Manager** is used to manage the structure templates you use for your various projects. In the left hand pane the projects and their associated templates are arranged similar to the directories in the Windows Explorer. On the right pane is a drawing showing an unscaled representation of the shape of the currently highlighted template. The highlighted template becomes the current template when you Close the Template Manager. The following describes the Template Manager functions in more detail.

**Delete button:** This allows you to delete a Project or an individual template.

**Create button:** This allows you to generate a template "on-the-fly" while in the current drawing file. This method of creating templates should only be used for the simplest of templates. In most cases it is recommended that you import pre-drawn templates from other existing drawings.

When the Create button is selected, the **Add A Template** dialog appears (shown earlier).

**Name of Project:** enter a new name or press the down arrow to select from existing projects.

**Name of Template to Add:** enter a new name or press the down arrow to select from existing projects.

**Approximate Overall Dimensions of Template:** enter an approximate length and width. Make sure this overall dimension will include the entire template so you will be given enough room to draw the template - too large is better than too small.

**Grid:**
If you wish to have a snap grid as a drawing aid when you create a template, check the **Use grid to aid in drawing the template** checkbox and set the grid interval. You need not use a grid but it is useful in creating simple rectangular templates.

Click **OK** to begin creating the template. To create the template, pick the desired locations for the various building corners. Be sure to close the structure perimeter by typing C and Enter. After closing the template polyline you will be returned to the **Template Manager**.

**Import button:**
Clicking this button allows you to import the template from another drawing file. As described earlier, you should create a separate template drawing. In that drawing draw the required templates as closed polylines. The templates may contain arcs.

When you select the Import button a dialog (shown earlier) comes up asking you to enter or select a **Project Name** and to specify the **Name of Template to Add**.

**The Project Name** can be anything you wish but is often the name of the subdivision or the client name. The template name can also be anything you wish. It should generally reflect the type or style of structure the template represents.

After filling out the project and template names and clicking **OK**, a file dialog will be displayed. Choose the drawing file you created earlier containing the template(s) you wish to import.

After closing the file dialog the template drawing will be shown and you will be asked to choose the template polyline. When you pick the template polyline its geometry is stored in a special file reserved for template information and you will be returned to the **Template Manager**.

If you highlight the newly imported template on the left hand pane it becomes the current template and you should see it displayed in the right hand pane.
If you wish to import another template just repeat these steps as many times as necessary.

By highlighting the template name it is made the current template. You may choose to mirror the current template on the Y axis by checking the Mirrored checkbox. All you need do now is click the Close button to close the Template Manager and place the footprint in the drawing.

Fit Structure Example

The following file names will be used when describing the following example:

Coordinate File: Mitchell Estates.crd
Drawing File: Mitchell Estates.dwg
Template Drawing File: Mitchell Estates bldg.dwg

Note: The template drawing file may have several templates in the same drawing file. For example you may have a subdivision with many different house footprints.

Import the templates

Open the subdivision drawing file, in this case; Mitchell Estates.dwg, and the associated coordinate file: Mitchell Estates.crd.
The subdivision drawing should already exist and you should have already defined the bounding polygons within which the structures are to be placed. These bounding polygons can be defined either by polylines (arcs are allowed) or lines and arcs. The lots and setbacks (bounding polygons) can also be defined using a C&G Point Group or Groups.

Once the subdivision drawing is open and has been prepared for the placement of structures choose Fit Structure from the menu.
If you have not run the Fit Structure command and set a current template in this drawing session, the Template Manager dialog will appear.
The first task will be to create a project and import templates from the template drawing file, Mitchell Estates bldg.dwg.
Select the Import button and fill in the project name and template name.
In this example the subdivision name is Mitchell Estates and the house model being added to the template list is the Wilson.
Next a drawing file dialog will be displayed. Highlight the template drawing file (in this case Mitchell Estates bldg.dwg) and click the Open button and use the cursor to choose the polyline representing the template to be imported.

After choosing the template polyline, you will be returned to the Template Manager. You will notice that the template you just chose has been added to the template manager under the project you selected. To see its shape and make it the current template, click the template name under the current project.
You may continue to add templates as required. Click Close to begin placing the template in the subdivision drawing.

After the Template Manager closes you will return to the main drawing and see the following prompt:

**Pick the lot within which the structure will be placed [cg-Point-group/Done] <pick>:**
Pick a polygon or a series of lines that define a closed lot boundary or setback within which you wish to place the structure. Type P and Enter to use a C&G point group file to define the bounding polygon.

**Place the structure in the bounding polygon**

Once you have specified the bounding polygon you will be asked to place the structure near its final location in the bounding polygon. Move the structure near its desired location using the mouse and click the left mouse button to place it at that location. Once you have picked the approximate location for the structure you will then be allowed to rotate and move the structure to its exact final location.

Note: If you need to adjust a template further once it has been placed within the bounding polygon and you have exited the Fit Structure command, you can run the Fit Structure command again and pick the existing structure instead of using a template.

**Adjust the structure**

After placing the structure in the bounding polygon you will see the following prompt at the command line:

**Adjust structure [Move/Step-move/step-Rotate/roTate/rot-Ninety/Parallel/On-boundary/setUp/Done] <D>:**
You are now at the stage where the structure can be adjusted to its final desired location with relationship to the setback lines and its orientation with respect to the street and other features.

In all the commands used to adjust the structure, the distances to the bounding polygon may be displayed at the appropriate corners of the template (see example below). You may turn this distance display on or off or view or change other fit structure parameters using the setUp option (type U and Enter at various the prompts).

![Diagram of a structure within a bounding polygon with distances displayed at the corners.](image)

**Move:**
Type M and Enter to "drag" the structure around using the mouse cursor - similar to when you first placed the structure in the bounding polygon. This option is only meant for moving the structure in a gross, imprecise way and thus allow you to place it near its final location. After using this option the structure can be more finely adjusted using one of the other options described here.

**Step-move:**
To move the structure up, down, left or right, using the arrow keys on the keyboard, type S and Enter. The following prompt will appear:

**Press arrow keys to move 1.000 dwg units [setUp/Done] <D>:**

Now you can use the arrow keys on your keyboard to move the structure by steps in the X and Y directions. The distance moved per keystroke is indicated at the command line - in this case the structure moves 1 unit each time you press an arrow key. To change the per step increment, type U for setUp. This brings up the **Fit Structure Setup** dialog, allowing you to change the **Translation Step** setting (see below).
Click **OK** to return to the **Adjust Structure** command line.

**Step-Rotate:**
If you type **R** and Enter for **step-Rotate** you can then use the up and down arrow keys on the keyboard to rotate the structure by small rotational steps.
The following prompt will appear:
**Use down/up arrow keys to rotate 10°00'00'' clockwise/ccw [setUp/Done] <D>:**

**Rotate:**
To rotate the structure, type **R** and Enter. The following prompt will appear:

**Rotate structure to desired orientation: [setUp] <pick>:**

Use this option to rotate the structure by moving the mouse. Left clicking will place the structure at the current rotated orientation. This method of rotation is not precise and is thus useful only for gross rotational movements.

**rot-Ninety:** Type **N** and Enter to rotate the structure 90 degrees in a clockwise direction.

**Parallel:**
Type **P** and Enter to rotate the structure so that one of its sides is parallel to a specified line segment on the bounding polygon.
First, select the side of the bounding polygon that you wish to be parallel to a selected side of the structure. Next, select the side of the structure that is to be parallel to the previously selected line on the bounding polygon. After picking the side on the structure the structure will be rotated into position.

**Note:** If the rotating the structure about its geometric center to make the selected sides parallel to one another will cause an encroachment, an error message will be displayed, no changes will be made, and you will return to the **Adjust Structure** ... prompt.

**On-boundary:**
Type **O** and Enter to choose a point on the structure that is to touch a selected point on the bounding polygon. This is accomplished by translation only.
Pick the point on the bounding polygon where you want the structure to touch: Pick the point where the structure touches the bounding polygon.

Choose the point on the structure that you want to touch the bounding polygon: Pick the point on the structure that touches the bounding polygon.

If choosing a structure corner as the point to touch the bounding polygon, you should use the end point snap. If you do not use end point snap, the translation of the point picked to the bounding polygon will likely cause the corner of the structure to encroach. You can specify end point snap when picking the point on the structure by typing in "end" and Enter at the prompt, then you merely need to pick a point on the structure near the desired corner to actually specify the corner point.

Note: If the translating the structure to make the selected point touch the bounding polygon at the selected point would cause an encroachment, an error message will be displayed, no changes will be made, and you will return to the Adjust Structure ... prompt.

Completing the adjustment process

Once you are satisfied with the location of the structure type D and Enter and you will see the following prompt:

Creating structure coordinate points:
Enter description for structure corner points <footprint_pt>:

You can accept the default description shown in brackets by pressing Enter or you may type in a description that will help you identify this particular structure and lot.
The corner and any radius points for the current location of the structure are stored in the current coordinate file and, if Auto plot points is ON, the points are drawn.
After storing the points for the previously placed structure you will see the following prompt:

Choose a structure template [Set template/Current Template/Mirror current/Done] <C>:

Press Enter or C and Enter if you wish to repeat the process and place the current structure template in the same or another bounding polygon.
If you wish to place a mirrored ("reverse") version of the current structure template in a bounding polygon, type M and Enter.
If you wish to place a different structure in a bounding polygon, type S and Enter to bring up the Template Manager, allowing you to pick a new template.
If you are done placing templates for now, type D and Enter for Done.
At any time you may adjust an existing structure by choosing Fit Structure. If there are existing structures in the drawing, it will be detected and the following the prompt will appear at the command line:

Pick existing structure to adjust or choose a structure template.
[Set-template/Current-template(Wilson)/Mirror-current/Done] <C>:

At this prompt you can use the mouse to pick an existing structure to adjust. You can now use any of the adjustment methods described above to further refine the location of the structure. After the adjustment process is complete the coordinate file is updated to reflect the adjusted locations of the structure's corner and radius points.

Note: When you pick an existing structure, any plotted corner point symbols are temporarily removed to facilitate the adjustment process. Once you are done adjusting the existing structure, these points are re-plotted at their new adjusted locations

At this prompt you may also choose to place a new structure in a bounding polygon. To use a different template, type S and Enter to bring up the Template Manager and allow to choose the desired template. If you
have already placed a template in the current drawing session, the prompt will indicate the current template. By
typing C and Enter or just pressing Enter you can choose to place the current template in a bounding polygon or
you can type M and Enter to place a mirrored version of the current template:

Prompts

Template Manager dialog: create or choose a template to place within a bounding polygon (a lot)
Add a Template dialog: Used in conjunction with the Template Manager dialog to add a template to a given project.

if you have already specified a template to use but no templates have been placed in the drawing:
Choose a structure template
[Set template/Current template (Wilson)/Mirror-current/Done] <C> : Type "S" and Enter to bring up the
Template Manager dialog. Type "C" and Enter or just Enter to use the current template. Type "M" and Enter to
mirror the current template. Type "D" and Enter when done placing templates.

if a structure/template exists in the drawing or you have already specified a template to use:
Pick existing structure to adjust or choose a structure template.
[Set-Template/Done] <S> : To adjust an existing structure pick it on the screen. Type "S" and Enter or just Enter
to bring up the Template Manager dialog to choose a new template. Type "D" and Enter when done.

after you set a new template or chose to use the current one:
Pick the lot within which the structure will be placed [c&g-Point-group/Done] <pick> : pick the polyline or a
series of lines that define a closed polygon within which the structure template will be placed. Type P and Enter to
specify the bounding polygon using a C&G Point Group file.
Place the structure near its final location in the bounding polygon <pick> : Drag the structure template to the
desired location and click the left mouse button to place the structure.

after you place a template or pick one to adjust:
Adjust structure [Move/Step-move/step-Rotate/rotTate/rot-Ninety/Parallel/On-boundary/setUp/Done] <D> : Type "M" and enter to move the structure. Type "S" and Enter to use the arrow keys to move the structure in
predefined steps. Type "T" and Enter to use the cursor to rotate the structure. Type "R" and Enter to rotate the
structure template a predefined number of degrees using the up and down arrow keys. Type "N" and Enter to rotate
the structure 90 degrees clockwise. Type "P" and Enter to translate and rotate the structure template parallel to a
side of the bounding polygon. Type "O" and Enter to move the structure template so a chosen point on the structure
touches a chosen point on the bounding polygon. Type "U" and enter to use the Setup dialog to change the step
sizes, layer names and other configuration items for the fit structure command.

when saving the structure coordinate points:
Enter description for structure corner points <footprint_pt> : Specify a description for the structure template
corner points to be saved in the coordinate file or just press Enter to use the default description.

Pulldown Menu Location: Area/Layout > Layout Utilities
Keyboard Command: cg_fit_structure
Prerequisite: coordinate file, pre-drawn bounding polygon (lines and arcs or a polyline)

Lot Network Settings

This command displays a dialog for the current Lot Network Settings which specifies the lot network name, road
network name, label settings, setback settings and lot area tolerance.
Click Select for the Road Network Name and choose the Road Network file (.RDN).

Then select Edit for Line/Curve Label Settings. The Auto-annotate dialog appears; accept the defaults and hit OK.

Then select Edit for Area Label Settings. The Area Defaults dialog appears; accept the defaults as they appear in the figure and hit OK.
The routine will also draw property setbacks. To do this select Settings for Draw Setback. Set the Front to 20.0, the Side to 10.0 and the Back to 10.0. Say OK.

The tolerance sets the level at which the area computations will go to be considered "correct".

The files involved in the process are all saved to an .LTN file that can be recalled, modified and re-processed.

**Pulldown Menu Location:** Area/Layout  
**Keyboard Command:** lotnet_config  
**Prerequisite:** None

### Lot Network Boundary

These are a collection of commands to assign and verify the site boundary for lot network. Sets the site boundary. It must be a closed polyline.

Indicates the boundary to the user by highlighting it.

Indicates the boundary to the user by hatching it.
Erases the hatched boundary for the user.

Deletes the boundary designation from the polyline.

**Pulldown Menu Location:** Area/Layout  
**Keyboard Command:** `lotnet_limit`, `lotnet_highlight_limit`, `lotnet_hatch_limit`, `lotnet_hatch_erase`, `lotnet_untag_limit`  
**Prerequisite:** None

---

**Lot Networks Sub-Areas**

**Tag Sub-Area**

This command provides the ability to establish "exclusion" areas (such as wetlands or drainage ponds) that limit where Lots or Lot Setbacks from the Lot Network routines can be created.

**Prompts**

Select polyline for sub-area: *Pick a closed polyline that defines the sub-area.*  
Area Category: *Provide the name of a general category for the sub-area.*  
Area Description: *Provide a more specialized description for the sub-area.*

**Note:**

- If a Sub-Area is created after a Lot Network has been processed, the existing Lot lines are kept and any associated setback lines are updated to honor the Sub-Area.
- If a Lot Network is processed after a Sub-Area has been created, the newly created Lots will honor the Sub-Area(s).

**Pulldown Menu Location(s):** Civil > Area/Layout > Lot Network Sub-Areas, Survey > Area/Layout > Lot Network Sub-Areas  
**Keyboard Command:** `tag_subarea`  
**Prerequisite:** A closed polyline

**Untag Sub-Area**

This command removes the from the selected polyline(s) the Sub-Area Category and Description information placed with the Tag Sub-Area command.

**Prompts**

Select sub-area polylines to remove sub-area tag.  
Select objects: *Pick the polyline(s) whose Sub-Area information you wish to clear and press Enter when complete.*  

**Pulldown Menu Location(s):** Civil > Area/Layout > Lot Network Sub-Areas, Survey > Area/Layout > Lot Network Sub-Areas  
**Keyboard Command:** `untag_subarea`  
**Prerequisite:** A closed polyline with appropriate Sub-Area data.

**Identify Sub-Area**

This command displays the Sub-Area Category and Description information found on polylines tagged with the Tag Sub-Area command and reports it to the Command prompt.

**Prompts**
Pick polylines to check or search drawing [<Pick>/Search]: Press Enter to individually select Sub-Area polylines or Type S and press Enter to search the entire drawing.

Select sub-area polyline: Pick the polyline whose Sub-Area information you wish to identify and press Enter when complete.

Pulldown Menu Location(s): Civil > Area/Layout > Lot Network Sub-Areas, Survey > Area/Layout > Lot Network Sub-Areas

Keyboard Command: id_subarea

Prerequisite: A closed polyline with appropriate Sub-Area data

---

**Report Sub-Area**

This command displays the Sub-Area Category and Description information found on polylines in the drawing that have been tagged with the Tag Sub-Area command and reports the information to the standard Report Viewer.

Pulldown Menu Location(s): Civil > Area/Layout > Lot Network Sub-Areas, Survey > Area/Layout > Lot Network Sub-Areas

Keyboard Command: report_subarea

Prerequisite: A closed polyline with appropriate Sub-Area data.

---

**Hatch Sub-Areas**

This command places a hatch pattern into polylines in the drawing that have been tagged with the Tag Sub-Area command.

![Hatch Settings dialog box](image)

Prompts

**Hatch Name:** Type in the name of a valid hatch pattern. A sample of the pattern will appear near the "Select Pattern" control.

**Automatic Hatch Scale:** Disable this toggle to manually control the size/density of the hatch pattern.

**Hatch Scale:** Specify the size of the hatch pattern. Larger Scale values create a less dense pattern.

**Select Pattern:** Use a visual dialog box approach to select a hatch pattern. The name of the hatch pattern selected displays in the Hatch Name control.

**Select Color:** Use a visual dialog box to specify the color of the hatch pattern.

Note:

- Any previous hatch patterns placed by the Hatch Sub-Areas command are first erased from the drawing.
- Hatch patterns are placed onto the LOTNET_HATCH_SUBAREA layer.

Pulldown Menu Location(s): Civil > Area/Layout > Lot Network Sub-Areas, Survey > Area/Layout > Lot Network Sub-Areas

Keyboard Command: hatch_subarea

Prerequisite: A closed polyline with appropriate Sub-Area data
Erase Sub-Areas Hatch

This command removes the hatch pattern(s) placed with the Hatch Sub-Areas command.

**Pulldown Menu Location(s):** Civil > Area/Layout > Lot Network Sub-Areas, Survey > Area/Layout > Lot Network Sub-Areas

**Keyboard Command:** erase_subarea_hatch

**Prerequisite:** A Sub-Area with an appropriately placed hatch pattern

Label Sub-Areas

This command displays the Sub-Area Category and Description information found on polylines tagged with the Tag Sub-Area command and uses the current text style to place the information as text into the drawing.

**Prompts**

- **Text Size <4.00>:** Press Enter to accept the specified text size or type an alternate numeric text size and press Enter.
- **Label area size [Yes/<No>]?:** Choose whether or not the area of the Sub-Area(s) should be labeled in the drawing.
- **Layer name <LOT_SUBAREA>:** Press Enter to accept the layer name specified or type in the desired layer name and press Enter when complete.

**Note:**

- To remove Sub-Area Labels from the drawing, use the Lot Network Settings command.

**Pulldown Menu Location(s):** Civil > Area/Layout > Lot Network Sub-Areas, Survey > Area/Layout > Lot Network Sub-Areas

**Keyboard Command:** label_subarea

**Prerequisite:** A closed polyline with appropriate Sub-Area data

Lot Networks Roads

Input-Edit ROW Offsets

This command defines the ROW offsets for the Road Network for Lot Networks. The ROW offsets are for the frontage polylines to the left and right of the centerlines. Besides the ROW, you can also define additional offset polylines to be drawn. These additional offset polylines do not affect the lot network.

**Pulldown Menu Location:** Area/Layout

**Keyboard Command:** lotnet_row
Lot Network Road Network

This command develops the linework, geometry and labeling for subdivision, commercial and industrial sites by using the familiar Road Network interface and pre-defined settings. The program docks a dialog on the left of the screen identifying the geometry settings and all road files and leaves an active CAD screen and command line. You can save drawings and run virtually any standard AutoCAD command while within the docked dialog. Once you identify centerlines for the road network, the program detects intersections and end segments suitable for cul-de-sacs, and through input of design parameters for offset criteria, cul-de-sac dimensions and intersection transitions, the program will process the complete geometry layout, with output options including creating Lot files for later reference and a variety of labeling options for such items as Areas, Distances and Bearings. The road network settings are saved in a .RDN file.

Before running the Road Network, use the following procedure to setup the lot labeling settings and site boundary. Click the Lot Network Settings button. Note that you can use the Area/Layout Menu pulldown to access these commands as well. Select or create a lot network settings file. Next, select the Set Boundary icon. Select a closed polyline for the boundary around your site. Next select the Road Network icon. When prompted, select the .RDN file from the Existing tab. This is where the centerlines involved for the subdivision will be defined and added to the Road Name area of the panel. These centerlines are standard Carlson .CL files. Click a centerline and choose Edit. If a CRD file is requested choose or create a .CRD file. The Edit Road dialog appears. The centerline can be selected here and these centerlines can be edited on the fly if needed. For ROW Offsets, we are using the Row-OFF-a.Row file. Click Edit. The ROW offsets dialog displays. Use the defaults of 45' left and right and note that additional graphics can be automatically generated by hitting Add and entering additional values, names and layers. Hit Exit.

Note also that Optional Input files can be attached to the process for roadway widenings based on the standard Carlson Road design tools of the same name. This is where a polyline indicating where the roadway template ID's should be tapered or widened is developed into a Centerline file and attached to the roadway template involved. Refer to the Road Design documentation for this information. Hit OK to close the Edit Road dialog. These settings can be set and altered for each road in the network.

Next click on one of the intersections you may have and select Edit Intersection. In the Edit Intersection dialog, the
intersection's radii can be set. Click on the Front Left or Front Right to verify this. Hit OK when ready.

The program can also develop cul-de-sacs for the subdivision, although this example doesn't require one. To see how it works, click Add under Cul-de-sac's area of the panel. The Select Road for Cul-de-sac dialog appears. Select the road for the Cul-de-sac and the Edit Cul-de-sac dialog opens. Then as shown in the figure, choose whether the cul-de-sac occurs at the beginning or ending of the roadway, provide a cul-de-sac radius and filet radius and any other criteria to develop the graphics as desired. Since we do not have a cul-de-sac in this example we will skip this step.

Next select Settings at the bottom of the Road Network panel.
The Radius is the default for new intersections. The radius for any existing intersection can be modified by selecting the intersection in the list and picking the Edit button. The ROW Snap Boundary Tolerance is used to snap the ROW linework onto the Lot Network Boundary which is useful to clean up any undershoots between the ROW and boundary in case the centerline is not perfectly perpendicular to the boundary. The Create Lots setting draws linework for lots for the specified geometry parameters. Otherwise, only the ROW polylines are drawn. Use a radius of 25.0 and turn on the Create Lots toggle and click Settings. Set the values as shown in the Create Lot Settings dialog below. Then hit OK and OK to exit.

**Prompt For Each Area**: This option will pause to prompt for the target area as each lot is created.

**Target Lot Area**: The new lots will have this area +/- the Lot Area Tolerance under Lot Network Setting plus any effect from handling the Remainder.

**Minimum Frontage**: Controls the minimum lot perimeter length along the ROW.

**Use Setback For Minimum Frontage**: This option bases the Min Frontage check at the specified Frontage Setback from the ROW.

**Minimum Lot Depth**: This setting is the min distance from the ROW to the back of the lot for the lot side lines.

**Maximum Lot Depth**: This setting is the max distance from the ROW to the back of the lot for the lot side lines.

**Minimum Back Distance**: This setting is the min distance along the back of the lot perimeter between the two lot side lines.

**Interior/Back Reduce Offset**: For interior boundaries generated by the program between lots, this option reduces
the number boundary vertices. A vertex is removed if it doesn't affect the boundary by more than the specified offset amount. This method is similar to the Reduce Polyline Vertices command.

**Edge Method:** The lot sides can be created perpendicular to the frontage ROW, back boundary or at a specific angle. **Remainder:** This option determines how to handle any remaining area that is less than the target area after fitting as many lots as possible. The Create Separate End Lot will make a lot with this remainder area. The Apply Equally to All Lots will spread the extra area to all the lots. The Add To Last Lot will add the remainder to the last lot created making it larger than the target area. The Create Back Lot Edge makes a back lot edge that meets the target area at min frontage.

**Lot Type:** Sets the lot type for the new lots.

**Check Building Placement:** Checks that the building footprints fit within the lots for the specified setbacks.

![Building Placement Settings](image)

**Lot Setback Parameters:** These setting offset the lot perimeter inward for different sides of the lot. **Min Setback Area:** This option checks that the lot area within the setbacks is at least this much.

![Lot Setback Diagram](image)

In the Road Network panel click Save or Saveas to save these settings for your own experimentation.

Now Click Process to begin the lot layout. You will notice the ROW's and EOP's being generated, followed by the lot lines. Then areas are labeled and setbacks are created. Finally, the lotlines are labeled with distances, bearings and arc data.
Lot Network Linework

The following commands allow for the Lot Network to be manipulated after the processing. The commands allowing this are:

Adds a ROW polyline into the model. By clicking this command, the software asks for the user to select the new ROW polyline. It then reprocesses the site based on this new ROW data and relocates the EOP for this portion of the roadway.

This command adds a lot edge to the model. The software may request a Lotnet Settings file and if so create or select it. The software prompts with: Select Edge linework to add to model: Select the polyline you drew in the lot representing the new lot edge. The software reprocesses the site based on this new data and redevelops the lot layout accordingly.

This takes a property line out of the model. Select the edge in question when prompted.

This command allows for adding a new property corner to an existing lotline. Simply select the lot edge in question and then pick the point to be added using a snap or other means.

This command allows for moving a lot corner.

This command allows for eliminating a lot corner. Simply select the lot edge in question and then the corner to be removed.
**ID Linework**
This command identifies the type of Lot Network linework and which Lot Network it belongs to. For example, you can identify whether a line is a lot edge or ROW.

**Prompts**

Select Lot Network linework: *pick an entity*
Lot Edge: SETBACKS
Select Lot Network linework (Enter to end): *press Enter*

Pulldown Menu Location(s): Area/Layout > Lot Network Linework
Keyboard Command: lotnet_id
Prerequisite: Lot network linework

**Untag Linework**
This command removes entities from the Lot Network model by removing the Extended Entity Data (Xdata) related to Lot Network. You can use this command to remove a lot edge or ROW polyline that you no longer want to be part of the Lot Network.

**Prompts**

Select Lot Network linework to untag.
Select objects: *pick entities to untag*
Remove Lot Network tags for 2 entities

Pulldown Menu Location(s): Area/Layout > Lot Network Linework
Keyboard Command: lotnetntag
Prerequisite: Lot network linework

**Lot Newtor Areas**

**Subdivide Area**
This command sub-divides an area into smaller parcels. The command starts with the Create Lot Settings dialog. Set the settings and pick OK. Next the command prompts to pick a point within the parcel to subdivide. Then select where on the frontage to begin the lot creation. Note the program highlights the frontage involved. Note also that whether the entire subdivision re-labels itself is based on the Lot Network Settings toggle for Automatic Labels.
Size Lot by Frontage

This command provides the ability to resize a Lot associated with the current Lot Network .LTN file based on a user-specified amount of Lot Frontage.

Prompts

Pick inside lot to adjust: Identify the interior portion of a Lot whose Frontage is to be adjusted.
Select lot edge to adjust: Choose a side Lot edge that is common to two Lots. The Current Area and Current Frontage of the selected Lot is reported.
Frontage (ft): Type in the new Frontage amount and press the Enter button.

Note:

- To specify an alternate .LTN file, use the Lot Network Settings command.

Pulldown Menu Location(s): Civil > Area/Layout > Lot Network Areas, Survey > Area/Layout > Lot Network Areas
Keyboard Command: lotnet_ssfront
Prerequisite: A processed set of Lots and their graphical entities created by the Lot Network routines.

Sliding Side Area

In this routine a lot side can be altered to reflect a new target area. It will hold its angle and slide along the front and back lot lines until it has achieved the desired area. When running the routine, Select the lot in question when asked to pick inside lot to adjust and then select the lot edge to adjust. Then the prompt asks Acres/<Enter Target Area(sf)>: Type in the desired area you are trying to obtain and the system computes it.

Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet_ssarea
Prerequisite: None
**Hinged Area**

In this routine a lot side can be altered to reflect a new target area. It will hold a lot corner and pivot, or rotate until it achieves the desired area. The procedure is as follows:
- Pick inside lot to adjust: Select a point inside the lot to modify.
- Select lot edge to adjust: Select the edge that will move.

The routine will report the current area to you and then ask for your desired area.

**Current Area:** 22494.5 SF 0.516 Acres

**Acres/[]**

**Enter Target Area (sf):** 10000

**Pulldown Menu Location:** Area/Layout

**Keyboard Command:** lotnet_harea

**Prerequisite:** None

---

**Lot Network Labels**

These are a collection of commands to draw lot network area, line and arc labels.

Deletes the labels in the model and re-labels the linework based on the LTN file settings.

Deletes the labels in the model and re-labels the linework.

**Pulldown Menu Location:** Area/Layout

**Keyboard Command:** lotnet_update, lotnet_redraw

**Prerequisite:** None

---

**Lot Network Utilities**

**Lot Network Report**

This command generates a summary report of the areas and number of lots in the lot network model. For a detailed report of the lot data, output the lot network to a .lot file and run the Report function inside Lot File Manager.

**Lot Network Report**

**File:** C:\Carlson Projects\Clearwater Oaks.ltn

**Total Area:** 20.520 acres, 893839.8 sf
**Lot Area:** 17.600 acres, 766648.4 sf
**ROW Area:** 2.920 acres, 127191.3 sf
**Other Area:** 0.000 acres, 0.0 sf

**Number of Lots:** 50

**Pulldown Menu Location:** Area/Layout

**Keyboard Command:** lotnet_report

**Prerequisite:** None
Lot Number Report

This command reports the range of lot numbers used in the current lot network and any gaps in the numbers. Here's a sample report:

Lot Number Report

File: C:\\sample\\setbacks.ltn

Used Numbers
1,26-37,39-52
Number of used numbers: 27

Unused Numbers
2-25,38
Number of unused numbers: 25

Pulldown Menu Location: Area/Layout > Lot Network Utilities
Keyboard Command: lotnet_number_report
Prerequisite: A Lot Network

Lot Network Inspector

This command shows a dynamic report of the lots as the cursor passes over them. The program has a small dialog that shows the lot number, area, perimeter and frontage.

Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet_inspector
Prerequisite: a lot network

Check Lot Network Parameters

This command compares area and frontage of Lots associated with the current Lot Network file (.ltn) against user-specified area and frontage values.

Enabling the "Check ROW Offsets" option will also check for proper right-of-way distances using a specified centerline file (.cl) or (.rdn) file.

A detailed report is generated that displays the Lots that meet or do not meet the area and frontage minimums along with the coordinates of points along Lot frontage that violate the right-of-way value specified.
Minimum Lot Area: Specify the smallest acceptable area a Lot can be to "pass the test" and the appropriate unit of measure.

Minimum Frontage: Specify the smallest allowable amount of street frontage the Lot must have in order to "pass the test."

Check ROW Offsets: This setting allows you to specify the full right-of-way width for the road defined by the centerline file (.cl) you specify.

Note:
- To specify an alternate .LTN file, use the Lot Network Settings command.
- To "browse" over lots already in a drawing, use the Lot Network Inspector command.

Pulldown Menu Location: Area/Layout > Lot Network Utilities
Keyboard Command: lotnet_check
Prerequisite: A processed set of Lots created by the Lot Network routines

Find Lot Name
This command displays a temporary indicator in the drawing showing the location of a Lot associated with the current Lot Network .LTN file.

Note:
- To specify an alternate .LTN file, use the Lot Network Settings command.
- To "browse" over lots already in a drawing, use the Lot Network Inspector command.

Prompts

Lot Network File to Process dialog Locate an existing .LTN file
Lot name to find: Type in the Name (usually the Lot Number) of the Lot you wish to locate and press Enter

Pulldown Menu Location(s): Civil > Area/Layout > Lot Network Utilities, Survey > Area/Layout > Lot Network Utilities
Keyboard Command: lotnet_find
Prerequisite: A processed set of Lots created by the Lot Network routines

Connect Driveways
This command adjusts driveway polylines to connect them with a selected frontage polyline or the Lot Network ROW. The driveway polylines need to be closed polylines. The program will extend or trim the driveway to the frontage polyline and make the driveway follow the frontage for the width of the driveway. To run this routine, first select the driveway polylines to adjust and then choose the frontage to connect to either as a selected polyline or the Lot Network ROW.
Before Connect Driveways

After Connect Driveways

**Prompts**

*Select driveways to connect.*
*Select objects: pick driveway polylines*
*Connect to ROW or pick polylines [<ROW>/Pick]? P*
*Select polylines for driveway connections.*
*Select objects: pick frontage polyline*

**Pulldown Menu Location(s):** Area/Layout > Lot Utilities
**Keyboard Command:** connect_driveways
**Prerequisite:** Driveway and frontage polylines

**Tag ROW Segments to Skip Frontage**

This command tags lot lines along the ROW to not use as frontage. When calculating setback, the program figures if a lot line is on the frontage based on whether the lot line is on the ROW. This command lets you tell the program not to use a lot line as frontage even when the lot line is on the ROW. This applies is cases of a corner lot where the
lot side is on the side road ROW and you want this lot side to be considered as a side setback instead of front setback.

The tags are done by placing a symbol on the lot line. The program prompts for the symbol name, size and layer. Then the program prompts to pick the lot edges to tag. The symbol is drawn on the lot mid-point.

Prompts

**Pick segment to skip:** *pick a lot edge*
**Pick segment to skip (Enter to end):** *press Enter*

**Pulldown Menu Location:** Area/Layout > Lot Network Utilities  
**Keyboard Command:** 3darc  
**Prerequisite:** Lot lines

**Tag No-Building Area**
This command tags a polyline as a no-building area that Lot Network will avoid when placing building pads.

**Pulldown Menu Location(s):** Area/Layout > Lot Network Utilities  
**Keyboard Command:** tag_no_build  
**Prerequisite:** closed polyline

**Untag No-Building Area**
This command removes the no-building tag from selected polylines. You can use this command to update a polyline area that you no longer want to be counted as non-buildable.

**Pulldown Menu Location(s):** Area/Layout > Lot Network Utilities  
**Keyboard Command:** untag_no_build  
**Prerequisite:** tagged no-building polyline

**Point Check**
This command checks for points that are close together in the Lot Network. Any points that are within the specified Tolerance are reported. The command has an option to Draw Symbols at these points which helps with finding these points in the drawing. Also, the Adjust Polylines To Match Vertices option combines the close points to a single point by averaging them together and updates the linework entities. The Check T-Intersections option finds any points with the tolerance of a line segment.
Pulldown Menu Location(s): Area/Layout > Lot Network Linework
Keyboard Command: lot_pt_check
Prerequisite: Lot network linework

Set Lot Edge Angles To Nearest Second
This command adjusts the coordinates of Lot Network lines and polylines to set their bearings to the nearest specified precision between 1 and 60 seconds. This routine eliminates decimal seconds for the linework. Here's an example inverse showing decimal seconds on a line before running this routine.

Northing(Y) Easting(X) Elev(Z)
7054276.3676 11519401.0186 0.0000
7054104.6344 11519556.5360 0.0000
Bearing: S 42d09'47.5207'' E Horizontal Distance: 231.6850115

Here's the inverse showing the bearing to the nearest second on the line after running this routine:

Northing(Y) Easting(X) Elev(Z)
7054276.3673 11519401.0182 0.0000
7054104.6344 11519556.5360 0.0000
Bearing: S 42d09'48.0000'' E Horizontal Distance: 231.6850115

Prompts
Set Linework Precision dialog
Select lot edges to process.
Select objects: Pick lot lines to adjust

Pulldown Menu Location: Area/Layout > Lot Network Utilities
Keyboard Command: edge2sec
Prerequisite: A lot network

**Renumber Lots**
This command allows you to renumber the lot number for selected lots. The program prompts for the Starting Lot Name: where the new value can be types, such as 200 for the new starting number. It then says Pick point inside lot to start renumbering: so you would pick inside the desired lot. The routine then asks for the Next direction point for renumbering: and you must pick into the next lot to continue or cross over several lots in one pick to include all of those lots in the renumbering process.

Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet_renum
Prerequisite: a lot network

**Assign Building Type**
This command lets you change the building type within selected lots. The available building types are defined in the Lot Network Settings command under Edit for Building Placement Settings.

![Set Building Type dialog](image)

To run this routine, select the Building Type to use from the pull-down list in the dialog. Then select the lots to use this building type. The Crossing Selection method selects lots by picking within the lots to update. To update a single lot, pick a single point in that lot. To update a series of lots, pick a point in the first lot and another point in the last lot. Then every lot that crosses this line is updated. For the Inclusion Perimeter method, draw a closed polyline around the lots to update before running this command and pick this polyline as the inclusion and all lots inside are updated.

Pulldown Menu Location: Area/Layout > Lot Network Utilities
Keyboard Command: lotnet_bldg
Prerequisite: Lot network lots

**Output To Lot File**
This command will create a .LOT file containing the points to define the lots. The points are stored into the specified coordinate file. The Output Boundary option creates a lot for the overall site perimeter. The Output ROW option creates lots for the ROW areas.

The .LOT file is used by the collection of Lot File commands including Lot File Manager.
**Lot Network - Assign Lot Type**

This command allows you to assign a new Lot Type to Lots in a Lot Network by dragging a line across the Lots to be re-assigned.

**Note:** Lot Types must have already been defined through the LotNet Settings dialog box.

**Prompts**

**Set Lot Type dialog:** Select the "Default" or other pre-defined Lot Type.

**Pick a point inside lot to start re-assigning:** Use the left-mouse button to drag a multi-segmented line across all the Lots to be re-assigned to the selected Lot Type. *Press Enter to finish.*

**Pulldown Menu Location:** Area/Layout \(\rightarrow\) Lot Network Utilities

**Keyboard Command:** lotnet_type

**Prerequisite:** A lot network and pre-defined Lot Types

**Set Lot File**

This command sets the lot (.LOT) file name that other lot routines will automatically reference. The lot (.LOT) file stores a list of lots with each lot being a list of point numbers which reference coordinates stored in a coordinate (.CRD) file.

**Pulldown Menu Location:** Area/Layout

**Keyboard Command:** setlot

---

**Pulldown Menu Location:** Area/Layout \(\rightarrow\) Lot Network Utilities

**Keyboard Command:** lotnet_lotfile

**Prerequisite:** a lot network
Create Lots

Design Lot

This command creates lot definitions that are stored in a lot (.LOT) file. The lots are defined by entering a sequence of point numbers. The point numbers reference coordinates from the current coordinate (.CRD) file. Each lot has a lot name and block name. The lots are not required to be closed perimeters and can also be used to represent other linework such as centerlines. Curves are entered by first specifying the PC point number, then type R for radius and enter the radius point number followed by the PT point number.

Prompts

Lot Name <1>: 105
Block Name <1>: press Enter
Lot Starting Station <0.0>: press Enter
If the figure that you are entering is a centerline, then you could use this as the starting station of the centerline.
Starting point number: 17
Point number (R-RadiusPt,U-Undo,Enter to end): 18
Point number (R-RadiusPt,U-Undo,Enter to end): 19
Point number (R-RadiusPt,U-Undo,Enter to end): R
Radius point number: 20
Use large included angle for curve (Yes/<No>)? press Enter
End of curve point number (R-RadiusPt,U-Undo,Enter to end): 21
Point number (R-RadiusPt,U-Undo,Enter to end): 22
Point number (R-RadiusPt,U-Undo,Enter to end): 17
Point number (R-RadiusPt,U-Undo,Enter to end): press Enter
Enter another lot (<Yes>/No)? N

Pulldown Menu Location: Area/Layout > Create Lots
Keyboard Command: mklot
Prerequisite: Points in a coordinate (.CRD) file
Polyline to Lot File

This command will create lot (.LOT) files from selected polylines. The lots are defined by the series of point numbers. This command will create point numbers in the current coordinate (.CRD) file for each point in the polylines. Before creating a point number, the program will check to see if the point coordinates are already in the coordinate (.CRD) file and will use the existing point number if found. Each lot has a lot name and block name. Lots are not required to be closed perimeters and can also be used to represent other linework such as centerlines.

Prompts

Polyline To Lot File Options Dialog *enter in values*
After entering in the Starting Point Number, points will be automatically numbered starting from this value.
Select lot polyline: *pick a polyline*

Select lot polyline:
Lot Name <LOT 19>:

Created 3 lot points.
Select lot polyline (Enter to end):
Lot Name <LOT 20>:

Created 3 lot points.
Select lot polyline (Enter to end):
Lot Name <LOT 21>:

Created 3 lot points.
Select lot polyline (Enter to end):
Select lot polyline: *pick a polyline*
Lot Starting Station <0.0>: *press Enter*
Lot Name <106>: *press Enter* This defaults to the next available name.
Block Name <1>: *press Enter*
Lot Starting Station <0.0>: *press Enter*
Created 7 lot points.
Select lot polyline (Enter to end): *press Enter*

Pulldown Menu Location: Area/Layout > Create Lots
Keyboard Command: pl2lot
Prerequisite: A polyline
Lot File by Pick Interior

This command is used to create a lot by picking a point, and having the program figure the enclosing linework.

creates lot definitions from the selected polylines and text. For each text entity, the program finds the bounding polyline around the text. The text is used as the lot name. The polylines do not need to be closed themselves but selected together they should define closed areas. Multiple lots can be created at once with this command. All the lots will have the same block name as entered and all lots will be assigned a starting station of 0.0.

The lots are defined by the series of point numbers. This command will create point numbers in the current coordinate (.CRD) file for each point in the bounding polylines. Before creating a point number, the program will check to see if the point coordinates are already in the coordinate (.CRD) file and will use the existing point number if found.

This command works well in conjunction with Draw Lot File. Once a lot (.LOT) file containing 1 or more lots is created, all lots can be redrawn automatically, with annotation, using Draw Lot File. Furthermore, since the lots are drawn from point numbers, if the point numbers for the lot corners are moved, the lots can be redrawn to the new point positions using Draw Lot File. If a point number is at the corner of four lots, moving that one point number will cause Draw Lot File to draw differently all four lots.

Prompts

Starting point number <8>: press Enter Points will be automatically numbered starting from this value.
Select lot polyline: pick a polyline
Block Name <1>: press Enter
Select lot lines, polylines and text.
Select objects: select the polylines and text
Select objects: press Enter
Created 3 lots.

Pulldown Menu Location: Area/Layout > Create Lots
Keyboard Command: txt2lot
Prerequisite: Polylines and text

Lot File by Closed Linework

This command creates lot definitions from the selected polylines, lines and arcs. This command is similar to Lot File By Interior Text. The difference is that this routine does not process text for the lot names. Instead this command finds all the closed areas from the selected linework and then automatically names the lots.

For each lot, the program stores a series of points to the lot file. In the options dialog, there are settings for the point number, point description and whether to order the points clockwise around each lot. The Draw Points option will create point entities besides storing the points to the current coordinate file. The Starting Lot Name is used for assigning the lot names which then get incremented by one for each other new lot.

Chapter 14. Area/Layout Menu
Prompts

Lot File By Closed Linework dialog
Select lot lines and polylines.
Select objects: select linework
Created 3 lots.

Pulldown Menu Location: Area/Layout > Create Lots
Keyboard Command: lwork2lot
Prerequisite: Polylines, lines or arcs

Lot File by Interior Text
This command creates lot definitions from the selected polylines and text. For each text entity, the program finds the bounding polyline around the text. The text is used as the lot name. The polylines do not need to be closed themselves but selected together they should define closed areas. Multiple lots can be created at once with this command. All the lots will have the same block name as entered and all lots will be assigned a starting station of 0.0.

The lots are defined by the series of point numbers. This command will create point numbers in the current coordinate (.CRD) file for each point in the bounding polylines. Before creating a point number, the program will check to see if the point coordinates are already in the coordinate (.CRD) file and will use the existing point number if found.

This command works well in conjunction with Draw Lot File. Once a lot (.LOT) file containing 1 or more lots is created, all lots can be redrawn automatically, with annotation, using Draw Lot File. Furthermore, since the lots are drawn from point numbers, if the point numbers for the lot corners are moved, the lots can be redrawn to the new point positions using Draw Lot File. If a point number is at the corner of four lots, moving that one point number will cause Draw Lot File to draw differently all four lots.

Prompts
Starting point number <8>: press Enter Points will be automatically numbered starting from this value.
Select lot polyline: pick a polyline
Block Name <1>: press Enter
Select lot lines, polylines and text.
Select objects: select the polylines and text
Select objects: press Enter
Created 3 lots.

Pulldown Menu Location: Area/Layout > Create Lots
Keyboard Command: txt2lot
Prerequisite: Polylines and text

Lot Layout

This command draws lots based on a front and back polyline. Starting from the front polyline, the program calculates two lot side lines perpendicular from the front polyline that intersect the back polyline and create the specified lot size. Lots are created along the front polyline in the order that the front polyline is drawn. If the front polyline needs to be reversed, use the Reverse Polyline command found on the Edit menu. The direction of the back polyline does not matter. The lots can be drawn as closed polylines or just the lot sides can be drawn. There is also an option to automatically create all the possible lots at the specified area between the front and back polylines or to prompt for each 0.4 acre lot.

In prompt mode, the program reports the remaining area between the front and back polylines and then asks for the lot size. The lot size can be specified either by area or frontage along the front polyline.

The lots are sized to meet the specified area and also meet the minimum frontage and backlot distances. The program starts by checking the lot area at the minimum distances. If this area is greater than the target, then the lot is drawn at the minimum distance and the resulting lot area will be greater than the target area. Otherwise the program will increase the frontage until the lot reaches the exact target area. The Use Frontage Setback Polyline option allows you to use another polyline besides the actual frontage polyline for the minimum frontage indicator. Typically, this Frontage Setback Polyline would be offset a set amount from the actual frontage polyline.

Prompts
Lot Layout dialog
Select front polyline: pick a polyline
Select back polyline: pick a polyline
With prompt for each lot active:
Area remaining: 160326.88 S.F, 3.6806 Acres
Quit/Frontage/Enter lot area (Acres) <1.2269>: 1
Area remaining: 116766.88 S.F, 2.6806 Acres
Quit/Frontage/Enter lot area (Acres) <1.0000>: F
Enter Frontage <50.00>: 75
Lot Area: 37807.50 S.F, 0.8679 Acres
Area remaining: 78959.38 S.F, 1.8127 Acres
Quit/Area/Enter frontage <50.00>: A
Quit/Frontage/Enter lot area (Acres) <1.0000>: press Enter
Area remaining: 35399.38 S.F, 0.8127 Acres
Quit/Frontage/Enter lot area (Acres) <1.0000>: Q

Polylines for Lot Layout
The Front Polyline goes from right to left

Resulting lots numbered using Sequential Numbers

Pulldown Menu Location: Area/Layout
Keyboard Command: lotlay
Prerequisite: A frontage polyline and a backlot polyline.

LotNet Road Network
This command develops the linework, geometry and labeling for subdivision, commercial and industrial sites by using the familiar RoadNet interface and pre-defined settings. The program docks a dialog on the left of the screen identifying the geometry settings and all road files and leaves an active CAD screen and command line. You can save drawings and run virtually any standard AutoCAD command while within the docked dialog. Once
you identify centerlines for the road network, the program detects intersections and end segments suitable for cul-de-sacs, and through input of design parameters for offset criteria, cul-de-sac dimensions and intersection transitions, the program will process the complete geometry layout, with output options including creating Lot files for later reference and a variety of labeling options for such items as Areas, Distances and Bearings. The road network settings are saved in a .RDN file.

Before running the Road Network, use the following procedure to setup the lot labeling settings and site boundary.  Click the Lot Network Settings button. Note that you can use the Area/Layout Menu pulldown to access these commands as well. Select or create a lot network settings file. Next, select the Set Boundary icon. Select a closed polyline for the boundary around your site. Next select the Road Network icon. When prompted, select the .RDN file from the Existing tab. This is where the centerlines involved for the subdivision will be defined and added to the Road Name area of the panel. These centerlines are standard Carlson .CL files. Click a centerline and choose Edit. If a CRD file is requested choose or create a .CRD file. The Edit Road dialog appears. The centerline can be selected here and these centerlines can be edited on the fly if needed. For ROW Offsets, we are using the Row-OFF-a.Row file. Click Edit. The ROW offsets dialog displays. Use the defaults of 45' left and right and note that additional graphics can be automatically generated by hitting Add and entering additional values, names and layers. Hit Exit.

Note also that Optional Input files can be attached to the process for roadway widenings based on the standard Carlson Road design tools of the same name. This is where a polyline indicating where the roadway template ID's should be tapered or widened is developed into a Centerline file and attached to the roadway template involved. Refer to the Road Design documentation for this information. Hit OK to close the Edit Road dialog. These settings can be set and altered for each road in the network.

Next click on one of the intersections you may have and select Edit Intersection. In the Edit Intersection dialog, the intersection's radii can be set. Click on the Front Left or Front Right to verify this. Hit OK when ready.
The program can also develop cul-de-sacs for the subdivision, although this example doesn't require one. To see how it works, click Add under Cul-de-sac's area of the panel. The Select Road for Cul-de-sac dialog appears. Select the road for the Cul-de-sac and the Edit Cul-de-sac dialog opens. Then as shown in the figure, choose whether the cul-de-sac occurs at the beginning or ending of the roadway, provide a cul-de-sac radius and filet radius and any other criteria to develop the graphics as desired. Since we do not have a cul-de-sac in this example we will skip this step.

Next select Settings at the bottom of the RoadNet panel. Use a radius of 25.0 and turn on the Create Lots toggle and click Settings. Set the values as shown in the Create Lot Settings dialog below. Then hit OK and OK to exit.
In the RoadNet panel click Save or Saveas to save these settings for your own experimentation.

Now Click Process to begin the lot layout. You will notice the ROW's and EOP's being generated, followed by the lot lines. Then areas are labeled and setbacks are created. Finally, the lotlines are labeled with distances, bearings and arc data.

Pulldown Menu Location: Area/Layout
Keyboard Command: lotnet_rdn
Prerequisite: centerlines and a site boundary polyline

**Input-Edit ROW Offsets**

This command defines the ROW offsets for the Road Network for Lot Networks. The ROW offsets are for the frontage polylines to the left and right of the centerlines. Besides the ROW, you can also define additional offset polylines to be drawn. These additional offset polylines do not affect the lot network.

![ROW Offsets dialog box](image)

**Pulldown Menu Location:** Area/Layout  
**Keyboard Command:** lotnet.row  
**Prerequisite:** None

---

**Lot File Manager**

This command combines Input-Edit Lot capabilities with, Draw Lot and Report Lot into one command. It comes with spreadsheet data entry for lot data, with dynamic graphic preview. There are added functions for changing the direction of the lots, to change the point of beginning for the lots, and to save and load lot name selections.
Prompts

Starting point number <8>: press Enter Points will be automatically numbered starting from this value.
Select lot polyline: pick a polyline
Block Name <1>: press Enter
Select lot lin .................

Pulldown Menu Location: Area/Layout
Keyboard Command: editlot
Prerequisite: Polylines and text

Lot File Utilities

Lot File Inspector
This command activates a small pop-up window that when you place your pointer into a lot file area, the details of that lot file will be displayed in the Lot Inspector window.
Prompts

Move pointer inside lots (Pick to edit, Enter to End) hover crosshairs above lot(s)

Pulldown Menu Location: Area/Layout
Keyboard Command: lotinspector
Prerequisite: None

Right-of-Way Crossing Table

This command will create a table using user selected information and user defined table features. A polyline is selected that crosses one or more lots. Lots must be defined in a Lot file prior to running the command. In the following example the polyline is labeled as a Pipeline.

When the command is started the user is presented with the Lot Crossing Settings dialog box. There two tabs; Label Fields and Settings and Table Settings.

Available Labels: This is the list of information that may be included in the table.

Used Labels: These are the items that have been selected to be in the table. They are placed in the table in the order listed. The green up and down arrows will move used labels up or down in the list.

Add: Clicking the Add button will add the highlighted labels in the available list to the used list.
Remove: Clicking the Remove button will remove labels highlighted in the used list and display in the available list.

Setup: Setup opens the Field Settings dialog for the Used Label that is highlighted.

OK: Clicking the OK button will proceed to the selection of the crossing polyline.

Cancel: ends the command with no table being created.

Load: Loads previously saved settings so table created match previous tables.

Save: Saves the settings as currently displayed for use on future tables.

Help: Load this file.

Include Header: This draws a header row with the field names.

Include Horizontal Lines: This draws horizontal lines between the rows of the table.

Sheet Width (in): This value defines the width of the table. If set too small the text in the table will overlap.

Table Layer: Select an existing layer to draw the table on using the Select button or use a new layer by typing the name in the edit field.

Table Color: The use can specify a color for the table gridlines using the Select button. Bylayer will use the color assigned to the Table Layer for the grid lines.

Table Title: A title can be specified for the table by typing the desired title in the Table Title field. See example below.

Title Text Color: This specifies the color for the Table Title text.

Title Text Style: This specifies the text style for the Table Title text. Be sure the style specified is defined in your drawing.

Title Text Size Scaler: This specifies the plotted height of the Table Title text. The table is drawn in model space. The height of the text in model space is the Text Size Scaler multiplied by the horizontal scale in Drawing Setup.

Use Table Title Background Color: This option allows the user to specify a background color for the Table Title.

Use Table Header Background Color: This option allow the user to specify a background color for the Table Header row.

Use Table Contents Background Color: This option allows the user to specify a background color for body of the table.

Use Table Contents Alternating Background Color: If the Table Contents Background color is being used, This option allows the user to specify a second color to use on alternating rows of the table body.
The Field Settings dialog box is opened by double-clicking a Used Label or highlighting a Used Labels and clicking the Setup button.

**Row Title:** Row Titles are the Used Labels that were selected Label Fields and Settings tab.

**Text Style:** This specifies the text style to be used for the current row text. You may use the Select button to choose a text style. Be sure the selected text style is loaded in the drawing.

**Text Style Scaler:** This specifies the plotted height of the current row text. The table is drawn in model space. The height of the text in model space is the Text Size Scaler multiplied by the horizontal scale in Drawing Setup.

**Text Color:** This specifies the color for the current row text. You can use the Select Color button to choose the color from a pallet. Bylayer uses the color of the Table layer for the text.

**Prefix:** This places the user provided prefix text with the row entries. An example would be prefixing lot numbers with the word Lot.

**Suffix:** This places the user provided suffix text with the row entries. An example would be using ft for feet as a suffix for a length.

**Justification:** Users can specify, Left, Center or Right text justification.

### Calculated Numeric Values

Table numeric values that are calculated, like area or lengths, have the two following controls in addition to those listed above.

**+/−:** Users may specify a +/- be used as a prefix or suffix. The default is None, not used.

**Precision:** Decimal precision for calculated numeric values can be set to zero and up eight decimal places.

**OK:** Saves changes and closed the Field Setting dialog box.

**Cancel:** Closes the Field Settings dialog box without saving changes.

**Help:** Accesses this documentation.

### Prompts

**Pick a polyline for lot crossings:** Select polyline crossing lots

**Starting Station <0.0 >:** Enter desired starting station

**Ending Station <1642.88 >** Accept full length or enter ending station to process a part of the polyline.

**Pick location for report table:** Select location in drawing for table
Define Lot Attributes

This command allows the user to define the Lot Type, Lot Attributes and Point attributes. With the use of the opening Lot Attribute Definitions dialog box, shown below, this routine allows you to edit, add, remove or reposition all of these definition types. You can save the selected data to a new Lot Attribute Definition file (LTD). You are also able to load an existing LTD file to work with.

The Lot Types section of the dialog lists out the Lot Type and the layer associated with it.

You can set up different lot types and a layer. When the lots are drawn, the layer name is used per lot type. Also, Lot Types are used in the lot report. There are also Lot Attributes, which are additional fields that you can define for the lots, such as deed number. And there is also Point Attributes.

Edit/Add: Both the Edit and the Add buttons bring up the same Lot Type dialog, shown here. You can edit an existing lot or add a new one.

The Lot Attributes section asks for the Name and to enter the Data Type.
Edit/Add: Edit or add the name of the lot attribute. Choose from one of the four options for Data Type: Real, Integer, String or Document.

Similarly, the **Point Attributes** section also asks for the Name and to enter the Data Type.

Remove: Any of the Remove button will remove a lot type, lot attribute or point attribute from the list above it, depending upon which Remove button you use.

Up/Down (all three): Types and attributes can be repositioned.

Track Original Coordinates: This option will track the original coordinates of the lot so that this record may be kept for your future usage and needs.

Load: A Lot Attribute Definition file (LTD) can be loaded.

SaveAs: A new Lot Attribute Definition file (LTD) can be saved.

Pulldown Menu Location: Area/Layout

Keyboard Command: lotattr

Prerequisite: None

---

**Import Lot File From MDB Database**

This command will import a lot file from a Microsoft Access database file (.MDB) format.

**Prompts**

Database File to Import dialog *select existing .MDB file*

Lot File to Write dialog *select existing or create a new .LOT file*

Pulldown Menu Location: Area/Layout > Lot File Utilities

Keyboard Command: lotimport

Prerequisite: A lot (.LOT) file

---

**Export Lot File to MDB Database**

This Lot File Utilities command will export a lot file to a Microsoft Access database file format.

**Prompts**

Lot File to Export dialog *select existing .LOT file*

Database File to Write dialog *select existing or create a new .MDB file*
Export Lot File To Old SurvCADD

This Lot File Utilities command will export a Carlson lot file to SurvCADD .LOT file format.

Prompts

Source Lot File to Export dialog select existing .LOT file
Destination Lot File To Write dialog create a new .LOT file

Set CRD File for Lot Files

This command allows you to set the coordinate (.CRD) file that is associated with any number of lot (.LOT) files. This can be useful if the name or location of the coordinate (.CRD) file is changed. In the Set CRD for Multiple Lots dialog, press the Select .LOT files button to select any number of lot (.LOT) files. They are added to the list. Next, press the Select .CRD file button. After you have selected the files, press the Process button.

Lot File to Centerline

This command creates a centerline (.CL) file from a lot (.LOT) file. Since the lot definitions contain a series of points and a starting station, the lot (.LOT) file contains the necessary data to create a centerline. The Select Lot to Convert dialog lists the available lot names in the current lot (.LOT) file. Select a single lot to process, then specify the centerline (.CL) file name to create.
Prompts

Centerline File to Write dialog  enter new centerline (.CL) file name
Select Lot to Convert dialog  select a lot from the list

Pulldown Menu Location:  Area/Layout > Lot File Utilities
Keyboard Command:  lot2cl
Prerequisite:  None
Annotate Menu

These menus include commands for labeling lines with bearing/azimuth and distances, special lines, coordinates, curves, curve tables and line tables. The precision of labeled distances and coordinates are set and controlled with the Annotate Defaults command.
Annotation Defaults

This command sets the defaults for the annotation menus and controls the way various annotation commands work. Some of these defaults can be changed globally by running *Configure* command, which changes the file COGO.INI so that every time you start Carlson, the new defaults are set. When this menu option is selected the Annotate Defaults dialog appears.

This dialog is broken into 5 tabs: General, Angle, Distance, Serial Lines and Parallel Lines.

**General Tab**

This tab is used for settings that apply to all annotation types.

![Annotate Defaults Dialog](image)

**Text Size Scaler:** This value is multiplied by the horizontal scale value to set the text size units. The Horizontal Scale is set in the Drawing Setup command.

**Text Offset Scaler:** This value multiplied by the horizontal scale defines the distance that an annotation label is placed from its defining line.

**Line Type Spacing:** Specifies the distance between the symbols on special line types.

**Line Type Text Scaler:** This value multiplied by the horizontal scale specifies the size of the symbols of special line types.

**Use MText:** This option creates the labels as MText instead of standard Text entities.

**Label Flip Tolerance (degrees):** Gives extra tolerance for label flipping for readability. Labels draw in the
Spaces Between Bearing and Distance Labels: Controls number of spaces between labels when bearing and distance are labelled on the same row.

Previous Labels: Specifies if previous labels for the for the set of linework being annotated are kept or deleted. Setting values are Retain, Erase, Prompt Before Erasing.

Draw Leaders to Endpoints on Lines: This option creates leader lines (crow's feet) between the distance annotation and the line segment endpoints as shown below. These leaders are used to help identify the endpoints that were used to create the distance label.

Distance Labels Only: When checked, leaders will not be drawn unless the label includes a distance.

Leader Size Scaler: This option determines the maximum length for leaders. The size in drawing units will be the Leader Size Scaler multiplied by the Horizontal Scale (for example, 0.5x50=25). If the line segment is too short, the leader is shortened to fit.

Height Scaler: This option controls the height of the leader.

Offset Scaler: This option controls the distance between the line endpoints and the leader endpoints.

Arrow Scaler: This option controls the arrowhead size for leader styles with arrows.

Leader Style: This option determines which of the five styles of endpoint leaders to use. The styles are: Arrow-Arc, Arc-Arrow, Arc-Only, Dash-Dot, Dashed and Arrow-Line.

Leader Layer: This option determines the layer for drawing the leader.

Draw Leaders to Endpoints on Arcs: This option creates leader lines (crow's feet) between the arc segment endpoints as shown below. These leaders are used to help identify the endpoints that were used to create the arc label.
Leader Size Scaler: This option determines the maximum length for leaders. The size in drawing units will be the Leader Size Scaler multiplied by the Horizontal Scale (for example, 0.5x50=25). If the arc segment is too short, the leader is shortened to fit.

Offset Scaler: This option controls the distance between the arc endpoints and the leader endpoints.

Leader Style: This option determines which of the five styles of endpoint leaders to use. The styles are: Arrow-Arc, Arc-Arrow, Arc-Only, Dash-Dot, Dashed and Arrow-Line.

Leader Layer: This option determines the layer for drawing the leader.

Angle Tab

This tab is for settings that apply to angle labels:

Angle Layer: This specifies the layer to be used for angle labels.

Angle Text Style: This specifies the text style to be used for angle labels.

Bearing Prefix and Suffix: Specifies the prefix and suffix text for bearing labels.

Azimuth Prefix and Suffix: Specifies the prefix and suffix text for azimuth labels.

Bearing Annotation Precision: Specify the display precision for bearing labels.

Angle Separator: Choices are Symbol, Hyphen, Space, Other. When Other is chosen the Deg. Min. and Sec. fields are enable to allow the user to enter custom angle separators.
Bearing Direction Method: Choose the orientation of the bearing. This controls how lines selected for bearing or azimuth annotations will be referenced.

Toward Picked End: If this option is chosen, the line will be labeled in the direction of the endpoint that is closest to the point where you selected the line.

Away from Picked End: This labels the line in the direction away from the closest endpoint.

North Only: This option controls whether bearing annotations will always be labeled in the north quadrants (NE or NW) and never in the south quadrants.

East Only: This option controls whether bearing annotations will always be labeled in the east quadrants (NE or SE) and never in the west quadrants.

By Linework: This option labels the line in the direction that the line was drawn.

Label Geodetic Mean Angle: Instead of labeling the direct coordinate bearing between two points, this option labels the geodetic mean angle which is the average of the geodetic bearings at the two points. This method converts the drawing coordinates to lat/lon and calculates the convergence angles for both points. The projection must be defined under Settings->Drawing Setup.

Strip Spaces in Bearing Labels: This option causes the spaces in bearing labels to be removed.

Add Spaces in Bearing Labels: This option puts spaces between the degree, minutes, and seconds numbers.

Strip Zero Minutes and Seconds: This option shortens the label by dropping either seconds and or minutes and seconds when they are equal to zero. The Leave Last Zero will keep a single zero in the label.

Strip Degrees Leading Zero: This option removes any extra leading zeros on angle degrees.

Bearing Quadrant Labels: These settings control the labels for the north/south prefix and east/west suffix for bearing labels.

Label Cardinal Angles by Name: When checked, the user is allowed to enter the labels that will be used for each of the four cardinal angles.

Bearing Leaders: The Leader Scaler controls the length for the leader. The Offset Scaler controls the distance between the bearing label and leader. The Leader Arrow Scaler controls the size of the arrowhead. The Leaders To Side option creates a direction arrow with the bearing annotation as shown below. The Leaders After Bearing option is similar to the Leaders To Side. The difference applies when having both the bearing and distance labels together. The Leaders To Side option puts the leader after the distance label. The Leaders After Bearing puts the leader between the bearing and the distance labels.

Leaders After Bearing method draws the bearing leader to the right side of the bearing label.

Distance Tab
This tab is for settings that apply to distance labels:

Distance Layer: This specifies the layer to be used for distance labels.

Distance Text Style: This specifies the text style to be used for distance labels.

Distance Prefix and Suffix: These specify the prefix and suffix that are added to distance annotations.

Decimals: The decimal places can be set to a specific number or set to match the CAD units which are set by the LUPREC system variable. The decimal settings with "5" round to the nearest half.

Decimals by Distance Range: This option uses different decimals depending on the distance amount. Pick the Setup button to define these decimals. In this dialog, distances less than 100 will have 3 decimals, distance between 100 and 1000 will have 2 decimals, and distance more than 1000 will have 1 decimal.
**Distance In Inches:** This controls the precision for inches from 1/2 to 1/256th of an inch when the Distance Units is set for inches.

**Distance Type:** This controls whether to label grid distances or geodetic distances at zero or mean elevation. The geodetic distances require the grid projection to be set in Drawing Setup.

**Distance Units:** This specifies the units used for distance labels. Choices are Decimal, Chains, Rods, Varas, "Feet and Inches" and Both.

**2nd Scaled Distance Options:** This option labels determines if a 2nd scaled distance is included in distance labels. This 2nd distance is scaled by the Report Scale Factor set in the Drawing Setup dialog. Choices for this option are "Label 1st Only" (label distances in current drawing units only), "Label 1st and 2nd" (label distances in both current drawing units and scaled by the Report Scale Factor) and "Label 2nd Only" (label distances scaled by the Report Scale Factor Only). There are separate settings for the 2nd Distance for the label prefix and suffix and decimal places. There is an option for labeling the scale factor used for the 2nd distance.

**Label:** This variable will be assigned as a suffix to the second scaled distance label.

**Drop Trailing Zeros in Distances:** This option allows you to drop trailing zeros on distance labels. **Leave Last Zero** will strip all except the decimal for tenths.

**Use Commas in Distance Labels:** This option formats the distances over 1000 with a commas (ie. 1,234.0).

**Arcs Tab**

This tab has settings for arc labels.

---

<table>
<thead>
<tr>
<th>General</th>
<th>Angle</th>
<th>Distance</th>
<th>Arcs</th>
<th>Series Lines</th>
<th>Parallel Lines</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arc Labels Layer</td>
<td>BRGTXT</td>
<td>Select</td>
<td>Arc Labels Style</td>
<td>ROMAN</td>
<td>Select</td>
</tr>
<tr>
<td>Arc Text Spacing Factor</td>
<td>1.050</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Arc Angle Decimals</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Arc Length Label</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Report Delta Angle as 1/2 Actual Angle</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

[Annotate Defaults dialog window]
**Arc Labels Layer:** This specifies the layer to be used for arc labels.

**Arc Labels Style:** This specifies the text style to be used for arc labels.

**Arc Angle Decimals:** Controls the number of decimals for arc angle labels.

**Arc Length Label:** Specifies the prefix label for arc length labels.

**Arc Text Spacing Factor:** This variable controls how close letters will be spaced when labeling arcs. The lower the number, the closer the spacing. The higher, the farther apart. (The suggested range between 0.8 and 1.5)

**Report Delta Angle as 1/2 Actual Angle:** The angle value in the label will be 1/2 the actual angle.

**Strip Degrees Leading Zero for Delta Angle:** Controls whether to have a leading zero which applies to delta angles under 100 degrees. For example, "054" verses "54".

**Series Lines Tab**

This tab is for settings that apply to Series Lines labels (See the section "Auto Annotate" for a detailed description of series line handling).

![Annotate Defaults window](image)

**Text Size Scaler:** This value is multiplied by the horizontal scale value to set the text size units for serial lines.

**Text Offset Scaler:** This value multiplied by the horizontal scale defines the distance that an annotation label is placed from its defining line for serial lines.

**Angle Layer:** This specifies the layer to be used for angle labels on serial lines.
Angle Text Style: This specifies the text style to be used for angle labels on serial lines.

Distance Layer: This specifies the layer to be used for distance labels on serial lines.
Distance Text Style: This specifies the text style to be used for distance labels on serial lines.

Parallel Lines Tab

This tab is for settings that apply to Parallel Lines labels (See the section "Auto Annotate" for a detailed description of parallel line handling).

Text Size Scaler: This value is multiplied by the horizontal scale value to set the text size units for parallel lines.

Text Offset Scaler: This value multiplied by the horizontal scale defines the distance that an annotation label is placed from its defining line for parallel lines.

Angle Layer: This specifies the layer to be used for angle labels on parallel lines.

Angle Text Style: This specifies the text style to be used for angle labels on parallel lines.

Load/Save: Choose these functions to load an existing annotation defaults file (.ADF) or save a new one, which will contain your current selections.

Pulldown Menu Location: Annotate
Keyboard Command: LDEF
Prerequisite: None
Auto Annotate

This command allows you to select a group of lines, arcs and/or polylines to be labeled. It allows for any combination of line and distance labeling, and also any combination of arc labeling.

You can position the features of the labels, once in the Auto-Annotate dialog, by using the Row, Side, Order, Orientation and Position Types options, all found under Lines tab. For Arcs, you can select the Arcs tab and determine the type of auto-annotating you would prefer for arc entities. As you select different options, you can see the changes in the preview display of the entry dialog. You will select the Angle Format in terms of Bearing, Azimuths and Gons and there is an important feature that allows you to avoid label overlaps. This is done by applying specific, user-defined settings. When labeling arcs, there are options to set the label prefixes for curve annotation. The Settings button will bring you to the Annotation Defaults dialog, as explained in a previous section. Defaults will restore the prior settings.

Apply Label Settings by Layer brings up another dialog box which allows you to import from file, or load, predetermined configurations. There is an option to have different label settings applied by layer. Apply Label Settings By Layer allows you to set, load, and save your preferred variables.

The Avoid Label Overlap option can bring up a special dialog called the Overlap Manager. This screen, which contains extra tools for, as an example, sliding or stacking the labels that are overlapping and conflicting with drawing entities, gives you the real-time ability to move along the plan and make your corrections. This also will help you to avoid overlapping with other labels, text, symbols and linework – including fence and utility lines. In this Overlap Manager, docked on the left side of the screen, it is recommended that you use the Back and Next button frequently in order to review, adjust and correct your drawing.

Auto-Annotate dialog starts with the Lines (tab).

**Angle/Distance:** Allows you to enter the what row the Angle label is on, what side and the order of the label on the linework. The same applies for Distance labels. Notice the preview display changing.

**Row:** Using numbers (1 or 2), or choosing None, you can determine the order and appearance of the descriptions. Note the change in the preview display.
Side: Choose inside or outside of the line.
Order: If you determine that the annotations are to be on the same row and same side of the line, then you must pick the order in which they will appear, from left to right.
Justification: This option gives the ability to left or right justify labels at ends of line or center justify the labels.
Orientation: This offers this choice between parallel or perpendicular with regards to the labels' orientation to the line being labeled.
Position Types: Determined how each label is placed in relationship to the line and the other label. The Inside/Outside For Closed Polylines treats the first position type as the inside position and the second as outside for labeling closed polylines which applies when labeling lot polylines that are closed and you want a style like distances on the inside of the lots and bearings on the outside.
Angle Format: Bearing, azimuths or gons are the choices.
Combine Common Angles: This allows the user to reduce label clutter by minimizing labeling of serial and parallel linework. Choices are Off, Series, Parallel and "Series and Parallel". Series common angles are those where serially connected linework share the same angle. Common series angles are labeled at the mid-point of the series of connected line segments. When series common angles are selected they may be drawn stacked on the same side as the distance labels or on the opposite side from the distance labels. Also, for serial common angles the total distance may be included in the label. Parallel common angles are those where adjacent areas share parallel lines that include the line that bisects the areas. In this case, only the outer-most lines of the set of parallel lines will be labeled with the angle.

The common angle labels have separate settings for layer, style, size and offset. Please see the section "Annotate Defaults" for information on how to control these settings.

The following example shows the results of combining common serial labels, including totaling of the distances:

![Example Diagram]

The following example shows the results of combining common serial and parallel labels:
Compress Labels for Short Lines: When angle and distance labels are being placed on the same side and row, this feature allows the user to place the label on different rows in the case that the label will not fit on the line otherwise. The options are Off, "Angle Above, Distance Below", "Distance Above, Angle Below", "Stacked Angle-Distance" and "Stacked Distance-Angle".

Add Space Between Angle and Distance Labels: When angle and distance labels are being placed on the same side and row, this feature allows the user to have the angle and distance labels spread apart from each other as allowed by the length of the line being annotated.

Reduce Space Between Angle and Distance Labels: When angle and distance labels are on the same row, this option puts a single space between them. Otherwise, there are two spaces.

Create Separate Angle and Distance Labels: When the angle and distance labels are on the same row, this option creates them as separate text entities. Otherwise, the labels are combined in a single text entity as long as their text styles match from Annotation Defaults.

Flip Text for Twist Screen: This option automatically flips the labels when needed to make them right-side up.

Use Line Tables: Line tables are sometimes preferred as they keep the drawing linework clean and free of labeling. Choices are Always, Never or By Scaler. If By Scalar is chosen "To Line Table Scaler" is enabled.

To Line Table Scaler: If the length of the line is less than this minimum, the line is labeled as a line table entry. The To Line Table Scaler is relative to the current horizontal scale and represents the length of the line in plotted inches.

Starting Table Number: User choice. You might change this because perhaps you have another group of line labels, in table form, in the drawing. Line table entries are numbered sequentially beginning at the line Starting Table Number. The location for the line table can be picked if there is no current table. Otherwise, Auto Annotate will add to the end of the current line table. To set the location for the current line table, run the Table Header command in the Annotate > Line/Curve Table menu.

Auto-annotate dialog box, by selecting the Arcs tab, displays the options for auto-annotating arcs. The columns are described, followed by the rest of the options.
**Label:** Here you might alter slightly the defaults by entering a letter or acronym that will represent to type of calculation. Or you could leave it alone.

**Row:** Using numbers, or choosing None, you can determine the order of the descriptions, and determine whether or not some might be left off altogether.

**Side:** Choose inside or outside of the arc.

**Order:** If you determine that the annotations are to be on the same row and same side of the curve, then you must pick the order in which they will appear, from left to right.

**Label Chord Angles in:** Bearing, azimuths or gons are the choices.

**Type of Curve:** Choose between Road and Rail.

**Flip Text on Arcs that Open to the North:** Clicking here might make for a easier to read finished plan. User preference.

**Use Symbol for Delta Angle Label:** The popular and traditional triangle-shaped symbol can be used, instead of the letter D, or any other letter(s).

**Combine Common Radii:** This allows the user to reduce label clutter by minimizing labeling of connected arc segments that share a common radius and center point. When selected, only one radius label will be generated for such arc segments. The following shows an example where a curve made of three arc segments is labeled with only one radius label. The radius label is placed offset to the mid-point of the combined arcs.
**Use Arc Tables:** Curve tables are sometimes preferred as they keep the drawing linework clean and free of labeling. Choices are Always, Never or By Scaler. If By Scalar is chosen "To Curve Table Scaler" is enabled.

**To Curve Table Scaler:** The To Curve Table Scaler applies when the Type of Arc label options is not set to Curve Table. If the length of the arc is less than this minimum, the arc is labeled as a curve table entry. The To Curve Table Scaler is relative to the current horizontal scale and represents the length of the arc in plotted inches.

**Starting Table Number:** The Starting Table Number is the starting number for the first line entered in the Curve Table. Curve Table entries are numbered sequentially from the curve Starting Table Number. The location for Curve Tables can be picked if there is no current table. Otherwise, Auto Annotate will add to the end of the current Curve Table. To set the location for the current Curve Table, run the Table Header command in the Annotate > Line/Curve Table menu.

**Stack Labels:** Stacked labels are sometimes preferred as they can help reduce label overlapping. Choices are Always, Never or By Scaler. If By Scalar is chosen "To Stack Scaler" is enabled.

**To Stack Scaler:** When Stack Labels is set to "To Stack Scaler" this control is enabled. If the length of the arc is less than this minimum, the arc is labeled as a stacked label. The To Stack Scaler is relative to the current horizontal scale and represents the length of the arc in plotted inches. The Stack Settings button is enabled when Stack Labels is set to Always or By Scaler. This button brings up the Stack Arc Labels which displays the options for creating stacked arcs labels. The columns are described, followed by the rest of the options.
**Label**: Here you might alter slightly the defaults by entering a letter or acronym that will represent to type of calculation. Or you could leave it alone.

**Row**: Using numbers, or choosing None, you can determine the order of the labels, and determine whether or not some might be left off altogether.

**Label Chord Angles in**: Bearing, azimuths or gons are the choices.

**Side**: Choose inside or outside of the arc.

**Type of Curve**: Choose between Road and Rail.

**Flip Text on Arcs that Open to the North**: Clicking here might make for a easier to read finished plan. User preference.

**Use Symbol for Delta Angle Label**: The popular and traditional triangle-shaped symbol can be used, instead of the letter D, or any other letter(s).

**Draw Leader for Stacked Labels**: When checked, a leader will be drawn from the stacked label to the mid-point of the arc.

**Stack Label Offset**: This value multiplied by the horizontal scale defines the distance that an annotation label is placed from its defining arc.

**Align Text With Chord**: Determine whether the stacked label is oriented horizontally (unchecked) or in the direction of the chord (checked).

---

**Arc Dimensions**

The Arc Dimensions style draws and annotates lines for each arc for the chord and radial lines. To use the Arc Dimensions label style, turn on **Use Arc Dimension Labeling** on the Arcs tab. On the Arc Dimensions tab, there are settings for the label prefix and position for the chord angle, chord length, radius and radial angles. You can also set the layer, color and linetype for the arc dimension lines.
Auto-Annotate dialog commands, common to both Lines and Arcs.

**Apply Label Settings By Layer:** See the Label By Label Settings dialog and details below.

**Avoid Label Overlap:** See dialog and details below.

**General Settings:** Brings you to the A ate Defaults dialog.

**Layer Settings:** Apply Label Settings By Layer option must be clicked in order to activate. You will then see the Label By Layer Settings dialog.

**Overlap Settings:** Avoid Label Overlap option must be clicked in order to activate. Brings up the Avoid Label Overlap dialog.

**Reset to Defaults:** This returns you to the default label values.

**Point Group:** This function prompts for a point group to use for the input data to annotate. The program uses the series of points to define the lines and arcs to annotate.

**Load:** You can load an existing .AAN file.

We will now say, for example, that with linework only to label in the drawing we run this routine. We first decide to go without the Avoid Label Overlap feature. This can be done by unclicking this option in the Auto-Annotate dialog. We will say that there is a fence line cutting through our property line, the property lines being the lines that we want to auto-annotate. In going without Auto Annotate's overlap protection, we perform Auto Annotate and we see that there is an overlap, with the labels running into the property lines and the fence line.
Panning and zooming the screen shows the problems we confront. Now, run Auto annotate again, but this time click ON the Avoid Label Overlap feature. Then click Overlap Settings button which brings up a dialog as shown below. This program and this specific dialog box has many different methods for fixing the overlaps. We will choose the different methods to apply.

First, we will choose Slide. This slides the labels along the linework. We can even choose a maximum amount of slide and other related parameters. We will also turn on the Stack method. The Avoid Linework Conflicts feature pertains to that fence line we have. Finally, click OK. Now can pick the linework. Note that you do not need to erase the existing auto annotate labels ahead of time. This command will remember that those labels were created with this command. It will simply replace the entire group of labels with the new auto annotate labels.

The result, with overlap detection on, is that this routine fixed 7 out of 7 of the conflicts. It slid some of the labels over and stacked others. You can also run Auto Annotate Overlap with manual mode. To do this, remove the automatic options (such as Stack, Slide, etc.) and click View Remaining Overlaps After Applying Rules ON. Say OK. It docks the Overlap Manager on the left side of the screen.

You can then fix the conflicts with this Overlap Manager by using the different methods presented in this new window. This manager will highlights the conflicts, it will, for example, slide to the next conflict and allow you to pick a new position. Hit the Next several times. Again, stack one, slide another over, and perform other changes. Then choose Close.

Also, remember that depending on the linework layer, you can even have different annotation styles. There is also an option to have different label settings "by layer". These decisions are made by using the Label By Layer Settings dialog options. To get to this dialog, click on the Layer Settings button at the bottom of the Auto-Annotate dialog.

**Label By Layer Settings option and dialog.**

![Label By Layer Settings](image)

**Layer:** Select a layer from the existing list of layers. If the linework you select and to be labeled is on this layer, the parameters that you set in this dialog will be reflected in all labels.

**Auto-Annotation Settings:** Select an existing Annotation Settings file (AAN) by clicking the File button on the right. Or stick with the defaults.

**Auto-Defaults Settings:** Select an existing Default Settings File (ADF) by clicking the File button on the right. Or stick with the defaults.

**Load:** Select this option in order to load an existing layer file (LAY) to load.

**Avoid Label Overlap option and dialog.**
Overlap Settings dialog

**Available Methods**: Your choices. Pick from these.

**Used Methods**: Different ways in which this routine attempts to resolve the label overlaps. The overlap resolution attempt methods are applied in the order listed here.

**Slide**: If this is selected then the labels will be moved parallel to your linework until they do not overlap. The labels will not move past the end of the linework or the Max Slide which you determine.

**Offset**: will move your labels perpendicular to your linework as far as you set the Max Offset.

**Table**: Replaces your labels with a numbers and create a table of the numbers with the corresponding labels.

**Reorient**: If chosen, the labels will change orientation in the plain view to avoid overlapping.

**Flip**: It will flip your label onto the other side of the linework.

**Stack**: It will stack or unstack the text of your labels to avoid overlapping.

**Move Area Labels**: This method, which only applies to area labels, will attempt to move the area label to the closest place within the area that doesn't overlap with any other labels. You can control the move interval (distance between move attempts) and total number of move attempts by setting the values "Interval (multiples of text height)" and "Max Move Attempts" in the "Move Area Labels Parameter" section:

You can use any combination of these commands by using the add/remove button. You can also determine the order in which the command tries a method by using the Move Up and Move Down buttons. If a solution is not found by using the first method then the next method is used in descending order.

**Add/Remove**: Some methods you might prefer not to use.

**Slide/Offset Parameter (multiples of text height)**: These are variable that help you to slide or offset the label(s) in question.

**View Remaining Overlaps After Applying Rules**: This option will help you to see what still needs treatment.

**View Last Overlap File**: When it is checked, the Overlap Manager will return to the previous labels that were under review.

**Skip Resolved Overlaps**: When it is unchecked, the Overlap Manager will display all the labels that were moved by the command as a final check to you.

**Restore Original Zoom**: This will restore the zoom you were previously at before running the command.

**Avoid Linework Conflicts**: This is an extra precaution for when linework conflicts exist.
If there is a conflict, the following Overlap Manager dialog appears on the screen. It zooms to the conflict and provides you with the necessary tools to resolve the issues that need to be addressed. Many of the choices selected in the earlier dialog boxes can be modified yet again in the Overlap Manager, in your quest for a clean looking drawing. Within this special window you can zoom, pan, move to the next conflict, and perform many other tasks.

The Overlap Manager screen appears as a docked dialog window to the left of the main screen.

The Overlap Manager can be used to manually check and change label overlaps. The current overlap item will be have a yellow box drawn around it to help make it clear which item is the one currently being worked on. If you check on "View Remaining Overlaps After Applying Rules" then any remaining overlaps will be zoomed in on and you will have the ability with the Overlap Manager to flip through and fix or ignore the unresolved labels. When the current overlap item is an area label, only the Move and Table button will be enabled as these are the only two manual methods that can be applied to these types of labels. For line and curve labels, all methods will be enabled.

**Prompts**

**Auto Annotate Dialog** Choose settings and click OK.

**Select Lines, Arcs, and/or Polylines to Annotate.**

**Select Objects:** *pick entities*. Select the group of lines, arcs and/or polylines you want to annotate.

**Pulldown Menu Location:** Annotate

**Keyboard Command:** autoann

**Prerequisite:** Lines, arcs or polylines to annotate

**Angle/Distance**

The Angle/Distance sub-menu contains many commands for labeling the angle and/or distance of line segments. The line segments can be defined by picking a line, picking a polyline segment, entering two point numbers or
picking two points. The angles can be labeled in bearing, azimuth or gon format. In the command names, the "," indicates which side of the line label will appear. For example, "Bearing," will label the bearing above the line and ",Bearing" will label below the line. There is also a Custom Label Formatter option. When this command is used and Option is chosen, there will appear a Custom Line Label dialog with various settings.

Prompts

Define bearing by, Points/type in Bearing/<select line or polyline>: P
1st Point?
Pick point or point number: 11
PtNo. North(y) East(x) Elev(z) Description
 11 4869.06 4390.31 0.00
2nd Point?
Pick point or point number: 2
PtNo. North(y) East(x) Elev(z) Description
 2 4610.89 4078.44 0.00

Bearing_Distance

Stacked DistanceBearing_
BearingDistance

Pulldown Menu Location: Annotate > Angle / Distance

Keyboard Command: Bearing and distance or bearing only or distance only: brg, bbrg, brgdis, disbrg, brgdis, _brgdis, dis, bbrgdis; Stacked labels: stackbd, stackdb2, stackdb3, stackdb4; Azimuth: AZI, BAZI, AZI2, AZI3, azidist2, azidist3, azidist4, dist_azi; Gon: gonlab, gonlab2, gonlab3, gonlab4.

Prerequisite: None

Custom Label Formatter AD

This command allows you to customize the labeling for lines and polylines. You are first prompted to select a line or polyline to label, given the existing defaults currently set. The linework is shown as labeled on the screen. The command line, shown below, also offers you an important choice called Options. When you type ‘O’ for options the below dialog box appears. In this dialog, there are three columns at the top of the dialog, along with other features. On the command line, there is also a choice called Format (F), which allows you to enter quick-key style keywords for quickly changing the label format. See below for these
Row: This column allows you to stack the data in different ways. You can place more than one item in the same row. If None is selected, then that item will not be displayed.

Side: This column allows you to place each item either inside or outside of the line or polyline.

Order: This column determines the order of items when they are placed in the same row.

General Settings: This button brings you to the Annotate Defaults dialog, see 'Annotate Defaults' for more.

Reset To Defaults: This button restores the default settings shown above.

Load/Save: You may also Load and Save different label configurations with the corresponding buttons.

Prompts

Options/Format/Points/<Select line or polyline>: select entity
Options/Format/Points/<Select line or polyline>: O

Custom Line Label dialog choose your preferences and click OK

You can decide to go into the Option dialog at the start of the command, or after your initial labeling. If you use the Format command line option, you will be asked to enter the Format command. The choices are:

B = bearing
A = azimuth
G = gon
D = distance
R = next row
. = switch side of line

Pulldown Menu Location: Annotate > Angle/Distance

Keyboard Command: anline

Prerequisite: An arc to label

Draw End Point Leaders

These three commands draw a pair of leaders (crow's feet) at the ends of the line or polyline segment. The segment can be selected from a line, polyline or pair of points. The leaders are drawn above or below the line or polyline, or you can pick a side, depending on which Endpoint Leader command is run. The Pick Side command gives you the ability to place the crow's feet on a selected side of the line or polyline. Controls to customize the look of the endpoint leaders are accessed through the Annotate Defaults command in the Annotate menu. The Leader Size Scaler determines the maximum length of the leader. If the line segment is too short, the leader is shortened to fit. The actual length of the leader in drawing units is calculated by multiplying the leader scaler by the drawing horizontal scale (i.e.. 0.5*40=20). The Offset Scaler sets the distance that the leader head is off the line endpoint. There are four leader styles to choose from: Arc with Arrow, Arc Only, Dash-Dot-Dash and Dashed. Endpoint leaders can be drawn together with bearing/distance annotation by having the Draw Leaders to Endpoints option on under Annotate Defaults. This Draw End Point Leaders command allows you to add the leaders as another step.

Prompts

Define line by [Points/<select line or polyline>]: Select a line or polyline.

If you wish to define by points, enter "P" at this prompt and pick points on the screen, or type in point numbers. If a coordinate (.CRD) file has not been previously loaded, a dialog will open to allow you to select a coordinate (.CRD) file to process. While using the Point selection method, the last point picked in the selection is stored in default
brackets. So if you are working around a boundary, simply press enter to accept the defaults for the first point and move ahead to the next point.

Arc with Arrow Endpoint Leader

Dashed Endpoint Leader

**Pulldown Menu Location:** Annotate

**Keyboard Command:** crowft

**Prerequisite:** None

### Dynamic Annotation Note

Bearing and distance annotations can be linked to the linework, such that the annotations will automatically update if the linework is changed. For example, if a line is moved with the AutoCAD *Move* command, the bearing label will update. This link can be found, and toggled on and off, under Object Linking in Configure > General Settings. Configure is in the Settings menu. The link is established between the label and the line, or polyline, when the label is created by commands such as *Auto Annotate*, *Line Table* or *Bearing Distance*. There are no links for annotation created using the Points option. To update bearing annotation without using the dynamic annotation, use the *Global Reannot*ate command in the Annotate menu. To remove the links between the annotation and the linework entities, use the *Remove Reactors* command, found under File > Drawing Utilities.

![General Settings](image)

### Flips Labels

#### Switch Bearing/Azimuth Quadrant

This command switches the Bearing quadrant label or adds 180° to an Azimuth label. For example, N90°32'16"E would be replaced with S90°32'16"W or AZ 78°17'18" would be replaced with AZ 258°17'18". This routine changes bearing text to read as if the bearing were in the opposite direction.
Prompts

Pick Bearing or Azimuth Text: *pick text*
Pick Bearing or Azimuth Text: *press Enter to end*

Examples of switch bearing/azimuth quadrant

Pulldown Menu Location: Annotate > Flip Labels
Keyboard Command: brgquad
Prerequisite: bearing or azimuth label

Mirror Selected Labels
This command rotates a group of text 180 degrees and maintains the same text position. Use this command to rotate any text. Ignores all entities in the selection set except text.

Before Mirror Labels

After Mirror Labels

Pulldown Menu Location: Annotate > Flip Labels
Keyboard Command: flipset
Prerequisite: Text to rotate

Mirror and Flip Selected Labels
This command mirrors the label to the other side of the labeled segment. At the new location, it then flips the label back to its original orientation. Use this command to manipulate any text. It ignores all entities in the selection set except text.
Before Mirror & Flip Labels

After Mirror & Flip Labels

**Pulldown Menu Location:** Annotate > Flip Labels >
**Keyboard Command:** MFLIP_LABELS
**Prerequisite:** Text to rotate

---

**Flip ON/OFF**
When activated, the bearing and distance text will be rotated 180 degrees when drawn.

**Pulldown Menu Location:** Annotate > Flip Labels
**Keyboard Command:** flp
**Prerequisite:** None

---

**Flip Last Label**
This command flips the last text drawn 180 degrees. Use this command to rotate your last annotation.

**Pulldown Menu Location:** Annotate > Flip Labels
**Keyboard Command:** flip
**Prerequisite:** Text to flip

---

**Flip Selected Labels**
This command rotates a group of text 180 degrees. Use this command to rotate any text. The command ignores all entities in the selection set except text.
Pulldown Menu Location: Annotate > Flip Labels
Keyboard Command: flip_labels
Prerequisite: Text to rotate

Annotate with Leader

Move Label with Leader
This command allows the user to make a leader label out of a selected angle/distance label.

Prompts:

Select Label to Move (O for Options, R for Restore): pick an angle or distance label.
Pick end point for move: pick the end point of the move (end of leader).
Select another Label to Move (O for Options, R for Restore, Enter to End): pick another angle or distance label if desired.
While moving the label, the user is shown where the leader and label will be drawn.

After Move is Completed

Select Label to Move (O for Options, R for Restore): O

When Options is chosen the "Move Label With Leader Options" dialog allows the user to customize the leader and label drawing settings:

**Minimum Leader Length Scaler:** If the distance of the move is less than this value, a leader will not be drawn.

**Draw Horizontal Leader Tick:** When checked, a horizontal leader tick will be drawn from the end of the leader towards the annotation.
**Leader Offset Scaler:** This is used to set the distance from the end of the leader and the annotation.

**Use Separate Leader Layer:** This allows the user to place the leader on a separate layer from the annotation.

**Align Label to Linework:** When selected the orientation of the label will be parallel to the linework. Otherwise the label is orientated horizontally.

**NOTE:** The leader scaler units (Minimum Leader Length Scaler and Leader Offset Scaler) are multiplied by the current horizontal scale value, which was set in the auto annotation dialog.

**Select Label to Move (O for Options, R for Restore):** R

**Select Label to Restore:** pick an angle or distance label that had been moved with the "Move with Leader" command previously.
The selected label will be restored to its previous state.

**Pulldown Menu Location:** Annotate > Annotate with Leader

**Keyboard Command:** annlead

**Prerequisite:** Angle or distance label to move.

---

**Bearing with Leader**

This command places the bearing of a line or polyline segment at a point, then plots a user specified leader line to point to the defining line or polyline. There is the ability for multi-segment leaders, and the option to align the label horizontal to the current view or parallel to the linework.

**Prompts**

**Options/Points/</Select line or polyline>:** select entity

**Pick point to start leader:** pick a point near the entity

**Label Position:** pick a point/Select the point where to place the label.

**Options/Points/</Select line or polyline>:** O

---

![Diagram of Bearing with Leader](image)

When Options (O) is chosen

**Pulldown Menu Location:** Annotate > Annotate with Leader

**Keyboard Command:** brglead

**Prerequisite:** None

---

**Distance with Leader**

This command labels the distance of a line or polyline segment at a point then draws a user specified leader line to point to the defining line. There is the ability for multi-segment leaders, and the option to align the label horizontal
to the current view or parallel to the linework.

Prompts

Define distance by, Points/<Select line or polyline>: select a line  
Pick point to start leader: pick a point near the line  
Label Position: pick a point  
Define distance by, Points/<select line or polyline>: press Enter to end

Distance-Bearing with Leader

This command labels the distance and bearing of a line at the end of a user-specified leader which points to the defining line. The line can be specified by two points or by selecting a line or polyline entity. There is the ability for multi-segment leaders and the option to align the label horizontal to the current view or parallel to the linework.

Prompts

Options/Points/<Select line or polyline>: select entity  
Pick point to start leader: pick a point near the entity  
Label Position: pick a point

Bearing-Distance with Leader

This command places the bearing and distance labels of a line or polyline segment at a selected position and draws a leader line to the defining line or polyline.

At the command prompt, type O for Options to bring up the options dialog. There is the ability for multi-segment leaders and the option to align the label horizontal to the current view or parallel to the linework.

Prompts

Options/Points/<Select line or polyline>: select entity  
Pick point to start leader: pick a point near the entity
Label Position: *pick a point* Select the point where to place the label.
Options/Points/<Select line or polyline>: *O*

Pulldown Menu Location: Annotate > Annotate with Leader
Keyboard Command: bdlead
Prerequisite: None

**Azimuth-Distance with Leader**
This command places the azimuth and distance label of a line or polyline at a point, and then plots a user specified leader line which points to the defining line or polyline. There is the ability for multi-segment leaders and the option to align the label horizontal to the current view or parallel to the linework.

**Prompts**

Options/Points/<Select line or polyline>: *pick entity*
Pick point to start leader: *pick point*
Label Position: *pick location*
Options/Points/<Select line or polyline>: *O*
Label Leader Settings dialog *make selection*
Fix Label Overlaps

This command allows you to fix label overlaps, where a conflict exists, for lines, arcs and polylines. You are immediately taken to the Avoid Label Overlap dialog. Here you can realign your labels by using a variety of optional methods. When the setting are to your liking, click OK. The command line then prompts you to select the entities for which to resolve annotation conflicts. Once you have selected your entities and hit Enter, this routine finds the conflicts and fixes the label overlaps.

When Options (O) is chosen

Pulldown Menu Location: Annotate > Annotate with Leader
Keyboard Command: azilead
Prerequisite: None
If **Slide** is selected then the labels will be moved parallel to your linework until they do not overlap. The labels will not move past the end of the linework or the Max Slide which you determine.

**Offset** will move your labels perpendicular to your linework as far as you set the Max Offset.

**Table** will replace your labels with a numbers and create a table of the numbers with the corresponding labels.

If **Reorient** is selected then the labels will change orientation in the plain view to avoid overlapping.

**Flip** will flip your label onto the other side of the linework.

**Stack** will stack or unstack the text of your labels to avoid overlapping.

**Move Area Labels** will attempt move overlapping area labels to the closest place to the original position that does not overlap with other labels. The distance between move attempts and the number of move attempts is controlled by the **Interval** and **Max Move Attempts** settings of the **Move Area Labels Parameter** section.

You can use any combination of these commands by using the add/remove button. You can also determine the order in which the command tries a method by using the **Move Up** and **Move Down** buttons. If a solution is not found by using the first method then the next method is used in descending order.

The **Overlap Manager** can be used to manually check and change label overlaps. If you check on "View Remaining Overlaps After Applying Rules" then any remaining overlaps will be zoomed in on and you will have the ability with the Overlap Manager to step through and fix or ignore the unresolved labels. When the current overlap item is an area label, only table and move buttons will be enabled as these are the only methods that apply. For line and curve label overlaps, the buttons for all methods will be enabled. Once a label is moved with the "Move with Leader", only Table, Default and "Move with Leader" will be enabled. The Default button can be used to restore the label back to its original state.

When **View Last Overlap File** is checked, the Overlap Manager will return to the previous labels that were under review.

When **Skip Resolved Overlaps** is unchecked, the Overlap Manager will display all the labels that were moved by the command as a final check to you.

**Restore Original Zoom** will restore the zoom you were previously at before running the command.
Prompts

Select Lines, Arcs, and/or Polylines for which to resolve annotation conflicts:
Select objects: select entities

Pulldown Menu Location: Annotate
Keyboard Command: annconf
Prerequisite: Annotation conflicts

Global Reannotate

This command updates bearing and/or azimuth labels for when the lines and polylines associated with the labels have been rotated after the bearings and/or azimuths were labeled.

Prompts

Select One Bearing/Azimuth Text Before Rotation: pick a bearing or azimuth label
Pick line associated with old bearing/azimuth: pick the line or polyline for the selected label
Select All or specific objects to reannotate (<All/Objects)? press Enter to update all text

Pulldown Menu Location: Annotate
Keyboard Command: globalre
Prerequisite: Bearing or azimuth labels and lines or polylines
This dialog box routine sets up the defaults for the Building Dimensions, Offset Dimensions and Adjoiner Text commands. The Load and Save functions allow you to store and recall the settings using a .svt settings file.

**Building Dimensions** allows you to set text specifications for building dimensions.
- **Layer**: Allows you to set the layer for the building text.
- **Text Style**: Allows you to set the text style for the building text.
- **Text Size Scaler**: This value multiplied by the horizontal scale determines the actual text size.
- **Decimal Places**: Allows you to set the display precision for the building dimensions. The AutoCAD Units option sets the decimals to match the current drawing precision (LUPREC system variable).
- **Drop Trailing Zeros**: Allows you to truncate trailing zeros from dimensions.
- **Characters To Append**: Allows you to set characters to add to reported dimensions.
- **Offset From Line**: Allows you to set the offset distance from the line to the dimension text.
- **Auto Label Closed Pline**: Allows you to choose between automatically labeling the Interior or Exterior or closed polylines. You may also choose none.

**Offset Dimension Text** allows you to set text specifications for offset dimensions.
- **Layer**: This option allows you to set the layer for the offset text.
- **Text Style**: This option allows you to set the text style for the offset text.
- **Text Size Scaler**: This value multiplied by the horizontal scale determines the actual text size.
- **Arrow Size Scaler**: This option allows you to set the arrow scaler to determine arrowhead size.
- **Decimal Places**: This option allows you to set the precision for the offset dimensions. The AutoCAD Units option sets the decimals to match the current drawing precision (LUPREC system variable). The Annotation Defaults option uses the distance decimal settings from the Annotation Defaults command including the option to set the decimals by the distance range.
- **Drop Trailing Zeros**: This option allows you to truncate trailing zeros from dimensions.
- **Distance In Inches**: This option allows you to use feet and inches.
- **Suppress Dim Extension Lines**: This option skips drawing extension lines.
Characters To Append: This option allows you to set characters to add to reported dimensions. Offset From Line: This option allows you to set the offset distance from the line to the dimension text. Text Alignment allows you to align text either parallel to the line or horizontally in the drawing. Position allows you to determine if you are to pick the location of the text, or if the text is automatically positioned in the drawing. Dimension Line Type allows you to determine the line style to use for dimensions. Single Arrow Line: Draws a line with an arrowhead from the dimension text to the figure. Dual Arrows Line: Draws dual arrowhead. Standard Line: Draws a line with no arrowhead from the dimension text to the figure. Curved Leaders: Draws a curved line with an arrowhead from the dimension text to the figure. Dimension Only: Draws the dimension text with no line.

Adjoiner Text allows you to set text specifications for adjoiner text. Layer: Allows you to set the layer for the adjoiner text. Text Style: Allows you to set the text style for the adjoiner text. Text Size Scaler: Allows you to set the text scaler to determine text size. Justification: Allows you to set the text justification. See the AutoCAD Reference Manual for details on each justification choice. Use MText: Chooses between creating MText and regular Text entities.

Pull down Menu Location: Annotate > Survey Text
Keyboard Command: svtextdf
Prerequisite: None

Offset Dimensions
This command labels the perpendicular distance between a point and a line or polyline. The point can be a building corner or other object. The endpoint snap is on by default for picking this point, although you may choose another snap mode manually. There is also an option for arrow only on end of line. The text layer, size, style and the dimensioning method are set in the Survey Text Defaults command, found in Settings > Configure > Survey Settings.

Prompts
[end on] Pick Bldg/Object Corner: pick a point
Pick Line To Offset From: pick a line or polyline
Offset Dimensions showing perpendicular distances from corners to property lines

**Pull-down Menu Location:** Annotate > Survey Text  
**Keyboard Command:** dimentxt  
**Prerequisite:** Line or polyline

**Building Dimensions**

This command labels the length of line and polyline segments. The label is located in the middle of the line or polyline segment. The options for Building Dimensions are set in the *Survey Text Defaults* dialog. This dialog is found in Settings > Configure > Survey Settings. One option in *Survey Text Defaults* labels all the segments of a closed polyline with one pick of the polyline. Otherwise, the procedure is to pick a line or polyline segment and then choose an alignment. Depending where the alignment point is picked, the label is drawn either perpendicular or parallel, above or below the line.

**Prompts**

**Pick Line or Polyline:** *pick line or polyline segment to label*  
**Pick Alignment:** *pick point as shown*

**Pull-down Menu Location:** Annotate > Survey Text  
**Keyboard Command:** bldgtext  
**Prerequisite:** Line or polyline
Adjoiner Text

This command draws text that is aligned with the selected line or polyline segment. The layer, style, size and justification for the text is set in the Survey Text Defaults command, found in Settings > Configure > Survey Settings. To align text that is already drawn, use the Rotate Text command found in the Edit menu.

Prompts

Pick Line or Polyline: pick a line or polyline for alignment
Starting point: pick a point to start the text
Text: MAIN STREET

Adjoiner Text aligns text with a line or polyline

Pulldown Menu Location: Annotate > Survey Text
Keyboard Command: adjntext
Prerequisite: Line or polyline

Draw Grid

This command will plot a plan view grid at a user specified distance and optionally label the northing and easting coordinates of the grid. This command takes in consideration the current screen twist angle in which case it prompts for three corner points. After selecting the corner points the dialog below will appear. The title block is assumed right justified to the lower right corner of the grid definition points. After changing any of the settings select the OK button to plot the grid.
Grid Interval: The distance between each grid line.
Horizontal Scale: Reports the scale of the current drawing. This can also be set using the Drawing Setup command in the Settings menu.
Grid Format: The Ticks Only option will draw tick marks instead of grid lines. Selecting the Ticks Only option activates the Tick Size option for sizing the tick marks. There is also a Full Grid and Perimeter option.
Layout of Ticks: This option places the ticks throughout the interior of the grid work or just on the perimeter of the grid boundary.
Use ‘-’ for Negative Coordinates: This option labels the negative grid coordinates with a ‘-’.
Label Grid: Selecting this Grid Text Setting option labels the grid coordinates.
Use Split Coordinates Layout: Puts the thousands digits above the grid line and the hundreds digits below the grid line.
Text Size Scaler: This scaler, multiplied by the Horizontal Scale, determines text size.
Offset Scaler: This scaler, multiplied by the Horizontal Scale, determines the offset for text.
Avoid Title Block Area: This Title Block Exclusion option will allow you to not draw grid lines or tick marks in the title block area. It is for making sure that the grid does not overwrite the title block.
Pick Title Block Corner: This option prompts you to pick the corner of the title block to determine where the grid lines and ticks will be omitted.
X Dimension Scaler: This is the horizontal dimension of the title block. This option is automatically filled in when the Pick Title Block Corner option is selected.
Y Dimension Scaler: This is the vertical dimension of the title block. This option is automatically filled in when the Pick Title Block Corner option is selected.
Label Prefix North: This option is for assigning a prefix to the northing grid line and tick mark coordinates.
Label Prefix East: This option is for assigning a prefix to the easting grid line and tick mark coordinates.

Prompts

Pick or Type Lower Left Corner Point: endp of (pick point)
Pick or Type Upper Right Corner Point: endp of (pick point) Select the corners of your border in which you want the grid plotted.
Draw Plan View Grid Dialog
**Pulldown Menu Location:** Annotate  
**Keyboard Command:** dgrid  
**Prerequisite:** None

---

**Draw Legend**

This command draws a legend based on a legend definition file. After choosing the legend definition (.LGD) file to use, a dialog displays the current definitions. The legend definition file consists of descriptions assigned to text, symbols, linetypes and hatch patterns. The default legend that is included with Carlson is called legend.lgd.

![Legend Definitions Dialog Box](image)

**Edit** edits a definition, select it and then click on the Edit button. This brings up the Symbol Definition dialog box.
• **Item Type:** Each item can be either a simple text label or a symbol from the drawing.

• **Text Name:** This is the legend label associated with the specified Description.

• **Symbol Name** designates the symbol to draw in the legend. You can either type in the symbol name or choose it from a slide library by picking the appropriate Select button.

• **Description** is the name of the symbol.

• **2nd Description** is an optional additional name for the symbol.

• The **Hatch Scale and Color** options are used if the symbol uses a hatch pattern.

• **Include in Legend:** This option corresponds to the Include column on the Legend Definitions dialog box. Not all the defined entries need to be drawn. An entry will be drawn (shown as Yes) if the Include in Legend box in the Symbol Definition dialog box is checked.

• **Use Individual Layer:** This option allows for drawing the legend item on a separate layer besides the layer from the Draw function.

• **Select Point Symbol:** This option displays a slide library of point symbols to choose from.

• **Select Drawing Linetype:** This option displays a linetype name list to choose from.

• **Select Library Linetype:** This option displays a slide library of linetypes to choose from.

• **Select Hatch Pattern:** This option displays a slide library of hatch patterns to choose from.

**Add** inserts a new definition to the definitions. To insert a new definition, pick an existing definition and click on the Add button. The new definition is added immediately following the existing definition.

**Add from Drawing** adds entries to the legend table for each different symbol that is selected from the drawing.

**Remove** removes the selected definition.

**On** switches the Include field in the selected definition to Yes.

**Off** switches the Include field in the selected definition to No.

**On/Off by Drawing** prompts you to select symbols from the drawing. Symbols found will be turned on, all others will be turned off. This helps you create a legend that includes only symbols found in the drawing.

**Description by Field-to-Finish** uses the description from the Field-to-Finish code definition for symbols that match
the code symbol.

**Sort** sorts the definitions alphabetically and numerically.

**Draw** draws the included definitions as a legend.

**Report** uses the Report Formatter to make a customized report of the names and descriptions in the legend.

**Move Up** This option moves the selected definition up one row. Legend entries are drawn in the order that they are defined.

**Move Down** moves the selected definition down one row. Use the Move Up and Move Down buttons to change the order that the symbols will be drawn.

**Save** saves the legend file as its original file name.

**Save As** saves the legend file to a new file name.

**Exit** exits the command back to the drawing window.

**Draw** opens the Draw Legend dialog.

![Draw Legend Dialog]

- **Text Size** sizes the text in the legend. It defaults to the value from Drawing Setup in the Setting menu.
- **Symbol Size** defaults to the value from Drawing Setup in the Settings menu.
- **Hatch Size** sizes the hatch pattern scaler.
- **Line Size** sizes the lines in the legend.
- **Layer Name** defines the layer for the legend.
- **Style Name** sets the style for the legend labels.
- **Draw 2nd Description** creates another column with the 2nd descriptions for the symbols.

- **Draw Legend Title** draws the text from the Name, Title Line 1 and 2 fields.
- **Draw Header** adds a header row with the Symbol, Desc and 2nd Desc fields at the top of the columns.
- **Draw Grid Lines** creates a legend table with lines for the rows and columns.

- **Layout Left Justified** has the symbol on the left and then the labels left-justified.
- **Layout Right Justified** has the symbols on the left and the labels right-justified.
Prompts

Specify Legend Definition File Dialog *choose the file to process*
Legend Definitions Dialog
Draw Legend Dialog
Enter or pick upper left point for legend: *pick a point*

Sample legend created by Draw Legend

**Pulldown Menu Location:** Annotate  
**Keyboard Command:** legend  
**Prerequisite:** None

**Draw North Arrow**

This command inserts a north arrow symbol. You can select from several styles of arrows, and you can add your own by using the Edit Library button which is similar to the Symbols Library command. The north arrow symbol library is stored in the narrow.dta file in the USER folder.

The Label Geodetic North option draws a line for geodetic north and labels the convergence angle between grid and geodetic north.

The Label Magnetic North option draws a line for magnetic north and labels the angle.
**Prompts**

**Draw North Arrow Dialog** *choose an arrow symbol, layer and other variables*

**Specify insertion point:** *pick a point*

**X scale factor** <1> / **Corner** / **XYZ**: *press Enter*

**Y scale factor** (default=X): *press Enter*

**Rotation angle** <0d0'0' '>: *press Enter*

**Pulldown Menu Location:** Annotate

**Keyboard Command:** narrow
**Draw Barscale**

This command draws a barscale at the user-specified scale. The command options are set in the dialog shown here. The Horizontal Scale controls the size and labels for the barscale. For example, enter 50 for 1 inch = 50 feet in English mode. The Barscale Style chooses between different barscale formats.

![Draw Barscale dialog](image_url)

**Prompts**

- **Draw Barscale options dialog**
- **Pick location for barscale:** pick a point
- **Pulldown Menu Location:** Annotate
- **Keyboard Command:** barscale
- **Prerequisite:** None

**Point Table**

**Create Point Table**

This command draws a table of the coordinate data of the points from the current coordinate (.CRD) file using different methods displayed at the top of the dialog. The command displays the dialog shown below for setting all of the point table options. At the top of the dialog enter the range of point numbers to label, do a Screen Pick or select a Point Group(s). You can also specify the order and format of the table columns. If you do not want to include a data type, set the Sequence number to blank. The Northing/Easting Format can be set to Degrees/Minutes/Seconds for when the coordinate file contains latitude and longitude. The Max Rows Per Column setting makes the program start a new table when the specified max points is reached. The Use Table Entity option create a Carlson Table entity which has more formatting options and can be adjusted with the Edit > Table functions.

**Prompts**

- **Point Table Generator Dialog**
- **Building Data List ... Done.**
Table Upper Left Corner: *pick a point*
Generating Table... Done.

Typical Point Table

**Pulldown Menu Location:** Annotate > Point Table

**Keyboard Command:** pointtbl

**Prerequisite:** A coordinate (.CRD) file

### Update Point Table

This command prompts you to select an existing point table. The program then reads the settings from this table and displays these settings in the same dialog used in *Create Point Table*. You can change any of the table format options. The program will also update the table to reflect any changes to the coordinate (.CRD) file.

#### Prompts

**Select existing point table:** *pick anywhere on the point table or select points from the screen*

**Point Table Generator Dialog**
Point To Point Table

This command creates a course table of the angle and distance between pairs of points. The table data is entered in a spreadsheet. Fill in the From and To point numbers. The program reads the coordinates for the points from the current coordinate file and fills out the Angle and Distance. There are settings for the Angle Format as either Bearing or Azimuth, Decimals and Suffix for the distance, and Header labels for the table.

The Add From List button selects points from the current coordinate file. The Screen Pick button prompts to pick the points from the drawing.

Once the data is entered, use either the Create Table or Report buttons. The Create Table function draws the table in the drawing. The Report function uses the Report Formatter to create a user-specified report.

![Image of Point to Point Table dialog box]

![Image of Course Table]

Pulldown Menu Location: Annotate
Keyboard Command: p2ptable
Swing Table

This command creates a swing table. From two reference points, the table reports the two distances to target points. Use the Add function to fill in the spreadsheet. The Add function prompts for two reference points and then the target points. You can also edit the spreadsheet directly. When the data is ready, use the Create Table function to draw the table. Use the Report to use the Report Formatter to make a custom report.

Prompts

Reference Point 1 (pick point or point number): pick a point
Reference Point 1 Name <A>: IP SET
Reference Point 2 (pick point or point number): pick a point
Reference Point 2 Name <B>: CM
Target Point (pick point or point number): pick a point
Target Name <5>: press Enter
Target Description: press Enter
Target Point (pick point or point number or Enter to end): press Enter

Pulldown Menu Location: Annotate
Keyboard Command: swingtbl
Prerequisite: None

**Line/Curve Table**

**Table Defaults**

This command sets the format for line and curve tables. Line and curve tables are commonly used in situations where:

1. The amount of line/curve annotation in the drawing itself makes the drawing look too "cluttered," and/or
2. The length(s) of the line(s)/curve(s) are too short for the annotation label being placed

You specify the label and table attributes in the Line/Curve Table Defaults dialog:

**Combine Line and Curve Tables:** This option makes a single table with both line and curve data. When this option is active, the curve settings govern and the line settings aren't used. For line segments, the chord length and chord bearing fields are used for the line length and bearing. Typically the chord length and chord bearing would be set to Sequence numbers 1 and 2. Also, under Curve Table Labels you can set the headers for curve number to "ID", chord length to "Length" and chord bearing to "Bearing" to make the headers apply for both lines and curves.

<table>
<thead>
<tr>
<th>ID</th>
<th>LENGTH</th>
<th>BEARING</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>161.52</td>
<td>N 66°32'02&quot; E</td>
</tr>
<tr>
<td>2</td>
<td>142.12</td>
<td>N 78°41'24&quot; E</td>
</tr>
<tr>
<td>3</td>
<td>202.36</td>
<td>N 77°30'20&quot; W</td>
</tr>
<tr>
<td>4</td>
<td>120.27</td>
<td>N 51°07'27&quot; E</td>
</tr>
</tbody>
</table>

**Label Text Layer:** Click the Set button or specify the layer of the annotation which is applied to the line/curve itself.

**Label Text Style:** Click the Set button or specify the text style of the annotation which is applied to the line/curve itself.

**Label Text Size:** Specify the text size of the annotation which is applied to the line/curve itself.
Line Label Prefix: Specify a prefix which should be inserted prior to each line number. The prefix can be an alpha-numeric string.

Line Table Title: Specify a caption for the line table.

Table Text Layer: Click the Set button or specify the layer of the annotation which is inserted to the line/curve table.

Table Text Style: Click the Set button or specify the text style of the annotation which is inserted to the line/curve table.

Table Text Size: Specify the text size of the annotation which is inserted to the line/curve table.

Row Height Factor: Indicate a positive, non-zero multiplier of the Table Text Size to help adjust spacing for each row in the table.

Curve Label Prefix: Specify a prefix which should be inserted prior to each curve number. The prefix can be an alpha-numeric string.

Curve Table Title: Specify a caption for the curve table.

Set Line Table Labels: See the expanded Set Line Table Labels section below.

Set Curve Table Labels: See the expanded Set Curve Table Labels section below.

Prompt for Label Location: When enabled, this option prompts you to pick the location for the label placed onto the line/curve itself. If this is disabled, the location is chosen automatically.

Label Symbol: Select a geometric shape that is placed around the label that is applied to the line/curve itself.

Distance Format: Indicate how distances for the lines are reported:

- **Horizontal:** The distance displayed is only the horizontal distance, even if the selected entity has different "Z" values at either end of the line.
- **Slope:** The distance measured is the slope distance, used mostly for 3D polylines to get their true length.
- **None:** For a table of angles only.

Total Distances: Adds a row at the bottom of the line table to label the total distance for the table.

Label Angles in: Indicate how the line direction is labeled:

- **Azimuth:** The angles are reported as azimuths.
- **Bearings:** The angles are reported as bearings.
- **Gons:** The angles are reported as gons.
- **None:** For a table of distances only.

Automatic Table Update: Indicate if labels in the table should be re-sequenced:

- **On:** This option renumbers the other table entries and the associated labels in the drawing if a new (but previously used number) is specified for the table. For example, if a line table contained lines #1-5 and a line #4 was added, the new line #4 would be inserted into the table and the previous lines #4 and #5 would be updated to #5 and #6. The L4 and L5 labels on the lines would also be updated to L5 and L6.
- **Off:** You must manually pick the entry location and update the labels.

Label Alignment: Indicate the method by which the label is oriented on the line/curve itself:

- **Horizontal:** This option places the label horizontal to the current screen alignment, as defined by the various Twist Screen commands (Standard, Line, Polyline or Text, Surveyor or Restore Due North).
- **Parallel:** This option will orient the label parallel to the line or curve chord.

Use Table Entity: When enabled, Line and Curve Tables can be further manipulated with the Split Table, Merge Tables and Edit Table Values commands. The **Row Height Factor** controls the height of the table rows.

Combine Equal Rows: When enabled, lines or curves that share identical geometry with other lines and curves can assume the number of the equivalent line/curve. As an example, if a line 100 feet long on a bearing of N 90d00'00"
E is assigned a label of L3 and additional lines with this geometry are labeled, you will have the option of re-using the L3 label for these additional lines. In other words, a single label reference in the table can correlate to many identical entities in the drawing and can keep the overall length of the line/curve table to a minimum.

**Append First Table Item To Line/Curve Label:** When enabled, an additional reference item from the Line/Curve Table will be placed alongside the label number assigned to the line/curve itself.

**Curve Options:** Indicate the order in which curve labels shall be inserted into the curve table. Entries left blank (empty) will not be listed in the curve table.

**Load:** Loads a previously saved collection of Line/Curve Table Default values (*.LCT) into memory.

**Save:** Saves the current Line/Curve Table Default values to a*.LCT file.

Selecting the **Set Line Table Labels** option allows you to control the label, column width, text justification and displayed precision for the options selected in the Line Table Distance and Label Angles In controls.

With the above settings, you might find the Line Table more aesthetically pleasing as it produces the following example:

The prefix flexibility and the fact that the text used for the column header can be changed, means that line and curve tables can be plotted in any language. For example, in Puerto Rico survey plats are typically submitted in bearings, in meters and in Spanish. For that location, the table could be reconfigured as shown here:
This would lead to the following line table (see the Notes section below for additional information):

![Line Table Labels](image)

Essentially identical to the Set Line Table Labels command, the Set Curve Table Labels command allows you to control the label, column width, text justification and displayed precision for the options selected in the Curve Options control.

![Curve Table Labels](image)
Note:

- Changing the distance suffix to "m" (or omitting any suffix by making it blank) is accomplished in the more general command of Annotate Defaults.
- Reporting distance units in a unit of measure different from that of the current project is accomplished via the Drawing Setup > Report Distance Scale Factor option and the Annotate Defaults command.
- Physical changes to the lines/curves will trigger label updates if the Link Labels with Linework option (if available) is enabled under Carlson Configure > General Settings.

Pulldown Menu Location(s): Annotate > Line/Curve Table
Keyboard Command: tdef
Prerequisite: None

Table Header
This command draws the column header labels for the Curve Table and Line Table commands. When prompted for the starting point, the user may enter a coordinate or pick a point on the screen. The starting point location that the curve or line table command defaults to is one row below the start of the header labels.

<table>
<thead>
<tr>
<th>CURVE</th>
<th>RADIUS</th>
<th>ARC LENGTH</th>
<th>CHORD LENGTH</th>
<th>CHORD AZIMUTH</th>
<th>DELTA ANGLE</th>
</tr>
</thead>
</table>

Curve table header (C option)

Prompts

Type of table [Line/<Curve>]? C
Starting point of Curve table text <(6585.0 -704.0 0.0)>: pick point

Pulldown Menu Location: Annotate > Line/Curve Table
Keyboard Command: tabhead
Prerequisite: None

Set Table Position
This command sets the position for adding line table entries. The next line table rows will start from this point. To add to an existing table, pick a point at the lower left of the existing table.

Pulldown Menu Location: Annotate > Line/Curve Table
Keyboard Command: set_tbl
Prerequisite: None

Curve Table
This command will compute curve data and draw it in tabular form using the settings specified in Table Defaults. The program computes the curve data from an arc entity, an arc segment of a polyline or from specified points on an arc. The curve data includes radius, length of curve, chord length, chord bearing, tangent and delta or included angle. The current curve table numbers are remembered between drawings. The user is prompted for curve number (default is sequential starting with 1) and the starting point of the table. The curve is labeled with a C#, where # is the sequential curve number. After picking the starting point of the table, the placement point for the other table entries will default to the next position and you can just press Enter unless you want to relocate the table. The Auto Annotate command can also create curve tables. Use the Table Header command to draw the column header of the curve data names.
Prompts

Define arc by, Points/<Select arc or polyline>: pick an arc
Enter curve number <1>: press Enter
Starting point of curve table text <(5000,5000)>: pick a point in a clear area of the drawing
Define arc by, Points/<Select arc or polyline>: pick another arc
Enter curve number <2>: press Enter
Starting point of curve table text <(4030,4490)>: press Enter to use next position
Define arc by, Points/<Select arc or polyline>: press Enter to end

<table>
<thead>
<tr>
<th>CURVE</th>
<th>RADIUS</th>
<th>ARC LENGTH</th>
<th>CHORD LENGTH</th>
<th>CHORD BEARING</th>
<th>DELTA ANGLE</th>
<th>TANGENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1</td>
<td>80.44</td>
<td>53.73</td>
<td>54.77</td>
<td>S 70°32'43&quot; W</td>
<td>39.54</td>
<td>31.59</td>
</tr>
<tr>
<td>C2</td>
<td>107.82</td>
<td>79.59</td>
<td>74.69</td>
<td>N 7°29'44&quot; W</td>
<td>49.41</td>
<td>39.32</td>
</tr>
<tr>
<td>C3</td>
<td>110.31</td>
<td>91.29</td>
<td>91.45</td>
<td>S 83°33'00&quot; E</td>
<td>48.58</td>
<td>50.24</td>
</tr>
</tbody>
</table>

Pulldown Menu Location: Annotate > Line/Curve Table
Keyboard Command: arctabl
Prerequisite: None

Line Table

This command will compute line data and draw it in tabular form, using the settings specified in Table Defaults. The program computes the bearing and distance from a line, polyline segment or between points. The current line table numbers are remembered between drawings. The line is labeled with a L#, where # is the sequential number of the line picked. The bearing and distance will then be drawn in tabular form similar to the previous Curve Table command. The Auto Annotate command can also create line tables. Use the Table Header command to draw the column header of the line data names.

<table>
<thead>
<tr>
<th>LINE</th>
<th>BEARING</th>
<th>DISTANCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>L1</td>
<td>N 22°33'19&quot; E</td>
<td>31.9873'</td>
</tr>
<tr>
<td>L2</td>
<td>S 89°00'57&quot; W</td>
<td>355.8657'</td>
</tr>
<tr>
<td>L3</td>
<td>N 31°35'59&quot; E</td>
<td>37.0750'</td>
</tr>
</tbody>
</table>

Pulldown Menu Location: Annotate > Line/Curve Table
Keyboard Command: linetabl
Prerequisite: None

Railroad Curve Table

This command is exactly like Curve Table, except the curve data is calculated for Railroad curves. See the Curve Table command for more details.

Pulldown Menu Location: Annotate > Line/Curve Table
Keyboard Command: rr_curvetbl
**Edit Table Properties**

This command allows you to edit the properties of an entity based table.

For general tables, the Edit Table Options dialog is shown. In the dialog, you can change the header labels, width, word wrap, size, alignment and style. The text size is set by the Scale multiplied by the Horizontal Scale from Drawing Setup. The Wrap option automatically makes multi-line rows for long text strings. There are settings for the table colors, title and layer.

For line and curve tables, the Line/Curve Table Defaults dialog will be displayed. Here you can change the settings of the selected table. Change the settings for either line or curve tables depending upon the type of table selected. The changes will be reflected once the user selects the OK button.

Text Layer and Text Style determine the layer and style of the line/curve table text. The distance for line tables can be labeled in horizontal or slope distance. The Automatic Table Update option will automatically insert the entry into the line or curve table. The auto update will renumber the other table entries and the associated labels in the drawing. For example, if a line table had lines #1-5 and a line #4 was added, then the new line #4 would be inserted into the table and the previous lines #4 and #5 would be updated to #5 and #6. The L4 and L5 labels on the lines would also be updated to L5 and L6. Without the automatic update option, the entry location must be picked and the labels updated manually. The Label Alignment determines the orientation of the L# or C# that is labeled on the line or curve. Horizontal will make the label horizontal to the current twist screen and Parallel will draw the label parallel with the line or curve chord. The Line and Curve Label Prefix sets the text before the number that is drawn in the table and on the line or curve (i.e. "L3" or "Line3"). The Curve Options specifies which curve data to include in the table and the order. You specify the label and table attributes in the Line/Curve Table Defaults dialog.
**Label Text Layer**: determines the layer of the line/curve text.
**Label Text Style**: determines the style of the line/curve text.
**Label Text Size**: determines the size of the line/curve text.
**Line Label Prefix**: determines the prefix for each line.
**Line Table Title**: draws a title row at the top of the line table with this string.
**Table Text Layer**: determines the layer of the line/curve table text.
**Table Text Style**: determines the style of the line/curve table text.
**Table Text Size**: determines the size of the line/curve table text.
**Curve Label Prefix**: determines the prefix for each curve.
**Curve Table Title**: draws a title row at the top of the curve table with this string.
**Prompt for Label Location**: prompts you to pick the location to label each line or curve. If this is not selected, the location is chosen automatically.

Under **Line Table Distance**, the method for measuring distance is specified.
**Horizontal**: The distance measured is only horizontal, even if the line is a 3D polyline.
**Slope**: The distance measured is the slope distance, used mostly for 3D polylines to get their true length.

Under **Label Angles in**, the type of angle is selected.
**Azimuths**: The angles are reported as azimuth.
**Bearings**: The angles are reported as bearings.
**Gons**: The angles are reported as gons.

Under **Automatic Table Update**, the option automatically inserts the entry into the line or curve table. The auto update renumerates the other table entries and the associated labels in the drawing. For example, if a line table contained lines #1-5 and a line #4 was added, then the new line #4 would be inserted into the table, and the previous lines #4 and #5 would be updated to #5 and #6. The L4 and L5 labels on the lines would also be updated to L5 and L6. If you set the Automatic Table Update to Off, you must manually pick the entry location and update the labels. If Automatic Table Update is set to On, the table is updated automatically whenever the line is modified.

**Label Alignment** determines the orientation of the L# or C# that is labeled on the line or curve. **Horizontal** will make the label horizontal to the current screen alignment, **Parallel** will draw the label parallel to the line or curve chord. Under Curve Options, you specify which curve data to include in the table and the order.
Use Table Entity: will use single block for the whole table. Otherwise, each row is a separate block.

Combine Equal Rows: will use the same line or curve number when the data exactly matches an existing row in the table. For example, if two line segments have the same bearing and distance, then they would both get the same line# (ie. "L5").

Display First Row With Table Reference: When there is room on the line or arc, this option will label both the number and the first column data value from the table on the line or arc. For example, if the first curve table column is for radius and the arc length is big enough to fit the label, then the program would label both the curve # and the radius (ie. "C5 R=100.0").

Selecting "Set Line Table Labels" will lead you to the Line Table controls, as "Set Curve Table Labels" (see graphic at end of this command page) leads to the Curve Table controls. For fields that apply to the Report Scale Factor from Drawing Setup, there is a second Scaled Label name for the table header. This scale factor can be used for reporting both grid and ground or both english and metric distances. The options in “Set Line Table Labels” are shown below:

With the above settings, for example, the Line Table appears as shown below. For improved "aesthetics", you might prefer to change the Bearing justification to "Center", for example.

<table>
<thead>
<tr>
<th>LINE</th>
<th>BEARING</th>
<th>DISTANCE</th>
</tr>
</thead>
<tbody>
<tr>
<td>L1</td>
<td>S 58°18'48&quot; W</td>
<td>87.33'</td>
</tr>
<tr>
<td>L2</td>
<td>S 75°06'27&quot; E</td>
<td>148.57'</td>
</tr>
<tr>
<td>L3</td>
<td>N 88°27'07&quot; E</td>
<td>63.44'</td>
</tr>
<tr>
<td>L4</td>
<td>N 58°40'01&quot; W</td>
<td>63.44'</td>
</tr>
</tbody>
</table>

To save space, you can reduce the size of the "Distance" column from 11.5 to 10. Note that using the Line Label Prefix option, L1 and L2, for example, can read Line1 and Line2, and for that, you may want to expand the "Width" setting for the Line column. The prefix flexibility, and the fact that the text used for the column header can be changed, means that line tables and curve tables can be plotted in any language. In Puerto Rico, for example, surveys are typically conducted in bearings, in meters and in Spanish. For that location, the table could be reconfigured as shown here:
This would lead to the following line table:

<table>
<thead>
<tr>
<th>LINEA</th>
<th>RUMBO</th>
<th>DISTANCIA</th>
</tr>
</thead>
<tbody>
<tr>
<td>L1</td>
<td>S 58°18'48&quot; W</td>
<td>87.33m</td>
</tr>
<tr>
<td>L2</td>
<td>N 88°27'07&quot; E</td>
<td>63.44m</td>
</tr>
<tr>
<td>L3</td>
<td>N 58°40'01&quot; W</td>
<td>63.44m</td>
</tr>
</tbody>
</table>

Note that changing the distance suffix to "m" (or omitting any suffix by making it blank) is accomplished in the more general command Annotation Defaults.

Finally, below we see the dialog that appears when you choose Set Curve Table Labels.

Prompts

Select a line or curve table to modify: pick an entity based line or curve table.

Pulldown Menu Location: Annotate > Line/Curve Table, and Edit > Table
Keyboard Command: tabedit
Prerequisite: An entity based line or curve table.

Edit Table Values
The **Edit Table Values** permits the modification of any of the text labels found within a Carlson table entity. A Carlson table can be created using the Report Formatter, the Draw > Table command, or by Line or Curve table created with the Use Table Entity option enabled under Line/Curve Table Defaults.

To sort the table, you can pick on the header in the spreadsheet for the column to sort by.

---

### Add Row:
Adds a blank line to the end of the spreadsheet control.

### Insert Row:
Inserts a blank line immediately preceding the currently selected line in the spreadsheet control.

### Delete Row:
Removes the currently selected line from the spreadsheet control.

### Add Column:
Adds a blank column to the end of the spreadsheet control.

### Insert Column:
Inserts a blank column immediately preceding the currently selected column in the spreadsheet control.

### Delete Column:
Removes the currently selected column from the spreadsheet control.

### Report:
Sends the current content of the spreadsheet control to the Standard Report Viewer.

### Export:
Exports the current content of the spreadsheet control to an XLS file compatible with most spreadsheet applications, including Microsoft Excel (R).

Through the use of the Insert and Delete commands along with standard Windows Copy (Ctrl+C) and Paste (Ctrl+V) functionality, it is possible to return the list above into a normal-order list as illustrated below:
Note:

- Changes to the direction or length values **DO NOT** change the direction or length of the corresponding line or curve entity in the drawing!

**Prompts**

Select an entity table to modify: *Graphically select any portion of a table that is to be edited*

Pulldown Menu Location(s): Annotate > Line/Curve Table

Keyboard Command: edittbl

Prerequisite: A line or curve table created with the Use Table Entity option enabled under Line/Curve Table Defaults

**Split Table**

The **Split Table** command allows you to break a Line or Curve table created with the Use Table Entity option enabled under Line/Curve Table Defaults. This is commonly desired when a table is too lengthy to fit in its entirety on a plat. Splitting the table into two or more smaller tables allows the tables to be independently positioned on the plat. For example:

Becomes:
Note:

- In the example above, the initial table was first split at "L2" and then again at "L3".
- Split tables can be re-assembled through the use of the Merge Tables command.

Prompts

Select row of table to perform split on: *Graphically select the last row of the table that is to be retained in the original table*

Pulldown Menu Location(s): Annotate > Line/Curve Table

Keyboard Command: splittbl

Prerequisite: A line or curve table created with the Use Table Entity option enabled under Line/Curve Table Defaults

Merge Tables

The **Merge Tables** command allows you to combine two Line tables or two Curve tables into a single table. Both tables in the merge must have been created with the Use Table Entity option enabled under Line/Curve Table Defaults.

For example:
Can become:

Note:
- In the example above, table "L1" was merged with table "L4" and then the modified "L1" table was merged with table "L3".
- Table numbers can be re-ordered through the use of the Edit Table Values command.

Prompts

Select first table of merge: Graphically select the first of two tables that should be combined together
Select second table of merge: Graphically select the second of two tables that should be combined together

Pulldown Menu Location(s): Annotate &acirc;&dagger; Line/Curve Table
Keyboard Command: splittbl
Prerequisite: Two or more line or curve table created with the Use Table Entity option enabled under Line/Curve Table Defaults. Each table in the merge must contain the same number of columns as the other table.
Order Table

This command orders the tags for line or curve tables to make the tags easier to reference in the drawing. To run this command, simply pick the line or curve table to order. At the command prompt, type O for Options to select the ordering method. The Alignment Polyline method lets you pick a polyline such as a centerline to have the tag order follow the polyline.

Prompts

Select table to order (O for Options): pick table
Select table to order (O for Options): press Enter

Pulldown Menu Location: Annotate > Line/Curve Table
Keyboard Command: order_tbl
Prerequisite: line or curve table

Delete Table Elements

This command erases rows from line or curve tables. The table entries following the removed rows are automatically repositioned and renumbered. The line or curve labels on the linework in the drawing are also updated.

Pulldown Menu Location: Annotate > Line/Curve Table
Keyboard Command: del_tbl
Prerequisite: Line or curve tables

Annotate Arc

Label Arc

This command labels the arc data along the arc between the endpoints of the arc. The curve information is also displayed. The format for the label is set in the dialog shown here. For each arc data value, you can specify the label, the row number, and the side of the arc it will appear on. If a row number is left blank, then that value is not labeled. There is a choice of labeling inside or outside of the arc. Annotation is drawn as a block. The advantage of this is that the characters, rather than being individual entities, are plotted as a single entity that can be moved and edited as a unit. You would need to explode the "blocked" text in order to edit the text. A toggle button determines whether the user wants to flip the text on arcs that open to the top of the drawing.

Prompts
Define arc by, Points/ <select arc or polyline>: select arc
After selecting the arc or polyline arc segment the command displays the dialog below. Select the OK button and the arc is labeled with the current settings of the dialog.

Examples of Label Arc (above and below)
Example of Stack Label Arc

**Pulldown Menu Location:** Annotate > Annotate Arc

**Keyboard Command:** labarc

**Prerequisite:** Arc or polyline should be drawn before execution

---

**Stack Label Arc**

This command draws a small table of curve data. Unlike the command *Label Arc*, instead of fitting the text on the arc, this command lines the data up in rows. The command prompts to select an arc, define the arc by three points, or type O for Option to display the dialog shown here. For each type of arc value, you can specify the label and the sequence number. Under Label Options, the Stack Label Arc data table will display the values in the order by sequence number. There are also settings to justify label left or right.
Under Label Options, the data table will display the values in order based upon sequence number. For each of the arc properties, you can set the Label prefix, Row and Order. For multiple labels on the same row, the Order controls the label sequence for that row. The Header field is just the specified label and doesn't have an arc value. To display the special C/L label, enter \U+2104 in the label.

Chord Angle Mode allows you to set how the chord and radial angles are labeled as azimuth, bearing or gon.

Curve Angle Mode allows you to set how the delta angle and degree of curve are labeled as degree/minute/second or gon.

The Type of Curve option determines the type of curve.

Roadway: The length is determined as the true length of the curve.

Railroad: The length is adjusted based on 100-foot chord segments.

Justify sets the alignment for the text as left, center or right.

Flip Labels controls whether the text is drawn upside down in the current twist screen view.

The Use symbol for Delta Angle option uses a delta triangle symbol for the prefix.

Draw Leader Horizontal Tick draws a short horizontal line at the label end of the leader.

Align Text With Chord sets the angle of the text to match the chord angle. Otherwise, the text is draw horizontal to the current twist screen.

General Settings shows Annotation Defaults which has settings such as Text Size Scaler which apply to this routine.

Reset To Defaults puts the settings back to built-in defaults.

Load and Save functions store and recall the settings to an .ANS file. This is a way to share a label style with others or manage different styles.

Prompts

Options/Points/<Select arc>: P The P option causes the command to prompt for points on the arc. This can be
useful for labeling sub-arcs such as lot corners of a cul-de-sac.
Pick point or point number for Endpoint of arc: pick a point
Pick point or point number for Radius: pick a point
Pick point or point number for Other Endpoint: pick a point
Direction of curve [Left/<Right>]? press Enter for right
Pick stack label point (Enter for none): pick a point
Pick point to start leader at ([Enter] for none): pick a point
To point: pick a point
Options/Points/Select arc (Enter to end): press Enter to end

Pulldown Menu Location: Annotate > Annotate Arc
Keyboard Command: slabarc
Prerequisite: an arc entity or arc points

Custom Label Formatter
This command allows you to customize the labeling for arcs. You are first prompted to select an arc to label, given the existing defaults currently set. The arc is shown as labeled on the screen. The command line, shown below, also offers you an important choice called Options. When you type 'O' for options the below dialog box appears. There are four columns at the top of the dialog along by other features.
**Label**: This first column allows you to set the prefix that will go before your arc data.

**Row**: This column allows you to stack the data in different ways. You can place more than one item in the same row. If *None* is selected then that item will not be displayed.

**Side**: This column allows you to place each item either inside or outside of the arc.

**Order**: This column determines the order of items when they are placed in the same row.

**Flip Text on Arcs that Open to the North**: When this is checked text will be orientated according to the open side of your arcs instead of being orientated according to the plain view.

**Use Symbol for Delta Angle Label**: Allows you to use the triangle symbol for delta as the label instead of plain alphabetic or numeric representation.

**General Settings**: This button brings you to the Annotate Defaults dialog, see 'Annotate Defaults' for more.

**Reset To Defaults**: This button restores the default settings shown above.

**Load/Save**: You may also Load and Save different label configurations with the corresponding buttons.

---

**Prompts**

- **Options/<Select arc>:** select entity
- **Options/<Select arc>:** *O*
- **Custom Arc Label dialog** choose your preferences and click OK

You can decide to go into the Option dialog at the start of the command and after your initial labeling.

**Pulldown Menu Location**: Annotate > Annotate Arc

**Keyboard Command**: annarc

**Prerequisite**: An arc to label

---

**Arc Dimensions**

This command labels dimensions of an arc including the chord angle, chord length, radius and radial bearing in and out. Besides creating the labels, this command also draws the chord line and radial lines. In the options dialog, choose which labels to draw, the label prefix and label position. The arc can be defined by selecting an arc entity, selecting an arc segment of a polylines or by entering points for the arc.
Prompts
Options/Points/<Select arc>: pick an arc

Pulldown Menu Location: Annotate > Annotate Arc
Keyboard Command: arcdim
Prerequisite: None

Draw Text On Arc
This command draws text that aligns with an arc or polyline arc segment. Each letter of the text is drawn as a separate text entity that is rotated to align with the arc at that point. These text letters are automatically grouped together as an anonymous block. This command starts with the Create Text on Arc dialog. This command draws text that aligns with an arc, beginning at a picked point. Each letter of the text is drawn as a separate text entity that is rotated to align with the arc. These text letters are automatically grouped together as a block. The text string, text height, and text style are set in the Create Text on Arc dialog box.
**Text String:** Specify the text to label on the arc.

**Text Height:** Specify the text height. The default value is obtained from the text height specified in Drawing Setup. The value set here is retained throughout the drawing session.

**Text Style:** Choose an existing text style from the list of defined styles.

**Select text offset on screen:** When checked, the program will prompt you for offset. You can set the text offset from the arc by graphically picking the offset point on the screen. When this option is not checked, the Text Offset field described below becomes available to specify a known offset distance.

**Text Offset:** If the above setting is not selected, specify the Text Offset here. A positive value denotes an offset distance inside the arc, while a negative value denotes an offset distance outside the arc.

**Is base of text towards radius point?:** This option determines whether the base of the text should face the radius point of the arc. It orients the text to the curve. Examples showing the results of different settings follow.

![Diagram showing text orientation options](image)

**Example 1** - Offset distance specified on screen and base of text away from radius point.

Select Arc or Polyline segment: **pick Arc or Polyline segment** to place text on.

Select Text Offset: **pick the desired offset distance from arc**

Select Text Placement: **pick a point**, select the desired position to draw the text. Note that the text remains visible on the screen and attached to the "rubber banding cursor" so that various positions can be inspected before specifying the placement point. The graphic below shows this aspect of the command.

Note that the ghosted text is located along the mid point of the arc. If no offset distance is specified or picked from the screen, the text will be placed at this point. An offset of zero puts the text directly on the arc.
Example 2 - Offset distance specified in dialog and base of text towards radius point.

Select Arc or Polyline Arc Segment: **pick Arc**
Select Text Placement: **pick point**

Note that the prompt for offset distance was skipped because the offset distance was input on the dialog box. Simply select the text placement point resulting in the graphic below.

**Pulldown Menu Location:** Annotate > Annotate Arc
**Keyboard Command:** textarc
**Prerequisite:** An arc entity
Draw Text on Tangent

This command is identical to Draw Text on Arc, except that the text is not curved to fit the arc. You are presented with this dialog box. Fill in the text, decide on the other options, click OK, and then follow the prompts.

Pulldown Menu Location: Annotate > Annotate Arc
Keyboard Command: textarctan
Prerequisite: Arc or polyline arc segment

Edit Text on Arc or Tangent

This command allows you to edit text created by the Draw Text on Arc or Draw Text on Tangent command. You can change the text string, text height and text style. Use Edit Text Position to slide the text along the arc. The Towards Radius Point option can be used to flip the text.

The program prompts you to select the Text on Arc entity, then displays the same dialog used in Draw Text on Arc.

Pulldown Menu Location: Annotate > Annotate Arc
Keyboard Command: editarctext
Prerequisite: text entity as described above
Fit Text Inside Arc

This command fits text between two points picked along an arc. Text is curved to fit the arc using individual text entities, which can only be edited one at a time. The Draw Text on Arc command creates an text entity that can be edited using Edit Text on Arc or Tangent. It will optionally display information about the selected arc. If you choose to display the curve data, you will be prompted to pick the endpoints of the arc in a clockwise manner. When prompted, enter the text you want drawn inside the arc.

Prompts

Pick points in a clockwise direction.
[nea on] Start Point on arc for text: pick point on arc to start text Notice that the Nearest snap is turned on by default.
[nea on] End Point on arc for text: pick point on arc to end text Notice that the Nearest snap is turned on by default.
Enter text for inside of arc: MEADOWVIEW LANE

Pulldown Menu Location: Annotate > Annotate Arc
Keyboard Command: inarc
Prerequisite: An arc entity

Fit Text Outside Arc

Same as the previous command except this command fits text on the outside of the arc.

Pulldown Menu Location: Annotate > Annotate Arc
Keyboard Command: OARCT
Prerequisite: An arc entity

Line Types

Change Polyline Linetype

This command changes the linetype of polylines or lines to the linetype selected from the dialog. True AutoCAD linetypes are created and applied to the selected entities, compared to other commands, such as Polyline to Special Line and Special Line/Entity, which break the polyline into segments. The spacing between linetype symbols and the symbols size are controlled by the Line Type Spacing and Symbol Size Scaler settings in the dialog. The Gap Size Scaler controls the size of the break in the line for the linetypes that have a break like UserDef and Arrow_B. The Gap Size Scaler is multiplied by the symbol size to get the gap size in drawing units. To select a linetype from the dialog, pick on the linetype image. Use the Next button to see more linetypes. At the end of the list of linetypes, there are two special choices. The UserDef choice lets you enter your own text string into a linetype, and the Wingdings choice lets you insert any Wingdings font character into a linetype. Consult Windows® documentation for a listing of Wingdings characters.
Prompts

Select Linetype dialog select linetype and adjust other variables
Select items to change.
Select objects: pick the polylines

Linetype styles available using Change Polyline Linetype
Polyline to Special Line

This command converts polylines into special lines by adding the appropriate symbol onto the polyline, such as railroad, hedge, stonewall or telephone lines. Carlson has defined several line types as shown below. You can create custom lines by selecting the Other ‘?’ which then prompts you for the text label to use. The size and spacing are set by the Spacing Scaler and Symbol Size Scaler settings. For some of the linetypes, this routine breaks the polyline using the Gap Size Scaler in order to fit in the symbol. Broken polylines cannot be used by the Area command, and are difficult to edit.

The Change Polyline Linetype command is another linetype method that creates actual AutoCAD linetypes that are applied to the selected entities.

Prompts

Select Carlson Linetype dialog
Select the polyline(s) to convert.
Select objects: pick the polylines
Polyline to Tree Line

This command changes a polyline into a series of semicircles for representing a tree line.

Prompts

Side for arcs on polyline direction? (<Left>/Right) press Enter
Enter the segment distance <10.0>: press Enter
Select the polylines to convert.
Select objects: pick one or more polylines

Before and After Polyline to Tree Line

Pulldown Menu Location: Annotate > Line Types
Keyboard Command: maketree
Prerequisite: Polyline

Add Zig to Polyline

This command draws a [not-to-scale] style zig to a polyline. First pick the polyline and then pick a position on the polyline to draw the zig.

Prompts

Zig size <4.0>: press Enter
Select polyline to add zig: pick a polyline
Pick or enter point to add zig: pick a point along the polyline
Select polyline to add zig: press Enter to end

A zig in a polyline

Pulldown Menu Location: Annotate > Line Types
Keyboard Command: addzig
Prerequisite: Polyline

Add Culvert to Polyline

This command adds culvert style brackets to both ends of the selected polylines.

Prompts
Culvert symbol size <4.0>: 12
Select polylines to add culvert symbols.
Select objects: pick the polylines

Pulldown Menu Location: Annotate > Line Types
Keyboard Command: drwcvrt
Prerequisite: Polyline

Sketch Tree Line
This command draws a tree line as you move the cursor. At the first prompt, you can type O for Options and set
the Interval Scaler which controls the spacing of the bubbles. Also at the first prompt, you can type P for Polyline
and then select an existing polyline to convert into a tree line. At the end, there is an option to flip the side for the
bubbles in case they came out on the opposite side.

Prompts
Pick First Point [Options/Polyline]: pick a point
Sketch treeline (pick point to end): slowly move the cursor and pick a second point to end the routine
Reverse direction [Yes/<No>]? press Enter

Pulldown Menu Location: Annotate > Line Types
Keyboard Command: treeline
Prerequisite: None

Special Line/Entity
This command breaks a line, arc or polyline and inserts a string of text or a block at an interval. It can be used to
draw fence lines, utility lines, tree lines or any line which can be constructed by inserting a text or block entity. The
command prompts to select an entity then the distance between inserts. Next, the user selects whether to insert text
or a block, and whether to enter the distance or length to be broken out of the entity. If the user enters a 0 distance for
the break distance, then the entity is not broken. If a distance greater than 0 is entered, then this distance is divided
in half and broken out of the entity on both sides of the point at which the insert distance measures the entity.
If the user elects to insert text, the command prompts for the text to be inserted. Next, choose whether you want the text Middle or Center aligned, and whether you want to have the text flipped so it does not appear upside down. See the AutoCAD Reference Manual for more information on justification options. The size of the text is controlled by the text size setting in Drawing Setup.

If the user elects to insert a block, the command prompts for the block name. The size of the block is controlled by the symbol size setting in Drawing Setup. Considering that almost anything can be made into a block, such as raster images, wipeout entities, etc., this is a very powerful command.

Alternatives to this command are Polyline to Special Line and Change Polyline Linetype.

Pulldown Menu Location: Annotate > Line Types
Keyboard Command: speent
Prerequisite: None

Guard Rail
This command adds box symbols along a polyline to generate a guard rail. See the command Change Polyline Linetype also.

Prompts

Pick Polyline/Last: pick a polyline
Left/Right: L for Left

Pulldown Menu Location: Annotate > Line Types
Keyboard Command: grail
Prerequisite: Polyline

Label Angle

Function
This command will label and report the interior and exterior angles between two directions. The angles can be defined by three points or by two line or polyline segments that have a common endpoint.

Prompts

Define angle by, Points/<select line or polyline>: pick a polyline segment
Select adjoining line or polyline: pick another polyline segment
Interior: 72d39'46" Exterior: 287d20'14"
Angle to label (<Interior>/Exterior/None)? press Enter
Define angle by, Points/<select line or polyline>: press Enter to end

Pull-Down Menu Location: Annotate
Prerequisite: None
Keyboard Command: labang
Label Coordinates/Elevation

This command will label a coordinate on the screen. You can choose to label the northing and easting, or the
elevation, or all three properties. The point can be picked on screen, or specified by point number or point group
from the current coordinate (.CRD) file. Options include drawing a box around the label, labeling both feet and
meters, setting the layer name for the label, setting the display precision, deciding whether or not to use a leader
and selecting a change in the symbol used to mark the point. You can also set the text prefix and suffix for the label.
Additionally, you can locate a label on Real Z Axis. The Label With Inches option labels with whole feet and
inches for the decimal part. The Label Point Number option uses the point number from the coordinate file. The
Label Description option is for including a description with the label. There is a choice for placing this description
as a header or footer. The program will prompt for the description. The Use MText option chooses between creating
the labels as MText or regular text entities. The Label Angle setting chooses between having the labels horizontal,
at a fixed azimuth or prompting to pick the angle for each label. The Label Style chooses between labeling with a
leader, with a symbol, as an MLeader entity or along the x/y axis. The Separate Negative Labels option has prefix
and suffix settings for negative coordinates that can be used for South and West labels. The Label Lat/Lon adds
latitude and longitude labels to the coordinate labels. To use this option, the coordinate system must be defined in
the Drawing Setup command.
There is also an option to label the Delta X, Y and/or Z between two points, which is called **Label Delta Between Two Points**. When this option is clicked On, and after the prompt, you will first click two points locations. The label, with the delta value(s), will then be placed precisely in between these two pick locations. If,
for example, the North, East and Elevation button is chosen, the resulting label will show the N, E and Z delta values.

The Save and Load buttons save and recall all the settings for this command to .LCE files. This is a way to manage different label styles for different mapping standards and to share between users.

**Prompts**

**Label Coordinates/Elevation dialog**

**Point to Label ?**

Pick point or point number: *pick a point*

Point to Label (ENTER to End)?

Pick point or point number: *press Enter*

**Pulldown Menu Location:** Annotate

**Keyboard Command:** labcoor

**Prerequisite:** None

**Label LatLong**

This command will label the latitude and longitude of a selected point. The program will convert the northing and easting of the input points to latitude and longitude. There is an option to include elevation in the labels. The coordinate system for the drawing coordinates must be defined in Drawing Setup before running this command. First, the program displays a dialog box with options to set the sizes, to set label prefixes, to set the display precision, to draw a box around the label and to change the symbol used to mark the point. The **Prompt For Label Angle** option prompts for the label rotation instead of automatically drawing the label horizontal. For the **Use Attribute Block** option, the symbol must be a block with three attributes for the latitude, longitude and elevation that the program will place and fill out the attributes instead of creating text labels. After the options dialog, the program prompts for the points to label. As you move the cursor, the program display the latitude/longitude in real-time.

For **Label Style**, the Leader and MLeader styles prompt for the point to label and then the label location and draws a leader or mleader between these points. For the Symbol style, the specified symbol is drawn at the point and the label is drawn automatically to the size.
Prompts

**Label Latitude / Longitude** dialog

Pick point or point number: *pick a point*

Pick point or point number: *press Enter to end*

**Pulldown Menu Location:** Annotate

**Keyboard Command:** lablat

**Prerequisite:** Define coordinate system in Drawing Setup

---

**Label Curb Flow Elevations**

This command labels top of curb and/or bottom of curb (flowline) elevations with a leader along an alignment. The data to label comes from Carlson points and alignment is defined by a selected polyline. The program reads all the points in the drawing and then you select which descriptions to use the top of curb labels and which to use for the bottom of curb labels.
There are separate settings for the top and bottom to control the label prefix, suffix and decimals. The Tolerance setting is the maximum distance between a point to label and the polyline. The Leader Bearing determines how the Leader Angle is applied: Relative adds the angle to the alignment polyline and Absolute means based on the orientation of the screen. The Text Horizontal Offset Scaler controls the distance between the alignment polyline and the label. The Text Vertical Offset Scaler controls the buffer offset between the leader line and the label. The User Leader Entities option chooses between drawing the leaders as polylines or as leader entities. The Elevate Annotations setting controls whether the labels are created at their elevation or at zero.

Prompts

**Top Curb Descriptions** pick descriptions to label for top of curb
**Bottom Curb Descriptions** pick descriptions to label for bottom of curb
**Pick a polyline to annotate (Enter to End):** *pick a polyline*
**Pick side for flowline (Enter to End):** *pick a side*

**Pulldown Menu Location:** Annotate
**Keyboard Command:** cflelev
**Prerequisite:** points with elevations and descriptions, and alignment polyline

**Replot Descriptions**

This command will create user specified text entities at the location of selected point descriptions.

Prompts

This command will Search for a certain Point Description and plot
**New text on the current layer with current style.**
**Attribute Text to Search for < >:** STK
**New Text to plot < >:** Stake Fnd
**Select objects:** Select Carlson points
**Select objects:** press Enter
**Number of Text Entities Plotted:** 4
Points with description STK

Found four STK descriptions and created four text entities

**Pulldown Menu Location:** Annotate  
**Keyboard Command:** plotdesc  
**Prerequisite:** Points with descriptions must be plotted. Set the layer and text style that you require.

### Label Offset Distances

This command labels the distances of a point to one or two lines. The first distance is between the point and an east-west line. This distance is labeled as either north or south of the line. The second distance is between the point and a north-south line. This distance is labeled as either east or west of the line. The distances are labeled with a leader and a description of the point.

#### Prompts

- **Pick 'E-W', Left to Right Property Line (if any)**
- **Pick Line or Polyline (Enter for None):** *pick the polyline*
- **Pick 'N-S', Top to Bottom Property Line (if any)**
- **Pick Line or Polyline (Enter for None):** *pick the polyline*
- **Pick Offset Point, (N) for Number, <E> to Exit:** *pick a point*
- **Pick point to start leader at:** *pick a point at or near the offset point*
- **To point:** *pick an alignment point for the label*
- **To point:** *press Enter*
- **Pick Offset Point, (N) for Number, <E> to Exit:** *press Enter to End*
**Label Elevations Along Pline**

This command labels point elevations and aligns with a polyline based on settings shown in the dialog. These settings can be divided into five groups.

**Label Settings:** The *Source of Elevations* are read from Carlson points drawn on the screen, polyline vertices, elevations of grade break vertices and can also be picked on the screen. The *Side for Labels* is relative to the direction the polyline is drawn. Labels can be *aligned* horizontally, parallel or perpendicular to the polyline or according to the picked alignment. The *Offset distance scalar* offsets the label from the actual point.

**Text Settings:** The labels will be drawn on *Layer* with selected *Style*. The *Text size scalar* is relative to the current horizontal scale, which is set in *Drawing Setup*. These scalers are multiplied by the horizontal scale to obtain the actual drawing units. The number of *Integers* and *Decimals* can also be specified along with *Prefix* and *Suffix* for the main elevation label.

**Leader Settings:** The Leader Settings are used to *Draw Leader* with *Arrowhead* on the leader *Layer* with length of leader equal to *Leader Scaler*. The option *Draw text above leader* extends the leader tick to the length of the label.

**Additional Settings:** *Draw box around label* draws box around the elevation label. *Flip text for twist screen* changes the text direction if the text is drawn upside down. If the option *Ignore zero elevation* is on zero elevation labels will be ignored. The Carlson points or picked points are beyond *Maximum offset to use* will be ignored.

**Additional Offset Settings:** If the *Additional offset* is other than 0, it will be labeled with *Prefix* and *Suffix* using the other text settings on the next line of main elevation label.

The overlapping labels can be moved using Move Elevation Labels command to remove the overlap.

If the Link Labels With Linework option is on in Carlson Configure > General Settings when the labels are created, then the labels will automatically update when the elevations of the polylines are changed.

**Prompts**

**Label Elevations Along Polyline dialog**

Select alignment polyline: *pick a polyline*

Select points to label.

Select objects: *pick the points*
The alignment polyline with points to label is shown

**Pulldown Menu Location:** 3D Data->Label Polylines
**Keyboard Command:** elevlab  
**Prerequisite:** Polyline and points
The Surface menu, shown below, has many commands for triangulation, contouring, volumes, profile design and much more.
Triangulate & Contour

At the heart of nearly every land design project is at least one terrain model. These models go by several names and one of the most common is that of a "TIN" or Triangulated Irregular Network; another common name is that of a "DTM" or Digital Terrain Model. Since accurate representations of a surface model are significantly important to most land development projects, having a thorough understanding of the Triangulate & Contour controls is very important.

Surface models are generally comprised of combinations of the following general data types:

- **Points** - Most surface models are comprised of points whose coordinates (x,y,z) contribute to the formation of triangular planes that connect three points that are in close proximity to one another. Within Carlson, most points come from the Draw Field to Finish command and/or the Draw-Locate Points command. Points can be selectively filtered from the triangulation engine through the use of the Tag Non-Surface Points command.
- **Breaklines** - Breaklines (or "fault lines") are used to control the connection sequence between four points which results in two triangles. Common uses of breaklines include ravines, ditches, berms and other areas where distinct grade discontinuity occurs. The "leg" of a triangle can travel along a breakline but cannot cross the breakline. Breaklines must be in the form of 3D polylines or simple lines whose vertices or endpoints define a valid "Z" elevation. A common problem related to breaklines is when two breaklines cross one another in 3D space. In these situations, an impasse results and will result in a "crossing breakline" report. Within Carlson, most breaklines come from the Draw Field to Finish command and/or the 3D Polyline command. Breaklines fall into one of two general categories:
  - "Soft" breaklines - Unless otherwise specified, all breaklines are considered "soft" breakline. The nature of soft breaklines allows a degree of contour smoothing across the breakline itself resulting in a "weathered-" or natural-looking contour.
  - "Hard" breaklines - Breaklines tagged as "hard" breaklines prevent contour smoothing through the breakline. Hard breaklines are generally used to represent man-made terrain breaks that commonly occur during excavation and construction. Breaklines can be changed to hard breaklines through the use of the Tag Hard Breaklines command.
- **Inclusions** - Inclusions (or "boundaries") are used to identify the entities that can be used for triangulation and multiple inclusion regions can be selected for a given surface model. Entities that fall outside of an inclusion boundary and are not otherwise bound by a different inclusion boundary are ignored by the triangulation engine. Inclusion regions must be in the form of a closed 2D or 3D polylines. Within Carlson, most inclusion polylines come from the Shrinkwrap Entities command.
- **Exclusions** - Exclusions (or "void regions") are the antithesis of Inclusions and are used to prevent triangulation from occurring between points that are bound by an Inclusion region. Common uses of exclusion regions include building footprints and free-standing water limits (e.g. ponds). Entities that fall inside an exclusion region are ignored by the triangulation engine. Exclusion regions must be in the form of a closed 2D or 3D polylines. Within Carlson, most exclusion polylines come from the Boundary Polyline command and/or the 3D Polyline command.

Carlson provides a programming interface for these file types and also offers a third file type (*.GRD) for the representation of terrain data. See the Notes section for additional details.

The **Triangulate** tab provides options and settings that control the creation and analysis of the TIN itself.
**Draw Surface Object:** This option draws the triangulation faces as a Carlson Surface Object.

**Draw Triangulation Lines:** When enabled, the program will draw the triangulation using simple line entities at the appropriate elevation(s). Use the **Select** button or specify the layer for these lines.

**Draw Triangulation Faces:** When enabled, the program will draw the triangulation using a collection of 3D Face entities. These 3D Faces can then be used rendering routines such as *HIDE* and *SHADE* or in Carlson routines such as 3D Viewer Window, 3D Surface Fly-Over and Slope Zone Analysis. Use the **Select** button or specify the layer for these 3D Faces.

**Draw Slope Arrows:** When enabled, slope arrows are created within the triangles indicating the downhill dip direction as illustrated below.

Clicking the **Setup** button yields the Draw Slope Arrow Settings dialog box.
**Arrow Layer:** Indicate the layer to which the slope arrows are to be placed.

**Size Scaler:** Indicate a positive, non-zero value for the scale factor that should be applied to the slope arrows.

**Draw Slope Percent Label:** When enabled, the slope value (in percentage) of the triangle is labeled onto the slope arrow. Specify the desired unit suffix (e.g. "%") to apply to the end of the numerical value that is calculated from the TIN triangle(s).

**Label Decimals:** Indicate the amount of precision that is to be displayed on the slope label.

**Min Area to Label:** Indicate the smallest allowable triangle size that can be used for the slope percentage labels.

**Write Triangulation File:** When enabled (strongly suggested), an external surface model file is created which can subsequently be used for volume calculations, the creation of profiles, cross-sections and graded pads. Carlson currently provides two file types to store the DTM data created by the Triangulate & Contour routine:

1. *.TIN - The TIN file format is the default and preferred file format due to its compact file size and organizational efficiency. The Carlson TIN format is governed by Carlson and is in a binary (non-human readable) format.
2. *.FLT - The FLT file format is a legacy ASCII-based (human-readable) file format and is used in some older machine control applications.

**Use Inclusion/Exclusion Areas:** When enabled, the program will prompt you for inclusion and exclusion polylines and prevents the use of the Shrink-Wrap Perimeter Reduction option. These are used to further control the area of activity for triangulation and contouring. The inclusion and exclusion polylines must be closed polylines and when used, must be drawn before using *Triangulate & Contour*. It is suggested that the height of the Command: line display must be set to show at least two lines so that the additional prompts can be easily viewed. Refer to the Notes section for additional information on Inclusion/Exclusion polyline selections.

**Boundary Method:** This option controls whether edges that cross the inclusion or exclusion perimeter are trimmed or removed. Use the Remove option if you don't want the triangulation to interpolate across the perimeters. Use the Trim option if you want the triangulation to fill the area up to the perimeter.

**Shrink-Wrap Perimeter Reduction:** This option produces an inferred Inclusion region around the data to be selected and mimics the results of the Shrinkwrap Entities command. Under the Setup, there is an option to draw the shrink-wrap perimeter polyline on a specified layer.

**Ignore Zero Elevations:** When enabled, this option will filter out all data points and entities at an elevation of zero from the triangulation data set.

**Specify Input/Output Elevation Range:** If you would like to manually set the range over which to contour, select either or both of the aforementioned toggles. One controls the triangulation of the source data and the other for the contour output. The program will automatically contour from the lowest elevation in the data set up to the highest at the increment specified in Contour Interval.

**Prefix Layers With Surface Name:** This option applies when using Write Triangulation File. The file name is added as a prefix to all the layers created during Triangulate and Contour as a way for layer management to organize.
all the contouring layers for a surface file.

**Max Triangle Length:** Two bounds are provided to limit the length of the "legs" within a triangulation network. Based on the available data, if the edge length of a triangle exceeds the respective bound, the triangle will not be formed:

- **Exterior:** This value applies to triangulation lines around the perimeter of the triangulation area.
- **Interior:** This value applies all the other triangulation lines. Generally you would have the Exterior value larger than the Interior value.

**Densify Breaklines:** This option subdivides linework segments for the input data so that the maximum length of the segments is the specified Interval. This option is similar to the Densify Polyline Vertices command except that the entities are not modified in the drawing. Having shorter breakline segments is often helpful for holding the breaklines in the TIN and making more regularly sized triangles.

**Minimize Flat Triangles:** When enabled, this toggle instructs the triangulation "engine" to iterate through the triangulation permutations to minimize the occurrence of "flat" (or more precisely, horizontal) triangles. Flat triangles often occur when creating surface models from contour data. In this scenario, the often used Delaunay triangulation algorithm may produce unrealistic results. The Minimize Flat Triangle option will perform additional permutations of the triangulation network through the use of the Surface Manager > Swap Edge routine in an attempt to maximize the number of "sloped" triangles. Another option that produces similar results is the Interpolate Ridges and Valleys option.

---

![Surface before Minimize Flat Triangles](image)

**Before:** Surface made from an existing contour map with Minimize Flat Triangles disabled.
After: The same surface with Minimize Flat Triangles enabled. Note the better defined ravine and ridge definitions.

Difference: A Cut/Fill Color Map showing the regions of significant triangulation difference between the "Before" scenario and the "After" scenario of "Minimize Flat Triangles."

Erase Previous Contour Entities: In the event that a TIN needs to be recreated and Carlson-produced contours are in the drawing, three options exist that allow you to control whether or not the contour data should be removed from the drawing:

- Off - All existing Carlson-generated contours are left intact in the drawing. If these contours satisfy all of the triangulation requirements, they can be utilized by the Triangulation algorithm.
- Current Surface - Only the Carlson-generated contours that are associated with the active Triangulation file are removed from the drawing.
- All Contour Entities - All Carlson-generated contours are removed from the drawing, regardless of the surface model that created them.

Pick Reference Plane: When enabled, this option allows you to contour an overhang or cliff by changing the refer-
ference plane to a side view. The reference plane can be specified by using the View>Viewpoint 3D>View command (see the AutoCAD/IntelliCAD Help menu for additional details) or by specifying three data points on the cliff (two along the bottom and one at the top).

**Highlight Breaklines:** When enabled, this routine highlights breaklines in the triangulation network by drawing the triangulation lines along breaklines in yellow.

**Interpolate Ridges and Valleys:** The intent of this routine is similar to, and is the pre-cursor of the Minimize Flat Triangles option. When enabled, this option inserts "best-guess" breaklines into the drawing which are subsequently used in the triangulation process in an attempt to minimize flat, horizontal triangles.

**Interpolate Summits and Pits:** When enabled, this option creates additional triangulation in a summit or pit situation to more accurately represent existing ground conditions from a surface model created from contour entities. Since the tops of hills and the bottom of pits are often not shown on existing ground contour maps, this option often helps improve the accuracy of existing terrain conditions.

**Interpolate Valleys:** this function generates 3D data polylines from a contour map that approximate the downhill flow of water through valleys. These polylines are then used when creating a triangulation and can improve the it in these valley regions by giving more definition to these areas. The polylines are created by looking for "sharp" or angled regions of the contours, and then connecting these regions with a smooth curve.

**Simplify Surface:** When enabled, this option reduces the digital size of a surface without significantly compromising the integrity or accuracy of the surface itself. The most common application to enable this option is when using very large datasets, such as smoothed contours. Its use is less applicable to design surfaces or surfaces based on surveyed points, but it can still be utilized.

**Elevation Method:** When enabled, this option reduces the size of the surface file by analyzing the difference in elevation between each vertex of the TIN and the vertices directly surrounding it, assigning a numerical weight or value to each vertex. If it is determined that the calculated weight for a particular vertex is less than the **Tolerance** factor, the vertex is a candidate for removal. The number of vertices removed is directly proportional to the Tolerance factor, so the higher the Tolerance factor, the more vertices are removed and vice versa.

**Preserve Breaklines:** When enabled, this option analyzes the TIN by focusing on the edges; calculating the angular difference between adjacent triangular faces. If the angular difference between edges is greater than the specified **Breakline Angle**, it is considered to be a breakline, and it is preserved. If its angular difference is determined to be below the **Breakline Angle**, it becomes a candidate for removal. In that case, the **Weight** factor is applied to the corresponding vertex, adjusting its original value. If the resulting value is still below the **Tolerance**, it is then removed. The number of vertices removed is inversely proportional to the **Weight** factor, so the greater the **Weight** factor. The fewer vertices that are removed, the lower the **Weight** factor, the more vertices that are removed.

A good rule-of-thumb that can be used when deciding whether or not to use these options is:

- If the surface contains no man-made features, use **Simplify Surface** option (with or without the **Elevation Method** option).
- If the surface contains man-made features, such as roads, use both **Simplify Surface** and **Preserve Breaklines**.
Draw Contours: When enabled, the program will draw contour lines using the designated settings after triangulation process is complete. Otherwise, only the designated Triangulation operations are performed. If this option is disabled and contours are subsequently desired, use the Contours from TIN File command.

Interval Method: Indicate the desired elevation(s) for contours to be drawn:

- Contour by Interval: Specify the desired interval (e.g. every 2 feet) into the Contour Interval field.
- Contour an Elevation: Specify a desired elevation (e.g. a floodplain elevation or other unique elevation of interest) and set the desired value into the Contour Interval field.

Contour Layer/Index Layer: Specify the layer to which the contours/index contours are to be drawn.

Contour Interval/Index Interval: Specify the interval to which the contours/index contours are to be drawn.

Contour Line Width/Index Line Width: Specify the line width to be applied to the contours/index contours.

Draw Index Contours: When enabled, index (or "major") contours will be created with independent characteristics from the regular contours.

Min Contour Length: Specify the minimum linear threshold that should be used to draw contours.

Apply Outlier Reduction Filter: When enabled, this option attempts to remove "the jaggies" which tend to occur along long, thin triangles.

Apply Meander Reduction Filter: This option smooths contours by removing back-tracking.

Reduce Vertices: When enabled, this option removes extra vertices from the contours using the Offset Distance value. The Offset Distance is the maximum amount that the polyline can move horizontally when removing a point. The result of this action is often a significant reduction in vertex locations along the contour resulting in a more efficiently-sized and compact drawing file.

Offset Distance: Specify the maximum allowable distance for shifting the original contour line in order to reduce vertices. The reduced contour will shift no more than this value, at any point, away from the original contour line. A lower value will decrease the number of vertices removed and keep the contour line closer to the original. A higher value will remove more vertices and allows the contour to shift further from the original location.
Reduce Before Bezier Smoothing: When enabled, this option removes extra vertices from the contours before they undergo Bezier Smoothing using the Offset Distance value. The Offset Distance is the maximum amount that the polyline can move horizontally when removing a point. Removing points before smoothing gives the Bezier smoothing more freedom to make the contour curvy.

Contour Smoothing Method: Indicate the desired amount of smoothing (often used for existing, natural ground conditions to simulate a "weathered terrain" effect) that should be applied to the contours:

- **No Smoothing:** This option is often used for proposed, man-made surface considerations where the terrain has been shaped with earth-moving equipment. For applications where a "nature-emulated" man-made terrain is desired, refer to the Carlson Natural Regrade documentation.
- **Bezier Smoothing Factor:** This option holds all the contour points calculated from the triangulation and only smooths between the calculated points.
- **Polynomial Smoothing:** This option applies a fifth degree polynomial equation through the contour data points for a smooth transition between the triangulation faces.

Subdivisional Surfaces: When enabled, adjust the horizontal slider to indicate the degree of triangular subdivisions. This causes each triangle in the triangulation surface model to be subdivided into \((x + 1)^2\) triangles, where \(x = \text{Subdivision Generations}\). The mathematically generated sub-triangle vertices are raised or lowered to provide smoother contours. More generations increase the smoothness of the contours but incur increased processing time. Although this algorithm does not produce "crossing contours," it can result in undesired contours in terrain scenarios such as where graded slopes abruptly transition to nearly horizontal slopes (e.g. the sides and bottom of a detention pond).

Bezier Smoothing Factor: Adjust the horizontal slider to obtain a preview of how much smoothing can be expected at each setting. Sliding the bar to the left results in a lower setting which have less looping or less freedom to curve between contour line points. Likewise, moving the slider to the right results in a setting that increases the looping effect. Note that too much smoothing applied in some situations can result in crossing contours.

Highlight Depression Contours: When enabled, use the Setup button to establish general configuration settings for depression contours.

Layer: Specify the layer to which the depression contours are to be drawn.

Tick Size Scaler: Indicate the relative scale factor that should be applied to the depression ticks.

Tick Interval Scaler: Indicate the desired interval scaler which controls the spacing of the depression ticks.

Line Width: Specify the line width to be applied to the depression contours.

Hatch Zones: When enabled, this option will create hatching between the contours based on elevation zones. The following dialog will open allowing the user to specify the hatch type and color for each elevation zone. The entire elevation range of selected data is displayed under Current Values.
Auto: Opens the following dialog, allowing for automatic configuration of the range of elevations in each zone, assigning of colors and hatch patterns, and the scale.

Starting Zone: Sets the zone with which to begin the application of the setting defined in this dialog. For instance, if the Starting Zone was set to 10, the settings definitions applied here wouldn’t affect Zones 1-9, but would start at Zone 10.

Set Values: Enables the Starting Value and Value Interval fields, which allow the user to specify the starting elevation for the given zone and set the zone increment.

Starting Value: Sets the elevation of the beginning zone to define.

Value Interval: Sets the elevation increment for subsequent zones.

Set Colors: Enables the Starting Color and Color Increment fields.

Starting Color: Sets the starting color number based on the standard CAD color chart.

Color Increment: Sets the color number to increase for subsequent zones. So if the increment was set to 5, and the starting color was 60, the next color would be 65, 70, and so on.

Set Pattern: Sets the hatch pattern for the defined zones.

Set Scale: Enables the Scale option.

Scale: Sets the scale for the selected hatch pattern.

Clear: Clears all of the Elevation fields in the dialog.
Load: Loads previous settings from a saved .pat file.

Save: Saves the current setting configuration to a .pat file.

Label Contours: When enabled, contours will be labeled based on the settings below. If this option is disabled and further contour annotation is desired, utilize the Contour Elevation Label command.

Label Layer: Specify the layer name for intermediate contour labels. To only label index contours, enable the Label Index Contours Only option.

Use Contour Layer as Prefix: This option adds the Contour Layer name to the Label Layer name.

Index Label Layer: Specify the layer name for index contour labels.

Label Style: Specify the text style that will be used for the contour label text.

Label Integers controls how many digits to label to the left of the decimal. For example, if all contours are in the 5000's, then setting for three digits would label the 5280 contour as 280.

Label Decimals: Specify the amount of precision to display on the contour labels.

Label Text Size Scaler: Specify a relative text size scale factor to be applied to the label(s).

Use Commas adds a comma into the labels for the thousands place such as "5,000" instead of "5000".

Min Length to Label: Specify the desired minimum length of contours that should be annotated. In other words, Contours whose length is less than the value will not be labeled.

Positive/Negative Contour Prefix: Indicate a desired string of prefix text (e.g. Elev= ) that is to precede the positive and/or negative contour elevations, respectively.

Positive/Negative Contour Suffix: Indicate a desired string of suffix text that is to follow the positive and/or negative contour elevations, respectively.
Break Contours at Label: When enabled, the contour lines will be broken and trimmed at the label location for label visibility. As an alternative to physically placing a gap into the contour, consider using the Hide Drawing Under Labels option.

Break Buffer Offset: Specify the offset distance which determines the gap between the end of the trimmed contour line and the beginning or ending of the text.

Draw Box Around Text: When enabled, a rectangle is drawn around the contour elevation labels.

Box Buffer Offset: Specify the offset distance which determines the gap between the box and the beginning or ending of the text.

Label At Centerline Offset: When creating contours and subsequent plan sheets for roads, enable this option to position the labels at a fixed offset from a centerline. The program automatically uses any polylines in the drawing that are tagged as centerlines. To check whether a polyline is a centerline, use the Centerline ID command. To create a centerline polyline from a centerline file, use the Draw Centerline File command.

Draw Broken Segments: When enabled, the segments of contours that have been broken out for label visibility will be redrawn as independent segments. To join these segments back into the contour, use the Join Nearest command.

Layer: Specify the layer that is to receive the newly drawn broken segments.

Label Contour Ends: When enabled, the ends of "open" contours will be labeled.

Label Index Contours Only: When enabled, only the index contours are labeled. This option is active only when Draw Index Contours has been selected in the Contour tab.

Hide Drawing Under Labels: When enabled, a "Wipeout" entity is placed with the annotation label that will create the appearance of trimmed segments at the contour label, even though the contour line is still fully intact. This feature provides the user with the best of both worlds; you have clean looking contour labels yet the contour lines themselves remain contiguous. This feature will also hide other entities that are in the immediate vicinity of the contour label.

Align Text with Contour: When enabled, the contour elevation labels will be rotated to align with their respective contour lines.

Use MText: When enabled, contour labels are created using the MText entity type. Otherwise, the standard DText entity type is used.

Draw On Real Z Axis: When enabled, the contour labels are placed at the same "Z" (elevation) value of the contour itself. When disabled, the contour labels are placed at a "Z" (elevation) value of 0 (zero).

Align Facing Uphill: When enabled, the contour elevation labels will still be rotated to align with their respective contour lines, but the labels will be placed in such a manner that the top of the text label will always be toward the uphill side of the contour.

Internal Label Intervals: Indicate the desired method for contour labels within the contour itself:

- **Label Intervals**: This option will label each contour with a set number of labels.
- **Distance Interval**: This option allows you to specify an interval distance between labels.
**Filter Selection By Inclusion/Exclusion Areas:** This option filters out selected entities from the triangulation that are outside the surface area defined by the inclusion/exclusion perimeter polylines. Otherwise, all the selected entities are used for triangulation and then the triangulation is trimmed at the inclusion/exclusion perimeters. Whether to prompt for inclusion/exclusion perimeters is specified on the Triangulate Tab.

**Specify Selection Options:** When enabled, indicate the type(s) of entities that are to be used during the triangulation process. This is an excellent method of "filtering out" unwanted entity types or enabling the use of desired entity types.

- **CAD Points, Lines, 2D Polylines, 3D Polylines, 3DFaces, Elevation Text and Inserts (blocks)** are standard CAD entities types.
- **Carlson Point Inserts** refer to Carlson points (such as those placed with the Draw Field to Finish command or which utilize the Carlson "SRVPNO*" family of blocks with point number, elevation, and description attributes).
- **Spot/Bottom Elevation Inserts** include text entities that start with 'X'.

**From File:** When enabled, allows you to triangulate from the points in an external coordinate (.CRD) or ASCII file. This option also provides access to the use of Point Groups as a data source. An **Error Log** is generated if the triangulation routine finds vertical conflicts between breaklines or other surface entities and displays the conflicts in a "docked dialog box." Three types of conflicts are reported (each conflict type is listed into its own category):

1. Crossing Breaklines - Indicates the common X,Y location of two breaklines that do not share a common "Z" elevation.
2. Vertical Edges - Indicates that two entities or vertexes of differing elevations have the same x-y location, thus forming a vertical plane to another point.
3. Breakline T-Intersections - Indicates that a third entity is abutting another entity, but the second entity doesn't have a vertex at the point of intersection.

Click the "+" sign beside a category to display the individual conflicts within that category and click the "+" sign to collapse the list. When a line item error is selected, a highlighted arrow is temporarily placed in the drawing to indicate the exact location of the specific conflict. Zoom functionality allows the user to more closely inspect...
the specific problem area, and if needed a marker can be drawn or a report generated for an individual conflict or conflicts.

**Zoom To:** Centers the display on the location of the error without affecting the zoom resolution.

**Zoom In:** Increases the ability to see detail.

**Zoom Out:** Decreases the ability to see detail.

**Report One/All:** This option toggles between "One" and "All" depending whether a single line item conflict or an entire category is selected from the error log. An error report is generated listing the x-y position and the elevation difference of the entities in conflict.

**Draw One/All:** This option toggles between One and All depending whether a single conflict or a category is selected from the list. This option draws an "X" symbol at each selected conflict.

**Settings:** Indicate the desired configuration settings for the error log:
**Tolerances:** Indicate the lowest elevation difference threshold that should be reported for Crossing Breaklines, Vertical Edges and Breakline T-Intersections, respectively.

**Layer Name:** Specify the layer name for the "X" entities drawn with *Draw One/All* option. This also sets the layer name for the *Draw Lines* option.

In the case of crossing polylines, *Draw Lines* will trace over the polylines responsible for the conflict.

**Symbol Size:** Specify the size of the "X" symbol that is drawn to delineate the selected errors. This will determine the actual size of the symbol in the drawing. This value is not multiplied by the horizontal drawing scale.

**Note:**

- When selecting Inclusion/Exclusion polylines, you may select any number of Inclusion polylines and any number of Exclusion polylines. Selecting multiple Inclusion polylines results in "islands" of terrain data within a given TIN file.
- If *Triangulate & Contour* reports zero points found and fails to do anything when you're using Carlson points, then those points are probably located at zero elevation. To fix this problem, make sure that Carlson Point Inserts is toggled on in the Selection tab. This will enable *Triangulate & Contour* to read the elevation from the elevation attribute of the point.
- For those experienced in programming, Carlson offers a DTM API (Application Programming Interface) which provides functions that can be used to access and manipulate information stored within a DTM file.
- In surface situations where a series of rectangular grid cells are desired, explore the Make 3D Grid File command.

**Prompts**

The following are the most often encountered prompts:

**Select the Inclusion perimeter polylines or ENTER for none.**

**Select entities:** Select the desired closed polylines that form the bounding inclusion area(s) of the surface model and press Enter when complete.

**Select the Exclusion perimeter polylines or ENTER for none.**

**Select entities:** Select the desired closed polylines that form the regions(s) of the surface model where triangulation should not occur and press Enter when complete.

**Select the points and breaklines to Triangulate.**

**Select entities:** Select the desired entities from CAD using standard CAD selection methods and press Enter when complete.

**Pulldown Menu Location(s):** Surface (Survey, Civil, Hydro, Construction, Field, Natural Regrade), Takeoff > Surface Tools

**Keyboard Command:** tri

**Prerequisite:** 3D entities in the drawing (defined by the Selection Tab) and/or an external point file
Contour from TIN File

This command creates contours directly from a TIN file (.flt or .tin) without the need to have the TIN drawn on the screen. The routine starts by opening the dialog for Triangulate and Contour, allowing the user to specify triangulation, contour and label settings. After pressing OK on the initial dialog, a second dialog opens, allowing for the selection of the TIN file from which to create the contours.

See the Triangulate and Contour section in the manual for a detailed description of each of the settings.

Prompts

Fill out the Triangulate and Contour Dialog information with the desired options.
Select the desired TIN file and choose Open.

Loading edges...
Loaded 1994 points and 5944 edges
Created 3936 triangles
Removed 9 disconnected edges.
Reading points... 0
Contouring elevation 497
Inserted 1926 contour vertices.
The user may be prompted for additional information depending on settings used in the Triangulate and Contour dialog box.

Pulldown Menu Location: Surface >> Contour from...
Keyboard Command: cntrTIN
Prerequisite: A TIN file (.flt or .tin)
**Draw Triangular Mesh**

This command draws a triangulation (.flt or .tin) file as either Surface Object, 3D LINES or 3DFACEs. Since 3DFACE entities can be shaded within the 3D Viewer Window or 3D Surface FlyOver, or with the AutoCAD 3D Orbit command, this is an excellent tool for visual surface inspection. 3D Lines cannot be shaded.

The Surface Object is a custom object for displaying the TIN in the drawing. This custom object also supports the EndPoint snap. The main advantage of the Surface Object is with displaying large TIN files because the Surface Object is more efficient than drawing individual 3D Faces or Lines. The Surface Object requires Carlson to be loaded to display.

In the options dialog, choose the method for how to draw. The Use Inclusion/Exclusion Perimeters will prompt for selecting closed polylines to limit the area where to draw. The Use TIN Colors will color the entities using the colors for triangles stored in the TIN file. Colors can be stored in the TIN files using commands like Triangulation File Utilities, Road Network and Color Surface By Layer. The Erase Previous will erase the existing entities in case the TIN file has already been drawn. For Lines, there is an option to use a different colors for edges in the TIN that are from breaklines.

Triangulation (.flt or .tin) files can be created by routines such as Triangulate & Contour.

**Prompts**

**Select Triangulation File to Draw**

Choose a triangulation (.flt or .tin) file from the file selection dialog. You are then prompted for options:

![Image of Triangulation Options dialog]

If using Inclusion/Exclusion Perimeters, you will be prompted to select them as the routine executes.

**Loading edges...**

**Loaded 198 points and 234 edges**
This Triangulation mesh was drawn as 3DFaces with the Draw Triangular Mesh command, and then colorized by elevation within 3D Viewer Window

**Pulldown Menu Location:** Surface >> Draw Surface  
**Keyboard Command:** drawtri  
**Prerequisite:** A triangulation (.flt or .tin) file

## Contour Utilities

### Smooth Contours

This command has options for applying smoothing to polylines. Select the radio button for the smoothing option you want to apply. If you use Quadratic B-Spline type smoothing or Cubic B-Spline type smoothing, the Spline Segments AutoCAD system variable is relevant. The Curve Fit option provides the least smoothing, and the Cubic B-Spline option applies the most. Another effective way of smoothing is by creating the contours from rectangular meshes using various grid resolutions. Increase the smoothing by lowering the grid resolution and decrease by raising the grid resolution. The Bezier option provides an incremental type of smoothing. The Linetype Generation option turns on the Ltype Gen flag for the selected polylines. For more information on this option and the spline smoothing options, look up the PEDIT command in the AutoCAD Reference Manual. After selecting the OK button the routine will prompt for needed values.

Bezier smoothing is also embedded in many of the routines that create contours. Bezier smoothing applies the Bezier smoothing algorithm to polylines. This smoothing technique has two advantages over Spline or Curve Fit smoothing. One is that a Bezier smoothed polyline will pass through all of the vertices in the original polyline, while a Spline smoothed polyline only curves towards the original vertices and can pull away from vertices at sharp corners. Hitting all the original vertices can be an important feature in contour maps for maintaining the exact location of the contours. Another benefit of Bezier smoothing is the ability to control the looping and vertex factors. A higher looping factor increases the curving effect. Use this setting with some care, as too high a looping factor may cause nearby contour lines to cross after the smoothing has been applied.

Vertex reduction can also be applied along with the smoothing. This avoids having to create smoothed polylines with numerous vertices and then having to reduce these vertices in a second step. Be sure not to make the cutoff offset for reduction too high or you can negate or even reverse the smoothing effect. One disadvantage to Bezier
smoothing is that it cannot be decurved like the other smoothing techniques.

Prompts

Enter the looping factor (1-10) <5>: press Enter This determines the extent of curving. 1- least curvy, 10 - most curvy.

Enter the offset cutoff <0.05>: press Enter This value is the maximum shift distance for vertices reduction. A higher value removes more vertices.

Select polylines to smooth.
Select objects: pick polylines
Reduce Contour Vertices

Contouring and smoothing often creates an explosion in file size due to the many vertices it adds to the individual contour polylines. Fortunately, many of these vertices are very close together, some of which can be removed with no visible effect on the contour polylines themselves. Reduce Contours Vertices can reduce the total number of vertices up to 90%. This has the benefits of a smaller drawing file, faster drawing loading, and faster regens.

This command removes vertices in a polyline that are within a user specified offset cutoff. The algorithm looks at three vertices at a time, and calculates the distance between the second point and the line from the first to the third point. If this distance is less than the user specified cutoff, the second point is removed. In theory, reducing the polyline vertices should not shift the polyline more than the user's cutoff distance. The default for this cutoff is one tenth of a foot. Increasing the cutoff will remove more vertices while decreasing it will more closely preserve the original contour line. When combining vertex reduction with smoothing, it is suggested to smooth before reducing, although it can be done the other way around.

Prompts

Enter the offset cutoff <0.1>: .3
Select polylines to reduce. select polylines
Select objects: press Enter to conclude selection
Processed polylines: 1
Total number of vertices: 1125
Number of vertices removed: 939
**Pulldown Menu Location:** Surface >> Modify Contours  
**Keyboard Command:** reduce  
**Prerequisite:** Polylines (contours) with vertices to reduce

---

**Edit Contours**  
This command revises a segment of a contour polyline. Begin by picking a point on the contour where you want to start editing. Then pick new points for the polyline. When finished picking new points, press Enter and then pick a point on the contour to connect with the new points. The polyline segment between the start and end points is then replaced with the new points.

If there is a triangulation file associated with the contours, then the command prompts for whether to update the triangulation surface file to match the contour edits. When this option is used, data points are added to the triangulation surface along the edited contour segment to make the triangulation surface match the contour line. Existing triangulation source data is retained. So the updated triangulation is the combination of the original source data and the additional points from Edit Contours. One way to get a triangulation surface associated with the contours is to use the Triangulate & Contour command with both Write Triangulation File and Draw Contours options active.

**Note:** If the triangulation association is not used, then this routine has no effect on the actual triangulation or grid surface model file that the contours may have been drawn from. It only revises the drawn contour or polyline on the screen. If the contours are later regenerated from this file, the edits will be discarded.

---

**Prompts**
Select contour to edit: *pick the contour polyline at the place to start editing*
Pick intermediate point (Enter to End): *pick a point*
Pick intermediate point ('U' to Undo, Enter to End): *pick a point*
Pick intermediate point ('U' to Undo, Enter to End): *press Enter*
Pick reconnection point on contour: *pick the contour polyline at the place to join*

![Edit this contour by picking new points](image1)
![Contour with segment replaced with new points](image2)

**Pulldown Menu Location:** Surface >> Modify Contours  
**Keyboard Command:** editctr  
**Prerequisite:** Polylines with elevation (contour polylines)

---

### Contour ID

Contour ID reports the routine and source data used to generate the selected contour polyline.

### Prompts

**Select contour polyline to identify:** *pick a polyline*  
**Surface Name:** Triangulate & Contour by screen entities  
**Select contour polyline to identify (Enter to end):** *press Enter*

**Pulldown Menu Location:** Surface->Modify Contours  
**Keyboard Command:** CTR_ID  
**Prerequisite:** a contour polyline

---

### Color Contours by Elevation

This command sets the color of the selected contour polylines and text based on elevation. The color to use is defined in elevation range table.
- **Auto** - This button opens the following dialog, allowing for automatic configuration of the range of elevations and colors.

- **Starting Zone #** - Sets the zone with which to begin the application of the settings defined in this dialog. For instance, if the Starting Zone was set to 10, the settings definitions applied here wouldn't affect Zones 1-9, but would start at Zone 10.

- **Set Values** - Enables the Starting Value and Value Interval fields, which allow the user to specify the starting elevation for the given zone and set the zone increment.

- **Starting Value** - Sets the starting elevation value for the first zone.

- **Value Interval** - Sets the elevation increment for subsequent zones.

- **Set Colors** - Enables the Starting Color and Color Increment fields.

- **Starting Color #** - Sets the starting color number, based on the AutoCAD standard color chart.

- **Color Increment** - Sets the color number to increase for subsequent zones. So if the increment was set to 5, and the starting color was 60, the next color would be 65, 70, and so on.

- **Note**: The Pattern, Scale, and Layer options do not apply to this command.

- **Clear** - Clears the all of the Elevation fields in the dialog

- **Load** - Loads previous settings from a saved .pat file

- **Save** - Saves the current setting configuration to a .pat file.
Prompts

Select polylines and text to color: *pick the entities*
Define Ranges Dialog
Pick point for color legend: *pick a point to a clear area of the drawing to place a legend or press Enter for no legend*

Pull-Down Menu Location: Surface >> Modify Contours >> Color Contours
Keyboard Command: ctrcolor
Prerequisite: Contours polylines

Color Contours by Interval
This command sets the color of the selected contour polylines based on the elevation interval values, which are essentially the number that the elevation ends with, so specific colors are assigned for elevations ending in 0, 1, 2, etc. The color assignments are defined in the Define Interval Colors dialog box.

![Define Interval Colors Dialog]

Select Entities: User is prompted to select the contour polylines to change.
By Layer: Contour polylines are selected automatically by their layer.

Prompts

Define Interval Colors Dialog If Select Entities is set as Interval Colors Method, *pick OK*, and you are prompted to:
Select polylines and text to color: *pick the entities* If By Layer is set as Interval Colors Method, set the layers by Screen selection or from a list by Name, then *pick OK*.

Pull-Down Menu Location: Surface >> Modify Contours >> Color Contours
Keyboard Command: ctrcolor2
Prerequisite: Contours polylines

Highlight Index Contours

This command will move contours of a specified interval to another layer. This allows the user to change the color or width of a certain interval. This is useful if all the contours had been generated on a single layer, and you wish to display the index contours differently based on a new layer setting.

Prompts

Layer name of existing contours <CTR>: press Enter
Layer name for highlight contours <NCTR>: press Enter
Select Contours to Highlight.
Select objects: Select contours using any standard selection methods.
Select objects: press Enter to conclude selection. The program then sorts and displays the High and Low interval of the selected contours.
Contour increment to highlight: 10
Starting Highlight at elevation <98.0>: 100
Ending Highlight at elevation <152.0>: 150
Assuming we had drawn 1 foot intervals, the above example would move the contours on elevations 100, 110, 120, 130, 140 and 150 to the layer NCTR.

Pulldown Menu Location: Surface >> Modify Contours
Keyboard Command: indexctr
Prerequisite: Contours should be plotted and visible on the screen.

Highlight Depression Contours

This command highlights depression contours by changing their layer, color, and adding tick marks. A depression contour is a closed contour line that leads to a local minimum such that there are no contour lines with a higher elevation within the contour. This routine finds the depression contours out of the selected polylines. The depression contours are highlighted, and the user selects which ones to label.

Prompts

Layer name of existing contours <CTR>: Enter
Layer name for depression contours <DCTR>: Enter
Width for depression contours <1.0>: Enter
Tick Interval for depression contours <50.00>: Enter
Tick Size for depression contours <6.0>: Enter
Select the existing contours.
Select objects: Select all the contour polylines, even the contours that aren't depression contours.
Select objects: press Enter to conclude selection. The program then sorts and displays the high and low elevations of the selected contours.
Reading the selection set ...
Locating the depression contours ...
Highlight all or selected depression contours [All/<Selected>]? A The "All" option changes all contours identified as depression contours to the specified layer and adds tick marks. The "Selected" option highlights all contours identified as depression contours and then user is prompted to select which ones to change to specified depression contour layer and add tick marks to.

Drawing the depression contours ...
Highlighted depression contours

**Pulldown Menu Location:** Surface >> Modify Contours  
**Keyword Command:** depress  
**Prerequisite:** Contours should be plotted and visible on the screen.

---

**Change Contour-Plines Width**

This command allows the user to select a group of contours/plines and change their width for emphasis when plotting. Prior to running this command, the desired contours can be isolated to their own layer using the Highlight Index Contours command, or if already on a separate layer you may use Isolate Layer from the View menu.

An alternate to using this routine is to assign an AutoCAD lineweight to the layer that the contours or polylines are on and set the Display Lineweight toggle at the bottom of the screen. If using this routine to assign a polyline width, then this new width will display regardless of the lineweight toggle.

**Pulldown Menu Location:** Surface >> Modify Contours  
**Keyword Command:** cwidth  
**Prerequisite:** Contour polylines should be drawn and visible on the screen.

---

**Contour Elevation Label**

This command can be used to simultaneously create elevation labels on a group of contour polylines at elevation. First the command starts with a dialog with the label options. Then to place the labels, pick two points crossing the contour polylines at the desired label location. The program will find all the contour polylines that intersect the picked line (defined by the two picked points) and will place labels at the intersection point of each contour. A second crossing line can be initiated immediately, so multiple areas can be quickly labeled while remaining in the command. Alternatively, you can type P for Polyline at the Command prompt and select a polyline. Then the program finds all the intersections between the selected polyline and the contours and places labels at these intersections. The actual "z" elevation of the contour line determines the label value.
**Label Layer** specifies layer name for the contour labels that will be created.

**Label Style** specifies the text style to be used for labels.

**Horizontal Scale** is used in conjunction with the Text Size Scaler to determine unit height of the contour labels.

**Text Size Scaler** is a scaler that will be multiplied by the horizontal scale to set the actual text height of the labels in AutoCAD units.

**Integers** controls how many digits to label to the left of the decimal. For example, if all contours are in the 5000's, then setting for three digits would label the 5280 contour as 280.

**Decimals** sets the decimal precision for the labels to be created.

**Label Position** determines the label position in relation to the contour polyline.

- **On Contour** centers the label on the contour line.
- **Above Contour** places the label above the contour line. If this option is used, the options for Break Contours at Label and Draw Broken Segments become inactive.

**Ignore Zero Elevation Polylines** enables the routine to filter out all entities with an elevation of zero.

**Hide Drawing Under Labels** activates a text wipeout feature that will create the appearance of trimmed segments at the contour label, even though the contour line is still fully intact. This feature provides the user with the best of both worlds: you have clean looking contour labels, yet the contour lines themselves remain contiguous. This feature will also hide other entities that are in the immediate vicinity of the contour label.

**Align Facing Uphill** makes the label parallel to the contour and flips the label so that it reads facing uphill. Otherwise, the labels are made to face up relative to the current screen view. When this option is on, the program prompts for a triangulation surface file that should match the surface the contours represent.

**Use Commas** adds a comma into the labels for the thousands place such as "5,000" instead of "5000".

When **Align Text with Contour** is checked, contour elevation labels will be rotated to align with their respective contour lines.

When **Break Contours at Label** is checked, the contour lines will be broken and trimmed at the label location for label visibility.

When **Draw Broken Segments** is checked, segments of contours that are broken out for label visibility will be redrawn as independent segments. Specify the layer for these broken segments in the box to the right of this toggle.
Label Contour Ends creates labels off the ends of the contours.
Label By Distance places the labels by distance along the contour. The user is not prompted for screen picks of contour crossing when this option is used.

- **Interval** sets the distance interval to be used between labels on each contour.

When **Draw Box Around Text** is checked, a rectangle will be drawn around the elevation labels. The Offset Scaler controls the size of the rectangle.
The **Draw On Real Z Axis** chooses between creating the text entities at the elevations of the contours or at zero elevation.
The **Use MText** chooses between creating MText and DText label entities.

**Index Contours:** Label All will label both index and intermediate contours with the same settings. Label Index Only labels only the index contours. Separate Index Layer will label both index and intermediate contours with the index labels on a different layer.

**Prompts**

**Contour Label Options Dialog Opens** Select the desired options and press OK.
Define a line which slices the contours at the desired label locations.
Pick 1st point (P-Polyline, Enter to end): *pick a point*
Pick 2nd point: *pick a point*

By selecting two points the contour lines that cross the line defined by the two points are labeled.

**Pulldown Menu Location:** Surface >> Contour Labels
**Keyboard Command:** gclabel
**Prerequisite:** polylines with elevation (contour polylines)

**Move Label Along Contour**

This command slides an existing contour label along a contour, maintaining its alignment with the contour. After moving the label, you can type F for Flip at the Command prompt to rotate the label orientation by 180. The label must have originally been created with the **Break Contours at Label** option Off. If the option to **Hide Drawing Under Labels** was used when the label was created, the wipeout will move with the label when using this command.
In addition to moving a label, an existing label can be copied and placed at a new position along the contour by using the Copy option at the first prompt.

**Prompts**

Copy/<Select contour label to move>: Pick label
Pick new contour label position: Move mouse to relocate label
Flip last/<Select contour label to move (Enter to end)>: press Enter

Pulldown Menu Location: Surface >> Contour Labels  
Keyboard Command: move_ctr_label  
Prerequisite: generated contour labels

**Flip Contour Labels-Text**

This command individually rotates each of the selected text entities by 180 degrees.

Pulldown Menu Location: Surface >> Contour Labels  
Keyboard Command: fliptext  
Prerequisite: Text labels on contours

**Volumes By Triangulation**

Volumes By Triangulation is a volume method that compares two triangulation networks. This method is different from the grid based volume routines (Volumes By Layer, One Surface Volumes, Two Surface Volumes, Stockpile Volumes, etc.) and the cross section volume routine (Calculate Section Volume). Volumes by Triangulation calculates faster in most cases than the other methods, and it is the most accurate because it uses true TIN to TIN prismatic volumes. This added accuracy in general is very small. The grid resolution is usually sufficient to model the surface for the grid based volumes. The Volume By Triangulation accuracy applies well when there is a feature like a 5 foot wide ditch. Then the grid resolution would need to be less than 5 feet to model the ditch which might be difficult on a large site.

When multiple inclusion polylines are selected, there is an option to Report Multiple Perimeters Separately which reports the volumes for each inclusion separately. Otherwise the total volumes from all the inclusions is reported. For the separate inclusions report, the report will include the names assigned to the polylines by either the Tag Predefined Boundaries, Tag Area Descriptions, Tag Area Of Interest or Name Pit Polylines commands.

The disadvantage to this routine is that it lacks the output options that help the analysis of the volume such as Difference Contours. Also Volumes by Triangulation does no extrapolation and stops calculating volume at the perimeter of the smaller of the two triangulation networks. Volumes By Triangulation is better when used with point data instead of contour data because contour data requires triangulating all the contour polylines as breaklines which creates a large triangulation network and is slower.

The triangulation networks to compare are defined in .tin or .flt files that are created by Triangle & Contour with the Write Triangulation File option. Note that while both file formats are supported, the newer binary triangulation file format (.tin) is twice as fast to load and save, and half the size, of the .flt triangulation file format. For this reason, the .tin file format is recommended. Before using this command, run Triangle & Contour twice to create an triangulation (.TIN or .FLT) file for each surface. The volume calculation is limited by either the extent of the triangulation networks or by an inclusion/exclusion perimeter(s). These perimeters must be closed polylines.

Output data includes area, tons by density, average thickness, shrink and swell, ratio, and total volume.
Shrink/Swell Factors

An optional aspect of the Volumes by Triangulation routine is the ability to supply either a Cut "Swell" Factor and/or a Fill "Shrink" Factor to the results of the volume calculation. Having a solid understanding on the ramifications of each factor is important for determining how (and when) the values should be used for earthwork considerations.

The factors are commonly expressed as decimal differences from the "factor neutral" value of 1.00. In most cases, surface models are representations of what currently exists in the field or what is desired to exist after construction. Consider the following examples:

**Excavating a Pit**

Suppose you are given the task of designing a below ground storage pit. Based on your design surface model, the amount of Cut has been determined to be 1,000

**C.Y.Cut Swell Factor > 1 (example 1.15)**

Supplying a Cut Swell Factor greater than 1 would usually be taken to mean "How much volume will my 1,000 C.Y. of material occupy when it comes out of the ground?" With a 15% swell factor (1.15) applied, the 1000 C.Y. of excavated material would now occupy 1,150 C.Y. of space.

**C.Y.Cut Swell Factor < 1 (example 0.85)**

Supplying a Cut Swell Factor less than 1 would usually be taken to mean "How much volume will 1,000 C.Y. of material occupy in this hole when it has been compacted?" With a 15% compaction factor (0.85) applied, the 1000 C.Y. of material getting compacted would now occupy 850 C.Y. of the hole space.

**Working with a Stockpile**

Suppose you have a stockpile of material that is suitable for building purposes. Based on your design surface model, the amount of material has been determined to be 1,000 C.Y.

**Fill Shrink Factor > 1 (example 1.10)**

Supplying a Fill Shrink Factor greater than 1 (see NOTE below) would usually be taken to mean "How much volume would this 1,000 C.Y. of material occupy if it were picked up and deposited elsewhere?" With a 10% swell factor (1.10) applied, the 1000 C.Y. of stockpile material would occupy 1100 C.Y. of space.

**Fill Shrink Factor < 1 (example 0.90)**

Supplying a Fill Shrink Factor less than 1 would usually be taken to mean "How much volume will 1,000 C.Y. of stockpile material occupy when it has been compacted?" With a 10% compaction factor (0.90) applied, the 1000 C.Y. of material getting compacted would now occupy 900 C.Y. of the hole space.

**Note:**

- In a design Fill scenario (such as a berm), often it is desired to know how much material would need to be brought in at a given compaction factor to occupy the design fill. To determine this value, use the following equation:

  \[
  \text{Fill Factor} = \frac{100.0}{(100.0 - \text{shrink\_percentage})}, \text{using 15% shrink as an example,}
  \]

  \[
  \text{Fill Factor} = \frac{100.0}{(100.0 - 15.0)} = 1.17647
  \]

**Prompts**

Select EXISTING Surface Triangulation File Choose an .flt or .tin file
Select FINAL Surface Triangulation File Choose an .flt or .tin file
Select Inclusion polylines.
Select objects: select objects that form a perimeter around the area of study
Select Exclusion polylines.
Select objects: select objects that form an exclusion area within the area of study
**Cut Swell Factor:** Supply an appropriate factor by which the calculated Cut volume should be multiplied.  
**Fill Shrink Factor:** Supply an appropriate factor by which the calculated Fill volume should be multiplied.  
**Use Report Formatter:** Choose between customizing the report and using the standard report.  
**Volume Units and Area Units:** Choose the units to include in the report.  
**Calculate Elevation Zone Volumes:** This option calculates cut/fill volumes within elevation ranges. The ranges use a specified elevation interval and can start from the top or bottom.  
**Report Tons:** Enable this option to report the tonnage of Cut material and Fill material based on the material density.  
**Density:** Indicate the average material density.  
**Write TIN Difference:** Enable this option to create a TIN based on the elevation difference between the EXISTING surface and the FINAL surface.

---

**Pulldown Menu Location(s):** Civil > Surface > Volumes by Triangulation, Survey > Surface > Volumes by Triangulation  
**Keyboard Command:** trivol  
**Prerequisite:** Two .flt or .tin files
One Triangulation Surface Volumes

This command calculates and reports the volume between a triangulation surface (.tin, .flt) file and a reference. The reference can be either an elevation or the TIN perimeter. The elevation method applies to cases like having a triangulation surface for the bottom of a pond and calculating the water volume to a water elevation. The TIN perimeter method creates a second surface by triangulating the perimeter points of the TIN. This method applies to cases like stockpile volumes where the base of the stockpile is not level and is covered so that the perimeter is the only data available to model the base.

In the Volume Report Options, the Cut and Fill Swell Factors are multiplied by the Cut and Fill volumes for the report. The Report Tons option multiplies the volumes by the specified density to report tons. The Write TIN Difference option creates a new TIN surface of the elevation difference between the triangulation and reference surfaces.

Note: The volume comparison of this routine uses the triangulation surface file as the base surface, and the reference as the final surface. So be aware that if your reference is set primarily below the surface defined by the triangulation file, it will report as cut, when in reality you may be filling above the reference to reach the defined surface.

Prompts

Select Triangulation File dialog
Triangulation Volumes options dialog
Select Inclusion polylines.
Select objects: select inclusion boundary(ies) or Enter for none.
Select Exclusion polylines.
Select objects: select exclusion boundary(ies) or Enter for none.

Chapter 16. Surface Menu
**Pulldown Menu Location:** Surface > Volumes By Triangulation  
**Keyboard Command:** trivol1  
**Prerequisite:** Triangulation (.flt or .tin) file  

---

**Triangulation File Utilities**

This command allows you to modify TIN surfaces in a variety of different ways, then allows for 3D viewing and shading of the modified surface and finally for saving the file with a choice of output formats. The focus of the routine is to elevate or lower the TIN or selected areas within the TIN, merge TINs with other surfaces, or use data from other TIN files to apply to the current TIN.

Operations can be performed on the entire TIN or just on user selected Inclusion and/or Exclusion areas. The routine will automatically rework the TIN network for conformation to a selected boundary, say a building outline. In the case of said building, a value of 10 could be subtracted from the building outline. This will drop all of the triangulation within the outline by 10', thus creating a model of the excavated area for the building. The modified TIN can then be saved to a new file, which could be used to compute an excavation volume with Volumes by Triangulation. This routine does not allow for manual editing of individual portions of the TIN; refer to the editing options found under Surface Manager.
**Load TIN File:** Allows you to specify a triangulation (.flt or .tin) file to load.

**Load GRD File:** Allows you to specify a grid (.grd) file to load.

**Load DXF File:** Allows you to specify a DXF file to load. Only loads 3DFACE entities from the selected DXF file.

**Select 3D Faces:** Allows you to select 3DFACE entities from the current drawing. This also includes rectangular 3D faces from a plotted grid.

**Pick Bounding Polylines:** Allows you to select any inclusion/exclusion perimeter(s). When this button is selected, the user is taken back to the drawing and prompted to select the perimeters. Press Enter when the selections are finished to return back to the dialog.

**Display TIN:** Controls the detail level of the TIN in the graphic display. When the TIN is very large, the graphic display can cause delays. The Low Detail mode shows a simplified TIN graphic. The Outline Only mode shows only the TIN perimeter. The Full Render mode shows all the triangles.

**Color Display:** Displays the triangles based on whether or not they are part of the Inclusion/Exclusion set via the Pick Bounding Polylines option or colored based on the individual triangle color property.

**Fast TIN Intersect:** When checked, this command will perform a simple and fast check for overlapping triangles and is the preferred choice in most cases. However, if problems with the TIN are suspected, this option should be unchecked so a complete and thorough check and repair of the TIN is performed.

**Fill-in-holes:** When checked, any missing triangulation (or "gaps") in the surface will be automatically filled in with additional triangles. This option has to be set before loading the TIN file to take effect.

**Region Mode:** This option deals with nested or overlapping boundaries. When checked, "hatch pattern logic" is applied in which all nested boundaries are used in an alternating fashion, so that an Inclusion Boundary within an Exclusion Boundary is still recognized. If this option is not checked, everything within an Exclusion Boundary is ignored.

**Next:** Press this button to proceed to the next dialog after all selections have been made.

The next dialog allows you to perform mathematical operation(s) on the loaded TIN. Each operation is described below. Keep in mind that generally these operations are to be performed on an area inside your inclusion perimeter (but excluding anything inside your exclusion perimeters). If you do not specify any perimeters, the desired
operation(s) will be performed on the entire TIN.

---

**Add:** Adds to the TIN elevations using either a Value or another TIN. For Value, it prompts for a value to Add to the elevations of the subject area of the TIN. The TIN method raises the subject area of the current TIN by the elevation value from a second user-selected TIN file. This function is most applicable to applying a strata thickness (e.g. landfill cover) on top of a TIN to get a new target surface elevation.

**Subtract:** Subtracts from the TIN elevations using either a Value or another TIN. For Value, it prompts for a value to Subtract from the elevations of the subject area of the TIN. The TIN method lowers the subject area of the current TIN by the elevation value from a second user-selected TIN file.

**Multiply:** Multiplies the TIN elevations by either a Value or another TIN. For Value, it prompts for a value to Multiply to the elevations of the subject area of the TIN.

**Divide:** Divides the TIN elevation by either a Value or another TIN. For Value, it prompts for a value to Divide into the elevations of the subject area of the TIN.

**Min TIN:** This does a comparison between the current TIN and a second user-selected TIN file and applies the lower value of the two TINs to the subject area.

**Max TIN:** This does a comparison between the current TIN and a second user-selected TIN file and applies the higher value of the two TINs to the subject area.

**Merge TIN:** Merges the current subject TIN into a second user-specified TIN file. There are six methods to merge tins. The methods for merging effect the way the gaps and elevation differences between the TINs are handled. If the two TINs being merged meet within a relatively close tolerance, the different methods will have little effect. In situations where the two surfaces being merged vary significantly, i.e. an asbuilt of an area where the existing ground ‘tie in points’ are also disturbed, the method of merging will be more obvious.
1. **Current TIN inside/Second TIN outside the buffer boundary:** This method is only available when Bounding Polylines are selected in the first Triangulation File Utilities dialog. The current TIN will be used inside the boundary polylines and the second TIN is used everywhere else. Any gap or elevation difference between the two TINs are directly joined and interpolated within the confines of that gap. The current TIN file should be the smaller of the two surfaces since the subject file will be joined or merged into the second file. For example, to merge a pad design into existing ground with this method, choose the pad design as the current TIN, pick the pad perimeter as the bounding polyline and use existing ground as the second TIN. This method is effective if there is little difference between the two TINs.

2. **Second TIN inside/Current TIN outside the buffer boundary:** This method uses the second TIN inside the boundary and the current TIN everywhere else. The outline of the second TIN is used as the boundary if no bounding polylines where selected in the initial dialog. Any gap or elevation difference between the two TINs are directly joined and interpolated within the confines of that gap. For example, to merge a pad design into existing ground with this method, choose the existing ground as the current TIN and choose the pad design as the second TIN. This method is effective if there is little difference between the two TINs.

3. **Second TIN inside/Current TIN outside single boundary, adjusted elevation:** This method removes triangles from the current TIN for areas that overlap the second TIN and then adjusts the elevations to meet the second TIN edges. This method creates a smoother transition between the two TINs but will densify the triangles along the edges. For example when blending an As Built TIN into an previously surveyed area, choose the As Built TIN as second.

4. **Remove from Current TIN where overlaps Second TIN, combine and repair gap:** This method removes triangles from the current TIN for areas that overlap the second TIN. Then the second TIN is added into the current TIN surface and the gap between the current and second TINs is triangulated to stitch them together. This method is useful when the two TINs don't have matching elevations on their common boundary. This method will create a transition zone between the TINs but creates more distortion along the first TIN but will have less dense triangles than the *adjusted elevation* method.

5. **Second TIN inside/Current TIN outside boundary, merge points into single triangulation:** This method merges the two TINs by triangulating a new surface from the point data from each TIN, eliminating any overlapping areas. This method will create all new triangles for the entire surface so any previous edits (ie. swapped edges) will not be maintained.

6. **Merge source data and recreate triangulation. TIN history data required.** This method merges two TINs and recreates a new surface utilizing any edits made and recorded in the TIN history file. This is method
is effective for users who have performed particular edits to either TIN that may not be contained in the underlying data.

Set color of Included Triangles: When enabled, the color of triangles included in the merge are set as specified.
Set color of Excluded Triangles: When enabled, the color of triangles excluded from the merge are set as specified.

Enhance Flats: There are two method:
1. **Interpolate Ridges, Valleys, Summits:** This routine eliminates flat triangles by adding a data point inside the triangle at a different elevation to subdivide the triangle. The elevation of this point is calculated based on the slopes of the neighboring triangles.
2. **Swap Edges to Minimize Flat Triangles:** This routine swaps edges of flat triangles when it can find a neighboring point with a different elevation and still maintain the triangulation.

Translate: This function has two methods:
1. **Delta:** This method moves the TIN points by the specified delta x, y and z.
2. **Geoid:** This method adjusts the elevations by the selected geoid. To use the Geoid method, the grid projection for the drawing must be defined in the Drawing Setup command.

Rotate: Rotates the TIN points by the specified rotation angle around a base point.

Scale: Scales the TIN points by the specified scale factor from a base point. The scale can be applied to just the x,y of the TIN points or the z, too. As an example, the Scale feature can be used to convert a TIN between Imperial and Metric units.

Offset: Performs a perpendicular offset (from the face/s) to the TIN surface by the specified amount. The routine offsets each point in the TIN vertically by looking at the slopes that connect to the point. For points at slope transition points such as at the bottom of a ditch, these corner points are effected by both slopes which means the program can't hold either exactly. To hold both slopes exactly would require changing the x/y position of the TIN points which this routine doesn't do to avoid more complications. So if the offset surface needs to exactly hold the slopes, then use another method like extracting Cross-sections from the Surface, offsetting these sections, creating 3D polylines from Sections and modeling the 3D polylines.

Smooth: There are three methods to smooth the triangulation surface.
1. **Moving Least Squares:** Smooths the surface by adjusting the elevations using a moving least squares method.
2. **Subdivide:** Performs a subdivision on the triangles within a TIN for the intent of developing a smoother rendition of the surface. This option is commonly used in scenarios where surface models are derived from man-made data (e.g. surfaces from contour maps, on-line sources, etc). The routine starts to subdivide each triangle "n" times with each iteration finding the centroid of the triangle. New triangles are formed using this centroid location and the process continues.
3. **Polynomial:** This option uses a polynomial interpolation in an effort to add additional points into the surface model in an effort to produce a more "rounded" (less man-made) surface.
4. **Laplace:** This method uses the Laplacian method that adjusts each vertex using the positions of the neighboring vertices.

Simplify: Causes edges within the TIN mesh to be collapsed to reduce the number of triangles, edges, and points within the TIN while having a minimal impact on the overall shape of the TIN. There are three methods:
1. **Elevation Difference:** Looks at the effect of removing a point from the TIN. The point is removed if the elevation difference between the original point and the updated TIN is less than the tolerance.
2. **Edge Cost:** Looks at the effect of removing an edge from the TIN.
3. **Quadric Error:** Looks at vertex pairs and minimizes surface changes using quadric matrices.
**Tolerance:** This setting is used by both of the Simplification options described above. Specify the maximum average distance that any point can be moved outside of the plane of any triangle that connects to that point. Values might range from .01 to .1 for most purposes.

**Passes:** For the Elevation Difference option, this is the number of times the program will check through all the points.

**Hold Breaklines:** Further analyzes the TIN by focusing on the edges, calculating the angular difference between adjacent triangular faces. If the angular difference between edges is greater than the specified Breakline Angle, it is considered to be a breakline, and it is preserved. If its angular difference is determined to be below the Breakline Angle, it becomes a candidate for removal. In that case, the Breakline Weight factor is applied to the corresponding vertex, adjusting its original value. If the resulting value is still below the Tolerance, it is then removed. The number of vertices removed is inversely proportional to the Breakline Weight factor, so the greater the Breakline Weight factor, the fewer vertices that are removed, the lower the Breakline Weight factor, the more vertices that are removed.

**TIN Statistics:** Generates a report of the TIN statistics, including number of points, edges, and triangles, and minimum and maximum Z values.

**Set Color:** Assigns a selected color to the TIN triangles. The color is used when viewing the TIN file in the 3D viewer commands. To set the color within an inclusion perimeter, use the Pick Boundary Polylines option.

**Ridge/Valley Lines:** This option permits you to select previously drawn polylines that represent surface model breaklines to enhance the approximate appearance or effect of ridges and/or valleys within the surface model. A more precise procedure would be to first utilize the 3D Polyline routine and re-create the surface model by specifying the 3D polylines within the Triangulate & Contour routine.

**Refine:** This function adds points to the triangulation to make more uniform triangles and fewer skinny triangles. The Min Edge Length prevents adding points that result in an edge length below this minimum. The Interations is how many passes the routine does through the triangulation.

**Break Bent Edges:** Used commonly in scenarios for a TIN created from contour entities, there is a likelihood of areas where horizontal triangles (also known as "flat triangles") adjoin sloped triangles. The routine will detect such edges, add an additional point on the horizontal triangles and assign its elevation representing the trend of the surface, by extrapolation, looking to restore presumed surface data that was lost in recreating the TIN from...
contours. This methodology provides additional corrective options to that of the Minimize Flat Triangles option of the Triangulate & Contour routine.

**Set Elevation:** This button has four functions.

- **Set New Elev:** Sets all TIN faces in the subject area to the elevation specified.
- **Set NULLs to Elev:** Sets all NULL (empty) values in the subject area to the elevation specified.
- **Set Elev to NULL:** Sets all of the elevation values in the subject area to NULL (empty).
- **Set Elev by Surface:** Sets all TIN faces within the subject area to the elevations from a second surface file within the same area. You will be prompted to select a second TIN file or grid file. Only areas common to both surfaces will be applied to the subject TIN.

**Shrink-Wrap:** This function removes skinny triangles around the perimeter without causing any triangulation points to become disconnected. There are three reduction levels: low, medium and high. The low removes the fewest triangles and high the most.

**Reduce:** This function removes triangulation points that are within the specified distance and then re-triangulates the surface.

**Improve Valleys:** The purpose of this function to clean up the bottom of the valley to permit unrestricted water flow for watershed analysis routines. The typical TIN may include small ridges, crossing the very bottom of the valley, obstructing the flow. There are two separate clean up methods in this function: the breakline method and the low path one.

- **The Breakline Method** improves TIN surface by inserting breakline segments between each eligible sink and the closest lower point to that sink such that the highest crest point between these two points is not higher than a given height tolerance (max depth) above the sink. Maximum breakline is a limit to the length of used breakline.

- **The Lower Path Method** works by finding optimal paths between neighboring sinks, and lowering the necessary points between them to allow water to run from one to the other. The maximum depth controls the maximum amount a point along the path can be lowered by.

**Crop/Cut:** This function removes the triangulation by a closed perimeter polyline. The routine embeds the polyline into the triangulation surface using the elevations of the triangulation. You can either remove the triangulation...
inside the perimeter (Cut), or remove the triangulation outside the perimeter (Cut).

**Clean:** This function removes skinny and tiny triangles that have an edge less than the specified Distance Tolerance.

## Output Options

The following three options determine what part or parts of the TIN modifications that will be saved to the new TIN file. If the entire TIN is to be saved, all three options should be enabled.

- **Insides:** If this is the only option checked, only changes made to the TIN within the inclusion perimeter will be saved. TIN entities outside of the perimeter will not be saved to the named file.
- **Border:** When the routine re-works the TIN to fit around a perimeter, a small horizontal offset is automatically applied to prevent the formation of vertical faces. The Border function will save changes made to TIN in this offset area.
- **Outsides:** If this is the only option checked, TIN entities inside of the inclusion perimeter will not be saved to the named file. Everything outside of the perimeter will be saved.

**Save:** Saves the current TIN as an .flt or .tin file.

**Draw:** Draws the current TIN as 3D Faces in the current viewport. The Layer window is used to specify the layer that the faces will be created in.

**Export:** There are three export formats:
1. Export To Text (points only): Writes the TIN point locations to a user-specified ASCII-based coordinate file.
2. Export To Text (points and triangles): Outputs a text file of the points and triangle indexes.
3. Export To DXF: Saves the current TIN as a .dxf file. This format can be used by many other CAD programs.

<table>
<thead>
<tr>
<th>Control</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Zoom In/Out" /></td>
<td>Converts the left mouse button to a zoom function. Hold the button down and move the mouse up or down to zoom in and out.</td>
</tr>
<tr>
<td><img src="image.png" alt="Rotate" /></td>
<td>Converts the left mouse button to a rotate function. Hold the button down to rotate the view in any X, Y or Z direction. When the XY appears in the window, the rotation will occur relative to the XY axis. When the mouse is moved toward the outer perimeter of the window, the XY will change to a Z. Holding the button down while the Z is visible will rotate the drawing on the Z axis.</td>
</tr>
<tr>
<td><img src="image.png" alt="Pan" /></td>
<td>Restores the graphics to plan view.</td>
</tr>
<tr>
<td><img src="image.png" alt="Shading" /></td>
<td>Converts the left mouse button to a pan function. Hold down on the button while moving the mouse to pan. Holding down the mouse wheel will also serve as a pan function in any of the above modes.</td>
</tr>
<tr>
<td><img src="image.png" alt="Undo" /></td>
<td>Toggles shading on and off.</td>
</tr>
<tr>
<td><img src="image.png" alt="Redo" /></td>
<td>Reverses the effects of all operations performed on the TIN and reverts it back to its original status.</td>
</tr>
<tr>
<td><img src="image.png" alt="Exit" /></td>
<td>This icon exits the routine. If the TIN has been modified, you will be prompted to save.</td>
</tr>
</tbody>
</table>

**Usability Controls**

**Pulldown Menu Location(s):** Surface

**Keyboard Command:** tinutil
Prerequisite: 3D Faces, a TIN file or a DXF file containing 3DFACE entities.

**Triangulation Surface Manager**

**Surface Manager**

The Surface Manager toolkit allows you to modify pre-defined triangulated surfaces, making real-time modifications and updates to contours and associated TIN (Triangulated Irregular Network) definitions. Functionality includes swapping TIN lines, adding or removing (untagging) breaklines, adding or removing points by range or group, adjusting point elevations, removing TIN lines, drawing or removing contour lines and labels, re-contouring at a different interval or with different label settings, etc. Contour lines are automatically updated to reflect any changes made to the TIN. A surface must be named and saved by one of the surface modeling routines (in the Triangulate tab) as a prerequisite to using the Surface Manager.

![Surface Manager interface](image)

All of the tools available in the Surface Manager are also available in the fly-out menu, as shown in this figure. Their functions are identical but require a surface to be set current. Changes made apply only to the current surface.

![Surface Manager menu](image)

**Set Current** Designates a surface as current for editing with various surface tool functions, such as modifying TIN lines, setting a new contour interval, labeling contours, etc.
Add Allows you to add a surface by selecting a surface model file (.TIN or .FLT).

Remove Allows you to remove a surface from the list of stored surfaces.

Rename Allows you to rename a surface.

Copy Creates a copy of the TIN file and adds the copy as a new entry.

Edit Displays various edit tools. Clicking on any of these commands will activate the command line, where you will be prompted based on the Edit command selected.

Draw Allows you to alter the drawing display properties for TIN lines, contours and labels for the selected surface. Applicable dialogs from Triangulate and Contour are used to provide a full set of options. When accessed, settings for the current surface display configuration are set. To make a modification, simply specify the desired change and press ok. For instance, if Draw Triangulation Lines was checked on, unchecking the box and pressing ok will redraw the surface without the TIN lines. If the contours were drawn at 1 foot intervals, setting the interval value to 2 and pressing OK will redraw the contours at 2 foot intervals. Refer to the Triangulate and Contour section of the manual for a more detailed explanation of the options.

History The Triangulation History Editor displays all functions performed during the creation and editing of a TIN file. Each edit can then be eliminated from the process without recreating the TIN from scratch. In cases where the user does recreate the TIN, any edits previously performed can be recalled and re-implemented.

Settings Allows you to set the triangle edge and breakline Color and Transparency for easier editing. Many times the triangle edges or breaklines can get lost or match colors for say the contours and this allows you to better differentiate the items when editing.
**Add Point (AP)** prompts to pick point or point number to add [Group/Range]. This allows you to add triangulation point(s) to the network by either graphically picking points from the screen; typing a point number; or by adding an entire (R)ange or point (G)roup to the TIN. You can add points to the inside or the outside of the TIN. The elevation for graphically selected points is interpolated from the surrounding TIN network. This is a good method for adding additional triangulation to the surface in a sparse area. Also, a new elevation can be specified for the picked point. There is an option for whether to store the graphically selected point to the coordinate file. When 3D polylines are created by Field to Finish and you add point by range or point group that covers the point numbers used to make the 3D polylines, then the segments from these 3D polylines are used as breaklines in the TIN.

**Remove Point (RP)** removes an existing triangulation intersection from the TIN network. The affected triangulation re-adjusts to compensate for the missing intersection. Contours update accordingly.

**Move Point (MP)** is a combination of removing a point and adding it at a new location.

**Set Elevation (SP)** sets a new elevation for a specified TIN intersection. The affected TIN is adjusted and the contours are updated.

**Add Breakline (AB)** adds a breakline to the surface by picking beginning and ending points on the screen. The endpoint snap automatically turns on. Only one breakline can be created at a time. The TIN network will reconfigure to follow the new breakline and update the contours. This does not create 3d polylines in the drawing.

**Untag Breakline (UB)** removes breaklines from the TIN that were either added through Add Breakline Edit command or through the initial selection of lines in the drawing.

**Add Entities (AE)** adds selected points and breaklines into the TIN by graphical selection of existing entities on screen.

**Remove Entities (RE)** removes selected points and breaklines from the TIN by graphical selection of entities used in its creation.

**Swap Edge (SW)** swaps common TIN edges to create two different triangles from the original triangle configuration. Contours automatically update to reflect changes made to the TIN. Some common edges may not be swapped because of the orientation of the two triangles.

**Remove Triangle by Interior Point (RT)** removes a TIN line from the surface by picking a TIN line or selecting an interior point. Contours are removed from the affected area.

**Remove Triangles by Fence (RF)** removes existing triangles that touch the fence as it is being drawn across the triangles.

**Remove Triangles by Window (RW)** removes existing triangles using a crossing-type window whereby any triangles that touch or are contained within the window when drawn will be removed.

**Remove Triangles by Boundary (RB)** removes existing triangles that touch or are contained within a selected closed boundary or polyline.
Add Pnt(AP), Move Pnt(MP), Set elev(SP), Add Breakline(AB), Untag Breakline (UB), Add Entities(AE), SWap edge(SW), ID Pnt(ID), Show/Hide Tris(ST), Remove Pnt(RP), Remove Tri(RT), Remove Entities(RE), Remove by Window(RW), Remove by Fence(RF), Remove by Boundary(RB), Update Tris(UT) Press Enter to end. Press Esc to cancel.

Add Pnt(AP)

Pick point or point number to add [Group/Range]: Graphically pick points from the screen; type a point number; or add an entire (R)ange or point (G)roup to the TIN. When graphically selecting a point, you will be prompted for the elevation of the new point, and if you would like to add the new point to the current coordinate file.

Move Pnt(MP)

Pick near point to move: Graphically pick near a point to move. Carlson will take that point and place it in a new location when prompted.

Set elev(SP)

Pick near point to set elevation: Graphically pick near a point to change the elevation and you will be prompted for the new elevation.

Add Breakline(AB)

Pick point or point number for 1st breakline point: Graphically snap 2 points on the screen for the new breakline.
Untag Breakline (UB)

Select an breakline edge to untag: Graphically select a triangle edge that represents a breakline to remove.

Add Entities (AE)

Select points and breaklines to add to triangulation. FILter/Select entities: Graphically select entities to add to the TIN by pick or window selection.

SWap edge (SW)

Select an internal edge to swap: Graphically pick near a Triangle Edge to swap. This will switch the direction of two triangles sharing the same edge.
**ID Pnt(ID)**

*(Prompt is from current edit command)* The coordinates of the nearest triangle vertex are displayed on the commandline *(Point: x=, y=, z=).*

**Show/Hide Tris(ST)**

*(Prompt is from current edit command)* Temporarily toggles the display of the triangles ON or OFF the screen for easier editing.

**Remove Point(RP)**

**Pick point to remove:** Graphically pick near a point you wish to remove from the TIN.

**Remove Tri(RT)**

**Removing Triangles, Pick point or enter keyword:** Graphically pick inside a triangle you wish to remove.
Remove Entities (RE)

Select entities to remove from triangulation. Filter/Select entities: Graphically remove breaklines, points, etc. that were used in the creation of the TIN that you want to remove from the TIN. This will reform the TIN without the selected entities.

Remove by Window (RW)

Pick 1st corner of area to remove: Graphically select 2 points of a window. Any TIN triangles inside or touching the window selection will be removed from the TIN.

Remove by Fence (RF)

Pick beginning of fence: Graphically select points on a screen to create a fence. Any TIN triangles touching the fence selection will be removed from the TIN.

Remove by Boundary (RB)

Select boundary polyline: Graphically select a closed polyline. Any TIN triangles inside or touching the polyline will be removed from the TIN.

Update Tris (UT)

(Prompt is from current edit command) Refreshes the TIN drawn on the screen from the TIN file.

To conclude the Surface Edit mode, press Enter at the end of the internal command sequence. This will return to the Surface Manager dialog. If you press Escape key instead, the following dialog is displayed:
This prevents you from accidentally undoing all of your changes by unintentional pressing the ESC key.

(Draw) Properties allows you to draw the surface and control the properties for the TIN lines, contours and labels for the selected surface. Applicable dialogs from Triangulate and Contour are used to provide a full set of options. When accessed, settings for the current surface display configuration are set. To make a modification, simply specify the desired change and press ok. Refer to the Triangulate and Contour section of the manual for a more detailed explanation of the options.

The Triangulation History Editor displays all functions performed during the creation and editing of a TIN file. Each edit can then be eliminated from the process without recreating the TIN from scratch. In cases where the user does recreate the TIN, any edits previously performed can be recalled and re-implemented. For example, if you have added several breaklines and later decide that they were unnecessary, highlight the added breaklines and click Remove Entry. You can also change the order in which an edit appears, such as the application of an exclusion boundary toward the end of the list of edits.
**Move Up / Move Down** moves the selected edit up or down in the chronological list of edits.

**Remove Entry** removes an edit from the TIN.

**Zoom To** centers the CAD screen on the location of the selected edit.

**Ignore history data from missing entities** If toggled OFF, all history data in list will be used to process the TIN. If toggle ON, any entities not available will not be used to recreate the TIN, and therefore will be removed until the missing TIN entities are restored.

**Add/Remove Entities** allows you to select new items to add to the TIN or select existing items to remove from the TIN.

**Replace Selection** allows you to replace a TIN edit in the history with a new edit.

**Check for Changes** will read the TIN file and check to see if any changes have been made that are not currently reflected in the current TIN file.

**Pulldown Menu Location:** Surface  
**Keyboard Command:** surface_mgr  
**Prerequisite:** Need to have at least one TIN (.TIN/.FLT) file

**Surface_Report**  
This command reports a variety of information on each of your different surfaces. This is useful for checking for bad data and the file names of your surfaces. An example is below.

**Surface Report 3/10/2005 15:34**
Original Ground After Topsoil Removal
File: C:\Documents and Settings\Todd Carlson\Desktop\Takeoff\Drawings\demo3-ex.flt
Date Modified: Thu Feb 10 10:02:05 2005
File Size: 64,028
Points: 259, Edges: 744, Triangles: 486
Min Z: 184.000 at 409299.790,206879.287
Max Z: 210.000 at 409571.562,207177.240

Design With Subgrade and Topsoil Replacement
File: C:\Documents and Settings\Todd Carlson\Desktop\Takeoff\Drawings\demo3-fn.flt
Date Modified: Thu Feb 10 10:02:08 2005
File Size: 153,038
Points: 609, Edges: 1,779, Triangles: 1,171
Min Z: 176.000 at 409357.096,206821.604
Max Z: 206.000 at 409551.532,207185.124

Original Ground Before Topsoil Removal
File: C:\Documents and Settings\Todd Carlson\Desktop\Takeoff\Drawings\demo3-og.flt
Date Modified: Thu Feb 10 10:02:05 2005
File Size: 64,028
Points: 259, Edges: 744, Triangles: 486
Min Z: 184.000 at 409299.790,206879.287
Max Z: 210.000 at 409571.562,207177.240

Design Without Subgrade or Topsoil Replacement
File: C:\Documents and Settings\Todd Carlson\Desktop\Takeoff\Drawings\demo3-bs.flt
Date Modified: Thu Feb 10 10:02:08 2005
File Size: 153,038
Points: 609, Edges: 1,779, Triangles: 1,171
Min Z: 176.000 at 409357.096,206821.604
Max Z: 206.000 at 409551.532,207185.124

Design With Subgrade
File: C:\Documents and Settings\Todd Carlson\Desktop\Takeoff\Drawings\demo3-zn.flt
Date Modified: Thu Feb 10 10:02:08 2005
File Size: 153,038
Points: 609, Edges: 1,779, Triangles: 1,171
Min Z: 176.000 at 409357.096,206821.604
Max Z: 206.000 at 409551.532,207185.124

Prerequisites: A Surface
Keyboard Command: SURF STATS

Make 3D Grid File
This command creates a grid (.GRD) file which serves as a surface model for use in many of the other Surface routines. The program internally makes a triangular network of the data points (if Triangulation is selected as the modeling method) and then interpolates the elevation values of a rectangular grid at the specified grid resolution. Data points can be either points, inserts, lines, or polylines. Lines and polylines are treated as breaklines in the triangulation.
Gridding as a means of modeling surface features is generally less favorable than triangulating as the surface is defined only at the intersection of the grid lines. This can lead to inaccuracies around local features such as ditches or curb lines, since the grid resolution must be small enough to adequately capture the changes in these local regions. Contrast this with Triangulated Networks which carry all this information at every point along the features. Gridding can, however, be useful for modeling large sites in general trends such as watershed analyses and large-scale volume computations.

The grid location is specified by first picking a lower left corner and then an upper right corner. The screen cannot be twisted when this is done because grids always run north-south and east-west.

The dialog box sets the range of elevations to process, modeling method and grid resolution. Each of these items is described below.

- **Source Data**: This option selects the type of data to use for gridding. The Screen Entities option processes selected 3D entities from the drawing including points, lines, polylines, 3D faces and inserts. The Coordinate
File and Text File options read point data from the selected file. These methods are useful for large datasets that would take extra memory and time to draw as points in the drawing. For the Text File, the program will prompt for the order of the fields and the delimiter. The Triangulation File option will interpolate the grid elevations from the selected triangulation surface.

• **Range of Elevations/Values to Process:** Entities with elevations or values outside the range to process are ignored and will not be used for the gridding.

• **Modeling Method:** The modeling method almost always should be triangulation for surface topographic grid files. Polynomial, inverse distance, kriging and linear least squares apply to random data points for surfaces like underground features, usually sourced by such methods as drillholes, data tables, etc.

• **Triangulation Mode:** When using Triangulation and Polynomial methods, There are four triangulation modes: AutoDetect, Triangulation Only, Intersection with Triangulation and Intersection Only.
  
  – **Auto Detect** method automatically chooses between the Triangulation Only and Intersection with Triangulation methods. If the selected surface entities are primarily made of polylines, then the Intersection with Triangulation method is used. Otherwise the Triangulation Only method is used.
  
  – **Triangulation Only** method builds a triangulation surface out of all the selected points, lines and polylines. All lines and polylines are treated as breaklines. Grid node elevations are calculated based on the triangulation.
  
  – **Triangulation with Subdivision** method uses the subdividual surfaces modeling method. This option causes each triangle in the triangulation surface model to be subdivided into an average of three smaller triangles per subdivision generation. This gives a much smoother surface model, where instead of one triangle, there are now three or more.
  
  – **Intersection Only** method goes directly to the Steepest Intersection method using the selected lines and polylines. The Steepest Intersection method is used to assign the grid node elevations from the linework of the triangulation lines and the selected lines and polylines. The triangulation step is skipped and any selected point data is not used. This method can be used for making grids out of polylines such as a contour map as long as the surface is defined just by contour polylines without needing spot elevation points. Skipping the triangulation step makes this method a lot faster especially for large files.

• **Use Inclusion/Exclusion Areas:** This option will prompt for inclusion and/or exclusion perimeter polylines and will only assign grid cell elevations within these areas and leave the rest of the grid cells as Null.

• **Grid Resolution:** The grid resolution is specified by either the number of grid cells or by the size for each grid cell. It is usually best to set the Dimensions of a Cell to a known size, and the program will calculate the "number of cells in X and Y." While the program can handle really large grids with no limit, a general rule of thumb is to keep the total number of grids cells under 500,000 (about 700 by 700 cells) to limit the processing time. The grid location and resolution can also be specified by using the position/resolution from an existing grid file. In this case, the location and resolution of the new grid will match those of the selected grid file which is useful for routines that require two grid files with identical locations and resolutions.

No elevations are calculated on grid cells that extend beyond the extent of the data. The figure shows an example of how the grid is calculated to the limits of the data points. Extrapolation can be used to calculate elevations for the grid cells that are beyond the data limits. When there are grid cells with no elevation in a grid (.GRD) file, many routines will prompt *Extrapolate grid to full grid size?* Extrapolation fills in all the grid cells. The method to extrapolate uses a safe calculation that tends to average out or level the extrapolated values. So extrapolated grid areas are not as accurate as grid areas within the limits of the data. *Grid File Utilities* can be used to apply and save extrapolation to a grid file. The *Plot 3D Grid* command can then draw the grid file so that you can see the extrapolation.

A Carlson grid (.GRD) file has the following format:

Line 1 is the lower left Y coordinate
Line 2 is the lower left X coordinate
Line 3 is the upper right Y coordinate
Line 4 is the upper right X coordinate
Line 5 is the X direction grid resolution
Line 6 is the Y direction grid resolution

The rest of the lines are the Z values of the grid intersects starting from the lower left moving in the left to right direction and ending at the upper right. If the intersect has no value, the letter ‘N’ is saved instead of the Z value for Null values. An example is shown in the Display-Edit Report dialog.

**Gridding from Contour Maps**

A grid file can be created from contours represented as polylines with elevation. The program calculates the elevation of each grid corner by looking for contour intersections in eight directions (N, S, E, W, NE, SE, SW, NW) and then interpolating the elevation between the two steepest intersections.

To accurately model the surface, it might be necessary to add entities in addition to the contour polylines. For one, spot elevation points can be added for the high and low points. Otherwise the grid model might plateau at the last contour. Also 3D breaklines need to be added on long narrow ridge and valley contours because in these areas the program will find the same contour when it looks for intersections in the eight directions. When all eight intersections are the same contour, the interpolated grid elevation equals the contour elevation instead of rising up the ridge or dipping in the valley. The 3D breaklines force interpolation along the ridge or valley. To draw these polylines, set the OSNAP to Nearest and run the 3D Polyline command. Then draw the polyline by picking the contour polylines where the breakline crosses them. Another way to quickly create breaklines is to first draw 2D polylines. Then convert these polylines into 3D polylines with the Screen option in the 2D to 3D Polyline by Surface Model command found on the 3Dpoly menu. There is also an automatic way to draw these breaklines. Under 3D Data, use the command: Create Ridge polylines from Contours.

**Prompts**

**Grid File to Create File Selection Dialog**
Enter a name for the grid file.

Use position from another file or pick grid position [<Pick>/File]?

Pick Lower Left grid corner <8111.88,3985.08>: pick a point for the lower left limit of the grid

Pick Upper Right grid corner <8366.88,4195.08>: pick a point

Make Grid File dialog box
In this dialog, you specify the grid resolution and whether or not to include data points with zero elevations. You can specify the resolution by entering the number of grid cells in the X and Y directions. By the Dimensions option, you to set the X and Y size for each grid cell.

Reading points ...
Select points, lines, polylines and faces to grid from.
Select objects: Specify opposite corner: 1075 found
Select objects:
Reading points ... 980
Finding points on breaklines ...
Ignored 2729 duplicate points.
Inserting breaklines 3480 ...
Triangulating points ... 980
Assigning grid values> 1800
Writing grid file: C:\Carlson 2008\WORK\example1.grd
Pick the Lower Left grid corner: pick a point for the lower left limit of the grid
Pick the Upper Right grid corner: pick a point

Pulldown Menu Location: Surface
Keyboard Command: mkgrid
Prerequisite: Entities that define the surface

Draw 3D Grid File

This command draws the 3D grid mesh of the chosen grid (.GRD) file. Each grid cell can be drawn as a Surface Object, 3D Face entities, Polyface mesh, Text or temporary lines. 3D Faces and Polyface Meshes can be viewed/used in the following commands: 3D Viewer Window, Viewpoint 3D, Hide, Shade, 3D Surface FlyOver, and Slope Zone Analysis.

The Surface Object is a custom object for displaying the grid in the drawing. This custom object also supports the EndPoint snap. The main advantage of the Surface Object is with displaying large grid files because the Surface Object is more efficient than drawing individual 3D Faces. The Surface Object requires Carlson to be loaded to display.
If **Use Vertical Exaggeration** is checked, grid elevations are multiplied by the value specified.

**Exaggeration Method** specifies whether to use an *Absolute* exaggeration method or *Relative to Base*, which uses the specified base elevation.

Specify the type of entities to draw in **Draw Method**. 3D Faces are described above. The Preview Only option draws the grid using temporary vectors. This method provides a much faster way to view the grid. However, these temporary vectors are erased when the viewport is modified. This means as soon as you execute zoom, redraw, regen or plot, this grid will disappear. You can quickly redraw the grid by typing in VG for View Grid at the command prompt. Polyface Mesh is similar to 3D Faces except it is a single entity. The Text option will label the grid elevation at the grid corner. The text is placed center justified over the grid corner. To reduce clutter, there is an option to skip rows and columns.

Specify the layer for the grid entities in **Layer Name**.

Specify the initial viewing direction in **View**.

When **Color by Elevation** is checked, the grid will be colored based on a table of user-defined elevation ranges and the assigned colors. There is also an option to subdivide the grid cells at the color zone transitions. This is similar to the Elevation Zone Analysis command. Use the Specify Elevation Zones command to define ranges and colors.

When **Draw Side Faces** is checked, the program will draw vertical faces around the perimeter of the grid. The side faces will be drawn vertically from the grid perimeter to the Sides Base Elevation. You may optionally specify the Sides Base Elevation, it defaults to 0.00.

When checked, **Reverse Face Order** changes the direction of the points for a grid cell from clockwise to counterclockwise. The order applies to shading the grid cell in 3D render viewers such as the 3D Viewer Window command. The grid cell will only appear shaded when viewing the grid cell from the clockwise side. Viewing from the other side will show a wire frame. The default is to show the shaded side from the top-down view. This option allows you to draw the grid so that the underside of the grid is shaded.

When checked, **Draw Corners Only** will draw the side lines only at the grid corners. Otherwise side lines are drawn down each perimeter grid cell.
When checked, **Extrapolate Grid to Full Size** draws the entire rectangular surface of the grid.

When **Use Inclusion/Exclusion Perimeters** is checked, it allows you to select inclusion and exclusion areas. Only grid cells inside the inclusion polylines will be drawn. Grid cells inside the exclusion polylines will not be drawn.

When checked, **Subdivide Grid Around Inclusion Perimeter** subdivides grid cells that are partially inside and outside the perimeter into smaller resolution grid cells.

![Drawn grid file using inclusion perimeter and side faces option viewed with Viewpoint 3D](image)

**Pulldown Menu Location:** Surface >> Draw Surface  
**Keyboard Command:** plotgrid  
**Prerequisite:** a grid (.GRD) File

---

**Two Grid Surface Volumes**

*Two Grid Surface Volumes* calculates the cut and fill volumes between two surfaces modeled by grid (.GRD) files. These two grid files must have the same location and resolution. To create the grid files, use the *Make 3D Grid File* routine. When creating the second grid file, choose *Use position of another file* and select the first grid file. Using the position of the first grid file sets the location and resolution of second grid to match the first.

There are several other routines that calculate volumes based on grid files. Grid based volumes can be calculated by *One Grid Surface Volumes, Volumes by Layer, Stockpile Volumes, and Pond/Pit Volumes*. These routines have special prompting and calculate the grid surfaces and volume in one step.

Volumes by Two Surface Volumes has three steps:

1. Creating the first grid file with *Make 3D Grid File*
2. Creating the second grid file with *Make 3D Grid File*
3. Running *Two Grid Surface Volumes*

One advantage to this command is that you have more output options to help analyze volumes.

Besides grid based volumes, volumes can also be calculated between triangulation surfaces using the *Volumes by Triangulation* commands. Cross section end area is another volume method that is used by the *Calculate Sections Volume* command in the Civil Design module.

There are also options to specify inclusion and exclusion areas. When inclusion areas are specified, only the volume within this inclusion area is calculated. **Important:** Whenever possible you should use a polyline that represents the limits of disturbed area as the inclusion perimeter. Volumes within an exclusion area are not included in the calculations. Inclusion and exclusion areas are represented by closed polylines and must be drawn prior to calling this routine.

If the grid contains grid cells that have no elevations, you have the option to extrapolate elevations from the grid cells with elevations. When you choose not to extrapolate, no volume is calculated for the grid cells left without
elevations. In general, extrapolation is not very accurate and should be avoided whenever possible. Sometimes you may get small amounts of cut in stockpiles that should only be fill, or small amounts of fill in pits that should only be cut. These extraneous quantities are due to extrapolation at the border and should be small enough to be ignored. When inclusion or exclusion polylines are used, the program will automatically extrapolate the grids. In addition to writing a volume report to the file, printer or screen, there are several volume report options.

**Write Difference Grid File** creates a grid (.GRD) file of the elevation difference of the two grid files.

**Draw Difference Contours** creates a contour map of the difference or depth between the two grid files.

**Draw Elevation Difference in Each Cell** plots the elevation difference at the grid corners which is the same as the Elevation Difference routine.

**Draw Volume in Each Cell** plots the calculated volume for each grid cell and is an excellent way to verify the volume calculation. If a cell contains both cut and fill, both values will be plotted.

**Calculate Elevation Zone Volumes** calculates the cut and fill between different elevation ranges.

**Draw Cut/Fill Color Map** fills each grid cell with different shades based on the average cut or fill in the cell. Red shades are used for cut and blue for fill. There is an option to draw a color legend. You can subdivide the grid cells at zone transitions. Also, there is an option to control the zone intervals and range.

**Use Report Formatter** allows you to customize the report by choosing the fields to report and their order. Also the report formatter can be used to output the report data to Microsoft® Excel or Microsoft® Access.

**Process Another Area with Current Grids** runs Two Surface Volumes again using the same grid files but different inclusion/exclusion polylines. This option saves the step of reloading the grid files to calculate volumes from the same grids for multiple areas.

The **Cut Swell Factor** value is multiplied by the cut volume in the report.

The **Fill Swell Factor** value is multiplied by the fill volume in the report.

**Report Tons** allows you to enter the material density and the program will report the cut and fill tons in addition to volume.

Given two accurate grid (.GRD) files, this routine will calculate accurate volumes. To verify the volume calculation, it is a good idea to check the grid (.GRD) files either by drawing them with **Draw Surface >> Draw 3D Grid File** and viewing them with the 3D Viewer or by contouring the grids with the **Contour Grid File** command.

---

**Chapter 16. Surface Menu** 1057
Contours from the Draw Depth/Difference Contours option. Cut contours are red, fill contours are blue, daylight contours are green. This is a good way to check that both surfaces are modeled correctly and to verify the volumes.

**Sample Two Surface Volumes report:**

**Volume Report**

Comparing Grid: C:\scad2006\data\simo.grd
and Grid: C:\scad2006\data\final.grd
Lower left grid corner: 186551.67, 57624.98
Upper right grid corner: 186828.81, 57897.09
X grid resolution: 75, Y grid resolution: 75
X grid cell size: 3.70, Y grid cell size: 3.63
Total inclusion area: 37016.71 sq ft, 0.850 acres
Cut to Fill ratio: 1.14
Cut (C.Y) / Area (acres): 3642.35
Fill (C.Y) / Area (acres): 3182.70
Cut vol: 83570.89 cubic ft, 3095.22 cubic yards
Fill vol: 73024.56 cubic ft, 2704.61 cubic yards

**Prompts**

Select the Inclusion perimeter polylines or ENTER for none:
Select objects: pick a closed polyline for the limits of disturbed area
Select objects: press Enter
Select the Exclusion perimeter polylines or ENTER for none:
Select objects: press Enter
Specify Base Grid File Selection Dialog
Choose a grid (.GRD) file to process.
Extrapolate grid to full grid size (Yes/<No>)? press Enter If you enter Yes to this prompt, surface elevations will be computed for any grid cells that have null elevations.

Sample report from the Calculate Elevation Zone Volumes option:
(Calculates the cut and fill in different elevation ranges at a user-specified interval and beginning at a user-specified starting elevation.)

Volumes by elevation zone
Zone 20.00 to 30.00
Cut volume : 0.30 cubic ft, 0.01 cubic yards
Fill volume: 107.90 cubic ft, 4.00 cubic yards
Zone 30.00 to 40.00
Cut volume : 4.88 cubic ft, 0.18 cubic yards
Fill volume: 73021.14 cubic ft, 2704.49 cubic yards
Running total:
Cut volume : 5.18 cubic ft, 0.19 cubic yards
Fill volume: 73129.05 cubic ft, 2708.48 cubic yards
Zone 40.00 to 50.00
Cut volume : 65044.26 cubic ft, 2409.05 cubic yards
Fill volume: 0.25 cubic ft, 0.01 cubic yards
Running total:
Cut volume : 65049.44 cubic ft, 2409.24 cubic yards
Fill volume: 73129.29 cubic ft, 2708.49 cubic yards
Zone 50.00 to 60.00
Cut volume : 17786.85 cubic ft, 658.77 cubic yards
Fill volume: 0.00 cubic ft, 0.00 cubic yards
Running total:
Cut volume : 82836.29 cubic ft, 3068.01 cubic yards

Specify Final Grid File Selection Dialog
Choose a grid (.GRD) file to process.
Extrapolate grid to full grid size (Yes/<No>)? press Enter
Volume Report Options dialog
This shows a grid drawn by Plot 3D Grid File and volume values drawn by the Draw Volume in Each Cell option of the Two Surface Volumes routine. Cut appears as negative and fill as positive. Notice that cells bordering cut and fill regions contain a little of both.

Pulldown Menu Location: Surface >> Volumes By Grid Surfaces
Keyboard Command: volcalc2
Prerequisite: Two grid files

**Volumes By Layers**

This is the easiest yet still equally accurate method for calculating volumes. For this command, volumes are calculated in one step by a simple window of the area, selecting the items, and *calculate*.

First, you must specify the grid location and resolution. The grid location should enclose the area for volume calculations. Next the program asks for the layer names of the entities for the base and final surfaces. You designate the layers to use for each surface either by typing the layer names or by picking from the screen, then during the routine you select the entities to use. You may safely use the keyword *ALL* to select the entities, since you have pre-defined the layers to use, and all those entities not on the specified layers will be filtered out. These entities, for use in modeling the surfaces, can be points, lines (such as triangulation lines), 2D polylines (such as contours), and 3D polylines (such as breaklines).

Inclusion and exclusion perimeters may optionally be specified to limit the volume calculation area on the grid. An inclusion perimeter should be used if there is a closed polyline for the limit of the disturbed area. Then the program internally generates grids of the surfaces from the entities on the corresponding layers and then calculates and reports the volume. The main disadvantage to this routine is that it doesn't have the special output options of Two Grid Surface Volumes such as Depth Contours.

**Prompts**

Command: layervol
Pick Lower Left limit of surface area: pick lower left corner of grid
Pick Upper Right limit of surface area: *pick upper right corner of grid*

You are then prompted to designate layers:

```
Press Select Layers from Screen to show the routine which layers to use by selecting sample objects from those layers.

Select entities on layers of Existing surface. *select sample object(s)*
Select objects: Specify opposite corner: 3 found
Select objects: press Enter to conclude selection.

Select entities on layers of Final surface. *select sample object(s)*
Select objects: Specify opposite corner: 10 found
Select objects: press Enter to conclude selection.

Reading points ...
Select surface entities on corresponding layers.
Select objects: *all* filters out those objects not on designated layers
85 found
Select objects: press Enter to conclude selection.
Reading points ... 9396
Assigning grid values > 5300
Pass > 28 Null Z values left > 0
Writing grid file: C:\Documents and Settings\..\USER\grid1.grd
Assigning grid values > 5300
Pass > 43 Null Z values left > 0
Writing grid file: C:\Documents and Settings\..\USER\grid2.grd

Select the Inclusion perimeter polylines or ENTER for none: *select inclusion perimeter*
Select objects: 1 found
Select objects: press Enter to conclude selection.
Select the Exclusion perimeter polylines or ENTER for none.
Select objects: press Enter for none.
Reading cell > 5346
Pass > 28 Null Z values left > 0
Reading cell > 5346
Pass > 43 Null Z values left > 0
Pre-processing grid cells ....
Processing cells ...
Select point for color legend (Enter for None): press Enter
```
Pulldown Menu Location: Surface >> Volumes By Grid Surfaces

Keyboard Command: layervol

Prerequisite: Entities that define both the base and final surfaces.

Spot Elevations

Draw Spot Elevations

This command creates spot elevation labels based on user settings.
Label Style: This option at the top of the dialog determines which options are available in the rest of the dialog.

Label with Leader: This option draws a leader between the spot location and the label. The style of the leader is controlled by the current DIMSTYLE settings.

Label with Symbol: Draws the specified symbol at the spot with the label off to the side.

Carlson Point: This option creates a Carlson point entity with the point#, elevation, description attribute block and stores the point to the current coordinate file. When creating Carlson points, there is an option for Prompt For Description for entering descriptions for the points for the point entities and coordinate file.

Label Decimal on Point: Draws only the elevation label and positions the label so that the label decimal is on the spot.

Label Insertion on Point: Draws only the elevation label and uses the spot location for the insertion point of the label.

Label Only: Draws the label without any indicator of the exact reference point for the label.

Symbol: Draws the symbol to be used for the location of the spot elevation. If Draw with Leader is selected, the use of a symbol is automatically disabled. Along with the symbol name, you can also set the Size Scaler to size the symbol and the Offset Scaler to control the offset between the symbol and the label. The Prompt For Symbol Angle option allows you to rotate the symbol. Otherwise, the symbol is drawn horizontal to the current twist screen.

Leader Segments controls how many leader segments the program will prompt for. Place Label Along Leader draws the label along the leader instead of horizontal off the end of the leader. Leader Horizontal > Tick draws a short horizontal segment at the label end of the leader. Leader Horizontal > Underline draws a leader line under the label. Draw Symbol with Leader combines the symbol with the leader. Arrow Scaler controls the size of the arrowhead. The Use MLeader creates an mleader entity. Otherwise a regular leader and separate text entities are drawn.

Draw Point Node: Specify whether to create a node (point entity) at the spot.

Options: Under Options, there are settings to control the layer, text style, text size and prefix/suffix for the labels.

Box Labels controls whether to draw a box around the label and Box Scaler controls the size of the box and is applied as a factor of the text size.
Locate Label On Real Z sets whether the label and symbol are placed at the spot elevation or at zero elevation. There are several settings for fields to prompt for when placing each spot label including prefix, suffix, position and angle.

Use Attribute Block: This option uses a block with attributes to draw the spot elevations. This allows you more control of the label layout. There is one default spot elevation attribute block called spot_z1.dwg in the Carlson Support folder. To customize the layout, open the attribute block drawing, make your edits and then save the drawing. The attribute block uses three attribute definitions: Integers, Decimals, Suffix. Integers is for the elevation digits to the left of the decimal point. Decimals is for the digits to the right of the decimal point. Suffix is a text description.

Use MText: This option draws the labels as MText instead of regular Text.
Prefix/Suffix on New Line: This option labels the elevation value on a separate line from the prefix or suffix.

Placement Method:
Individual: Prompts the user for a screen pick or a point number to specify the location of the spot elevation.
Pick Entity: This method labels the elevation of the selected 3D entity. For 3D polylines, the elevation comes from the polyline at the location the polyline is selected.
Point Range/Group: Draw spot elevations at the specified point numbers or point group name from the current coordinate file.
Interval: Prompts the user to select an existing polyline and specify an interval distance to set spot labels along the polyline. It also prompts for number and interval for additional labels to be set at offset distances right and/or left of the polyline.

Use Reference:
Off: User is prompted to supply elevation for each new spot elevation.
Single Surface File: Prompts user to specify the triangulation or grid surface model file to read the elevations from. Spot elevations created with this method are automatically updated if the surface model elevation changes.
Two Surface Difference: Prompts user to specify an existing surface file and a design surface file, and labels the elevation difference between the two.
Slope Percent/Ratio From Point/Polyline: These methods allow you to set the spot elevation by a slope percent or ratio from a reference point/polyline. These methods have another option for whether to Prompt for Slope which will prompt for the slope from the reference for each spot. Otherwise, the Slope From Reference setting in the dialog is used. When using the Polyline reference method, the program finds the station-offset of the spot point along the polyline and uses the elevation of the polyline at that station for the reference.
Link To Reference applies to using a surface file or 3D polyline for the spot elevations. This link option will automatically update the labels when the reference surface file or 3D polyline change.

The Hide Drawing Under Labels option creates a wipeout under the spot label to hide any other drawing entities behind the label.
The Integers setting controls how many decimal places to the left of the decimal point to label and the Decimals settings controls how many decimal places to the right of the decimal point to label. The Round By .5 option rounds the last digit to either 0 or 5.

Prompt for Prefix/Suffix: These options will prompt for the labels for each point which is useful when labeling different kinds of spots.
Prompt for Label Position: When using Label With Symbol style, this option will prompt for where to place the label for each spot.
Prompt for Elevation: Prompts to enter the elevation for each spot. Otherwise, the elevation of the picked point is used.
Prompt for Second Elevation: Prompts for a second elevation for each spot. This option applies when labeling two elevations at the same point such as top and bottom of curb when they have varying elevation differences between them. If the two elevation have a fixed elevation difference, then you can use the Vertical Offset for the Second Label.
Prompt for Label Angle: This option allows you to rotate the label for each spot. Otherwise, the label is drawn horizontal to the current twist screen.
Vertical Offset adjusts the elevation label by the specified amount.
Additional Label has separate settings for Vertical Offset, Prefix and Suffix which allows for labeling two elevations for the same spot such as labeling both bottom and top of curb.
write and recall the settings to a .LSE file so that you can store different label styles and share them.

**Pulldown Menu Location:** 3D Data  
**Keyboard Command:** labspot  
**Prerequisite:** None

### Adjust Elevation Labels

This command has several functions that allow you to modify spot elevation labels.

The **Remove Base Elevation** function removes the base elevation amount from the labels. For instance, often elevations are abbreviated to save space. If every elevation in a drawing is in the 500's instead of labeling every elevation 523.5, 543.3, 537.2 sometimes you may wish to have them displayed as simply 23.5, 43.3, 37.2. This command allows you to adjust the labels by a given amount, such as 500, to every label elevation. This does not affect the actual elevation of entities in the drawing or in the associated surface model file.

The **Add Base Elevation** function is the reverse of Remove and applies when the labels are missing the base elevation and you want to add this elevation into the labels.

The **Offset Elevation** function adds the specified offset amount to the elevation labels and applies when elevation labels need to be adjusted by a fixed vertical offset.

The **Set Integer Digits** function sets the number of digits to the left of the decimal point for the elevation labels.

The **Set Decimals** function sets the number of digits to the right of the decimal point for the elevation labels.

The **Elevation Block Attribute Tag** edit allows the user to specify the name of the tag in a block reference to apply elevation adjustment functions to. This settings does not apply to Carlson Coordinate Point block references for which the "ELEV2" tag attribute is always adjusted.

### Prompts
Select a sample elevation label: select single label to identify the source layer to process
Select spot elevation labels to process.
Select objects: select the text to process

Pulldown Menu Location: 3D Data
Keyboard Command: adjust_elevation_labels
Prerequisite: Spot Elevation label text

Hard Breakline Polylines

Tag Hard Breakline Polylines
This command tags polylines with a description so that Triangulate & Contour can identify these polylines as hard breaklines. The tag is invisible and doesn't change the polyline. Triangulate & Contour will not smooth the contours as they cross these hard breaklines, even with contour smoothing turned on. For example you could tag 3D polylines that represent a wall or a curb so that the contours go straight across without smoothing curves. If contour smoothing is turned off, this tag had no effect.

Prompts
Select hard breakline polylines. (For no smoothing in Triangulate & Contour)
Select objects: Select breaklines to tag
Select objects: press Enter to conclude selection
Set 14 polylines as hard breaklines.

Pulldown Menu Location: 3D Data >> Hard Breaklines
Keyboard Command: hardbrk
Prerequisite: Polylines

Highlight Hard Breakline Polylines
This command visually highlights all polylines in the drawing that have been tagged as hard breaklines.

Pulldown Menu Location: 3D Data >> Hard Breaklines
Keyboard Command: highlight_hardbrk
Prerequisite: Polylines tagged as hard breaklines

Identify Hard Breakline Polylines
This command prompts to select polylines and reports to the command line whether they are tagged as hard breaklines or not.

Prompts
Select polyline: select polyline
Polyline is a hard breakline
Select polyline ([Enter] to End): select polyline
Not a hard breakline
Select polyline ([Enter] to End): press Enter to conclude.
Untag Hard Breakline Polygons

This command removes description tags from poly-lines. These tags are used by Triangulate & Contour to identify poly-lines as hard breaklines. Contours are not smoothed as they cross these hard breaklines. This routine un-tags poly-lines so that contours are smoothed across them.

Prompts

Select poly-lines to remove hard breakline tag from.

Select objects: select poly-lines

Prerequisite: Poly-lines with hard breakline tag.

Keyboard Command: softbrk

Non-Surface Points/Entities

Tag Non-Surface Points

This command allows you to tag Carlson points in the drawing so that they will not be used when creating a surface. These could be points that are far from the site, such as off-site horizontal control, or points with elevations that are not on the ground, such as a TBM taken on the top of a fire hydrant. There are several methods available to select the points for tagging as non-surface points. One key to remember is that they must be present in the drawing to be tagged.

Range: This option allows you to specify a range of point numbers, or select ALL of the points currently in the drawing, or specify a Point Group, remembering, however, that only points that are currently in the drawing can be tagged. So if you select a Point Group, but only some of the points listed in the Point Group are currently present in the drawing, the whole Point Group will not be tagged.
This option allows you to utilize inclusion and/or exclusion polyline(s) to specify an area in the drawing within which any points currently in the drawing are tagged as non-surface points.

Selection Set: This option allows the manual selection of points within the drawing.

Description Match: This option allows the filtering of selected points by descriptions. For example, you could use a Range of ALL, but set the Description Match to TBM, and only the points with that description would be tagged.

Pulldown Menu Location: 3D Data >> Non-Surface Points
Keyboard Command: tagns
Prerequisite: Carlson points in a drawing

Untag Non-Surface Points
This command allows you to Untag Carlson points in the drawing that have been tagged as non-surface points, so that they will again be used when creating a surface. As with tagging non-surface points, there are several methods available to select the points for untagging, and the points must be present in the drawing to be untagged.

Range: This option allows you to specify a range of point numbers, or select ALL of the points currently in the drawing, or specify a Point Group, remembering, however, that only points that are currently in the drawing can be tagged. So if you select a Point Group, but only some of the points listed in the Point Group are currently present in the drawing, the whole Point Group will not be tagged.

Area: This option allows you to utilize inclusion and/or exclusion polyline(s) to specify an area in the drawing within which any points currently in the drawing are tagged as non-surface points.

Selection Set: This option allows the manual selection of points within the drawing.

Description Match: This option allows the filtering of selected points by descriptions. For example, you could use a Range of ALL, but set the Description Match to TBM, and only the points with that description would be tagged.

Pulldown Menu Location: 3D Data >> Non-Surface Points
Keyboard Command: untagns
Prerequisite: Carlson points in a drawing
This command allows you to generate a report of Carlson points in the drawing that have been tagged as non-surface points. As with tagging and untagging non-surface points, there are several methods available to select the points for the report, and again, the points must be present in the drawing to be included in the report.

**Range:** This option allows you to specify a range of point numbers, or select ALL of the points currently in the drawing, or specify a Point Group, remembering, however, that only points that are currently in the drawing can be tagged. So if you select a Point Group, but only some of the points listed in the Point Group are currently present in the drawing, the whole Point Group will not be tagged.

**Area:** This option allows you to utilize inclusion and/or exclusion polyline(s) to specify an area in the drawing within which any points currently in the drawing are tagged as non-surface points.

**Selection Set:** This option allows the manual selection of points within the drawing.

**Description Match:** This option allows the filtering of selected points by descriptions. For example, you could use a Range of ALL, but set the Description Match to TBM, and only the points with that description would be tagged.
Pulldown Menu Location: 3D Data >>> Non-Surface Points  
Keyboard Command: tagns  
Prerequisite: Carlson points in a drawing

**Import/Export Surface Data**

**Convert LDT/Civil3D Surface Drawing**

This command allows you to convert Autodesk Civil3D or Land Desktop custom surface objects into standard AutoCAD entities. For example, this command will convert AECC_CONTOUR objects into polylines with elevation. The conversion is done on the currently opened drawing. Besides converting the drawing entities, the routine checks for triangulation surface definitions within the drawing and prompts whether to save these surfaces to Carlson .TIN files. The conversion routine was developed in cooperation with the Open Design Alliance (ODA) and does not use object enablers from Autodesk.

If you have Civil 3D, another way to make a drawing with standard AutoCAD entities is to use the aectoacad command in Civil 3D which converts the custom objects into standard entities.

Pulldown Menu Location: Surface >>> Import/Export  
Keyboard Command: c3d_tin  
Prerequisite: AEC surface objects to convert

**Convert LDD Contours**

This command allows you to convert Autodesk Land Desktop contours (known as AECC_CONTOUR objects) into polylines. You must have the AEC Object Enabler installed before using this command. If you do not have the object enabler installed, download the latest version from http://www.autodesk.com.

**Note:** If no object enabler is installed, opening a Land Desktop drawing with contours will display large boxes for each contour, essentially outlining the extents of each one. In this case you will need to download the object enabler. If the object enabler is installed, contours will appear normally, and you can use this command to convert them to standard lwpolylnies or you can use the Explode command. The Carlson Convert LDD Contours command is preferable only in the fact that it will search the drawing for AECC_CONTOUR objects and convert only those, while an Explode command could inadvertently explode other entities that you do not wish to be exploded.

You can use the List command to determine if contours are polylines or AECC_Coontour objects. Here is an example listing:

**AECC_CONTOUR Layer:** "CONT-MJR"  
Space: Model space  
Handle = 429  
Major Contour Interval  
Elevation: 1005.00  
Smoothing: None  
Number of Vertices: 48  
Open  
Length: 560.25  
Constant width: 0.00  
Style Name: Standard

**Prompts**

Select AEC Contours to convert  
Select objects: pick the AEC contour entities
Import Google Earth Surface

This command creates a Carlson Triangulation file (TIN) by downloading surface data from Google Earth. While the elevation accuracy of the Google Earth surface should be considered coarse, it might be suitable for large-scale watershed modeling studies, preliminary land-planning studies or "proof-of-concept" preliminary designs.

Before running this command, the grid projection system for the drawing must be defined in Settings > Drawing Setup.

After selecting the TIN file to output, the program prompts to pick the rectangular area in the drawing for where to create the surface file. Then there is a dialog to set the grid resolution of the data points. You can either specify the number of rows and columns for the grid or define the size of the grid cells.

![Import Google Surface dialog](image)

**Note:**

- In an effort to protect their servers from abuse, Google limits the number of data points.
- The Import Google Earth Surface routine fetches terrain data in real-time from the Google servers and requires an Internet connection to proceed.
- It bears repeating that the terrain data returned by Google Earth should only be used for illustrative or proof-of-concept purposes only!
- To import a Google Earth image into your drawing, use the Place Google Earth Image command.
- To import KML content into your drawing, use the Import Google Earth File command.
- To export content from your drawing to a KML file, use the Export Google Earth File command.

**Prompts**

**Select Output File:** Choose a TIN file to create.

**Pick first corner of bounding box:** Identify one corner of a drawing window that should be used to set the Google Earth display.

**Pick second corner of bounding box:** Identify the opposite corner of a drawing window that should be used to set the Google Earth display.

**Import Google Surface dialog**
Export Topcon Grid or TIN File

The Export Topcon TIN File command writes a Topcon TIN file (.TN3) from a Carlson triangulation file (.TIN, .FLT). The routine first prompts for the Carlson file and then the Topcon file.

The Import Topcon TIN File command creates a Carlson TIN file (.TIN, .FLT) from a Topcon triangulation file (.TN3). The routine first prompts for the Topcon file and then the Carlson file.

The units (Feet or Meters) for the triangulation file are the current units set in Drawing Setup.

Design Pad Template

This command creates design slopes from a perimeter polyline at specified cut/fill slopes to reach existing ground. This routine can be used to design building pads, pits, roads, ditches, stockpiles, etc. The design is drawn as 3D polylines for the cut/fill slopes and for the daylight perimeter where the design meets existing ground.

Before beginning this routine, you must have drawn the polyline representing the outside edge of the feature to model. The edge is drawn as a polyline which can be either a 2D or 3D closed or open polyline. For a 2D polyline, the program will prompt for an elevation for the pad perimeter. With a 3D polyline, the pad perimeter is set to the elevations of the 3D polyline. For an open polyline, the program will prompt for the side for the design. With a closed polyline, the program designs the slopes either outward or inward depending on the settings in the dialog.
Under **Source of Slope Target Surface Model**, choose between a Surface File (.GRD, .FLT, .TIN), Screen Entities, or a specific Elevation. If using Screen Entities, the routine internally calculates a gridded model, the limits of which are specified by screen picks. Make sure that the grid area covers the entire area for the pad including room for the cut/fill slopes.

For closed pad perimeters, there is a **Slope Direction from Closed Plines** option to draw the slopes inward or outward from the perimeter. The outward method starts the slopes at the design elevation of the perimeter and projects out to intersect the existing surface. The inward method projects the slopes inside to reach the grid surface or a set elevation. Outward sloping would be used for such things as building pads, parking lots, etc. where the interior remains as a defined surface. Inward sloping would be used for such things as the top edge of an excavated pit or pond where the interior side slopes project downward at the specified slopes until reaching the original ground surface.

The **Slope Projection Perpendicular To** option applies to sloping pad perimeters. The Pad Polyline method creates the user-specified slope perpendicular to the pad perimeter. The Slope Direction method accounts for the slope of the pad perimeter and makes the final surface to match the user-specified slope. For example, if the pad perimeter is at a 10% slope and the fill slope is at 2:1, then the Pad Polyline method would create fill slopes that are 2:1 perpendicular to the pad while slightly steeper (1.96:1) for the actual slope that goes in the slope direction with the effect of the sloping pad perimeter. For the same case except with the Slope Direction method, the resulting slope perpendicular to the pad is less steep (2.04:1) while the actual slope in the slope direction is exactly 2:1.

Under **Design Slope Format**, choose between *Ratio, Percent, Degree* or *Template*. The use of a Template allows for complex slopes to be applied, and is also an alternative approach to road design. The template (.TPL) file is created in the *Design Template* routine in the Roads menu. When using a template, the pad perimeter represents the centerline. One way to create the pad perimeter for the template is to use the *Profile to 3D Polyline* command which converts a 2D centerline to a 3D polyline using a design profile. With a template, the program uses not only the cut and fill slopes from the template file but also draws all the template grade points such as edge of road, curb and ditch. The subgrade, superelevation and template transition options of the template file are not used in this command. These options are only applied in the *Process Road Design* command. The grade points are drawn as 3D polylines parallel with the centerline. Cross section 3D polylines that include the grade points are also drawn at the specified interval.

The **Force Cut** option will try the cut slope to find a catch point even when the pad perimeter starts out in fill. This is possible when the existing ground is rising faster than the cut slope. Likewise the **Force Fill** option will try the fill slope to find a catch point when the pad starts out in cut.

The **Grade Limits** option makes the cut/fill slopes fit within the grade limits either by making the slopes steeper or by putting in a vertical wall where the slopes reach the grade limits. When this option is on, the program prompts to select a closed polyline to set the grade limits.

The **Min Cut/Fill Height** setting creates no tie slope when the cut/fill is less than a minimum. To always draw the tie slope, set this value to zero.

The **Merge Surface Color** is used to set the color of the triangles within the pad when using a triangulation surface as the target surface and updating this surface with the pad design. The triangle colors are shown in the 3D Viewer graphics.

The **Process Multiple Pad Polylines** option allows you to process multiple pad perimeter polylines at a time instead of a single pad perimeter. The program will prompt for a selection set of pad perimeter polylines and then
cycle through and run the design on each one. There will be one final report for the earthworks for all the pads. The Setup function allows you to specify different cut/fill slopes by layer and also to set the processing order by layer. For example, in the case of processing both building pads with a shallow slope and ditch polylines at a steeper slope, you could set up the processing order to do the building pad first and the ditch last so that the ditch cut slopes will carve out any overlap with the building fill slopes. These pad layer slope and order assignments can be saved and loaded from a .PAD file.

![Multiple Pad Processing Order](image)

**Use Another Surface for Pad Interior** will bring up a prompt for another Surface file (.GRD, .FLT, .TIN) to use for the design surface within the starting pad perimeter. Otherwise the program will model the pad interior by straight interpolation from the starting pad perimeter elevations. For example, if a building pad has a starting pad perimeter at a set elevation and the pad is supposed to be flat, then this option is not needed. This option is needed in a case where you are designing a pit and the starting pad perimeter is a 3D polyline that follows an undulating pit bottom surface. The pad design will model the pit side slopes. In order to model the undulating bottom of the pit, you need the Use Another Surface for Pad Interior option to select a surface that models the pit bottom.

**Use Different Slopes for Separate Sides** allows you to specify different slopes for different sides of your pad polyline. If this is toggled ON, the Assign Pad Cut/Fill Slopes dialog is invoked, where you can create multiple Slope Groups along the Pad Template polyline and set the Cut and Fill design ratios for each.
Use **Slope Pad Design** allows you to set a cross slope amount for the top of the pad. You will be prompted to screen pick two points that designate the slope direction. For automatic balancing of cut/fill quantities, you will be prompted to find the optimal slope and slope direction.

**Draw Slope Direction Arrows** draws an arrow on the outslopes that points in the downhill direction. Arrows on fill slopes are drawn as solid filled.

**Solid Cut Arrows** allows you to choose between drawing the cut arrows as solid filled or as wire frame.

**Round Exterior Corners** holds the outslopes around the corners. Otherwise the side outslopes stay straight until they meet at the corners as shown in the figure.

**Erase Previous Pad Entities** erases drawing geometry created with this command previously.

When **Draw Side Slope Polylines** is ON, Design Pad Template will draw 3D polylines perpendicular to the pad perimeter from the pad to the catch point.

**Color Side Polylines** assigns different colors to Cut and Fill Side Polylines to make them easier to distinguish.
Example of pit design for option of Use Another Grid for Pad Interior

Pad corner without round corners option

Pad corner with round corners option

**Side Polyline Spacing** specifies the interval at which to draw the Side Slope Polylines. Besides at the interval, side slope polylines are also drawn at grid corners.

**Corner Delta Angle** is the delta angle in degrees between side slope polylines to span the delta angle around exterior corners.
The **Subgrade Depth** is applied to lower the design surface within the pad for the volumes calculations. The volumes are from the existing surface to the base of the subgrade. The effect of the subgrade is to increase cut and decrease fill.

The **Topsoil Depth** is used to report the topsoil removal volume by removing this depth within the pad disturbed area.

Cut volume is multiplied by the **Cut Swell Factor** in the final volume report.

Fill volume is multiplied by the **Fill Shrink Factor** in the final volume report.

The **Contour Pad** option draws contours on the pad. At the end routine, a dialog lets you set the contouring options. Usually you should specify a new contour layer and turn off smoothing.

The **Write Final Surface** option creates a surface model of the pad using the elevations of the pad within the disturbed area polyline and using the original ground surface everywhere else. At the end of the routine, the program will prompt for the surface file name to create.

The **Trim Existing Contours Inside Pad** option trims existing contours inside the disturbed limits of the pad.

You must specify the **Pad Layer Name** that the pad 3D polylines will be drawn on.

The **Use Report Formatter** option allows for making a customized report and outputs to various formats.

There is an option to calculate volumes for the pad design. The volumes are calculated by comparing the existing surface with the pad design. The inclusion perimeter for the volume calculation is the daylight perimeter polyline which represents the limits of disturbed area. The existing surface model is defined by the existing surface file (.GRD, .FLT, .TIN) or screen entities selected at the beginning of the command. The pad design surface is calculated by making a surface from the pad 3D polylines including the starting pad perimeter, the side polylines and the daylight perimeter.

Besides calculating the volumes in the **Design Pad Template** routine, you can also calculate the volumes with the **Two Surface Volumes** command, or the **Volumes by Triangulation** command. Two Surface Volumes works with two grid files, Volumes by Triangulation works with two TIN files. The design surface for Two Surface Volumes can be the final output surface from Design Pad or you can create a design surface with **Make 3D Grid File** using the 3D polylines created in **Design Pad**. You could also create a TIN surface of the design surface using **Triangulate and Contour**. Some of the reasons to use either the Two Surface Volumes command or the Volumes by Triangulation command are that these volume routines have more output options (cut/fill color maps, etc.) and you can check the volumes by plotting or contouring the surface files. Also, you can combine several pads and other final surfaces by running **Make 3D Grid File** or **Triangulate and Contour** and then use these volume commands to calculate the overall site volumes.

The design is drawn as 3D polylines and the earthwork volumes are calculated. Before ending, the program allows you to adjust the design by changing the pad elevation, slopes and offset. The program can find the cut/fill balance by automatically adjusting the pad elevation. If adjustments are specified, the pad polylines are redrawn and the volumes recalculated.

**A few key notes:**

1. If the Source of Slope Target Surface Model is set to a Surface File, and the surface file used is a grid file, then the surface produced from the designed pad will be a grid surface and a grid file (.GRD).
2. If the Source of Slope Target Surface Model is set to a Surface File, and the surface file used is a TIN file, then the surface produced from the designed pad will be a triangulated surface and a TIN file (.TIN).

3. If the Surface used as a Target Surface is listed in the Surface Manager, the prompt seen in the Design Pad Template command is whether or not to Update the Surface, which is the Target Surface, so if you say "Yes," your Existing Ground Surface will now essentially contain the designed pad. So if you want to maintain an unedited version of Existing Ground, you may want to start with a copy of the Existing Ground Surface.

4. If the Surface used as a Target Surface is not listed in the Surface Manager, the prompt seen in the Design Pad Template command is whether or not to create a new surface of the combined surfaces.

5. If you respond "Yes" to the prompt about whether to contour the designed pad, the contouring dialog box has an option of whether to write the designed pad as a new surface, which will be only the area within the limits of the new design, not the entire Target Surface and design pad surface combined.

Prompts

First you are presented with the Design Pad Template dialog box.

If the Source of Slope Target Surface Model is set to a Surface File, you will first be asked to:

**Pick the top of pad polyline:** select perimeter polyline

Then the Select Slope Target Surface dialog box is presented. Choose the Slope Target Surface file, pick Open. You then proceed to enter the slope parameters of the pad...

If the Source of Slope Target Surface Model is set to a Screen Entities, you will first be asked to:

**Pick Lower Left limit of pad disturbed area:** pick lower left

These prompts appear for the Screen Entities surface model method.

**Pick Upper Right limit of pad disturbed area:** pick upper right

Be sure to pick these limits well beyond the area of the top of pad polyline in order to make room for the outslopes.

**Make Grid File Dialog** After selecting the limits of the disturbed area the program will generate a 3D grid that represents the surface. Specify the grid resolution desired and select OK.

Then,

**Pick the top of pad polyline:** select perimeter polyline

Then proceed to enter the slope parameters of the pad...

**Enter the fill outslope ratio** <2.0>: 2.5

**Enter the cut outslope ratio** <2.0>: 2.5 After entering outslopes slope ratios, a range of elevations along the pad top will be noted.

**Enter the pad elevation** <29.5>: 39

**Calculate earthwork volumes** (<Yes>/No)? press Enter


**Adjust parameters and redesign pond** (Yes/<No>)? press Enter

**Write final surface to grid file** (Yes/<No>)? press Enter

**Trim existing contours inside pad perimeter** (Yes/<No>)? press Enter

**Contour the pad** (<Yes>/No)? press Enter
Existing contours with top of pad perimeter polyline

Pad template with contours

3D view of pad with DTM of surface and triangulation faces of pad

Template to apply in Design Pad Template
Existing surface with 3D polyline centerline

Result of Design Pad Template showing template grade polylines, cross section polylines, cut/fill slopes, and final contours

Viewpoint 3D view of Design Pad Template
Design Pad Template can also handle self-intersecting side slopes

Pulldown Menu Location: Surface
Keyboard Command: pad
Prerequisite: A pad perimeter polyline and surface entities or a surface file for an intercept target.

Slope Analysis
Slope Report
This command calculates the sloped surface area, average slope and average elevation on a site. The surface can be defined by a surface model file, (.GRD, .TIN or .FLT), or generated from 3D entities on the screen. Sloped area information is useful to compute seeding quantities for hillsides, for example.
For the screen method, the surface is modeled from the user-selected entities such as contour polylines. Besides the surface entities, a perimeter polyline is used as the inclusion area for the slope report. If the perimeter polyline is on the PERIMETER layer, the command will locate it automatically.

For area reports, there are options to specify inclusion and exclusion perimeters. When inclusion perimeters are specified, only the area within the inclusion perimeters is calculated. The area within exclusion perimeters is not included in the calculations. Inclusion and exclusion perimeters are represented by closed polylines and must be drawn prior to running this routine.

The option to Report by Cut/Fill Areas will report the slope areas separately for cut and fill areas. When this option is on, the program prompts for a second surface to use as a reference to determine the cut/fill areas.

Prompts

For Area report using a File:
Select surface model file.
Select the Inclusion perimeter polylines or ENTER for none: pick any inclusion polylines
Select the Exclusion perimeter polylines or ENTER for none: pick any exclusion polylines
Note: If the surface model file is a grid file (.GRD), you are prompted whether to extrapolate the grid to full grid size.

For Area report by Screen method:
Ignore zero elevations (<Yes>/No)? press Enter
Select surface entities and perimeter.
Select objects: pick the objects
If no polyline is found on layer PERIMETER, you are prompted to: Select Pond/Pit perimeter polyline.
The Make 3D Grid File dialog is presented. Pick OK.

Select the Inclusion perimeter polylines or ENTER for none: pick any inclusion polylines
Select the Exclusion perimeter polylines or ENTER for none: pick any exclusion polylines

For Points method:
Select surface model file.
Pick first point:
Pick Second point:
The slope report is displayed on the command line for the 3D vector, projected on the surface, defined by those 2 picks.

Point 1: 5119.646,5640.322,98.979
Point 2: 4951.964,6022.419,135.546
Horiz Dist: 417.27 Slope Dist: 418.87 Elv Diff: 36.57
Slope: 8.76 Ratio: 11.41:1

Pull-down Menu Location: Surface >> Slope Analysis
Keyboard Command: sarea
Prerequisite: A surface file or screen entities of the surface.

Slope Zone Analysis
This command calculates the surface area of a site in different slope zone ranges. This command can use either a surface model file, (.TIN, .GRD, or .FLT), or 3D Face drawing entities, which can be generated by the Plot 3D Grid File command, the Draw Triangular Mesh command, or the Draw Triangulation Faces option of Triangulate & Contour. For each slope zone, the 3D Faces can be hatched with any AutoCAD hatch pattern, including the SOLID pattern, or left empty with the NONE pattern.
This command can also generate contours of the slope zones based on the calculated slope at each point of the 3D Faces. The slopes can vary greatly between neighboring points. When contoured directly, these slope data points produce incoherent contours. Instead this routine applies a filtering algorithm that reduces the noise. There is another option to output a grid file of the slope values.

There are also options to specify inclusion and exclusion areas. When inclusion areas are specified, only the slope area within the inclusion polyline is calculated. Slope area within an exclusion polyline are not included in the calculations. Inclusion and exclusion areas are represented by closed polylines and must be drawn prior to calling this routine. Without inclusion and exclusion polylines, all the slope area of each selected 3D Face is used.

**Prompts**

**Source of surface model:** [File/<Screen>]? F for File

**Slope Zone Options dialog box.** Choose whether to Draw Slope Zone Contours, whether to Output Grid File of Slope, and Slope Format. Pick OK

**Select surface model file.**

**Define Ranges dialog.** Specify the slope zones, colors and patterns from lowest to highest. Pick OK.

**Select the Inclusion perimeter polylines or ENTER for none:** select perimeter(s) or press Enter

**Select the Exclusion perimeter polylines or ENTER for none:** select perimeter(s) or press Enter

Report is generated.

If you choose to draw Slope Zone Contours, the Contour Options dialog box is presented.
Note: If you choose to use Screen entities instead of a surface model file, you are prompted whether to:

- Apply hatch patterns to grid cells [Yes/<No>]?
- Freeze grid layer after processing [Yes/<No>]?

Surface contours

3D Faces from a grid surface model
3D Faces created by *Triangulate & Contour* with the Draw Triangulation Faces option

Slope zone contours

Slope zones that follow the surface contours using the triangulation 3D Faces
Hatched slope zone contours created from the grid 3D Faces

**Pulldown Menu Location:** Surface >> Slope Analysis  
**Keyboard Command:** szone  
**Prerequisite:** Surface model file (.TIN, .GRD, or .FLT), or 3D Faces entities

### Quick Profile

This command allows you to create a profile in one step. The alignment for the profile can be defined using picked points, a centerline file or a polyline. The surface for the profile can be defined by 3D screen entities, 3D polyline or surface files (grid or triangulation).

**Screen Entities:** The program creates the profile by finding the intersections of the centerline with 3D linework entities in the drawing. There's an option for whether to ignore entities at zero elevation.

**3D Polyline:** Creates a profile using a selected 3D polyline. The polyline vertex elevations are used for the profile elevations and the profile stations are from the lengths of the polyline segments.

**Surface File:** This option allows you to use one or two grid or triangulation surfaces. There's also an option to Show Pipe Crossings which will find and display pipe crossings from sewer networks and 3D polylines tagged as pipes. The sewer network can be created in the Hydrology module. To tag a 3D polyline as a pipe, use the Assign Pipe Data To Polyline command.

Since picked points are the default for the horizontal alignment, the command is as quick as select surface type (screen or file), then Pick, Pick, Enter and view. The resulting profile is displayed in a graphic dialog box with real time data reporting. As the crosshairs are moved across the profile in the window, the station, elevation and slope data corresponding to the current crosshair location appear in the lower right of the window. A second crosshair on the plan view corresponds to crosshair movement along the profile so the user knows exactly where the current profile point is on the plan view. Also the Adjust Alignment function allows you to drag a horizontal alignment point and update the profile in real-time.
**Vertical Exaggeration:** Determines the amount of vertical exaggeration for the profile in the window.

**Drag Action:** Determines whether the right mouse button functions as "Zoom" or "Pan" in the profile window.

**Grid Ticks Only:** Instead of the full graph as shown above, Grid Ticks only plots only ticks along the horizontal and vertical axis near the station and elevation text.

**Adjust Alignment:** Allows you to pick a horizontal alignment point and while moving it, the profiles are updated in real-time. You can also select a horizontal alignment segment and move the whole alignment position. The Adjust Alignment function is only available when surface files are used as the source of the surface model. When you adjust the alignment, the program prompts on exit whether to save the adjusted alignment to a centerline file (CL).

**Save:** Writes the current profile data to a .PRO file.

**Draw:** This draws the profile with grid in the drawing. The user has options for horizontal and vertical scales and the layer of the profile. The Draw Profile command includes more options for drawing the profile. In order to use this command, you must first create a .PRO file using the Save command described above.

**Print:** This makes a graphic report of the profile in either PDF or DWF format as selected under Settings->Configure.

**Exit:** Exits this command.

**Help:** Opens on-line help.

---

Note that the Draw option will exit the Quick Profile command after the drawing is complete. A typical completed drawing, in this case with two surfaces, is shown below. Note also that the horizontal stationing text offset follows the setting in the Draw Profile command itself.
Prompts

Pick starting point (CL-Centerline, P-Polyline): screen pick alignment points for profile
Pick second point: pick next point
Pick next point (Enter to end): press enter to end
Tested 58 of 58 Entities Intersects found > 33

Dialog Box

Pulldown Menu Location: Profiles
Keyboard Command: quickpro
Prerequisite: 3D screen entities or surface file

Create Profile From

Profile from Surface Entities

Profile from Surface Entities creates a profile from contours, triangular mesh, and other 3D drawing entities. The method is to draw a polyline as the profile centerline. Then the profile is derived from the intersections of this polyline with the 3D entities. For added accuracy in pulling the profile, include the triangular mesh as well as the contours.

File: Displays the name of profile to be created.
Beginning Station: Specify the beginning station for the profile.
Interpolate Endpoint Elevations from Beyond Profile Extents: When checked, the program will look past the ends of the centerline for additional intersections with 3D entities. These additional intersections will then be used to interpolate the elevation at the starting and ending station of the centerline.

Extrapolate Endpoint Elevations to Extents of Profile: This option uses the slope of the last two elevation points of the profile and calculates the elevation of the endpoint from this slope.

Station by another reference centerline: When checked, the program will prompt you to pick another centerline polyline. The intersection points along the first centerline are then projected onto the second centerline. The profile then stores the elevation of the intersection with the station along the second centerline.

Breakpoint Descriptions from Layers: When checked, breakpoint descriptions are assigned based on layer name of surface entities. These descriptions are used in routines such as Input-Edit Profile and Profile Report.

Ignore Zero Elevation Lines in Surface Model: When checked, any zero elevations selected in the surface model are ignored.

Profile Offsets: Specify optional offset profiles. Enter offsets separated by a space. Example: 30 -30 (to create 30' left and 30' right offset profiles). After entering the offset values, press TAB to select file options described below.

Offset Profiles to: Specify whether offsets profiles should be created as separate profile (.PRO) files, or included in a single profile (.PRO) file. Only available if you specify Profile Offsets above. Offset profiles are automatically named by combining the profile name and the offset. For example, if the profile is named NATGRD.PRO and you create a 30' right offset profile, it will be named NATGRD30.PRO.

Prompts

Profile File to Write dialog Specify a new profile file (.PRO) name to create.
Profile from Surface Model dialog Make choices, click OK.
Polyline should be drawn in direction of increasing stations.
CL File/Select polyline which represents the profile centerline>: pick the centerline (Do not press Enter.)
Select Lines, PLines, and/or 3DFaces that define the surface for profiling.
Select objects: C (for crossing and window everything the centerline crosses) or All (to select all objects on the drawing)

Keyboard Command: prosm
Prerequisite: A polyline centerline and surface lines and polylines.

Profile from Grid or Triangulation Surface

This command creates a profile (.PRO file) from a centerline polyline and a surface model stored in a 3D grid file (.GRD) or triangulation file (.TIN or .FLT). The polyline defines the alignment of the profile and the grid defines the surface.

After selecting the reference surface file, there is a Profile Options dialog with these options:

Link Profile To Triangulation: This option will update the profile whenever the reference triangulation is modified.
Type of Centerline: This setting chooses the type of stationing for centerline curves.
Station by Another Reference Centerline: This option uses a second reference centerline for the stationing of the profile. The main centerline is used to find the elevations on the surface and then these main centerline positions are projected onto the reference centerline to get the stationing. The reference centerline needs to extend along the full range of the picked polyline in order to project correctly and capture offsets along the entire length of the picked centerline.
Profile Offsets: In addition to creating the profile along the centerline, you can also create profiles offset left and right.
Prompts

Choose Grid or Triangulation file to process  Select existing .GRD, .TIN, or .FLT file.
Profile Options dialog.
Choose PROfile file to Write dialog Enter a profile file (.PRO) name to write.
Polyline should have been drawn in direction of increasing stations.
CL File/<Select polyline that represents centerline>: select a polyline
Polyline should have been drawn in direction of increasing stations.
CL File/<Select Reference centerline polyline>: select a polyline
CL File/<Select Reference centerline polyline>: press Enter
Reference CL starting station <0.0>: press enter

Pulldown Menu Location: Profiles > Create Profile From ...
Keyboard Command: progrid
Prerequisite: A .GRD grid file, .TIN, or .FLT tmesh file

Profile from Points on Centerline

This command creates a .PRO file from points and a centerline that is represented by a polyline or centerline file. The elevations of the profile are derived from the elevation of the points and the stationing for these profile points is calculated from the distance along the centerline. The points must be within the offset distance from the polyline in order to be included in the profile. The profile is created by projecting the points perpendicular onto the alignment to determine the station and the elevation comes from the point elevation. The polyline or centerline should be drawn (or defined) in the direction of increasing stations. The points can be selected from point entities in the drawing (Screen), by point numbers from the current coordinate file (Numbers), or by point group as defined by the Point Group Manager (Group).
**Prompts**

**PROfile file to Write dialog box:** Enter a new profile file name to write.

**CL File/<Select polyline that represents centerline>:** *pick a polyline or choose C for Centerline*

Select Centerline file if Centerline option is used. If the desired points are further from the centerline, enter a larger maximum offset tolerance.

Note: for all selected points, the points should be located on the real Z axis.

**Select the Carlson points along the centerline.**

**Select objects:** Select the point entities.

**Keyboard Command:** propts

**Prerequisite:** A polyline centerline and points

---

**Input-Edit Profile File**

Similar to the Input-Edit Road Profile command, this command features a spreadsheet type editor and handles a variety of profile (.PRO) configurations. Besides editing a profile, this routine can be used to just view the contents of a profile.

The command starts by prompting for the profile file to edit. Alternately, you can run Input-Edit Profile by double-clicking on a profile polyline that is drawn on a profile grid.

The opening dialog below shows the layout of this editor. At the top of the dialog, you can dynamically see the profile and vary its appearance by using zoom and pan. The station, elevation and slopes are also shown at the lower left of the dialog which update/track with the movement of the cursor. There are between five and nine possible data fields in a profile depending on the type of profile that has been selected.
Profile Name: This name is optional and often used when multiple profiles are stored in a profile (.PRO) file and graphically generated using the Draw Profile command.

Add Row: Adds a new row into the profile after the current row.

Remove Row: Removes the current row.

Type of Profile: There are 6 types of .pro files and the spreadsheet columns will change to match the data fields for the selected profile type:

- **Generic** - Generic profiles have station, elevation and description fields.
- **Road** - Road profiles include the Generic controls and adds a vertical curve field. For an asymmetrical vertical curve, enter the left and right side values separated by a dash in the spreadsheet cell. For example, a 200' vertical curve with 50' to the left of PVI and 150' to the right would be entered as "50-150".
- **Sewer** - Sewer profiles include the Generic controls and adds step up, pipe size, pipe thickness, manhole elevation and manhole ID fields.
- **Pipe** - Pipe profiles include the Generic controls and adds a pipe size field.
- **Crossing** - Crossing profiles are for pipe crossings along the centerline. Besides station and elevation, the crossing data points also have the pipe size. The crossing elevation is for the bottom elevation of the pipe. The crossing profile data points are not connected.
- **Circular** - Circular profiles are the same as Road profiles except the vertical curve is circular instead of parabolic.

Edit Slope To Change: This setting controls which field to update when the slope is modified in the spreadsheet.

Reference Profile: Selects a reference profile and displays it in the profile graphic view immediately.

Reference CL: Selects a reference centerline which is used for station equations.

Sag-Crest Points: When editing a road profile, its sag/crest points are shown here.
Through Pt: This button lets user to make the road profile pass through a certain point.

Vertical Exaggeration: Changes the look of the profile.

Edit Slope to Change: When edit the slope value, you can choose a value to change from the following selection: the next elevation, the previous elevation, the next station or the previous station.

Check Stations: Reports profile information at the specified stations. The Check Stations are not stored in the profile; they are merely used as a design/analysis tool for viewing the elevations at certain stations while adjusting the profile data.

Speed Tables: This button is enabled only when you edit a road profile. Please refer to the documentation on Input-Edit Road Profile for the information on Vertical Speed Tables.

Next: Used for navigation when editing a .PRO file containing multiple profiles, loads the next profile.

Previous: Used for navigation when editing a .PRO file containing multiple profiles, loads the previous profile.

Load: Used for loading another, existing .PRO file for editing.

Save: Saves the profile using the current profile file name. The current profile file name is displayed in the top title bar of the dialog box.

SaveAs: Allows you to save the profile under a different profile file name.

Calc PI: This function calculates a station/elevation point given two existing station/elevation points and slopes from them. The values are entered in this dialog. When you pick Calculate, the program finds the intersection of the grade lines. Then pick OK and the calculated PVI is added to the profile.

Report: Creates a report of current profile.

Undo: Reverts the last action in the editor.

Settings: Opens the settings dialog.
**Hold Next Slopes:** When editing a profile elevation, this option will maintain all the slopes after the edit point by adjusting the elevations. Otherwise, the elevations for the rest of the profile points are held and the slope from the edit profile point to the next profile point is adjusted.

**Show Slope When Zoom In:** This option allows to display the slopes on the long enough profile segments when zoom in.

**Grid Ticks Only:** Toggles between displaying the grid and grid ticks in the graphic box.

**Set Grid Interval:** This option allows you to control the elevation grid spacing in the graphic preview. When this option is off, the program automatically figures the elevation grid interval.

**Hold Elevation When Update Step-Up for Sewer Profiles:** Toggles between holding the elevation or the pipe slope

**Enable Additional Invert-In Fields for Sewer Profiles:** When editing a sewer profile, this option allows you to display an extra invert-in column for in-coming pipes. The invert-in elevations are separated by commas.

**Enable Cradle Fields for Sewer Profiles:** When editing a sewer profile, this option allows to display cradle above and cradle below columns.

**Display Sight Distance Options:** Display either K-Value or Sight Distance in the fifth column for road profiles.

**Grid Mode:** The **Dynamic** option will update the grid interval labels when you zoom in or out of the profile image. The **Static** option will keep the grid interval labels static.

**Tools:** Opens the Tools dialog.
**Translate**: Globally adds or subtracts value to stations and/or elevations within the specified range of stations. While **Scale** will apply the specified scale factor to stations and/or elevations within the specified range of stations.

![Translate Profile](translated_profile.png)

**Scale**: Applies the specified scale factor to stations and/or elevations within the specified range of stations.

![Scale Profile](scaled_profile.png)

**Reduce**: Reduces the profile points by the Offset Cutoff value.

![Reduce Profile](reduced_profile.png)

**Reverse**: Reverses the direction of the stationing for the profile.

**Cradle Setup**: Sets up the cradles for sewer profiles. The cradle parameters are different with different pipe sizes and are defined in the Pipe Size Library. You can either use library data or specify new values here.

![Cradle Setup](cradle_setup.png)

**Pulldown Menu Location**: Profiles  
**Keyboard Command**: profedit  
**Prerequisite**: None
Draw Profile

*Draw Profile* is a flexible routine for drawing a profile anywhere in the drawing. The profile can be placed in a layout tab or in the model space of the drawing. It may be drawn with or without a grid or with just tick marks. The vertical curve annotations for a road profile and manhole annotations for a sewer profile, may also be drawn. Draw Profile uses the profile information that is stored in .PRO files. It is also able to use a reference centerline stored in a .CL file. Once the profile is drawn using Draw Profile, the design and labeling routines of the Profiles dropdown are applicable to the profile. Please note, several of the options presented in the following dialogs will depend on the type of unit system being used, metric or english. Options such as text sizes, sheet dimensions, and scaling factors may vary from the examples shown here.

**Select Profiles to Draw**

Reference CL: When using Draw Profile to create Plan & Profile Sheets, a reference centerline will be needed to properly establish the "Plan" portion of the sheet. Use the Set button to locate and specify the desired Reference Centerline.

Add: Use this option to add desired Profile (*.PRO) files one at a time into the dialog box.

Add Multiple: Use this option to add desired Profile (*.PRO) files (one or several at a time via standard Windows Shift+click and/or Ctrl+click functionality) into the dialog box.

Remove: Use this option to remove the currently selected profile the dialog box.

Clear: Use this option to remove all profiles from the dialog box.

Special Stations: Use this option to to label stations that are significant for the project.

Open Set: Opens/loads a previously saved set of Profile files as stored in a *.PST file.

Save Set: Permits the current collection of profiles to be saved to a *.PST file for later recall.

Multiple Profile: For *.PRO files that have multiple profiles within the same file (*e.g.* those produced by Input-Edit Profile that might have profile data at the centerline and also at offsets of -12 and +12), use this button to select which of the profiles to draw:
Another type of multiple profile is a profile with breaks such as a curb profile with breaks across intersections. This is built-in to Road Network (aka RoadNet). In RoadNet Settings (specifically, the Output Options tab), there's **Output EOP Profiles**. RoadNet will then create profiles with descriptions at the intersections and Draw Profile will break the profile across the intersections. You can also manually put in these descriptions in Input/Edit Profile to set the breaks. Use **EP_FL:@E** to stop the profile and **EP_FL:@S** to resume the profile.

When the Select Profiles To Draw dialog has been set up, select the OK button to move on to the **Draw Profile** dialog box.

**Draw Profile**

Within the Draw Profile dialog box are numerous sub-commands that permit great flexibility in how the resulting profile(s) are drawn. Use the table below to access additional information about each of these sub-commands:

<table>
<thead>
<tr>
<th>Draw Grid</th>
<th>Draw Sheet</th>
<th>Draw Horiz Axis Elev</th>
</tr>
</thead>
<tbody>
<tr>
<td>Draw Horiz Label Box</td>
<td>Hatch Cut/Fill</td>
<td>Draw Slope Labels</td>
</tr>
<tr>
<td>Draw Break Point Sta</td>
<td>Draw Break Point Elev</td>
<td>Draw Break Point Desc</td>
</tr>
<tr>
<td>Draw Break Point Elev Diff</td>
<td>Draw Line/Point Crossings</td>
<td>Draw Road Intersections</td>
</tr>
<tr>
<td>Road Profile Labels</td>
<td>Sewer/Pipe Profile Labels</td>
<td>Pipe Crossing Labels</td>
</tr>
<tr>
<td>Lateral Connection Labels</td>
<td>Utility Profile Labels</td>
<td>Draw Break Leader/Symbol Setup</td>
</tr>
<tr>
<td>Layers/Colors</td>
<td>Text/Symbol</td>
<td>Linetypes</td>
</tr>
</tbody>
</table>

**Draw Profile "Sub-Commands"**

For each of the sub-commands above that have a check-box toggle, enable the toggle and use the appropriate Setup.
Link To Files: This setting controls the linkage of the plotted profile(s) to the actual profile file(s) (.PRO), determining how changes to the file affect the plotted profile(s):

- **Off**: Changes to an underlying profile file do not trigger a change to its drawn profile.
- **Prompt**: Changes to an underlying profile file trigger a prompt if its drawn profile should be updated.
- **Auto**: Changes to an underlying profile file result in an automatic change to its drawn profile.

Match Line Elevations: For high relief profiles that might otherwise exceed the profile limits of the sheet (typically dependent on the Vertical Scale), the Match Line Elevations option can be used to "break" (or vertically split) the profile and redraw the remaining portion (again, shifted vertically) to remain in the profile portion of the sheet.

Elevation Range: This is the range of elevations that is used in conjunction with the Match Line Elevations option. If the range is exceeded (that is, if the range is greater than 80), the program will break the profile and draw the remainder with a separate vertical axis range.

Output to Separate Drawing: When enabled, this option draws the profile(s) to a separate drawing. Use the Set button to specify the name/location of the external drawing. Suggested uses for this feature are when profile-only sheets need to be generated and provided to others for detailing or construction purposes.

Horizontal Scale: Indicate a real-world distance that should be used within the span of a horizontal grid cell.

Vertical Scale: Indicate a real-world elevation amount that should be used within the span of a vertical grid cell.

Layers

The Layers button permits layer names to be associated with items including the profiles, profile grid and general labels.
**Sewer Label Layer Use Profile Layer** option sets the profile layer name as a prefix or suffix to the sewer profiles and text layers.

**Set Level by Reference CL** sets the level of the profile entities based on the name of the profile which can be seen in the Level Manager under the View menu.

The **Prefix** and **Suffix** options allow the user to add a prefix or suffix in various ways to the default layer names shown above.

**Profile Line Layers** displays the names of the profiles selected and allow the user to control which layer each profile will be placed on. If more profiles are selected, they will be displayed.

**Colors**

The Colors button provides the ability to control the color associated for items such as the profiles, profile grid and general labels. Any color selected will override the default ByLayer.
Text/Symbol Settings

The Text/Symbol button has the text style and size scalers for profile grid and general labels. The size scalers are multiplied by the profile Horizontal Scale to determine the text size in drawing units.

Double-Click Text Link Profile Settings: When enabled, double-clicking a drawn profile text item launches the Draw Profile Settings for that text item. When disabled, double-clicking the text item launches the native CAD command (e.g. Edit Text).
The Linetypes button has linetype settings for the profile line and profile grid. There are also settings for drawing a profile legend of the profile lines.

**Label Profile Name on Profiles** adds the name of the profile on the profile in a user defined location.

**Profile Description for Waterline** will draw a horizontal blue line at the profile elevation for the profile point with a description that matches this setting.

**Draw Legend** when enabled, will draw a legend of linetypes on the sheet(s) created when the **Draw Sheet** option is selected.

**Draw Border with Wipeout** places a wipeout component under the legend.

**Line Length** defines the length of the box that is drawn around the legend.

The **Horizontal** and **Vertical Offsets** control the placement of the legend relative to the sheet border.

**Back**: Allows you to return to the previous dialog box to alter or adjust the information it provides.

**Load Settings**: Loads a saved collection of Draw Profile settings, saved in a (.PFS) file.

**Save Settings**: Saves all Draw Profile settings in a (.PFS) file. Use this to be able to use all the settings on a future project.

**Draw Grid**

The Draw Grid option controls whether or not the grid and axis elevations for the profile are drawn. The **Setup** button launches the Grid Setup dialog. Here you can control numerous settings for how the grid, general text and stationing are drawn.
**Horizontal Grid:** Enter a value of how often grid lines should be displayed to coincide with the station values along the horizontal axis of the grid.

**Horizontal Major Grid:** Enter a value of how often major (or "heavy") grid lines should be displayed to coincide with the station values along the horizontal axis of the grid.

**Station Text:** Indicate how often station text labels should appear along the horizontal axis of the grid.

**Vertical Grid:** Enter a value of how often grid lines should be displayed to coincide with the elevation values along the vertical axis of the grid.

**Vertical Major Grid:** Enter a value of how often major (or "heavy") grid lines should be displayed to coincide with the elevation values along the vertical axis of the grid.

**Elevation Text:** Indicate how often elevation text labels should appear along the vertical axis of the grid.

**Grid Direction:** Profiles can be drawn Left to Right (the default) or Right to Left. Although most profiles are drawn left to right, if you have a road that runs East to West and you wish to draw the profile stationing beneath the actual road stationing, then choosing a Right to Left profile may be appropriate.

**Vertical Grid Adder to Top:** This adds the specified amount of grid to the top of the profile.

**Bottom:** This adds the specified amount of grid to the bottom of the profile.

**Horizontal Grid Adder to Left:** This adds the specified amount of grid to the left of the profile.

**Right:** This adds the specified amount of grid to the right of the profile.

**Grid Style:** This selects the type of Grid to generate. The choices are Grid Lines, Ticks Only, Ticks and Dots, Ticks and Checks, Horizontal Lines with Ticks, None and Grid Lines and Dots.
Draw Vertical Bar on Right: This option places the vertical label bar on the right of the grid, as opposed to the left.

Label Scale: Click on this option and you obtain a scale drawn at the lower left corner of the profile. Click the Setup button to establish the desired Scale labels and placement values.

Draw Vertical Bar Separately draws a vertical bar with elevation labels separate from the profile grid. The Offset value controls how far away from the grid it will be drawn.

Label Stations: Disable this option if you do not want station labels to be placed along the grid.

Label Station Equations: Disable this option if you do not want station equation labels to be placed along the grid.

Label Base Elevation: Labels the low elevation on the sheet. The setup dialog allows for prefix and suffix for the text, size of text, layer and number of decimals to display.

Station Type: Indicated the preferred style of station formatting.

Station Text Orientation: This option allows you to specify the orientation of the station text shown along the profile. The example below shows both options:

Station Text Position: Indicate if the station text should appear along the top of the profile grid or along the bottom of the profile grid.

Use Partial Labels for Intermediate Stations: Enable this toggle if the "full station" content to the left of the "+" symbol should be omitted at intermediate stations. This is useful for large station values where intermediate station
labels are desired. When enabled (assuming 100' station values), an intermediate station such as 1023+50 would simply be annotated as +50.

**Increment Station Text from Beginning Station:** Enable this option if you wish to have the station text labels be relative to the starting station value. For example, if the starting station value is 0+23.68 and the *Station Text* interval is 50, station labels of 0+73.68, 1+23.68, 1+73.68, etc, would be generated.

**Label Elevations:** Disable this option if you do not want elevation labels to be placed along the grid.

**Skip Grid Range Dialog:** This option automatically uses the calculated grid station and elevation ranges after picking OK from the main dialog instead of showing the dialog to set these ranges.

**Draw Elevation Bar:** Click on this option if you desire to have a vertical barscale displayed. It will run up and along the left-most vertical grid line of the profile, unless the Draw Vertical Bar on Right option is selected.

**Draw Elevation Labels Only On Left Side:** Enabling this option eliminates elevation labels on the right side of the profile.

**Draw Grid Line Under Elevation Labels:** Enabling this option extends the grid lines underneath the elevation labels.

**Elev Text Vertical Justify:** Indicate vertical justification for the elevation labels.

**Offset Elevation Text:** This option offsets the left-side vertical axis text using the specified Offset Scale.

**Offset Station Text:** This option offsets the horizontal axis Station text by the specified Offset Scale, allowing the insertion of elevation or other information above the stationing. It is often used in conjunction with the Label Horizontal Axis options.

**Stack Profile Grids:** This option allows you to stack profile grids for multiple profiles. In the Setup dialog, all profiles in the Multiple Profile file are listed and you can choose which one goes to the first grid, which one is second, and so on.

**Grid Vertical Spacer:** Indicate the amount of vertical space between successive grids.

**Draw Sheet**

Plan Only, Profile Only, or Plan and Profile sheets can be created. The options within Sheet Setup become available when this toggle is checked on. Select Setup to access the Sheet Setup dialog.
Choose Space: Indicate whether sheets are to be drawn to Paper Space (also known as a Layout) or to Model Space. When the Model Space option is selected a toggle for how the sheets are created is enabled. They can be displayed in Paper Space or Model Space. If the Paper Space toggle is used the sheet will be drawn in Model Space but with Paper Space units.

Layout Name: Enter a name for the paper space "tabs" to be assigned to each layout for each sheet. The program will automatically divide the plan view and the profile view into sheet layouts, and if the length of the profile extends beyond a single sheet, then multiple layouts are created, with the layout name ID incremented by 1.

Note:

• The "Tile Sheets" toggle needs to be disabled for the auto-incrementing functionality.
• If either the Start Station in Layout Name or the End Station in Layout Name options are enabled, the Layout Name field will be disabled as the Layouts will get named automatically.

If you enter "ms" to go to model space within a Layout tab, you can pan to alter the plan view position. However, it is best to zoom in/out and edit within the Model tab. The Layout tabs appear at the bottom of the screen, along with the "Model space" tab to go back to standard plan view:

Add Layout Name to File for Drawing Output: When the option to Output To Separate Drawing is on, this option will create a separate DWG file for each layout by adding the layout name to the main DWG file name.

Use Template Layout: This option allows you to use a layout that exists in the current drawing as the template for layouts created by the command. This option only works for paper space sheet creation.

Start/End Station in Layout Name: These options allow you to include starting and ending station in the Layout Names.

Add Layouts to Layout Set: This option allows you to add the layouts created to an existing layout set that was previously generated using the Layout Set Manager. You will need to specify the name of the layout set.

Block Name: This is the drawing name for the plan and profile sheet to be inserted. The Set button can be used to change the block name. Carlson provides a standard plan and profile border in the form of profile.dwg located in the working folder of %AppData%\Carlson Software\...\Sup}. You may wish to revise profile.dwg and add your
company logo, and re-save it as profile1.dwg. Alternatively, you could add your own complete version of a Plan and Profile sheet block/border. Be aware that the Draw Right to Left option in Draw Grid is superseded when Draw Sheet is enabled. Note that the Sheet mode will re-orient the centerline left to right, which may cause text (such as the stationing) to plot upside down, until you use the Flip Text command.

**Set Sheet Attributes:** This button allows you to specify the values used by any attribute definitions associated with the sheet Block Name. These can be entered manually in the Set Sheet Attributes dialog.

![Set Sheet Attributes dialog](image)

You can use the Set button to the right of any field to set that field to a preset value pulled from the drawing information.

![Set Sheet Attribute dialog](image)

**Sheet Width:** This is the profile width in the units specified on the sheet.

**Lower Left Offset X/Y:** Indicate the offset value(s) for the insertion point of the sheet in CAD units. This option allows user-defined Block Names to be properly positioned relative to the remainder of entities placed through the Draw Profile command.

**Printer/Plotter:** Indicate the desired output device.

**Paper Size:** Indicate the desired paper size.

**Draw Profile Grid Lines:** Enable this option if your Block Name does not contain profile grid lines and if you want profile grid lines to appear on the sheet.

**Draw Plan/Grid to Full Sheet Width:** Enable this option if you want to have what would otherwise be "partial" sheets (typically found at the end of a Plan & Profile Sheet run) occupy the full width of the sheet.

**Draw Grid to Full Sheet Height:** Enable this option if you want to have the profile grid drawn to the height of the sheet.
Stack Profile Sheets: When enabled (and when the Choose Space option is set to Model), this option permits the profiles to be stacked on top of one another.

Stack Vertical Spacer: Specify the amount of space that should be utilized when Stack Profile Sheets is enabled.

Sheet Contains: This drop list allows the selection of which type of sheet to generate.

Plan View Lower Y: This sets the lower position of the paper space window for the plan view.

Top Y: This sets the upper limit for the plan view window.

Profile View Lower Y: This sets the lower position of the paper space window for the profile view.

Upper Y: This sets the upper limit for the profile view window.

Plan/Profile Gap: Indicate the amount of vertical separation between the Plan portion of the sheet and the Profile portion of the sheet.

Draw North Arrow in Plan View: This draws a North Arrow in plan view. Click the North Arrow Settings button to establish the desired North arrow and placement information.

Draw Plan View Borders in Model Space: This draws the borders in Model Space which can be useful or orienting text and other labels to the orientation of the sheet. When this option is selected, use the Layer text box or Set button to choose the layer on which the borders will be drawn.

Plot at 1:1: With this clicked on, the sheet will be paper size, designed to be plotted at 1:1. A 30-inch profile sheet will measure 30 units, even though the centerline and profile may be 1500 feet in length. If the Scale 1:1 option is turned on, then you cannot check the distances of features using commands such as Bearing and Distance on the Inquiry menu, because the distances will be scaled down by a factor equal to the drawing scale (for example, at 1"=50’, the reduction in scale factor is 1/50 or 0.02). You can set the absolute starting coordinate for the 1:1 scaled plot by setting the Sheet Lower X and Sheet Lower Y values. With this clicked off, the profile will drawn full size, with a 1500-foot profile measuring 1500 feet.

Fit Each Vertical: With this option turned on, the program will size the profile grid to fit within the vertical space on the profile sheet. With this option off, the profile grid is sized to fit the elevation range of the profile.

Tile Sheets: If clicked on, only one Layout is created in paper space, and all sheets appear in this single Layout as tiles of individual sheets, much like the tiles mode of viewing files within Windows Explorer.

Starting Page Number: Specify the desired page number for the sheet(s) about to be cut. This is commonly used with the Set Sheet Attributes option.

Label Match Line: When clicked on and multiple sheets are plotted with plan view option on, a match line will plot in the plan view.

Overlap Stations: In multiple plan and profile sheet plotting, after the first sheet, all subsequent sheets will have the first 2 stations in common with the last 2 stations on the previous sheet, if the Overlap Station option is turned on. For example, if the last 2 stations are 3+10 and 3+20 on sheet 1, then sheet 2 will start with 3+10, then 3+20, with this option turned on. With this option turned off, if the first sheet ends with 3+20, then the second sheet would begin with 3+20.
Draw Horiz Axis Elev

This option creates elevation labels along the horizontal axis. Pick Setup to access the Horizontal Axis Elevations settings dialog. A preview of the labels will be shown to the right of the settings. If the preview does not match the settings, click the Update Preview button.

Linear and Curve Interval: Indicate how often the profile elevation labels should be placed along the horizontal axis of the sheet. The Curve Interval applies within vertical curves and the linear applies everywhere else.

Draw Tick and Tick Height: This option draws a line at the specified height at each station for the elevation labels.
Draw Box Below the Labels: When enabled, a box is drawn around the labels.

Place Existing Grade Profile Elevation on Top: When enabled, places the existing grades above the profile grid as opposed to below.

Existing/Final Grade: Indicate the appropriate profile, precision, text scale, layer, style, prefix, suffix and color for the text labels.

Text Layout: Indicate whether the text labels should be oriented vertically or horizontally.

Label Offset Scale: Indicate the distance from the horizontal axis for the labels. If the value is negative, the labels are placed above the horizontal axis.

Justification: Allows you to justify the elevation text about the left, center, or right side of the interval insertion.

Elevation Difference Options: If both existing grade and final grade are to be drawn, you may choose to also label the Cut/Fill depth values with the appropriate precision, text scale, layer, style, prefix, suffix and color for the text labels that separates the existing and final profiles at each station.

Label Between Elevations: When enabled (and for a Text Layout of Vertical), the label is centered on the various elevations and Cut/Fill Difference label.

Skip Elevation Labels: When enabled, only the Cut/Fill Difference label is generated.

Draw Horiz Label Box

This option draws a boxed area either above or below the profile. It is best used in standard Draw Grid mode, with Draw Sheets clicked off. Pick Setup to access the Horizontal Label Box Setup dialog which has a list of available fields to label. To label a field, highlight the field from the Available list and pick the Add button. Then use the Up/Down buttons to order the fields in the used list.

Box Placement: Set this to either Top or Bottom.

Box Offset: This controls how far to offset the box from the profile.

Header Text Size Scaler: Indicate a relative scale size for the header text values. This value is a scaler that is multiplied by the profile horizontal scale.

Header/Label Offset: This controls how far to offset the Header Text/Label Text box from the profile.
**Skip Tolerance:** Indicate a threshold in which labels should not be placed in an effort to reduce annotation clutter.

**Special Stations:** This controls whether special stations on the Centerline, high and low points on the profile and odd stations that exist in a Section Alignment are labelled.

**Existing and Road Profile:** Set which profile is existing and which is the finished road.

**Profiles for Break Point Stations:** Toggle on which profiles should be used for break point stations.

**Draw Vertical Lines:** This option draws lines from the data point on the profile to the label in the box.

**Draw Box Lines:** This option draws the row and column lines for the label box.

**Layer:** Set the layer for the elements to be drawn on.

**Draw Label Header:** Indicate whether or not the label header(s) should be drawn.

**Draw Vertical Line to Highest Profile:** This option is only available when the Draw Vertical Lines toggle is on. When on the vertical lines will be drawn to the highest profile.

**Pipe Slope Format:** Use this drop down to set the slope format between unit per unit or expressed as a percent.

**Pipe Distance Format:** Use this drop down to set whether the pipe length is shown as the horizontal distance or the slope distance.

**Add and Remove:** Use the >>Add<< button to add items to the list for annotation. Use the <<Remove<< to remove items from the list.

**Edit:** Use the Edit button to set parameters for the label in the box. The Label 2nd Row option creates another row for the field. You can also edit a blank row and specify the row height scaler.

Use the Update Preview to see the results of your changes before committing them to a sheet. An example of the resulting plot is shown here:
Hatch Cut/Fill

Use the Hatch Cut/Fill toggle to enable Hatch Setup. Choose the hatch pattern you would like to use for Cut and Fill as well as the scale, layer and color for each.

![Hatch Setup dialog box]

Draw Slope Labels

When enabled, this option allows you to detail additional slope information onto selected profiles.

![Select Profile dialog box]
Indicate the desired profile(s) whose slope annotation you'd like to control and click on the Setup button for expanded criteria.

Prefix/Suffix: Enter a prefix or suffix on the slopes as desired. Be aware that you may want to add spaces after the prefix or before the suffix.

Label Size Scaler: Set the label size scaler appropriate to your sheet setup.

Layer and Style: Set the layer and style for the text.

Decimals: Set the number of decimal places for the annotation.

Show Slope Sign: Indicate the preferred method for distinguishing positive vs. negative slopes.

Slope Arrow: If you would like a slope arrow to help understand the direction of slope, use one of the radio buttons for Above, Next to or On the profile.

Skip Overlapping Labels: If the labels would overlap and you do not want that to happen, use the Skip Overlapping Labels toggle.

Label at Interval: Draws slope labels at the specified station interval.

Minimum Segment Size: You may not want to annotate shorter segments. If not, set a minimum segment size.

Label Slope As: You have the option of labeling the slope express as unit per unit, as a percent or as a ratio.

Update Preview: Use the update Preview button to see what your changes would look like before committing them to sheets.

Draw Break Point Sta

When enabled, this option will label station values along the profile line above each break point in the profile. Pick Setup to access the Break Point Station Setup dialog.
**Label Size Scaler:** Set the label size scaler appropriate to your sheet setup.

**Prefix/Suffix:** Enter a prefix or suffix on the slopes as desired. Be aware that you may want to add spaces after the prefix or before the suffix.

**Layer, Style and Color:** Set the layer, style and color for the text.

**Description Match:** Set the description you are looking to match.

**Decimals:** Set the number of decimal places for the annotation.

**Position:** Set the position for the text top or bottom and left, center or right.

**Place Labels at Interval:** Set up linear and curve intervals for the text.

**Place Labels at Centerline Special Stations:** Turn the toggle on and select the Setup button to change the settings.

**Place Labels at Break Stations:** Toggle this on to place labels at break stations.

**Place Labels at Begin/End Stations:** Toggle this on to place labels at the beginning and ending stations.

**Update Preview:** Use the update preview button to check your changes before committing them to a drawing.

**Draw Break Point Elev**
When enabled, this option will label elevation values along the profile line at each break point in the profile. Pick **Setup** to access the Break Point Elevation Setup dialog.

**Label Size Scaler:** Set the label size scaler appropriate to your sheet setup.

**Prefix/Suffix:** Enter a prefix or suffix on the slopes as desired. Be aware that you may want to add spaces after the prefix or before the suffix.

**Layer, Style and Color:** Set the layer, style and color for the text.

**Description Match:** Set the description you are looking to match.

**Decimals:** Set the number of decimal places for the annotation.

**Position:** Set the position for the text top or bottom and left, center or right.

**Place Labels at Interval:** Set up linear and curve intervals for the text.

**Place Labels at Centerline Special Stations:** Turn the toggle on and select the Setup button to change the settings.

**Place Labels at Break Stations:** Toggle this on to place labels at break stations.

**Place Labels at Begin/End Stations:** Toggle this on to place labels at the beginning and ending stations.

**Update Preview:** Use the update preview button to check your changes before committing them to a drawing.

**Draw Break Point Desc**
When enabled, this option will label descriptions along the profile line at each break point in the profile. Pick **Setup** to access the Break Point Description Setup dialog.

![Break Point Description Setup dialog](image)

**Label Size Scaler:** Set the label size scaler appropriate to your sheet setup.

**Prefix/Suffix:** Enter a prefix or suffix on the slopes as desired. Be aware that you may want to add spaces after the prefix or before the suffix.

**Layer, Style and Color:** Set the layer, style and color for the text.

**Description Match:** Set the description you are looking to match.

**Position:** Set the position for the text top or bottom and left, center or right.

**Update Preview:** Use the update preview button to check your changes before committing them to a drawing.

The **Description Table** button on the Select Profile dialog for Draw Break Point Desc brings up the spreadsheet dialog shown below. This table sets up translations of profile descriptions into labels and symbols to draw. For example, for a profile description of "WL", you can label the profile as "WATER LINE" and draw a symbol at this point. If you only want to change the label, then only fill out the label and leave the symbol blank.
Draw Break Point Elev Diff

When enabled, this option will label elevation difference values along the profile line at each break point in the profile relative to a reference profile (e.g. existing grade). Pick Setup to access the Break Point Elevation Difference Setup dialog.
**Reference Profile:** Indicate the profile that should be used as the point of comparison for the break point locations.

**Label Size Scaler:** Set the label size scaler appropriate to your sheet setup.

**Prefix/Suffix:** Enter a prefix or suffix on the slopes as desired. Be aware that you may want to add spaces after the prefix or before the suffix.

**Layer, Style and Color:** Set the layer, style and color for the text.

**Description Match:** Set the description you are looking to match.

**Decimals:** Set the number of decimal places for the annotation.

**Decimal Shift Right:** Indicate the number of places to shift the decimal point to the right. For example, if a traditional elevation difference was calculated to be 1.234 and the Decimal Right Shift value is set to 1 (a factor of 10), the reported elevation difference would be shown as 12.34.

**Position:** Set the position for the text top or bottom and left, center or right.

**Place Labels at Interval:** Set up linear and curve intervals for the text.

**Include/Exclude Break Stations:** Use the radio buttons to toggle between including or excluding break stations.

**Update Preview:** Use the update preview button to check your changes before committing them to a drawing.

**Break Point Leader/Symbol Setup**

Click this button to establish if it desirable to have a leader and/or break point symbol used in conjunction with the Draw Break Point Sta and/or Draw Break Point Elev options.
Label Placement: Use the label placement settings to control where this annotation will be placed.

Offset Scaler: Set the label size scaler appropriate to your sheet setup.

Leader Settings: Set one of the two options for how the leader is drawn.

Symbol Settings: Set and select the symbol, layer, color and scaler for the symbol.

Update Preview: Use the update preview button to check your changes before committing them to a drawing.

Draw Line/Point Crossings

This option draws labels for linework that crosses the reference centerline. The reference centerline is set in the first Draw Profile dialog where the profiles to draw are selected. The Setup dialog has a list of layers. The program will find intersections between the reference centerline and linework on these specified layers. For each layer, there is a Description which is used for the label on the profile. Besides labeling these descriptions for the crossings, the program includes the station along the reference centerline at the crossing. In the options dialog, there are settings to control the layer, style, color, size, decimal places for the station label, label position and whether to draw a vertical line from the label to the profile.
Chapter 16. Surface Menu
Draw Road Intersections

When enabled, this option will label the location(s) of any road(s) from an identified Road Network that intersect the main road.

Size Scaler: Set the label size scaler appropriate to your sheet setup.

Decimals: Set the number of decimal places for the annotation.
**Layer, Style and Color:** Set the layer, style and color for the text.

**Label Position:** Use the label placement settings to control where this annotation will be placed.

**Draw Road Name Label, Draw Main Station Label, Draw Side Station Label, Draw Elevation Label:** Toggle on to draw the this annotation and set the location.

**Leader Settings:** Indicate the type of leader to be drawn.

**Offset Scaler:** Indicate the plotted distance between the symbol and the text label(s) to establish the length of the leader.

**Draw Symbol:** Toggle this on to set a symbol and the size of the symbol.

**Update Preview:** Use the update preview button to check your changes before committing them to a drawing.

## Road Labels

This button opens Vertical/Circular Curve Settings dialog. From a wide variety of available labels, you are able to create your own label selections very conveniently. Each label can be edited individually through the Setup button. You can specify the prefix, suffix, symbol style, decimal places, text orientation and position, etc, in the Edit Label dialog.
VC Point Layer sets the layer for the point symbols on the vertical curve.

Draw PVI 'V': You can choose to draw either a full tangents style PVI 'V' point, or a partial tangents style, or nothing.

PVI ''V'' Layer specifies the layer that the tangent lines will be drawn on

Label Placement: This setting determines where to place the vertical curve labels. There are six options: Pick Single Row, Pick Individual Position, Auto Place Above Highest PVI Point, Specify Offset from Grid Top, Offset from Curve - Aligned, Offset from Curve - Horizontal.

Label Justification sets the text justification to Left or Center

Label Offset from Grid/Curve: Indicate the distance from the Grid or Curve when the Label Placement option is set to Offset from Grid Top or Offset from Curve, respectively.

Symbol Size Scaler sets the size for the symbols at the vertical curve points

Draw Horizontal Dimension Lines: This option draws horizontal lines connecting the PVC and PVT of all vertical curves.

Draw Vertical PVC & PVT Lines: This option draws vertical lines emanating from the PVC and PVT of all vertical curves.

Combined PVC/PVT Labels sets the prefix and suffix for the stations and elevations of the vertical curve components

Symbols for the PVI, PVC and PVT can all be selected from the symbol library.

Label PVI When VC=0: When vertical curve length is 0, no label is created unless you choose this option and then the PVI label would be shown.

Draw Slope Direction Arrow: Draws an arrow to indicate slope direction.
**Arrow Direction:** You can choose from Profile Direction, Uphill Slope Direction and Downhill Slope Direction.

**Draw Vertical Interval Labels:** This option labels the intervals of the vertical curve section. In its setup dialog, you can specify the intervals, distance from the vertical curve to put the labels, decimal places to display the interval stations and elevations, symbol settings and label settings.

![Vertical Interval Labels dialog box](image)

Here is an example of a road profile.

![Road profile example](image)

**EOP Profile Setup**

This button allows you to establish the criteria for drawing and labeling Edge of Pavement (EOP) profiles:
Begin/End Front Curb Return: Enter a description for the front curb return.

Begin/End Back Curb Return: Enter a description for the back curb return.

Include Road Name: Enable this control if you’d like the road name included with the edge of pavement profile.

Draw VC Labels for EOP Profiles: When enabled, this option will label vertical curves found in edge of pavement profiles.

Draw Curb Return Length Label: When enabled, this option will label the length of curb returns. Use the Setup button to specify and control the display settings.

Draw Curb Return Elevation Labels: When enabled, this option will label the elevations of curb returns. Use the Setup button to specify and control the placement and display settings.

Sewer/Pipe Labels

This button opens Draw Sewer/Pipe Options dialog.

General Tab
Each style has a **Setup** dialog to specify which labels are to be created and in what order. For labels with leaders, you can setup the leader styles.

**Example of Settings for Draw Annotations above Rim**

![Sewer Label Settings dialog](image)

**Note:**
In addition to the numerous annotation options found on the General Tab, many of the options will also contain an **Equation** option that permits user-defined equations using numbers and/or Rim, Invert Out or Step Up for even additional control. For example, to label rims with 2 elevations for 2 datums, one might specify an equation of \([RIM] + 1.0\) (or similar).

**Draw Horiz Axis Annotations:** Labels structure or pipe profile along the horizontal axis.

**Draw Annotations Above Rim:** Creates structure or pipe profile labels above the rim of manholes.

**Draw Annotations Below Invert:** Creates structure or pipe profile labels below the rim of manholes.

**Draw Annotations with Leader from Rim Position:** Creates structure or pipe profile labels with a leader from manhole's rim position.

**Draw Annotations with Leader from Invert Position:** Creates structure or pipe profile labels with a leader from manhole's invert position.

**Draw Annotations with Attribute Block:** Inserts blocks with attributes for the structure or pipe labels.

**Draw Manhole Label as MTEXT:** When enabled, the manhold label will be placed as an MTEXT entity.

**Skip Rim Elevation/Invert Out Elevation/Invert In Elevation for Outlet:** When enabled, the cited component(s) will not be placed for the special Outlet structures.

**Connect Rims with Polyline:** When enabled, a polyline representing the average grade between each pair of rim elevations will be drawn to the specified layer.

**Tick Mark for Station:** Draws a tick mark at every station.

**Project Invert In/Out Elev at Manhole Center:** The Invert In/Out elevations are not the actual values, but are projected elevations to the manhole center.

**Station Manholes by Another Centerline:** This option will make new station for each manhole by referencing the profile to another centerline, for example a road centerline.

**Draw Sump:** When enabled, specify the height of the sump to be drawn into the sewer profile.

**Draw Base:** When enabled, specify the base height to be drawn into the sewer profile.

**Draw Extended Pipe At Beginning/End:** Draws the pipe beyond the beginning or the end by a specified length.

**Draw Break Lines for Extended Pipes:** When enabled (and requires either **Draw Extended Pipe At Beginning** or **Draw Extended Pipe At End** to be enabled), a “squiggle” is drawn at the end of the extended pipe to indicate that it is a partial pipe. Otherwise, the pipe end is left "open”.

**Label Precision:** Click on the Label Precision button to set the amount of precision used for sewer station, elevation, length and slope labels.

**Label Additional Elevation:** This option may be utilized to apply a scale factor (e.g. Imperial Units to SI Metric Units) for plans that require alternate units to be cited.

**Manhole Tab**

On this tab, you are able to specify how to label the manhole name and how to draw the manholes.
**Draw Manhole Name:** Enable this option and select the desired geometric shape that shall circumscribe the manhole name. If selected, enter any desired prefix or suffix for the labels.

![Manhole Name Setup](image)

**Draw Manhole Sides Down To Invert:** Closes the manhole at pipes.

**Manhole Rim Elevation Prompt:** Ignores the manhole's rim elevation and prompts to enter new values.

**Manhole Rim Offset Prompt:** Prompts to enter the offset value and adds the offset to the manhole's rim elevation.

**Manhole Width Prompt:** Enable this option to prompt for the top width of the manhole.

**Manhole Bottom at Pipe Slopes:** Enable this option to prompt for the bottom width of the manhole.

**Draw Manhole Separate from Pipe Polylines:** Enable this option to draw the shape of the manhole as a separate polyline from that of the pipe.

**Draw Vertical Line Through Manhole Center:** Draws a vertical line through the manhole center from rim to bottom of profile grid.

**Draw Drop Across As Vertical On Uphill Side:** If a step up is used, draws this as a vertical line on the higher side of the structure.
**Draw Sump:** When enabled, specify the height of the sump to be drawn into the sewer profile.

**Draw Base:** When enabled, specify the base height to be drawn into the sewer profile.

**Drop Across Manhole:** Adds a step up to the invert-in elevation.

**Taper Format, Manhole Dimensions:** When drawing from a profile file created with the Design Sewer/Pipe Profile command, these parameters are used to define the manhole shape and dimension. When drawing from a profile created from Network in the Hydrology module with commands such as Export to Profiles, these Draw Profile settings are ignored and the dimensions come from the Network instead. The taper settings are used for transitioning between different manhole top and bottom widths. The Top Taper Offset sets the distance from the top of the manhole to the point that the taper will end. The Fixed Taper Height determines the overall length of the tapered section.

![Manhole Dimensions Diagram]

In this example image, all the manholes have Top Width of 2 and Bottom Width of 4. Manhole #1 has Top Taper Offset of 2 and Fixed Taper Height of 0. Manhole #2 has Top Taper Offset of 100 and Fixed Taper Height of 0. This large Top Taper Offset is greater than the manhole depth so that the taper runs the full length of the manhole. Manhole #3 has Top Taper Offset of 3 and Fixed Taper Height of 1.

**Pipe Tab**

Here you can choose to label pipe in a very flexible order. Each label has a setup function which specifies the label prefix and suffix, decimal places, row number and etc.

![Pipe Tab Diagram]

**Label Layer:** Set the layer for the labels.

**Label Style:** Set the text style and size of the text.

**Pipe Distance Method:** Label either the center to center distance or the actual distance of the pipe.

**Pipe Slope Method:** Choose from three common methods of calculating pipe slope.
**Pipe Label Position:** Choose from along the pipe, along the axis or inside the pipe.

**Pipe Material:** Indicate the type of material used for the pipe.

**Draw Pipe Thickness:** When selected, draws pipes in profile as double lines indicating the thickness of the pipe. This option also allows for cross hatching of the double lines.

**Draw Manhole Base to Match Pipe Thickness:** When selected, this option draws the base of the manhole to the same depth relative to the pipe thickness.

**Label Pipe Distance as Station Along Horiz Axis:** This option creates pipe distance labels as the station style along the horizontal axis. Click the **Setup** button to access the labeling method and style.

![Pipe Label Distance as Station](image)

**Draw Flow Arrows:** Indicate if arrows should be drawn illustrating the direction of flow.

**Draw Cradle Lines:** If the sewer profile contains cradle data, this option would draw cradle lines above and below the pipe segments.

**Draw Pipe Label as MTEXT:** When enabled, text labels will be drawn as a *multiline text* (MTEXT) entity.

**Fit Pipe Label Between Structures:** When enabled, this option will ensure that pipe labels will fall within a structure-to-structure distance.

### Pipe Crossing Labels

This button opens Pipe Crossing and Link Label Options dialog, which contains all the settings for drawing a pipe crossing type or profile, or the pipe crossings when pipes or sewer networks in the drawing are intercepted by a profile to be drawn.
(Setup) Label Prefix/Suffix: Indicate labels that should precede and/or follow the pipe information.

(Setup) Label Precision: Decimal places of the labels.

(Setup) Label Station/Elevation/Size/Name/System Name: Options to label the parameters or not.

Pipe Symbol: Options to show pipe crossing in circle, square, or based on the pipe shape.

Text Rotation: Labels can be drawn either horizontally or vertically. This option becomes disabled when the Draw Annotations with Leader option is enabled.

Fill Pipe Shape: When enabled, the cross-section area of crossing pipes will be hatched for visual distinction.

Station Crossing Profile By Another Centerline: This option will make new stations by referencing the profile to another centerline, for example a road centerline.

Draw Pipe Crossing On-The-Fly: When this option is chosen and there are pipes or sewer networks drawn in the drawing, the program will prompt to select a reference centerline that represents one of the profiles to be drawn to detect the pipe crossings. Any pipe crossings found would be drawn with other profiles.

Draw Parallel Pipes Within a Swath Width: When this option is chosen and there are pipes or sewer networks drawn in the drawing, the program will prompt to select a reference centerline that represents one of the profiles to be drawn to detect if there's any pipe segments that are within a swath width along the profile. Any pipe segments found would be drawn with other profiles.
Draw Annotations with Leader: When enabled, this uses a leader in conjunction with pipe labels.

Draw Annotations with Vertical Line: When enabled, this uses a vertical line and orientation to indicate the location of the pipe crossing being labeled.

Show Pipe Thickness: When enabled, this draws the pipes in profile using double lines to indicate the thickness of the pipe. The area between the lines can be cross-hatched.

Link Label Settings: Settings to determine how to draw link labels.
An Example of Pipe Crossings On-The-Fly

An Example of Parallel Pipes Within a Swath Width

**Lateral Connection Labels**

These settings apply for profiles create from a Sewer Network from the Hydrology module that contains lateral structures. There are several lateral data fields available for labeling. Use the Add/Remove buttons to make the list of fields to label. Use the Setup button to set the prefix and suffix for each field, and control whether the field is labeled on a separate row. There are settings to choose the symbol on the pipe at the lateral station, the text orientation, whether to draw a vertical line at the lateral station, set the label position and offset, set the text justification and whether to draw a leader from the pipe to the label.
**Lateral Symbol:** Set this to circle, square or pipe shape as appropriate.

**Text Orientation:** Use this to control whether the text is oriented horizontally or vertically.

**Draw Vertical Line:** Set the vertical line to none or a number of rows.

**Label Position:** Use this to set the label position relative to the Right-of-Way, Connection or Mainline.

**Label Offset:** Set the offset of the label relative to its reference point.

**Text Justify:** Use this to justify the text either center, left or right.

**Draw Annotation with Leader:** If you want to use a leader, enable this option.

**Show Lateral Thickness:** Use this setting to show the thickness of a lateral.

**Update Preview:** Use this button to update the preview window and review your changes before committing them to a drawing.

**Utility Profile Labels**
**Station Profile By Another Centerline:** This option will derive stations by referencing the utility to another centerline, for example a road centerline.

**Draw Connection:** When enabled, and for Utility Networks that have been assigned Connections, the connection point(s) is (are) drawn into the profile.

**Label Connection:** When enabled, and for Utility Networks that have been assigned Connections, the label(s) for the connection point(s) is (are) drawn into the profile.

**Draw Annotations with Leader:** This option will permit the Utility label to be placed with a leader with further control via the **Setup** option.

**Label Offset:** Indicate the plotted distance the Utility label should be drawn away from the Utility entity.

**Prompts (may vary based on Settings)**

**Grid Starting Station:** Indicate the desired starting station for the profile grid.

**Ending Station:** Indicate the desired ending station for the profile grid.

**Grid Top Elevation:** Indicate the bounding upper elevation for the profile.

**Grid Bottom Elevation:** Indicate the bounding lower elevation for the profile.

**Polyline should be drawn in direction of increasing stations.**

**CL File/<Select pipe crossings on-the-fly or parallel pipes centerline>:** Pick a polyline upon which to base the stationing or **Type C to select an existing Centerline .CL file and then press Enter**

**Centerline Starting Station <0.0>:** Press Enter to accept the default station value specified or Type in the beginning station then press Enter

**Pulldown Menu Location(s):** Civil > Profiles, Survey > Surface, Hydrology > Network, Construction/Takeoff > Roads, Field > Roads
Profile to 3D Polyline

This command converts a 2D polyline centerline into a 3D polyline that follows the elevations of the profile. Horizontal and vertical curves are represented as a series of polyline segments since 3D polylines cannot contain arcs. Profile to 3D Polyline can be combined with other commands for plan-view road design as follows:

1. Draw 2D polyline centerline.
2. Profile from Surface Model - to create existing surface profile.
3. Design Road Profile - to design the final profile with vertical curves.
4. Profile to 3D Polyline - create a 3D polyline of the road centerline.
5. Offset 3D Polyline - offset the 3D polyline centerline left and right by the horizontal and vertical distances.
6. Design Pad Template - run twice for left and right polylines of road to tie into surface at specified cut and fill slopes. This creates the limits of the disturbed area. Or use Join Nearest, Direct Connect Endpoints, to create a closed loop pad with one run of Design Pad Template for simple ramps, driveways and access roads.
7. Triangulate & Contour - draw final contours using road 3D polylines.
8. Volumes - use any of the volumes commands to calculate cut and fill volumes.

Prompts

Layer Name for 3D Polyline <3DPROF>: press Enter
Select profile centerline polyline: pick a polyline
Station by another reference centerline [Yes/<No>]? N for no. This option will prompt for a second centerline to use for stationing.
Enter the starting station <0.0>: press Enter
Select Profile File
Starting station of centerline <0.0>: press Enter
Erase centerline (Yes/<No>)? Y This option will erase the original 2D polyline centerline.

Example of road design in plan-view with Profile to 3D Polyline

Keyboard Command: proto3dp
Prerequisite: A .PRO file and a centerline polyline
Profile To Points

This command creates Carlson points along a horizontal alignment polyline using a profile file to compute the point elevations. The created points are stored in a coordinate (.CRD) file and can also be drawn on screen in the layer specified by the user. Station text, profile name, and special points (vertical and horizontal PC’s and PT’s) can be stored in the point description depending on user settings.

Create points at Profile special points: Includes vertical PC and PT points.
Create points at Centerline special points: Includes horizontal PC and PT points.
Create points at Station Intervals: Allows you to specify intervals for point creation.
Interval On Line Segments: Allows you to specify intervals for line segments.
Interval On Curve Segments: Allows you to specify intervals for curve segments.
Station to Begin Intervals: Specify station to start intervals.
Prompt For Additional Odd Stations: Any station can be entered to create additional points with elevations derived from the profile.
Create Points on Centerline: When checked, points will be created on the centerline.
Create Left Offset Points: When checked, left offset points will be created. Specify the offset in the edit box.
Create Right Offset Points: When checked, right offset points will be created. Specify the offset in the edit box.
Vertical Offset Of Profile: Specify the vertical offset. Enter zero for no vertical offset.
Plot Points: When checked, points will be plotted in the drawing, otherwise points are only added to the current coordinate (.CRD) file.
Include profile name in point descriptions: When checked, the profile name will be used as the prefix on the point description. For example, if the profile name is DESIGN.PRO, then the point description might be DESIGN 0+63.37.
Decimal Places: Specify the display precision for points that are plotted in the drawing. This setting does not affect the coordinates stored in the CRD file.
Centerline by: Click either Polyline or CL File.
Type of Centerline: Click either Roadway or Railroad.
OK: Specify files.
Prompts

Select Coordinate File to Process
If the current coordinate is set, it is used automatically without this prompt.

Select profile centerline polyline: pick a polyline

Starting station of centerline <0.0>: press Enter

Station by another reference centerline [Yes/<No>]? N for no. This option will prompt for a second centerline to use for stationing. With this option, the first centerline is used for locating the points and the second reference centerline is used for locating the profile stations. So the first centerline represents where the points are created (ie. the edge of pavement) and the second centerline represents the profile location (ie. the road CL).

Choose Profile to Process dialog Specify a profile name.

Starting point number <1>: press Enter This defaults to the point number after the highest one currently in the CRD file.

Station for additional point (ENTER to end): press Enter This option will create a point at the specified station. Prompt occurs only if option is specified in dialog.

Keyboard Command: pro2pts
Prerequisite: A .PRO file and a centerline polyline

Profile Conversions

There are eleven Profile Conversion commands, all of which are listed below. The first nine in the list are Import Profile commands. These commands allow you to convert a single profile file from their respective program to the Carlson profile (.PRO) format. For each, you are prompted to select the file to be imported, then provide a Carlson profile file name. Underneath each of the nine brief descriptions shown are, in bold, the prompts that you see in dialog box form and/or on the command line.

The last two commands listed below are Export Profile commands. They allow you to convert a single Carlson profile (.PRO) file to Softdesk (.TXT) format, or a single Carlson profile (.PRO) file to Leica (.GSI) format. You are prompted to select the Carlson profile file, then provide a name for the Softdesk or Leica file.
Import Columnar Text

Allows you to Import a comma or space delimited text file to create a profile (.PRO) file.

Import CAiCE Profile

Allows you to convert a single CAiCE (.KCP) profile file to the Carlson profile (.PRO) format. You are prompted to select the CAiCE file, then provide a Carlson profile file name.

Pulldown Menu Location: Profiles > Profile Conversions

Keyboard Command: caice2pro

Import Leica Profile

Allows you to convert a single Leica profile (.GSI) file to the Carlson profile (.PRO) format. You are prompted to select the Leica file then provide a Carlson profile file name.

Choose Leica/Wild File to Read dialog Select existing file.

Choose Profile to Write dialog Select file name.

Pulldown Menu Location: Profiles > Profile Conversions

Keyboard Command: wildpro2

Import MOSS Profile

Allows you to convert a single MOSS profile (.INP) file to the Carlson profile (.PRO) format. You are prompted to select the MOSS file then provide a Carlson profile file name.

Choose MOSS Profile File to Read dialog Select existing file.

Choose Profile to Write dialog Select file name.

Pulldown Menu Location: Profiles > Profile Conversions

Keyboard Command: moss2pro

Import Novapoint Profile

Allows you to convert a Novapoint profile (.NYL) file to the Carlson profile (.PRO) format. You are prompted to select the Novapoint file then provide a Carlson profile file name.

Choose Novapoint Profile File to Read dialog Select existing file.

Choose Profile to Write dialog Select file name.
Import Softdesk Profile

Allows you to convert a single Softdesk profile (.TXT) file to the Carlson profile (.PRO) format. You are prompted to select the Softdesk file then provide a Carlson profile file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: nova2pro

Import Sokkia/SDR Profile

Allows you to convert a single Sokkia/SDR (.SDR or .RAW) profile file to the Carlson profile (.PRO) format. You are prompted to select the Sokkia/SDR file, then provide a Carlson profile file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: dcapro2

Import Spanish ALZ Profile

Allows you to convert a single Spanish ALZ profile (.INP) file to the Carlson profile (.PRO) format. You are prompted to select the Spanish ALZ file and then provide a Carlson profile file name.

Choose CLIP File to Read dialog Select existing .ALZ file.
Choose Profile to Write dialog Select file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: alz_to_pro

Import Spanish RAS Profile

Allows you to convert a single Spanish RAS profile (.RAS) file to the Carlson profile (.PRO) format. You are prompted to select the Spanish RAS file and then provide a Carlson profile file name.

ISPOL File to Read dialog Select existing .RAS file.
Choose Profile to Write dialog Select file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: ras_to_pro

Import Terramodel Profile

Allows you to convert a single Terramodel (.RLN) profile file to the Carlson profile (.PRO) format. You are prompted to select the Terramodel file, then provide a Carlson profile file name.

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: tm2pro

Export Softdesk Profile

Choose Profile File to Read dialog Select existing .PRO file.
Choose Softdesk File to Write dialog Enter new Softdesk file name.
Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Command: dcapro1

Export Leica Profile

Choose Profile File to Read dialog Select existing .PRO file.
Choose Wild File to Write dialog Enter new .GSI file name.
GSI file format [<8>/16]? press Enter

Pulldown Menu Location: Profiles > Profile Conversions
Keyboard Commands: wildpro1
The GIS menu shown below has commands for managing and reporting data attached to drawing entities.
GIS Database Settings

This command sets the current GIS Features and GIS Data Format. The GIS Features file (.GIS) defines the structure of the GIS features and their attributes. This file is set by the Define GIS Features command.

The Data Format defines where the GIS data will be stored and the file format. For Single File Type Database, the data is stored in an external database in either SQLite format (.DB) or Microsoft® Access (.MDB). Map Object Data is limited to Autocad Map 3D only. Map object data is attached to individual object and stored in tables in the drawing. Object data tables store text and numerical information related to an object. The Esri MSC Data stores the GIS data within the drawing file in a format that both Carlson and Esri use. Esri added support for MSC from ArcGIS V9.3. The ESRI MSC structure makes the DWG file a type of geodatabase with all the feature definitions, GIS data and geometry stored in the file. The SQLite/Spatialite stores date in SQLite format(.sqlite) with spatial capabilities. The SQLite/Spatialite DB can be added into QGIS layer.

Use Enable Store/Read Point GIS Data to/from SQLite (CRDB) File to provide an easier transferal method to and from data used in SurvCE/PC and Carlson Office products. The CRDB file format is based on SQLite structures. The CRDB format contains the same data as a CRD format but with extra information like GIS data and photos links. If Enable Store/Read Point GIS Data to/from SQLite (CRDB) File is OFF, the GIS data will be stored in a VTT format file.

Prompts

GIS Setting dialog Click both file buttons and select new or existing files.

New or Existing File

File type> *.DB,* .MDB

Existing

New SQLite Format

New Access '97 Format

New Access 2000 Format

Help

Pull down Menu Location: GIS Data
Keyboard Command: gis_config
Prerequisite: None
Define GIS Features

This command creates the Feature/Attribute data structure, template database or schema, for GIS functionality. The structure is stored in a Carlson Features File with a GIS file extension.

A feature, such as a manhole, can have multiple attributes, such as Number of rungs, Type of material, Number of inlets, etc. Features can be organized into Categories: Utilities, Roads, Properties. The Category designation is an arbitrary way of organizing the features. Features and attributes can be imported from:

- Carlson GIS Features file (.GIS)
- Carlson Field to Finish file (.FCL)
- Esri MSC data contained within the drawing (.DWG)
- Carlson Template Database file (.MDB)
- Trimble Features file (.FXL or .FCL)
- SurvCE Features file (.VTT)
- TDS Features file (.FEA)
- Comma Separated Values (.CSV)
- Carlson Coordinate File (.CRDB)
- Esri File GeoDatabase (.GDB)
- Map Object Data

Features and attributes can of course also be defined “from scratch” in the Define GIS Features dialog box. The workflow is outlined below.

1. Set the GIS file name which will contain the features and attributes structure. Use the File menu to create a new (.GIS) file or open an existing one for editing. Please note that the system will only process correctly if a FCL and a GIS file both have the exact same file name.
2. Set up one or more Category Names, using the Category menu. GIS feature codes can be categorized (e.g. STRUCTURES, UTILITIES, ROAD FEATURES, etc.). At least one category must be created.
3. Define Features, using the Feature menu. To edit a feature, double-click on the feature name. A category such as UTILITIES might have features such as manholes, light poles, fire hydrants, water valves, etc.
4. Define the attributes for the Feature. Each attribute has:
   a) a Name
   b) a Full Name, or Prompt
   c) a Type - Integer, Character or Real
   d) a system Default Value. Press the Default button to add a system variable from a list. For example, press Default > Elevation. The system will add $SEQN=SLAT$, a system variable that will insert the current latitude from the point measurement.
   e) optionally, a List of values to pick from. Use the List Values button or type in each value followed by Enter within the field required, to build a list. The list will as a pick list when the attribute screen is shown.
   f) whether the attribute is required
   g) whether the attribute Value can be field Edited, appears as Read Only, or is Hidden
   h) whether the value used is restricted to the list

The order of attributes appearing on the data-entry screen is controlled by the Up and Down buttons.
Geometry Settings

At the bottom of the dialog box the user can specify the geometry settings for each feature. Each feature can be defined as an open/close polyline or point. Each feature can also have a layer, block text style and line type defined. Please note that GIS features can only be defined on polylines and not lines.

Pulldown Menu Location: GIS Data
Keyboard Command: def_template
Prerequisite: None

Input-Edit GIS Data

This routine creates, reviews and appends GIS data linked to entities stored in the drawing.

The GIS Smart Prompting dialog has a spreadsheet format for editing the data fields. The GIS table to process is selected in the pull-down list in the upper right of the dialog. The GIS tables that are available depend on the tables that are defined in the current template database. Use the GIS Database Settings and Define Template Database commands to setup the tables. Once you select a table to process, the fields for that table are displayed in a spreadsheet format. If a field is related to a field in another table in the database, a "+" character is shown next to the field name. Picking the "+" will open another dialog box with the related data in the other table. The data in this related table is not editable, only the data in the initial linked table.

The bottom portion of the dialog has features for attaching images to the entity. (Note: The bottom portion is only limited to single file type database and ESRI MSC Data.) Existing image files (BMP, JPG or GIF) can be linked by choosing the New option. The Update option will replace the current image with a newly selected image. The Delete option will remove the current, attached image. The Capture button will take a shot in the field using a
configured camera and then attach the image to the entity. Different digital cameras can be used by picking Pick or Set Camera.

The Input-Edit GIS Data command is an excellent way to simply review the data associated with an entity. If the entity has GIS data, the banner line at the top of the dialog will display "Entity has GIS Data". If not, the banner line will display "Entity has no GIS Data". Even when the entity has no data, the default values for the prompts will appear. Pressing OK will assign this data to the entity. To avoid assigning data to the entity (if it has none), press Cancel. Alternately, you can use the commands GIS Inspector Settings, followed by GIS Data Inspector, to review the data with no possibility of editing or inputting data in the process.

There are three methods for selecting the drawing entities to process: S for Select, P for Pick and N for Number:

**Select Object method:** With this method, you pick the drawing entity to process the data attached to that entity. When selecting a Carlson point, the point number is used to link to the database.

**Pick method:** For this method, you pick inside a closed polyline to process the data attached to that polyline.

**Number method:** Here you simply input the point number from the current CRD file to process.

Map Object Data has different dialog that only allow user to select GIS Feature table and add/edit/delete data.

### Prompts

**Select object (Number/Pick/Select):** P

**Pick a point inside polygon (Select/Number/Pick):** pick a point

**GIS Smart Promoting dialog make selections**

Map object data editor dialog

### Pulldown Menu Location:
GIS Data

**Keyboard Command:** gisdata

**Prerequisite:** MDB GIS prompting must be created in Define Template Database and points or entities must exist to link GIS information to.

### GIS Inspector

This command displays all or portions of the data attached to drawing entities in real-time. How much of the attached data is displayed is set by the command GIS Inspector Settings. When you move the cursor over an entity with GIS data, selected fields are displayed in a tooltip box next to the cursor. For data attached to closed polylines, you can move the cursor anywhere inside the polyline to show the data. Polylines that are closed will highlight with a solid
fill as you inspect each one. Open polylines, such as road centerlines, will highlight with a solid fill generated along the length of the polyline. The solid fill color for all highlighting is set in GIS Inspector Settings.

The routine starts by prompting you to select entities. The entities that you select will be used by GIS Inspector. In the case of a large drawing, this selection allows you to limit the entities for inspector to a local area instead of having to process the whole drawing. Then after reading the entities, you can move the cursor around the drawing to inspect the GIS data. You can also use the arrow, page up and page down keys to pan and zoom the display. Pressing enter ends the routine.

Prompts

Select objects: select entities with attached data
Arrow keys=Pan; PageUp/Down=ZoomOut/In;
Zoom=Pick left-lower and right-upper corner;
Move pointer over entity with Gis Data (Enter to End): move cursor over entities with data; press Enter to end

Pulldown Menu Location: GIS Data
Keyboard Command: gis_inspector
Prerequisite: MDB GIS Prompting must be created in Define Template Database and entities must have linked GIS information.

GIS Inspector Settings

This command sets up the fields to be displayed when using GIS Data Inspector. Each GIS table code can have different display options stored in the GIS Inspector Settings command.

GIS Inspector Settings reads all the points and entities with GIS information currently linked in the drawing and displays a list of the linked data tables under the Available GIS Table column. When a GIS Table code is highlighted (i.e. 0001 or Road), the fields for this GIS table are displayed to the right in the Select Fields column. Up to 6 fields or lines of GIS data can be defined for display for each GIS code table, including one picture. To add a field to the display list, double-click on the field name. To remove a field from the display list, highlight the GIS table to remove from and then use the Clear Settings buttons. The Last Option button will remove the last field to display from the current GIS table. The Picture Name will remove the image from the display list. The Entire Line button removes all the fields from display for the current GIS table.
Pulldown Menu Location: GIS Data
Keyboard Command: set_inspetor
Prerequisite: MDB GIS Prompting must be created in Define Template Database and points or entities must have linked GIS information.

GIS Query/Report

This command applies a user-defined query on a data table or related tables with the database. Records in the table that pass the query can be reported or the associated entities can be highlighted in the drawing. The Query Using option in the main dialog box sets the source of the data table to process as either GIS data attached to selected drawing entities or from the current Output MDB file.
The query is defined in the dialog shown here. To add a query, enter a new query name in the in the space underneath Current Query. If there is already a name there, just highlight and type over it with a new name, then hit Clear All to clear out existing query lines and get full access to all Feature Names.

The top portion of the dialog contains a list of the query parameters. To add a parameter, select a Feature Name from the pop-up list. The available features will either be all the features found in the GIS links of the drawing or all the features from the Output MDB file depending on the Query Using option. Once the feature is specified, the Field Name pop-up list contains all the available fields in the feature. Choose a field from this list. Next choose the operator (=, >, etc.) from the operator list. The Value pop-up list contains all the different values for that field that are found in the current data set. You can either select one of these values or type in another value into this field. If a Field Name relates to another Feature, when you select that Field, an additional button will appear allowing you to add a query parameter from the related feature.

When all the parameter values are set, pick the Add Parameter button. Once a feature is selected and add a parameter is added, the Feature Names list becomes unavailable because any additional query parameters must come from that feature, or relate through that primary feature.

When all the parameters are defined for the query, you can save these settings by filling out a name Current Query field and then picking the Save button. This query can be recalled later by highlighting the query name and clicking the Load button. The Delete button removes the highlighted query. The Save, Load and Delete functions operate on the current set of queries active in the program. The Save To File and Load From File functions read and write the collection of queries to a .QRY file for managing different sets of queries and sharing with others.

Pick the Execute button to process the query. The Mark Screen Entities option will set the color of entities with GIS data that match the query to the specified color. The Build Selection Set option creates a selection set of the entities that pass the query. To use this selection set in other commands, enter "P" for previous at the "Select objects:" prompt. With the Generate Report option, the program will bring up the Report Formatter which allows you to choose the fields to include in the report and the report format. If the Highlight Screen Entities option is on, then the program will highlight the entities with GIS data that pass the query. Point entities are highlighted by drawing
a box around the point and polylines are highlighted by solid fill. Shown here is the report for all manholes with a Condition of Good.

Pulldown Menu Location: GIS Data  
Keyboard Command: gis_query  
Prerequisite: MDB file with data or entities with linked GIS information

**Label GIS Polyline: Closed Polyline Image**

This command draws images inside the selected closed polylines with attached GIS image files. Images can be assigned to polylines by the Input-Edit GIS Data command.

The program starts by selecting closed polylines in the drawing with GIS data. Then a dialog appears for specifying the image to draw. This dialog displays a list of all the GIS table names found in the selected polylines. First choose a table to process. Then the image fields defined for this table are displayed in the lower list. Only one image can be draw inside the polyline. The Erase Images button will erase any existing images inside the selected polylines. The settings can be saved to and recalled from a GIS settings file (.gsf) using the Save and Load buttons. Once all the settings are ready, pick the Draw button to draw the images. The images are drawn in the centroid of the polylines.
**Example of images drawn inside closed polylines**

**Pulldown Menu Location:** GIS Data > Label GIS Data  
**Keyboard Command:** display_polygon_image  
**Prerequisite:** Closed polylines with linked GIS images
Label GIS Polyline: Closed Polyline Data

This command draws text labels for the specified fields inside the selected closed polylines with attached GIS data. The program starts by selecting closed polylines in the drawing with GIS data. Then a dialog appears for specifying the fields to label. This dialog displays a list in the upper left of all the table names found in the selected polylines. First choose a table to process. Then the fields defined for this table are displayed in the lower left list. To add a field to the label, highlight the field name and pick the > button. The fields names in the lower right list are the fields to be labeled in order. Use the Up and Down buttons to change the field order. The Erase Labels option will erase any existing field labels inside the selected polylines. The settings can be saved to and recalled from a GIS settings file (.GSF) using the Save and Load buttons. Once all the settings are ready, pick the Draw button to create the labels. The labels are drawn center justified in the centroid of the polylines.

Pulldown Menu Location: GIS Data > Label GIS Data
Keyboard Command: display_polygon_image
Prerequisite: Closed polylines with linked GIS information

Label GIS Polyline: Open Polyline Data

This command draws text labels for the specified fields along the selected polylines with attached GIS data. The program starts by selecting polylines in the drawing with GIS data. Then a dialog appears for specifying the fields to label. This dialog displays a list of all the table names found in the selected polylines. To label a field, highlight the field from the Available Fields list and pick the > button. Then use the Up/Down buttons to order the fields in the Used Fields list. The Erase Labels option will erase any existing field labels for the selected polylines. The settings can be saved to and recalled from a GIS settings file (.GSF) using the Save and Load buttons. Once all the settings are ready, pick the Draw button to create the labels. The labels are drawn along the polylines, and it is optional to label on all segments, maximum length segment or at interval. Also, it is optional to let the user pick label location for each polylines.

Use the Label Setup button to set parameters for the label in the used box.
Create Links

This command makes GIS links between blocks in the drawing and a database table using a key field that is in both the block attributes and the database table. Both the block entities and database records must exist before running this routine.

The routine starts by prompting you to select the block entities to process. Then a dialog appears for choosing the block attribute and table to link. The current template and output database file names are shown at the top of the dialog. Use the GIS Database Settings command to set these file names before running Create GIS Links. The dialog lists all the block names that were found in the entity selection. Choose a block name to process. Then in the lower left of the dialog, there is a list of the attributes for the selected block. Highlight the attribute name that contains the point ID key field for the blocks and then pick the Select First Key Value button. For each block entity, the program will use the value of this attribute to link to the record in database table. This value is matched to the database record using the PT_ID database table field. For example, a block with an attribute value of 402 for the specified attribute name will be linked to the database record with a value of 402 in the PT_ID field.

Next, the database table needs to be specified to either one fixed table name or to table names defined by a block attribute. A list of the available tables in the current output database is displayed. To link all the blocks to one table, highlight the table name from the list and pick the Select Second Key button. Or to link the blocks to various table names based on a block attribute, highlight the attribute name and pick the Select Second Key button. This attribute value for the blocks will then need to contain the database table name. For example, consider a block for electric utility data with two attributes: ID and TABLE. The ID is a number to use as the first key and the TABLE is the table name (i.e. POLE, BOX). Once the key fields are set, pick the OK button to create the links.
Erase Links

This command removes all the GIS links from the selected entities (polylines, blocks, etc.).

Pulldown Menu Location: GIS Data
Keyboard Command: erase_links
Prerequisite: Entities with GIS links

Audit Links

This command checks the GIS links for the selected entities in the drawing to make sure that the template database, output database and table exist. Any invalid links can be erased from the entities or be fixed by selecting another database or table. For example if a database file (.mdb) has moved to another directory, then you can use this command to specify the new location.

The routine starts by prompting you to select the entities to check. If no errors are found, then the routine is done. When there are errors, a dialog box appears. Each GIS link is defined by a template database, output database and table. For each combination of these three settings that have an error, this dialog displays the template database, output database and table name from the entities. The number of GIS link combinations with errors is shown in Table Used for Links field (i.e. 1 of 2). The template database is shown at the top. If the template database link is broken, then use the Select New Template MDB button to assign another template database file. The output database also has a Select New Output MDB to set the output database file. In the lower left of the dialog is a list of the table names from the output database. You can choose the table to use for the link from this list. The Fix Links for Current Table button will assign the template database, output database and table name from the dialog to all the selected entities. The Erase Links from Table button will remove these broken links from the entities. The Go to Other Table button will process the next GIS link combination with errors.
Pulldown Menu Location: GIS Data
Keyboard Command: audit_links
Prerequisite: Entities with GIS links

Import SHP File

The Import SHP File command converts ESRI SHP files into Carlson drawing entities and can also optionally write the available attribute data to an external Access MDB file and create GIS links between the drawing entities and the records in the database. Use the Geometry with GIS Data Import Option to accomplish this. Use the Geometry Only Import Option to just draw the linework. If you don't need the data, this option is much faster.

The Import SHP File dialog displays the Output MDB file to add data to and the source SHP file to be imported. SHP files are similar to entities in one layer in CAD. You must specify the table name to store the data in the MDB database and the layer name for the entities to be created. Typically these names are the same or near equivalent as the SHP file name. Once these names are entered, the Import Polylines from SHP button becomes available. Pick this button to import the SHP files entities and database. You can also assign elevations by a specified data attribute.

There are primarily three types of ESRI SHP files: Points, Arcs and Polygons. Each will provide different options on Import. Once the SHP file is selected, Carlson detects the data contents of the file and sets the dialog options for importing either polygons, arcs or points. Carlson GIS also supports the use of three other types of SHP files: PointM, PolylineM and PolygonM.

Both Arc and Polygon SHP files are brought into Carlson as polylines in the drawing, with attribute data stored in an external Access .MDB database file if that option is selected.

Point SHP files are imported in a three step process. The first step uses the Import SHP File command to create a coordinate file (.crd) for the points in the SHP file and a corresponding table in the output MDB file for the points database. The second is to use Draw Locate Points to draw the points from the CRD file into the drawing. The third step uses Create Links to select the points in the drawing and link the database to these plotted points.
Note: If the SHP file you are Importing is in a different Projection or Units than that specified in the Drawing Setup, then a transformation will occur during Import, as long as the (.PRJ) Projection file is present with the SHP set of files. If there is no (.PRJ) file with the SHP, then no transformations will occur.

Pulldown Menu Location: GIS Data
Keyboard Command: import_shp
Export SHP File

This command creates a SHP file from the selected entities in the drawing. After selecting entities to be converted, a dialog shows the number of Points, Polylines (Arcs) and Closed Polylines (Polygons) found in the drawing selection set. Those Points, Arcs and Polygons with database information linked are displayed with their database table names. Any Points, Arcs and Polygons without linked database information display as unknown. The Coordinate System setting chooses between creating a SHP file using the northings/eastings from the drawing or using lat/lon by converting the drawing coordinates to lat/lon with the projection parameters from Drawing Setup.

Highlight the Point, Arc and Polygon tables to output or selects Export All to select all entities including the UNKNOWN entities to export into SHP files. The Export SHP File commands outputs all entities selected into SHP files with the same name as their table name into a subdirectory selected. Also Points can be stored in the ESRI Arcview database as 3D X, Y and Z coordinates when Include Z Coordinates is toggled on. SHP files do not have arc entities. So the export routine will convert arcs and polyline arcs into a series of small chords segments. The Offset Cutoff field sets the maximum horizontal shift allowed between the original arc and the chord segments.

These SHP files can be imported into ESRI’s Arcview product. Database GIS links in Carlson are converted to SHP files by storing the GIS database information into DBF files for ESRI’s Arcview product to read and link to.

Prompts

Specify Name for SHP File dialog select .SHP file name
Select objects select entities
Export Carlson Entities to SHP File dialog choose settings, click OK

Pulldown Menu Location: GIS Data
Keyboard Command: export_shp
Prerequisite: None

Export DWG File with Esri MSC

This command is used to create a new drawing file that contains Esri MSC Feature data.
The drawing is scanned for MSC data and further, which are new entities with MSC, which are entities with edited geometry, and which are entities with edited attributes. The user specifies which are to be included in the new drawing file. On OK, a new drawing file name is specified.

The drawing is scanned for MSC data and the list is populated with represented Feature Classes. You can select which ones to include in the Export (Export Yes/No column). The check boxes at the bottom allow you to choose whether to Export the unmodified entities for the selected Features, new entities, entities with CAD edits, such as Trim, Extend, Move, etc, and entities with edited attributes. On OK, a new drawing file name is specified. There is also a Report function to review the changes and to make a record of these transactions.

One possible application of this command is to create a DWG from ArcGIS with its Export to CAD tool, open the drawing in Carlson and edit it, and then use this command to send the edits back to ArcGIS as a new DWG with MSC.

**Pulldown Menu Location:** GIS Data  
**Keyboard Command:** export_msd  
**Prerequisite:** drawing with MSC

---

**Import GIS Data from SurvCE**

This command reads GIS attribute data collected and imports it into the drawing and embeds it within the point blocks in the drawing as Esri MSC that can be read directly by ArcGIS. There are two import methods for SurvCE and TDS. With SurvCE, the setup is to have a coordinate file (.CRD) set current, the points drawn in the drawing, an applicable attribute definition file (.GIS), and a file that is storing the attribute values (.VTT), that was created by SurvCE. You are prompted to pick the GIS file, and then the data from the VTT is imported and embedded within the matching point blocks in the drawing. With TDS, the process is the same except that the attribute data comes from a TDS .RW5 or .RAW file instead of a .VTT.

**Pulldown Menu Location:** GIS Data  
**Keyboard Command:** survce2msd, tds_gis  
**Prerequisite:** GIS file, CRD file, VTT file, or TDS .RW5/.RAW, and points in drawing
Export GIS Data to SurvCE

This command is used to set up a SurvCE Feature Code Library (.FCL) with attributes from points in a drawing with Esri MSC data.

In this dialog box, the coordinate file is specified, as well as the Field to Finish file being used. The name of the SurvCE FCL file is then specified. Picking OK prompts the user to select the points in the drawing with Esri MSC data.

**Pulldown Menu Location:** GIS Data

**Keyboard Command:** msd2survce

**Prerequisite:** CRD file, FLD file, points in drawing with MSC

### Image Inspector

This command views images and documents attached to entities. At the start, there's a prompt for inspecting on the screen or in a dialog. For Screen, the program highlights all entities that have attached images or documents. When you move the cursor over these entities, the attached image or document name is displayed in a window. If you click within the image window, the program will start the image application editor that is setup for your system. For documents, click on the document name to start the document application. This application, such as Microsoft Internet Explorer, depends on your Windows system setup. Also while moving the cursor over drawing entities, you can use the up/down arrows to resize the image. When multiple images or documents are attached to the same entity, use the left/right arrows to cycle through the images.

For the Dialog method, the dialog shows a list of all the images/documents found in the drawing. When the image is highlighted in the list, the dialog shows a graphic preview. You can use the Zoom buttons to zoom the drawing to the highlighted image. The Report function makes a report of all the images in the drawing.

### Prompts

**Inspector view [Screen]/[Dialog]?** press Enter for Screen

**Arrow keys Up/Down=Image Size; Left/Right=Cycle Images; Pick Image=Open Image**

**Move pointer over entity with image (Enter to End):** press Enter
Car image displays in upper-left of drawing when cursor is over car symbol

**Inspector view** [Screen>/Dialog]? *D for Dialog*

**Pull down Menu Location:** Images
**Keyboard Command:** view_image
**Prerequisite:** drawing entity with attached image or document
Place Camera Symbol/Image

Prompts

Image File To Process: choose .TIF file

Pulldown Menu Location: GIS Tools
Keyboard Command: maketfw
Prerequisite: TIF image file

Attach Image to Entity

This command attaches image and document files to a drawing entity. The possible file formats are .pdf, .doc, .bmp, .jpg and .gif. Any type of drawing entity can be used such as polyline, points or symbols. To run the command, first pick an entity on the screen. Then a dialog appears for selecting the image or document. First set the image directory and then highlight the file name. A graphic of the image should appear in the preview window. Then click Attach Selected Image/Doc.

The Capture New Image button can be used to trigger an attached digital camera to take an image. The Pick Camera and Set Camera buttons can be used to configure the camera to use.

Multiple images or documents can be attached to the entity by picking Attach Selected Image/Doc or Capture New Image multiple times. To cycle the images in the preview, use the Next and Prev buttons. Use the Remove Attached Image to remove the image shown in the preview. Use Remove All Attached Images to clear all images from the entity.

The View Attached Image/Doc button will display in the preview window any image already attached to the entity instead of the selected image file. Also any image already attached to the selected entity is displayed in the Current Image field at the top of the dialog when nothing is selected in the file list.

Prompts

Select object to attach symbol to: pick an entity
Attach Image to Object Dialog
Done.
Select object to attach symbol to: press Enter
Pulldown Menu Location: Images
Keyboard Command: set_image
Prerequisite: A drawing entity and an image or document file

Import MrSID Images

This command allows you to select one or more image files in the MrSID format (.SID) and have them converted to either a (.TIF) or (.JPG) file format. Corresponding World files are also created. The new image files use the same file name and folder of the original MrSID image files except with the new file extension of .jpg or .tif. This conversion supports up to MG4 (Generation 4) MrSID files.
**Place Image by World File**

This routine is intended for users of Carlson products that do not have the AutoCAD Map platform. If you have the Map extension available, it is recommended that you use the tool provided.

This function allows you to insert Geo-Referenced TIF files into the drawings. This process requires the presence of an accompanying TFW file. The TFW file contains information about the location and scaling of the actual raster image TIF file. This eliminates the guesswork in inserting, moving, and rotating raster images to the project area. You begin by selecting the TFW or JGW file to process. If the related TIF file is present in the same directory, the image will be inserted into the proper coordinates.

**Prompts**

Select World File: *choose existing .TFW or .JGW file*

**Database File Utilities**

This command is designed to import GIS data from SurvCE, GISCE and FAST Survey files, as well as from user-defined text/ASCII file fields. It also exports data from Carlson Note files (.NOT or .VTT) to Microsoft® Access (.MDB) database tables. The .NOT extension is used when data transfers from desktop. The .VTT extension files are data transfers from data collector.
Note files are associated with Coordinate files (.CRD) and contain additional data for point numbers. For example, the Coordinate file for a manhole point could contain the point number, northing, easting, elevation and 32 character description, while the corresponding note file for that point contains additional data on the manhole such as diameter, depth, condition, etc.. A Carlson Note file for a Coordinate file will have the same name as the Coordinate file, except with a .NOT or .VTT extension instead of the .CRD extension (e.g. PARK.NOT goes with PARK.CRD). The Carlson Note file is a text file which consists of a point number (PT_ID) followed by field names with values. This group of point number and fields can also have a GIS_FILE name, which is used to identify this group of fields. This GIS_FILE name comes from the Note file prompting definition file (.GIS), which defines the field names for the group and is created in the Define Note File Prompts command.

You can select the Note file to process by using the Import Note File button. The program will then list all the GIS_FILE names that were found in the Note file. If a set of data for point number does not have a GIS_FILE name, then this group will appear in the list as UNKNOWN.

The name of the Microsoft® Access database to add the data to is the output database file, listed at the top-left of the Database File Utilities dialog. You can change the output database by using the Open Database button and selecting an existing database, or by clicking New Database to create a new database. The database tables will automatically have the same name as the GIS_FILE. This dialog also allows you to preview and edit a spreadsheet editor, which in turn allows you to modify values in the table. Each set of note file data for a point is displayed on one row with the corresponding record from the database shown on the next row. You can export the Note file data and create a new Access database .MDB file, in Access '97 format or in Access 2000 format, by doing a SAVEAS into .MDB format. You can rename and delete a table as well.

Database File Utilities can be combined with the Create Links command to make GIS links between the point entities in the drawing and the Microsoft® Access database records. The point entities can be drawn with the Draw/Locate Points or Field to Finish commands.

**Initial dialog at start of command with primary functions**

Available Table from Output Database: Selection list. Pick a table from the Output Database.
Import Note File: Imports a Carlson Note File (.NOT).
Import ASCII File: Imports ASCII file.
Preview/Edit Table: Displays a spreadsheet editor, allowing you to preview/edit values from table.
Rename Table: For renaming a table as needed.
Delete Table: For deleting a table as needed.
Current Table: Displays the selected table from above list.
Dialog seen after choosing Import ASCII File and selecting file name

**Pulldown Menu Location:** GIS Data

**Keyboard Command:** noteutil

**Prerequisite:** A note file (.NOT from desktop or .VTT from data collector)
CGFile

Current Information

The Current Information Dialog Box contains information on:
Drawing: displays the current drawing file Path, Name, Scale, and Units
Coordinate File: displays the current coordinate file path and names.

File Type: This will display the current Coordinate file type.
The file types are:
C&G Numeric (.CRD) (PT #: 126)
C&G Alpha-Numeric (.CGC) (PT #: RW126)
Carlson Numeric (.CRD) (PT #: 126)
Carlson Alpha-Numeric (.CRD) (PT #: RW126)

Description Length: Numbers of character in the description
Total Points: Total number of points in the file
High Point: The highest point number stored
Points Used and Points Available: displays the block or blocks of points used or available in the coordinate file currently open.
Other Files: Displays the files that are currently open:
Data Path: displays the current default path and coordinate file name
Description Table: displays the current default path and description table
Print: displays the current default path and Print file name
Raw: displays the current default path and RAW file name
Map Check: displays the current default path and Map Check file name
Cross Section: displays the current default path and Cross Section file name
TIN: displays the current default path and TIN file name

Pulldown menu Location: CG-Survey > File
Keyboard Command: INF, cg_current_info
Coordinate Files

Opening Closing and Saving

Choose Coordinate Files from the CGFile pull-down menu.

![Coordinate File Menu]

New

The New allows you to create a new coordinate file.

Prompts

Follow these steps: CGFile > Coordinate Files > New Coordinate File
Save in: Browse to folder location

Enter the name of the coordinate file you wish to create: File Name: Hickory farms

Press enter or press Save Button

NOTE: The directory displayed is the Data Path is the directory as set from the tool bar:
CG-Tools > CG Options > Data Path Options

NOTE: The description length for the new file just created will be set based on the current description length setting in the:
CG-Tools > CG Options > General

NOTE: You will not be able to change the description length once the new file is created. You must set the description length prior to creating the new file. You can however move the points to another file that has a longer description length

Pulldown Menu Location: CG-Survey > File > Coordinate Files
Keyboard Command: OPNC, CG_NEW_COORD
Prerequisite: None

Open
The Open menu item allows you to open an existing .CRD or .CGC file. Only one coordinate file can be open at a time in a given drawing.

Prompts
To open an existing coordinate file follow these steps:

In the file dialog box (Shown below),
Browse to folder location
select or Highlight the coordinate file you wish to open by clicking on it
Click the Open button

NOTE: The default directory is the "Data" directory below the directory where CG-SURVEY was installed. You can change the default directory by choosing:
CG-Survey > Tools > CG Options... - Data Path tab.

**Pulldown Menu Location:** CG-Survey > File > Coordinate Files
**Keyboard Command:** OPC, CG_OPENCOORD
**Prerequisite:** an existing coordinate file

**Close**
To close an open coordinate file

**Pulldown Menu Location:** CG-Survey > File > Coordinate Files
**Keyboard Command:** OPC, CG_OPENCOORD
**Prerequisite:** Coordinate File Open

**Save As**
As new points are stored in a coordinate file, the file is automatically updated. If you are concerned that the changes to be made to the coordinate file may not be correct, you should use the Save As option to make an extra copy of the file before making any changes. This option allows you to save the open coordinate file under a different name. The new file becomes the current file. The original file will remain unchanged.

**Prompts**
To Save As the open coordinate file under a new name, select: > CGFile > Coordinate File > Save As

Browse to Folder Location: The Save Coordinate File As dialog box will display the default directory as set in the Data Path Options,

Enter the name: of the new file for the coordinates to be saved to.

Press Save Button: Save or Press enter

Pulldown Menu Location: CG-Survey > File > Coordinate Files

Keyboard Command: SCF, CG_FILE_SAVEAS

Prerequisite: None

Export Coordinates to ASCII

This menu item allows you to export coordinate files to an ASCII (American Standard Code for Information Interchange) file format. ASCII files are a simple text format and can be read by almost all word processors and text editors.

Prompts

To export coordinates to an ASCII file, follow these steps: > CGFile > Coordinate File > Export Coordinates to ASCII File
If a coordinate file is not currently open, the Open Coordinate File dialogue box will appear, select the file.

You will be prompted at the command line to select the points you wish to export:
Add points from coordinate file. (Enter When Done) (All/Block/Code/Desc/Elev/ Pt-group/Limits/Radius/Select):
After choosing the set or sets of points you wish to export, press until the following dialogue box appears.
Enter a new file name or select an existing ASCII file and click the Save button. Next, select an ASCII file format (see the ASCII File Formats section of this chapter for an explanation of each format):

Select the OK button to export your coordinate points.

**ASCII FILE CONVERSION FORMATS**

NOTE: In the following formats the point code can be placed in the first two characters of the description field, followed by a semicolon. The description will follow the semicolon. You can export and import ASCII files in the following formats:

- **STANDARD (Point #, North, East, Elevation,"Desc")**
  2,5054.76393,9777.75761,103.70000,"gs"
  3,5098.69743,9783.82411,105.20000,"gs"
  4,5158.78043,9773.74111,105.67000,"gs"
  5,5205.11493,9777.40661,106.25000,"gs"

- **CLM (PNT Point # Easting Northing)**
  PNT 2 9777.75761 5054.76393
  PNT 3 9783.82411 5098.69743
  PNT 4 9773.74111 5158.78043
  PNT 5 9777.40661 5205.11493

- **Autocogo (Point # Easting Northing Elevation Desc)**

*Chapter 18. CGSurvey Module* 1174
MTI (Point #, Easting, Northing, Elevation,"Desc")
2,9777.75761,5054.76393,103.70000,"gs"
3,9783.82411,5098.69743,105.20000,"gs"
4,9773.74111,5158.78043,105.67000,"gs"
5,9777.40661,5205.11493,106.25000,"gs"

Standard (without description quotes) (Point #, North, East, Elevation, Desc)
2,5054.76393,9777.75761,103.70000,gs
3,5098.69743,9783.82411,105.20000,gs
4,5158.78043,9773.74111,105.67000,gs
5,5205.11493,9777.40661,106.25000,gs

Abacus/MTI (Point #, Northing, Easting, Elevation)
2,5054.76393,9777.75761,103.70000,"12;gs"
3,5098.69743,9783.82411,105.20000,"12;gs"
4,5158.78043,9773.74111,105.67000,"12;gs"
5,5205.11493,9777.40661,106.25000,"12;gs"

Surv-A-Soft (Code Northing Easting: Desc/Elevation")
6 0 "VER 2"
-1 0.00000 0.00000 " "
2 5054.76393 9777.75761 "103.70000"
2 5098.69743 9783.82411 "105.20000"
2 5158.78043 9773.74111 "105.67000"
2 5205.11493 9777.40661 "106.25000"
2 5253.39243 9779.12911 "110.47000"

The Surv-A-Soft file structure is as follows:
The first line of the file is a header line with the following information:
The total number of points is placed in the code field.
Zero (0) is placed in the northing field.
"VER 2", etc. is placed in the easting field.

After the header line each line specifies a coordinate point. The line number minus one is the point number.
The code field has three possible values:

Value Explanation
-1 no coordinate point
2 elevation (in description field)
1 description (in the description field)

Since .CRD and .CGC files can have both an elevation and description, when converting them to an ASCII
Surv-A-Soft file one of the following will occur depending on the elevation value:

If the point has an elevation it will be placed in the description field. If there is no elevation, the description
will be placed in the description field.

Star+Net (Point # Northing Easting Elevation Desc)
2 5054.76393 9777.75761 103.70000, gs
USER DEFINED

Upon selecting User Defined format, the following dialog box will appear:

As the name implies you can create a format specific to your conversion needs.

Creating a User Defined Format: There are 5 basic pieces of information that can be defined in a user defined format. Point number Northing (required) Easting (required) Elevation Description (Code can also be part of the description field) There are two types of user defined formats " Character Separated Fields Character Separated Fields means that each field of information is separated by a character, often times a comma, but any ASCII character can be used. Fixed length Fields Fixed length fields means that you define the number characters for each field item. The fields can be in any order

Field Order
Point Number 4
North 3 (required)
East 2 (required)
Elevation 1
Description 5

NOTE: Coordinate values will be rounded based on the setting in the Rounding Options dialog box.
If the point number field is not assigned a value, the line number will be the point number. Select the Field Type (Character Separated or Fixed Length) and follow the appropriate instructions below:
Character Separated User Define Export File

>Go to CGFile >Select Coordinate files >Select Export to ASCII At the command line you will be prompted to select points:

Add points from coordinate file. (Enter when Done) (All/Block/Code/Desc/Elev/ Pt-group/Limits/Radius/Select):
After selecting the point set or sets to export press return

Select or name the file to store the converted points.

Set the conversion format to "User Defined Format" The following dialog box allows you to define the attributes of the points being converted.
For this example Character Separated Fields has been chosen as the Field Type.
Points......... -> 1
North.......... -> 2
East........... -> 3
Elevation..... -> 4
Description -> 5
So the line data will be: Point #, North, East, Elevation, Description

**Empty Field Values:** It's necessary to distinguish between a field that has no value and a field that has "0" as a value. In coastal areas "0" is a valued elevation and in some cases "0" could actually be a coordinate value. By defining empty field values with a value that cannot be misunderstood for a valid value, a conversion process will not produce invalid data.

**Character Values:**

1st & 2nd Field Separators, these are the ASCII characters that define the fields within a line.
1st & 2nd Line Terminator; these are the ASCII characters that define separate lines
Description Markers; An ASCII character that surrounds the description such as quotation marks.
Code Separator; Allows you to designate the ASCII character that separates the Code information from the Description information. In the example above the Character values are set as follows:

- 1st Field Separator: 44 (which is a comma)
- 2nd Field Separator: -1 (none used)
- 1st Line Terminator: 13 (carriage return)
- 2nd Line Terminator: 10 (line feed)
- Description Marker: -1 (none used) Code Separator: -1 (none used)

This example would read as follows: 1,5000.0000,10000.0000,954.63,MH
The following is a list of all of the ASCII codes and the respective values.
2nd Field Separator: You may however define two separators. For example, you can use a carriage return and line feed if you wish to have each field on its own line: 1 <CR> <LF> (Point number)
1000.000 <CR> <LF> (Northing)
1000.000 <CR> <LF> (Easting)
954.56 <CR> <LF> (Elevation)
MH <CR> <CF> (Description)

NOTE: Do not use a character as a separator if it appears in any of the fields. For example, if your record looks like this:
1 1000.000 1000.000 954.56 MH <CR><LF>

Then the period (.) character cannot be used as a separator because it is used in the northing, easting and elevation fields. Pressing the View ASCII Codes button will show you the 256 valid characters that can be used in an ASCII file. The table shows each character, with its integer value to the left of it.

NOTE: Character number 26 cannot be used as a field separate because it marks the End of File (EOF).

Fixed Length Field User Define Export File:

> Go to CGFile > Select Coordinate files
> Select Export to ASCII Select points. (Enter When Done) (All/Block/Code/Desc/Elev/ Pt-group/Limits/Radius/Select):

At the command line you will be prompted to Select Points After selecting the point set or sets to export press return Select or name the file to store the converted points.

Chapter 18. CGSurvey Module
Set the conversion format to "User Defined Format"

The dialog box below allows you to define the attributes of the points being converted.

For this example Fixed Length Fields has been chosen. In this case the order is set at:
Points......... - > 1  
North......... - > 2  
East........... - > 3  
Elevation..... - > 4  
Description - > 5

So the line data will be:

**Point #** - North-East-Elevation-Description But unlike Character Separated Fields, the information sets will be defined by their placement on the text line, rather than a separating character.

**Empty Field Values:** It is necessary to distinguish between a field that has no value and a field that has "0" as a value. In many cases around coast lines "0" is a contour elevation and in some cases "0" could actually be a coordinate value. By defining empty field values with a value that cannot be miss-understood for a valid value, any conversion process will not produce questionable data.

**Character Values:** 1st & 2nd Field Separators, do not apply, separators are defined by spacing. 
1st & 2nd Line Terminator; do not apply, separators are defined by spacing. 
Description Markers; An ASCII character that surrounds the description such as quotation marks. 
Code Separator; Allows you to designate the ASCII character that separates the Code information from the Description information. In the example above the Character values are set as follows:
1st Field Separator: Do not apply  
2nd Field Separator: Do not apply  
1st Line Terminator: 13 (carriage return)  
2nd line Terminator: 10 (line feed)  
Description Marker: -1 (none used)  
Code Separator: -1 (none used)

This example would read as follows: 
1 5000.0000 10000.0000 954.63 MH <CR> <LF>

The first 8 spaces are the reserved for the point number The next 16 are reserved for the northing The next 16 are reserved for the easting The next 16 are reserved for the elevation The next 20 are reserved for the description Then a (carriage return) and a (line feed)

**The following is a list of all of the ASCII codes and the respective values.**
NOTE: Do not use a character as a separator if it appears in any of the fields.

**Description Markers:** If you have a description field, you may wish to use a Description Marker. This is a character that surrounds the description. For example, a description surrounded by quotes: 23,1056.789,2345.769,982.345,"MH" <CR> <LF>

If you are not using a description marker, enter -1 in the Description Marker box

**Code Separator:** If you have a description field, and want the first characters of the description field to be a C&G point code, you can enter the decimal value of the character that separates the point code from the description. This allows you to transfer both the point code and the description to an ASCII file. For example, using a semicolon as a code separator: 23,1056.789,2345.769,982.345,"MH; Inv Elev -9.23" <CR> <LF>

If you are not using a code separator, enter -1 in the Code Separator box.

**No Northing Value and No Easting Value**

If the ASCII file does not have a point number field, the No Northing and No Easting values are mandatory. The record number will be used as the point number. This means that skipped point numbers will be filled with false northing, easting and elevation values.

Here is an example of a file with a record that has no point number field (assume you entered -999999 in the No Northing, No Easting and No Elevation boxes):

```
1056.789,2345.769,982.345,MH <CR> <LF> Point 1
-999999,-999999,-999999, <CR> <LF> No Point 2
2356.679,2455.645,992.678,MH <CR> <LF> Point 3
2786.799,5645.789,984.234,MH <CR> <LF> Point 4
```

**No Elevation Value** You must place a value in this box. When converting a C&G point to an ASCII point, this value will be placed in the elevation field of the ASCII point if a C&G point with "No Elevation" is encountered. When converting an ASCII point to a C&G point, if "No Elevation" is encountered in the ASCII point then "No Elevation" will be placed in the elevation field of the C&G Point.
Import ASCII File into Coordinates

This option allows you to import the contents of an ASCII file into a coordinate file.

Prompts

Follow these steps: > CGFile > Coordinate Files > Import ASCII File Into Coordinates

If a coordinate file is already open, the ASCII file will be imported into it, if a coordinate file is not open you will be prompted to open an existing file or create a new coordinate file.

Select the ASCII format that is being imported and how to handle duplicate points.
The points will be imported and displayed on the screen.

**Pulldown Menu Location:** CG-Survey > File > Coordinate Files  
**Keyboard Command:** IMC, CG_IMPORT_COORDS  
**Prerequisite:** None

---

**Close Raw File**

To close the current raw data file, select CGFile from the main menu and then select Close RAW File.

**Pulldown Menu Location:** CG-Survey > File  
**Keyboard Command:** CLR, CG_CLOSE_RAW  
**Prerequisite:** Raw File OPEN

---

**Close Map Check File**

To close the current map check file, select CGFile from the main menu and then select Close Map Check File.

**Pulldown Menu Location:** CG-Survey > File  
**Keyboard Command:** CLM, CG_CLOSE_MAP  
**Prerequisite:** Mapcheck file Open

---

**CGDos Drawings**

Before opening a CGDOS drawing you must choose the "setup" option to provide information needed for opening the PL!/PL2 files.
This feature allows you to import a CGDOS PL1/PL2 file and convert it to a standard CAD drawing. This is similar to a DXF conversion, but in addition to simple converting the graphics, this feature also retains the C&G data. That means that after the conversion is finished the drawing file is still referenced to the coordinate file. If you query a line it tells you what coordinate file the graphic was created from, the points that line is drawn from, the layer and line stop information just like query did in the CGDOS. This means you can continue working on the job after the conversion in a manner that is familiar to you as it was in CGDOS.

**Pulldown Menu Location:** CG-Survey > File  
**Keyboard Command:** None  
**Prerequisite:** CGDos Drawings>Setup

## Open Dos Drawing

If the current drawing file you are in has any graphics the following dialog box will appear. This is meant to prevent you accidentally placing the PL1 drawing on top of another existing drawing file.

![CGSurvey dialog box](image)

Selecting will bring up the following dialog box that will allow you to select the PL1 file to be converted to a standard CAD drawing.

![Open a CG-SURVEY for DOS PL1 file dialog box](image)
After selecting the file to be converted, if you look at the command line you will see that the program is going through the PL1 file and converting the drawing entities one at a time to make them conform to the C&G format. This means all of the C&G data is maintained so the new drawing is still linked to the coordinate file it was created from. Also during this conversion process any of the CGDOS *.INS files (inserts) will be converted to standard CAD blocks and be added to the CG list of available inserts. Meaning all of the inserts you were accustomed to using in the CGDOS product will now be a part of the CG Survey program.

**Prompts**

Select a *.PL1 drawing file from browse file dialog box: Select file & click on OPEN button

Pulldown Menu Location: CG-Survey > File

Keyboard Command: None

Prerequisite: CG-Survey > File > CGDos Drawings>Setup completed properly

**Setup DOS Dwg**

The first dialog asks you to give the path to the CGDOS Program Files and the path to CGDOS Inserts.

When this is set properly, any Insert used in the DOS PL1 file will be converted to a block and stored in the C&G symbols folder: These inserts will also be listed in the insert library when you go to: CGDraw > Drawing Settings > Active Symbol NOTE: Currently those inserts converted from the CGDOS PL1 files will not be shown graphically in the CGSurvey Active Point Symbol dialog box but they will appear in the symbols list and thus can be selected for use from the list.

**Prompts**

Select a Location for CGsurvey Program from browse file dialog box: Pick Browse button

Select a Location for Insert files from browse file dialog box: Pick Browse button

Pulldown Menu Location: CG-Survey > File

Keyboard Command: None

Prerequisite: None
Convert Old CG Dos Level File to New Format

This option converts old C&G DOS level files (files with a .LEV extension) to the new CGSurvey level file format (files with a .LEV extension).

Prompts

Select CGFile from the main menu.
Select Convert Old C&G DOS Level File to new Format from the pull-down menu.
From the file dialog box, select the file to convert:
Click the OPEN button to convert the file.

Pulldown Menu Location: CG-Survey > File
Keyboard Command: CVL, CG_CONVERT_DOS_LEVEL_FILE
Prerequisite: None

Convert Old CG Dos Raw File to New Format

This option converts old C&G DOS raw files (files with a .RAW extension) to the new CGSurvey raw file format (files with a .CGR extension).

Prompts

Select CGFile from the menu bar.
Select Convert old C&G Raw File to new format from the pull-down menu.
From the file dialogue box, select the file to convert:
Click the OPEN button to convert the file.

Pulldown Menu Location: CGFILE
Keyboard Command: CVR, #CG_CONVERT_RAW
Prerequisite: None

Convert Old CG Dos Cross Section File to New Format

This option converts old C&G DOS Cross Section files (files with a .EW extension) to the new CGSurvey earthwork files format (files with a .CEW extension).

Prompts

Select CGFile from the menu bar.
Select Convert Old C&G Cross Section File to new format from the pull-down menu.
From the file dialog box, select the file to convert: Click the OPEN button to convert the file.

Pulldown Menu Location: CG-Survey > File
Keyboard Command: CVX, CG_EW_CONVERT_FILE
Prerequisite: None
Convert Old CG Dos Template File to New Format

This option converts old C&G DOS Template files (files with a .TPL extension) to the new CGSurvey earthwork files format (files with a .CTP extension).

Prompts

Select CGFile from the menu bar.
Select Convert Old C&G Cross Section File to new format from the pull-down menu.
From the file dialog box, select the file to convert:
Click the OPEN button to convert the file.

Pulldown Menu Location: CG-Survey > File
Keyboard Command: CVT, CG_EW_CONVERT_TEMPS
Prerequisite: None

Empty Print File

Choosing this menu item will remove all the text now in your print file.
You should empty the print file periodically so that it does not use too much of your disk space and become difficult to view and print.

Note: If user wishes to change the Printer.Txt file name or choose a different location. see CG-Survey > CG Options... - Output Tab

Pulldown menu Location: CG-Survey > File
Keyboard Command: EPF, cg_df
Prerequisite: Set print file name and path in CG-Survey > CG Options... - Output Tab

Print View Print File

While computations are taking place a Print File is being maintained showing all computations. This file is saved in the text file specified in the Output Options dialog box below

This text file may be edited, printed or viewed from any text editor or any word processor. (Note: For further explanation on Output Printing Settings please consult CGTools Menu)

After choosing the Print/View Print File menu item, the print file will be opened using the Windows text editor WordPad. To print the whole file, use the printer icon or the Print menu item on the WordPad File menu. To print a portion of the print file, you must highlight the portion you wish to print, then choose File > Print. On the General tab of the Print dialog box click the Selection radio button then click the Print button to print the highlighted text.
NOTE: Print Preview is also available on the WordPad File menu.

You can choose whether to use the Windows Notepad or Wordpad to view and print the print file by going to the CG-Survey > CG Options... menu and clicking the Output tab then clicking on either the Notepad or Wordpad radio buttons in the Print File Viewer section of the dialog (shown below).

Pulldown menu Location: CG-Survey > File

Keyboard Command: VPF, CG_VIEW_PRINT_FILE
Prerequisite: Set print file name and path in CG-Survey > CGOptions... - Output Tab

CGTrav

Quick Traverse

This feature allows you to utilize the keyboard and the mouse to perform a traverse using points and data found in the drawing and the coordinate file. There is no raw data entry associated with Quick Traverse. The Quick Traverse feature has no ability to adjust the resulting traverse. If you wish to adjust coordinates, you could create a raw data file using the CGEditor - on the CGTrav menu - then use the Reduce Traverse feature, also on the CGTrav menu.

NOTE: If you wish to check the closure of a plat from bearing and distance data, use the CGEditor to create a map check file, then use the Reduce Map Check File feature on the CGTrav menu.

Prompts

During the process of entering data for the Quick Traverse feature you will see the prompt:
[aZimuth/Bearing/Deflection/Side shot/curve/Closure/horiz. distanCes]

At this prompt you may:
Change the type of angular input between Horizontal Angle, Azimuth and Bearing modes at any time.
Change how distances are specified as either slope distance and vertical angle or horizontal distance and vertical distance.

Turn the vertical angle input on or off.
Traverse around tangent and non-tangent curves.
Switch from Traverse to Side shot mode.
Traverse mode: automatically occupy the foresight point.
Side shot mode: continue to occupy the current instrument point until you change to
Traverse mode: and thus occupy another point.

Note: There are several settings found in the C&G Options dialog box that should be set or checked prior using the Quick Traverse feature:

The default values for the initial traverse input modes are set in the Traverse Options.
If you wish to calculate or enter elevations, check the Elevations: ON checkbox and choose Enter Elev. Or Calculate Elev. as desired in the Global Options tab. If you are calculating elevations, make sure the Vertical Angles ON checkbox is checked on the Traverse Options tab.

**Quick Traverse Example**

In this example the mode is set to traverse and elevations are on and are to be calculated.

After choosing Quick Traverse from the CGTrav menu you will be asked to enter the following information:

**Instrument point:** for the example enter 1 (assuming that the currently open coordinate file has a point in it with a point ID of 1).

**Backsight point:** for the example enter 2.

[aZimuth/Bearing/Deflection/Side shot/cUrve/Closure/slope distaNces.]

Enter horizontal angle <0.0000>:

Since elevations are on and set to calculate so you will be prompted for the following:
If you selected H.I. as Plus-Up on the Traverse Options tab, the coordinates and elevation of the instrument point will be read from the file and you will be prompted for the instrument height (H.I).

If no elevation is found, you will be prompted to enter the ground elevation at the instrument point and then the H.I.

If you selected H.I. as Elevation in the Traverse Options dialog box, you will be asked to enter the actual elevation of the instrument scope.

**Backsight Point:** If you are turning angles or deflection angles instead you will be prompted for the backsight point.

**Rod Height:** With Calculate Elevations on you are prompted to enter the prism height.
You will be prompted for the horizontal angle (or deflection angle)

If you need to change the prism height <esc> and you will be prompted for a new prism height, if you <esc> again you will be prompted for a new instrument point.

**Angle data entry**

**Instrument point:** 1
**Back site:** 2
[aZimuth/Bearing/Deflection/Side shot/cUrve/Closure/slope distaNces.]

Enter horizontal angle <0.0000>:

When you are entering Quick Traverse data you have the options to change the angular input method. To change the angular input mode, enter the upper case letter seen in the prompt for the method of entry you want to change to and press <Enter>. The prompt should then change to reflect your choice.

Note: You need not use the shift and type a capital letter to choose a command line option. For example, to change to Side shot mode you can type either s or S.

The method that is currently set will not be shown as an option in the command line prompts. For example,
if you type s and <Enter> for Side shot mode, the prompt will change to include Traverse and Side shot will no longer be available since you have chosen it as the current mode.

**Traversing a curve**

The Traverse routine allows you to traverse both reverse and compound curves.

Note: You will not be allowed to traverse around a curve if calculate elevation is selected.

**If you type U and <Enter> for cUrve, the following dialog box appears:**

![CGSurvey for AutoCAD dialog box](image.png)

**Enter any two of the curve components.**

- **Identify the curve bearing as Chord if the angle, deflection, bearing or azimuth about to be entered is to the PT.**
- **Identify the curve bearing as Radius if the angle, deflection, bearing or azimuth about to be entered is to the radius point.**

Click the Clockwise box if the curve is clockwise. If this box is not checked, the curve is considered to be counterclockwise.

If there is a previous traverse leg, check the Tangent Curve checkbox if the curve is tangent to the previous leg. If this checkbox is not checked, the curve is assumed to be non-tangent.

**When you have entered the required data:** click the OK button.

The input multiplication factor is applied to the curve data you enter (radius, arc length, chord, etc.).

**At the next prompt,** if the curve is a non-tangent curve, enter the angle, deflection, bearing or azimuth from either the PC to the PT or the PC to the radius point (depending on whether you set Curve Bearing to Chord or Radius). If the curve is tangent to the previous traverse line you will not be asked for the angle and distance.

The curve data will be calculated and shown at the command line:

- Bearing and distance from the PC point to the radius point.
- Bearing and distance from the radius point to the PT point.
- Bearing and distance from the PC point to the PT point.

**Other curve information.**

The radius and PT points will be stored in coordinate file using the STORING POINT prompt.
Closure

At the prompt: aZimuth/Bearing/Deflection/Side shot/cUrve/Closure/slope distaNce.

Enter horizontal angle <0.0000>:

Type C and <Enter> to view closure information for the traverse to the current foresight.

Slope/Horizontal Distance Data Entry

If you have selected Slope Dist/Vert. Angle in the Traverse Options tab or switched to slope distances by typing N and <Enter> at the command line, enter the slope distance. Otherwise, enter the horizontal distance.

Note: The following steps are required only if Vertical Angles ON is checked on the Traverse Options tab or if Calculate Elev. was selected on the Global Settings tab.

For slope distance - vertical angle:

Enter the vertical angle.

Depending on the settings in the Traverse Options tab enter one of the following:
Zenith (zero up)
Nadir (zero down)
Transit (zero level)

Transit vertical angles can be full circle (0 - 360), or positive for up and negative for down.

For horizontal distance - vertical distance:

Enter the vertical distance.

Pulldown Menu Location: CGTrav

Keyboard Command: QTR, CG_QTRAV

Prerequisite: Open Coordinate File

Edit Raw File

The Edit Raw File feature allows you to use the CGEditor to create a new raw data file, append to an existing raw data file, or edit an existing raw data file. For further and complete information on using the Edit Raw File see the chapter on CGEditor in the Tools section.

CGEditor General Information

The CGEditor is an integral part of preparing files for use in C&G applications. The CGEditor is a very powerful tool. You can open multiple data files of any supported file type and edit the files as needed. The CGEditor has a full complement of tools for searching and replacing and navigating within a file. It will also allow you to cut or copy records from one file and paste them into another file in order to merge files, move data between phases of a job, etc.

The CGEditor can create and/or edit six types of data files used by C&G:

Raw Data Files

Raw data files contain information pertaining to a field traverse. Raw data files are typically downloaded from the data collector and converted to the C&G raw data file format. These files have the extension .CGR.
Map Check Files

Map Check files contain bearing, distance and curve information and are typically used to calculate the closure of a deed description. These files have the extension .CGM.

Cross Section Files

Cross Section files contain one or more cross sections identified by their station along the alignment. Each cross section record has the percent grade defined for its left and right slopes. Following the "Station" record are several "Point" records containing the elevations and offsets of the points along the cross section. Cross section files consist of a pair of files; the main data file has the extension .CEW and the index file has the extension .CEX.

Template Files

Template files are merely cross section files that represent a standard cross section and can be used to generate other cross section files. However, unlike cross section files, template files use an integer ID instead of a station to uniquely identify each template. Like cross section files, the percent grade is defined for the left and right slopes of each template and there are a set of "Point" records specifying the template elevation at a given offset. The centerline elevation at offset 0.00 is typically set to 0.00. Template files consist of a pair of files; the main data file has the extension .CTP and the index file has the extension .CTX.

Point Group Files

Point Group Files (formerly called batch point files) are simply a list of point numbers that can define a group of points, a lot/parcel of land, or an alignment. These are ASCII files and have a .PTS extension.

Coordinate Files

CGSurvey supports many different coordinate file formats:

C&G .CRD/.IDX - C&G numeric coordinate files
C&G .CGC/.CGX - C&G alpha-numeric coordinate files
Carlson .CRD - Carlson coordinate file format, numeric and alpha-numeric
Simplicity .ZAK - Simplicity coordinate file
LDT - MDB - Land Desk Top coordinate file

Pulldown Menu Location: CGTrav\Edit Raw File
Keyboard Command: ET, CG_EDIT_RAW
Prerequisite: Open Raw File

Data Collector Transfer

The Data Collector Transfer program allows transfer of data to and from the data collector. The program may also be used to convert raw data and coordinate files to the supported formats.

There are two variables that affect the interaction between your data collector and CGSurvey. One is the data collector itself and the other is the software you use in the data collector. This section provides information on the use of data collectors and software that will interact with CGSurvey.

NOTE: This manual is not a substitute for your data collector manual.
GENERAL INFORMATION ON USING DATA COLLECTORS

Before using the data collector program, make sure the correct data collector, communication port and communication parameters have been selected in the Settings dialog box.

![Image of Data Collector Transfer window]

**Direction of Transfer:**

Choose either "Data Collector to Computer" or "Computer to Data Collector".

**Data Collector and Computer Transfer Options**

**Instructions:** Press the STEP 1 button. Depending on the type data collector, type file and direction of transfer, this option will give you step by step directions on how to proceed.

The Transfer dialog is divided into two sections, left and right. The left part of the dialog box pertains to "Data Collect Options" such as file source, file format and the file being transferred. The right part of the dialog box pertains to the Desk Top "Computer Options". Below are instructions for setting both.

**Data Collector Options**

Pressing the triangle to the right of the edit box will bring up the list of data collectors to choose. From the list select the type of data collector being used.
Use Data Collector:

Check this box to transfer data to/from the data collector. You can also transfer to/from a file in the selected data collectors format.

Use Disk File:

Check this box if the data is in computer file. The data file must be formatted for the data collector selected.

File Name:

If you are importing from a file, or exporting to a file, or are connecting to a data collector that requires a file name for transfer, the File Name edit field will be active. To select the file path click on browse. In the file dialog box specify the path and file name of the file to be opened. select or enter the path and file name of the file desired file.

Transfer Coordinates with Raw:

Chapter 18. CGSurvey Module
Some field software allows unadjusted coordinates to be carried in the raw file as the field data is collected. This checkbox gives you the option to transfer this data or not. If you do not want approximate coordinates that were calculated in the field to be confused with control when processing the raw data, leave this box unchecked.

**Computer Options**

**File type:** Choose the file type you are transferring/convert ing. Example: Raw Data, Coordinate, ASCII, etc.

**File Format:** C&G will import and export several types of file formats for both Raw and Coordinate files.

Supported Raw Data File Formats:

- New CGR ......... *.cgr
- Old C&G .......... *.raw
- OBS ..................... *.obs
- Geolab ............... *.iob
- StarNet .............. *.dat
- SDR2x ................ *.dat
- SDR33 ................ *.dat

Supported Coordinate File Formats:

- C&G AlphaNumeric ......... *cgc / cgi
- C&G ...................... *crd / idx
- Carlson AlphaNumeric ....... *crd
- Carlson Numeric ............ *crd
- ASCII .................... *nez
- ASCII .................... *asc
- Geolab .................... *neo
- StarNet .................... *pts
- SDR2x .................... *.dat
- SDR33 .................... *.dat
- Simplicity ................ *zak
- LDT ....................... *.mdb

**Description Table:**

To use a description table check "Use Description Table" box.

You have the ability to use multiple description tables. Examples of that might be:
Each of these could have different codes and descriptions and this option would allow you to choose which description table to use for the reduction of this file. To change the description table click the "Browse" button and select the TBL file.

Below is an example of a description table:

![Description Table Example](image)

When using a description table, any INTEGER numbers in the description field of the data coming from the data collector will be replaced by the description in the table. For example, if your description is "13 5", the description put in the coordinate or raw data file will be "CL CMP".

**Transfer**

**Instructions**: The instructions window will guide you step by step through the transfer routine. It will tell you what to do on the data collector, and in what order.

**Transfer**: Once all of the settings are set correct, clicking on the TRANSFER button will begin the transfer between the data collector/file and the desktop.

The **Current Status** window at the bottom of the Transfer Dialog will indicate the status of the transfer.
Settings

At the bottom middle of the main screen is the "Settings" button. The settings control communications, data units and output data path.

Data Collector

The Data Collector dialog box allows you to select a short-list of data collectors you are transferring to and/or from.

When you select the down button to the right of the data collector shown and the "Show Defaults only" box is unchecked, you will see the complete list of all the data collectors that C&G interfaces with.
You also can create a Default List. This default list should consist of the various data collectors your company may have and/or interface with on a daily basis.

You can use the Show Defaults only check box to limit the data collectors which may be selected from the Data Collector list on the main Data Collector Transfer Screen. If this box is checked, only those data collectors you have specified for the default list will be show.

To add a data collector to the default data collector list:
First make sure the Show Defaults only box is unchecked. Next Select a data collector from the list by scrolling up and down the list using the arrow keys. When the new data collector is selected, make sure the communication parameters are correct to the data collector. Once the settings are correct, click Add DC button Now click the Save List to save the changes to the list.

When through setting all of the typical data collectors you may use, check the Show defaults only check box and only those instruments and settings will be displayed for your selection.

To remove a data collector from the default list:
Make sure the Show Defaults only is checked.
Highlight the data collector you which to remove from list
Click on the Remove DC
Click on the Save List button
Chose OK and verify that the data collector is no longer in the default listing.

Communications

The Communication box allows you to set the following parameters:
Port
Baud rate
Parity
Word length
Stop bits

When a data collector is selected, C&G reads a list of default settings and compares it to the settings currently shown. If the current settings are different than those recommended the defaults will be displayed and a Set Recommended button will be displayed. This allows you to automatically set the recommended communication parameters for your data collector.
The Measurement portion of the Settings dialog box pertains to the units of Raw and Coordinate data input.

Angle Mode........................... Degrees or Grads
Direction Mode....................... Bearing or Azimuth
Azimuth Direction................. North or South
Vertical Input...................... Zenith, Nadir or Horizontal
Distance......................... Foot or Meter
Foot Definition................ U.S. or International
Coordinate Position.............. North-East or East-North
Description Length.............. 1 to 100 characters

The Description Table portion of the Settings dialog allows you to select the default description table.

As mentioned earlier you can have multiple description tables, here is where you would select the description table to use.
The Use Description Table option, when checked , will replace any integer description found in the raw data file with corresponding description found on the description table. When this check box is not checked data will be transferred without translation.

Default Path for Output Files Allows you to set the default location for storing transferred files
Receiving Coordinates from Data Collectors:
There is a point protection feature in place when bringing coordinates into an existing coordinate file from a data collector. If the point already exists, and if the coordinate values are different, you will see the following dialog box.

You will have the following options:

**Overwrite:** overwrite existing point

**Do Not Overwrite:** skip point

**Overwrite, Do Not Ask Again:** Overwrite all existing points

**Do Not Overwrite, Do Not Ask again:** Bring in only new points

**Transfer Options**

Depending on the type of data collector that you are using, you will be able to perform some of the following functions:

- Receive raw data from the data collector or file.
- Send raw data to the data collector or file.
- Receive coordinates from the data collector or file.
- Send coordinates to the data collector or file.
- Send a program to the data collector.
- Execute a program on the data collector.
- Delete files on data collector
- View and/or Select files on data collector
- Format data area on the data collector

As data is received from a particular data collector or file, it is converted to a .CGR or .CRD file (or other supported format).

Data that is sent to the data collector is converted from the .CGR or .CRD format to the data collector format.

When data is received from a data collector, a read-only file in the data collectors native format is created and stored on the computer. If it is a raw data file, it has a .R$$ extension. If it is a coordinate file, it has a .C$$ extension.
When transferring coordinates to the data collector you may choose which points are to be transferred. The default is ALL points. When you click on the Select Points button the following dialog box comes up.

**Change file select from:** Click the file button to select the coordinate file that you want to transfer coordinates from.

**Choose Points:** This option allows you to select groups of points to be included from the file you have opened, using the C&G selection options.

**All Points:** All Points in the file will be selected.

**Block:** select blocks of Points.

**Desc:** select points by their description.
**Match Case:** Case sensitive compare.

**Match Whole Word Only:** If your description is BOC this box is NOT checked, points with the descriptions BOC, BOC1, BOC2, etc. would all be included. If the box were checked, only points with the description BOC would be included.

**Code:** select points by Code

**Match Case:** Match the case of the text

**Match Whole Word Only:** If checked, in the above example, only AB would be selected. Descriptions of AB1, ABC and ABB would not.

**Elevation:** select points by elevation

**Low Value:**
Point ID: Point Number
Elevation: elevation at point

**High Value:**
Point ID: Point Number
Elevation: elevation at point

If a point number is entered in the point ID box the elevation for that point will be used for either the high or low elevation. You may however enter an elevation only.

**In Radius:** select all the points within a given radius.
If a point number is entered in the point ID box, the northing and easting of that point will be used for the center of the search circle. To manually enter a northing and easting, leave the Point ID box empty and enter the values for the northing and easting of the circle. Enter the radius for the search circle.

**In Rectangle:** Select all the points within a given rectangle.

If a point number is entered in the point ID box, the northing and easting of that point will be used for that corner of the rectangle. To manually enter a northing and easting, leave the Point ID box empty and the northing and easting values. The two points defined the diagonal corners of the rectangle.

**Choice:** This option allows you to choose to include or exclude points previously in the C&G select point dialog box. Example:

**In the choose points dialog box:** select by Desc
Then type: GS as the description
in the choice dialog box: select Exclude
Any point that has "GS" in the description field will be removed from the selection set.

**Total selected Points:** the total number of points selected is shown in the lower right hand corner of the dialog box.

**Default Column Width:** The columns have a default width. If you have changed the width of a column, say NORTHING, you may press this button to go back to the default widths.

The remainder of this section discusses specific data collectors and software.
CG-Field & FieldPlus Data Collectors

Establish a connection between the data collector and desktop computer with a standard 9-Pin serial cable, USB cable, Bluetooth, etc. Check the settings as shown above.

Download a Description Table

You can transfer the desktop description table directly to the CG-FieldPlus data collector. The table will be placed in the data collector's DC_DESC.TBL file. CG-Field will let you use codes without a description table. Simply delete the DC_CODES file from the data collector and use the code numbers to enter descriptions. When you transfer the file to the desk top, the codes will automatically be replaced with the appropriate description. (This allows you to combine codes.) For example, if you enter [1 20 30], in the description field on the data collector when the transfer takes place these numbers will be read from the desk top description table and converted to the corresponding description, such as [BL TC SW].

Receiving Raw Data from CG-Field

**NOTE:** When uploading raw data from a data collector using CG-FieldPlus, a read-only file in the original CG-Field format is created on the computer (in the data directory) with a .R$$ extension.

On the desk top data collection transfer dialog box, set the following:

- **Set transfer method to Data Collector to Computer.**
  - **Data Collector Type:** CGFIELD+
  - **Use Data Collector:**
  - **Transfer Coordinates with raw:** -yes or no (your choice)
  - **File Type:** Raw Data
  - **File Format:** C&G (*.cgr)
  - **File Name:** enter the path and name where the file is to be stored or click on the "Browse" button and select the path.
  - **Description Table:** enter the path where the Description Table is stored or click on the "Browse" button and select the path
  - **Select Transfer when all settings are correct.**

On the data collector **Utils** menu, select:

1:C&G Transfer
2:Send Raw Data
Enter or select the raw data file
The file will be transferred.

**NOTE:** CG-Field uses only 2-character point codes. If you have CGSurvey set for 4-character point codes, the CG-Field file will be converted to a 4-character format but it will still have the correct 2-character code. If you download the same file back to the data collector, the downloaded file will be correct if you did not add any codes that actually consist of 4 characters.

Receiving Coordinate File from CG-Field

On the desk top data collection transfer dialog box, set the following:

- **Transfer Data Collector to Computer**
  - **Data Collector:** CGFIELD+
Use Data Collector:
File Type: Coordinate
File Format: C&G (*.crd) or C&G (*.cgc)
File Name: enter the path where the file is to be stored or click on the "Browse" button and select the path.
Description Table: enter the path where the Description Table is stored or click on the "Browse" button and select the path
Press Transfer when all settings are correct.

On the data collector Utils menu, select:
1:C&G Transfer
3:Send Coords
Select Points
All points
Blocks of points
From points file
The file will be transferred.

NOTE: In any transfer routine it is important to prepare and have ready the device that will be receiving data first.

Sending Coordinate File to CG-Field

On the data collector Utils menu, select:
1:C&G Transfer
3:Receive Coords

On the desk top data collection transfer dialog box, set the following:
Transfer: Computer TO Data Collector
Data Collector: CGFIELD+
Use Data Collector:
File Type: Coordinate
File Format: C&G (*.crd) or C&G (*.cgc)
File Name: enter the path where the file is to be stored or click on the "Browse" button and select the path.
Check the Select Points settings:
This tool allows you to select what group or groups of coordinates are transferred to the data collector.
Press Transfer: when all settings are correct.

NOTE: You should not download a file containing a 4-character code to your data collector. You will be warned that the last 2 characters of the code will not be sent. This means that a code of 1584 will be received as 15.

Receiving ASCII File from CG-Field

On the desk top data collection transfer dialog box, set the following:
Transfer Data Collector to Computer
Data Collector: CGFIELD+
Use Data Collector:
File Type: ASCII
File Name: enter the path where the file is to be stored or click on the "Browse" button and select the path.
Select Transfer when all settings are correct.

On the data collector Utils menu, select:
1:C&G Transfer
6: Send ASCII
File Name With Extension
File:
Transfer Name:
******.***
<Enter>

Sending ASCII File to CG-Field

On the data collector Utils menu, select:
1: C&G Transfer
5: Receive ASCII

On the desk top data collection transfer dialog box, set the following:
Transfer Computer to Data Collector
Data Collector: CGFIELD+
Use Data Collector:
File Type: ASCII
File Name: enter the path where the file is to be stored or click on the "Browse" button and select the path.
Select Transfer when all settings are correct.
The following are examples of typical data collection transfer settings. There will be cases with certain models or manufactures where special instructions will be required and C&G will provide those as needed.

There three different dialog boxes involved with data collection transfer:

C&G Data Collection Transfer (shown above)
Settings
Description Table Editor.

The function and settings for each of these is described in detail in the previous pages.
The examples shown on the following pages show transfers directly from and to data collectors. These same transfer routines will also work with files that have been downloaded to the desktop computer.

File Conversion Utility

To convert data from files check the Use Disc File box and either hand enter the path and name or click on "Browse" and search for the file location.

These files need to be in the correct data file format.

Receiving Raw Data

On the desk top data collection transfer dialog box, set the following:

Select Data Collector to Computer
Data Collector: (select data collector from list)
Check Use Data Collector:
Transfer Coordinates with raw: -yes or no (your choice)
Receiving Coordinate Data

On the desk top data collection transfer dialog box, set the following:

Select Data Collector to Computer
Data Collector: (select data collector from list)
Use Data Collector:
File Type: Coordinate
File Format: C&G (*.crd) or C&G (*.cgc)
File: enter the path to store the file or click on the Browse button and select the path.
Description Table: enter the path where the Desc Table is located or click on the Browse button and select the path.
Press Transfer: when all settings are correct.
Begin transfer from data collector

NOTE: In any transfer routine it is important to prepare and have ready the device that will be receiving data first.

Receiving ASCII Data
On the desk top data collection transfer dialog box, set the following:

**Select Data Collector to Computer**

**Data Collector**: (select data collector from list)

**Use Data Collector**:

**File Type**: Coordinate

**File Format**: ASCII (*.nez)

**File**: enter the path to store the file or click on the Browse button and select the path.

**Description Table**: enter the path where the Desc Table is stored or click on the File button and select the path.

**Select Transfer**: when all settings are correct.

**Begin transfer from data collector**

---

**Sending Coordinate Data**

---
Prepare Data collector to receive Coordinate file
On the desk top data collection transfer dialog box, set the following:

**Select Computer to Data Collector**
*Data Collector:* (select data collector from list)
*Use Data Collector:*
*File Type:* Coordinate
*File Format:* C&G (*.crd) or C&G (*.cgc)
*File:* enter the path to file or click on the Browse button and file

Check the **Select Points setting:**
*Press Transfer:* when all settings are correct.

**Sending ASCII File**
On the desktop data collection transfer dialog box, set the following:

**Select Computer to Data Collector**
- **Data Collector**: (select data collector from list)
- **File Type**: ASCII
- **File**: enter the path to store the file or click on the bROWSE button and select the path
- **Press Transfer**: when all settings are correct.

**Sending Description Table**
On the desk top data collection transfer dialog box, set the following:

**Select Computer to Data Collector**

**Data Collector:** (select data collector from list)

**File Type:** Description Table

**File:** enter the path to store the file or click on the File button and select the path

**Press Transfer:** when all settings are correct.

**SurvCE Data Collector**

You can receive coordinates and raw data from the data collector, or send coordinates to the data collector. Make sure SurvCE is selected as the data collector.

**Receive Coordinates from SurvCE**

On the desktop, click on "Data collector to Computer": select SurvCE as the Type data collector.

Set **FILE TYPE to Coordinate**: and select the desired File Format.

On the Data Collector, Select **FILE > DATA TRANSFER:** Choose Carlson/C&G Transfer.

On the desktop, select **BROWSE button next to the FILENAME field:** You will see the coordinate files that are on SurvCE.

Select the **File you wish to download:** and press OK.
Press the Transfer button. If you do not have a destination FILE NAME selected, you will see the following dialog:

In this case, the file already exists. If you press OK the coordinates will be written to the existing file. Point Overwrite Protection will allow you to select which points you wish to bring in. You can decide individually whether you want to overwrite a point or not, or you can select overwrite ALL points, or you can select to bring in ONLY new points.

A file with the same name and a C$ extension will also be created with the data that came directly from survCE in survCE’s format. This file is ready-only and can be archived for legal purposes.

Receive Raw Data from SurvCE
On the desktop, click on "Data collector to Computer": select SurvCE as the Type data collector.

Set FILE TYPE to Raw Data: and select the desired File Format.

On the Data Collector, Select FILE > DATA TRANSFER: Choose Carlson/C&G Transfer.

On the desktop, select BROWSE button next to the FILENAME field: You will see the raw data files that are on SurvCE.

Select the File you wish to download: and press OK.

The selected raw data file will be transferred and converted to the selected format. A file with the same name and a R$$ extension will also be created with the data that came directly from survCE in SurvCE's format.
Send Coordinates to SurvCE

Select Computer to Data collector. Make sure the Data Collector TYPE is set to SurvCE: select the file to be set to SurvCE (N_DRUIDH.crd). If you do not select a destination name, it will be sent to the same named file as the source.

If you do not want to send ALL the points, but need to select specific point: press the SELECT POINTS button and choose the point to transfer.

On the data collector select FILE > DATA TRANSFER: Choose Carlson/C&G Transfer
On the Desktop, Press the TRANSFER BUTTON: The selected coordinates will be transferred.
If the file already exists on SurvCE, you will see the following dialog:

You have the following choices:
Overwrite the existing file
Skip the file (do nothing)
Rename the file
Merge the points.
If you select the Merge option, you will see Carlson's standard merge dialog:

This dialog allows you to fix all conflicts prior to transferring the points.

**TOPCON DATA COLLECTORS**

Use Topcon cable A-5 if your computer has a 25-pin serial port, or Topcon cable A-16 if your computer has a 9-pin serial port. When uploading raw data from a Topcon/TDS data collector, a read-only file in the original data collector format is created on the computer (in the data directory) with a .RSS extension. When you send the description table to a Topcon/TDS data collector, only the first 999 descriptions will be sent.

**FC1 DATA COLLECTOR**

For the transfer program to be able to access any data in the FC1, it must be stored in the FC1 using the Program 2 supplied with the FC1 transfer software. First locate the necessary cables to connect the FC1 to your computer. (your dealer should be able to help you with this).

**NOTE:** Currently, the only programs that are supported are ET1 and GTS3, which are supplied with the system.

Follow these instructions:
Select either ET-1 or GTS-3 when prompted. Once you have loaded Program 2 into the FC1, you may enter your field data in either of two ways. The first way, is by connecting the FC1 to your total station and let the total station record angular and distance measurements for you by using the ET1 (GTS3) section of the FC1 program. The other way is to use the Manual Entry section of the program to store all of your field data directly through the FC1’s keyboard.

**Collecting Data using the FC1**
1) Set up data recording mode in the FC1.
2) Enter job information: job name, operator, instrument number, date, temperature, pressure.
3) Enter instrument point information: point number, H.I., backsight point, angle in instrument to backsight.
4) Enter foresight point information: point number, rod height, horizontal and vertical angles, distance.
5) If there are other foresights from the same instrument point, repeat step 4; or if you have another instrument setup, go to step 3; or if you are through, go to the end of the program.

NOTE: Never press the <skip> key when the FC1 is asking for data. Only use the <skip> key to by-pass "go to" options (see step 5 below).

Automatic Recording of Data

1) To set up the recording mode, have the FC1 connected to the ET1 (GTS3), and turned on. Wait until the left side of the display says READY.

If the right side of the display says PRG > 2, then you are ready for step 1A.
Otherwise, press these keys: <func>, <#, <Enter> and then go to step 1B below.

A) Press the <F1> key.

B) When the display says GOTO 7 ET1-PROG? ("GOTO 7 GTS3-PRG"), press the <Enter> key.

2) Enter any name you want for the job-id:
Enter the name of the operator.
Enter the instrument number.
Enter the date, temperature, and pressure.

3) Sight the backsight point with the instrument:
Enter the instrument point number.
Enter the instrument height (H.I.).
Enter the backsight point number.
Press <Enter> for the rod height.
Press <Enter> when the display says REC MODE 2 (REC V/H< MODE? on GTS3).
When the display says MODE>, press <2> and the ET1 should send angular information to the FC1.

4) Turn to the foresight.
Enter the foresight point number, and press <Enter>.
Enter a description for the foresight and press <Enter>.
Enter the foresight rod height and press <Enter>.
When the REC MD3-DR/2R (REC SD/V/HMODE?) message appears, press <Enter>, then choose mode 3 if you are entering a direct angle.

If this is your second angle to that foresight, then you may use mode 2 to record angles only.
5) After step 4, then you should see this message in the display: GOTO 18 FS.PT#?. If you wish to turn more angles from the current instrument point, then press <Enter>, and go back to step 4.

-or-
Press <Skip>. The next message will be GOTO 13 INST.PT? If you want to record another instrument set-up, then press <Enter>.

-or-
Press <Skip>. The next message is, GOTO 8 OPER.? To change operators, press <Enter>, and go to step 2.

-or-
Press <Skip>. The next message is, GOTO 53 END? To end input for this job, press <Enter>.

Steps on Manual Recording of Data

1) To set up the recording mode, have the FC1 turned on. Wait until the left side of the display says READY.
If the right side of the display, says PRG > 2 then you are ready for step 1A.
Otherwise press these keys: <func>, <#, <Enter> and go to step 1B.

A) Press the <F1> key.
B) When the display says GOTO 7 ET1-PROG? (GOTO 7 GTS3-PRG): press the <skip> key.

When the display says GOTO 30 MANUAL?: press the <Enter> key.

2) Enter any name you want for the job-id:
Enter the name of the operator:
Enter the instrument number:
Enter the date, temperature, and pressure:
3) Enter the instrument point number:
Enter the instrument height (H.I.).
Enter the backsight point number:
Enter the rod height if desired:
Enter the angle in the instrument: when the backsight was taken.
Enter the vertical angle and distance: if desired.
4) Turn to your foresight. Enter the foresight point number, and press <Enter>.
Enter a description for the foresight and press <Enter>.
Enter the foresight rod height and press <Enter>.
Enter the horizontal angle, slope distance, and vertical angle to the foresight.
5) After step 4, then you should see this message in the display: GOTO 43 FS. PT#?
If you wish to turn more angles from the current instrument point, then press <Enter>, and go back to Step 4.
-or-
Press <Skip>. The next message will be GOTO 36 INST.PT? If you want to record another instrument set-up, then press <Enter>.
-or-
Press <Skip>. The next message is GOTO 31 OPER.? To change operators, press <Enter>, and go to step 2.
-or-
Press <Skip>. The next message is GOTO 1 MENU? To go to the menu for another job, press <Enter>.
-or-
Press <Skip>. The next message is END. Press <Enter> to end entry for this session.

Receive Data from FC1

Once you have your data stored in the FC1, you must upload it to the computer.

Select the Receive Raw Data function. If you have already dumped the data stored on the FC1 to a computer file (in the Topcon format), you may choose to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file.

NOTE: To power your FC1 while sending data to the computer, you must plug the power cable into the signal port at the top of the FC1 and toggle the FC1's power switch to EXT.

TOPCON PROPAC DATA COLLECTOR

To enable the Propac to collect raw data in a format Suitable for CG-Survey's data transfer program the CG program must be installed on the 71B. To load the software: connect the Propac to the computer com port.

Follow the directions to download.
You may store the CG program in a freeport on the 71B. This has several advantages, the main one being it will not be lost if the batteries die.

Under the Propac options choose Load CG Program Into Propac.

On the 71B:
Type Freeport(.01) and key <Endline>.
Type COPY CG TO :PORT(.01) and key <Endline>.

For ROM Versions Prior to 1.75
Type DEF KEY 'f7'"USER @ RUNCG": and key <Endline>.

For ROM Versions 1.75 or Later
Type DEF KEY 'f7'"USER @ CONT PRGM2": and key <Endline>.

This will set up the raw data collection program to run on the Propac when the yellow function key and the <7> key are pressed. Unless something happens to the 71B, you should not need to reinstall the CG-Field program again.

Now delete the CG-Field program from the main memory of the Propac by typing PURGE CG:MAIN and key <Endline>. The program is still stored in the freeport.

To use the CG-RAW data program, turn the Propac on and type RUN PRO then key <Endline>. From the KEYS prompt press the yellow function key then the <7> key. This will start the CG program, then just follow the prompts.

The CG raw data program is the only one needed on the Propac other than the Propac options already available. If you are collecting coordinates and elevations instead of raw data, simply follow the Propac instructions.

To transfer the collected data to and from the computer, choose the Propac option you wish and follow the directions on the screen.

If you have already downloaded the data stored on the Propac to a computer file (in the Propac format), you may choose to receive the data directly from the file. Enter the file name that contains the data, and the file name for the .CGR file (raw data file) or .CRD file (coordinate file).

**FC-4 DATA COLLECTOR**

The C&G data collector transfer program can accept data that was collected from the FC-4 in either the traverse mode or topo mode. It can receive coordinates from the FC-4 and also send coordinates to the FC-4 for stakeout. The CG data collector transfer program supports most the valid methods of collecting data in the traverse or topo mode of the FC-4 (including the ability to collected direct and reverse angles). Refer to the FC-4 users manual to learn the different methods of data collection supported by the FC-4.

**Special Features - When translating the FC-4 file to a raw data file using the C&G data collector transfer program:**

1) If an FC-4 record is not used, the record will be placed in the raw data file as a comment with the message Not Used appended. No FC-4 record will be ignored. For example, *123 Not Used
2) Remarks ("R" records) will be placed in the raw data file as a comment record.
3) Coordinates will be placed in the raw data file as a coordinate record, (C 23 10000.0000 10000.0000 923.24 'TP).
4) When using the FC-4 Benchmark function, the following will be placed in the raw data file:
   A) The benchmark coordinates.
   B) The measurements to the benchmark as a foresight point.
5) When using the FC-4 Angle-Offset function the following will be placed in the raw data file:
   A) A comment line saying the next line is an angle/offset and showing the 1st and 2nd angle recorded to the point.
   B) A foresight record combining the first distance measurement and the 2nd angle measurement.
6) When using the FC-4 Distance-Offset function the following will be placed in the raw data file:
A) A comment line saying the next line is a distance/offset and showing the slope distance, vertical angle and offset distance measured to the base point.
B) A foresight record with a new slope distance and vertical angle calculated from the above information.

7) When using the FC-4 Perpendicular-Offset function the following will be placed in the raw data file:
A) The foresight record to the base point.
B) A comment line saying the next line is a perpendicular offset and showing the offset forward/backward, the offset left/right and the offset up/down.
C) A foresight record with a new horizontal angle, slope distance and vertical angle calculated from the above information.

**NOTE:** If there is no left/right offset, data will not convert correctly to a CG-SURVEY raw data record. For example, if the Perpendicular Offset routine is used to locate a point away from the instrument but on the same line, the resulting data record will use the wrong horizontal angle.

8) Backsight azimuths are transferred to the .CGR file as reference azimuths.

When a file is first created on the FC-4 the user will be prompted for some header information. When the data is transferred to the computer, the C&G data collection transfer program will use the job-id as the file name for the raw data file created on the computer.

To prepare the data collector and computer for data transfer, connect the A-5 or A-16 cable to the serial port of the FC-4 and to the appropriate serial port of the computer. Make sure the correct data collector comm port has been chosen in Settings Dialog.

Choose the appropriate menu option on the FC-4, then follow the instructions and answer the prompts as they appear on the screen. Once the raw data has been downloaded into the computer the raw data can be edited, reduced and printed out from the Traverse/Input Edit program.

If you have already downloaded the data stored on the FC-4 to a file on the computer, you can transfer the data using the "Use Disc File" command.

**TOPCON and TDS**

**Transferring Data**

On the C&G Data Collector Transfer screen set the data collector option to: 
Check Settings to make sure all options are set correctly
Sending Description Table to 48  

When sending the description table (DC_CODES file) to the 48, the following occurs:

A new file (DESCRIPT.TXT) is created in the data directory on the computer.

The first 200 descriptions are duplicated from the DC_CODES file.

After that, the first 100 descriptions are reproduced 7 times with the following mapping codes preceding the descriptions:

- 201 - 300 BL*(DESC)
- 301 - 400 EL*(DESC)
- 401 - 500 CL*(DESC)
- 501 - 600 CF*(DESC)
- 601 - 700 OC*(DESC)
- 701 - 800 PC*(DESC)
- 801 - 900 PT*(DESC)

The DESCRIPT.TXT file is then sent to the 48.

TOPCON CR2 CARD READER

Data collected and stored using the Topcon Card Reader is in the same format as data on the FC-4. All data format rules for the FC-4 apply here.

**Set-Up**

Card Read Preparation. Before using the card reader it is necessary to set the two DIP switches on the bottom of the unit to the settings described below. The direction on the switch which is marked ‘OFF’ is really a ‘1’. You should read the attached label, not the switches.

**The CR2 should be set as follows:**

**Baud:** 19200
Parity: None
Stop Bits: 1
Word: 8

**SW1 DIP Switch:** Set the communication parameters

**SW2 DIP Switch:** Sets other parameters

Use the interface cable supplied with the CR2 unit and plug it into the comm port on the computer. Make sure you select the Topcon CR2 data collector and the correct comm port.

The Card Reader program allows:
1) Receive raw data from the CR2 or from a CR2 file.
2) Receive coordinates from the CR2 or a CR2 file.
3) Send coordinates to the CR2.
4) Send or receive a description table to CR2.
5) Receive description table.
6) Send or receive ASCII files from the CR2.
7) Send an executable (EXE) file to the CR2.
8) Catalog (or directory) of all files on CR2.
9) Delete files on the CR2.
10) Format cards for the CR2.

**Receiving Data from the CR2**
You may receive raw data files (.R), coordinate files (.N), ASCII files or description table from the CR2. All files on the CR2 of the type you wish to receive will be shown on the screen

**Raw Data**

**Coordinates**

**ASCII**

**Description Table**

**Receiving Data from a CR2 File**

If you have already downloaded the data stored on the CR2 to a file on the computer, you may choose to receive the data from the file.

**Sending Data to the CR2**

You may send coordinate (.CRD) files, ASCII files, EXE files or description table to the CR2. Select the file you wish to send. You may not send a file to the card reader that already exists on the CR2. You must delete the file first. The .CRD files will be converted to .N files. ASCII files will be transferred without conversion, (make sure the file you are transferring is a true ASCII file).

**EXE files**

Programs with .EXE extensions can be transferred to the CR2. These files will be transferred with a .X extension.

**Note:** See opening section of this chapter for detailed instructions on the Settings dialog box & information on sending and receiving files.

**Catalog:** The catalog function will show you all existing files on the Topcon Card Reader.

**Deleting Files:** All files on the CR2 will be shown on the screen. Select the file you wish to delete. Be careful, once the file is deleted it is gone forever.

**Format:** The format function will allow you to format a card, making it ready to accept (store) data. If the card is already formatted, you will be warned that all information on the card will be lost, be careful.

**SOKKIA (LIETZ) SDR2 DATA COLLECTOR**

**General Information**

Use the cable supplied with the SDR2 data collector to plug into your computer's serial port.

When uploading or downloading to or from the computer, turn the switch on the cable toward the word PRINTER. If this does not work, turn the switch toward the word COMPUTER and try again. If you still have trouble please call us.

In order to use the Lietz SDR2 data collector with the transfer program, there are 4 areas that you must consider: (1) Entering data into the data collector in a format that can be sent to your computer, (2) the transfer program itself, (3) sending calculated coordinates back to the data collector, and (4) the data collector code conversion table which converts numeric codes for points into English-language descriptions as the data is sent to the computer.

Sokkia (Lietz) data collectors allow you to enter attribute data. To use attribute data with CG-SURVEY, it must be appended to the description records in the following format:

DESCRIPTION [attribute name] attribute
**Entering Data into the Data Collector**

**Note:** that all of the following assume that you have a Getting Started book and Operator's Manual from the Lietz Company.

1) To begin a new job, press `<clear>` until Select operation appears in the display. Press the `<Menu>` key. When JOB appears in the display, press `<Enter>`, and enter the job name and scale factor.

2) To enter field data, press `<clear>` until Select operation appears in the display. Press the `<Prog>`. When Traverse appears in the display, press `<Enter>` and begin traversing.

2a) You may use the TOPO program rather than the Traverse program. If you use this program, you must use the R option when sending data to your computer. The "Transferring Field Data to the Computer" section of this contains more about this.

**Note:** The coordinates that you enter for the first instrument point are for the internal use of the SDR2, and can be changed when your field data gets to the computer.

**Note:** When recording your first backsight information, simply enter an azimuth from the instrument point to the backsight (0.0000 will do). The azimuth information is also only used internally in the SDR2. You can change all of that as you reduce your field notes on the computer.

**Note:** At each instrument setup, the first angle recorded must be to your backsight. Your instrument may be "zeroed" or not, but when the Traverse Reduction program runs, it will subtract the backsight angle from the foresight angles.

**Transferring Field Data to the Computer**

If you have already dumped the data stored on the SDR to a computer file (in the SDR format), you may choose option to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file (raw data file) or .CRD file (coordinate file).

Before data can be transferred in either direction between the computer and the SDR2, you must set up the transfer parameters in the SDR2. Once these have been set, they will not change, until you change them again. You do not have to set them each time. (The only parameter that you may wish to change is the baud rate.)

In our tests, the computer can receive data from the SDR2 at 4800 baud, its fastest speed, but the SDR2 could only receive points at 1200 baud. For fastest transmissions to and from the SDR2, you might wish to change this parameter in the SDR2.

The SDR-22 and SDR-24 data collectors will send to the computer at 9600 baud and receive data from the computer at 4800 baud.

1) **Set up parameters by pressing `<clear>` until the message Select operation appears in the SDR2 display.** Then, press `<Menu>`. Press the up or down arrow until Parameters appears in the display, then press `<Enter>`. You can then go from one parameter to the next by pressing the up or down arrows. When a parameter you wish to change shows on the display, press the `<Edit>` key, and change it. (See the SDR2 operator's manual.)

**These parameters must be in effect:**
Baud: 4800 (or 1200 for sending to the SDR2, see above discussion.)
2) **After the parameters have been set**, simply connect the SDR2 to the computer, and select the transmission option. (On the Lietz transfer cable, there is a switch that must be set to DTE.)

3) **Choose the same baud rate at the computer as you selected in the SDR2 parameters. When the computer says Waiting for data...**, press <clear> on the SDR2 until Select operation shows in the display window. Press the <Menu> key. Press an up or down arrow key until Comms output shows in the display, then press <Enter> on the SDR2. Answer <N> if you do not wish to send all jobs. Then enter the job that you do wish to send. (See the SDR2 manual for a complete discussion of this process.)

4) The SDR2 should then send its information to the computer.

**Note:** As each job record is encountered in the computer will ask you for a file name to store the data in. You may press <Enter> to use the same name as was used in the SDR2 or enter another name. You must use a valid DOS name (all numbers and letters of 8 or less characters will be fine.)

Attribute data collected by the SDR (13AT records) is appended to the descriptions as follows: DESC[Attribute Name]Attribute

Example: PIPE[diameter]18"

**Transferring Coordinates to the SDR2**

Be careful of the units when transferring coordinates. For example, if the SDR2 is set to Metric Mode, the SDR2 will automatically convert the coordinates from feet to meters. Before you can transfer coordinates to the SDR2, you must first set up the transfer parameters in the SDR2. Refer to the first part of the previous section for details about how to do this. Then:

1) **Ready the SDR2** by pressing <clear> until Select operation appears on the display. Press the <Menu> key. Then press the up or down arrows until Comms input appears on the menu. Press <Enter>.

2) **Select the Send Coordinates option and press Transfer.**

3) **Select the coordinate file on the computer.**

4) **Choose which coordinates to send.**

**SOKKIA (LIETZ) SDR33 DATA COLLECTOR**

The SDR33 works the same as the SDR2. In Equipment Options there are two SDR33 choices, because when creating a new job on a SDR33 the format is determined by setting the Point ID field to Numeric (4) or Alpha (14).

**SDR33 4-Pt**

To transfer data to CG-SURVEY, select this setting if your SDR33 is set to Numeric (4). The highest point number allowed is 9,999.
The C&G *.cgc files allow 10 character Alphanumeric point numbers. While C&G *.crd files allow only 5 digit numeric point numbers. To transfer a SDR33, set to Alpha (14), the file format setting must be set to *.cgc.

Note: See opening section of this chapter for detailed instructions on the settings dialog box and on sending and receiving files.

LEICA (WILD) GRE3/GRE4 AND GIF-2 INTERFACE

Set Up for GRE3/GRE4

Select the Wild: GIF-2 under Equipment Options. Before transferring data from the GRE3/4 to your computer, you must first set up the transfer parameters in the GRE3. To do this follow these steps on the GRE3/4:

1) <Set> <Mode> <7><0> <Run> <4><8><0><0> <Run> <Run>
(Sets the baud rate to 4800. If you wish, you may leave it at 2400, which is the rate the T2000 needs to communicate with the GRE3/4.)
2) <Set> <Mode> <7><1> <Run> <2> <Run> <Run>
(Sets even parity.)
3) <Set> <Mode> <7><2> <Run> <1> <Run> <Run>
(Use protocol.)
4) <Set> <Mode> <7><3> <Run> <0> <Run> <Run>
(<CR> only.)
5) <Set> <Mode> <7><4> <Run> <2> <Run> <Run>
(ACK/NAK + <CR>.)
6) <Set> <Mode> <4><0> <Run> <4> <Run> <Run>
7) \texttt{<Set> <Mode> <4> <1> <Run> <1> <Run> <Run>} (Feet).

8) \texttt{<Set> <Form> <.> <Run> <Rec>}

\textbf{(for the T2000)}

\texttt{-or-}

\texttt{<SET> <FORM> <+/-> <.> <RUN> <1> <1> <RUN> <REC>}

\textbf{(for the T1000)}

\textbf{Note:} The above parameters do not "go away" when the GRE3/4 is switched off. They will stay the same until you change them or re-initialize everything.

\textbf{Note:} See opening section of this chapter for detailed instructions on the Settings dialog box & information on sending and receiving files.

\section*{Switch Settings/Cable}

\textbf{Option 1}

GIF-2 Switches Cable Configuration
\[= \text{X GRE-3/4 Computer} \]
S1 \(< 2 < > 3\)
S2 \(< 3 < > 2\)
S7 \(< 7 < > 7\)
5 <
(Jump 5, 6, 8, 20) 6 <
8 <
20 <

\textbf{Option 2}

GIF-2 Switches Cable Configuration
\[= \text{X GRE-3/4 Computer} \]
S1 \(< 2 < > 3\)
S2 \(< 2 < > 2\)
S7 \(< 3 < > 7\)
7 <
5
(Jump 5, 6, 8, 20) 6 <
8 <
20 <

\section*{Data Collection Format for GRE3, GRE4, GIF-10}

The transfer program expects your data to be in a specific format. To get your data in this format, follow these steps.

\textbf{1) To begin a new job enter a "CODE 1" block into the GRE3/4. Example:}  
RDY [CODE]  
CODE [1]  
I1 ? [RUN]
your job number (Example: 87001)  
[RUN]  
I2 ? job date (Example: 091687 for Sept. 16, 1987)  
[RUN]
2) Define the first automatic point number for your first foresight. Example:
RDY [SET]
SET [NR0]
S NR [2] for point number 2 as first foresight.
[RUN]

3) At each instrument point, enter a "CODE 2" block into the GRE3/4. Example:
RDY [CODE]
CODE [2]
[RUN]
[RUN]
I2 ? [instrument height] EX: [550] for 5.50 feet.
[RUN]
I3 ? [REC]

Note: Each instrument point "CODE 2" block must be followed by a measurement reading to your backsight. You will probably need to change the point number for the backsight by:

RDY [NR]
NR [point number] EX: 4 for backsighting point 4.
[RUN]
THEN:
RDY [MEAS]
REC [REC]
-or-
ALL on T1000 will store in GRE3/4

4) Record your foresights. If necessary, change the rod height and/or the description of the foresight.
Use "CODE 3" or "CODE 4" to do this. Both codes are essentially the same, but one asks for the description first and the other asks for the rod height first, allowing you to skip the second entry by pressing [REC] rather than entering a value (see the third example below). This step may be skipped if you do not wish to change either rod height or description from the previous entry.

Example 1:
RDY [CODE]
CODE [3] Code 3 = description, rod height
[RUN]
I1 ? [0][1] Description = 01 (must be 2 digits)
[RUN]
I2 ? [5][5][0] Rod height = 5.50 feet
[RUN]
I3 ? [REC]
See following section on Setting-up Description Codes.

Example 2:
RDY [CODE]
[RUN]
I1 ? [5][5][0] Rod height = 5.50 feet
[RUN]
I2 ? [1][0] Description = 10 (must be 2 digits)
[RUN]
Example 3:
RDY [CODE]
CODE [3] Code 3 = description, rod height
[RUN]
I1 ? [1][2] Description = 12 (must be 2 digits)
[RUN]
I2 ? [REC] (leave the rod height the same)

5) Take your measurement (make sure that the point number is correct first):
RDY [MEAS]
REC [REC]

6) Now, go to step 4 for another foresight or to step 3 for another instrument set-up:

Uploading from Data Collector to the Computer

If you have already dumped the data stored on the GIF-2 to a computer file you may choose to receive the data from the file. Enter the file name that contains the data. After you have collected your field data, connect the GRE3/4 to your computer. Then select the receive option on the computer. The baud rate in the computer must match the baud rate in the GRE3/4. After selecting the baud rate on the computer, follow the steps on the screen to initiate transmission.

Those steps are:
1) Connect the GRE-3/4 to the computer, turn it on, and wait for RDY to show on the display.
3) Press <GoTo>, press <Run>, and wait for the GRE-3/4 to display D CD.

After the computer detects the end of transmission, it will begin to format the data in a usable form. When each job record is encountered (CODE 1), you will be prompted to give the computer the name that you want to enter the file name for that job.

Sending Coordinates to the GRE-3/4

From the Menu, select the send coordinates option. The baud rate in the computer must match the baud rate in the GRE3/4. Initiate transmission on the GRE-3/4 by doing the following:

Note: See opening section of this chapter for detailed instructions on the Settings dialog box & information on sending and receiving files.

1) On GRE-3/4, SET MODE 80 <Run> 2 <Run> <Run> to select file 2.
2) On GRE-3/4, SET MODE 81 <Run> <#blocks> <Run> <Run> to dimension file 2.
3) Press any key to continue:
4) Next, select the points you wish to send: The transmission will begin.

LEICA (WILD) GIF-10 INTERFACE
Receiving Raw Data from GIF-10 Interface:

Select the receive raw data option on the computer. If you have already dumped the data stored on the GIF-10 to a computer file (in the Wild format), you may choose receive the data from the file. Enter the file name that contains the data.

The baud rate in the computer must match the baud rate in the GIF-10. Do the following on the GIF-10:

1) Set the comm parameters as follows:
   Baud: (your choice)
   Parity: EVEN
   Protoc: ACK/NAK
   Stop Bit: 2
   End Mark: CR
   Connected AS: DTE
2) Put the GIF-10 in upload mode by selecting <Send> on the GIF-10.
3) Press <Run> on the GIF-10 and select the file you wish to send.
4) Press <Run> on the GIF-10.

Sending Coordinates to the GIF-10 Interface:

Select the send coordinates option. The baud rate in the computer must match the baud rate in the GIF-10. Do the following on the GIF-10:

1) Create receive file in GIF-10 now.
2) Put the GIF-10 in download mode by selecting Receive on the GIF-10.
Select the points you wish to send. The transmission will begin.

Note: See opening section of this chapter for detailed instructions on the Settings dialog box & information on sending and receiving files.

LEICA (WILD) GIF-10/WS

This is a Wild GIF-10 interface that will accept data in the same format as WildSoft. You will be asked for the Observation Pattern when the file is transferred. This pattern can be either BS-FS-FS-BS or BS-FS-BS-FS. As with WildSoft, codes 101 and above will be treated as descriptor codes. Code 100 will be subtracted from the descriptor code and that description will be read from CG-SURVEY's description table. So 101 is description 1, 102 is description 2, and so forth.

The following table shows acceptable WildSoft data collection codes:

WildSoft Data Collection Codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Start Job</td>
</tr>
<tr>
<td>2</td>
<td>Occupy a Point</td>
</tr>
<tr>
<td>3</td>
<td>FS to Traverse Point</td>
</tr>
<tr>
<td>11</td>
<td>Assign Coordinates</td>
</tr>
<tr>
<td>13</td>
<td>Target Height</td>
</tr>
<tr>
<td>14</td>
<td>Add to Target Height</td>
</tr>
</tbody>
</table>

Chapter 18. CGSurvey Module
21 Occupy Saved Point
31 FS to Single Point
32 Radial Sideshots
33 Sets of Angles
63 Remark
101+ Descriptions

**LEICA (WILD) GIF-10/WS2**

This is the exact same interface as the GIF-10/WS except 100 is not subtracted from the descriptor code.

**LEICA (WILD) GIF-10/TOPORS**

This is a Wild GIF-10 interface that will accept data in the same format as the Canadian software TOPOS. To select this format, choose GIF-10/TOP from the data collector choices in the Equipment Options. The following information explains the format.

**These six Wild codes are used:**

<table>
<thead>
<tr>
<th>Code</th>
<th>Field 1</th>
<th>Field 2</th>
<th>Field 3</th>
<th>Field 4</th>
<th>Rectype</th>
</tr>
</thead>
<tbody>
<tr>
<td>91</td>
<td>Job Name</td>
<td>Date</td>
<td>Temperature</td>
<td>Pressure</td>
<td>New Job</td>
</tr>
<tr>
<td>10</td>
<td>Label #</td>
<td>HI Instrument Pt.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Label #</td>
<td>RH Backsight Pt.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>Label #</td>
<td>RH Trav. Pt.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>Label #</td>
<td>RH Side Shot Pt.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Label #</td>
<td>RH Offset Angle SS</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1) If RH (rod height) is 999 it will be considered no value (do not calculate elevation for this point).
2) The Label# (point description number) can contain up to eight characters. The first four and last four will be read as separate descriptions. For example, if Label# is 00210034, then description 21 will be pulled from the description table and description 34 will be pulled from the description table. If 21 is BL* and 34 is TC, then the resulting description will be BL* TC.
3) Point numbers are taken from measurement records. A measurement record will follow code 10, 20, 30, and 40 records. For example: In this example, there is a side-shot record (40), a point label description (71), a rod height (2.150), and a point number (332).
4) If an offset distance is placed in Field 3 of a side-shot record, the measured angle will be shown in a comment line prior to the data record with the newly calculated angle.
5) If a comment is placed in field 4 of a side-shot record, the comment will be appended to the point's description. example: If the label# is 25 and the comment is 150, description 25 (lets say TREE) will be pulled from the description table and the comment will be appended to the description, giving TREE 150 as the description.

**Leica Data Pro:**

You are allowed to read and write to the Leica Data Pro formatted GSI files. There is no communication directly with the Leica Total stations.

**GEODAT 122/124 DATA COLLECTOR**

In order to use the Geodat 122 or 124 data collector with the transfer program, there are three areas that you
must consider: (1) entering data into the data collector in a format that can be sent to your computer, (2) the transfer program itself, and (3) the data collector code conversion table which converts numeric codes to more readable descriptions when the data is sent to the computer. The following section describes how to enter your data into the data collector. The next section will then give you some information about how to transfer the data. The data collector code conversion table can be changed with menu selection E from the program menu.

Entering Data into the Data Collector

1) Each individual job stored in the Geodat's memory should begin with a job identifier. To enter a job identifier, follow these steps:
   a) Press the <Info> key.
   b) At the prompt "inFo=" enter a job number, like this: inFo=87001<Ent> (<Ent> means to press the <Ent> key.)
   c) At the prompt "dAtA=" enter the date like this: Example: dAtA=050187<Ent> (for 05/01/87)

2) For each instrument location, you must enter an instrument point identifier.
   Follow the following steps to do this:
   a) Press the <Stn> key.
   b) At the "Stn=" prompt enter you instrument point number like this: Stn=1<Ent> (for instrument point 1)
   c) At the "iH=" prompt enter the instrument height, like this: iH=5.5<Ent> (for 5.5 feet)
   d) Next the prompt "PCod=" will appear on the display. At this time, enter your backsight point, just like the foresights in the next step. You may enter "0" (zero) for all of the fields except: "Pno=" (enter the backsight point number)
      "Hor=" (enter the angle in your instrument when you take the backsight.)
   3) Recording foresights. You are now ready to record a foresight:
   a) At the "PCod=" prompt enter the point code for your foresight like this: PCod=10<Ent> (for point code 10)
   b) At the "Pno=" prompt enter your foresight point number like this: Pno=2<Ent> (for point number 2)
   c) At the "SH=" prompt enter the rod height of your foresight like this: SH=5.5<Ent> (for 5.5 feet)

   The next three fields may be entered manually or may be automatically stored by your instrument.
   d) At the "Hor=" prompt enter the horizontal angle to your foresight like this: Hor=65.1253<Ent> (for 65 degrees, 12 minutes, and 53 seconds.)
   e) At the "ELE=" prompt enter the vertical angle to your foresight like this: ELE=90.1215<Ent> (for 90 degrees, 12 minutes and 15 seconds)
   f) At the "diSt=" prompt enter the slope distance to your foresight like this: diSt=100.128<Ent> (for 100.128 feet)

   Now, go to step 2 for a new instrument point, or step 3 for another sight from the current instrument point.

   Note: If you have already dumped the data stored on the 122/124 to a computer file (in the 122/124 format), you may choose to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file.

Receive Data from Data Collector

Select the receive raw data option.

1) Before you upload your data, make sure that the description table is current.
2) Before you initiate the upload program, you must first define the upload parameters for the Geodat. To do this, follow the steps outlined below.

3) This should not have to be done each time. The values that you enter should stay the same until you change them.

a) Press the <f>, the <1>, the <0> and the <Ent> keys. (For function 10.)
b) Answer the baud rate question like this: bAud=1200<Ent> (for 1200 baud you can use 300 baud, but it will take longer to transfer your data.)
c) Make sure that "Eob=" looks like this: Eob=0123456789<Ent>
d) Make sure that the "StArt=" prompt looks like this: StArt=035<Ent>
e) Make sure that the "StoP=" prompt looks like this: StoP=000<Ent>
f) Make sure that the "ErrCodE=" prompt looks like this: ErrCodE=037<Ent>
g) Make sure that the "nuLLS=" prompt looks like this: nuLLS=000<Ent>

GEODAT 126, 400, 500 AND INTERNAL MEMORY THEODOLITES

These Geodat data collectors use the following data entry format:

**Instrument Point Setup**

<table>
<thead>
<tr>
<th>Labels Explanation</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>#2 Instrument Point</td>
<td>2</td>
</tr>
<tr>
<td>3 Height of Instrument</td>
<td>3</td>
</tr>
<tr>
<td>#62 Backsight Point</td>
<td>62</td>
</tr>
<tr>
<td>21 Backsight Angle</td>
<td>21</td>
</tr>
<tr>
<td>6 Backsight Rod Height</td>
<td>6</td>
</tr>
<tr>
<td>7 Horizontal Angle to Backsight</td>
<td>7</td>
</tr>
<tr>
<td>8 Vertical Angle to Backsight</td>
<td>8</td>
</tr>
<tr>
<td>9 Slope Distance to Backsight</td>
<td>9</td>
</tr>
<tr>
<td>* Indicates required code</td>
<td>*</td>
</tr>
</tbody>
</table>

**Note:** Pcodes (label 4) cannot be used anywhere except in foresight records.

**Note:** The order of the instrument point setups is not important.

**Foresight Points**

<table>
<thead>
<tr>
<th>Labels Explanation</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>#5 Foresight point</td>
<td>5</td>
</tr>
<tr>
<td>6 Backsight rod height</td>
<td>6</td>
</tr>
<tr>
<td>#7 Horizontal angle to backsight</td>
<td>7</td>
</tr>
<tr>
<td>#8 Vertical angle to backsight</td>
<td>8</td>
</tr>
<tr>
<td>#9 Slope distance to backsight</td>
<td>9</td>
</tr>
<tr>
<td>4 Pcode (Description)</td>
<td>4</td>
</tr>
<tr>
<td>* Indicates required code</td>
<td>*</td>
</tr>
</tbody>
</table>

**Note:** Foresight points must begin with either a Pcode (label) or a foresight point (code 5). The order of the remaining parameters is not important.

Label 4 (Pcodes) are placed in the description field of the raw data file. If you cannot get the entire point description into a single Pcode, we allow you to use multiple Pcodes for an individual point.

Example: 4 = Manhole,
4 = Inv. -10.23,
4 = 12" Conc.Pipe
The resulting point description is: Manhole, Inv. - 10.23, 12'' Conc.Pipe

If the Append Info Records to Pcode toggle is on, info records (label 0=) that directly follow a Pcode (label 4=) will be appended to the Pcode prior to being placed in the point description.

Example: 4 = Manhole, 0 = Inv. -10.23, 0 = 12'' Conc.Pipe

The resulting point description is: Manhole, Inv. - 10.23, 12'' Conc.Pipe

GEODAT 126 DATA COLLECTOR

I. The Cable

Your cable should be made as follows:

NC - No connection.

Geodat 126 (male) Computer 25 Pin
2 ......................... 2 (TxD)
3 ......................... 3 (RxD)
7 ......................... 7 (S.GND)
5-NC —— 5 (CTS) jumper 5-6-8-20
6-NC —— 6 (DSR)
8-NC —— 8 (CD)
20-NC —— 20 (DTR)

Geodat 126 (male) Computer 9 Pin
2 ......................... 3 (TxD)
3 ......................... 2 (RxD)
7 ......................... 5 (S.GND)
5-NC —— 8 (CTS) jumper 8-6-1-4
6-NC —— 6 (DSR)
8-NC —— 1 (CD)
20-NC —— 4 (DTR)

II. Set Protocol 2 and 5; Set Format 2

Be sure the INT./EXT. switch is set to INT. if you are not connected to an external power source. Be sure the on/off switch is in the on position.

Set protocol by using program 51 in the Geodat.
Protocol 2 Protocol 5
1: 9600 1: 9600
2: 2 2: 2
3: 7 3: 7
4: 2 4: 2
5: 10 5: 10
6: 0 6: 0
7: 0 7: 0
8: 0 8: 0
9: 0 9: 0
10: 0 10: 0
11: 0 11: 0
Set format by using program 50 in the Geodat.
Format 2
1: 1
2: 80
3: 13
4: 15

III. Data Storage in the Geodat 126

Raw data is gathered into job files using the pre-programmed UDS's in the Geodat 126. Call us if you wish to create others.

To use the existing programs, begin by choosing program #10. This sets up the header information and first instrument/back sight points. For foresights, choose program #0 if you are carrying elevations or program #1 for horizontal locations only. Use program #11 to change instrument set-ups. These programs are explained on page 8:4 in the Geodat manual.

Coordinates are transferred from and into area files.

Special numeric point codes may be used. These codes are converted to alphanumeric descriptions as the data is received from the Geodat 126. The codes are defined in the description table.

IV. UDS Requirements

The initial testing of the Geodat 126 was done using the standard UDS's supplied with the Geodat 126. If you wish to try using your own, these rules apply:

1) A measurement must end with label 9. (See sample UDS's 0, 1, 2, 3.)
2) Each Job. No. file must begin (1st record) with ADM type data (see sample UDS 10). This sequence must end with label type 74 - Air Pressure.
3) Each instrument station sequence must end with Hz. Ref. (Label 21). See the UDS 11 in Geodat 126 manual for sample.

Select the receive/send option from the computer menu and follow the prompts. If you have already dumped the data stored on the DR-2 to a computer file (in the DR-2 format), you may choose to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file (raw data file) or .CRD file (coordinate file).

GEODAT 400 DATA COLLECTOR

Setting up the Geodat 400 for use with the transfer program:
1) Set protocol 0 (as shown below).
2) Set format 0 (as shown below).

Be sure the on/off switch is in the on position. Set protocol by using program 51 in the Geodat field instru-
Protocol 0
1: 9600
2: 0
3: 8
4: 1
5: 10
6: 0
7: 1
8: 17
9: 19
10: 0
11: 0
12: 0
13: 0
14: 1.13
15: 0
16: 1.04

Line 7 implements software handshaking between the 400 and the MS-DOS computer by using a value of 1. When the value of item 7 is 0, then no software handshaking is done.

Line 8 is given a value of 17 which is the Xon value used for the communication handshaking.

Line 9 is given a value of 19 which is the Xoff value used for the communication handshaking.

Set format by using program 50 in the Geodat field instrument.

Format 0
1: 1
2: 80
3: 324:
4 *

Note: It is important that the values above be set as we show them or our software can not communicate with the Geodat 400 Data Recorder.

If you have already dumped the data stored on the 400 to a computer file (in the 400 format), you may choose to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file (raw data file) or .CRD file (coordinate file).

**Uploading Raw Data to the Computer**

After you have collected your field data, connect the Geodat 400 to your computer. Select the receive raw data option. The baud rate in the computer must match the baud rate in the Geodat 400. Do the following:

1) **Connect the 400 to the computer, turn it off, then on.**
2) **Make certain that you have selected the correct protocol and format.**
3) **Enter name of Geodat job file.**

**Download Coordinates into 400 Area File**

Select the send coordinates option.
Select the points to send.
Ready the 400 with the following steps:
1) Connect the 400 to the computer, turn it off, then on.
2) Make certain that you have selected the correct protocol and format.
3) Enter name of Geodat area file.
The coordinates will be transferred.
Get Coordinates from 400 Area File

Receive coordinates from 400 Area File

The baud rate in the computer must match the baud rate in the 400. Do the following:
1) Connect the 400 to the computer, turn it off, then on.
2) Make certain that you have selected the correct protocol and format.
3) Enter name of Geodat area file.
The transmission will begin.

GEODAT 500 DATA COLLECTOR

Setting up the Geodat 500 for use with the transfer program:
1) Set protocol 0 (as shown below).
2) Set format 0 (as shown below).
Be sure the on/off switch is in the on position.
Set protocol by using program 51 in the Geodat field instrument.

Protocol 0
1: 9600
2: 0
3: 8
4: 1
5: 10
6: 0
7: 1
8: 17
9: 19
10: 0
11: 0
12: 0
13: 0
14: 1.13
15: 0
16: 1.04

Line 7 implements software handshaking between the 500 and the MS-DOS computer by using a value of 1. When the value of item 7 is 0, then no software handshaking is done.

Line 8 is given a value of 17 which is the Xon value used for the communication handshaking.

Line 9 is given a value of 19 which is the Xoff value used for the communication handshaking. Set format by using program 50 in the Geodat field instrument.

Format 0
**Note:** It is important that the values above be set as we show them or our software can not communicate with the Geodat 500 Data Recorder.

The C&G Data collector Transfer dialog box has an additional option for the GEODAT 500 collector, as shown below. the show DC files:

![C&G Data Collector Transfer Dialog Box](image.png)

This Option actually reads and displays the data files on the GEODAT 500 data collector. From the display options you can select to view all files, just coordinate files or just raw files.

If you have already dumped the data stored on the 500 to a computer file (in the 500 format), you may choose to receive the data from the file. Enter the file name that contains the data, and the file name for the .CGR file (raw data file) or .CRD file (coordinate file).

You can also delete files from the GEODAT 500. Be careful, once the files is deleted it is gone forever. When you have the files selected, you want to transfer, select exit.
The Geodat 500 program allows:
1) Receive raw data from the Geo 500
2) Receive raw data from a file.
3) Receive coordinates from the Geo 500.
4) Receive coordinates from a file.
5) Send coordinates to the Geo 500.
6) Catalog (or directory) of all files on Geo 500.
7) Delete files on the Geo 500.

Receiving Data from the 500

You may receive raw data files (M=), or coordinate files (I=). All files on the 500 of the type you wish to receive will be shown on the screen (for example, all I= files for coordinate).
1) Select the file you wish to receive. Raw Data (Job Files)

2) After the raw data file is transferred, you will be asked to select the file name it will be stored under on the computer. The default value will be the same name with a .CGR extension. Coordinates (Area Files)

3) After the coordinate file is transferred, you will be asked to select the file name it will be stored under on the computer. The default value will be the same name with .CRD/.IDX extensions.

Sending Data to the 500

You may send coordinate (.CRD) files to the 500. All coordinate files on the computer will be shown on the screen. Select the file you wish to send.
1) You may select the only the coordinates that you wish to send (you do not have to send the entire file). Catalog
2) The catalog function will show you all existing files on the Geodat 500.

Deleting Files
All files on the 500 will be shown on the screen.
1) Select the file you wish to delete. Be careful, once the file is deleted it is gone forever.
2) Press <Esc> if you do not want to delete a file.

GEODIMETER TOTAL STATIONS WITH INTERNAL MEMORY

You can select Geodat 500 and interface directly with any Geodimeter that has internal memory. To transfer data from a Geodimeter Total Station with internal memory, do the following:

1) In Equipment Options, select Geodat 500 as the data collector and run data collection program.
2) Use Geotronix cable #571136756. Connect RS232 on computer to RS232 on Geodimeter with cable.
3) Power on Geodimeter and turn off compensator with Function 22 as follows:
   Key
   <F> (Function)
   <22>
   <Ent> (Enter)
   <0>
   <Ent>
   Then press <Ent> until P0 is displayed on Geodimeter screen.

4) Set the END character to 4 with Function 79 as follows:
   Key
   <F> (Function)
   <79>
   <Ent> (Enter)
   <4>
   <Ent>
5) Initiate comm port on Geodimeter as follows:
   Key
   <Mnu> (menu)
   <4> (data com)
   <1> (select device)
   <2> (serial)
   <Yes> (serial on)
   <1.8.0.9600> (com=) skip if already set
   <Ent> (enter)
   <0> (table no=)
   <Ent>
   <No> (REG. key?)
   <No> (Slave ?)
6) You may now select all options on the computer menu for data collection transfer with the Geodimeter. See Geodat 500 instructions for data transfer (disregard formatting procedures).

SMI 48 ENHANCED DATA COLLECTOR

The SMI interface routine works only with SMI Enhanced Cards. Use the interface cable supplied with the SMI unit (plugs into the comm port on the computer).

SMI 48 transfer Versions 5

Receiving Data
If you have already dumped the data stored on the SMI to a file on the computer, you may choose to receive the data from the file.

Receiving Raw Data from the SMI

Select the Receive raw data option on the computer. On the SMI, select TOPC and then RAW. The transfer will begin. The file name will be shown on the screen after the transfer is complete. You may enter a new file name if you wish. Our reduction program does not allow a raw data file with mixed angle types (for example: azimuths, angles right, deflections, etc.). When you are collecting data on the SMI, stick to one angle type. You can mix distance types if you wish (slope/zenith, horizontal/vertical).

Receiving Coordinates from the SMI
1) Select the Receive Coordinates option on the computer: On the SMI select TOPC and then SMI.
2) On the SMI, enter the first and last point numbers you wish to send: The transfer will begin.

Sending Coordinates to the SMI

1) On the SMI select TD48 and the SMI.
2) Select the Send Coordinates option on the computer. You will be asked if you wish to send descriptions.
The answer to this question depends on whether the SMI coordinate file you are sending to is a 15 byte file (no descriptions) or a 30 byte file (descriptions).

3) On the computer, select the points you wish to send. When the selection set is complete, press <T> for transmit. The transfer will begin.

SMI 48 transfer Versions 6, 7 & 8

Receiving Raw Data from the SMI

1) Get the C&G Transfer Program ready to receive raw data: Press Transfer
2) On the SMI data Collector select [PRINT]: set the soft-key to [WIRE]

Receiving Coordinates from the SMI

1) Get the C&G Transfer Program ready to receive raw data and Press Transfer
2) On the SMI data Collector select [JOB], then [KERM]: set the soft-key to [NE] and [COMM], select [SEND] and then select the points to transfer.

Sending Coordinates to the SMI

1) On the SMI data collector select [JOB] the [KERM]: set the soft-key to [NE] and [COMM], select [RECV].
2) Configure the C&G Transfer Program to send Coordinates: select the points to be sent and press TRANSFER

Nikon Data Collection Transfer
Receiving Raw Data from the Nikon Total Station:

1) Get the C&G Transfer Program ready to receive raw data and Press Transfer
2) On the Nikon select [MENU]. Select option [SET] and then option [COMM]. Set "Ext.Comm:" to Nikon. Set the communication parameters to match those in the C&G transfer program.
3) From the Main Menu on the Nikon select "Comms" and "Download": select format: NIKON and Data: RAW
4) Press ENTER to send.

Receiving Coordinates Data from the Nikon Total Station

1) Get the C&G Transfer Program ready to receive raw data and Press Transfer
2) On the Nikon select [MENU]. Select option [SET] and then option [COMM]. Set "Ext.Comm:" to Nikon. Set the communication parameters to match those in the C&G transfer program.
3) From the Main Menu on the Nikon select "Comms" and "Download": select format: NIKON and Data: COORD.
4) Press ENTER to send.

Sending Coordinates Data from the Nikon Total Station

1) On the Nikon select [MENU]. Select option [SET] and then option [COMM]. Set "Ext.Comm:" to Nikon. Set the communication parameters to match those in the C&G transfer program.
2) From the Main Menu on the Nikon: select "Comms" and "Upload Data". Press ENTER to receive.
3) Configure the C&G Transfer Program to Send Coordinates: select the points to be sent and press TRANSFER.
Pulldown Menu Location: CG-Survey>CGTrav>Data Collector Transfer
Keyboard Command: DC, CG_DATA_COLLECTOR
Prerequisite: Check Cable Connection & Communication Parameters

Reduce Traverse

The Reduce Traverse feature allows you to reduce a raw data file, with or without adjustment, and thus create a coordinate file or append to an existing coordinate file.

NOTE: Before you reduce a traverse, check the traverse settings on the Traverse Options tab of the C&G Options dialog.

Select the type of adjustment to use: (Compass, Least Squares, etc..)
Adjust Angles: (off/on)
Balance Elevations: (off/on)
If you are adjusting a 3-D traverse, make sure Elevations are turned on: ON

Once the traverse options are set properly you can proceed with traverse reduction.
Select Reduce Traverse from the CGTrav menu.

If a raw data file is already open, it will be used. If not, a dialog box will appear prompting you to open a raw data file.

If a coordinate is already open it will be used. If one is not opened you will be prompted to open one. You can select an existing file or type in the name of a new file to create.

**NOTE:** One coordinate file may be used with many raw data files. For example, you may store the coordinates reduced from an initial boundary traverse (raw data file) in a newly created coordinate file. If you do additional location or traverse work with the control created by the original traverse, this additional work may be placed in new raw data files and reduced to the same coordinate file.

If the raw data file does not have traverse codes *(see the CGEditor chapter)* a dialog will appear asking you which type to use. There are three types of traverses that can be processed. These are shown in the following figure:

The following figures show examples of the three traverse types. The H.I. and rod height entries are optional (if Elevations are on). These are examples of a single distance/angle entry. Each type traverse may be placed in a separate raw data file and reduced into a single coordinate file. However, with the use of special codes you can combine traverses in a single raw data file *(See the CGEditor chapter)*.

**Traverse Reduction Types:**

**Closed Loop Traverse**
Closed Loop Traverse Beginning and Ending at Known points

Shows above is closed traverse beginning on two known points (1 and 2) and ending on two known points (4 and 5). With this type of traverse, both a linear and angular closure can be calculated.
Closed Loop Ending on One Known Point

<table>
<thead>
<tr>
<th>Instr Point</th>
<th>Inst Height</th>
<th>Backsight</th>
<th>Rod Height</th>
<th>H Orr.Angle</th>
<th>° Slope Dist</th>
<th>° Vert.Angle</th>
<th>Foresight</th>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP</td>
<td>2</td>
<td>5.00000</td>
<td>1</td>
<td>0.00000</td>
<td>0.00000</td>
<td>0.00000</td>
<td>7</td>
<td>TP</td>
<td>H&amp;T</td>
</tr>
<tr>
<td>FS</td>
<td>7</td>
<td>5.23000</td>
<td>2</td>
<td>5.60000</td>
<td>56.11156</td>
<td>164.12000</td>
<td>68.20200</td>
<td>8</td>
<td>H&amp;T</td>
</tr>
<tr>
<td>IP</td>
<td>8</td>
<td>5.34000</td>
<td>7</td>
<td>5.80000</td>
<td>217.40500</td>
<td>193.51000</td>
<td>90.58300</td>
<td>8</td>
<td>H&amp;T</td>
</tr>
<tr>
<td>FS</td>
<td>8</td>
<td>5.34000</td>
<td>7</td>
<td>5.80000</td>
<td>162.14000</td>
<td>191.57000</td>
<td>92.03140</td>
<td>4</td>
<td>IPF</td>
</tr>
<tr>
<td>FS</td>
<td>4</td>
<td>5.30000</td>
<td>8</td>
<td>5.80000</td>
<td>62.55100</td>
<td>0.00000</td>
<td>0.00000</td>
<td>5</td>
<td></td>
</tr>
</tbody>
</table>
Shown above is a traverse that begins on two known points, or a single known point and a back sight azimuth, and ends on one known point. This situation sometimes occurs when you begin on two known points (or a single known point and a back sight azimuth) and end on one known point. In this case only a linear closure is possible.

In order to reduce this type of traverse you must use the CGEditor to enter data not gathered in the field. Points 2 and 4 are the known beginning and ending points. Points 100 and 101 do not exist. We have entered a back sight reference bearing (N 25° 23' 25'' E) from 2 to 100. Line 8 is a dummy setup (we never setup on point 4 and back sighted point 8. Line 9 shows a dummy angle to the dummy point 101.

Reduce the traverse as a closed Traverse Beginning and Ending on Known Points.

When the traverse is reduced you will have to enter one of the following:

The coordinates of point 101
The bearing from point 4 to 101. Or press <esc> for no angular closure.

If you choose no angular closure, the traverse will be reduced but will report only a linear closure. The adjustment will be made assuming no angular error.

**Open Traverse**
An Open Traverse is either an open ended traverse which ties into no known points or a file containing only side shots. In both cases no adjustment is possible.

Note: The data shown in the CGEditor views accompanying the four illustrations include instrument height (HI) and rod height entries. However, if you have elevations turned off, these entries are optional. Also, the examples use single distance and angle entries but multiple measurements are allowed.

In these figures each traverse has been placed in a separate raw data file. However, with the use of special codes you can combine multiple traverses in a single raw data file.

### Notes on Traverse Types and Reduction

**Closed and Azimuth Traverses:** If you are running azimuth traverses, the angle to the side shot is calculated and stored instead of the azimuth. After the traverse has been reduced and adjusted, the angles are used to calculate the side shot coordinates. Thus the side shots are always relative to the instrument point and backsight point used in their location. The first azimuth in the raw data file will be considered a reference azimuth and will be held.

**Reducing Loop Traverses:**

If there is at least one reference bearing in the raw data file being reduced you will not be asked for a starting bearing. If the instrument point coordinates at the first reference bearing exists, you will not be asked to enter the starting coordinates or elevation. The traverse reduction will begin from the first reference bearing in the raw data file, not necessarily the first instrument point.

If you have more than one reference bearing in the raw data file, the angular closure and adjustments will be from one reference bearing to the next. In other words, all reference bearings will be held as correct, and any angle adjustment will be done from one to the next. This feature was designed for those surveyors who perform...
Solar or Polaris observations at intermediate traverse stations, and wish to hold the observed bearing at those stations (the bearings will of course change when the coordinates are adjusted, unless you use Crandall's Rule which does not change bearings).

**Reducing Open Traverse:**

Any Reference Bearings found in the raw data file for an Open traverse will be ignored (except the starting reference bearing/azimuth to the back sight point).

**Traverse Reduction: Closed Loop**

If the first instrument point in the raw data file does not exist, you will be asked to enter the coordinates for that point.

If the first back sight point in the raw data file does not exist and you do not have a reference bearing/azimuth to the back sight point in the raw data file, you will be given the choice of entering one of the following:

- **Back sight point coordinates**

- **Bearing from the first instrument point to the first back sight point**

If you are processing a Closed Traverse that Begins and Ends on known points, and the last (tie) instrument point in the raw data file does not exist, you will be asked to enter the coordinates for that point. If the last foresight point in the raw data file does not exist and you do not have a reference bearing/azimuth to the foresight point in the raw data file, you will be given the choice of entering one of the following:
Foresight point coordinates
Bearing from the last instrument point to the last foresight point (the last instrument and foresight point are the tie points necessary for linear and angular closure calculations).

Note: The bearing from the first instrument point to the first backsight point, and the bearing from the last (or tie) instrument point to the last (or tie) foresight point will be treated as reference bearings (held fixed). These four points will not be adjusted. If there are any reference bearings in the raw data file, the angular closure and adjustments will be from one reference bearing to the next, just as in Loop Traverses.

Since you may have many foresights from the instrument tie point (side shots), you will be asked to enter which foresight point you will be tying into (unless there are no side shots at the last instrument point).

The traverse will begin by the coordinates found in the coordinate file for the first instrument point and backsight point (coordinate values can be placed directly into the raw data file). The traverse will then be calculated. When the traverse is finished, the coordinates for the last instrument point and foresight point in the raw data file will be read from the coordinate file (or raw data file) in order to calculate the angular, vertical and horizontal closure.

If Elevations are ON you will be shown the elevation control found in the Raw Data and Coordinate files that pertains to your traverse. If no elevation control is found none will be shown and you will have to ADD control. Your elevation control can be anywhere in the traverse. It does not have to be on the first point.

You will have the following option at the command line:
Point Elevation
1 500.00
[Add/Change/Delete/Go/aBort]: <G>g

Select Add to add points to elevation control: A
Select Change to change the elevation assigned to a point in the elevation control: C
Select Delete to remove a point from the elevation control: D
Select Go to calculate elevations: G
Select aBort to quit without calculating elevations B

Select the appropriate option and the elevations will be calculated based upon the supplied information.

At this point you will get two closure reports:

The first report is before angle adjustment:

********** Closure Report **********
Total angular error: -0°00'06"
Angular error per point: -0°00'01"
Correct Ending Coordinates, North: 5000.00000 East: 5000.00000
Ending Coordinates, North: 5000.04008 East: 5000.00421
Error, N: 0.04 E: 0.00 Total: 0.04 Brg: S 05°59'43"W
Distance Traversed: 2470.51 Closure: 61308

The Second Report is after angle adjustment:

********** Closure Report **********
Total angular error: 0°00'00"
Angular error per point: 0°00'00''
Correct Ending Coordinates, North: 5000.00000 East: 5000.00000
Ending Coordinates, North: 5000.04314 East: 5000.01593
Error, N: 0.04 E: 0.02 Total: 0.05 Brg: S 20°16'08''W
Distance Traversed: 2470.51 Closure: 53721

Following the angular adjustment the reduced traverse will be displayed:

Adjusted by Least Squares
Bearing Distance Northing Easting Elevation Pt ID Code Description
5000.00000 5000.00000 500.00 1 1 TP1 2
N 00°00'00''E 242.12 5242.12397 5000.00000 496.39 2 1 tpons
N 74°41'24''E 199.78 5294.87495 5192.69243 467.97 3 1 tpons
N 00°22'42''W 148.48 5443.34679 5191.71202 460.90 4 1 tpons
N 04°35'35''W 310.32 5752.67444 5166.86125 458.07 5 1 tpons
S 83°11'32''W 300.98 5716.99780 4868.00744 473.72 6 1 tpons
S 84°09'21''W 290.03 5687.46658 4579.48877 472.10 7 1 tpons
S 13°25'02''E 137.70 5553.52582 4611.44085 484.33 8 1 tpons
S 05°29'41''E 234.70 5319.90709 4633.91387 501.54 9 1 tpons
S 13°25'02''E 308.42 5019.23837 4702.63376 517.34 10 1 tpons
S 86°17'54''E 297.99 5000.00000 5000.00000 500.00 1 1 TP1 NAIL

Sq. Feet: 341547 Acres: 7.8

Once the traverse is reduced the side shots will be computed and displayed:

Side Shots
Angle Distance Northing Easting Elevation Pt ID Code Description
Inst.Pt.: 1 Bs.Pt.: 10
148°15'53'' 123.43 5058.01266 5108.95161 489.96 47 3 ipf1otp
97°53'24'' 46.81 5045.85154 5009.40500 499.25 48 2 iprb
17°33'40'' 96.60 5035.03240 4909.97367 506.27 49 2 ipf4rb
Inst.Pt.: 2 Bs.Pt.: 1
255°33'17'' 93.22 5265.37939 5090.27763 480.73 25 4 ipf1\2ctp
146°29'54'' 17.38 5256.61928 4990.40516 500.49 26 4 ipf1\2ctp
Inst.Pt.: 3 Bs.Pt.: 2
297°01'47'' 18.33 5276.92239 5188.96820 468.73 27 4 ipf1#ctp
Inst.Pt.: 4 Bs.Pt.: 3
10°21'19'' 65.64 5378.69600 5180.33917 466.55 28 4 ipf1ctp
159°23'20'' 63.27 5502.41856 5169.04898 461.70 29 3 ipf1otp
113°52'33'' 138.30 5498.48975 5064.87673 483.03 30 4 ipf1\2ctp
113°47'52'' 186.84 5517.60975 5020.26008 489.30 31 9 fly
291°56'23'' 100.21 5406.52118 5284.90634 455.81 32 9 fly
299°04'02'' 111.18 5389.97593 5289.24079 455.88 33 4 ipf1ctp
Inst.Pt.: 5 Bs.Pt.: 4
39°33'59'' 47.28 5713.93615 5139.76338 458.30 34 4 ipf1ctp
260°33'36'' 119.08 5781.54910 5282.38627 464.12 35 2 ipf4rb
72°51'12'' 136.19 5702.23225 5040.36168 469.98 36 4 ipf1\2ctp
Inst.Pt.: 8 Bs.Pt.: 7
32°47'04'' 103.73 5651.38227 4645.83837 475.70 37 9 nf
150°46'50'' 209.58 5399.34540 4753.39990 512.22 38 9 fly
104°48'11'' 144.87 5550.02257 4756.26507 497.59 39 9 fly
Inst.Pt.: 10 Bs.Pt.: 9

Chapter 18. CGSurvey Module 1254
The calculate points will be stored in the coordinate file. There is an overwrite protection built into the software. If a point already exists in the coordinate file you will have the following options:

**CANCEL**: will terminate the process of storing coordinates.

**OVERWRITE**: will overwrite the existing point.

**DO NOT OVERWRITE**: skip to the next point. If you have the "Do Not Ask Again" box checked, OVERWRITE will overwrite all points without asking.

**DO NOT OVERWRITE**: will only write NEW points to the coordinate file.

### Traverse Reduction: Open Traverse/Side Shots

When reducing these types of traverses, no adjustments are possible. The coordinates for instrument points and back sight points will be pulled from the coordinate file (or raw data file) and used to calculate and store the foresights. This option allows you to occupy newly created points.

Coordinates of back sight points will be calculated only if a distance has been entered to the back sight point and the back sight point does not exist in the coordinate file.

If you are back sighting a point that does not exist in the coordinate file and the raw data file does not contain a reference bearing or azimuth to the back sight point, you will be given the choice of entering one of the following:

**Coordinates of the back sight point**

**Bearing from the instrument point to the back sight point**

If you choose to enter the bearing and there is no distance to the back sight point in the raw data file (thus making it impossible to calculate its coordinates), and you later occupy that point, you will be asked to enter the
real coordinates of the point.

If you are backsighting a point that does exist, and you have a distance measurement to the backsight point in the raw data file, we will show a warning if the inversed distance from the coordinate file does not match the measured distance within the tolerances set in the CGTools->Global Options->Traverse Options dialog.

A table will be printed containing the following:

<table>
<thead>
<tr>
<th>Side Shots</th>
<th>Angle Distance Northing Easting Elevation Pt ID Code Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inst.Pt.: 1 Bs.Pt.: 10</td>
<td>148°15'53'' 123.43 5058.01266 5108.95161 489.96 47 3 ipf1otp</td>
</tr>
<tr>
<td></td>
<td>97°53'24'' 46.81 5045.85154 5009.40500 499.25 48 2 ip4rb</td>
</tr>
<tr>
<td></td>
<td>17°33'40'' 96.60 5035.03240 4909.97367 506.27 49 2 ip4rb</td>
</tr>
</tbody>
</table>

**Angle Adjustments**

If you have set Adjust Angles in the Traverse Options dialog box, all angles will receive equal adjustment. If there is more than one reference bearing, the angles will be adjusted equally between reference bearings. You will be shown the closures before and after the angle adjustment.

**NOTE:** If you are going to use the Least Squares Adjustment, you should not adjust the angles. Angular adjustment is part of the Least Squares Adjustment process.

**Elevation Adjustment**

If you have set Adjust Elevations in the Traverse Options dialog box, the elevations will be adjusted in proportion to the lengths of the lines (the longer the line, the more the adjustment).

**Least Squares, Crandall's and Compass Rule**

If you select any of these adjustment options the coordinates will be adjusted with the appropriate method.

**Find Bad Angle**

If you have a bad angular closure, select Find Bad Angle in the Traverse Options dialog box instead of an adjustment type. This function will not create or store any coordinate points.

**NOTE:** This option cannot be used with Azimuth Traverses.

You will see the following report:

Total angular error: 0\(^\circ\)00'07''
Angular error per point: 0\(^\circ\)00'01''
Correct Ending Coordinates, North: 10000.00000 East: 10000.00000
Ending Coordinates, North: 10000.05876 East: 9999.95840
Error, N: 0.05876 E: -0.04160 Total: 0.07200 Brg: S 35°17'49''E
Distance Traversed: 1492.10800 Closure: 20725

Instrument point: 1, Error: 0.07200, Closure: 20725
Instrument point: 2, Error: 0.08249, Closure: 18089
Instrument point: 3, Error: 0.08284, Closure: 18013
Instrument point: 4, Error: 0.07542, Closure: 19785
Instrument point: 5, Error: 0.06751, Closure: 22103
Worst Closure: 18013
Average Closure: 19620
Possible bad angle at instrument point: 5, Closure: 22103

In the above example, there were 5 traverse points. The traverse is reduced five times, beginning at each traverse point. The starting instrument point that produces the best closure is shown as having the bad angle. All closures are shown.

OTHER METHODS OF TRAVERSING

Every surveyor has his own unique methods when it comes to traversing. This section describes and shows examples of four additional entry methods.

Notice in the sample traverses there is a distance and vertical angle recorded for each foresight and back sight. This is optional, but you need at least one distance to each foresight.

Where both foresight and back sight distances are recorded, distances will be averaged when reduced

Side shots may be entered along with traverse information. You may turn more than one angle to side shots if you wish.

A description and/or code only needs to be entered once for a given foresight point.

Single Position with Direct and Reverse Angles

Perform this method as follows:
Shoot the back sight.
Turn to a foresight.
Record the angle and distance.
Plunge the instrument.
Take another reading (reversed) to the foresight. You may do this to traverse points and side shots.
Turn back to the back sight with the instrument reversed.
Record another angle to the back sight.
The final angle in each set for each instrument point must be a reverse reading to the back sight.
The angle in the instrument for the first back sight will be subtracted from the first angle to each foresight. The final (reverse) angle to the back sight will be subtracted from the second angle to each foresight. The two resulting angles will then be averaged to give you an angle to the foresight. All distances recorded will be averaged.
Single Positions with Multiple Direct and Reverse Angles

Entering multiple sets of direct and reverse angles is very much like the preceding example where 1 direct and reverse set was entered. The only thing to remember is that each direct and reverse pair is a set. When another set is entered, it begins with a back sight direct angle (recorded like a foresight), has direct angles and reverse angles to the foresights, and ends with a reverse angle to the back sight. Do not begin a new instrument point for the second set, merely record a new back sight angle and continue with the procedure through each foresight, and end with another reverse angle to your back sight.

<table>
<thead>
<tr>
<th>SET</th>
<th>InstPoint</th>
<th>InstHeight</th>
<th>Backsight</th>
<th>Rod Height</th>
<th>Horz.Angle</th>
<th>Slope Dist</th>
<th>Vert.Angle</th>
<th>Foresight</th>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP 1</td>
<td>5.3200000</td>
<td>5</td>
<td>5.000000</td>
<td>0.00000</td>
<td>290.54000</td>
<td>80.35000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS</td>
<td>5.000000</td>
<td>109.19170</td>
<td>292.31000</td>
<td>88.35000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
<td>HT</td>
</tr>
<tr>
<td>FS</td>
<td>5.000000</td>
<td>269.15300</td>
<td>292.31000</td>
<td>211.25000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>FS</td>
<td>5.000000</td>
<td>199.32100</td>
<td>52.39000</td>
<td>90.32550</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6</td>
<td>IPF</td>
</tr>
<tr>
<td>FS</td>
<td>5.000000</td>
<td>18.32100</td>
<td>52.39000</td>
<td>265.27000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>FS</td>
<td>5.000000</td>
<td>180.00000</td>
<td>290.54000</td>
<td>271.25000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>FS</td>
<td>5.000000</td>
<td>90.00000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP 2</td>
<td>5.2000000</td>
<td>1</td>
<td>5.000000</td>
<td>0.00000</td>
<td>290.31000</td>
<td>81.31000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS</td>
<td>5.000000</td>
<td>96.03500</td>
<td>324.25000</td>
<td>88.51300</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3</td>
<td>IPF</td>
</tr>
<tr>
<td>FS</td>
<td>5.000000</td>
<td>276.03500</td>
<td>324.25000</td>
<td>271.08300</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>FS</td>
<td>5.000000</td>
<td>180.00100</td>
<td>290.31000</td>
<td>268.23000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>IP 3</td>
<td>4.9000000</td>
<td>2</td>
<td>5.000000</td>
<td>0.00000</td>
<td>324.25000</td>
<td>81.10000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS</td>
<td>5.000000</td>
<td>124.03500</td>
<td>275.84000</td>
<td>92.22400</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4</td>
<td>IPF</td>
</tr>
<tr>
<td>FS</td>
<td>5.000000</td>
<td>304.03400</td>
<td>275.84000</td>
<td>267.31700</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>FS</td>
<td>5.000000</td>
<td>179.59500</td>
<td>324.25000</td>
<td>268.50620</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>IP 4</td>
<td>5.1200000</td>
<td>3</td>
<td>5.000000</td>
<td>0.00000</td>
<td>275.84000</td>
<td>87.37600</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS</td>
<td>5.000000</td>
<td>93.02100</td>
<td>309.68000</td>
<td>85.13600</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5</td>
<td>IPF</td>
</tr>
<tr>
<td>FS</td>
<td>5.000000</td>
<td>273.02200</td>
<td>309.68000</td>
<td>270.47100</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>FS</td>
<td>5.000000</td>
<td>180.00100</td>
<td>275.84000</td>
<td>272.23600</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>IP 5</td>
<td>5.1500000</td>
<td>4</td>
<td>5.000000</td>
<td>0.00000</td>
<td>309.68000</td>
<td>90.50000</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FS</td>
<td>5.000000</td>
<td>117.30500</td>
<td>290.55000</td>
<td>91.24300</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td>IPF</td>
</tr>
<tr>
<td>FS</td>
<td>5.000000</td>
<td>297.30400</td>
<td>290.55000</td>
<td>265.35600</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>FS</td>
<td>5.000000</td>
<td>180.00030</td>
<td>309.67000</td>
<td>265.1060</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4</td>
<td></td>
</tr>
</tbody>
</table>

Azimuth Traverses
Azimuths are entered into a file with the azimuth to each foresight entered in the Foresight data entry line at the azimuth column.

**NOTE:** If you are running a Closed Loop Traverse, a reference azimuth must be placed at the last instrument point if you wish to adjust the angular error.

The reference azimuth is the correct azimuth from the last instrument point in the raw data file to the first instrument point (or last foresight).

### Traverse with Doubled Angles

Each new instrument setup requires a 0 to the back sight. The first angle to the foresight is the single angle. This angle is locked into the gun and the back sight is retaken. The second angle to the foresight is the doubled angle. You can double angles to side shots.

### Loop Traverse Beginning and Ending on External Reference Azimuths

This type of traverse occurs frequently. The example below shows a Loop Traverse that begins on an external reference azimuth and ends on an external reference azimuth. Even though this traverse closes on itself, it must be reduced as a Closed Traverse Beginning and Ending at Known Points.

Point 100 is a dummy point on the azimuth line. Line 3 shows a reference bearing from point 1 to 100 (negative means from ip to bs) of S00-00-00E.

Line 16 shows the same reference bearing.

Point number 100 need not exist in the coordinate file and will not be calculated, but a dummy backsight and foresight point number must be entered into the raw data file.
Use Of Reference Bearings and Azimuths

Reference Bearings and Azimuths are entered by Adding or Inserting a Reference Bearing data entry line. For example:
DR 1-2 123.4523
The direction from point 1 to point 2 is N23-45-23E.
Reference bearings and azimuths are optional (except for Closed Loop Azimuth Traverses). If a reference bearing is used, that direction will be held during the reduction process. More than one reference bearing may be used. The data below shows a raw data file using multiple reference bearings:

The previous data represents a loop traverse. If you choose to adjust angles, all angles will be adjusted from one reference bearing to the next (angles 1-5, 6-1). Angular closure information will also be shown from one reference bearing to the next. See the Reduction section of this chapter for more specific information on the use of reference bearings with different types of traverses.
Except for an initial reference bearing to the back sight point, reference bearings will be ignored for Open Traverses (no adjustments are available).

Multiple Traverse Codes in a Single File

This sample is of a raw data file that contains multiple traverse codes in a single file: ET end main loop traverse Scale factors are placed after Instrument Point data entry lines. Any text following a LT, CT, OT or ET marker is
used for comments. Notice that the codes MUST precede the first instrument setup that begins the traverse. The Foresight Tie Point in the previous example is necessary because there is a side shot (point #25) at the end of the Closed Traverse. The reduction routine does not know whether you are tying into point 25 or point 2.

**Pull Down Menu Location:** CGTrav\ Reduce Traverse  
**Keyboard Command:** RT, CG_REDUCE_RAW  
**Prerequisite:** Open Raw file *.CGR

---

**Edit Map Check File**

The map check program is used to enter or edit deed and map information for checking closures and to assist with evaluating data from other sources for a job you are working on.

**Note:** for further and complete information on using the Mapcheck editor, see the chapter on CGEditor in the Tools section.

**Pulldown Menu Location:** CGTrav/Edit Mapcheck File  
**Keyboard Command:** EM, CG_EDIT_MAP  
**Prerequisite:** None

---

**Reduce Map Check File**

If a map check file is not open, a file dialogue box will appear, allowing you to open an existing map check file. If you wish the coordinates to be adjusted, select the type of adjustment in the Traverse Options dialog box. If a coordinate file is not open, a file dialog box will appear allowing you to open one. **NOTE** You may use the same coordinate file as often as you wish. Make sure the correct coordinate file is open. **Next Enter Point values:** the starting Point number, Northing and Easting and the ending Northing and Easting:
The map data will then be reduced and the coordinates stored in the coordinate file. Overwrite protection is in place in case the points already exist in the coordinate file. If a point already exists in the coordinate file you will have the following options:

CANCEL: will terminate the process of storing coordinates.
OVERWRITE: will overwrite the existing point.
DO NO OVERWRITE: skip to the next point. If you have the "Do Not Ask Again" box checked.
Overwrite will overwrite all points without asking, and Do Not Overwrite will only write NEW points to the coordinate file.

The initial closure information will be shown. For example:

Correct Ending Coordinates, North: 5000.0000 East: 5000.0000
Ending Coordinates, North: 5071.8346 East: 4894.7441
Error, N: 71.83 E: -105.26 Total: 127.43 Brg: S 55ø41'15''E
Distance Traversed: 1308.19 Closure: 10

A full report including acreage may be viewed by pressing the F2 key to view the CAD Text Window. You may also view/print the display file.
Visual Map Check

This routine allows you to graphically pick the Call Text (Bearings and Distance) from a drawing and perform a Map Check Closure.

Prompts

First you will be asked: **Pick Point of Beginning:** You can enter the beginning point number, or graphically pick the point on the screen.

Next: **Pick Bearing Text for Leg 1 (ask Reverse is ON) [Off/Done]<Done>:** Graphically pick the text with the Bearing. If "ask Reverse" is turned ON, you will be allowed to reverse the direction of the bearing after it is selected:

![Graphically pick the bearing](image)

Next: **Pick Distance Text for Leg 1:** Graphically pick the text with the distance. You will see:
If you select **YES**, you will go to the next leg. **If you select NO:** you will be asked to pick the Bearing and distance for Leg 1 again.

**After selecting all the Calls:** press ENTER for DONE. You will have the option:

If you select **YES**, the information: you selected will be placed in a Map Check File. You will be asked to select the CGM file.

Next: Enter the starting and ending coordinates for the traverse.

The map data will then be reduced and the coordinates stored in the coordinate file. Overwrite protection is in place in case the points already exist in the coordinate file. If a point already exists in the coordinate file you will have the following options:
CANCEL: will terminate the process of storing coordinates.
OVERWRITE: will overwrite the existing point.
DO NO OVERWRITE: skip to the next point. If you have the "Do Not Ask Again" box checked, OVERWRITE will overwrite all points without asking, DO NOT OVERWRITE: will only write NEW points to the coordinate file.

Below is a sample Report:
Correct Ending Coordinates, North: 10000.00000 East: 10000.00000
Ending Coordinates, North: 9586.74896 East: 9586.74832
Error, N: -413.25104 E: -413.25168 Total: 584.42568 Brg: N 45°00'00"E
Distance Traversed: 1492.10700 Closure: 3

Adjusted by Least Squares
Bearing Distance Northing Easting Elevation Point ID
10000.00000 10000.00000 900.00000 1
S 58°19'27"W 146.64772 9922.99352 9875.19793 2
N 05°19'46"W 299.65818 10221.35627 9847.36450 3
N 73°17'06"W 156.24457 10266.29428 9697.72179 4
S 04°35'43"E 226.90862 10040.11507 9715.90113 5
S 64°19'20"E 371.14929 9879.29253 10050.39763 900.00000 1

Sq. Feet: 814183.13568 Acres: 18.69107

Pulldown menu Location: CGTrav
Keyboard Command: VM, cg_visual_mapcheck
Prerequisite: Call Text must be displayed to select

Create StarNet File
This option converts a raw data file to the Star*Net (.DAT) format. The raw data file will be preprocessed. During conversion, multiple distances and angles will be averaged and compared to the maximum ranges set in the Traverse Options dialog box. To use this option properly, you must know how Star*Net works. You should be familiar with all Star*Net codes and commands.
NOTE: This manual is not a substitute for the Star*Net manual.

Below is a sample raw data file that contains three different traverse types. This raw data file can be reduced using CG-SURVEY or written to a Star*Net file for reduction with Star*Net, both without any editing.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>X</th>
<th>Y</th>
<th>Z</th>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1</td>
<td>Concrete Monument</td>
<td>1000</td>
<td>1000</td>
<td>923.56</td>
<td>C2</td>
<td>Concrete Monument</td>
</tr>
<tr>
<td>C2</td>
<td>Beginning of main loop</td>
<td>1205.25</td>
<td>1208.13</td>
<td>931</td>
<td>C2</td>
<td>Beginning of main loop</td>
</tr>
<tr>
<td>C3</td>
<td>End of main loop</td>
<td>1127.73</td>
<td>739.05</td>
<td>930</td>
<td>C3</td>
<td>End of main loop</td>
</tr>
</tbody>
</table>

```
1 5.32 5 5.00 0.00000 290.540 88.35000
2 5.20 1 5.00 0.00000 292.310 88.35000 2 H&T
5.00 289.19300 292.310 271.25100 2
5.00 180.00200 290.540 271.25100 5
2 5.00 190.32100 52.390 90.22550 6 IPF
5.00 10.32120 52.390 269.27080 6
5.00 98.03580 324.260 88.31320 3 IPF
5.00 276.03580 324.260 271.08300 3
5.00 180.00100 292.310 268.28320
3 4.98 2 5.00 0.00000 324.260 91.10000
5.00 124.03560 275.840 92.22400 4 IPF
5.00 304.03400 275.840 267.37100 4
5.00 179.95950 324.260 268.50020 2
3 5.03 2 0.00000
5.00 185.23560 135.260 95.23150 20 Nail
20 5.12 3 0.00000
```

Chapter 18. CGSurvey Module

1266
The coordinate formats (C code) are the same for Star*Net and CG-SURVEY; no translation is necessary.

If a comment line in the raw data file uses a valid Star*Net code or command, it will be used in its original form (as with coordinates); not as a comment. These codes are #, C, A, D, V, B, M, TB, T, TE, SS (followed by a space) and all dot commands. (example: .CURVE, .SCALE, etc...)

Multiplication factors are converted to the .Scale command. The original multiplication factor set in the Global Options dialog box will be placed at the beginning of the Star*Net file. Other multiplication factors will be placed as they occur in the raw data file.

NOTE: You cannot use a multiplication factor for meter/feet conversion in a 3-D traverse in Star*Net 3.2.

Reference bearings/azimuths are converted to the B format.

All traverse points are converted to the M format and side shots to the SS format. Only points used once (as a foresight point) will be considered a side shot. If a point is located from more than one instrument setup, or is used as an instrument point or backsight point, the point will be converted to a M format.

The LT, ET, OT, FT and CT codes are converted to comments. Point codes are combined with descriptions.
**If Elevations are on, the Star*Net file must be adjusted as a 3-D traverse.** The following could occur:

If you input slope distances and vertical angles, all distances will first be reduced to their horizontal/vertical components. Multiple distances will be averaged and then a slope distance and vertical angle will be recomputed from the averaged horizontal/vertical components. This is done so Star*Net can compute corrections for curvature and refraction and vertical divergence (can only be done if vertical angles are used in a 3-D traverse.) A "Delta Off" command will be placed in the Star*Net file.

If Curvature and Refraction is on in the Options/Global Options dialog box, a Curve command will be placed in the Star*Net file.

If you input horizontal and vertical distances, a "Delta On" command will be placed in the Star*Net file. No corrections for curvature and refraction or vertical divergence will be possible.

If Elevations are off in the Options/Global Options dialog box, the Star*Net file must be reduced as a 2-D traverse. The following will occur:

If you input slope distances and vertical angles, all distances will be reduced to their horizontal/vertical components and the vertical components will be thrown away. Multiple distances will be averaged.

No corrections for curvature and refraction or vertical divergence are allowed in a 2-D traverse with Star*Net version 3.2 or earlier.

**Pulldown Menu Location:** CGTrav

**Keyboard Command:** STN, CG_REDUCE_STARNET

**Prerequisite:** Open CG Raw file *.CGR

---

**CGCogo**

**General Information**

<table>
<thead>
<tr>
<th>CGCogo</th>
<th>CGDraw</th>
<th>CGMtn</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inverse</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Intersects</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Station Offset</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Points on Line</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Curves</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Area Summary</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Roadways</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stake-Out</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Best Fit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Triangulation</td>
<td></td>
<td>NAD93</td>
</tr>
</tbody>
</table>

The Command Line:
Throughout CGSurvey the user will be prompted at the command line for input. Typically the command line is at
the bottom of the CAD graphic screen, although the command line can be placed above the graphics screen. To enter a command at the command line use the keyboard, and press the <Enter> key when finished. The F2 hot key can be used at any time to access a full text window that displays user input and history.

As point numbers are typed in, or selected on the screen using the mouse, the point number entered is displayed at the command line. When the next point ID is requested the previous point ID is used as the starting point for the command.

For example, when inversing from 5 to 7. First you type 5 at the command line and press <Enter>.

Command:
[Point group/Reset/sNap on] (last point = <none>): 5
[Clockwise curve/ccW curve/Point group/Reset/sNap on] (last point = 5):

Note that 5 is now displayed as the "Last Point". This means that when 7 is entered at the command line the inverse will be calculated from point 5 to point 7.

To clear the last point enter R or "." and <Enter> for Reset. The last point will now be shown as <none>.

**Inverse**
This command allows you to determine the bearing and distance between the endpoints of a line or a curve by entering the points that define the line or curve.

After choosing the Inverse menu item you are asked to "Enter point sequence". A point sequence is a series of points that define the points being used to calculate the inverse. You may enter one point ID at a time to inverse from point to point. You may enter the two points separated by a dash (5-7), etc.

Enter point sequence
[Point group/Reset/sNap on] (last point = <none>): 5
[Clockwise curve/ccW curve/Point group/Reset/sNap on] (last point = 5): 7

Note that 5 is now displayed as the "Last Point". This means that when 7 is entered at the command line the inverse will be calculated from point 5 to point 7.

To "Reset" the last point enter R or "." and <Enter> for Reset. The last point will now be shown as <none>.

**Inversing Around Curves Clockwise**
To inverse around a clockwise curve (one curving to the right), enter the PC point ID then enter "L" or "+" to indicate a clockwise curve. Next enter the point ID of the radius point of the clockwise curve and follow with the PT point ID.

For Example:
First enter the PC of the curve. In this example type or pick point ID 2201
Enter point sequence
[cg-Point-group/Reset/turn-Snap-on] (last point = <none>): 2201

Now type L or "+" and <Enter> for a clockwise curve
Enter point sequence
[clockWise curve/Ccw curve/Point group/Reset] (last point = 2201):L

Next type or pick the radius point ID 2200
Enter radius point for curve [Reset/sNap on]: 2200

You may also use the mouse to pick a C&G Arc. In this case, the arc's radius point will be used
Next type or pick the PT point ID 2202
Enter point of tangency (PT) for curve [Reset/sNap]: 2202

**Inversing Around Curves Counter Clockwise**
To inverse around a curve in a counter-clockwise direction (curving to the left) simply type W or "-" and <Enter> then proceed as with a clockwise curve.

**Inversing between a series of points in the coordinate file**
By entering 2 point numbers separated by a "+" you can inverse through successive point IDs in the order they are found in the coordinate file (either numeric or alphabetic order). For example, if you enter 3+6, inverses will be calculated and displayed from point 3 to 4, 4 to 5 and 5 to 6. You can use the <F2> key to view the information printed at the command line or you can view the print file (CGFile > Print/View Print File).

**Inversing using Point Groups:**
You can use a Point Group to inverse between a series of points specified by the point group. To specify a point group type a P or 's' and <Enter> at the command line. This will display a dialog box showing the Point Groups currently in the default directory.
Prompts

Enter point sequence
[Point group/Reset/sNap on] (last point = <none>): Enter or pick the first point on a line or the PC of a curve. Type "P" and Enter to use a point group to specify the inversing sequence. Type "R" and Enter to Reset the last point. Type "N" and Enter to turn on CAD snaps (these are turned off when the command starts).
[ccW curve/Point group/Reset/sNap on] (last point = 5): Enter or pick the next point ID to inverse to or type "L" and Enter or "W" and Enter to specify the radius point of a curve.
if you are entering a curve:

Enter radius point for curve [Reset/turn Snap on]: Enter or pick the radius point for the curve.
Enter point of tangency (PT) for curve [Reset/turn Snap on]: Enter or pick the PT point for the curve.

Pulldown Menu Location: CG-Survey > Cogo
Keyboard Command: cg_inverse
Prerequisite: coordinate file

Intersects
This feature allows you to calculate intersections based on one of the following methods:

Bearing-bearing
The bearing-bearing intersect is calculated based on a line passing through a point on a given bearing intersecting another line passing through a second point on another specified bearing.

Bearing-distance
This is based on a line passing through a point at a given bearing intersecting a circle at a given distance (radius) from a second point. This intersection by result in 2 points of intersection.

Distance-distance
This is based on intersecting a circle at a given distance (radius) from a point with another circle at another given distance (radius) from a second point. This may also result in 2 points of intersection.

Perpendicular
This is based on calculating the perpendicular distance from a given point to a line that passes through another point
Tangent
This is based on calculating the tangent points of a line drawn from a given point to a circle having a specified radius and radius point.

Command line input
After selecting the Intersects option on the CGCogo pull down menu and the Use Intersects Dialog menu item is not checked you will see the following prompt.

Intersection method: Brng-Brng/Brng-Dist/Dist-Dist/Perp/Tangent or offsets-on
[BB/BD/DD/Perp/Tangent/turn-Offsets-on]:

Bearing-Bearing Intersections:

Type "bb", then press <Enter>
At the Enter first Point: prompt type in or pick the point using the mouse
As an illustration, using the example shown in the figure: type or pick point 2203.
At the Enter first bearing: prompt there are 3 options available:
Type the bearing directly using the special C&G notation qddmmss (quadrant, degrees, minutes and econds)
105.2316 (N 05° 23' 16''E)

Enter the two known C&G points that define the bearing either by typing the two points in with a dash between them or picking the two points one at a time using the mouse.
Or select a C&G line. When you select a line the bearing is computed by inversing between the two points that created the line. The bearing quadrant is based on traversing from the end point of the line farthest from the location where the line was picked to the end point of the line nearest to the point picked.

Enter second point: for the example type or pick point 2204
Enter second bearing: use any of the methods outlined for entering first bearing.
The intersection will then be calculated, the intersection point saved to the coordinate file and the results displayed at the command line.

When saving the intersection point, depending on your settings on the Global Settings tab of the C&G Options dialog, you may be asked to either enter or change the point ID, elevation, point code and description.

At each of the STORING POINT prompts there is an option to change settings [Settings]. Pressing S will bring up the Global Options tab of the C&G Options dialog box, allowing you to change settings prior to saving the point. (see the CGTools Chapter for a description of the CGOptions dialog box)

**Bearing-Distance Intersection**

![Bearing-Distance Intersection Diagram](image)

Type bd to calculate the intersection of a circle with a line. Generally, the data is entered in the same fashion as for a bearing-bearing intersection.

Once the data is entered each of the two solutions will be displayed one at a time.

You will be asked if the solution shown is the correct solution.

Is this the correct solution [Yes/No/ESC]:

If the solution is the correct one press Y for <Yes>. If it is not the correct solution press N for <No> and the second solution will be displayed. If neither solution is correct press <Esc> to cancel and return to the previous prompt.

**Distance-Distance Intersection**
Type dd to calculate the intersection of two circles: with the distances being the radii of the circles. You will be prompted to enter the first radius point and distance (radius). You will then be asked to enter the second radius point and distance (radius). As with the bearing-distance intersection, the two possible solutions will be displayed and you will be asked to choose the correct one (see dialog below).

If you click the No button the other possible solution will be displayed. If you click the Yes button the intersection point will be stored. If you click Cancel the point will not be stored.

The routine will continue with additional DD Intersections prompts until you escape [ESC] the routine. The process will be repeated until the user presses <Esc> twice to end the command.

**Perpendicular Intersection**
Press P and <Enter> to calculate the point where the perpendicular constructed from a given point to a line intersects the line.

At the Enter first Point <>: prompt, type or pick a point on the line (in the example illustrated in the figure, type or pick point 2514)

At the Enter bearing: <>: prompt, type the bearing of the line or type or pick the two points defining the bearing (in the example, 2514-2513)

You will then be asked if you want to Store Perp. Int. Pt. (Yes/No):

Choose whether to store the calculated point or simply view the data (you may not want to save the resulting intersection point).

Enter second point <>: Type the point ID, or use the mouse to pick the point from which the perpendicular to line is to be constructed (in the example, 2488).

The STORE POINT prompt will indicate the point being stored (in the example it will be 2489). Press <ESC> to cancel point storage.

To exit the Intersects feature, the user must press <Esc> twice or the routine will repeat.

Tangent Intersection
Type T and <Enter> to calculate the points at which a line from a given point becomes tangent to a circle. You must choose a radius point for the circle, the radius of the circle, and the external point from which the tangent will start.

At the Enter radius point for circle: prompt, type or pick the center or radius point of the circle (in the example, 2490)

At the Enter radius of circle: prompt, type the radius or type or pick two points that define the radius distance (in this example, 2490-2492, or 69.92’)

At the Second point: prompt, type or pick the point through which the tangent lines must pass (in the example, 2491)

As in some of the other intersection types, you must select the desired solution from the two possible solutions using the dialog shown for the distance-distance intersect. If you click the Yes button, the intersection point will then be saved to the coordinate file and the results displayed at the command line.

To end the command, press <Esc> twice or the routine will repeat

**Turn-Offsets-on:**
Type O and <Enter> to turn the use of offsets on or off.
An example of an offset intersection would be the easement lines for a sewer line. This routine can calculate the offset intersection say for a 7.5' left offset and a 10' right offset, as shown.
For example:
Enter first offset distance <>: -7.50

Enter Second offset distance <-7.50>: 10.00
The offset distances are positive if right of the line, as seen looking down the line in the direction of the defined bearing, negative if left of the line.

Intersects dialog
If the Use Intersects Dialog menu item is checked you will see the following dialog:

To use the Intersects dialog just set the Intersect Type drop down list to specify the type of intersect you wish to do. Next click on the item you wish to specify. You may type in the information or you can move the cursor over the drawing area and you will be prompted for the information required for the edit box you were last in. To enter the next item, click on that edit box and type the information or, as before, move the cursor over the drawing and you will be prompted for the necessary information for the last edit box you were in. Continue to do this until all information has been entered then click the Compute button to compute the intersection. The results will be printed
on the CAD command line and to the print file. If the Store Intersect Point check box is checked the intersection point will be stored in the coordinate file. You may specify offsets by checking the Specify Offsets checkbox and entering or picking the offset distance(s). Click the Reset button to remove all entered data from the dialog.

You may perform any other commands while the Intersects dialog is displayed - the data entered in the dialog will remain for use at any time.

**Prompts**

Not using Intersects Dialog:

**Intersection method:** Brng-Brng/Brng-Dist/Dist-Dist/Perp/Tangent or offsets-on

[BB/BD/DD/Perp/Tangent/turn-Offsets-on]: Type the 1 or 2 capitalized letters to specify the type of intersect to calculate or to turn offsets on.

Point prompts:

- **Enter point:** Type a point ID or pick a point symbol on the screen.
- **Enter first point:** Type a point ID or pick a point symbol on the screen.
- **Enter second point:** Type a point ID or pick a point symbol on the screen.
- **Enter radius point for circle:** Type a point ID or pick a point symbol on the screen.
- **Enter point on tangent line:** Type a point ID or pick a point symbol on the screen.

Bearing prompts:

- **Enter bearing** \(<100.0000>\): Type or pick the bearing.
- **Enter first bearing** \(<100.0000>\): Type or pick the bearing.
- **Enter second bearing** \(<100.0000>\): Type or pick the bearing.

Distance prompts:

- **Enter distance** \(<0.000000>\): Type or pick the distance.
- **Enter 1st distance** \(<0.000000>\): Type or pick the distance.
- **Enter radius of circle** \(<0.000000>\): Type or pick the distance.

Perpendicular intersect prompt:

- **Store perpendicular intersect point [Yes/No]** \(<N>\): Type "Y" or "N" and Enter.

Stopping to allow viewing of intersect point (red X) \(<\text{Enter to continue}>\) This prompt is displayed if you answered "N" to the previous prompt. Just press Enter to continue.

**Intersects dialog:** Type or pick the data into the appropriate edit boxes then click the Compute button to view the results and save the intersection point to the coordinate file.

**Pulldown Menu Location:** CG-Survey > Cogo

**Keyboard Command:** cg_intersects

**Prerequisite:** coordinate file

---

**Station Offset**

**Station Offset**

In order to use the station offset functions, you must create a Point Group (formerly called a batch point file or point file) defining a centerline alignment. The Coordinate Management > Point Groups > Create section describes how you can create a Point Group.

To illustrate the use of point groups in the various station offset features, the following point group file will be used:

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.25+ (Slope in, 1st vert. Curve)</td>
</tr>
<tr>
<td>1.75- (Slope out, 1st vert. curve &amp; slope in, 2nd vert. Curve)</td>
</tr>
<tr>
<td>200+ (Vertical Curve Length curve 1)</td>
</tr>
<tr>
<td>/123.50 (PVI Elevation curve 1)</td>
</tr>
<tr>
<td>*1300 (PVI Station curve 1)</td>
</tr>
<tr>
<td>2.00- (Slope out of curve 2)</td>
</tr>
</tbody>
</table>
NOTE: Information shown in parenthesis are comments used here for explanation and do not appear in the point group file itself.

Alignment used for examples

**Coords From Station Offset**
This feature allows you to calculate and store a coordinate point for any given station and offset along an alignment defined by a point group. Use the Select a C&G Point Group File dialog to open a point group file.
Enter Starting Station [Done] <0.0000> You can Press <Enter> to use the default station shown, or you can enter a new starting station. If you enter a "+" followed by a value, ex. "+50", all stations on a 50 foot interval will be calculated automatically.

Enter Offset <0.00000>: Enter the offset distance from the alignment.

The point ID, station, offset, northing, easting, elevation and description will be printed at the command line and written to the print file.

You may repeat the process until you have calculated all the desired stations or press D then <Enter> to exit the command.

Note: If Elevations are set to "Calculate" and Elevation is on, (See General tab of the C&G Options dialog) then you will be asked to "Enter constant elevation change for offset points". The constant elevation change will be added to or subtracted from the calculated elevation of each newly created point on the alignment. If there is vertical curve information contained in the point group, this information will be used to calculate the initial elevation of each point. If there is no vertical curve information, the elevation of each new point will be calculated by interpolation between the elevations of the points contained in the point group.

Prompts

Enter Starting Station [Done] <0.0000>: You can Press <Enter> to use the default station shown, or you can enter a new starting station.

Enter station [Interval] <0.000000>: Enter a station expressed as a decimal number. Type "I" and Enter to specify an interval or, alternatively, you can precede the station number with a "+". This will cause stations to be automatically calculated based on the value you specify. If you choose Interval in the previous prompt:

Enter interval: Enter the desired interval for automatic generation of stations.

Enter offset (+ = right, - = left) <0.000000>: Enter the offset distance from the alignment.

Pulldown Menu Location: CG-Survey > Cogo > Station Offset

Keyboard Command: cg_crds_from_staoft
**Prerequisite:** coordinate file, point group file defining the alignment

---

**Create Point Group From Station Offset**

This feature allows you create a point group by locating all the points along a predefined alignment at a given offset. It then sorts the points by station and saves the points to a new Point Group.

Select Create Point Group from Station-Offset from the menu.

Use the Select a C&G Point Group File: to open the point group file specifying the points in the alignment.

At the Calculate new points on the control line [Yes/No] <Y> prompt,

If you answer no to this prompt, the points chosen by you in the previous step will be saved in station order to the new point group file.

If you answer yes to the prompt, a new point will be created exactly on the offset line for each point found in the coordinate file that lies within the given range. The elevation of the new point will be set to the elevation of the nearby existing point and the new point IDs will be written to the new point group file instead of the existing point IDs.

Repeat the above steps to specify another offset.

Press D for <Done> to exit.

---

**Prompts**

*At the Enter Offset <0.0000>:* Type an offset if desired or just press enter for no offset. Offsets to the left should be preceded by a ".".

*At the Enter Maximum Range <0.0000>:* Specify the tolerance for points not exactly on the alignment.

*Choose initial points for base selection set from coord file. (Enter when done)*

*[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/Select]:* Use the various methods available to choose the points to be tested for being within the tolerance from the alignment.

*Calculate new points on the control line [Yes/No] <Y>:* Type "Y" and Enter or just Enter to create new points on the alignment for those points found to be near the alignment and place these new point IDs in the point group being created. Type "N" and Enter to place the existing points in the point group being created.

---

**Pull down Menu Location:** CG-Survey > Cogo > Station Offset

**Keyboard Command:** `cg bpf_from_sta`

**Prerequisite:** coordinate file, point group containing the points in the alignment

---

**Display Centerline Stations**

This feature allows you to view a list of the centerline stations for a given point group.

In the file dialog select the point group file that defines the alignment.
At the Enter Starting Station [Done] <1000>: prompt you will notice that the subgroup name is used to determine the starting station default value. To use the default value, press <Enter>. You may also enter a new starting station for the first point in the point group. For example, 24+34.12 is entered as 2434.12.

The centerline station information will be listed on the command line and written to the print file.

The Enter Starting Station (Done) <0.00000>: prompt will again be displayed at the command line, at this point you can either enter another point group, or type in another starting elevation. When done entering data, type D and <Enter> for to end the command.

NOTE: The first line of the Point Group must be the beginning station of the alignment. In any routine that computes or requires stationing information the station numbers must be relative to the stationing in the Point Group file.

**Prompts**

**At the Enter Starting Station [Done] <1000>:** Enter the starting station for the alignment as a decimal number.

**Pulldown Menu Location:** CG-Survey > Cogo > Station Offset

**Keyboard Command:** cg_display_cl_sta

**Prerequisite:** coordinate file, point group file defining an alignment

**Station Offset From Coords**

This feature allows you to calculate the station and offset of selected points in the current coordinate file, based on the alignment as defined by the Point Group.
Select Station Offset from Coords from the menu. 
You will first be asked to open the point group file that defines the alignment. 
At the Enter Starting Station [Done] <0.00000>: prompt, enter the station of the first point in the point group. For example, if the first station is 24+34.12, enter it as 2434.12. 
(As an example using the point group listed in the previous section, the starting station must be greater than 1000, the starting station in the point group, and less than 2016.05, the station of the last point in the point group. If not, no information will be displayed.) 
Enter Maximum Range <0.00000>: The range identifies how far to look left and right of the alignment for points in the current coordinate file. 
Next, you will be asked to select the points to be considered in computing the station offsets 

Add points from coordinate file. (Enter when done) [All/Block/Code/Desc/Elev/Pt-group/Limit/Radius/Select]: At the prompt type A and <Enter> for all the points in the current coordinate file or use the other options to choose a subset of the points. As indicated by the prompt, press <Enter> by itself to end point selection. 
The station and offset information will be printed in order by station. 
The Enter Start Station [Done] <0.00000>: prompt will appear again, you may enter the next starting station or type D and <Enter> to end the command.

**Prompts**

**Enter Starting Station [Done] <0.00000>:** Enter the starting station as a decimal number.
**Enter Maximum Range <0.00000>:** The range defines the distance tolerance left and right of the alignment for points selected from the current coordinate file.
**Choose initial points for base selection set from coord file. (Enter when done)**

**Pull down Menu Location:** CG-Survey > Cogo > Station Offset
**Keyboard Command:** cg_stao ff_from_crd s
**Prerequisite:** coordinate file, an existing point group file defining the alignment

**Points on Line**

This feature allows you to calculate and store points along a line at specified distances.
After choosing Points on Line from the menu and, if needed, opening a coordinate file, you will see following prompt:

Pts on line - specify No. of pts & dist., divide line, or place pts at interval [Number and dist/Divide/Interval]:

Choose one of the following:
Number and dist: Type N and <Enter> to specify a number of points at a given interval from the start point on a line.
Divide: Type D and <Enter> to select a line and indicate how many points you wish to create. The program then creates the specified number of points equally spaced along the length of the line.
Interval: Type I and <Enter> to create points at the specified interval along a line defined by 2 points.

**Number and dist**

This option allows you to calculate a given number of points at a fixed distance along a line. For example, you can set the corners for 3 lots at 150’ intervals.
At the Enter start point: prompt, enter a point on the desired line by typing a point ID or picking a point with the mouse.
At the Enter bearing <100.0000>: prompt, use any one of the methods available to enter the bearing of the line on
which you wish the points to fall.

At the Enter distance <0.0000>: prompt, use any of the available methods to enter the distance between the points along the line.

Enter number of points: Enter the number of points you want created.

At the STORING POINT: prompt data required will vary depending on your current settings. You can enter a point number and its elevation, description, and code. This prompt will appear for each of the points created along the line.

The Enter start point: prompt will repeat until you press <Esc>.

Pressing <Esc> again will allow you to create points on a line using one of the other methods.

Pressing <Esc> a third time to end command.

**Divide**

Choosing this method allows you to create points by dividing a line between two points into a specified number of divisions.

Enter start point: Enter the first point defining the line by picking a point using the mouse or typing a point ID.

Enter end point: Enter the second point defining the line by picking a point using the mouse or typing a point ID.

Enter number of segments: Enter the number of points you want to create.

As the points are saved respond to the STORING POINT: prompt as required.

The Enter start point: prompt will repeat unless you press <Esc>.

After pressing <Esc> once you may choose another method of creating points on a line or press <Esc> once more to end command.

**Interval**

This option allows you to create as many points as possible at a specified interval on a line between two points.

Enter start point: Enter the first point defining the line by picking a point using the mouse or typing a point ID.

Enter end point: Enter the second point defining the line by picking a point using the mouse or typing a point ID.

Enter Distance <0.0000>: Enter the desired distance between the points created along the line. Points will be created along the line at the given distance. As many points as will fit between the end points at the given spacing will be created.

No matter which method is used to create points, the Saving Point dialog (see below) will appear for each of the points created.
Click OK to save the point in the coordinate file.

Repeat from the Enter start point: prompt or press <Esc> to use another method to create points along a line. Press <Esc> once more to end the command.

**Prompts**

Specify: Number of points and distance, divide line or points at an interval

[Number_and_dist/Divide/Interval]: Type "N" and Enter to create a specified number of points along a line a specified distance apart. Type "D" and Enter to create a specified number of points between 2 points. Type "I" and Enter to create a point a specified distance from the starting point of a line specified by 2 points.

**Enter start point:** Enter the point ID or pick the point symbol for the starting point of the line.

for Number and Dist:

**Enter bearing <100.0000>:** Enter the bearing of the line along which the points are to be created.

**Enter distance <0.000000>:** Enter the distance between the points.

**Enter number of points:** Enter the number of points to be created.

for Divide:

**Enter end point:** Enter the point ID or pick the point symbol for the ending point of the line.

**Enter number of segments:** Specify the number of points to be created on the line between its end points.

for Interval:

**Enter end point:** Enter the point ID or pick the point symbol for the ending point of the line.

**Enter distance <0.000000>:** Enter or pick the distance along the line for creating the new point.

**Pulldown Menu Location:** CG-Survey > Cogo

**Keyboard Command:** cg_pol

**Prerequisite:** coordinate file
Curves

There are several possible curve calculations available on the Curves submenu. The available options will be described in the following sections.

![Curves Submenu]

**Calculate Horizontal**

This feature allows you to calculate the components of a horizontal curve but does not save any points to the coordinate file.

In the dialog enter any two curve components then press OK to calculate the other components. To use the mouse to pick the two known components press the Pick button and pick the PC, PT and radius points or a C&G or non-C&G arc. The description field is merely used to identify the curve in the printout. The Reset button clears all fields. When done, press the Cancel button to close the dialog.

![Horizontal Curve Calculation Dialog]

**Prompts**

**Horizontal Curve Calculation dialog:** Enter any two curve components then press OK to calculate the other
**Curve Between Tangents**

This feature allows you to calculate the curve components for a curve between two tangent lines given either the radius, the length of the tangent line or a point through which the arc passes.

At the Enter first point [Done]: prompt, enter or pick a point on one of the tangent lines. The point ID of the point selected will be displayed on the command line.

Enter first Bearing <100.000000>: use any of the available methods to enter the bearing from the point you just selected going toward to the point of intersection (P.I.) of the curve. The bearing entered will be displayed on the command line.

Enter second point: type or pick a point on the other tangent line.

Enter second bearing <100.000000>: enter the bearing of the other tangent.

Offset out <0.000000>: This is an optional entry. It allows you to calculate a point outside the curve (for example, on the right-of-way). Press <Enter> to use the default value or enter another offset. The offset used will be displayed on the command line.

Offset in <0.000000>: 50 This optional entry allows you to calculate a point inside the curve.

Enter point on arc [Radius mode/Tangent-Distance mode]:

At this prompt there are three options as to how to specify the location of the desired curve:

At this prompt you can type or pick a point on the arc,

Or you can type R and <Enter> to get the prompt:

Specify radius of curve [Tangent-mode/Point-on-arc-mode]:

At this prompt specify the radius of the curve.

Or you can type T and <Enter> to get the prompt:

Specify tangent distance [Radius-mode/Point-on-arc-mode]:

At this prompt enter the distance from the PC or PT to the PI.

The locations of the PC, PI, PT, and radius point are calculated and the Saving Point dialog (see below) will appear once for each.
Depending on the Global Options settings, the calculated points may be drawn. If Auto Line Plot is on, the arc will be drawn as well. The coordinates of points that were created and the curve information will be displayed at the command line.

To end the command type D and <Enter> at the Specify an existing point on the first tangent line [Done]: prompt.

**Prompts**

**Specify an existing point on the first tangent line [Done]:** Enter or pick a point on one of the tangent lines.

**Specify the bearing of the first tangent line <100.0000>:** Enter the bearing or pick 2 points or a line to define the bearing.

**Specify an existing point on the second tangent line:** Enter or pick a point on the second tangent line.

**Specify the bearing of the second tangent line <100.0000>:** Enter or pick the bearing of the second tangent.

**Offset out <0.000000>:** This is an optional entry. It allows you to calculate a point outside the curve.

**Offset in <0.000000>:** This optional entry allows you to calculate a point inside the curve.

**Specify an existing point on the arc [Radius_mode/Tangent_distance_mode]:** Enter or pick a point on the arc or change how you define the arc by entering "R" and Enter for the Radius method or "T" for the Tangent-distance method.

**Specify radius of curve [Tangent_distance_mode/Point_on_arc_mode]:** Enter the radius or change the mode.

**Specify tangent distance [Radius_mode/Point-on-arc-mode]:** Enter the tangent distance or change the mode.

**Pulldown Menu Location:** CG-Survey > Cogo > Curves

**Keyboard Command:** cg_cbt

**Prerequisite:** coordinate file

**Middle Ordinate Solution**

Allows you to calculate the other curve elements when you can locate the chord and determine the middle ordinate distance in the field.
Prompts

Save coordinates [Yes/No] <Y>: press Enter or type "Y" and Enter if you want the calculated radius point to be stored in the coordinate file. If not type "N" and Enter. Press Esc key to end the command.

Enter P.C. point: specify the PC point by typing a point ID or picking a point on the screen.

Enter PT point: specify the PT point by typing a point ID or picking a point on the screen.

Middle ordinate: Type in the middle ordnate distance or pick it on the screen.

Pulldown Menu Location: CG-Survey > Cogo > Curves

Keyboard Command: cg_chd_mo

Prerequiste: coordinate file

Points on Arc

This feature allows you to create points along an arc. The first point is set at a distance measured along the arc starting at the PC.
Enter PC point or pick a C&G Curve: enter or pick the PC point or pick a C&G curve.
If you picked a C&G Curve, the PC, Radius point, Pt point and arc length will be displayed at the command line.
After picking a C&G Curve, skip the next 2 steps.
Enter PT point: Enter or pick the PT point.
Enter radius point [cLockwise/ccW]: For a clockwise curve either type ‘L’ or ‘+’ and <Enter> then pick or type a point ID or type a point ID preceded by a ‘+’. For a counter clockwise curve either type a ‘W’ or a ‘-’ and <Enter> then pick or type a point ID or type a point ID preceded by a ‘-’.
Enter arc length [Occupy/Multiple points] <0.000000>:  
Occupy option 
In occupy mode the points are located along the arc with the arc length being measured from the previous point. Thus the occupied point moves ahead to the last computed point as calculations proceed. When you type O and <Enter> the prompt becomes: 
Enter arc length [do not Occupy/Multiple points] <0.000000>:  
Specify the arc length at the prompt.
A point will be created and you will be prompted for the next arc length. Continue entering arc lengths until done then press <Esc> to return to the Enter PC point or pick a C&G Curve: prompt.
Multiple points option 
This option allows you to compute multiple points along the arc at a given distance. The specified distance is used to set as many points along the arc as will fit between the PC and the PT. When you type M and <Enter> the prompt becomes: 
Enter arc length [do not Occupy/Single point] <0.000000>:  
Specify the arc length at the prompt.
As many points as can be fit between the PC and the PT will be created. You will then be prompted for the next arc length. Continue entering arc lengths until done then press <Esc> to return to the Enter PC point or pick a C&G Curve: prompt.
At the Enter PC point or pick a C&G Curve: prompt you can continue specifying curves or you can press <Esc> to end the command.

Prompts

Enter PC point or pick a C&G Curve: Enter a point ID or pick a point symbol or a C&G Arc on the screen. Press Esc to end the command.
Enter PT point: Enter or pick the PT point.
Enter radius point [cLockwise/ccW]: For a clockwise curve either type ”L” (or a plus sign (‘+’)) and <Enter> then pick or type a point ID or type a point ID preceded by a ‘+’. For a counter clockwise curve either type a ”W” (or a minus sign (‘-’)) and <Enter> then pick or type a point ID or type a point ID preceded by a ‘-’. 
Enter arc length [Occupy/Multiple points] <0.000000>: Enter an arc length to create a single point on the arc. Enter "O" and Enter to "occupy" the calculated point so the next arc length is calculated from that point instead of the PC. Enter "M" and Enter to calculate multiple points along the arc at a specified distance.

Enter arc length [do not Occupy/Single point] <0.000000>: For multiple points enter the desired arc length or change input mode.

Pulldown Menu Location: CG-Survey > Cogo > Curves
Keyboard Command: cg_poa
Prerequisite: coordinate file

**Spiral Curve Design**

This feature allows you to design a spiral curve. You will be prompted using standard spiral curve component nomenclature.

Follow the prompts described in the Prompts section below and the following Spiral curve data is calculated and displayed at the command line and written to the print file.

- Point of Intersection of the spiral (PI for spiral)
- Tangent point of the spiral (TS for spiral)
- Point where spiral meets simple curve (SC for spiral)
- Radius point of the simple curve
- Point where simple curve meets outgoing spiral (CS for spiral)
- Point where spiral meets tangent on outgoing side (TS for spiral)

For each of the points calculated the prompt The Saving Point dialog (see below) will appear and allow you to specify the point ID.

Click OK to cause the point to be stored in the coordinate file.

At the Curve Description <enter if done>: prompt you can either enter the description for another curve or press <Enter> to end the command.
Prompts

Curve description <enter if none>: This description is optional but is used to identify the information in the results. Press Enter to end the command.

Enter the first point: Enter or pick a point on the tangent going into the spiral.

Enter first bearing <100.0000>: Enter or pick the bearing from first point to the P.I. of the spiral.

Enter second point: Enter or pick a point on the tangent going out of the spiral.

Enter second bearing <100.0000>: Enter the bearing from second point to the PI.

Enter Radius [Degree of curve] <0.000000>: Enter or pick the radius or type "D" and Enter to change to degree of curve prompt.

or

Enter Degree of Curve [Radius]: Enter or pick the degree of curve or type "R" and Enter to change to radius prompt.

Enter spiral length in <0.0000>: Enter or pick the length of the spiral coming from the first tangent into the simple curve. Enter a zero for no spiral in.

Enter spiral length out <0.0000>: Enter the length of the spiral from the simple curve out to the second tangent. Enter a zero for no spiral out.

Pulldown Menu Location: CG-Survey > Cogo > Curves

Keyboard Command: cg_scd

Prerequisite: coordinate file

Spiral Curve Stakeout

This feature allows you to calculate points along a spiral at a given interval and offset for use in staking out the curve in the field.

Curve Description <enter if done>: This text description is only used to identify the spiral curve data printed at the command line and written to the print file.

Enter the first point: Enter or pick a point on the tangent line going into the spiral.

Enter first bearing <100.000000>: Enter the bearing going toward the P.I. of the spiral from the first point.

Enter second point: Enter or pick a point on the tangent line going out of the spiral.

Enter second bearing <100.0000>: Enter the bearing from the tangent point just defined to the P.I. for the spiral.

Enter Radius [Degree of Curve] <0.0000>: Radius option: Entering the radius is the default option as indicated by the wording of the prompt.

Degree of Curve option: To change to entering the degree of curve type D and <Enter>.

Once you have chosen the type of data you wish to specify, type or pick the radius of the simple curve between the two tangents or the degree of curve.

Enter spiral length in <0.000000>: enter the length of the spiral from the TS (Tangent to Spiral) to the SC (Spiral to Curve). Enter zero for no spiral in.

Enter spiral length out <0.000000>: enter the length of the spiral from the CS (Curve to Spiral) to the ST (Spiral to Tangent). Enter zero for no spiral out.

Enter P.I. station <0.0000>: Enter the station of the PI. For example: station 460+28.52 is entered as 46028.52

Enter station interval <0.0000>: Specify the interval at which you wish to stake the spiral. For example, enter 50 to stake every 50 units.

Enter offset from centerline <0.0000>: This can be a positive or negative number depending on whether you want to set points inside or outside the spiral. If you want to place points on the centerline, simply press <Enter> to use
Odd stations to be staked (6+34.22 as 634.22): You can stake as many odd station locations as needed. When done press <Enter> without entering a station value. The points will be calculated and stored in the coordinate file. The station and offset will be placed in the description field. The results will be printed at the command line and in the print file. Continue to stake another spiral or press <Esc> or <Enter> at the Curve Description <enter if done>: prompt to end the command.

Prompts

**Curve Description** <enter if done>: This text description is optional and is used to identify the spiral curve in the output.

**Enter the first point**: Enter or pick a point on the tangent line going into the spiral.

**Enter first bearing** <100.000000>: Enter the bearing going toward the P.I. of the spiral from the first point.

**Enter the second point**: Enter or pick a point on the tangent line going out of the spiral.

**Enter second bearing** <100.0000>: Enter or pick the bearing from the second tangent point to the P.I. for the spiral.

**Enter Radius [Degree of Curve]** <0.0000>: Enter or pick the radius. or, to change to entering the degree of curve, type "D" and Enter.

**Enter spiral length in** <0.000000>: enter the length of the spiral from the TS (Tangent to Spiral) to the SC (Spiral to Curve). Enter zero for no spiral in.

**Enter spiral length out** <0.000000>: enter the length of the spiral from the CS (Curve to Spiral) to the ST (Spiral to Tangent). Enter zero for no spiral out.

**Enter P.I. station** <0.0000>: Enter the station of the PI. For example: station 460+28.52 is entered as 46028.52

**Odd stations to be staked (6+34.22 as 634.22)**: Enter as many odd stations as needed. When done press Enter.

**Pulldown Menu Location**: CG-Survey > Cogo > Curves

**Keyboard Command**: cg_scs

**Prerequisite**: coordinate file

**Stakeout Horizontal**

This feature allows you to create points for field staking a horizontal curve.

After choosing the Horizontal Stakeout menu item, and opening a coordinate file you will be asked if you want to Save coordinates [Yes/No] <Y>.

If you respond Yes (or press enter), a new point will be saved to the coordinate file for each point to be staked along the curve. No matter how you answer this question, stakeout information will be generated and displayed.

Enter curve description: Enter a description that will allow you to identify the curve in the output.

P.C. station <0.000000>: Enter the station for the P.C. of the curve.

Station interval <0.000000>: Enter an interval for staking the points along the curve.

Odd stations to be staked (6+34.22 as 634.22) [Done]: Enter the station of any odd location along the curve to be staked. For example, you may wish to stake the point on the curve at which a pipe crosses or the point where the extension of a property line intersects the curve. You may enter as many odd stations as required. When done, press <Enter> at the prompt without entering a new odd station or press D and <Enter>.

Offset from C/L <0.000000>: enter a non-zero value here if you must stake points offset from the main alignment - for example: along a curb line, a barrier wall or along a property line.

If the distance is entered as a positive number, the distance will be added to the radius or staked outside the curve. If the number entered is negative, it will be subtracted from the radius or staked inside the curve. To stake the centerline, enter zero.

At the Enter PC point or pick a curve: prompt you can type a point ID for the P.C. or use the mouse to pick a point.
or a C&G curve on the screen.
If you picked a C&G curve in the previous step, you need not enter the PT point or the radius point so skip the next
2 steps.
Enter PT point: type the point ID for the P.T. or click the point on the screen.
Enter radius point [cLockwise/ccW]: Use any of the available methods of specifying a radius point.
Type the radius point: If the curve is in a clockwise direction from the P.C. to the P.T., enter the point number
preceded by a plus sign, e.g. +18. If the curve is in a counterclockwise direction from the P.C. to the P.T., the point
ID preceded by a minus sign, e.g. -18.
Pick the radius point with the mouse: If the curve is in a clockwise direction from the P.C. to the P.T., type an L or a
'+' and <Enter>, then use the mouse to pick the point on the screen. If the curve is in a counterclockwise direction
from the P.C. to the P.T., type either a W or a '-' and <Enter>, then pick the point on the screen.
The report will be printed at the command line and written to the print file.
The command will repeat until you press <Esc> at the Save coordinates [Yes/No] <Y>: prompt to end command.

Prompts

Save coordinates [Yes/No] <Y>: Type "Y" and Enter or just Enter if you wish to save resulting points to
coordinate file. Type "N" and Enter if not. Press Esc to end command.
Enter curve description: Enter a description that will allow you to identify the curve in the output.
P.C. station <0.000000>: Enter the station for the P.C. of the curve.
Station interval <0.000000>: Enter an interval for staking the points along the curve.
Odd stations to be staked (6+34.22 as 634.22) [Done]: Enter as many "odd" stations to be staked. Type Enter or
"Done" and Enter when all odd stations have been entered.
Offset from C/L <0.000000>: If you wish to stake stations not on the centerline, enter the offset and press Enter
or just press Enter to accept the default offset. Positive offset is outside the radius and negative is inside.
Enter PC point or pick a curve: Enter a point ID, pick a point symbol or pick a C&G arc.
if you did not pick a C&G arc:
  Enter PT point: Enter or pick the PT point.
Enter radius point [cLockwise/ccW]: Enter "L" or "W" to choose the type of curve then Enter or pick the radius
point. You may also enter "+" and Enter then enter or pick a point for the radius point of a clockwise curve or Enter
a "-" and enter or pick a point for the radius point of a counter clockwise curve.

Pulldown Menu Location: CG-Survey > Cogo > Curves
Keyboard Command: cg_hcso
Prerequisite: coordinate file

Tangent Between Curves
This feature allows you to calculate the end points of a tangent line joining two curves. This may be used, for
example, to layout roads which do not have curve/tangent information.
Follow the prompts noted below and, if a solution is possible, the endpoints of the tangent between the two curves will be calculated. Point IDs will be assigned and coordinates stored for the points of tangency. Repeat or enter "D" when done.

NOTE: There are 4 tangent solutions for this problem. The solutions sets differ according to the sign preceding the radius or degree of curve.

**Enter first radius point** [Done]: Enter or pick the center point for one of the curves. Press Enter or type "D" and Enter when done.

**Enter first radius** <0.00000>: Enter the radius of the first curve. Use a "+" sign before the point ID to specify a clockwise curve or a "-" sign to specify a counter clockwise curve.

**Enter second radius point**: Enter or pick the center point for the second the curve.

**Enter second radius** <0.00000>: Enter the radius for the second curve. Use a "+" sign before the point ID to specify a clockwise curve or a "-" sign to specify a counter clockwise curve.

**Pulldown Menu Location:** CG-Survey > Cogo > Curves

**Keyboard Command:** cg_tbc

**Prerequisite:** coordinate file

---

**Vertical Curve Design**

This feature prints a list of station and elevation information for stations along one or more vertical curves.

Use the Odd stations to be staked (6+34.22 as 634.22): prompt to enter any stations along the curve for which you wish elevation information. This permits you to calculate elevations over culverts or at other important locations.

The calculated station and elevation information. The station, tangent elevation, tangent offset and grade elevation will be printed at the command line and in the print file. The high or low point will be marked with an asterisk. Repeat the process to design another vertical curve or press <Esc> at the Enter curve description: prompt to end the command.

**Prompts**

**Enter curve description**: Description is used to identify the curve in the output.

**Enter slope in** <0.00000>: The slope is entered as a percent. For example: enter -1.5 for a 1.5% downhill slope.

**Enter slope out** <0.00000>: Enter the slope as a percent.

**Enter length of vertical curve** <0.00000>: Enter the length of the vertical curve.

**Enter PVI Station** <0.000000>: Enter the PVI station. For example: Enter 1250.00 for station 12+50.00

**Enter PVI Elevation** <0.000000>: Enter the PVI elevation.

**Enter station interval** <0.000000>: Enter the station interval.
Odd stations to be staked (6+34.22 as 634.22): Enter any stations along the curve for which you wish elevation information.

Pulldown Menu Location: CG-Survey > Cogo > Curves
Keyboard Command: cg_vcd
Prerequisite: coordinate file

Area Summary
The Area Summary feature allows you to get information on the area and perimeter of one or more parcels and the tract that contains the parcels.

After choosing the Area Summery menu item and, if required, opening a coordinate file, you are asked to specify the type of Area Summary you want:
Type of Area Summary [Complete/Area only/Mapcheck] <C>:

Complete Area Summary
Complete summary allows you to get complete information on the area and perimeter of parcels and the tract that contains the parcels
Source of points defining area [Point group/Manual entry] <P>
If you have a Point Group, enter <P>. Enter <M> if you prefer to manually enter the points.
Once the overall area and parcels have been defined either by using a point group or manually entering the information, the Complete Area Summary is displayed at the command line.
The points used in defining the area are listed first. If there are any arcs involved in the area computation, all of the elements of the curve will be displayed as well. After listing the points defining the area, the area and perimeter summary are reported.

Area Only
The data input is the same as for the Complete Area Summary but the report produced contains only the area of each parcel and the accumulated area for the entire tract

Mapcheck Area
The data input is the same as for the Complete Area Summary as is the resulting report except that it also includes closure information. The closure information includes the correct ending coordinates; the actual ending coordinates; the northings, eastings, and bearing and distance of the error; the total distance traversed and the overall closure.

Prompts
Open Coordinate File dialog: If a coordinate file is not open, you will be asked to open one.
Type of Area Summary [Complete/Area only/Mapcheck] <C>: Press "C" and Enter or just Enter for Complete, "A" for Area only, or "M" for Mapcheck.
Source of points defining area [Point group/Manual entry] <P>: Type "P" and Enter or just Enter to use a point group to specify the points defining the tract. Type "M" and Enter to specify the points defining the tract by typing in point numbers or picking from the screen.

Pulldown Menu Location: CG-Survey > Cogo > Area
Keyboard Command: cg_asum
Prerequisite: coordinate file
Roadways

The roadways submenu contains 2 features: Right-of-Way/Easements and Intersections/Cul-de-Sacs and the Inter-
sections/Cul-de-Sacs has a submenu containing several features for each type of intersection or cul-de-sac.

Right-of-Way Easements

The Right-of-Way/Easements feature allows you to compute offsets left and/or right of an alignment.

After the alignment points have been entered, offset points will be created to the left and right of each point you
specified in the alignment. If Auto Point Numbering is on, the calculated points will be stored in the coordinate file.
Depending on your settings for Auto Line Plot and Auto Point Plot in the Graphic tab of the C&G Options dialog,
the new points and lines may also be drawn. If Auto Point Numbering is off, you will see the Saving Point dialog
and can accept or change the default point number and other information associated with the point.

Prompts

Enter offset right <0.000000>: Enter the offset to the right of the alignment.
Enter offset left <0.000000>: Enter the offset to the left of the alignment.
Method for specifying center line points [Point group/Manual entry] <P>: To use a point group type "P" and
Enter or just Enter and select the point group from a file dialog box. Type "M" and Enter to specify the alignment
interactively.

Pulldown Menu Location: CG-Survey > Cogo > Roadways
Keyboard Command: cg_rw
Prerequisite: coordinate file containing points defining the alignment

Intersections/Cul-de-sacs

T Intersections

This feature allows you to calculate the right-of-way intersection points and/or the fillet points and fillet radius points
(if fillets are used) at T type intersections. One or both of the roads may have arc centerlines.
The points defining the fillet points will be calculated and stored in the coordinate file. Repeat as needed or press <Esc> or <Enter> at the Enter C/L intersection point (Enter when done): prompt to end the command.

**Prompts**

**Enter C/L intersection point (Enter when done):** enter or pick the centerline intersection point.

**Enter through road C/L bearing [Arc] <0.000000>:** If the through road is a straight road, enter or pick the bearing for the road. Otherwise type A and <Enter> to switch to Arc mode and enter the radius point of the through road.

**Enter through road width <0.000000>:** Enter the width of the through road.

**Enter 2nd road C/L bearing away from intersection [Arc] <0.000>:** enter the 2nd bearing or press <A> for Arc and enter the radius point. The bearing is away from the intersection.

**Enter 2nd road width <0.000>:** Enter the 2nd road width.

**Enter fillet radius <0.000>:** If you do not want to have fillets, press <Enter> to use the 0.00 default value. Otherwise, enter the fillet radius.

**Pulldown Menu Location:** CG-Survey > Cogo > Roadways > Intersections/Cul-de-sacs

**Keyboard Command:** cg_tint

**Prerequisite:** coordinate file

**X Intersections**

The radius, PC and PT points for each fillet will be calculated and stored. If Auto Line Plot is on, the fillet arcs will be drawn. Repeat as needed then press Enter or Esc to end the command.
Prompts

Enter C/L intersection point (Enter when done): enter or pick the intersection point of the two road centerlines.
Enter 1st road C/L bearing [Arc]: If first road is straight, enter the 1st bearing. If it is an Arc, enter the 1st radius point.
Enter 1st road width: Enter 2nd road C/L bearing (Arc): If the intersection point for the first road centerline is on a straight segment, enter the bearing of the centerline. If it is on an arc, type A and <Enter> then enter the first road centerline's radius point.
Enter 2nd road width: Enter the second road width.
Enter 2nd road C/L bearing [Arc]: Enter the second road centerline bearing or type A and <Enter> and specify the centerline radius point for the second road.
Enter fillet radius: Enter the fillet radius or zero, if there are no fillets.

Pulldown Menu Location: CG-Survey > Cogo > Roadways > Intersections/Cul-de-sacs
Keyboard Command: cg_xint
Prerequiste: coordinate file

Y Intersections

The radius, PC and PT points for each fillet will be calculated and stored and if Auto Line Plot is on, the fillet arcs will be drawn. Repeat as necessary then press <Esc> or <Enter> to end command.

Prompts

Enter C/L intersection point (Enter when done): Enter or pick the intersection point for the three road centerlines.
Enter 1st road C/L bearing away from intersection point: Enter one of the road centerline bearings (going away from the intersection point).
Enter 1st road width: enter the first road width.
Enter 2nd road C/L bearing away from intersection point: Enter another of the road centerline bearings (going away from the intersection.)
Enter 2nd road width: Enter the width of the second road.
Enter 3rd road C/L bearing away from intersection point: Enter last of the road centerline bearings (going away from the intersection.)
Enter 3rd road width: Enter width of third road.
Enter fillet radius: Enter radius of fillets or zero for none.
Pulldown Menu Location: CG-Survey > Cogo > Roadways > Intersections/Cul-de-sacs
Keyboard Command: cg_yint
Prerequisite: coordinate file

Bubble Cul-de-Sac

This type of cul-de-sac is also called a fish-eye cul-de-sac. It is commonly used at sharp turns in roads in subdivisions.

Follow the prompts described below. When done the fillet points and radius points will be stored in the coordinate file. These points will be plotted and the fillet arcs will be drawn if the C&G settings call for it. You may repeat the process as necessary or press <Esc> to end command:

Prompts

Enter cul-de-sac radius point (Enter when done): type or pick the radius point.
Enter cul-de-sac radius <0.000>: Enter the radius of the cul-de-sac.
Enter 1st C/L bearing away from radius point <0.000>: Enter the bearing along the first roadway centerline away from the cul-de-sac radius point.
Enter 2nd C/L bearing away from radius point <0.000>: Enter the bearing along the second roadway centerline away from the cul-de-sac radius point.
Enter road width <0.000>: Enter the roadway width.
Enter fillet radius <0.000>: Enter the fillet radius or zero for no fillets.

Standard Cul-de-Sac

The standard cul-de-sac is a common feature of most subdivisions.
Enter cul-de-sac radius point (ENTER when done): type or pick the cul-de-sac radius point (in this example, point 2301).
Enter cul-de-sac radius <0.000000>: Enter or pick the radius of the cul-de-sac (60 units in the example).
Enter C/L bearing away from radius point [Arc]: In computing a straight cul-de-sac you must enter the bearing of the road centerline going away from the radius point. For the example the bearing is from point 2301 to point 2302.
Enter point on C/L (NOT radius point): This must be a C&G point on the centerline but cannot be the same as the cul-de-sac radius point. In this case we can use point 2302.
Enter road width <0.000000>: enter the total width of the road right-of-way.
Enter fillet radius <0.000000>: Enter the fillet radius. Remember, you do not have to have a fillet radius, you may enter zero here.
The points needed to define the cul-de-sac and the fillets are calculated and stored in the coordinate file.
If Auto Line Plot is on the lines for the cul-de-sac and the fillets will be drawn automatically.
You may repeat the process as many times as necessary.
When done, press <Enter> at the
Enter cul-de-sac radius point (ENTER when done):

Standard Cul-de-Sac on ARC
The procedure for a cul-de-sac on arc is the same as it is for a straight cul-de-sac, except at the Enter C/L bearing away from radius point [Arc] : prompt, choose A for Arc, then enter the C/L radius point for the roadway, in this case point 2313.

Offset cul-de-sac:

The procedure for offset cul-de-sac is the same as a straight cul-de-sac except the radius point is the offset point. In the sketch, the point 2326 is the radius point. The bearing is from 2324 toward 2325 and the point on the C/L would be point 2325.

Prompts

**Enter cul-de-sac radius point (ENTER when done):** type or pick the cul-de-sac radius point. Press Enter when done.

**Enter cul-de-sac radius <0.000000>:** Enter or pick the radius of the cul-de-sac.

**Enter C/L bearing away from radius point [Arc]:** Enter or pick a point. For a straight cul-de-sac roadway, this must be a point on the centerline but cannot be the same as the cul-de-sac radius point. Type "A" and Enter to specify information for a cul-de-sac on a curved roadway.

if you chose a curved roadway:

**Enter C/L radius point [Line]:** Type a point ID or pick a point symbol or type "L" and Enter to switch back to a straight roadway.

**Enter point on C/L (NOT radius point):** Type a point ID or pick a point symbol.

**Enter road width <0.000000>:**

**Enter fillet radius <0.000000>:** Enter the fillet radius. You may enter 0.0 for no fillets.
Stake-Out
The Stakeout feature allows you to calculate the required information for either a radial stakeout or staking out using angles right.

Angles Right
This feature is similar to the Radial Stakeout feature except it allows you select the foresight points one at a time.

If a coordinate file is not open, a file dialog will appear, allowing you to open an existing coordinate file.
After following the prompts outlined below, the angle from the backsight point, the distance, the foresight point ID, the azimuth and the description are printed at the command line and written to the print file.
You may press <F2> to view the complete listing of angles and distances.
Repeat the prompt sequence as many times as are required.
Press <Enter> or type D and <Enter> when done.

Prompts
Enter the instrument point. [Done]: Type or pick the instrument point.
Enter backsight point. [Done]: Type or pick the backsight point.
Enter foresight point. [Done]: Type or pick the foresight point.

Radial Stake Out
This feature allows you to obtain the angles required to stakeout several foresight points from a single instrument point.

If a coordinate file is not open, a file dialog box will appear, allowing you to open an existing coordinate file.
After following the prompts outlined below, the angles right from the backsight point, the distances, the foresight point IDs, the azimuths and the descriptions for all the selected points will be printed at the command line and written to the print file.
You may press <F2> to view the complete listing of angles and distances.
Repeat as necessary for as many setups as are required.
When done, press <Enter> to end the command.

Prompts
Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/Select]: Use one of several methods to specify the points in the coordinate file to be staked out.
Enter the Instrument point [Done]: Type or pick the instrument point.
Enter the Backsight point [Done]: Type or pick the backsight point.
Best Fit

The best fit feature uses a least squares algorithm to compute the best fit line or circle for the points selected. The user can assign a weight to each point that is between 1 and 15, a point with a weight of 15 acts as if there are 15 of the points at the same location and thus skews the fit closer to that point. This is done to skew the result in favor of certain points. A weight of 0 means do not adjust this point or give it “infinite” weight.

When you choose Best Fit from the CGCogo menu you will see the following prompt:
Enter the type of best fit problem [Line/Arc/Tan-arc-tan] <L>:
Best Fit Line:
Press <Enter> for Line to calculate the best fit line through a series of points. In the example in the figure below, 2075 is an Iron Pin Found that we do not want adjusted, so the weight will be set to 0.

![Diagram of points and weights](image)

Enter a point ID or pick a point symbol on the line: for the example, type or pick 2075
Enter weight for point 2075 <1>: for the example type 0 (zero) and <Enter>

Enter a point ID or pick a point symbol on the line: for the example, type or pick 2076
Enter weight for point 2076 <1>: for the example, type 8 and <Enter>

Continue entering point ID - weight pairs until done then press <Enter> when asked for the next point ID.
The point locations and weights will be used to compute the best fit line.
The results, a list of the point IDs entered and their offsets from the best fit line and the bearing of the line, is printed at the command line and written to the print file.

Printed output for the line example
Pt.: 2075 Wt.: 0 Offset: 0.000 RT
Pt.: 2076 Wt.: 8 Offset: 5.360 LT
Pt.: 2077 Wt.: 3 Offset: 3.411 RT
Pt.: 2078 Wt.: 6 Offset: 1.915 RT
Pt.: 2079 Wt.: 2 Offset: 6.326 LT
Pt.: 2079 Wt.: 2 Offset: 6.326 LT
Pt.: 2080 Wt.: 4 Offset: 1.093 RT
Pt.: 2081 Wt.: 4 Offset: 0.986 RT
N: 6354.64727 E: 8112.07615 Dir: N 88°30'32''E
N: 6366.14982 E: 8553.96369 Dir: S 88°30'32''W

At the [Edit/Ok/Quit] <0>: prompt:
If you are satisfied with the results, press <Enter> for Ok and the endpoint coordinates will be computed and saved.
For each point saved, the Saving Point dialog (see below) will be shown.
Clicking OK will cause the point to be saved to the coordinate file.

If, on the other hand, you wish to edit the input data, type E and <Enter>. You see the following prompt:
[Add/Change/Delete/eXit]:
Add - add another point to the calculation
Change - change the weight of one of the points
Delete - remove one of the points from the calculation
eXit - when done editing.
If you wish to cancel the command without calculating the line type Q and <Enter>.

Best Fit ARC:
This option allows you to calculate the best fit arc through a series of points. As with the Line option, each point can be weighted from 0 (no adjustment) to 15.
At the Enter the type of best fit problem prompt, type A and <Enter> to choose the Arc option.
Enter the point ID - weight pairs as in the Line option.
When all the point ID - weight pairs have been entered press <Enter> at the Enter or Pick a C&G point on the line prompt.
A table of the results similar to that for the Line option will be displayed at the command line.

Output for the example in shown in the figure
The [Edit/Ok/Quit] <O> prompt and its options for editing the input data are explained in the section on the Line option.

If you are satisfied with the results, press <Enter> for Ok and the PC, PT and radius point of the best fit arc will be saved to the coordinate file using the Saving Point dialog.

Tan-arc-tan:
This option allows you to calculate a combination of the best fit tangent line going into a curve, the best fit arc for the curve itself and the best fit tangent line out of the curve through a series of points defining two tangent lines and an arc.

The two tangent lines are calculated using a least squares solution and then the best fit arc is calculated. The method used to find the best fit arc is to calculate a radius and radius point for each point on the arc using a function that calculates a curve between tangents through a known point. Each radius and radius point is weighted based on the central angles between the PC, point-on-arc and PT points. The larger the central angles, the higher the resulting weight will be. All the calculated radii and radius points are then averaged. It is not necessary that you locate the actual PC or PT points in the field.

At the prompt
Enter the type of best fit problem [Line/Arc/Tan-arc-tan] <L>:

First you must enter the points on the 1st tangent line. At the series of prompts to:
Enter a point ID or pick a point symbol on 1st tangent:
and
Enter weight for point XXXXX <1>:
enter the point ID - weight pairs for the tangent going into the curve.
When done entering the tangent line points, press <Enter> when asked for the next point.
Next at the series of prompts:
Enter a point ID or pick a point symbol on the arc:
enter the points for the arc. Weights for these points are calculated by the program.
In the example shown in the figure, there are 2 points defining the first tangent, 3 points defining the arc and 2 points defining the tangent out.
Output for example shown in figure

Pt.: 2210 Wt.: 0 Offset: 0.000
Pt.: 2211 Wt.: 5 Offset: 0.000

N: 6512.07291 E: 8572.91824 Dir: N 45°00'00''E

N: 6567.12692 E: 8627.97226 Dir: S 45°00'00''W

Pt.: 2212 Wt.: 5 Offset: 0.000 LT
Pt.: 2213 Wt.: 1 Offset: 0.000 LT

N: 6585.04757 E: 8796.89599 Dir: S 45°00'49''E

N: 6505.88861 E: 8876.09255 Dir: N 45°00'49''W

Pt.: 2214 Offset: 1.736 OUT
Pt.: 2215 Offset: 3.232 IN
Pt.: 2216 Offset: 2.324 OUT

N: 6492.00101 E: 8721.39653 RAD: 119.183

The [Edit/Ok/Quit] <O>: prompt following the output is explained in the Line option.
If you are satisfied with the results press <Enter> for Ok.
The coordinates for the endpoints of the tangents and PC, PT and radius point of the curve are computed and saved to the coordinate file using the Saving Point dialog.

Prompts

**Enter the type of best fit problem [Line/Arc/Tan-arc-tan] <L>:** Type "L" and Enter or just Enter for a best fit line, "A" and Enter for a best fit arc or "T" and Enter for the best fit of a curve with two straight tangents in and out.

For a best fit line or arc:
**Enter or Pick a C&G point on the line (or Arc):** Type a point ID or pick a point symbol on the screen. Repeats until all points are entered and the user presses Enter at this prompt.
**Enter weight for point <####> <1>:** Enter a number between 0 and 15 (0 = infinite weight).

For best fit tan-arc-tan:
**Enter a point ID or pick a point symbol on 1st tangent:** Enter or pick as many points and weights as desired for the first tangent line.
**Enter a point ID or pick a point symbol on the arc:** Enter of pick as many points as desired for the arc (weights are determined by the program).
**Enter a point ID or pick a point symbol on 2nd tangent:** Enter or pick as many points and weights as desired for the second tangent line.

[Edit/Ok/Quit] <0>: Type "E" and Enter if you wish to change the weight of a point or add or delete points. Type "O" and Enter or just Enter to calculate the best fit line, arc or line-arc-line and store its defining points in the coordinate file. Type "Q" and Enter to quit without calculating the best fit points.

[Add/Change/Delete/eXit]: if you choose Edit then this prompt allows you to Add a point, Change a weight, or Delete a point. When done editing press "X" and Enter to return to the Edit/Ok/Quit prompt.

Pulldown Menu Location: CG-Survey > Cogo

Keyboard Command: cg_bfit
Prerequisite: Coordinate file.

**Triangulation**

This feature allows you to calculate the location of an unknown point given the angles at the 3 vertices of the triangle formed by the 2 known points and the unknown point.

Enter the point ID of the first known point then the point ID of the 2nd known point (the backsight) and the measured horizontal angle to the unknown point. Do the same for the 2nd known point backsighting the 1st known point. Next, if available, enter the angle between the 2 known points with the instrument at the unknown point. The standard deviation and other information for the calculation will be printed at the command line and written to the print file. The calculated point will be saved to the coordinate file using the Saving Point dialog (Shown Below).
Prompts

**Enter first instrument point:** Enter a point ID or pick a point symbol on the screen.
**Enter first backsight point:** Enter a point ID or pick a point symbol on the screen.
**Enter first horizontal angle to unknown point:** Enter an angle.
**Enter second instrument point:** Enter a point ID or pick a point symbol on the screen.
**Enter second backsight point:** Enter a point ID or pick a point symbol on the screen.
**Enter second horizontal angle to unknown point:** Enter an angle.
**Enter horizontal angle at unknown point or <skip> <0.000000>:** Enter an angle if available or press Enter to skip.

**Pulldown Menu Location:** CG-Survey > Cogo  
**Keyboard Command:** cg_triangulation  
**Prerequisite:** coordinate file

**NAD83**

This feature allows you to convert longitude and latitude to and from NAD83 state plane coordinate systems. 
**NOTE:** Do not use this function for any other coordinate system, i.e. NAD 1927. Make sure the correct state is selected on the General tab of the C&G Options dialog box.

After choosing the NAD83 menu item from the CGCogo menu you will be prompted for the necessary data.
At the Enter zone prompt enter the letter for the appropriate zone for the area where the survey was performed. The zones allowed may vary by state.  
[Coords to longitude-latitude/Longitude-latitude to coordinates] <C>:  

**Coords to longitude-latitude**

Pressed <Enter> (or type C and <Enter>) you will be asked to select the points.
After selecting points a table of longitude-latitude and related data for the points will be printed at the command line.
Longitude-latitude to coordinates
Type L and <Enter>,
You will be asked to enter the longitude and latitude of the points you wish to calculate
When you have entered the final longitude-latitude pair press <Enter> when asked for the next latitude.
The computed points will be stored in the coordinate file using the Saving Point dialog shown below.

Click OK to save the point to the coordinate file.

Repeat until done or press <Enter> to end the command.

Prompts

Enter zone (E, W): enter the letter for the appropriate zone for the area where the survey was performed. The letters allowed will vary depending on the state.
[Coords to longitude_latitude/Longitude_latitude_to_coords] <C>: Type "C" and Enter or just Enter to calculate coordinates given longitude and latitude. Type "L" and Enter to do the reverse.

if you chose Coords to longitude-latitude:
Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/Select]: Use the various selection methods to choose the points for which you wish to calculate longitude and latitude

if you chose Longitude-latitude to Coords:
Enter latitude [<Enter> when done]: Enter the latitude angle for a longitude - latitude pair.
Enter longitude: Enter the longitude angle for a longitude - latitude pair.

Pulldown Menu Location: CG-Survey > Cogo
Keyboard Command: cg_nad83
Prerequisite: coordinate file

CGDraw

Drawing Settings

See CG Options... menu item in the Tools menu.

Pulldown Menu Location: CG-Survey > CGDraw > Drawing Settings
Keyboard Command: DSU, CG_DRAW_SETUP
Prerequisite: None

Set Line Type

To use a line type it must be loaded and it must be the current line type. The current line type will be used for any lines or polylines drawn. The Set Line Type feature allows you to load line types from any line type file (*.lin) and to specify the currently active line type. It gives you easy access to the most commonly used line type files while allowing you to access any line type file available to you.

Prompts

Clicking the Set Line Type menu item brings up the Line Types dialog: By default the dialog displays the acad.lin line type file contents (CgSu.lin in the standalone version of CGSurvey).

By clicking the AutoCAD/IntelliCAD ISO button: you can view the acadiso.lin file line types (CgSu-iso.lin in the standalone version of CGSurvey).

By clicking the C&G button: you can view the custom line types created for CGSurvey (in CgLinedefs.lin). You may also use the Browse... button to view and load line types from other line type files.
To load a line type: pick the file the line type is in, highlight the desired line type, then click the Load button. Notice that the status column now indicates that the line type is "Loaded".

To make the highlighted line type current: click the Set Current button. The status column now reads "Loaded (C)", indicating that the line type is loaded and it is the currently active line type.

You can load a line type and make it current: by double-clicking it. If it is already loaded, double-clicking will make it current.

Cancel button: returns the current line type to what it was before the command was run.

Click the Done button: to close the dialog.

Pulldown Menu Location: CG-Survey > CGDraw>Set Line Type
Keyboard Command: SLT, CG_SET_LINE_TYPE
Prerequisite: None

Global Edit
Global Edit allows you to make several changes to one or more entities, in one operation.

Prompts
After selecting Global Edit from the CGDraw menu you will be asked to specify the method of entity selection at the command line:
Screen: This option allows you to use any of the standard mouse based CAD selection methods.
Points: Allows you to select C&G points using the standard C&G selection methods. Checking a given check box activates that section of the dialog box and allows you to make the desired changes.
Done: When finished selecting the entities enter "D" for done this will bring up the Dialog box.

There are five basic sections in this dialog.

All: checking this checkbox is just a fast way of checking all the checkboxes and thus allows you to edit all of the properties of the selected entities.
All of the editable items for the entities selected will have their checkboxes checked.

CAD properties

Layer: change the layer of the items selected
Color: Change the color of the items selected
Font/Style:  Change the font style to a another existing font style.
Text Size: Change the current Text size (this setting is in inches)

Lines

Linetype: set the linetype for the lines selected. Pressing the down arrow will bring up a list of all of the available linetypes.
Line Scale:  This allows you to set the length of the pattern.
Line Stop:  This allows you to set the line stop. This item will only be activated if a C&G line was chosen.

Without Linestop

With Linestop

Line stop is a C&G parameter that allows you to stop the line short of the point symbol plotted at the point location thus the line can be made to not go through the symbol.  For example, if you were plotting 0.10 diameter circles for property corners, you could set the line stop to .10. This would cause a C&G line drawn to the property corner to end .05 plotted units short of the actual corner and thus not cross the property corner point symbol

Calls

Distance precision:  From the pull down select the number of decimal places to be displayed.
Angle precision: From the pull down simple select the angle precision you need.

Points

This portion of the Global Edit dialog allows you to change various aspects of point symbols:
Symbol: from the pull down select the new symbol to use.
Symbol Size: set the symbol size (in inches or cm)
Point Label Size: Set the point label size (in inches or cm)
**Point Label Position:** Displays the point label configuration dialog box, set the options as needed. Elevation Places Displayed: set the number of places to be displayed.

**Pulldown Menu Location:** CG-Survey > CGDraw>Global Edit  
**Keyboard Command:** GE, CG_GLOBAL_EDIT  
**Prerequisite:** Coordinate file

---

**Border**
This option allows you to place a border Polyline on your drawing with sheet sizes.

![CGSurvey Draw Border](image.png)

**Prompts**

**Sheet Setup**

**Sheet Size:** The letters A, B, C, etc. refer to ANSI sheet size standards. You also have the option of creating and naming custom sizes.  
**Rotate 90 Degrees:** when checked will rotate the border 90 degrees.  
**Border Inset:** specifies the inset distance for the border. Keep in mind this inset distance is measured from the edge of the plotable area of your plotter. Check the plotter manual for plotter specifications.  
**Layer:** The layer the border will be drawn on.  
**Line Width:** The thickness of the border line in inches (cm).  
**Press OK button** when done and the border polyline will be drawn at the mouse cursor. You can move it to the correct location and left click to place it there.

**Pulldown Menu Location:** CG-Survey >CGDraw>Border  
**Keyboard Command:** DB, CG_DRAW_BORDER
Coordinate Grid

Choosing the Coordinate Grid item in the CGDraw menu brings up the Grid Configuration dialog. The various areas of the dialog are described below:

**Map Grid:** is used to provide a visual reference grid to show northings and eastings on a map. A Map Grid can be labeled along its border to show the coordinate values of the grid lines. The Map Grid is oriented North-South East-West whereas a Layout Grid can be oriented at any specified bearing.

**Layout Grid:** is meant to be used to create points on a regular grid for laying out building columns, a topo grid, etc. A Layout Grid does not allow for a border nor for coordinate labels along the border.

**Grid Layer:** specify the layer the grid is to be created on. The layer does not need to exist prior to running this command.

**Lines:** If selected grid lines will be drawn for the full height and width of the grid dimensions.

**Crosses:** Only crosses will be drawn at the grid intersections for the full height and width of the grid dimensions.

**Cross Height (drawing units):** this defines the size of the crosses in drawing units. If your drawing scale is 40 feet and you wish to have crosses that are 0.25 inches when plotted, you must specify cross height as 10 feet.

**Draw Border:** If checked, a border will be drawn around the perimeter of the defined grid. You can choose a different layer for the border if you wish. This will allow you to set the color, line thickness and/or line type for the border (this option is not available for Layout Grid).

**Draw Labels:** Label the grid lines or crosses around the perimeter at the same interval as the Baseline and Perpendicular intervals (this option is not available for Layout Grid). If checked you must specify:

**Label Interval:** This number must be some even multiple of both the baseline and perpendicular intervals. The Label Interval CAN NOT be less than the base or perpendicular interval settings.

**Label Decimal Places:** Specify the number of decimal places used for the label text.

**Label Layer:** Specify the layer the labels are to be drawn on.
Grid Dimensions: **Baseline Extent:** This is the total width of the grid, East to West (or parallel to the baseline bearing in the case of a Layout Grid).

**Perpendicular Extent:** This is the total height of the grid perpendicular to the baseline.

**Baseline Interval:** This is the distance between the grid lines (or X's) drawn perpendicular to the baseline.

**Perpendicular Interval:** This is the distance between the grid lines (or X's) drawn parallel to the baseline.

**Grid Baseline:**

**Use Point ID for Baseline Origin:** checking this box allows you to use an existing C&G coordinate for the Grid Origin. This is typically used for a Layout Grid.

Enter the point ID, or select the point from the screen.

**Origin Northing/Origin Easting:** manually enter the Northing and Easting value for the grid origin or pick it on the screen using the Pick Origin button.

**Baseline Bearing:** This is only used when you are drawing a Layout Grid. This is the bearing of the baseline. Use the standard C&G bearing input format qdd.mmss (e.g. 125.3527 for N25°35'27"E or 325.5405 for S25E54'04"W)

**Pick Origin button:** This option allows you to pick the origin graphically on the screen. You do not have to pick a C&G point.

**Create Points at Grid Intersections:**

Checking this box will cause the default C&G point to be plotted at each grid point or grid line intersection and a corresponding point to be stored in the currently open coordinate file. This is especially useful when creating a Layout Grid.

**Point Description:** enter a point description for the points saved to the coordinate file.

**Exclude Area:** This button allows you to graphically specify a horizontal window within which no grid is to be drawn. This can be used to guarantee that a title block, legend or other area is not obscured by the grid or its labels.

**Preview:** This button allows you to preview the grid as specified. Pressing <Enter> will return you to the Grid Configuration dialog allowing you to make changes if necessary.

**Cancel:** This button exits the command without drawing the grid.

**OK:** This button causes the grid to be drawn.

**Pulldown Menu Location:** CG-Survey > CGDraw>Coordinate Grid

**Keyboard Command:** GRD, CG_DRAW_GRID

**Prerequisite:** Coordinate file

---

**Text on Arc**

**Create**

Text on arc allows you to create text that follows an arc specified by you. Each word in the text is a separate block and can be moved later as needed.

**Prompts**

You will be prompted to Enter Text to place on arc:

```
Command:
Enter Text to place on arc: Text on Arc
Enter center point for arc:
```

Type the desired text then press <Enter>:

**Enter center point for arc:** using the mouse, select the center point of the arc the text is to follow, this can be a C&G point, or any point in the drawing. You need not actually have an arc drawn.

**Enter Midpoint of text:** select the midpoint of the text, this can be a C&G point, or any point in the drawing.
**Move**

The text will be drawn at the cursor. Move the cursor to the desired location and left click to place the text.

**Move to desired location:** The text will be drawn at the cursor. Move the cursor to the desired location and left click to place the text.

**Pulldown Menu Location:** CG-Survey > CGDraw > Text on Arc > Create

**Keyboard Command:** TOA, CG_TOA

**Prerequisite:** Coordinate file

**Move**

Allows you to move all the text associated with the selected text-on-arc entity.

**Prompts**

**Select entities:** select text

**Entities in set:** 1 item is found and selected

**Select entities:** press <Enter> to accept entry

**Move Text to desired location:** move text

**Select entities:** repeating the selection set

**Press <ESC> or <Enter>:** to end command

**Pulldown Menu Location:** CG-Survey > CGDraw > Text on Arc > Move

**Keyboard Command:** MTA, CG_MOVE_TOA

**Prerequisite:** Coordinate file

**Edit**

Allows you to edit the text associated with a text-on-arc entity.

**Text:** Arc=107.6709, R=75.7740 (Edit Text )

**Text Attributes**

**Layer:** 0 (current)

**Text Size:** 0.100 inches (Default)

**Text color:** Bylayer
Set Color Button: select a new color
Text style: Standard text style

Prompts

Select entities: select text
Entities in set: 1 item found and selected
Select entities: repeat selection set
Press <ESC> or <Enter>: to end command

Pulldown Menu Location: CG-Survey > CGDraw > Text on Arc > Edit
Keyboard Command: ETA, CG_EDIT_TOA
Prerequisite: Coordinate file

Delete

Allows you to delete all the text associated with a text-on-arc entity.

Prompts

Select entities: select text
Entities in set: 1 item found and selected
Select entities: repeat selection set
Press <ESC> or <Enter>: to end command

Pulldown Menu Location: CG-Survey > CGDraw > Text on Arc > Delete
Keyboard Command: DTA, CG_DELETE_TOA
Prerequisite: Coordinate file

Draw Mapcheck

This routine will draw a mapcheck file. The settings allow you to plot points, draw lines, and place calls all at the same time.

If a mapcheck file is NOT currently open when you open the map check file routine a dialog box will prompt you to open a mapcheck file. Once a mapcheck file is open the following dialog box will open.
If the mapcheck file displayed at the top of the dialog box is not the file you want to draw you can use the browse button to search for another file.

You also have the option to edit the file which will take you to the mapcheck editor (CGEditor).

**Reduce File:** If this item is checked there will be a closure report written to the print file and the command line.

**Starting/Ending Points:** You have the option of entering an existing point number or manually entering the northing and easting. If you enter an existing point number the northing and easting values will be read from the coordinate file and placed in the appropriate edit boxes (see below).

Clicking the **Select Point** button will cause the **Draw Mapcheck** dialog to be hidden thus allowing you to pick the starting and ending points from the screen or use the command prompt:

**Select starting point for mapcheck:**

or

**Select ending point for mapcheck:**

rather than manually entering the point number or coordinate values in the edit boxes.

**Lines:** This portion of the dialog allows you to turn on or off the draw line command as well as select the linetype and layer where the line will be drawn.
**Calls:** This section of the dialog allows you to turn on or off the draw calls command as well as edit the call setup options.

**Point Symbols:** This area of the dialog allows you to turn on or off the draw point symbols command as well as having a button that will take you to the drawing settings dialog. At the drawing settings dialog you can change the symbol, symbol size, label options and more.

**OK:** Selecting ok will cause the mapcheck file to be drawn, based on the current settings as described above.

**Prompts**

**Select starting point for mapcheck:** Select a point symbol or type a point number for the starting point.

or

**Select ending point for mapcheck:** Select a point symbol or type a point number for the ending point.

**Pulldown Menu Location:** CG-Survey > CGDraw>Draw Mapcheck

**Keyboard Command:** DMP, CG_DRAW_MAPCHECK

**Prerequisite:** Open Mapcheck file *.cgm

**Multi-Draw**

This feature allows you to complete several drawing operations at the same time. For example, in one operation you can plot points and generate a coordinate table for the points at the same time. Or you can draw lines by points and place calls on the resulting lines at the same time.
**Prompts**

When you choose Multi-Draw from the CGDraw menu, the Multi-Draw dialog box is displayed.

**Specify Points**

Use the radio buttons to indicate how you want to specify the points that will be used for the drawing operations. You can Choose Points Interactively using the standard C&G point sequence command line interface or you can Use Point Group.
**NOTE:** If you Choose Points Interactively, you will not have the option of plotting points or creating a coordinate table.

If you click Use Point Group, you must specify a Point Group Name and the point group description for the points you wish to use. You can either type the full path (including the drive letter) to an existing point group file or you can click the Browse button and use the file dialog box to specify the Point Group file.

**NOTE:** In this context, Description refers to the Point Group description, NOT the description for the individual points as found in the coordinate file.

### Drawing Operations

In this area of the dialog box you must specify which drawing operations to perform and, if needed, make the necessary settings changes required for the drawing operations. Any settings changes are saved to the drawing and thus remain in effect after this command is completed.
Plot Points: Checking this checkbox will cause the selected points to be plotted. Point Settings button: selecting this button will bring up the Drawing Settings dialog box allowing you to make changes to the drawing settings.

Coordinate Table: Checking this checkbox causes a coordinate table to be created for the points selected.

Table Settings button: will bring up the Coordinate Table Settings dialog box allowing you to make changes to layer, text size and line spacing.

Draw Lines/Arcs: Checking this checkbox causes lines and or/arcs to be drawn between the points specified.

Line Settings button: Will bring up the Linetype Manager allowing you to select the linetype.

Draw Breaklines: Checking this checkbox causes breaklines to be drawn between the specified points. Breaklines are for use in topographic operations (see CGTopo).

Topo Settings button: displays the CGSurvey Auto Contouring settings dialog box allowing you to make changes to the current topo settings.

Draw Calls: When Draw Calls is checked, calls will be drawn between the points specified.

Call Settings button: will display the Call Settings dialog box allowing you to make changes.

If Use Call Table is checked: all call information will be placed in a call table, rather than along the line work. The Call Table Settings button displays the Call Table Settings dialog and allows you to set the layer calls will be placed on, the text size, the line spacing, the first course label, etc.

If Use Curve Table is checked: all curve information will be placed in a curve table, rather than along the line work. The Curve Table Settings button displays the Curve Table Settings dialog and allows you to specify: which components will be shown in the curve table, which layer the table will go on, the text size, the line spacing, the first course label, etc.

The Layer Settings button: displays the Layer Manager dialog. Here you can create any layers you need or set the current layer as required.
When you are satisfied click OK.

If you choose Use Point Group: the drawing operations you have selected will be completed immediately.

If you have selected Choose Points Interactively: enter or pick the desired points at the following standard C&G point sequence command line prompt:

Note: When entering the points at the command line, some drawing operations may occur as you enter the points.

Placement of coordinate, call and or curve tables

No matter what point selection method you use, if you specified that any tables be drawn, the coordinate, call or curve table will be placed at the cursor and you will be asked to move the cursor to the desired location. Clicking the left mouse button will place the table in the drawing at the cursor location.
Plot Points and Symbols

Plot Points on Screen

Plot Points on Screen: This feature plots the selected points from a coordinate file on the screen.

Prompts

If a coordinate file is not open, a file dialog box will appear allowing you to open one.

You will then be asked to select the points to be plotted (for additional information, see Getting Started: Coordinate point selection sets).

Type the Capped Letter to initialize the selection Set
[All/Block/Code/Desc/Elev/Pt_group/Limits/radius/select]: A

Press <Enter> 3x when done: The points will be plotted on the screen.

In which layer will the points be plotted?

If the Use Description Table for point plotting parameters checkbox is not checked in the Graphic Options tab in C&G Options dialog: then all points will be plotted on the current layer according to the Drawing Settings dialog.

If the Use Description Table for point plotting parameters checkbox is checked and the Default layer for codes or descriptions not found in description table is specified: point's will be plotted to the layers specified by the description table (for a discussion of description tables see the CGMngmt chapter).

Description matches a description found in the description table: the point and its labels will be plotted as specified in the description table. For a description to match it must be a whole word match, disregarding numbers.

For example:
Table Description Point Description Match
TC TC-.5 to Bc yes
SW SW1 yes
FH TOPFH no

If a point has several different descriptions found in the description table: then that point can be plotted in more than one layer. For example: If the point's description is TC WV, it will be plotted in the layer assigned to the description TC as well as the layer assigned to the description WV.
No match is found in description table: the point will be plotted in the default layer with point labels as specified for the active point symbol.

Pulldown Menu Location: CG-Survey > CGDraw>Plot Points and Symbols>Plot Points on Screen  
Keyboard Command: PP, CG_PLOT_POINTS  
Prerequisite: Coordinate file

Remove Points from Screen
This feature allows you to remove/erase specified points from the drawing.

Prompts
If a coordinate file is not open, a file dialog box will appear and allow you to open an existing coordinate file.

Using the standard C&G Select Points commands, select the points to be removed.

Type the Capped Letter to initialize the selection Set
[All/Block/Code/Desc/Elev/Pt_group/Limits/radius/select]: A

<table>
<thead>
<tr>
<th>Command:</th>
<th>Command:</th>
<th>Command:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose initial points for base selection set from coord file. (Enter when done)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/select]:</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Press <Enter> 3X when done: The points will be removed from the screen.

Note: Remove Points from Screen does NOT delete points from the coordinate file.

Pulldown Menu Location: CG-Survey > CGDraw>Plot Points and Symbols  
Keyboard Command: RP, CG_REMOVE_POINTS  
Prerequisite: Coordinate file

Graphic Scale
This feature allows you to draw a graphic scale. Make sure the correct scale has been specified in the Drawing Settings dialog box.

Prompts
In the CGSurvey Draw Graphic Scale dialog specify the layer for the graphic scale.
Layer: Scale
Once you have specified the layer: press the OK button.

The Graphic Scale symbol will then be drawn at the mouse cursor: You can move the cursor to position the graphic scale then press the left mouse button to place it at the cursor location.

Pulldown Menu Location: CG-Survey > CGDraw>Plot Points and symbols>Graphic Scale
Keyboard Command: GSC, CG_DRAW_GSCALE
Prerequisite: Coordinate file

Lines and Polyline

Lines by Point Number

This feature allows you to draw lines and/or arcs based on the points in the coordinate file.

Prompts

If you choose this option and a coordinate file is not open, you will be prompted to open one.
You will be prompted at the command line to enter the coordinate point IDs that define a line/arc or a series of lines/arcs. You may type the point IDs at the command line or pick points on the screen.

Enter Point Sequence
(point group/Reset/sNap on) (last point = <72>):

Once a point is selected the command line will change to a new group of options
(cLockwise curve/ccW curve/Point group/Reset/sNap on) (last point = <72>):

Once finished plotting points simple hit<Enter> and the command line will clear.

Point Input: When entering a point sequence specifying a line/arc the following input forms are acceptable:

34: Either specifies the starting point of a line or, if this is a continuing series of lines, draw a line from the previous end point to point 34 and occupy point 34.
6-9: Draw a line from point 6 to 9 and occupy point 9.
-4: Draw a line from the previous end point to point 4 but remain at previous end point.
L: Specify a cLockwise curve. The previous end point is assumed to be the PC of the curve. The next point specified is the center or radius point of the curve and the next point entered is the PT of the curve.
W: Specify a counter clockWise curve. The data entry sequence is similar to a clockwise curve.
P: Use a Point group to specify the lines/arcs. You will be asked to pick the point group file using a file dialog box.
R: Reset the "last point" to none
N: Toggles the CAD snap command on or off
If you choose to use a point group file, lines will be drawn from point to point in the order specified in the point group file (see the CGMngmt chapter for information on point group files).

If you do not want to type in the point IDs to define the lines/arcs, you can select the points from points that are plotted on the screen using your mouse. (see Plot Points and Symbols).

**Note:** To specify an arc to be drawn pick the PC point of the curve then enter either L <Enter> for clockwise or W <Enter> for counter clockwise curve. When prompted, pick the radius point and then pick the PT.

**Pull down Menu Location:** CG-Survey > CGDraw > Lines and Polylines > Lines by Point Number  
**Keyboard Command:** LBP, CG_LBP  
**Prerequisite:** Coordinate file

### Lines by Description

This feature allows you to connect lines between all the points in a coordinate file having a common description.

![CGSurvey Draw Lines by Desc dialog](image)

**Prompts**

After choosing the Lines by Description menu item you will see the CGSurvey Draw Lines by Desc dialog.

**Layer:** Specify the name of the layer the lines are to be drawn on.

**Desc:** Specify the description of the points you want to connect. Case is ignored and, unless the checkboxes described below are checked, only the leading characters of the point description are considered for a match.

**Match text anywhere in desc:** If this checkbox is checked, the entire point description field will be searched for the characters specified in the Desc: edit box. For example:
Input Description Point Description Match  
MH SanMH Yes

**Force match to be whole word:** If this box is selected, the match must be a complete word in the point description, not just a portion of a word. For example:
Input Description Point Description Match  
RD CL RD Yes (whole word)
Connect Mode

**Sequential:** Connects the points in point ID order.

**Closest:** Ignores point ID and connects to the closest point with named description.

### Pulldown Menu Location:
CG-Survey > CGDraw> Lines and Polylines > Lines by Description

### Keyboard Command:
LBD, CG_LBD

### Prerequisite:
Coordinate file

---

### Lines by Codes

This feature allows you to draw lines between the points in the coordinate file having a common point code. The point code is a two to four character field (depending on the type of coordinate file).

![CGSurvey Draw Lines by Code](image)

- **Layer:**
- **Code:**
- **Connect Mode:**

**OK**

---

### Prompts

Choosing the Lines by Code menu item brings up the CGSurvey Draw Lines by Code dialog. With the exception of the Code: field, the items in this dialog are identical to those in the CGSurvey Draw Lines by Desc dialog.

- **Code:** field specifies the code for the points you want to connect. Case is ignored.

**Connect Mode**

- **Sequential:** connects line in point ID order
- **Closest:** connect lines in Closest point with named description

---

### Polylines by Point

This feature works very similar to the Lines by Point feature described in the previous pages. In Polyline by Points data entry is similar to Lines by Point except Reset does not apply to a polyline. The C&G Polyline allows you to treat road centerlines and other similar things that would normally be made up of several line segments, as one entity. You can use a C&G polyline to create a point group or you can place calls along it. You could also use a C&G polyline as the bounding polygon in the Fit Structure feature.

### Pulldown Menu Location:
CG-Survey > CGDraw> Lines and Polylines > Polylines by Point

---

*Chapter 18. CGSurvey Module*
**Keyboard Command:** CGP, CG_POLY  
**Prerequisite:** Coordinate file

---

**Fit Polygons**

This feature allows you to use a variety of best fit methods to smooth an existing polyline.

---

**Prompts**

First you must choose the method to use in fitting the selected polylnes at the following prompt:

Type of fit to apply: [Decurve/Fit/Quadratic spline/Cubic spline/Cg spline]<C>:

Next, select the polylnes you wish to fit then press the <Enter> key or right mouse button to apply the fit to the selected polylnes.

**Decurve:** This will decurve a previously smoothed polyline.

[Diagram of Decurve]

**Fit:** uses CAD fit - a series of interconnected circular arcs.

[Diagram of Fit]

**Quadratic spline:** Uses a quadratic spline curve fitting algorithm.

[Diagram of Quadratic Spline]
**Cubic spline**: Uses a cubic spline curve fitting algorithm.

**C&G Spline**: Creates a smooth curve that passes through all vertices.

**Pulldown Menu Location**: CG-Survey > CGDraw > Lines and Polylines > Fit Polyline

**Keyboard Command**: FITP, CG_FIT_POLY

**Prerequisite**: Coordinate file
Calls
Place Calls
This feature allows you to annotate C&G and CAD lines, arcs and polylines.

Call Setup

Selecting Calls Setup will bring up the Call settings dialog box.

![Call Settings Dialog Box]

**Desired Call Components:** Specify the desired components for the call.
- Bearing and Distance (or Arc and Radius)
- Bearing (Arc)
- Distance (Radius)
- Bearing over Distance (Or Arc over Radius)

If you specify points to form a curve then the components shown in parentheses will be used to form the call text.

**Format and location:** Specify how you want the call placed relative to the line or arc:
- **Parallel:** to the line or Arc
- **Perpendicular:** to the line or arc
- **At Cursor:** means the call text will be drawn horizontally at the cursor and you must move it to the desired location then left click to place it.
- **Place Call to Right of Line:** If you are placing a call either parallel or perpendicular to a line or arc, select this box if you want the call placed to the right of the line or arc, assuming you are standing on the line and facing in the direction of the bearing. The call will be centered along the line or arc.
- **Use the Foot Abbreviation [ ’ ] in Distance Text:** Checking this box will place the [ ’ ] mark after the distance (125.36’). Un-checking the box will remove the [ ’ ] mark (125.36).
- **Line Bearing Direction to:**
**Selecting NW,NE**: will force all calls to be shown only with NE and NW notation (N 428 35' 12'' E or N 168 25' 31'' W)

**Selecting SW,SE**: will force all calls to be shown only with NE and NW notation (S 428 35' 12'' E or S 168 25' 31'' W)

If **< no preference >**: is selected the software will define the bearing based on the direction of the points selected.

**Layer Name for Call Text**: Specify the layer where you want the calls placed.

### Automated Placement of Calls on Specified Layers

Check the Automate Placement of Calls check box making the options in the dialog active. This routine allows you to select one or more layers to scan for the placement of calls. The scan will look for lines only in the layers you specify even though other layers may be currently displayed.

Choose one or more layers to search: this dialog will display the complete list of layers in the drawing file. You can scroll up and down the list and simple click with the mouse those layers you want to search for lines/polylines.

#### Types of Lines to Annotate:

- **C&G Lines and C&G Polylines**: refer to lines that have been drawn using the CGDraw command, thus being based on the C&G coordinate file.
- **CAD lines and CAD Polylines**: refer to lines that have been drawn using the CAD Draw command and are not based on the C&G coordinate files.
- **Example Cell**: this display shows you the actual layout as it will appear on your drawing.

### Prompts

When you choose the Place Calls menu item and a coordinate file is not already open, you will be asked to open a coordinate file. You will then see the following prompt at the command line:

- **Enter point sequence**: [Point group/Reset/turn_sNap on/Setup/polYline] (last point = <none>):
- **Point Group**: If you press P and <Enter> you will be asked to enter a point group and it will be used to place calls automatically.
- **Reset**: Press "R" resets the last point ID to <none>
- **sNap on or sNap off**: Press "N" turns the CAD snaps on or off. When the command starts the AutoCAD snaps are off by default.
**The Setup:** Press "S" option brings up the Calls Setup dialog box.

**polYline:** if you Press "Y" and <Enter> you can then pick a C&G polyline and it will be annotated in the order that the vertices were specified when it was drawn.

**Pulldown Menu Location:** CG-Survey > CGDraw>Calls>Place Calls  
**Keyboard Command:** CALL, CG_CALLS or CALS, CG_CALLS_SETUP  
**Prerequisite:** Coordinate file

---

**Move Calls**

 Allows you to move call text and once moved it will not go back to its original location when you use Refresh Screen to refresh calls. The calls will move or change if the point numbers that generated the call change but the position of the call relative to the end points will remain approximately the same.

**Prompts**

**Select entities:** Pick call on screen  
Entities in set: 1  
Select entities: Pick another call on screen  
Move call to desired location.

**Pulldown Menu Location:** CG-Survey > CGDraw>Calls>Move Calls  
**Keyboard Command:** MCL, CG_MOVE_CALLS  
**Prerequisite:** Coordinate file

---

**Reverse Calls**

 This feature allows you to reverse the bearing of the call.

**Prompts**

**Pick a call to reverse:** select call bearing on screen  
**Pick a call to reverse:** select another call bearing on screen  
**Pick a call to reverse:** select again if wish to continue or  
**Press <Esc>:** to quit command

**Pulldown Menu Location:** CG-Survey > CGDraw>Calls>Reverse Calls  
**Keyboard Command:** RCL, CG_REVERSE_CALLS  
**Prerequisite:** Coordinate file

---

**Tables**

**Coordinates**

 This feature allows you to draw a table containing information related to specified points in the coordinate file then place the table in the drawing by picking the desired location.
When you pick the Table > Coordinate menu item and a coordinate file is not already open, you will be asked to open one. Once a coordinate file is open, then the Coordinate Table Settings dialog will appear. Using this dialog you can configure the following settings:

**Layer:** Specify the layer on which you want the table drawn.

**Text Size:** Enter the text size in inches or centimeters. The text size is the size the text will appear when printed on a page.

**Line Spacing:** Enter the space you want between lines in inches or centimeters. The line spacing is the height of the spacing when the table is printed on a page.

**Note** Northing and Eastings will be rounded based on the values specified in the Rounding Options tab of the C&G Options dialog box.

**Note** The point ID, northing, and easting will always be part of the coordinate table. If you want elevations, codes and descriptions shown, make sure they are set to "On" on the Global Settings tab of the C&G Options dialog. Click OK to save the settings and continue the command, this will return the action to the command line. If you click Cancel the command will be canceled.

**Selecting Points for the coordinate table:**
Select the points that will be included in the table using the familiar C&G prompt.

Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/Select]: A

**Prompts**

Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/Select]: A

Expand base selection set: Choose more points from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/Select/Include/eXclude/View]:
Building Point Selection Set...

Press Enter 2 more times to end selection set: <Enter>

When done selecting points just press <Enter>: The table will be drawn at the cursor.

Move Coord Table to desired location: Drag the table to the desired location on the drawing and press the left mouse button to place the table.
Pulldown Menu Location: CG-Survey > CGDraw > Tables > Coordinate

Keyboard Command: CRDT, CG_COORD_TABLE

Prerequisite: Coordinate file

Call Table

This feature allows you to place the bearings, distances, etc. in a table instead of along the lines and curves in the drawing. This is especially useful when space along the lines or curves is limited. When you use a call table only the course labels are placed along the line or curve to identify it in the table.

When you choose the Table > Call item from the menu the Call Table Settings dialog appears. As with the coordinate table, this dialog box allows you to enter: the layer, text size and line spacing for the call table.

Drawing Settings
Course labels

First course label: The course labels will be based on the First course label setting in the Call Table Settings dialog box. The course label will then be determined by incrementing the last character in the previous course label starting with the first course label.
For example: line1 increments to line2, line3, etc. whereas line_a increments to line_b, line_c, or as in the example above L1, L2 L3, etc.

Automatically increment course label: Check or Uncheck box
This setting will automate the process with selecting point sequence

After configuring the settings in the Call Table Settings dialog:
Ok Button : select OK

Prompts

You will be prompted at the command line to enter the point sequence.
Enter the point sequence by typing point IDs or by selecting C&G points and/or lines on the screen.

Enter point sequence: [cLockwise_curve/ccW_curve/Point_group/Reset/turn_Snap_on]

The Reset button: The ‘R’ resets the last point to <None>

When you are done entering calls: press <Enter>
This will end the input process and the call table will be drawn at the cursor.

Move Call Table to desired location: Drag the table and left-click the mouse button to place table on screen. The course description will be placed in the table and on the line or arc in the drawing.

<table>
<thead>
<tr>
<th>Course</th>
<th>Bearing</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>L1</td>
<td>N 15°04'36&quot; E</td>
<td>183.84'</td>
</tr>
<tr>
<td>L2</td>
<td>S 85°52'05&quot; E</td>
<td>170.10'</td>
</tr>
<tr>
<td>L3</td>
<td>S 11°44'15&quot; E</td>
<td>163.23'</td>
</tr>
<tr>
<td>L4</td>
<td>S 65°53'25&quot; W</td>
<td>141.06'</td>
</tr>
<tr>
<td>L5</td>
<td>N 66°49'49&quot; W</td>
<td>132.63'</td>
</tr>
</tbody>
</table>

Pull down Menu Location: CG-Survey > CGDraw>Tables>Call
Keyboard Command: CALT, CG_CALL_TABLE
Prerequisite: Coordinate file
Curve
This feature allows you to Draw a table containing curve information for specified curves.

You will be prompted to open a coordinate file if one is not already open. Once the coordinate file is open, the Curve Table Settings dialog box will appear. The Curve Table Settings dialog allows you to configure the following settings:

**Curve Components**
Check the checkboxes for the curve components that you wish to appear in the table, Radius, Tangent, Arc Length, Chord Bearing, Delta, Degree and Chord.

**Drawing Settings**
Enter the layer, text size and line spacing, and check or uncheck the Use Foot Symbol checkbox.
*Layer*: CG_Template
*Text Size*: 0.100
*Line spacing*: 0.075

**Curve Labels**
Enter the First Curve Label for the first curve
*First Curve Label*: C1
*Automatically increment curve label*: check or uncheck the Automatically increment curve label checkbox.

*OK Button*: When done, click OK to begin entering the curve data.
Prompts

You will be prompted at the command line to Enter point sequence

Picked C&G Point [1444]

Enter point sequence

[cLockwise_curve/ccW_curve/Reset/turn_Snap_on] (last point = 1444): L

Enter radius point for curve [Reset/turn_Snap_on]:
Picked C&G Point [1449]

Enter point of tangency (PT) for curve [Reset/turn_Snap_on]:
Picked C&G Point [1448]

Move Curve Table to desired location: Drag Table to desired location and Left-mouse click to place on the drawing.

Note: After entering the PT point for any curve, you can continue entering curve data. However, you should be aware that the PT point is shown as the last point.

If the PT point is not the PC of the next curve then you need to enter "R" for Reset. This allows you to begin the next curve at a new PC, then continue on to enter its radius point and PT.

Pulldown Menu Location: CG-Survey > CGDraw>Tables>Curves
Keyboard Command: CURT, CG_CURVE_TABLE
Prerequisite: Coordinate file

Auto Map

Map allows the user to automate the production of a drawing based on special "mapping codes" included in the descriptions found in the coordinate file. Using this feature can save a great deal of time. This allows the lines and points to be placed in the drawing based on mapping codes without user intervention.

Pulldown Menu Location: CG-Survey > CGDraw>Auto Map
Keyboard Command: MAP, CG_MAP_DRAW
Prerequisite: Coordinate file

Draw

This feature automates the production of a drawing that can contain specific points, lines, arcs and curve fit lines. The draw option also acts as a Cogo function in that it will calculate the PC, PT and radius points of curves and has the ability to calculate points by traversing and intersection.

Prompts

After choosing the Draw command, if a coordinate file is not open, you will be asked to open one.
After opening the coordinate file, you will be asked to select the points you want to map:

Choose initial points for base selection set from coord. file: (Enter when done) [All/Block/Code/Desc/Elev/Pt-group/Limits/Radius>Select]

Next, you will be asked whether you want to store elevations at calculated PC, PT, and radius points: When locating items like back of curb you may need to note the beginning and ending of curves. The points located are never exact as far as the beginning and ending of the curve, but when noted in the mapping routine the application will compute a PC, PT and Radius using the best fit routine and you can choose to store these points or not.

Note: If Auto Point Plot is ON as specified in the Graphic Options tab of the C&G Options dialog, points will be plotted and lines, arcs and/or curve fit lines are drawn when indicated by Mapping Codes found in the point descriptions.

Mapping Codes Used by the Draw feature

The map codes used by the Draw feature must be placed in the description field for each point in the coordinate file that is to be “Mapped”.
Below is the list of map codes:
BL - Begin Line
EL - End Line (optional)
CL - Close Figure
PC - Begin Curve (tangent to previous line)
OC - Point on Curve (begin/end non-tangent curve)
PT - End Curve (tangent to next line)
RP - Radius Point
CF - Curve Fit (spline fit to irregular curves)
CC - Compound Curve
RC - Reverse Curve

Mapping Codes can be upper or lower case. The map code MUST be followed by an asterisk and a line description for the line that is being drawn. For example: BL*CURB1, where CURB1 is the line description for the line you are beginning. It is OK to have spaces between the code, asterisk and line description, but it is not necessary.

For example:
Important Note: Mapped lines are connected in ascending order by point ID. The point ID's are always saved in the coordinate file in increasing order. Since the coordinate file is used to perform the Map Drawing and the point ID sequence is produced when the raw data is reduced, it follows that the order of field location of the points will determine point ID sequence order when the lines are mapped.

In the sample sequence above:
Point 5 begins two lines, **Curb1** and **SW1**. Curb1 and SW1 are line descriptions. A line description must be a whole word (no spaces). **WV** (water valve) is not the beginning of a line because an asterisk does not precede it.

For example:

5 BL*CURB1 BL*SW1 WV

The Curb1 line will be drawn from point 5 to point 6 to point 8. This begins a curve tangent to the line from 6 to 8 continuing to point 10. The curve is tangent to the line from 10 to 11. Since point 18 begins a new Curb1, point 11 is the end of the first Curb1 line (the EL code is not required in order to end a line).

A second line (SW1) will be drawn from 6 to 7 to 11 to 12. At point 12 a non-tangent circular curve begins and continues through points on the curve at 13, 14, and 15. The non-tangent curve ends at point 16 and lines continue from 16 to 17 to 1 (the CL code closes the figure). In creating the non-tangent curve from point 12 through point 16, points 13-15 are used by the Map Draw feature in the calculation of the best fit circular curve.

In addition to the lines drawn, the symbol specified for the WV description in the description table (see CGMngmt) will be placed at point 5 and, at point 7, the symbol specified in the description table for the description PP will be drawn.

As demonstrated in the above example, you may combine multiple codes and line descriptions within a single point description.

For example:

Point ID Description
20 BL*SW1 BL*Curb1 Curb2 EL*Curb3 CL*Curb4

In this example point 20 begins the **SW1** line and the **Curb1** line. It continues the **Curb2** line. It ends the **Curb3** line and it closes the **Curb4** line.

The Begin Line Code:
All lines must start with a BL code. No lines will be connected to a point unless a word in the point description matches a BL* line name.

The Close Line Code: The close line code (CL) causes the Draw Map feature to connect the CL point to the BL point. You can also use the CL command to traverse. Thus you may place dimensions after a CL command. For example:

**Point ID Description**

20 *BL*BLD1
21 CL*BLD1+10.1+10.2-20.3+50.6 EL*SW1

**Note:** The FC-48 data collector does not allow '+' characters in description field. Because of this, the '/' character can be used instead of the '+' character in all the CL examples.

In the above example a line will be drawn from point 20 to point 21. The following points will then be calculated through a traverse sequence (assume the next point available is 100):

<table>
<thead>
<tr>
<th>Occupied Pt</th>
<th>BS Pt</th>
<th>Angle</th>
<th>Distance</th>
<th>New Point</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>20</td>
<td>90</td>
<td>10.1</td>
<td>100</td>
</tr>
<tr>
<td>100</td>
<td>21</td>
<td>10.2</td>
<td>101</td>
<td></td>
</tr>
<tr>
<td>101</td>
<td>100</td>
<td>20.3</td>
<td>102</td>
<td></td>
</tr>
<tr>
<td>102</td>
<td>101</td>
<td>50.6</td>
<td>103</td>
<td></td>
</tr>
</tbody>
</table>

Point 103 will then be connected to point 20 to close the BLD1 line. Please note that point 21 is also the end of the SW1 line.

In a CL mapping code sequence, a negative dimension turns -90 degrees from the back azimuth and a positive dimension turns +90 degrees from the back azimuth. Both the '+' and '-' symbols are required but, as noted above, the '/' symbol can be substituted for the '+' where necessary.

This same figure could also be drawn using the following sequence:

**Point ID Description**

20 BL*BLD1
21 CL*BLD1+10.1+10.2-20.3+

**Note** that the closing distance was not included in the description sequence. See the following examples.

If you have located two corners of a rectangle, you may use the following short cut:

**Point ID Description**

20 BL*BLD1
21 CL*BLD1+50.6+

In the above example a line will be drawn from point 20 to point 21. The following points will then be calculated through a traverse sequence (assume the next point available is 100):

<table>
<thead>
<tr>
<th>Occupied Pt</th>
<th>BS Pt</th>
<th>Angle</th>
<th>Distance</th>
<th>New Point</th>
</tr>
</thead>
<tbody>
<tr>
<td>21</td>
<td>20</td>
<td>90</td>
<td>50.6</td>
<td>100</td>
</tr>
</tbody>
</table>

Point 101 will be calculated by a bearing-bearing intersection. Then point 101 will be connected to point 20. The first '+' sign determines the direction used to calculate point 100. The description ending in a '+' sign has the same effect as ending in a '-' sign: if there is no dimension after the last '+' or '-' sign, the last point will be calculated by a bearing-bearing intersect.

If you have located three corners of a rectangle, you may use the following short cut to define the lines to be drawn:

**Point ID Description**

20 BL*BLD1
21 BLD1

Chapter 18. CGSurvey Module

1341
In the above example lines will be drawn from point 20 to 21 to 22. The missing corner will be calculated using a bearing-bearing intersect and stored. As noted earlier, ending in a '-' sign instead of a '+' sign has the same end result.

**Curve Codes**

Anytime a circular curve is encountered, 3 new points may be calculated and stored in the coordinate file. These points are the PC, PT and radius point of the curve. It is necessary to calculate these points during automated mapping since the field points are only approximations of a perfect curve. They will automatically be assigned point numbers (regardless of the Auto Point Numbering setting). The points calculated during automated mapping of curves will begin with the coordinate files current high point number plus 1.

If the beginning of a line is also the beginning of a curve, one of the following formats must be used:

**Point ID Description**
- 10 BL*SW1 CF*SW1 (begin a curve-fit line)
- or 10 BL*SW1 OC*SW1 (begin a non-tangent circular curve)
- or 10 BL*SW1 PC*SW1 (begin a tangent circular curve)

Once a curve has begun, all matching line descriptions will be considered points on the curve until the curve is ended. A curve is ended with either a PT*, OC*, or CF* code.

For Example:

**Point ID Correct Sequence Incorrect Sequence**
- 10 OC*SW1 (Begin SW1)
- 11 SW1 OC*SW1 (will end SW1)
- 12 SW1 OC*SW1 (will end SW1)
- 13 SW1 OC*SW1 (will end SW1)
- 14 OC*SW1 (End SW1)

The first OC begins the curve. The next OC ends the curve. All the points between them are on the curve. The same is true for curve fit (CF*).

If a curve is either tangent (in), tangent (out) or tangent (in) & tangent (out), you only need two points to define the curve:

**Point ID Sample 1 Sample 2 Sample 3**
- 10 PC*CURB1 PC*CURB1 OC*CURB1
- 11 PT*CURB1 OC*CURB1 PT*CURB1

Otherwise you will need at least three points on a curve:

**Point ID Description**
- 12 CF*CURB1
- 13 CURB1
- 14 CF*CURB1

**The RP Mapping Code**

If you use the RP code (radius point), it will be used regardless of the number of points on the curve. The radius will be calculated by averaging all the distances from the radius point to the points on the curve.

Best Fit Circular Curve Calculations

If you have three or more points on a non-tangent curve, the best-fit curve solution is used to find the radius point. If you have three or more points on a tangent curve (either tangent in, tangent out, or tangent in and out), the best-fit
curve solution is used to determine an approximate radius and radius point. A dummy point is then calculated on the curve and a curve is drawn that goes through the dummy point and meets the tangent criteria (the PC and PT points are shifted up/down the tangent lines as necessary). If only three points are located, PC, POC and PT, the curve will always go through the POC point.

If you have only two points (PC and PT) on a tangent curve, the tangent lines from the PC and PT will be intersected to find the PI of the curve. The distance from the PI to the PC and the distance from the PI to the PT will be averaged to obtain a tangent distance. A new PC and PT point will be calculated on the tangent line and the radius point will be calculated based on the tangent and central angle.

Non-Circular Curves

You may use the CF* code for a non-circular curve fit (splines). The CF code will start a curve fit line. The curve will continue until a second CF* code is encountered, example:

<table>
<thead>
<tr>
<th>Point ID</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>CF*SW1</td>
</tr>
<tr>
<td>12</td>
<td>SW1</td>
</tr>
<tr>
<td>13</td>
<td>SW1</td>
</tr>
<tr>
<td>14</td>
<td>CF*SW1</td>
</tr>
</tbody>
</table>

Only use CF to start or end a curve. Notice points 12 and 13 do not have automated mapping codes. A smooth curve will be drawn through points 11, 12, 13 and 14. No new coordinate points are generated with the CF code.

Layers and linetypes for mapped lines and curves

The description table determines the layer in which a mapped line will be drawn. For mapped lines and curves, only the description and layer fields in the description table are used. However, if the default layer is not set, no description table lookup is performed and the line is drawn on the current layer.

For example, assume that the default layer has been set and that the description table contains the following entry:

<table>
<thead>
<tr>
<th>Desc. No.</th>
<th>Description</th>
<th>Layer Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>CURB Road</td>
<td></td>
</tr>
</tbody>
</table>

Since layer "Road" is specified for description "Curb", all lines with descriptions "Curb" will be placed in layer "Road". Numbers are not used in the comparisons: Curb1, Curb2, Curb10, etc. are considered a match for the description "Curb" and will therefore be placed in layer "Road".

If a matching description is not found in the description table, the line is drawn on the default layer (as set in the Graphic Options tab of the C&G Options dialog box).

Calculated Points

All coordinate points that are automatically calculated and stored during automated mapping are given a MP point code.

Note: Even though the point description field can contain Mapping Codes, the point code found in C&G coordinate files is separate and distinct from the point description field. All points already having an MP Code are ignored by automated mapping. This avoids re-mapping points that were generated during automated mapping and thus were not points actually located in the field.

Important Note: Consider the MP point code as a reserved code and do not use it for field data collection.
The description (e.g., CURB) used for calculated points is the same as the line description of the points the calculated point is associated with and reflects the type of calculated point that it is.

For Example:
Assuming the line description for the following points is "CURB1" and the points are the PC, PT and radius point of a curve, then the line descriptions will be:

<table>
<thead>
<tr>
<th>New Point ID</th>
<th>Point Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>MP</td>
<td>PC CURB1</td>
</tr>
<tr>
<td>101</td>
<td>MP</td>
<td>RAD.PT CURB1</td>
</tr>
<tr>
<td>102</td>
<td>MP</td>
<td>PT CURB1</td>
</tr>
</tbody>
</table>

Plotting of Points

If Auto Plot Points is "On", all the selected points in the coordinate file will be plotted on the screen during the mapping process. If a default layer is set, Each point will be drawn on the layer specified in the description table. The points labels will be configured as specified in the description table. Any point that does not have a description match in the description table will either be drawn on the default layer.

Pulldown Menu Location: CG-Survey > Auto Map > Draw
Keyboard Command: MAP, CG_MAP_DRAW
Prerequisite: Coordinate file

Erase

The Map Erase feature will find all line, arc, curve fit and point entities created Using the Map Draw feature and delete them from the drawing. It will also delete any coordinate points from the coordinate file that were created with the using Map Draw (PC, PT, radius points and close line (CL) points or those points having the point code MP)

Pulldown Menu Location: CG-Survey > CGDraw > Auto Map > Erase
Keyboard Command: EMAP, CG_MAP_ERASE
Prerequisite: Coordinate file

Leaders

Leaders are used to label features in the drawing. They consist of a line or series of connected line segments with an arrow at one end and a text label at the other end. The arrow size is determined by the symbol size as set in the Drawing Settings - Active Point Symbol dialog.

Text

A text leader allows you to draw a series of lines with an arrow at the starting point then specify the text that is to be drawn at the final endpoint of the leader.
Prompts

To draw a text leader:

**Pick start of leader:** Pick the starting position of the leader with the left mouse button:
Picked C&G Point [4]

**To point (Enter to end):** Move the cursor to the next point on the leader and press the left mouse button. The first segment of the leader will be drawn with an arrow placed at the first point picked.

**To point (Enter to end):** As you pick succeeding points, lines will be drawn from the previous point to the current point.

**To point (Enter to end):** When you have picked the final point, press <Enter> or the right mouse button.

**Enter Text for leader:** At the command line, type the text to be placed on the leader and <Enter>.

Sample of Text Leader

**Pick start of leader:** repeats the command

**Pulldown Menu Location:** CG-Survey > CGDraw > Leaders > Text

**Keyboard Command:** TXTL, CG_TEXT_LEADER

**Prerequisite:** Coordinate file.

Coordinate Leader

This feature allows you to pick a point then draw a leader that is labeled with the coordinates of the point picked.

To draw a Coordinate Leader:

Prompts

**Pick the starting point of the leader with the left mouse button:** If you pick a C&G point, the coordinates will be read from the coordinate file, otherwise the graphic coordinates will be used.

**Move the cursor to the next point for this segment of the leader and click the left mouse button:** Repeat until all desired leader segments are drawn.

The coordinates of the first point picked will be drawn near the final point on the leader. The coordinates are rounded based on the rounding specifications in the Rounding Options Tab of the C&G Options dialog box.

**Pulldown Menu Location:** CG-Survey > CGDraw > Leaders > Coordinate Leader

**Keyboard Command:** CRDL, CGCOORD_LEADER

**Prerequisite:** Coordinate file
**Point Label**

This feature allows you to label a point using a leader instead of the normal point labels. This feature can only be used with C&G points. The leader will display the point ID and, if Elevation and/or Descriptions are "On", the elevation and description will be displayed as well.

**Prompts**

It is suggested that you first plot the points on the screen with the point labels turned off by setting their point label positions to 0 on the Drawing Settings - Point Label Position dialog. Thus only the symbols will be plotted. Next, in the Drawing Settings tab of the CGOptions dialog box: turn on the items you want to be displayed on the leader.

Now choose the Point Label Leader menu item:

**Pick start of leader:** Move the cursor to a C&G point and press the left mouse button. Picked C&G Point [3]

**To point (Enter to end):** Move the cursor to the end point of the next leader segment and press the left mouse button. An arrow will be drawn at the first point picked.

**To point (Enter to end):** When you have picked the end of the last segment of the leader, press <Enter> or the right mouse button.

**To point (Enter to end):** The point attributes will be placed near the last point picked for the leader.

(You may repeat the previous step as many times as is necessary)

**When done press <Enter>** when asked to pick the next C&G point, Press Enter

**Pulldown Menu Location:** CG-Survey > CGDraw>Leaders>Point Label

**Keyboard Command:** PTL, CG_POINT_LEADER

**Prerequisite:** Coordinate file

**Station-Offset**

This Leader feature allows you to label points along a predefined alignment with their station and offset.
Prompts

Prior to using this feature you must create a point group that defines the alignment.

Next you will be asked to open a point group file. In the Select a C&G Point Group File dialog box: select the point group file that defines the horizontal alignment you wish to use.

**Enter starting station <0.00000>:** 1000

10+00.00

Enter Starting station for the alignment as defined by the point group. If a station is specified for the first subgroup name in the point group file, it will be used as the default station (for more details on this, see the section on point group files in CGMngmt).

**Pick the starting location of the leader:** Picked C&G Point [3]

If a C&G point is not found at this location, the station and offset will be calculated using the drawing coordinates of the picked point. If a C&G point is found, the station and offset will be calculated from the coordinates read from the coordinate file. If a C&G point is found, the point ID will be printed at the command line.

**To point (Enter to end):** Move the cursor to the end point for this segment of the leader and press the left mouse button, An arrow will be placed at the first point picked. Repeat until all the segments of the leader have been specified.

**To point (Enter to end):** When you have picked the end point of the last segment of the leader, press the <Enter> key or right mouse button.

The station and offset label will be placed next to the end point of the leader.

**To point (Enter to end):** Enter

**Pick start of leader:** Repeats the command

**Note:** The station and offset values are rounded based on the values specified in the Rounding Options tab of the CGTools > CGOptions dialog box

**Pulldown Menu Location:** CG-Survey > CGDraw>Leaders>Station-Offset

**Keyboard Command:** STOL, CG_STA_OFF_LEADER

**Prerequisite:** Point group must be created

Query

Selecting Query and then selecting a drawing object will display information related to the following C&G entities:

Point symbols and labels

Lines
Arcs
Polylines
Calls
Structure Footprints
Coordinate, Call and Curve Tables

Prompts

Select entities: (Pick entity on screen) Entities in set: 1
Select entities: (item selected) C&G POLYLINE

Below is an example of a Query listing of a C&G Polyline:

Coordinate File: CGDEMO.CRD (C&G Numeric)
Plotted from Auto Mapping: No
Layer: Boundary
Points defining C&G Polyline: 11->9
Polyline is NOT CLOSED

Pulldown Menu Location: CG-Survey > CGDraw>Query
Keyboard Command: Q, CG_QUERY
Prerequisite: Coordinate file

Drop C&G Attributes

This feature allows you to strip the C&G attribute from any C&G entity. When the C&G attribute is dropped, the graphic entity becomes standard CAD entity and will no longer be affected by the Refresh Screen feature nor can they be used by C&G commands requiring C&G entities as input.

Prompts

Select entities: pick on graphic screen
Entities in set: 1
Select entities: pick again on screen
Entities in set: 4
Select entities: select another set of entities by window
Entities in set: 7
Select entities: Specify opposite corner: 8 total found,
Entities in set: 8

Pulldown Menu Location: CG-Survey > CGDraw>Drop C&G Attributes
Keyboard Command: DROP, CG_DROP
Prerequisite: Coordinate file

re-Associate Coord. file

This routine allows you to associate the current drawing file with different coordinate file than created the drawing file. An example of this could be a phase of a project. The overall project coordinate file might contain 10,000 to 15,000 coordinates, While working on a phase of the overall project a separate, smaller, coordinate file was created, easier to work with a 1000 points rather than 15,000. Now you want to re-associate this new drawing file with the
Prompts

After selecting the re-Associate command there will be displayed a Warning dialog box. This box recommends that you create a backup of your drawing file. The danger with using this application is if the coordinates are not managed carefully and the same point ID’s were used in both the overall project file and the out parcel then the graphics will be incorrect. C&G graphics are based on the coordinate file and if the X/Y/Z values change so does the graphics.

Do you wish to Continue? Press <Y> button: Y
Re-associate only those C&G entities plotted using which coord. file [Any_file] <A>: A

An Additional Warning message may also appear indicating conflicts in linked crd files
Do you wish to Continue? Press <Y> button: Y

Pulldown Menu Location: CG-Survey > CGDraw>re-Associate Coord. file
Keyboard Command: Not available
Prerequisite: Coordinate file
Refresh Screen

Many graphic entities created by CGSurvey contain attributes that tie them to the coordinate file (C&G points, lines, arcs, calls, etc.). Examples would be point numbers, elevations, and descriptions that are plotted with the node when you plot points. However, once an entity is drawn the user is free to move or edit it. Also, it may be necessary to change the coordinates of the point or points used to create the entity.

If C&G entities are edited or the coordinate values change, you refresh the drawing so that it reflects the current coordinate file values. You can use the Refresh Screen feature to find all C&G entities tied to the coordinate file and read the points from the coordinate file and redraw the entities based on the current coordinate values.

Prompts

Check the appropriate boxes in the list to refresh: Press Ok to continue

Do you wish to retain the point symbol size and label height of the existing points?: Press <Y> button

Below is example of Refreshed screen entities:
Command: cg_refresh
24 Lines refreshed.
Pulldown Menu Location: CG-Survey > CGDraw > Refresh Screen
Keyboard Command: REF, CG_REFRESH
Prerequisite: Coordinate file

CGMngmt

Point Manager

The point manager allows the user to perform most of the normal coordinate file management functions. You can perform whole file operations such as renaming the file, copying or moving the file, etc. There are also point operations which allow the user to add, delete, or change individual points or groups of points in a coordinate file.

The C&G Point Manager dialog (shown below) is divided into three sections. These sections are described below.

Current Coordinate File Information

This section gives you basic information on the currently selected coordinate file. The Directory and File Name defaults to the currently active coordinate file but you can choose to perform operations on any one of the supported types of coordinate files by clicking the Browse... button. When you click the Browse... button you will see a file dialog allowing you to choose the coordinate file you wish to work on. The Make Current checkbox allows the user to make the specified file the current file. Thus, when the dialog closes, the file will be used for future commands requiring a coordinate file.
File Operations

This section of the dialog allows you to perform operations that effect the entire coordinate file.

There eight operations that can be performed using this section of the dialog (see descriptions listed below). To perform one of the operations on the file shown in the Current Coordinate File Information section, click on the radio button for the desired operation then click the Perform Operation button.

Apply Desc Table

This operation only applies to C&G coordinate files and will not be available for other file types. When you apply a description table to a coordinate file it translates the numeric codes found in the description field using a C&G description table. For each point in the coordinate file having an integer in the description field the program looks for that integer description number in the description table. If a matching description number is found in the description table, the description found in the description table is placed in the description field for that point and the description number is placed in the code field for that point. The point is then stored back to the coordinate file with the changed field values. If no match is found the point is not changed in any way.

Change Desc Length

This operation only applies to C&G coordinate files and will not be available for other file types. When a C&G coordinate file is created, the user is allowed to specify the length of the description for a given point in the file. The description length may be between 1 and 100 characters. This operation allows the description length to be changed. It can be made smaller or larger. If an existing point in a coordinate file has a description that is longer than the new description length, the description will be truncated. When you click the Perform Operation button you will be asked to enter the desired description length (see dialog below).

Change File Type

This operation allows the use to convert among the supported types of coordinate files. The types supported are C&G numeric (*.crd) and alphanumeric (*.cgc), Carlson numeric (*.crd) and alphanumeric (*.crd), Simplicity (*.zak) and AutoCAD Land Desktop (*.mdb). When you select this operation and click the Perform Operation button you will see the Change File Type dialog:
In the **Change File Type** dialog choose the type of file you want the current file to be converted into by clicking on the appropriate radio button.

**Note:** the radio button for the current file type is greyed out.

After choosing the file type click the **OK** button. Click **Cancel** to cancel the operation.

If you attempt to convert to a file type having point ID length or description length limits that are less than the limits for the file being converted, you will get the following warning:

**Copy File**

Performs a basic file copy. Must be to another directory and/or file name. When you click the **Perform Operation** button you will be asked to specify the copied file name and directory using a file dialog (see below).
Note: by changing the **Save as type:** this command can change the file type when it copies the file. However, if the type of file being copied has maximum allowable point IDs or descriptions that are greater than one or both of those for the file being copied to, you will receive a warning that point IDs and/or descriptions may be truncated (see Change File Type section above).

### Delete File

Deletes the file listed in the **Current Coordinate File Information** area of the **C&G Point Manager** dialog along with any of its associated files. Before actually deleting the file you must click the **Yes** button in the following dialog.

### Edit File

Allows the user to use the CGEditor to edit the coordinate file. You may add and delete points or edit any of the fields for an existing point (see the CGEditor section for more information on using the CGEditor)
Move File

Moves the current file to a new location. You will use a file dialog to specify the new location of the file. When moving a coordinate file you may also change the file type by changing the **Save as type:** The same cautions with regard to possible point ID and description truncation apply here as they do any time you change the file type (see Change File Type section above).

Rename File

Simply renames the file to whatever name the user specifies. You will use a file dialog to specify the new name and location of the file. Thus this command may be used to change the file type and/or move the file to a different directory. To change the file type change the **Save as type:** in the file dialog when you specify its new name. The same cautions with regard to possible point ID and description truncation apply here as they do any time you change the file type (see Change File Type section above).

Point Operations

You may perform several operations that effect one or more of the points in the current coordinate file in this section of the **C&G Point Manager** dialog. Use the **Points used:** and **Points Available:** lists to help you determine which points or ranges of points you wish to work on.

Add/Delete section

You may use the standard CGSurvey interface or the CGEditor to add or delete points. Choose which one to use using the radio buttons on the right side of the Add/Delete portion of the Point Operations area.

Add Points

If you chose to use the CGEditor, the CGEditor will come up (as shown above - see the CGEditor section for more information on using the CGEditor).
If you chose to Use the Standard CGSurvey Command, you will see the Manual Coordinate Storage dialog (see below). Fill in the edit boxes as described in Management > Manual Storage

Delete Points
If you chose to use the CGEditor, the CGEditor will come up (as shown above - see the CGEditor section for more information on using the CGEditor).

If you chose to Use the Standard CGSurvey Command, you will see the following prompt at the Command: line:

Choose initial points for base selection set from coord file. (Enter when done) [All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: use one or more of the available methods to specify which points are to be deleted from the current coordinate file.

Buttons section

Renumber Points

If you click on the Renumber Points button you will see the Renumber Points dialog:

Fill in the dialog (see the Management > Renumber Points section for more details) and click OK to renumber the specified range of points. If you check the OVERWRITE Existing Points checkbox, you will not be warned of any points that are overwritten during the renumbering process.

Import Points
You can use this to copy points from another coordinate file into the current coordinate file. If you click the Import Points button you will be asked to specify the coordinate file from which the points are to be imported. After specifying the import file name, you will use the C&G Select Points from: dialog to select which point are to be imported:

![C&G Select Points from: dialog](image)

**C&G Select Points from: <file name>** dialog

**Choose Points** section:

You can select any one of the methods you wish to use to choose the points by clicking one of the methods of point selection in the Choose Points section of the dialog. You may also specify whether you wish to Include or Exclude the points chosen. If you include the points, they will be added to the list from the coordinate file. If you exclude the points, the points chosen will be removed from the list of points previously Included. The method of choosing the points is very much like using the

**Choose initial points for base selection set from coord file. (Enter when done)**

[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]:

prompt. For example, if you choose the Include radio button and the All radio button then click on the <Add button, all the points in the coordinate file will be shown in the list on the left side of the dialog. If you then choose the Exclude radio button and the Block radio button, fill in the block of points you wish to remain in the list, then all but these points will be excluded from the list when you click the Remove> button (see the example dialog below).
When the points you wish to import are all in the list on the left, click OK.

**CAUTION: If the points that are being imported exist in the current coordinate file, they will be overwritten without warning!**

**Export Points** - click the **Export Points** button to copy points from the current coordinate file into another coordinate file. You will be asked to specify the file to export the points into then, similar to importing points, use the **C&G Select Points from:** dialog to select the points to be exported. Click OK in the **C&G Select Points from:** dialog to export the points.

**CAUTION: If the points that are being exported exist in the file they are being exported to, they will be overwritten without warning!**

**Prompts**

Choose initial points for base selection set from coord file. (Enter when done)

[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: use one or more of the available methods to specify which points are to be deleted from the current coordinate file. Note: this prompt is only used if you have the **Use the Standard CGSurvey Command** radio button set.

**Pulldown Menu Location:** CG-Survey > Management > Point Manager

**Keyboard Command:** cg_pt_mngr

**Prerequisite:** One or more Coordinate files

**Edit Coordinates (CGEditor)**

The user can use the CGEditor to edit an existing coordinate file or create a new one. You can add and/or delete points and edit existing points. The CGEditor has many sophisticated editing tools that make editing fast and relatively easy. Please refer to the CGEditor section of the Tools menu for a detailed explanation of how to use the CGEditor.
Auto Create Points

The purpose of this feature is to create points in the current coordinate file and draw the associated point symbols using coordinate values extracted from existing drawing entities. These drawing entities may or may not have been created with CGSurvey. The user can automatically place C&G point symbols at the vertices, radius points, insertion points, etc. of selected lines, arcs, points, polylines, and point blocks. The coordinates of the newly created points are then saved in the currently open coordinate file.

Note: Unless point symbols are picked, the coordinates that are stored will be the coordinates of the CAD entity. In the case of point symbols, the point ID will be read and used to look up the proper coordinates in the current coordinate file.

After picking the Auto Create Points menu item, the Auto Create Points dialog box will appear:

Entity Types section

Select the entity types for which you wish to create C&G points. You can check any combination of the available entity types.

When you click the Select Entities button, specifying only certain entities allows you to window a large area but only have points created for the specified types of entities. You may also select individual entities or several groups of entities. After selecting the entities, click the Create Points button to create the points and save them to the current coordinate file.

Point Blocks

If you wish to have coordinates created for point blocks (or inserts) and you want the point ID, description and elevation to be set from information contained in the block, the block must have attributes that can be used to obtain
these values. When you choose Point Blocks, the following edit boxes in the dialog are activated and must be filled out:

**Block Name:** Specify the name of the blocks you wish to have points created for.
**Point Attribute Tag:** For the block entities chosen, specify the tag name for the attribute of the block contains the point ID. If no point ID attribute is found then the next sequential point ID will be used.
**Description Tag:** For the block entities chosen, specify which attribute of the block contains the description. If descriptions are ON and no description attribute is found then the default description will be used.
**Elevation Tag:** For the block entities chosen, specify which attribute of the block contains the elevation. If elevations are ON and no elevation attribute is found: if the **Use Z-Value as Elev** is checked, then the Z value of the block insertion point will be used for the elevation of the newly created point; otherwise the specified default elevation will be used.

**Point Creation Information section**

**Starting point number:**
Use this to specify the starting point number. Specifying anything other than the next available point in the coordinate file as the starting point makes it possible that one or more existing points could be overwritten. However, whenever a situation arises that a point in the coordinate file may be overwritten, a dialog box will appear warning you of this and allowing you to decide whether to proceed with the overwrite or not.

**Use coordinate point duplication factor:**
If this box is checkbox Coordinate point duplication tolerance edit box is activated and you must enter a tolerance for determining coordinate point duplication. This is used to test if a new point that is about to be created is the same as a point already in the coordinate file. If the new point coordinates are within this tolerance the new point will not be created.

**Use Z-Value as Elev**
Select this box if the entities you select may have a Z value and you want that value used as the point's elevation.

**Default Code**
If point codes are turned ON, then this value is used as the default Code for all newly created points.

**Default Elevation**
If elevations are turned ON, then this value is used as the default Elevation for all newly created points.

**Default Description**
If descriptions are turned ON, then this value is used as the default Description for all newly created points.

**Buttons**
**Select Entities**
Press this button to begin selecting the entities for which you wish to create coordinate points. The dialog box will disappear and you will be asked to use the normal entity selection methods to choose the entities to be used for point creation. Just press Enter at the Select Entities prompt when you are done. You will then be returned to the **Auto Create Points** dialog.

**Create Points**
After the entities have been selected, press this button to create coordinate points using the entities. Any existing C&G lines, arcs or polylines will be ignored since they already have points associated with them. Non-C&G lines, arcs and polylines will be converted to C&G lines, arcs and polylines.

**Prompts**
Fill in the dialog box as required (see above explanation).

Select Entities: use the normal entity selection methods to select the entities to use for creating points.

Pulldown Menu Location: CG-Survey > Mngmt

Keyboard Command: cg_acp

Prerequisite: Coordinate file.

Manual Storage

This feature allows you to store points in a coordinate file by typing in the values for the point ID, code, northing, easting, elevation and/or description. You also have the option of using the mouse to pick the location coordinates on the screen.

When you choose the Manual Storage menu item:

If a coordinate file is not currently open, you will be prompted to open one.

Next, the following dialog box will appear:

![Manual Coordinate Storage dialog box]

Point

When the dialog box first appears, the point ID (Point) field defaults to the next available point ID as set on the General tab of the C&G Options dialog box. If you enter an existing point number in the point field and click on one of the other fields, the values associated with that point number will be retrieved from the current coordinate file and placed in the other fields. You may edit them if you wish.

Note: If you enter an existing point ID and alter any of the other fields associated with that point then save the point, NO POINT OVERWRITE WARNING WILL BE GIVEN!

North, East and Elevation

There are three different ways to enter coordinate values:

1. You can type in the coordinate values and elevation in the appropriate edit boxes.
2. You can duplicate a points values by entering a '+' sign and a point ID (example: +25) in the North field. When you click on another field, the coordinate values for the specified point will be automatically entered in the North, East and Elevation fields.
3. Or you can press the Pick Coords button. When you do this the dialog box disappears and you are prompted to pick a point on the screen. Once you have picked the desired point on the screen, the dialog box reappears with the coordinates of the selected point entered in the North and East fields.

Note: If you pick a C&G point, the coordinate values will be read from the coordinate file.

Note: The elevation field is only activated if Elevation is ON.

Code and Description

Enter the desired description in the description edit box.

Enter the point code in the edit box. The point code field is a 4 digit alpha or numeric code only used by
C&G. When present it can be used as a sorting tool in addition to the description table.

As an example: say that the description table number 25 is defined as 'Sanitary Manhole'. In addition to using 25 from the description table you also have used the code 'AB' for As-Built and 'DS' for design. Now you can build a selection set of all the description 25's, excluding all of the 'AB' codes and the selection set will contain only those points that are Design Sanitary Manholes.

Note: If descriptions are ON and Get Description From Table is checked, then if you enter an integer code in either the Code or Description field, that number will be used to lookup a description in the current description table. If a matching number is found it will be used for the code and the associated description will be used for the point's description. If there is no matching number found in the description table all fields will remain as entered.

Buttons

Store Point: When all the fields are entered, press the Store Point button to store the point in the coordinate file. If Auto Point Plot ON is checked on the Graphics tab in the C&G Options dialog, the point will be plotted as well.

Reset: This button clears all the fields in the dialog box and sets the point number to the next available point number.

Pick Coords <: click this button to use the mouse cursor to pick the point's coordinates on the screen.

Cancel: Press this button when done.

Prompts

Pick coordinates for point '<point ID>': use the mouse cursor to pick the coordinates for the point.

Pulldown Menu Location: CG-Survey > Mngmt

Keyboard Command: cg_man_coord_store

Prerequisite: Coordinate file

Delete

This feature allows the user to delete selected points from a coordinate file.

If a coordinate file is not open, you will be prompted to open one.
Select the points you wish to delete, either by picking with the mouse or entering the point sequence at the command line.
When point selection is complete, press Enter.
A dialog box will come up asking if you are sure you want to delete the points.
If you click OK, the points are deleted.

Note: Deleted points CANNOT BE RECOVERED unless point history is turned on. (See Carlson Configure)

Prompts

Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt_group/Limits/Radius/Select]: Use any of the point ID selection methods to specify which points you wish to delete from the current coordinate file.
Fix Coords
This feature should only be used if you wish to attempt to repair a damaged C&G coordinate file. A file can sometimes become damaged when the computer is shut down prior to closing the file. It is wise to always keep a backup copy of your coordinate files in case a damaged one cannot be fixed.

Before running this command, try to open the file after closing any other C&G softer that may be running.

When you run this command you will first be warned that only C&G files should be fixed:

When the file dialog comes up, browse to the file you wish to attempt to repair.

If the fix is unsuccessful, you will get an error message otherwise the fix was successful.

Prompts
Use the file dialog to choose the file to be fixed.

List
This feature allows the user to list all the information associated with selected points in the current coordinate file.
If Display at command line On is checked on the Output tab of the C&G Options dialog box, the information for the selected points is displayed at the command line (press <F2> to view it). Otherwise the output is sent to the print file. If a coordinate file is not open, you will see a file dialog allowing you to open one.

Note: To print and/or view the print file after listing the coordinates, choose Print/View Print File from the CG-Survey > File menu. This will open a text editor with the print file as the current file. You may view the file or print it using the text editor.
Renumber Points

This feature allows you to renumber the point IDs of a range of points in the current coordinate file. The point IDs will be renumbered sequentially. If the renumbered points have been previously plotted to the drawing, the points will be redrawn to reflect the changed point IDs.

When you choose this menu item, the following dialog box appears:

Point ID range to renumber:
Specify the range of point IDs you wish to renumber. Use the Point IDs Used and Point IDs Available lists to help you determine the appropriate range.

New Starting point ID:
Specify the new starting point ID for the range specified. The specified range of points will be renumbered sequentially starting with the New Starting point ID.

OVERWRITE Existing Points
If you check this check box and, in the process of renumbering the points, the new point ID is the same as an existing point in the coordinate file, the point will be overwritten. However, if you do not check this checkbox and a possible overwrite is detected, you will be informed of the possible overwrite and required to check this checkbox before proceeding. If you do not wish to overwrite existing points, either re-specify the New Starting point ID or click the Cancel button.

To proceed with the renumbering click the OK button.

Note: this feature will only renumber points in a coordinate file in which all point IDs are numeric. Thus you can renumber the points in Carlson and C&G alphanumeric coordinate files only if all the point IDs are numeric.

Prompts

Fill in the dialog box as specified above.

Pulldown Menu Location: CG-Survey > Mngmt
Keyboard Command: cg_renumber_pts
Prerequisite: Coordinate file
Transformations

Combined Transformations

The Combined Transformations feature allows the user to translate, rotate, adjust elevation and/or scale the selected points in a specified coordinate file. The user may also specify whether the transformed coordinates replace the values in the current coordinate file or are saved to another coordinate file.

The Combined Transformations menu item brings up the Transform Points dialog box. This dialog is used to configure the transformations that will be applied.

To begin the process, in the Coordinate Files Used area, choose the coordinate file into which the transformed points are to be stored. If you wish to store them in the current coordinate file, you can go on to the next step. However, if you wish to have the transformed points stored to a coordinate file other than current coordinate file, click the Browse... button and use the file dialog to choose the desired destination file.

Next, check the checkboxes for each of the transformations you wish to apply. Then, for each type of transformation to be applied, fill in each item of data in that area of the dialog.

Translate Points

To translate the points check the Translate checkbox, then fill in the data in the edit boxes in this section of the dialog.

The amount that the selected points are translated in the North and East directions is determined by the difference between the northing and easting of the Reference Point and the coordinates specified in the New Northing and
Reference Point specifies the point in the current coordinate file that is to be used as the reference point for the translation. All the selected points are translated in the same manner as the Reference Point. The reference point will be translated by the difference between its current coordinates and those specified in the New Northing and New Easting edit boxes. You can fill in the New Northing and New Easting edit boxes directly or you can enter a point ID in the New Point edit box. Assuming the point ID entered is found in the coordinate file, the coordinates read from the coordinate file will be placed in the New Northing and New Easting edit boxes. You can edit these coordinates or leave them as they are.

Rotate Points

If the Rotate check box is checked, the selected points will be rotated according to the specifications in the Rotate Points area. Rotation defaults to rotation by an angle but can be changed by merely clicking on the Bearing or Angle radio button.

Use the Rotate About Point edit box to specify the point in the current coordinate file about which the selected points will be rotated.

Rotating by an angle

To rotate by an angle click the Angle radio button. Next, type in the appropriate angle in the Rotation Angle edit box or click the Pick Angle button and pick the desired angle on the screen.

Rotating by Bearing

To rotate by bearing, click the Bearing radio button then type in the appropriate values in the Current Bearing and New Bearing edit the boxes or click the Pick Bearing button and pick the desired bearing on the screen.

Note: Bearings must be specified using qdd.mm.sss notation, where q is the quadrant (1 = NE, 2 = SE, 3 = SW, 4 = NW), dd is degrees, mm is minutes and sss is seconds. Seconds can be specified to 0.1 seconds if desired.

Adjust Elevation

If the Adjust Elevation box is checked, the elevations of the points will be adjusted according to the specifications in the Adjust Elevation area. The type of elevation adjustment can be specified by clicking on the Translate or Scale radio button.

To Translate elevations
The elevations of the selected points will be translated by the difference between the **Reference Point** elevation and the value entered in the **New Elevation** edit box. When you enter a point ID in the **Reference Point** edit box and click on another edit box the **New Elevation** edit box will be filled out with the current elevation of the reference point.

**To Scale elevations**

The elevations of the selected points will be scaled by the value entered in the **Multiplication Factor** edit box.

**Scale**

If the Scale check box is checked the northings and eastings of the selected points will be scaled according to the specifications in the Scale area of the dialog.

**Meters to Feet and Feet to Meters**

You can scale the coordinates to convert feet to meters or meters to feet by checking the appropriate check boxes. Using this form of scaling disables the other items in this section of the dialog box.

**Other types of scaling:**

The **Point to Hold** is a point in the current coordinate file that will be used to obtain the reference coordinates for the application of the specified scaling factor to the selected points.

**Simple Scale** - if you choose simple scaling it will calculate the scaled differences in northing and easting between the **Point to Hold** and each of the points selected for scaling. This scaled difference is found by calculating the difference between the coordinates of the **Point to Hold** and those of a given selected point and multiplying that times the specified **Scale Factor**. This scaled difference is then added back to the northing (easting) of the given selected point.

**Adjust to Grid** - this scaling method uses the **Site Elevation (MSL)** and the **Projection Table Factor** to adjust the northings and eastings of the selected points to grid coordinates.
Methods of Specifying Point IDs for the Various Transformations

When specifying a point ID in the transformation data (for example to specify the Reference Point when the Translate checkbox is checked), you may select points using any one of the three options listed below:

1. Type the point ID directly into the edit box provided.
2. Point List: click the Point List button to bring up the Choose Point Blocks dialog. The left pane shows a listing of all the points found in the current coordinate file. Highlight the desired point in the Points Available list then click the Add > button and the point selected will be displayed in the Points Chosen list. In every case you are only allowed to choose a single point. Once you are satisfied with the point chosen click the OK button.

3. Screen Pick: when you click the Screen Pick button the Transform Points dialog disappears and Choose a point: prompt is displayed at the command line. You may type a point ID or pick a point symbol from the drawing.

Selecting Which Points Will be Transformed

At any time prior to clicking the OK button you may choose the points to be transformed. To do this click the Select Points button. The Transform Points dialog will disappear and you will be prompted to choose the points:

Choose initial points for base selection set from coord file. (Enter when done) [All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: - use any of the available methods to specify the
Transforming the points

To transform the selected points, click the OK button. The points will be transformed and saved to the specified coordinate file.

Prompts

Fill out the Transform Points as described above.

When the Select Points button is clicked the following prompt appears:

Choose initial points for base selection set from coord file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: - use any of the available methods to specify the points to be transformed. When done specifying the points press Enter until the Transform Points dialog reappears.

Pulldown Menu Location: CG-Survey > Management > Transformations

Keyboard Command: cg_transformations

Prerequisite: Coordinate file

Best Fit Transformation

Best Fit Transformation is used to transform the coordinates in the current coordinate file using a "rubber sheet" method of transformation.

First the user must

Add points from the coordinate file. (Enter when done)
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: specify which points are to be transformed using one or more of the available selection methods.

Next, in the Coordinate Transformation dialog the user must choose at least 2 points in the coordinate file that are known (or "fixed") points
To specify a fixed point, highlight it in the **Points Available** list then press the **Add >** button to copy it to the **Points with Known Coordinates** list on the right. Or, if you wish, you can also specify a known point from the drawing by clicking the **Screen Pick** button and picking a point from the screen or typing a point ID at the command line. After choosing a known point, the following dialog will appear:

The **Add Point** dialog allows you to change the current coordinates of the known point or accept the current coordinates. When done specifying the coordinates of the known point, click the **OK** button.

After a point has been placed in the **Points with Known Coordinates** list on the right, you can edit the values you entered by highlighting the incorrect point and clicking the **Edit Point** button. Or, if you wish, you can remove an incorrect point from the right hand **Points with Known Coordinates** list by highlighting it and clicking the **< Remove** button.

After specifying all the known points, you must specify which coordinate file will be used to store the transformed points. If you wish to use the current coordinate file you need do nothing. If you wish to write the transformed points to a different coordinate file than the one listed in the **Store the Transformed Points in the File:** edit box, click the **Browse...** button and use the file dialog (see below) to specify a new or existing coordinate file. When done choosing a coordinate file, click the **Open** button in the file dialog.
Click the Transform button in the Coordinate Transformation dialog to cause the transformed coordinates to be calculated and stored in the specified file.

**Prompts**

Add points from the coordinate file. (Enter when done)  
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: specify which points are to be transformed using the typical C&G Selection method.

Follow the instructions above to fill out the Coordinate Transformation dialog box.

**Pulldown Menu Location:** CG-Survey > Mngmt > Transformations  
**Keyboard Command:** cg_crd_trns  
**Prerequisite:** Coordinate file

**Copy Coordinates**

This feature allows the user to copy a selected set of points from the current coordinate file to itself or to another coordinate file and, optionally, increase or decrease the point ID by a specified number.

First you must choose the points to be copied:

Add points from coordinate file. (Enter when done)  
[All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: use one of the available methods to specify the set of points to be copied.

Next, you must specify what value to add to or subtract from the point IDs to form the new point IDs. If you press <Enter> the default is to leave the IDs the same.

Value to add or subtract from point numbers <0>: press Enter to leave the point IDs as they are or enter a positive or negative number.

Next you must specify the coordinate file to which the points are to be copied.
Store coordinates in [Current-file/Existing-file/New-file] <C>: type "C" and Enter or just Enter to copy the specified points into the current coordinate file. Type "E" and Enter to choose an existing coordinate file into which to copy the points or Type "N" and Enter the copy the points to a new file. If you choose either an existing or new file you will use a file dialog to specify the file to use.

The selected points will then be copied to the specified file.

Prompts

Add points from coordinate file. (Enter when done) [All/Block/Code/Desc/Elev/Pt-group/Limits/Radius/Select]: use one of the available methods to specify the set of points to be copied.

Value to add or subtract from point numbers <0>: press Enter to leave the point IDs as they are or enter a positive or negative number.

Description Tables

Description tables have several purposes. They can be used as a shortcut method of using point codes or numeric descriptions to automatically set point descriptions when points are saved to a coordinate file. (Description have a similar functionality when used in conjunction with the CGEditor)

Note: the description table is only used in conjunction with saving points to the coordinate file if Descriptions are ON and Get Description From Table is checked on the General tab of the C&G Options dialog.

Description tables allow the user to specify many details regarding the appearance of a plotted point when using Auto Map > Draw or Trav > Reduce, or anytime points are being plotted.

Note: the description table is only used in conjunction with drawing points if Descriptions are ON and Use description table for point plotting parameters is checked on the Graphics tab of the C&G Options dialog.

A description number acts as an index into the description table.

When saving a point to the coordinate file and a number is used in a description field, the description table will be searched for that number. If that description number is found, the number in the description field will be replaced with the description in the description table. In the case of C&G coordinate files, the number will be moved to the point code field. If no match is found, the number will remain in the description field.

When plotting points, the description for the point being drawn is compared to the descriptions found in the description table. If a match is found then the point is plotted using the parameters specified in that description table entry.

The items in this menu allow you to create and manipulate description tables. You can create a new empty
description table and edit it. You can edit an existing description table. You can set or close the current description table and set a different default description table to be used in new drawings.

**Pulldown Menu Location:** CG-Survey > Mngmt  
**Keyboard Command:** None  
**Prerequisite:** None

---

### Create

This feature allows you to create a new description table. A dialog box will prompt you to name the description table to be created.

Once you have specified the description table to create, you will be allowed to edit the new, empty description table. See Description Table > Edit for a detailed description of how to edit a description table.

---

### Prompts

Use a file dialog to specify the name and location of the new description table and the Edit Description Table dialog to create the table entries.

**Pulldown Menu Location:** CG-Survey > Mngmt > Description Tables  
**Keyboard Command:** cg_create_desc_table  
**Prerequisite:** None

---

### Edit

This feature allows you to edit an existing description table. The following edit dialog box will appear:

**Note:** Editing a description table does not make it the current description table for the current drawing. To make a description table the current one you must choose the *Set Current* menu item in the Description Table.

**Caution for CG-SURVEY for DOS users:** You may open the older format CG-DOS Description Table. However, when opened, the CG-DOS description table will be converted to the current format and once converted, the description table cannot be converted back to or used by the CG-SURVEY for DOS program.
Description Table File:

Displays the name and location of the description table currently being edited. Pressing the **Browse** button brings up the **Choose a Description Table to Edit** file dialog box allowing you to select a description table to edit.

**Note about the Browse button:** If you are in the editor just after using the create menu item to create a new description table, you should not use the Browse button.

**Descriptions list**

This list contains a list of all the descriptions in the current description table. You may scroll through the list using the scroll bar on the right or use the scroll bar on the bottom to view the complete description. The list contains one description per line. By clicking on a description in the list its properties are displayed to the right of the list. The list itself contains some of the description's properties but you must click on the specific description you are interested in to view all its specifications. Each row in the list consists of first the description number then the description itself then the symbol and symbol and label height.

**Description section**

**Description Number:** This number acts as an index to the description table.

**Description:** The description you wish to set parameters for.

**Auto Map Line Drawing section**

If you check the **Draw Lines ONLY** checkbox then during Auto Mapping (see Draw > Auto Map > Draw) points with this description will not have the point symbol drawn but will be connected by lines if the line drawing codes are used. The **Line Type to Use** drop down box allows you to choose one of the currently loaded line types for the
lines drawn between points having this description.

Point Symbol section

Symbol: The drawing in the box on the left side indicates which point symbol is currently specified for this description. The text next to the symbol drawing is the name of the symbol minus the .dwg ending. This is the symbol to be used when plotting a point having a description matching that specified in this description entry. You may specify any valid block name by first selecting the type of symbol you wish to use: either Carlson or C&G. You can specify any standard C&G or Carlson symbol supplied with the software or create your own custom point symbols. Custom point symbols must be located in either the users Sup directory with the Carlson symbols or with the C&G symbols in Sup\CGPTSYM generally found under C:\Documents and Settings\<User Name>\Application Data\Carlson Software\<Carlson product name>\<CAD version> directory.

You may press the Change Symbol button to view and/or select the desired symbol.

![Choose Point Symbol](image)

Symbol Layer: The drawing layer that the point symbol will be plotted on for any point having a description matching that specified in this description table entry.

Point Labels section

Point Label Positions

The entries in this area refer to the plotting of Point ID, Description and Elevation labels around a point symbol.

Layer

The Point ID, Description and Elevation layer names can be specified. If none is specified then the current layer will be used.

Position
You can assign the Position of the point number, elevation and description labels in relation to the point symbol.

Valid positions are 0 through 9 based on the numeric keypad on your keyboard. Consider 5 as the location of the center of a point symbol. Labels can be placed around the point symbol just as the other numbers surround 5. You identify the location where you want the label to be placed around the point symbol by selecting the number on the numeric keypad that corresponds to that relative location. The relative positions are also indicated in the list and can be picked directly from the list.

Position 0 - indicates that you do not want the label to be plotted.
Position 5 - can only be used for the elevation label. (If you select position 5 for any other label it will be treated as Position 0). If you select position 5 for the elevation label the whole number portion of the elevation will be plotted to the left of the center of the symbol and the decimal portion of the elevation will be plotted to the right.

Whole Places - can be specified for the elevation label only.
Decimal Places - can be specified for the elevation label only.

Plot Radial
If Plot Radial is checked, the point labels will be plotted radially from the symbol's center at the Position specified. If plot radial is not selected, point labels will be plotted horizontally.

Symbol and Label Size section

Symbol Size: The size of the symbol to be plotted for a point having a description matching that specified for this description table entry.

Label Size: The height of the point label text. This refers to labeling symbols with point number, elevation and description.

Units: Units can be set to Scale X Symbol Size or Literal.

Scale X Symbol Size indicates that the values for Symbol Size and Label Size will be multiplied by the drawing scale (Specified on the Drawing Settings tab of the C&G Options dialog) to determine the size of the symbol and/or label in actual drawing units.

Literal indicates that the specified Symbol Size is in actual drawing units and should not be scaled.

Note: If the Units for a given description is set to Scale X Symbol Size, then the symbol size and label height on the printed drawing are interpreted to be in inches if drawing units are set to FEET on the General tab of the C&G Options dialog and centimeters if drawing units are set to METERS or METRES.

Buttons

List: clicking this button causes the description table to be printed as a report on the command line and to the print file.

Add/Replace: click this button to save your changes when you complete a new description or edit an existing description.

Delete: click this button to delete the highlighted description. If you delete a description, it cannot be recovered and you will not be allowed to cancel the deletion.

Exit: When finished editing, click this button.
Prompts

Use the Edit Description Table dialog to enter or modify descriptions and their drawing parameters.

**Pulldown Menu Location:** CG-Survey > Mngmt > Description Tables  
**Keyboard Command:** cg_edit_desc_codes  
**Prerequiste:** An existing C&G description table or a newly created one (see Create)

---

**Set Current**

Allows the user to select the current description table using a file dialog. The selected description table will be active for the current drawing. When Set Current is used the description table name and location are saved with the drawing settings.

**Prompts**

Use a file dialog to choose the current file.

**Pulldown Menu Location:** CG-Survey > Description Tables  
**Keyboard Command:** cg_set_desc_table  
**Prerequiste:** Existing C&G Description table

---

**Close Current**

Closes the current description table. This is saved with the drawing as part of the CG_SETTINGS.

**Pulldown Menu Location:** CG-Survey > Mngmt  
**Keyboard Command:** cg_close_desc_table  
**Prerequiste:** None

---

**Set Default**

Allows the user to select the default description table using a file dialog. The selected description table will be saved to the CGSURVEY.OPT file for the current user and used to set the default settings for any new C&G drawings created by the current user.

**Prompts**

Use a file dialog to choose the default file.

**Pulldown Menu Location:** CG-Survey > Description Tables  
**Keyboard Command:** cg_set_default_desc_table  
**Prerequiste:** Existing C&G Description table

---

**Convert to SurvCE FCL file**

This feature allows you to convert a C&G description table to a SurvCE feature code list or FCL file.
If you are using SurvCE and wish to import your C&G description table for use with SurvCE use this feature to create the FCL file then upload it to the SurvCE data collector FCL directory.

If a C&G description table is not currently open you will be asked to choose which file you wish to convert using a file dialog box.

Next, using file dialog, you will be asked to specify the name of the FCL file to create.

When you click OK after specifying the FCL file name, the conversion will take place.

**Prompts**

Use file dialog boxes to pick the C&G description table to convert and to specify the name of the FCL file to create.

**Pulldown Menu Location:** CG-Survey > Mngmt > Description Tables

**Keyboard Command:** CG_CONVERT_DESC_TO_SURVCE_FCL

**Prerequisite:** Existing C&G description table (*.tbl) and its index file (*.tbx).

**Point Groups**

Point groups were formerly called Batch Point Files or point files. These files are text files with the extension pts.

These features allow the user to create or edit a point group. A point group is simply an ASCII text file that contains a list of point IDs that are in a specific sequence. The points in a point group can describe a tract of land, a road centerline, a utility line, a group of lots in a subdivision, etc. - anything that can be defined by a series of points. Point groups can also contain the PC radius point and PT for horizontal curves as well as vertical curve information.

**An example of a point group file:**

If you view a point group file in a text editor like notepad you will see something like this example

**Note:** the text in square brackets does not appear in the file itself - it is only used to clarify this example:

```
LOT 1 [Subgroup description]
  1 [Point 1]
  23 [Point 23, PC]
  +48 [Clockwise radius point 48]
  49 [Point 49, PT]
  50 [Point 52]
  1 [Point 1, back to starting point]
LOT 2 [Subgroup description]
  12 [Point 12]
  24 [Point 24]
  65 [Point 65]
  70 [Point 70]
  12 [Point 12, starting point]
```

The above example illustrates a point group with two subgroups. Each subgroup defines a lot. The last point in each subgroup is optional - you don't need to close the lot boundary by entering the starting point twice.

**Pulldown Menu Location:** CG-Survey > Mngmt
Create
There are two ways to create a new point group: you can use this command or you can use the CGEditor. Previous C&G users may prefer to use this command but the CGEditor allows the user the ability to view and edit the point group as it is being created.

If a coordinate file is not open, you will be prompted to open one using a file dialog.

Once the coordinate file is open, the point group file dialog can be used to specify the name of the point group file you wish to create.

**Subgroup description** <Enter when done>: Enter the subgroup description.
**Specify points for subgroup** <filename>:

**[Block/Code/Desc/Elev/Indiv/limits/Radius/Vertical_curve]** <pick polyline>:

Use any of the available methods, including picking a polyline in the drawing, to specify the point IDs of the points in the subgroup. Remember that, within a given subgroup, you are defining a specific shape or line and thus the points need to be entered as an ordered sequence that properly defines the lot, alignment, etc.
Repeat the steps outlined above until all subgroups and their points have been entered.
To end the command and create the point group file, press Enter twice after specifying the last point in the last subgroup.

Using a Polyline to specify a group of points

If you pick a polyline, the coordinate file is searched for points having northings and eastings that match the x and y coordinates of the vertices of the polyline. If none of the points in the coordinate file match the polyline vertices, then no points are added to the points in the current subgroup. Any points that match are added to the subgroup points and you are prompted for the next point in the subgroup. You may continue using any of the methods of specifying points, including picking other polylines.

Entering a Curve

First type "I" and enter to enter individual points. As you are specifying the individual points in the subgroup you can specify a curve by entering the radius point ID immediately after entering the ID of the PC. The radius point must be indicated by preceding its point ID with a plus sign for a clockwise curve or a minus sign for a counterclockwise curve. The next point ID you enter is assumed to be the PT.

Vertical Curves

If you are creating a point group to define a road alignment, you may wish to enter vertical curve information so that both the horizontal and vertical alignments are defined.

**Note:** You may find it more convenient to use the CGEditor to enter vertical curve information.

To do this type "V" and Enter at the command prompt. You will see the following prompt:

**Vertical Curve 1**

**[Next/slope-In/slope-Out/Length/pvi-Station/pvi-Elevation]:**

For the first vertical curve you must enter five curve components. Enter these five components by typing the capitalized letter representing the component that you wish to specify, then press Enter. You will be prompted to
You must enter a value for each of the following five required fields:

The slope-In
slope-Out
Length of the vertical curve
pvi-Station
pvi-Elevation.

Entering succeeding vertical curves

After entering the information for the first vertical curve, enter <N> for Next. Since the slope in and PVI elevation are determined by the previous vertical curve information, so you need only specify three fields for any additional curves:
slope-Out
Length
pvi-Station

Use Previous and Next to enter and/or change the vertical curve information. You may enter as many as fifty vertical curves. You can press the F2 key at any time to view the prompt history screen, then use the scroll bar on the right to view the entire data entry sequence.

Multiple Subgroups

To place more than one subgroup in a single point group, press Enter when asked to select another point for the current subgroup. This ends input for the current subgroup.

At the Subgroup description <Enter when done>: prompt, enter the name of the next subgroup and go on to enter a new series of points, including both horizontal and vertical curve information as needed.

Continue to enter subgroups of points by repeating these steps until all subgroups have been entered.

When you have entered all the subgroups, press Enter until you get the Subgroup Description prompt.

Press Enter at the Subgroup Description prompt to end the command and create the point group file.

Prompts

Subgroup description <Enter when done>: Enter the subgroup description.

Specify points for subgroup <filename>: [Block/Code/Desc/Elev/Indiv/limits/Radius/Vertical curve] <pick polyline>: use one or more of the available methods to specify points in the current subgroup.

Vertical Curve 1

Vertical Curve ##

Pulldown Menu Location: CG-Survey > Mngmt > Point Groups

Keyboard Command: cg_create_bpf

Prerequisite: Coordinate file
Edit

The Edit Point Groups feature allows you to use the CGEditor to edit/create an existing point group file.

CGEditor General Information

The CGEditor is an integral part of preparing files for use in C&G applications. The CGEditor is a very powerful tool. You can open multiple data files of any supported file type and edit the files as needed. The CGEditor has a full complement of tools for searching and replacing and navigating within a file. It will also allow you to cut or copy records from one file and paste them into another file in order to merge files, move data between phases of a job, etc.

The CGEditor can create and/or edit six types of data files used by C&G:

Raw Data Files

Raw data files contain information pertaining to a field traverse. Raw data files are typically downloaded from the data collector and converted to the C&G raw data file format. These files have the extension .CGR.

Map Check Files

Map Check files contain bearing, distance and curve information and are typically used to calculate the closure of a deed description. These files have the extension .CGM.

Cross Section Files

Cross Section files contain one or more cross sections identified by their station along the alignment. Each cross section record has the percent grade defined for its left and right slopes. Following the "Station" record are several "Point" records containing the elevations and offsets of the points along the cross section. Cross section files consist of a pair of files; the main data file has the extension .CEW and the index file has the extension .CEX.

Template Files

Template files are merely cross section files that represent a standard cross section and can be used to generate other cross section files. However, unlike cross section files, template files use an integer ID instead of a station to uniquely identify each template. Like cross section files, the percent grade is defined for the left and right slopes of each template and there are a set of "Point" records specifying the template elevation at a given offset. The centerline elevation at offset 0.00 is typically set to 0.00. Template files consist of a pair of files; the main data file has the extension .CTP and the index file has the extension .CTX.

Point Group Files

Point Group Files are simply a list of point numbers that can define a group of points, a lot or parcel, or an alignment. These are ASCII files and have a .PTS extension.

Coordinate Files

CGSurvey supports many different coordinate file formats:

C&G .CRD/.IDX - C&G numeric coordinate files
C&G .CGC/.CGX - C&G alpha-numeric coordinate files
Carlson .CRD - Carlson coordinate file format, numeric and alpha-numeric
Simplicity .ZAK - Simplicity coordinate file
LDT - MDB - Land Desk Top coordinate file

Note: for further and complete information on using the Edit Raw File see the chapter on CGEditor in the Tools section.

Pulldown Menu Location: Management\Point Groups\Edit
Keyboard Command: BPF, CG_EDIT_BPF
Prerequisite: Open Raw File

CGTopo

Topographic Settings
Allows you to view or change the Topographic Settings. See the Topography tab section of the CG Options menu item of the Tools menu.

Pulldown Menu Location: CG-Survey > Topo
Keyboard Command: cg_cont_setup
Prerequisite: None

Erase Surface from DWG
When you open a C&G surface (or TIN file, *.tin) it is shown on the screen as a graphic image overlaid on your drawing. You must use the Write Surface to DWG feature to actually create contour polylines, TIN lines, etc. If the surface changes due to changes in elevation or location of points you will want to erase the old surface and write the new surface to the drawing. However, once a surface is written to the drawing, it can be a difficult process to pick out all the surface entities in order to erase them from the drawing. This feature makes this an easy, one step operation.

You can use the items in this menu to erase the various topographic features: the TIN, Main Contours, Intermediate Contours, Break Lines, Include Boundaries, and/or Exclude Boundaries or All topo items.

Note: To erase contour labels use CG-Survey > Topo > Label Contours > Delete Labels

Pulldown Menu Location: CG-Survey > Topo

Tin
This feature erases all the C&G TIN entities found on the TIN layer specified on the Topography tab of the C&G Options dialog.

Pulldown Menu Location: CG-Survey > Topo > Erase Surface from DWG
Keyboard Command: cg_erase_tin
Prerequisite: None

Main Contours
This feature erases all the C&G main contour polyline entities found on the main contour layer specified on the Topography tab of the C&G Options dialog.
Intermediate Contours
This feature erases all the C&G intermediate contour polyline entities found on the intermediate contour layer specified on the Topography tab of the C&G Options dialog.

Pulldown Menu Location: CG-Survey > Topo > Erase Surface from DWG
Keyboard Command: cg_erase_interm_cont
Prerequisite: None

All topo items
This feature erases all the C&G topo entities found on any of the layers specified on the Topography tab of the C&G Options dialog.

Pulldown Menu Location: CG-Survey > Topo > Erase Surface from DWG
Keyboard Command: cg_erase_all_topo
Prerequisite: None

Label Contours
The items in this submenu allow you to either label contour lines with appropriate elevations or remove previously placed contour labels.

Pulldown Menu Location: CG-Survey > Topo

Place Labels
This feature allows you to place the appropriate elevation labels at selected locations on C&G contour polylines. The label is a TEXT entity overlaying a WIPEOUT entity. The WIPEOUT entity serves to create a space between the label text and the contour line and to keep the contour line from showing through the text and obscuring it.

If you have not already done so, please review the contour labeling settings by choosing the CG-Survey > Topo > Topographic Settings menu item. The labels will be created on the Main and Intermediate Contour Label Layers. The Labeling Interval determines which contours are labeled. For example, if the Labeling Interval is set to 2.00, then every C&G contour polyline that you choose having an elevation evenly divisible by 2.00 will be labeled. The Label-Contour Separation Distance: is the space separating the contour line and the start and end of the label text.

Once you have verified the correct settings, choose the Label Contours > Place Label menu item.

At the prompt (see below) use the left mouse button to pick any point that is on one side of the contour line you wish to label.

Pass a line thru the contours to be labeled.
Pick first point on line. [<ENTER> to quit]:

Now, at the next prompt (see below), drag the rubber band line through one or more of the contours you
wish to label and click the left mouse button a second time.

Pick second point [<ENTER> to quit]:

The labeling operation can be repeated as many times as needed, then press Enter to end the command.

Some Trouble Shooting Tips for Labeling Contours:

When a C&G surface is opened it is shown only as a graphic image overlying the drawing. Therefore, before you can place labels on the contour lines, the surface must be written to the drawing using the CG-Survey > Topo > Write Surface to DWG menu item..

If the labels do not appear on the contour lines you chose, verify the elevation on the contour using the CAD LIST command.

Also, try changing the Labeling Interval setting on the Topography tab of the C&G Options dialog.

If the labels still do not appear on the contour lines, look at Drawing Settings tab of the C&G Options dialog and verify that the Text Size is set to a value that is large enough to be seen when viewing the contours.

If the elevation labels are created with an incorrect number of decimal places, check the Elevation Precision on the Rounding tab of the C&G Options dialog under Text in Drawing. Use the CAD UNDO command to undo the previously placed labels and try again.

Prompts

Pass a line thru the contours to be labeled.
Pick first point on line. [<ENTER> to quit]: use the left mouse button to pick any point that is on one side of the contour line you wish to label.

Pick second point [<ENTER> to quit]: drag the rubber band line through one or more of the contours you wish to label and click the left mouse button a second time.

Pulldown Menu Location: CG-Survey > Topo > Label Contours
Keyboard Command: cg_label_contours
Prerequisite: C&G contour polyline entities in the drawing

Delete Labels

This feature allows you to delete previously placed C&G contour labels. C&G contour labels consist of two entities: a TEXT entity containing the elevation text and a WIPEOUT entity used to hide the contour polyline under the elevation text. While you can delete these using standard CAD commands, it requires several steps and can be tricky. This feature makes deleting these labels a one step operation.

After choosing the CG-Survey > Topo > Label Contours > Delete Labels menu item you will see the following prompt at the command line:

Select contour labels to delete:
Select objects: use the mouse to pick the label text for the labels to be deleted. Press Enter when done and the labels and their accompanying WIPEOUT entities will be deleted.
Prompts

Select contour labels to delete:
Select objects: use the mouse to pick the label text for the labels to be deleted.

Pulldown Menu Location: CG-Survey > Topo > Label Contours
Keyboard Command: cg_del_cont_labels
Prerequisite: None

CGTools

CG Options

The CG Options menu item brings up the C&G Options dialog, allowing you to view or change various CGSurvey settings or save the currently configured settings to be used as the default settings for a newly created drawings.

There are nine tabs on the C&G Options dialog. Each tab pertains to a category of settings:

1. General tab - settings regarding the coordinate file type for new files, units, scale factors, and other general settings.
2. Rounding tab - number rounding settings used for the print file and for text placed in the drawing.
3. Graphics tab - specify when CGSurvey draws points and lines, format of bearings and other graphics related settings.
4. Traverse tab - settings used by all traverse related features.
5. Output tab - specify the name and layout of the print file and how the results of C&G features are displayed.
6. Data Path tab - specify the default path to your data files
7. Drawing Settings tab - specify drawing scale, text size, and details of how point symbols and their labels are to be drawn.
8. Topography tab - specify contouring parameters along with the layers used for the TIN, contour and other topographic entities.
9. Calls tab - specify the components, format and layer for calls (annotations).

Each of these tabs will be covered in the following sections.

This tab contains a wide variety of settings that apply to almost all of the features found in the CG-Survey menus. These are settings such as Next Point ID, Elevations, State, Arc Definition, Bearings/Azimuths, Coordinate order and more.
Creating New Coordinate Files section

**File Type:** You may select one of the following coordinate file types:
C&G numeric (*.crd)
- point ID can be an integer between 1 and 65,536
- description from 1 to 100 characters
C&G alphanumeric (*.cgc)
- point ID can contain up to 10 characters using any combination of letters and numbers.
- description from 1 to 100 characters
Carlson numeric (*.crd)
- point ID can be any integer containing up to 9 digits.
- description from 1 to 31 characters
Carlson alphanumeric (*.crd)
- point ID can contain up to 9 characters using any combination of letters and numbers.
- description from 1 to 31 characters
Simplicity (*.Zak)
- point ID can contain up to 8 characters using any combination of letters and numbers.
- description from 1 to 28 characters
Land Desktop Format (*.mdb)
- point ID can contain up to 255 characters using any combination of letters and numbers.
- description from 1 to 255 characters

**Description Length:** This value can only be set for C&G coordinate files. It becomes the default description length for new C&G coordinate and C&G raw data files. It can be set to from 1 to 100 characters.

Current Coordinate File section
Elevations ON If this checkbox is checked, elevations will be carried on all points computed and/or you will be able to enter an elevation when saving a point.
Enter Elev.: If this checkbox is checked, you will be prompted to manually enter elevations.
Calculate Elev.: If this checkbox is checked and an elevation can be computed from the data that has been entered during the command, it will be. Otherwise you will be asked.

Descriptions ON If the Descriptions ON checkbox is not checked, you will not be prompted to enter a description as points are created or edited.
If descriptions are ON, and Get Description From Table IS NOT checked, you will be prompted to manually enter a description for each coordinate point created. However, if Descriptions are on and Get Description from Table IS checked, when a point is stored and a description table IS NOT open, you will be prompted to select a description table. The description table will then be used to look up any integer number in the description in order to substitute the description in the table for the integer and move the integer to the Code files. (see help under CG-Survey > Management > Description Tables)

Point Codes ON If the Point Codes ON checkbox is checked, you will be allowed to enter a two to four character code depending on the number of characters in the code type you are using. This code can be used later to group points with the same code for plotting or listing points. When Point Codes are off, you will not be prompted to enter the point codes.

Automatic Point Numbering ON If the Automatic Point Numbering ON checkbox is checked, as points are created they will automatically be assigned the next available point ID in the current coordinate file. If Automatic Point Numbering is OFF, as points are created you will be prompted to enter their ID. If you enter a point number that already exists in the coordinate file, you will be asked if you want to overwrite the existing point or enter a new point ID.

Scale Factors section

Input: This allows you to set a scale factor that will be applied to all entered distances and coordinate values during any C&G feature.

Output: This allows you set a scale factor that will be applied to all output. For example, if this factor is set to 2.0 and the inversed distance between two points is 100.00, the output will show the distance as 200.00.

Apply Scale to Elevation If the Apply Scale to Elevation checkbox is checked, the Input and Output Scale Factors will be applied to elevation values.
Apply Scale to Coordinate Listings If the Apply Scale to Coordinate Listings checkbox is checked, the Input and Output Scale Factors will be applied to coordinates listed at the command line and in the print file using the C&G feature in menu item CG-Survey > Management > List.

Units section

Angles: Choose either the Degrees or Gradians radio buttons.
Distance: Choose Feet, Meters or Metres from the list.
Note: The only difference in the two metric choices is the spelling used for output.
Foot Definition: Choose either the US or International radio button.

Location section
State: specify the state in which the current survey was done.
This is only used in the following features:

Solar Observation
NAD83 (to and from longitude and latitude)

Hemisphere: Hemisphere can be set to Northern or Southern.
This is only used in the following features:
Solar Observation (Calculating the Convergency Angle)
NAD83 (to and from Longitude and Latitude - UTM only)

Miscellaneous section

Azimuth/Bearing: Allows you choose between Bearing and Azimuth for all direction input and output.

Azimuth Direction: This sets all azimuth input and output to either North or South azimuth.

Curve Definition The Curve Definition can be set to Arc or Chord.
Arc: the most commonly used definition in roadway design. When units are set to Feet, the degree of curve is the
central angle of a 100 foot arc length.
Chord: is most commonly used in railroad work. When units are set to Feet, the degree of curve is the central angle
of a 100 foot chord.
When a curve is added to a Curve Table or the results of calculations are listed at the command line and in the print
file, the displayed information will reflect the Curve Definition setting.

Coordinate Order: Can be set to North-East or East-North. This sets the order in which coordinates are
displayed and input.
Allows you to specify the rounding settings for various types of numbers for the print file text and for the drawing
text.
Note: All internal calculations are performed with double precision accuracy. Only the output is rounded.
When you select the Rounding tab, you will see the following dialog:
The Rounding dialog has a section for At Command Line and in Print File rounding settings and a section for Text in Drawing rounding settings. Both sections have similar settings but they apply to different output. At Command Line and in Print File rounding settings effect all output to the command line and the print file. Text in Drawing rounding settings effect numeric text placed in the drawing.

Angular precision can be specified to the nearest:
- Angles in Degrees or Angles in Grads
  0.1 Second 0.000001 Grad
  Second 0.00001 Grad
  5 Seconds 0.0001 Grad
  15 Seconds 0.001 Grad
  30 Seconds 0.01 Grad
  Minute 0.1 Grad

Distance precision can be specified to the nearest:
- Foot (or Meter) 0 (no decimal places)
- Tenth of Foot (or Meter) 0.1
- Hundredth Foot (or Meter) 0.12
- Thousandth Foot (or Meter) 0.123
- Ten Thousandth Foot (or Meter) 0.1234
- Hundred Thousandth Foot (or Meter) 0.12345

The Graphics tab settings apply only to CGSurvey features that draw points, lines, etc. to the drawing. When you select the Graphics tab, the following dialog will appear:
Point Drawing section

Auto Point Plot ON if the Auto Point Plot ON checkbox is checked, points symbols will be drawn as they are calculated and saved to the coordinate file by the various C&G features.

Use Description table for point plotting parameters  When this checkbox is checked the description(s) for a given point in the coordinate file will be matched with the descriptions in the description table. If a match is found then the description table information will be used to set the layer, symbol type, symbol size, and label positions of each point plotted. If no descriptions in the description table match then the layer will be set to the layer specified in the Default layer for codes or descriptions not found in description table edit box and the other settings specified in the Drawing Settings tab will be used (see below).

If the Use Description table for point plotting parameters checkbox is not checked, the points, symbols and labels will be plotted on the Current Layer as set in the CAD layer manager.

Default layer for codes or descriptions not found in description table: When the Use description table for point plotting parameters checkbox is checked, any points plotted that do not have a description or having a description that does not match any of those in the description table, will be plotted on the layer you have specified as the default layer in this edit box.

Use Elevation as Z Value: If this checkbox is checked, objects (lines/arcs/points) will be placed in 3-D space with the point elevation serving as the Z-value. C&G features, such as intersects and inverse, ignore the Z-value of lines and arcs. If you inverse a 3-D line, the 2-D distance between the points will be shown.

If the Use Elevation as Z Value checkbox is not checked, all objects will be placed at zero elevation.

Note: 3D lines can cause problems in trimming or editing using CAD functions. 3D lines do not intersect if their elevations are different. Thus two lines may appear to intersect in plan view but do not actually intersect in 3D space.

Line Drawing section
Auto Line Plot ON If the Auto Line Plot ON checkbox is checked, those features that create points that can be interpreted as a line will draw C&G lines. The following features can draw lines and curves as the points are calculated:

Quick Traverse (not to side shots)
Curve Between Tangents and Tangent Between Curves
Bearing and Hinge/Radial Area-Cut-Off
Roadways (Right of Way/Easements and Intersections/Cul-de-Sacs)
Middle Ordinate Solution
Best Fit

Line Stop Size This allows you to terminate C&G lines at the edge of the point symbols plotted. If you are drawing lines and/or arcs with a C&G feature that draws lines and you want the line to end before crossing into the symbol, then set the Line Stop Size to the symbol size.

Note: If you set the line stop to something other than 0.0, the line that is drawn is shorter than the actual distance between the coordinate points. So if you wish to check the true distance of that line, use the Query command (on the Draw menu) rather than the CAD LIST command.

Text section

Arc Annotation Prefix
This is used when annotating arcs when drawing calls. This should be set to the desired prefix for arc length annotation.
Example:
"Arc =" annotation prefix results in the annotation being
Arc = 256.32

"A =" annotation prefix results in the annotation being
A = 256.32

Radius Annotation Prefix
This is used when annotating arcs when drawing calls. Similar to Arc Annotation Prefix, This should be set to the desired prefix for radius annotation.

Leading Space in Bearing
When the Leading Space in Bearing checkbox is checked the bearing text has a space between the N or S and the degrees text (eg, N 85º15'30''E). When left unchecked there is not space (eg, N85º15'30''E).

Miscellaneous section

Process Descriptions before Displaying:
This setting will allow you to specify how descriptions are processed prior to being displayed. It allows the removal of all underscores (_) and/or mapping codes. No change is made to the data in the coordinate file.

C&G Snap can be set to:
Off: No snap.
POINTS - Snap to C&G point symbols and labels.
LINES - Snap to C&G lines.
POINTS-LINES - Snap to C&G points and lines. All C&G functions will use this setting when you are picking point symbols, point labels, lines, and arcs on the screen.

Curve Fit Type

When contouring, the contour lines that are created can be smoothed using one of the following methods:

No Fit - Straight line segments between the points.

Fit - Use the CAD program's standard fit method. Contours may not pass through point symbols having the same elevation as the contour.

C&G Spline - Use the C&G Spline Fit algorithm. Contours are guaranteed to pass through point symbols having the same elevation as the contour.

These settings are specific to traverse raw data entry using the CGEditor and the traverse reduction and quick traverse features.

Raw section

Raw Angle Input
This allows you to specify how you want to specify angles when inputting raw traverse data. The options are: Angle, Azimuth or Deflection Angle.

Adjustment Method
You have the following choices for traverse adjustment:

None

Least Squares (NOT network least squares - see SurvNET for that)

Find Bad Angle

Compass

Transit

Crandall
Note: See the Reduce Traverse feature help section for more details on these methods.

If the Backsight Distance ON checkbox is checked and you entering raw traverse data, you must specify the distance to the backsight at each instrument point. These distances will then be used during the reduction process.

If the Adjust Angles ON checkbox is checked, angles will automatically be balanced prior to traverse adjustment. Angular error will be spread equally between all points. Closure information prior to and after balancing will be displayed at the command line.

If the Balance Elevations ON checkbox is checked, the elevations in a 3-D traverse will automatically be balanced during traverse adjustment. The elevations are adjusted proportional to the length of the traverse legs.

Tolerances section

Horz. Angle.
When comparing multiple angles for a given foresight point from a given instrument point and backsight point, this value will be used as the maximum acceptable angular error. If the difference between any two angles is greater than the acceptable limit, the reduction process will pause and showing the instrument point ID and angle measurements will be displayed at the command line.

Horz. Dist.
When comparing multiple horizontal distance components or measurements to a single foresight point, this value will be used as the maximum acceptable distance difference. If the difference between any two distances is greater than this limit, the reduction process will pause and the instrument point ID and the involved distances will be displayed at the command line.

The horizontal distance tolerance is also used as the maximum allowable difference between the two calculated curve radii at the curve end points. If the difference between the distances from the radius point to the PC point and the radius point to the PT point is greater than this value, the calculations will be terminated with an appropriate error message.

Note: for curves, if this value is set unreasonably low, many curves will produce this error message. If you change the setting to a larger, more reasonable value, the curve can be recalculated and generated without error.

Vert. Dist.
This value is the maximum acceptable elevation difference. It is used when comparing multiple vertical distance components/measurements to a given foresight point from a given instrument point. If the difference between the distances is greater than this limit, the reduction process will pause, showing you the instrument point ID and the involved distances. This only applies to the reduction of a 3-D traverse.

Quick section

Quick Angle Input
This specifies the default angle input mode for the Quick Traverse Feature. This can be changed when using the Quick Traverse feature.
The angle input modes are:
Angle
Deflection Angle
Azimuth
Bearing
If the **Print Traverse Input ON** checkbox is checked, all raw input data will be displayed along with the traverse output. If this checkbox is not checked, only the traverse output will be printed.

If the **Vertical Angles ON** checkbox is checked you will be asked to enter vertical angles with the traverse distances. This can be changed when using the **Quick Traverse** feature.

**Curve Bearing**  
This defines how non-tangent curve bearings will be input and can be set to either **Chord** or **Radius** depending on how you wish to define the orientation of non-tangent curves.  
When set to **Chord** and you are traversing around a non-tangent curve, you must enter the bearing or angle from the PC to the PT.  
When set to **Radius** and you are traversing around a non-tangent curve, you must enter the bearing or angle from the PC to the radius point.  
Curve Tables and printed calculations will reflect this setting.

**Traverse Mode**  
Sets the default traverse mode for the **Quick Traverse** feature.  
It can be set to **Traverse** or **Side Shot** mode.  
**Traverse** mode: as a point is created the new point is occupied and backsight the previously occupied point.  
**Side Shot** mode: as a point is created the currently occupied point and backsight will be held.

**Common section**

**Instrument Height (HI)**  
The value entered for the HI can be either the actual instrument **Elevation** or the distance from the ground to the instrument (**Plus up**). In the latter case the elevation of the point the instrument is over is read from the coordinate file and the instrument height is added to it to determine the instrument elevation.

**Vertical Angle Input** - can be set to one of the following, depending on the type of instrument used:  
Zenith: Zero angle up  
Nadir: Zero angle down  
Transit: Zero angle level  
**Note:** If set to Transit, vertical can either be full circle (0 to 360 degrees; 0 to 400 grads) or positive angle up and negative angle down.

**EDM Offset**  
Depending on where your EDM is mounted, enter the vertical difference between the center of the scope of the instrument and the center of the beam of the EDM (+ if EDM is above; - if EDM is below). Do not use an EDM Offset for scope mounted EDM's. This offset should only be applied to yoke or azimuth base mounted EDM's.

**Note:** Use of the EDM offset allows you to turn your vertical angles directly to the target. A correction will be applied to all distances and elevations computed from field entries in the Traverse and Quick Traverse routines. Most total stations today have the EDM coincident with the center line of instrument scope. In this case the EDM Offset should be set to zero.

**Note:** When an offset is entered, it is used on all distances in the traverse. If some distances are chained, the correction will also be applied. These shots should be reduced separately with no EDM Offset.

**Distance Components** - This option can be set to allow either **Slope Distance/Vertical Angle** or **Horizontal Distance/Vertical Distance** data entry.

If the **Curvature and Refraction ON** check box is checked, the horizontal and vertical components of all
slope distances are corrected for curvature and refraction. If your EDM does not already make this correction, it is recommended that this correction be used when carrying elevations using vertical angles and distances. This tab allows you to specify the name and format of the print file and how it is viewed.

Print File Name section

The final results of calculations and other actions performed during C&G command execution will always be printed to this ASCII text file. New information is always appended to this file and never overwritten. The default file name is PRINTER.TXT. It is recommended that you use a name that corresponds with the project you are working on. This way you will have a record of all calculations throughout the project. Use the New Print File button to specify a new print file to create. Use the Existing Print File button to specify an existing file.

Print File Viewer section

You can choose to use Microsoft Notepad or Wordpad when viewing or printing the print file. If you want the viewer to always come up full screen, check the Force print file viewer to use full screen checkbox.

Point Configuration section

If the Headings On checkbox is checked, a heading is printed to the command line and/or the print file any time multi-line output is generated by a C&G feature. The heading information contains date, time, feature name, coordinate file name and input and output scale factors. The header is repeated when the number of lines output by a function exceed the value set for Lines Per Page.

If the Display On checkbox is checked, the output from CGSurvey features is printed at the command line. Regardless of this setting, output is always sent to the print file.

Printable Columns
Use the edit box to specify the maximum number of characters per line to be written to the print file. This allows you to fit the text to the printed page given the font and paper your uses. The acceptable values are 80 through 255.

**Lines Per Page**

This allows you to set the number of lines that will be placed on a page. If headings are on, a header will be printed to the print file and the command line each time this number of lines is exceeded.

On this tab you can specify the path to your data files. The data path is the default directory for file dialogs used in various C&G commands that open or save files.

You can type the path in the **Data Path** edit box or you can use the **Browse...** button to use a file dialog to specify the data path.

On this tab you can specify drawing scale, text size, point symbol type and its format, and point symbol layers.

**Drawing Scale section**

This sets the horizontal scale. For example, if units are set to feet and you want a horizontal scale of 1" = 20' then type 20 in the Horizontal (ft/in) edit box. For metric units, if you want a scale of 1m = 500m then enter 500 in the Horizontal (m/m) edit box.

**Text Size section**

Allows you to set the text size for any text drawn using a CGSurvey feature. The text size is the size of the text as measured on the plotted or printed page. It must be specified in inches if using feet or centimeters if using meters.
Point Symbol Configuration section

Current Symbol section

This section allows you to control the symbol, its size and how it is scaled (called units here).

Type of Point to be Drawn: There are two point symbol libraries to select symbols from, the C&G and the Carlson symbol libraries.

Using symbols from either the C&G or Carlson symbol library both allow you to use all of the associated C&G features for plotting, sorting, line stops, attribute information, selection, etc. If you choose to use Carlson symbols the Label Position section of the dialog changes somewhat. This will be discussed later in this section.

Select Symbol button

Choosing Select Symbol button will bring up the Choose Point Symbol dialog:

Use this dialog to choose the active point symbol. You do this by highlighting the symbol name in the list on the left or by clicking the symbol image on the right. Symbols CG00 and CGDCA are compatible with LDT/LDD points. The CGDCA symbol is the correct size for a true LDT/LDD point, and should be used if you are also using LDT/LDD.

Symbol Size and Units
There are two options available for specifying symbol size: \((\text{Height}) \times (\text{Scale})\) and \(\text{Literal}\).

If \(\text{Units}\) are set to \((\text{Height}) \times (\text{Scale})\), then the symbol size entered here is specified as \textit{plotted page units} (inches or centimeters - depending on whether feet or meters are being used). In this case, regardless of scale, the symbol will always be the same size when plotted. In example above, the symbol is set to .300'. At 30 scale the symbol height will be 9 feet in the drawing itself, at 40 scale it would be 12 feet. Thus, in either case, its plotted size will be 0.3 inches.

If \(\text{Units}\) are set to \(\text{Literal}\) then the symbol will be drawn \textit{in the drawing} at the size specified. This setting is often used for inserts such as title blocks, north arrows, company logos, standard notes, etc.

**Label Layer Control section**

If you check the Separate Layers check box, you can assign each point label to a specific layer. This allows you to see only the labels you want by turning different layers on or off. If this checkbox is not checked, all the point labels will be drawn on the current layer.

**Label Position section**
C&G Labels:
If the label location is set to 0 <Off> that label will not be displayed when a point is plotted. Only the elevation is allowed to be at the Center position. If you select Center for the elevation label, the whole number portion of the elevation will be on the left side of the insertion point of the symbol and the decimal portion on the right side (example: the elevation 987.23 will be drawn as 987+23, where the plus sign represents the symbol).

If Plot Radial is checked, the point labels will be plotted radially from the symbol’s center. If not selected, point labels will be plotted horizontally.

Label Position for Carlson Symbols

In the Point Symbol Configuration section of the dialog you have the option to plot C&G symbols or Carlson symbols. When the Carlson symbols are used, the Label Position portion of the dialog box changes to display the Carlson method for defining label positions (see below).

These "label positions" are actually pre-defined blocks with a predefined location and orientation for the attributes (or labels). There are ten blocks available. The available blocks are identified by the numbers 0 through 9.

Note: when Carlson point symbols are used, the Sample drawing is only approximate - the actual layout will look slightly different when drawn.

Label Format section
**Label Height:** this is the text size in inches/centimeters when **Units** are set to (Height) x (Scale) or feet/meters when **Units** are **Literal**. The **Label Height** is used for all three labels: point number, point description, and point elevation.

**Number of description characters to show:** Depending on the type of coordinate file being used, here may be as many as 255 characters in the description field. This option allows you to truncate the description at a given number of characters.

**Elevation:** This sets how many characters are displayed before and after the decimal point. On a flat piece of property 2 placed before the decimal may be enough information. On a steep mountain site 3 or 4 decimal places may be needed.

**Topography tab**

**NOTE:** The information on this tab is used for items on the CGTopo menu which has limited functionality and does not allow you to create a TIN. You must use the Carlson features to make, use and manipulate TINs (see Surface menu). These settings *may* be used when opening a CG-SURVEY for DOS drawing (*.PL1) when it has topo data in it.

The items on this tab allow you to specify contouring parameters and Tin, contour and other topographic entity layer specifications.
This dialog allows you to specify the drawing layers for the various topographic entities, as well as set various parameters for the creation of a new surface and placement of contour elevation labels.

Layer Names section

In this part of the dialog you can specify the layers for the various previously existing topographic entities found in the drawing. These allow you to label contours and, if necessary, remove contours and/or labels from the drawing.

**TIN Layer:** Specifies the layer on which triangulation network lines or TIN are found.

**Main Contour Layer:** Layer on which main contours are found.

**Intermediate Contour Layer:** Layer on which intermediate contours are found.

**Main Contour Label Layer** - Elevation labels for the main or index contour lines will be drawn on this layer.

**Intermediate Contour Label Layer** - Elevation labels for the intermediate contour lines will be drawn on this layer.

*Note:* The last two Contour Label Layer names will be used when labeling contours.

TIN and Contour Parameters section

**TIN Interpolation Range:** The interpolation range determines which points will be joined to form the triangles in the TIN. (MAY be used converting a CG-SURVEY for DOS PL1.)

**Contour Interval:** (MAY be used converting a CG-SURVEY for DOS PL1.).

Labeling Parameters section

**Label Interval:** When labeling contours, only the contours falling on this interval will be labeled. For example, if you enter a 10' interval, only the contours at 900, 910, 920, etc will be labeled.
**Label-Contour Separation Distance:** This is the space between each end of the elevation label text and the contour line being labeled. A separation distance that is too small can make the elevation label hard to read, while a separation distance that is too large may not be visually pleasing.

This tab gives you several options for specifying the call or annotation format.

---

### Desired Components section

The of the dialog allows you to specify what you want displayed for a given call and whether the call text is stacked. The text in parentheses indicate the call items for a curve.

### Format and Location section

The allows you to specify whether the call is placed **Parallel to Line**, **Perpendicular to Line** or requires the user to pick the location for horizontal call text (**At Crosshair**). If the **Place Calls to Right of Line** checkbox is checked the calls will be placed on the right side as determined by standing at the first point picked or the first point in a C&G line and looking toward the second point. You may also specify whether to use the foot symbol when units are feet. If bearings are being used, you may specify whether to limit bearing text to **NW, NE only** or **SW, SE only** or **<no preference>**.

### Layer name for call text:

Specify the layer the call text is to be drawn on.

### Automated Placement of Calls on Specified Layers section

This section of the dialog sets the parameters for a feature that allows you to place calls on C&G and/or CAD lines.
and/or polylines found on specified layers. To use this option, check the **Automate Placement of Calls** checkbox. Choose one or more layer names from the list of layer names. You can specify multiple layers by holding the Ctrl key down while picking the layers to search.

In the **Types of Lines to Annotate** section, check the types of entities you wish to annotate.

**Example Call section**

The of the tab allows you to see a good approximation of how the call will look when drawn. **OK** - click the **OK** button to save all the settings and close the dialog.

**Cancel** - click the **Cancel** button to close the dialog and discard any changes.

**Set As Default**
Click this button to save the settings to the CGSURVEY.OPT file. These settings will then be used whenever a new CGSurvey drawing is created. **Note:** You can set the default settings and not affect any of the settings for the current drawing by clicking the **Cancel** button after clicking the **Set As Default** button.

**Pullldown Menu Location:** CG-Survey > Tools  
**Keyboard Command:** cg_options  
**Prerequiste:** None

**Copy Entity to Layer**

This feature allows you to easily copy a single entity or group of entities from one layer to another.

**Choose entities to copy:**  
**Select entities:** use the standard CAD selection methods to choose one or more entities to be copied. Once you have selected the entities press Enter.

Next use the **Layer Name** dialog to choose the layer to copy the entities to:

![Layer Name dialog](image)

**Prompts**

**Choose entities to copy:**  
**Select entities:** use the standard CAD selection methods to choose one or more entities to be copied.

**Pullldown Menu Location:** CG-Survey > Tools  
**Keyboard Command:** cg_copyent
Layer Control
These routines allow you to freeze, thaw, restore, turn on and off, and set the current layer without having to open the CAD layer manager.

Pick Layers to Freeze
This feature allows you to freeze layers by picking entities that are on layers you wish to freeze. You may pick as many entities as you wish.

Prompts

Select object on layer to FREEZE.
Select entities: choose objects on the layers you wish to freeze. Press Enter when done.

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_flfreeze
Prerequisite: None

Pick Layers to Thaw
This feature allows you to thaw frozen layers by picking entities that are on a layer you wish to freeze. All frozen layers are turned on while you pick the entities. You may pick as many entities as you wish.

Prompts

Select object(s) on layers to keep THAWED.
Select entities: choose objects on layers you wish to thaw. Press Enter when done.

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_fthaw
Prerequisite: None

Freeze ALL Layers
Choosing this menu item causes all layers, except the current layer, to be frozen.

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_flfreeze
Prerequisite: None

Thaw ALL Layers
Choosing this menu item causes all layers to be thawed.

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_fthaw
Prerequisite: None
Pick Layers to turn Off

This feature allows you to turn off layers by picking entities that are on layers you wish to turn off. You may pick as many entities as you wish.

Prompts

Select object on layer to turn OFF. choose objects on layers you wish to turn off. Press Enter when done.

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_loff
Prerequisite: None

Pick Layers to turn On

This feature allows you to turn on layers by picking entities that are on layers you wish to turn on. All layers will be turned on during the command to allow you to pick the desired entities. You may pick as many entities as you wish.

Prompts

Select object(s) on layers to keep ON.
Select entities: choose objects on layers you wish to turn on. Press Enter when done.

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_lon
Prerequisite: None

Turn OFF ALL Layers

Choosing this menu item causes all layers, except the current layer, to be turned off.

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_aloff
Prerequisite: None

Turn ON ALL Layers

Choosing this menu item causes all layers to be turned on.

Pulldown Menu Location: CG-Survey > Tools > Layer Control
Keyboard Command: cg_alon
Prerequisite: None

Pick Current Layer

This feature allows you to pick an entity that is on a layer you wish to make the current layer.

Prompts

Set Current Layer - Select entity on the desired layer: pick the entity which is on the layer you want to made the current layer.
Elevations
If this menu item is checked, then point elevations are ON. If it is unchecked then point elevations are OFF.

When point elevations are ON and the **Enter Elev.** radio button is set on the **General** tab of the **C&G Options** dialog, you will be prompted to enter an elevation when new points are saved to the coordinate file. When point elevations are ON and the Calculate Elev. radio button is set you will not be prompted to enter an elevation. When point elevations are OFF, no elevation is stored when coordinate points are saved to the coordinate file.

**Pulldown Menu Location:** CG-Survey > Tools
**Keyboard Command:** cg_lset
**Prerequisite:** None

Descriptions
If this menu item is checked, then point descriptions are ON. If it is unchecked then point descriptions are OFF. Generally, when point descriptions are on, you will be prompted to enter a description when new points are saved to the coordinate file. Also, when descriptions are ON, the description field will be enabled when editing coordinate point values.

**Pulldown Menu Location:** CG-Survey > Tools
**Keyboard Command:** cg_log_desc
**Prerequisite:** None

Point Code
If this menu item is checked, then point codes are ON. If it is unchecked then point codes are OFF. Point codes are unique to C&G coordinate files that can be used to filter or group points in various C&G features.

When point codes are ON, you will be prompted to enter a point code when new points are saved to the coordinate file. When point codes are OFF, no code is stored when coordinate points are saved to the coordinate file.

**Pulldown Menu Location:** CG-Survey > Tools
**Keyboard Command:** cg_log_code
**Prerequisite:** None

Auto Point Number
If the **Auto Point Number** menu item is checked then automatic point numbering is ON. This means that, as points are created they will automatically be assigned the next available point ID in the current coordinate file and will be saved without any user interaction.

When auto point numbering is OFF, as points are created you will be asked to enter the point ID. If you enter a point ID that already exists in the coordinate file, you will be asked if you want to overwrite the existing point or enter a new point ID.

See also: **Automatic Point Numbering ON** checkbox on the **General** tab of the **C&G Options** dialog.

**Pulldown Menu Location:** CG-Survey > Tools
**Keyboard Command:** cg_log_auto_num
**Auto Point Plot**

If the Auto Point Plot menu item is checked, when a point is calculated and stored in the coordinate file it will be plotted in the drawing.

See also: the Auto Point Plot ON checkbox on the Graphics tab of the C&G Options dialog.

**Pulldown Menu Location:** CG-Survey > Tools

**Keyboard Command:** cg_tog_auto_pt_plot

**Prerequisite:** None

---

**Auto Lines**

If the Auto Lines menu item is checked, automatic line plotting is ON. When automatic line plotting is ON, the following COGO features will automatically draw lines and curves using the newly calculated points as they are saved to the coordinate file:

- **Quick Traverse** - but lines will not be drawn to side-shots
- **Curve Between Tangents** and **Tangent Between Curves**
- **Bearing Area Cut-Off**
- **Hinge/Radial Area Cut-Off**
- **Roadway** (Right-of-way and all Cul-de-Sacs and Intersections features)
- **Middle Ordinate Solution** for curves
- **Best Fit**

See also: Auto Line Plot ON checkbox on the Graphics tab of the C&G Options dialog.

**Pulldown Menu Location:** CG-Survey > Tools

**Keyboard Command:** cg_tog_auto_lines

**Prerequisite:** None

---

**CG Snap**

C&G Snaps are object snaps that are active only during a C&G command. These snaps allow you to pick point symbols and/or C&G lines by clicking near them. They work similar to the CAD snaps but only snap to C&G entities. The C&G snaps work in conjunction with the normal CAD snaps but, when a C&G command is run, the CAD snaps are automatically turned off at the start of the command and the C&G snaps become active. In almost all C&G features you have the option of turning the CAD snaps back on if desired. When both the CAD and C&G snaps are on, the CAD snaps are applied first to determine the x and y screen coordinates of the point on the appropriate CAD entity; these coordinates are than passed to C&G and they are used to apply the C&G snaps and find the nearest appropriate C&G entity.

**Note:** If CAD snaps are turned on during a C&G command and if C&G snaps are also on, a double snapping process occurs. Because of this double snapping, it is recommended that when C&G Snaps are on, CAD snaps should be left off during C&G commands.

**Note:** If snapping is desired and C&G snaps are off, then the CAD snaps must be turned on each time a C&G command is run.
**Off**

This turns off all C&G snaps.

Note: This setting applies ONLY to C&G features and is not directly supported by whatever CAD software you are using.

**Points**

This allows you to pick near and snap to a C&G point symbol whenever a point ID is required for a C&G feature.

Note: This setting applies ONLY to C&G features and is not honored by whatever CAD software you are using.

**Lines**

This allows you to pick near and snap to a C&G line whenever a bearing, distance, or pair of points is required for a C&G feature.

Note: This setting applies ONLY to C&G features and is not honored by whatever CAD software you are using.

**Points and Lines**

This allows you to pick near and snap to a C&G point or line whenever a point ID, bearing, distance, or pair of points is required for a C&G feature.

Note: This setting applies ONLY to C&G features and is not directly supported by whatever CAD software you are using.

**Zoom to Point ID**

This feature pans the drawing in order to place the location of the point ID you specify at the center of the screen. It is not necessary to plot the point symbol prior to using this feature.
Prompts

Point ID of point to zoom to: specify the point ID of a point in the current coordinate file.

The drawing will be panned to center the point and a "rubber band" line will extend from the point to your cursor.

Stopping to view point [View another/Done] <D>: Press "D" and Enter or just Enter to clear the rubber band line and return to the CAD command line. Press "V" and enter to specify another point ID.

Pulldown Menu Location: CG-Survey > Tools
Keyboard Command: cg_zoom_pt
Prerequiste: coordinate file

Windows Calculator

Selecting this menu item will bring up the standard Microsoft Windows ® calculator.

Pulldown Menu Location: CG-Survey > Tools
Keyboard Command: cg_cal
Prerequiste: None

CGEditor

The CGEditor is an integral part of preparing files for use for C&G applications. The CGEditor is a very powerful tool. You can open multiple data files of any supported file type and edit the files as needed. The CGEditor has a full complement of tools for searching and replacing and navigating within a file. It will also allow you to cut or copy records from one file and paste them into another file in order to merge files, move data between phases of a job, etc.

Types of data files supported

The CGEditor can create and/or edit four types of data files used by CGSurvey and Carlson.

Raw Data Files

Raw data files contain information pertaining to a field traverse. Raw data files are typically downloaded from the data collector and converted to the C&G raw data file format. These files have the extension .cgr.

Map Check Files

Map Check files contain bearing, distance and curve information and are typically used to calculate the closure of a deed description. These files have the extension .cgm.

Cross Section Files

Cross Section files contain one or more cross sections identified by their station along the alignment. Each cross section record has the percent grade defined for its left and right slopes. Following the "Station" record are several "Point" records containing the elevations and offsets of the points along the cross section. Cross section files consist
of a pair of files; the main data file has the extension .cew and the index file has the extension .cex.

Template Files

Template files are merely cross section files that represent a standard cross section and can be used to generate other cross section files. However, unlike cross section files, template files use an integer ID instead of a station to uniquely identify each template. Like cross section files, the percent grade is defined for the left and right slopes of each template and there are a set of "Point" records specifying the template elevation at a given offset. The centerline elevation at offset 0.00 is typically set to 0.00. Template files consist of a pair of files; the main data file has the extension .ctp and the index file has the extension .ctx.

NOTE: The CGEditor program sold as part of the standalone version of SurvNET can only be used to edit raw data files. The CGEditor can be used to create new files or edit existing files. It uses a multi-document interface, so you can edit or view several files of several different types at the same time. The following sections will describe how to open and edit files.

Opening Existing Files

To open an existing file, click on the File menu then choose Open in the submenu. You can then use the Open file dialog box to browse to the desired file. Check to make sure the Files of Type: is set correctly. Click on the desired file to highlight it, then click the Open button.

Creating Files

To create a new file, use the File menu and choose New and then click on the type of file you wish to create:
C&G Raw File  
C&G Mapcheck File  
C&G Cross Section File  
C&G Template File  
Coordinate File  
Point Group File

After clicking the menu item for the type of new file you wish to create, a temporary file is created with no data in it and a spreadsheet-like window will open. At this point more menus items will be added to the main menu and, as you will see, the Add menu item will allow you to insert data rows (or records) where you can enter your data.

**NOTE:** The CGEditor program sold as part of the standalone version of SurvNET can only be used to edit raw data files.

**The CGEditor Menus**

**File Menu**

Many of the following File menu items will be familiar to experienced Windows users:  
**New:** Allows you to create a new file.  
**Open (Ctrl + O):** Brings up the Open File dialog box so you can select and edit an existing file.  
**Close (Ctrl + E):** Closes the current data file. If more than one file is open, the file that is currently being worked on will be closed.  
**Save (Ctrl + S):** Saves the current file.
Save As: Allows the user to save the current file to a file having a different name.
Print (Ctrl + P): Allows the user to print a copy of the currently active file.
Print Preview (Ctrl + W): Display a preview of the file about to be printed.
Print Setup (Ctrl + u): Printer selection as well as page size and layout.
Exit (Ctrl + Q): Exit the CGEditor application.

Edit Menu

As with the File menu, the Edit menu is typical of most Windows programs.
Most of the items in the Edit menu require that either a field within a record, or the entire record itself, be selected (highlighted) before clicking the menu item. To select a an individual data item (or field) in a data record simply click the field. To select a record (row) simply click in the first field (Type or Row#) for the desired record.
Undo (Ctrl + Z): Undoes the most recent editing action. (you need not have anything highlighted for this item)
Redo (Ctrl + Y): Reverses the most recent undo action. (you need not have anything highlighted for this item)
Cut (Ctrl + X): Cuts the currently highlighted cell or record. You may then use the paste command to put the cut cell or record in another location.
Copy (Ctrl + C): Copies the currently highlighted cell or record. You may then use the paste command to put the copied cell or record in another location.
Paste (Ctrl + V): Allows you to paste any previously cut or copied cell or record to the currently highlighted location.
If entire records are being pasted and only a field is currently highlighted, the pasted records will be inserted above the current record. However, if one or more entire records are currently highlighted, the pasted records will replace the highlighted records.
Delete (<Delete> key): Deletes the currently highlighted field or record.
Select All (Ctrl + A): Selects all the records in the current data file.
Clear (Ctrl + L): Removes the data from the selected field or record.

Add Menu

The Add menu allows you to add a record to the current file. The Add menu item appends the record to the end of the file. The types of records that can be added will depend on the type of file being edited, these record types will be described in more detail in later sections for each type of file you can edit.

Insert Menu

The Insert menu allows you to insert a record above the current record.
The types of records that can be inserted will depend on the type of file being edited, these record types will be described in more detail in later sections for each type of file you can edit.

View Menu
The View menu allows you to turn tool bars on or off. The items listed in the View menu will differ for different types of files. The individual tool bars will be discussed in the sections pertaining to the various types of files that can be edited.

### Standard Tool Bar

The above figure shows the standard tool bar. The Standard toolbar is the same for all types of files. It allows you to create all the various files that can be edited by the CGEditor. It allows you to open and save files. It allows you to cut, copy and paste and undo and redo as well as print the current file.

### Settings

The Settings Menu will differ depending on the type of file being edited. But generally contains the settings for the file and the record colors.

### Tools

The Tools Menu contains a variety of spread sheet tools, such as find, find next, find and replace etc. The menu will vary slightly for each type of data file and will be discussed in the sections pertaining to the various file types.
Windows

This menu contains many of the standard Window menu items found in other programs. It allows you to arrange the currently open windows in several configurations. It has the added functionality of the New Window command which allows you to have two or more views of a single file.

 Traverse types

The raw data file can contain data pertaining to one or more traverses. If you will be using SurvNET to process the data, there is no need to delineate separate traverses in the raw data file. However, if you are using the old C&G traverse reduction program, and you want to combine more than one traverse in a raw data file, you will need to use the special traverse code records at the beginning and end of each traverse.

There are three basic types of traverses:

Closed Loop Traverse
Closed Traverse Beginning and Ending at Known Points
Open Traverse and Side Shots

Figures 1, 2, 3 and 4 show illustrations of each of these traverse types. Below each illustration you will also see the accompanying raw data as seen in the CGEditor.

Closed Loop

A closed loop begins and ends on the same two points as shown below in Figure 1

Figure 1
Closed Loop beginning and ending on known points

Figure 2 shows a closed traverse beginning on two known points (1 and 2) and ending on two known points (4 and 5). With this type of traverse, both a linear and angular closure can be calculated.

![Diagram of closed loop traverse]

**CLOSED LOOP TRAVERSE BEGINNING AND ENDING AT KNOWN POINTS**

Figure 2

Loop beginning on two known points and closing on an azimuth

Figure 3 illustrates a traverse that begins on two known points, or a single known point and a back sight azimuth, and ends on one known point. In this case it is only possible to calculate a linear closure.
Figure 3

<table>
<thead>
<tr>
<th>DR</th>
<th>From Point</th>
<th>To Point</th>
<th>Bearing</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP</td>
<td>2</td>
<td>100</td>
<td>125.72(\degree)</td>
</tr>
<tr>
<td>IP</td>
<td>2</td>
<td>450000</td>
<td>100</td>
</tr>
<tr>
<td>FS</td>
<td>7</td>
<td>523000</td>
<td>2</td>
</tr>
<tr>
<td>IP</td>
<td>7</td>
<td>523000</td>
<td>2</td>
</tr>
<tr>
<td>FS</td>
<td>8</td>
<td>514000</td>
<td>7</td>
</tr>
<tr>
<td>IP</td>
<td>8</td>
<td>514000</td>
<td>7</td>
</tr>
<tr>
<td>FS</td>
<td>4</td>
<td>530000</td>
<td>8</td>
</tr>
<tr>
<td>FS</td>
<td>4</td>
<td>530000</td>
<td>8</td>
</tr>
</tbody>
</table>

Open Traverse

Figure 4 shows an open traverse (side shots).
Note: The data shown in the CGEditor views accompanying the four illustrations include instrument height (HI) and rod height entries. However, if you have elevations turned off, these entries are optional. Also, the examples use single distance and angle entries but multiple measurements are allowed.

In these figures each traverse has been placed in a separate raw data file. However, with the use of special codes you can combine multiple traverses in a single raw data file.

Entering and Editing Traverse Data

In the CGEditor "Raw Data" refers to unadjusted field traverse data, typically downloaded to the PC from a data collector. C&G raw data files have the extension .CGR.

Creating or Opening a Raw Data File

To create a new file or open an existing file click on the File menu then either click on New or Open. If you click on New, another submenu will appear, pick C&G Raw Data File. In either case you will then see a file dialog. Browse to the directory where you wish to work and, if creating a new file, type in a file name, or, if opening an existing file, click on a raw data file (*.cgr). Next, click the Save button for a new file or the Open button for an existing file.

If you are creating a new file, an empty file will be shown in its own document window within the editor. If you are editing an existing file, the data from the file will appear in a similar document window. It is possible to have multiple documents open at the same time. So you could create a new file and open an existing file in the same editing session and each would appear in its own window in the editor. You can have as many new and/or existing
files open as your project demands.

**Settings**

Before entering any data you should check the current settings. Click the Settings menu item then click Raw Data File to review and/or change the current settings. (See Settings Menu section later in this section.)

**Traverse Data Entry**

A line or row in the raw data file is referred to as a record and each item of data in a record is referred to as a field. There are several types of records that you may use in a raw data file:

- **Instrument Point**
- **Foresight**
- **Foresight Tie**
- **Reference Bearing**
- **Coordinate Value**
- **Standard Errors**
- **Control**
- **Measurement**
- **Setup**
- **Elevation**
- **Scale**
- **Loop Traverse**
- **Closed Traverse**
- **Open Traverse**
- **End Traverse**
- **Data on/off**
- **Comment**

The type of data required for each of these types of records varies. Some require no data entry and are only "flags" to signify the beginning or ending of a series of records, others require only one field to be filled out, while others require several fields of data.

**Adding and Inserting new records**

When creating a new file, to begin entering data you must select from the **Add** or **Insert** menus to create the first blank record and begin data entry. Depending on what type of record you are editing, when you press <Enter> for the last field in the record, the following record will be added automatically.

**Note:** If the **Add** and/or **Insert** toolbars are not showing, click on the View menu then click on the toolbar you want to turn on.

When you click on one of the **Add** menu items or toolbar icons, an empty record is added to the end of the file. If you click on one of the **Insert** menu items or toolbar icons, an empty record is inserted above the currently active record or field. To make a record the currently active record, just click on one of its fields.

**Moving from field to field:**

While entering data, to move to the next field, press the Enter or the Tab key. To move to the preceding field press the Esc key or both the Shift and Tab keys at the same time.
Insert and Add menus

<table>
<thead>
<tr>
<th>Insert</th>
<th>Ctrl+Alt+P</th>
<th>Ctrl+Alt+R</th>
<th>Ctrl+Alt+G</th>
<th>Ctrl+Alt+B</th>
<th>Ctrl+Alt+U</th>
<th>Ctrl+Alt+F</th>
<th>Ctrl+Alt+S</th>
<th>Ctrl+Alt+I</th>
<th>Ctrl+Alt+C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Instrument Point</td>
<td>Ctrl+Alt+P</td>
<td>Ctrl+Alt+R</td>
<td>Ctrl+Alt+G</td>
<td>Ctrl+Alt+B</td>
<td>Ctrl+Alt+U</td>
<td>Ctrl+Alt+F</td>
<td>Ctrl+Alt+S</td>
<td>Ctrl+Alt+I</td>
<td>Ctrl+Alt+C</td>
</tr>
<tr>
<td>Foresight</td>
<td>Ctrl+Alt+R</td>
<td>Ctrl+Alt+G</td>
<td></td>
<td>Ctrl+Alt+B</td>
<td>Ctrl+Alt+U</td>
<td>Ctrl+Alt+F</td>
<td>Ctrl+Alt+S</td>
<td>Ctrl+Alt+I</td>
<td>Ctrl+Alt+C</td>
</tr>
<tr>
<td>Foresight Tie</td>
<td>Ctrl+Alt+G</td>
<td></td>
<td></td>
<td>Ctrl+Alt+B</td>
<td>Ctrl+Alt+U</td>
<td>Ctrl+Alt+F</td>
<td>Ctrl+Alt+S</td>
<td>Ctrl+Alt+I</td>
<td>Ctrl+Alt+C</td>
</tr>
<tr>
<td>Reference Bearing</td>
<td>Ctrl+Alt+B</td>
<td>Ctrl+Alt+U</td>
<td>Ctrl+Alt+F</td>
<td>Ctrl+Alt+S</td>
<td>Ctrl+Alt+I</td>
<td>Ctrl+Alt+C</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Coordinate Value</td>
<td>Ctrl+Alt+U</td>
<td>Ctrl+Alt+F</td>
<td>Ctrl+Alt+S</td>
<td>Ctrl+Alt+I</td>
<td>Ctrl+Alt+C</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Coords From File</td>
<td>Ctrl+Alt+F</td>
<td>Ctrl+Alt+S</td>
<td>Ctrl+Alt+I</td>
<td>Ctrl+Alt+C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Standard Error</td>
<td>Ctrl+Alt+S</td>
<td>Ctrl+Alt+I</td>
<td>Ctrl+Alt+C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Elevation</td>
<td>Ctrl+Alt+I</td>
<td>Ctrl+Alt+C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scale</td>
<td>Ctrl+Alt+C</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Loop Traverse</td>
<td>Ctrl+Alt+L</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Closed Traverse</td>
<td>Ctrl+Alt+D</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open Traverse</td>
<td>Ctrl+Alt+O</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>End of Traverse</td>
<td>Ctrl+Alt+N</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Data On/Off</td>
<td>Ctrl+Alt+X</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comment</td>
<td>Ctrl+Alt+M</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Instrument Point records

The first record of a raw data file is often an instrument point. Add or insert a blank record using the menus or toolbars. Fill in the following fields in the new instrument point record:

**Inst. Point:**
Enter the point ID of the instrument point.

**Inst. Height (or HI):**
Enter the instrument height. This may be either the distance from the IP on the ground ("Plus-up") or the actual elevation of the instrument, depending on how the data is to be reduced. This field will only be active if elevations are on. (See the Settings section in the Entering and Editing Traverse Data section of this chapter). If elevations are ON and you leave this field BLANK (zero is a valid height), all measurements taken a this setup will be considered 2D and no elevations will be calculated.

**Backsight:**
Enter the point ID for the backsight.

**Rod Height:**
Enter the rod height. This field will only be active if elevations are on. (See the Settings section in the Entering and Editing Traverse Data section of this chapter).

**Horz. Angle:**
Enter the instrument's initial horizontal angle reading at the backsight. When doing an azimuth traverse, no entry is required here.

**Note:** on doubled angles: Doubled angles require 2 Instrument Point records. Each new instrument setup requires a 0 to the back sight. The first angle to the foresight is the single angle. This angle is locked into the gun and the back sight is retaken. The second angle to the foresight is the doubled angle. You may also double angles to side shots.

**Slope Distance and Vertical Angle or Horizontal Distance and Vertical Distance to the Back sight:**
Enter the appropriate distance and/or angle. A blank is assumed to be a zero.
Note: When the Slope Dist/Vert Angle or Horz. Dist/Vert. Dist. column headings are preceded by a “^”, it indicates that a record inserted before the current record (or added after the current record) will have the same type of distance entry mode. For example, if the heading shows Dist and Angle and you insert a record, the new record will be in the Slope Dist/Vert Angle distance entry mode. You can change this by clicking on one of the distance headings to remove or add the “^”. If the “^” is not present it means that the inserted or added record will have the opposite distance entry mode than does the current record.

If, after entering the data in the last field of a given Instrument Point record, you press the Enter or Tab key, a Foresight record will automatically be created. If you want to change this newly created blank Foresight record into an Instrument Point record, press the Esc key. If you are at the end of the file, pressing Esc again to delete last blank record.

**Foresight Point records**

After entering the data for the last field in the Instrument Point record, press Enter. This will cause a Foresight record to be created below it. This record will contain the following columns (the explanations of several of these columns are as described for Instrument Points, only the differences will be noted here):

**Rod Height:**
This column is only active if elevations are on. If elevations are ON and this field is left BLANK, the point will be considered 2D and an elevation will not be calculated. **Horz. Angle:**
Enter the instrument’s horizontal angle reading at the foresight point. Enter a positive value for a clockwise angle and a negative value for a counter-clockwise angle. This entry may be blank if you are entering only the distance readings to the foresight.

**Slope Dist./Vert Angle or Horz. Dist/Vert. Dist.:**
Enter the distance data for the foresight point.

**Foresight:**
Enter the Point ID for the foresight point.

**Code:**
Enter the code for the Foresight Point. This column is only active if Code is on. (See Settings in this section.)

**Description:**
Enter the description for the Foresight Point. The number of characters you are allowed to enter is set in the Settings under Description Length. If you enter an integer code here and the Translate Raw Descriptions Using Description Table is checked in the Settings and a matching description number is found in the description table, then the description from the table will replace the integer value you entered in the Description field. The integer value you entered will then be moved to the Code field.

Note: Side shots should be placed within the block of foresights immediately following the instrument point record for the instrument point from which they were shot. You may append side shots to the end of a traverse file, but they must be preceded by a begin open traverse record.

**Foresight Tie records**

In some cases, you will need to tie to an existing traverse. You use a Foresight Tie record to do this. This record is used in the reduction process to determine what known point you are tying into. It is necessary if there are side shots taken at the last setup along with the tie point.

In a closed traverse, you must end a traverse by occupying a known point and turning an angle to a second known point. The second known point is the tie point.

**Reference Bearing**

**From Point**
Enter the point ID of the from point.

**To Point**
Enter the point ID of the to point

**Bearing (Azimuth)**

Bearings must be entered in the form Qdd.mmss where Q is the quadrant (1 = NE, 2 = SE, etc), d is whole degrees, m is minutes, and s is seconds (you can specify seconds to the nearest .1 seconds but when you do not wish to specify tenths of a second, a trailing 0 is not required)
Azimuth is entered as ddd.mm.sss (when the leading d or the trailing s is zero, it is not required)

**Coordinate Value record**

You can use either the Add or Insert menus or toolbars to create a new coordinate record. You can then hand enter known coordinates for a point. Coordinates can be used as a reference point during the reduction process.

**Entering CoordinateValue records from a Coordinate File**

Instead of hand entering coordinate points, you can insert coordinate records from an existing coordinate file. Click the Insert menu, then pick the Coords From File menu item.

![](image)

**Elevation**

You can specify the elevation for a given point ID using an Elevation record.

**Scale**

You may specify a scale factor in a Scale record. A scale factor is a decimal number. You may enter as many scale factors as you wish. A scale factor will be used until another is encountered. Scale factors should be placed before an Instrument Point record.

**Note:** Multiple Traverses: If you are combining more than one traverse in a single raw data file, you must separate the traverses with special records. After inserting or adding a begin traverse record, you may type in a comment regarding the traverse in the Comment column. You may also specify the order in which the traverses are to be processed by using the first part of the Comment field. Please see Traverse reduction order below for more details.
Note: If you are processing the data with SurvNET, the Scale records are ignored. SurvNET calculates scale factors automatically when working on State Plane coordinates.

**Beginning and/or ending a Traverse**

Note: If you are processing the data with SurvNET, Traverse Records (LT, OT, CT, ET) are ignored. Since SurvNET adjusts all data simultaneously, it requires no traverse definitions.

Use **Loop Traverse**, **Open Traverse** and **Closed Traverse** records to delineate multiple traverses within a single file.

**Traverse reduction order**

The order in which the traverses appear in the raw data file is typically not important. Traverses are processed in the order in which they appear in the file. Traverses may be entered in a sequential order or you may embed one traverse within another. However, *if the coordinates computed from one traverse are needed for the reduction of another traverse, then traverse order IS important.* If this condition is true for a raw data file and the traverses have NOT been placed in the raw data file in the correct order, then you need to specify a **Traverse Order Number** for each traverse in the file.

Note: If you specify Traverse Order Numbers, the traverses in the file will be reduced in the order of their Traverse Order Numbers.

**Traverse Order Numbers**

Each **Loop Traverse**, **Open Traverse** or **Closed Traverse** comment field can contain a Traverse Order Number.

Note: The Traverse Order Number must be an integer and must appear as the first entry in the Comment field separated from the remainder of the comment by a space.

For example, the comment field of a **Loop Traverse** record having a **Traverse Order Number** of 3 should look like this:

3 this is a comment

*If any one Begin Traverse record has a Traverse Order Number, then all Begin Traverse records MUST have a Traverse Order Number. Also, the Traverse Order Numbers in a given file must begin with 1 and continue sequentially. You may not duplicate a Traverse Order Number for any Begin Traverse record in a given file.*

**IMPORTANT NOTE:** Reducing a raw data file having **Traverse Order Numbers** that violate any of the above specifications will have unpredictable results. Error messages during the reduction process may not reflect the fact that improper traverse order numbering is actually the root cause of the problem.

**Loop Traverse**

This record indicates the beginning of a loop traverse. A loop traverse begins and ends at the same point. If you wish to add a comment to identify the traverse in some way, just type it in the Comment column.

**Closed Traverse**

This record indicates the beginning of a closed traverse. A closed traverse ties into known points at both ends. If
you wish to add a comment to identify the traverse in some way, just type it in the Comment column.

**Note:** If you are running a Closed Traverse and tying into a single point, a reference azimuth must be placed at the last instrument point if you wish to adjust the angular error.

**Open Traverse**

This record indicates the beginning of an open traverse. An open traverse is a group of side shots. If you wish to add a comment to identify the traverse in some way, use the **Comment** column.

**End Traverse**

Signals the end of the data records for any of the traverse types.

**Comment**

Inserts a comment line above the current active line. Comment lines are ignored during processing.

**Data On/Off**

**Data On/Off** records surround a series of records that are to be ignored during processing by C&G or SurvNET. The first **Data On/Off** record encountered causes processing to skip to the next **Data On/Off** record. Processing continues beginning at the record after the second **Data On/Off** record. This can be used when trying to isolate errors in a traverse.

**The Add and Insert Tool bars**

<table>
<thead>
<tr>
<th>IP</th>
<th>FS</th>
<th>FT</th>
<th>DR</th>
<th>S</th>
<th>E</th>
<th>LT</th>
<th>CT</th>
<th>ET</th>
<th>SE</th>
<th>Co</th>
<th>DO</th>
</tr>
</thead>
</table>

**ADD Tool Bar:** add the various types of traverse records to the end of the current file.

**Insert Tool Bar:** insert one of the various types of traverse records above the current record.

Notice that the only difference between the appearance of the Add Toolbar and the Insert Toolbar above is the check mark in the lower right hand corner of each icon of the Insert Toolbar.

**Toolbar Icon Explanation**

- **IP Add/Insert an Instrument Point record**
- **FS Add/Insert a Foresight record**
- **FT Add/Insert a Foresight Tie record**
- **DR Add/Insert a Reference Bearing record**
- **S Add/Insert a Scale record**
- **C Add/Insert a known Coordinate point record**
- **E Add/Insert an Elevation benchmark record**
- **LT Add/Insert a Loop Traverse record**
- **OT Add/Insert a nOpen Traverse record**
- **CT Add/Insert a Closed Traverse record**
- **ET Add/Insert an End Traverse record**
- **SE Add/Insert a Standard Error record for Network Least Squares Adjustment (SurvNET) program**
- **Co Add/Insert a Comment record**
The Least Squares Toolbar

The "network" icon:
Selecting this icon will start the SurvNET Network Least Squares program. If SurvNET has already been started, clicking this icon will bring it to the front so you can work with it. (See the Tools menu section and the SurvNET section for additional info.)

The "eyeball" icon:
This icon brings up a separate window displaying a scaled map of the current raw data file. (See Graphic View under the View menu section)

The "C" icon:
Clicking this icon hides all Comment records. The Comment records still remain in the raw file, they are just not shown on the screen. You will find that there are some actions you cannot perform when Comments are off.

The "No DO" icon:
Clicking this icon removes all the Data On/Off records from the raw data file.

Status bar

When this menu item is checked, the status bar will display. The status bar is along the bottom border of the CGEditor window. On the left side of the status bar a brief help message is displayed when you hold the cursor over such things as menu items or toolbar icons. It also has indicators that tell you if Caps Lock or Num Lock are turned on and displays the Row/record number that is currently active.

Graphic View

Clicking on this menu item brings up a window containing a graphic representation of the traverse. The traverse lines and points are drawn to scale using the data from the current raw data file.
The Graphic View Window

The Graphic View window shows a scaled drawing of the current raw file traverse lines and points. The toolbar icons at the top of the window can be used to move around in the view and change its appearance. The icons will be discussed as they appear from left to right:

**Pan:** This works very much like the CAD Pan command. When you click the hand icon the cursor changes to a hand. When you click on the graphic screen the first time you are "grabbing" the graphic. You can then move it to the proper view and click a second time to "put it down". You may repeat this as many times as you wish in order to move around the drawing. When done with the Pan command, click on the Pick Point icon.

**Zoom In:** Clicking on this icon causes the graphic image to be enlarged a preset amount. The zoom factor cannot be configured. If you wish to see a certain area of the graphic image it is recommended that you click Zoom Extents then use Zoom Window to view the desired area.

**Zoom Out:** As with Zoom In, Zoom Out reduces the image size a preset amount. The zoom factor is not configurable.

**Zoom Extents:** Zooms the image so all points and lines can be seen on the screen.

**Zoom Window:** Allows you to click on two diagonal corners of the rectangular area that you wish to see.

**Pick Point:** Use this icon to allow you to pick a point on the graphics screen in order to "zoom" to the first instance of the associated point ID found in the raw data editor window. This allows you to rapidly and conveniently locate a given point ID in the data file. This is especially useful in trouble shooting for errors or other problems in the data that may be more easily detected in the graphic image than when viewing the raw data. When you pick near a plotted point on the graphics screen its point ID is noted. The raw data file is then searched for that point ID. The active field in the editor window is then set to the first instance of that point ID. You can pick the same location several times to move to the next instance of the point ID in the file. If you have a large Pick Radius set (See Graphic Settings) or are zoomed out, picking a point may result in more than one point being found. If this occurs, a dialog box listing the nearby points will pop up. Using the list box in the dialog choose the desired point ID and press <Enter> or click OK to find the point in the data file.

Clicking this icon also allows you to turn off the Pan feature when you are done panning.

Brings up the **Graphic Settings** dialog:
The graphic settings dialog allows you to configure the appearance of the various items that may be seen on the graphics screen.

**Note:** The Graphic Settings dialog is also used for the SurvNET program and thus the items on the Error Ellipses and GPS tabs have no effect on the CGEditor Graphic View.

**Points and Trav/SSs tabs**

**Control Points, Fixed Control Points and Floating Points and Traverse, Sideshots and Azimuths:**
Specify whether the symbols, labels or lines for any of these should be shown. Also, if they are to be shown, specify symbol and/or line color, symbol type and point ID label size.

**Symbol:**
Choose to represent the various types of points as a Square, Triangle or Circle using the drop down list.

**Color:**
For symbol or line color you can choose Red, Green, Blue, Cyan, Magenta or Yellow from the drop down list.

**Size:**
Specify the point symbol size.

**Pt. Num. Text:**
Check the check box if you want the points labeled.

**Size:**
If the points are to be labeled, specify the label height.

**Pick Radius**
When you pick near a point plotted on the graphics screen, the current field in the editor window moves to the first instance of that point in the current raw data file. Setting the pick radius allows you to specify how large an area around the pick point is to be searched for raw data points drawn in the Graphics View window.

**Error Ellipses tab (Has no effect in CGEditor)**

**GPS tab (Has no effect in CGEditor)**

**Refresh Graphics:** Allows you to refresh the graphics to view recent changes in the raw data due to editing.

**Important Note:** For the Refresh Graphics to reflect recent changes in the raw data file, you must save the file itself prior to refreshing the graphics.
Settings Menu

The items in the settings menu can be used to configure how the data in the raw data file will be interpreted and the appearance of that data as seen in the CGEditor.

Raw Data File Settings dialog

When you click on the Raw Data File menu item you will see a dialog box that allows you to specify many of the more important settings related to the currently open raw data files. You can also set up the defaults that will be used for newly created raw data files.

Note: See the More on Default Settings subsection at the end of the Settings Menu section.

The Raw Data File Settings dialog

Current File

To view and/or edit the settings for a given file, pick the file using the Current File list box. You can also view and/or edit the DEFAULT settings for newly created files.

File Information
This portion of the dialog allows the user to specify job or project specific information. Except for description length, these items are for your own information and do not affect processing of the raw data.

**Job:** Enter any name you wish to identify the job or project.

**Operator:** Enter the name of the person who led the field work.

**Client:** The name of the person or company for whom this work was done.

**Date:** Date in any format you wish to use.

**Temperature:** Temperature at the time the field work was done. For your reference only. May be Celsius or Fahrenheit.

**Pressure:** Atmospheric pressure at the time the field work was done. For your reference only. May be in any units.

**Book:** Field book number for the field work.

**Page:** Page number in the field book.

**Description Length:** Specify the length of the description field used in this file.

---

**Set Defaults:**
This button sets the items in the **File Information** portion of the dialog as the current default values. When a new raw data file is created, these default settings will be used. See the More on Default Settings heading at the end of the Settings section.

**Restore Values:**
This button allows you to set the values in the File Information portion of the dialog back to what they were when you opened the Raw Data File Settings dialog.

**Save As Default:**
Sets the default values for the **File Information** portion of the dialog. These values are used as the default settings when a new file is created. See the More on Default Settings heading at the end of the Settings section.

---

**File Measurement Info**

**Angular Units:** Clicking the button to the right changes the angular units from **Degrees** to **Grads** or vice versa.

**Distance Units:** Clicking the button to the right changes the distance units from **Foot** to **Meter** or vice versa.

**Foot Definition:** Clicking the button to the right changes the foot definition from **US** feet to **International** feet or vice versa. This button is only active when Distance Units are set to **Foot**.

**Traverse Angles:** Choose one of the items in the list to specify how the traverse angles were measured:
1. Horiz. Angles
2. Azimuths
3. Deflection Angles

**Direction:**
Specify what type of angle is used to define the direction of a line. Clicking the button to the right changes the direction from **Bearing** to **Azimuth** or vice versa.

**Azimuth Direction:**
Specify the reference direction for azimuths. Clicking the button to the right changes the azimuth direction from **North** to **South** or vice versa. This button is only active when Direction is set to **Azimuth**.

**Coordinate Order:**
Clicking the button to the right changes the Coordinate Order from North-East to East-North or vice versa.

**Vertical Reference:** Pick one of the items from the list to the right to specify the reference orientation for measuring vertical angles:
1. Zenith
2. Nadir
3. Horizontal

**Set Defaults:**
This button sets the items in the **File Measurement Info** portion of the dialog to the current default values. See the More on Default Settings heading at the end of the Settings section.
**Restore Values:**
This button allows you to set the values in the **File Measurement Info** portion of the dialog back to what they were when you opened the **Raw Data File Settings** dialog.

**Save As Default:**
Sets the default values for the **File Measurement Info** portion of the dialog. These values are used as the default settings when a new file is created. See the **More on Default Settings** heading at the end of the Settings section.

**Edit Options**

**Elevation Off:**
Check this check box to turn off the Elevation data entry column for this file. This makes data input more convenient since you do not have to enter any data in the Elevation column, nor do you have to tab through it. Turning off elevations does not cause any data to be deleted from the current file.

**Code Off:**
Check this check box to turn off the Code data entry column for this file. This makes data input more convenient since you will not have to enter any data in the Code column. Turning off codes does not cause any data to be deleted from the current file.

**Description Off:**
Check this check box to turn off the Description data entry column for this file. This makes data input more convenient since you will not have to enter any data in the Description column. Turning off descriptions does not cause any data to be deleted from the current file.

**Note:** You can turn the Elevation, Code and Description data entry columns on or off while editing a file by clicking on the column heading.

**Distance Component:**
Specify how distances are to be entered. Clicking the button to the right changes the Distance Component from Slope Dist-Vert Angle to Horiz. Dist-Vert. Dist. or vice versa.

**Translate Raw Descriptions Using Description Table:**
This check box is only active if descriptions are on. If you check this check box, integer codes entered in the Description field will be looked up in the specified description table (See the following item.). If a matching description number is found in the description table, the code will be moved to the Code field and the description found in the description table will be placed in the Description field. If no matching description number is found, the Description field remains as entered.

**Desc Tbl:**
Click on the Desc Tbl button use a file dialog to set or change the description table. The description table is used to set the Description field when an integer number is entered in the Description field. (See the previous item.) If you prefer, instead of clicking on the Desc Tbl button you can also type in the full file path in the edit box.

**Set Defaults:**
This button sets the items in the Edit Options portion of the dialog to the current default values. See the More on Default Settings heading at the end of the Settings section.

**Restore Values:**
This button allows you to set the values in the Edit Options portion of the dialog back to what they were when you opened the Raw Data File Settings dialog.

**Save As Default:**
Sets the default values for the Edit Options portion of the dialog. These values are used as the default settings when a new file is created. See the More on Default Settings heading at the end of the Settings section.
Other Edit Options dialog

Click the Other Options button to bring up the Other Edit Options Dialog box.

![Other Edit Options dialog](image)

Current File:
Click on the name of the file in the file list for which you wish to review and/or specify the settings. You can also choose to view or edit the DEFAULT settings.

Default values for new record:
Checking the check box for the following items causes CGEditor to "remember" the most recently entered value in the respective field. Thus when you insert or add a record containing one of the checked items, it will be filled in with a "default" value.

- Backsight ID
- Horz. Angle
- Vert. Angle
- Foresight ID
- Rod Height
- Code
- Description

Note: The previously used field values are not "remembered" and thus will not be used to fill in new records the next time you open the CGEditor.

Set Defaults:
This button sets the items in the Other Edit Options dialog to the current default values. See More on Default Settings at the end of the Settings section.

Restore Values:
This button allows you to set the values in the Other Edit Options dialog back to what they were when you opened the Raw Data File Settings dialog.

Save As Default:
Sets the default values for the items found in the Other Edit Options dialog. These values are used as the default settings when a new file is created. See More on Default Settings at the end of the Settings section.

Click OK to close the Other Edit Options dialog.

Click OK to close the Raw Data File Settings dialog.
More on Default Settings:

When the CGEditor is started from CGSurvey, many of the initial default settings may not be those you had specified in a previous session. This is because many of the default settings you previously specified where overridden by the current CG Settings specified in CGSurvey. However, you may yourself override the default settings for the current session only by changing any of the settings and clicking the Save As Default button. If you wish to change the "default" settings for future editing sessions, you must change the CG Settings in CGSurvey.

Settings overridden by the settings on the various tabs in the CAD C&G Options dialog:

**File Information:** only Description Length is overridden by the settings in the CAD C&G Options dialog.

**File Measurement Info:** ALL items are overridden by the settings in the CAD C&G Options dialog.

**Edit Options:** ALL items are overridden by the settings in the CAD C&G Options dialog.

**Other Edit Options:** NONE are overridden by the settings in the CAD C&G Options dialog.

Record Color

To set the color for a given record type click the Record Color menu item. Then, in the Record Color dialog, click on the record type and a color selection dialog will appear. Click on the color you want the that record type to have. If you click the Set Defaults button, the original program default colors are set. Click the OK button to save the color settings and close the dialog. Click the Cancel button to close the dialog without saving the changes.
Validate Records

If this menu item is checked, all the records in the file will be validated prior to saving the file. To change the Validate Record setting, just click the menu item. If an invalid record is encountered when saving a file with the Validate Records menu item checked, you are asked if you want to edit the invalid field, ignore the error or ignore all errors. If you decide to edit the offending field, the field will be highlighted and you can edit it and attempt to save again.

The Tools menu has several items that can be used to find and replace specific text in specific types of fields. It even allows you to apply simple mathematical functions to allow you to edit the data in a group of fields in a single step.

<table>
<thead>
<tr>
<th>Tools</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to</td>
<td>Ctrl+T</td>
<td></td>
</tr>
<tr>
<td>Find</td>
<td>Ctrl+F</td>
<td></td>
</tr>
<tr>
<td>Find next</td>
<td>F3</td>
<td></td>
</tr>
<tr>
<td>Find prev</td>
<td>Shift+F3</td>
<td></td>
</tr>
<tr>
<td>Find Record Type</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Replace</td>
<td>Ctrl+R</td>
<td></td>
</tr>
<tr>
<td>Removes Data On/Off</td>
<td>Ctrl+D</td>
<td></td>
</tr>
<tr>
<td>Change</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Goto (Ctrl + T):

Select this item to go to a certain row (or record) number. In the dialog box that comes up, type in the desired row number and click OK. The editor window will zoom to that record and set the current field to the first editable field in the record.

Find (Ctrl + f) menu item:

The Find dialog allows you to enter a value to find and set the detailed search criteria.
Find: Type in the string or number you are searching for in the edit box or pick a previous search string from the list.

Field is a: Choose what type of data is in the field you are looking for. Check appropriate checkbox for matching case and/or whole word.

Columns to search:
The default is to search All columns, but if you choose the Columns radio button, you can enter a comma separated list of column numbers. The column to the right of the TYPE column is column 1 and it is the first column in which you can search.

Search:
You can search By Rows or By Columns and you can choose to search Up or Down from the current field.

Once you have specified the parameters for the search, click the Find Next button to find the first instance of the search string. Continue to click the Find Next button to find the next instance of the string. To just find the next instance of a string and close the dialog box, you can click OK.

Find Next (F3) menu item: Finds to the next occurrence of the string previously specified in the Find dialog.

Find Prev (<Shift> + <F3>) menu item: Moves you to the previous occurrence of the string previously specified in the Find dialog.

Find Record Type menu item: Allows you to find the next record type of the type specified. The search starts at the current record. When you click this menu item, the Find Record Type dialog box is displayed. Choose the record type you wish to look for by picking from the list then specify the direction of search and click the Find Next button to find the record. Click Cancel when done.

Replace (<Ctrl> + r) menu item: When you click on this menu item, the Replace dialog appears.
The **Replace** dialog allows you to specify a **Find:** value and a **Replace with:** value. The other fields in the **Replace** dialog are the same as the **Find** dialog. You can view the **Find:** value one instance at a time by clicking the **Find Next** button, if you decide to replace a given value found just click the **Replace** button. Alternatively, you can allow the software to automatically replace all the instances of the **Find:** value encountered in the specified columns in the raw data file by clicking the **Replace All** button.

**Note:** Before clicking the **Replace All** button, be sure to specify whether you wish to replace matching fields in the highlighted **Selection** of fields/records or in all the fields in the **Whole File**.

**Data On/Off (<Ctrl> + d) menu item:**

Selecting this menu item inserts a Data On/Off record above the current record. Records between pairs of Data On/Off records are ignored when the traverse is reduced. This can be useful when trying to find problems in a traverse.

**Change**

The items in this submenu allow you to change specific types of fields in the raw data file.

**Point ID (<Ctrl> + I) menu item:** This menu item allows you to change point IDs for instrument points, back sight points, or foresight points. You can change individual points one at a time or you can make a global change. You can specify a value to find and a value to replace it with. The **Change Point ID** dialog has several sections that are similar to the **Replace** dialog.
Field is a: You must specify how you want to treat the point ID field. You can do this by clicking on the String or Number radio buttons.

Define: You must specify whether you wish to specify the replacement value by Value or Formula.

Note: The Values: (Input – Output) section of the dialog changes its title to Formula: when you elect to Define by Formula. Also, the content of this portion of the dialog changes according to the field type (see Values: or Formula: section below).

Instr. Point, Backsight, and Foresight check boxes: Check the check boxes of the types of point IDs you wish to change.

Values: or Formula: section
When Define is set to by Value and Field is a is specified as either a String or a Number then the title of this section of the dialog becomes

Values: (Input – Output) (as shown in the dialog above). In this configuration the Change Point ID dialog functions like the Replace dialog except that it only searches the point ID fields specified.

Specify the value to search for in the edit box to the left of the "–>" and the value to replace it with in the edit box to the right of the "–>".

The Find Next, Replace and Replace All buttons act exactly the same as the Find Next, Replace and Replace All buttons in the Replace dialog.

When Define is set to Formula the title of this section of the dialog becomes Formula:
If Field is a is specified as a String, the dialog is as shown below:

In this configuration the formula acts to add a prefix and/or a suffix to the existing point ID (represented by [Old]). Enter the prefix in the edit box to the left of [Old] and the suffix in the edit box to the right of [Old]. If you do not wish to add a prefix or you do not wish to add a suffix, you may leave either the left or right hand edit boxes empty.
If Field is a specified as a **Number**, the dialog is as shown below:

![Change Point ID dialog](image)

In this configuration the formula adds a specified number to a given point ID. Enter the positive or negative number in the edit box to the right of "[Old] +".

**NOTE:** When the Field is a specified as a **Number** and a point ID containing non-numeric characters is encountered, it will be skipped and no change will be made to it.

**Change Height ( <Ctrl> + h)**

Use this menu item to change the instrument height and/or rod height. Clicking this menu item brings up the **Change Height** dialog.

![Change Height dialog](image)

**Action section of dialog**

Use this section to determine how the height is to be changed when **Define** is set to **Formula**.

- **Multiply/Divide:** Choose this if you wish to multiply or divide the height by a given number.
- **Add/Subtract:** Choose this if you wish to add a specified number to the height or subtract a specified number from the height.

**Define section of dialog by Value:** If you choose by Value, this command becomes like the Replace command, except that it acts only on instrument heights and/or rod heights.
**Formula:** This allows you to specify a number to apply to the height by addition, subtraction, multiplication, or division. (See the **Action** and **Values:**/Formula: sections.)

**Values:**/Formula: section of dialog

Depending on what you choose in the Action and Define sections there are several possibilities for this section of the dialog:

When **Define** is set to by Value the **Action** section of dialog is disabled and the title of this section becomes **Values: (Input->Output)**

In this configuration the feature functions like the Replace command, except that it acts only on instrument heights and/or rod heights.

When **Define** is set to **Formula**, the **Action** section of dialog is enabled and the title of this section becomes **Formula**: 

When the **Action** is set to **Multiply/Divide**, the **Formula:** section changes as seen below:

![Change Height](image)

In this configuration you can multiply or divide the instrument height or rod height by the number specified in the edit box. To switch between multiply and divide, just click on the button with the multiply ("*") or divide ("/"") symbol on it.

When **Action** is set to **Add/Subtract**, the **Formula:** section changes as seen below:

![Change Height](image)

In this configuration you can add or subtract the number specified in the edit box to or from the instrument height or rod height. To switch between add and subtract, just click on the button with the add ("+") or subtract ("-"") symbol on it.
on it.

### Search section of the dialog

Use this section of the dialog to specify how the records will be searched. The search begins at the currently active field.

**Instrum.** and **Rod** checkboxes: Check one or both of these check boxes to specify which types of heights are to be searched/changed.

**Find Next** button: Use this button to move to the next field that matches the specifications you entered.

**Replace** button: Use this button to replace the highlighted text that was found.

**Change All** button: Use this button to make the changes specified to all matching fields in the file. Be sure to specify whether to apply the changes to the highlighted **Selection** (records or fields) or to the **Whole file**.

**Cancel** button: Click the Cancel button to close the dialog.

### Change Angle (<Ctrl> + g)

Choose this menu item to change vertical and/or horizontal angle fields. Clicking the **Change Angle** menu item brings up the **Change Angle** dialog: This dialog is almost identical to the **Change Height** dialog and will not be described in detail. The differences are: the **Multiply/Divide** action seen in the **Change Height** dialog is replaced by the **Make Opposite** action; you can check either the Vertical or Horizontal check boxes to specify the angles you wish to change; choosing **Formula** and **Make Opposite** disables the **Formula**: section of the dialog due to the fact that the action to be taken is merely to reverse the sign of the angle.

### Change Distance (<Ctrl> + D)

The **Change Distance** dialog is almost identical to the **Change Height** dialog. The only difference is that you can choose to change the **Slope** distance and/or the **Horizontal** distance by checking the checkboxes.

### Change DescLen (<Ctrl> + j)

This command allows you to set the description length for the current raw data file. It displays the **Longest description length**: that is found in the current records in the file. It allows you to specify a new **Description length**.

**Warning:** If you specify a length less than the longest description found in the file, the descriptions that exceed that length will be truncated.

### Network Least Sq. menu item

This menu item runs the **SurvNET Network Least Squares Adjustment** program. Please refer to the section on SurvNET for a detailed description of this very powerful traverse and level loop adjustment program.

### Window menu
This menu contains many of the standard Window menu items found in other programs. It allows you to arrange the currently open windows in several configurations. It has the added functionality of the New Window command which allows you to have two or more views of a single file

Help

For information regarding the CGEditor program version click the About CGEditor... menu item.

Editing C&G Mapcheck Files

Mapcheck files are typically used to check the closure of a given parcel of land given the deed description of that parcel. A mapcheck file may contain straight line boundaries as well as boundaries described by both tangent and non-tangent curves.

Creating or Opening a Mapcheck File

To create a new file or open an existing file choose File on the main menu then either click New or Open. If you choose New a submenu will appear, click the C&G Mapcheck File menu item. In either case you will then see a file dialog. Browse to the directory where you wish to work and, if creating a new file, type in a file name, or, if opening an existing file, click on a mapcheck file (*.cgm). Next, click the Save button for a new file or the Open button for an existing file.

If you are creating a new file, an empty file will be shown in its own document window within the editor. If you are editing an existing file, the data from the file will appear in a similar document window. It is possible to have multiple documents open at the same time. So you could create a new file and open an existing file in the same editing session and each would appear in its own window in the editor. You can have as many new and/or existing files open as your project demands. You may also cut, copy and/or paste between files.

Settings: Before entering any data you should check the current settings. Click the Settings menu item then click Map Check File to review and/or change the current settings. (For more details, see the Settings Menu section of Editing C&G Mapcheck Files.)

Mapcheck Data Entry

Opening an existing template file or creating a new one is very similar to opening or creating a raw traverse data file. There are three types of records that you may use in a mapcheck file:

- Straight line (identified as Line in the Type column)
- Tangent Curve (identified as TC in the Type column)
- Non-tangent Curve (identified as NTC-C or NTC-R in the Type column for Chord or Radius definition NTC records)

Adding and Inserting new records

To create a new record in the current file you must either use the Add or Insert menu item or the Add or Insert toolbar.

Note: If the Add and/or Insert toolbars are not showing, click the View menu then choose the menu item for the toolbar you want to turn show.

When you click on one of the Add menu items or toolbar icons, an empty record is added to the end of the file. If you click on one of the Insert menu items or toolbar icons, an empty record is inserted above the currently active record or field. To make a record the currently active record, just click on one of its fields.
Moving from field to field: While entering data, to move to the next field, press the Enter or Tab key. To move to the preceding field press the Esc key or the Shift and Tab keys at the same time.

Straight Lines

There are two fields to be filled out in a Straight Line (or Line) record:

**Bearing or Azimuth:** For a bearing, use the standard C&G bearing notation:

**For Bearing:** Qdd.mmsss

Where
- q = quadrant (1 = NE, 2 = SE, 3 = SW, 4 = NW)
- d = 2 digit bearing
- m = minutes
- s = seconds and tenths of seconds

For example: enter S 35° 22' 34.2'' E as 235.22342

**For Azimuth, use the notation:** ddd.mmsss

**Distance:** Enter the length of the boundary in whatever units you have specified in the Map Check File Settings.

**Code:** Enter a code (optional).

**Note:** If Code Off is checked in the Map Check File Settings dialog, this field will not be active. However, clicking on the Code column title will turn it on.

**Description:** Enter a description (optional).

**Note:** If Description Off is checked in the Map Check File Settings dialog, this field will not be active. However, clicking on the Description column title will turn it on.

If Translate Mapcheck Descriptions Using a Description Table is checked in the Map Check File Settings dialog and you have entered an integer number description, then when you move to the next field, the description table will be searched for a description number matching the integer entered. If a matching description number is found, the description from the table will be placed in the Description field and the integer originally entered in the Description field will be placed in the Code field.

Tangent Curves

For a Tangent Curve record there are six possible fields to enter. Of the following six fields you must enter data for two of the first four:

**Radius** - decimal distance

**Arc Length** - decimal distance

**Chord** - decimal distance

**Central Angle** - angle specified as ddd.mmss (degrees.minutes and seconds to nearest .1 sec.)

**Code** (optional - see Straight Lines above)

**Description** (optional - see Straight Lines above)

Non-Tangent Curves

The fields in a Non-Tangent Curve record vary according to whether it is defined using the chord bearing/azimuth or radius bearing/azimuth.
When using **Non-Tangent Curve** record it is necessary to specify whether the chord or radius definition will be used when specifying the curve. There are four ways to accomplish this:

1. Prior to Inserting or Adding the record, use the **Settings** menu then choose **Map Check File**. In the **Map Check File Settings** dialog set the **Curve Definition** in the **File Measurement Info** section of the dialog.
2. Prior to Inserting or Adding the record, use the **Settings** menu to check or uncheck the **Non-Tan Curves Use Chord** menu item. When the **Non-Tan Curves Use Chord** menu item is checked, newly created **Non-Tangent Curve** records will added or inserted that use the chord definition, otherwise they will use the radius definition.
3. Prior to Inserting or Adding the record, click the **C-R** toolbar icon. When the icon appears depressed, newly created **Non-Tangent Curve** records will use the chord definition, otherwise they will use the radius definition.
4. To change the type of curve definition for an existing **Non-Tangent Curve** record, use the Edit main menu and choose the **Change Curve Def'n** menu item. This changes the current record from what it is now to the opposite type of curve definition.

For both the **Chord** and **Radius** definitions the following fields are present in the record:

**Chord or Radius Brg/Azimuth**

used to orient the curve properly as it leaves the PC. As noted in the **Tangent Curves** section, bearings must be entered in the qdd.mmsss format and azimuths entered in the ddd.mmsss format. **Radius**

**Arc Length**

**Chord**

**Central Ang**

**Code**

**Description**

All but the first field has been discussed earlier in the **Tangent Curves** section and will not be described here.

**Editing a Mapcheck File**

Most of the menu items found in the mapcheck menus have been discussed in the **Editing Traverse Raw Data Files** section. Only the differences will be discussed here.

**File Menu:** The **File** menu when editing a mapcheck file is identical to the **File** menu discussed in the **Editing Traverse Raw Data Files** section.

**Edit Menu:** With the exception of the **Change Curve Def'n** menu item, the **Edit** menu is identical to the **Edit** menu discussed in the **Editing Traverse Raw Data Files** section. **Change Curve Def'n** was discussed above in the **Non-Tangent Curves** section

**Add Menu:** The Add menu allows you to add **Straight line**, **Tangent Curve** and **Non-Tangent Curve** records to the end of the file.

**Insert Menu:** The Insert menu allows you to insert **Straight line**, **Tangent Curve** and **Non-Tangent Curve** records above the current record.

**View Menu:** Allows you to turn the toolbars on and off.

**Settings Menu**

The **Settings** menu contains items that allow you to specify the format of the data in a mapcheck file and how this data will appear in the **CGEditor**.

**Map Check File settings menu item**
The **Map Check File** menu item brings up the **Map Check File Settings** dialog (see below). This dialog allows you to specify settings for each of the mapcheck files currently open in the editor. It also allows you to specify the default settings for creating new map check files.

![Map Check File Settings dialog](image)

**Current File:** Use this list to choose a file you wish to set or view the settings for. You may also set or view the **DEFAULT** settings that are used for newly created files.

**File Information and Edit Options:**
The settings in the File Information and Edit Options sections have been discussed under the Settings Menu section of Editing a Raw Data File.

**File Measurement Info:**
Most of the settings in the File Measurement Info section have been discussed under the Settings Menu section of Editing a Raw Data File. However, a **Curve Definition:** item has been added to this section for mapcheck files:

**Curve Definition:** click the **Curve Definition** button to change from Chord to Radius definitions and vice versa. **Curve Definition** only applies to the insertion or addition of **Non-Tangent Curve** records.

**Record Color menu item**

The **Record Color** menu item has been discussed under the **Settings Menu** section of **Editing Traverse Raw Data Files**. The only difference is that here you are setting the colors for the various types of mapcheck records instead of raw data records.

**Validate Records**

This menu item allows you to set whether records are validated prior to being saved. (See also, **Validate Records** in the **Settings Menu** section of **Editing Traverse Raw Data Files**.)

**Non-Tan Curves Use Chord:** Use this to switch which types of **Non-Tangent Curve** records are added or inserted.
Tools, Window and Help Menus the items in these menus have been discussed in the Editing Traverse Raw Data Files section.

C&G Cross Section Files

Cross section files contain data which defines one or more topographic or design cross sections along an alignment. Any features using a cross section file assume that it is at right angles to the alignment. Each cross section is identified by its station along the alignment. Each cross section is defined by a Station record specifying a station on the alignment followed by a series of Point records specifying the offset and elevation of points on the cross section at that station. Cross sections can be used to visualize a site, specify design elevations and calculate volumes. Opening an existing cross section file or creating a new one is very similar to opening or creating a map check file.

Cross Section File Data Entry

Station Records: There are three fields to be filled out in a Station record:
Station: Specifies the station of this cross section along the alignment. For example: station 6+45.37 is indicated as 645.37.
Left Slope: This field defines the slope at the left side of the cross section in feet per foot (or meters per meter if units are set to meters). This slope will be used to extend this cross section to meet any cross section it overlays.
Right Slope: This field defines the slope at the right side of the cross section in feet/foot (meters/meter). This slope will be used to extend this cross section to meet any cross section it overlays.

Point Records

There are two fields in a Point record:
Offset: The Offset defines the perpendicular distance from the alignment to this point on the cross section.
Elevation: The Elevation specifies the elevation of this point on the cross section.

Cross Section File Data Editing

Adding and Inserting new records: To create a new record in the current file you must either use the Add or Insert menu or toolbars.

Note: If the toolbars are not showing, click on the View menu then click the item for the toolbar you want to turn on.

Settings Menu item

Record Color:
The Record Color menu item has been discussed under the Settings Menu section of Editing Traverse Raw Data Files. The only difference is that here you are setting the colors for the various types of cross section records instead of raw data records.

Validate Records: This menu item has been described in the Settings Menu section of Editing Traverse Raw Data Files

US Foot: If this menu item is checked units are US feet. If the Meters menu item is checked, this menu item is disabled.
International foot: If this menu item is checked units are International feet. If the Meters menu item is checked, this menu item is disabled.

Feet: If this menu item is checked units are Feet.

Meters: If this menu item is checked units are meters.

Note: The settings for US Foot and International foot will be ignored if Meters is checked.

**C&G Template Files**

Template files contain data defining standard cross section templates that can be used to create a cross section file that represents the design cross sections for a proposed alignment. Cross section files created using templates can be overlaid on existing cross sections to allow the computation of cut and fill volumes and to visualize the design alignment. Opening an existing template file or creating a new one is very similar to opening or creating a map check file.

**Entering and Editing Template Data**

Entering and editing template data is analogous to that described in *Entering and Editing Cross Section Data* except that, instead of being identified by their station along the alignment, templates are identified by an integer template identifier. This identifier is used when building a cross section from templates in order to specify a template among the many that a template file may contain. Templates are placed along a proposed alignment at various stations and thus create a series of cross sections using the alignment elevation to set the elevation of the template points. When building cross sections along an alignment using templates, cross sections at stations between two template stations result in a series of cross sections being created to transition between the templates.

**Template File Data Entry**

**Template Records:** There are five fields to be filled out in a Template record:

- **Template:** Template number for identifying the template
- **Left Slope:** Specifies the slope at the left side of the template in feet/foot (meters/meter). This slope will be used to extend this template generated cross section to meet any cross section it overlays.
- **Right Slope:** Enter the slope at the right side of the template in feet per foot (or meters per meter units are set to meters). This slope will be used to extend this template generated cross section to meet any cross section it overlays.
- **Offset:** The Offset defines the distance from the centerline of the template to this point on the cross section. The template centerline should be assigned a 0.0 offset. The 0.0 offset is placed on the alignment when cross sections are generated from templates.
- **Elevation:** The Elevation specifies the elevation of this point on the template. If the elevation of the centerline point is set to 0.0, then this elevation can be used to directly compute the elevation of the point based on the elevation of the alignment where the template is placed.

**Editing a Template File:** All template menu items and editing procedures are identical to those described for cross sections.

**Editing Coordinate Files**

Coordinate files contain data on the Point IDs, Northings, Eastings, Elevations, Descriptions and, for C&G files, Codes for various points located in the field and points created by calculations and/or by hand data entry. The coordinate file may have points from a single job, portions of a single job or many jobs. The Point ID must be a
unique identifier for a given point. Typically Point IDs are integer numbers but may also be any combination of letters and numbers depending on the format of the file.

The CGEditor can be used to edit six different types of coordinate files. All the supported coordinate file types have **Point ID**, **Northing**, **Easting**, **Elevation**, and **Description** fields. In all formats, any given point may have a blank **Description** field. The types of files supported and a brief description of their differences follows:

**C&G Numeric (*.crd)**
- **Point ID**: any integer number between 1 and 65,536.
- **Description**: The maximum description length for a given file can vary between 1 and 100 characters and is set when the file is created. A given point description entry may be blank.
- **Code**: up to 4 characters long. Used to filter and sort points. The **Code** field may be blank.

**C&G Alpha-numeric (*.cgc)**
- **Point ID**: up to 10 characters long and can contain any combination of alphabetic and numeric characters.
- **Description**: The maximum description length for a given file can vary between 1 and 100 characters and is set when the file is created. A given point description entry may be blank.
- **Code**: up to 4 characters long. Used to filter and sort points. The **Code** field may be blank.

**Carlson Numeric (*.crd)**
- **Point ID**: any positive integer number containing 1 to 9 digits.
- **Description**: entries can be from 0 to 31 characters long.
  (the **Code** field is not supported.)

**Carlson Alpha-numeric (*.crd)**
- **Point ID**: any a series of from 1 to 9 alphabetic or numeric characters.
- **Description**: entries can be from 0 to 31 characters long.
  (the **Code** field is not supported.)

**Simplicity (*.zak)**
- **Point ID**: can be any positive integer number containing 1 to 8 digits.
- **Description**: entries can be from 0 to 28 characters long.
  (the **Code** field is not supported.)

**Land Desktop (*.mdb)**
- **Point ID**: can be a series of from 1 to 255 alphabetic or numeric characters.
- **Description**: entries can be from 0 to 255 characters long.
  (the **Code** field is not supported.)

**Creating or Opening a Coordinate File**

To create a new file or open an existing file choose **File** on the main menu then either click **New** or **Open**. If you choose **New** a submenu will appear, click the **Coordinate File** menu item or click on the "C" icon in the **Standard** toolbar. Next pick the type of coordinate file you wish to create using the **Coordinate File Type** dialog:
A new coordinate file with a temporary name will appear in its own document window in the CGEditor and will contain only a single blank coordinate Point record.

If you are opening an existing file using the Open menu item, you will be asked to choose the file using file dialog. Browse to the directory where you wish to work click on a coordinate file and click the Open button. The coordinate records from the file will appear in a separate document window in the CGEditor.

It is possible to have multiple documents open at the same time. So you could create a new file and open an existing file in the same editing session and each would appear in its own window in the editor. You can have as many new and/or existing files open as your project demands. You may also cut, copy and/or paste between files.

Settings: Before entering any data you should check the current settings. Click the Settings menu item then click Coordinate File to review and/or change the current settings. (For more details, see the Settings Menu section of Editing Coordinate Files.)

Entering and Editing Coordinate File Data

Once a coordinate file has been opened or created, you can edit any of the fields in any of the records. To create a new coordinate point you must use the Add/Insert main menu or toolbar. Both the Add/Insert menu and toolbar allow you to add or insert individual blank records or one or more records from an existing coordinate file. When you add a record or records, they are appended to the end of the file. When you Insert one or more records they are inserted just above the current record.

Insert and Adding Coordinate Records from an Existing Coordinate File

If you choose to either the Add or Insert Pts from File or the corresponding toolbar item, you will see the C&G Select Points from: dialog.
This dialog consists of a list of the points chosen so far from the file listed in the **Change File to Select From** edit box. Use the **File** button to set the file name and the **Open** button to open the file for use. When the dialog first comes the point list is empty.

**Choose Points section**

Choose one of the available methods you will use for choosing points. Different methods will cause data entry controls to appear below the **Choose Points section**.

Note: Any time there are points in the list the **REMOVE from SELECTION** button will be enabled. Clicking this button will remove points from the list according to the current method being used to choose points.

**All**

If you choose all and not all of the points in the file are in the list, the **ADD from FILE** button will be enabled. Clicking the **ADD from FILE** button will add all the points from the file to the list.

**Block**

If you choose the **Block** method, the following **Define Block** section will appear below the **Choose Points section** of the dialog.

![Define Block](image)

Fill in the **Starting Point ID** and **End Point ID** then click the **ADD from FILE** button.

**by Desc**

If you choose the **by Desc** method, the following **Specify Description** section will appear below the **Choose Points section** of the dialog.

![Specify Description](image)
Fill in the description to look for and check the **Match Case** and **Match Whole Work Only** checkboxes as needed. Next click the **ADD from FILE** button

and any matching point records will be added to the list.

by Code

If you choose the **by Desc** method, the following **Specify Code** section will appear below the **Choose Points section** of the dialog. This section of the dialog looks and functions the same as the **Specify Description** section shown above except you must specify a code.

by Elev

If you choose the **by Desc** method, the following **Specify Elevation** section will appear below the **Choose Points section** of the dialog.

Specify the high and low elevation values. You can do this by directly entering the elevation values or you can type a point ID in the **Point ID** edit box then click on another edit box. When you do this the elevation of the point is written to the appropriate **Elevation** edit box. If you used a point ID to get the elevation, you can edit the value if necessary. Next click the **ADD from FILE** button to add the points to the list.

in Radius
in Rect

**Coordinate File Data Entry**

There is only one type of coordinate record called a **Point** record. This record has six fields:

**Point ID**: Point identifier must be unique. Its format varies according to the type of coordinate file.

**Northing**: Specifies the northing or Y coordinate of a point.

**Easting**: Specifies the easting or X coordinate of a point.

**Elev**: Specifies the elevation or Z coordinate of a point. (May be On or Off. To turn the column on click the column heading.)

**Code** (**C&G** coordinate files only):

a 4 character optional field used to group points. May be blank. (May be On or Off. To turn the column on click the column heading.)
**Description:**
Text describing the point. May be blank. Length limited by type of coordinate file. (May be On or Off. To turn the column on click the column heading.)

After adding or inserting a **Point** record, fill in the various fields as needed. Use the Tab or Enter keys to move from one field to the next. If you press Enter when in the last activated field in a record, a new blank record will be created just below the current record and the current field will be set to the **Point ID** field in the new record.

To replace the data in an existing record, just click once on the field you wish to replace and begin typing the new data. To edit the data in an existing record, click twice on the field you wish to edit and make any edits required in the existing data.

**Settings Menu**

**Coordinate Files**

Choosing this menu item brings up the Coordinate File Settings dialog

**Settings for**
drop down list box allows you to specify settings for any coordinate file currently open in the CGEditor as well as choose to set the **Default settings for new files you create**.

**Type of File** is only visible for the files currently open.

**Description Length:**
this edit box can be used to set a new description length for the file. If you choose to change the description length, any descriptions that already exist in the file will be truncated to the new length.

**Translate Coordinate Descriptions Using Description Table** checkbox
if this is checked then the description table file name edit box and the **Browse...** button will be enabled and you will be required to specify a description table to use.
Description ON checkbox - if this is checked then the Description column will be activated in the editor.

Point Code ON checkbox - if this is checked then the Code column will be activated in the editor. (Only applies to C&G coordinate files)

Elevation ON checkbox - if this is checked then the Elevation column will be activated in the editor.

Units: click the button to switch between Foot and Meter.

Foot Definition: click the button to switch between US and International feet. (Disabled if Units are set to Meter)

Coordinate Display section
Places displayed: drop down list - use to specify the number of decimal places displayed in the editor for northing, easting and elevation.
Note: the Places displayed setting does not affect the values actually stored in the coordinate file, only how they are displayed in the editor window.
Coordinate Order: click button to switch between North-East and East-North.

Printing: Page Orientation section
choose Portrait or Landscape. You may wish to choose Landscape to avoid having the coordinate records with long descriptions causing each page to span 2 pages in width.

The Set Defaults, Restore Values and Save As Default have been covered elsewhere.

US Foot menu item
If this menu item is checked units are US feet. If the Meters menu item is checked, this menu item is disabled. The check will also be set or cleared by changes in the Coordinate File Settings dialog.

International foot menu item
If this menu item is checked units are International feet. If the Meters menu item is checked, this menu item is disabled. The check will also be set or cleared by changes in the Coordinate File Settings dialog.

Feet menu item: If this menu item is checked units are Feet. The check will also be set or cleared by changes in the Coordinate File Settings dialog.

Meters menu item: If this menu item is checked units are meters. The check will also be set or cleared by changes in the Coordinate File Settings dialog. Note: The settings for US Foot and International foot will be ignored if Meters is checked.

Tools Menu
With the exception of Renumber Points, the items on the Tools menu are similar to those items already described for other file types.

Renumber Points menu item
When you choose the Renumber Points menu item you will receive a warning regarding the problems that
may be encountered in existing C&G drawings.

After considering the problems you may encounter due to point renumbering respond Yes or Yes-Don't Ask Again to continue with the renumbering operation, or No to cancel the operation.

If you choose to continue with the renumbering of points, you will see the Renumber Points dialog:

Renumber Points dialog
Points to Renumber section
First choose All or Enter Points.
If you choose Enter Points you must fill in the edit box specifying the points to renumber. The points to renumber can consist of single points or range(s) of points. Multiple entries of ranges and/or single points must be separated from the next entry by a comma (","), and ranges must be specified using a dash ("-")

Renumbering Method section
choose Add or Multiply then enter the Amount to Add: or Multiply by: in the edit box. You may specify a positive or negative whole number.

When done click OK. Click Cancel to end the command without changes to the coordinate file being edited.

Editing C&G Point Group Files

A C&G point group is essentially a list of points placed in a specially formatted text file (*.pts). It is possible to create and/or edit point group files using any plain text editor like Microsoft Notepad or Wordpad if you know the format of the file. Typically it is far easier to use the CGEditor to create and/or edit C&G point group files. Point groups have many uses in C&G commands: road alignments, property boundaries, define Include and Exclude Boundaries for Topo commands, etc. In the case of alignments, a point group can also include vertical curve information.

C&G point group files are organized into named subgroups. The subgroup name can be anything you wish
to use to identify the points that follow. You may have several subgroups in a single point group file. For example, if you are defining subdivision lots, then you may choose the subgroup names to be lot 1, lot 2, etc. For an alignment you can make the subgroup name the starting station and C&G features will make this the default starting station when asking you for an alignment. Point groups can also be used to.

Creating and Opening Point Group Files

You may open and/or create as many files as are needed for your project.

To create a new empty point group file choose the File menu then the New menu item then the Point Group File menu item or, more simply, just click the "P" toolbar icon on the Standard toolbar. In either case, a document window will appear within the main CGEditor window. This will have a single blank record or row for the Subgroup name - identified by SGR in the Type column.

To open an existing point group file, choose File then Open... Then, in the file dialog, browse to the directory where your point group file is located, highlight the desired file and click the Open button. The records will be read from the file and will be displayed in a separate document window.

Entering and Editing Point Group File Data

If you do not have a subgroup name record, choose the Add/Insert main menu then, if you wish to place it at the end of the file, choose the Add Subgroup menu item or, if you wish to insert it above the current record, choose the Insert Subgroup menu item. After filling in the subgroup name, you can just press Enter to add a single Point record (identified by PNT in the Type column) below the subgroup name record. Alternatively, you can use the Add/Insert menu to add or insert a single point or you can choose to add or insert several points from a coordinate file. These same add and insert methods can be found on the Add/Insert Toolbar.

If you choose to Add or Insert Pts from File the following dialog comes up:

![C&G Select Points from EGDEM.LORD](image)

The use of this dialog to choose points has been described in detail under the section on Editing Coordinate Files. Please refer to that section for more details. After choosing the points you wish to add or insert into the point group using the C&G Select Points from ... dialog, click OK and the point records will be created in the point group file being edited.
Horizontal Curves
You may have noticed that the Rad Pt Type column is marked with <None> for the points you have inserted so far. However, if you wish to specify a curve in your alignment or lot boundary, you must designate the record as a radius point. If you click on the Cw toolbar icon (for clockwise) or the Cc toolbar icon (for counter clockwise) or choose similar items on the Tools menu, you will notice that the Rad Pt Type column for the point changes to CW or CCW to indicate that the point is a radius point. If a radius point is specified, the preceding point is assumed to be the PC and the following point is assumed to be the PT. If you wish to change the point back to not being a radius point, click the Not Radius Pt toolbar icon or use the Tools menu.

Vertical Curves
You may enter vertical curve information in a point group file. This allows you to not only specify the horizontal location of the alignment, but also its vertical alignment. A point group file that has vertical curves in it may not contain any subgroup records. If you attempt to place vertical curve data in a file having one or more subgroups, you will be given the following warning:

As indicated by the choices in the dialog, you may continue and place vertical curve info in a point group file containing subgroups, but it will not be usable in C&G commands.

If you have no subgroups (or if you do and answer “Yes” to the warning) and this is the first vertical curve in the file, the Enter Vertical Curve Information dialog will come up.

Enter the information in the dialog to specify the vertical curve. The Starting Station and the PVI Station should be entered as decimal numbers and when you click in another edit box the decimal station will be converted to standard station notation. The Slope in and the Slope out should be entered as a percent (For example, enter 2 or 2.0 for 2%). When you click OK the vertical curve records VC1 and VC are added in the document window.

For the second and succeeding vertical curves, you can either Add Vertical Curves to the end of the vertical curve records or you can Insert Vertical Curves within the existing vertical curve records. For these vertical curve records, the dialog requires fewer entries:
This is a result of the fact that the initial vertical curve **Starting Station, Initial PVI Elevation** and **Slope in** control the overall vertical orientation of the succeeding vertical curves thus you need only enter the **PVI Station, Length** and **Slope out** for these vertical curves. When you click **OK**, another vertical curve record will be added to or inserted into the document.

Once the vertical curve information has been specified you can go ahead and enter the points specifying the alignment.

**Settings Menu**

The Settings menu allows you to configure the point group file and the record appearance.

Choose the **Point Group Settings** menu item to bring up the **Point Group Settings** dialog:

In this dialog you can set the units and the page orientation for printing.

**Note:** the units setting only effects the display of stations in station notation.

Choose the **Record Color** menu item to bring up the **Record Color** dialog. Set the display color of the various records by clicking on the line for the record type. This brings up a color dialog that allows you to pick from the 16 available colors. Click **OK** when done.

**Tools Menu**

The items in the **Tools** menu are, for the most part, self-explanatory or have been covered in detail for other types
Pulldown Menu Location: CG-Survey>Tools>CGEditor
Keyboard Command: eda, cg_edit_all
Prerequisite: May need existing C&G raw traverse data file (*.cgr), C&G Map Check file (*.cgm), C&G Cross Section file (*.cew), C&G Template file (*.ctp), coordinate files (*.crd, *.cgc, *.zak, *.mdb) and/or C&G Point Group files (*.pts)
Index

plus-0.5 in
2 Point - 2 Point Intersect, 743
2 Tangents, Arc Length, 342
2 Tangents, Chord Length, 342
2 Tangents, Degree of Curve, 344
2 Tangents, External, 343
2 Tangents, Mid-Ordinate, 343
2 Tangents, Radius, 342
2 Tangents, Tangent Length, 344
2 Tangents, Through Point, 344
2-Radius Curve Series, 348
2D Align, 266
2D Line, 328, 330, 496
2D Linewor Library, 450
2D Polyline, 27, 50, 53, 57, 108, 123, 129, 131, 156, 330, 331, 333, 447, 804, 808, 849, 850
3 Point, 340, 350, 351
3-Radius Curve Series, 348
3D Arc, 347, 628
3D Entity to, 17
3D Entity to 2D, 291
3D Line, 330, 1017
3D Points, 116, 771
3D Polyline Utilities, 286, 288, 289
3D Polyline by Slope on Surface, 289
3D Polylines, 116, 289
3D Viewer Window, 301, 302, 311, 313, 427, 1003, 1017, 1018, 1055
3D Viewer/Model Library, 450
3D Views, 301
3DX Model File, 313
4 Sided Building, 54, 723
AASHTO, 785
Add/Replace Layer Prefix, 322
Add Culvert to Polyline, 989
Add Intersection Points, 275
Add Point by Two Slopes, 288
Add Points At Elevation, 289
Add Polyline Arcs, 276
Add Polyline Vertex, 276
Add Prefix/Suffix To Text, 263
Add Zig to Polyline, 989
Adjoiner Text, 65, 951
Adjust Areas, 840
Adjust Coordinates, 501
Adjust Elevation Labels, 1065
Align, 266, 267, 353, 355, 389, 416, 482, 485, 486, 507, 508, 510, 530, 588, 601, 685, 686, 778, 804, 809, 812, 822, 852, 859, 860, 950, 963, 968, 969, 976, 1012, 1027, 1087, 1088, 1111
1124, 1279
Align Paper With Model Space, 301
Align Points, 507
All topo items, 1383
Alphanumeric, 42, 428, 1228
Angle/Distance, 17, 66, 502, 933, 936
Angle Balance, 571, 595, 597, 698
Angle Info, 409, 410
Angle Mode, 415, 427, 430, 682, 732, 979, 1201
Angles Right, 1303
Annotate Arc, 976, 978, 980, 982, 984, 986
Annotate Menu, 915
Annotate with Leader, 940, 942, 945
Annotation, 3, 17, 23, 385, 387, 427, 680, 931, 947, 976, 996, 1127, 1128, 1132, 1133, 1135, 1136, 1391
Annotation Defaults, 916, 924, 926, 948, 971, 979
Append Another Raw File, 606
Arc Dimensions, 981
Arc From Last Point, 346
Arc Length, 333, 338
Area/Layout Menu, 820, 822, 903
Area by Closed Polylines, 828
Area by Interior Point, 828
Area by Lines & Arcs, 827, 828
Area Defaults, 821, 824, 855, 828, 831, 832, 877
Area Description, 839
Area Label Defaults, 725, 830
Area Radial from Curve, 841
Area Summary, 1296
Area Table Defaults, 835, 836
Area Tables, 831, 832, 834, 835, 838
Area Utilities, 830
Arrowhead, 256, 257, 379, 520, 523, 998
| CGFile, 1168 | CGMngmt, 1351 |
| CG Options, 1385 |
| CG Snap, 1407 |
| CGSurvey Module, 1167 |
| CGTools, 1385 |
| CGTopo, 1382 |
| CGTrav, 1189 |
| Chamfer By Chord Length, 246, 247 |
| Change Attribute Style, 247 |
| Change Block/Inserts Resize, 251 |
| Change Block/Inserts Rotate, 250 |
| Change Block/Inserts Substitute, 250 |
| Change Colors, 249 |
| Change Contour-Plines Width, 1026 |
| Change Elevations, 153, 247 |
| Change Layer Color, 321 |
| Change Lineweight, 249 |
| Change Point LayerColor, 529 |
| Change Polyline Elevation, 278 |
| Change Polyline Linetype, 51, 56, 57, 986, 988, 991 |
| Change Polyline Width, 279 |
| Change Style, 248 |
| Change Text Font, 257 |
| Change Text Oblique Angle, 259 |
| Change Text Size, 258 |
| Change Text Width, 258 |
| Channel Sample, 25 |
| Check Elevation Range, 283, 335 |
| Check Lot Network Parameters, 890 |
| Check Polylines, 283, 284 |
| Chord Bearing, 408, 677 |
| Chord Length, 17, 247, 341, 342, 346 |
| Circle, 339, 350, 493, 494, 608, 609, 642, 748, 764 |
| Close, 1359, 1377, 1411, 1414, 1415, 1418, 1422, 1423, 1339, 1377, 1411, 1414, 1415, 1418, 1422 |
| Close Current, 1377 |
| Close Polylines, 128 |
| Close Map Check File, 1184 |
| Close Polylines, 280 |
| Close Raw File, 1184 |
| Closure, 2, 1377, 589, 592, 612, 677, 681, 697, 698, 700, 718, 721, 1184, 1190, 1192, 1253, 1256 |
| Closure by Point Numbers, 697 |
| Closure Error, 713, 827 |
| Coal Sections, 438 |
| Code Definitions, 630, 660 |
| COGO Menu, 724 |
| Color by Elevation, 1055 |
| Color Contours by Elevation, 1022 |
| Color Contours by Interval, 1024 |
| Combined Transformations, 1365 |
| Command Entry, 16 |
| Compare Points, 482, 487, 488 |
| Compass, 611, 613, 615, 721, 825, 1246, 1392 |
| Compass Polyline Adjustment, 720 |
| Composite Bed Qualities by Density, 437 |
| Compound Curve, 785, 787 |
| Compound or Reverse, 347 |
| Configuration, 23, 26, 441, 443, 444, 459, 861, 1229, 1316, 1395, 1397, 1399 |
| Configure Carlson, 690, 835 |
| Conformance, 435 |
| Connect Driveways, 891, 892 |
| Consolidate Area Table, 838 |
| Consolidate Table, 265 |
| Contour Elevation Label, 1026 |
| Contour from TIN File, 1016 |
| Contour ID, 1022 |
| Contours, 144, 152, 279, 431, 457, 1008, 1011, 1012, 1020, 1022, 1024, 1026, 1028, 1043, 1053, 1057, 1058, 1067, 1070, 1071, 1084, 1382, 1384, 1392 |
| Contour Utilities, 1018 |
| Convert C&G to Carlson Points, 535 |
| Convert CAICE KCM to Carlson CRD, 537 |
| Convert Carlson Points to Ashtech GIS, 536 |
| Convert Carlson Points to C&G, 534 |
| Convert Carlson Points to Eagle Point, 537 |
| Convert Carlson Points to Land Desktop, 533 |
| Convert Carlson Points to Simplicity, 535 |
| Convert Carlson Points to Softdesk, 537 |
| Convert Civil 3D to Carlson Points, 533 |
| Convert CRD to Land Desktop MDB, 532 |
| Convert CRD to TDS CR5/Convert TDS CR5 to CRD, 532 |
| Convert Eagle Point to Carlson Points, 538 |

Index
| Design Road Profile | 157, 1137 |
| Design Template | 162, 1073 |
| Digitize Areas | 830 |
| Direct-Reverse Settings | 605, 606 |
| Discussion Groups | 28 |
| Display-Edit File | 312 |
| Display Centerline Stations | 1281 |
| Display Last Report | 413 |
| Display Order | 317 |
| Distance-Bearing with Leader | 943 |
| Distance-Distance Intersect | 740, 1273 |
| Distance Between Two Entities | 817, 818 |
| Distance with Leader | 942 |
| Divide Along Entity | 770 |
| Divide Between Points | 770 |
| Double Break | 750 |
| Double Proportion Line Division | 749 |
| Dozer | 25, 220 |
| Dozer Push | 24 |
| Dragline | 24, 26 |
| Draw | 1338, 1341, 1344, 1346, 1372, 1374, 1376 |
| Draw-Locate Points | 470, 485, 499, 544, 625, 677 |
| Draw 3D Grid File | 1054, 1057 |
| Draw Barscale | 115, 358, 958 |
| Draw Box Around Text | 359, 1012, 1028 |
| Draw Building Envelope Polyline | 780 |
| Draw By Example | 389 |
| Draw Centerline File | 797, 1012 |
| Draw End Point Leaders | 936 |
| Draw Field to Finish | 624, 630, 633, 634, 636, 637 |
| Draw Grid | 951, 955, 1098, 1102, 1105, 1107, 1110 |
| Drawing Block | 396 |
| Drawing Cleanup | 221, 224 |
| Drawing Explorer | 13, 170, 210, 426 |
| Drawing Inspector | 403, 405 |
| Drawing Inspector On/Off | 403 |
| Drawing Save Log | 227, 426 |
| Drawing Settings | 1311, 1323, 1325, 1335, 1337 |
| Drawing Setup | 13, 17, 18, 52, 43, 44, 51, 72, 117 |
| Draw Model View | 314 |
| Draw North Arrow | 358, 956, 957, 1108 |
| Draw Perimeter | 825 |
| Draw Pipe | 665, 1131, 1132 |
| Draw Polyline Blips | 282, 283 |
| Draw Polyline File | 220 |
| Draw Polyline Start/End | 274 |
| Draw Profile | 18, 25, 156, 157, 422, 432, 1088, 1097, 1098, 1101, 1102, 1107, 1119, 1130 |
| Draw Spot Elevations | 1062 |
| Draw Standard Item | 384, 385, 387 |
| Draw Table | 360 |
| Draw Text On Arc | 982 |
| Draw Text on Tangent | 985 |
| Draw Triangular Mesh | 1017, 1018, 1083 |
| Drop C&G Attributes | 1348 |
| Duplicate Points | 223, 482, 487 |
| Dynamic Annotation Note | 937 |
| Eagle Point | 178, 537, 538, 631, 633 |
| Eagle Point Coding | 631, 632 |
| Earth Curvature | 592, 609, 612 |
| Edit | 1317, 1319, 1354, 1356, 1358, 1370, 1372, 1374, 1377, 1379, 1381, 1382, 1392, 1412, 1417, 1419, 1429, 1431, 1439, 1441, 1444, 1446, 1451, 1452 |
| Edit-Process Level Data | 617 |
| Edit-Process Raw Data File | 545, 569, 677, 697, 699 |
| Edit Area Table Properties | 832 |
| Edit Contours | 1021 |
| Edit Coordinates (CGEditor) | 1358, 1359 |
| Edit Field to Finish Codes | 675 |
| Edit Map Check File | 1261 |
| Edit Menus | 231, 577, 622 |
| Edit Multiple Pt Attributes | 515 |
| Edit Point | 17, 140, 475, 495 |
| Edit Point Attributes | 428, 508, 512 |
| Edit Points | 497, 660, 686 |
| Edit Polyline | 275, 277, 278, 279 |
| Edit Polyline Section | 278 |
| Edit Polyline Vertex | 277 |
| Edit Process SDMS File | 624 |
| Edit Raw File | 1192, 1193 |
| Edit Table Properties | 968 |
| Edit Table Values | 972 |
| Edit Text | 254 |
| Edit Text on Arc or Tangent | 985, 986 |
| Elevate 2D Polylines | 850 |
| Elevation Along Entity | 771 |
| Elevation Between Points | 771 |
| Elevation Difference | 732, 1037, 1038, 1057, 1110, 1117 |
| Elevations | 1406 |
| Elevation Zones | 1055 |
Empty Print File, 1188
End Areas, 24
Enter-Assign Point, 729
Enter and Assign, 122, 473
Enter Deed Description, 675, 680
Entities to Polylines, 218, 271, 797
Entity Insertion Point Rotate, 252
Erase, 232, 234, 294, 403, 418, 485, 490, 495, 496
521, 524, 627, 700, 801, 822, 826, 879, 917
1006, 1017, 1075, 1137, 1153, 1344
Erase by Closed Polyline, 233
Erase by Layer, 232
Erase Links, 1155
Erase Outside, 234
Erase Point Attributes, 109, 521
Erase Points, 499
Erase Select, 232
Erase Sub-Areas Hatch, 881
Erase Surface from DWG, 1382, 1383
Explode, 239, 240, 399, 531, 1070
Explode Carlson Points, 531
Export, 207, 209, 211, 214, 216, 218, 219, 221, 446
479, 480, 484, 496, 527, 535, 560, 561, 575
593, 633, 645, 681, 818, 912, 913, 972
1040, 1070, 1072, 1130, 1139, 1141, 1142
1158, 1159, 1177, 1179, 1358
Export 12D File, 212
Export Civil 3D Drawing, 212
Export Civil 3D Points, 214
Export Civil 3D Surface, 214
Export Coordinates to ASCII, 1172
Export Drawing to AutoCAD 14, 214
Export DWG File with Esri MSC, 1158
Export ePlan File, 212
Export GIS Data to SurvCE, 1160
Export Google Earth File, 215, 218, 220, 1071
Export LandXML File, 207
Export Lot File to MDB Database, 912
Export Lot File To Old SurvCADD, 913
Export RoadXML File, 210
Export SHP File, 1158
Export Text/ASCII File, 478, 482, 485, 496
Export Topcon Grid or TIN File, 1072
244, 328, 330, 333, 336, 338, 463, 464, 464, 1128, 1128, 1159
Extend Arc, 241
Extend by Distance, 242
Extended Entity Data, 227
Extend To Edge, 240
Extend to Intersection, 241
Extrapolate, 289, 440, 1052, 1059, 1090
Extrapolate Grid, 1056
Extrapolation, 1052
Fence Diagram, 24
Ferm Codes, 24
Field Text, 354
539, 605, 626, 630, 633, 648, 675, 1043
1145
Field to Finish Inspector, 672, 673
File Editor, 618, 619, 621
File Menu, 181, 572, 622, 1411, 1441
Fillet, 27, 126, 268, 273, 288, 291, 849
Fillet 3D Polyline, 288
Find Bad Angle, 606, 1256, 1392
Find Lot Name, 891
Find Point, 405
Fit Polylines, 1329
Fit Structure, 865, 868, 869, 871, 873, 875, 1328
Fit Text Inside Arc, 986
Fit Text Outside Arc, 986
Fix Coords, 1363
Fix Label Overlaps, 945
Fix Point Attribute Overlaps, 522, 524
Fix Text Overlaps, 260
Flip Contour Labels-Text, 1029
Flip Last Label, 939
Flip ON/OFF, 939
Flip Selected Labels, 939
Flips Labels, 937
Flip Text, 111, 261
Flip Text By Twist Screen, 261
Flood Note, 455
Flow Leader, 384
Footprint Creator, 855, 860
Four Way Control, 757
Freeze ALL Layers, 1404
Freeze Layer, 61, 113, 136, 152, 323, 499
Freeze Layer By Name, 324
Freeze Layer By Pick, 322
Freeze Layer By Selection, 323
Freeze Points, 499, 500
General Commands, 177, 726, 727, 729, 730
General Information, 1268
Geodimeter, 536, 546, 565, 567, 574, 616, 1242
Geoid Utilities, 528
Geolocate DWG Files, 225
Geologic Column, 24
geologic model, 432, 438
Getodetic, 748
Get Project from Data Depot, 184
GIS Database Settings, 1144, 1146, 1154
GIS File, 470
GIS Inspector, 217, 1147, 1148
GIS Inspector Settings, 1147, 1148
Index
1461
Lot File, 136, 141, 143, 688, 889, 895, 898, 900, 911–913
Lot File by Closed Linework, 899
Lot File by Interior Text, 136, 900
Lot File by Pick Interior, 899
Lot File Inspector, 907
Lot File Manager, 906
Lot File to Centerline, 913
Lot File Utilities, 899
LotNet Road Network, 902
Lot Network - Assign Lot Type, 896
Lot Network Boundary, 878, 884
Lot Network Inspector, 890, 891
Lot Network Labels, 889
Lot Network Linework, 886, 887, 894
Lot Network Report, 889
Lot Network Road Network, 882
Lot Network Settings, 876, 887, 888, 891, 903
Lot Networks Roads, 881
Lot Networks Sub-Areas, 879
Lot Network Utilities, 889, 891, 893, 895, 896
Lot Newtor Areas, 887
Lot Number Report, 890
Main Contours, 1382
Make 3D Grid File, 1050, 1056, 1077, 1083
Make Arcs Tangential, 279
Manhole, 70, 106, 1128–1131, 1235, 1236, 1362
Manual Storage, 1361
Map check, 699
Map Points from, 482, 485
Maps, 215, 1053
Maptech, 478, 575
Max Samples, 431, 433
Measured, 564
Median Offset, 237
Merge Closed Polylines, 274
Merge PDF Files, 194
Merge Tables, 974
MicroStation, 220
Middle Break, 750
Middle Ordinate Solution, 1288, 1391, 1407
Minimum Frontage, 884, 891
Mirror, 27, 267, 869, 871, 875, 876, 938, 939
Mirror and Flip Selected Labels, 938
Mirror Selected Labels, 938
Mortgage Block, 455
Move, 234, 242, 255, 257, 260, 328, 355, 421, 447
448, 490, 497, 508, 519, 520, 524, 682, 711
788, 821, 832, 836, 840, 864, 872, 873, 908
932, 937, 940, 942, 946, 955, 998, 1029
1043, 1044, 1049, 1148, 1160, 1317, 1333
1334, 1345, 1347, 1355, 1433
Move Attributes with Leader, 257
Move Calls, 1333
Move Label Along Contour, 1028
Move Label with Leader, 930
Move Point Attributes, 110, 112
Move Point Attributes Single, 519
Move Point Attributes with Leader, 519, 524
Move Points, 508
Move Text, 255, 256
Move Text with Leader, 255
Multi-Draw, 1320, 1321
Multileader with Text, 381
Multiple Offsets, 237
NAD83, 1309, 1388
National Geodetic Survey, 509
Nearest Found, 395, 626, 641
New, 182, 183, 187, 196, 247, 248, 250, 251, 265
279, 291, 295, 318, 319, 322, 323, 332, 337, 371
375, 473, 480, 482, 487, 491, 502, 504, 509
524, 567, 572, 573, 600, 622, 625, 670, 703
719, 720, 730, 749, 751, 868, 996, 1037
1039, 1146, 1155, 1165, 1169, 1196, 1233
1341, 1344, 1364, 1367, 1372, 1386, 1395
1410, 1411, 1414, 1417, 1439, 1445, 1451
New Area Table, 831
Nikon, 546, 564, 565, 575, 616, 1245, 1246
Nodes, 470, 471
Non-Surface Points/Entities, 1067
North Arrow, 37, 68, 115, 1108
Note File, 1165
Numeric, 42, 428, 910, 1168, 1196, 1227, 1348, 1445
Numeric Pad COGO, 746
Object Data, 439, 1145, 1147
Object Height, 431
Object Linking, 228, 428, 937
Object Snap, 462, 473
Obtaining Technical Support, 28
Occupy Point, 727, 732
Off, 1408, 1423, 1424, 1429, 1434, 1440, 1443, 1444
1448, 1449
Offset, 236, 239, 260, 272, 280, 281, 287, 331, 333
348, 349, 351, 352, 357, 358, 428, 440, 470
523, 564, 567, 609, 639, 659, 663, 670, 694
707, 716, 738, 741, 776, 779, 781, 803, 806
811, 812, 814, 817, 849, 850, 853, 882, 884
890, 891, 903, 919, 929, 932, 946, 983, 984
997, 998, 1008, 1009, 1012, 1028, 1037
1063, 1065, 1090, 1096, 1102, 1104, 1107
1110, 1124, 1129, 1130, 1135, 1136, 1138
1158, 1221, 1222, 1233, 1272, 1276, 1278
1280, 1281, 1287, 1288, 1293, 1294, 1302
1304, 1306, 1307, 1394
Offset 3D Polyline, 286
Offset Cutoff, 221, 223
Offset Dimensions, 64, 115, 949, 950
Offset Point Entry, 17, 813
Offset Points By Interval, 775
Offsets & Intersections, 848, 850
Offset to Area, 236
Offset To Layer, 236
One Triangulation Surface Volumes, 1032
One Way Control, 753
Open Dos Drawing, 1185
Opening Closing and Saving, 1169
Open Polylines, 280
Order Table, 976
Output Layouts to PDF, 193
Output To Lot File, 895
Ownership, 25
Page Setup, 189, 190, 193
Pan, 300, 303, 329, 331, 336, 427, 524, 582, 673, 734, 788, 930, 1088, 1148, 1425
Parking, 852
PC, PT, Center, 340
PC, PT, Radius, 340
PC, PT, Tangent, 341
PC, Radius, Arc Length, 341
PC, Radius, Chord, 341
PCMCIA card, 564
PC Point, 342
PDF, 1123, 1195, 253, 310, 311, 713, 1088
PDMODE, 534
PDSIZE, 427
Perpendicular Intersect, 741, 848, 1274
Pick Current Layer, 1405
Pick Intersection Points, 737
Pick Layers to Freeze, 1404
Pick Layers to Thaw, 1404
Pick Layers to turn Off, 1405
Pick Layers to turn On, 1405
Pipe Polylines, 1129
Pipe Size, 25, 1096
PI Points, 792, 803, 808
Pit Polylines, 1029
Pivot Point Rotate by Bearing, 251
Place Calls, 1331, 1333, 1402
Place Camera Symbol/Image, 1162
Place Image by World File, 1164
Place Labels, 1383
Plot Points and Symbols, 1324, 1325, 1327
Plot Points on Screen, 1324
Plot Preview, 189
Point Check, 893
Point Code, 1406, 1450
Point Description, 34, 406, 473, 490, 531, 532, 657, 729, 730, 735, 737, 770, 772, 778, 812, 896, 1316, 1327
Point Entity, 482, 516, 517, 660
Point Entity Grouping, 228
Point Group Manager, 491, 495, 498, 635, 689, 1091
Point Groups, 1378, 1380
Point ID, 402, 482, 486, 668, 1204, 1205, 1227, 1265, 1279, 1295, 1316, 1340, 1343, 1364, 1375, 1385, 1409, 1420, 1434, 1435, 1444, 1445
Point Label, 1346, 1375
Point Layer, 635, 650, 657, 778
Point Manager, 1351, 1354, 1355, 1358
Point Notes, 591, 628, 816
Point Number Report, 482, 487
Point Object Snap, 431, 461
Point Object Snap On/Off, 461
Point on Arc, 769
Point Protect, 203, 206, 209, 471, 490, 553, 555, 556, 558, 559, 562, 565, 566, 590, 591, 728
Point Range, 25, 484, 551, 1064
Points, 1408, 1414, 1420, 1426, 1446, 1448, 1450–1452
Points and Lines, 1408
Points Menu, 467
Points on Arc, 1289
Points on Centerline, 814, 1138
Points on Line, 1283
Point Table, 958, 960
Point To Point Table, 960
Point Utilities, 529, 573, 528, 530, 531
Polygon Processor, 25
Polyline Blips, 282, 404
Polyline by Nearest Found, 395
Polyline File, 206, 220, 221
Polyline Info, 410
Polyline Report, 717, 718
Polylines by Point, 1328
Polyline to Centerline File, 797, 799, 800
Tag Hard Breakline Polylines, 1066
Tag No-Building Area, 893
Tag Non-Surface Points, 1067
Tag Predefined Boundaries, 1029
Tag ROW Segments to Skip Frontage, 892
Tag Sub-Area, 879–881
Tang, PC, Radius, Chord Length, 346
Tang, PC, Radius, Delta Angle, 346
Tangent, PC, Radius, Arc Length, 345
Tangent, PC, Radius, Tangent Length, 345
Tangent Between Curves, 1294
Tangent Intersect, 742, 1275
Tangent Line from Circles, 747
Tangent Out Bearing, 675
TDS, 2, 378, 545, 558, 569, 575, 577, 619, 633
TDS CR, 532
Technical Support, 28
Template Database, 1145–1149
Template Point Centerline, 797
Template Point Profile, 707
Temporary Erase, 234
Terramodel, 1141
Text, 254, 265, 305, 309, 352, 354, 356, 359, 361
376, 379, 382, 386, 390, 403, 404, 411, 413
415, 417, 448, 449, 471, 473, 476, 477, 485
496, 531, 551, 583, 629, 633, 634, 650, 651
655, 658, 659, 661, 678, 690, 705, 709, 801
803, 810, 812, 817, 822, 829, 833, 834, 836
838, 853, 881, 899, 909, 910, 916, 918, 920
922, 923, 926, 927, 929, 938, 940, 947, 949
951, 952, 954, 955, 962, 963, 968, 969, 979
981, 986, 992, 996, 998, 1011, 1012, 1027
1029, 1040, 1052, 1054, 1055, 1058, 1064, 1098
1101, 1103, 1105, 1107, 1110, 1132, 1135
1140, 1262, 1263, 1265, 1313, 1316, 1318
1331, 1332, 1334, 1336, 1337, 1344, 1345
1384, 1389, 1391, 1396, 1426, 1449
Text Capitalization, 262
Text Enlarge/Reduce, 38, 117, 254, 258
Text Explode To Polylines, 220, 262
Text Export, 354
Text File To Report Formatter, 412
Text Import, 354
Text Mask, 357
Text Math, 263
Text on Arc, 1316
Text on Line, 356
Text on Polyline, 357
Text Plot Size, 44, 117
Text Size, 39, 62, 64, 65
Text Style, 74
Text UnMask, 360
Text Wizard, 353

Thaw/On All Layers, 324
Thaw ALL Layers, 1404
Thaw Layer, 61, 153, 324, 500
Thaw Layer By Name, 324
Thaw Points, 500
Three Way Control, 755, 756
TIF file, 1162, 1164
Tin, 1382, 1400
T Intersections, 1297
Title Block, 5, 35, 44, 68, 113, 311, 453, 952
Toolbars, 445
Topographic Settings, 1382, 1383
Topsoil Removal, 1050
Transformations, 1365, 1368, 1369, 1371, 1372
Transit, 596, 604, 677, 698, 1192, 1392, 1394
Translate Layers, 226
Translate Points, 315, 482, 483, 504, 508, 1365
Traverse, 727, 732, 748, 869, 1189, 1222, 1226
1232, 1246, 1247, 1250, 1251, 1253, 1256
1258, 1262, 1265, 1385, 1393, 1394, 1414
1418, 1421, 1423, 1428
Triangle Solutions, 761
Triangular Mesh, 18
Triangulate & Contour, 1002, 1004, 1015, 1017
1022, 1029, 1038, 1066, 1067, 1083, 1086
1137
Triangulation, 18, 24, 26, 431, 440, 706, 710, 1003
1004, 1006, 1008, 1017, 1021, 1029, 1030
1032, 1033, 1042, 1048, 1050, 1052, 1056
1071, 1083, 1086, 1090, 1091, 1308
Triangulation File Utilities, 1033, 1036
Triangulation Surface Manager, 1041
Trim, 27, 174, 240, 264, 268, 478, 545, 556, 575, 577
619, 622, 633, 1004, 1077, 1078, 1145
Trimble, 200, 210
Trim by Point Symbol, 39, 528, 529
Trim Linework Through Text, 561
Turn Layers On/Off, 325
Turn OFF ALL Layers, 1405
Turn Off By Pick, 325
Turn Off By Selection, 325
Turn ON ALL Layers, 1405
Turn On Layers, 325
Tutorials, 31
Twist, 109–111, 250, 252, 255, 316, 427, 521, 522
Twist 3D Entities, 316
Twist Point Attributes, 110, 521
Twist Screen, 315, 316, 427, 521, 812, 822, 963
Twist To 3D View, 316, 317
Two Grid Surface Volumes, 1056
Two Way Control, 754
Typical Template, 169
Undo, 232, 240, 242, 278, 295, 322, 325, 328, 330

Index
Index

Units Control, 459
Universal Transverse Mercator, 486, 509, 759
Unlock Attributes, 229
Unlock Points, 501
Untag Area Descriptions, 839
Untag Hard Breakline Polylines, 1067
Untag Linework, 887
Untag No-Building Area, 893
Untag Non-Surface Points, 1068
Untag Sub-Area, 879
Update Drawing from CRD File, 482, 489
Update Point Table, 959
Using the Carlson Software Manual, 2

Variable Offset, 238
Ventilation, 25
Vertical Angle, 567, 580, 590, 605, 610, 729, 732, 735, 736, 1235, 1394, 1419, 1469, 1599, 1597
Vertical Angle Mode, 469
Vertical Curve, 159, 432, 1278
Vertical Curve Design, 1295
Vertical Extents on All Layouts, 300
Zoom - Center, 299
Zoom - Dynamic, 299
Zoom - Extents, 298
Zoom - Previous, 298
Zoom - Window, 298
Zoom IN, 299
Zoom Most, 299
Zoom OUT, 299
Zoom Points, 300
Zoom Selection, 299
Zoom to Point ID, 1408

Web Site, 28
What is New, 17
White Solid Behind Text, 361
Wild, 60, 119, 144, 222, 472, 477, 479, 564, 591, 616
Wildsoft, 490, 563, 564, 574
Windows Calculator, 1409
With Text, 17
Write Block, 397
Write Polyline File, 220, 262
X Intersections, 1298
Xref Manager, 195, 196, 200
Y Intersections, 1299
Zeiss, 479, 575
Zero Thickness, 437
Zone Polylines, 221
Zoom Limits, 298, 300, 302, 303, 329, 331, 336, 403, 419
946, 988, 949, 952, 1013, 1014, 1049, 1095
1148, 1160, 1142
Zoom Extents on All Layouts, 300
Zoom IN, 299
Zoom Most, 299
Zoom OUT, 299
Zoom Points, 300
Zoom Selection, 299
Zoom to Point ID, 1408

Index 1470